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EKTRON INC. SOFTWARE LICENSE AGREEMENT

Important: ** READ THISBEFORELOADINGSOFTWARE**

1. License: Licensor hereby grants to Licensee a worldwide, fully paid, royalty free, irrevocable non-exclusive license (the “License”) to use the

following Software:

CMS400.NET [specify Professional with number of URLs and seats, or Enterprise Package with Unlimited Users and Unlimited URLs on a single

server]

The Software is licensed for use only in delivered code form. Delivered code is defined as the code base delivered by the Licensor to the Licensee and

is comprised of Ektron’s compiled and un-editable source code as well as additional modifiable and customizable code layers. Each copy of the

Software is licensed for the number of seats, URLs, or servers listed above. Any use of the Software beyond the number of authorized seats or servers

contained in the Professional or Enterprise Package as provided herein shall cause this license to terminate. Should Licensee wish to add seats or

servers beyond the Professional / Enterprise Package, Licensee may add seats or servers at the then current price for additional seats.

For purposes of this section, the term “seat” shall mean an individual user provided access to the capabilities of the Software. A “server” should be

defined as a specific physical or virtual server managed by the software.

Licensee may not modify, alter, reverse engineer, disassemble, or decompile the Software. The Software is licensed, not sold.

2. Duration: This License shall continue so long as Licensee uses the Software in compliance with this License. Should Licensee breach any of its

obligations hereunder and the License is terminated in accordance with Section 6 hereof, Licensee agrees to return all copies of the Software and this

License upon notification and demand by Licensor.

3. Copyright: The Software (including any images, “applets,” photographs, animations, video, audio, music and text incorporated into the Software) as

well as any accompanying written materials (the “Documentation”) is owned by Licensor or its suppliers, is protected by United States copyright laws

and international treaties, and contains confidential information and trade secrets. Licensee agrees to protect the confidentiality of the Software and

Documentation. Licensee agrees that it will not provide a copy of this Software or Documentation nor divulge any proprietary information of Licensor

to any person, other than its employees or contractors, without the prior consent of Licensor; Licensee shall use its best efforts to see that any user of

the Software complies with this License.

4. Limited Warranty: Licensor warrants that the Software will perform in all material respects in accordance with the description in the RFP response

submitted by Licensor to Licensee and that the Software will be free from defects in material and workmanship under normal, proper and intended

usage for a period of three (3) months from the date of purchase. Licensor warrants that the Software at the time of purchase will be free of malicious

code and disabling code and shall not infringe on the intellectual property rights of any third party. Except as provided in the preceding sentence,

Licensor does not warrant the use of the Software will be uninterrupted or error free, nor that program errors will be corrected. This limited warranty

shall not apply to any error or failure resulting from (i) machine error, (ii) Licensee's failure to follow operating instructions, (iii) negligence or

accident, or (iv) modifications to the Software by any person or entity other than Company. In the event of a breach of warranty, Licensee’s sole and

exclusive remedy is repair of all or any portion of the Software. If such remedy fails of its essential purpose, Licensee’s sole remedy and Licensor’s

maximum liability shall be a refund of the paid purchase price for the defective Software only. This limited warranty is only valid if Licensor receives

written notice of breach of warranty no later than thirty days after the warranty period expires.

5. Limitation of Warranties and Liability: EXCEPT AS SET FORTH IN SECTION 4, THE SOFTWARE AND DOCUMENTATION ARE SOLD

“AS IS” AND WITHOUT ANY WARRANTIES AS TO THE PERFORMANCE, MERCHANTIBILITY, DESIGN, OR OPERATION OF THE

SOFTWARE. NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED. EXCEPT AS DESCRIBED IN SECTION 4,

ALL WARRANTIES EXPRESS AND IMPLIED ARE HEREBY DISCLAIMED. NEITHER LICENSOR OR ITS SUPPLIERS SHALL BE

LIABLE FOR ANY LOSS OF PROFITS, LOSS OF BUSINESS OR GOODWILL, LOSS OF DATA OR USE OF DATA, INTERRUPTION OF

BUSINESS NOR FOR ANY OTHER INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY KIND UNDER OR

ARISING OUT OF, OR IN ANY RELATED TO THIS AGREEMENT, HOWEVER, CAUSED, WHETHER FOR BREACH OF WARRANTY,

BREACH OR REPUDIATION OF CONTRACT, TORT, NEGLIGENCE, OR OTHERWISE, EVEN IF LICENSOR OR ITS

REPRESENTATIVES HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH LOSS.

6. Indemnification:



(a) General. Except as otherwise expressly provided, each Party to this agreement shall defend, indemnify and hold harmless the other Party and any

of the other Party’s agents, employees, and invite es against all claims, liability, loss and expenses, including reasonable costs, collection expenses,

court costs and attorney’s fees, which may arise because of the negligence, misconduct, or other fault of the first Party in the performance of its

obligations under this agreement.

(b) Indemnification for Infringement. Licensor will, at its expense, defend, and indemnify Licensee against any actual or threatened action or

proceeding by a third party (a “Claim”) that the Software infringes a United States patent or copyright of any third party, and will pay all losses,

liabilities, damages and claims and all related costs and expenses (including reasonable attorneys' fees, litigation, settlement, judgment, interest and

penalties) either awarded by a court or agreed to in an out-of-court settlement approved in advance in writing by Licensor. Licensor may, at its

option, either procure for Licensee the right to continue using the Software or replace or modify the Software so that it becomes non-infringing. If, in

Licensor’s reasonable business or legal opinion, neither option is feasible, Licensee will return the infringing Software to Licensor, the License will

be terminated and Licensor will reimburse Licensee a full refund. If Licensee elects to continue using the Software rather than return it to Licensor,

Licensor will have no further liability to Licensee. Licensor will not indemnify Licensee for infringement if Licensee has modified the Software

without Licensor’s assistance.

(c) Indemnification Procedures. If Licensee becomes aware of a Claim that may require indemnification, Licensee will promptly notify Licensor in

writing of the Claim and will allow Licensor to assume sole and full control of the defense and settlement of the Claim. Licensee will provide

Licensor with reasonable assistance and information necessary to defend and settle the Claims. Licensee’s counsel will have the right to participate in

the defense and settlement of the Claim, at Licensee's own expense.

9. Assignment: Both parties shall be entitled to assign this Agreement in whole or in part, and its rights and obligations hereunder, without advance

notice and without cost, to any current and future parent, subsidiary or affiliate of such assigning party and to a business entity in connection with a

merger, or sale or contribution of some or all of its assets. Written confirmation notice of any assignment will be given by the assigning party to the

other party to this Agreement as soon as commercially reasonable. Otherwise, all rights and obligations are not assignable without prior written

consent of the other party, which consent shall not be unreasonably withheld.

10. Transfer: Upon completion of payment for the software referenced herein the Licensee shall receive perpetual, non-expiring license keys for

their production environment. Once delivered to the Licensee, these keys exist in perpetuity in the Licensee’s possession. In the event that the

Licensee requests a change to the perpetual keys referenced above, Licensor requires a mutually signed license transfer document and Licensee must

remit a license transfer fee equal to thirty (30) percent of the initial license purchase cost.

11. Miscellaneous: This Agreement and its performance and all claims arising from the relationship between the parties contemplated herein shall be

governed by, construed and enforced in accordance with the laws of the State of Missouri without regard to conflict of laws principles thereof. The

parties agree that any action brought in connection with this Agreement shall be maintained only in a court of competent subject matter jurisdiction

located in the State of Missouri or in any court to which appeal there from may be taken. The parties hereby consent to the exclusive personal

jurisdiction of such courts in the State of New Hampshire for all such purposes. The United Nations Convention on Contracts for the International

Sale of Goods is specifically excluded from governing this License. If any provision of this License is to be held unenforceable, such holding will not

affect the validity of the other provisions hereof. Failure of a party to enforce any provision of this Agreement shall not constitute or be construed as a

waiver of such provision or of the right to enforce such provision. This Agreement may not be modified other than in a writing signed by both parties.

This Agreement and the Schedules hereto represent the entire understanding between the parties with respect to its subject matter. This Agreement

may be executed in counterparts, each of which shall be deemed an original and which together shall constitute one document. Facsimile copies of

signatures shall be acceptable as originals.

LICENSEE HEREBY ACKNOWLEDGES THAT IT HAS READ THIS AGREEMENT AND THAT IT UNDERSTANDS THIS

AGREEMENT.

Copyright 1999 - 2009 Ektron, Inc. All rights reserved. LA10031, Revision 3.0
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Securing your Ektron CMS400.NET

Security Checklist
The following is a checklist of things an administrator must do to secure Ektron CMS400.NET.

Change the Admin and Builtin Users’ Passwords

Make sure you change the password for the Admin and Builtin user. To change the Admin

user’s password, navigate to .

Change Admin user password

Change the Admin user’s password in the Workarea by following these steps.

1. In the Workarea, navigate to Settings > Users

2. Click the Admin user.

3. Click the Edit Users button.

4. In the Password and Confirm Password fields enter the new password.

5. Click the Save button.

Change builtin user password

Warning! If you changed the builtin user password during the site setup, you do not need to change it again. See

"Editing Builtin" on page xxv for additional information.

Change the builtin user’s password in the Workarea by following these steps.

1. In the Workarea, navigate to Settings > Configurations > Setup.

2. Click the Edit button.

3. Find the Built In User field.

4. In the Password and Confirm Password fields enter the new password.

5. Click the Update button.

Remove Sample Users and Sample Membership Users

Some sample users and sample membership users are included with Ektron CMS400.NET for

evaluation and demonstration purposes. These users should be removed when they are no

longer needed.

Securing your Ektron CMS400.NET
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CMS users have access to the Workarea. They can be content authors, administrators or even

developers who need access to information in the Workarea. These people count towards the

number of users in your license.

Membership users are typically people who only interact with your Web site. Membership

users are a category of users who have limited privileges to Ektron CMS400.NET. Unlike

regular CMS users, they cannot use the Workarea and do not count towards the number of

users in your license.

Remove Sample Users and Sample Membership Users

Warning! Some users in this list might not appear in your User list. Also, youmight have sample users that appear

in your users lists. This dependson which version of the software you have installed.

Ektron CMS400.NET Users Membership Users

jedit

tbrown

jsmith

vs
See Also: "Managing Users and

User Groups" on page 15-1

jmember

member@example.com

north

supermember

west
See Also: "Membership Users and

Groups" on page 16-4

Removing CMS400.NET Users
To remove Ektron CMS400.NET users in the Workarea, follow these steps.

1. In the Workarea, navigate to Settings > Users.

2. Click the check box next each user you want to remove.

3. Click the Delete button ( ).

4. Click OK in the dialog box that appears.

The page refreshes and the users are removed.

Removing Membership Users
To remove Membership users in the Workarea, follow these steps.

1. In the Workarea, navigate to Settings > Community Management > Memberships >

Users.

2. Click the check box next each user you want to remove.
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3. Click the Delete button ( ).

4. Click OK in the dialog box that appears.

The page refreshes and the membership users are removed.

Do Not Allow the Use of Group User Accounts

Do Not Allow the Use of Group User Accounts

A group account is an account that multiple people use to log in to Ektron CMS400.NET

using the same username and password. This is a serious security issue as you lose the ability

to accurately keep track of who is doing what in your Web site’s environment. The use of a

group user account is a violation of Ektron CMS400.NET's license agreement.

Additional Information
You do not need to make these changes if you are using the CMS400.NET for demonstration

or evaluation purposes. These changes should be completed once the decision is made to

purchase the product and go live with your site.

Warning! Ektron recommendscreating your own Administrator user and deleting the Admin user.

Warning! Ektron recommendsdeleting anyusers from the CMS400.NET that are not needed on the system.

The Everyone Group

By default, the root folder in Workarea provides the Everyone Group with all permissions

except Overwrite Library. Ektron Inc. recommends reviewing the permission needs of the

Everyone Group when you add a folder. See Also: "Folder Permissions" on page 5-43

Editing Builtin

Warning! The “builtin” user doesnot appear in the Users list. This user appears on the application setup screen.

To change the builtin account information, follow these steps.

1. In the Workarea, click Settings > Configuration > Setup.

2. Click the Edit button ( ).

3. Locate the Built In User field.

4. Edit the built in user information by changing the username and password.

5. Click the Update button ( ).
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Note: If you cannot sign in to Ektron CMS400.NET because the builtin user password waschanged and you don’t

know the new password, use the BuiltinAccountReset.exe utility. This resets your Ektron CMS400.NET user \

password to Builtin \ Builtin. This utility is located in C:\Program

Files\Ektron\CMS400versionnumber\Utilities.

ServerControlWS.asmx

Best Practice

For improved security, Ektron recommends renaming or removing theWeb services

file when youmove it to your production server. After installation, this file is named

ServerControlWS.asmxand resides in thewebroot/siteroot/Workarea folder.

ServerControlWS.asmx is the Web service that lets the server controls talk to Ektron CMS400.NET. The path is
coded in the web.config file. This is how it appears:

<!-- Web Service URL for Server Controls design time --> <add key="WSPath"

value="http://localhost/CMS400Developer/Workarea/ServerControlWS.asmx" />

You will need to edit this line if you change the location or name of the ServerControlWS.asmx file.

Ektron CMS400.NET
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System Requirements

The following components are required when developing or viewing an Ektron CMS400.NET

based application.

n "Server Requirements" on page 1-2

n "PC Client Requirements" on page 1-3

n "Apple Macintosh Client Requirements" on page 1-4

Server Requirements

Component Requirements

Recommended

hardware configuration

n Intel® Pentium® 4 supporting Hyper-Threading or Intel®

Xeon® processor (with 800MHzbus)

n 2GBRAM or higher

n RAID array for hard drives

Web server operating

system

Microsoft ®Windows® Server 2003

n 32 and 64 bit versions

MicrosoftWindowsServer 2008

n 32 and 64 bit versions

MicrosoftWindowsServer 2000, XPProfessional

Note: Only useWindowsXP for testing and development. Do not

use it on your production server.

MicrosoftWindowsVista Business&Ultimate

Web application server Microsoft .NET™ Framework3.5

Web server Microsoft® Internet Information Server (IIS) 6.0 or higher

File System NTFS (FAT 32 isnot supported)

Database

n Microsoft SQL™Server 2008

n Microsoft SQL™Server 2005 SP2 and higher (including

Express version)
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Component Requirements

Warning! Ektron CMS400.NET doesnot support case sensitive

databases.

Note: VirtualServers are not recommended for database

environments.

PC Client Requirements

Component Requirements

Operating

system

n Any IBM-PC compatible system runningWindows, including Vista® Ulti-

mate and Vista® Business

n MacOSX

Browsers for

viewing

Allmajor browsers including:

n Mozilla Firefox

n Microsoft ® Internet Explorer 6.0 or higher

n Google Chrome

Browsers for

editing

n Mozilla Firefox (but see FirefoxSupport Summary)

n Microsoft ® Internet Explorer 7.0 or higher

Note: Only released versionsare supported.

Warning! If using Firefox, uncheck theBlock Popup Windows setting. To

access this setting, go to Tools > Options > Content.

Hardware
Suggestedminimum requirements: Pentium 166MHzor faster with at least

64MBof RAM

Web

development

tools

n VisualStudio 2005 / 2008

n VisualWebDeveloper 2005 / 2008 Express

For Web site development

n VisualC# 2005/2008 Expressand VisualVB 2005 Express

For Plug-in Extensions creation

n Adobe Dreamweaver

PC Client Requirements
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Apple Macintosh Client
Requirements

Component Requirements

Operating system MACOSX

Browsers for viewing

Allmajor browsers including:

n Microsoft ® Internet Explorer

n Mozilla Firefox

Browsers for editing n Mozilla Firefox

Hardware AppleMacintosh

Note: Ektron doesnot guarantee support of beta releases for components listed above.
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License Keys

Introduction
Ektron controls the use of CMS400.NET through a license key, a unique code assigned to your

domain when you purchase CMS400.NET. Your license key is included in the email that

Ektron sends when you request or purchase CMS400.NET.

See Also:

n See "License Key Types" on page 1-5

n See "License Key Format" on page 1-6

n See "Inserting the License Key" on page 1-6

n See "WebImageFX License Keys" on page 1-7

n See "Using CMS400.NET without a License Key" on page 1-8

n See "Domains in which You Can Use the License Key" on page 1-8

n See "Register Domains, not IP Addresses" on page 1-8

n See "More Information" on page 1-9

License Key Types
There are three levels of license keys available for use with Ektron CMS400.NET. The features

that are available in your specific version of CMS400.NET depend on the license key you

purchase. The table below shows the major features at each level.

Feature Enterprise Professional Standard

Analytics

Document Management

eCommerce Optional Optional

eSync Optional

License Keys
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Feature Enterprise Professional Standard

Multi-site Optional

Personalization

SocialNetworking

XLIFF Support

AllOther Ektron CMS400.NET Features

License Key Format
A license key typically begins with a base URL (domain name, computer network name, or IP

address) followed by descriptor tags, a question mark, a series of numbers, a hyphen and one or

two digits signifying release number. For example:

dev.mysite.com(exp-2008-10-25)(modifiers)(users-10)?51510837796786063064924334416-XX

License keys cannot contain spaces or line breaks.

Inserting the License Key
If you download the executable (.exe) file, you are prompted to enter a license key during

installation. If you choose not to install the license key during the installation, you can enter it

by navigating to Workarea > Settings > Setup and clicking the Edit button. Once you are in

edit mode, add the license key to the License Key(s) text box.

Changing License Keys Upon Upgrade
If you upgrade to a new release of CMS400.NET and want to replace the old license key with

a new one, navigate to Workarea > Settings > Setup and click the Edit button. Once you are in

edit mode, add the license key to the License Key(s) text box. On the other hand, if you want

to add new keys in addition to old keys, create a comma delimited list of keys in the License

Key(s) text box.
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When cutting and pasting license keys, keep the full license key intact without adding or

deleting characters. License keys that are changed in any way render CMS400.NET inoperable.

WebImageFX License Keys
If you are installing WebImageFX with CMS400.NET, a WebImageFX license key is included

in the email you receive when you purchase CMS400.NET. A WebImageFX key resembles a

CMS400.NET key but includes the string wifx.

To add the key to CMS400.NET, navigate to Workarea > Settings > Setup and clicking the

Edit button. Once you are in edit mode, add the license key to the Module Licenses text box.

License Key Check
When you login to a Web site that contains CMS400.NET, it checks the license key(s) against

the domain.

If the URL of a valid license key matches the URL of the site being accessed, the Workarea

appears.

If no valid license key is found for the URL of the site being accessed, CMS400.NET is

disabled and you must log in the with Builtin account to change the License Key.

Invalid License Key Message
If you have a broken license key or a license key with an incorrect base URL, an error message

appears in the CMS400.NET Login window. The message states, “Error: A license violation

has occurred and the application is presently locked. Please see your administrator.”

If this message appears, you can login with the Builtin account and reenter your license key. If

the message continues to appear and you are sure you have a valid key, contact Ektron

Support.

WebImageFX License Keys
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Using CMS400.NET without a
License Key
For evaluation purposes, when you install CMS400.NET, you do not need a license key.

During the installation process, leave the License Key field blank and click the next button on

the License screen. This allows you to use CMS400.NET as localhost.

Domains in which You Can Use the
License Key
The license key is assigned to your base URL, which is typically your domain name. For

example, if your domain name is www.mycompany.com, the license key follows this pattern:

www.mycompany.com(expdate)(Modifers)?1234567890.

Each domain name requires its own license key. For example, to support the domain names,

www.mycompany.com, sales.mycompany.com and support.mycompany.com, you need three license

keys.

Register Domains, not IP Addresses
When you purchase a license key, be sure to register a domain name, not an IP address. For

example, register www.mycompany.com, not 192.168.0.1.

Although CMS400.NET supports IP addresses, the domain that you license becomes the

required URL in the browser address. For example, if you register 192.168.0.1, you would need

to access the site as http://192.168.0.1/somedirectory/myloginpage.aspx.

Since users would typically not identify a Web page by its IP address, you should register the

domain name instead.

Installing Ektron CMS400.NET
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More Information
Additional information about licenses is available at

http://www.ektron.com/products.aspx?id=1144.
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Development and Staging
Configurations

This chapter presents five examples of how to configure your Ektron CMS400.NET Web site.

Reading this will help you decide which configuration is the best fit for your particular

situation.

Configuration Properties
Implementation

Guidelines

VirtualStaging
n UseCMS400.NET’s approval processand

scheduled publishing of content to manage when con-

tent goes live

"VirtualStaging"

on page 1-11

Multiple sites,

Same Server,

SameDatabase

n Production and development/staging sites use

separate copiesof Ektron CMS400.NET but reside

on same server and point to same database

n Ektron CMS400.NET’s settings, managed con-

tent, and library files are identical between sites

"Same Server,

SameDatabase"

on page 1-13

Multiple sites,

Same Server,

Different

Databases

n Production and development/staging sites use

separate copiesof Ektron CMS400.NET’s display

layer, reside on same server, but point to different

databases

n Changes to content, configuration, or library files

made in one site must be copied to other site

"Same Server,

Different

Databases" on

page 1-11

Multiple sites,

Separate

Servers, Same

Database

n Production and development/staging sites

reside on separate servers, which point to the same

database.

n Ektron CMS400.NET settings, content, and

library files are identical between sites.

n Changes to templatesmust be copied between

servers.

"Separate

Servers, Same

Database" on

page 1-14

Multiple sites,

Separate

Servers,

Separate

Databases

n Production and development/staging sites are

installed to separate servers and point to different

databases

n Changes to content, configuration, or filesmust

be copied between sites.

"Separate

Servers, Separate

Databases" on

page 1-15

Installing Ektron CMS400.NET

1-10
ReferenceManual

Version 8.0 Rev 1.3



After deciding which configuration is best, read the following sections to learn about

procedures for working with multiple sites, servers, and databases.

n Installing Ektron CMS400.NET on Several Servers

n "Copying the Site and Database to Other Environments" on page 1-16

Virtual Staging

n Best choice when changes to templates and library files assets are infrequent

n No special implementation guidelines; just an installation on one server

n When upgrading this type of site, make a temporary copy of the site (both display layer

and database) on a separate server to test the upgrade

Same Server, Different Databases

Virtual Staging
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To set up this configuration, follow these guidelines.

n To maintain file paths between sites, follow these steps.

- Create separate Web Sites in IIS.

- Assign different ports to the production and development/staging sites. For example,

the production site is http://www.example.com, and the development/staging site is

http://www.example.com:8080.

- Separate the databases for isolation.

- One database is the master, and the other is a copy

- Only edit content in the site connected to the master database

- Remove the Ektron CMS400.NET login page from the site connected to the copy

database

n To copy the Ektron CMS400.NET database, your best choice is Ektron’s eSync feature.

This is described in See "Synchronizing Servers Using eSync" on page 18-1 .

If you have not implemented eSync, copy site content using a replication tool for the database.

- SQL Server 2000 SDK Replication - see http://msdn.microsoft.com/library/en-

us/replsql/replover_694n.asp

n Library files - Make the Ektron CMS400.NET uploadedimages/ and uploadedfiles/ folders

IIS virtual directories that point to the same physical directory.

n Templates and other file system assets - The best way to move these is syncs. If that was

not implemented and changes to these items are infrequent, you can manually copy them.

For automated replication, use a product such as Microsoft Application Center.

n Upgrading Ektron CMS400.NET - To test an upgrade, make a temporary copy of the site’s

display layer on a separate server connected to the development/staging database. If the

development/staging database is the master, back it up before upgrading.

Installing Ektron CMS400.NET

1-12
ReferenceManual

Version 8.0 Rev 1.3

http://msdn.microsoft.com/library/en-us/replsql/replover_694n.asp
http://msdn.microsoft.com/library/en-us/replsql/replover_694n.asp
http://msdn.microsoft.com/library/en-us/replsql/replover_694n.asp


Same Server, Same Database

To set up this configuration, follow these guidelines.

n To maintain file paths between sites, follow these steps.

- Create separate Web Sites in IIS.

- Assign different ports to the production and development/staging sites. For example,

the production site is http://www.example.com, and the development/staging site is

http://www.example.com:8080.

n Both sites must use the same pathing relative to the Web root. For example,

www.example.com\Workarea\applicationAPI.asp and

dev.example.com\Workarea\applicationAPI.asp.

n Because both sites use the same database, editing and publishing content on one site

affects the other site. As a result, the development/staging server always has the freshest

content.

n Make the Ektron CMS400.NET uploadedimages/ and uploadedfiles/ folders IIS virtual

directories that point to the same physical directory.

n Template changes must be copied between sites. The best way to copy site templates and

other file system assets is eSync. This is described in See "Synchronizing Servers Using

eSync" on page 18-1.

If that was not implemented and changes to these items are infrequent, you can manually

copy them.

SameServer, SameDatabase
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1. To test and QA an upgrade, make a temporary copy of the site’s display layer on a

separate server connected to the development/staging database.

If the development/staging database is the master, back it up before upgrading.

Separate Servers, Same Database

To set up this configuration, follow these guidelines.

n Configure Ektron CMS400.NET’s Load Balancing feature to copy uploaded images and

files between the servers.

n The best way to move site templates and other file system assets is eSync. This is described

in "Synchronizing Servers Using eSync" on page 18-1.

If that was not implemented and changes to these items are infrequent, you can manually copy

them. For automated replication, use a product like Microsoft Application Center.

n When upgrading Ektron CMS400.NET, follow these steps.

- Back up the file system of the development/staging server

- Make a temporary copy of the production server database

- Switch the development/staging site to use the copy

- Test and QA the upgrade on the development/staging server

Installing Ektron CMS400.NET
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Separate Servers, Separate
Databases

To set up this configuration, follow these guidelines.

n Both sites must have the same pathing relative to the Web root, for example,

www.example.com\Workarea\applicationAPI.asp and

dev.example.com\Workarea\applicationAPI.asp.

n Separate the databases for isolation.

- One database is the master, and the other is a copy

- Only edit content in the site connected to the master database

- Remove the Ektron CMS400.NET login page from the site connected to the copied

database

n The best way to copy site templates and library files is eSync. This is described in

"Synchronizing Servers Using eSync" on page 18-1.

If that was not implemented and changes to these items are infrequent, you can manually copy

them. For automated replication, use a product like Microsoft Application Center.

Separate Servers, Separate Databases
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n To copy the Ektron CMS400.NET database (containing HTML and XML content), your

best choice is Ektron’s eSync feature.

If you have not implemented eSync, copy site content using a replication tool for the database.

- SQL Server 2000 SDK Replication - see http://msdn.microsoft.com/library/en-

us/replsql/replover_694n.asp

n Make the Ektron CMS400.NET uploadedimages/ and uploadedfiles/ folders IIS virtual

directories that point to the same physical directory.

n When upgrading Ektron CMS400.NET, follow these steps.

- Back up the file system of the development/staging server

- Make a temporary copy of the production server database

- Switch the development/staging site to use the copy

- Test and QA the upgrade on the development/staging server

Copying the Site and Database to
Other Environments
Once your project is ready to be tested in house, move the site to a staging server. When the

project is ready to go live, move the site to a production (live) server.

You can use the same database for all environments. Back up that database often to keep it

safe. Alternatively, create a separate database for each server. For more information about how

to configure your Ektron CMS400.NET Web site, see "Development and Staging

Configurations" on page 1-10.

Tips on Creating Additional Environments
To create new environments, follow these steps.

1. On the same server or a separate server, create new folders for Ektron CMS400.NET:

C:/cmsstage and/or C:/cmsproduct.

2. In IIS, create a new domain for each server. http://stage.example.com points to

c:/cmsstage and http://www.example.com points to c:/cmsproduct.

3. If all environments are on the same server, you don't need to copy other folders. But, if you

are using a separate server for each environment, copy the c:/assetcatalog and

c:/assetlibrary folders to the other servers.

4. For the database, access the SQL manager and make a backup of the development

database. Then, create new databases for staging and production. Finally, restore the

backup of the development database to the staging and production databases.
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5. In the staging and production environments, open web.config. Then, update the database

connection information so that it points to the new databases.

6. Test the staging and production environments.

Copying the Site and Database to Other
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Installing Ektron CMS400.NET

Before You Install
Prior to installing Ektron CMS400.NET, complete these tasks.

Prerequisites:  See See "Installing Ektron CMS400.NET" on page 1-1

1. Create a folder for the site. Make sure the drive and folder to which you install your

Ektron CMS400.NET Web site have sufficient space. Anticipate future needs, since the

site is likely to grow over time.

2. Make sure that Internet Information Server (IIS) is installed in your server. See "Creating a

Web Site in IIS" on page 1-104.

3. Enable the ASP.NET 2 Web Service Extensions. To do this, open IIS Manager, and click

the Web Service Extensions folder. Then, click ASP.NET v2.0 and Allow (as shown

below).

4. Install and configure your Web Application Server. For more information, see

http://www.asp.net.

5. If you are setting up one Web site that uses multiple CMS servers and points to a single

database server, make sure both servers connect to the same database. This configuration

ensures that membership user registrations, forum/blog posts, statistics, etc., are the same on

both servers. For more information, see "Moving a Site to Another Directory or Server" on

page 1-41.

6. If the server to which you are installing has IIS7 (that is, it’s running Windows Vista or

Server 2008), enable IIS 6 metabase compatibility. To do that, follow these steps.

- Open the Control Panel.

- Click Programs and Features.

- From the left panel, click Turn Windows Features On or Off.
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- Click to open Internet Information Services > Web Management Tools > IIS 6

Management Compatibility.

- Check IIS Metabase and IIS 6 configuration compatibility.

- Press OK.

Installing the Minimum and Starter
Sites
The installation scheme has changed for version 7.0.2 or higher. Previously, when you

installed Ektron CMS400.NET, the installation created a site with sample content. (Sample

Installing theMinimum and Starter Sites
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content provides an example of how Ektron CMS400.NET’s features can be implemented.)

Beginning with 7.0.2, however, the base installation file provides no sample content.

To supplement the base installation, Ektron provides several sample sites. You can install as

many as you wish. Many customers install sample content that resembles their environment.

For example, a legal practice might install the legal starter site.

Sample sites are available from http://www.ektron.com/cms400-web-cms.aspx?id=4189.

Note: To get the technical information for developers, which waspreviously available on the Developer’sSample

page, install the developer starter site.

Installing a Starter Site

No Current Ektron CMS400.NET Installation
To install one or more sample sites, download them plus the base install file

(CMS400Basev80.exe) from www.ektron.com to the same folder on your Web server. Then,

click a starter site’s .exe file, such as Legal.exe. When you do, it copies the templates and

database to your machine. Next, the base install runs until it completes phase 1 of the

installation steps listed in "Performing the Installation" on page 1-21.

Once the base installation is complete, the Site Setup portion of the install is run. Once the

setup is complete, you can install any number of additional sample sites by downloading and

clicking them.

If you want to re-install a Starter Site, click the Site Setup link in Start > Programs > Ektron

> CMS400v8X > Utilities > CMS400 Site Setup.

If you are familiar with Ektron CMS400.NET, you do not need to install a starter site. Simply

use the base installation and proceed with site development.

Upgrading an Existing Installation
If you have an earlier version of Ektron CMS400.NET, first upgrade to Release 8.0. Then,

select one or more starter sites and install them.

Starter Applications
Ektron has also developed several starter applications that you can install to better learn

Ektron CMS400.NET’s capabilities. Starter applications are built on the Ektron CMS400.NET

engine and leverage Ektron CMS400.NET's flexible API made available via its SDK. Starter

applications are tailored to address the needs and requirements for specific business processes

for organizations of any size, but are flexible enough to meet your custom requirements.
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Starter applications are shipped open source and are free of charge. They work out of the box

and, if needed, can easily be extended. Starter applications are a perfect starting point for

building your own web application. The only requirement is that a Ektron CMS400.NET base

install exist on your server.

If you install the legal starter site, the Case Management Starter App is automatically installed.

If you install any other starter site, the Project Management Starter App is automatically

installed.

Starter Applications are available from http://www.ektron.com/products.aspx?id=5948.

Performing the Installation

Note: The installation program checks for an installation of MSSQL on your server. If it is not installed, it will

attempt to install SQL Express.

Installing Ektron CMS400.NET involves these actions. The installation program guides you

through them.

Phase Action What it does For details, see

1

Copy installation

files to C:\Program

Files

n ensures system

requirements

n installs non-working

copyof files needed to set up

site

"A screen displaysEktron’s License

Agreement. Please read the

agreement." on page 1-23

2

Set up a site - (can

be started any time

after Phase 1)

n moves files based on

selectedWeb folder

n creates IIS application

directories

n sets upload folder per-

missions

n updatesweb.config

(path, version, and build

number)

"Setting up a Site" on page 1-25
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Phase Action What it does For details, see

3 Set up a database

n referencesdatabase

folder for scripts needed to

create a database

n createsnew tables and

populates them

n addsand sets user per-

missions

n updates the web.config

file

n tests database con-

nection

"Setting up a Database" on page 1-

28

"Set Up a User for the CMS400.NET

Database" on page 1-32
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Running the Installation and Setup Program

Step Setup Screen

1. Go to the EktronWeb site

(http://www.ektron.com/download.cfm?

product_id=342&purchase=0) and download

Version 8.0 Rev1.3 of

Ektron CMS400.NET.

2. Double click the downloaded CMS400Basev80.exe file.

3. A screen displaysEktron’s License Agreement.

Please read the agreement.

n Click I Accept... to accept the agreement.

n Click I do not accept. If you do not accept the

agreement, this action ends the setup.

4. SelectComplete to install all components.

Or, selectCustom to choose which components to

install. You can also choose where the components are

installed.

Note: Once you click next, the install checks to see if you have SQL or SQL 2005

Express installed on the server. If you do not, a dialog appears asking if you would like

to install SQL 2005 Express.

5. TheReady to Install the Programscreen

appears. Click Install.
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Step Setup Screen

6. The installation program copies the necessary

files to the C:\Program Files folder.

Warning! - After completing the installation, you

should further configure your permissionsbased on

your network securitymodel before using Ektron

CMS400.NET.

7. ClickYes to check for updates. This verifies that

you have the latest version of CMS400.NET.

8. Youmight be prompted to restart your server. If

so, Ektron recommendsdoing a restart now.

Once you restart, the site setup procedure beginsupon completing the restart.

If the site setup doesnot start once the restart is complete, you can launch the site setup from Start > Programs > Ektron >

CMS400 > Utilities > CMS400 Site Setup.

Warning! If the above dialog appears, do not run the site setup until the system has

been rebooted.
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Step Setup Screen

Setting up a Site
This section allows you to setup a CMS400.NET site. The installation copies the following folders from C:\Program

Files\Ektron\CMS400v8x to theWeb root folder you specify:

n BIN

n workarea

n documentation

n uploaded files and uploaded images

n a login page

n the VS 2005 solution file

The site setup can be runmanually by clicking the cms400sitesetup.exe file located in C:\Program

Files\Ektron\CMS400v80\Utilities\SiteSetup or by clickingStart >Programs >Ektron >CMS400vXXUtilities >

CMS400 Site Setup.

9. This is the Site SetupWelcome screen. It lets you

set up aWeb site.

10. The Setup Type screen appears. Choose an

option and clickNext.

n CMS400 Full Installation - For setting up a

new site installation.

n CMS400 Upgrade - For upgrading existing site.

Upgrades the database and site files asnecessary.

n CMS400 Database Setup - For setting up a

new site database. Site files, such as .aspxpagesare

not included in this setup.
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Step Setup Screen

11. In the License Key field, enter your primary

license key for Ektron CMS400.NET.

License keysare typically emailed to your organization

when you request a copyof the application.

When cutting and pasting a license key, keep the full

license key intact without adding or deleting characters.

If you do not have license keysnow, you can insert

them later. See "Updating Setup Information" on page

19-3.

12. This dialog boxallows you select which site you

want to install. This screen doesnot appear the

first time you run the site setup for a starter site. If

you run it again and havemultiple sites, this dialog

boxwill appear.

13. If your server operating system accommodates

multipleWeb sites (for example,WindowsServer

2003), select the site to which you want to install

Ektron CMS400.NET from the dropdown list.

Otherwise, accept the default.
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Step Setup Screen

14. Enter the destination folder for the site.

If your Web site resides in a folder other than the

default, clickBrowse and navigate to the correct folder.

The default reflects your selection in the previous

dialog.

Warning! Do not install under another application’s

folder within theWeb root.

15. Enter the path of the Secure Asset Location.

Warning! If you plan to load balance several servers,

make sure this path is the same for all servers in the

cluster. See Also: See "Load Balancing Support" on

page 19-32

Note: Be sure the drive to which you install the asset

library has sufficient storage space plus room for

growth.
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Step Setup Screen

16. Next, theMoving Files dialog appears and the following thingshappen.

n files are copied to the site

n permissionsare set for the site’s directories

n ASPNET or IIS_WPGand IUSEare given permissions to the directories.

n the indexing catalogsare setup

n the site is set up to use .NET 3.5

n web.config settingsare configured

n IIS is configured

Setting up a Database
Your database contains information such asusers and content blocks.

The database setup program:

n checks for SQL or SQL Express server. If SQL is installed on your server, a SQL database is set up. If SQL Express is

installed, an SQL Expressdatabase is set up.

n loadsdatabase tables

n updates the web.config file with information about your database connection, based on your responses

17. You are asked if you want to set up a database.

ClickYes.

If you are using a separate database server, you need the following information

n database server host name or IP address

n if the database server is on the same domain as the application server, it must support NT or SQL authentication

n if the database server is on a separate domain from the application server, it must support SQL authentication

n youmust have database administrator or database creator privileges
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Step Setup Screen

18. Enter the name of the database you are creating.

Warning! Ektron strongly urges you to change the user name and password for the builtin user.

19. Change the builtin user’s name and password. For instructionson editing the builtin account in theWorkarea, see

"BuiltIn User" on page 19-11.
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Step Setup Screen

20. This screen prompts for database connection

information.

Server - List the database server on this system. To

setup the database on this server, accept the default.

Otherwise, enter a SQL or SQL Express server that

alreadyexists. For SQL, thiswould typically be (local) if

it’s installed on the local server. Otherwise, enter the

Server’s name. For SQL Expressenter (local)\SQL-

EXPRESS.

Username - Enter the username you will use to access the database.

Password - Enter the password you will use to access the database.

Note: If you want to use NT authentication, leave the username and password blank. Thiswill set up a trusted

connection.

After you complete the screen, the setup tests the database connection to verify the information is valid. If the database name

alreadyexists, you are asked to assign a different name. Once a connection ismade and the name is available, the installation

program createsa database using the provided information.

21. If your server hasVisualStudio.NET installed, the

following prompt appears.

22. If you want to install Ektron CMS400.NET’sSoftware Developer’sKit (SDK), clickYes. Otherwise, clickNo.

If you clickNo, skip to "The site and database setup portion of the install is complete." on page 1-31.

See Also: "Ektron’sDeveloper SDK" on page 21-481.
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Step Setup Screen

23. Choose the type of Setup for the CMS400.NET

SDK.

ClickNext.

24. Click Install to begin the installation.

25. The Setup Status screen appears.

26. When the SDK install is finished, the following

screen appears. ClickFinish.

The site and database setup portion of the install is com-

plete.
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Step Setup Screen

27. If your license key supports eCommerce, this

screen appears. To learnmore about PCI

Compliance, see the following KB article:

http://dev.ektron.com/kb_article.aspx?id=26304

28. If your license key isEnterprise-level or

Professionalwith an eSyncmodifier, this screen

appears.

For details on how to complete it, see "Managing eSync

SecurityCertificates" on page 18-43.

Set Up a User for the CMS400.NET Database
The installation automatically sets up user permissions based on data collected during setup.

However, if there is a problem setting permissions for the user, this section describes how to set

the permissions manually.

Note: If you are using SQLAuthentication, you only need to set up the SQL user. If you are usingWindows

Authentication, you need to set up IUSR and an ASPNET or IIS_WPGuser. The IIS_WPGuser is used instead of

the ASPNET user in MicrosoftWindows2003 server andMicrosoftWindowsVista.
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Step Setup Screen

1. In the SQL Enterprisemanager, select

Security > Logins.

2. Right click themouse and selectNew

Login.

3. On the Login Properties dialog, click the

button to the right of theName field.

4. Select your server.

5. From the user list select theASPNET

user or IIS_WPGand IUSR user.

6. ClickAdd thenOK.

7. On theDatabase Access tab, select

your CMS400.NET database. Then,

assign permission to read and write to

that database (as illustrated).

8. Run the grant permission script.

Note: Before doing this, review your users and their permissions. Adjust asnecessary for your

configuration. Also, if you useWindowsAuthentication and all users are domain users (and the
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Step Setup Screen

database administrator wants it thisway), youmaynot have to perform this step.

Follow these steps to do that.

n Open the SQLQueryAnalyzer.

n From the dropdown list, select the CMS400.NET database.

n ClickFile > Open.

n Open C:\Program Files\Ektron\CMS400vnn\Uti-

lities\SiteSetup\Database\cms400_permissions.sql. (nn represents the release

number)

n Within that file, replace [MACHINENAME or DOMAINNAME\USERNAME] with your domain

name, backslash (\), and ASPNET (the ASP.NET machine account). For example, [ws100-

80\ASPNET]. Note: If you are usingMicrosoftWindows2003 Server or MicrosoftWidowsVista,

the user is IIS_WPG. For example, [ws10080\IIS_WPG].

n Click the Execute Query button ( ).

n Replace the text between square bracketswith your domain name, backslash (\), and the

IIS Internet Guest Account. For example, [ws10080\IUSR_ws10080]. Click the Execute

Query button.

n If using SQL server authentication, replace the text between square bracketswith the SQL

server authentication name only. Do not include the domain name. Click the Execute Query but-

ton.

Possible Error Messages During Installation

Error
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Possible Causes and Solutions

Possible cause Suggested solution

User doesnot have

permission to create

objects

Grant user permission to create objects. For information on how to, read IIS

Security help topic “Setting NTFSPermissions for a Directory or File.”

http://localhost/iishelp/iis/htm/core/iidfpsc.htm

IIS is not installed Make sure IIS is installed on the server.

Host is not localhost Install Ektron CMS400.NET on localhost machine only.

Error

Cause and Solution
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Cause Solution

You installed Ektron CMS400.NET for .NET 2.0 but

have the 1.1 .NET framework.

Install the .NET 2.0 framework.

Or, install the version of Ektron CMS400.NET for

the 1.1 .NET framework.

Document Management Client
Install for Firefox
See "Installing FireFox Plug In" on page 7-411.

eWebEditPro+XML Client Install

Note: If you are using eWebEdit400 as the default editor, you do not need to deployanything. See Also: "Ektron

CMS400.NET Editors" on page 7-20

There are two options for deploying Ektron CMS400.NET’s editor, eWebEditPro+XML, to

client machines.

n Silently deploy the ewebeditproclient.msi file, which is installed to C:\Program

Files\Ektron\CMS400v8x\workarea\ewebeditpro\clientinstall. To do this, use this

command-line:

msiexec /i "c:\Program Files\E-

ktron\CMS400v8x\workarea\ewebeditpro\clientinstall\ewebeditproclient.msi" /qn

The command line parameters are explained on this Web page:

http://helpnet.installshield.com/robo/projects/HelpLibDevStudio9/IHelpCmdLineMSI.htm.

n Each time a user connects to Ektron CMS400.NET, his PC is checked for

eWebEditPro+XML. If an older version or no version exists, the user is prompted to

download ewebeditproclient.exe from the server’s C:\Program

Files\Ektron\CMS400v8x\workarea\ewebeditpro\clientinstall folder.
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The user clicks Install Now to install eWebEditPro+XML.

To use this procedure, the user must be authorized to install programs on his computer.

Results of Installation

File Locations
By default, the installation inserts files into two locations on the server:

n C:\Program Files\Ektron\CMS400vXX: sample and minimal databases, documentation,

utilities, site setup files (for creating additional sites)

n C:\Inetpub\wwwroot\cms400Min: bin folder, Web Services, scripts, supporting files,

uploaded files and images, graphics used in the application, CustomAPI (used to

customize Ektron CMS400.NET), etc.
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Note: The bin folder storesEktron CMS400.NET’sbinaryexecutable files. The .NET environment automatically

searches this folder when looking for .dll files.

File Permissions

During installation, the ASPNET or IIS_WPG and IUSR users are given permission to create

folders in the following directories:

n C:\Inetpub\wwwroot\[Your Site]\uploadedfiles

n C:\Inetpub\wwwroot\[Your Site]\uploadedimages

Indexing Service

The installation automatically starts the Indexing service. Ektron CMS400.NET’s search uses

this service.

If you want the Indexing service to work manually, you need to change the settings. These

steps explain how to disable Indexing of the site.

1. Navigate to Administrator Tools > Internet Information Services.

2. In the IIS window, find the Web site.

3. Right click the site and choose properties.

4. On the Directories tab, uncheck the Index this resource box.

5. Click OK.

Changes to the CMS400.NET
web.config File
See Also: "Managing the web.config File" on page 1-69

After you install Ektron CMS400.NET, the web.config file is updated as follows.

web.config setting Assigned this value by installation

ek_sitePath webroot/siteroot

ek_buildNumber current build number of Ektron CMS400.NET

ek_version current version of Ektron CMS400.NET
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web.config setting Assigned this value by installation

Connection String
Information about the how the database is

connected to Ektron CMS400.NET.

After Installation
Ektron strongly recommends configuring a secure socket layer (SSL), especially if you are

using Active Directory Integration. SSL encrypts passwords that are otherwise sent as clear text

to the Ektron CMS400.NET server. See "Configuring SSL" on page 1-94 for more information.

Setting Up an Additional Site
After installing Ektron CMS400.NET, it is easy to create another site. While creating the new

site, you can create a sample or minimal site and database. To create a site for your content,

you would typically install a minimal site and database, then create your Web page templates.

Later, you can add users and content.

Note: Because ofWindows Indexing Service limitation, your server can support eight Ektron CMS400.NETWeb

sites. If you want to installmore than 8, youmust merge the Indexing Service catalogs. This is documented See

"Merging Indexing Service Catalogs" on page 7-462.

To set up an additional site, follow these steps.

n "Step 1: Set up New Site" on page 1-39

n "Step 2: Set up New Database" on page 1-40

n "Step 3: Create Project in Visual Studio.NET" on page 1-40

Step 1: Set up New Site
1. Create a new folder in the Web root folder to contain the site files.

2. From the Windows Start menu, follow this path:

Start > Programs > Ektron > CMS400 > Utilities > SiteSetup

3. Follow the steps for creating a new site, as described in "Setting up a Site" on page 1-25.

When prompted to select a folder to which you want to install the files, choose the folder

you created in Step 1.
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Step 2: Set up New Database
After installing an Ektron CMS400.NET site, it is easy to create a new database. You can

create either a sample or minimal database. When creating a database for your content, you

typically install a minimal database.

To set up a database, follow these steps.

1. From the Windows Start menu, follow this path:

Start > Programs > Ektron > CMS400 > Utilities > SiteSetup

2. On the Setup Type screen, choose Database Setup only.

3. Follow the steps for creating a new database, as described in "Setting up a Database" on

page 1-28.

Step 3: Create Project in Visual Studio.NET
To work with the new site in Visual Studio.NET, you must create a new project for it. To do

that, follow these steps.

1. Navigate to the folder that contains the new site.

2. Double click Ektron CMS400.NET’s solution file. If you are using the minimal database,

the file is CMS400Min.sln.
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At this point, you can build the project and log in. If you cannot log in because you have not

set up the license key, use the builtin account: by default, the username is builtin and

password is builtin.

Warning! You should only use the builtin account temporarily. As soon aspossible, you should insert the license

keyand log in under a user name assigned in Ektron CMS400.NET.

To learn about creating templates and using server controls, see "Developer Topics" on page

21-1.

Moving a Site to Another Directory or
Server
Use this procedure to move an Ektron CMS400.NET Web site to a new folder or even a

different server. For example, you complete work on a site that resides on a development server

and want to move it to a production server.

Within this documentation, the original site’s folder is referred to as the source directory, and

the new site’s folder is called the destination directory. The directories can reside on the same

server or different ones.

Moving the site consists of the following major steps. Each step is described below.

n "Step1: Set up an IIS Site on the Destination Server" on page 1-42

n "Step 2: Copy Files to Destination Directory" on page 1-43

n "Step 3: Set Permissions on the New CMS Web Site" on page 1-43

n "Step 4: Make the New Directory an IIS Application" on page 1-43

n "Step 5: Back up the Database" on page 1-44

n "Step 6: Create a New Database" on page 1-45

n "Step 7: Restore the Database" on page 1-45

n "Step 8: Set Security on the Copied Database" on page 1-47

n "Step 9: Update web.config on the Destination Site" on page 1-47

Moving a Site vs. Using the eSync Feature
In addition to the Site Move procedure described below, Ektron CMS400.NET offers an eSync

feature. That feature automatically pushes new and updated site files to a production server.

eSync is especially useful when your site contains sensitive information (for example, pricing)
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that needs to be carefully reviewed for quality assurance before it goes live. For more

information, see "Synchronizing Servers Using eSync" on page 18-1.

When You Would Use the eSync feature
You'd use the eSync feature in these cases.

n Moving a site from staging to production

n Distributing a site among load-balanced servers

When You Would Use the Move Site Procedure
You'd use the Move Site procedure in cases listed below. Additional information that may help

you move your site manually can be found at http://dev.ektron.com/kb_article.aspx?id=16408

n You do not have the eSync feature.

n The initial move of a site up to a shared server (or any other server on which you cannot

run the .exe installer). Subsequently, you could use eSync if you have it.

n Moving a site to a new server. For example, you purchase a new server to replace your

existing one.

n Moving a site between two servers that are not connected by a network.

Step1: Set up an IIS Site on the Destination Server

Note: This procedure assumesyour Web server runsWindows2003 server.

1. On the destination server, go to Start > Control Panel > Administrative Tools > Internet

Information Services.

2. Click the plus sign (+) next to the computer’s name so that you can see the Web Sites

folder.

3. Right click the Web Sites folder and select New Web Site.

4. The Web Site Creation wizard walks you through the steps of creating a new Web site.

5. At the TCP Port field, make sure the IP address/host header/ port combination does not

conflict with an existing Web site. For example, if the destination server already publishes

a Web site on IP address 172.23.23.231 with host header dev.example.com on port 80,

your new site could use the same settings on port 81. The new site is accessible through

http://dev.example.com:81/.

6. When prompted for the path to the new site, create a new folder for the site in the

destination server's file system.

7. When prompted to assign permissions to the new folder, assign read and run scripts

permissions.
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Step 2: Copy Files to Destination Directory
1. In the Web root of the destination directory, create a folder with the same name as the

folder in the source directory.

Note: You do this in order to set the destination site on the sameURL path as the source site on the source

server. For example, if you the source site’s login page ishttp://localhost/MySite/login.aspxand you're

moving it to dev.example.com port 81, place the destination site at

http://dev.example.com:81/MySite/login.aspx.

Note: It is important for both sites to use the sameURL path because Ektron CMS400.NET uses root relative

pathing in links to pagesand images. Thismeans that anymanaged content item can be displayed on anypage in

theWeb site. Since the pathmaybe embedded in hyperlinksand image paths, changing the URL path on the

destination server maycause problems.

2. Copy all files in the source directory to the destination directory.

Step 3: Set Permissions on the New CMS Web Site
1. Open Windows Explorer.

2. Navigate to new Web site’s folder.

3. Right click the uploadedfiles directory, and choose Properties.

4. On the General tab of the properties dialog, ensure the Read-Only attribute is not

checked.

5. On the Security tab of the properties dialog, ensure that the IIS anonymous user (usually

named “IUSR_COMPUTERNAME”) has Write permission.

6. Right click the uploadedimages directory, and choose Properties.

7. Repeat steps 4 and 5 for the uploadedimages directory.

Step 4: Make the New Directory an IIS Application
1. Within IIS manager, right mouse click the folder created in "Step 2: Copy Files to

Destination Directory" on page 1-43.

2. Select Properties.

3. In the Application Settings area, click Create.
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4. Click OK.

Step 5: Back up the Database

Warning! Do not use SQL Server Data Transformation Services tomove the database. This feature is not com-

patible with Ektron CMS400.NET.

Ektron recommends backing up the database in the source folder then restoring the database

backup to the destination folder. This procedure is described below.

1. In the Ektron CMS400.NET source folder, open the web.config file and verify the name of

the database. The database name appears after key="ek_dbCatalog" value= .

2. On the source server, open SQL Enterprise Manager and navigate to the database you

identified in Step 1.

3. Right mouse click the database then select All tasks > Backup database.

4. Select a destination file name by clicking the Add button in the Destination area of the

SQL Server Backup screen.

Installing Ektron CMS400.NET

1-44
ReferenceManual

Version 8.0 Rev 1.3



Step 6: Create a New Database
1. On the Destination server, open SQL Enterprise Manager.

2. Expand the display until you see the Databases folder.

3. Right click the Databases folder.

4. Choose New Database....

5. Assign a name to the database.

6. The remaining options can remain as defaults, or you can be edit them as needed.

Step 7: Restore the Database
Restore the database to the new destination folder. To do this, follow these steps.

1. Right click the database you created in "Step 6: Create a New Database" on page 1-45.

2. Select All Tasks > Restore database.
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3. In the Restore as database field, verify that the database you created in Step 6 appears.

4. In the Restore section, click From device (circled above).

5. Click the Select Devices button (circled above).

6. The Choose Restore Devices screen appears. Click the Add button (circled below).

7. On the Choose Restore Destination screen (below), select File name and navigate to the

backup file you copied to the destination folder.
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8. Click OK three times. SQL copies the data to the database you created in "Step 6: Create

a New Database" on page 1-45.

Step 8: Set Security on the Copied Database
1. This procedure is described in "Set Up a User for the CMS400.NET Database" on page 1-

32. Do this for the following users.

n IUSER

n ASPNET User

Step 9: Update web.config on the Destination Site
1. Within the destination site folder, open the web.config file.

2. Update your connection string values (see example below).
<connectionStrings>
<add name="Ektron.DbConnection" providerName="System.Data.SqlClient"

connectionString="server=1ER80\SQLExpress;database=CMS400Developer;Integrated

Security=TRUE;user=;pwd=;" />
</connectionStrings>

3. Modify the following values as needed.

Web.config element How tomodify

ek_sitePath The path to the new folder, relative to the server’swebroot folder.

WSPath
The full path to the folder that stores theWeb Service URL for

Server Controls at design time.
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Upgrading Ektron CMS400.NET

Warning! If you are upgrading from a version prior to 7.6, run Ektron’sBig Int Utility on allWeb sites you want to

upgrade. If you do not run this utility, your Web site will not compile, and you receive errors related to the int (VB) or

int32 (C#) data type. See "Using the Big Int Utility" on page 1-58

Upgrading From Version 6 or higher
to Version 8.X
The upgrade procedure copies Ektron CMS400.NET’s latest features to your Web server.

CMS400.NET is installed to its own folder, CMS400v8x. This means it can coexist on the same

machine with previous versions -- the template directories are independent.

Warning! During the upgrade procedure, your Web site’sBin,Workarea and Documentation folders are

removed. Any customized files in these folderswill be lost. So, only store custom files in these folderswhen abso-

lutely necessary. Even then, you should keep a back-up file in another folder.

The Base Folder
The upgrade installs a base folder (C:\\Program Files\Ektron\CMS400v8x), which provides a

template for setting up Ektron CMS400.NET Web sites. The Site Setup utility uses the files in

the base folder to create and upgrade Ektron CMS400.NET sites.

The base folder contains the following subfolders.

Subfolder Includes

AssetManagement Folders and files for the Document Management Functionality

Bin Required .NET assemblies for Ektron CMS400.NET

CommonFiles
Location for application GlobalResources,WebReferencesand

Starter Application files.

Documentation
Documentation. The site setup procedure copies this directory to the

workareadirectorywhen setting up a site.

EktronAsyncProcessor_

Service
Files needed to add AsynchronousProcessor for Web Alerts

StarterSites Files for any starter sites that have been added.
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Subfolder Includes

StudioHelp Files necessary for adding the API help to VisualStudio 2005

Utilities

Utilities for

n database upgrade

n database application stringsupdate

n email encrypt password tool

n a setup Sharepoint Portal

n Document Management Registration tool

n Load Balancing service files

Workarea

Scripts used for theWorkarea

Note: The contents of this folder are later copied to aWeb site folder,

typically in theWeb server’sweb root. The sample providesa good

way to learn how to workwith an Ektron CMS400.NET site. An

alternative is theminimum database. Use thiswhen you understand

how to create a site and do not want to place extra, sample files on

your server.

The Upgrade Procedure
Upgrading involves the following tasks.

1. Install new files to the new directories. See Also: "Running the Installation and Setup

Program" on page 1-23

2. Remove the following folders (and their subfolder) from your site’s directory and copy the

new folders to the site directory.

n bin

n workarea

n Documentation

Warning! The upgrade procedure removes these folders. Any customized files in these folderswill be lost. So,

only store custom files in these folderswhen absolutely necessary. Even then, you should keep a back-up file in

another folder.

3. Update the web.config file with new settings.

4. Update your databases using the upgrade and language update utilities. See Also:

"Performing the Upgrade" on page 1-50

5. If needed, modify the site to use the server controls. See Also: "Updating the Server

Controls" on page 21-6.
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Note: After you upgrade Ektron CMS400.NET, youmaynotice that, for some content that inherits the following

property from their folders, the field is not checked: The content in this folder is private and can only be

viewed by authorized users and members. To resolve this problem, edit the content’s View Permissions for

Content screen andmanually check the box.

Note: Before you can check the checkbox, youmust disable inheritance. After checking the box, enable

inheritance.

Note: The upgrade automatically starts the IIS and Indexing services.

This chapter walks you through the upgrade process.

Performing the Upgrade
.

1. Follow the stepsof the installation procedure, "Running the Installation and Setup Program" on page 1-23.

These steps instruct you to install Ektron CMS400.NET and restart your server. Return to step two when

the Site Setup Selection appears.

2. The Setup wizard appears.

(If this screen doesnot appear, launch it by following

this path from theWindowsStart menu:

Start > Programs > Ektron > CMS400 > Util-
ities > Site Setup)

3. The Setup Type screen appears. Choose the

Upgrade radio button, and clickNext.
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4. Choose an application directory. If you are not

sure, use the default (C:\\Program Files\

Ektron\CMS400v8x).

This directory storesEktron CMS400.NET com-

ponents and utilities.

Warning! This dialog appears onlywhen the Setup

cannot detect where the site’s application is direc-

tory located.

5. If your server operating system accommodates

multipleWeb sites, select the site to which you

want to install Ektron CMS400.NET from the

dropdown list.

Otherwise, accept the default.

6. Select the path of theWeb site you are

upgrading.

Note that the upgrade only updates the web.config

file, Ektron CMS400.NET assembly files, andWeb

Service components. It doesnot update your tem-

plates nor other files not mentioned above.

7. Select Yes to backup your site.

Warning! Ektron strongly recommendsbacking up

your site before continuing the upgrade. If you

choose No and the upgrade fails, you will not be

able to revert the files back.
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8. If you choose to backup your site, a dialog asks

where to store the backup.

9. You are asked if you want to update your

siteroot/widgetsdirectory.

ClickYes if you want to install the latest widgets. How-

ever, if you customized widgets in that folder and not

renamed them, the customized versionswill be over-

written.

To prevent this, rename anywidgets that you cus-

tomize.

10. You are notified that files aremoving to the starter site directory.

11. The Choose Destination Location screen

appears. Enter the path to your

AssetManagement Directory.

Warning! This dialog appears onlywhen the Setup

cannot find the AssetManagement directory.

12. If you chose to do so, your site is now being backed up. Next, the bin,Workarea and other files are updated.

Anymissing permissionsor Index catalogsare added.

Warning! The previous version’s bin andWorkarea folderswill be removed from

your Web site. Any customized fileswithin these folders are lost. If possible, do not

store custom files in them unlessabsolutely necessary. Even then, you

should always keep a separate back-up file in another folder.

13. Your web.config file is updated with information needed to run Ektron CMS400.NET.

If other applicationsuse the web.config file, the upgrade doesnot affect their sections.

14. A dialog boxappears asking if you want to
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upgrade the database. SelectYes to upgrade. I

f you selectNo, the site will not work properly until the

database upgrade hasbeen run. To upgrade the

database at a later time, run the Site Setup and

selectDatabase Upgrade. The site setup is located

inStart >Programs >Ektron >CMS400vXx >Util-

ities >CMS400 Site Setup.

15. If you selected yes, the Database Upgrade

Wizard starts.

16. This screen prompts for database connection

information.

Server - List the database server on this system. To

setup the database on this server, accept the default.

Otherwise, enter a SQL or SQL Express server that

alreadyexists. For SQL, thiswould typically be

(local) if it’s installed on the local server. Otherwise,

enter the Server’s name. For SQL Expressenter

(local)\SQLEXPRESS.

Note: This dialog appears if you are using SQL

Authentication. If you are usingWindows

Authentication, skip to the next step.

17. A dialog boxappears asking you to backup your

database.

18. If you clicked Yes in the previous step, select the

location of your database backup. If this path

doesnot exist on your databasemachine, the

backup will fail.

Otherwise, skip to the next step.
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If the backup fails, the followingmessage appears.

Warning! Important: In this case, you shouldman-

ually backup your database before clickingOK. See

Also: "Backing UpDatabases" on page 1-63

19. Select whether to generate a summary for all

content blocks.

20. If it is installed, select whether to upgrade you

CMS400.NET SDK.

21. Once the SDK is installed, clickFinish on the final screens to complete the upgrade.

22. A dialog appears asking if you want to enable

PCI compliance.

SelectingYes changes the following web.config keys

to “true”.

<add key="ek_ecom_ComplianceMode"

value="false" />

<add key="UseSSL" value="false" />

Warning! Enabling compliance requires you to
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have an SSL certificate installed for your web site.

Note: This dialog only appears if you are upgrading

from version 7.6.5 or earlier and have the

eCommerceModifier (E) in your license key.

What Happens Next?
After upgrading your site and rebuilding the solution, you are ready to use Ektron

CMS400.NET.

If you did not run the database upgrade or language update during the installation, you need

to do it manually. The next sections explain how to do that.

Upgrading Your Database
If the database upgrade was unsuccessful during installation, or you chose to do it outside of

the install, you need to manually upgrade your database. Use the Database Upgrade within the

Site Setup utility to do so.

Performing the Database Upgrade

Warning! Ektron recommendsbacking up your database before performing an upgrade. For information on

backing up a database, see "Backing UpDatabases" on page 1-63.

To perform the database upgrade, follow these steps.

1. Click theWindowsStart button then follow this path: Programs >Ektron >CMS400 >Utilities >

CMS400 Site Setup. (If this path doesnot work, click the cms400sitesetup.exe file, located under the

C:\Program Files\Ektron\CMS400v8x\Utilities\SiteSetup folder.)

2. TheWelcome screen appears. ClickNext.
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3. The Setup Type screen appears. Select

CMS400 Database Setup and clickNext.

4. SelectCMS400Database Upgrade (SQL

Only!) from the Setup Type screen.

5. A dialog warns you to upgrade your site files

before you perform the database upgrade.

ClickOK.
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6. If you selected yes to the database upgrade,

the Database UpgradeWizard starts.

7. Choose an application directory. If you are not

sure, use the default (C:\\Program Files\

Ektron\CMS400v8x).

This directory storesEktron CMS400.NET com-

ponents and utilities.

8. Choose the path to your Web site’s directory.

9. The upgrade process checks the connection to your database. If it connects, continue on to the next step.

Otherwise, a connection dialog appears.

10. A dialog boxappears asking if you want to
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upgrade your database.

Warning! Important: Ektron strongly rec-

ommendsbacking up the CMSdatabase.

11. If you choose to backup your database, a

dialog appears asking you where you to store

the backup. If you chose not to upgrade,

proceed to the next step.

12. Select whether to generate a summary for all

content blocks.

13. After the your database is backed up and updated theDatabase Upgrade Complete screen appears.

ClickFinish.

Using the Big Int Utility
Warning! Only use this utility if you are upgrading from a version of Ektron CMS400.NET that precedes7.6.

The Big Int Utility changes certain references of the Data Type int (VB) or int32 (C#) to long

(VB) or int64 (C#) inside Ektron methods used in your Web site. See Also: "Why Ektron

Changed the Data Type" on page 1-59.

It is important to note that this utility might not catch all instances that need to be changed.

After running the Big Int Utility, you should precompile your Web site. Next, check for error

messages that state: during the compile process, the system cannot convert int (VB) or int32

(C#).
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If these messages appear, go to the line of code and change the data type to long (VB) or int64

(C#). For example, The Big Int Utility will not change the Return Type of a function. For

information on scenarios where the Big Int Utility does not change a data type, view the

following KB article.

http://dev.ektron.com/kb_article.aspx?id=21436

Another way to verify that all the necessary int and int32 references have been changed to

long and int64 is to run the Bad link checker located in Workarea > Reports > Contents >Bad

Link Report.

Why Ektron Changed the Data Type
In version 7.6 of Ektron CMS400.NET, Ektron changed the Data Type for its primary IDs from

int (VB) or int32 (C#) to long (VB) or int64 (C#). For example, Ektron now uses the long or

int64 data type for user IDs and content IDs.

This change was implemented to handle the larger IDs needed for eSync. See Also: "Unique

ID Numbering" on page 18-42

While Ektron made this change to accommodate eSync, the change affects all Ektron

CMS400.NET sites being upgraded to version 7.6 or higher.

Running the Big Int Utility
1. Navigate to

C:\Program Files\Ektron\CMS400v8x\Utilities\BigIntUtility

2. Double click CtrlH.exe.

3. The Big Int Utility screen appears.

4. Click the Browse button.

5. Select the site root folder and click OK.
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6. Next, click the other Browse button to select a location to store the backup.

7. Select the folder where your site will be backed up. If you want to create a new folder,

click Make New Folder.

Installing Ektron CMS400.NET

1-60
ReferenceManual

Version 8.0 Rev 1.3



8. Click the Convert button.

9. The utility goes through your Web site's files, finds references to int (VB) or int32 (C#) in

your Ektron methods, and changes them to long (VB) or int64 (C#). An int or int32 is

changed only when used inside an Ektron method.

Warning! Whenever a file is changed, a copyof the original is added to the backup directory.
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Note: Depending on the size of your Web site, the conversionmight take a while to complete.

10. Once the conversion is complete, close the utility by clicking the red X in the upper right

corner. Your site has been updated to use long (VB) or int64 (C#) instead of int (VB) or

int32 (C#) in Ektron methods.

11. Precompile your Web site.

12. After compiling, check for error messages that state: during the compile process, the system

cannot convert int (VB) or int32 (C#). If these messages appear, go to the line of code and

change the data type to long (VB) or int64 (C#).

Another way to verify that all the necessary int and int32 references have been changed to

long and int64, is to run the Bad link checker located in Workarea > Reports > Contents >

Bad Link Report.
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The Log File
A log file of the changes is located in C:\Program

Files\Ektron\CMS400v8x\Utilities\BigIntUtility. The log file's name is based on the date and

a series of numbers.

This log contains a list of files that were processed. If a file was changed, the log lists the line

number and what was changed. For example:
Line 487 - Changed 'ByVal content_id As Integer' to 'ByVal content_id As Long'.

Backing Up Databases
To protect the information in your database, Ektron recommends backing it up before

upgrading. During the upgrade, Ektron CMS400.NET attempts to create a backup of your

database. If that fails, use the following MSDN links for instructions on backing up and

restoring your database via SQL Server.

Towork with this

database version
See this MSDN article

Backup SQL Server 2008

http://msdn.microsoft.com/en-us/library/ms187510.aspx

Note: The bottom of the above page provides links to options for

restoring the backed-up database.

Backup SQL Server 2005

http://msdn.microsoft.com/en-

us/library/ms187510(SQL.90).aspx

Note: The bottom of the above page provides links to options for

restoring the backed-up database.

Warning! Before restoring an SQL database, either stop the EktronWindowsservice or force all connections

closed. You need to do this because the EktronWindowsService accesses the database. To view and update the

status of the service, go to Computer Management >Servicesand Applications>Services. For more information,

seeSee "EktronWindowsService" on page 19-13 .

Updating Application Messages
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Warning! If upgrading from version 5.0 or later, this section doesnot need to be completed.

Ektron CMS400.NET provides language support for French and German. If you are upgrading

from a previous version and are using your old database, the translated strings are not included.

Because of this, the installation includes a utility that lets you populate your old database with

the translated strings.

Prerequisites
Before using the language upgrade utility, you must upgrade your version of Ektron

CMS400.NET. For information on this, see "Performing the Upgrade" on page 1-50. During the

upgrade, if you opt to keep your previous database, proceed with this section.

Using the Language Update Utility
To use the language update utility, follow these steps.

1. Go toStart > Programs > Ektron > CMS400 > Utilities > Application Strings Update.

2. The Language Update Utility opens.
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3. Select the DSN for the database from

the drop down list.

4. Enter a username and password with permissions to the DSN if required.

5. Select the type of database you are

using. It will be updated with the

language strings.
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6. Select the action you want to perform.

n Repopulate - deletes all stringsand

repopulates the database

n Add New Strings - addsonly new

strings in the current release of Ektron

CMS400.NET. (Recommended if you

changed existing strings)

7. Select the languages that you would

like to be updated/added to the

database.

8. Click theUpdate button.

9. When the language update is

complete, the following screen

appears.
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10. ClickOK to close the window.

11. ClickClose on the LanguagesUpdate Utilitywindow.

Troubleshooting Upgrade Problems

Problem Solution

After upgrade, Ektron CMS400.NET doesnot

load properly. Also, an error icon appears next to

your templateswhen you open the project in

VisualStudio.NET, as illustrated below.

The problem is that your .NET referencesneed to

be updated.

To verify the problem, open the Ektron CMS400.NET

solution file in VisualStudio.NET

(webroot\siteroot\cms400sitename.sln; for

example, cms400Intranet.sln) and lookat the template

files.

If your referencesare broken (as shown in the sample

screen on the left), delete all Ektron references. Then, add

new referenceswith the same name from the

webroot\siteroot\bin folder.
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Problem Solution

When viewing a page containing CMS400.NET

Server controls or API calls, the page returnsa

fatal error Compiler failed with Error Code

2000.

Detailed compiler output maysayFatal error

BC2000: compiler initialization failed

unexpectedly: The filename, directory name,

or volume label syntax is incorrect.

This error messagemight appear after an

upgrade.

See Ektron Knowledge Base article “ERRMSG: Compiler

failed with Error Code 2000”

(http://dev.ektron.com/kb_article.aspx?id=2029)

After upgrading from Ektron CMS400.NET

version 4.8 or earlier, Metadata is no longer

applied or required when adding or editing

content.

In Ektron CMS400.NET version 4.8 or earlier, Metadata is

applied globally. In later versions, metadata is applied to

each folder individually. Child folders can inherit the

metadata from a parent folder or they can have their own

metadata settings.

To set themetadata settingsback to global, follow these

steps.

1. In theWorkarea, click on the site’s root folder.

2. Next, clickView>Folder Properties.

3. Click the Edit Properties button ( ).

4. Click theMetadata tab.

5. Check the all of the appropriate checkboxes for

Assigned andRequiredMetadata.

6. Click theSave button ( ).

If you have not broken inheritance on anyof the folders,

your metadata settingsare applied globally.

See Also: "AssigningMetadata to a Folder" on page 7-165
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Managing the web.config File

Ektron CMS400.NET’s web.config file lets you control many key functions of the content

management system. When you install Ektron CMS400.NET, web.config is placed into

webroot/siteroot.

This section explains the settings in the web.config file.

If your server is currently running another .NET application, you must merge that web.config

file with this one. To distinguish Ektron CMS400.NET’s tags from others, all Ektron

CMS400.NET settings begin with ek_ and reside within the <appSettings> tags of the

web.config file.

Settings in the web.config File

Setting Description

Analytics - see See "Setup Procedure for Google Analytics" on page 7-755

Connection Strings

For SQL Server

Use this connection string to define an SQL server.

n name=“Ektron.DbConnection”

n providerName=“System.Data.SqlClient”

n connectionString - this part of the connection string contains the

following element.

n server - the name of the database server to which Ektron

CMS400.NET is installed. If installed locally, the value is localhost. This

value is set during installation, at the Host screen.

n database - use the name of the database.

n Integrated Security - use True or False. True - use integrated

security.

n user - If required, specify the username used to connect to the

DSN. This user account must have at least read and write permissions to

the database.

Note: This value can be blank if you are usingWindowsauthentication.

n pwd - If required, specify the password for the username given. It

shouldmatch your database name.
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Setting Description

Note: This value can be blank if you are usingWindowsauthentication.

Warning! After changing anydatabase settings, youmust stop and

restart the EktronWindowsService. See Also: "EktronWindowsServ-

ice" on page 19-13

appSettings

ek_RedirectFromLoginKeyName

Providesamechanism to return from the login page to the previous

page, specify the query string key-name. Bydefault the value is

RedirectUrl.

Currently, the redirect works in two instances.

The first, when a user tries to use a forum but is not logged in, it sends

them to a login page and returns them. The value in this keyused in

conjunction with the ek_RedirectToLoginURL key sends the user from

a forum page to a login page and back to the previouspage. For

example, a user tries to reply to a forum post, but he is not logged in. He

is sent to the login page and then returned to the original page.

The second, when a user sendsa privatemessage to another user or

group administrator from the SocialBar server control, he is retuned to

the page where he clicked privatemessage once themessage is sent.

For example, a user visits a community group’s page and clicksPrivate

Message Admin. The user is taken to the privatemessage screen and

once he clicks post, he is returned to the community group’s page. For

additional information, see "PrivateMessaging from the Social Bar" on

page 16-222.
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Setting Description

ek_RedirectToLoginURL
The URL of the login page to automatically redirect to when a site visitor

is not logged in asa user or membership user.

GoogleMap
Enter connection information for using GoogleMapswith theMapping

feature in Ektron CMS400.NET.

VirtualEarthMap
Enter connection information for using BingMaps for Enterprise with the

Mapping feature in Ektron CMS400.NET.

ek_TreeModel

Choose whether or not to use Ajax for the folder tree in theWorkarea.

n 0 - use the legacy folder tree in theWorkarea.

n 1 - use Ajax for the folder tree in theWorkarea.

Warning! Important: This keyhasbeen removed from theWeb.co-

nfig file. However, you can still use this keybyadding it between the

<appSettings> tags. For example, <add key=”ek_TreeModel”

value=”0”> changes the folder tree in theWorkarea back to legacy.

ek_workareaDateFormat

Choose how you want to display dates in some areasof theWorkarea.

n long - for example, SaturdayMay21, 2005

n short - for example, 5/21/2005

ek_sitePath

The location of Ektron CMS400.NET relative to theWeb root. This value

is set during installation at the Site Path Directory screen.

If youmove Ektron CMS400.NET to another folder, youmust update

this value.

ek_buildNumber
This value is set by the installation program. You typicallywould not

change it.

ek_version
This value is set by the installation program. You typicallywould not

change it.

ek_appPath

This element is prefixed by the ek_sitePath value and describes the

location of the workarea folder. This file storesexternal applications

(such aseWebEditPro and eWebDiff), templates, and the images folder.

ek_xmlPath

The location of the xmlfiles directory. The ek_sitePath path is prefixed to

this location.

You would only change this value if you want to move the location of the

xml files relative to theWeb root.

ek_pluginDir not used currently -- for future use

ek_appName
The name of the application, CMS400. You typicallywould not change

this value.
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Setting Description

ek_RedirectorInstalled

Setswhether the redirector is turned on or off in the Ektron

CMS400.NET Workarea. Turning the redirector on enables the option

of aliasing the URL of your Web site. The default is false.

n True =Aliasing turned on

n False =Aliasing turned off

See Also: "URL Aliasing" on page 10-1

ek_RedirectorManualExt

Set a comma-delimited list ofWeb page extensions for which you will

want to create aliased pages. For example, “.aspx,.htm,.html,”. By

default the list contains .aspx.

NOTEYou can enter one or more extensions. Each extensionmust

begin with a period, and the last extensionmust be followed bya comma

(,).

See Also: "URL Aliasing" on page 10-1

ek_LDAPMembershipUser

Integratemembership userswith LDAPor Active Directory. Set the

value to True for Membership Users to be authenticated using

LDAP/AD.

ek_appImagePath

The folder that stores the imageswithin Ektron CMS400.NET, such as

toolbar icons. You would only change this value if you need tomove the

images folder to another location.

Note that this value is prefixed by the value set in the ek_appPath

variable. Bydefault, ek_appPath is set to

webroot/cms400Min/workarea/. So, bydefault, this folder is set to

webroot/cms400Min/workarea/images/application/.

ek_appeWebPath

The folder that storeseWebEditPro, Ektron CMS400.NET’s editor. You

would only change this value if you need tomove the editor to another

location.

Note that this value is prefixed by the value set in the ek_appeWebPath

variable. Bydefault, ek_appeWebPath is set to

webroot/CMS400Min/workarea/. So, bydefault, this folder is set to

webroot/CMS400Min/workarea/ewebeditpro.

ek_appeXSLTPath

The folder that storesXSLTs. You would only change this value if you

need tomove the XSLT folder to another location.

Note that this value is prefixed by the value set in the ek_appPath

variable. Bydefault, ek_appPath is set to

webroot/CMS400Min/workarea/. So, bydefault, this folder is set to

webroot/CMS400Min/workarea/Xslt.

Images - These imagesappear before the user signs in, so cannot be stored in the database. Update as

needed.

Their location is set in the ek_appImagePath variable. See Also: "ek_appImagePath" on page 1-72
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Setting Description

ek_Image_1
close button

ek_Image_2
small login button

ek_Image_3
big login button

SMTP server configuration - See "Configuring SMTP Settings" on page 1-85

ek_SMTPServer The server that processesemail

ek_SMTPPort The port your system uses to retrieve email

ek_SMTPUser The username set up to send and receive email

ek_SMTPPass The password set up to send and receive email

Mail Format

ek_MailFormat

The format of the email created in Ektron CMS400.NET. A value of

HTML generatesemail in HTML format, while a value of Text generates

plain text email.

SSL Support - See "Configuring SSL" on page 1-94

ek_UseSSL Determines if server will use SSL for security

ek_SSL_Port SSL port used byWeb server.

Active Directory Server Configuration

ek_ADEnabled Whether your Ektron CMS400.NET usesActive Directory support.

ek_ADAdvancedConfig Enable Active Directory advanced configuration.

ek_ADUsername User name for the Active Directory server.

ek_ADPassword Password for the Active Directory server.

ek_AUTH_Protocol

The directory accessprotocol used with the Active Directory feature.

The default value is LDAP. Other protocols are GC (global catalog) and

WINNT.

Menu Settings
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Setting Description

ek_UserMenuType

Determines the appearance of themenu that appearswithin every

content blockafter the user signs in.

n 0 - New dynamicmenu - only appearswhen user moves cursor

over content block

n 1 - Old classicmenu - alwaysappears

n 2 - Menu without borders - a silver pin head appears above content

that hasamenu available. Hovering over this pin producesamenu.

See Also: "Changing the Appearance of theWeb Site Content Menu" on

page 7-7

ek_MenuDisplayType

This setting onlyworks if ek_UserMenuType is set to zero (0).

Determines the appearance of themenu that appearswithin every

content blockafter the user signs in.

n 0 - Horizontal - menu iconsare arranged horizontally

n 1 - Vertical - menu iconsare arranged vertically and include the tool-

tip text

Multilingual Settings

ek_EnableMultilingual

Enable or disable support for multilingual content

n 1 - enable

n 0 - disable

See Also: "Enabling/Disabling Support for Multiple Language Content"

on page 14-4

ek_DefaultContentLanguage

Sets the four-digit, decimal representation of the default content

language. For example, American English is 1033.

If you have a version of Ektron CMS400.NET that precedes than 4.7, all

content blocksare set to this value during the upgrade.

See Also: "The Default Language" on page 14-7

ek_ServerURL

Mainly used inWeb services to determine the location of a remote

server.

For example, in aWeb farm environment, the content server can reside

in a remote location. In this case, the developer’s content is replaced with

this value, so all<img src=””…/>and <href…. referencespoint to

server named here instead of the local one.

Miscellaneous Settings

WSPath
Determines the location of theWeb servicespage used by the server

controls at design time.
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Setting Description

ek_BatchSize

The amount of files that can be uploaded at the same time. The default is

4, but it can be anynon negative number.

Note: Users can upload anyamount of files. The system handles them

four at a time.

ek_CacheControls

Choose whether to enable caching for Ektron CMS400.NET server

controls or not. For information, see "Caching with Server Controls" on

page 21-31

n 0 - Disable

n 1 - Enable

ek_WorkareaSearchResultMode

Sets theWorkarea search-resultsmode.

n text - returnsa text only version of the search results.

n mixed - returns text and imagesassociated with search results.

n graphical - returnsa imagesassociated with search results. See

Also: "Searching theWorkarea" on page 9-87

ek_

WorkareaLibSearchResultMode

Sets theWorkarea Library search-resultsmode.

n text - returnsa text only version of the library search results.

n mixed - returns text and imagesassociated with library search

results.

n graphical - returnsa imagesassociated with library search

results.

ek_

ShowWorkareaRetErrorReferrer

Choose whether to enable referrer debug information on the

RetError.aspxpage.

n True - enable

n False - disable

ek_QueueName Path to themessage queue.

ek_LogFileName Path to the log file name for themessage queue

ek_loginAttempts

Ektron CMS400.NET hasa login security feature that, by default, locks

out a user after five unsuccessful attempts to log in. That feature is

controlled by this element.

See Also: "Restricting Login Attempts" on page 3-9.
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Setting Description

ek_passwordCaseSensitive

Bydefault, passwordsare case insensitive. So for example, if the

password isTOKEN and the user enters token, the sign-on is successful.

If you want to make passwords case sensitive, change the value of this

element from false to true.

If you do, and the password isTOKEN and the user enters token, the

sign-on is unsuccessful. The user would have to enter TOKEN to sign

on. See Also: "Making PasswordsCase Sensitive" on page 3-12

ek_LinkManagement

This setting determines if Ektron CMS400.NET uses linkit.aspxwhen

inserting a quicklink. Bydefault, it is set to true.

If set to true, when a user inserts a quicklink, Ektron CMS400.NET

inserts a special link instead of a quicklink. A special link determines the

correct quicklink to use when a site visitor clicks it.

For example, a user addsa content block to folder A. A quicklink to that

content isa.aspx?id=10. Later, if an administrator changes the folder’s

template but doesn’t update the quicklinkwithin the content block, the

quicklink is broken.

To avoid this problem, enable linkmanagement.

ek_LoginScreenWidth

The width of the login screen in pixels. Youmayneed to widen the

screen if you are using Active Directory and the database namesare

long.

ek_ToolBarFormatTag

Note: This setting only appliesafter a user signs in to your site.

Change this setting if the colored border that surrounds content looks

wrong. (The border color indicates the content’s status.)

Bydefault, <table> tags create the border. If the border lookswrong or

inappropriate, change setting to div. If you do, <div> tagsare used to

draw the border instead of <table> tags.

This change typically solves the problem.
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Setting Description

ek_PageSize

This setting determines themaximum number of items that can appear

on a page before it “breaks.” When a page breaks, additional entries

appear on another screen, and the following text appears near the

bottom of the items list:

Page 1 of 2

[First Page] [Previous Page] [Next Page] [Last Page]

Note: The above text changesdepending on the page you are viewing.

Youmust click an option to see and update the remaining items.

This setting affects pages that let you edit the following items:

n content

n library items

n menu items

n collection items

n membership users

n membership users not verified

n forums

ek_XliffVersion
Define the XLIFF version to use when exporting files. See Also: "What is

XLIFF?" on page 14-14

ek_extensionServiceEnabled
Enable ExtensibilityPlug-in service. For more information on Plug-ins,

see Introduction.

ek_EnableDeveloperSamples

Enable the API developer sampleson the Developer demo site shipped

with CMS400.NET.

n True - enable developer samples

n False - disable developer samples

ek_assetPath

The folder that storesAssets. You would only change this value if you

need tomove the Assets folder to another location.

Note that this value is prefixed by the value set in the ek_appPath

variable. Bydefault, ek_appPath is set to webroot/CMS400Min. So, by

default, this folder is set to webroot/CMS400Min/assets.

ek_InvitationFromEmail

The “From” email address the system useswhen a user sendsan

Invitation. Invitationsare emails that are sent to non-system users asking

them to join your site. See Also: "Invite Server Control" on page 16-208
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Setting Description

ek_EnableMessageBoardEmail

Setting this key to True enables the system to send e-mail notifications

when a user posts amessage to a user or community group’smessage

board.When a user posts amessage to another user’smessage board,

the user who owns the board receivesa notification stating amessage

hasbeen posted.When a user posts amessage to a community group’s

message board, allmembers of the group receive e-mail notifications.

It is important to note that when this key is set to True, it activates e-mail

notifications for all user and communitymessage boards. However,

content message boardsare not affected. See Also: "Notifications" on

page 16-129

ek_EditControlWin

Select which editor will be used byMicrosoftWindowsoperating system

users. Choice are:

ContentDesigner - Use the eWebEdit400 editor. This editor doesnot

require an ActiveX installation on the user’s computer.

eWebEditPro - Use the eWebEditPro editor. This editor requires an

ActiveX install on the user’s computer. See Also: "Ektron CMS400.NET

Editors" on page 7-20

ek_EditControlMac

Defines the editor that is usedMacintosh operating system user. This

must beContentDesigner.

See Also: "Ektron CMS400.NET Editors" on page 7-20

system.diagnostics

LogLevel

Enter a numeric value that determines the level of message logging. By

default, diagnosticmessagesare logged in the Event Log. Choicesare:

1 =Error: log errors.

2 =Warning: log errors and warnings.

3 = Information: log errors, warningsand informationals.

4 =Verbose: Everything is logged.

ektronCommerce

ek_ecom_TestMode
When set to true, payments are sent to a test gateway instead of the

actual one.

ek_ecom_DefaultCurrencyId

Select the default currencyand enter itsNumeric ISOcode. This should

be done before creating your product catalog.

Warning! Important: Do not change the default currencyafter your

eCommerce site is live. *****

See Also: "The Default Currency" on page 17-55

ek_MeasurementSystem
Select whether to use English or Metricmeasurements for your

packages. See Also: "Packages" on page 17-87
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Setting Description

mediaSettings See Also: See "Managing Multimedia Assets" on page 7-447

WindowsMedia-CLSID The class ID for theWindowsMedia Player.

Quicktime-CLSID The class ID for the Quicktime player.

Realplayer-CLSID The class ID for the Real player.

Flash-CLSID The class ID for the Flash player.

WindowsMedia-Codebase Location of the code base plug-in for WindowsMedia Player.

Quicktime-Codebase Location of the code base plug-in for Quicktime player.

Realplayer-Codebase Location of the code base plug-in for Real player.

Flash-Codebase Location of the code base plug-in for Flash player.

application/x-shockwave-flash
Define the relationship between the Shockwave Flashmime type and

the Flash player.

audio/x-wav
Define the relationship between theWAVmime type and theWindows

Media, Quicktime and Real players.

audio/x-wav-default
Define the relationship between theWAVdefault mime type and the

WindowsMedia Player.

video/x-avi
Define the relationship between the AVImime type and theWindows

Media, Quicktime and Real players.

video/x-avi-default
Define the relationship between the AVI default mime type and the

Quicktime player.

video/x-msvideo
Define the relationship between themsvideomime type and the

WindowsMedia, Quicktime players.

video/x-msvideo-default
Define the relationship between themsvideo default mime type and the

WindowsMedia Player.

audio/x-ms-wma
Define the relationship between theMS-WMAmime type and the

WindowsMedia Player.

video/mpeg
Define the relationship between theMPEGvideomime type and the

WindowsMedia Player.
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Setting Description

audio/mpeg
Define the relationship between theMPEGaudiomime type and the

WindowsMedia Player.

video/x-realvideo
Define the relationship between the realvideomime type and the Real

player.

video/x-ms-wmv
Define the relationship between theMS-WMVmime type and the

WindowsMedia Player.

audio/x-realaudio
Define the relationship between the realaudiomime type and the Real

player.

video/quicktime
Define the relationship between the quicktimemime type and the

Quicktime player.

Miscellaneous

session state

mode - This setting determines the storage option for session data.

CMS400.NET only supportsInProc. Other session statemodesare not

supported.

HttpHandlers

This section sets how the URL Aliasing feature handlesURLswith

certain extensions. If you have anyextension you do not want aliased,

add it below the following line using the same syntax.

add verb="*" path="*.png" type="URLRewrite.StaticFileHandler,

Ektron.Cms.URLRewriter" />

maxRequestLength

This setting determines themaximum size of files that can be uploaded

to your server. The default setting is 204,800 kilobytes, or 200MB.

Enter the desired value in kilobytes. To convert megabytes to kilobytes,

go to http://www.onlineconversion.com/computer.htm.
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email Features

email features are explained through the following topics.

n "Configuring E-Mail for Tasks and Content" on page 1-81

n "Automatic eMail Notification" on page 1-86

n "Customizing Ektron CMS400.NET email" on page 1-87

n "Instant eMail" on page 1-91

Configuring E-Mail for Tasks and
Content
An email is sent to notify users when a task (such as approving a content block or submitting

a form) was performed or needs to be performed. This section explains the steps needed to use

Microsoft’s SMTP service to enable this kind of e-mail notification in Ektron CMS400.NET.

To learn about email notification for Web Alerts, see "Web Alert Feature" on page 20-1.

CDOSYS
To process email, Ektron CMS400.NET uses the CDOSYS model. Using the Simple Mail

Transport Protocol (SMTP) and the Network News Transfer Protocol (NNTP) standards,

CDOSYS enables applications based on Windows XP, Windows 2000 or Windows 2003 to

route e-mail and USENET-style news posts across multiple platforms.

CDOSYS, the successor to CDONTS, is as easy to use as CDONTS but is more powerful by

letting authors create and view sophisticated emails using html and data sources.

Note: If the SMTP server that is processing email doesnot find CDOSYS installed, it tries to use CDONTSasa

mail server protocol.

Set up SMTP Server
For CDOSYS to work, set up the SMTP server on your local system (to which you installed

Ektron CMS400.NET) or a remote system that sends and receives email.

Note: To accessan SMTP server on a local or remote system, consult the system administrator whomanages

email in your organization. This administrator maynot be the same as the Ektron CMS400.NET administrator.
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n Local - Before setting up an SMTP server on your local system, install IIS. The SMTP

server settings on a local system would be something like this:
“ek_SMTPServer" value=“localhost”
“ek_SMTPServer" value=“127.0.0.1”
“ek_SMTPServer" value=“myname”

n Remote - Set up an SMTP server on a remote system. The SMTP server on a remote system

can be something like this:
“ek_SMTPServer" value= “smtp.example.com”
“ek_SMTPServer" value= “example.com”

After the SMTP server is set up, configure it as described in "Verification for Relay" on page 1-

82.

Verification for Relay
To verify that your Ektron CMS400.NET Web server’s IP address supports relay through your

SMTP server, follow these steps.

Note: TheWWWand SMTPcomponentsof IISmust be installed on theWeb server to which Ektron

CMS400.NET is installed.

1. On your SMTP server, access your Internet Services Manager in the Administrative Tools.

2. In the IIS Management Console, select the SMTP virtual server.

3. On the Action menu, click Properties.
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4. The SMTP properties window opens.

5. Click the Access tab.

6. The access properties appear.
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7. In the Relay Restrictions section, click the Relay... button.

8. The Relay Restrictions window opens. Set or remove relay restrictions.
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Note: For more information, see “Setting or Removing RelayRestrictions from a VirtualServer” from thisWeb

page: <http://www.microsoft.com/WINDOWS2000/en/professional/help/moc04_57.htm>

Configuring SMTP Settings
Next, configure Ektron CMS400.NET to use SMTP.

1. Open the web.config file. (See "Managing the web.config File" on page 1-69.)

2. Move to the section of the file that has these settings.
<!-- SMTP Server configuration -->
<add key="ek_SMTPServer" value="localhost" />
<add key="ek_SMTPPort" value="25" />
<add key="ek_SMTPUser" value="" />
<add key="ek_SMTPPass" value="" />

3. Set the ek_SMTPServer value. See "Set up SMTP Server" on page 1-81.

4. Set the ek_SMTPPort value to the port your system will access to retrieve email. In most

cases, the port is set to 25. If that is not the case, see your System Administrator.

5. Set the ek_SMTPUser value to the username that is set up for the SMTP Server to send and

receive email. Typically, the username takes the form of an email address, such as “ek_

SMTPUser“ value=“yourname@example.com“.

This retrieval of email is based on how basic authentication is set up for you, though you do

not need a username when using a local SMTP server. Check with your System Administrator

for details.

If you are using a remote system for accessing email, you must provide an authenticated user-

name before you can send or receive email.

6. Set the "ek_SMTPPass" value to the password that is set up for the SMTP server to
send and receive email. This password is based on the basic authentication. By
default, the Ektron CMS400.NET only accepts passwords in the encrypted form.

To encrypt the password, Ektron provides a password encrypting tool. See "The Encrypt

Password Utility " on page 1-85.

The Encrypt Password Utility
To use the utility tool EncryptEmailPassword.exe, follow these steps.

1. Open C:\Program Files\Ektron\CMS400\Utilities

2. Run EncryptEmailPassword.exe.

3. The Encrypt Utility dialog appears.
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4. Enter your SMTP password in the Text field.

5. Click the Encrypt button.

6. The screen displays an encrypted password in the Encrypted field.

7. Copy the encrypted password and paste it into the web.config file after "ek_SMTPPass"

value=.

Error Messages

When submitting a form or a content block in an approval process, if you get an error message

listed below, it is generated by the SMTP server on which you set up the mail system, not by

Ektron CMS400.NET.

n The Transport failed to connect to the server. [CBR SendMail R1] [CBR R65]

[DIO R 36]

n The server rejected one or more recipient addresses. The server response was:

550 5.7.1 Unable to replay for yourname@example.com [CBR SendMail R1]
[CBR R1] [DIO R36]

.

Automatic eMail Notification
Ektron CMS400.NET has an automated email system that sends emails to the proper users

when an action has been, or needs to be, performed. Emails are generated when any of the

following actions takes place.
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email sent to When content is

Next approver Submitted to be published

Next approver Submitted to be deleted

Author Published toWeb site

Author Declined to be published or deleted

In order for users to be notified of these actions, the following criteria must be met:

n Valid system email address

n Enabled email notification

n User email address

n User email notification enabled

These values are set in the Edit User screen. See Also: "Managing Users" on page 15-3

The Tasks feature also has automatic email notification. For more information, see "Task Email

Notification" on page 11-40.

Content of Automatic email

The automatic emails are stored in and received from the database. Each email consists of one

string for the subject and one for the body. Ektron CMS400.NET does not currently support

HTML emails, but the messages are fully customizable. For more information, see

"Customizing Ektron CMS400.NET email" on page 1-87.

Customizing Ektron CMS400.NET
email
Ektron CMS400.NET can send email notification to users, informing them that actions have

either taken place or are requested of them. For example, a content contributor receives an

email that his content has been published to the Web site.

These emails are stored in the resource files. In that file, each email consists of one string for

the subject and one for the body. Ektron CMS400.NET does not support HTML email,

however the message text is fully customizable.
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The procedure for customizing resource files is documented in "Procedure for Translating

Workarea Strings" on page 14-41.

The body of an email can include variables, located between @ symbols. Ektron CMS400.NET

replaces these variables with the information for that instance of the email. For example,

@appContentTitle@ in the following sentence is replaced with the email’s title.

Before The content “@appContentTitle@” hasbeen deleted.

After The content “Home Page Content” hasbeen deleted.

These emails can be customized. The variables can be taken out or moved around. More text

can be added; text can be rewritten or reorganized.

Before “@appContentTitle@” hasbeen deleted from the XYZWeb site.

After “About Us” hasbeen deleted from the XYZWeb site.

Each message is called in the presentation layer by its message title.

Carriage Return/Line Feeds are represented by the variable @appCRLF@. These cause the

email to move down one line. For example:

Before The content wasapproved.@appCRLF@Thank you!

After
The content wasapproved.

Thank you!

Variables
The following table lists variables you can use to customize email messages. When the email is

sent, the corresponding description replaces the variable.

Variable Inserts

@appCRLF@ Acarriage return.

@appContentTitle@ The title of the content block.

@appDeletionDateTime@ The date and time the content will be deleted from theWeb site.

@appChangeDateTime@ The date and time changeswill be updated on theWeb site.
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Variable Inserts

@appDeclinerFirstName@ The first name of the user who declined the content block.

@appDeclinerLastName@ The last name of the user who declined the content block.

@appSubmitterFirstName@ The first name of the user who submitted the content block.

@appSubmitterLastName@ The last name of the user who submitted the content block.

@appFolderPath@
The location of the content block in the folder tree in the Ektron

CMS400.NET Workarea.

@appContentLink@
The link to the content blockon theWeb site.

Note: Youmust be logged in to see the changes.

@appSubmitterDateTime@ The date and time the content blockwassubmitted.

@appApprovalList@
The current approval list that the content blockmust pass

through.

@appComment@ Displays the comments for the content block.

@appPassword@
Displays the account password for ResetPassword and

RequestResetPasswordmessage types.

@appEmailFrom@ The addressof the email sender.

@appEmailTo@ The addressof the email receiver.

List of Ektron CMS400.NET Default email

Notify Approval Process Complete
Because of the logic, there are four emails for notifying that the approval process is complete.

Deletion of ContentApproved

Message Title: email subject: content deletion approved.

Message Text: Deletion of content has been approved.

Immediate Deletion of Content

Message Title: email subject: content has been deleted.

Message Text: Content has been deleted.
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ApprovedContentAwaiting Go Live Date

Message Title: email subject: content changes approved.

Message Text: Content changes have been approved.

ApprovedContentPublished Immediately

Message Title: email subject: content has been changed.

Message Text: Content changes have been made.

Decline Approval Request
Message Title: email subject: approval request declined.

Message Text: Content approval request declined.

Send Approval Message
Message Title: email subject: request for approval.

Message Text: Request for content approval.

Variables
The following table lists variables you can use to customize email messages. When the email is

sent, the corresponding description replaces the variable.

Variable Inserts

@appCRLF@ A carriage return.

@appContentTitle@ The title of the content block.

@appDeletionDateTime@
The date and time the content will be deleted from theWeb

site.

@appChangeDateTime@
The date and time changeswill be updated on theWeb

site.

@appDeclinerFirstName@ The first name of the user who declined the content block.
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Variable Inserts

@appDeclinerLastName@ The last name of the user who declined the content block.

@appSubmitterFirstName@ The first name of the user who submitted the content block.

@appSubmitterLastName@ The last name of the user who submitted the content block.

@appFolderPath@
The location of the content block in the folder tree in the

Ektron CMS400.NET Workarea.

@appContentLink@
The link to the content blockon theWeb site.

Note: Youmust be logged in to see the changes.

@appSubmitterDateTime@ The date and time the content blockwassubmitted.

@appApprovalList@
The current approval list that the content blockmust pass

through.

@AppComment@ Displays the comments for the content block.

(continued in List of Default email)

Instant eMail
In addition to automatic email, Ektron CMS400.NET lets you send email instantly to a user or

user group from many screens. Your ability to send instant mail is indicated by either

n a small mail icon next to a user or group name, as indicated in red below

n a small mail icon on the toolbar (see second image below)
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When you click one or more user/group names then the email icon, the email screen appears, as

shown below. Once you complete the screen and click Send, an email is sent to designated

users.

Condition for Instant eMail

n The email software must be configured for your server. See "Configuring E-Mail for Tasks

and Content" on page 1-81

Where Instant email is Available

Instant email is available from several screens that display users and user groups. Typically,

you click a user name or the email icon to launch an email. Screens in the following Ektron

CMS400.NET features support instant email.

n Smart Desktop

n Tasks

n Approvals

n Reports

Installing Ektron CMS400.NET

1-92
ReferenceManual

Version 8.0 Rev 1.3



Wherever instant email is available, an email icon appears (circled in the illustration below).

Modifying Instant eMail

When the email screen appears, the following information is copied from Ektron CMS400.NET

into the email.

Field Source of Default Information Editable?

To

User you selected to receive the email. If the user doesnot

have valid email address, an error message appears. If you

then insert a valid email address, the email is sent.

If you specify a group to receive themessage, as long as

one groupmember hasa valid email address, all group

memberswith valid addresses receive the email.

Yes.

If desired, you can

add recipients by

typing them into this

field.

From User who signed on to Ektron CMS400.NET. No

Subject
If the emailmessage is linked to content, its title appears.

Yes

Bodyof

message

If the emailmessage is linked to content, a link to the content

appears.
Yes
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Configuring SSL

In Ektron CMS400.NET, you can use SSL when users log in to your Web site. SSL encrypts

the username and password during transmissions to the server.

When you set up the SSL certificate, and configure Ektron CMS400.NET to use it, the login

page is launched in a Secure Socket Layer. This section explains how to set up SSL for Ektron

CMS400.NET.

Setting Up the Certificate
If your Web server does not have a certificate installed, you need to install one. To do so,

follow these steps.

1. Access the Internet Information Server Administrator Console on your Web server.

2. Navigate to the computer and Web site to which Ektron CMS400.NET is installed.

3. Right click on the Web site.

4. Click Properties.

5. Click the Directory Security tab.
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6. In the Secure communications area, click the Server Certificate button.

7. Use the wizard to set up a certificate for your Web site.

8. Close the wizard. You return to the Properties window.
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9. Click the Web Site tab at the top of the Properties window.

10. Set the SSL Port that the Web server will use.

11. Click OK.

Updating the web.config File
Next, configure Ektron CMS400.NET to use the SSL certificate.

1. Open the web.config file. (See ”Managing the web.config File” on page 1-95.)

2. Move to the section of the file that has these settings.***

<add key="ek_UseSSL" value="false" />
<add key="ek_SSL_Port" value="443" />

3. Set the ek_UseSSL value to true.

Warning! If the ek_UseSSL value is true, but you did not install the certificate to theWeb Server, you cannot log

into Ektron CMS400.NET.
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4. Set the ek_SSL_Port value to 443 (unless you specified another SSL port).

5. Save and close the file.

You are ready to use the SSL support for Ektron CMS400.NET.
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Migrating Your Site to Ektron
CMS400.NET

This chapter explains how to migrate your Web site to Ektron CMS400.NET. This chapter

explains

n What to copy to your Web site

n Setting up and deploying templates

This chapter assumes you installed Ektron CMS400.NET and have read the Ektron

CMS400.NET documentation, so that you have an understanding of basic concepts, some of

which are mentioned here.

Initial Steps
The following section describes tasks you need to perform before migrating your Web site.

Installation
Ektron CMS400.NET requires a physical installation of the product. If you do not have

physical access to the machine, someone with access to the machine must run the install.

Note: For more information, see Installing .

Verify Installation
After you install Ektron CMS400.NET, verify that it is properly installed by using the starter

site. By default, the sample Web site is located at the following address on the machine to

which Ektron CMS400.NET is installed.

http://localhost/siteroot/default.aspx

If you can browse the starter site and it works properly, Ektron CMS400.NET is properly

installed.

Best Practices

Ektron recommends keeping a working version of the starter site. This

can be used to help you debug problems.
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For instance, if you encounter errors on your site, you can refer to the

starter site to see if the same errors occur. If they do, that may indicate

a problem with the installation. If they do not, the installation is

probably OK and an external factor is causing the problem.

Setting up Your New Site

Note: You can use the Site Setup utility to perform these tasks. To launch this utility, go to Start > Programs >

Ektron > CMS400 > Utilities > Site Setup. To read about it, go to "Setting up a Site" on page 1-25.

Copy Application Core Files
Copy the application core files from the siteroot/workarea folder into your site’s folder. These

files operate the workarea, library, and content functions.

Set up the Database
Since the content is stored in a database, you need to create one. To learn how to set up a

database, see "Setting up a Database" on page 1-28.

Modify Application Parameters
After you install and create the Ektron CMS400.NET database, modify the web.config file that

installed to the directory to which you installed Ektron CMS400.NET.

Edit that file and modify the following settings

Setting Type in...

ConnectionString

Update the information between the <Con-

nectionString> tags to point to your:

n server

n database

n user

n pwd
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Note: If you are using SSL, the settings you need tomodify are explained in "Configuring SSL" on page
1-94.

Creating a Login Page
Now that everything is set up, you can create a login page. You can either copy the one from

the starter site or create your own.

See Also: "Login Server Control" on page 3-6

Log In
To log into your Ektron CMS400.NET Web site, follow these steps.

1. Browse to the login page you created and click the Login button.

2. A login dialog box opens asking for a username and password.

3. Enter the default username (admin) and password (admin) and click Login.

4. You are logged into Ektron CMS400.NET

Note: If you get amessage that the application is locked, log in using the username and password builtin/builtin.

You get themessage if your license key is invalid or hasnot been entered yet.

Modifying Configuration Settings
After you log in, access the Workarea by clicking on the Workarea button. From there, you can

modify the configuration settings.

Set up Active Directory
If plan to use Active Directory, configure this now. The settings for Active Directory can be

found in the Settings > Configuration folder. Refer to "Active Directory Feature" on page 15-

48.

Modify the Setup Screen
The Ektron CMS400.NET setup section is located under the Settings > Configuration folder.

The setup section allows you to configure items such as your license key, style sheet support,

max summary size, and default language.

See "Administering Ektron CMS400.NET" on page 19-1.
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Set up Metadata
Ektron CMS400.NET includes extensive metadata support. Settings for metadata definitions

can be found under the Settings > Configuration folder in the Workarea. You can have as

many metadata definitions as needed.

See See "Working with Metadata" on page 7-146 for more information.

Set up Smart Forms
You can also set up your Smart Forms. You create XML files externally or via the Data

Designer. Next, a Smart Form is assigned to content blocks and folders.

See "Working with Smart Forms" on page 7-288 for additional information.

Creating Ektron CMS400.NET Users
If you are not using Active Directory support, add your users manually. The maximum number

of users is determined by your license key. For instance, if you purchase a 10-user license, you

can enter 10 users.

Note: If you exceed the licensed number of users, youmayget locked out of Ektron CMS400.NET.

Every user must belong to a group. When you first add a user, he or she is automatically added

to the Everyone group. You can create more user groups and add users to them as desired.

For more information, see "Managing Users and User Groups" on page 15-1.

Configuring Content and Forms
Folders
Next, create folders to organize content blocks and forms. Create as many folders as you want.

Each folder level can go as deep as you want.

Best Practices

Keep your folder structure simple so it’s easy for your users to

navigate. Organize folders in a way that makes sense to the users

who will navigate through them. So, you may have 6 or so top level
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folders, and each folder may go 4 or so deep.

This folder structure is replicated under the Library folder.

As you create folders, you can assign a default template and style sheet. The default template is

used when a new content block is created and Ektron CMS400.NET creates a Quicklink that

points to the new content block. If you do not provide a default template, it is inherited from

the parent folder.

After creating the folders, assign permissions and workflow to them. Permissions can be

assigned to a user or a user group. The same is true for the approval process.

Best Practices

Limit permissions for the “Everyone” group, as this gives every user

permissions to that content. Similarly, you should limit the “Everyone”

group’s inclusion in the approval chain if you want to restrict which

users can publish content.

Creating your Templates
Now you can create your templates. Templates contain the look and feel of the site. Masthead,

navigation, and footer graphics are all part of the template. Use server controls to insert Ektron

CMS400.NET content into a template. For a list of server controls, see "Developer Topics" on

page 21-1.

Best Practices

Since dynamic templates include URL parameters, make each main

landing page and other important pages static tags. This makes it

easier for you to remember if you need to provide that link to

someone.

For instance, each main landing page from your home page could

use the static tag. Then, as you go deeper into that section,

subsequent pages use a dynamic tag.

Migrating/Creating Content
At this point, you can begin to create/migrate your content. If you are migrating content from

an existing site, add a new content block, and cut and paste the content into the Ektron

CMS400.NET editor.
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Note: All imagesand filesmust be uploaded and inserted into the content separately.

Deployment
Deployment from development to production is as simple as moving the files over. To properly

deploy your new Ektron CMS400.NET Web site, following these steps.

1. Copy all assets (templates, images, files, etc.) from your development box to your

production machine.

2. Move the database. You have two choices

n point your data source on the production machine to the database you were using

n copy the database, move it to your production box, and point a data source to that

Advanced Features
The previous information allows you to create a basic Ektron CMS400.NET Web site from

scratch. This section explains some advanced features that you may implement, although they

are not needed for the Web site to function properly.

Email Notification
For email notification to work in Ektron CMS400.NET, make sure the SMTP service is setup

and running in IIS, and that it points to a valid mail server.

Refer to "Configuring E-Mail for Tasks and Content" on page 1-81 for additional information.
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Creating a Web Site in IIS

Note: This text is adapted fromMicrosoft’s IIS help.

Adding Web Sites to Your Server

IIS lets you create multiple Web sites on a single server. To create a new Web site, you must

n prepare the server and associated network services

n create a unique identity for the site

See Also:

n "Preparing to Add a Web Site" on page 1-104

n "Adding a Web Site" on page 1-105

n "Related Topics" on page 1-110

Preparing to Add a Web Site
Adding a Web site to a server requires careful preparation before running the Web Site

Creation Wizard. Consider these recommendations.

n Review the methods of hosting multiple Web sites, and determine which one is

appropriate for your environment.

n Multiple Web sites can use the same IP address. But if you decide to use a unique IP

address for the new Web site, obtain a static IP address from your organization or ISP.

Then, configure the server’s TCP/IP settings.

n If you use a host header name to identify the new Web site, select a unique name. On a

private network, the host header can be an intranet site name. But on the Internet, the host

header must be a publicly available Domain Name System (DNS) name, such as

support.microsoft.com. Register a public DNS name with an authorized Internet name

authority.

n Update your name resolution system (typically DNS) with a new record that contains the

new IP address and site name. For more information, see Domain Name Resolution in IIS

help.

n Standard Internet services use TCP port 80 by default. It is not recommended to use any

other port for HTTP services.
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If you use a non-standard TCP port number to identify a new Web site for special situations

(such as a private Web site for development/testing), select a TCP port number above 1023. In

this way, the number does not conflict with well-known port numbers assigned by the Internet

Assigned Numbers Authority.

n Use Windows Explorer to create a home directory for the content. Create subdirectories to

store HTML pages, image files, and other content as needed.

To organize home directories for multiple Web sites on one server, create a top-level directory

for all home directories, then subdirectories for each site.

You can create a home directory

- on the local server

- as a uniform naming convention (UNC) path on a network share

- as a URL that redirects clients to a different Web server

You can also create virtual directories that map to physical directories. For more information,

see “Setting Home Directories” and “Using Virtual Directories” in IIS help.

n Determine whether to generate the Web site’s identification number incrementally or from

the Web site name. When you create a new site using IIS 6.0, a Web site identification

number is randomly generated using the Web site name.

With IIS 5.1 and previous versions, site identification numbers were generated incrementally.

For example, because the default Web site is created first, its Web site identification number is

1. The next site created is 2. For more information, see “DisableLazyContentPropagation in

Global Registry Entries” in IIS help.

n Create a home page that clearly identifies the new site.

Adding a Web Site
IIS provides two methods for adding a new Web site.

n The Web Site Creation Wizard

n The iisweb.vbs command-line script

Warning! Youmust be amember of the Administrators group on the local computer to perform the following pro-

cedure (or procedures), or youmust have been delegated the appropriate authority. Asa security best practice,

log on to your computer using an account that is not in the Administrators group, and then use the Run as com-

mand to run IISManager asan administrator. From the command prompt, type runas /user:administrative_

accountname "mmc%systemroot%\system32\inetsrv\iis.msc".
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Adding a Web site with the Web Site Creation Wizard
1. In IIS Manager, expand the local computer, right-click the Web Sites directory, point to

New, and click Web Site.

2. Click Next.
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3. In the Description box, enter the name of the Web site and click Next.

4. In the Enter the IP address to use for this Web site box, click All Unassigned to allow

HTTP to respond to all unassigned IP addresses on the server, or click a specific IP address

for the site.

Note: In theWeb Site CreationWizard,All Unassigned refers to IP addressesassigned to a computer but not a

specific site. The defaultWeb site usesall IP addressesnot assigned to other sites. Only one site can be set to use

unassigned IP addresses for a given port number. For more information on how sitesare identified, see Creating

Multiple FTPSites in IIS help.
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5. The TCP port is assigned to port 80 by default. To use a nonstandard port number to create

a unique identity for a private Web site, use the TCP port this Web site should use box,

and type a new port number above 1023.

6. In the Host Header for this Web site (Default:None) box, type a host header name to

identify a Web site. If you are adding additional sites to a single IP address by using host

headers, you must assign a host header name containing the full name of the site, for

example, www.ektron.com.

7. If SSL encryption is enabled on the server, the SSL port box appears. Type the SSL port

number, and then click Next.

8. In the Path box, type or browse to the path of your Web site home directory.

9. Web sites are configured for anonymous access by default. To create a secure or private

Web site, clear the Allow anonymous access to this Web site check box, and click Next.
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10. In the Web Site Access Permissions dialog box, select the permissions for the home

directory. Click Next, and then click Finish.

To add a Web site with the iisweb.vbs command-line
script
If the new Web site will be in a new directory, create the new directory. Follow these steps to

do that.

1. From the Start menu, and click Run.

2. In the Open box, type cmd, and click OK.

3. From the command prompt, switch to the systemroot\system32 directory.

4. Type cscript iisweb.vbs /create Home DirectorySite Description" /i IP Address /b

Port and click <Enter>.

For example, the following command creates a Web site called MyWebSite on port 80 at IP

address 123.456.789 with c:\inetpub\wwwroot\newdirectory as its home directory.

cscript iisweb.vbs /create c:\inetpub\wwwroot\newdirectory "MyWebSite" /i 123.456.789 /b 80

Note: The iisweb.vbsscript supports additional options for creating aWeb site. To see them, search for

iisweb.vbs inWindowsHelp.
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Related Topics
The following IIS help topics provide additional information.

To change properties on existing Web or FTP sites, see “Changing Default Web Site Settings.”

To add virtual directories, see “Using Virtual Directories.”

To perform common tasks from command-line scripts, see “Using Command-Line

Administration Scripts.”
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Using Ektron CMS400.NET to manage Web content is easy once you know the basics of

setting up and maintaining your site. This documentation explains how to maintain an Ektron

CMS400.NET site. By reading this documentation, you will gain an understanding of how

Ektron CMS400.NET works.

This section introduces basic concepts that you should understand when beginning to work

with Ektron CMS400.NET through the following subtopics.

n "About Ektron CMS400.NET" on page 2-2

n "What is a Content Block?" on page 2-2

n "Types of Content" on page 2-3

n Workflow in

n "Editing Content" on page 2-5

n "The Lifecycle of Content" on page 2-5

About Ektron CMS400.NET
Ektron CMS400.NET is a powerful, easy-to-use, and affordable XML content management

solution that empowers anyone to take an active role in managing Web content and optimizing

online strategies. It streamlines site management, automates workflow processes, and supports

collaboration. Ektron CMS400.NET reduces costs, saves time and makes Web sites, extranets,

and intranets more effective – while generating rapid ROI.

Business users, like marketing or PR pros, can author, manage and publish Web content, build

and deploy Web forms, and collect and leverage visitor info. Our browser-based editor supports

the industry’s best in-context editing environment – ensuring user adoption and project

success.

Ektron CMS400.NET also helps to move paper-based forms processes to the Web. Our editor

lets users create Web forms such as expense reports, health records, and insurance forms, deploy

them to internal users, collect data, apply validation and math functions, and run forms through

workflow – all within a browser.

What is a Content Block?
A Web site consists of several pages. Each page is made up of one or more blocks of content.

For example, the home page from one of Ektron CMS400.NET’s sample sites is below.

Introduction to Ektron CMS400.NET

2-2
ReferenceManual

Version 8.0 Rev 1.3

../../../../../manuals/Documentation/CMS400/Source/Reference/flare/ReferenceManual/Content/Main_Import_file/introduction workflow.htm#introduction_workflow_2156156523_1131621
../../../../../manuals/Documentation/CMS400/Source/Reference/flare/ReferenceManual/Content/Main_Import_file/introduction workflow.htm#introduction_workflow_2156156523_1131621


You can work with content from the Web site or after logging into the Ektron CMS400.NET

Workarea. See Also:

n "Working with Content From Workarea vs. Web Site" on page 7-3

n "The Workarea and Smart Desktop" on page 4-1

Types of Content
Every piece of content in Ektron CMS400.NET is one of the following types. The table below

summarizes all types.

Type Description

For more

information,

see

HTML content
Content designed to be published on theWorld

WideWeb

"Ektron

CMS400.NET

Editors" on

page 7-20

XMLSmart Forms

Online forms, polls, or surveysdesigned to collect

information from site visitors and save it in an

XML format

"Working with

Smart Forms"

on page 7-288

HTML form/survey

Online forms, polls, or surveysdesigned to collect

information from site visitors and save it in an

HTML format

"Working with

HTML Forms"

on page 7-220

DMSDocuments, which

consist of Office
See details below
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Type Description

For more

information,

see

documents, managed

files, andmultimedia files

Office documents
Files normally created and edited usingMicrosoft

Office

"Working with

Microsoft

Office

Documents"

on page 7-413

Managed files

Files created outside of Ektron CMS400.NET,

such asPDFsand .jpeg files. You cannot create

or edit these fileswithin Ektron CMS400.NET -

you can only store them.

"Working with

Managed

Files" on page

7-435

Multimedia
Files that run in amedia player, such as sound

andmovie files

"Managing

Multimedia

Assets" on

page 7-447

When creating new content, you must assign a type.

As you can see, the New menu lists all types of content you can work with.
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Editing Content
Click the Edit button ( ) or menu option to open content in an editor. Below is an example
of content within the editor.

The editor resembles popular word processing software. You can enter text, then select it and

click a button to change its display properties. For example, you can make text bold, change

the color, or copy and paste it. You can also insert images, tables, links to other Web pages,

and check spelling. See Also: "Ektron CMS400.NET Editors" on page 7-20

The Lifecycle of Content
After you edit content, you typically submit it for approval to one or more individuals who

oversee changes to your Web site. These people can review, edit and approve the change.

When the last approver signs off, the new content becomes available on the Web site.

In some cases, you are one of the content approvers. In this case, you receive an email

notifying you that content needs approval. You look it over, change it as needed, then pass it

on to the next approver. If you do not agree with the changes, you can decline the request. In

this case, the user who made the edits is informed that the change is not approved.

The following graphic illustrates the content approval cycle.
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To help track content’s position in this workflow, Ektron CMS400.NET assigns a status to

each content item. The status determines what you can do with it, and indicates what must

occur in order for it to get published to the Web site. For more information, see "Content

Statuses" on page 7-133.

Introduction to Ektron CMS400.NET

2-6
ReferenceManual

Version 8.0 Rev 1.3



Chapter 3

Logging In and Out

ReferenceManual
Version 8.0 Rev 1.3

3-1



This section explains how to log in and out of Ektron CMS400.NET, use the Site Preview

feature, and password/login management through the following subtopics.

n "Prerequisites" on page 3-2

n "Logging into an Ektron CMS400.NET Web Site" on page 3-2

n "Site Preview" on page 3-4

n "Logging Out of the Sample Site" on page 3-5

n "Restricting Login Attempts" on page 3-9

n "Password Management" on page 3-12

Prerequisites
Once your Webmaster or administrator installs Ektron CMS400.NET, you need the following

items before you can use it.

n URL (Web address) of Ektron CMS400.NET Web site

n Username and password

Once you acquire both, you can log into Ektron CMS400.NET and begin managing Web site

content.

.

Logging into an Ektron CMS400.NET
Web Site
To sign on to an Ektron CMS400.NET site, follow these steps.

1. In your Web browser, navigate to the URL of your Ektron CMS400.NET Web site. Your

system administrator provides this.

2. Click the Login button on the screen.

3. The Login dialog box appears.
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4. Enter your username and password.

If you are using one of Ektron’s sample sites, you can use any of three standard users that

demonstrate Ektron’s flexible user-permissions model. The table below lists the username and

password needed to log in as each user type, as well as the permissions assigned to each user.

User Type Username Password Permissions

Administrator admin admin All

Standard

user
jedit jedit

Basic (for example, add/edit content, manage

library files, etc.)

Membership

user
jmember jmember Read-only permission to private content

5. Click the Login button.

6. The Web page appears.

You can navigate around your Web site as you could before signing in. But now, the content

is either surrounded by a border or has a Silver Access Point in the top left corner (illustrated

below).
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For more information, see "Web Site Content Menu Options" on page 7-4.

Site Preview
While logged into Ektron CMS400.NET, you can preview the Web site as it would appear to

visitors, or view it in regular view.

Button

Appearance
Status Description

Preview

Mode

Content appears as last edited. The advantage of thismode is that

you can see aWeb page as it will appear when published to your

site. Continue editing until you are satisfied with its appearance.

In Preview mode, click thePreview button to switch to regular

mode.

Regular

View

Themost recentlypublished version of content appears.

In thismode, colored borders surround content when youmove

the cursor over it.

In regular view, click thePreviewbutton to switch to preview

mode.

Toggling Site Preview

To toggle site preview on and off, follow these steps.
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1. Navigate to a page that includes the login/logout button.

2. Click the Preview button:

3. The Web site is now in preview mode.

4. To turn preview mode off, click the ( ) button on the login screen.

Logging Out of the Sample Site
To log out of Ektron CMS400.NET, follow these steps.

1. Click the Logout option from the content menu, or click the Logout button (
) on the Web page.

2. The Logout confirmation box appears.

3. Click the Logout button.

4. You return to the Web page from which you logged out. However, it is in standard view,

not Ektron CMS400.NET view.
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Login Server Control
The Login server control paints a login button on the template when displayed in a browser.

When the Login server control is inserted and the project is built, the control displays the

following buttons on a Web page.

Button Description

When user is not logged in, this button appears. Clicking the button opens the

login window, where a user can enter a username and password. Upon

authentication, the user is logged in to the Ektron CMS400Web site.

After a user logs in, this button replaces the login button to let the user log out.

When logged in, this button appears under the logout button, allowing the user

to access theWorkarea.

Lets the user preview the entireWeb site as if all checked-in content were

published. For more information, see "Logging In andOut" on page 3-1

Turnsoff site preview mode.

Launchesonline, context sensitive help for Ektron CMS400.NET.

This subsection contains the following topics:

n "Placing a Login Button" on page 3-6

n "Login Server Control Properties" on page 3-6

Placing a Login Button

You can add any number of login buttons to a template. You can insert a login button on each

template, or set up a special Web page, called login.aspx, from which users can log into the

CMS400 site without the public being able to access the page.

Login Server Control Properties
The following table explains the properties of the Login server control.
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Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value Data Type

Authenticated

Indicates if you are logged in to the CMS

Explorer and can use it to browse to Content, Collections, etc. See

Also: "Using CMSExplorer to Browse Your Ektron CMS400.NET

Site" on page 21-9

String

AutoAddType

Set this type to define automatically added users asmembership users or CMS400.NET content

authors.

Author=CMS400.NET content authors

Member= site visitor membership users

Data Type: Common.EkEnumeration.AutoAddUserType

AutoLogin

When set to true, users are automatically logged in using Active

Directory authentication. Theydo not need to enter a username or

password. The default is False.

True =Use Active Directory authentication when logging in.

False =Do not use Active Directory authentication when logging in.

Warning! For this property to function

properly, youmust be using Active Directory authentication with your

CMS400.NET Site.

Boolean

Hide

Used to hide login button in design time and run time.

True =Hide login button

False =Show login button

Boolean

Language

Set a language for the Login server control. This property shows

results in design-time (in VisualStudio) and at run-time (in a

browser).

Integer

OnlyAllowMemberLogin

This changes the Login button so onlymembership users can log in.

This prevents someone from trying to login asan Ektron

CMS400.NET user and gain access to the Ektron CMS400.NET

Workarea. If a CMSAuthor tries to log in using this dialog box, a

message appears in the box:

“Onlymembers are allowed to login here.”

The default isFalse.

True =Allow onlymembership users to login.

False =Allow Ektron CMS400.NET users andmembership users to

login.

Boolean
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Property Value Data Type

PromptLogout

When set to False, the logout processwill not include the Logout

Prompt window (shown below).

True =Usersmust click the Logout button in the Logout prompt

window before theyare logged out.

False =Users are logged out without having to use the Logout

prompt window.

Boolean

SuppressHelpButton

Hides the Help button that appears below the Login button when set

to true. The default is False.

True =Do not display the Help button.

False =DisplayHelp button.

If you are editing this server control from a text file and want to

suppress the Help button, add the following code to the login tag

source:

Boolean

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The

default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a

blockof code.

Custom - Allows you to use a custom tag.

String
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Restricting Login Attempts
Ektron CMS400.NET has a login security feature that, by default, locks out a user after five

unsuccessful attempts to log in by a user on one computer. This section explains the flexibility

you have in controlling this feature.

You can control the following capabilities.

n "Changing the Number of Unsuccessful Login Attempts" on page 3-9

n "Unlocking a Locked Account" on page 3-10

n "Manually Locking a User from Signon" on page 3-10

n "Disabling the Login Attempts Feature" on page 3-10

n "Preventing CMS Users from Signing On" on page 3-11

n "Preventing All Users from Signing On" on page 3-11

n "Changing Images Used for Logging In and Out" on page 3-11

n "Resolving Problem with Login Screen" on page 3-11

You control login security feature by changing the value of the ek_loginAttempts element in

the web.config file. The following table summarizes your options.

Warning! If you want your Ektron CMS400.NET eCommerce feature to complywith Payment Application Data

SecurityStandard (PADSS) certification, the ek_loginAttempts valuemust be between 1 and 6.

Value Description

anynumber

between 1 and

254

The number of unsuccessful login attempts after which the user is

locked out.

0 Lockout all users

-1 Disable feature; unlockall locked users

-2 Lockout CMSusers only; membership users can still log in

Changing the Number of Unsuccessful Login Attempts
By default, if a user unsuccessfully tries to log in five times, the following error message

appears: The account is locked. Please contact your administrator. Afterwards, even if the

user enters the correct password, he is locked out, and the error message reappears.
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Note: You can change the text of the error message in the resource file. To learn about editing the resource file,

see "Procedure for TranslatingWorkarea Strings" on page 14-41.

To change the number of unsuccessful login attempts that occur prior to lockout, edit the value

of the ek_loginAttempts element in the siteroot/web.config file. For example, to allow only

three unsuccessful logins, change the value to 3. You cannot enter a value greater than 254.

Unlocking a Locked Account
Once an account is locked out, the Account Locked field is checked in the user settings.

To unlock the account, an administrator user (or a user assigned to the user-admin role)

accesses the Edit User screen and unchecks the box. At this point, the user can attempt to sign

in again.

Note: If you want to unlockall locked usersat once, set the value of the ek_loginAttemptselement in the

web.config file to -1. For more information about the effects of this setting, see "Disabling the Login Attempts

Feature" on page 3-10.

Manually Locking a User from Signon
You can use the Account Locked field (described above) to manually lock a user out of Ektron

CMS400.NET. To do so, go to the Edit User screen, identify the user, and check the Account

Locked field.

That user cannot sign in until either you uncheck the box or change the value of the ek_

loginAttempts element in the web.config file to -1.

Disabling the Login Attempts Feature
To disable the Login Attempts feature, set the value of the ek_loginAttempts element in the

web.config file to -1. If you do, any user can try to log in as many times as he wants. The error

message never appears, and he is not prevented from entering a password.

Note: Setting the value of the ek_loginAttemptselement in the web.config file to -1 automatically unlocksall

locked accounts.
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Preventing CMS Users from Signing On
If you want to lock all CMS users out, set the ek_loginAttempts element in the web.config file

to -2. If you do, only membership users can sign in.

Note: The builtin user cannot sign in if ek_loginAttempts is set to -2.

Preventing All Users from Signing On
If you want to lock out all users (including membership users), set the ek_loginAttempts

element in the web.config file to 0. If you do, no one can sign in to Ektron CMS400.NET until

you change the value.

Note: The builtin user cannot sign in if ek_loginAttempts is set to 0.

Changing Images Used for Logging In and Out
You can change the images used for the login and logout buttons. To do so, follow these

steps.

1. Move the new images to the following folder: webroot\your site’s root

directory\Workarea\images\application.

2. Open the web.config file in your Web site’s root directory.

3. Change the images referenced in this section of the file:
<add key="ek_Image_1" value="btn_close.gif" />
<add key="ek_Image_2" value="btn_login.gif" />
<add key="ek_Image_3" value="btn_login_big.gif" />

Note: Youmust update the imagesand web.config each time your system is updated.

Resolving Problem with Login Screen
You may find that in certain browsers, the login screen occupies the entire browser window

instead of just a small box (see illustration below).
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Browsers such as Internet Explorer 8 and Firefox have a feature called tabs. When the login

window pops up, it appears as a new tab as shown above.

You can change this behavior by turning off tabs within the browser.

Password Management
This section contains the following topics relating to managing passwords.

n "Making Passwords Case Sensitive" on page 3-12

n "Forcing Password Change Every 90 Days" on page 3-13

n "Passwords Must Be Seven Characters Minimum, Include Alpha and Numeric Characters"

on page 3-13

n "New Passwords Cannot Match the Last Four Passwords" on page 3-13

n "After 15 Minutes of Inactivity, User Must Log in Again" on page 3-13

Making Passwords Case Sensitive
By default, passwords are case insensitive. So for example, if the password is TOKEN and the

user enters token, the signon is successful.

Logging In andOut
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If you want to make passwords case sensitive, change the value of the ek_

passwordCaseSensitive element of the siteroot/web.config file from false to true.

If you do, and the password is TOKEN and the user enters token, the signon is unsuccessful.

The user would have to enter TOKEN to successfully sign on.

Forcing Password Change Every 90 Days
Ektron CMS400.NET has a password security feature that forces an administrator or user with

the Commerce Admin role to change his password at least every ninety days. This feature is

only enabled when the ek_ecom_ComplianceMode key in the site’s Web.config file is set to true.

Once such a user goes eighty-five days without changing his password, a dialog box appears

at next log-in, asking to change the password. If they do not want to do so at that time, they

can click the Skip button. They are allowed to do this for the next five days. Once ninety days

have passed, they must change their password before they can log into Ektron CMS400.NET.

Passwords Must Be Seven Characters Minimum,
Include Alpha and Numeric Characters
Ektron CMS400.NET has a password security feature that forces an administrator or user with

the Commerce Admin role to use at least seven characters in his password. Further, the

password must contain at least one alphabetic and one numeric character.

This feature is enabled only when the ek_ecom_ComplianceMode key in the site’s Web.config

file is set to true.

New Passwords Cannot Match the Last Four
Passwords
Ektron CMS400.NET has a password security feature that forces an administrator or user with

the Commerce Admin role to create a password that does not match his last four passwords.

This feature is enabled only when site’s Web.config file has the ek_ecom_ComplianceMode key is

set to true and the ek_ecom_PasswordHistory key is set to at least four.

You can set ek_ecom_PasswordHistory to a number higher than four if you want a higher level

of security. If you set this key to less than four and the ek_ecom_ComplianceMode key is set to

true, Ektron CMS400.NET enforces at least four.

After 15 Minutes of Inactivity, User Must Log in Again
Ektron CMS400.NET has a password security feature that automatically logs out an

administrator or user with the Commerce Admin role after 15 minutes of inactivity. Activity is

based on requests made to the server.

PasswordManagement

ReferenceManual

Version 8.0 Rev 1.3
3-13



This feature is enabled when the site’s Web.config file‘s ek_ecom_ComplianceMode key is set to

true. In addition, if you are using IIS7, the line in red below needs to appear between the

<modules> tags in the Web.config file. This line is a part of the default install. You should

make sure it has not been removed.

<modules>
<add name="MyDigestAuthenticationModule"

type="Ektron.ASM.EkHttpDavHandler.Security.DigestAuthenticationModule,

Ektron.ASM.EkHttpDavHandler" />
<add name="ScriptModule" type="System.Web.Handlers.ScriptModule, System.Web.Extensions,

Version=1.0.61025.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35"

preCondition="integratedMode" />
<add name="EkUrlAliasModule" type="UrlAliasingModule" preCondition="integratedMode" />
</modules>

If you are using IIS 6, the line in red below needs to appear between the <httpModules> tags in

the Web.config file. This line is a part of the default install. You should make sure it has not

been removed.

<httpModules>
<add name="DigestAuthenticationModule"

type="Ektron.ASM.EkHttpDavHandler.Security.DigestAuthenticationModule,

Ektron.ASM.EkHttpDavHandler " />
<add name="ScriptModule" type="System.Web.Handlers.ScriptModule, System.Web.Extensions,

Version=1.0.61025.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35"/>
<add name="EkUrlAliasModule" type="UrlAliasingModule" />

</httpModules>
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The Ektron CMS400.NET Workarea contains 6 pages that you use to manage and develop

content for your Web Site.

Note: To access theWorkarea, youmust be logged into your Ektron CMS400.NETWeb Site. See also "Logging

In andOut" on page 3-1.

Page Formore information see

Smart Desktop "Personalizing the Smart Desktop" on page 4-4

Content "Content" on page 7-1

Library "LibraryFolder" on page 8-1

Settings "Settings" on page 4-13

Reports "Reports" on page 4-14

Help See Ektron Documentation

The Workarea and Smart Desktop are more fully explained in the following topics:

n "Accessing the Workarea" on page 4-3

TheWorkarea and Smart Desktop
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n "The Workarea Menu Tabs" on page 4-4

n "Personalizing the Smart Desktop" on page 4-4

n "Workarea Style Sheets" on page 4-12

n "Settings" on page 4-13

n "Reports" on page 4-14

Accessing the Workarea
To access the Workarea, follow these steps.

1. Log in to your Web site, as described in "Logging into an Ektron CMS400.NET Web

Site" on page 3-2.

2. Click the Workarea button ( ) on a login page.

3. Your Smart Desktop is displayed.

Note: In the Application Setup screen, you can determine which screen appearswhen you access theWorkarea.

See Also: "Updating Setup Information" on page 19-3

The Smart Desktop contains useful information that pertains to you. You may personalize this

page by adding, moving or deleting Workarea Widgets. To learn how, see "Personalizing the

Smart Desktop" on page 4-4.
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Closing the Workarea

There are two ways to close the workarea.

n Close by logging-out of the Web Site from either a Logout link on the web page or the

Logout button ( ).

n Close by using the Windows Close button ( ) in the upper right corner of the browser.
When you do this, you remain logged into the Ektron CMS400.NET Web Site.

The Workarea Menu Tabs
Ektron CMS400.NET’s menu tabs appear in the upper right corner of the Smart Desktop. Use

this menu to access all other pages.

Personalizing the Smart Desktop
By personalizing your Smart Desktop, you can choose and rearrange items displayed on the

desktop that pertain to your work.

To see the Smart Desktop, click the Desktop menu tab ( ) in the Workarea’s
upper right corner.

The Smart Desktop looks like this.

TheWorkarea and Smart Desktop

4-4
ReferenceManual

Version 8.0 Rev 1.3



The default Smart Desktop page contains Widgets that provide information about your Web

Site. The page above shows the default widgets for the Ektron Medical starter site.

The following topics explain how to customize personalize the Smart Desktop.

n See "How Customizing the Smart Desktop Works" on page 4-5

n See "Adding a Widget into the Smart Desktop" on page 4-6

n See "Adding a Tab to the Smart Desktop" on page 4-7

n See "Adding Columns" on page 4-8

n See "Deleting columns" on page 4-9

n See "Restoring Tabs and Widgets" on page 4-9

n See "Setting the Default Widgets " on page 4-10

n See "Customizing the Widgets Available to the Smart Desktop" on page 4-11

How Customizing the Smart Desktop Works
The Ektron CMS400.NET Workarea can have multiple tabs, letting you organize content by

subject – think of tabbed browsing. You can easily add new tabs and switch between them.

Within a tab, you can add, move or delete Widgets for your own personalized Smart Desktop.
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Widgets that you use on the Smart Desktop are stored in a widget tray. You can drag and drop

widgets from the tray onto the Smart Desktop into any tab and column.

You control the arrangement of the Smart Desktop Widgets for your own profile.

Adding a Widget into the Smart Desktop
Go to the Workarea > Desktop and follow these steps.

1. Click Toggle Widget Tray located in the upper right corner of the Smart Desktop window

(circled below).

TheWorkarea and Smart Desktop
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Next you see the Widget Tray containing widgets that you can drag and drop onto your

Smart Desktop. Use the left arrow ( ) or right arrow ( ) buttons to see more widgets.

2. Choose the widget you wish to use by dragging and dropping it from the tray into the

Smart Desktop panel.

Once you have placed the widget into the Smart Desktop, you may drag it to any location on

the desktop.

Adding a Tab to the Smart Desktop
Tabs help you organize your Smart Desktop. By default, there is one tab containing a few

standard widgets. You may wish to add other tabs for eCommerce or Analytics type widgets.

To add an eCommerce widget for example, do the following.

1. Click the Options button on the upper right of the Smart Desktop.

2. Click on Add Tab. You next see the Add Tab dialog window.
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3. Enter the Tab Label for the tab. For example, “eCommerce”.

4. Click OK to save the Tab Label.

The new tab appears on the top of the Smart Desktop.

Adding Columns
By default, 3 columns are placed on the Smart Desktop. You may add columns by following

these steps.

1. Click the Options button on the upper right of the Smart Desktop.

2. Click Add Column.

TheWorkarea and Smart Desktop
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3. Click the Options button to see the columns below the Widget tray.

Deleting columns
1. Click the Toggle Widget Tray button (circled below) to show the Widget Tray and

Columns.

2. Click the Remove Column button (circled below) inside the column you wish to delete.

Restoring Tabs and Widgets
All users can restore their Smart Desktops to the Default Widget set. To do this, follow these

steps.

1. Click the Options button on the right side of the Smart Desktop.

2. Click Remove Widgets and Tabs.
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3. When the dialog box appears that confirms you want to delete all Tabs and Widgets, click

OK.

Warning! This action will remove all tabsand widgets that youmayhavemodified on your Smart Desktop. Only

the default set of tabsand widgetswill be shown.

Setting the Default Widgets
Note: To restore DefaultWidgets, youmst be amember of the Administratorsgroup.

By using the previous procedure "Restoring Tabs and Widgets" on page 4-9, the user restores

their Smart Desktop to the Default Widget set. The Default Widget set is defined by users in

the Administrators group by doing the following.

1. Click the Options button on the right side of the Smart Desktop.

2. Click Edit Default Widgets.

3. Arrange the Smart Desktop with Tabs and Widgets that you wish to be the default.

TheWorkarea and Smart Desktop
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4. Click the Options button.

5. Click Done to save the Default Smart Desktop.

Customizing the Widgets Available to the Smart
Desktop
The Widgets used in the Smart Desktop are located on the web server in the workarea\widgets

folder.

Widgets developed for Personalization and Page Builder can be also used within the Smart

Desktop.

In the following example, we demonstrate how to add a Calendar Widget to a Smart Desktop.

Note: Access to theWeb Server folders is required to perform the following steps.

1. On the web server, copy the widget files you want to use from the siteroot\widgets folder

into the siteroot\workarea\widgets folder. Be sure that all files related to the widget are

copied.

The example below shows all files related to the Calendar Widget.

2. Click the Workarea > Settings tab.

3. Choose the Configuration > Personalizations > Widgets folder.

4. Click the Synchronize Widgets button shown below.
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5. At the prompt, click OK.

6. Add the Widget to the Smart Desktop using the procedure described in "Adding a Widget

into the Smart Desktop" on page 4-6.

For example, the results look like this after you drag and drop the Calendar widget onto

the Smart Desktop.

Workarea Style Sheets
Ektron CMS400.NET’s Version 8.0 Workarea uses two primary style sheets:

TheWorkarea and Smart Desktop
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n Ektron.workarea.css - the primary CSS file for the workarea. It replaces the previous CMS

version’s global.css file.

n Ektron.workarea.ie.css - is used for Internet Explorer browsers, and generally targeted at

IE7 or less. It includes overrides for some CSS rules in Ektron.workarea.css that get around

IE CSS bugs or deficiencies.

Using widely accepted style sheet classes and class attributes, you can modify the Workarea,

including colors, spacing, fonts, etc. Also, if you later upgrade or re-install Ektron

CMS400.NET, you can reuse this file and retain your changes.

Language Images
Several language specific Images are used at the top of the Workarea. They reside in the

language folders and always start with the word “Workarea” and end with “_top.”

These images are 467 pixels wide by 77 pixels high. Their width can change but the height

cannot.

There are approximately six images in each language folder. an Adobe Photoshop file,

Workarea_top.psd, can be found under \Workarea\images\English folder. You can modify

these images as needed.

Settings

To view the Settings page, click the Settings menu tab in the upper right corner of the

workarea.

Note: Youmust be logged into the Ektron CMS400.NET in order to see these pages. See also "Logging In and

Out" on page 3-1.

The Settings page contains these folders.

Settings
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Page Formore information see

Commerce "eCommerce" on page 17-1

Community

Management
"CommunityManagement" on page 16-1

Configuration "LibraryFolder" on page 8-1

Roles "Defining Roles" on page 15-32

BusinessRules "BusinessRules" on page 12-1

Import XLIFF Files
"Importing Translated Files into Ektron CMS400.NET" on

page 14-19

User Groups
"Accessing the Users and User GroupsFolders" on page

15-2

Users "Managing Users" on page 15-3

Reports

TheWorkarea and Smart Desktop
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To view the Reports page, click the Reports menu tab in the upper right corner of the

workarea.

Note: Youmust be logged into the Ektron CMS400.NET in order to see these pages. See also "Logging In and

Out" on page 3-1.

The Reports page contains these folders.

Page Formore information see

eCommerce "eCommerce Reports andWidgets" on page 17-237

Contents "Content Reports" on page 7-702

Site Analytics "Analytics" on page 7-752

Tasks "Managing Tasks" on page 11-1
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An administrator can control every aspect of the content and the folders that hold them. The

controls include setting permissions, approvals, and adding, editing, publishing, and deleting

content. Below is the content folder.

This chapter explains how to add, edit, publish, and delete content. It includes the following

information.

n "Viewing a Folder" on page 5-3

n "Workarea Content Menu" on page 5-9

n "Folder Properties" on page 5-13

n "Adding Subfolders" on page 5-19

n "Deleting Folders" on page 5-20

n "Purge History" on page 5-21

n "Community Folders" on page 5-22

Managing Folders

5-2
ReferenceManual

Version 8.0 Rev 1.3



Viewing a Folder

To view any folder under the content folder, follow these steps.

1. Access the Workarea, as described in "Site Preview" on page 3-4.

2. Click Content Tab on top menu area.

3. All content in the root folder and the selected language appear in the right frame.

Subfolders appear in the left frame.

Note: The Viewmenu option lets you filter content by type. For example, you can set it to view onlyHTML content.

Therefore, youmayonly see content of a selected type in the folder. See Also: "ViewMenu" on page 5-6

4. To work with any folder or its content, click the folder. When you do, its content appears

in the right frame.

Note: You can only view folders for which your system administrator hasgranted permission.

5. If your system supports more than one language, you can select content for a particular

language or all languages using the View > Language menu option (illustrated below).
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Each folder lists the following information about its content.

Field Description

Title The name of the content.

Language
The language of the content. See Also: "Working with Multi-

Language Content" on page 14-1

ID

The number assigned to the content byEktron
CMS400.NET . It is used to retrieve the content from a

database.

Status
The status of the content. See Also: "Content Statuses" on page

7-133

DateModified
Themost recent date the content wasadded, edited, or

published.

Last Editor The last user who accessed the content.

The following menus and button appear across the top of the View Contents of Folder screen.

Managing Folders
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Note: Depending on your permissions, youmaynot see allmenu options.

n "New Menu" on page 5-5

n "View Menu" on page 5-6

n "Delete Menu" on page 5-7

n "Action Menu" on page 5-8

n Add Asset button ( ) See "Adding Documents Using Drag and Drop" on page 7-419

n "Workarea Content Menu" on page 5-9

New Menu

Menu

Option

Lets you create or upload this new

item into folder
Formore information, see

Folder Folder

Blog Blog "Blogs" on page 7-492

Discussion

Board
Discussion Board "Discussion Boards" on page 7-596

Community

Folder

Folder whose content can be updated by

membership aswell as regular users
"Community Folders" on page 5-22

HTML

Content
HTML content "Adding HTMLContent" on page 7-15

HTML

Form/Survey
HTML Form, Poll, or Survey "Working with HTML Forms" on page 7-220

Smart Form Smart Form "Working with Smart Forms" on page 7-288

DMS

Document

n Office Document

n Managed file, any supported type

n "Working with Microsoft Office Doc-

uments" on page 7-413

New Menu
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Menu

Option

Lets you create or upload this new

item into folder
Formore information, see

n Multimedia file, any supported type
n "Working with Managed Files" on page

7-435

Multiple DMS

Documents

SeveralOffice documents, managed files,

multimedia files

"Adding DocumentsUsing theMultiple DMS

DocumentsOption" on page 7-418

Collection Collection "Working with Collections" on page 9-99

Menu Menu "Working with Menus" on page 9-129

View Menu
The View Menu provides the following functions.

MenuOption Function

For more

information,

see

All types Displaysall content typesof selected language.

n HTML content

n HTML Form/Survey

n DMSDocument, which

includesOffice Documents,

Managed Files, Multimedia,

OpenOffice

Limits folder display to selected content type. For

example, chooseView > DMS Document and see

onlymanaged assets in the folder -- other content

typesare suppressed.

This is especially helpful if the folder hasa lot of items,

and you are looking for only one type of content.

Note that the icon for the selected type appears to the

left ofView, as illustrated below.

n "Adding

HTMLContent"

on page 7-15

n "Working

with HTML

Forms" on page

7-220

n "Working

with Microsoft

Office Doc-

uments" on page

7-413

n "Working

with Managed

Files" on page 7-

435

n "Managing

Multimedia

Managing Folders
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MenuOption Function

For more

information,

see

Assets" on page

7-447

Language

Limits display of content within folder to one language.

Also, sets language of new itemsyou create or upload

into the folder.

Menus
Lets user view and workwith menusassigned to this

folder

"Adding aMenu

Item via Content

Folder" on page

9-138

Collections
Lets user view and workwith Collectionsassigned to

this folder

"Working with

Collections" on

page 9-99

Archived Content

Lets user view and workwith content that passed its

scheduled End Date and whose archive option is either

Archive and remove from site or Archive and

remain on Site.

"Setting Archive

Options" on page

7-198

Folder Properties

Only system administrators see this option. It lets you

assign folder properties, such aswhich users can edit a

folder’s content.

"Folder

Properties" on

page 5-13

Delete Menu
This menu lets you perform the following functions.

Menu option Lets you Formore information, see

Delete this folder
Delete current folder and all of its content

Note: You cannot delete the Root folder.
"Deleting Folders" on page 5-20

Delete content Delete one or more content items in folder "Deleting Content" on page 7-130

DeleteMenu
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Action Menu
This menu lets you perform the following functions.

Menu option Lets you More Information

Export for

translation

Prepare content for translation bya

translation agency

"Using the Language Export Feature" on

page 14-13

Move/Copy

Content
Move or copy content to another folder.

"Moving or Copying Content" on page 7-

113

Search Search content in theWorkarea "Searching theWorkarea" on page 9-87
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Workarea Content Menu

The View Contents of Folder screen features a context-sensitive, dropdown menu of options

you can perform for a content item.

The options depend on several factors, such as

n your folder permissions

n your position in the approval chain (if any)

n the content’s status

n whether the item is a Microsoft Office document

To see the dropdown menu options for any content item, follow these steps.

1. After signing in, navigate to a Web page or the folder that contains the content.

2. Hover the cursor over the content item. It is surrounded by a blue rectangle, and a triangle

appears to the right of the title.

Workarea Content Menu
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3. Hover the cursor over the triangle ( ) and click.

4. A menu of options available for that content item appears. For example, if you have

permission to edit it, Edit appears on the dropdown menu.

Dropdown Menu Options

Option Allows you to...

For more

information,

see

Approve Approve content that hasbeen submitted for publishing

"Approve/Decline

OneContent

Item" on page 5-

35

Check in

Change status of selected content to checked in. Might use if you

checked out and saved a document then it became lost or corrupted.

This option changesoriginal document’s status to checked in. However,

it doesnot replace the version of the file in Ektron CMS400.NET. To

replace content that was checked out and edited, drag and drop it into

Ektron CMS400.NET. See Also: "Checking Out, Saving, and Replacing

anOffice Document" on page 7-430

Note: PreviousEktron CMS400.NET releases included aWorkOffline

option, whoseCheck In function replaced the version of the file in Ektron

CMS400.NET. In contrast, this release’sCheck In function only changes

the content’s status.

"Checked-In

Content" on page

7-135

Checkout

and Save As

Change a content item’s status to checked out and save it to your local

computer.When you finish editing the item, drag and drop it into Ektron

CMS400.NET.

"Checking Out,

Saving, and

Replacing an

Office Document"

on page 7-430

Decline

Decline an approval request submitted to you. This option reject the

changesand keeps the current version live onWeb site. You are

prompted to enter a reason for the decline.

After you decline

n The author whomade the change is notified byemail

n The content is removed from the ApprovalChain

If the author updated content then submitted it for approval, the updated

content remains in the file. If you do not want it to remain, choose the

"Approve/Decline

OneContent

Item" on page 5-

35

Managing Folders
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Option Allows you to...

For more

information,

see

Edit option.

Youmaybe asked to decline both a content change and a request to

delete content.

Delete Submit content for deletion.

n "Deleting

Content" on page

7-130

n "Deleting an

Office Document"

on page 7-429

n "Deleting a

Managed File" on

page 7-438

Edit

n HTML, HTML form, or XML Smart Form content - edit content

within an Ektron CMS400.NET editor

n Asset - First, useCheck out and Save As or Save As to save

asset to your computer and edit it. Then, use Edit to replace version in

Ektron CMS400.NET.

n "Editing

HTMLContent"

on page 7-105

n "Editing

Smart Forms" on

page 7-383

n "Editing a

Managed File" on

page 7-437

Edit in

Microsoft

Office

Edit Office document within Ektron CMS400.NET, which launchesOffice

"Editing anOffice

Document" on

page 7-427
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Option Allows you to...

For more

information,

see

Edit

Properties

Edit item’sEktron CMS400.NET information, such asSummary,

Metadata, Schedule, and Taxonomy.

After you complete the edit screen, you proceed to the View Content

screen. From here, you can perform additional content activities, such as

move/copy, delete, and view history.

n See "Con-

tent Properties"

on page 7-141

n See "Work-

ing with Meta-

data" on page 7-

146

n See "Sched-

uling Content to

Begin and End"

on page 7-195

n See "Tax-

onomy" on page

9-200

Force

Check In

Only appears if user is amember of the Administrator group or assigned

the folder admin role and content is checked out.

Allowsan admin to check in content even though he is not the one who

checked it out.

Publish Accept changes to content and publish it to the site.

Request

Check In

Allowseither admin user or non-admin user with edit permission for the

content’s folder to email the user who checked out content. The email

asks the check-out user to check it in.

Save As SaveOffice document or asset to your computer.

"Saving anOffice

Document" on

page 7-432

Submit

Submit current version of content for publishing.When you do this, the

next person in the ApprovalChain is notified that your content is ready for

review.

"AssetWorkflow"

on page 7-439

Synchronize Synchronize content or folders between two servers

See

"Synchronizing

ServersUsing

eSync" on page

18-1

View

View item’sEktron CMS400.NET information, such asSummary,

Metadata, Schedule, and Taxonomy. After viewing, you can also edit

that information if you have permission.

Managing Folders
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Option Allows you to...

For more

information,

see

Next, you proceed to the View Content screen. From here, you can

perform additional content activities, such asmove/copy, delete, and

view its history.

View in

Microsoft

Office

View Office document within Office application. Cannot change.

View

Properties

View Office document’sEktron CMS400.NET information, such as

Summary, Metadata, Schedule, and Taxonomy. After viewing, you can

also edit that information if you have permission.

After you complete the edit screen, you proceed to the View Content

screen. From here, you can perform additional content activities, such as

move/copy, delete, and view its history.
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Folder Properties

The folder properties screen lets you set permissions and approvals for a folder. You can also

assign or modify the folder’s metadata, Web Alerts, and Smart Forms.

Note: Onlymembersof the Administrator User Group and those defined in theManageMembers for Role: Folder

User Admin screen can view, add, or edit folder properties. (See Also: "Defining Roles" on page 15-32) In addition,

if a user is not amember of the Administratorsgroup, hemust be given permission for individual folderson the

Folder Properties>View Permissions for Folder screen. (See Also: "Folder Permissions" on page 5-43)

Note: If you are using an eCommerce catalog, see See "Product Types" on page 17-106 for a description of the

Product Typesscreen.

Note: If you are using aWebCalendar folder, see "Viewing SystemCalendar Folder Properties" on page 7-554.

Accessing the Folder Properties
Screen
To access the folder properties screen, follow these steps.

1. Click View > Properties.

2. The folder’s View Properties screen appears.

If you want to change any properties, click the Edit button ( ) to proceed to the edit screen.

The table below describes the fields on the Folder Properties screen.
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Fields on the Folder Properties Screen

Field Description

Foldername
Edit the name of the content folder.

Note: You cannot change the root folder name.

Description Edit the description of the content folder.

Style Sheet filename for this

folder: (leave blank to inherit)

Specify a style sheet that defines styles that maybe applied to content in this

folder. The style sheet that you identifymust reside in the site root folder. Or,

leave this field blank to inherit the parent folder’s style sheet.

The style sheet populates the style dropdown list (see below) within the editor.

Note: This style sheet affects content being edited. It doesnot necessarily affect

the content’s appearance on your Web site. To set or edit the style sheet that

determines your Web pages’ appearance, open the page’sWeb form and place

a <link rel=”stylesheet”... tag within its<HEAD> tags. If desired, you can

identify the same style sheet in both locations. To include user-selectable styles,

theymust be generic classes.

Caption and Visible Properties

eWebEdit400 ignores the CSS custom propertiescaptionand visible. To

address this problem for the Internet Explorer browser, replace themwith the

customCSSpropertieslocaleRef, caption and visible.

For other browsers, use the customCSS selectorslocaleRefand

unselectable (same asvisible: false).

To achieve cross-browser compatibility, use both approaches.

Note: Non-IE browsers have no equivalent for caption.

Page Templates

Lets you specify one or more templates for content in this folder. This folder’s

content uses the specified template when appearing on your Web site. See

Also: "Inheritance of Folder Templates" on page 7-187

Inherit Parent Template

Configuration

Check this box to inherit the template from the parent content folder.

Or, do not check this boxand specify one or more templatesbelow. See Also:

Accessing the Folder Properties Screen
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Field Description

"Inheritance of Folder Templates" on page 7-187

Taxonomy

n If you want this folder to inherit taxonomyconfigurations from the parent

folder, check Inherit Parent Taxonomy Configuration.

If you uncheck Inherit Parent Taxonomy Configuration, you can then

select taxonomies that can be applied to content in this folder.

n If you want all content in this folder to be assigned at least one taxonomy

category, checkRequired at least one category selection.

See Also: "Inheriting Taxonomies from a Parent Folder" on page 9-215;

"Taxonomy" on page 9-200

Flagging

Check this box if content in this folder inherits a flagging definition from its parent

folder. If you do not check the box, use the dropdown list to apply a flagging

definition to content in this folder.

See Also: "Flagging" on page 16-193, "Assigning a Flagging Definition to a

Folder" on page 16-197

Multi-site Domain

Configuration

Note: Only appears for Site

folders.

Lets you set up andmanage severalWeb sites under one

CMS. See Also: "Multi-Site Support" on page 19-21.

Should Office documents

added to this folder be

published in other format?

Note: This field only appears if

theEnable Office

documents to be

published in other format

property is checked in the

Settings>Configuration >

Setup screen.See Also:

"Modifying the Application

Setup Screen" on page 19-2

Publish Office documents as PDF

Check this option if Office documents in this folder are published asPDF files.

See Also: "PDF Generation" on page 7-454

Note: This property is not inherited from a parent folder, nor is it inherited byany

subfolders below this folder.
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Tabs on the Folder Properties Screen

Tab Formore information, see

Metadata "AssigningMetadata to a Folder" on page 7-165

Web Alerts
"AssigningWeb Alert Information to Folders and Content" on page

20-21

Smart Forms "Working with Smart Forms" on page 7-288

Breadcrumb "Creating SiteMap Breadcrumbs" on page 9-278

Product Types

(only appears

with

eCommerce

folder)

"Product Types" on page 17-106

Folder Properties Toolbar
The Folder Properties screen contains these toolbar buttons.

Button Name Description More Information

Edit

Properties

Access the Edit Folder

Properties screen

"Editing Folder Properties" on page

5-17

Permissions
Access the folder’s

PermissionsTable
"Folder Permissions" on page 5-43

Modify

Preapproval

Group

Set or update preapproval

group assigned to folder

"AutomaticCreation of Tasks

Associated with Content" on page

11-34

Approvals
Access the folder’s

approvals table
"ApprovalChains" on page 5-28

Purge

History

Access the folder’s purge

history table
"Purge History" on page 5-21
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Button Name Description More Information

Restore

Web Alert

Inheritance

Assigns the folder’sWeb

Alert properties to all

content in folder

"Inheriting Content-LevelWeb Alert

Information from ItsFolder" on

page 20-28

Back Go to previous screen

Editing Folder Properties
A content folder’s properties consist of

n name

n description

n style sheet

n template (see "Creating/Updating Templates" on page 7-184)

n Metadata (see "Assigning Metadata to a Folder" on page 7-165)

n Web Alerts (see "Assigning Web Alert Information to Folders and Content" on page 20-

21)

n "Working with Smart Forms" on page 7-288

n "Creating SiteMap Breadcrumbs" on page 9-278

To edit any properties for a folder, follow these steps.

1. Access the View Properties screen for the folder you want to edit, as described in

"Accessing the Folder Properties Screen" on page 5-13.

2. Click the Edit button ( ).

3. The folder’s Edit Properties screen appears.
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4. Make the necessary changes to the content folder’s properties. See "Fields on the Folder

Properties Screen" on page 5-14.

5. Click the Update button ( ).
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Adding Subfolders

To further organize content on your Web site, create subfolders to store related content. To add

a sub folder, follow these steps.

1. Navigate to and click the folder within which you want to create a subfolder (that is, the

parent folder).

2. Each folder has a default language. By default, it is inherited from its parent folder. To

change a folder’s default language, use the parent folder’s View > Language selection

(shown below).

Effect of a Folder’s Default Language

By default, when a user adds content to a folder, the default language is applied to the content

unless the user explicitly changes the language. So, you should select a default language in

which you expect the majority of folder’s content to be created.

1. Click New > Folder.

2. The Add a Subfolder screen appears.

3. Complete the fields. See "Fields on the Folder Properties Screen" on page 5-14.

4. Click the Save button ( ).
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You can modify the subfolder’s properties, permissions, approval chain, etc. For a list of

options, see "Folder Properties Toolbar" on page 5-16.

If this is a Community Folder, see "Community Folders" on page 5-22.

If this is a Site Folder, see "Multi-Site Support" on page 19-21.

Deleting Folders
You can delete obsolete folders from the Ektron CMS400.NET Web site.

Note: The top-level folder,Root, cannot be deleted nor renamed.

Warning! Deleting a content folder permanently deletes the content andQuicklinks that belong to the content

folder, aswell as its subfolders.

To delete a content folder, follow these steps.

1. In the Workarea, navigate to the content folder you want to delete.

2. From the options across the top of the screen, click Delete > This Folder.

3. A confirmation message is displayed.

4. Click OK.
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Purge History

The Purge History option lets you delete historical versions of content in a folder. When

purging, your options are

n specify a date before which historical versions are purged

n indicate whether the purge includes a folder’s subfolders

n purge published as well as checked-in versions of content

Note: OnlyEktron CMS400.NET administratorsand users identified on theManageMembers for Role: Folder

User Admin screen can purge history.

To purge the history for a content folder, follow these steps.

1. Access the View Folder Properties screen for the content folder you want to purge the

history for, as described in "Accessing the Folder Properties Screen" on page 5-13.

2. Click the Purge History button ( ).

3. The Purge History screen appears.

4. Use the following table to customize the Purge History options.

Field Description Required?

Only purge

historical

versions

before

Specify a date to limit the number of historical versions to

purge.When specified, only historical versionswith a date

before this date are purged.

Yes

Recursive

Purge
Purgeshistorical records for content in this folder’s subfolders. No

Purge

versions

marked as

Published

Purgespublished versionsof content aswell as checked-in

versions.
No

5. Click the Purge History button ( ).

6. A confirmation message is displayed.

7. Click OK to continue.

8. Ektron CMS400.NET executes the purge and displays a confirmation when complete.
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Community Folders

Community folders resemble regular folders in most ways. The only difference is that

membership users can add and edit content in these folders only. Community folders have a

unique icon, which looks like two people ( ).

Membership users add and edit Community folder content after signing in to the Web site.

They do not use the Workarea to add or edit content.

Note: Authorized CMSusers can also create and update Community folder content.

See Also:

n "Creating a Community Folder" on page 5-22

n "Assigning Permissions for a Community Folder" on page 5-23

n "How a User Views and Edits Community Folder Content" on page 5-24

n "How a Membership User Adds Community Folder Content" on page 5-26

n "How a Membership User Adds an Asset" on page 5-26

n "How a Membership User Updates an Asset " on page 5-27

Creating a Community Folder
1. In Workarea > Content, go to the folder in which you want to create the community

folder.

2. Select New > Community Folder.

3. Assign properties as you would any other folder. See "Adding Subfolders" on page 5-19

Note: The folder properties screen lets you requiremetadata for any content item. However, membership users

cannot enter metadata. Therefore, this requirement is ignored whenmembership usersedit community folder

content. If an Ektron CMS400.NET user tries to edit that content, he is required to enter ametadata value.
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Assigning Permissions for a
Community Folder
Since Community folders are intended for membership users, this section explains how to

assign permissions for them. To assign folder permissions for regular users, see "Folder

Permissions" on page 5-43.

1. Navigate to the folder.

2. Click View > Properties.

3. Click the View Permissions button ( ).

4. If necessary, uncheck the Allow this object to inherit permissions checkbox.

5. Click User Type: Membership Users.

6. Click the Add button ( ).

7. Select the membership user or group to which you want to assign permission for this

folder.

8. Check the permission boxes as appropriate.
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How a User Views and Edits
Community Folder Content
When a user with Read-only or higher permission navigates to a page whose content is in a

community folder, he can view it. If he has edit permission, a menu appears.

Warning! Important: Membership users can edit onlyHTML content and assets. They cannot edit other content

types (HTML forms, Smart Forms, etc.).

When a membership user clicks the Edit button ( ), a new window displays the content
within an editor.

Other membership buttons are View History ( ) and Log out ( ).
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This editor has fewer capabilities than Ektron CMS400.NET’s editor. However, a membership

user can

n add images and files via the library button ( ) if the membership user has Add Images
and Add Files permission. See Also: "Library Folders and Permissions" on page 8-4

n add a wiki using the page link button ( ).

n assign a taxonomy category to the content by clicking the Category tab. See Also:

"Taxonomy" on page 9-200
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Note: TheCategory tab only appears if a Taxonomy is applied to the content’s folder.

n replace the content summary with the first 40 words of the content, using the Auto

Generate New Summary check box. See Also: "Automatic Creation of a Summary" on

page 7-143

When a membership user finishes editing, he clicks Publish. If the content’s folder has an

approval chain, the content’s status changes to submitted, and the border color changes to

yellow. If there is no approval chain, the content is published immediately.

How a Membership User Adds
Community Folder Content
You will need the assistance of your developer to enable this feature. Instructions for doing so

are in the developer sample site. To download the developer sample site, go to

http://www.ektron.com/solutions/startersites/. After you install it, go to

siteroot/developer/ContentBlock/AddContentMembershipUser.aspx.

Or, from the developer home page (siteroot/developer/default.aspx), go to Memberships >

Membership Add Content.

How a Membership User Adds an
Asset
First, your developer must create a template, then drop an Asset Server Control onto it. While

adding the Asset Server Control, the developer specifies Add at the Upload Type property,

and a community folder to which the asset will be saved at the DefaultFolderID property.

When a membership user authorized to add content navigates to the page with the server

control, he sees an Asset control area like the one that appears when CMS users add assets. He

can then drag and drop assets into Ektron CMS400.NET.
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Additional information about administering assets is found in "Using the Document

Management System" on page 7-408.

How a Membership User Updates an
Asset
Your developer adds the Asset Server Control, as described in "How a Membership User Adds

an Asset" on page 5-26. The only difference is that the developer specifies Update at the

Upload Type property, and a community folder to which the asset will be saved at the

DefaultFolderID property.

Then, the developer specifies an asset ID number at the DefaultAsset ID property. Using that

control, the membership user can update the identified asset only.
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WorkFlow

Approval Chains

What is an Approval Chain?

An approval chain is a series of users or user groups who must approve content before it can

be published on your Web site. When the last person in the chain approves content, it goes

live.

Also, if a user deletes content, before it is removed from Ektron CMS400.NET, it must pass

through the approval chain.

When a new, edited, or deleted content is submitted to the approval chain, it is reviewed by

users who may

n change it

n approve or decline it

n publish it (it’s published when the last user in the chain approves it)

The chart below illustrates the approval process.

You can approve, edit, or decline all content submitted to you from the approval folder.
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Ektron CMS400.NET can automatically send email notification, informing users that content

workflow events have either taken place or are requested of them. As examples

n as soon as one member of the approval chain approves content, the next user or group is

notified that the content is ready for their approval

n a content contributor receives an email that his content has been published to the Web

site.

The list of automatic emails and directions for customizing their content are described in

"Customizing Ektron CMS400.NET email" on page 1-87.

Conditions for Membership in Approval Chain

An approval chain can include any number of users or user groups. However, only users or user

groups with read-only or higher permission to the folder or content item can be added to the

approval chain. See Also: "Folder Permissions" on page 5-43

Note: If you assign a user group to an approval chain, onlyonemember of the group needs to approve the

content, not allmembers.

Note: Also, if a user appears in an approval chain twice (both asa user and part of a user group), the approval

chain skips the second approval because the user hasalreadyapproved the content.

You can set up an approval chain for a content folder or a content item as well as a language.

See Also: "Multi-Language Approval Chains" on page 14-23

Finally, the Approval Method determines if content must be approved by all users in the chain,

or only users higher up the chain than the one making the edits.

This chapter explains how to manage approval chains through the following subtopics.

n "Approval Chain Scenarios" on page 5-30

n "Inheritance and the Approval Chain" on page 5-30

n "Creating an Approval Chain for a Content Folder" on page 5-30

n "Editing an Approval Chain For Content" on page 5-34

n "Approve/Decline One Content Item" on page 5-35

n "Approve/Decline Several Content Items" on page 5-36

n "Example of an Approval Chain" on page 5-37

n "The Approval Method" on page 5-41

Note: OnlyEktron CMS400.NET administratorsand users identified on theManageMembers for Role: Folder

User Admin screen canmodify the approval chain.
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Approval Chain Scenarios
An approval chain lets you control how and when your Web site is updated. For example, if

your Webmaster needs to approve every new content item or update of an existing item, he

would be last user in every approval chain and exert total control over the site.

Alternatively, you could set up a less centralized organization, where each department head

controls his section. To accommodate this, set up an approval chain for each department, and

assign the department head as the last person in the chain.

On the opposite extreme, you can delete the approval chain for a content item or folder. In this

case, every item in that folder is published as soon as a user submits it for publication.

Inheritance and the Approval Chain
An approval chain’s inheritance is determined by the corresponding permission table. So, if a

folder’s permission table inherits settings from its parent folder, that folder’s approval chain

also inherits. To learn about enabling and disabling permission table inheritance, see

"Inheritance" on page 5-44.

The Approval Chain screen only displays its inheritance status; it does not let you set it.

Creating an Approval Chain for a
Content Folder
Before you can create or edit an approval chain, you must access the View screen.
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Viewing a Folder’s Approval Chain

To view a folder’s approval chain, follow these steps.

1. Select a folder from the left frame of the Workarea.

2. Click View > Language.

3. Select the language of the approval chain you want to view.

4. Click View > Properties.

5. Click the Approvals button ( ).

6. The approval chain appears in the lower section of the screen.

This screen shows the following information about the approval chain.

n its language

n every user and user group in the approval chain

n the approval order

n the approval method (See Also: "The Approval Method" on page 5-41)

n toolbar buttons for modifying the approval chain and method

See Also: "Creating an Approval Chain for a Content Folder" on page 5-30

Actions You can Perform from the Approvals Screen
From this screen, you can perform these actions.

Action Button See this section for details

Add approvers "Adding Approvers" on page 5-32
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Action Button See this section for details

Remove approvers "Deleting Approvers" on page 5-34

Change the order of users in the

approval chain

"Editing the ApprovalOrder" on page

5-33

Change the approvalmethod
See "The ApprovalMethod" on page

5-41

Change the language of the

approval chain

Content

Language

"Multi-Language ApprovalChains"

on page 14-23

Adding Approvers
To add a user or user group to the approval chain, follow these steps.

1. Access the approval table, as described in "Viewing a Folder’s Approval Chain" on page

5-31.

2. Select the language of the approval chain. The chain only applies to content in this

language.

3. Click the Add button ( ).

4. The Add Approvals screen appears.

Note: Onlyusersand user groupswith permissions to the folder appear. See "Adding a User or User Group to

the PermissionsTable" on page 5-49 for more information.

Best Practice

Ektron suggests assigning user groups to the approval chain, as opposed to

individual users. In thisway, if someone is out of the office for a day, another group

member can approve the content.

5. Click the user or user group to add to the approval chain.

6. A confirmation message appears.

7. Click OK.

See Also: "Creating an Approval Chain for a Content Folder" on page 5-30

Note: If you assign a user group to an approval chain, anymember of the group can approve the content, not all

members.
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Editing the Approval Order
After you assign approvers to a folder, you may want to adjust the approval order. Place the

user or group with final review at the end of the approval chain (that is, the highest number).

For example, if you have a content contributor whose edits must be approved by a department

head, and the Webmaster has final review of all content, the approval order would look like

this.

User or Group Name Approval Order

Content contributor 1

Department Head 2

Webmaster 3

To edit the approval order, follow these steps.

1. Access the approval table as described in "Viewing a Folder’s Approval Chain" on page 5-

31.

2. Select the language.

3. Click the Reorder button ( ).

4. The Edit Approval Order screen appears.

5. Click the user or group whose approval order you want to change.

6. Click the Up ( ) or Down ( ) arrow to move the user or group to the desired order.

7. Click the Save button ( ).

See Also: "Creating an Approval Chain for a Content Folder" on page 5-30
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Deleting Approvers

Note: If a user in an approval chain is deleted from the permissions table, he or she is automatically deleted from

the approval chain.

To delete a user or user group from an approval chain, follow these steps.

1. Access the approval table as described in "Viewing a Folder’s Approval Chain" on page

5-31.

2. Select the language.

3. Click the Remove button ( ).

4. The Remove Approval screen appears.

5. Click the user or group that you want to remove from the approval chain.

6. A confirmation message appears.

7. Click OK.

See Also: "Creating an Approval Chain for a Content Folder" on page 5-30

Editing an Approval Chain For
Content
At times, you may need to change the approval chain for a specific content item. Use the

Approvals button ( ) on the View Content screen to change a content item’s approval chain.

Viewing an Approval Chain for Content

To view the approval chain for content, follow these steps.

1. Navigate to the folder that contains the content.

2. Click the content.

3. Click the View Approvals button ( ).

4. Uncheck the checkbox next to Allow this object to inherit permissions.

5. Return to the View Content screen.

6. Click the Approvals button ( ).

7. The content’s approvals table appears.
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After viewing the content’s approval chain, you can perform the same actions on it as you can

perform on a folder. This list of actions is available from .

Approve/Decline One Content Item
1. Click the Smart Desktop button.

2. Click Reports.

3. Click Approvals.

4. Click the content you want to approve or decline.

To select all displayed content, click Select All at the top of the screen.

5. The content appears. You can view the content, summary, metadata, etc.

A toolbar at the top of the screen lists tasks you can perform on the content.
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Button Name Result of Clicking

Publish

Accept changes to the content and publish it to the site.

Note: If there is another approver in the content’s approval chain, this is

replaced byaSUBMIT button.

If you clickPublish but the content item hasan incomplete taskassigned to

another user, the content cannot be published. Instead, the following error

message appears.

The user to whom the task is assignedmust complete it before you can

publish the content.

Decline

Reject changesand keep current version of content live onWeb site. You

are prompted to enter a comment that providesa reason for the decline.

The author whomade the change is notified byemail of the decline.

The content inserted by the last editor remains in the file. If you do not want it

to remain, choose theEdit option.

Edit Checkout content and change it if desired.

View

Published/Staged

Toggle between published and submitted versionsof content. This can help

you compare versions. See Also: "Staged Content" on page 7-139

View Diff

View differencesbetween the version awaiting approval and the published

content.

See Also: "Comparing Versionsof Content" on page 7-120

Back Return to previous screen.

Approve/Decline Several Content
Items
To approve several submitted content items without reviewing them, follow these steps.

1. Select the submitted content you want to approve, as described in .

2. Click the Approve All button ( ).

3. The following message appears.
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4. To continue, click OK.

5. The approved content is either submitted to the next publisher, published immediately to

the Web site, or deleted, depending on the approval chain set for the content.

Example of an Approval Chain
The approval chain begins when a content contributor submits a new or edited content. If

email is enabled, an email is sent to the next approver in the approval chain.

The following example follows a typical content block from creation to publication. Three

users make up this approval chain.

n Sports Writer - creates sports content

n Sports Editor - edits and publishes all sports articles

n Editor In Chief - edits and publishes all articles

Each user has different permissions that correspond to their roles.

The example uses the following topics to explain a typical approval chain.

n "Creating Content" on page 5-37

n "First Approver" on page 5-38

n "Second Approver" on page 5-40

Creating Content
The first step is to create content. To create new content, follow these steps.

1. Log in to Ektron CMS400.NET as a SportsWriter.

2. Create content, as described in "Adding HTML Content" on page 7-15.

3. Click the Submit button ( ).
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4. The content is placed into the approval chain. The next user in the chain receives an email

saying the content is ready for approval.

Note: Emails are only sent if your administrator enables them.

The content contributor, Sports Writer, has completed his role in the approval chain but

continues to receive emails notifying him of changes in the content’s status.

First Approver
After Sports Writer submits the content, the first user in the approval chain, Sports Editor,

receives an email stating content needs his approval. He can change and approve the content

or decline it.

Sports Editor logs into Ektron CMS400.NET, navigates to his desktop, where he sees the Content

Awaiting Approval panel.

Example of an Approval Chain
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He clicks the View All link and sees all content awaiting his approval.

The approvals folder window displays information such as title, who submitted it, go live date,

etc. The Sports editor clicks the submitted content.

The View Content Awaiting Approvals window appears listing all information necessary to

decide whether to approve or decline the content.

At the approval window, the Sports Editor has these options.

Button Result

Approve
Send content to next approver in approval chain.

Decline

1. Send email to creator, notifying him/her that content wasdeclined.

2. Remove content from approval chain.

Edit
Invokes the editor. From here, the approver can change the content.

Managing Folders

5-40
ReferenceManual

Version 8.0 Rev 1.3



For demonstration purposes, we‘ll choose Approve.

Second Approver
After the content is approved, the next approver in the approval chain receives an email saying

that the content is ready for approval.

EditorInChief logs in to Ektron CMS400.NET and accesses his Workarea. The Workarea has

an Approval folder with the content awaiting his approval. EditorInChief navigates through

the Approval folder until he finds the content Red Sox win World Series.

From this window, EditorInChief can view information about the content, including title, go

live date, user who created it, etc. He then clicks the content he wants to approve.

This window is similar to the previous approver’s but includes a Publish button at the top of

the screen. The EditorInChief has a publish button (instead of a submit button) because he is

the last approver in the approval chain. When he approves the content, it is published to the

Web site.

Like the Sports editor, the EditorInChief has the following options.
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Button Description

Publish Publish the content.

Decline

1. Sendsan email to the creator, notifying him/her that content wasdeclined.

2. Removes content from the approval chain.

Edit Invokes the editor. The approver changes the content.

After reviewing the content, the EditorInChief decides it is great and publishes it. At this point,

the content becomes live on the Web site, and the approval chain is complete.

The user who created the content receives an email notifying him that it was published.

The Approval Method
The Approval Method determines if content must be approved by all users in the chain, or only

users higher up in the chain than the user making the edits. The approval method only affects

the approval process if the person submitting content for publishing is a member of the

approval chain.

Two approval methods are available.
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Approval Method Description

Force All Approvers
Allusers in approval chainmust approve the content, beginning with the

first

Do Not Force All

Approvers

Approversafter the user submitting content in the approval chainmust

approve the content

For example, assume the approval chain is set as below.

User or Group Name Approval Order

Content contributor 1

Department Head 2

Webmaster 3

If the Approval Method is Force All Approvers, and the Department Head submits content,

the content must be approved by the content contributor, then the department head, and the

Webmaster before it is published.

If the Approval Method is Do Not Force All Approvers, and the Department Head submits

content, the content must only be approved the Webmaster before it is published.

Changing the Approval Method

By default, the approval method is set to Do Not Force All Approvers. To change the

approval method for a content folder or item, follow these steps.

1. Access the approval table, as described in .

2. Click the Edit button ( ).

3. The Edit Approval Method screen appears.

4. Select an approval method by clicking the radio button.

5. Click the Save button ( ).
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Folder Permissions
Permissions determine which actions users and members of user groups can perform on content,

library items, and content folders. For example, you allow your Webmaster to perform the most

advanced actions, such as adding folders, editing folder properties, and deleting folders. At the

same time, you could restrict content contributors to viewing, editing, and adding new content.

You can set permissions for a content folder or content item. When you assign permissions to a

content folder, it affects all of its subfolders unless you break inheritance for a subfolder.

Permissions are more fully explained through the following topics:

n "Who Is Authorized to Set Permissions" on page 5-43

n "Setting Permissions through the Permissions Table" on page 5-43

n "Inheritance" on page 5-44

n "Standard & Advanced Permissions" on page 5-45

n "Setting Permissions for a Content Folder" on page 5-47

n "Setting Permissions for Content" on page 5-51

Who Is Authorized to Set Permissions
Only Ektron CMS400.NET administrators and users identified on the Manage Members for

Role: Folder User Admin screen can set permissions. See Also: "Using the Roles Screens" on

page 15-33

Setting Permissions through the
Permissions Table
Warning! Allmembers of the Administrators group are automatically granted all permissions to all Ektron

CMS400.NET folders. Although these users do not appear when you view a folder’s permission settings, they

have full permissions.

You manage the following permissions through the Permission Table (illustrated below).

n Content management: view, add, edit, delete, restore

n Library File Management: view, add images, add other types of files, add hyperlinks,

overwrite files
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n Folder management: add, edit, delete, traverse

n Work with Collections and Menus

Note: You can use the Roles screens to assign additional permissions that are not defined in the Permission

Table, such as the ability to create tasks. See Also: "Defining Roles" on page 15-32

The Permission Table appears when you click the Permission button ( ) from a folder’s or
content item’s Properties window.

Best Practice

If you need to assignmultiple users the same permission, Ektron recommends

placing them in a user group and assigning the group to the Permission Table. If you

assign toomanyusers in the Permission Table, your system's response timemay

degrade.

Inheritance
By default, all content folders and items inherit permissions from their parent folder. You have

two options for modifying permissions.

n Modify the permissions of the parent folder - see "Setting Permissions for a Content

Folder" on page 5-47

n Break inheritance and add permissions to a folder

Inheritance
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Breaking Inheritance

To break inheritance from a parent folder, follow these steps.

1. Access the Permissions Table for a content folder or content in your Workarea, as

described in "Accessing the Permissions Table" on page 5-47.

2. Remove the check mark from the box that says Allow this object to inherit permissions.

3. A confirmation message appears.

4. Click OK.

Restoring Inheritance

To restore inheritance for a content folder or content, follow these steps.

1. Access the Permissions Table as described in "Accessing the Permissions Table" on page 5-

47.

2. Place a check in the box that says Allow this object to inherit permissions.

3. A confirmation message appears.

4. Click OK.

Standard & Advanced Permissions
There are two categories of permissions. You assign permissions in each category from a

different screen.

n Standard Permissions - basic functions

n Advanced Permissions - administrator level functions

The following table explains the permissions in Ektron CMS400.NET.
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Category Permission
Allows user/user group to perform this action on content

in selected folder

Standard

ReadOnly View content

Edit Edit content

Add Add content

Delete Delete content

Restore Restore old versionsof content

LibraryRead

Only

View items in the corresponding library folder

See Also: "LibraryFolder" on page 8-1

Add Images Upload images to the corresponding library folder

Add Files Upload files to the corresponding library folder

Add Hyperlinks Add hyperlinks to the corresponding library folder

Overwrite

Library
Overwrite imagesand files to the corresponding library folder

Advanced

Collections Manage collectionsSee Also: "Working with Collections" on page 9-99

Add Folders Add sub foldersSee Also: "Adding Subfolders" on page 5-19

Edit Folders Edit folder propertiesSee Also: "Folder Properties" on page 5-13

Delete Folders Delete the current folder or its subfolders

Traverse

Folders

Access folders under the root folder. Bydefault, the Everyone user

group haspermission to view all subfolders.

If you disable or modify the Everyone user group, and you want to

grant users/groupspermission to a folder other than the root folder,

youmust also assign Traverse permission. If you do not, the user

cannot access the folder. In that case, the user cannot perform any

other granted permissions.

Modify

Preapproval

Set or update a folder’s preapproval group. See Also: "Automatic

Creation of TasksAssociated with Content" on page 11-34
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Setting Permissions for a Content
Folder
You can set permissions for any content folder and language from the Folder Properties screen.

Circled below is the Permissions button on the Folder Properties screen.

Accessing the Permissions Table

To access the Permissions Table, follow these steps.

1. Select a content folder from the left frame of the Workarea.

2. Click View.

3. From the language dropdown, select the language whose folder properties you want to

update.

4. Click View > Properties. The Folder Properties screen appears.

5. Click the Permissions button ( ).

6. The Permissions Table appears.
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The Permissions Table displays each user’s abilities to perform actions on content within the

selected folder. Since all permissions cannot fit on one screen, you can click View Advanced

Permissions to see the other group.

After viewing the permissions, you can change them. Below is a list of actions you can

perform from this screen.

Actions You Can Perform from the Permissions Table
The following table summarizes actions you can perform from the Permission Table screen.

Action How to perform it
For more information,

see

View advanced

permissions
Click View Advanced Permissions

"Setting Permissions for a

Content Folder" on page 5-

47

Add user or group to

permission table Click

"Adding a User or User

Group to the Permissions

Table" on page 5-49

Remove user or

group from

permission table
Click

"Deleting Users or User

Groups from the

PermissionsTable" on page

5-50

Viewmembership

users
ClickView MemberShip users

"Community Folders" on

page 5-22

Have this folder

inherit permissions

from parent folder

Checkboxnext toAllow this object

to inherit permissions

"Setting Permissions for a

Content Folder" on page 5-

47

Setting Permissions for a Content Folder

ReferenceManual

Version 8.0 Rev 1.3
5-49



Action How to perform it
For more information,

see

Make content in this

folder private

Checkboxnext to The content in

this folder is private and can only

be viewed by authorized users

and members

Note: IfAllow this object to inherit

permissions is checked, you cannot

check this box. In that case, this folder

is inheriting this setting from its parent

folder.

"Private Content" on page 7-

191

See Also:

n "Adding a User or User Group to the Permissions Table" on page 5-49

n "Editing User or User Group Permissions" on page 5-50

n "Deleting Users or User Groups from the Permissions Table" on page 5-50

Adding a User or User Group to the Permissions Table
To add a user or user group to the Permissions Table, follow these steps.

Note: Before adding usersor groups, youmust break inheritance. See "Setting Permissions for a Content Folder"

on page 5-47.

Note: If a user and the user group to which that user belongsare both given permission to a folder, the user hasall

permissions to which he/she is assigned aswell as permissionsassigned to the user group.

Note: You can only assign ReadOnly permission to aMembership user or user group. See Also: "Membership

UsersandGroups" on page 16-4

1. Access the Permissions Table for the content folder or content, as described in "Accessing

the Permissions Table" on page 5-47.

2. Click the Add button ( ).

3. The Add Permissions screen appears. Only users and groups not assigned to the

Permissions Table appear.

4. Click a user or group to add to the Permissions Table.

5. The Add Permissions screen appears.

6. Check the standard and advanced permissions for the user or group. Refer to "Setting

Permissions for a Content Folder" on page 5-47 for a description of permission options.
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Note: CheckEnable All to assign all standard permissions. If you do, you stillmust assign advanced permissions

byhand.

7. Click the Save button ( ).

Editing User or User Group Permissions
To add or remove permissions for a user or group, editing the user or group in the Permissions

Table. To do so, follow these steps.

1. Access the Permissions Table for the content folder or content, as described in "Accessing

the Permissions Table" on page 5-47.

2. Click the user or group for which you want to edit permissions.

3. The Edit Permissions screen appears.

4. To assign any permission, check the box. To remove any permission, uncheck the box.

Note: Remember to toggle between standard and advanced permissions.

5. Click the Update button ( ).

Deleting Users or User Groups from the Permissions
Table
To remove permissions from a user or user group, use the Delete button on the View

Permissions window. To do so, follow these steps.

1. Access the Permissions Table for the content folder or content, as described in "Accessing

the Permissions Table" on page 5-47.

2. Click the Delete button ( ).

3. The Remove Permissions screen appears.

4. Click the user or group to remove from the Permissions Table.

5. A confirmation message appears.

6. Click the OK button.

Note: When you delete the permissionsof a user or user group, that change is propagated to all subfoldersand

content. Also, if the user or group waspart of an approval chain, theyare removed from it.

See Also: "Folder Permissions" on page 5-43

Setting Permissions for a Content Folder

ReferenceManual

Version 8.0 Rev 1.3
5-51



Setting Permissions for Content
You can assign permissions to a single content item, overriding the default permissions

inherited from the folder. To do so, follow these steps.

1. Access the content by navigating to its folder, selecting a language, and clicking on it.

2. Click the View Permissions button ( ).

3. Uncheck the box next to Allow this object to inherit permissions.

4. A confirmation message appears. Press OK.

5. You can perform any action on the content that you can perform on a folder. These

options are described in "Actions You Can Perform from the Permissions Table" on page 5-

48.
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Overview

As the name suggests, PageBuilder is a tool that enables you to build Web pages in the Ektron

CMS400.NET. What makes PageBuilder unique as a Web page creation tool is two-fold:

n Firstly, it allows non-technical users a simple way to build rich and fully-featured Web

pages.

n Secondly, the Ektron development community can leverage PageBuilder as a simple way

to reuse and share common functionality from one Ektron-powered site to another.

PageBuilder leverages the versatility of Ektron Portal Framework to streamline the process of

building new pages on your Web site. Members of an organizations’ Web team can now more

efficiently make changes to pages and content, without relying on the availability of

developers. Ultimately, PageBuilder helps not only redefine roles within an organization, but

also maximizes efficiency and productivity.

In a typical PageBuilder scenario, the initial layout is managed by developers, while the final

content, design, and placement of functionality is managed by non-technical users who have a

need for creating specific Web pages. These non-technical, content authors would typically be

marketing departments or similar organizations.

PageBuilder for Developers

To someone new to PageBuilder, it might seem as though PageBuilder takes the work of

building and maintaining a Web site out of the IT department’s hands. However, this is not the

case. Web page developers still create page templates, building wireframes into which content

authors place functional widgets that will make the Web page a success. PageBuilder allows

the IT department to concentrate on what they do best: develop the back end of a system and

address the technical nuances that today’s Web sites generate. Content and messaging is out of

their hands and squarely where it belongs: in Marketing.

Wireframes, Dropzones, and Widgets
Page Builder requires developers to create a wireframe template. This wireframe is the basic

architecture for a Web page. As developers build wireframes, they add dropzone user controls

where non-technical users need to insert the content, design, and messaging of the site. These

zones are literally the areas into which someone can “drop” a widget.

Widgets are mini-applications that can provide either specific functionality (calculators, search,

and social bars, etc) or areas into which you can add Ektron CMS400.NET content (content

blocks, list summaries, collections, etc.). It is simple for developers to apply classes to these

pages. Developers can also manage the level of control non-technical users have. For example,

a developer can configure hard limits for the width of dropzones.
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After a wireframe is created, an administrator assigns it to a folder, creates a page, and selects

the widgets that will be available to place on that page.

PageBuilder for Everyday Users

Marketing teams (technical and non-technical alike) can build out entire pages on the

wireframe templates by dragging-and-dropping widgets. This creates the user experience on the

page while maintaining a consistent “look and feel.” With PageBuilder, they can launch

campaigns as needed and respond to market conditions rapidly with unique Web pages that

have targeted and effective content.

PageBuilder pages have the same business-level controls as content blocks. Like other Ektron

CMS400.NET content, PageBuilder pages maintain permissions, approval chains, enable SEO

(through metadata), Taxonomy, Aliasing, and allow users to view histories and restore past

versions.

Approvers can preview PageBuilder pages before they go live, and pages can be cloned and

then modified to maintain look and feel across campaigns or to support A/B split testing.
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Streamline Process and Improve Efficiency
PageBuilder adds a level of agility to key processes that overlap marketing and IT departments.

By using it to streamline the workflow of launching new pages, time and expenses can be

minimized. Moreover, your IT infrastructure remains secure because non-IT resources do not

need to access mission-critical servers — all needed assets are accessible through the Workarea.

The CMS400.NET PageBuilder is the logical evolution of the WYSIWYG editor, extending

the concept of content management beyond single elements of content. Now, that philosophy

can be applied to whole pages and even entire sites, boosting productivity and giving you the

tools you need to make your Web site do exactly what you want it to do.

PageBuilder Video

You can see a video explaining PageBuilder in more detail by visiting this URL:

http://ektron.vo.llnwd.net/o28/flashvideos/pagebuilder/FinalPageBuilder.html.

See Also:

n "Building Pages" on page 6-5

n "PageBuilder Code Samples" on page 6-30

n "Advanced PageBuilder Topics " on page 6-32
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Building Pages

Use Case: AcmeBooks.com
AcmeBooks.com is a fast growing company that specializes in foreign and hard-to-find books.

Recognizing it needed a stronger presence on the Web, it recently installed and deployed

Ektron CMS400.NET.

The Chief Information Officerof Acme Books is especially excited about the company’s recent

move to CMS400.NET. She is particularly interested in PageBuilder, feeling it will enable the

Marketing team to respond to changing market conditions and quickly launch and

communicate promotions on the AcmeBooks.com Web site. She is also pleased that

PageBuilder promises to appease the company’s Web site developers. No longer will they have

to deal with numerous daily requests for content changes from Marketing.

So, she wonders, “How does it all work? How will the Web team work together to use

PageBuilder?” Right now, the team is composed of herself and:

Pete. He runs the Web Development team (including designers).

Grace. She is the CMS/Web site administrator.

Pierre. Acme Books' Marketing guru. He is also in charge Marketing and Acme Books’

content authors.

See Also:

n "PageBuilder Workflow" on page 6-6

n "Steps to Creating a “PageBuilder” Page" on page 6-7

n "Create a PageBuilder Wireframe" on page 6-8

n "Enable Manual Aliasing" on page 6-13

n "Identify the PageBuilder Wireframe in the CMS" on page 6-14

n "Assign the PageBuilder Wireframe to a Folder" on page 6-15

n "Assign the PageBuilder Wireframe to a Folder" on page 6-15

n "Create the New Page" on page 6-18

n "Place Widgets on the Page" on page 6-20

n "Part 1: Add New Column and Set Column Widths" on page 6-22

n "Part 2: Insert New Content Block Widget into Right Column" on page 6-24

n "Part 3: Insert a List Summary Widget into Left Column" on page 6-27

n "Final Assessment" on page 6-29
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PageBuilder Workflow
Let’s start with the general PageBuilder workflow. Basically, there are three stages:

Envisioning the “Big Picture”

In the beginning, stakeholders define functionality and “look” needed on Web pages. At Acme

Books, this includes the CIO, the Marketing team, the CMS400.NET Administrators, and the

Web designers and developers in the IT department.

When a consensus is reached, Pete’s designers and developers define the page layout and

present it to the whole team for review and approval.

Designing and Development

Here, Pete’s developers identify page areas and build wireframes based on design

specifications. At this point, they should understand the functionality needed and use, modify

or build widgets based on the requirements.

Building PageBuilder Pages
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Implementation and Maintenance

When complete, a PageBuilder page is active and in use by Pierre and his team on a daily

basis. Pierre can create pages, drag-and-drop widgets, and edit properties as necessary. Subject

matter experts create and maintain content.

Steps to Creating a “PageBuilder”
Page
Creating a Web page with PageBuilder functionality at Acme Books consists of the following

tasks:

n "Create a PageBuilder Wireframe" on page 6-8. This is performed by Pete and his

developers.

Steps to Creating a “PageBuilder” Page
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n "Enable Manual Aliasing" on page 6-13. This is performed by Grace, the Web site

administrator.

n "Identify the PageBuilder Wireframe in the CMS" on page 6-14. This is performed by

Grace, the Web site administrator.

n "Assign the PageBuilder Wireframe to a Folder" on page 6-15. This is performed by Grace,

the Web site administrator.

n "Create the New Page" on page 6-18. This is performed by Pierre and his team.

n "Place Widgets on the Page" on page 6-20. This is performed by Pierre and his team.

Create a PageBuilder Wireframe
As explained earlier, Pete first creates a wireframe. Next, he defines dropzones, areas of the

page on which a content creator drags and drops widgets.

The relationship between a wireframe, a dropzone, and a widget is illustrated below.

Here is how Pete creates a wireframe that contains one dropzone.

1. He opens the Web site in Visual Studio.

2. He adds a new Web form to the site by clicking Web Site > Add New Item.
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3. He selects Web Form.

4. Pete sets the Name to PageLayout.aspx, the Language to Visual C#, and checks Select

master page.

5. He clicks Add, then changes to Source view.

6. He registers the following assemblies directly below the @ Page directive (at the top of

the file).
<%@ Register Assembly="Ektron.Cms.Widget" Namespace="Ektron.Cms.PageBuilder"

TagPrefix="PB" %>

<%@ Register Assembly="Ektron.Cms.Controls" Namespace="Ektron.Cms.Controls"

TagPrefix="CMS" %>

7. Next, he’ll drop a PageBuilder Menu and DropZone user control onto the page. When

rendered, a PageBuilder menu and control look like this.

.
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This control lets a content author drop widgets on the page. It also provides the save/check

in/publish functions, and lets the author preview how the page will look when it’s published.

When rendered on a page, a DropZone user control looks like this.

The content author uses a DropZone control as a placeholder, into which he will insert

widgets. He can also use it to insert additional placeholders as needed.

8. He switches Visual Studio from Source to Design view.

9. In the Visual Studio explorer, he finds the /Workarea/PageBuilder/PageControls folder.

10. He drags and drops the PageHost.ascx user control onto the page.
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11. The left panel now looks like this.

12. Below the PageHost control (below Pullchain), he drags and drops the Dropzone.ascx user

control onto the page.

13. He switches to source view.

Note: See "Advanced PageBuilder Topics " on page 6-32 for information on customizing user controls.

14. The screen now looks like this.
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Note: Ektron Best Practice is to set values for the FolderIDand SelTaxonomyIDproperties. See "How a Page’s

Default Folder isSet" on page 6-33 and "Assigning a Default Taxonomy to aWireframe" on page 6-37

Note that Pete adds only one dropzone now. He plans to add more later.

15. Pete is finished with the user control file and is ready to begin working on his codebehind

file.

16. Pete opens the codebehind page, PageLayout.aspx.cs.

17. He adds a reference to the PageBuilder namespace by adding the following line after the

last using statement.
using Ektron.Cms.PageBuilder;

18. Inherit the PageBuilder class instead of System.Web.UI.Page. To do this, change:
public partial class PageLayout : System.Web.UI.Page
To:
public partial class PageLayout : PageBuilder

19. Pete adds the following code, which handles errors and notifications, after the Page_Load

event.

Note: You can copy the following code from siteroot/developer/pagebuilder/pagelayout.aspx.cs.

public override void Error(string message)

{
jsAlert(message);
}
public override void Notify(string message)
{
jsAlert(message);
}

public void jsAlert(string message)
{
Literal lit = new Literal();
lit.Text = "<script type=\"\" language=\"\">{Ø}</script>";
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lit.Text = string.Format(lit.Text, "alert('" + message + "');");
Form.Controls.Add(lit);
}

He does not need to use the jsAlert system defined here. If he doesn’t, Pete must somehow add

overrides to handle errors and notifications to the codebehind.

20. Save the PageLayout.aspx and PageLayout.aspx.cs files.

Enable Manual Aliasing

Note: The Ektron “best practice” is to enableManual and Auto aliasing.

Pete’s development team needs to make sure that manual aliasing is enabled within Ektron

CMS400.NET. Doing this allows you to apply a user-friendly URL when you’re creating a

PageBuilder page, as shown below.

Note: See “"URL Aliasing" on page 10-1 for more information.

To enable manual aliasing, the development team does these steps.

1. In the Ektron CMS400.NET Workarea, they go to Settings > Configuration > URL

Aliasing > Settings.

2. They select Manual, then click Save ( ).
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Identify the PageBuilder Wireframe
in the CMS
In this step Grace, the CMS administrator, makes the wireframe that Pete created available

within the Ektron CMS400.NET Workarea.

1. In the Ektron CMS400.NET Workarea, she goes to Settings > Configuration > Template

Configuration.

2. She clicks the Add button ( ).

3. The Add a New Template screen appears.

4. Grace clicks the browse button and navigates to PageLayout.aspx, the wireframe Pete
created earlier in "Create a PageBuilder Wireframe" on page 6-8.

5. She clicks the PageBuilder Wireframe check box. This box tells Ektron CMS400.NET that

this template can be used to create a PageBuilder page.

All widgets that can be applied to the template appear. Ektron CMS400.NET provides over 30

standard widgets. See "Standard Widgets" on page 21-404.

Note: "Creating Your OwnWidgets" on page 21-386 explainshow to create a customwidget.
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6. Grace clicks the ContentBlock and List Summary widgets. When she does, their

background color changes.

7. She clicks Save ( ).

Assign the PageBuilder Wireframe to
a Folder
Here, Grace creates a folder for the content that will appear on the new page. To accomplish

this, she does the following.

1. Grace clicks the Content tab in the Ektron CMS400.NET Workarea. All folders appear in

the left panel.

2. She clicks the Root folder (highlighted below).

Note: For more information about folder permissionsand approval chains, see "WorkFlow" on page 5-28.
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3. She clicks New > Folder.

Grace knows that it is an Ektron best practice to keep content and PageBuilder pages in

separate folders, so she will later create and configure a folder called “Content”. The content

folder will simply contain content blocks and other assets, as well as sub-folders.

4. She accesses the folder properties for the new folder.

5. In the Name field, she types Pages.

Next, Grace assigns the template created earlier as the default (and only) template for this

folder. This will ensure that only PageBuilder pages can be created in this folder.

6. Grace clicks the Templates tab.

7. Grace clears the Inherit Parent Template Configuration option and clicks OK at the

prompt.

Note: For more information about folder inheritance, see "Folder Permissions" on page 5-43.
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8. She selects PageLayout.aspx from the template list. This is the wireframe Pete created

earlier.

9. She clicks the Add button ( ) to the right of the pull-down menu. PageLayout.aspx is
now added to the list of page templates.

10. She deletes CMSlogin.aspx from the list to ensure that no content is placed in the folder.

11. Grace selects PageLayout.aspx (the default option, circled below) and clicks Save( ).

.

12. Grace will follow steps 3 through 6 to create a folder for content. However, this time,

instead of assigning pagelayout.aspx as the template, she will assign a template used to

create Ektron CMS400.NET content.
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Create the New Page
It’s time for Pierre and his team to create a PageBuilder page. Currently, at AcmeBooks.com,

there is a pressing need to market a new series of mystery novels from an up-and-coming

Australian novelist. So, the Marketing team needs to quickly create a Web page to announce

the new series. Here’s how they build the page with PageBuilder.

Warning! When you edit Pagebuilder pages in the Ektron CMS400.NET Workarea via Internet Explorer, IE ver-

sion 7 or higher is required.

1. They click the Pages folder, which was created in "Assign the PageBuilder Wireframe to a

Folder" on page 6-15.

2. They click New > Page Layout.

3. The Add New Page screen appears.
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4. Since only one template is assigned to the folder, it appears as the default. Click Next.

5. A new screen appears.

This allows the team to assign a title, taxonomy, and aliasing information to the page.

6. The team enters New Australian Mystery Series in the Page Title field.

7. By default, the Manual Alias matches the Page Title. The Marketing team changes it to

Australian_Mystery.

They do this in the Alias field so the new page has a user-friendly name. For example, by

default, the page’s name is www.acmebooks.com/new_mystery_series.aspx. The alias Australian_

Mystery lets the page display as www.acmebooks.com/Australian_Mystery.

8. Click Next.
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9. The following screen appears.

This allows the team to assign metadata and a summary to the page. See Also: "Working with

Content Summary" on page 7-142; "Working with Metadata" on page 7-146

10. Click Finish.

11. The following message appears. Press OK.

Place Widgets on the Page

Note: For information about how to create a widget, see "Creating Your OwnWidgets" on page 21-386.

After Pierre and the Marketing team create the page, a new page opens. It contains one

dropzone, which consists of two Add Column buttons and two columns (shown below).

Building PageBuilder Pages

6-20
ReferenceManual

Version 8.0 Rev 1.3



The top of the page contains a PageBuilder menu control. Pierre will use it to perform actions

on the page, such as check in, view properties, and drop widgets onto the page.

Pierre uses the right/left arrow buttons (circled below) to open and close the PageBuilder

menu.

Pierre determines that the page needs a two-column layout, as shown below.
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Note: Although you can drop existing content onto the page, theMarketing teamwill create new content on the

page.

n The left column is 35% wide and displays a list of all content in the Marketing folder.

Web site visitors use the list to access all Marketing collateral for AcmeBooks.com.

n The right column is 65% wide and displays a single content block.

Pierre’s Marketing team creates this layout in three steps:

n "Part 1: Add New Column and Set Column Widths" on page 6-22

n "Part 2: Insert New Content Block Widget into Right Column" on page 6-24

n "Part 3: Insert a List Summary Widget into Left Column" on page 6-27

Part 1: Add New Column and Set
Column Widths
In this part of the procedure, the Marketing team adds a second column to the right of the top

one. Then, they set the width of both columns.

1. They click the Add Column button, and a new column appears to the right of the existing

one.
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2. They set the left column width to 35% by clicking the pencil icon (circled below).

3. A field lets them enter a width and measurement (pixels or percent).

4. So, they enter 35 into the New Width field, change the measurement to Percent, and click

Save.

5. Then, the team sets the right column to 65% width by clicking the pencil icon, changing

its width to 65 Percent, and clicking Save.

6. Now the screen looks like this.
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Part 2: Insert New Content Block
Widget into Right Column
Now that Pierre’s team has set up the columns, Pierre is eager to try inserting a ContentBlock

widget into the right column.

1. From the small block in the center of the PageBuilder menu, Pierre clicks the down arrow

(circled below).

Note: Pierre tells his team that if theydo not see the PageBuilder Menu, look for small blockwith two arrows, one

orange and one blue (shown right). Click the orange arrow to open themenu.

2. All widgets that the Web site administrator (Grace) assigned to the page wireframe in

"Identify the PageBuilder Wireframe in the CMS" on page 6-14 appear.

3. Pierre places the cursor over the content block widget and drags it below the widget panel.

4. The widget panel disappears.

5. Pierre drops the content block widget in the right column.
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6. That column looks like this.

7. Pierre clicks the pencil icon (circled above), and the following screen appears.

8. He selects the Content folder, and clicks New in the lower right corner (circled above).

9. The Add Content screen appears.

10. In the Title field, Pierre enters New Australian Mystery Series.
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11. In the content area, he enters some text about the series of books, and clicks the Check In

button ( ).

12. The content displays as shown below.

13. When the Marketing team wants to edit content on this page, they can click the Access

Point in the upper left corner. A menu displays.
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Part 3: Insert a List Summary Widget
into Left Column
Now that Pierre has inserted content in the right column, he can insert a List Summary widget

in the left column.

1. From the PageBuilder menu, he clicks the down arrow (circled below).

2. All widgets Grace (the CMS administrator) assigned to the page wireframe in "Identify the

PageBuilder Wireframe in the CMS" on page 6-14 appear.

3. Pierre places the cursor over the List Summary widget and drags it below the widget

panel.
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4. The widget panel disappears.

5. He drops the List Summary icon in the left column.

6. That column looks like this.

7. The widget displays a list summary for content in the root folder. Pierre needs to change it

to refer to the Content folder. To do that, he clicks the pencil icon in the widget’s top

right corner (circled above).

8. The following screen appears.

9. He clicks the Folder tab and selects the Content folder.

10. He clicks Save, and the list summary shows content in the Content folder.
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11. From the PageBuilder menu, Pierre clicksFile > Check In.

12. The whole Marketing team can now review the page in Preview mode and make sure it is

formatted properly.

13. If they need to change it, they can click File > Edit from the PageBuilder menu.

Final Assessment
The CIO of AcmeBooks.com is can see the power of the PageBuilder, and is convinced that

this will greatly increase effectiveness of the company’s Marketing and sales goals. The simple

workflow and ease of use will help the Marketing team quickly deploy and launch marketing

campaigns and keep the Web site fresh and dynamic.

She still has one lingering question:

“How on earth do you build a widget?”
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PageBuilder Code Samples

The following shows a complete example of pagelayout.aspx

PageLayout.aspx
<%@ Page Language="C#" AutoEventWireup="true" CodeFile="PageLayout.aspx.cs"

Inherits="Developer_PageBuilder_PageLayout" %>
<%@ Register Src="~/Workarea/PageBuilder/PageControls/PageHost.ascx" TagName="PageHost"
TagPrefix="PB" %>
<%@ Register Src="~/Workarea/PageBuilder/PageControls/DropZone.ascx" TagName="DropZone"
TagPrefix="PB" %>
<%@ Register Assembly="Ektron.Cms.Widget" Namespace="Ektron.Cms.PageBuilder"
TagPrefix="PB" %>
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN"

"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd">
<html xmlns="http://www.w3.org/1999/xhtml">
<head runat="server">
<title>Page Builder Sample</title>
</head>
<body>
<form id="form1" runat="server">
<div>
<PB:PageHost ID="ucCms400Developer" FolderID="382" runat="server" />
<PB:DropZone ID="top" AllowAddColumn="true" AllowColumnResize="true" runat="server">
<ColumnDefinitions>
<PB:ColumnData columnID="0" unit="percent" width="100" />
</ColumnDefinitions>
</PB:DropZone>
</div>
<div>
<PB:DropZone ID="bottom" AllowAddColumn="true" AllowColumnResize="true" runat="server">
<ColumnDefinitions>
<PB:ColumnData columnID="0" unit="percent" width="100" />
</ColumnDefinitions>
</PB:DropZone>
</div>
<div>
</div>
</form>
</body>
</html>

PageLayout.aspx.cs

The following shows a complete example of pagelayout.aspx.cs

using System;
using System.Data;
using System.Configuration;
using System.Collections;
using System.Web;
using System.Web.Security;
using System.Web.UI;
using System.Web.UI.WebControls;
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using System.Web.UI.WebControls.WebParts;
using System.Web.UI.HtmlControls;
using Ektron.Cms.PageBuilder;
public partial class Developer_PageBuilder_PageLayout : PageBuilder
{
protected void Page_Load(object sender, EventArgs e)
{
}
public override void Error(string message)
{
jsAlert(message);
}
public override void Notify(string message)
{
jsAlert(message);
}
public void jsAlert(string message)
{
Literal lit = new Literal();
lit.Text = "<script type=\"\" language=\"\">{0}</script>";
lit.Text = string.Format(lit.Text, "alert('" + message + "');");
Form.Controls.Add(lit);
}
}
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Advanced PageBuilder Topics

This section covers the following advanced topics that help you implement PageBuilder more

fully.

Wireframes:

n "Customizing the PageBuilder Menu Control" on page 6-32

n "Customizing the DropZone User Control" on page 6-34

n "Assigning a Default Page to a Wireframe" on page 6-35

n "Assigning a Default Taxonomy to a Wireframe" on page 6-37

Widgets:

n "Applying Global and Local Properties to Widgets" on page 6-41

n "Adding a Field to a Widget" on page 6-44

n "Including Help for a Widget" on page 6-45

n "Opening a Widget’s Edit Properties Screen in a Modal Dialog" on page 6-46

n "Working with JavaScript and Cascading Style Sheets" on page 6-39

n "Verifying that a Page is a PageBuilder Page" on page 6-40

Customizing the PageBuilder Menu
Control
You can customize the PageBuilder Menu user control’s behavior in the following ways.

n "Determining the Ektron CMS400.NET Folder to Which Pages are Saved" on page 6-33

n "Changing the Page’s Cache Interval" on page 6-34
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Determining the Ektron CMS400.NET Folder to Which
Pages are Saved

How a Page’s Default Folder is Set
By default, when a site user creates a new PageBuilder page from an existing one, it is saved

to the same Ektron CMS400.NET folder. For example, consider this folder/content structure.

Root (folder id 0)
Products (folder id 20)
PageLayout: “Omaha Mailorder Steaks” (content id 35)
Services (folder id 30)

If you are viewing content id 35 and click New Page or Copy/Save as, the new page is saved

to that content’s folder (Products, folder id= 20).

Note: When you create a new page layout from theWorkarea, you first select a folder then begin creating the

page layout.

Overriding the Default Folder
Use the PageBuilder control’s FolderID property to override the default and specify an Ektron

CMS400.NET folder to which new pages are saved. Here is an example of that property:

<ucPageBuilder:PageHost ID="ucPageHost1" FolderID="25" runat="server" />

When a user is working on a page that hosts this PageBuilder control, and he saves a new

page, it is saved to folder id 25.
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Changing the Page’s Cache Interval
Use the CacheInterval property to cache a page and its Widgets that represent Ektron

CMS400.NET server controls, such as a Collection Widget.

This property sets the amount of time, in seconds, that data is cached. The default is 0 (zero).

<ucPageBuilder:PageHost ID="ucPageHost1" CacheInterval="25" runat="server" />

Customizing the DropZone User
Control
Three properties lets you customize the DropZone user control’s behavior in the following

ways.

n "Letting Users Add Columns to a DropZone" on page 6-34

n "Letting Users Resize a Dropzone" on page 6-34

n "Setting a DropZone’s Column Widths Programmatically" on page 6-35

Letting Users Add Columns to a DropZone
Use the AllowAddColumn property to let users add columns to a DropZone.

<ucPageBuilder:DropZone ID="ucDropZone1" AllowAddColumn="true" Allow-

ColumnResize="true" runat="server" />

For example, a Dropzone initially contains one column, but the page creator wants three. If this

property is set to true, this change is possible.

This property’s default value is true.

Letting Users Resize a Dropzone
Use the AllowColumnResize property to let users change the width of columns in a DropZone.

<ucPageBuilder:DropZone ID="ucDropZone1" AllowAddColumn="true" Allow-

ColumnResize="true" runat="server" />

For example, column width is 100% by default. A page creator wants to change it to 50%. If

this property is set to true, this change is possible.

This property’s default value is true.

Building PageBuilder Pages

6-34
ReferenceManual

Version 8.0 Rev 1.3



Setting a DropZone’s Column Widths
Programmatically
If you want to set a dropzone’s column widths programmatically, follow these steps.

1. Add the following Register statement to the page’s <head> tags.
<%@ Register Assembly="Ektron.Cms.Widget" Namespace="Ektron.Cms.PageBuilder"

TagPrefix="PB" %>

Warning! TheWidget and Dropzone assembliesmust have the same Tag Prefix. See example.

<%@ Register Src="~/Workarea/PageBuilder/PageControls/PageHost.ascx" TagPrefix="PB"

TagName="PageHost" %>
<%@ Register Src="~/Workarea/PageBuilder/PageControls/DropZone.ascx" TagPrefix="PB"

TagName="DropZone" %>

<%@ Register Assembly="Ektron.Cms.Widget" Namespace="Ektron.Cms.PageBuilder" Tag-

Prefix="PB"%>

2. Within the page’s <body> tags, add the following code. the following example adds three

columns of 100 pixels each.
<PB:DropZone ID="Middle" runat="server">
<ColumnDefinitions>
<PB:ColumnData width="100" columnID="0" unit="pixels"></PB:ColumnData>
<PB:ColumnData width="100" columnID="1" unit="pixels"></PB:ColumnData>
<PB:ColumnData width="100" columnID="2" unit="pixels"></PB:ColumnData>
</ColumnDefinitions>
</PB:DropZone>

Set width to an appropriate number. For the unit, the options are

n pixels

n percent

n em

If you set a dropzone’s column widths programmatically, you must also set the AllowAddColumn

and AllowColumnResize properties to false. If you do not, users working with widgets can add

columns and adjust column widths on the page, but their changes will revert to these settings

when they try to save.

Customizing the Wireframe

Assigning a Default Page to a Wireframe
You can assign a default page to a wireframe. If you do, and a site visitor enters a URL with a

path to that wireframe that lacks a query string ID, the default page appears. The following
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example explains this feature.

URL Returns this Page Layout content

http://site

root
/cms400developer/developer/PageBuilder

/PageLayout.aspx?pageid=1036

In the PageBuilder folder, PageLayout ID

1036

http://site

root/cms400developer/developer

/PageBuilder/PageLayout.aspx

(Note lackof query string parameter)

The Page Layout page identified in the

PageLayout.aspx file’sPageBuilder menu

user controlDefaultPageIDproperty.

To assign a default page to a wireframe, follow these steps.

1. In the Ektron CMS400.NET Workarea, create a PageBuilder page that will be used as the

default pageid for a wireframe.

2. In Visual Studio, open the wireframe file assigned to that folder.

3. Find the PageBuilder menu user control (circled below).

4. Add a new property, DefaultPageID.

5. For the property’s value, enter the ID of the page you created in Step 1.

Here is an example of that line with the DefaultPageID property added.

<ucPageBuilder:PageHost ID="ucCms400Developer" DefaultPageID=”1035” runat="server" />

6. Save your changes.

To continue the above example, if someone opens a browser and enters http://site

root/cms400developer/developer/PageBuilder/PageLayout.aspx, he is redirected to

http://site root/cms400developer/developer/PageBuilder/PageLayout.aspx?pageid=1035
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Assigning a Default Taxonomy to a Wireframe
While creating a new PageBuilder page in the Ektron CMS400.NET Workarea, the user can

assign one or more of the taxonomy categories that are set in the page’s folder properties. See

example below.

As a developer, you can assign a default taxonomy category to a wireframe. If you do, and the

user creating a page using that wireframe makes no changes, the default category is assigned to

the page. However, the user can change the taxonomy when the Add New Page screen

appears.

Note: Default taxonomiesare applied onlywhen a user logs into aWeb site and addsa new page -- theyare not

applied when creating new pageswithin theWorkarea.

To assign a default taxonomy category to a wireframe, follow these steps.

Prerequisite

The ID number and the name of the top-level parent taxonomy for the default taxonomy

category. For example, the screen below shows that the Photo category’s ID is 138, and its

parent taxonomy is Photo Gallery.
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1. In the Ektron CMS400.NET Workarea, navigate to the folder properties screen of the

folder to which the wireframe is applied.

2. Click the Edit button ( ).

3. Locate the Taxonomy tab of the Edit Folder properties screen.

4. If you will assign to the wireframe a top-level taxonomy (that is, one of those in the area

circled above), check its box.

5. If you will assign a taxonomy category (that is, a child node below a top-level taxonomy),

check the box of its parent Taxonomy.

6. Save your changes to folder properties.

7. Open Visual Studio.

8. Open the wireframe to which you will assign a default taxonomy.

9. Find the PageBuilder menu user control (circled below).
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10. Add a new property, SelTaxonomyID.

11. For the property’s value, enter the ID of the default taxonomy or category.

Here is an example of that control with the SelTaxonomyID property added.

<ucPageBuilder:PageHost ID="ucCms400Developer" SelTaxonomyID=”13” runat="server" />

12. Save your changes.

To continue the above example, the next time someone creates a page based on that wireframe,

taxonomy ID 13 will be the page’s default taxonomy category. If desired, the user can change

it by navigating to the Taxonomy tab and assigning different or additional categories.

Customizing Widgets
The following topics let you further customize widget behavior.

n "Working with JavaScript and Cascading Style Sheets" on page 6-39

n "Verifying that a Page is a PageBuilder Page" on page 6-40

n "Applying Global and Local Properties to Widgets" on page 6-41

n "Adding a Field to a Widget" on page 6-44

n "Including Help for a Widget" on page 6-45

n "Opening a Widget’s Edit Properties Screen in a Modal Dialog" on page 6-46

Working with JavaScript and Cascading Style Sheets
You can use JavaScript or a cascading style sheet to add custom functionality or styling to a

widget. To do this, place the JavaScript or cascading style sheet (css) instructions in an

external file, then register it in the codebehind file.
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Here is an example of including a JavaScript file.

void EditEvent(string settings)
JS.RegisterJSInclude(this, _api.SitePath + "widgets/contentblock/jquery.cluetip.js",

"EktronJqueryCluetipJS");

Here is an example of including a .css file.

Css.RegisterCss(this, _api.SitePath + "widgets/contentblock/CBStyle.css","CBWidgetCSS");

Warning! Youmust register JavaScript and .css files in an external file, as shown above. If you do not, the OnSub-

mit event placesHTML in the TextArea field in encoded brackets (< >) and generatesa dangerous script error.

The JS.RegisterJSInclude and Css.RegisterCss functions take three arguments.

Argument Description Example (from above code)

1

A reference to the control that

needs the script or style sheet on

the page. Typically, ‘this’ or ‘me’.

this

2

A unique key.

Only include the script specified by

a keyonce.

Your organization should develop a

standard way to define JavaScript

and .css keys.

n "EktronJqueryCluetipJS"

n “CBWidgetCSS”

3

The URL of the script or style sheet

being included.

Ektron recommendsprefixing the

URLwith a site path, so it can be

used with URLs like

http://localhost/ektrontech

and http://ektrontech.

n _api.SitePath + "widg-
ets/contentblock/jquery.cluetip.js"

n _api.SitePath + "widg-
ets/contentblock/CBStyle.css"

Note that Widgets use an update panel for partial postbacks. As a result, the ASP.NET tree

view and file upload controls do not work with widgets. Ektron CMS400.NET has

workarounds for these functions. For an example of a tree view, see the content block widget

(site root/widgets/contentblock.ascx). For an Ajax file uploader, see the flash widget (site

root/widgets/flash.ascx).

Verifying that a Page is a PageBuilder Page
Whenever your code is interacting with a widget, you need to verify that it is on a page

builder page (as opposed to another Ektron CMS400.NET page that hosts widgets, such as

personalization).

To check for this, insert the following code:

Ektron.Cms.PageBuilder.PageBuilder p = (Page as PageBuilder);
If(p==null) // then this is not a wireframe
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When you want to check the mode, use code like this.

If(p.status == Mode.Edit) // we are in edit mode

Applying Global and Local Properties to Widgets
Global and local widget properties reduce your development effort by eliminating settings data

classes. While you can still use these classes and manage your own serialization, for the vast

majority of types, the built-in engine performs all the work necessary.

Global properties apply to every instance of a widget. Local properties can apply to one

instance of a widget. If both local and global values are assigned to a property, the local

overrides the global.

As an example of using a local property to override a global, consider a ListSummary widget.

You may want its sort to mostly be by modified date in descending order, but in certain

instances you want to override that and sort by title in ascending order.

The following table explains how to set the different property types.

Type
Setting default value in

codebehind file
How to change default

Global

[GlobalWidgetData()]

public string

NewWidgetTextData {

get {return _

NewWidgetTextData;}

set {_NewWidgetTextData =

value;

}}

Workarea >Settings>Configuration >

Personalizations>Widgets

Local

[WidgetDataMember()]

public string New-

WidgetTextData {

get { return _New-

WidgetTextData; }

set { _NewWidgetTextData =

value;

} }

User dropswidget onto PageBuilder page, then

clicks edit button ( )

See Also: "Setting a Widget’s Global Properties" on page 6-42; "Setting a Widget’s Local

Properties" on page 6-43
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Setting a Widget’s Global Properties
A global property lets an Ektron CMS400.NET developer or administrator assign properties

and values that apply to all instances of a widget. You apply a global property to the widget’s

codebehind page. Administrators could then set or update the property’s value in the

Workarea’s Widgets screen.

For example, the BrightCove Video widget requires a player ID. You could insert that in the

widget’s codebehind file. Then, an administrator could review and possibly update that

information in the Workarea widgets screen. Whenever a user drops a BrightCove Video

widget onto a page, the player ID is already assigned.

If the developer does not set a default value in the codebehind, an administrator must set one

on the Workarea’s Widgets screen.

If the developer does set a default value in the codebehind, it will be applied unless changed

by an administrator on the Workarea’s Widgets screen.

Steps for Setting a Global Property
Follow these steps to set a global property.

1. Open the widget’s codebehind file, which is located in the site root/widgets folder.

2. In the properties section, insert the GlobalWidgetData attribute (shown below) to set the

global property’s name and type.
[GlobalWidgetData()]
public string NewWidgetTextData { get { return _NewWidgetTextData; } set { _

NewWidgetTextData = value; } }

Here is an example.

The supported types for GlobalWidgetData are

n Date Time

n int

n long

n double
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n boolean

n string

n any enumeration

1. Save the codebehind file.

2. In the Ektron CMS400.NET Workarea, go to Settings > Configuration > Widgets.

3. Click the edit icon ( ) for the widget whose codebehind file you edited in Step 1.

4. A dialog lets you view and edit global properties set in the codebehind file. See example

below.

Setting a Widget’s Local Properties
A local property lets an Ektron CMS400.NET user assign property values that apply to a

particular instance of a widget. For example, the BrightCove Video widget requires a Video

ID, which identifies the video that appears where you drop the widget.

To set a local property, follow these steps.

1. Open the widget’s codebehind file, which is located in the site root/widgets folder.
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2. In the properties section, insert the WidgetDataMember attribute to set the property. See

example below.
[WidgetDataMember(150530105432)]1
public long VideoID { get { return _VideoID; } set { _VideoID = value; } }

3. If you want to set a default value for the widget, use the attribute’s optional argument,

which follows [WidgetDataMember. In the example above, the value is 150530105432.

4. Save the settings in your properties by populating them as you normally would.

5. In the Save event, call _host.SaveWidgetDataMembers();. See example below.

Adding a Field to a Widget
This section provides an example of adding a Content type drop down to the List Summary

widget. The drop down lets the person dropping the widget on the page select from these

choices.

n all types of content

n HTML content only

n assets only

Here is what the drop down looks like once it is implemented.
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To add this drop down to the List Summary widget, follow these steps.

1. In Visual Studio, open the ListSummary widget, site root/widgets/ListSummary.ascx.

2. Find the text DisplaySelectedContent.

3. Below DisplaySelectedContent, add the following code to create a drop down list

for the ContentType property.
<tr>
<td>
DisplaySelectedContent:</td>
<td>
<asp:CheckBox ID="DisplaySelectedContentCheckBox" runat="server" />
</td>
</tr>
<tr>
<td>
ContentType:
</td>
<td>
<asp:DropDownList ID="ContentTypeList" runat="server">
<asp:ListItem Value="AllTypes">AllTypes</asp:ListItem>
<asp:ListItem Value="Content">Content</asp:ListItem>
<asp:ListItem Value="Assets">Assets</asp:ListItem>
</asp:DropDownList>
</td>
</tr>

4. Save the ListSummary.ascx file.

5. Open the codebehind file, ListSummary.ascx.cs.

6. In the properties region, declare a string variable for the ContentType property, as shown

below.
private string _ContentType;

7. Create a local property with default setting of AllTypes, as shown below.
[WidgetDataMember("AllTypes")]
public string ContentType { get { return _ContentType; } set { _ContentType = value; } }

8. In the EditEvent area, set the select list's value to ContentType.
ContentTypeList.SelectedValue = ContentType;

9. In the SaveButton_Click event, set ContentType as the select list's value.
ContentType = ContentTypeList.SelectedValue;

10. In the SetListSummary() function, set the List Summary server control's ContentType to the

CMSContentType property.
ListSummary1.ContentType = (CMSContentType)Enum.Parse(typeof(CMSContentType),

ContentType);

11. Save the ListSummary.ascx.cs file.

Including Help for a Widget
You can include help for any widget. The help is intended to guide the user who is dropping

the widget on the page and setting its properties.
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The help icon only appears when a user is editing a PageBuilder page. The icon appears both

when a user is viewing a widget and editing its properties.

It is not available to a page’s site visitors.

Defining a Widget’s Help File
To create a widget’s help file, follow these steps.

1. Create an HTML file with information for users who will drop the widget on the

PageBuilder page.

Note: You could create a content blockwithin Ektron CMS400.NET then switch to source view, copy the content

into a word processor (like Notepad), and save it with an HTML extension.

2. Save the help file to the folder that contains the widget.

3. Add the WidgetHost’s HelpFile property to the codebehind of the page that hosts the

widget. See example below.
protected void Page_Init(object sender, EventArgs e)
{
_host = Ektron.Cms.Widget.WidgetHost.GetHost(this);
_host.HelpFile = "~/widgets/myWidget/help.html";

Opening a Widget’s Edit Properties Screen in a Modal
Dialog
If your PageBuilder page has several columns, some property screens do not have adequate

space for data entry. See example below.
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If desired, you can display a widget’s properties screen in a modal dialog, which is much wider

and provides room for data entry. See example below.

To do this, use the ExpandOptions property in the widget’s codebehind file. Its type is

Ektron.Cms.Widget.Expandable, and it is an enumeration with three possible values.
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To have the edit button Use this option

Open amodal dialog, where the user can edit

properties

Within the widget’spage_init event, set

_host.ExpandOptions =

Expandable.ExpandOnEdit;

Provide a button that a user can click to open amodal

dialog

1. Within the widget’spage_init event, set

_host.ExpandOptions = Expand-

able.DontExpand;

2. In your Edit Event callback, update the property

to

_host.ExpandOptions = Expand-

able.ExpandOnExpand;

See "Option to DisplayPropertiesScreen asModal

Dialog" on page 6-48.

Show edit options in a regular window

Note: This is the default setting. You can do nothing

to achieve this result.

Within the widget’spage_init event, set

_host.ExpandOptions =

Expandable.DontExpand;

Option to Display Properties Screen asModal Dialog
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For an introduction to Ektron CMS400.NET content concepts, see

n "What is a Content Block?" on page 2-2

n Workflow in

n "The Lifecycle of Content" on page 2-5
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Working with Content From
Workarea vs. Web Site

You can perform many actions from either the Ektron CMS400.NET Workarea or your Web

site. In both cases, you must sign in before you can work with content.

Ektron CMS400.NET provides three types of dropdown menus that let you edit content. The

first menu is available within the Workarea. The second and third menus are available after

you log into your Web site.

n Workarea Content Menu - available within the Ektron CMS400.NET Workarea; lets you

edit content from the View Contents of Folder screen. See Also: "Workarea Content

Menu" on page 5-9

Note: TheWeb site menusdo not appear if you are in site previewmode. See Also: "Site Preview" on page 3-4.

n Web Site Server Control Menu - available after signing into an Ektron CMS400.NET Web

site. Lets you edit content from most server controls on a Web page. The options depend

on the control and user’s folder permissions. To display this menu, click the triangle to

right of content (see below).

n Web Site Content Menu - available after signing into an Ektron CMS400.NET Web site.

See Also: "The Web Site Content Menu" on page 7-4
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The Web Site Content Menu
After you sign in to your Web site, just above content you have permission to edit is a silver

access point (see illustration below). When you hover the cursor over it, a menu appears.

You can perform Ektron CMS400.NET tasks from the menu. Menu options vary depending on

the content’s status, your permissions, etc. The advantage of this feature is that you can see

how a Web page will appear to site visitors.

See Also:

n "Web Site Content Menu Options" on page 7-4

n "Hiding and Showing the Content Border" on page 7-6

Web Site Content Menu Options
The following table describes the menu options that may appear.

Button Name Description
More

Information

Add

Appears if you selected a language and the

content is not available in that language. Use this

button to copyexisting content into new content

Content
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Button Name Description
More

Information

and translate it to the new language.

Approve
Approve or decline a request to publish or delete

content

"Approve/Decline

OneContent

Item" on page 5-

35

Add Task Add a task to a user

"Managing

Tasks" on page

11-1

Delete
Open View Content page. From it, you can delete

the content.

"Viewing

Content" on page

7-9

Edit
Checkout content for editing; open in separate

window

"Editing HTML

Content" on page

7-105

Edit in

Context

Checkout content for editing; content remains

withinWeb page

"Edit in Context"

on page 7-107

Logout Log out ofWeb site

"Logging Out of

the Sample Site"

on page 3-5

New Poll Create new poll or survey

"Creating Polls

and Surveys" on

page 7-274

Preview Preview content before it is published
"Site Preview" on

page 3-4

Properties Open content’sView Content page

"Viewing

Content" on page

7-9

View

Content

Difference

Display differencesbetween previousand

currently-published version of content

"Comparing

Versionsof

Content" on page

7-120
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Button Name Description
More

Information

View

History

Open View History screen, where you can view

previous versionsof content

"Viewing and

Restoring

Previous

Content" on page

7-117

Workarea
OpenWorkarea. From here, you can perform all

Ektron CMS400.NET tasks.

"TheWorkarea

and Smart

Desktop" on

page 4-1

Hiding and Showing the Content Border
By default, the Ektron CMS400.NET provides the silver access point to indicate where the edit

menu is located. An alternate view of the edit menu can be seen by using borders around the

content areas. This is optional and can be set in the web.config file. To learn how to set this

option, see "Changing the Appearance of the Web Site Content Menu" on page 7-7.

Warning! When changing the border to hidden, theAdd andEdit buttons for menusare also hidden. This dis-

plays the page as it appearswhen you are not logged in. For information onmenus, see "Working with Menus" on

page 9-129.

You can hide the border that may surround content when you are logged into Ektron

CMS400.NET. This lets you view the page as it appears when not logged in.

When the border is hidden and you hover over a content area, there is no indication that it is

CMS400.NET content. However, you can still right click to access the menu.

TECHNICALNOTE

Note: Information about whether a border is hidden is stored in a cookie on a user’s system. This preserves the

information between sessions.

Hiding the Border
To hide the content border, right click a content block while logged in. Next, select Hide

Borders. The page refreshes, and no border appears.

This image shows the content with a border and menu.
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This image shows the same content without the border.

Showing the Border
To show the border, right click a content block while logged into Ektron CMS400.NET. Next,

select Show Borders. The page refreshes, and the border appears.

Changing the Appearance of the Web Site Content
Menu
You have three choices for determining the appearance of the Web Site Content menu. To

make your choice, edit the ek_UserMenuType element of the siteroot/web.config file. By default,
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ek_UserMenuType is set to 2.

Value set in
ek_

UserMenuType
Description Illustration

2 (default)

Dropdown Interface - No borders; dropdownmenu appears

when user clicks the Silver AccessPoint in top left corner of

server control

1

Classic Interface - Colored borders andmenusalways

appear; menu optionsappear as icons in the top row

Note: If you use this interface, the page layout is not depicted

accurately because of the fixed toolbars.

0

Hover Interface - Colored border appearswhen user hovers

mouse over area; menu appearswhen user right clicksmouse

inside border.

This interface has two display options: vertical (shown on right)

and horizontal.

To change:

1. Open the siteroot/web.config file.

2. Find ek_MenuDisplayType.

3. Change its value:

0 (zero) = horizontal

1 = vertical
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Viewing Content

You can view all content in your Ektron CMS400.NET Web site. Viewing content allows you

to see the content, metadata, summaries, and other information.

For more information, see:

n "Viewing Content from a Web Page" on page 7-9

n "Viewing Content from the Workarea" on page 7-10

Viewing Content from a Web Page
To view content from a Web page, follow these steps.

1. Sign in.

2. Browse to the content you want to view.

3. Mouse over the silver access point.

4. Click Properties.

5. Continue reading from "The View Content screen appears." on page 7-11.
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Viewing Content from the Workarea
Navigate to the folder that contains the content, as explained in "Viewing a Folder" on page 5-

3.

To change the type of content being displayed, click View then select a type.

1. If your system supports more than one language, you can view only content in any

language via the View > Language menu option (illustrated below).
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2. Hover the cursor over the content, click the triangle ( ), and select View from the
dropdown menu.

Alternatively, click the content’s title.

3. The View Content screen appears.

Note: You can also click the content title to access the View screen.

After you select the content, you have the following options.

Your options depend on your permissions and the status of the content.

Button or

Tab
Name Description

For more

information, see

Properties

tab

Content

Properties
View the content’s properties

"Properties" on page

7-13

Content

tab

View

Content
Displays content

Summary

tab

Edit

Summary
Edit content’s summary

"Working with

Content Summary"

on page 7-142
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Button or

Tab
Name Description

For more

information, see

Metadata

tab

Edit

Metadata
Edit content’smetadata

"Working with

Metadata" on page

7-146

Alias tab Edit Alias
n View and edit the content item’s primary alias

n View all secondary aliases

"ManualAliasing" on

page 10-27

Comment

tab

View

Comment

View comments on changesmadewhen editing

content.

This comment also appears on the View Content

and Content History screens. Use it to help

distinguish one version from another.

Tasks tab
Add/edit

tasks
Add or edit tasks for this content

"Managing Tasks" on

page 11-1

Web

Alerts tab

Add/edit

Web Alerts
Add or edit Web Alerts for this content

"Web Alert Feature"

on page 20-1

Templates

tab

Add/edit

Templates
The template currently assigned to the content.

"Creating/Updating

Templates" on page

7-184

Category

tab

Add/edit

Taxonomy

Category

Any taxonomycategories currently assigned to

the content.

"Taxonomy" on page

9-200

Edit Content Open content for editing

"Editing HTML

Content" on page 7-

105

View History
View older versionsof content; restore older

version

"Viewing and

Restoring Previous

Content" on page 7-

117

View

Published
Displays content as it is currently published

View

Difference
Compares current and earlier versionsof content

"Comparing Versions

of Content" on page

7-120
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Button or

Tab
Name Description

For more

information, see

Delete Delete content

"Deleting a Single

Content Item" on

page 7-130

Check for

content

linked to this

content

Identify all content with Quicklinks to this content
"LinkChecking" on

page 7-132

Add Task Attach a task to content

"Creating a Task via

the Content Folder"

on page 11-23

Return Go back to previousmenu

View

(language)
View

If you can view content in more than one

language, select a language from the drop down

list.

Add

-select

language-

Add

-select

language-

Lets you copy current content into a new item and

translate it to selected language.

"Translating Content

to Another

Language" on page

7-112

Properties

The content properties screen contains information about the content.

Field Description

Content Title The title assigned to the content

Content ID
The ID number assigned to the content. The ID number is used to retrieve content from a

database.

Content

language
The content’s language

Status The current status of the content. See Also: "Content Statuses" on page 7-133

Last User to

Edit
The last user to edit this content
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Field Description

Last Edit

Date
When the content was last edited

Start Date When the content will go live on theWeb site

End Date When the content will be removed from theWeb site

Action on End

Date

What happens to the content when its end date and time are reached. See Also: "Setting

Archive Options" on page 7-198

Date Created When the content was created

Approval

Method

Whether all approversmust sign off on content before it is published; managed by your

system administrator. See Also: "The ApprovalMethod" on page 5-41

Approvals
The users in the approval chain for this content. See Also: "Approve/Decline OneContent

Item" on page 5-35

Smart Form

Configuration

The Smart Form applied to the content. This is typicallymanaged by your system

administrator. See Also: "Working with Smart Forms" on page 7-288

Template
The template currently assigned to the content. This is typicallymanaged by your system

administrator. See Also: "Creating/Updating Templates" on page 7-184

Path The folder path to the content’s folder. A slash (\) represents the Content folder.

Rating

Ektron CMS400.NET providesa Content Rating feature that lets site visitors rate any

content item on a scale of 1 to 10. If this feature is enabled for the content item, the average

numerical rating appears. See Also: "Content Rating" on page 7-743

Content

Searchable

True appears if the content can be found when someone searches your Web site.

However, even if content isnot searchable, theWorkarea Advanced search still finds it. See

Also: "The Advanced Search Tab" on page 9-90

.
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Adding HTML Content

You can only add content to a folder if you have permission to do so. The following flowchart

illustrates a typical sequence of events when working with content.

After you create content, you or your system administrator typically make it available on the

site. For example, you can add a hyperlink to it from another page, or place it in a collection

or menu. Your administrator can add it to a list summary or content list.

Note: OnlyuserswithAdd permission for a folder can add content to it. See Also: "Folder Permissions" on page

5-43

Note: This section only explainshow to create HTML content. Procedures for creating/uploading other types

content are in the appropriate chapters.

Content Type Create/Upload Procedure

HTML Form/Survey "Creating a New Form" on page 7-222

XMLSmart Forms See "Working with Smart Forms" on page 7-288

Adding HTMLContent
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Content Type Create/Upload Procedure

Assets (including

multimedia)
"Working with Managed Files" on page 7-435

Microsoft Office documents "Working with Microsoft Office Documents" on page 7-413

PageBuilder Page "Building PageBuilder Pages" on page 6-1

To add HTML content, follow these steps.

1. Browse to the folder where you want to create the new content.

2. Click View > Language and select a language from the list.

3. Click New > HTML Content.
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4. The Edit Content window opens.

5. Create content in the editor using the following table.

To learn about the content editor, which you use to create or update content, see "Ektron
CMS400.NET Editors" on page 7-20.

Responding to the Fields on the Add
Content Screen

Field Description

Title
Enter a title for the content. It cannot include these characters:

\, /, *,>, <,|

Content

Searchable

Note: This checkboxonly appears if you are amember of the AdministratorsUser Group.

Check this box if the content should be found when someone searches your Web site.

However, even if content isnot searchdisplay‘

n theWorkarea Advanced search still finds it. See Also: "The Advanced Search Tab" on

page 9-90

n it can appear among Suggested Results. See Also: "Suggested Results" on page 9-31

After you respond to the above fields, the following buttons are available.

Responding to the Fields on the Add Content
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Buttons on the Add Content Screen

Button Name Description

Submit

Submit the content into the approval chain. This action also returns the new or updated

content to the database and exits the editor.

See Also: "Approve/Decline OneContent Item" on page 5-35

Publish

Publish the content to theWeb site.

Note: Only the last approver in the approval chain sees this button. If no approval chain

is assigned to the content’s folder, every authorized user sees this button.

See Also: "Approve/Decline OneContent Item" on page 5-35

This action updates the content in the database and exits the editor.

Check

In

Save and check-in the document. This action updates the content in the database and

exits the editor. It doesnot submit the content into the approval chain. Rather, it allows

you and other users to continue changing it.

Save
Save the content without leaving the editor. It is a good idea to save your work

frequently.

Cancel Close the editor without saving changes.

Tabs on the Edit Content Screen

Tab Description

Content
Insert content. For more information about using Ektron CMS400.NET’s editors, see "Ektron

CMS400.NET Editors" on page 7-20.

Summary
Enter or edit the content summary.

See Also: "Working with Content Summary" on page 7-142
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Tab Description

Metadata

Enter or edit the content metadata.

Note: All requiredmetadatamust be added before content can be checked in or submitted

into the approval chain.

See Also: "Working with Metadata" on page 7-146

Comment
Briefly describe the content, or comment on changesmadewhen editing content.

The history comment appears on the View Content and Content History screens.

Schedule

Use this tab to set a future publication date/time. In order to be published, this content must be

approved and reach its publication date/time.

See Also: "Scheduling Content to Begin and End" on page 7-195

If appropriate, enter a date when the content will no longer be viewable on theWeb site.

See Also: "Setting an End Date on Content" on page 7-197

Web

Alerts
See "Web Alert Feature" on page 20-1.

Templates

This content’s folder must have a default template. It can also have additional templates

assigned.

When content is created, the default template is automatically assigned to it. If you want to

change the template assigned to this content, click this tab and choose a template from the

dropdown list.

See Also: "Creating/Updating Templates" on page 7-184

Category Assign taxonomycategories to this content. See Also: "Taxonomy" on page 9-200
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Ektron CMS400.NET Editors

Ektron CMS400.NET has two choices for a main content editor, depending on your computer’s

operating system.

Operating

System
Possible editors

Windows
n eWebEditPro+XML

n eWebEdit400

Macintosh n eWebEdit400

TECHNICALNOTES

Note: eWebEdit400 doesnot require installation of an ActiveX control to each client computer.

Each editor’s toolbar is illustrated below.

eWebEdit400 Toolbar

eWebEditPro+XML Toolbar

Note: Your choice of editors only affects themain HTML content editor. It doesnot affect other screenswhich use

eWebEdit400, such as the TaskDescription.
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Setting the Editor for Ektron
CMS400.NET Users
Each Web server that hosts Ektron CMS400.NET has two editor options: one for clients that

run Windows and another for clients using MacIntosh. Your system administrator determines

the editor options in the site’s web.config file, using the following settings.

<appSettings>
.
!-- EditControlWin may be either "ContentDesigner" or "eWebEditPro" or "UserPreferred" -

->
<add key="ek_EditControlWin" value="UserPreferred" />
<!-- EditControlMac Only "ContentDesigner" -->
<add key="ek_EditControlMac" value="ContentDesigner" />
.

</appSettings>

The table below contains information about both editors.

Operating

System

Web.Config

file key
Possible editor key values

Windows
ek_

EditControlWin

n eWebEditPro

n ContentDesigner (use to load eWebEdit400)

n UserPreferred (loadseditor selected byuser at

Content and Forum Editor field in User Profile) See

Also: "Content and ForumEditor" on page 15-5

Macintosh
ek_

EditControlMac n ContentDesigner (use to load eWebEdit400)

The following section explains how to use the eWebEdit400 editor.

To learn about eWebEditPro+XML, see

http://www.ektron.com/manuals/CMS400/76/usermanual.pdf > “Introduction to

eWebEditPro+XML”.
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Introduction to Ektron CMS400.NET
eWebEdit400 is a browser-based, Web content editor designed for dynamic Web sites. It lets

you create and publish your own Web content in any language supported by the operating

system and your Web site.

Note: To learn how to enable eWebEdit400 for all clients that connect to your server, see "Setting the Editor for

Ektron CMS400.NET Users" on page 7-21.

More specifically, eWebEdit400 lets you perform Web page editing functions, such as

n copy content from any Windows-based application

n cut, copy, and paste

n find and replace text

n check spelling

n change font style, size, attributes (bold, italics, underline), and color

n begin lines with bullets or numbers

n adjust indentation

n right, center, or left justify text and images

n add a bookmark, hyperlink, image, or table

n view your text as WYSIWYG or HTML code

n insert or clean HTML source code

You gain access to these functions from the toolbar at the top of the editor, or from a menu that

appears when you right click the mouse inside the editor.

Also, if you create and maintain HTML forms, this chapter describes how to do that using

eWebEdit400.

Using eWebEdit400
eWebEdit400 is like many other word processing applications. You type text and then use

toolbar buttons (illustrated below) and menu options to change the text’s appearance or

perform functions on it, such as spell checking.
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To learn more about using eWebEdit400, see these topics.

n "Toolbar Buttons" on page 7-23

n "Copying from Other Applications" on page 7-30

n "Finding and Replacing Text" on page 7-31

n "Checking Spelling" on page 7-36

n "Working with Images" on page 7-37

n "Using Bookmarks" on page 7-53

n "Using Hyperlinks" on page 7-55

n "Inserting email Links" on page 7-59

n "Working with HTML" on page 7-60

n "Working with Tables" on page 7-63

n "Working with HTML Forms" on page 7-220

Toolbar Buttons
This section explains how to use the buttons and drop-down lists on the toolbar. (The toolbar

is the row of buttons across the top of the editor window, illustrated below.)

The buttons let you perform functions such as cutting and pasting text, inserting images, and

creating tables.

All buttons may not appear. Your Webmaster determines which buttons appear on your

toolbar.

Note: The following Ektron Knowledge Base article explainshow aWebmaster addsa custom toolbar button to

eWebEdit400: http://dev.ektron.com/kb_article.aspx?id=16550.
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See Also:

n ”Selecting Text” on page 1-472

n ”Applying Formatting Attributes to Text” on page 1-473

n "Table of Toolbar Buttons" on page 7-24

n "Form Elements Toolbar" on page 7-30

Table of Toolbar Buttons
eWebEdit400’s toolbar buttons are explained below.

Button

Equivalent

Keystroke

(Internet

Explorer

only)

Function

For more

information,

see

Select All Ctrl+A Select all content

Cut Ctrl+X

Remove selected text and

graphics. Place that data into

temporarymemory, also known as

the “clipboard.”

(If you later cut or copymore

information onto the clipboard, the

new information overwrites the

original information.)

Copy
Ctrl+C

Copyselected text and graphics

into temporarymemory. Leave

selected data where it is.

(If you later cut or copymore

information intomemory, the

original information is lost.)

"Copying from

Other

Applications" on

page 7-30

Paste Ctrl+V

Insert themost recently cut or

copied text and graphics at the

current cursor location.

"Copying from

MicrosoftWord"

on page 7-31
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Button

Equivalent

Keystroke

(Internet

Explorer

only)

Function

For more

information,

see

Paste fromWord,

Cleaning Fonts&Styles

Designed for pastingMicrosoft

Word content, this button strips

fonts and classes. For example, if

you use the Paste button,Word

content contains these tags.

<p class="MsoNormal"

style="MARGIN: 0in 0in

0pt"><span

style="BACKGROUND: lime;

mso-highlight: lime"><font

size="3"><font face="Times

New Roman">

But if you paste that content using

this button, only <p> tagsare

preserved.

"Copying from

MicrosoftWord"

on page 7-31

Paste Plain Text

Paste the clipboard’s contents as

plain text. That is, all HTML tags

(including images) are stripped out.

This button is helpfulwhen you

want to eliminate HTML formatting

from the copied text.

"Copying from

MicrosoftWord"

on page 7-31

Find and Replace

Launch the Search and Replace

dialog box. The dialog searches for

(and lets you optionally replace)

text that you specify.

"Finding and

Replacing Text"

on page 7-31

Print Ctrl+P Print the editor content.

Undo Ctrl+Z

Reverse themost recent action, as

if it never occurred. You can undo

asmanyactionsas you wish.

Redo Ctrl+Y Reverse the undo action.

SpellCheck
Begin spell checker.

"Checking

Spelling" on

page 7-36

Anchor Tag
Insert a bookmarkanchor.

"Using

Bookmarks" on

page 7-53
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Button

Equivalent

Keystroke

(Internet

Explorer

only)

Function

For more

information,

see

Add/edit Hyperlink

Change information about a

hyperlink.

"Using

Hyperlinks" on

page 7-55

Remove Hyperlink
Remove a hyperlink.

"Removing a

Hyperlink" on

page 7-59

Library
Insert a library file.

"Adding a

LibraryFile to

Content" on

page 8-18

AddWiki Link Create a wiki link.

Translate

Translate content into another

language

"Translating

Content to

Another

Language" on

page 7-112

Horizontal Line
Insert a horizontal line.

Insert Symbol

Insert symbols and special

characters.

Validate

Check content for adherence to

XTMHL and accessibility

standards.

"Validating with

eWebEdit400"

on page 7-682

ApplyCSSClass

Display a list of style sheet classes.

Users can select from the list to

apply a class to selected text. The

list can change depending on the

selected text.

Your Webmaster determineswhich

styles are available.

Paragraph Style

Display a list of paragraph styles.

Users can select from the list to

apply a style to selected text. The

list can change depending on the

selected text.
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Button

Equivalent

Keystroke

(Internet

Explorer

only)

Function

For more

information,

see

Your Webmaster determineswhich

styles are available.

Bold Ctrl+B Make selected text bold.

Italic
Ctrl+I Make selected text italic.

Underscore Ctrl+U Make selected text underlined.

Strikethrough
Apply strikethrough to selected text.

For example: Here is some text

Superscript
Make selected text appear smaller

and above text line.

Subscript
Make selected text appear smaller

and below text line.

Relative Font Size Change the relative font size. Your

Webmaster determineswhich

relative font sizesare available.

Font
Style

Change the font style.

Your Webmaster determineswhich

fonts are available.

Note: If more than one font

appears in a selection, the browser

on the reader’sPC tries to display

text using the first font. If the

browser cannot find that font, it tries

to use the second, etc.

Note: Your system administrator

can enable or disable the font

toolbar buttons (style, size, color,

and background color). See

”Enable Font Buttons” on page 19-

12.

"Font Manager"

on page 19-43

Font Size

Change the font size in points. Your

Webmaster determineswhich font

sizes in points are available.
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Button

Equivalent

Keystroke

(Internet

Explorer

only)

Function

For more

information,

see

Font Color Change the font color.

Background Color

Change the background color of

the selected content.

Number

Begin the line on which the cursor

restswith a number. If the line

above this line is

n not numbered, assign this line

1

n numbered, assign a number

onemore than the line above

Note: The Number toolbar button

applies a number to each

paragraph. If you want to switch to

regular (that is, non-numbered)

paragraphs, click the button a

second time.

Bullet

Begin the line on which the cursor

rests (or all selected lines) with a

bullet ( ).

Note: The Bullet toolbar button

applies a bullet to each paragraph.

If you want to switch to regular (that

is, non-bulleted) paragraphs, click

the button a second time.

Indent

Increase or decrease the current

line’s distance from the left margin.

Left, Center, and Right

Justify

Align paragraph so that it is

arranged

n evenly on the left side (uneven

on the right)

n in the center of each line

n evenly on the right side

(uneven on the left)

n evenly on right and left side

Use the last button to remove

justification.
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Button

Equivalent

Keystroke

(Internet

Explorer

only)

Function

For more

information,

see

Insert table Insert a table.

"Working with

Tables" on page

7-63

Insert row above

Insert a new row above current one

(that is, the one in which the cursor

currently resides).

Insert row below

Insert a new row below current one

(that is, the one in which the cursor

currently resides).

Insert column left

Insert a new column to the left of

the current one.

Insert column right
Insert a new column to the right of

the current one.

Delete row Delete current row.

Delete column Delete current column.

Delete cell Delete current cell.
"Deleting a
Cell" on page
7-95

Merge cells
horizontally

Merge current cell with cell to its

right.

"Merging Two

Cells" on
page 7-102

Merge cells
vertically

Merge current cell with cell below it.
"Merging Two
Cells" on
page 7-102
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Button

Equivalent

Keystroke

(Internet

Explorer

only)

Function

For more

information,

see

Split cell

Divide a cell into two. After you split,

each cell occupies one half the size

of the original cell.

"Splitting a
Cell" on page
7-101

Table properties Adjust a table’s properties

"Modifying
Table
Properties"
on page 7-66

Cell properties Adjust properties of current cell
"Working with
Table Cells"
on page 7-92

Show/hide border
Display/suppress internal table

border

"Setting Table

Borders" on

page 7-82

Form Elements Toolbar
These toolbar options appear when you are working with an HTML form, poll, or survey.

See "The Form Toolbar Options" on page 7-229.

Copying from Other Applications
You can copy information from most other Windows applications into eWebEdit400 and retain

most or all of the original application’s formatting. In general, copying from another

application involves these steps.

1. Sign on to the application that contains the information.

2. Select the text to be copied.

3. Press <Ctrl>+<C>.

4. Go to eWebEdit400.

5. Press <Ctrl>+<V> to paste the selected information.
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Note that you can only copy content, not background information that generates content. So,

for example, you can copy the values in a spreadsheet but not the formulas used to generate

them. Also, copying dynamic fields from Microsoft Word retrieves the current value of the

fields but not the variables that generate the values.

It’s a good idea to experiment with copying from different sources to test the results.

Copying from Microsoft Word
eWebEdit400 is very flexible in handling content pasted from Word. The table below present

your options and how your users can achieve them.

To preserve
Apply this Application Setup screen

setting

Press this

toolbar button

MSWord styles, classattributes,

and allHTML tags

Check Preserve MS-Word Styles,Preserve

MS-Word Classes
Paste ( ) or
<Ctrl> + <V>

AllHTML tags
Uncheck Preserve MS-Word Styles,

Preserve MS-Word Classes
Paste ( ) or
<Ctrl> + <V>

HTML tagsexcept <span>and

<font> tags
Not applicable

Paste fromWord

( )

Visual line breaksonly Not applicable
Paste Plain Text

( )

Finding and Replacing Text
To find (and optionally replace) text on your Web page, click the Find and Replace button (

). When you do, the Find and Replace dialog box appears.
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You can use this dialog to simply find text, or to find text then replace it with other text. Each

option is explained below.

Note: You can also use this dialog to delete text that appears repeatedly. To do so, follow the directions in "Finding

and Replacing Text" on page 7-32 and enter nothing in theReplace With field.

See Also:

n "Finding Text" on page 7-32

n "Finding and Replacing Text" on page 7-32

n "Additional Options on the Dialog Box" on page 7-33

Finding Text

1. In the Find field, type the text you want to find.

2. Set dialog box options (see "Additional Options on the Dialog Box" on page 7-33).

3. Click Find Next to find the next occurrence of the “find” text.

Finding and Replacing Text

1. In the Find field, type the text you want to find.

2. Click the Replace tab.

3. In the Replace With field, type the text to replace the “find” text.

4. Set dialog box options (see "Additional Options on the Dialog Box" on page 7-33).

5. If you want to

- replace all occurrences of the “find” text with the “replace” text, click Replace All.

Content

7-32
ReferenceManual

Version 8.0 Rev 1.3



Note: You can undo replacementsone at a time using the Undo button ( ).

- replace only the highlighted term with the “replace” text, click Replace.

- find the next occurrence of the “find” text (and optionally replace it with the “replace”

text), click Find Next.

- change the highlighted term using the editor, exit the Find and Replace dialog, move

to the term and edit as needed. To restart the search, press the Find button ( ).

6. Continue to find and optionally replace or edit until you reach the end of the text.

Additional Options on the Dialog Box

The dialog box also lets you do the following.

n "Searching Selected Text" on page 7-33

n "Specifying a Search Direction" on page 7-34

n "Considering the Case of a Search Term" on page 7-34

n "Whole Word Match" on page 7-35

Searching Selected Text
You can search and replace text in a selected portion of content. To do so, follow these steps.

1. Select text that you want to search and replace by dragging the cursor over it.

2. Click the Find and Replace button ( ).

3. In the Find & Replace dialog, enter the search string.

4. If desired, click the Replace tab and enter a replacement string.

5. Under Search, click Selection only.

6. Click Find Next.

7. The search runs but is limited to text you selected in Step 1.
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Specifying a Search Direction
The search begins where the cursor is when you click Find Next. To make sure you find every

occurrence of a term, place the cursor at the top of the content before beginning the search.

If you begin the search somewhere other than the top of the page, use the Direction field to

search from the current location to the top or bottom of the content.

To search from the

cursor location to the

Click this option in the

Direction field

end of the page Down

top of the page Up

Considering the Case of a Search Term
By default, the search ignores the case (upper or lower) of a search term. In other words, if you

enter Bob in the Find field, the search finds bob, Bob, BOB, etc.

If you want the search to be case sensitive, use the Match case check box. If you enter Bob in

the Find field and place a check in the Match case box, the search only stops at Bob, not bob

or BOB.
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Whole Word Match
By default, the search finds any occurrence of the text that you type into the Find field. For

example, if you enter the, the search finds the word the, as well as those letters embedded in

other words, such as others and theater.

If you want the search to find only whole word occurrences of the text in the Find field, click

the Match whole words only box.
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Checking Spelling

Note: This section describes the spell check software installed with eWebEdit400. If you use the FireFoxbrowser,

it has its own spell check software. To eliminate confusion between eWebEdit400’sand Firefox’s spell checker,

Ektron suggestsdisabling Firefox’s. This is set on Firefox’sTools>Optionsdialog >General Tab >Check my

spelling as I type checkbox.

To begin spell checking, click the spell check button ( ).

When you do, eWebEdit400 underscores in red each word that’s not in the dictionary. Then, it

stops at the first misspelled word and displays your options for fixing the problem.

The Spelling Options

Option Use this option if you want to...

One or

more

similar,

correctly-

spelled

words

Replace highlighted word with one from the list. To do this, click the correct word.

Ignore,

Ignore All

Don’t want to change the highlighted word, nor do you want to add it to the dictionary.

If the word appears repeatedly in the content, Ignore All also appears. Use this to skip all

occurrencesof the word in this spell check session.

Change

Manually

Retype the highlighted word.

If the word appears repeatedly in the content, the followingmessage asks if you want to change

alloccurrences to the fixed version.

This word occurs more than once in the text. Would you like to replace all

instances?
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Option Use this option if you want to...

Add to

Dictionary

Add the selected word to the “dictionary.” Do this if it is correctly spelled, and you expect to use

the word in the future.

Once you add a word to the dictionary, it will no longer be highlighted by the spell checker. The

word can also now appear on the correctly-spelled words list.

Technical note:Wordsadded using this option are placed in a .txt file located in the host server’s

site root/Workarea/Foundation/RadControls/Spell/TDF folder. The file’s name

beginswith the selected language, and endswith custom.txt. For example, if the language is

U.S. English, the file is en-US-custom.txt.

Using the Spell Checker

n As soon as you select an option, the spell checker moves to the next misspelled word and

displays its options.

n If you finish spell checking all words, you return to edit mode.

n Instead of stopping at every misspelled word, you can place the cursor on any highlighted

word. When you do, its spelling options appear.

n If you are done before fixing every misspelled word, click Finish spell checking from the

toolbar (circled below). If you do, your changes are saved, and you return to edit mode.

n If you want to exit the spell checker and ignore all changes you have made since

beginning it, click Cancel (circled above) at any time.

Working with Images
eWebEdit400 makes it easy to insert images in to your content.

First, you import the image into library or as a Ektron CMS400.NET asset. Then, add it to the

content. Next, you can edit its properties, such as border width and color, spacing, width and

height, etc.

For more information, see
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n "Inserting an Image" on page 7-38

n "Inserting an Image Thumbnail" on page 7-39

n "Editing an Image’s Properties" on page 7-40

n "Editing an Image" on page 7-47

n "Deleting an Image from Content" on page 7-52

Inserting an Image

Prerequisite
Before you can insert an image into eWebEdit400, it must be either uploaded to the Library or

imported as an asset.

n "Copying Files to the Library" on page 8-12 explains how to upload an image to the

Library

n "Importing Managed Files" on page 7-437 explains how to import an asset

Procedure for Inserting an Image
To insert an image into the editor, follow these steps.

1. Place the cursor where you want the image to appear

2. Click the library button ( ).

3. Make sure Images is selected in the content type dropdown (circled below).

4. From the folder display in the left panel, select the folder that contains the image you want

to insert.
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If you don’t know the image’s folder, use the search button ( ) to find the image by
title, description, or internal file name.

5. Select the image you want to insert.

6. Click the insert button ( ).

7. The image is inserted into the content.

Inserting an Image Thumbnail
As an alternative to inserting an image, you can insert a thumbnail, a miniature version of the

image. When the thumbnail appears on a Web page, a site visitor can click it to see a full-

sized version of the image. See an example of both below.
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To insert an image thumbnail, follow the steps in "Procedure for Inserting an Image" on page 7-

38, but when you get to Step 5, click the image’s thumbnail button ( ).

Note: You can change the thumbnail image by right clicking it, selecting Set Image Properties and editing the

Image Src field. If you do that, however, and someone clicks it, the original full-sized image appears. If you want to

change both the thumbnail and the full-sized image, delete it then enter a new thumbnail.

Editing an Image’s Properties
After an image in inserted, you can adjust the following properties for it.

n border width

n border color

n alt text

n description

n alignment

n the image itself

n horizontal and vertical spacing

n width and height
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To access the Image Properties dialog, follow these steps.

1. Select the image.

2. Right click the mouse.

3. Click Set Image Properties.
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Note: You can also view and adjust some image propertiesat the bottom of the Edit Content screen, as shown

below.

The following explains the fields on the Image Properties dialog.

Field Description

Border

Width

Set the width of the image’s border in pixels. See Also: "Setting a Border" on
page 7-45

Border

Color

To set the color of the image’s border, click the X circled below. When you do, a
palette of colors appears. Click the border color from the palette.
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Field Description

If a color hasalreadybeen assigned, it appears next to this field label. To change it, click down

arrow next to the color to display the color palette.

Image Alt

Text

The image’s title is used as the default alt text. Change if desired.

The alt text appears in place of the image on theWeb page if the image doesnot display.

Examplesof when an image doesnot display include:

n a speech browser (for example, a visually impaired person)

n a text-only browser (for example, browsing from amobile phone)

n a graphical browser with images turned off

Image

Alignment

The alignment of the image relative to adjacent text and images. If you choose
left or right alignment, the text wraps around the image. For more information,
see "Aligning the Picture" on page 7-45

Image Src

The path to the image.

If you want to change the image, click the ellipsis ( ) button to open the library. From there,
select a replacement image.

Horizontal

Spacing,

Vertical

Spacing

The amount of horizontal and vertical space around the picture. See Also: "Adding Space

around the Picture" on page 7-47

Width

The width of the picture in pixels. See Also: "Pixels" on page 7-44

Note: TheWidth andHeight settingsdetermine the area on aWeb page in which the image is

displayed. To display an image correctly, its height and width settings shouldmatch its actual

size (set using the resize button). See Also: "Resizing the Image" on page 7-49

Height The height of the picture in pixels. See Also: "Pixels" on page 7-44
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Field Description

Constrain

The constrain feature lets you determine if an image’s height and width can be adjusted

independently. Typically, you want Constrain on, as shown below.

In this state, if one dimension is adjusted, the other is automatically adjusted in proportion to it.

For example, if you change the height from 100 to 200, the width is also doubled.

To turn Constrain off, click it. When you do, it looks like this.

When Constrain is off, the adjusted picture can be disproportionate, as shown below.

Warning! If you substantially adjust the picture’s height and/or width, the picturemaybe distorted when users

view your Web page.

Pixels

A pixel is a single point in a graphic image.

Computer monitors display pictures by dividing the screen into thousands of pixels, arranged

in rows and columns. The pixels are so close together that they appear connected.

Below is an image shown at regular size and then enlarged so you can see the pixels that make

up the picture.

regular size

enlarged to show pixels
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Setting a Border
To add a border around a picture, enter the border’s thickness in pixels in the Border Width

field on the Image Properties dialog. See Also: "Pixels" on page 7-44

Here is a picture with a 1 pixel border.

Here is the same picture with a 10 pixel border.

If the picture is not a hyperlink, its border is black. If the picture is also a hyperlink, the border

is the same color as a hyperlink (for example, blue or purple if visited).

Aligning the Picture
To align a picture, use the Image Alignment field on the Image Properties dialog.
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The following table lists your alignment choices.

To align

Click this

Alignment

option

Illustration

The picture on

the left margin,

allowing

subsequent text

to wrap around it

The picture on

the right margin,

allowing

subsequent text

to wrap around it

The top of the

picture with the

first line of text

The vertical

center of the

picture with the

first line of text
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To align

Click this

Alignment

option

Illustration

The bottom of

the picture with

the first line of

text

Adding Space around the Picture
On the Image Properties dialog box, you can use the Spacing fields (Horizontal and Vertical)

to add space around the picture. You enter a number of pixels to determine spacing value.

The following graphic illustrates the effect of adding spacing to a picture.

Editing an Image
You can perform the following tasks on any image inserted into eWebEdit400 content.

n crop

n resize

n rotate
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n adjust brightness

To access the image editing tool, edit a piece of eWebEdit400 content, right click an image,

then click Image Modification Tool.

When you do, the following dialog appears.

Note: When you save edits to an image, a version is placed in the site root/uploaded images/CMS folder

folder. The version is named filename.nextnumber.file extension.

For example, if a library image is named ektronlogo.png, and someone inserts it into content and saves it, a new

version is created and named ektronlogo.1.png. If someone later saves that image in another content block (or

even another section of the same content), that version is named ektronlogo.2.png. Also, whenever someone edits

and saves the image, a new version is created and assigned the next highest number.

These edits have no effect on the original image stored in the library.

The following table explains the toolbar buttons. After changing the image, click the Save

button ( ) to finalize changes.

Button Description
For more information,

see

Save changes Note above

Exit without saving changes
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Button Description
For more information,

see

Crop image (that is, remove a portion of it).

Drag the boxaround the area you want to keep and

clickDone.

"Cropping an Image" on

page 7-52

Change image size
"Resizing the Image" on

page 7-49

Rotate image
"Rotating an Image" on page

7-51

Adjust brightness
"Adjusting Brightness" on

page 7-51

Note: If you begin editing an image then click the cancel button ( ), and later try to edit that image, youmaysee
a small, red x instead of the image. (This problem only occurs if your browser is Internet Explorer.) To remedy the

problem, go to Tools> Internet Options>Browsing History>Settings (or TemporaryFiles>Settings in Internet

Explorer 6). SetCheck for newer versions of stored pages toEvery Visit.

Resizing the Image

To change an image’s size, click the Resize button ( ). When you do, the following dialog
appears.

Change the image to the desired size then click Done.
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Keeping the Aspect Ratio
Aspect ratio is the relationship between an image’s width and height. For example, if a graphic

has an aspect ratio of 2:1, its width is twice as large as its height.

If you check the Keep Ratio box, just specify a new width or height - the other dimension is

calculated for you.

Effect of Changing Image Size on the Image Properties
Dialog
The Width and Height settings on the Image Properties dialog (shown below) determine the

area on a Web page in which the image is displayed.

To display an image correctly, its height and width on this dialog should match its actual size

(that you set using the Resize button).
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Adjusting Brightness

To adjust the image’s brightness, click the brightness button ( ). When you do, a brightness
control appears.

The red dot indicates the current brightness level.

n To brighten the image, place your cursor to the left of the red dot and click.

n To darken it, move the cursor to the right of the red dot and click.

When you click, the image redisplays using the new brightness level. When you are satisfied,

click Done.

Rotating an Image

To rotate an image, click the Rotate Image button ( ). When you do, image rotation buttons
appear.

Working with Images

ReferenceManual

Version 8.0 Rev 1.3
7-51



Use the buttons to rotate the image clockwise or counterclockwise in ninety degree increments.

When you are satisfied, click Done.

Cropping an Image
Cropping an image removes the portion of the image that is not within the cropping tool. To

crop an image, click the Crop Image button ( ). When you do, the crop image box appears.

Drag the crop tool’s handles to frame how the image is cropped. When you are satisfied, click

Done. Everything outside the crop box is removed.

Deleting an Image from Content
If you want to delete a picture, follow these steps.

1. Move the cursor over the picture.

2. Click the mouse to select the picture.

3. Click the Cut button ( ).

Note: If you want to remove an image from content created from an XMLSmart Form and eWebEdit400 is your

editor, click the image icon ( ), open the Image Propertiesdialog, and delete the image path (circled below).
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Using Bookmarks
Use a bookmark to let a user “jump” from any word or phrase to another place in the same

content block. On your Web page, text appears in a different color to indicate the bookmark.

Bookmarks are particularly helpful if your page is very long. For example, if your Web page

contains minutes from several meetings, the top of the page could list the meeting dates. You

could then assign a hyperlink to each date and a bookmark to each set of minutes. The user

sees that a date is in a different color, so clicks it to “jump” (using the bookmark) to the

correct minutes.

"Creating a Bookmark" on page 7-53 describes how to set up a bookmark within a file. You

can also set up hyperlink to

n another Web page. This procedure is described in "Using Hyperlinks" on page 7-55.

n a bookmark within another Web page. This procedure is described in "Creating a

Hyperlink to a Location Within a Web Page" on page 7-58.

Creating a Bookmark
When creating a bookmark, you must specify a

n source, the text a user clicks to move to the bookmark

n bookmark, the destination to which the cursor jumps when a user clicks the source

To continue with the above example, a meeting date is the source, and the meeting minutes are

the bookmark.

To create a bookmark, follow these steps.

1. Select the bookmark text.

2. Click the Insert Bookmark button ( ).

3. The Hyperlink Manager dialog appears with the Bookmark Tab selected.
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4. Enter a name for the bookmark.

5. Click OK.

6. The editor screen redisplays. (The bookmark does not appear on the page.)

7. Select the source text.

8. Click the Hyperlink Manager button ( ).

9. The Hyperlink Manager dialog appears with the Hyperlink tab selected.

10. Click the down arrow below the Existing Anchor field and click the bookmark you

created in Step 4.

11. If desired, use the Target dropdown to change the destination text ‘s window. For details,

see "Changing the Destination Window" on page 7-54.

If you leave the Target Frame field blank, the new window replaces the current window.

12. Click OK.

Changing the Destination Window
Use the Target Frame field on the Hyperlink Manager dialog to change the window that

displays the destination page.
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The values you can enter into the Target Frame field are explained below.

If you want the destination page to appear
Click this in the Target

Frame field

In a new browser window, on top of the current browser. NewWindow

In the same position within the browser window. The new

window replaces the current one.

Same Window

Note: this is the default.

If your page contains frames, in the frame that contains the

framewith the hyperlink.
Parent Window

If your page contains frames, in the full display area, replacing

the frames.
Browser Window

Using Hyperlinks
Use hyperlinks to let a user “jump” from any word or phrase to another Web page. The page

can be within your network (that is, on an intranet) or anywhere on the internet.
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Note: If you want to create jumpswithin a content block, see "Using Bookmarks" on page 7-53.

For example, if your Web page should include a link to the Ektron Web site, you would enter

the text to indicate the jump (for example Ektron Web Site), then create a hyperlink to

www.ektron.com. When users see Ektron Web Site in a different color, they can click the text to

“jump” to the site.

Although most jumps go to the top of another Web page, you can also jump to a bookmark

within a Web page.

This section explains

n "Creating a Hyperlink" on page 7-56

n "Creating a Hyperlink to a Location Within a Web Page" on page 7-58

n "Creating a Hyperlink to a Location Within a Web Page" on page 7-58

n "Editing a Hyperlink" on page 7-58

n "Removing a Hyperlink" on page 7-59

n "Preventing a URL from Becoming a Hyperlink" on page 7-59

Creating a Hyperlink
When creating a hyperlink, you must specify a

n source, the text the user clicks to move to the destination

n destination, the Web page that appears when someone clicks the source

To continue with the above example, Ektron Web Site is the source, and www.ektron.com is the

destination.

Entering a Hyperlink

To create a hyperlink, follow these steps.

1. Select the source text.

Note: Alternatively, you can select an image and apply a hyperlink to it.

2. Click the Hyperlink Manager button ( ). The Hyperlink dialog appears.
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3. Click in the URL field after http://. Then, enter the address of the destination Web page.

For example, www.ektron.com.

If your version of Ektron CMS400.NET has URLs that have been entered into the library

as hyperlinks, click the ellipsis button ( ) to browse the library and insert a hyperlink.
See Also: "Hyperlinks" on page 8-20

4. If desired, use the Target Frame field to change the window in which the destination text

appears. For details, see "Changing the Destination Window" on page 7-54.

If you leave the Target Frame field blank, the new window replaces the current window.

5. You can enter text to appear in a small window when someone hovers his cursor over this

link. For example:

To add such text, use the Tooltip field.
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6. The style of this hyperlink is normally determined by the style sheet assigned to the

content’s page template. However, if you want to apply a special style sheet class to this

link, select it from the CSS Class dropdown.

7. Click OK.

Creating a Hyperlink to a Location Within a Web Page
Sometimes, the destination Web page contains bookmarks, and you want to jump from your

page to a bookmark on another page. (Bookmarks are described in "Using Bookmarks" on page

7-53.)

To create a hyperlink that jumps to another page’s bookmark, follow these steps.

1. Open a browser and your Web site.

2. Go to the Web page that contains the bookmark link.

3. Click the bookmark that you want to jump to. For example, on the illustration below, the

text Benefits to Partners jumps to a bookmark further down the page.

4. When you click the bookmark, its full address appears in the browser address bar. This

bookmark’s address looks like this.
http://www.example.com/single.aspx?id=35#Benefits2

5. Click the address bar. The address is selected.

6. Press <Ctrl>+<C> to copy the address into the Windows clipboard.

7. Go to eWebEdit400.

8. Select the text or image from which you want to jump to the bookmark.

9. Click the Hyperlink button ( ). The hyperlink dialog box appears.

10. Move the cursor to the Link field.

11. Press <Ctrl>+<V> to paste the address you copied in Step 4 into the Link field.

12. Click OK.

Editing a Hyperlink
If you need to change a hyperlink’s destination Web page or target frame, follow these steps.
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1. Select the hyperlinked text.

2. Right click your mouse.

3. Click Set Link Properties.

4. The Hyperlink Manager dialog appears.

5. Edit the fields as needed. Several fields are explained in "Entering a Hyperlink" on page

7-56.

6. Press OK.

Removing a Hyperlink
If you want to remove a hyperlink from text, select the text and press the Remove Link button

( ).

Preventing a URL from Becoming a Hyperlink
If you enter a URL or an email address into eWebEdit400, it automatically becomes a

hyperlink. To avoid this, select the text and click the Remove Link toolbar button ( ).

Inserting email Links
You can easily insert email links into your content. Such links provide an easy way for your

site visitors to communicate with your organization.

An email link resembles a hyperlink. But, when a site visitor clicks the link, instead of

opening a different Web page, his email application is launched.

The address and subject are retrieved from the mail link and inserted into the user’s email

screen, as shown above.

To insert an email link, follow these steps.
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1. Within eWebEdit400 content, insert text that a site visitor will click to open the email

link. For example: Contact us today!

If the text does not exist yet, insert it.

2. Select the text.

3. Click the Hyperlink Manager button ( ). The Hyperlink dialog appears.

4. Click the E-mail tab.

5. Note that the selected text appears in the Link Text field.

6. In the Address field, enter the email address to which the message will be sent.

7. In the Subject field, enter default text for the email’s Subject line if desired. The user

sending the mail can edit this text if desired.

8. Press OK.

Working with HTML
eWebEdit400 creates pages for display on the internet or an intranet. These pages use HTML

(hypertext markup language) to format text and images for display in a browser. You do not

need to know HTML to use eWebEdit400.

However, if you know HTML, you can view, insert or edit your Web page’s HTML code.

Viewing and Editing HTML

To view your page’s HTML, follow these steps.
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1. Scroll to the bottom of the screen.

2. Click the HTML button (circled below).

3. The HTML code appears, as shown below.

4. You can edit the HTML using functions like Cut, Copy, Paste and Delete. To access these

functions, right click the mouse.

5. To return to normal view, click the Design button (circled below).

Adding Custom Tags to the Content’s Source
You can insert custom tags into your content. The tags can be used to provide all kinds of

functionality, such as video/object tag support, JavaScript and .css file support.

To insert custom tags, edit the source of your content, as explained in "Viewing and Editing

HTML" on page 7-60. Then, enter the custom tags. Here is an example.
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Working with Tables
Sometimes, the information on your Web page looks better when displayed on a table. Here is

an example.

City Baseball Team Hockey Team

Boston Red Sox Bruins

New York Yankees / Mets Rangers

Chicago White Sox / Cubs BlackHawks

This chapter explains everything you need to about working with tables. It explains

n "Creating a Table" on page 7-63

n "Deleting a Table" on page 7-68

n "Inserting a Table within a Table" on page 7-69

n "Modifying Table Properties" on page 7-66

n "Working with Table Cells" on page 7-92

n "Section 508 Tables" on page 7-87

Creating a Table
When creating a table, you need to specify a number of rows and columns. A row is a

horizontal series of cells, while a column is a vertical series.
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If you know how many rows and columns the table will be, enter those numbers. If you don’t

know the exact number when you create the table, estimate how many you need. You can

easily add or remove rows and columns later.

There are two ways to create a table. If your table will be six rows by six columns or less, use

the Table Builder. See Also: "Creating a Table Using the Table Builder" on page 7-64

If it will exceed 6 x 6, use the Table Wizard. See Also: "Creating a Table Using the Table

Wizard" on page 7-65

Either way, once the table is created, you use the features described in "Modifying Table

Properties" on page 7-66 to add borders, background color, set width and height, etc.

Creating a Table Using the Table Builder
To create a table, follow these steps.

1. Click the table button ( ).

2. Drag the cursor over rows and column to indicate the size of the table.

The following example shows a table that is 4 rows by 5 columns.

3. Click the mouse.

At this point, the table looks like this.
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4. Begin entering text and images into the table cells. To further modify the table, see

"Modifying Table Properties" on page 7-66.

You can also select the table and drag its right border to the right and/or down to enlarge it for

ease of use.

Creating a Table Using the Table Wizard
1. Click the table button ( ).

2. Click Table Wizard (circled below).

3. The Table Wizard dialog appears.

Creating a Table

ReferenceManual

Version 8.0 Rev 1.3
7-65



4. To change the number of columns or rows, click the plus or minus signs (+ -) next to

Columns and Rows.

5. The image adjusts to show the number of rows and columns.

6. Press OK.

7. Begin entering text and images into the table cells. To further modify the table, see

"Modifying Table Properties" on page 7-66.

Modifying Table Properties
To modify a table’s properties, follow these steps.

1. Click inside the table.

2. Right click the mouse.

3. Click Set Table Properties.

4. The Table Wizard dialog appears.
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The dialog has four tabs, described below.

Tab Description For more information, see

Table

Design

Lets you

n adjust the number or row and columns

n span rowsor columns (that is, two or more

adjacent cells aremerged)

"Choosing the Number of Rowsand

Columns" on page 7-69

"Spanning Rowsor Columns" on page

7-97

Table

Properties

Lets you set the table’s

n width

n height

n background color

n background image

n alignment

n cell spacing and padding

n Id

n css class

n border

"Specifying TableWidth" on page 7-71

"Table Backgrounds" on page 7-77

"Specifying Horizontal Alignment" on

page 7-75

"Setting Cell Padding and Spacing" on

page 7-103

"Setting Table Borders" on page 7-82
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Tab Description For more information, see

Cell

Properties

Lets you set the selected cells’

n alignment

n background color

n background image

n height and width

n ID

n css class

n abbreviation

n categories

"Aligning TextWithin a Cell" on page 7-

100

"Specifying a Cell’sBackground Color "

on page 7-95

"Specifying a Background Image for a

Cell" on page 7-96

"Specifying a Cell’sBackground Color "

on page 7-95

"SpanningMore thanOneRow or

Column" on page 7-98

Accessibility

Lets you assign accessibility information for the

table.

n heading rowscaption

n heading columnscaption

n caption alignment

n caption

n summary

"Section 508 Tables" on page 7-87

Deleting a Table
To delete a table, follow these steps

1. Move the cursor over the table until the cursor becomes a four-headed arrow ( ).

2. Click the mouse button. The table becomes selected (small squares appear around it).

3. Press <Delete>.
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Inserting a Table within a Table
You can insert a table within a table. You might want to do this to arrange text in columns.

Note: HTML doesnot let you use tabsor spaces to align text in columns. Youmust use a table to align columns.

You can remove the table’s border, so that no linesappear between the columnsand rows.

To insert a table within a table, follow these steps.

1. Place the cursor in the cell into which you want to insert a table.

2. Click the Insert Table button ( ).

3. Drag the cursor over rows and column to indicate the size of the table.

4. Click the mouse.

Choosing the Number of Rows and
Columns
Use the Table Design tab of the Table Properties box to change the number of rows or

columns in a table.
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Use the plus (+) or minus (-) signs next to Columns or Rows to adjust the number.

Alternatively, place the cursor within the table then add or remove columns relative to that

cell. See "Adding or Removing Rows and Columns" on page 7-70.

Adding or Removing Rows and Columns

To add or remove table rows and columns, follow these steps.

Note: You can also adjust the number of rowsand columnsusing the TableWizard. See Also: "Creating a Table

Using the TableWizard" on page 7-65.

1. Place the cursor in the cell from which you want to add or delete rows or columns.

2. Right click the mouse. A menu appears.

Menu options relating to adding/removing rows or columns are highlighted below.
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3. Click the appropriate menu option. For example, to add a row above the current cursor

location, click Insert Row Above.

Note: These optionsare also available on the toolbar.

Specifying Table Width
After you create a table, you can set its width by specifying one of the following:

n percentage of the window: the table’s width varies as a user adjusts the browser size

n fixed number of pixels, the table’s width stays the same as a user adjusts the browser size

You can also not set a width but instead let information you enter into the table’s cells

determine its width.

Note: To set the width of a column, adjust the width of one of the cellswithin the column (asdescribed in

"Specifying the Height andWidth of a Cell" on page 7-94). Usually, this change affects the other cells in the column.
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Specifying Table Width by Percentage

Specify table width and height by percentage if you want the table to be resized as the user

resizes the browser.

Note: In order for the table to resize with the browser, theWordWrap attributemust be turned on in all table cells.

For details, see "WordWrap" on page 7-102.

For example, if you specify that a table is 100% wide and high, and your browser displays 14

inches across when it is maximized, the table fills the screen (except for the browser border).

If you resize the browser to half the screen, the table will be about 7” wide. You still see both

columns, but some of the data is moved down.
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Setting Table Width or Height by Percentage
To specify table width by percentage, follow these steps.

1. Place the cursor within the table.

2. Right click the mouse.

3. Select Set Table Properties.

4. Click the Table Properties tab.

5. In the Dimensions section of the Table Properties tab, specify the percentage at the

Width or Height field. Follow the number with the percent sign (%), as shown below.
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Specifying Table Width or Height by Pixels

Specify table width or height by pixels if you want the table size to remain the same when a

user resizes the browser.

For example, if you specify that a table is 610 pixels wide, and the user’s browser is set to low

resolution (640 x 480 pixels), the table occupies the full width of the browser when it is

maximized.

If the user resizes the browser so that it only occupies the left half of the screen, only the left

half of the table appears. A scroll bar appears at the bottom of the browser. The user must move

the scroll bar to see the rest of the table.

Content

7-74
ReferenceManual

Version 8.0 Rev 1.3



Setting Table Width by Pixels
To specify table width or height by pixels, follow these steps.

1. Place the cursor within the table.

2. Right click the mouse.

3. Select Set Table Properties.

4. Click the Table Properties tab.

5. In the Dimensions section of the Table Properties tab, enter the number of pixels at the

Width or Height field.

Specifying Horizontal Alignment
You can specify your table’s horizontal alignment (left, right, or center) within the browser.

Alignment Example

left

right
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Alignment Example

center

If you specify right or left justify, you can wrap text around the table. To do this, move the

cursor to the right or left of the table and begin typing.

To specify table alignment, follow these steps.

1. Place the cursor within the table.

2. Right click the mouse.

3. Select Set Table Properties.

4. Click the Table Properties tab.

5. Specify table alignment at the Alignment field.
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Table Backgrounds
You can specify a background color or image for your table.

n "Deleting a Table’s Background Color" on page 7-79

n "Specifying a Table Row’s Background Color" on page 7-79

n "Specifying a Table’s Background Image" on page 7-81

Specifying a Table’s Background Color
You can assign a background color to a table to give it more visual appeal. Here is an

example.

To assign a background color to your table, follow these steps.

1. Place the cursor within the table.

2. Right click the mouse.

3. Select Set Table Properties.

4. Click the Table Properties tab.

5. Click the Background dropdown list.
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6. A selection of colors appears. Click a color for the table’s background.

From the dropdown, you can add custom colors by selecting a color patch or entering a color’s

hex value. Follow these steps to get help on how to use the color box.

1. Click the question mark in the top right corner.

2. A large question mark appears next to your cursor.

3. Drag the question mark to the area of the dialog box that you want to learn about.

4. Click the mouse button. A box appears with instructions for that area.
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Deleting a Table’s Background Color
To delete a table’s background color, click the Background dropdown list on the Table

Properties tab of the Table Wizard.

Then, click the top left choice (circled above).

Specifying a Table Row’s Background Color
To assign a background color to a table row, follow these steps.

1. Place the cursor within the table.

2. Right click the mouse.

3. Select Set Table Properties.

4. Click the Cell Properties tab.

5. Within the Table Wizard dialog, hold down the <Ctrl> key while clicking all cells in the

row. In the following illustration, the second row from the top is selected (dark gray).
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6. Click the Background dropdown list (circled above).

7. A selection of colors appears. Click a color for the table’s background.

8. Click OK.
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Specifying a Table’s Background Image
You can specify a background image for your table. Here is an example.

Note that when you apply a background image to a table

n if the table is larger than the image, the image repeats until it fills the table.

n if the image is larger than the table, the top left corner of the image aligns with the top left

corner of the table. The rest of the image fills as much of the table as possible.

n you can also apply an image to individual cells (see "Specifying a Background Image for a

Cell" on page 7-96).

n make sure the image does not obscure the table’s legibility

To insert a table background image, follow these steps.

1. Place the cursor within the table.

2. Right click the mouse.

3. Select Set Table Properties.

4. Click the Table Properties tab.

5. In the Background Image field, click the ellipsis button ( ) to open the Library. From
there, select an image for the table’s background. See Also: "Library Folder" on page 8-1
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6. Click Update.

Deleting a Background Image

1. Place the cursor within the table.

2. Right click the mouse.

3. Select Set Table Properties.

4. Click the Table Properties tab.

5. Select the value in the Background Image field.

6. Press <Delete>.

7. Click OK.

Setting Table Borders
A table border consists of the lines that separate a table’s cells form each other, and the table

from the rest of your Web page. There are two types of table borders.
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Border

type

Used by this type of

user
Illustration

internal content author

external site visitor

See Also:

n "Assigning an Internal Table Border" on page 7-83

n "Assigning External Table Border Attributes" on page 7-83

Assigning an Internal Table Border

A table’s internal border is either on or off. You cannot specify other attributes.

To turn a table’s internal border off or on, follow these steps.

Note: If the table’s border is on, these steps turn it off. If it is off, they turn it on.

1. Place the cursor inside the table.

2. Right click the mouse.

3. Click Show/Hide border.

Assigning External Table Border Attributes
You can modify these external border attributes

n color - see "Assigning Table Border Color " on page 7-83

n size (thickness) - see "Assigning Border Size" on page 7-85

n line selection - see "Determining Which Table Border Lines Appear" on page 7-86

Assigning Table Border Color
This section explains how to change the color of a table’s border (see example below).
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To assign the color of your table’s border, follow these steps.

1. Place the cursor within the table.

2. Right click the mouse.

3. Select Set Table Properties.

4. Click the Table Properties tab.

5. Click the Border Color drop down (circled below).

6. A color selection box appears. Click a color to apply to the table’s border.

Follow these steps to get help on how to use the color box.

1. Click the question mark in the top right corner.
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2. A large question mark appears next to your cursor.

3. Drag the question mark to the area of the dialog box that you want to learn about.

4. Click the mouse button. A box appears with instructions for that area.

Assigning Border Size
You can also adjust the size of a table border. Size is measured in pixels.

The border size only adjusts a table’s exterior border - it has no effect on the border between

cells.

To assign a border size to your table, follow these steps.

1. Place the cursor within the table.

2. Right click the mouse.

3. Select Set Table Properties.
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4. Click the Table Properties tab.

5. Enter a number of pixels into the Border field (circled below).

If you set a table’s border size to zero (0) but wish to view boundary lines while editing, see

"Assigning an Internal Table Border" on page 7-83.

Determining Which Table Border Lines Appear
You may want to suppress some table borders. For example, the table below only shows

horizontal lines.

To modify which border lines appear, follow these steps.

1. Place the cursor within the table.

2. Right click the mouse.

3. Select Set Table Properties.

4. Click the Table Properties tab.

5. Use the icons within the Border area to indicate which border lines should appear. Each

icon has tooltip text that explains its function.

Note: In order to view the selected borderson the dialog, a border color must be assigned. See "Assigning Table

Border Color " on page 7-83.
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Note that if a table already has border lines but you want to start “fresh,” it is a good idea to

remove all borders using the icons indicated below. Then, you can begin adding new ones.

Section 508 Tables
You can apply the following information to any table to make it 508 compliant. Narrative

software uses the information from the Accessibility table fields (heading rows, columns,

caption alignment and summary) to produce a Tooltip message for each table cell. Users with

impaired vision can see those Tooltips as they hover over the cells.

Information Where applied For more information, see

Heading Rows Accessibility dialog "AccessibilityDialog" on page 7-89
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Information Where applied For more information, see

Heading Columns Accessibility dialog "AccessibilityDialog" on page 7-89

Summary Accessibility dialog "AccessibilityDialog" on page 7-89

Caption Accessibility dialog "AccessibilityDialog" on page 7-89

HorizontalCaption

Alignment
Accessibility dialog "AccessibilityDialog" on page 7-89

VerticalCaption Alignment Accessibility dialog "AccessibilityDialog" on page 7-89

Abbreviation
Cell properties

dialog

"Accessibility Fields on Cell PropertiesDialog" on page

7-91

Categories
Cell properties

dialog

"Accessibility Fields on Cell PropertiesDialog" on page

7-91

Learn About Creating a 508 Compliant Table

To create a 508 compliant table, follow these steps.

1. Create a new table or edit an existing one, as explained in "Creating a Table" on page 7-

63.

2. Place the cursor inside the table.

3. Right click the mouse.

4. Click Set Table Properties.

5. The Table Properties dialog appears.

6. Click the Accessibility tab.
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See Also:

n "Accessibility Dialog" on page 7-89

n "Setting Abbreviation and Category Attributes" on page 7-90

Accessibility Dialog
The fields on the tab are described below.

Field Description

Heading

Rows

If you want your table to have a horizontal header, enter the number of rows that it should

occupy. The number cannot exceed five.

Beginning with the top, all cells in the specified number of rowsare designated as table headers.

Heading

Columns

If you want your table to have a header, enter the number of columns that it should occupy. The

number cannot exceed three.

Beginning with the left column, all cells in the specified number of columnsare designated as

table headers.

Caption

Alignment
To choose the caption’s alignment, click the down arrow next to this field as shown below.
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Field Description

Click the box that represents the alignment style you want.

Caption
If desired, enter a table caption. The caption appears above the table. The caption’s alignment is

set in theCaption Alignment field.

Summary

If desired, enter the table summary. Non-visual browsers use the summary to explain the table’s

contents.

From http://www.w3.org/TR/WCAG10-HTML-TECHS/#data-tables

“A summaryof the relationships among cells is especially important for tableswith nested

headings, cells that spanmultiple columnsor rows, or other relationships that maynot be

obvious from analyzing the structure of the table but that maybe apparent in a visual rendering

of the table. A summarymayalso describe how the table fits into the context of the current

document. If no caption is provided, it is evenmore critical to provide a summary.”

Associate

Cellswith

Headers

Check this box if you want to associate the table’s data cellswith the appropriate headers. See

Also: http://www.w3.org/TR/WCAG20-TECHS/H43.html

After you complete the Table Properties dialog, click OK to make the table Section 508

compliant.

Setting Abbreviation and Category Attributes
You can modify abbreviation (ABBR) and category (AXIS) attributes within a table. To do so,

follow these steps.

1. Select one or more cells.

2. RIght click the mouse.

3. Select Set Cell Properties.

4. The Cell Properties dialog appears. It includes the Abbreviation and Categories fields (see

illustration below).
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The following explains how to respond to these fields.

Accessibility Fields on Cell Properties Dialog

Field Description

Abbreviation

Sets or retrievesabbreviated text for the content in the tag. Can be used to

render non-visualmedia, such as speech or Braille.

For more information, seehttp://msdn2.microsoft.com/en-

us/library/ms533058.aspx

Categories

Sets or retrievesa comma-delimited list of conceptual categories associated with

that tag. Can be used to render non-visualmedia, such as speech or Braille.

For more information, see http://msdn2.microsoft.com/en-

us/library/ms533489.aspx
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Working with Table Cells
Along with functions for managing tables (described in "Working with Tables" on page 7-63),

eWebEdit400 also lets you perform actions on individual cells within a table.

You can perform the following actions on individual table cells.

n "Specifying the Height and Width of a Cell" on page 7-94

n "Deleting a Cell" on page 7-95

n "Specifying a Cell’s Background Color " on page 7-95

n "Specifying a Background Image for a Cell" on page 7-96

n "Spanning Rows or Columns" on page 7-97

n "Aligning Text Within a Cell" on page 7-100

n "Splitting a Cell" on page 7-101

n "Merging Two Cells" on page 7-102

n "Word Wrap" on page 7-102

n "Setting Cell Padding and Spacing" on page 7-103

Note: HTML doesnot allow you to adjust the width of a cell’s border.

You can also select several cells or a row of cells and change them as described above.

However, you cannot select and change a column of cells.

Selecting Cells to Modify
n "Modifying a Single Cell" on page 7-92

n "Modifying Several Cells" on page 7-93

Modifying a Single Cell
If you want to make any of the modifications described in this section to a single cell, follow

these steps.

1. Place the cursor in that cell.

2. Right click the mouse.

3. Select Set Cell Properties from the menu.

4. Make the changes on the Cell Properties dialog.
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5. Click Update.

Modifying Several Cells
If you want to make any of the modifications described in this section to several cells, follow

these steps.

Note: Most procedures in this section tell you to select Cell Properties from the right clickmenu. To perform an

action on several cells, selectSet Table Properties from the right clickmenu, then click theCell Properties tab.

1. Place the cursor anywhere in the table.

2. Right click the mouse.

3. Select Set Table Properties from the menu.

4. Click the Cell Properties tab.

5. Select the cells that you want to change. Hold down the <Ctrl> key while selecting.

As you select a cell, its color changes from light to dark gray.

6. Make changes to fields on the lower part of the Cell Properties tab. The fields are

described later in this section.

7. Click OK.
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Specifying the Height and Width of a
Cell
As described in "Specifying Table Width" on page 7-71, there are several ways to set the width

of a table. Within a table, you can also specify the height and width of an individual cell.

When you set a cell width, there is no guarantee that the cell will occupy that width when

displayed in a browser. This is because the cell is part of a column, and changes to other cells

in the column can affect the cell whose width you set. Setting cell width only guarantees that

the cell will not be less than the width you specify.

If you want to ensure that a cell’s size does not change, set all cells in a column to that width.

To specify a cell’s height and width, follow these steps.

1. Place the cursor in the cell whose height or width you want to set.

2. Right click the mouse.

3. Click Set Cell Properties from the menu.

4. Click Cell Properties from the menu.

5. The Cell Properties dialog appears.

6. Enter the cell width and height in the fields circled above. You can enter the width in

pixels or percentage. These choices are explained in "Table Backgrounds" on page 7-77.

7. Click Update.
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Deleting a Cell
To delete one or more cells, follow these steps.

1. Move the cursor to the cell you want to delete.

2. Right click the mouse.

3. Click Delete Cell from the menu.

Cells to the right of the deleted cell shift left to occupy the vacant space. In this example, the

cursor was in cell “b” when the user clicked on Delete Cells.

Before

After

Specifying a Cell’s Background Color
"Specifying a Table’s Background Color" on page 7-77 explains how to apply a background

color to a table. You can also apply a background color to a cell.

To apply a background color to a cell, follow these steps.

1. Move the cursor to the cell.

2. Right click the mouse.

3. Click Set Cell Properties.

4. Click the Background dropdown.
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5. A color selection box appears.

6. Click a color to apply to the cell’s background.

Deleting a Cell’s Background Color

To delete a cell’s background color, click the square in the top left corner of the Background

area (circled below).

Specifying a Background Image for a
Cell
"Specifying a Table’s Background Image" on page 7-81 explains how to apply a background

image to a table. You can also apply a background image to a cell.

To insert an image into a cell, follow these steps.

1. Place the cursor within the table.

2. Right click the mouse.

3. Select Set Cell Properties.

4. In the Background Image field, click the ellipsis button ( ) to open the Library. From
there, select an image for the cell’s background. See Also: "Library Folder" on page 8-1

5. Click Update.
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Note that when you apply a background image to a cell

n If the cell is larger than the image, the image repeats until it fills the cell.

n If the cell is smaller than the image, the top left corner of the image appears in the top left

corner of the cell. The rest of the image fills as much of the cell as possible.

n Make sure the image does not obscure a user’s ability to read the cell text (if any exists).

Deleting a Background Image

1. Place the cursor within the table.

2. Right click the mouse.

3. Select Set Cell Properties.

4. Delete the value in the Background Image field.

5. Click Update.

Spanning Rows or Columns
You can create a table cell that stretches across more than one row or column. In the following

table, notice how the “Sports Teams” row spans three columns.

Sports Teams

City Baseball Team Hockey Team

Boston Red Sox Bruins

New York Yankees Rangers

Chicago White Sox BlackHawks

You can also create a column that spans several rows, as illustrated below. Notice that Boston

spans three rows.
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Colleges

City Name

Boston

Boston College

Northeastern University

Boston University

New York Columbia University

Spanning More than One Row or Column

To have a table cell span more than one row or column, follow these steps.

1. Place the cursor in the cell that will span rows or columns.

2. Right click the mouse.

3. Click Merge Cells Horizontally orMerge Cells Vertically from the menu.

n Merge Cells Horizontally merges the cell in which the cursor resides with the cell to its

right.

n Merge Cells Vertically merges the cell in which the cursor resides with the cell below.

Note: You can alsomerge cells on the Table Design tab of the TableWizard.

Content

7-98
ReferenceManual

Version 8.0 Rev 1.3



Effect of Spanning a Cell
When you set a cell to span rows or columns, eWebEdit400 does not remove the cells that are

in the way. Instead, it moves those cells across or down to the next available position.

For example, the following table has two rows and two columns.

If you set cell A to span two rows, note that cell C moves across to make room for cell A. This

action pushes cell D to the next column.
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Aligning Text Within a Cell
Within a cell, you can specify how your text aligns horizontally and vertically.

You have nine choices for specifying the horizontal and vertical alignment of a cell, illustrated

below.

To set cell alignment, follow these steps.

1. Place the cursor in the cell that you want to edit.

2. Right click the mouse.

3. Click Set Cell Properties.

4. The Cell Properties dialog appears.

5. Click the down arrow to the right of Content Alignment.

6. Click your alignment choice.

7. Click Update.
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Splitting a Cell
You can divide a cell into two. If you split a cell, each cell occupies one half the size of the

original cell.

Row before split

Row after split

To split a table cell into two cells, follow these steps.

1. Place the cursor in the cell that you want to split.

2. Right click the mouse.

3. Click Split Cell from the menu.

4. Two cells now appear where only one appeared before.
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Merging Two Cells
You can merge two cells into one. If you merge two cells, the new cell contains all of the

information from both. The new cell’s width or height equals the sum of the two cells that

were merged.

Cells Before Merge

Cell After Merge

The above example shows a horizontal merge. You can also merge cells vertically.

To merge two or more cells, follow these steps.

1. Place the cursor in the left or upper cell.

2. Right click the mouse.

3. Click Merge Cells Horizontally orMerge Cells Vertically.

Word Wrap
Word Wrap is a text formatting feature of cells. It causes text to move down to the next line

when the width of the characters on a line equals the column width. For example, if you set

column width to 50%, with word wrap turned on, a table looks like this.
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If you turn Word Wrap off for the same table, you get this result.

If Word Wrap is turned off, text stays on one line until the user entering table text presses

<Enter>. That keystroke causes text to move down to the next line.

By default, all cells have the Word Wrap feature turned on.

Turning Word Wrap On and Off

To turn Word Wrap on or off for a cell, follow these steps.

1. Place the cursor in the cell that you want to edit.

2. Right click the mouse.

3. Click Set Cell Properties.

4. The Cell Properties dialog box appears.

5. To turn off Word Wrap, click the No Wrapping checkbox.

6. Click Update.

Setting Cell Padding and Spacing
Cell padding is the space between a cell’s data and its border.

Setting Cell Padding and Spacing
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Cell spacing is the space between a cell and surrounding cells.

Assigning Cell Padding and Spacing

To assign cell padding and spacing to your table, follow these steps.

1. Place the cursor in the table.

2. Right click the mouse.

3. Click Set Table Properties.

4. The Table Properties dialog appears.

5. Click the Table Properties tab.

6. In the Cell Padding and Cell Spacing fields, enter the number of pixels.

7. Click Update.
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Editing HTML Content

Ektron CMS400.NET HTML content can be in any of several statuses, as described in

"Content Statuses" on page 7-133. You can only edit content for which you have permission

and in one of the following statuses:

n published

n checked in

n checked out by you

n submitted for your approval

Note: If you check content out, you, amember of the Administratorsgroup or a user assigned the folder admin

rolemust check it in before other users can edit it.

Note: Editing content is a privilege granted by the system administrator. If you do not see an Edit option on the

dropdownmenu, you do not have permission to do so.

See Also:

n "Translating Content to Another Language" on page 7-112

n "Editing an Office Document" on page 7-427

n "Editing a Managed File" on page 7-437

Finding Content
Much of your work involves editing existing content or creating new content. Ektron

CMS400.NET provides three methods for finding content to be updated. You can use

whichever method is easiest.

n Navigate through your Web site to the content you want to edit

n Find the content through the Workarea, which resembles Windows Explorer and helps

you find content by navigating through a folder tree. See Also: "The Workarea and Smart

Desktop" on page 4-1

n Use the Search button ( ), which appears on many screens. When clicked, a screen

prompts you to enter keywords and then finds content containing the keywords.
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Steps in Editing HTML Content
There are several ways to edit content.

n from a web page after you log in (See Also: "Editing Content from a Web Page" on page

7-106)

- Edit

- Edit in Context

n from the Ektron CMS400.NET Workarea (See Also: "Editing Content from the Workarea"

on page 7-110)

Each is explained below.

Editing Content from a Web Page
There are two options for editing content from a Web page, illustrated below.

This table compares the editing options.

Edit in Context

Option
Edit Option

How editor is displayed
Within the page you are

viewing
In new window

Editing functions Only a few Complete set
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Edit in Context

Option
Edit Option

What you can update Content only
Content plus all editor tabs (Summary, Metadata,

etc.)

Typesof content

available
HTML only

n HTML

n HTML forms

n XMLSmart Forms

What you can do after

editing
Submit/Publish only Check in or Submit/Publish

Available from Web Site Content Menu

Web Site Content Menu andWeb Site Server

ControlMenu

See Also: "TheWeb Site Content Menu" on page

7-4

For more information

see

"Edit in Context" on page

7-107
"Edit Option" on page 7-109

Edit in Context
The Web Site Edit in Context option offers content authors quick access and editing within a

page. But it has a limited set of editing functions (listed below). See Also: "Editing Content

from a Web Page" on page 7-106

To Edit in Context from a Web page, follow these steps.

Prerequisite: You must have permission to edit the content.

1. Sign in to a Web site.

2. Browse to the content you want to edit.

3. Click Edit in Context from the menu.

4. The content opens within the page, as shown below.
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5. Use the following table to help you edit and save the content.

Toolbar button/

menu option
Description

For more information,

see

Save changesand submit content to

the approval chain

Note: Unlike other edit options, the

check-in button is not available.

"Approve/Decline One

Content Item" on page 5-35

Undo checkout, discard your edits, and

close the editor

Spell check
"Checking Spelling" on page

7-36

,
Add/remove a hypertext link

"Using Hyperlinks" on page 7-

55

Insert library item
"Adding a LibraryFile to

Content" on page 8-18

, Apply bold or italic formatting

Right clickmenu options

Cut selected text " Cut" on page 7-24

Copy selected text " Copy" on page 7-24

Paste text " Paste" on page 7-24

Paste text fromWord "" on page 7-25

Paste plain text "" on page 7-25

Set Image Properties (appearswhen

you select an image)

"Editing an Image’s

Properties" on page 7-40

Note:

Note:

Note:

Note:

Note:
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Note: * System administrators can remove toolbar buttonsbyediting the C:\Program
Files\Ektron\CMS400v8x\workarea\ContentDesigner\configurations\InterfaceEditInContext.aspx

file.

Note: * The content block server control’sSuppresswrappertagspropertymust be set to false.

Edit Option
The Web Site Edit option offers content authors full access to all editing functions.

To access the Edit Content screen from a Web page, follow these steps.

1. Sign in to the Web site.

2. Browse to the content you want to edit.

3. Click Edit from the menu.

4. The Edit Content in Folder screen appears. One of two editors may appear. See Also:

"Ektron CMS400.NET Editors" on page 7-20

From here, you can

n edit content

n create or edit a summary

n specify metadata for the content

n enter or update a comment

n enter or update start and end dates

n review and update Web Alert information (To learn more, see "Web Alert Feature" on

page 20-1)

n if aliasing is enabled and you are an alias administrator, an Alias tab appears (To learn

more, see "Manual Aliasing" on page 10-27)

n assign or change available templates (To learn more, "Creating/Updating Templates"

on page 7-184)

n assign taxonomy categories (To learn more, see "Taxonomy" on page 9-200)

n save changes

n check in content

n submit content for approval

n publish content to the Web site

n access the library

5. Edit the content. See Also: See "Toolbar Buttons" on page 7-23

Or, you can choose a toolbar option or tab from the top of the Edit Content window.

These options are described in "Buttons on the Add Content Screen" on page 7-18 and

"Tabs on the Edit Content Screen" on page 7-18.
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Editing Content from the Workarea
To access the Edit Content screen from the Workarea, follow these steps.

1. Access the View Content screen for the folder that contains the content you want to edit,

as described in "Viewing Content" on page 7-9.

2. Select View > Language then the language whose content you want to view.

3. Hover the cursor over the triangle ( ) and click.

4. Select Edit from the menu.

5. The editor opens with the content block inserted. One of two editors may appear. See

Also: "Ektron CMS400.NET Editors" on page 7-20

6. From the Edit Content window, you can

n edit content

n create or edit a summary

n specify metadata for the content

n enter or update a comment

n enter or update start and end dates

n review and update Web Alert information (To learn more, see "Web Alert Feature" on

page 20-1)

n review and update templates (To learn more, see "Creating/Updating Templates" on

page 7-184)

n review and update categories (To learn more, see "Taxonomy" on page 9-200)

n save changes

n check in content

n submit content for approval
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n publish content to the Web site

n access the library

7. Make the necessary edits to the content.

Or, you can choose a toolbar option or tab from the top of the Edit Content window.

These options are described in "Buttons on the Add Content Screen" on page 7-18 and

"Tabs on the Edit Content Screen" on page 7-18.
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Translating Content to Another
Language

Note: The following procedure onlyworkswith HTML or XML content. You cannot translate other file typesas

described below.

Use this procedure when you want to initialize a new foreign language content item with

content from a source language. This copying should facilitate the translation.

For example, an editor is translating content from French to German. The editor copies the

French edition to new content whose language is German. As the editor translates the French

edition into German, he deletes the French content. Any images in the content would usually

remain, and all formatting (tables, bullets, etc.) is retained.

Note: Ektron CMS400.NET also hasa Language Export feature copies content into XLIFF files for submission to

a translation agency. For more information, see "Using the Language Export Feature" on page 14-13.

To copy content into new content block of a different language, follow these steps.

1. Go to the View Content screen for the content you want to translate. See Also: "Viewing

Content" on page 7-9

2. Use the Add: dropdown list in the upper right corner to select the language into which

you want to translate the content.

3. The Edit Content screen appears with original language content.

4. Translate into the new language then delete the original content.

If desired, you can click the Translate button ( ). If you do, a new screen prompts you
to identify the original language, new language, and a glossary. Then, the content is

translated. If you like the translation, click Paste Content, and the translated content

replaces the original.

Once the translated content is inserted into the editor, you can edit it as needed.

5. When you save the content, it is saved as the edition of that content in the selected

language. It has the same content ID number as the original content but a different

language identifier.
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Moving or Copying Content

You can move content from any folder to any other folder. Or, you can copy content from one

folder to another. At the end of both procedures, a copy of the content resides in the new

folder. Moved content retains the original ID number, while new content gets the next

available ID number.

When copying, you leave the content in its original folder, while moving deletes the content

from the original folder. Other than that difference, the procedure for performing both actions is

virtually identical.

Who Can Move or Copy Content?
n members of the Administrators user group

n users assigned in the Roles > Folder Specific > Folder User Admins screen

n users assigned in the Roles > Folder Specific > Move or Copy screen

See Also: "Defining Roles" on page 15-32; "Guidelines for Using the Folder-User Admin

Role" on page 15-37; "Move or Copy" on page 15-36

Impact of Content Status on Moving
and Copying
Your ability to move and copy content is affected by the content’s status, as described below.

Action Content Status

Move Approved, Checked in

Copy Approved
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What is Moved Or Copied?
When content is moved or copied, the following changes are made.

n The content inherits permissions and the approval chain from the new folder.

n The content’s Quicklink is moved or copied in the library to the destination folder.

However, the Quicklink remains the same (that is, the default template doesn’t change).

You can update this by editing the Quicklink. This procedure in "Updating Default

Template for Multiple Quicklinks" on page 8-24.

Note: If the LinkManagement setting in the web.config file is set to true, you do not need to update the quicklink.

LinkManagement automatically finds the correct template based on the current folder.

n If the new folder already contains content with the same title, Ektron CMS400.NET

appends a number to the title to make it unique. For example: ASP.NET Unleashed(2).

n The new folder’s default template is assigned to the content

n Library image paths inside the content remain the same

n If the content’s template is a Smart Form, it remains assigned even if the Smart Form is not

assigned to the new folder

Moving Or Copying One Content Item
To move or copy content to another folder, follow these steps.

See Also: "Moving or Copying Content" on page 7-113

1. Access the View Content screen for the content you want to move or copy, as described

in"Viewing Content" on page 7-9.

2. Click the Move/Copy Content button ( ).

3. The Move/Copy Content screen is displayed.

4. Select eitherMove or Copy.

5. If you choose Copy, and you want the content to be published as soon as the copying is

complete, check Publish Copied Content.

If you want the content status in the new folder to be checked in, uncheck the Publish

Copied Content checkbox.

6. Enter the path to the destination folder. If you don’t know the path, click Select Folder

and navigate to the destination folder.
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7. Click the Move/Copy Content button ( ).

8. A confirmation message is displayed.

9. Click OK to continue.

10. The content is moved or copied to the specified content folder. The destination folder

appears with the new content.

Moving Or Copying Several Content
Items
To move or copy several content items in the same folder at once, follow these steps.

See Also: "Moving or Copying Content" on page 7-113

1. Navigate to the folder that contains the content you want to move or copy.

2. Click Action > Move/Copy Content.

3. The Move/Copy Contents of Folder screen is displayed.

4. Select eitherMove or Copy.

5. If you choose Copy, and you want the content to be published as soon as the copying is

complete, check Publish Copied Content.

If you want the content status in the new folder to be checked in, uncheck the Publish

Copied Content checkbox.

6. Enter the path to the destination folder. If you don’t know the path, click Select Folder

and navigate to the destination folder.

7. Check the boxes next to the content that you want to move or copy.

Note: Checkoff the box in the header cell to select all or deselect all eligible content.

8. Choose the content folder to move or copy the selected content from the drop down list.
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9. Click the Move/Copy Content button ( ).

10. A confirmation message is displayed.

11. Click OK.

12. The content is copied or moved to the destination folder.
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Viewing and Restoring Previous
Content

Past versions of published content are available unless your system administrator purged them.

Your ability to view a content item’s history is determined by your user privileges.

After viewing previous versions of content, and comparing any two versions, you can replace

the current version with any previous one.

Note: The Purge History feature deleteshistorical versionsof content according to user-defined criteria.

Therefore, some previous versionsmaybe unavailable. See Also: "Purge History" on page 5-21

The View and Restore features are explained through the following subtopics.

n "Accessing Content History" on page 7-117

n "The Content History Window" on page 7-118

n "Comparing Versions of Content" on page 7-120

n "Restoring a Previous Version" on page 7-128

n "Removing Applied XSLT" on page 7-129

Accessing Content History
By default, all users can view the history of Ektron CMS400.NET content. You can access

content history from two places:

n The Workarea’s View Content page

n A Web page

Once you access the history, the functionality is identical.

The following sections explains how to access the content history from both places.

Accessing the Content History from the Workarea

To access the history from the Workarea, follow these steps.

1. Navigate to the View Content page for the content whose history you want to view.

2. Click the item whose history you want to view.
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3. The View Content Screen appears.

4. Click the View History button ( ).

Accessing the Content History from a Web Page

To access the history for content from a Web page, follow these steps.

1. Sign in.

2. Browse to the content whose history you want to view.

3. Click the View History menu option.

4. The Content History window opens.

The Content History Window

The View Content History window lists every version of the content available in Ektron

CMS400.NET. The window displays the following information for each version.

n version number See Also: "The Content Version Number" on page 7-119
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n a green circle indicates a version that was published. Versions without a green circle

indicate content that was checked-in but not published.

n date and time version was checked in or published

n title of content

n last user who edited content

n comments entered by user to describe nature of changes made

To view any version, click its title. When you do, the Content History window appears for

that content.

The Content Version Number

Ektron CMS400.NET assigns a unique number to each saved version of a content block. The

number is increased by one tenth if the content is checked in but not published. If the content

is published, the next whole number is assigned.

For example, if the current version is 1.0 and you check in that content, the new version is 1.1.

If the next editor publishes it, the new version is 2.0.

If content versions are purged, the numbering scheme restarts with the remaining content.

The Detail History Window

After viewing the View Content History window, you can click any version to see the detail

for it. The detailed History window has two sides:

n The left side redisplays information from the content history window. See Also: "The

Content History Window" on page 7-118

n The right side displays the selected version of the content. After viewing a version of

content, you can perform these actions on it.

Action Button Description More Information

View Difference
Compare historical version to current

version

"Comparing Versionsof

Content" on page 7-120

Restore Restore historical version of content
"Restoring a Previous

Version" on page 7-128

Remove XSLT

XML Content

Only

Remove XSLT applied to XML content
"Removing Applied XSLT"

on page 7-129
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Comparing Versions of Content
There are two versions of this procedure. You may need to consult your system administrator to

determine the correct procedure for you.

If the Ektron

CMS400.NET

server is

And

your

client is

See

32 bit 32 bit "The View Content Difference Screen" on page 7-120

64 bit 32 bit

"The View Content Difference Feature" on page 7-122

Note: This procedure was the only one prior to 7.5.2. It

downloadsan ActiveX control to your computer.

64 bit 64 bit The View Content Difference feature is not available

The View Content Difference Screen

Note: Use this procedure if both your computer and the Ektron CMS400.NET server are 32 bit.

The View Content Difference screen highlights changes to selected content. Below is an

example of the View Content Difference screen, showing the default tab, Difference.
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Each tab is explained below.

Tab Shows this content

Difference

Both versions:

n content that only appears in the version on the This Content tab is high-

lighted in yellow

n content that only appears in the currently published version is red

n unchanged content is black

Last

Published
Currently-published.

This

Content
The version you are comparing the currently-published content against.

Warning! If there is no difference between the versions, you seeContent is Identical.

The View Content Difference feature is explained through the following topics.

n "When Can I Compare Content?" on page 7-121

n "Accessing the View Content Difference Feature" on page 7-122

When Can I Compare Content?
The View Content Difference feature is available when

Comparing Versions of Content
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n you are viewing a version of content

n a staged version of that content is available (See Also: "Staged Content" on page 7-139)

Learn About Accessing the View Content Difference Feature

Accessing the View Content Difference Feature
To Access the View Content Difference feature, follow these steps.

1. Navigate to the content whose versions you want to compare.

2. Click View Properties.

3. Click the History button ( ). The View Content History screen appears. See Also:
"Comparing Versions of Content" on page 7-120

4. Click a version that you want to compare with the most recently published version.

5. Click the View Content Difference toolbar button ( ).

The View Content Difference Feature

Note: Use this procedure if your computer is 32 bit, and the Ektron CMS400.NET server is 64 bit.

The View Content Difference feature highlights changes that were made to selected content.

Below is an example of the View Content Difference screen, showing two versions of content.

The changes are indicated by

n redlining deleted content

n highlighting in yellow added content
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Within the View Content Difference feature, you can perform several tasks, as well as view

different versions of the content separately, or compared.

The View Content Difference feature is explained through the following topics:

n "When Can I Compare Content?" on page 7-121

n "The Compare Content Window" on page 7-123

n "First Use of the View Content Difference Feature" on page 7-127

When Can I Compare Content?
The View Content Difference feature is only available when

n you are viewing an historical version of content

n a staged version of the content is available (See Also: )

The following table explains when you can use the feature, and which versions are compared.

Content Status Compares current published version with

Published Historical version stored in the content history area

Checked-In Most recently checked-in version

Submitted Submitted version

Pending Start Date Scheduled version pending start date

CheckedOut Not available

If content can be compared with another version, the View Difference button ( ) appears in
the content history area or the Web page view.

The Compare Content Window

Note: The first time the View Content Difference feature is opened, a simple installation program runs. See Also:

"First Use of the View Content Difference Feature" on page 7-127.

The Compare Content window consists of the following:

n "Toolbar" on page 7-124

n "Content Area" on page 7-126
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n "View Tabs" on page 7-127

Each area is explained below.

Toolbar

The content comparison toolbar has five buttons, explained below.

Button Name Description

Print

Sends content to local or network printer.

Note: This option prints the currently displayed content, whether it is the

compared, published, or staged content.

Save

Savesa copy in HTML format on your localmachine or network.When saved

asa physical file, the HTMLmaybe edited. However, the changesare not

saved to theWeb Server.

Note: The save option saves the version of the content you are viewing.

Setup

Opens setup dialog box to configure the settings. Typically, only an

administrator would use this.

For more information, see "Setup" on page 7-125.

Help Displaysadditional information about the compare feature.

Exit Closes the window.
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Setup

Click the Setup button ( ) to open the setup dialog box. Typically, a system administrator
would edit these settings.

You can change the setup options to better suit your needs. The following table explains each

option.

Option Description

Compare Options

Compare visual aspect Compares content as it would appear on aWeb page.

Compare source code Displays compared content as source HTML.

WhitespaceOptions

Ignore All Blank (whitespace) characters are ignored.

Smart Detect

One or more consecutive whitespace characters are treated asa

single separation sequence. That is, multiple whitespace characters

are ignored.

Detect All Blank (whitespace) characters are treated asanyother character.

Other Options

Ignore Case

Determineswhether comparison is case sensitive. For example, if you

check this box, the strings “Bob” and “BOB” are not highlighted

because their only difference is the case of the characters.
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Option Description

Ignore Format Attributes
Determineswhether comparison ignores changes in text-formatting

attributes (HTMLVisualAnalysis only).

After updating setup information, click OK to save changes.

Content Area

The content area displays the content comparison.

The following table describes the change indicators.

Symbol Example Content state

Plain black text Unchanged

Yellow highlighted text Added

Red, struck-through text Deleted
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View Tabs

When viewing content in the View Content Difference feature, there are three view modes,

explained below.

View Description

Diff Comparespublished version of content to staged version

Published Displays currently published version

Staged
Displays the staged version of content. See Also: "Staged Content" on

page 7-139

To switch between views, click the corresponding View tab.

First Use of the View Content Difference Feature

The first time the View Content Difference screen is used on a client machine, a simple

installation program is performed.

Click Yes when the following screen appears.
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When the installation program completes, close and reopen the View Content Difference

feature.

Actions are explained below.

Restoring a Previous Version

Note: The ability to restore content is a privilege granted by the system administrator. If you do not see a Restore

button ( ) on the View Content History screen, you do not have permission to do so.

1. Open the content folder that contains the content.

2. Click the content item.

3. Click the History toolbar button ( ).

4. Select an historical version of the content that you want to restore.

5. Click the Restore button ( ).

6. The content history window closes, and you return to the View Content page or the Web

page, with the content in a checked in status.

7. If desired, check out the content to make additional changes.

8. Select the workflow to perform on the content.

9. When the historical version is placed in the approval chain and approved, it is published

to the Web site.
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Removing Applied XSLT
You can only remove an applied XSLT when viewing historical versions of XML content. If

you remove the applied XSLT, you can view the content without the irrelevant XML tags.

The following table compares the views.

With XSLT

Without XSLT

Removing Applied XSLT
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Deleting Content

Note: The ability to delete content is a privilege granted by the system administrator. If you do not see a Delete

option on the View Contents of Folder screen, you do not have permission to do so.

Note: It is good practice to check for broken quicklinksbefore deleting content. See "LinkChecking" on page 7-

132.

The Delete command lets you permanently delete obsolete content from your Web site.

There are two ways to delete content.

n A folder-level Delete option ( ) removes several content items from the current
folder. This option only deletes Approved content. For more information, see "Deleting

Several Content Items in a Folder" on page 7-131.

n Depending on the content’s status and your permissions, you may be able to delete one

item at a time. The options for doing so are

- a Delete option when viewing content from a Web page

- a Delete menu option that appears after selecting content on the View Contents of

Folder screen

For more information, see "Deleting a Single Content Item" on page 7-130.

Like publishing, deleted content must proceed through the approval chain before it is removed.

If you are the last approver in the approval chain, the content is deleted immediately. See Also:

"Approve/Decline One Content Item" on page 5-35

Deleting a Single Content Item
To delete one content item, follow these steps.

Deleting One Content Item from a Web Page
To delete content from a Web page, follow these steps.

1. Sign in.

2. Browse to the content you want to delete.

3. Click the Delete menu option.

4. The View Content screen for the selected content appears. (See "Viewing Content" on

page 7-9.)
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5. Click the Delete button ( ).

6. A confirmation message appears.

7. Click OK to delete the content.

Deleting One Content Item from the Workarea
1. Access the View Contents of Folder screen for the content you want to delete, as

described in "Viewing Content" on page 7-9.

2. Hover the cursor over the triangle ( ).

3. Select Delete from the dropdown menu.

Note: If you do not seeDelete, either you lackpermission to delete the content, or its statusmakes it ineligible for

deleting.

4. A confirmation message appears.

5. Click OK to delete the content.

Deleting Several Content Items in a
Folder
On the View Contents of Folder screen, you can delete several Approved content items at

once. To do so, follow these steps.

Note: If you are working with an eCommerce catalog entry, you can only delete it if it is not on an order nor

checked out.

1. Navigate to the folder that contains the Approved content you want to delete.

2. Hover the cursor over the Delete menu ( ).

3. Select Content from the dropdown menu.
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4. Check boxes next to Approved content items you want to delete.

Note: Check the box in the header cell to select all or deselect all.

5. Click the Delete Content button ( ).

6. A confirmation message appears.

7. Click OK to continue.

Link Checking
The link checker button locates all content with a link to the displayed content. This feature is

useful if you decide to delete content. You can use this to remove links that will not work after

the deletion.

1. Access the View Content screen for the content you want to execute the link checker for,

as described in "Viewing Content" on page 7-9.

2. Click the Link Search button ( ).

3. A screen displays each content item with a link to the current content.

4. Click the content title to access the View Content screen for the selected content.

5. Remove or change the Quicklink.
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Content Statuses

The table below describes all possible content statuses. The rest of this appendix explains each

status in more detail.

Letter Meaning Content state
More

Information

A Approved
Through the workflow and published on the

Web site.

"Approved

Content" on

page 7-134

O Checked Out
Currently being edited. Hasnot been checked

in.

"CheckedOut

Content" on

page 7-137

I Checked In Checked in for other users to edit.

"Checked-In

Content" on

page 7-135

S
Submitted for

Approval

Saved and submitted into the approval chain.

See Also: "ApprovalChains" on page 5-28

"Submitted

Content" on

page 7-138

M Marked for Deletion Requested for deletion.

Marked for

Deletion

Content

P Pending Go Live Date
Approved but the Go Live date hasn’t occurred

yet.

"Pending Start

Date Content"

on page 7-139

T
Awaiting Completion

of Associated Tasks
Task(s) assigned to content are not complete

D Pending Deletion

Content was created with a future start date

then checked in and deleted.

This status only remainsuntil the start date is

reached. At that point, the content is deleted.
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Approved Content
Approved content is live on the Web site. From the web page, you can see your choices of

actions you can perform on the content from the dropdown menu illustrated below.

When content is approved, you can perform the following actions on it, depending on your

permissions.

.

Button

Dropdown

Menu

Option

Description
For more information,

see

Checkout and

Save as

Check content out and save on your

computer

"Checking Out, Saving, and

Replacing anOffice

Document" on page 7-430

Save as Save copyof file to your computer
"Saving anOffice Document"

on page 7-432

Edit or Edit in

Office
Checkout the content to change it

n "Editing Content from a

Web Page" on page 7-106

n "Edit in Context" on

page 7-107
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Button

Dropdown

Menu

Option

Description
For more information,

see

n "Edit Option" on page 7-

109

n "Editing Content from

theWorkarea" on page 7-110

Edit Properties
Edit content’s summary, metadata,

schedule, comment, etc.

n "Working with Content

Summary" on page 7-142

n "Working with Meta-

data" on page 7-146

n "Scheduling Content to

Begin and End" on page 7-

195

View, View in

Office, or View

Properties

View all information about content
"Viewing Content from the

Workarea" on page 7-10

Delete

Submit a request to delete the content. If you

are the last or only approver, the content is

immediately deleted.

See Also: "Example of an Approval
Chain" on page 5-37

"Deleting Content" on page 7-

130

Checked-In Content
A checked-in content item is one to which changes were made, after which it was checked in

instead of being submitted or published. When content is checked in, it is accessible to all

users who have permissions to edit it. They can check it out and change it.

Keep in mind that the content seen on the template is not the same as the content in the editor

view.

See Also: "Example of an Approval Chain" on page 5-37

Each option you may perform on checked-in content is described below.
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Button Name Description
For more

information, see

Checkout and

Save as
Check content out and save on your computer

"Checking Out, Saving,

and Replacing anOffice

Document" on page 7-

430

Save as Save copyof file to your computer

"Saving anOffice

Document" on page 7-

432

Edit or Edit in

Office
Checkout the content to change it.

n "Editing Content

from aWeb Page" on

page 7-106

n "Edit in Context" on

page 7-107

n "Edit Option" on

page 7-109

n "Editing Content

from theWorkarea" on

page 7-110

Edit Properties
Edit content’s summary, metadata, schedule,

comment, etc.

n "Working with Con-

tent Summary" on page

7-142

n "Working with Meta-

data" on page 7-146

n "Scheduling Con-

tent to Begin and End" on

page 7-195

View, View in

Office, or View

Properties

View all information about content

"Viewing Content from

theWorkarea" on page

7-10

Delete

Submit a request to delete the content. If you are

the last or only approver, the content is

immediately deleted.

See Also: "Example of an ApprovalChain" on
page 5-37

"Deleting Content" on

page 7-130

Submit/Publish

Submit content into approval chain.

If you are last approver in the approval chain, the

publish button/option appears. If you click it, the

content is immediately posted toWeb site.

"ApprovalChains" on

page 5-28
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Checked Out Content
If content has a red border, it was checked out by a user other than you. (If you checked it out,

the border is green.) While in this status, other users are prevented from editing it.

The content remains checked out until it is checked in by the user who checked it out or a

system administrator. Only the user who checked out the content can edit it.

Each option you may perform on checked-out content is described below.

Button Name Description
For more

information, see

Check In
Check in content. Only appears to user who checked

content out.

"Check in" on page

5-10

Force Check

In

Only appears if user is amember of the Administrator

group and content is checked out.

Allows the admin to check in content even though he

is not the one who checked it out.

Request

Check In

Allowsanyuser to send an email to the user who

checked out content. The email asks the check-out

user to check in the content.

Save as Save copyof file to your computer

"Saving anOffice

Document" on page

7-432

Edit or Edit in

Office

Checkout content to change it. (Only available to user

who checked content out.)

n "Steps in Edit-

ing HTMLContent"

on page 7-106

n "Editing aMan-

aged File" on page

7-437

n "Editing an

Office Document" on

page 7-427

Edit Properties
Edit content’s summary, metadata, schedule,

comment, etc.
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Button Name Description
For more

information, see

View, View in

Office, or View

Properties

View all information about content

"Viewing Content

from theWorkarea"

on page 7-10

Submitted Content
A yellow border shows that a user submitted the content into the approval chain. The border

remains yellow until the content is published or declined. While the content is in the approval

chain, no user can check it out.

See Also: "Example of an Approval Chain" on page 5-37

Each toolbar button is described below.

Button Name Description

Approve

Approve and publish the content to theWeb site.

Note: Only the last approver in the chain has this option.

See Also: "Example of an ApprovalChain" on page 5-37

Decline

Refuse to publish the submitted content, and change its status to checked-in.

Note: Onlymembers of the approval chain have this option.

This button rejects the changesand keeps the current version live onWeb site.

The approver is prompted to enter a reason for the decline. After the decline

option is completed

n The author whomade the change is notified byemail

n The content is removed from the ApprovalChain

If an author updated content then submitted it for approval, the updated

content remains in the file. If you do not want it to remain, choose the Edit

option.

Approvers are prompted to publish or decline content changesaswell as

requests to delete content.

Edit

Checkout the content and edit it. Only the user who submitted the content has

this option.

Note: If you edit the content, you need to resubmit it to the approval chain.
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Button Name Description

View, View in

Office, or View

Properties

View all information about content

(continued in Marked for Deletion Content)

Pending Start Date Content
Content that is pending a Go Live date has been approved, but its start date and time have not

occurred yet.

Button Name Description

Edit

Checkout the content and edit it. Only the user who submitted the

content has this option.

Note: If you edit the content, you need to resubmit it to the

approval chain.

View, View in Office, or View

Properties
View all information about content

Staged Content
A staged version of content is one that is not published. It can be content that is checked in, or

content that is approved with a pending a start date.

Staging lets you make changes to content, while keeping it from the Web site until you are

ready to publish it.

See Also: "After you select the content, you have the following options." on page 7-11;

"Content Statuses" on page 7-133; Workflow in

Pending Start Date Content
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Content Properties
This section explains the properties of Ektron CMS400.NET content, such as the summary,

metadata, and the ability to schedule start and end dates.
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Content Properties

Content Properties
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Working with Content Summary
A summary provides a short description of content to supplement the title when a list of

content items appear on a Web page. You create a summary when creating or editing content.

Then, your Web site developer can create Web pages that display just the title and summary to

attract readers to the full story.

A good example is a news Web site, which lists titles and summaries of top stories (illustrated

below)

TOP STORIES

Ektron Named aRising Star (08-15-2003)

August 15, 2003, Amherst, New Hampshire, USA —
Ektron, Inc., an innovator in Web content

management and authoring, has been named a

Rising Star as part of the prestigious New

England Technology Fast 50 Program.

Ektron Launches International Distribution Program (08-
08-2003)
August 8, 2003, Amherst, New Hampshire, USA —
Ektron, Inc., an innovator in dynamic
Web content authoring and management
with over 350,000 users, today announced
the launch of its international
distribution program.

Like content, summaries can include images as well as different font styles and sizes. This

chapter explains how to create summaries and how they can help navigation on your site. Your

system administrator determines how and where to display summaries on your site.

See Also:

n "Automatic Creation of a Summary" on page 7-143

n "Creating a Summary for New Content" on page 7-143

n "Creating a Summary for Existing Content" on page 7-144

n "Editing a Summary" on page 7-145

n "ListSummary Server Control" on page 9-270
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Automatic Creation of a Summary
Ektron CMS400.NET automatically generates a summary for new content if none exists. To do

this, it checks the summary when new content is published. If the summary is blank, Ektron

CMS400.NET copies the first 40 words of the content to the summary.

After the content is published, you can update or delete the summary. If it is deleted, the

summary remains blank and is never again automatically generated for that content item.

You can disable this feature in Ektron CMS400.NET if desired. See "Automatically Recreating

a Catalog" on page 9-10.

Membership User Summary Editing

If a membership user edits content and wants to update the summary, he can automatically

copy the first 40 words of the content into the summary. To do this, the membership user

checks the Auto Generate New Summary field on the membership editing screen (shown

below).

There is no limit on the number of times a membership user can automatically generate a new

summary.

Creating a Summary for New Content
1. Navigate to the folder in which you want to create the content.

2. Click New then pick the content type from the dropdown menu.

3. The Add Content screen appears.

4. Insert a Title and content. See Also: "Adding HTML Content" on page 7-15
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5. Click the Summary tab.

6. Enter summary information for the content. The summary can include images, files, and

hyperlinks. Its length can be restricted by your system administrator in the configuration

setup file.

7. When done, click the appropriate button.

Creating a Summary for Existing
Content
1. Navigate to the folder that contains the content.

2. Hover the cursor over the content, click the triangle ( ), and select Edit or Edit
Properties from the dropdown menu.

3. The View Content screen appears.

4. Click the Summary tab to enter or edit summary information for the content. The summary

can include images, files, and hyperlinks. Its length can be restricted by your system

administrator in the configuration setup screen.

5. When done, click the appropriate button.

6. The View Content page reappears.

Note: When you enter or edit existing content’s summary, its status changes to checked out. After you create the

summary, click the Check-In button to check the content in. From that point, you need to submit or publish it.
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Editing a Summary

Note: You can only edit the summaryof content that is published, checked in, or checked out by you.

To edit a content’s summary, follow these steps.

1. Access the View Content page for the content whose summary you want to edit, as

described in "Viewing Content" on page 7-9.

2. Click the Summary tab.

3. The Edit Summary window opens.

4. Click the Edit button. The summary opens within the editor.

5. Make the necessary changes.

6. When done, click the appropriate button.

7. The View Content page reappears.

Note: When you edit an existing content summary, it goes into a checked out state. After creating the summary,

check the content back in. From that point, youmust submit it or publish it.
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Working with Metadata
Metadata is information about a content item, such as its title and language. Ektron

CMS400.NET provides extensive and flexible support for metadata, which it uses in both

standard and innovative ways.

This section explains the types of metadata available, and procedures for working with

metadata through the following subtopics.

n "Types of Metadata" on page 7-146

n "Meta Tags" on page 7-148

n "Title Tag" on page 7-149

n "Searchable Metadata" on page 7-150

n "Related Content Metadata" on page 7-151

n "Simple Dublin Core Metadata" on page 7-154

n "Working with Metadata Definitions" on page 7-156

n "Assigning a Metadata Image to Content" on page 7-171

n "MetaData Server Control" on page 7-171

n "MetaDataList Server Control" on page 7-175

Types of Metadata
The following kinds of metadata can be added to Ektron CMS400.NET content.

Metadata

type
Description

For more

information,

see

Meta tag

Resides in a content item’s source code, helping search engines find it.

Note: You can use the SEOControl to identify how search engines

evaluate your Web pages’metadata tags, and other search tools. See

Also: "Using the Search Engine Optimization (SEO) Control" on page

21-515

"Meta Tags" on

page 7-148

HTML tag

Information about the content used byaWeb browser. For example,

<title> identifies the content in the screen title, favorites list, and

browser history.

"Title Tag" on

page 7-149
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Metadata

type
Description

For more

information,

see

Searchable

Metadata that can be found byEktron CMS400.NET’s search.

This kind of metadata can also be found using theWorkarea Search

screen.

"Searchable

Metadata" on

page 7-150;

"Searching for

Metadata" on

page 9-52

Related

content

A related content item, collection, List Summary, or library item that

accompaniesa content item on aWeb page.

"Related

Content

Metadata" on

page 7-151

Simple

Dublin Core

A set of fifteen standard fields that cover themost useful information

about content.

"Simple Dublin

CoreMetadata"

on page 7-154

Content tags
Keywords that can be assigned to content and library itemsand allows

for tag-based searching.

”Tags” on page

16-280

Image
Not part of ametadata definition; automatically appears for every

content item and lets you assign an image to that content

"Assigning a

Metadata

Image to

Content" on

page 7-171

Best Practices

n When anyone createsa newMetadata definition, it is assigned the next avail-

able ID number. The ID numbers determine the order in whichmetadata definitions

are arranged on the Folder Properties screen’sMetadata tab.

n So, byplanning ahead, you can enter metadata definitions in logical groupings,

which willmake it more intuitive for the person assigning themetadata to pick the cor-

rect ones.

n Metadata can be used asa search criterion to find content on your Web site. In

order for this to work, themetadata definition name cannot include a space. So, it is a

good idea to eliminate spaces frommetadata definition names.
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Meta Tags
The META element is an extensible container for use in identifying specialized document

meta-information. Meta-information has two main functions:

n to provide a means to discover that a data set exists and how it might be obtained or

accessed

n to document the content, quality, and features of a data set, indicating its fitness for use

(Above copied from www.w3.org/MarkUp/html-spec/html-spec_5.html.)

Example Meta Tags

Creating and Deploying Meta Tag Definitions
1. While creating a metadata definition, enter the metadata name at the Name field. For

example, Description and Keywords. See Also: "Adding a Metadata Definition" on page

7-156

2. Reply to the standard fields. See "Metadata Definition Fields" on page 7-158.

3. Respond to the additional fields for meta tags. See "Meta Tag Additional Fields" on page

7-159

4. Add the definition to all applicable folders. See "Assigning Metadata to a Folder" on page

7-165

5. Add the definition to applicable content within the folder. See "Adding Metadata to

Content" on page 7-167

6. Add a Metadata server control to every Web form (.aspx page) on which the content will

appear. See "MetaData Server Control" on page 7-171.
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Title Tag
The title should identify the contents of the document in a global context. A browser may

display the title of a document in a history list or as a label for the window displaying the

document.

(Above text copied from www.w3.org/MarkUp/html-spec/html-spec_5.html.)

Creating and Deploying Title Tag Definitions
1. While creating a metadata definition, enter Title at the Name field. See Also: "Adding a

Metadata Definition" on page 7-156

2. Reply to the standard fields. See "Metadata Definition Fields" on page 7-158.

3. Respond to the additional field for HTML tags. See "HTML Tag Additional Field" on

page 7-159.

4. Add the definition to a folder. See "Assigning Metadata to a Folder" on page 7-165.

5. Add the definition to content within the folder. See "Adding Metadata to Content" on

page 7-167.

6. Add a metadata control to every Web form (.aspx page) on which this content will appear.

See "MetaData Server Control" on page 7-171.

Creating and Deploying Search Tag Definitions
1. While creating a metadata definition, in the Name field, enter a description of the kind of

data to be searched. (See examples circled above.) This title describes the search data on

the

n Metadata tab of the Folder Properties screen

n Metadata tab of the View Content Screen
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n Workarea search screen

Note: Searchablemetadata field namesshould not include a space. If theydo, the search cannot find the

metadata.

See Also: "Adding a Metadata Definition" on page 7-156

2. Reply to the standard fields. See "Metadata Definition Fields" on page 7-158.

3. Respond to additional fields for Searchable Property definitions. See "Searchable

Additional Fields" on page 7-160.

4. Add the definition to a folder. See "Assigning Metadata to a Folder" on page 7-165.

5. Add the definition to content within the folder. See "Adding Metadata to Content" on

page 7-167.

6. The next time you visit the Workarea search screen, you will see the new field.

7. If you want site visitors to use this field when searching your Web site, ask your developer

to set the ShowExtendedSearch property of the Search Server Control to true. This value

enables the Web site search to find searchable metadata.

Searchable Metadata
This type of metadata allows content to be found by a search phrase that you add to the

content’s metadata. The content is typically found by both a Web site search as well as a

Workarea search.

Note: When your system administrator sets upmetadata, he determineswhether or not is it “publicly viewable.”

If it is, the search field appearson the search screen that site visitors use along with the search screen in the Ektron

CMS400.NETWorkarea. If the data is not publicly viewable, it can only be found by theWorkarea search.

For example, each document stored in the Document Management functionality has a unique

part number. You want to let site visitors and Ektron CMS400.NET users locate the document

by its part number.

First, your system administrator would add a custom metadata definition called Part Number,

and specifies that only numbers can be inserted into the field. Then he adds that metadata def

inti on to all folders that contain the documents. Finally, when you add a document, you click

its Metadata tab, and insert the part number for the document (illustrated below).
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Then, anyone visiting your Web site can find that document by its part number using your

Web site’s search screen.

See Also: "Searching for Metadata" on page 9-52

Related Content Metadata
You can associate the following types of content with a content item.

n a content item

n a collection

n a list summary

n a menu

n a user

n one of the following types of library items

- image

- hyperlink

- file
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Next, you can set up a Web page so that whenever the source content item appears, the related

information appears next to it.

For example, your Web site sells motorcycle helmets. On a page that shows a particular helmet,

the left column lists a collection of motorcycle drivers who wear that helmet. Another example

might be showing the profile of a user when a certain content item is displayed.

Related Content vs. MetadataList Server Control
This capability is similar to the MetadataList Server control. The difference is that MetadataList

shows a link to every content item with a selected term in the keywords or title. Also, a

MetadataList is associated with a Web form (.aspx page), not a content item.

Related content lets you connect a content item with several types of related content (see list

above), and is associated with a content item, not a web form. For example, you can display a

library image of the company logo on a page whenever content in a certain folder appears. For

content in a different folder, a different logo could appear.

Creating and Deploying Related Content Definitions
1. While creating a metadata definition, in the Name field, enter a title for this kind of data.

This title describes the metadata on the

n Metadata tab of the Folder Properties screen

n Metadata tab of the View Content screen

See Also: "Adding a Metadata Definition" on page 7-156

2. Reply to the standard fields. See "Metadata Definition Fields" on page 7-158.

The Type must end with the word Selector. Choices are highlighted below.
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For example, if you choose ListSummary Selector, a specified List Summary will appear

on the page along with its associated content item.

Your choices are

n Collection Selector

n ListSummary Selector

n Content Selector

n Image Selector (associates a library image with content)

n Hyperlink Selector (associates a library hyperlink with content)

n File Selector (associates a library file with content)

n Menu Selector

n User Selector

3. Add the metadata definition to all appropriate folders. See "Assigning Metadata to a

Folder" on page 7-165

4. For each content item with which you want to associate related content, access its

Metadata tab and identify the related item(s).

Warning! If you are usingCollection Selector type, only userswith permission to workwith collections can

select a collection. Also, if you are using Image, Hyperlink or File Selector type, only userswith permission at

least read-only Library permissions can select a library item. See Also: "Folder Permissions" on page 5-43.

For example, a collection of pages describes popular books. You want this collection to

appear whenever a medical topic is being viewed.

To set this up, you would

- edit the medical content item

- click its Metadata tab

- find the metadata definition for the collection

- click Change

- select the Popular Books
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5. Have your Web developer add code to each page on which the related item appears. To

learn how to do this, access the developer sample page

(http://localhost/cms400developer/developer/default.aspx) and read the Metadata >

Meta Associations description.

Note: To download the developer sample site, go to http://www.ektron.com/solutions/startersites/.

Simple Dublin Core Metadata
Simple Dublin Core is a set of fifteen standard names for metadata fields designed to cover the

most useful items of information on a document. From the Dublin Core site FAQ: “Dublin

Core metadata provides card catalog-like definitions for defining the properties of objects for

Web-based resource discovery systems.” For more information, refer to the Usage Guide:

http://www.dublincore.org/documents/usageguide/.

By using the Metadata Server Control, you automatically create seven of the fifteen Dublin

Core metadata fields. These fields are automatically filled with the information from the

equivalent Ektron CMS400.NET property. Below is a list of the seven fields and their Ektron

CMS400.NET equivalent. For more information on the Metadata Server Control, see "MetaData

Server Control" on page 7-171.
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Dublin Core Field Name Ektron CMS400.NET Property

DC.title Content block title

DC.description Plain text version of a content summary

DC.contributor Content block last editor name

DC.date Content block last edit date

DC.format “text/html”

DC.identifier
URL of current page (from ASP.NET

Server.Request object)

DC.language

CMS language cookie / current site

language, expressed asa .NET

System.Globalization Culture Name

Creating the Additional Eight Fields
To fully comply with the Simple Dublin Core metadata element set, the administrator must

create the remaining eight Dublin Core fields as standard CMS400.NET Metadata definitions

and apply them to all CMS400.NET folders. Next, CMS users complete the appropriate values

for each content block.

Warning! When creating the Dublin Coremetadata fields in theMetadata section of theWorkarea, you do not

need to create the first seven fields in the table above. In addition, the namesof the fields you createmust match

the namesbelow. For example, in the name field, enter “DC.subject”. The DC identifies themetadata asDublin

Coremetadata.

The remaining eight Simple Dublin Core fields are described below:

Note: These descriptionsare from the Dublin CoreMetadata Initiative site. For amore detailed description, visit

http://www.dublincore.org.

n DC.subject - The topic of the content of the resource. Typically, a Subject is expressed as

keywords, key phrases, or classification codes that describe the topic of the resource.

n DC.type - The nature or genre of the content of the resource. Type includes terms

describing general categories, functions, genres, or aggregation levels for content.

n DC.source - A reference to a resource from which the present resource is derived. For

example, DC.source=”Image from page 54 of the 1922 edition of Romeo and Juliet”

n DC.relation - A reference to a related resource.
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n DC.coverage - The extent or scope of the content of the resource. Coverage typically

includes spatial location (a place name or geographic co-ordinates), temporal period (a

period label, date, or date range) or jurisdiction (such as a named administrative entity).

Examples: DC.coverage=”1995-1996”, DC.coverage=”Boston, MA”, DC.coverage=”17th

century” or DC.coverage=”Upstate New York”.

n DC.creator - An entity primarily responsible for making the content of the resource.

n DC.publisher - The entity responsible for making the resource available.

n DC.rights - Information about rights held in and over the resource. Typically, a Rights

element contains a rights management statement for the resource, or reference a service

providing such information.

Working with Metadata Definitions

Note: Onlymembersof the Administrator User Group and those defined in theManageMembers for Role:

Metadata-Admin screen can view, add, or edit metadata definitions. See Also: "Using the RolesScreens" on page

15-33

Procedures for creating, updating and deleting metadata definitions are explained in the

following sections.

n "Adding a Metadata Definition" on page 7-156

n "Viewing Metadata Definitions" on page 7-164

n "Editing a Metadata Definition" on page 7-164

n "Deleting a Metadata Definition" on page 7-165

n "Assigning Metadata to a Folder" on page 7-165

n "Adding Metadata to Content" on page 7-167

Adding a Metadata Definition
Use the Add Metadata Properties screen to define metadata (such as keywords and title). You

can define as many instances of metadata as you wish.

If your site supports multiple languages, you create metadata definitions for each supported

language.

See Also: "Working with Metadata" on page 7-146
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To define a metadata definition, follow these steps.

Warning! After creating a definition, youmust assign it to folderswhose content should use it. You do this via the

folder’s properties. See "AssigningMetadata to a Folder" on page 7-165.

1. From the Workarea’s left frame, click Settings > Configuration > Metadata Definition.

2. The View Metadata Definitions screen appears.

3. Select the language for the metadata you are about to define. This metadata will be

available only to content in this language.

4. Click the Add Metadata Definition button ( ).

5. The Add Metadata Definition screen appears. Using the following table, add the needed

information.

After you create a metadata definition, you may see the following error in the Windows Event

Viewer Log.
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To learn more about this problem and how to resolve it, see the following Microsoft KB

article: http://support.microsoft.com/kb/310680.

Metadata Definition Fields

Field Description

Name

Enter a name to identify thismetadata.

Note: Searchablemetadata field namesshould not include a space. If theydo, the search cannot

find themetadata.

Ektron CMS400.NET reservesa list of names that you cannot use. If you enter one of them, the

following error message appearswhen you try to save the definition.
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Field Description

Type

From the drop-down list, select whether this tag is

n a searchable property - See Also: "Searchable Additional Fields" on page 7-160

n an HTML tag (for example, <title>) - See Also: "HTML Tag Additional Field" on page 7-

159 and "Related Content Metadata" on page 7-151

n aMeta tag (<meta>) - See Also: "Meta Tag Additional Fields" on page 7-159 and "Related

Content Metadata" on page 7-151

n Collection Selector, ListSummarySelector, Content Selector, Image selector, Hyperlink

Selector, File Selector - See Also: "Related Content Metadata" on page 7-151

Editable

Check this box if you want to allow users to edit the contents of themetadata when creating or

editing themetadata’s content.

Uncheck this box if you want uniformmetadata text for each content item that uses thismetadata.

HTML Tag Additional Field
See Also: "Related Content Metadata" on page 7-151

Field Description

Default

Text

Enter default content for the HTML tag. For example:

content="document management web content management content management

cms"

Meta Tag Additional Fields

Note: For background information about metadata, see http://www.w3.org/TR/REC-

html40/struct/global.html#edef-META.

See Also: "Related Content Metadata" on page 7-151
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Field Description

Style

Select from the drop-down list to indicate whether you want the style to be name or http-

equiv.

For more information, see http://www.w3c.org/TR/REC-html40/struct/global.html#h-

7.4.4.2

Remove

Duplicates
Check this box to remove duplicate wordsor phrases from themetadata.

Case

Sensitive
Check this box to remove duplicates only if the letters and case of each letter match.

Separator Enter a character to separate themetadata values. The default is a semicolon (;).

Selectable

Metadata

Check this box to force users to select from the options specified in theAllow Selectable

Text andDefault Text fields.

If you do not check this box, users can create their ownmetadata.

Allow Multiple

Selections

Check this box to let users select multiple metadata values instead of one. If multiple values

are allowed, use the separator character to delimit them.

If this box is not checked, all valuesappears in a drop-down list, and the user selects the

correct one.

This field is only active if the Selectable Metadata box is checked.

Allowed

Selectable

Text

Enter standardmetadata that can be selected byusers. Separate each option by the

separator specified for themetadata definition.

This field is only active if the Selectable Metadata box is checked.

Default Text Enter default content for themetadata tag.

Searchable Additional Fields

Field Description

Publicly

Viewable

If you check the box, site visitors can find themetadata value when searching your Web site.

Otherwise, site visitors cannot find themetadata value.

Note: Regardlessof whether this is checked, thismetadata value can be found using the

Workarea’sSearch Content Folder screen. Only logged-in users can access theWorkarea.
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Field Description

Style

Select the style of the response field from these choices (available in a dropdown list). You are

specifying the kind of information that a user adding searchable properties to content will enter to

describe the data. Later, anyone using the search can search on that information.

See Also: "AssigningMetadata to a Folder" on page 7-165

n Text - The user enters free text to describe the content.

n Number - The user enters a number to describe the content.

n Byte - 1 byte. 0 through 255 (unsigned)

n Double - 8 bytes. -1.79769313486231570E+308 through -4.94065645841246544E-324

† for negative values; 4.94065645841246544E-324 through 1.79769313486231570E+308 † for

positive values

n Float - (single-precision floating-point) 4 bytes. -3.4028235E+38 through -1.401298E-45 †

for negative values; 1.401298E-45 through 3.4028235E+38 † for positive values

n Integer - 4 bytes. -2,147,483,648 through 2,147,483,647 (signed)

n Long - 8 bytes. -9,223,372,036,854,775,808 through 9,223,372,036,854,775,807

(9.2...E+18 †) (signed)

n Short - 2 bytes. -32,768 through 32,767 (signed)

n Date - The user enters a date to describe the content.

n Yes or No - The user answers yesor no to describe the content. For example, if the con-

tent describesautomobile parts, the user could answer yes to include new and used parts or no

to search for new parts only.

n Select from a list - The user picks a from a list to describe the content.

For an illustration of this style on the Edit Content screen/Searchable Properties tab and theWeb

site search screen, see "Select from a List" on page 7-161.

n Multiple selections - The user selects an item from a dropdown list.

For an illustration of this style on the Edit Content screen/Searchable Properties tab and theWeb

site search screen, see "Multiple Selections" on page 7-162.

See Also: "Converting the Style of aMetadata Definition" on page 7-162

Default

If desired, enter themost common response to this definition.

The default value is automatically applied to all existing content within folders to which this

definition is assigned.

While editing content that uses this definition, a user can accept the default value or change it.

See Also: "Effect of a Default Value on RequiredMetadata" on page 7-167

Select from a List
Appearance on Edit Content Screen > Metadata Tab
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Multiple Selections
Appearance on Edit Content Screen > Metadata Tab

Converting the Style of a Metadata Definition

This section explains how Ektron CMS400.NET handles changing the style of a searchable

property type of metadata. For example, you create a definition to collect Part Number.

Originally, the style is text, but you later decide its style should be number.

When you change the style of searchable property type metadata, Ektron CMS400.NET

attempts to maintain any data stored in content blocks that use the definition. For example, if

the data style was number and you change it to text, the number stored for that metadata

definition is converted to text and maintained in all content that uses it.

However, sometimes Ektron CMS400.NET cannot maintain the data when you change the

style. For example, if you change a metadata definition style from number to date, Ektron

CMS400.NET cannot convert those styles. In this case, any data stored in metadata definitions

is lost.
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The following table illustrates all conversion scenarios and how Ektron CMS400.NET handles

each one. It indicates whether data is maintained after you convert from a data style in the left

column to a style to its right.

Text Number Date Boolean
Single

Select

Multiple

Select

Text - OK OK NO NO NO

Number OK - NO NO NO NO

Date OK NO - NO NO NO

Boolean OK NO NO - NO NO

Single
Select

OK NO NO NO - OK

Multiple

Select
OK NO NO NO NO -

Table legend

n OK - Data is maintained

n NO - Data is lost during conversion

When you change the style of a metadata definition, the screen often gives you these choices:

n Use existing data if possible, else default

n Use default value
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Following these choices is a field that lets you define a default value. If you want to simply

replace any existing data, select Use default value and enter the new value in the Default field.

If the data is convertible (according to the table above), and you want to maintain existing data

if possible, select Use existing data if possible, else default. Then, enter a default value below.

If the existing data cannot be maintained, the default value replaces it.

Viewing Metadata Definitions
You may view any metadata definition. To do so, follow these steps.

1. From the Workarea’s left frame, click Settings > Configuration > Metadata Definition.

2. The View Metadata Definitions screen appears.

3. Select a language from the drop-down list.

4. Click the Metadata definition you want to view.

5. The View Metadata Definition screen appears. From here, you can edit and delete this

definition.

See Also: "Metadata Definition Fields" on page 7-158

Editing a Metadata Definition

Note: You cannot edit the definition for the following Ektron standardmetadata.

MapLatitude,MapLogntitude,MapAddress, MapDate

To edit a metadata definition, follow these steps.

1. Access the View Metadata Definition screen whose definition you want to edit, as

described in "Viewing Metadata Definitions" on page 7-164.

2. Click the Edit button ( ).

3. The Edit Metadata Definition screen is displayed.

4. Make the necessary changes to the definition.

See Also: "Metadata Definition Fields" on page 7-158

5. Click the Update button ( ).

What Happens When a Metadata Definition is Edited?
If you create a metadata definition, assign it to a folder, then users insert metadata information

into their content, the collected information takes on the characteristics of the metadata

definition. For example, if the metadata is title and its type is HTML tag, this is how it

appears in the Web page’s source code.

<title>CMS Developer</title>
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If you later change its type to Meta, the following effects occur:

n metadata to which the definition has already been assigned maintains the previous style

definition. For example, <title>CMS Developer</title>.

n when you create a new content item that uses the metadata definition, its metadata takes

on the new style. For example, <meta name="title" content="CMS developer">.

Deleting a Metadata Definition
You can remove metadata definitions that are no longer used from the Ektron CMS400.NET

site. When you delete a definition, it is removed from every content item that uses it.

To delete a definition, follow these steps.

1. Access the View Metadata Definition screen for the definition, as described in "Viewing

Metadata Definitions" on page 7-164.

2. Click the Delete button ( ).

3. A confirmation message is displayed.

4. Click OK.

5. Another confirmation message is displayed.

6. Click OK.

Assigning Metadata to a Folder
After creating a metadata definition (see "Adding a Metadata Definition" on page 7-156),

assign it to folders whose content will use it.

On each folder’s properties screen, you determine which metadata definitions can be used.The

section of the folder properties screen used to assign metadata appears below. Only metadata

definitions whose Assigned box is checked can be completed by users working with content

in the folder.

Working with Metadata Definitions

ReferenceManual

Version 8.0 Rev 1.3
7-165



Then, while creating or updating content, the user can insert the metadata information via the

Metadata tab (illustrated below).

Requiring Users to Enter Metadata
You can determine that a metadata value must be inserted before content can be saved (see the

Required checkboxes in the illustration above). This occurs both when new content is added

and existing content is edited.

If you set a kind of metadata to be required, its label is red and includes an asterisk (*) on the

Metadata tab of the Edit Content screen, as shown below.

If the user does not complete a required metadata field, a message informs him that it must be

completed before he can save the content.
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Effect of a Default Value on Required Metadata
A default value can be defined when creating or editing a field within a metadata definition.

See Also: "Adding a Metadata Definition" on page 7-156

If a default value is defined for a required metadata field, the default value is used when the

user saves the content. In this case, the user is not prompted to enter a value because the

default value is sufficient.

Inheritance of Metadata by Folder

Each folder can inherit metadata fields from its parent folder or have a unique set of them. The

information includes the kinds of metadata that are assigned and which of those are required.

For example, you could assign the top folder (Content) all metadata definitions, while you

assign the Contacts folder (directly below it) none.

On every folder’s Metadata tab, use the Inherit Parent Configuration check box (illustrated

below) to determine if metadata definitions are the same as the parent folder or unique.

By default, Inherit Parent Configuration is checked, which means that all folders inherit

metadata definitions from the root folder (Content).

When you uncheck Inherit Parent Configuration, you can change the settings as desired. All

inherited values appear by default (that is, Assigned and Required boxes are either checked or

unchecked).

Adding Metadata to Content
When a user creates or updates content, he can define its metadata within the assignments

specified for its folder.

Default metadata values are applied without user intervention.
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To enter or edit content’s metadata, follow these steps.

Warning! Youmayonly edit metadata of content that is published, checked in, or checked out by you.

1. Access the Edit Content screen for the content whose metadata you want to enter or edit,

as described in "Editing HTML Content" on page 7-105.

2. Click the Metadata tab.

3. The Edit Metadata screen opens with the current metadata displayed. In order to add

metadata to content, an administrator must have created definitions for it in the language

of the content.

Note: Your system administrator determines the appearance of theMetadata screen.

4. Edit the metadata. Note that
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n Required field labels are red and marked with an asterisk (*). You must place at least one

response in such fields before you can save the metadata.

n Your system administrator may prevent you from editing a field. In this case, the field has

a gray background, and you cannot place the cursor there.

n Fields may appear in two columns. In this case, the system administrator provides a list of

terms that you can apply to the content. You can select terms from the list or enter free

text.

One column is labeled Not Included and the other Included. Move terms between lists by

clicking the Add and Remove buttons.

n You may see a list of terms in one box, and a field labeled Text above it.

With such a list, you can

- add a new term by typing it into the Text field and clicking

- remove any term by selecting it and clicking Remove

- modify any term by selecting it. It appears within the Text field, where you can

change it. Then, press the Edit button.

- restore the terms to their default settings by pressing the Default button

- change the sequence of terms by selecting one then pressing the up and down arrows (

)

n If related content metadata is available for the content, its name appears followed by None

Selected (ID) Change Clear.

Click Change to display a window of choices. For example, if the related content type is a col-

lection, all collections appear in the popup. Select the appropriate data for this content.

Selected items appear in the bottom of the screen. You can reorder them by selecting an item

then clicking the up and down arrows. To remove items from the bottom of the screen, select

them and click the delete ( ) button.
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If the related content type is either content item or library image, hyperlink, or file, the fol-

lowing window appears when you click Change.

Use this screen to identify the related content. To do this,

- Select a folder from the left frame

- Double click the related-content item from the top right frame

- The item appears in the lower right frame

- When all items are in the lower right frame, click the Save button ( ) directly below
Select Metadata

n If default metadata is defined for a specific data type, you can click the Default button at

the bottom of each field to restore it.

n Below each field is a Characters Left field, which counts the number of metadata

characters. You cannot exceed the maximum (500 characters).

5. Click the Save button ( ).
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6. The View Content screen reappears.

The content is now in a checked out state to you. For the changes to take effect on the Web

site, check in the content and submit it to the approval chain.

See Also: "Approval Chains" on page 5-28

Assigning a Metadata Image to
Content
You can assign an image to any content item’s metadata. It is a standard field automatically

available to every content item. It is not a definition in the Metadata fields.

Use the Image field to identify an image that can be retrieved by Ektron Markup Language’s

(EKML) [$Image] and [$ImageThumbnail] variables. See Also: "Ektron Markup Language" on

page 21-414.

An example of using Image data is a list summary that includes a photo of every item on the

list. For example, your site promotes a soccer team. The list summary shows every player on

the team. To the left of each player’s name is a thumbnail of his image.

MetaData Server Control
The Metadata server control lets you add the metadata from content blocks to a Web page.

This lets developers add metadata quickly without having to type it in. You can add metadata

from a single content block, multiple content blocks, or by dynamically passing a content ID

from a URL.

This subsection contains the following topics:

n "MetaData Server Control vs. MetaDataList Server Control" on page 7-172

n "MetaData Server Control Properties" on page 7-172

n "Using the Simple Dublin Core Metadata Standard" on page 7-173

n "Using the MetaData Server Control" on page 7-174
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MetaData Server Control vs. MetaDataList Server
Control
With the MetaData server control, you add metadata from content blocks to your Web page.

With the MetaDataList server control, you create a list of content blocks to display on your

site, based on the Metadata in each content block. For Information on the MetaDataList server

control, see "MetaDataList Server Control" on page 7-175.

MetaData Server Control Properties
The Metadata server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it

to browse to Content, Collections, etc. See Also: "Using CMS

Explorer to Browse Your Ektron CMS400.NET Site" on page

21-9

String

CacheInterval

Sets the amount of time the server control’s data is cached. The

default is 0 (zero). This is the amount of time, in seconds, a

control’s data is cached. For example, if you want to cache the

data for fiveminutes, set this property to 300 (three hundred).

See Also: "Caching with Server Controls" on page 21-31

Double

DefaultContentID

The content block ID fromwhich the server control gets the

metadata.

If you want to addmetadata from several content blocks, set this

property to 0 (zero) and use theDefaultItemList

property to identify the content blocks.

If you don’t know the ID number of the content block, use the

CMSExplorer to browse to it. See Also: "Using CMSExplorer to

Browse Your Ektron CMS400.NET Site" on page 21-9

Long

DefaultItemList

A bracket separated list of content block IDs fromwhich to get

metadata. The DefaultContentID propertymust be set to 0

(zero) to add IDs to the list.

You can also specifymetadata keys for each content block. To

String
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Property Value
Data

Type

assignmetadata keys to a content ID, add a semicolon after the

ID and add the name of the key. For example,

This allows you to select whichmetadata for each content block

is added to the page.

DynamicParameter
Gets or sets the QueryString parameter to read a content ID

dynamically.
String

GenerateDublinCore

When enabled, this property automatically creates seven of the

Simple Dublin Coremetadata fields from standard

CMS400.NET system properties. The default is false.

True =Generate Simple Dublin Coremetadata fields

False =Do not generate Simple Dublin Coremetadata fields

The seven fields and how theyare associated with the

CMS400.NET properties is explained in "Using the Simple

Dublin CoreMetadata Standard" on page 7-173

Boolean

Hide

Used to hide aMetadata server control in design time and run

time.

True =HideMetadata server control

False =ShowMetadata server control

boolean

Language

Set a language for viewing form content. This property shows

results in design-time (in VisualStudio) and at run-time (in a

browser).

Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control.

The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of

an HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to

a blockof code.

Custom - Allows you to use a custom tag.

String
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Using the Simple Dublin Core Metadata Standard
See Also: "Simple Dublin Core Metadata" on page 7-154.

To generate Dublin Core metadata, set the GenerateDublinCore property to True. This creates

seven of the fifteen Dublin Core metadata fields. These fields are automatically filled with the

information from the equivalent Ektron CMS400.NET property. Below is a list of the seven

fields that are created and their Ektron CMS400.NET equivalent property.

Warning! These seven Dublin Core fields are automatically populated with information from their equivalent

Ektron CMS400.NET property.

Dublin Core Field Name Ektron CMS400.NET Property

DC.title Content block title

DC.description
Plain text version of a content block teaser

(summary)

DC.contributor Content block last editor name

DC.date Content block last edit date

DC.format "text/html"

DC.identifier
URL of current page (from ASP.NET

Server.Request object)

DC.language

CMS language cookie / current site

language, expressed asa .NET

System.Globalization Culture Name

To fully comply with the Simple Dublin Core metadata element set, the administrator must

create the remaining eight Dublin Core fields as standard CMS400.NET Metadata fields and

apply them to all CMS400.NET folders. Next, the CMS users must fill in the appropriate values

for each content block.

For information on the remaining eight Simple Dublin Core fields, see "Simple Dublin Core

Metadata" on page 7-154.

Using the MetaData Server Control
These steps show how to use the MetaData server control.

1. Drag a MetaData server control into a template.
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2. Set the properties of the Metadata server control. This will create the following HTML in

the HTML body.
 <cms:MetaData id="MetaData1" runat="server"

DefaultContentID="12"></cms:MetaData>

Or if you are using multiple content block IDs In the DefaultItemList, the following

HTML will be created.

 <cms:metadata id="MetaData1" runat="server"

DefaultItemList="[12,7,4]"></cms:metadata>

3. Click on the HTML tab and copy that line from the <body> tag into the <head> tag.

4. Save the Web form and rebuild the solution.

5. Open the Web page in the browser.

6. Right click on the Web page and click View Source. Look in the head tag. The meta tags

from the content block are added to the page.

The metadata information added is shown below.
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MetaDataList Server Control
Use the MetaDataList server control to create lists based on Keyword Names and Keyword

Values contained within the metadata of content. In the example below, KeyWord names are

circled in red, and KeyWord values are circled in green.

The list can display the information as a list of hyperlinks. You can choose, based on

properties you set, to display the summary and how to order the display. For general

information Metadata, see "Working with Metadata" on page 7-146.

This subsection contains the following topics:

n "MetaData Server Control vs. MetaDataList Server Control" on page 7-172

n "MetaDataList Server Control Properties" on page 7-176

n "Retrieving the XML Structure of a MetadataList" on page 7-183

MetaDataList Server Control Properties
The MetaDataList server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.
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Property Value

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to browse to

Content, Collections, etc. See Also: "Using CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9

Data Type: String

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0

(zero). This is the amount of time, in seconds, a control’s data is cached. For

example, if you want to cache the data for fiveminutes, set this property to 300

(three hundred). See Also: "Caching with Server Controls" on page 21-31

Warning! If theEnablePaging property is set to True, theCacheIn-

terval property is disabled.

Data Type: Double

ContentType

Select a type of content for this control. Choicesare:

n All Types

n Content

n Forms

n Archive_Content

n Archive_Forms

n Assets

n Archive_Assets

n LibraryItem

n Multimedia

n Archive_Media

n NonLibraryContent

n DiscussionTopic

To learn about archived content, see "Setting Archive Options" on page 7-198.

Data Type: Ektron.Cms.Controls.CmsWebService.CMSContentType

DisplayXslt

Determineshow the information on the page is displayed

None-databind only

ecmNavigation - lists the title of every content block in the folder

See Also: "Example of ecmNavigation Display" on page 9-124

ecmTeaser - lists the title of every content block in the folder plus the content

summary.

See Also: "Example of ecmTeaser Display" on page 9-124

Path to Custom Xslt - Enter the path to an Xslt that determines the display of

the page

Data Type: String
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Property Value

Warning! If you specify an external file, it is strongly recommended that you do

not store this file in your site'sWorkarea folder. If you store this file in theWork-

area folder, the file will be lost when you upgrade.

Warning! If you enter a valid EkML file at theMarkupLanguage property,

theDisplayxslt property value is ignored.

EnablePaging

This property, in conjunction with theMaxNumber property, lets site visitors view

an unlimited number of content itemswhile controlling the amount of screen

space. To accomplish this, the content display is limited to the number set in the

MaxNumber property.

If you set this property to true, and the number of content itemsexceeds the

MaxNumber number, navigation aids appear below the last item. The site visitor

uses the aids to view additional items. See example below.

Data Type: String

So, for example, if specifiedmetadata is found in 9 itemsand the MaxResults

property is set to 3, the screen displaysonly the first three items.When the site

visitor clicks [Next], he sees items4, 5 and 6, etc.

Warning! If theEnablePaging property is set to True, theCacheIn-

terval property is disabled.

Data Type: Boolean
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Property Value

ExactPhrase

Determineswhether the KeyWordValue needs tomatch themetadata value

exactly.

For example, if “site” is the KeyWordValue, the title of a content block is

“Welcome to the site” and ExactPhrase is set to true, you would not see the

content block in themetadata list. This is because “site” doesnot equal “Welcome

to the site”.

True =Match the exact phrase

False =Doesn’t need tomatch exact phrase

Data Type: Booolean

FolderID

The folder ID fromwhich content is retrieved. At the Recursive property, you

determine if content in this folder’s subfolders is also retrieved.

Data Type: Long

GetHtml

Set to True if you want to display the content (html body) for all content to appear

on thismetadata list. For example, you want to display content inside aWeb

server control such asaGridView.

Data Type: Long

Hide

Used to hide ametadata list in design time and run time.

True =Hidemetadata list.

False =Showmetadata list.

Data Type: Boolean

IncludeIcons

Choose whether to display iconsnext to themetadata list’s links.

Warning! This property onlyworkswhen ecmSummaryor ecmTeaser are

used in theDisplayXslt property.When the[$ImageIcon] variable is

used in an EkML file and that file is assigned to theMarkupLanguage prop-

erty, this property acts asTrue.

Data Type: Boolean
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Property Value

KeyWordName

KeyWordName represents ametadata definition, that is, the container for the

KeyWordValues. Examplesof a KeyWordName areKeywords and Title.

To view an illustration of the relationship between KeyWordName and

KeyWordValues, see "MetaDataList Server Control" on page 7-175.

If you are authenticated, you can click the ellipsis button and select from a list of

existingmetadata definitions. See "Using CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9.

For information on creatingmetadata definitions, see "Working with Metadata

Definitions" on page 7-156.

Data Type: String

KeyWordValue

Enter the valuesassociated with the KeyWordName. Only content whose

metadata (defined at theKeyWordName property) matches this value appears

on themetadata list.

Examplesof a KeyWordValue are “home; page; company.” To view an

illustration of the relationship between KeyWordName and KeyWordValues, see

"" on page 7-175.

Note: The character that separatesmultiple items is defined at the

KeyWordValueSeparator property.

Note: At theKeyWordValueMatchAll property, you determine if all

metadata definition valuesmust match or anyone of them.

Data Type String

KeyWordValueMatchAll

This property is only used if you enter more than one keyword value.

If you do, and onlywant content to appear on themetadata list if all values

entered at the KeyWordValue field match itsmetadata values, enter true.

If metadata can appear on the list as long asany value defined at the

KeyWordValue field matches the selectedmetadata value for a content item,

enter false.

Example:

KeyWordValue for Title (assigned for this server control): home; page;

company.

Metadata values for a content item’sTitlemetadata definition field: software;

ektron; company.

IfKeyWordValueMatchAll = true, content doesnot appear on

metadata list because some itemsdo not match.

IfKeyWordValueMatchAll =false, content item appears onmetadata list

because one item (company) matches.

Data Type: Boolean

KeyWordValueSeparator

Enter the character used to separate the list of keyword values. An example is a

semicolon(;).

Data Type: String
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Property Value

Language

Set a language for viewing theMetaDataList. This property shows results in

design-time (in VisualStudio) and at run-time (in a browser).

Data Type: Integer

LinkTarget

Defines the waya link actswhen a link is clicked.

Choicesare:

_blank - This target causes the link to alwaysbe loaded in a new blankwindow.

Thiswindow is not named.

_self - This target causes the link to always load in the samewindow the anchor

was clicked in. This is useful for overriding a globally assigned BASE target.

_parent - This target makes the link load in the immediate frameset parent of the

document. This defaults to acting like “_self” if the document hasno parent.

_top - This target makes the link load in the full bodyof the window. This defaults

to acting like “_self” if the document is alreadyat the top. It is useful for breaking

out of an arbitrarily deep frame nesting.

Data Type: ItemLinkTargets

MarkupLanguage

Identify the templatemarkup file that controls the display of themetadata list. For

example, mymetadatalistmarkup.ekml.

If the *.ekml file is located in the same folder as theWeb form containing the

server control, just enter its name. If the file is in another folder, enter the path

relative to site root. For example,

\

siteroot

\workarea\customfiles\markup\mymetadatalist.ekml.

See Also: "EktronMarkup Language" on page 21-414 and "metadatalist.ekml"

on page 21-465

Note: If you enter a valid EkML file, theDisplayXslt property value is

ignored. If the EkML file contains the[$ImageIcon] variable, the

IncludeIcons property acts asTrue.

Data Type: String
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Property Value

MaxNumber

Enter themaximum number of items to appear in the initial display of this server

control.

To set nomaximum, enter zero (0).

To let site visitors view more than themaximum but limit the amount of space

being occupied, enter themaximum number of results per page here. Then, set

theEnablePaging property to true.

If you do andmore than the number ofMaxResults are available, navigation

aids appear below the last item to help the site visitor view additional items. See

example below.

Data Type: Integer

OrderBy

The order of the list to be returned.

n Title - The title of the content block

n ID - The content block ID number

n Date Created - The date the content blockwascreated

n Date Modified - The date the content blockwas last modified

n LastEditorLname - The last editor’s last name

n LastEditorFname - The last editor’s first name

Data Type: Ektron.Cms.Controls.CmsWebService.ContentOrderBy

Recursive

Whether to search sub-folders of the identified root folder. The starting folder is

identified in theFolderID property.

Data Type: Boolean

SortOrder
Choose the order direction of the list, Ascending or Descending.

Data Type: String

SuppressWrapperTags

This property is set tofalse because Ajaxuses<div> tags to rewrite the

region around the tag. You cannot change the value totrue.

Data Type: Boolean
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Property Value

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

Custom - Allows you to use a custom tag.

Data Type: String

Retrieving the XML Structure of a MetadataList
Retrieving the XML structure of XML content allows for greater control over developing

XSLs. The following is an example of how to retrieve the XML structure:

1. Open a new Web form.

2. Drag and drop a MetadataList server control onto it.

3. Set the KeyWordName and KeyWordValue properties.

4. Drag and drop a Textbox on the Web form.

5. Set the TextMode property to MultiLine.

Note: It is also recommended that you set the width of the text box to at least 400px.

6. On the code behind page, add the following line.
Textbox1.Text = Metadata1.XmlDoc.InnerXml

7. Build the project.

8. View the Web form in a browser.

9. The XML structure of the MetadataList appears in the textbox.

For an additional example, see the MetadatList XML page on the CMS400Developer samples

page. It is located at:

In a browser:

http://<site root>/CMS400Developer/Developer/MetaDataList/MetadataListXML.aspx

In the source code:

<site root>/CMS400Developer/Developer/MetaDataList/MetadataListXML.aspx and

MetadataListXML.aspx.vb
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Creating/Updating Templates
During the setup of your Ektron CMS400.NET Web site, templates are created for your Web

pages. A template typically includes page headers and footers as well as placeholders for

content, forms, summaries, calendars, collections, or other page elements.

A template included with Ektron’s sample site appears below. Notice that the top of the screen

contains headers that appear on several pages. Other areas contain links to Ektron

CMS400.NET objects, such as menus and text. The developer can easily modify the content

inside these areas.

Note: To learnmore about creating templates, see "Setting Up a Template" on page 21-4. Another good

resource is the Ektron technical article “Templating in CMS400.NET”

(http://dev.ektron.com/articles.aspx?id=6724).

Templates are more fully explained through the following topics.

n "How Templates are Used" on page 7-185

n "Declaring Templates" on page 7-185

n "Inheritance of Folder Templates" on page 7-187

n "Assigning Templates to Folders" on page 7-188

n "Assigning Templates to Content" on page 7-190
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How Templates are Used
Except for your Web site’s home page, all pages on your site are made accessible by

hyperlinks. Hyperlinks can appear within content. They are also used to link content items

from list summaries, menus, and collections.

The template is a key component of the hyperlink definition -- it defines the template in which

to display the content. As seen in the example below, when the user selects Email, that

content item (ID 87) will display within the contactinformation.aspx template.

Declaring Templates
After creating your templates, declare them within Ektron CMS400.NET. To do this, go to the

Active System Templates screen, available from Settings > Configuration > Template

Configuration.
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From this screen, you can add new templates, or delete or update existing ones.

Note: Onlymembersof the Administratorsgroup and usersdefined in theManageMembers for Role: Template

Configuration screen have permission to add, delete or update templates. See Also: "Defining Roles" on page 15-

32

See Also:

n "Creating/Updating Templates" on page 7-184

n "Adding a New Template" on page 7-186

n "Deleting a Template" on page 7-186

n "Updating a Template" on page 7-187

Adding a New Template
To add a new template, click the Add button ( ). The Add a New Template screen appears.

Enter the path to the new template and click the Save button ( ).

Deleting a Template
To delete a template, click Delete next to the template.
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You can only delete a template if it is not assigned as any folder’s default template. If you

choose a template that is assigned as a default, a screen tells you why you cannot delete it and

lists the folders for which it is the default.

If you delete a template that is not used as a default but is applied to content, that content’s

template is changed to its folder’s default template.

Updating a Template
Use the update command to change all references from an old to a new template. For example,

your old template is named MyTemplate.aspx. You can want to replace all references to it to

Updatetemplate.aspx.

To do this, follow these steps.

1. Click Update next to the template.

2. A new screen appears.

3. Enter Updatetemplate.aspx.

4. Click the Save button ( ).

Inheritance of Folder Templates
By default, all folders below the root folder inherit a template from their parent. However, you

can override the default and assign a unique set of templates to any folder. See Also:

"Creating/Updating Templates" on page 7-184

Before you can change a folder’s template assignment, you must break inheritance from the

parent folder. To do this, go to the Edit Folder Properties screen and uncheck the box next to

Inherit Parent Template Configuration (illustrated below). See Also: "Editing Folder

Properties" on page 5-17

Inheritance of Folder Templates

ReferenceManual

Version 8.0 Rev 1.3
7-187



Each folder must have at least one template. Also, one template must be chosen as the default.

If the folder’s default template is changed, all existing template assignments remain. However,

any new content added or moved into the folder will assume the new default template.

Assigning Templates to Folders
If you break template inheritance, all inherited templates are initially assigned to the folder.

You can then remove unwanted templates or add new ones.

All available templates appear in the template dropdown list (illustrated below). Select any that

you want to be available from the folder and click Add.
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7-188
ReferenceManual

Version 8.0 Rev 1.3



The list of available templates is managed through the ActIve System Templates screen. See

Also: "Declaring Templates" on page 7-185

Adding a Template to a Folder
To add a new template, click the Add button ( ). The Add a New Template screen appears.

Enter the path to the new template and click the Save button ( ).

Removing a Template from a Folder
n If you try to delete a template that is the default for a folder, you are notified that you

must assign a new default to that folder before you can delete it.
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n If you try to delete a template that is assigned to a content block, you are notified via the

following message If you wish to continue and delete this template, the above content

will be set to their parent folder's default template. Do you wish to continue?

Assigning Templates to Content
A folder’s default template is automatically applied to all content in the folder. However, you

can change a content item’s template to any of those assigned to the folder.

This relationship is illustrated below.

To change the template applied to a content item, edit that content, and go to the Templates

tab as shown above. Then, select a template to apply to the content.

As explained in "How Templates are Used" on page 7-185, the template assigned to the

content will be used whenever a hyperlink is created to it.
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Private Content
Private content is only available to CMS users or membership users with at least Read-Only

permissions for its folder. Those users must log in to work with the private content.

Unauthorized site visitors cannot see it.

Note: Allmembersof the Administratorsgroup have access to private content, even if theyare not granted

permission on the View Permission for Folder screen.

You can designate a folder to be private. In that case, all content in it and its subfolders is

private (if they inherit permissions). Alternatively, you can designate specific content items as

private.

To demonstrate private content, the following table shows how a user’s status affects the

display of content in three scenarios.

Scenario Private Content Web Page

Site visitor

Logged in user

with read-only

permission
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Scenario Private Content Web Page

Logged-in user

with edit

permissions

Note: You can determine the appearance of themenu shown above. See

"Changing the Appearance of theWeb Site Content Menu" on page 7-7.

Making a Folder Private

Note: You can only set content to private when inheritance is broken. See Also: "Inheritance" on page 5-44.

To make a folder private, follow these steps.

1. In the Workarea, navigate to the folder that you want to make private.

2. Click View > Properties.

3. Click the View Permissions button ( ).

4. If necessary, uncheck the box that says Allow this object to inherit permissions.

(Inheritance must be disabled before you can make the content private.)

5. Check the box that says The content in this folder is private and can only be viewed by

authorized users and members.

6. A confirmation message is displayed.

7. Click OK.

All content in the folder is now private. As new content is added, it is automatically set to

private.
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Making Content Private
To make any content private, follow these steps. See Also: "Making Assets Private" on page 7-

193

1. In the Workarea, navigate to the folder that contains the content you want to make

private.

2. Click the content item you want to make private.

3. Click the View Permissions button ( ).

4. If necessary, uncheck the box that says Allow this object to inherit permissions.

(Inheritance must be disabled before you can make the content private.)

5. Check the box that says This content is private and is NOT viewable on the public Web

site.

6. A confirmation message is displayed.

7. Click OK.

The content is now private.

Making Assets Private
If assets are set to private, they are handled like other private content with one important

exception: Unless you follow the procedure described below, anyone can access an asset by

typing the URL of the asset into the browser’s address field.

If a user attempts to access the asset in any other way (such as, linking to it from a Web page),

the regular methods of making content private work. See "Making a Folder Private" on page 7-

192 and "Making Content Private" on page 7-193.

To make assets private even if someone types their URL into the browser’s address field,

follow these steps.

Note: If site users receive a 404 PageNot Found Error when trying to view private assets, make sure you have

completed all step below.

1. Open your Web site’s web.config file, located in the site root folder.

2. Make sure the following line is uncommented.
<remove verb="GET,HEAD,POST" path="*"/>

3. Comment out the eight lines indicated below.
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<httpHandlers>

<remove verb="GET,HEAD,POST" path="*"/>

<add verb="HEAD,OPTIONS,PROPFIND,PUT,LOCK,UNLOCK,MOVE,COPY,GETLIB,PROPPATCH,

MKCOL,DELETE,(GETSOURCE),(HEADSOURCE),(POSTSOURCE)" path="*"

type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<!--<add verb="GET,POST" path="*.doc"

type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.docx"

type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.xls"

type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.xlsx"

type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.ppt"

type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.pptx"

type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.vsd"

type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.vsdx"

type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>-->

Eight add verb statements in the middle are commented out.

4. Make sure the following line is uncommented.
<add verb="GET,HEAD,POST" path="*"

type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

5. Save web.config.
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Scheduling Content to Begin and
End
Scheduling lets you control when a version of content becomes visible on the Web site.

Similarly, you can remove content on a predetermined date and time. When used together, a

start and end date can relieve you of much work by managing how long a version of content is

viewable on your Web site.

You can also set options for what happens to a content version upon reaching its end date.

How Does It Work?

When you create or modify content, you can select a “go-live” date and time. If you do, and

the content makes it through the approval chain, Ektron CMS400.NET publishes the content

to the live site at that time.

For example, your company is having a sale of the century in a month, and everything is ready

except the announcement. You decide to update your Web site to let the public know about

the sale. With this feature, you create the Web content now and set it to go live a week before

the sale.

The Ektron Windows Service manages these changes to your site. See Also: "Ektron Windows

Service" on page 19-13

This topic is explained through the following subtopics:

n "Setting a Start Date" on page 7-195

n "Setting an End Date on Content" on page 7-197

n "Setting Archive Options" on page 7-198

n "Viewing Archived Content" on page 7-200

Setting a Start Date
To set a start date, follow these steps.

1. Access the editor by adding new content or editing existing content.

2. If adding new content, enter a title and the content.

3. Click the Schedule tab.
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4. Click the calendar button next to the Start Date field.

5. A calendar pops up.

6. Select the date and time when this version of the content will become visible on the Web

site.

7. Click the Done button.
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8. The date and time appear in the Start Date field.

Note: When you select a time for content to go live, that time dependson the server’s system clock. If the clock is

incorrect, the content will not go live at the intended time.

What Happens After I Set a Start Date?

After you save the content, it appears on the Content Pending Start Date report, which helps

you keep track of content with a future start date. See Also: "Content Pending Start Date

Report" on page 7-716

After you set a go-live date and the content completes the approval chain, two scenarios may

occur:

n The content is new

n The content already exists, and you are publishing a new version

Each scenario is now explained.

Setting the Go-Live Date on New Content
When you set a go-live date on new content, it becomes viewable on the specified date and

time as long as it completes the approval chain. If a site visitor accesses the page that contains

the content before then, he sees only the template.

If a logged-in CMS user browses your Web site, he sees a grey border around the content until

the date specified. If he clicks within the grey border, he can use the Preview option to see the

new content.

Setting the Go-live Date on Existing Content
When you set a go-live date for changes to existing content, and it completes the approval

chain, a logged-in CMS user sees a grey border around the content until the date specified.

When you view content on the Web site, you see the previously published version. When the

go-live date occurs, the new content replaces the previous version, and its status changes to

Active.

Setting an End Date on Content
To set an end date for content, follow these steps.

1. Edit content. See "Editing HTML Content" on page 7-105.
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2. Click the Schedule tab.

3. Click the calendar icon next to the End Date field.

4. A calendar pops up.

5. Select the date and time you want the content to be removed from the Web site.

6. Click the Done button.

7. The date and time appear in the End Date field

Note: When you select a time for content to go live, that time dependson the server’s system clock. If the clock is

incorrect, the content will not be removed at the intended time.

What Happens After I Set an End Date?

You have three choices for what to do with content when it reaches its end date. These are

explained in "Setting Archive Options" on page 7-198.

If your choice means the content will not appear on the Web site, Ektron recommends having

another content item ready to replace it. If not, and a site visitor visits the page containing the

content, he sees the template without the content.

Appearance on Content Reports

After content reaches its end date, it appears on the Expired Content report, which helps you

track expired content. See Also: "Content to Expire Report" on page 7-719

The report lists all content whose end date will occur within a number of days that you

specify.

Setting Archive Options
Use content’s archive options to determine what happens upon reaching its end date/time. To

be eligible for any option, the content must reach its end date/time, progress through its

approval chain, and be published. Until those events occur, the content remains visible both

within its content folder and on the site.

The archive options (illustrated below) appear below the Start Date and End Date fields on

the content’s Schedule screen.
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Each option is explained below.

Archive Options

Option
Can site visitors

view content upon expiration?

Can users view and edit

content within Ektron

CMS400.NET upon

expiration?

Archive

and

remove

from site

(expire)

No

Yes, within its folder by clicking the

View > Archive Content option.

Archived content can be found via

theWorkarea Advanced search (if

theArchived checkbox is

checked).

Archive

and

remain on

Site

n Content appears in a List Summary if the List-

Summary control’scontentypeproperty is set to

Archive_Content.

n If content is an HTML form, the response page

option appears. For example, if the form displaysames-

sage after the user completes it, that message appears.

n Content is found by the search (Workarea and

site)

n Content is visible within its taxonomydisplay

n Content is visible if site visitor enters exact path,

such ashttp://localhost/CMS400Developer

/dynamic.aspx?id=1014&__taxonomyid=14

Yes, within its folder by clicking the

View > Archive Content option.

Also, can be found via BasicSearch

and Advanced search (if the

Archived checkbox is checked).

Add to

CMS

Refresh

Report

Yes

Yes, in the active area of its folder

and on the Refresh Report.

See Also: "Refresh Reminder

Report" on page 7-717
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Restoring Content from Archived to Active State

To restore content from archived state to active, follow these steps.

1. Navigate to its folder.

2. Click View > Archived Content. (See "Setting Archive Options" on page 7-198).

3. Hover the cursor over the content, click the triangle ( ), and select Edit from the
dropdown menu.

4. The Edit Content in Folder screen appears.

5. Click the Schedule tab.

6. Remove the End Date or change it to a future date.

7. Submit the content for publishing. When the content is published, it will no longer be

archived.

Viewing Archived Content
The Archived content folder shows content in the selected folder whose end date has passed

and which meets all other archiving criteria. These are explained in "Setting Archive Options"

on page 7-198.

This content cannot appear on your Web site, although there are ways to reactivate it.

To return to the regular folder view, click View > Content.

See Also:

n "Deleting Several Content Items in a Folder" on page 7-131

n Accessing the Search Content Folder Screen
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Displaying Content on your Web
Site

Two Ektron CMS400.NET server controls are available to display HTML content on your

Web site.

Server

Control
Displays More Information

ContentBlock One content block
"ContentBlockServer Control" on page

7-201

ContentList
A comma-delimited list of content

blocks

"ContentList Server Control" on page

7-210

ContentBlock Server Control
The ContentBlock server control displays a content block on an Ektron CMS400.NET Web

page.

Ektron CMS400.NET has two types of content blocks:

n Static - displays one specified content block

n Dynamic - displays the content block of the ID passed through a URL parameter

In addition, a content block can contain XHTML or XML content.

For an example of using the ContentBlock server control programmatically, see "Using the

ContentBlock Server Control Programmatically" on page 7-208

This section contains the following topics:

n "Static Content Block" on page 7-202

n "ContentBlock Server Control Properties" on page 7-202

n "Dynamic Content Block" on page 7-203

n "XML Content Block" on page 7-205

n "The OverrideXslt and DisplayXslt Properties" on page 7-207

n "Using the ContentBlock Server Control Programmatically" on page 7-208
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Static Content Block
A static content block displays one identified content block on a Web page. The following

table explains how to complete the server control properties to insert a static content block on

a Web page.

ContentBlock Server Control Properties
The following table explains the properties of the ContentBlock server control.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to

browse to Content, Collections, etc. See Also: "Using CMSExplorer to

Browse Your Ektron CMS400.NET Site" on page 21-9

String

CacheInterval

Sets the amount of time the server control’s data is cached. The default

is 0 (zero). This is the amount of time, in seconds, a control’s data is

cached. For example, if you want to cache the data for fiveminutes, set

this property to 300 (three hundred). See Also: "Caching with Server

Controls" on page 21-31.

Double

DefaultContentID

The ID of a content block that appearswhere you insert this server

control.

If you don’t know the ID number of the content block, use the CMS

Explorer to browse to it. See Also: "Using CMSExplorer to Browse

Your Ektron CMS400.NET Site" on page 21-9

Note: If you identify a content block that displaysanOffice document

which will be published asHTML,make sure the template sets<span>

tags to display the content asa block.

Long

DisplayXslt Ignore for a non-XML content block. String

DynamicParameter
SelectNone - Use Default. This parameter is used for dynamic

content blocks.
String

Hide

Used to hide a content block in design time and run time.

True =Hide content block

False =Show content block

Boolean

Content
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Property Value
Data

Type

Language
Set a language for viewing content. This property shows results in

design-time (in VisualStudio) and at run-time (in a browser).
Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The

default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Warning! - If you want to let content authors edit this content using

Ektron CMS400.NET’sEdit in Context feature, thismust be set to

false.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a block

of code.

Custom - Allows you to use a custom tag.

String

In the above example, the server control retrieves content block id=28 and displays it in the

browser.

Dynamic Content Block
Use a dynamic content block to display a content block whose ID is passed through a URL

parameter. You would use this server control with a dynamic template.
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The following table explains how to complete the ContentBlock server control’s properties to

insert a dynamic content block on a template.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to

browse to Content, Collections, etc. See Also: "Using CMSExplorer to

Browse Your Ektron CMS400.NET Site" on page 21-9

String

DefaultContentID

The ID of a content block that appearswhere you inserted this server

control if no other content block is identified, or is not available.

If you don’t know the ID number of the content block, use the CMS

Explorer to browse to it. See Also: "Using CMSExplorer to Browse

Your Ektron CMS400.NET Site" on page 21-9

Long

DisplayXslt Ignore for a non-XML content block. String

DynamicParameter
Select id. When you do, this server control uses the content block

passed asa URL parameter.
String

Hide

Used to hide a content block in design time and run time.

True =Hide content block

False =Show content block

Boolean

Language
Set a language for viewing content. This property shows results in

design-time (in VisualStudio) and at run-time (in a browser).
Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The

default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Warning! - If you want to let content authors edit this content using

Ektron CMS400.NET’sEdit in Context feature, thismust be set to

false.

Boolean
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Property Value
Data

Type

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a block

of code.

Custom - Allows you to use a custom tag.

String

The following example shows how the ContentBlock server control can be used to pass the id

as a URL parameter.

When a user clicks a link that passes the content block ID as a URL parameter, that content

block appears. If that content block is not available, content block 1 appears.

XML Content Block
Use an XML content block to display an XML content block on an Ektron CMS400.NET

Web page.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to

browse to Content, Collections, etc. See Also: "Using CMSExplorer

to Browse Your Ektron CMS400.NET Site" on page 21-9

String

XMLContent Block

ReferenceManual

Version 8.0 Rev 1.3
7-205



Property Value
Data

Type

CacheInterval

Sets the amount of time, in seconds, a server control’s data is cached.

The default is 0 (zero).

For example, if you want to cache the data for fiveminutes, set this

property to 300. See Also: "Caching with Server Controls" on page

21-31

Double

DefaultContentID

The ID of a content block that appearswhere you inserted this server

control if no other content block is identified, or is not available.

If you don’t know the ID number of the content block, use the CMS

Explorer to browse to it. See Also: "Using CMSExplorer to Browse

Your Ektron CMS400.NET Site" on page 21-9

Long

DisplayXslt

Specify an externalXSLT file. See Also: "TheOverrideXslt and

DisplayXslt Properties" on page 7-207

Warning! If you specify an external file, it is strongly recommended

that you do not store this file in your site'sWorkarea folder. If you

store this file in theWorkarea folder, the file will be lost when you

upgrade.

String

DynamicParameter
Tomake this content blockdynamic, select id. When you do, this

server control uses the content blockpassed asa URL parameter.
String

Hide

Used to hide a content block in design time and run time.

True =Hide content block

False =Show content block

Boolean

Language
Set a language for viewing content. This property shows results in

design-time (in VisualStudio) and at run-time (in a browser).
Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The

default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a

blockof code.

Custom - Allows you to use a custom tag.

String
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The OverrideXslt and DisplayXslt Properties
The DisplayXslt property is optional. If used, it specifies an external XSLT file. If the

DisplayXslt property is not defined, the OverrideXslt property specifies an XSLT identified in

the Edit Smart Form Configuration screen. The following table provides more information

about these properties.

To use this display XSLT
Enter this value for

XSLT

Enter this

value for

Override XSLT

The default XSLT specified in the Edit Smart Form

Configuration screen (illustrated below). Note that, in this

example, the XSLT Packaged option is the default XSLT,

since it is selected.

XSLT Packaged is the XSLT from the Edit Smart Form

Configuration screen (that is, the XSLT created in the

Data Designer).

Default

XSLT 1 from the Edit Smart FormConfiguration screen 1

XSLT 2 from the Edit Smart FormConfiguration screen 2

XSLT 3 from the Edit Smart FormConfiguration screen 3
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To use this display XSLT
Enter this value for

XSLT

Enter this

value for

Override XSLT

An absolute or relative path to an XSLT file.

An externalXSLT file

not specified in the Edit

Smart Form

Configuration screen.

For example

sample.xslt

doesnot matter - if

XSLT value exists,

OverrideXSLT is

ignored

See Also: "Working with Smart Forms" on page 7-288l

Retrieving the XML Structure of an XML Content
Block
Retrieving the XML structure of XML content allows for greater control over developing

XSLs. The following is an example of how to retrieve the XML structure:

1. Open a new Web form.

2. Drag and drop a Content Block server control onto it.

3. Set the DefaultContentID to an XML content block.

Warning! This doesnot workwith HTML content blocks, as there is no XML structure to output.

4. Drag and drop a Text box on the Web form.

5. Set the TextMode property to MultiLine.

Note: It is also recommended that you set the width of the text box to at least 400px.

6. On the code behind page, add the following line.
TextBox1.Text = ContentBlock1.EkItem.Html

7. Build the project.

8. View the form in a browser.

9. The XML structure of the content block appears in the text box.

Using the ContentBlock Server
Control Programmatically
The following code will display a content block:
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Note: Before adding these linesof code, you need to drag and drop a literal boxon your Web form.

Dim MyContentBlock As New ContentBlock
MyContentBlock.DefaultContentID = 8
MyContentBlock.Page = Page
MyContentBlock.Fill()
Literal1.Text = MyContentBlock.EkItem.Html

To display a content block with the content block title, do the following:

Note: Before adding these linesof code, you need to drag and drop a two literal boxeson your Web form.

Dim MyContentBlock As New ContentBlock
MyContentBlock.DefaultContentID = 8
MyContentBlock.Page = Page
MyContentBlock.Fill()
Literal1.Text = MyContentBlock.EkItem.Title
Literal2.Text = MyContentBlock.EkItem.Html

Retrieving the XML Structure of a
ContentList
Retrieving the XML structure of XML content allows for greater control over developing

XSLs. The following is an example of how to retrieve the XML structure:

1. Open a new Web form.

2. Drag and drop a ContentList server control onto it.

3. Add at least one content ID to the ContentID property.

4. Drag and drop a Textbox on the Web form.

5. Set the TextMode property to MultiLine.

Note: It is also recommended that you set the width of the text box to at least 400px.

6. On the code behind page, add the following line.
Textbox1.Text = ContentList1.XmlDoc.InnerXml

7. Build the project.

8. View the Web form in a browser.

The XML structure of the ContentList appears in the textbox.

For an additional example, see the ContentList XML page on the CMS400Developer samples

page. It is located at:

In a browser:

http://<site root>/CMS400Developer/Developer/ContentList/ContentListXML.aspx
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In the source code:

<site root>/CMS400Developer/Developer/ContentList/ContentListXML.aspx and

ContentListXML.aspx.vb

ContentList Server Control
The ContentList server control is used to display a list of content blocks on a Web page. In

contrast to a List Summary, where content must be in a specified folder, the ContentList server

control uses content from any CMS400.NET folder.

When added to a template and visited, a ContentList Summary looks like this.

Depending on the setting you choose for DisplayXslt, you can change the amount of

information displayed for each content block. See Also: "DisplayXslt" on page 7-212.

There are two options for the ContentList server control to display a content list. First, by

defining a content list in the metadata of a content block and using that content block’s ID in

the DefaultContentID property. See Also: "Using Metadata to Display an Associated Content

List" on page 7-215.

Second, by adding a comma delimited list of content blocks to ContentIds property. See Also:

"Using the ContentID Property to Display a Content List" on page 7-218.

Using the DefaultContentID and MetaTag process, an administrator typically sets up the

Workarea portion of the process. Then a developer adds the server control to a Web form,

assigns the ID of the content block and the metadata name to the appropriate properties.

Because the content list in this process is assigned to a content’s metadata, you can pass the

content ID dynamically in a Web form and display a list for each content block you have

defined.

Using the ContentIds process, a developer adds ContentList server control to Web form. Then,

defines a list of content IDs in the ContentIds property. Once the server control is deleted or

the list in the ContentIds property is deleted, It is not available and will have to be created

again.

This subsection contains the following topics:

n "ContentList Server Control Properties" on page 7-211

n "Using Metadata to Display an Associated Content List" on page 7-215
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n "Using the ContentID Property to Display a Content List" on page 7-218

n "Retrieving the XML Structure of a ContentList" on page 7-209

ContentList Server Control Properties
The ContentList server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer. See

Also:

"Using CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9

String

CacheInterval

Sets the amount of time the server control’s data is

cached.

The default is 0 (zero). This is the amount of time, in

seconds, a control’s data is cached. For example, if you

want to cache the data for fiveminutes, set this property

to 300 (three hundred). See Also: "Caching with Server

Controls" on page 21-31

Double

ContentIds

A comma delimited list of content block IDs.

See Also:

"Using the ContentID Property to Display a Content

List" on page 7-218

String

DefaultContentID

Set content ID value. Once set, content IDsare

generated from theMetaTag value for this content.

See Also:

"MetaTag" on page 7-214

"UsingMetadata to Display an Associated Content List"

on page 7-215

Long
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Property Description Data Type

DisplayXslt

Determineshow information on the page is displayed.

None - databind only

ecmNavigation - lists the title of each content block

See Also: "Example of ecmNavigation Display" on page

9-124

ecmTeaser - lists the title of each content blockplus the

content summary

See Also: "Example of ecmTeaser Display" on page 9-

124

ecmUnOrderedList - sorts the list in no particular

order. Shows the title and content summary

Path to Custom Xslt - Enter the path to an XSLT that

determines the display of the page

Warning! If you specify an external file, it is strongly

recommended that you do not store this file in your

site'sWorkarea folder. If you store this file in theWork-

area folder, the file will be lost when you upgrade.

Warning! If you enter a valid EkML file at the Mark-

upLanguageproperty, the Displayxsltproperty

value is ignored.

String

DynamicParameter

Uses theQueryString parameter to read a content ID

dynamically.

None - Use Default - use the default content ID list.

ID - readsa content block’s ID dynamically.

ekfrm - readsa form block’s ID dynamically.

String

GetHtml

Set to True if you want to retrieve and display content

(html body) for all content blocks in the list summary.

For example, to display content inside a web server

control such asaGridView.

True =Get and displayHTML for each content block in

the list summary

False =Do not get and displayHTML.

Boolean

Hide

Used to hide output of the content list in design time and

run time.

True =Hide results

False = show results

Boolean
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Property Description Data Type

IncludeIcons

Choose whether to display iconsnext to the content

list’s links.

Warning! This property onlyworkswhen ecmSum-

maryor ecmTeaser are used in the DisplayXslt

property.When the [$ImageIcon] variable is used in

an EkML file and that file is assigned to the Mark-

upLanguageproperty, this property acts asTrue.

Boolean

Language

Set a language for viewing the list summary. This

property shows results in design-time (in VisualStudio)

and at run-time (in a browser).

Integer

LinkTarget

Defines the waya link actswhen a link is clicked.

_blank - This target causes the link to alwaysbe loaded

in a new blankwindow. Thiswindow is not named.

_self - This target causes the link to always load in the

samewindow the anchor was clicked in. This is useful

for overriding a globally assigned base target.

_parent - This target makes the link load in the

immediate frameset parent of the document. This

defaults to acting like “_self” if the document hasno

parent.

_top - This target makes the link load in the full bodyof

the window. This defaults to acting like “_self” if the

document is alreadyat the top. It is useful for breaking

out of an arbitrarily deep frame nesting.

ItemLinkTargets
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Property Description Data Type

MarkupLanguage

Identify the templatemarkup file that controls the

display of the content list. For example,

mycontentlistmarkup.ekml.

If the *.ekml file is located in the same folder as theWeb

form containing the server control, just enter its name. If

the file is in another folder, enter the path relative to site

root. For example, ..\workarea\customfiles

\markup\mycontentlistmarkup.ekml.

See Also: "EktronMarkup Language" on page 21-414

and "contentlist.ekml" on page 21-444

Note: If you enter a valid EkML file, the DisplayXslt

property value is ignored. If the EkML file contains the

[$ImageIcon] variable, the IncludeIconsproperty

acts asTrue.

String

MetaTag

Specify aMetadata definition whose type isContent

Selector.When you do, the associated list of content

itemswill appear where you place the server control.

Warning! You cannot insert other metadata types.

Thisworkswith the DefaultContentIDproperty.

See Also:

"DefaultContentID" on page 7-211

"UsingMetadata to Display an Associated Content List"

on page 7-215

For more information about usingmetadata to assign a

list of related content to a content item, see "Related

Content Metadata" on page 7-151.

String

OrderByDirection

Determineshow to order content in the list.

The sort field is determined by the OrderKeyproperty.

ascending - itemsare arranged A, B, C or 1,2,3.

descending - itemsare arranged. Z,Y,X or 3,2,1.

If sorting bydate, descending puts themost recent first.

When ascending is selected

and the Orderkeyproperty

is set to OrderOfTheIds, the order

of the IDsare preserved.When set to descending,

the order is reversed.

Datatype:

Ektron.Cms.Controls.CmsWebService.

ContentListOrderByDirection
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Property Description Data Type

OrderKey

Sort the list by one of these values:

Title - the order of the content’s title.

DateModified - the last date the content wasmodified.

DateCreated - the date the content was created.

LastEditorFname - the last editor’s first name.

LastEditorLname - the last editor’s last name.

OrderOfTheIds - preserves the content

ID order based on the list in the ContentIdsproperty.

Datatype:

Ektron.Cms.Controls.CmsWebservices.

ContentListOrderBy

(must be one of the values)

Random

Set to True if you want to randomly display one content

block link from the content list. The content changes

each time a user views the page.

True - randomly display one content block in

the specified folder.

False - display the content list normally.

Note: If you use a customXSLT or EkML file, the type of

content displayed can bemanipulated. For example, if

you use an EkML file that has the [$Html] variable in it,

the actual content is displayed instead of a link. See

Also: "EktronMarkup Language" on page 21-414 and

"[$Html]" on page 21-429

Boolean

SuppressWrapperTags

This property is set to false because Ajaxuses<div>

tags to rewrite the region around the tag. You cannot

change the value to true.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline

portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply

attributes to a blockof code.

Custom - Allows you to use a custom tag.

String

Using Metadata to Display an Associated Content List
You can use the ContentList server control to display a list of content associated with a given

content item. First, you define a content list in the metadata of a content block. Then, assign

the ID of the content block to the ContentID property and specify a Metadata definition in the
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MetaTag property. The ContentList server control pulls information defined in the metadata of

the content to display the list of content.

The steps below show an example of using the DefaultContentID and MetaTag properties to

create a content list.

1. In the CMS400.NET Workarea, create a metadata definition, in the Name field, enter a

title of the data. This name is used in the MetaTag property for the server control.

2. Fill in all standard fields. See Also: "Metadata Definition Fields" on page 7-158

The Type must be Content Selector.

3. Add the definition to all appropriate folders. See Also: "Assigning Metadata to a Folder" on

page 7-165

4. For each content item to which you want to associate related content, access itsMetadata

tab and identify the related item(s).

For example, a list of content blocks associated with motorcycle helmets. You want this

list to appear whenever a helmet is being viewed.

To set this up, you would

- edit the content block

- click its Metadata tab

- find the metadata definition for the Content List

- click the Edit Button
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- select the content blocks to be in the list

5. On a Web form in Visual Studio, add the ContentList server control.

6. Set the DefaultContentID property to the content block’s ID.

7. Add the name of the Metadata field in the Workarea to the MetaTag property.
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8. Set all other properties using the table in "ContentList Server Control Properties" on page

7-211.

9. Once the Web form is saved, navigate to the page and the content list is displayed.

Using the ContentID Property to Display a Content
List
1. On a Web form in Visual Studio, add the ContentList server control.

2. Add a comma delimited list of content IDs to the ContentIds property.

Content

7-218
ReferenceManual

Version 8.0 Rev 1.3



3. Set all other properties using the table in "ContentList Server Control Properties" on page

7-211.

4. Once the Web form is saved, navigate to the page and the content list is displayed.
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Working with HTML Forms

Note: This section explainshow to create/edit HTML formsusing eWebEdit400. If your editor is

eWebEditPro+XML, see http://www.ektron.com/manuals/CMS400/v76/usermanual.pdf >”Working with HTML

Forms.”

Ektron CMS400.NET provides powerful online form capabilities, allowing you to create an

online dialog with visitors. Now anyone in your organization – not just a developer or

Webmaster– can create and deploy Web forms to capture visitor information. Support

marketing strategies by getting feedback on their needs. Follow up on their interest in your

products and services. Register people for events.

Form capabilities include

n Creating a form and its postback message

n Creating polls and surveys

n Adding validation criteria to form fields

n Automatically assigning tasks for follow-up activities to form submissions

n Reporting on form information

n Exporting results to Microsoft Excel

A sample form appears below. Toolbar buttons for working with forms are circled.

This chapter explains how to perform all form actions through the following topics.

n "Overview of Form Processing" on page 7-221

n "The Structure of Form Data" on page 7-222

n "Creating a New Form" on page 7-222

n "Creating a Form’s Content" on page 7-228

n "Form Validation" on page 7-232

n "Form Fields" on page 7-233

n "Implementing a Form on a Web Page" on page 7-253

n "Assigning a Task to a Form" on page 7-260

Content

7-220
ReferenceManual

Version 8.0 Rev 1.3

http://www.ektron.com/manuals/cms400/v76/usermanual.pdf


n "Viewing Form Information" on page 7-268

n "Editing a Form" on page 7-272

n "Deleting a Form" on page 7-274

n "Creating Polls and Surveys" on page 7-274

n "FormBlock Server Control" on page 7-281

n "Poll Server Control" on page 7-284

Overview of Form Processing

Step Formore information, see

1. Create a form "Creating a New Form" on page 7-222

2. Assign it to aWeb page
"Implementing a Form on aWeb Page" on

page 7-253

3. Site visitor goes to your Web site and

completes form. Form ismailed to an email

address, saved to a database, or both.

4. View submitted form data and download it to

a spreadsheet.
"Viewing FormReports" on page 7-262

Form Permissions

Folder Permissions

By default, form permissions are inherited from a form’s folder. To customize permissions for

any folder that contains forms, access the corresponding folder under Content and assign

permission as described in "Setting Permissions for a Content Folder" on page 5-47.
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Administrator Permissions

Similar to content, users in the administrator user group have full control over form features.

You must be a member of the administrator group to:

n Add a form

n Edit a form

n Delete a form

n Assign content to a form

You may also perform all actions on a form’s content.

User Permissions

Users who are not members of the administrator user group can add, edit, delete, and restore

form content if granted these permissions for the content folder or item.

The Structure of Form Data
A form has the following components.

n Form (title, ID number, whether the form data is sent as email, and/or saved to a database,

etc.)

n Content information (title, start and/or end date, status, postback message, etc.)

n Form fields (text field, password field, text area, hidden text, choices, checkbox, select list,

calendar, submit button, etc.)

Creating a New Form
The screen you use to create a form follows five simple steps. After completing the steps, you

have a new form that’s ready to collect the information you need. To make the task easier,

Ektron CMS400.NET provides sample forms that you can start with then customize.
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As explained in "Mailto or Database Form" on page 7-273, form data can be emailed and/or

saved to a database. Forms created using the procedure described below are saved to a database

by default, but not emailed. To change either setting, use the Edit Properties screen. See

"Editing a Form’s Properties" on page 7-273.

To create a new form, follow these steps.

Note: You can also create a new edition of a form in another language by copying an existing form and translating

it. For more information, see "Translating Content to Another Language" on page 7-112.

Note: For the steps to create a new poll, see "WorkingWith Polls" on page 7-275. For the steps to create a new

survey, see "Creating a Survey" on page 7-279.

1. Consult with your Ektron CMS400.NET administrator about the folders in which you

should create forms. See Also: "Forms Must Use Template with FormBlock Server

Control" on page 7-281

2. From the View menu, click Language, and select the language in which to create the

form.

3. Click the New menu > HTML Form/Survey.

4. The New Form screen appears.

Note: When you choose Standard Poll or BlankSurvey, the number of steps in the FormsWizard changes from

five to four. This happensbecause the Assign Tasks step is removed. See Also: "WorkingWith Polls" on page 7-

275 and "Creating a Survey" on page 7-279.

5. Choose the form that you want to begin with. You can click the preview icon ( ) next
to any sample form to see it before choosing it.

Select a sample that most closely matches the form you want to create. After you create it,

you can add fields, remove fields, modify possible responses, etc.

6. Click Next.

7. Enter or edit the form’s Title and Description.
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n Title - used to reference the form within the Workarea (required)

n Description - an extended description of the form

8. The next screen lets you assign a task to a user or user group. If you do, a task will be

created every time a site visitor submits this form. See Also: "Assigning a Task to a Form"

on page 7-260

9. A new screen lets you determine what happens after the site visitor completes the form.

The choices are:

n Display a message - See "Composing the Postback Message" on page 7-224

Warning! If your form/survey/poll useseither Redirect option, your Web developer must use a FormBlock server

control to display this form on aWeb page. He cannot use a Poll Server Controlwhen redirecting to an action page.

n Redirect to a file or page - Identify a file or a page on your Web site that is

launched when the visitor completes the form.

- An example of a file is a white paper (a common file format is .PDF) that a

visitor requested

- An example of a page is one that prompts the visitor to download your

product

n Redirect to form data to an action page - See "Redirect to an Action Page and

Forward Form Data" on page 7-226

n Report on the form - See "Making Form Results Available to Site Users" on page 7-

227

10. Now that you have completed information about the form, you can enter the form’s

content. This procedure is described in "Creating a Form’s Content" on page 7-228.

Composing the Postback Message

The postback message can contain text or graphics, just like any other HTML content.

Typically, it acknowledges a site visitor’s completion of the form.

For most sample forms provided, sample text appears in the editor. Modify it as you wish,

using Ektron CMS400.NET’s editor to change the style sheet class, insert library items, etc.

Inserting Fields into the Postback Message
You can also insert fields into the Postback Message that retrieve form information.For

example, your postback message may be

Thank you «Full Name» for completing the «[Form Title]».

When the postback message appears, it looks like this.

Thank you Jay Kohler for completing the breakroom survey.
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When you click the Post back message tab and select Display a message, the Merge Field

button ( ) appears on the toolbar.

When you click that button, a dialog like the one below appears.

All form fields appear on the list. In addition, the list includes the following fields, which can

retrieve form information into the postback message.

n Form title

n Form description

n Date submitted
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Redirect to an Action Page and Forward Form Data

"Redirecting Submitted Form Data" on page 7-258 explains how your administrator sets up the

action page. After your administrator follows that procedure, he identifies a folder and

hyperlink that you use to select an action page.

Warning! Youmust have the folder and hyperlink name from your administrator to complete this procedure.

To redirect submitted form data to an action page, follow these steps.

1. Go to the page on which you determine the form’s response. If this is a new form, it is

page 3 of the Forms Wizard.

To modify an existing form, select the form’s folder, then the form. Next, select Edit and

click the Post back message tab.

2. Select Redirect form data to an action page.

3. Click the icon next to File or page.

4. The Hyperlink Manager dialog appears. Click the URL button.

5. The library appears. In the left panel, select the folder that contains the hyperlink.

6. In the right panel, select Hyperlinks from the file type dropdown.

7. Select the hyperlink whose name was given to you by your system administrator.

8. Click the insert button ( ).
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Making Form Results Available to Site Users
When you create polls and surveys, you can choose to display the results after a site visitors

completes the form. The results can display in the same window or a new window. In addition,

you can choose how to chart the data. For a description of chart types, see "Chart Types" on

page 7-227.

To show site visitors poll/survey results, follow these steps.

1. Go to the page on which you determine the form’s response. If this is a new form, it is

page 4 of the Forms Wizard.

To modify an existing form, select the form’s folder, then the form. Next, select Edit and

click the Post Back Message tab.

2. Select Report on the form.

3. Choose whether you want the results to appear in the Same Window or a New Window.

4. Choose the style of the report.

Chart Types

The following table describes the types of charts available.
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Chart

Type
Description Sample

Data Table
The poll or surveyanswers are displayed with the

percentage of userswho responded to each item.

Bar Chart

The poll or surveyanswers are displayed with a bar

graph. Use this chart type when you want a quick visual

representation of the responses.

Pie Chart

Displaysa standard pie chart. Poll or surveyanswers are

color coded, and the percentage of people who chose

each answer is shown.

Combined Combines the Data Table and the Bar Chart.

Warning! You cannot chart data entered into a text box. For example, if one choice in a poll isOther, and the sur-

veyhasa text box for site users to enter additional information, the text in the box is not charted. However, the fact

that a user choseOther is charted.

See Also: "The Structure of Form Data" on page 7-222

Creating a Form’s Content
Here is an example of form content that you can create.
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Note that some fields are required, and some provide a dropdown list of choices. You can learn

how to create such a form by following the directions below.

The following topics explain how to create a form.

n "The Form Toolbar Options" on page 7-229

n "Form Validation" on page 7-232

The Form Toolbar Options
Creating form content is similar to creating standard content. (See "Adding HTML Content" on

page 7-15). The big difference is a form toolbar (illustrated below), which lets you insert form

elements.

When using the form toolbar, place the cursor where you want field. Then, click the

appropriate toolbar button.
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Adding a Field to the Screen
The final screen of the Forms setup lets you arrange a form that collects exactly the information

you want. To create the form, insert fields that prompt a site visitor to enter information. Then,

add a button that enables the user to submit data.

If you chose a sample form at the beginning of the Forms Wizard, the form includes fields. If

you did not, the screen has only a Submit button.

TIP!

Note: In addition to inserting fields, you can add explanatory text, lines, images, etc. to the form. To layout fields in

columns, insert a table and place the fieldswithin table cells.

The table below explains each field type you can enter.

Button

Inserts

this

kind of

field

Description
For more

information, see

Checkbox User’s response is either checked or unchecked

"Inserting a

CheckboxField" on

page 7-233

Text Free text field; user cannot format text

"Inserting a Text

Field" on page 7-

234

Choices
Several choicesappear on screen. User checksany

number of appropriate responses.

"Inserting a Choices

Field" on page 7-

245

Calendar Lets user insert a date by clicking a calendar

"Inserting a

Calendar Field" on

page 7-248

Insert

Button

Button with no text. You can easily add text to it.

When a site visitor completing the form presses this button,

the data on the screen is submitted to your Web server.

"Inserting or Editing

Buttonson the

Form" on page 7-

251

Insert

Reset

Button withReset as its text. When a site visitor completing

the form presses this button, the form’s field valuesare set

to their state when the form first loaded.

"Inserting or Editing

Buttonson the

Form" on page 7-

251
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Button

Inserts

this

kind of

field

Description
For more

information, see

Insert

Submit

Button withSubmit as its text.

When a site visitor completing the form presses this button,

the data on this screen is submitted to your Web server.

"Inserting or Editing

Buttonson the

Form" on page 7-

251

After you complete the form, you have the following options.

Button or

Tab
Description

Postback

Message
See "Composing the PostbackMessage" on page 7-224

Metadata Edit themetadata for the form. See Also: "Working with Metadata" on page 7-146

Schedule
Assign start or end dates, or both, for when the form is published toWeb site See Also:

"Scheduling Content to Begin and End" on page 7-195

Comment Enter history comment to indicate changesmade to the form

Templates

The template assigned to the form.

Technical note: HTML formsmust reside in a folder whose template uses the FormBlock

server control.

See Also: "Creating/Updating Templates" on page 7-184

Category Any taxonomycategories assigned to the content. See Also: "Taxonomy" on page 9-200

Web

Alerts
Assign or updateWeb Alert information for the form. See "Web Alert Feature" on page 20-1.

Submit
Submit content into approval process.

Publish

Publish content toWeb site.

Note: If the content hasanyactive tasks, a commentswindow popsup. You can insert

comments to describe how approving or declining the content affects the task.

Note: Only the last approver in the approval chain sees this button.

Check
In

Save and check-in content. This button doesnot submit the content into the approval process,

but rather lets other users change it.
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Button or

Tab
Description

Save

Save the content without submitting it into the approval process.

If a user clicks save and then closes the editor, other users cannot edit the content.

Decline

This button appears if you are the next approver in the approval list. Click it to decline the

changesmade to the content.

Note: If content hasanyactive tasks, a commentswindow popsup. You can insert comments

to describe how approving or declining the content affects the task.

Cancel
Close the editor without saving changes.

Next, click the Save and Submit or Publish button ( ). The form only appears on your Web
site after it is published.

After you complete and save the form, it may need to go through the approval process. When

that is complete, add it to the site by assigning it to a page template. See "Implementing a

Form on a Web Page" on page 7-253.

Form Validation
You can apply validation rules to text or calendar field types. Validation rules ensure that the

information entered by site visitors meets your criteria. For example, a validation rule specifies

that a response to the Telephone field is 10 digits. If the response does not conform, an error

message indicates the problem. The input must conform before the form can be submitted.

For a list of validation rule types, see "Validation Options" on page 7-237.

When Validation Rules are Applied

Validation rules are applied when a site visitor submits an entire form, not when the input is

entered. If an invalid response is found, the error message that you define appears.

The site visitor must change his response to conform to the validation rule. When he does, the

next field is checked and, if that is invalid, its error message appears, etc.

Note: If you want to change the visual indicator that a field’s response is invalid, see the following Ektron

CMS400.NET KBarticle: http://dev.ektron.com/kb_article.aspx?id=7070.

Note: If you apply validation rules tomore than one field, include the field name in the error message. For

example, enter The name field only allows text.
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This is good practice because error messagesonly appear after a form is submitted. If themessage doesnot

identify the field, the user maynot know which field needscorrection.

Form Fields
You can insert the following types of fields onto an HTML form.

n "Inserting a Checkbox Field" on page 7-233

n "Inserting a Text Field" on page 7-234

n "Inserting a Choices Field" on page 7-245

n "Inserting a Calendar Field" on page 7-248

See Also: "Inserting or Editing Buttons on the Form" on page 7-251

Inserting a Checkbox Field
A Checkbox field is one character wide and accepts one of two possible values: checked or

unchecked. For example

To insert a checkbox field, follow these steps.

1. Place the cursor where you want the check box field to appear.

2. Click the Checkbox field button ( ).

3. The following dialog appears.
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Fields on the Checkbox Dialog

Field Description

Descriptive

Name
Enter a descriptive name for this checkbox.

Field

Name

Enter a name for this checkbox. This text identifies the field in the database and in email (if the

form ismailed).

Note: You cannot enter spacesnor most special characters (!@#$%^&*()+=<>,.:;’"{}[]|‘~) into

this field. If you do, theyare replaced byunderscores.

Tool Tip

Text

Enter text that appearswhen a site visitor hovers the cursor over this field (circled in red below).

Default

value

If you want this field to be checked when the screen first appears, clickTrue. Otherwise, click

False.

A site visitor can change the default value while completing the screen.

Caption

Enter text to guide the user’s response to this field. The caption appears on the screen to the

right of the checkbox.

To continue the above example, the caption would beCheck if you are over 65.

Inserting a Text Field
Use a text field when you want the user to enter a free text response, or to display text on the

screen. There are many variations you can apply to such a field, such as

n a default value

n text can be read-only or hidden

n the field can expand to accommodate user input

n validation, requiring user input to meet criteria such as a non-negative whole number or a

zip code

To insert a text field, follow these steps.

1. Enter a field label. For example, Name.

2. Place the cursor where you want the text field to appear.

3. Click the Text field button ( ).

Content

7-234
ReferenceManual

Version 8.0 Rev 1.3



4. The following dialog appears.

Fields on the Text Field Dialog - General Tab

Note: If you are using FireFox, you cannot enter text into a text field while creating or editing the form. If you need

to prefill a text field with text, use the field’sDefault Value property.

Field Description

Descriptive

Name

Enter a description of the field. This text describes the field on form reports. See "Viewing Form

Reports" on page 7-262.

Field

Name

Enter a name for this field. This text identifies the field in the database and in email if the form is

mailed.

Note: You cannot enter spacesnor most special characters (!@#$%^&*()+=<>,.:;’"{}[]|‘~) into

this field. If you do, theyare replaced byunderscores.

Tool Tip

Text

Enter text that appears if a site visitor hovers the cursor over this field (circled in red below).

Default

value

If you want to set a default value for this field, enter it here. For example, if this field collects a

city, andmost users enter New York, enter New York as the value.

A site visitor can change the default value while completing the screen.
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Field Description

Allow

multiple

lines

Check this box if you want this field to scroll vertically to allow the person completing the form to

enter asmuch text asneeded.

Note: This setting cannot be applied if this is a Password field.

Cannot be

changed

Check this box to prevent the person completing this field from changing its content. For

example, you want to display a license agreement.

Below this field, youmight place a checkboxprompting the site visitor to check it to indicate he

has read the agreement.

Asanother example, you could provide instructions for completing the screen.

Invisible

Check tomake this field hidden. This option lets you store unseen information in each

document. An examplemight be putting a version number on the form.

If you apply this property to a form, theAllow multiple lines andCannot be changed fields

are automatically checked and cannot be unchecked. Also, the Validation tab is disabled.

Password

field

Use a password field when you want the user to enter a password. A password is like a text field

but the user’s entry is disguised. This prevents an onlooker from seeing the password.

Passwords cannot exceed 18 characters.

Fields on the Text Field Dialog - Validation Tab
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Field Description

Validation
Select the kind of validation to apply to this field. See "Validation Options" on page 7-237

Your system administrator determineswhether a user can save an invalid document.

Message

Enter text that appears on the screen if a site visitor‘s response violates the validation criterion.

For example, if the validation criterion is telephone number, the error message could be Please

enter 7 or 10 digits. It would appear if the user entered, for example, S061882.

Bydefault, the error messagematches the selected validation criterion. Use this field to

customize the text.

Note: You can only enter double-byte characters if your Windowssettings include that language.

If you enter characters that are not in a language defined in your Windowssettings, question

marks (?) appear instead of the characters.

Custom

Validation
See "CustomValidation" on page 7-240.

Validation Options

Note: Your Web developer can customize validation options. For details, see ”Customizing Validation” on page -

1211. However, the file that maintains custom validation is different for HTML forms: it is

siteroot/workarea/ContentDesigner/ValidateSpace.xml.

Option Characteristics of Valid Response

Used

with

text

field

Used

with

calendar

field

No

validation
Response is not checked.

Cannot be

blank
Response is required. The format of the response is not checked.

Allow

Maximum

of 1000

characters

Response cannot exceed 1000 characters. (Only available if text field is

set toAllow Multiple lines.)

Minimum

of 8

characters

with at

least one

digit

Site visitor’s entrymust be at least 8 characters and include one digit.

(Only available if text field is set to Password field.)
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Option Characteristics of Valid Response

Used

with

text

field

Used

with

calendar

field

Non-

negative

whole

number or

blank

A positive whole number or no response.

Non-

negative

whole

number

(required)

Decimal

number or

blank

A decimal number (for example, 12.345 or 12) or blank. A leadingminus

sign “-” is allowed. The decimal point must be a period (.), even in locales

that normally use a comma (,).

Note: Decimal numbers include whole numbers because the decimal

point is implied. That is, 12 is 12.0000.

Decimal

number

required

A decimal number (it cannot be blank) of none, one, or two decimal

places.

A leadingminus sign “-” is allowed. The decimal point must be period (.),

even in locales that normally use a comma (,).

Note: Decimal numbers include whole numbers because the decimal

point is implied. That is, 12 is 12.0000.

Percent:

(0-100)

required

Awhole number from 0 to 100. A response is required.

email

address
a@a, where a is one or more characters.

email

address

required

a@a, where a is one or more characters. A response is required.

email

address

list

Several email addresses. Each address’s format isa@a, where a is one

or more characters. The user must separate each addresswith a

semicolon (;).

email

address

list

required

Several email addresses. Each address’s format isa@a, where a is one

or more characters. The user must separate each addresswith a

semicolon (;). A response is required.
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Option Characteristics of Valid Response

Used

with

text

field

Used

with

calendar

field

Zip code

(US)
5 (nnnnn) or 9 digits. If 9, a dash appears after the fifth (nnnnn-nnnn).

Zip code

(US)

required

5 (nnnnn) or 9 digits. If 9, a dash appears after the fifth (nnnnn-nnnn). A

response is required.

Social

Security

(US)

Nine digits in this pattern: nnn-nn-nnnn.

Social

Security

(US)

required

Nine digits in this pattern: nnn-nn-nnnn.A response is required.

Postal

Code

(Canada)

ana nan, where a is an alphabetic character and n is numeric.

Postal

Code

(Canada)

-

(required)

ana nan, where a is an alphabetic character and n is numeric. A response

is required.

Social

Insurance

Number

(Canada)

A nine digit number in the format: nnnnnnnnn.

Social

Insurance

Number

(Canada)

Required

A nine digit number in the format: nnnnnnnnn.A response is required.

Telephone

number

(US and

Canada)

A seven or 10 digit number in the format nnnnnnn or nnnnnnnnnn.

The site visitor can insert separator characters, such asdashes (-),

between numbers.
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Option Characteristics of Valid Response

Used

with

text

field

Used

with

calendar

field

Telephone

number

(US and

Canada)

(required)

A seven or 10 digit number in the format nnnnnnn or nnnnnnnnnn.

The site visitor can insert separator characters, such asdashes (-),

between numbers.

A response is required.

URL Aweb site address.

ISBN

The InternationalStandard BookNumber (ISBN) is a 10-digit number

that uniquely identifies booksand book-like products published

internationally. Every ISBN consists of ten digits.When printed, the ISBN

number is preceded by the letters ISBN. The ten-digit number is divided

into four parts of variable length, each part separated bya hyphen.

The four parts of an ISBN are:

n Group or country identifier - identifies a national or geographic

grouping of publishers

n Publisher identifier - identifies a particular publisher within a

group

n Title identifier - identifies a particular title or edition of a title

n Check digit - the single digit at the end of the ISBN which validates

it

(Above copied from www.isbn.org.)

ISSN

The ISSN (InternationalStandard SerialNumber) is an eight-digit

number which identifies periodical publicationsas such, including

electronic serials.

The ISSN takes the form of the acronym ISSN followed by two groupsof

four digits, separated bya hyphen. The eighth character is a control digit

calculated according to amodulo 11 algorithm on the basis of the 7

preceding digits; this eighth control character maybe an “X” if the result of

the computing is equal to “10”, in order to avoid ambiguity.

(Above copied from www.issn.org.)

Custom Validation
The Text and Calendar field dialog’s Validation tab features a validation area (illustrated

below).

Content

7-240
ReferenceManual

Version 8.0 Rev 1.3



The validation feature can ensure the following aspects user input.

n The data type - the default types are

- text

- URL

- whole number

- decimal number

- floating point number (Floating point includes scientific notation, so is appropriate for

scientific numbers. Decimals usually suffice for business numbers.)

- date (calendars only)

n The field value has one of the following relationships with another field, a number, or an

expression. The default expressions are

- between two values (either another field or a number that you specify)

- less than

- equal to

- not equal to

- maximum length (usually for text responses)

Note: Your Web developer can customize validation options. For details, see "Customizing Validation" on page 7-

686. However, the file that maintains custom validation is different for HTML forms: it is

siteroot/workarea/ContentDesigner/ValidateSpace.xml.

Your system administrator determines if a user can save the invalid data.
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When the Custom Validation option is selected from the Validation field, the Custom

Validation screen area becomes active.

n The Data Type field is the value’s basic type, for example, text, number, or URL.

n The Condition field displays the validation logic.

n The Examples drop-down list shows validation expressions that you can apply to the

field.

Example of Creating Custom Validation
As an example of custom validation, assume that a field collects telephone numbers, and you

want to make sure the user enters 10 digits. To accomplish this, follow these steps.

1. Insert a Text Field.

2. Complete the Text Field dialog’s General tab.

3. Click the Validation tab.

4. In the Validation dropdown list, select (Custom).
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5. In the Data Type field, select Whole Number from the drop down list. This ensures that

the user can only enter digits.

6. Click the down arrow to the right of the Examples field to see sample logic.

7. Click Maximum text length... . This option lets you specify the length of the user’s

response.

8. string-length(.) <= {X} appears in the Condition field.

9. Since you want the user’s input to equal 10, remove the less than sign (<) from the

calculation. Now it looks like this: string-length(.) = {X}.

10. Replace the {X} with 10. Now, it looks like this: string-length(.) = 10.

11. Move the cursor up to the Message field and compose a relevant error message. For

example: must be 10 digits.
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12. Your screen should look like this.

13. Press OK.

Fields on the Text Field Dialog - Data Style Tab
Click the Data Style tab to apply formatting to a field that accepts user input. When you do,

the following tab appears.
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Use the tab to assign the following formatting attributes to a response field.

n Font style and size

n Bold and italic

n Text alignment (especially helpful for formatting dollar amounts in a plain text field)

n Underline or strikethrough

n Font color and/or background color

Inserting a Choices Field
Use a Choices field when you want a site visitor to select from a predetermined list. You can

allow a site visitor to select only one or more than one choice. You can also determine the

list’s items and appearance.

To insert a choices field, follow these steps.

1. Enter a field label. For example, Country.

2. Click the Choices field button . See Also: "Adding a Field to the Screen" on page 7-
230

3. The following dialog appears.

Fields on the Choices Dialog
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Field Description

Descriptive

Name

Enter a description of the field.

This text describes the field on form reports. See "Viewing FormReports" on page 7-262.

Field Name

Enter a name for this field. This text identifies the field in the database and in email if the form is

mailed.

Note: You cannot enter spacesnor most special characters (!@#$%^&*()+=<>,.:;’"{}[]|‘~) into

this field. If you do, theyare replaced byunderscores.

Tool Tip

Text

Enter text that appearswhen a site visitor hovers the cursor over this field (circled in red

below).

List

Custom - You create your own set of choices. Use the Item List area to do this. See Also:

"Item List" on page 7-248

Languages - A standard list of languages

Countries - A standard list of countries

U.S States and Territories - A standard list of United States of America states

and territories

Canadian Provinces - A standard list of Canadian provinces

Age Ranges - A standard list of age ranges

Numeric Ranges - A standard list of numeric ranges

Years - A standard list of years

Gender - Male or female

Marital Status - A standard list marital statuses

Allow

Selection

ClickMore than one to let a site visitor select more than one item for this field. Otherwise, click

Only one to limit the user to one choice.

A selection is required - Check this box if the user must select at least one item.

First item is not a valid selection - You can use the first list item to prompt the user to

make a selection instead of being a valid response. For example, the first itemmaysaySelect

from the list. To do so, check this box.

If you do, the site visitor must choose any selection except the first item. If he tries to file the

screen without choosing a different item, this error message appears: First item is not a

valid selection.

Note: This option is only available ifAppearance is set toDrop List.
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Field Description

Appearance

ClickVertical List to arrange the choices vertically.

ClickHorizontal List to arrange the choiceshorizontally.

Click List Box to display all choices in a box. If more than four choicesare available, the user

scrolls to see additional options.

ClickDrop List to display all choices in a dropdown list. When the user clicks the down arrow,

all entries appear.
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Field Description

Item List

This section of the screen displays the list items. It is only editable if the list type isCustom.

The Context-Sensitive Menu

Buttons to the left of each item (circled below) display amenu. Themenu lets you remove

items, rearrange them, and insert additional itemsanywhere on the list.

The Selected Box

Place a check in the boxof any item to be checked bydefault on the data entry screen. If you

do, the user can accept the default or uncheck the item byclicking in the checkbox. Note that if

Only One is selected under Allow selection (above), only one item can be selected.

If theAppearance is set to Drop-Down list, this value is ignored.

Display Text

Enter text to describe this item on the data entry screen.

Value

Enter the value that is collected when the site visitor selects this item.

For example, if Interests appears in the Name field, and you want music to be collected

when the data entry user selects this item and saves the page, entermusic here.

The Disabled Checkbox

Check the boxnext to any selection that you want to disable. If you do, the option appears on

the form but the user cannot select it.

Option

Click this button to add a row to the bottom of the list.

Inserting a Calendar Field
To insert a field that lets a site visitor select a date, use a Calendar Field. To do that, follow

these steps.

1. Enter a field label. For example, Expiration Date.

2. Click the Calendar field button ( ). See Also: "Adding a Field to the Screen" on page 7-
230

3. The following dialog appears.
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Respond to the fields on the screen.

See Also:

n "Fields on the Calendar Field Dialog - General Tab" on page 7-249

n "Fields on the Calendar Field Dialog - Validation Tab" on page 7-250

n "Fields on the Calendar Field Dialog - Data Style Tab" on page 7-251

Fields on the Calendar Field Dialog - General Tab

Field Description

Descriptive

Name

Enter a description of the field.

This text describes the field on form reports. See "Viewing FormReports" on page 7-262.

Field

Name

Enter a name for this field. This text identifies the field in the database and in email if the form is

mailed.

Note: You cannot enter spacesnor most special characters (!@#$%^&*()+=<>,.:;’"{}[]|‘~) into

this field. If you do, theyare replaced byunderscores.

Tool Tip

Text

Enter text that appearswhen a site visitor hovers the cursor over this field (circled in red below).

Default

value

If you want to set a default date, enter it here. The site visitor can change the default value while

completing the screen.
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Field Description

Validation

Select the kind of validation to apply to this field. The choicesare:

n No validation - response is not checked

n Cannot be blank - Response is required. The format of the response is not checked. If

you assignCannot be blank, the field is surrounded by red dasheswhen it appears on your

Web site.

n Custom - See "CustomValidation" on page 7-240

Error

Message

Enter text that appears if a site visitor‘s response doesnot satisfy the validation criterion. For

example, if the validation criterion isCannot be blank, the error message could bePlease

enter a response.

Bydefault, the error message is the same as the validation criterion. Use this field to customize

its text.

Note: You can only enter double-byte characters if your Windowssettings include that

language. If you enter characters that are not in a language defined in your Windowssettings,

questionmarks (?) appear instead of the characters.

Fields on the Calendar Field Dialog - Validation Tab

Field Description

Descriptive

Name

Enter a description of the field.

This text describes the field on form reports. See "Viewing FormReports" on page 7-262.

Validation

Select the kind of validation to apply to this field. The choicesare:

n No validation - response is not checked

n Cannot be blank - Response is required. The format of the response is not checked. If

you assignCannot be blank, the field is surrounded by red dasheswhen it appears on your

Web site.

n Custom - See "CustomValidation" on page 7-240

Message

Enter text that appears on the screen if the site visitor‘s response doesnot satisfy the validation

criterion. For example, if the validation criterion isCannot be blank, the error message could

bePlease enter a response.

Bydefault, the error message is the same as the validation criterion. Use this field to customize

it.

Note: You can only enter double-byte characters if your Windowssettings include that

language. If you enter characters that are not in a language defined in your Windowssettings,

questionmarks (?) appear instead of the characters.
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Fields on the Calendar Field Dialog - Data Style Tab
See "Fields on the Text Field Dialog - Data Style Tab" on page 7-244

Editing a Form Field
To edit a form field, follow these steps.

1. Click inside the field. It becomes surrounded with small squares.

2. Click the toolbar button that corresponds to the field type. See Also: "The Form Toolbar

Options" on page 7-229

3. The dialog appears for that field type.

4. Edit as needed. See Also: "Form Fields" on page 7-233

5. Press OK.

Inserting or Editing Buttons on the
Form
A form typically includes one or more buttons, which let a site visitor submit a completed

form.
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eWebEdit400’s form toolbar has three buttons that you can place on a form (circled below.)

The buttons are described below.

Toolbar

Button
Name Description

Insert

Submits form information to your Web server. Bydefault, it hasno text.

To learn how to add button text, see "Editing a Button’sProperties" on

page 7-253.

Reset
Changesa form’s field valuesback to their state when the form first

loaded.

Submit Submits form information to your Web server. Its default text isSubmit.
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Editing a Button’s Properties

After you insert a button, you may want to enter or change its properties, such as its text,

height, and width. To edit a button’s properties, follow these steps.

1. Click the button so that it is selected. A selected button is surrounded by small squares, as

shown below.

2. Below the editor screen, several fields appear, as shown below.

3. Update the button fields as needed.

Field Description

Name Give the button a unique name.

Id If needed, give the button a unique ID.

Width Enter or change the button’swidth in pixels.

Height Enter or change the button’s height in pixels.

Value Enter or change the button text.

Tooltip
Enter or change the button’s tooltip (that is, text that appears in a smallwindow

when someone hovers themouse over the button).

Classname Enter or change the style sheet classassigned to the button.

Implementing a Form on a Web Page
After you create the form, you need to link it to another page on your Web site. You would

insert the link as you would any form link. See "Adding a Library File to Content" on page 8-
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Next, open your Web Site, navigate to the host page, and click the hyperlink to access the

form. Now, you can test the form and make sure it works as you expected. If needed, you can

return to edit mode, change the form, and test it again until you are happy with it.

Sending Data as XML
While creating a form that generates email, you can specify that the email be sent as XML data

or plain text.

XML has the following advantages over plain text.

n Because XML data is structured, you can easily parse the content to store and retrieve

important information.

n If you download the form data to an Excel spreadsheet, the XML tags become the

spreadsheet’s column headers. See Also: "Exporting a Form’s Raw Data" on page 7-267

This section contrasts XML and plain text email using the form displayed below as the

example. Here is an example of a form before it is submitted.

The following table displays the resulting email, depending on the method used.
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Form sent as Generated email

Plain Text

XML

XML email Structure

A form’s XML structure consists of two groups of XML tags:

n Form and mail elements

n Data elements

The following image illustrates the sections of XML email structure.
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The following explains the sections of the XML email.

Root Tag
The XML email is wrapped in <cmsMail> root tags.

Form and Mail Tags
The form and mail tags display information about the form that was generated from the form

information.

This illustration compares the information defined for the form with the information in the

XML email.
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The following table explains each XML tag in the form and mail sections of the email.

XML Tag Description

<FormTitle> Title given to the form that was submitted.

<FormDescription> Description given to the form that was submitted.

<date> Date and time the formwassubmitted.

<MailTo> To email address(es) defined in the form.

<MailFrom> From email address(es) defined in the form.

<MailCc> CC address(es) defined in the form.

<MailSubject> Subject for the generated email defined in the form.

<MailPreamble> Preamble for the generated email defined in the form.

Data Tags
The XML email’s data tags wrap the information entered by the form’s submitter. Each form

element in the content becomes an XML tag.
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The following image illustrates how a form is edited in the editor, displayed on a Web page,

and then converted to XML for the email.

As shown in the graphic, the content is comprised of four form elements that are converted to

XML tags:

n Name

n Email

n PhoneNumber

n Problem

Redirecting Submitted Form Data
This section explains how to redirect submitted form data to an action page. Because the data

is redirected via server transfer, you can easily customize the handling of a multi-page form.

Users can select this option when creating or editing a form response, as illustrated below.
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Instructions for how a user chooses a hyperlink to an action page are in "Redirecting

Submitted Form Data" on page 7-258.

Warning! If your formwill redirect the user to an action page, it must be implemented using a FormBlock server

control. You cannot use a Poll server controlwhen redirecting to an action page.

Note: If a form’s specifications indicate that its data is saved to a database, the data is saved before being

forwarded to an action page.

The following section explains how to set up a hyperlink to the action page in preparation for

a user’s selection.

Setting Up the Action Page

1. Create the action page. It must

- load and use the form variables

- have an .aspx extension

- reside in the same web application as your Web site

Warning! If your site is using URL Aliasing, the action page’s header must include the following: Ena-
bleEventValidation="false" EnableViewStateMac="false"

2. Place the action page in your Web site’s root folder.

3. Set up a library hyperlink to the .aspx page. Here’s how to do that:

- In Ektron CMS400.NET, go to the Library.

- Select Hyperlinks from the file type dropdown.
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- Click the Add button ( ).

- In the URL Link field, enter the path relative to the Web root to the .aspx file you

created in Steps 1 and 2. For example:
http://localhost/siteroot/ServerVariables.aspx

- Give the hyperlink a title and save it.

4. Inform your users of the hyperlink. They will select it when selecting the form response.

Assigning a Task to a Form
While tasks typically help Ektron CMS400.NET users track content activities, you can also

assign a task to users or user groups whenever a form is submitted.

For example, your Web site offers a free product demonstration to anyone who completes a

form. Whenever a site visitor submits the form, a task is assigned to your sales department’s

administrative assistant. He uses the information on the form to schedule a demonstration. The

sales manager can review the task history to audit sales leads and ensure demonstration

requests are being handled in a timely manner.

To set up a task that it is assigned to users or groups whenever a site visitor completes the

form, follow these steps.

Note: You should be familiar with tasksbefore beginning this procedure. See Also: "Managing Tasks" on page 11-

1

1. If you are creating a new form, assign the task at Step 3 of the Forms Wizard.

If you are editing a form, assign the task on the form’s Edit Properties screen.

In both cases, you identify only users and groups to whom the task will be assigned

whenever a site visitor completes the form. Ektron CMS400.NET assigns the remaining

task information.

2. You complete the form and make it available on your Web site.

3. A visitor to your site fills out and submits the form.

4. A task is created and assigned to users and groups you identified in Step 1.

5. Any Ektron CMS400.NET user can view all tasks created via form submission in the Smart

Desktop. See illustration below. See Also: "Personalizing the Smart Desktop" on page 4-4
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Ektron CMS400.NET users and administrators can also view and update tasks assigned to them

via the Task screens on the Smart Desktop. See "Viewing a Single Task" on page 11-24 and

"Viewing a Task’s History" on page 11-29.

See Also: "Task Information" on page 7-261; "email Automatically Generated Upon Form

Submission" on page 7-262

Task Information

The task created upon form submission has the following information.

Field Value

Title Form title, as entered by the author

Assigned to As set up by the user who created or edited the form

Assigned by User who created or last edited form

Priority Normal

Task

Category
Form Submission TaskCategory

Task type Form Submission Task

Created by User who created or last edited form

Not started

Assigning a Task to a Form
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Field Value

Not specified

Start date Not specified

Description

Data from form “form name” was received on date time.

form description

Name of every field on the form: value submitted by user into that

field

email Automatically Generated Upon Form
Submission

An email is automatically sent to every user named in Step 1 above who has a valid email

address in the User Information Screen. The email’s subject line is the form name. The body of

the email contains the following information for each field on the form.

n name

n value submitted by user

Viewing Form Reports
If a form is set to store data in the database, you can run a report that displays the submitted

data. To view a form report, follow these steps.

1. Navigate to the folder for which you want to view the report. The View Contents of

Folder screen appears.

2. Click the form you want to view. (If you do not see your form in the folder, make sure the

Content Type drop-down box is set to All Types or Forms.)

3. Click the View Reports button ( ).

4. The View Forms Report screen appears.

5. Enter report criteria using the following table as a reference.

Content

7-262
ReferenceManual

Version 8.0 Rev 1.3



Field Description

Start Date
If desired, specify a start date. The report displaysonly

forms that were submitted on or after the start date.

End Date
If desired, specify an end date. The report displaysonly

forms that were submitted on or before the end date.

Report Display Specify the format to display the report.

Select LegacyReport

Specify the version of the form or poll for which to get a

report. Using this option allows you to see the results from

previouspolls and forms.

6. Click the Get Result button to display the report.

Display Formats

The submitted form data can be viewed in any of these formats.

n "Table with Totals" on page 7-263

n "Summary of Selected Choices" on page 7-264

n "Table of Values" on page 7-265

n "List of Submitted Values" on page 7-266

n "Submitted Data as XML" on page 7-267

Table with Totals
The table of values shows the following information for each completed form.

n a checkbox that lets you delete the response

n an internal identification number of the response

n the name of the user who submitted the form, if he signed in to Ektron CMS400.NET

beforehand. If the user did not sign in, anonymous appears.

n date response was submitted

n The name of each field on the survey

- under each field name is the submitted response for the each user

n the bottom line sums the numerical and percentage totals for each response

Sample of Table with Totals Format
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Summary of Selected Choices
This format totals, for choice and select type fields, the number of times each choice was

selected. Only choices that were selected at least once appear.

Sample Summary of Selected Choices Format
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Table of Values
The table of values shows the following information for each completed form.

n a checkbox that lets you delete the response

n an internal identification number of the response

n the name of the user who submitted the form, if he signed in to Ektron CMS400.NET

beforehand. If the user did not sign in, anonymous appears.

n date response was submitted
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n descriptive name of each form field appears in the column header

- the value entered for each field appears below the header

Sample of Table of Values Format

List of Submitted Values
The List of Submitted Values format provides the same information as the Table of Values, but

is formatted vertically rather than horizontally. See Also: "Table of Values" on page 7-265

Sample List of Submitted Values Format
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Submitted Data as XML
Displays the results of the form in an XML format. The following information is included:

n <Title> - title of the form block

Warning! With polls you can create a new poll question to replace an existing poll question. Bydefault the poll still

has the same Title, ID, and other properties. You can change the title of a new poll question when you are editing

the poll.

n <Description> - description of the form

n <SubmittedData> - information that was submitted

Sample of Submitted Data as XML

Exporting a Form’s Raw Data

After you run a report, you can export its data to a Microsoft Excel spreadsheet file (.xls) for

further analysis. If a form uses an XML structure, each XML tag becomes a column header in

the spreadsheet.

To export form data, follow these steps.

1. Access the View Form Reports screen for the report you want to export, as described in

"Viewing Form Reports" on page 7-262.

2. Click the Export Reports button ( ).
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3. A File Download dialog box is displayed. Choose the option that best suits your needs.

4. After the data is exported, you can analyze and modify the .xls file.

Viewing Form Information
After a form is created, you can view its information in the Forms folder. To view a form,

follow these steps.

1. Access the folder that contains the form you want to view.

2. Click the form you want to view.

3. The View Form screen displays.

4. Click the Form Properties tab.

5. The following table explains the information on the screen.

Field Description

Form Title Title used to reference the form

FormID ID number automatically assigned to form

Status The form’s current status

Description Extended description for the form

FormData The type of form data: Mail or Database.

Form Submissions

Themaximum number of timesa user can submit the form. This is

typically used with polls and surveys to limit one user’s influence over

the results.

Assign Task to
Users and groups to whom a taskwill be automatically assigned

whenever a site visitor completes the form.

Content Properties Displays the properties of the form’s content

Content Title
Title of content associated with form

Note: The content name is the same as the Form name.

Content ID Content ID number assigned to content

Status The status of the content
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Field Description

Last Editor Last user to edit the content

Start Date
Date and time when content will go live onWeb site (if set for future

date)

End Date
Date and time when content will be removed fromWeb site (if set for

future date)

Date Created Date and time when content was created

Viewing and Editing a Form’s Properties

To see and update additional form information that does not appear on the View Form screen,

view its properties. To do so, follow these steps.

1. Navigate to the form’s View Form screen, as described in "Viewing Form Information" on

page 7-268.

2. Click the Form Properties button ( ).

3. The Form Properties screen displays a subset of form information.

n Title and Description

n Database or Mail - if form data is emailed whenever a site visitor submits it, enter mail

property information below. See "Mail Properties" on page 7-269

n Autofill form values - checked by default, this allows the form’s fields to fill automatically

when a logged-in site visitor has previously completed the form.

n Limit Submission - when checked, you can enter the number of times a user can submit a

form in the Number of Submissions text field

n Assign task to - see "Viewing Form Information" on page 7-268

n Form block’s ID number

n Mail Properties

Mail Properties
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Field Description

To

Email address to which the form is sent when submitted.

See Also: "Retrieving email Address from the Submitted Form" on

page 7-270

From
Text that appears in the email’s From field. See Also: "Retrieving

email Address from the Submitted Form" on page 7-270

CC
Text that appears in the email’s CC field. See Also: "Retrieving email

Address from the Submitted Form" on page 7-270

Subject
Text that appears in the email’s subject field. See Also: "Retrieving

FormData Into the Subject and Preamble Fields" on page 7-271

Preamble
Beginning text of the email. See Also: "Retrieving FormData Into the

Subject and Preamble Fields" on page 7-271

Send data in XML

Format

A green checkmeansemail data will be in a structured XML packet.

A red Xmeans the email data will be in a standardmailto format.

For more information, see "Sending Data asXML" on page 7-254.

Retrieving email Address from the Submitted Form
In the Mail Properties section of the Edit Form screen, you can select email addresses

submitted on the form to be inserted into these Mail Property fields:

n To

n From

n CC

So, instead of entering a static email address, it can be dynamically retrieved from the user’s

form submission. For example, you want to retrieve the “from” field of an email from the

information a user enters when completing the form.

To do this, use the OR to addresses in field dropdown lists circled below. These lists contain

fields that dynamically retrieve data from the submitted form.
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Note that the To and CC fields can accept fields whose validation type is email address or

email address list. On the other hand, the From field can only accept fields whose validation

type is email address (that is, a single email address).

To set this up, follow these steps.

1. Add a form field whose Validation type is Email address or Email address list . The

field prompts the user completing the form to enter his email address. Label the field

something like Enter your email address.

Note: If the field allowsmore than one address, add on-screen instructions to separate each addresswith a

semicolon (;).

2. Go to the Edit Form screen > Mail Properties section.

3. Move to the field labeled From:.

4. At the dropdown list following OR to addresses in field, select the field you created in

Step 1.

Now, when a user completes the form, the value he enters in the field created in Step 1 is used

for the email’s From address.

Retrieving Form Data Into the Subject and Preamble Fields
You can retrieve data from a submitted form directly to the form’s Subject and Preamble

fields. (The subject is a standard mail field, and the preamble is text that appears at the
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beginning of the email.)

For example, the form may provide a list of your products. While the user is completing the

form, he selects a product that he is interested in. The product then becomes the subject line of

the email.

Note: Since a Textarea field can spanmultiple lines, it can only be used with the preamble. However, a plain text

field can be used with both the subject and preamble.

To retrieve data dynamically from a form field into the email’s subject line or preamble, follow

these steps.

1. Add a form field that collects the information you want to insert into the email’s subject

line or preamble. See Also: "Adding a Field to the Screen" on page 7-230

2. Go to the Edit Form screen > Mail Properties section.

3. Move to the field labeled Subject or Preamble.

4. At the dropdown list following OR use text in field, select the field you created in Step 1.

Editing a Form
After you create a form, it can easily be edited if information needs to be changed. You can

update the following information by following the procedure below.

n the form fields

n post back message

n metadata

n schedule

n comments

n Web Alerts

However to edit a form’s Title, Description, form data, or task values, use the Edit Properties

screen.

To edit a form, follow these steps.

1. Access the View Form screen for the form you want to edit, as described in "Viewing and

Editing a Form’s Properties" on page 7-269.

2. Click the Edit button ( ).

3. The Edit Form screen is displayed. The screen is the same as the Add New Form screen.

For documentation of individual fields, see "Creating a New Form" on page 7-222.

4. Make the necessary changes to the form.
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5. Click the Save button ( ).

See Also: "Editing a Form" on page 7-272

Editing a Form’s Content

You can edit the content associated with the form by a variety of methods, including:

n Accessing the content by the floating toolbar on the Web page

n Editing the content by the View Form screen

n Accessing the content by the View Form content properties screen

This section explains how to edit a form’s content from the View Form screen. To edit a form’s

content, follow these steps.

1. Access the View Form screen for the content, as described in "Viewing Form Information"

on page 7-268.

2. Click the Edit Content button ( ).

3. The Edit Content screen appears.

4. Make the necessary changes to the form’s content.

5. If you want to edit any field’s properties, place the cursor in the field, right click the

mouse, and choose Field Properties.

6. If needed, click the Postback Message, Metadata, Schedule, Comment or Web Alerts tab to

edit that information.

7. Click a workflow button (Submit for Publication or Publish).

Editing a Form’s Properties

See "Viewing and Editing a Form’s Properties" on page 7-269

Mailto or Database Form
The Forms feature lets you create a mailto or a database form to use on your Web site. When

creating or editing a form, you must specify the type of form you are creating. The options are:

n Send it via email

n Store it in a database

n Send it via email and store in a database

See "Viewing and Editing a Form’s Properties" on page 7-269 for information about toggling

this option on and off.
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Advantages of a Mailto Form
By creating a mailto form, any email generation is done on the server-side, not on the client.

This means that site visitors can submit email whether or not the client has email software.

Storing Form Data in a Database
By storing form data in the Ektron CMS400.NET database, you can keep information

submitted by site visitors and view reports on that information. You can also export the form

data to a spreadsheet.

Deleting a Form
You can easily delete forms that are no longer needed.

Note: Deleting a form also deletes its associated content and information.

To delete a form, follow these steps.

1. Access the View Form screen for the form you want to delete.

2. Click the Delete Form button ( ).

3. A confirmation message is displayed.

4. Click OK.

Creating Polls and Surveys
Polls and surveys are a type of form. All of the same functionality is available and applies.

Warning! For complete understanding of forms, polls, and surveys, you should read the entire chapter "The Struc-

ture of FormData" on page 7-222.

n A poll is generally one question and appears on a site for a very short time: an hour or a

day.

n A survey is usually multiple questions and appears on your site for a longer time than a

poll.
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Note: For information on scheduling when your polls and surveysappear on the site, see "Scheduling Content to

Begin and End" on page 7-195.

With polls and surveys, you can show ongoing results to site visitors after they submit their

answers.

The following sections provide information about creating a poll or survey beyond the normal

form information.

n "Working With Polls" on page 7-275

n "Creating a Survey" on page 7-279

n "Making Form Results Available to Site Users" on page 7-227

n "Viewing Form Information" on page 7-268

For information on how to display a poll or survey on a Web site, see "Poll Server Control" on

page 7-284.

Working With Polls
Below is an example of a poll. Note that when a site visitor hovers over the poll, the question

also appears as ToolTip text.

This subsection contains the following:

n "Creating a New Poll in the Workarea" on page 7-276

n "Replacing a Poll from the Web Site" on page 7-277

n "Editing a Poll from the Web Site" on page 7-278
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Creating a New Poll in the Workarea
To create a new poll, follow these steps.

Note: You can also create a new edition of a poll in another language by copying an existing poll and translating it.

For more information, see "Translating Content to Another Language" on page 7-112.

Note: For the steps to create a new form, see "Creating a New Form" on page 7-222. For the steps to create a

new survey, see "Creating a Survey" on page 7-279.

1. From the View menu, click Language, and select the language in which to create the poll.

2. Click New > HTML Form/Survey.

3. The New Form screen appears.

Note: If you choose Standard Poll or BlankSurvey, the number of steps in the FormsWizard changes from five to

four. This happensbecause the Assign Tasks step is removed.

4. Choose Standard Poll. You can click the preview icon ( ) next to any sample form to
preview it before choosing it.

5. Click the Next button.

6. Enter or edit the form’s Title and Description.

n Title - used to reference the poll within the Workarea (required)

n Description - an extended description of the poll.

7. Click the Next button.

8. This screen lets you add a poll question and possible replies.

Content

7-276
ReferenceManual

Version 8.0 Rev 1.3



Note: This screen allowsyou to add up to eight replies. If you havemore than eight replies, you can add them in

the formseditor after clicking theDone button.

9. Click the Next button.

10. This screen indicates that you have entered the basic poll information and should click the

Done button to further edit and view the form’s fields.

11. After clicking the Done button, the form editor launches so you can edit existing fields

and properties. In addition, you can set post back and schedule information, add metadata

and comments, change the title, and submit the poll for publication.

Note: From this screen, you can addmore replies to your poll by right clicking on the choices field and clicking

properties. See Also: "Inserting a ChoicesField" on page 7-245.

Replacing a Poll from the Web Site
When logged into Ektron CMS400.NET, you can right click on a poll and choose New Poll to

replace the current one. The title of the poll, its ID, and properties stay the same. Only the

questions and answers change.

To replace a poll, follow these steps.

1. Log into Ektron CMS400.NET.

2. Navigate to the Web page that hosts the poll.

3. At the location of the poll, click the silver access point and choose New Poll.

4. The Workarea opens, indicating you are at step three of the Poll Wizard.
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5. Add a new question to the Question text box.

6. Add possible responses to the Choices text boxes.

7. Click Next.

8. Click Done.

9. The form editor launches, allowing you to edit the fields and properties. In addition, you

can set post back and schedule information, add metadata and comments, change the title

and submit the poll for publication.

10. Once published, the updated poll appears on the site.

Editing a Poll from the Web Site
To edit an poll on a Web site, follow these steps.

Warning! If you are logged into the site and create a new poll by right clicking on a poll selectingNew, the existing

poll is replaced by the new one.

1. Log on to the Ektron CMS400.NET Web site.

Content

7-278
ReferenceManual

Version 8.0 Rev 1.3



2. Click the sliver access point on the poll you want to change and click Edit.

3. Make changes to the poll using the Forms editor.

4. Submit the poll to the Approval Process.

Creating a Survey
To create a new survey, follow these steps.

Note: You can also create a new edition of a survey in another language by copying an existing form and

translating it. For more information, see "Translating Content to Another Language" on page 7-112.

Note: For the steps to create a new poll, see "WorkingWith Polls" on page 7-275. For the steps to create a new

form, see "Creating a New Form" on page 7-222.

1. Consult with your Ektron CMS400.NET administrator about the folders in which you

should create polls. See Also: "Forms Must Use Template with FormBlock Server Control"

on page 7-281

2. From the View menu, click Language, and select the language in which to create the

form.

3. Click the New > HTML Form/Survey.

4. The New Form screen appears.
.
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Note: When you choose Standard Poll or BlankSurvey, the number of steps in the FormsWizard changes from

five steps to four steps. This happensbecause the Assign Tasks step is removed.

5. Choose Blank Survey. You can click the preview icon ( ) next to any sample form to
preview it before choosing it.

6. Click the Next button.

7. Enter or edit the form’s Title and Description.

n Title - used to reference the survey within the Workarea (required)

n Description - an extended description of the survey.

8. Click the Next button.

9. This screen lets you determine what happens after the site visitor completes the survey.

The choices are:

n Display a message - See "Composing the Postback Message" on page 7-224

n Redirect to a file or page - Use the Library Identify a file or a page on your

Web site that is launched when the visitor completes the form

- An example of a file is a white paper (a common file format is .PDF) that the

visitor requested

- An example of a page is one that lets the visitor download your product

n Redirect to an action page and forward form data - See "Redirect to an Action Page

and Forward Form Data" on page 7-226

n Report on the form - See "Making Form Results Available to Site Users" on page 7-

227

10. Click the Next button.
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11. A screen indicates that you have entered basic information about the survey and should

click the Done button to enter the survey’s content. This procedure is described in

"Creating a Form’s Content" on page 7-228.

Forms Must Use Template with
FormBlock Server Control
HTML forms can only be created in a folder whose template uses a FormBlock or Poll server

control. In the Intranet sample site supplied with Ektron CMS400.NET, the Contact

Information folder uses such a template, contactinformation.aspx (illustrated below).

You can modify this template as needed or create your own form template and assign it to any

folder via its Folder Properties screen.

Since, by default, folders inherit properties from their parent folder, any new folders created

under a parent folder use the correct template. Of course, you can break inheritance and assign

a custom template for any folder.

FormBlock Server Control
The FormBlock server control displays a content block associated with a form.
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Warning! If you create a template for an existing form content block, youmust man-
ually change its quicklink to point to the new template. This change does not occur
automatically. This procedure is described in "Updating Default Template for Mul-
tiple Quicklinks" on page 8-24.

When added to a template and visited, the form content block might look like this. You can

change the display to suit your needs by modifying its properties.

This subsection contains the following topics:

n "FormBlock Server Control Properties" on page 7-282

n "Automatic versus Manual Generation of Form Tags" on page 7-284

FormBlock Server Control Properties
The following table explains the properties of the FormBlock server control.
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Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value Data Type

AddValidation
The AddValidation property is obsolete and ignored. It has

no effect. It is always true.
Boolean

Authenticated

Indicates if you are logged in to the CMSExplorer and can

use it to browse to Content, Collections, etc. See Also:

"Using CMSExplorer to Browse Your Ektron CMS400.NET

Site" on page 21-9.

String

CacheInterval

Sets the amount of time the server control’s data is cached.

The default is 0 (zero). This is the amount of time, in

seconds, a control’s data is cached. For example, if you want

to cache the data for fiveminutes, set this property to 300

(three hundred). See Also: "Caching with Server Controls"

on page 21-31

Double

DefaultFormID

The ID of a FormBlock that appearswhere you inserted this

server control if no other form block is identified.

If you don’t know the ID number of the form block, use the

CMSExplorer to browse to it. See Also: "Using CMS

Explorer to Browse Your Ektron CMS400.NET Site" on

page 21-9.

Long

DynamicParameter

Tomake this form blockdynamic, select id. When you do,

this server control uses the form blockpassed asa URL

parameter.

String

Fields

Displaysa list of fields that are defined in the form. These

fields are read only. This is an excellent wayof displaying the

field namesused on the form.With this list of names, you can

create events using the fieldswithout having to enter the

Workarea to see the names.

FormFieldCollection

Hide

Used to hide a form block in design time and run time.

True =Hide form block

False =Show form block

Boolean

IncludeTags

Determines if tagsare generated automatically of manually.

See Also: "Automatic versusManualGeneration of Form

Tags" on page 7-284

Boolean

Language

Set a language for viewing form content. This property

shows results in design-time (in VisualStudio) and at run-

time (in a browser).

Integer
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Property Value Data Type

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the

control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line

portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes

to a blockof code.

Custom - Allows you to use a custom tag.

String

Automatic versus Manual Generation of Form Tags
When using the FormBlock Server control’s IncludeTags property, you have two options.

Option

Recommended

if you are

developing

How to Enable

Let Ektron

CMS400.NET

generate form tags

automatically

A pure script .aspx

page
Set IncludeTagsproperty to True.

ModifyHTML form

tags in the .aspx file

An .aspxpage and

associated code-

behind web form

Set IncludeTagsproperty to False.

Here is the default .NET generated form tag:

<form id="Form1" method="post"

runat="server">

Modify the form tag as indicated in red:

<form id="Form1" method="post"

runat="server" OnSubmit=”return

EkFmValidate(this);”>
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Poll Server Control
The Poll server control displays a poll or survey created from an Ektron CMS400.NET form on

a Web page. When added to a template and visited, the poll might look like this. You can

change a poll‘s appearance by modifying its properties.

Ektron recommends displaying a poll or survey with a Poll server control, because it provides

great flexibility with the poll’s appearance. Typically, developers want a poll or survey in a

small section of a Web page, not the main content. By using the EnableAjax property, you can

display the results in the same area as the poll or survey without refreshing the entire page.

However, if you want the form/poll/survey’s response to be either Redirect to a file or page or

Redirect form data to an action page, you must use a Form Block server control to display

the form on a Web page. See Also: "FormBlock Server Control" on page 7-281

This subsection contains the following topics:

n "Poll Server Control Properties" on page 7-285

n "Automatic versus Manual Generation of Form Tags" on page 7-287

Poll Server Control Properties
The following table explains the properties of the poll server control.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.
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Property Value
Data

Type

(Poll ID)

The ID of the poll that appearswhere you inserted this server control.

If you don’t know the ID number of the form block, use the CMS

Explorer to browse to it. See Also: "Using CMSExplorer to Browse

Your Ektron CMS400.NET Site" on page 21-9

Long

AddValidation
The AddValidation property is obsolete and ignored. It hasno effect. It

is always true.
Boolean

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to

browse to Content, Collections, etc. See Also: "Using CMSExplorer to

Browse Your Ektron CMS400.NET Site" on page 21-9

String

CacheInterval

Sets the amount of time the server control’s data is cached. The default

is 0 (zero). This is the amount of time, in seconds, a control’s data is

cached. For example, if you want to cache the data for fiveminutes, set

this property to 300 (three hundred). See Also: "Caching with Server

Controls" on page 21-31

Double

DynamicParameter
Tomake this form blockdynamic, select ekfrm. When you do, this

server control uses the form blockpassed asa URL parameter.
String

EnableAjax

Displays the poll or results, using an iFrame, in the area of the page that

contains the pollwithout disturbing its surrounding contents. The

default is true.

True =Polls and results are shown in an iFramewithout modification or

a refresh of surrounding contents.

False =The poll and the results replace theWeb page’s content.

Boolean

Fields

Displaysa list of fields that are defined in the form. These fields are read

only. This is an excellent wayof displaying the field namesused on the

form.With this list of names, you can create events using the fields

without having to enter theWorkarea to see the names.

Hide

Used to hide a form block in design time and run time.

True =Hide form block

False =Show form block

Boolean

Include Tags
Determines if tagsare generated automatically of manually. See Also:

"Automatic versusManualGeneration of Form Tags" on page 7-287
Boolean

Language
Set a language for viewing form content. This property shows results in

design-time (in VisualStudio) and at run-time (in a browser).
Integer

SuppressWrapperTags
Suppresses the output of the span/div tagsaround the control. The

default isFalse. Boolean
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Property Value
Data

Type

True - Suppresswrap tags.

False - Allow wrap tags.

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a block

of code.

Custom - Allows you to use a custom tag.

String

Automatic versusManual Generation of Form Tags
When using the poll server control’s IncludeTags property, you have two options.

Option

Recommended

if you are

developing

How to Enable

Let Ektron

CMS400.NET

generate form tags

automatically

A pure script .aspx

page
Set IncludeTagsproperty to True.

ModifyHTML form

tags in the .aspx file

An .aspxpage and

associated code-

behind web form

Set IncludeTagsproperty to False.

Here is the default .NET generated form tag:

<form id="Form1" method="post"

runat="server">

Modify the form tag as indicated in red:

<form id="Form1" method="post"

runat="server" OnSubmit=”return

EkFmValidate(this);”>
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Working with Smart Forms

Warning! This section explains how to create andmanage Smart Formsusing the eWebEdit400 editor. For doc-

umentation on doing this via eWebEditPro+XML, see http://ww-

w.ektron.com/manuals/CMS400/v76/adminmanual.pdf > “Managing Content “> “Working with Smart Forms” >

Using the Data Designer with eWebEditPro +XML.

Warning! You cannot use eWebEditPro+XML to edit Smart Formscreated with eWebEdit400.

Ektron CMS400.NET’s Smart Forms give you access to the power of XML by separating Web

content from presentation. In addition to hiding the XML tags from users, Ektron

CMS400.NET can serve content to various presentation devices (PDAs, mobile phones, etc.),

saving users from the tedium of creating duplicate content. Review and revision are drastically

reduced because the accuracy and format of your Web content are managed using XML schema

validation.

Using Smart Forms with Ektron CMS400.NET provides the following benefits:

n Strictly enforce content and page layout with Ektron's editor (Ektron eWebEditPro+XML),

XSLT, and WYSIWYG templates for content contributors

n Deliver content to multiple devices (e.g., PDAs, mobile phones, etc.)

n Easily share content across B2B transactions

n Advanced XML authoring: Ektron's highly-acclaimed XML editor, Ektron

eWebEditPro+XML, lets developers hide XML tags from content contributors and

provides an easy-to-use WYSIWYG editing interface

The following are examples of industries that can benefit from XML Indexing.

Industry Use XML indexing to find

Health Care A cardiologist whose practice is located in your city

HumanResources Sick time policy

RealEstate
A house with a zip code of 03031 priced under

$200,000

Hospitality A hotel in Boston

Online Retail Fleece gloves for men

Educational A course in .NET programming
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Smart Forms are used in Ektron CMS400.NET to define the necessary files to display, save,

and validate the content properly. This section explains how to take advantage of Ektron

CMS400.NET’s Smart Forms.

See Also:

n "Benefits of Using XML Data" on page 7-289

n "Before You Manage Smart Forms" on page 7-290

n "Adding a New Smart Form" on page 7-291

n "Assigning Smart Forms to a Folder" on page 7-376

n "Viewing Smart Forms" on page 7-378

n "Editing Smart Forms" on page 7-383

n "Creating Smart Forms Based on Existing Configurations" on page 7-385

n "Viewing Data Designer XSLTs" on page 7-386

n "Deleting Smart Form Configurations" on page 7-387

n "XML Indexing" on page 7-389=

Benefits of Using XML Data
This section explains why you should use XML as opposed to HTML content for your Web

site. Because of XML’s advantages, Ektron recommends using XML content whenever

possible. Below are several reasons why XML is the preferred format for managing content.

n Standardized format for capturing content

- You can create an XML Smart Form then require anyone creating content in a folder

to use the form. The result is more uniform and consistent information.

- Within an XML Smart Form, you can require authors to complete fields in a specified

format. So, for example, if you want the author to enter a date, XML can ensure that

it’s captured in a standard format. Several standard formats are provided (email

address, zip code), and you can create your own.

n Superior control over content display

- Authors contribute XML content but have virtually no control over its format. The

Web administrator determines the format through an XSLT file. By customizing the

XSLT, you can exert maximum control over your Web site’s appearance.

- Since one file controls several (even hundreds of) pages, you can update just that file

to efficiently change the look of all pages whose content is based on the Smart Form.

n Improved search capabilities

- Because XML data is captured in individual fields, you can focus a search on relevant

fields. For example, if your XML content captures data about books, you can place an
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author search on your Web site. Since that search only looks through content in the

Author field, it is much faster and returns more reliable results than a search of HTML

content.

Before You Manage Smart Forms
You must define each Smart Form that will be used in your Web site. Each form is assigned to

a content folder or content item and lets you specify how XML content appears in the editor, is

validated, and is displayed in an output device.

There are two ways to create a Smart Form.

n Using the WYSIWYG Data Designer

n Using external XML files

Note: You cannot use externalXML files if your editor is eWebEdit400.

This section explains how to create and manage Smart Forms using both methods.

The Smart Form Toolbar

During the process of creating and managing Smart Forms, several toolbar buttons are

available. The following table describes the buttons and their actions.

Button Name Description More Information

Add

Smart

Form

Create a new Smart Form from scratch or

based on properties of an existing one

"Adding a New Smart

Form" on page 7-291

Back Return to previous screen

Delete Delete a Smart Form

"Deleting Smart Form

Configurations" on page 7-

387

Edit
Edit a Smart Form created with external

files

"Editing Smart Forms" on

page 7-383

Edit

Data

Design

Edit a Smart Form created with the Data

Designer

"Editing Data Design

Packages" on page 7-383
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Button Name Description More Information

Save Save changes

View

XSLT
Display the XSLT for a Smart Form

"Viewing Data Designer

XSLTs" on page 7-386

Accessing Smart Forms

Note: Onlymembersof the Administratorsgroup or those defined inManageMembers for Role: Smart Forms

Admin screen can create or edit Smart Forms. See Also: "Defining Roles" on page 15-32

To access the Smart Form section of the Workarea, follow these steps.

1. In the Workarea, go to Settings > Configuration > Smart Form Configuration.

2. The View Smart Forms screen is displayed.

From here, you can view, add, edit, and delete Smart Forms.

See Also:

n "Working with Smart Forms" on page 7-288

n "Before You Manage Smart Forms" on page 7-290

Adding a New Smart Form
When adding a new Smart Form, you have two options. The following sections explain both.

n "Adding a Smart Form Using the Data Designer" on page 7-292 (recommended)

Adding a New Smart Form

ReferenceManual

Version 8.0 Rev 1.3
7-291



n "Adding a Smart Form Using External XML Files" on page 7-293 (for example, XSLTs,

schemas, etc.)

Note: To create a new Smart Form bycopying and editing an existing one, see "Creating Smart FormsBased on

Existing Configurations" on page 7-385.

Adding a Smart Form Using the Data Designer

To add a Smart Form using the WYSIWYG Data Designer, follow these steps.

1. In the Workarea, go to Settings > Configuration > Smart Form Configuration.

2. Click the Add Smart Form button ( ).

3. The Add Smart Form screen is displayed.

4. Enter a Title for the Smart Form.

5. Click the Save button ( ).

6. The Smart Form Data Designer screen appears.

Note: If your computer runsWindowsand your server’sweb.config file is set to use eWebEditPro+XML, Ektron

CMS400.NET checks to see if eWebEditPro+XML is installed on your computer. If it is not, you are prompted to

install it.

7. If eWebEditPro+XML is being installed, you may get the following error dialog.
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To learn about why the dialog is appearing and help decide whether to click Yes or No,

click the link More information about Local Machine Lockdown. A Windows Help

topic appears and explains your options.

8. Design your Smart Form configuration in the Data Designer.

See "Using eWebEdit400 to Create Smart Forms" on page 7-296 for information about

creating XSLTs using the Data Designer.

9. Click the Update button ( ).

You are ready to assign the Smart Form to a folder or content item. See "Assigning Smart

Forms to a Folder" on page 7-376 for more information.

Adding a Smart Form Using External XML Files

Warning! Release 7.5.2 and up of Ektron CMS400.NET supports two editors: eWebEditPro+XML and eWe-

bEdit400. If you want users to insert Smart Form information using eWebEdit400, you cannot create or edit Smart

Formsusing external files. Youmust create and edit them using Ektron CMS400.NET’sData Designer.

To add a Smart Form using external XML files, follow these steps.

1. In the Workarea, go to Settings > Configuration > Smart Form Configuration.

2. Click the Add Smart Form button ( ).

3. The Add Smart Form screen is displayed.

4. Enter a Title for the Smart Form.

5. Click the Save button ( ).

6. The Smart Form Data Designer screen is displayed.

7. Click the Back arrow ( ) to exit.

8. The View Smart Form screen for the new Smart Form is displayed.
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9. Click the Edit button ( ).

10. The Edit Smart Form screen is displayed.

11. Enter the necessary information using the following table as a reference.
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Smart Form Fields

Section Field Description

Generic

Information

Title Name given to Smart Form.

ID (display

only)
ID number assigned when configuration is created.

Description
Detailed description given to configuration by its creator or

last editor.

Editor

Information

Edit XSLT XSLT applied to content while being edited.

Save XSLT
XSLT used to transform the XMLwhen saved to the

database.

Advanced

Configuration

XML file that contains display information, schema validation,

and other advanced XML data.

Validation

Information

XMLSchema The .xsd file used to validate the XML content

Target

Namespace
The default namespace used for outgoing XML

DIsplay

Information

XSLT1 XSLT 1 applied to XML data when viewed on a device

XSLT2 XSLT 2 applied to XML data when viewed on a device

XSLT3 XSLT 3 applied to XML data when viewed on a device

XSLT

Packaged

XSLT package applied to XML data when viewed on a

device

Note: When a Smart Form is created using the Data Designer, a default XSLT is created based on the

configuration. To learn about modifying the packaged XSLT, see "Editing a Smart Form’sXSLT" on page 7-385.

12. Specify the default display XSLT for the configuration by clicking the corresponding

radio button.
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13. Click the Save button ( ).

XML File Verification

A verification button ( ) appears to the right of some fields on the Add Smart Form screen.
After you identify an XSLT or schema, you can click this button to verify that the file:

n exists in the location specified

n contains well-formed XML

Note: The XMLVerification feature doesnot validate the contents of the XML file.

The following table explains possible results when clicking the verification button.

Display Result Description

Verified The file passesall verification parameters

Not

Verified

The file either:

n Doesnot exist in the specified location

n Doesnot contain well-formed XML

Review current settings. Ensure the file is in the proper location, and

that it containswell-formed XML

Using eWebEdit400 to Create Smart
Forms
When you use the Data Designer, eWebEdit400 changes in the following ways.
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n An additional row of toolbar buttons (circled below) lets you add Data Designer fields to

the screen.

To edit the properties of any field on the screen, select the field, right click the mouse, and

select Field Properties.

n two buttons at the bottom of the screen let you switch between Design mode and Data

Entry mode. (For more information, see "Inserting a Field Type" on page 7-297.)

n Data Design mode - lets you insert and remove fields from the data entry screen

n Data Entry mode - simulates the screen’s appearance during data entry

Inserting a Field Type
eWebEdit400 provides several options that let you insert or edit fields in the editor. Each field

type is described below.

Field type Icon Description

For more

information,

see

Group Box
Groups related fields, which can be surrounded bya box

and have a caption

"Group Box " on

page 7-308
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Field type Icon Description

For more

information,

see

Tabular
Same asgroup box, but fields can be presented in a table

format

"Tabular Data "

on page 7-317

Text Free text field; user can format text using the editor
"Text Field " on

page 7-323

Choices

Several choicesappear on screen. User checksappropriate

boxes. All user choicesare inserted as valueswithin single

XML tag.

"Choices " on

page 7-327

Checkbox User’s response is either checked or unchecked
"Checkbox " on

page 7-322

Calculated Performscalculationsusing other fields on the screen
"Calculated Field "

on page 7-332

Calendar Lets user insert a date by clicking a calendar
"Calendar Field "

on page 7-341

ImageOnly Lets user insert an image
"ImageOnlyField

" on page 7-344

LinkField Lets user insert a link to a file, such asa PDF document
"File LinkField "

on page 7-346

Resource

Selector
Lets user place content or folders on a Smart Form.

"Resource

Selector Field " on

page 7-349

Field

Properties

Lets you change the properties of any field. Select the field

then click this button.

Note: This option is also available on the right clickmenu.

Validate

Ensure the screen contains valid XML.

This button is available in both data entry and data design

modes.
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Field type Icon Description

For more

information,

see

Display

internals of

Data Design

See "Viewing an InternalRepresentation of the Design" on

page 7-299

Validate Validatesdata when previewing data entry

Deleting a Field from the Screen
To remove a field from the screen, follow these steps.

1. Move the cursor to the field. The field’s background color changes.

2. Press <Ctrl>+<X> to remove the field.

Usually, the field label is not deleted when you delete a field. To delete the label, select it and

press <Ctrl>+<X>.

Previewing the Screen
If you want to view how the screen will appear to the person who will complete the screen,

click the View Data Entry button ( ). (See Also: "Inserting a Field Type" on page 7-297.)

Viewing an Internal Representation of the Design
Several toolbar buttons display an internal representation of the Data Design. The buttons are

described below.
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Button Description Example

The XML data

document

- <root>
- <Information>
<LastName />
<FirstName />
<MiddleName />
<Gender>male</Gender>
<Address />
<city />
<state>MA</state>
<Zip />
<SSN />
<BDate />
<HomeTel />
<WorkTel />
<x-ray />
- <Dental_Insurance>
<Field1 />
<OtherInsurance>N/A</OtherInsurance>
<Account_Number>N/A</Account_Number>
</Dental_Insurance>
<medication />
<lastAppointment />
<clincal />
</Information>
</root>

Defines the

structure, content,

and semantics of

an XML document

- <xs:schema elementFormDefault="qualified"

attributeFormDefault="unqualified"

xmlns:xs="http://www.w3.org/2001/XMLSchema">
- <xs:element name="root">
- <xs:complexType>
- <xs:sequence>
- <xs:element name="Information">
- <xs:complexType>
- <xs:sequence>
- <xs:element name="LastName">
- <xs:simpleType>
- <xs:restriction base="xs:string">
<xs:minLength

xmlns:xs="http://www.w3.org/2001/XMLSchema"

value="1" />
</xs:restriction>
</xs:simpleType>
</xs:element>
- <xs:element name="FirstName">
- <xs:simpleType>
- <xs:restriction base="xs:string">. .. ..
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Button Description Example

A list of all fields

and information

about them (as

XML)

<fieldlist>
<field name="LastName" datatype="string"

basetype="text"

xpath="/root/Information/LastName" title="Last

Name">Last Name</field>
<field name="FirstName" datatype="string"

basetype="text"

xpath="/root/Information/FirstName" title="First

Name">First Name</field>
<field name="MiddleName" datatype="string"

basetype="text"

xpath="/root/Information/MiddleName"

title="Middle Name">Middle Name</field>
<field name="Gender" datatype="choice"

basetype="text" xpath="/root/Information/Gender"

title="" datalist="IDAPK3KC">Gender</field> . ..

.. ..

Index

xpath information

for any indexed

field on the screen

<indexable>
<xpath

type="string">/root/Information/SSN</xpath>
<xpath

type="string">/root/Information/HomeTel</xpath>
<xpath>/root/Information/WorkTel</xpath>
</indexable>

The Data Design

document’s

presentation XSLT

<xsl:stylesheet version="1.0"

xmlns:xsl="http://www.w3.org/1999/XSL/Transform">
<xsl:output method="xml" version="1.0" omit-xml-

declaration="yes" indent="yes" encoding="utf-8"

/>
<xsl:strip-space elements="*" />
<xsl:variable name="ektdesignns_fieldlist"

select="/*/ektdesignpackage_list/fieldlist" />
- <xsl:template match="/" xml:space="preserve">
<p> </p>
- <fieldset id="Information" title="Demographic

Information">
<legend>Patient Information</legend>
- <div>
- <p>
<strong>Last Name</strong>
<xsl:text> </xsl:text>
<xsl:value-of

select="/root/Information/LastName" />
<strong>First Name</strong>
<xsl:text> </xsl:text>

<xsl:value-of

select="/root/Information/FirstName" /> .. .. ...

..
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Sample Screen Design
This section provides a brief overview of designing a screen, so that you can learn how the

pieces fit together. Let’s assume you want the screen to look like this.

Note: The following example helps you understand how to create a simple data entry screen. It doesnot explain

how to save a screen so that a user can enter data into it. When you are ready to create a screen, ask your system

administrator to help determine amethod for saving it andmaking it available to users for data entry.

To create such a screen, follow these steps.

1. Sign on to the eWebEdit400 Workarea as an administrator or a Smart Form administrator.

See Also: "Defining Roles" on page 15-32

2. Go to Settings > Configuration > Smart Form Configurations.

3. Click the Add button ( ).

4. Assign the form a title. For example, Sample Smart Form.

5. Click the Save button ( ).

6. The screen refreshes and the editor appears.

7. Reviewing the screen design (shown above), you notice that the fields are surrounded with

a box and a caption. To achieve this, click the Group Box button ( ). Then, complete
the dialog as shown below.
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Note: Later, each field on the dialog is documented. Since this section providesan overview, it doesnot delve into

those details.

At this point, the screen looks like this.
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8. The next field, Street, should let the user enter text. So, place the cursor into the Address

box and type Street.

9. Place the cursor to the right of Street and click the text field icon ( ).

10. Complete the dialog as shown below.

Now, the screen looks like this.
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11. The next field, City, should also let the user enter text. Assume that you want City to

appear in the line below Street. To make room for City, move the cursor to the end of the

Street field and press <Enter> to create a new line. Then type City.

12. Click the plain text field icon ( ) . Then, complete the dialog as shown below.

Now, the screen looks like this.
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13. The next field, State, should let the user choose from several states. Assume that you want

the state to appear to the right of City. Move the cursor to the end of the City field and

drag the Choices Field field icon ( ) into that space. Then, complete the dialog as
shown below.
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Now, the screen looks like this.
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The above example is very simple and does not use the Data Designer’s more powerful and

flexible features. To learn more about Data Designer, read the rest of this chapter.

Data Designer Field Types
To help you use all of the Data Designer’s capabilities, this section explains each field type

you can insert. They are very flexible and can accommodate all of your needs when designing

a data entry screen.

The Data Designer supports the following field types.

n "Group Box " on page 7-308

n "Tabular Data " on page 7-317

n "Checkbox " on page 7-322

n "Text Field " on page 7-323

n "Choices " on page 7-327

n "Calculated Field " on page 7-332

n "Calendar Field " on page 7-341

n "Image Only Field " on page 7-344

n "File Link Field " on page 7-346

n "Resource Selector Field " on page 7-349

Group Box
A Group Box field lets you group related fields together on a screen by surrounding them with

a box and optionally placing a caption above them.

After you insert a Group Box field, to insert other kinds of fields within the box, place the

cursor inside the box then select a field type button.

Note: The tabular data field typemight better accommodate your needs. See "Tabular Data " on page 7-317.

Advantages of Grouping Fields
One advantage of grouping fields is that you can allow the user in Data Entry mode to add

another instance of a group.
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For example, if a screen collects several fields of information about each telephone call, the

user could simply click the Insert Below button to insert a new group of fields, ready to

collect information about the next call.

Another advantage of grouping fields is that you can suppress a group of irrelevant fields. For

example, if a screen includes two groups of fields that collect information about hardcover and

paperback books, and you are adding information about a hardcover book, you can collapse

the paperback book questions because they are not relevant to your current task.

Use the eyeglass icon to expand or collapse the display of fields within a group.

Expanded Group Field with glasses icon highlighted

Collapsed Group Field

Dialog Box
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Fields on the Group Box Dialog

Field Description

Descriptive

Name

Enter the name of this field.

Internally, the name is used as the field’s caption.

The Name Field’s Default Value

Bydefault, the Data Designer assignsa namemade up of Field followed by the

next available number. So, the first field’s default name isField1, the second

field’s default name isField2, etc. You can change the default if you want.

Field Name Enter the field’s element name. This defines the field in the XML.

Use See "The Use Field" on page 7-369

Allow See "The Allow Field" on page 7-370

Appearance

ClickShow border and caption if you want to surround the fields in this group

with a box. You can also create a caption to appear in the top line of the box.

ClickNo border if you do not want to surround the fields in this group with a box.
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Field Description

Caption

If desired, enter text to describe this group of fields on the data entry screen. For

example:

After you insert this field onto the screen, you can use eWebEditPro+XML’s

formatting capabilities to modify its size, font, color, and other attributes.

Note: The Caption field only appears on this dialog when you create the Group

Box field. If you later try to edit the field, the Caption field is not on the dialog.

However, you can edit Caption text within the editor.

Advanced

Tab
See "Advanced Tab" on page 7-366.

Relevance See "Relevance Tab" on page 7-312.

Using a Tag Other Than <Root>
By default, Ektron CMS400.NET surrounds your Data Design with <root> tags. If you would

like to replace the <root> tags with another element name, follow these steps.

1. After creating a new Data Design screen, insert a Group Box as the first field.

2. In the Group Box Dialog’s Field Name field, enter the root text.

3. On the Group Box Dialog box, click the Advanced tab.

4. In the Root tag section of that screen, select Use this element as the Root tag and press

OK.
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5. Place all other screen elements within the Group Box field.

Relevance Tab
The Relevance tab allows a group of fields to appear or disappear according to the value of

other fields in the configuration. It appears on both the Group Box and Tabular Data Box

dialogs.

Here are some example uses.

n A group of questions about pregnancy that appears only if the patient is female.

n A list of states that appears only if the user selects United States as his country.

n A list of car manufacturers. When a user chooses one, all of its models appear in a second

list.

Fields that can be Used in Relevance Conditions

Only the following field types can be used in a Relevance condition.

n Check box

n Text

n Calculated

n Choices

Note: If using aChoices field, in the Appearance area of the dialog, you can only choose List Box or Drop

Box.Vertical List andHorizontal List are not supported.
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Applying Relevance to aGroupBoxField

To apply relevance to a Group Box field, follow these steps.

1. Edit a Smart Form configuration in Data Design mode to which you want to apply

Relevance.

2. If necessary, insert the field(s) on which the group box’s appearance will depend.

3. Insert a Group Box field. See Also: "Group Box " on page 7-308

Note: The location of the Group Box field is independent of the location of the fields to which you will apply

conditions.

4. Click the Group Box dialog’s Relevance tab (circled below).

5. The Relevance tab appears.

6. Scroll through the list of sample conditions to determine which one best fits your

situation.

7. Select a field from the lower half of the screen to replace the first variable (X or Y) in the

condition.
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For example, if the condition is A checkbox field is checked ({X} = 'true'), click the

check box field whose value must be true in order for this group to appear.

8. Click Replace {X} in Condition.

9. Notice that, in the Condition field, the variable was replaced by the selected field (see

example below).

10. If the condition has another variable, repeat Steps 7 and 8.

11. Press OK.

It is a good idea to try out Relevance by switching to Data Entry mode and testing.

Example of Applying Relevance to aGroupBoxField

Assume you want a list of states in the United States to appear only if a user selects United

States from the Country field.
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To accomplish this, follow these steps.

1. Create a Choices field and assign to it three values:

n United States

n Canada

n Other

See Also: "Choices " on page 7-327

2. Create a Group Box field and name it States.

3. With that Group Box field, create a new Choices field.

- Name it US States.

- In its List field, select U.S. States & Territories.

- In Allow Selection, check First item is not a valid selection

- In the Appearance field select Drop List.
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4. Place the cursor on the States Group Box field and click the Group Box toolbar button.

5. Click its Relevance tab.

6. Pull down the Examples list.

7. Click A field has a given value ({X} = 'value').

8. Scroll through the lower half of the screen until you see the country Choices field.

9. Click Replace '{X}' in Condition.

10. Notice that the Condition field now reads ../Country/Country = 'value'.

11. In the Condition field, replace Value with United States.
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Warning! The text that replacesValuemust exactlymatch the desired value of the selected field.

12. Click OK.

Tabular Data
The Tabular data button inserts a table into which you can place other types of fields. It’s

similar to a group box.

Tabular data’s main advantage over a group box is that it lets you place fields in columns (see

below).

Note: "Group Box " on page 7-308 describesmany features that also apply to tabular data. Read that section to

gain a full understanding of working with tabular data.

Creating a Table
First you insert the table. Then, you insert an appropriate type of field into each column. As

examples, in the table above, the Description field type would be plain text, while the In

Stock? field type would be choices.

If you insert a field into a table and its caption appears to the left of the data entry region (see

below), move the caption to the column header (see second illustration below).
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To access table commands (such as add row and add column), place the cursor inside a table

cell and right click the mouse.

Warning! Only table cells into which you place a field are available to visitors of your Web page.

Editing Tabular Data
To edit tabular data, hover the cursor over a table border line until you see a four-headed

arrow. Then, click the right mouse button and select Field Properties.

Note: You cannot reduce the number of columnsbyediting the Tabular Data dialog’sColumns field. To delete a

column, place the cursor in the column, right click themouse, and selectDelete Column.

How Tabular Data Forms XML Structure
Tabular data creates three levels of XML tags:

n inner level: each field in the table

n middle level: each row in the table

n outer level: the entire set of table data

To explain how this works, we’ll use the following contact list as an example.

Name Phone Email

John Doe 555-1212 john.doe@example.com

MarySmith 555-8765 msmith@example.net

How XMLTags are Assigned to Field Names

When you insert a field into a table, a dialog helps you define the field type. For example,

when inserting a plain text field, the Plain Text Field dialog appears. On that dialog, the value

of the Phone field defines the tags that enclose that field’s contents.
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To continue our example, every contact is represented in XML as:

<Name>John Doe</Name>
<Phone>555-1212</Phone>

<Email>john.doe@example.com</Email>

and

<Name>Mary Smith</Name>
<Phone>555-8765</Phone>

<Email>msmith@example.net</Email>

How XMLTags are Assigned to Table Rows

Each row of the table collects information for one contact. On the Tabular Data Box dialog,

the Row Name field defines the XML tag that groups information for each contact. For

example, the Row Name field value is Contac

</AddressBook>
<contact>
<Name>John Doe</Name>
<Phone>555-1212</Phone>
<Email>john.doe@example.com</Email>
</Contact>
<Contact>
<Name>John Doe</Name>
<Phone>555-1212</Phone>
<Email>john.doe@example.com</Email>
 </Contact>
Contact>
<Name>Mary Smith</Name>
<Phone>555-8765</Phone>
<Email>msmith@example.net</Email>
</Contact>

</AddressBook>

Dialog Box
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Fields on the Tabular Data Dialog

Field Description

Descriptive

Name

Enter the name of this table.

The Name Field’s Default Value

Bydefault, the Data Designer assignsa namemade up of Field followed by the next available

number. So, the first field’s default name isField1, the second field’s default name isField2,

etc. You can change the default if you want.

Field

Name

Enter the table’s element name. Thiswill define the table in the XML. See Also: "How Tabular

Data FormsXMLStructure" on page 7-318

Tool Tip

Text
Enter the text that appearswhen a user hovers the cursor over the table’s column headers.

Use See "The Use Field" on page 7-369
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Field Description

Allow

See "The Allow Field" on page 7-370

Note: If you checkMore than one here, you are allowing the user to insert an entirely new

table, not an additional table row.

Rows

Row

display

name

Enter the text that appearswhen a user hovers the cursor over the table’s cells. Use this field to

describe the kind of information to be inserted into the table’s cells.

Row name
Enter the name of the XML tag used to collect data for each entry in the table.

See Also: "How Tabular Data FormsXMLStructure" on page 7-318

Minimum

number

If desired, enter theminimum number of rows for this table.

If you enter a number and the data entry user tries to save the screen without inserting at least

theminimum number of rows, he is informed thatElement content is incomplete

according to the DTD/Schema.

Bydefault, the user is allowed to cancel or save the screen anyway. However, the system

administrator determineswhether or not the user can save an invalid document.

Maximum

number

If desired, enter themaximum number of rows for this table. If you don’t want to assign a

maximum number, check theUnlimited checkbox.

Result of Assigning a Maximum

When this table appears on a data entry screen, and a user adds themaximum number of

rows, the Insert Above and Insert Belowoptionsare grayed out on themenu (see example

below).

Columns
Enter the number of columns to appear in the table.

See Also: "Editing Tabular Data" on page 7-318

Caption

If desired, enter text to describe this table on the data entry screen. The caption appears

centered above the table.

After you insert this field onto the screen, you can use eWebEditPro+XML’s formatting

capabilities to modify the caption’s size, font, color, and other attributes.

Advanced

Tab
See "Advanced Tab" on page 7-366
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Field Description

Relevance See "Relevance Tab" on page 7-312

Checkbox
A Checkbox field is only one character wide and accepts one of two possible values: checked

or unchecked. For example

Dialog Box

Fields on the Checkbox Dialog

Field Description

Descriptive

Name

Enter text to guide the user’s response to this field. To continue the above

example, the caption would beCheck if you are over 65.

After you insert this field onto the screen, the Descriptive Name appears to the

right of the checkbox. You can use eWebEditPro+XML’s formatting capabilities to
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Field Description

modify its size, font, color, and other attributes.

Note: The Descriptive Name field only appears on this dialog when you create the

CheckBox field. If you later try to edit the field, it is not on the dialog. However, you

can edit the Descriptive Name text within the editor.

Indexed

Check if you want to index this field. See Also: "XML Indexing" on page 7-389

The Indexed field maynot appear, depending on how your administrator set up

your system.

Field

Name
Enter the field’s element name. Thiswill define the field in the XML.

Tool Tip

Text

Enter text that appearswhen a user hovers the cursor over this field (circled in red

below).

Default

value

If you want this field to be checked when the screen first appears, clickTrue.

Otherwise, clickFalse.

Validation

tab

You can use this screen to specify that the checkboxmust be checked or

unchecked.

Advanced

tab
See "Advanced Tab" on page 7-366

Text Field
Use a text field when you want the user to enter a text response.

Note: If a plain text field tries to perform a numerical calculation with a value that is blankor contains letters, NaN

appears in the field. (NaN stands for “not a number.”) If a plain text field tries to divide by zero, Infinityappears.

Note: If a plain text field collects a URL, add on-screen instructions to prefix it with http:\\. If the user doesnot,

the URL address is not stored properly.

The following capabilities are available with a text field.

n The text can be read-only or hidden

n You can only allow plain text, or let the Smart Form author format the text

n You can specify that the text field consists of a single or multiple lines
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Dialog Box

Fields on the Text Field Dialog

Field Description

Descriptive

Name
Enter the name of the field.

Indexed

Check if you want to index this field. For more information, see "XML Indexing" on page 7-389.

The Indexed field mayor maynot appear, depending on how your administrator set up your

system.

Field

Name
Enter the field’s element name. This defines the field in the XML.

Tool Tip

Text
Enter the text that appearswhen a user hovers the cursor over this field.

Default

Value

If you want to set a default value for this field, enter that value here. The default value appears in

Data Entrymode, where the user can accept, change, or delete it.
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Field Description

For example, if this field collects a city, andmost users enter New York, enter New Yorkas the

value.

Use See "The Use Field" on page 7-369

Allow See "The Allow Field" on page 7-370

Allow Rich

Formatting

Check this box if you want to let the Smart Form author format the text in this field. If you do not

check the box, the author can only enter plain text.

Allow

Multiple

Lines

Checkhere to let this text boxexpand to accommodate the user’s input.

If you do not check this box, a single line input boxappears on the data entry screen to accept

user input.

Cannot be

Changed

Checkhere tomake this field read-only. That is, the user cannot insert data into it in Data Entry

mode.

Youmight use this option to provide instructions for completing the screen.

Invisible

Checkhere tomake this field hidden in Data Entrymode.

This option lets you store unseen information in an XML document. An examplemight be

putting a version number for the data design so that XML documents can be upgraded to

newer versionsusing an XSL transform.
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Field Description

Validation

Select the kind of validation to apply to this field. Your choicesare:

n No validation - the user’s response is not checked

n Cannot be blank - the user must enter a response

n Non-negative whole number or blank - the user must enter a positive whole number

or no response

n Non-negative whole number (required) - the user must enter a positive whole

number

n Decimal number or blank - must be a decimal number (for example, 12.345 or 12) or

blank. A leadingminus sign “-” is allowed. The decimal point must be a period (.), even in locales

that normally use a comma (,).

Note: Decimal numbers include whole numbers because the decimal point is implied. That is,

12 is 12.0000.

n Decimal number required - must be a decimal number (it cannot be

blank) of none, one, or two decimal places.

A leadingminus sign “-” is allowed. The decimal point must be period (.), even in locales that nor-

mally use a comma (,).

n Percent: (0-100) required - the user must enter a whole number from 0 to

100

n email address/email address required - a user name followed by an at

sign (@) followed by a domain name

n email address list/email address list required - several email addresses separated

bya semicolon (;)

n Zip code (US only) - the user’s responsemust consist of 5 (nnnnn) or 9 digits separated

bya dash after the fifth (nnnnn-nnnn)

n Social Security number (US only) - the user’s responsemust consist of nine digits in

this pattern: nnn-nn-nnnn

n Postal Code (Canada)/Postal Code (Canada) required - the user’s responsemust

consist of six characters in the format ANA NAN, where A is an alphabetical character and N is a

numeric.

n Social Insurance Number (Canada)/Social Insurance Number (Canada)

required - nine digits See Also: http://en.wikipedia.org/wiki/Social_Insurance_

Number
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Field Description

Validation

(continued

from

above)

n ISBN code - 13 digit ISBN code. See Also: http://isbn-information.com/13-

digit-isbn.html

n ISSN code - See Also: http://www.issn.org/2-22635-What-is-an-ISSN.php

n Custom - You can create custom validation.

For more information, see "CustomValidation" on page 7-371.

If you assign to this field any value other thanNo validation, the field is initially surrounded by

red dashes in Data Entrymode. If the user’s response doesnot meet the validation criterion,

the field remains surrounded by red dashes. The system administrator determineswhether or

not the user can save an invalid document.

Data Style See "The Data Style Field" on page 7-370

Advanced See "Advanced Tab" on page 7-366

Choices
Use the Choices field when you want to give the data entry user several options. For example,

you create a Choices field named Interests that lists these options.

n music

n art

n sports

The data entry user could check the first two and leave the third blank.

Flexibility of the Choices Field
The following capabilities are available with a Choices field.

n You can limit a user’s response to one item, or allow more than one.

n You can require a response.

n You can determine the list’s appearance from these choices.
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List

type
Example Description

vertical All choicesappear, arranged vertically.

horizontal All choicesappear, arranged horizontally.

list box
All itemsappear. The default one is selected when the

screen first appears, but can be changed.

drop list

Only the top item on the list appears. To its right, a down

arrow appears (circled). The user clicks the arrow to display

all itemsand select one.

n You can choose from a standard list of choices or create your own list.

See Also: "Creating Your Own Predefined List" on page 7-331

Using a Standard List

To use a standard list, click the black down arrow next to the List field to see your options.

If you choose a standard list, it appears in the lower half of the screen. You cannot change its

values.

Creating a Custom List

To create your own set of list options, accept the List field’s default value, Custom. Then, enter

the list values using the Item List section of the screen, shown below.
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To indicate an option is the default choice, check the Selected checkbox.

In the Display Text field, enter text to describe this item on the data entry screen. After you

insert this field onto the screen, you can format it. For example, you can apply bold, assign a

style, etc.

In the Value field, enter the value that is collected when the data entry user selects this item.

For example, if Interests appears in the Name field, and you want music to be collected when

the data entry user selects this item and saves the page, enter music here.

To add a new choice, delete an existing choice, or move a choice up or down within the list,

click the menu icon ( ) to the left of that choice. The select a menu option.

Dialog Box
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Fields on the Choices Dialog

Field Description

Descriptive

Name
Enter the name of the field.

Indexed

Check if you want to index this field. For more information, see "XML Indexing"

on page 7-389

The Indexed field mayor maynot appear, depending on how your

administrator set up your system.

Field Name Enter the field’s element name. This defines the field in the XML.

Tool Tip

Text
Enter the text that appearswhen a user hovers the cursor over this choice list.
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Field Description

List
See "You can choose from a standard list of choicesor create your own list." on

page 7-328

Allow

selection

ClickMore than one to let the data entry user select more than one item on the

data entry screen. Otherwise, clickOnly one.

For example, if you clickMore than one, and the choicesare: music, art, sports,

the user could select all three choices.

A selection is required - Check this box if the user must select at

least one list item.

First item is not a valid selection - Check here if the first item on

the list is not a valid value but instead text that prompts the user

to respond to the field. An example of such text for a list of states

is Select a state.

If you check this boxand the user selects the first value on the list (most likely by

default), an error message appearswhen he tries to save the screen.

Appearance
See "You can determine the list’s appearance from these choices." on page 7-

327

Item List See "Creating a Custom List" on page 7-328

Value

Enter the value that is collected when the data entry user selects this item.

For example, if Interests appears in the Name field, and you want music to be

collected when the data entry user selects this item and saves the page, enter

music here.

Data Style See "The Data Style Field" on page 7-370

Advanced See "Advanced Tab" on page 7-366

Creating Your Own Predefined List
An administrator can create a predefined list of options to appear when a user is inserting a

Choices Field.

Advantage of Creating Custom List in Configuration File

Although a user can create a custom list of choices via the Item List area of the Choices Field

dialog, that list is only available in that field of that screen. If the user wants to insert the same

list in another section of the screen or a different screen, he must re-enter all options.

However, if you create a list according to the steps below, your custom list is stored in the

configuration file (along with the standard choice lists, such as Countries). As a result, any

user connected to your server can insert the list into any Choices Field on any screen.
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Creating the List

To insert a custom list of choices, follow these steps.

1. Open the eWebEdit400 configuration file, site

root/workarea/contentdesigner/DataListSpec.xml.

2. Insert the new list following the pattern of the other lists in the file. Below is an example

of such a list.
<datalist name="MyNewList">
<schema datatype="string" />
<item default= "true" value= "Green" />
<item value= "Red" />
<item value= "Blue" />
</datalist>

Notes:

n you can specify a data type. Values are string, nonNegativeInteger, date, decimal.

n as shown in the third line above, you can specify a default value

Creating aDynamically PopulatedChoice List

You specify the elements of the custom options list described above in the configuration data.

You can also create a dynamically-populated list from any XML source. The source can be on

your server or on a remote Web site. Follow these steps to add a dynamic data list to the

Choices field.

1. Follow steps 1 through 3 in "Creating the List" on page 7-331.

2. Insert a new datalist item according to this pattern.

<datalist name="MyNewList" src="{url to xml data source}" select="{xpath to data item ele-

ment}" captionxpath="{relative xpath to data item's display text}" valuexpath="{relative xpath

to data item's value}">

Warning! The datalistnamemust match the listchoicedataattribute.'

For example

<datalist name="USPS-CA" src="[eWebEditProPath]/uspsca.xsd" select="/xsd:-

schema/xsd:simpleType/xsd:restriction/xsd:enumeration" cap-

tionxpath="xsd:annotation/xsd:documentation" valuexpath="@value"

namespaces="xmlns:xsd='http://www.w3.org/2001/XMLSchema'" validation="select-req">

In this example, the data list is stored in the uspsca.xsd file, located within the ewebeditpro

folder. However, it could be in any XML data source.

Calculated Field
Use a calculated field to perform a calculation based on values in other fields. For example, if

your screen collects mortgage information, you could create one field to collect the mortgage
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and interest payment and another to collect taxes and insurance. The calculated field could

sum those two numbers and display the monthly payment.

You can validate a calculated field. For example, you can require a positive number between

100 and 1,000.

Calculated fields are display only -- users cannot edit them.

Warning! If a field will be referenced in a calculation, use the validation feature to require a value for that field. This

forces the user to enter a number to be used in the calculation.

Dialog Box

Fields on the Calculated Field Dialog

Field Description

Descriptive Enter the name of the field.
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Field Description

Name

Indexed

Check if you want to index this field. For more information, see "XML Indexing" on page 7-389.

The Indexed field mayor maynot appear, depending on how your administrator has set up

your system.

Field

Name
Enter the field’s element name. This defines the field in the XML.

Tool Tip

Text
Enter the text that appearswhen a user hovers the cursor over this field.

Formula
Enter the calculation that this field will perform. See Also: "Using the Formula Field" on page 7-

334

Select

Field

Click this button to select a field to reference in the calculation. For more information, see "Using

the Formula Field" on page 7-334.

Examples

Click the down arrow to the right of this field to see examplesof calculations you can perform.

When you select an example, it is copied into the Formula field.

See Also: "Explanation of Examples" on page 7-336

Validation

Select the kind of validation to apply to this field. Your choicesare:

n No validation - the user’s response is not checked

n Non-negative number (required) - the result of the calculationmust be a positive

number

If you assign to this field any value other thanNo validation, the field is surrounded by red

dashes in Data Entrymode. If the user’s response doesnot meet the validation criteria, the field

remains surrounded by red dashes. Your system administrator determines if a user can save a

screen with invalid data.

Error

message

If you selectNon-negative number above, insert text that appears on the screen if the user’s

response doesnot meet this criterion.

Custom

Validation
See "CustomValidation" on page 7-371

Data Style See "The Data Style Field" on page 7-370

Advanced See "Advanced Tab" on page 7-366

Content

7-334
ReferenceManual

Version 8.0 Rev 1.3



Using the Formula Field
You can copy a sample calculation into the Formula field by clicking the Examples field and

selecting an operation from the drop down list. For example, if you click Examples Add two

numbers {X}+{Y}, {X}+{Y} appears in this field.

Next, replace the variables with fields on the screen. Be sure to select the curly brackets ({}) as

well as the letter between them. Then, when the user enters data into those fields, the

calculation is performed using the current field values.

If a calculated field tries to perform a numerical calculation with a value that is blank or

contains letters, NaN appears in the field. (NaN stands for “not a number.”)

If a calculated field tries to divide by zero, Infinity appears.

Warning! If the user doesnot replace all variableswith a field or a number, when the content is validated, val-

idation will fail.

To do this, follow these steps.

1. Select the first variable to replace. To continue the example, select {X}.

2. Select a field to replace that variable in the calculation.
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3. Click Replace X in Formula.

Warning! If a variable appearsmore than once in a formula (for example, {X} * number( {X} &lt;= {Y} )

+ {Y} * number( {X} &gt; {Y}), you only need to replace the first occurrence - eWebEdit400 replaces sub-

sequent occurrences for you.

4. Continue replacing all variables in the formula.

Notes

n If an XML document contains several occurrences of a field that is referenced in a formula,

the value is derived as follows:

- When using the XPath functions sum() and count(), all values with the field name are

considered. For example, a document includes three books whose prices are $10, $20

and $30. In this case, sum’s value is $60.

- When using all other functions, the first value is used. For example, a document

includes three books whose prices are $10, $20 and $30. If a calculation formula refers

to <price>, its value is $10.

n You can replace a variable with a number instead of a field. For example, replace {X} *

{Y} with ../price * 1.15.

n The expression can be complex, such as (round(Field1 * 0.80) + (1 div Field2)) - 2.

n You can use a string expression that creates a text message. For example, to calculate a full

name from its parts: concat( title, ' ', givenname, ' ', familyname), which could

produce “Dr. Jonathan Smythe”.

Referencing Other Calculated Fields
A calculated field can only reference other calculated fields that appear before it in a

document. For example, a document collects a series of numbers.

n One calculated field counts the number of numbers.
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n Another totals their values.

n A third computes the average by dividing the total by the count.

In this example, you must place the third field below or to the right of the first two fields.

Calculated fields that are defined later in a document do not appear in the Select Field or

Group dialog.

Explanation of Examples
The following table explains the standard examples that appear in the Examples drop-down

list of the Calculated Field dialog. Note that your system administrator can customize the list,

so it may not match what is below.

Example

Field Text
Example Field Formula Description

Add two

numbers
{X} + {Y}

Add the value in the first field

(X) to the value in the second

field (Y).

Subtract two

numbers
{X} - {Y}

Subtract the value in the

second field (Y) from the value

in the first field (X).

Multiply two

numbers
{X} * {Y}

Multiply the value in the first

field (X) by the value in the

second field (Y).

Divide two

numbers
format-number({X} div {Y},'0.###')

Divide the value in the first field

(X) by the value in the second

field (Y).

Format asa

percentage
format-number({X} div {Y},'#0%')

Determine what percentage

one number (X) is of another

(Y).

For example, if {X}=10 and

{Y}=100, the result of the

calculation is 10%.

Absolute

value of a

number

{X} * (number({X} &gt; 0)*2-1)
The number regardlessof the

sign (negative or positive).

Minimum of

two numbers
{X} * number({X} &lt;= {Y}) + {Y} * number({X} &gt; {Y}) The smaller of two field values.
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Example

Field Text
Example Field Formula Description

Maximum of

two numbers
{X} * number({X} &gt;= {Y}) + {Y} * number({X} &lt; {Y}) The larger of two field values.

Zero if

subtraction is

negative

({X} - {Y}) * number(({X} - {Y}) &gt; 0)

Subtract one number (Y) from

another (X). If the difference is

less than zero, insert zero.

Multiply by

another

number if

checkbox is

checked

{X} * ( {Y} * number( {Z} ='true') +

number( {Z} !='true'))

X is a numeric field.

Y is another numeric field to

multiply byX if a checkbox is

checked.

Z is the checkbox.

For example, {X}=2 and {Y}=3

n if the checkbox is

checked, the result is 2 * 3,

which is 6

n If the checkbox is not

checked, the result is 2

Round a

decimal

number

round({X})

Rounds the number to the

nearest integer. For example,

round(3.14). The result is

3.

Round up a

decimal

number

ceiling({X})

Returns the smallest integer

that is greater than the

number. For example,

ceiling(3.14). The result is

4.

For negative numbers:

ceiling(-3.14) = -3

Round down

a decimal

number

floor({X})

Returns the largest integer

that is not greater than the

number argument. . For

example, floor(3.14). The

result is 3.

For negative numbers:

floor(-3.14) = -4

Format

decimal

number 0.00

format-number({X},'0.00')

Roundsa value either up or

down to the hundredth place.

Asexamples, 100 becomes

100.00, and 3.14159265

becomes3.14.
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Example

Field Text
Example Field Formula Description

Total numeric

values from

multiple fields

sum({X}[text()] | {Y}[text()] | {Z}[text()]))

Add the values in all

referenced fields.

Only elements that contain a

value are summed. Empty

elements are excluded.

Total a list of

numeric

values

sum({X}[text()])

Total all values in a single

repeating field. Here’s an

example.

Plain Text Field properties

Name:Miles

Allow: more than one

Validation: non-negative whole

number

XMLData

<root>

<Miles>89</Miles>

<Miles>12</Miles>

<Miles>23</Miles>

<Miles>19</Miles>

</root>

sum(Miles) equals

89+12+23+19=143

Only elements that contain a

value are summed. Empty

elements are excluded.
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Example

Field Text
Example Field Formula Description

Average a list

of numeric

values

format-number(sum({X}[text()])

div count({X}),'0.###')

Calculate the average of all

values in a single repeating

field.

To continue the example from

the Total a list of numeric

values field (above):

Plain Text Field properties

Name:Miles

Allow: more than one

Validation: non-negative whole

number

XMLData

<root>

<Miles>89</Miles>

<Miles>12</Miles>

<Miles>23</Miles>

<Miles>19</Miles>

</root>

Average=89+12+23+19=143

divided by the number of

values (4)= 35.75

Only elements that contain a

value are summed. Empty

elements are excluded.

Count the

number of

values in a list

count({X})

Calculate the number of values

in a single repeating field.

To continue the example from

the Total a list of numeric

values field (above):

Plain Text Field properties

Name:Miles

Allow: more than one

Validation: non-negative whole

number

XMLData

<root>

<Miles>89</Miles>

<Miles>12</Miles>

<Miles>23</Miles>

<Miles>19</Miles>

</root>

Count = 4
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Example

Field Text
Example Field Formula Description

Lowercase

text

translate({X},'ABCDEFGHIJKLMNOPQRSTUVWXYZ',

'abcdefghijklmnopqrstuvwxyz')

Replace all uppercase

characterswith the lowercase

version of that character

Uppercase

text

translate({X},'abcdefghijklmnopqrstuvwxyz',

'ABCDEFGHIJKLMNOPQRSTUVWXYZ')

Replace all lowercase

characterswith the uppercase

version of that character

Remove

extra spaces
normalize-space({X})

Remove extra space

characters from content\

Concatenate

text
concat({X}, ', ', {Y})

Link text strings together into a

single string. For example,

concat('The',' ','XML')

yieldsThe XML.

Size of a text

string
string-length({X})

Count the number of

characters in a selected field’s

value. For example, if the

referenced field’s value is

Hello, string-length = 5.

Calendar Field
Insert a calendar field when you want the Smart Form author to enter a date. The user clicks a

date from an interactive calendar.
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Because users cannot enter digits, a standard date format is ensured. The date is stored as a

standard XML date (in the format yyyy-mm-dd), and localized to the computer of the user

viewing it.

Dialog Box

Fields on the Calendar Field Dialog

Field Description

Descriptive

Name
Enter the name of the field.

Indexed

Check if you want to index this field. For more information, see "XML Indexing" on page 7-389

The Indexed field mayor maynot appear, depending on how your administrator has set up

your system.

Field

Name
Enter the field’s element name. This defines the field in the XML.

Tool Tip

Text
Enter the text that appearswhen a user hovers the cursor over this field.
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Field Description

Default

value

If you want this screen to have a default date when the user first sees it, click the calendar icon to

the right and select a date. The user can change the date in Data Entrymode.

Note: If you enter a default date, you cannot later remove it. You can change it. If necessary,

you can delete the field and enter a new one.

Use See "The Use Field" on page 7-369

Allow

See "The Allow Field" on page 7-370

Warning! Warning! Do not insert a calendar field into a Smart Form that allowsmultiple

entries (using theAllow more than One option on the dialog). If you do, you cannot search

the Smart Form using that field.

Validation
If you want to require the user using the calendar to enter a response, click the down arrow to

the right of this response field and selectCannot be blank.

Error

Message

If you selectCannot be blank above, insert text that appears on the screen if the user’s

response doesnot meet this criterion.

Custom

Validation
See "CustomValidation with a Calendar Field" on page 7-343

Data Style See "The Data Style Field" on page 7-370

Advanced See "Advanced Tab" on page 7-366

Custom Validation with a Calendar Field
The Calendar Field dialog features a Custom Validation area (illustrated below).
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The Custom Validation area can ensure the user’s input is greater or less than the date you are

inserting on the Data Design screen.

n The Data Type field shows Date.

n The Condition field displays the validation logic.

n The Examples drop-down list shows validation expressions that you can apply to the

field.

n Any Error Message displays in Data Entry mode when the user inserts an invalid value.

Your system administrator determines if a user can save the invalid data.

n The Select a Field to Insert area displays fields that can be inserted into the Condition

field. You must choose a calendar type field (note the calendar to the left of these fields).

Example of Creating Custom Validation
As an example of custom validation, assume a field collects the date when a patient’s health

insurance policy expires. You want to make sure the date is later than today. To accomplish

this, follow these steps.

1. Create a calendar field that prompts for today’s date.

2. Create another calendar field that prompts for a patient’s health insurance policy expiration

date.

3. While creating the second field, in the Validation section, click Custom Validation.

4. The Custom validation screen appears.

5. Click the down arrow to the right of the Examples field to see sample logic.

6. Click Date After (not(. >={X}). This option lets you specify that the user’s response must

be later than a specified date.

7. In the Condition field, select {X} and click the Select Field button.

8. The Select Field or Group screen appears.

9. Select the field that prompts for today’s date, which you created in Step 1.

10. That field replaces {X} in the Condition field.

11. Move the cursor to the Error Message field and compose an error message. For example:

Must be after today.

12. Your screen should look like this.
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13. Press OK.

14. Press OK to save that dialog and test the validation on the date field. To do this, switch to

Data Entry mode and enter a date earlier than today to verify that validation works as

expected.

Image Only Field
Use an Image Only field to place an icon on the screen, which the user in Data Entry mode

can click to insert an image into the Web content. You can insert a default image if desired.

To let the user insert any file, such as a Microsoft Word document, use a File Link field. See

Also: "File Link Field " on page 7-346

Using an Image Only Field in Data Entry Mode
In Data Entry mode, the image’s caption appears, followed by a default image (if you specify

one) and this icon: .

Note: The user can only insert a file whose extension is defined within the <validext>element of the

configdataentry.xml file. Your system administrator can help you do this.

Dialog Box
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Fields on the Image Only Dialog

Field Description

Descriptive

Name
Enter the name of the field.

Indexed

Check if you want to index this field. For more information, see "XML Indexing" on page 7-389.

The Indexed field mayor maynot appear, depending on how your administrator has set up

your system.

Field Name Enter the field’s element name. This defines the field in the XML.

Tool Tip

Text
Enter the text that appearswhen a user hovers the cursor over this field.

Use See "The Use Field" on page 7-369

Allow See "The Allow Field" on page 7-370

Value
Whether the value is an element or plain text.

Value is an element renders the field as<img src=”url” alt=”text” /> for an image.
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Field Description

Value is plain text renders the field as just the url.

Default

Image

Location

If desired, you can insert a default image, whichmight be themost common image or simply a

reminder that an image needs to be inserted.

To help find the image, click the From File button and navigate to image file.

You can only insert an image file whose extension appears between the <validext> tags in

the configdatadesign.xml file. For example:

<validext>gif,jpg,png,jpeg,jpe,doc,txt

</validext>

Cannot be

blank

If you want to require the user completing this field to enter a response, click inside this check

box.

Description
Enter the image’s alt text, which is used asa replacement for an image whenever it cannot be

seen. For example, a visually impaired person is using a screen reader.

Advanced See "Advanced Tab" on page 7-366

File Link Field
Use a File Link field to place an icon on the screen which the user in Data Entry mode can use

to link to any Library file, such as a Microsoft Word document or a .gif image file. (You can

also use an Image Only field to let the user insert an image. See Also: "Image Only Field " on

page 7-344)

The File Link field does not let you link to Ektron CMS400.NET assets.

Using a File Link Field in Data Entry Mode

In Data Entry mode, the file link field’s caption appears, followed by this icon: . When
the user clicks the icon, this screen prompts the user to specify a information about the link.

Note: The user can only insert a file whose extension is defined within the <validext>element of the

configdataentry.xml file. Your system administrator can help you do this.
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Dialog Box
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Fields on the File Link Field Dialog

Field Description

Descriptive

Name
Enter the name of the field.

Indexed

Check if you want to index this field. For more information, see "XML Indexing" on page 7-389

The indexed field mayor maynot appear, depending on how your administrator has set up

your system.

Field

Name
Enter the field’s element name. This defines the field in the XML.

Tool Tip

Text
Enter the text that appearswhen a user hovers the cursor over this field.

Use See "The Use Field" on page 7-369

Allow See "The Allow Field" on page 7-370

Value

Whether the value is an element or plain text.

Value is an element renders the field as<img src=”url” alt=”text” /> for an image.

Value is plain text renders the field as just the url.

Default

Location

If desired, you can insert a default link, which can be themost common link or simply an

example.

To help find the link, click theSelect button and navigate to a file. You can only insert a file

whose extension appears between the <validext>element of the configdatadesign.xml file.

For example:

<validext>gif,jpg,png,jpeg,jpe,pdf,doc

</validext>

Cannot be

blank
If you want to require the user completing this field to enter a response, click this checkbox.

Description If desired, enter text that the user can click to access the linked file.

Target

Frame

n NewWindow(_blank) - In a new browser window, on top of the current browser.

n SameWindow(_self) - In the same position within the browser window. The new window

replaces the current one.

n ParentWindow(_parent) - If your page contains frames, in the frame that contains the

framewith the hyperlink.

n Browser Window(_top) - If your page contains frames, in the full display area, replacing

Data Designer Field Types

ReferenceManual

Version 8.0 Rev 1.3
7-349



Field Description

the frames.

Data Style See "The Data Style Field" on page 7-370

Advanced See "Advanced Tab" on page 7-366

Resource Selector Field
A Resource Selector field lets you place elements of Ektron CMS400.NET content or folders

on a Smart Form. For example, on the page below, all content in a selected folder appears.

Each content item in the folder is represented as a hyperlink followed by its summary. A site

visitor can click the hyperlink to view the content.

An alternative display of the content, showing hyperlinks only, appears below.
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So, a Resource Selector field acts like server controls that let you place content on your Web

pages, such as the content block and List Summary controls. The advantages of the Resource

Selector field are

n you can add content or folders to a Smart Form. This means you can easily position

resources then surround them with text, images, etc., to place them into proper context.

n the management is handled within the Workarea. This means CMS administrators and

content contributors can create the Smart Form without needing a developer to

create/modify templates and server controls.

Resource Selector Examples
You could use Resource Selector fields to create a KB article that provides links to other,

related KB articles.

Another benefit of using a Resource Selector is the ability to do single sourcing, that is, reuse

the same content on different pages. This is helpful for content that needs to appear repeatedly

(copyright information, license agreement, contact information, etc.), but you want to maintain

only one version.

Overview of Using a Resource Selector

Note: Before reading this section, you should be familiar with the processof creating Smart Forms. See Also:

"Adding a New Smart Form" on page 7-291

When creating an XML Smart Form that uses a Resource Selector, you follow these steps. You

would follow most of the steps with any Smart Form.
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Step

1. An XMLSmart FormDesigner createsa Smart Form con-

figuration.

2. While editing the Data Design, he placesResource Selector

fields on the configuration, along with other field types.

3. While placing a Resource Selector field, a dialog lets the

designer determine its properties.

For example, can the content author select content or folders?

These properties are described in "Adding a Resource Selector

Field" on page 7-353.

4. An administrator assigns the Smart Form configuration to

Ektron CMS400.NET folders.

See Also: "Assigning Smart Forms to a Folder" on page 7-376
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Step

5. An author createsa Smart Form based on the configuration.

6. He adds content or folders to the Smart Form, along with other

field types.

7. A site visitor browses to the page and views the content.

Adding a Resource Selector Field
To add a Resource Selector field to a Smart Form configuration, click the button shown below.
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When you do, the following dialog appears.

Complete the first three fields as described below.

Field Description

Descriptive

Name

Enter the name of this field.

Internally, the name is used as the field’s caption.

The Name Field’s Default Value

Bydefault, the Data Designer assignsa namemade up of Field followed by the next available

number. So, the first field’s default name isField1, the second field’s default name isField2,

etc. You can change the default if you want.

Field

Name
Enter the field’s element name. This defines the field in the XML.

Tool Tip

Text
Enter the text that appearswhen a user hovers the cursor over the table’s column headers.
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Next, you must decide if this resource selector field will let the content author insert content or

a folder. The following sections walk through both options.

n "Letting a Content Author Add Content" on page 7-355

n "Letting a Content Author Add a Folder" on page 7-361

Letting a Content Author Add Content
To add a Resource Selector field that lets an author add content to a Smart Form, follow these

steps.

Prerequisites: You completed the first three fields on the Resource Selector Field dialog. See

Also: "Adding a Resource Selector Field" on page 7-353

1. On the Resource Selector Field dialog, at the Resource Type dropdown, select Content

Resource.

2. The Default Value field lets you define a default content item. If you do, when a content

author places this field on a Smart Form, he sees the default content (as shown below).

The author can accept the default or change it.
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To specify a default content item, click the folder icon next to Default Value. The Select

Content dialog appears (shown below).

Use the Folder, Taxonomy, or Search tab to identify the default content. See Also:

"Taxonomy" on page 9-200, "The Search Published Tab" on page 9-87

Note: When browsing by folder, you only see content folders. You do not see eCommerce catalog, Blog,

Community, or Discussion Board folders.

3. Use the Allow section of the dialog to define a minimum and maximum number of content

items that can be placed on the screen where you are inserting this Resource Selector.

These settings affect the content author’s work with this field on a Smart Form in the

following way. Assume you set a Minimum of 1 and a Maximum of 2. After the content
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author adds two content items for this resource selector, his only options (shown below)

are to remove or rearrange fields -- he cannot add more.

4. Click the Type tab of the Resource Selector Field dialog.

All content types that a content author may add appear. Uncheck types that you do not

want to let a content author add. See Also: "Types of Content" on page 2-3

5. Click the Configuration tab. This tab lets you determine how a content author can select

content for the Smart Form.

If you check all three options (as shown above), when a content author clicks this Resource

Selector, he sees the following dialog.
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Note that the dialog lets the author browse the folder structure, taxonomy structure, or use

search to select content.

Note: When browsing by folder, you only see content folders. You do not see eCommerce catalog, Blog,

Community, or Discussion Board folders.

On the other hand, if you unchecked Browsing taxonomy categories and Searching for key

words, the content author could only use the Folder tab to select content.

6. Click the Appearance tab. This tab lets you determine the default appearance of this Smart

Form on your Web site.
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Note: Unlike other settingson this dialog, the content author is not involved in theAppearance settings.

The table below provides a sample of each Appearance option.

Appearance option How content appears onWeb site

Content

Content Title
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Appearance option How content appears onWeb site

Title followed by content

Quick Link
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Appearance option How content appears onWeb site

Quicklinkwith Summary

7. Save the dialog and configuration.

8. To learn how a content author works with this configuration, see "How a Content Author

Adds Resource Selector Field" on page 7-365.

Letting a Content Author Add a Folder
To add a Resource Selector field that lets an author add folders to a Smart Form, follow these

steps.

Prerequisites: You completed the first three fields on the Resource Selector Field dialog. See

Also: "Adding a Resource Selector Field" on page 7-353

1. On the Resource Selector Field dialog, at the Resource Type dropdown, select Folder

Resource.

2. The Default Value field lets you define a default folder. If you do, when a content author

places this field on a Smart Form, he sees the default folder (as shown below).
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The author can accept the default or change it.

To specify a default folder, click the folder icon next to Default Value. The Select Folder

dialog appears (shown below).

Use it to select the default folder.

Note: When browsing by folder, you only see content folders. You do not see eCommerce catalog, Blog,

Community, or Discussion Board folders.

3. Use the Allow section of the dialog to define a minimum and maximum number of folder

that can be placed on the screen where you are inserting this Resource Selector.
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These settings affect the content author’s work with this field on a Smart Form in the

following way. Assume you set a Minimum of 1 and a Maximum of 2. After the content

author adds two folders for this resource selector, his only options (shown below) are to

remove or rearrange fields -- he cannot add more.

4. Click the Configuration tab. This tab lets you determine the starting folder for this

resource.
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You can browse the folder structure to pick a starting folder. You can also determine if the

content author will have access to

n all folders in the folder structure

n this folder and all of its subfolders

n this folder only

Note: When browsing by folder, you only see content folders. You do not see eCommerce catalog, Blog,

Community, or Discussion Board folders.

5. Click the Appearance tab. This tab lets you determine the default appearance of this Smart

Form on your Web site.

Note: Unlike other settingson this dialog, the content author is not involved in theAppearance settings.

The table below provides a sample of each Appearance option.
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Appearance

option
How folder appears onWeb site

List Quicklinks and

summaryof folder

contents

All content in folder appears in format shown above.

List Quicklinks of folder

contents

All content in folder appears in format shown above.

Breadcrumb

The folder’s breadcrumb path appears, as defined on the folder Properties screen’s

Breadcrumb tab. See Also: "Creating SiteMap Breadcrumbs" on page 9-278

6. Save the dialog and configuration.

7. To learn how a content author works with this configuration, see "How a Content Author

Adds Resource Selector Field" on page 7-365.

How a Content Author Adds Resource Selector Field
When a content author creates a Smart Form whose configuration uses Resource Selector fields,

they appear as shown below.
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In the above example above, the top field lets the content author select content (id 30 is the

default), and the lower one lets him select a folder (id 20 is the default).

To select either one, he clicks the folder to its right, then uses the dialog to make the selection.

If working with content, the tabs which appear on the dialog are determined when the resource

is placed on the Smart Form configuration. See Also: "Click the Configuration tab. This tab lets

you determine how a content author can select content for the Smart Form." on page 7-357

Fields that Appear on Several Dialogs

Advanced Tab
The Advanced tab screen lets you control the XML that the field produces.
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This dialog has two sections.

n Type - lets you generate XML microformats. See Also: "The Type Area of the Advanced

Tab" on page 7-367

n Root Tag - lets you replace the <root> tag with another element name. See Also: "Using a

Tag Other Than <Root>" on page 7-311

The Type Area of the Advanced Tab

The dialog lets you generate XML microformats made up of standard XHTML tags and

attributes that contain a specific structure and values. The types are described below.

Warning! In order for Smart Form fields to searchable, theymust be stored aselements not attributes. See Also:

"Advanced Tab" on page 7-366 If you are upgrading to version 8.0, inspect your Smart Formsand change field

properties asneeded so theyare stored aselements not attributes.

Type This field defines Example

Element
A unique tag. The user’s response to the field becomes its

value.
<Lastname>Rogers</Lastname>
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Type This field defines Example

Attribute

An attribute of the containing field. The containing field is

typically a Group Box.

If you insert anAttribute field type, the Field Name field on the

dialog box is grayed out. The field name and type can only be

edited on the Advanced Field properties screen.

<PtInformation

Lastname="Rogers">

</PtInformation>

Content

The content of the containing field, typically a Group Box.

Note that, in this case, field name is not used. Asa result, the

Field Name field is grayed out. The field name and type can

only be edited on the Advanced Field properties screen.

Sincemost fields define their own content, this option is typically

used to define a value to a Group Box that contains other fields

defined asattributes.

Warning! Only one Content type field is valid within a con-

taining field.

<PtInformation>

Rogers

</PtInformation>

SampleMicroformat

For example, the microformat of an event looks like this.

<span class="event">
<a class= "url" href="https://www.lisa.org/events/2006nyc/package_

registration.html?from=fn1206 ">LISA Global Strategies Summit</a>

</span>

The Data Entry view looks like this.

The Data Design view looks like this.
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Additional Notes about the Type Area of the Advanced Tab

n If the element is a group box or table, its type must be Element because it surrounds other

elements.

n If the element is a Rich Area field, its type must be Element or Content.

The Use Field

Click May not be removed if this field must be included on the screen. Otherwise, click May

be removed.

If you check May be removed, when this field appears on a data entry screen, an icon

( **) appears to the left of the field.

If the user clicks the icon, a dropdown menu provides an option to remove the field, as shown

below.

If the user removes the field, field name replaces the field on the data entry screen to

indicate that the field was removed and can be re-added if necessary.
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For example, if the field’s display name is street address, and the user removes the field,

appears in place of the field.

Note: Themenu icon ( ) can also indicate that the user can add instancesof a field (see the Allow field, below).
So, if a field is required, the icon could appear but omit aRemove option.

The Allow Field

Check more than one if you want to let the user entering data add instances of this field.

Otherwise, check only one.

Warning! Do not insert a calendar field into a Smart Form that allowsmultiple entries (using theAllow more

than One option on the dialog). If you do, you cannot search the Smart Form using that field.

For example, if a screen is collecting names and addresses and you want to let the user enter

several of them, check more than one.

If you check more than one, when this field appears in Data Entry mode, appears to the
left of the field, as shown below.

If the user entering data clicks , a menu appears (shown above), which lets the user click
Duplicate to add instances of the field to the screen.

Note: Themenu icon ( ) can also indicate that the user can remove a field (see the Use field, above). So, even if
a field allowsonly one instance, the icon could appear but themenuwould only displayRemove.

The Data Style Field
Click the Data Style button to apply formatting to the field that accepts user input. When you

do, the following dialog appears.
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Use the dialog to assign the following formatting attributes to a user response field.

n Font style and size

n Bold and italic

n Text alignment (especially helpful for formatting dollar amounts in a plain text field)

n Underline or strikethrough

n Font color and background color

Note: The configuration data controls a command's appearance on the toolbar and on the Data Style dialog. For

example, if <button command="cmdfontname" /> is removed from configdatadesign.xml, it disappears from the

toolbar and the Data Style dialog.

Below is an example of a response field whose font, size, alignment, background, and

foreground colors were modified via this dialog.

Custom Validation
The Plain Text and Calculation field dialogs feature a Validation tab (illustrated below).
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Adding Standard Validation Options
By default, the Data Designer provides several standard validation options. You can see them

by clicking the down arrow to the right of the Validation dropdown.

For a description of standard validation options, see "Validation" on page 7-326.
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If you will frequently use a validation format that does not appear on the list, the following

Ektron KB article provides instructions for creating additional validation options.

http://dev.ektron.com/kb_article.aspx?id=7420

Creating Custom Validation Criteria
If the standard validation options do not provide the flexibility you need, use the custom

validation feature to ensure the following about the user’s input.

n The data type - the default types are

- text

- URL

- whole number

- decimal number

- floating point number (Floating point includes scientific notation, so is appropriate for

scientific numbers. Decimals usually suffice for business numbers.)

Note: Your system administrator maycustomize the choices.

n The field value has one of the following relationships with another field, a number, or an

expression - the default expressions are

- between two values (either another field or a number that you specify)

- less than

- equal to

- not equal to

- maximum length (usually for text responses)

Note: Your system administrator maycustomize the choices.

If the user’s response fails to meet the criteria, you can compose an error message that appears

when that happens. Your system administrator determines if a user can save the invalid data.

When the Custom Validation button is clicked, the Custom Validation dialog appears.
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n The Data Type field is the value’s basic type, for example, text number or URL.

n The Condition field displays the validation logic.

n The Examples drop-down list shows validation expressions that the data design creator

can apply to the field.

n Any Error Message displays in Data Entry mode when the user inserts an invalid value.

n This dialog displays fields that can be inserted into the Condition field. Some field types,

like the RichArea field, are not listed. See Also: "Referencing Other Calculated Fields" on

page 7-336

Example of Creating Custom Validation
As an example of custom validation, assume that a field collects telephone numbers, and you

want to make sure the user enters 10 digits. To accomplish this, follow these steps.

1. Click the Plain Text Field dialog and complete the screen.

2. In the validation section, click Custom Validation. The Custom validation screen appears.

3. In the Data Type field, select Whole Number from the drop down list. This ensures that

the user can only enter digits.
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4. Click the down arrow to the right of the Examples field to see sample logic.

5. Click Maximum text length... . This option lets you specify the length of the user’s

response.

6. string-length(.) <= {X} appears in the Condition field.

7. Since you want the user’s input to equal 10, remove the less than sign (<) from the

calculation. Now it looks like this: string-length(.) = {X}.

8. Replace the {X} with 10. Now, it looks like this: string-length(.) = 10.

9. Move the cursor to the Error Message field and compose a relevant error message. For

example: must be 10 digits.

10. Your screen should look like this.
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11. Press OK and return to the Plain Text field dialog.

12. Press OK to save that dialog and test the validation on the phone number field. To do this,

switch to Data Entry mode and enter more or fewer than 10 digits, as well as non-digit

characters to verify that validation works as expected.

Assigning Smart Forms to a Folder
When creating new content in a folder, the New menu provides a list of Smart Forms that you

can use to create new XML content. (See graphic below.)
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This section explains how to determine the list of Smart Forms available when creating

content.

Inheritance and Smart Forms

A folder’s Smart Forms can be inherited from the parent folder, or you can break inheritance

and assign a unique group of Smart Forms. Use the Inherit Parent Configuration checkbox to

retain or break inheritance.

Assigning Smart Forms to a Folder

If you break inheritance, you then select the Smart Forms that can be assigned to content in the

folder using the Smart Forms dropdown list (shown below).

You can preview any Smart Form by clicking the Preview button ( ). To add any Smart
Form, select it from the dropdown list and click Add.

To remove a Smart Form, click Remove.

Requiring Smart Forms

You can require a Smart Form to be the only type of content that can be added within a folder.

To enable this, click the Require Smart Forms check box on the Smart Forms tab.
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If you do, the user can only choose enabled Smart Forms when viewing that folder’s New

menu -- all other content types are suppressed.

Viewing Smart Forms
To view a Smart Form, follow these steps.

1. In the folder tree on the left side of the Workarea, go to Settings > Configuration > Smart

Form Configuration.

2. Click the form you want to view.

The View Smart Forms screen appears with a more detailed description of the configuration.
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Smart Form Created with Data Designer

Smart Form Created with External Files

The View Smart Form screen has three tabs.

n "Properties Tab" on page 7-380

n "Display Information Tab" on page 7-382

n "Preview Tab" on page 7-382
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Each tab is explained below.

After viewing, you can perform the following actions on the Smart Form.

Button Name Description More Information

Edit Edit a Smart Form
"Editing Smart Forms" on

page 7-383

Edit

Data

Design

Open Data Designer
"Editing Data Design

Packages" on page 7-383

Add

Smart

Form

Create a new Smart Form from

scratch or based on an existing one

"Viewing Smart Forms" on

page 7-378

View

XSLT
Display a Smart Form’sXSLT

"Viewing Data Designer

XSLTs" on page 7-386

Delete Delete a Smart Form

"Deleting Smart Form

Configurations" on page 7-

387

Back Return to previous screen

Properties Tab

Field Description

Title Name given to Smart Form.

ID
ID number assigned byEktron CMS400.NET upon creation of

the configuration.

Description
Detailed description of configuration given by creator or last

editor.

If the Smart Form was created using external XML files (instead of the Data Designer), the

following information also appears:

n "Editor Information" on page 7-381
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n "Validation Information" on page 7-381

Editor Information

Note: This section only appears if you do not use the Data Designer to create your Smart Form.

The editor information contains the file names of the XSLTs used when editing and adding

content in the editor.

Field Description

Edit XSLT

XSLT applied to the content when being edited.

Note: If no edit XSLT is specified, the Edit Data Design option

is enabled in the toolbar.

Save XSLT
XSLT used to transform the XML created in the editor when

the Smart Form is saved to the database.

Advanced

Configuration

XML file that contains display information, schema validation,

and other advanced XML data.

Validation Information

Note: This section only appears if you do not use the Data Designer to create your Smart Form.

You can validate the content created and edited with Ektron CMS400.NET with a schema if

desired. The validation information contains information about the schema.

Field Description

XMLSchema
Specify the .xsd file used to validate the XML content that the

Smart Formwill be assigned to.

Target

Namespace
Specify the default namespace used for outgoing XML.
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Preview Tab

The Preview tab displays the XSLT applied to the editor when XML content is created. This is

the XSLT that was created for the Smart Form.

Display Information Tab

The display information tab lists the XSLTs that are used when displaying XML in the

respective environment.

Field Description

XSLT1 DisplayXSLT 1

XSLT2 DisplayXSLT 2

XSLT3 DisplayXSLT 3

XSLT Package
DisplayXSLT Package (created

using the Data Designer)
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Note: When a Smart Form is created using the Data Designer, a default displayXSLT is also created which looks

similar to the edit XSLT created in the editor. This default XSLT can be applied to the XML content.

The asterisk (*) denotes the default XSLT for the Smart Form.

The tab also displays the Smart Form’s xpaths.

Editing Smart Forms
After creating a Smart Form, you can modify it when files defined in the configuration have

changed. Since there are two ways to create a Smart Form, there are two ways to edit one. See

Also: "Editing Data Design Packages" on page 7-383, "Editing a Smart Form Created with

External Files" on page 7-384

This section also explains how to customize the Smart Form’s XSLT. See Also: "Editing a

Smart Form’s XSLT" on page 7-385

n "Editing Data Design Packages" on page 7-383

n "Editing a Smart Form Created with External Files" on page 7-384

Editing Data Design Packages

After you create a Smart Form, you can modify it.

Before You Edit the Data Package!
Before editing a Smart Form data package, it is important to understand the effects of the

modifications. If an XML data package is edited, all content to which the configuration is

applied is updated. Information that was originally created may be lost, depending on the

changes you make to the package.

To ensure that information is not lost, use the Create New Smart Form Based on Existing Smart

Form option on the view Smart Form screen. See "Creating Smart Forms Based on Existing

Configurations" on page 7-385 for more information.

Editing a Data Design Package
To edit a data design package, follow these steps.

1. In the Workarea, go to Settings > Configuration > Smart Form Configuration.

2. Click the Smart Form configuration you want to edit.
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3. The View Smart Form screen appears with a more detailed description of the configuration.

4. Click the Data Design Mode button ( ) at the top of the screen.

5. The Edit Data Design Package screen displays the current package.

6. Make the necessary changes to the Data Design package in the editor. See "Using

eWebEdit400 to Create Smart Forms" on page 7-296 for information about creating XSLTs

using the Data Designer.

7. Click the Update button ( ).

Editing a Smart Form Created with External Files

Warning! Release 7.5.2 and up of Ektron CMS400.NET supports two editors: eWebEditPro+XML and eWe-

bEdit400. If you want users to insert Smart From information using eWebEdit400, you cannot create or edit Smart

Formsusing external files. Youmust create and edit them using Ektron CMS400.NET’sData Designer.

1. In the Workarea, go to Settings > Configuration > Smart Form Configuration.

2. Click the Smart Form configuration you want to edit.

3. The View Smart Form screen is displayed.

4. Click the Edit button ( ).

5. The Edit Smart Form screen is displayed.

6. Edit the necessary fields to update the Smart Form. See "Smart Form Fields" on page 7-295.

7. Click the Update button ( ).

Now, all content and folders that use the Smart Form take their properties from the updated

configuration.

See Also: "XML File Verification" on page 7-296
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Editing a Smart Form’s XSLT

Every Smart Form has a packaged XSLT, which is a default XSLT created from the

configuration’s display information. If you want to modify the Smart Form’s appearance,

follow these steps.

1. Go to Settings > Configuration > Smart Form Configurations.

2. Click the Smart Form configuration whose XSLT you want to customize.

3. Click the View XSLT button ( ).

4. Select and copy the XSLT.

5. Paste it into an XSLT editor.

6. Customize the file.

7. Save it with an .xslt extension to your site root/xmlfiles folder.

8. Return to the Smart Form configuration you selected in Step 2.

9. Click the Edit button ( ).

10. In the XSLT1 field, enter the Xslt you saved in Step 5.

11. Click the radio button next to XSLT1.

12. Click Save ( ).

You can edit the custom XSLT at any time. The changes immediately affect the appearance of

the Smart Form on your Web site. So, the XSLT is quite different from other aspects of the

Smart Form configuration, which generally cannot be edited for existing content.

Creating Smart Forms Based on
Existing Configurations
Whenever major changes must be made to a Smart Form, Ektron recommends making a copy of

it and modifying the copy. In this way, you do not affect the content controlled by the original

configuration.

To create a new Smart Form based on an existing one, follow these steps.

1. In the Workarea, go to Settings > Configuration > Smart Form Configuration.

2. Click the Smart Form configuration you want to view.

3. The View Smart Form screen appears with a more detailed description of the

configuration.

4. Click the Create New Smart Form button ( ).

5. The Add Smart Form screen is displayed.
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6. Enter a Title for the new Smart Form.

7. Click the Add Smart Form button ( ).

8. The View Smart Form screen for the new Smart Form is displayed. From here, you can

perform the necessary actions on it.

Viewing Data Designer XSLTs
When a Smart Form is created using the Data Designer, an XSLT is produced to assist you

with creating your display XSLT. This XSLT includes the structure for your XML documents.

If a display XSLT is not applied to a Smart Form, content is displayed using the default XSLT

displayed in the View XSLT screen.

To view the XSLT for a Smart Form, follow these steps.

1. In the folder tree on the left side of the Workarea, go to Settings > Configuration > Smart

Form Configuration.

2. Click the Smart Form configuration whose XSLT you want to view.

Note: The XSLT only appears if the Smart Formwascreated using the Data Designer.

3. The View Smart Form screen appears with a more detailed description of the configuration.

4. Click the View XSLT button ( ).
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5. The View XSLT screen is displayed.

You can use this information to create your display XSLT.

Deleting Smart Form Configurations
You can delete Smart Form configurations that are no longer needed. To do so, follow these

steps.

Note: If anySmart Form that uses this configuration hasone or more indexed fields, youmust delete all content

that uses the configuration before you can delete it. See Also: "SpecifyingWhich XMLElementsare Indexed" on

page 7-391

1. In the Workarea, go to Settings > Configuration > Smart Form Configuration.

2. Click the Smart Form configuration you want to delete.

3. The View Smart Form screen is displayed.

4. Click the Delete button ( ).

5. A confirmation message is displayed.
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6. Click OK.
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XML Indexing
XML Indexing lets site visitors search XML information collected via Smart Forms and view

the results. The results appear as a list of topic titles, optionally followed by the content

summary.

The Data Designer lets you choose which XML fields to index. You can also validate those

fields to be numbers, dates, Boolean, or string values. After you identify fields to be indexed, a

search dialog is created. Where appropriate, the dialog automatically populates drop down lists

from the indexed data.

Note: As the name implies, XML indexing is only available for information collected on XMLSmart Forms. It

cannot find information in XHTML content.

See Also:

n "User vs. Developer Selected Search Criteria" on page 7-389

n "Types of Search Criteria" on page 7-390

n "Setting up a User-Defined Search" on page 7-391

n "Setting up a Developer-Defined Search" on page 7-391

n "Specifying Which XML Elements are Indexed" on page 7-391

n "Search Dialog Setup" on page 7-393

n "IndexSearch Server Control" on page 7-394

n If you are upgrading from an earlier version of Ektron CMS400.NET to 7.5 or higher, the

Knowledge Base article “INFO: 7.5 Upgrade: Changes to 7.5 XML Index Search” lists

upgrade considerations.

User vs. Developer Selected Search
Criteria
There are two ways that XML Indexing can make XML content available to your site visitors.

n Present a screen of search criteria. A site visitor uses the screen to select the kind of

information he is looking for. For example, your site sells outdoor clothing, and a user

searches for wool hats under $20.00.

n Determine the search and display criteria programmatically using a custom function.

Your Web developer inserts a control that specifies search and display criteria. For

example, your site sells books. A site visitor sees a navigation link Find books under
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$5.00. When he clicks that link, the control searches your XML content and returns all

books whose price is less than $5.00.

Note: The EktronWindowsServicemanages the background processing that createsXML indexes. See Also:

"EktronWindowsService" on page 19-13.

Note: Ektron CMS400.NET content hasaContent Searchable checkbox, which is checked bydefault. It must

be checked if you want the IndexSearch to find Smart Form content. See Also: "The Content Searchable Field" on

page 9-23

Types of Search Criteria
XML Indexing allows multi-dimensional searches on all types of XML data.

Data Type XML Index Search can

Plain text Use an exact phrase, or anyword or letter in a phrase

Numerical and date

information

Use expressions such asgreater than, less than, or between two

values

List and choice fields
Display the field valuesand let the user select relevant ones.

Note: Choices field values can consist of single letter.

ImageOnly Use the altor srcattribute value

Link Use the text or hrefattribute value

For every search field, NoSelection is a value. If this is chosen, the search disregards that field

when compiling results. However, the user must select a value (or range of values) in at least

one field to get results.

Warning! Do not insert a calendar field into a Smart Form that allowsmultiple entries (using theAllow more

than One option on the dialog). If you do, you cannot search the Smart Form using that field.

Warning! In order for Smart Form fields to searchable, theymust be stored aselements not attributes. If you are

upgrading to version 7.5 or higher, inspect your Smart Formsand change field properties asneeded so theyare

stored aselements not attributes.
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Setting up a User-Defined Search
To create a user-defined search, follow these steps.

Step Formore information, see

1. Select a Smart Form
"Accessing Smart Forms" on page 7-

291

2. Assign indexing to each field to be searched
"SpecifyingWhich XMLElements are

Indexed" on page 7-391

3. Set up the search screen
"Search Dialog Setup" on page 7-

393

4. Have your Web developer set up a page that

displaysa search control and a results control

"IndexSearch Server Control" on

page 7-394

Setting up a Developer-Defined
Search
To set up a developer-defined search, which defines both the criteria and the results page, use

the SearchParmXML property of IndexSearch Server Control. For more information, see

"IndexSearch Server Control" on page 7-394.

Specifying Which XML Elements are
Indexed
You can index the following types of fields:

n Checkbox

n Plain Text
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n Choices

n List

n Calculated

n Image Only

n Link

n Calendar

Warning! Do not insert a calendar field into a Smart Form that allowsmultiple entries (using theAllow more

than One option on the dialog). If you do, you cannot search the Smart Form using that field.

To enable indexing for any field on an XML Smart Form configuration, follow these steps.

1. In the Ektron CMS400.NET Workarea, go to Settings > Configuration > Smart Form

Configuration.

2. Select a Smart Form configuration that you want to index. See Also: "Accessing Smart

Forms" on page 7-291

3. Open its Data Design.

4. Move the cursor to the first field you want to index.

5. Right mouse click the field.

6. Choose Field Properties.

7. A dialog box appears.

8. Check Indexed.

9. Repeat these steps for every field by which you want site visitors to search the Smart

Form.

Validation

Validation ensures that the user completing an XML form enters the right type of data. You

can decide if the user’s input should be a number, boolean, date, string, zip code, etc. If you do

not specify type attributes using validation data, the field is a string.

Validation is especially important when users search XML data, because it helps the search

find the correct information. For example, if a field collects a zip code but you set its type to

plain text, a user completing the form can insert anything into the field. If the user inserts the

Content

7-392
ReferenceManual

Version 8.0 Rev 1.3



letter “o” instead of the number zero (0), the field accepts that input but the search will not

find that record. On the other hand, if you set validation to zip code, the user can only insert

five or nine digits -- any other entry is rejected.

Search Dialog Setup
When you save a Data Design form, a dialog appears that lets you view all and modify

indexed fields (illustrated below).

The information on this screen is explained below.

Screen

section
Description

Xpath The xpath to each indexed field.

Label The index field’s field name, asdefined on its dialog.

Multiple

Check this box if you want to allow the user performing the search to select more

than one value. This checkboxonly appearswith List and Choice fields.

Note: To select more than one value on the search screen, the user holds down the

<Ctrl> keywhile selecting additional options.
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IndexSearch Server Control
Use the IndexSearch server control to display a Smart Form’s search screen on any Web form.

The control lets a site visitor search Smart Form content and displays the results.

Note: The xmlConfigIDproperty identifies the Smart Form that appearson the page on which you are placing

this server control.

See Also: "XML Indexing" on page 7-389

Below is a sample screen that the IndexSearch server control can generate.

Alternatively, you can predefine a search and have the results appear on a Web form via the

SearchParmXML property. See Also: "SearchParmXML Property" on page 7-400

In addition, you can run an XML search programmatically. See "Using the IndexSearch Server

Control Programmatically Example" on page 7-402 and "Programmatically Predefined General

Search Results Replaced By Specific Search Results" on page 7-405.

This section contains the following topics:

n "IndexSearch Server Control Properties" on page 7-395

n "SearchParmXML Property" on page 7-400

n "Using the IndexSearch Server Control Programmatically Example" on page 7-402

n "Programmatically Predefined General Search Results Replaced By Specific Search Results"

on page 7-405

n "Turn Off Caching In Mozilla Firefox" on page 7-407

n "Setting Page Size for Smart Form Search Results" on page 7-407
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IndexSearch Server Control Properties
The IndexSearch server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description Data Type & Values

Authenticated

Indicates if you are logged in to CMSExplorer

and can use it to browse to the folder needed for

the FolderID property. See Also: "Using CMS

Explorer to Browse Your Ektron CMS400.NET

Site" on page 21-9

String

ButtonImgSrc
If you want to display an image on the submit

button, enter the server path to it.
String

ButtonText Text that appears on the submit button.
String

The default is:Search

ContentParameter

Checks the QueryString for the content block ID

value and replaces the search with content when

ID is specified. Leave blank to alwaysdisplay the

search.

String

None - Use Default

ID - The server control uses

the content blockpassed as

a URL parameter.

CustomOrderBy

Provide the XPATH of an indexed field to order

search results by that field. For example, if your

XPATH is /root/Event/Location/city, resultswill be

sorted by city. Results can be ascending or

descending based on OrderByDirection. If you

enter an invalid XPATH, resultswill be ordered by

rank. If you specifyCustomOrderByand

OrderBy, the OrderByproperty is ignored.

String
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Property Description Data Type & Values

DisplayXslt

Determineshow search results display on the

page

Warning! : If you specify an external file, it is

strongly recommended that you do not store this

file in your site'sWorkarea folder. If you store

this file in theWorkarea folder, the file will be lost

when you upgrade.

String

None - databind only

ecmNavigation - lists the

title of every content block in

the folder

See Also: "Example of

ecmNavigation Display" on

page 9-124

ecmTeaser - lists the title of

every content block in the

folder plus the content

summary

See Also: "Example of

ecmTeaser Display" on

page 9-124

Path to Custom Xslt -

Enter the path to an Xslt that

determines the display of the

page

EmptyResultMsg

The resource file string that appears if the search

returnsno hits.

To learn about editing the resource file, see

"Procedure for TranslatingWorkarea Strings" on

page 14-41.

String

The default value is:

Your search did not

match any documents.

EncodeContentHtml
Determines if HTML content is encoded when

returned

Boolean

True =Content HTML is

encoded

False =Content HTML is

not encoded

FolderId

The numeric id of the folder that you want to

search. See Also: "Using CMSExplorer to

Browse Your Ektron CMS400.NET Site" on page

21-9

The Recursiveproperty determineswhether

the search includes this folder’s child folders.

Long

Any folder’s numeric ID.

0 (zero) is the root folder.

Hide

Use to hide output of the index search in design

time and run time. For example, you want to pass

the results to code behind for further

manipulation.

Boolean

True =Hide results

False = show results
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Property Description Data Type & Values

Labelafter

Labelbefore

LabelBetween

LabelContains

LabeldateBetween

LabelEqual

LabelExactPhrase

LabelGreaterThan

Labelinputdate

Labelinputnumber

LabelLessThan

Labelon

LabelSelect

All properties let you change their label names.

This is useful for multi-language issues.

For example, if you have a French site, change

Equal toÉgale.

Note: These labels do not change based on the

Languageproperty’s setting. For example,

setting the Languageproperty to 1036 doesnot

change these labels to French.

String

Examplesof what the user

seeson the site in French

and English.

Language

Set a language for viewing index search results.

This property shows results in design-time (in

VisualStudio) and at run-time (in a browser).

Integer
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Property Description Data Type & Values

LinkTarget
Use to define a link’s behavior

when clicked.

ItemLinkTargets

_blank - Causes the link to

alwaysbe loaded in a new

blankwindow. Thiswindow

is not named.

_self - Causes the link to

always load in the same

window the anchor was

clicked in. This is useful for

overriding a globally

assigned base target.

_parent - Causes the link to

load in the immediate

frameset parent of the

document. This defaults to

acting like “_self” if the

document hasno parent.

_top - Causes the link to

load in the full bodyof the

window. This defaults to

acting like “_self” if the

document is alreadyat the

top. Useful for breaking out

of an arbitrarily deep frame

nesting.

MaxResults
Themaximum number of content blocks

returned (0=unlimited)
Integer
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Property Description Data Type & Values

OrderBy

The search results’ sort criterion. For example, to

sort results by last modified date, chooseDate

Modified.

Use the OrderByDirectionproperty to

determine the direction of the sort.

String

n Title - The content

block title

n ID - The content ID

number

n Date Created - The

date the content blockwas

created

n Date Modified - The

date the content blockwas

last modified

n AuthorLName - The

last author’s last name

n AuthorFname - The

last author’s first name

n StartDate - TheGoL-

ive Date

OrderByDirection
The sort direction of the search results. This

propertyworkswith the OrderByproperty.

String

Ascending

Descending

Recursive

Determineswhether the search uses the

selected folder’s child folders. The folder is

selected at the FolderIDproperty.

Boolean

True

False

SearchParmXML

Opensa new window that lets you predefine a

search. For example, you want mystery books

from a AcmePublishing published in the current

year to appear on aWeb page.

To access the window click the graybutton.

For more information, see "SearchParmXML

Property" on page 7-400

ShowSearchBoxAlways
If set to false, the search boxdoesnot appear on

PostBack.

Boolean

True

False

SuppressWrapperTags
Suppresses the output of the span/div tags

around the control. The default isFalse.

Boolean

True - Suppresswrap tags.

False - Allow wrap tags.
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Property Description Data Type & Values

Weighted

Bydefault, this property is false, whichmeans

the search only finds content that matchesall

search criteria. So, the search criteria have an

AND relationship.

If set to true, content items that meet any search

criterion are found. This is anOR relationship.

Boolean

True - return content that

matchesat least one search

criterion

False - return content that

matchesall search criteria

WrapTag

Allowsa developer to specify a server control’s

tag.

The default isSpan.

String

Span - The <span> tag is

used to designate an in-line

portion of an HTML

document asa span

element.

Div - The <div> tag is used

when you want to apply

attributes to a blockof code.

Custom - Allows you to use

a custom tag.

xmlConfigID
ID of the Smart Formwhose indexed fields

appear on the search screen.

Long

XMLSmart Form ID

numbers

SearchParmXML Property
Use the SearchParmXML property to create a predefined XML search whose results appear upon

page load. Click the gray box in this property to open a window where you define the search.

The window’s parameters are defined by the Smart Form Configurations selected at the

xmlConfigID property.

If you are not logged in, this property launches the CMS Explorer login. For more information,

see ”Using CMS Explorer to Browse Your Ektron CMS400.NET Site” on page 21-12

The following example uses the SearchParmXML property to create a list of books, based on

publishers with “press” in their name.

1. To activate the window, click the gray box in the SearchParmXML property.

2. The Build Search Parameter screen appears.
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3. Click the check boxes for the parameters you want to search with.

4. Define the parameter.
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The drop down box in this example contains the following variables:

Select One - Prompts you to choose a variable

Exact Phrase - Enter a phrase and search for that exact phrase within the XML content

Contains - Enter a word or phrase and search for any XML content that contains that word

or phrase

5. Click OK.

6. Build the Web form.

7. Browse to the Web page in your browser.

8. The page shows XML content on your site that matches the parameters.

Using the IndexSearch Server Control
Programmatically Example

Note: When creating an IndexSearch server control form using code behind only, the controlmust be connected

with the page events. Otherwise, you cannot submit search parameters.

You can use the IndexSearch server control in code behind to manipulate how users view

search results. The following example shows how to return values associated with an XPath.

This example shows a list of book titles.

1. Open a Web form.
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2. Drag and drop an IndexSearch server control onto it.

3. Set the properties in the properties window.

Note: In this example, the hidepropertymust be true. Remember also to set the XmlConfigID. This example

uses ID number 4.

4. Drag and drop a Literal on the Web form.

5. Add the following to the code behind.
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IndexSearch1.Parm.XPath = "/root/subject"
Dim arStr As String()
Dim Str As String
Dim strRet As String
arStr = IndexSearch1.GetXPathValues("/root/subject")
For Each Str In arStr

 strRet += Str & "<br/>"
Next
Literal1.Text = strRet

Here is a breakdown of the code.

Code snippet Description

IndexSearch1.Parm.XPath = "/root/subject" Defines the parameter XPath location:

Dim arStr As String()

Dim Str As String

Dim strRet As String
Creates variables

arStr =

IndexSearch1.GetXPathValues("/root/subject")

Sets the variable arStr as an arrayof the

XPathValues

For Each Str In arStr

 strRet += Str & "<br/>"

Next

The for next loop iterates through the arrayof

XPathValues

Literal1.Text = strRet Displays valueson your Web form

6. Build the project.

7. Browse to your web form.

8. The list of book subject titles appears.
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Programmatically Predefined General Search Results
Replaced By Specific Search Results
This code behind example shows a predefined search appearing on a Web page, then being

replaced by more specific search results. This example creates a hyperlink list of book

publishers. When you click a specific publisher, it replaces the publisher list with a book list

from that publisher.

Follow these steps.

1. Add an IndexSearch server control to a Web form.

2. Set the following properties:

n DisplayXslt = ecmTeaser

n Hide = True

n ShowSearchBoxAlways = False

n Weighted = True

n XmlConfigId = 4

3. Add two Literals.

4. Add the following code to the Page Load Event in code behind.
Dim bRet As Boolean
 If Request.QueryString("publisher") <> "" Then

 IndexSearch1.Hide = False
 IndexSearch1.Parm.XPath = "/root/publisher"
 IndexSearch1.Parm.DataType = Ektron.Cms.Common.EkEnumeration.XMLDataType.String
 IndexSearch1.Parm.SearchType =

Ektron.Cms.Common.EkEnumeration.XMLSearchRangeType.ExactPhrase
 IndexSearch1.Parm.Value1 = Request.QueryString("publisher")
 bRet = IndexSearch1.AddParm()
 IndexSearch1.Search()

 Literal1.Text = "<h1>Publisher " & Request.QueryString("publisher") & " -

Books</h1>"
 Literal2.Text = "<a href=""webform.aspx"">Back</a>"

 Else
 Literal1.Text = "<h1>Publishers</h1>"
 Dim arStr As String()
 Dim Str As String
 Dim strRet As String
 arStr = IndexSearch1.GetXPathValues("/root/publisher")
 For Each Str In arStr
 strRet += "<a href=""webform.aspx?publisher=" & Server.UrlEncode(Str) & """>" &

Str & "</a><br/>"
 Next
 Literal1.Text += strRet

 End If

5. Save your Web form.

6. Build your Web form.

7. Browse to the Web form in your browser.
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8. The list of publishers appears.

9. ** Click a publisher.

10. A list of books with teasers by that publisher appears.

Notice the second Literal now contains a hyperlink to go back.

11. Click on a book.

12. The XML content for that book appears.
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Turn Off Caching In Mozilla Firefox
When using Mozilla Firefox to perform an index search some parameters become cached. To

prevent caching in Mozilla Firefox, add the following line to the Page Load Event in code

behind:

Response.Cache.SetNoStore()

Setting Page Size for Smart Form Search Results
Paging support is available for XML Index Search results. You set the number of results per

page in this Web.config file tag:

<web search>
<providers>
<add name="MSIndexDialectServer"
pageSize

If the number of results exceeds the pageSize value, the display terminates and the user see

Next Page below the last entry.
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Using the Document Management
System

The Document Management System (DMS) lets you import Microsoft Office files along with

other types of files into Ektron CMS400.NET. (Non-Office files are known as managed files.)

Collectively, these files are known as assets.

After being saved to Ektron CMS400.NET, assets can be updated and tracked like HTML and

XML content. If you’re familiar with how content is handled, most of what you know applies

to assets. For example, assets

n can be stored in folders with other content, or in separate folders that you create just for

them

n are assigned content ID numbers

n can have summary, metadata, comment, task, schedule, and taxonomy information

n inherit permissions and approvals from their folder properties

n progress through the workflow (check out, check in, publish)

n retain a history so you can restore earlier versions

n can be searched

n support foreign language editions

n can have a task assigned to them

n appear on content reports

n update the Smart Desktop listing of files awaiting approval, checked out, tasks, to expire

When an asset is imported to the CMS then saved, a copy of it is saved to the Document

Management server. Then, whenever a user edits and saves the asset, a new copy is stored. In

this way, you can review and, if needed, restore a prior version.

This chapter explains the Document Management Functionality through the following topics.

n "Supported Types of Assets" on page 7-409

n "Security" on page 7-410

n "Software Requirements" on page 7-410

n "Working with Microsoft Office Documents" on page 7-413

n "Working with Managed Files" on page 7-435

n "Asset Workflow" on page 7-439

n "Asset Reports" on page 7-440

n "Document Management Configuration" on page 7-441
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n "Checking Document Management Permissions" on page 7-444

n "Managing Multimedia Assets" on page 7-447

n "PDF Generation" on page 7-454

n "Adding Assets Automatically" on page 7-457

n "Merging Indexing Service Catalogs" on page 7-462

n "Troubleshooting" on page 7-468

n "Removing Front Page Server Extensions" on page 7-485

Supported Types of Assets
Ektron CMS400.NET can support all file types. By default, only the following types are

supported. However, your administrator can add or remove any file type via the Asset Server

Setup screen.

Exception!

Warning! Ektron CMS400.NET doesnot support double extensions, such as filename.aspx.vb.

n Microsoft Office 2000 or later documents: Word, Excel, Powerpoint, Project, Publisher,

Visio, etc.

n Managed files: *.zip files, PDFs, *.txt files, graphic files such as *.gif and *.jpeg, Open

Office documents such as *.odf, *.odt

n Multimedia files such as *.swf, *.mp3, *.wav. *.avi

Note: The file types that can be uploaded are determined by your administrator. If you try to upload the wrong

type of file, the following error message appears.
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Security
For the purposes of security, assets are treated like other content. Your system administrator

applies security to each folder, determining which user groups can perform which tasks on the

content in a folder. For more information, see "Folder Permissions" on page 5-43.

Software Requirements
Your production server must run Windows 2003 server or Windows 2000.

See Also:

n "Browser Requirements" on page 7-410

n "Installing FireFox Plug In" on page 7-411

Browser Requirements

Feature Browser Requirements
For more

information, see

Edit Microsoft

Office

documents

within

CMS400.NET

Internet Explorer. Option doesnot appear with

Firefox.

Note: Firefox users can checkanOffice document out

to their computer, edit it using Office, then drag and

drop the file back into CMS400.NET. See "Editing a

Managed File" on page 7-437.

Note: If your computer hasWindowsVista, youmust

turn off itsUser Account Control to use this feature.

For details, see

http://www.microsoft.com/technet/technetmag

/issues/2007/06/uac/default.aspx

"Editing anOffice

Document" on page

7-427

Multiple

DMS

Documents

Option

Internet Explorer. Option doesnot appear with other

browsers.

"Adding Documents

Using theMultiple

DMSDocuments

Option" on page 7-

418
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Installing FireFox Plug In
If you want to use the Document Management’s drag and drop feature with the Firefox

browser, you need to install software to enable it. You only need to do this the first time on a

computer. Afterwards, the features are available to you with no additional effort.

Follow these steps to install the Firefox plug-in software.

1. Launch the FireFox browser.

2. In the Ektron CMS400.NET Workarea, open a content folder.

3. Click the Add Assets button (circled below).

4. The following box appears in the center of the screen.

5. Click the word here.

6. The following dialog appears.
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7. Click the down arrow next to Netscape (default) and select Other.

8. Browse to C > Program Files > Mozilla Firefox > Firefox.exe.

9. Click Open.

10. Firefox.exe appears next to the Open with field.

11. Press OK.

12. The following dialog appears.

13. Click Install Now.

14. Close then reopen the Firefox browser.
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15. You can now drag and drop files into Ektron CMS400.NET.

Working with Microsoft Office
Documents
This section explains how to work with Microsoft Office documents through the following

subtopics.

n "MS Office Document Menu Options" on page 7-413

n "Notes on Working with Microsoft Office Documents" on page 7-414

n "Importing Office Documents" on page 7-415

- "How Imported Documents are Named" on page 7-416

- "Adding Documents Using the DMS Document Option" on page 7-417

- "Adding Documents Using the Multiple DMS Documents Option" on page 7-418

- "Adding Documents Using Drag and Drop" on page 7-419

- "Adding Documents to a Mapped Network Folder" on page 7-422

n "Editing an Office Document" on page 7-427

n "Deleting an Office Document" on page 7-429

n "Checking Out, Saving, and Replacing an Office Document" on page 7-430

n "Saving an Office Document" on page 7-432

n "Saving an Office Document in .html Format" on page 7-432

MS Office Document Menu Options
Depending on a document’s status, your role, and position in the document’s approval chain,

any of the following options may be available when you display the dropdown menu for an

Office document.
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See Also: "Dropdown Menu Options" on page 5-10

Notes on Working with Microsoft Office Documents
n Prerequisites

- Your computer has MS Office

- Internet Explorer to work with Office documents within Ektron CMS400.NET.

Note: While you cannot edit within Ektron CMS400.NET using Firefox, you can save anOffice document to your

computer, edit it, then drag and drop the updated version to Ektron CMS400.NET.

n Verify the following settings for every Office document type that you work with.

- Open Windows Explorer.

- Click Tools > Folder Options > File Types.

- Click an Office file type you work with (for example, DOC Microsoft Word

Document).

- Click the Advanced button.

- Change the checkboxes at the bottom of the screen so they look like this.

- Click OK
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n Problems can arise if you try to open a document created with Office 2007 and your

computer has an earlier version of Office. The best solution is to upgrade your computer to

Office 2007.

If you cannot do this, the next best option is to install Microsoft Windows Compatibility Pack.

See https://www.microsoft.com/downloads/details.aspx?FamilyId=941B3470-3AE9-4AEE-

8F43-C6BB74CD1466&displaylang=en .

Once installed, you can work with Office 2007 documents even though you have an earlier

version of Office.

n If you import an Excel spreadsheet then click it from its Ektron CMS400.NET folder, you

see Download this file name. Click the download link to view the file.

Importing Office Documents
DMS can store and help you manage Office documents. This section explains how to import

any document into Ektron’s Document Management System.

Ektron CMS400.NET provides several ways to import Microsoft Office documents. They are

described below.

Warning! You cannot simply place files in the siteroot/assets or siteroot/PrivateAssets folder thenmanage

them using Ektron CMS400.NET. You can only import documents using one of themethods listed below.

Note: OnlyuserswithAdd permission for a folder can import documents into it. See Also: "Folder Permissions"

on page 5-43

Method Advantages Disadvantages
For more

information, see

New > DMS

Document from

View Contents of

Folders screen

n Can enter Sum-

mary, Metadata infor-

mation etc. for each

document

n Can create unique

title for each document

n You can check in

or submit document for

approval

n Slower when importing

severalOffice documents

n Cannot maintainWin-

dows folder structure

"Adding Documents

Using theMultiple DMS

DocumentsOption" on

page 7-418

Importing Office Documents

ReferenceManual

Version 8.0 Rev 1.3
7-415

https://www.microsoft.com/downloads/details.aspx?FamilyId=941B3470-3AE9-4AEE-8F43-C6BB74CD1466&displaylang=en
https://www.microsoft.com/downloads/details.aspx?FamilyId=941B3470-3AE9-4AEE-8F43-C6BB74CD1466&displaylang=en
https://www.microsoft.com/downloads/details.aspx?FamilyId=941B3470-3AE9-4AEE-8F43-C6BB74CD1466&displaylang=en
https://www.microsoft.com/downloads/details.aspx?FamilyId=941B3470-3AE9-4AEE-8F43-C6BB74CD1466&displaylang=en
https://www.microsoft.com/downloads/details.aspx?FamilyId=941B3470-3AE9-4AEE-8F43-C6BB74CD1466&displaylang=en


Method Advantages Disadvantages
For more

information, see

New > Multiple

DMS

Documents from

View Contents of

Folders screen

n Can upload sev-

eral files at once, so it’s

faster thanNew DMS

Document option

n More efficient

when same summary,

metadata, schedule,

etc., apply to manydoc-

uments

n You can check in

or submit document for

approval

n Document title taken from

Windows file name

n Requires Internet

Explorer andMSOffice

"Adding Documents

Using the Multiple

DMS Documents

Option" on page 7-

418

Drag and drop

into

CMS400.NET,

from View

Contents of

Folders screen

n Can upload sev-

eral files at once, so it’s

faster thanNew DMS

Document option

n Can drag/drop

folder structure;

CMS400.NET rec-

reates it inWorkarea

n More efficient

when same summary,

metadata, schedule,

etc. apply to manydoc-

uments

n Content is in checked in

status; submitting it for pub-

lishing is a separate step

n Document title taken from

Windows file name

"Adding Documents

Using Drag and Drop"

on page 7-419

Drag and drop

into amapped

network folder

n User doesn’t need

to install or learn CMS

software

n Can drag/drop

folder structure;

CMS400.NET creates it

inWorkarea

n Document title taken from

Windows file name

n Content is in checked in

status; submitting it for pub-

lishing is a separate step

n Cannot assign language

to content or workwith content

in a language other than your

computer’s default language

"Adding Documents to

aMapped Network

Folder" on page 7-422

How Imported Documents are Named
When you use the New > DMS Document file import option, you enter an Ektron

CMS400.NET title for the file.
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When you import an Office document or managed file into Ektron CMS400.NET using any

other method, its name is the file name without the extension. So, a file named mypicture.jpg

becomes mypicture in Ektron CMS400.NET.

While it may appear that the file extension was removed, it is retained and reappears for assets

when you use the Edit option, on the View Contents of Folder screen (circled below).

The original file extension also appears when you check out.

If you import a file of the same name but a different extension into the folder, the new file’s

name has the next available number appended to it. For example, mypicture(2).

Adding Documents Using the DMS Document Option
To add a new Office document to Ektron CMS400.NET via the New > DMS Document menu

option, follow these steps.

1. From the Workarea, select the Content tab.

2. Select the folder in which you want to place the document.

3. The default language icon appears next to the screen title. To create a document for a

different language, click View > Language and select the language.
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4. Click New > DMS Document.

5. The following screen appears.

6. Click the Browse button and browse to the file you want to import. Click OK.

7. Enter a Title. It cannot include these characters: \, /, *,>, <,|

Note: If you want to retain the original document name, insert the full filename into the Title field. For example,

you could entermydocument.doc.

8. Use the Content Searchable checkbox to determine if the content should be searchable.

See Also: "Content Searchable" on page 7-14.

9. If desired, add a summary, metadata, a schedule, and comments. See Also:

n "Working with Content Summary" on page 7-142

n "Working with Metadata" on page 7-146

n "Scheduling Content to Begin and End" on page 7-195

10. Check in or submit the content for publishing as you would HTML content.

Adding Documents Using the Multiple DMS
Documents Option
To add Office documents to Ektron CMS400.NET via the New > Multiple DMS Documents

menu option, follow these steps.

Note: This option is only available if you are using Internet Explorer andOffice 2003 or higher is installed on your

computer.

Warning! If you will apply the same information (Summary, Metadata, Categories, etc.) to several files, place

those files in the sameWindows folder before starting this procedure.

1. From the Ektron CMS400.NET Workarea, select the Content tab.

2. Select the Ektron CMS400.NET folder in which you want to place the documents.

3. The default language appears next to the screen title. To create a document for a different

language, click View > Language and select the language.

4. Click New > Multiple DMS Documents.
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5. The Edit Content in Folder screen appears. The lower portion of the screen resembles

Windows Explorer.

The left frame shows folders in your computer. The right frame shows files in the selected

folder.

6. In the left frame, select the folder that contains files you want to upload.

7. In the right frame, check the box next to each file you want to upload. To select all files

in the folder, check the box in the header (circled below).

Note: You can only import files from one folder at a time.

8. If appropriate, enter the files’ summary, metadata, schedule, tasks, comments, or category.

Any information you enter is applied to all selected files.

9. To check in the files, click the Check In button ( ) from the top left corner.

To submit the files into the approval chain, click the Submit ( ) or Publish ( ) button.

Adding Documents Using Drag and Drop
When using drag and drop, you can choose individual files or a folder. If you choose a folder,

its structure is recreated in Ektron CMS400.NET even if it is several levels deep.

1. From the Ektron CMS400.NET Workarea, select the Content tab.
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2. Select the Ektron CMS400.NET folder in which you want to place the documents.

Note: You cannot drag and drop a file into a folder for which XMLSmart Formsare required.

3. The default language appears next to the screen title. To create the documents in a

different language, click View > Language and select the language.

4. Click the Add Assets button (circled below).

5. The drag and drop window appears.

Note: If you are using Ektron CMS400.NET with the FireFoxbrowser for the first time, see "Installing FireFox

Plug In" on page 7-411.

6. Resize Ektron CMS400.NET so that it occupies the left half of the screen.

7. Open Windows Explorer. Resize it so it occupies the right half of the screen.

8. Find the folder or assets you want to upload.

9. From Windows Explorer, select then drag and drop the folder or assets onto the drag and

drop window.
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10. The following screen appears.
.

If any asset being uploaded is not supported, an error message appears: An error occurred

copying some or all of the selected files. However, all supported files are uploaded. See Also:

"Importing Office Documents" on page 7-415

Note: If your Web site usesan https secure site setting, youmaysee errors after dragging an dropping assets. If

this occurs, open your site’sweb.config file and change the value of the add key="ek_UseSSL" setting to true.

11. If Ektron CMS400.NET requires you to apply metadata or a taxonomy category to the

content, the following screen appears.

Note: Your system administrator creates themetadata screen. The image below is only an example of what it

might look like.
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12. Required metadata field labels are red and have an asterisk (as title does above). Complete

all required metadata. See Also: "Working with Metadata" on page 7-146

13. If the Category tab appears, apply at least one taxonomy category to this asset. See Also:

"Taxonomy" on page 9-200

The status of a dragged and dropped document depends on the approval chain.

n If you are the last approver, or if there is no approval chain, its status is Approved.

n If there is an approval chain and you are not the last approver, its status is Checked In (I).

Adding Documents to a Mapped Network Folder
You can set up a mapped network folder then drag and drop folders or assets into it. The

advantage of this method is that you can upload documents without installing or learning how

to use Ektron CMS400.NET.

When using drag and drop, you can choose individual assets or a folder. If you choose a folder,

Ektron CMS400.NET recreates that folder structure, even if it is several levels deep. After the

assets are uploaded, they are set to Checked In status.

You can also delete and move assets using the mapped network folder.

This section explains these procedures.

n "Language Restrictions on Content in a Mapped Network Drive" on page 7-423

n "Setting up a Mapped Network Drive" on page 7-423

n "Dragging and Dropping Assets into a Mapped Network Drive" on page 7-425
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n "Viewing Managed Files in a Mapped Network Drive" on page 7-426

n "Removing Mapped Network Drives" on page 7-426

Language Restrictions on Content in a Mapped Network
Drive
You cannot choose a language for assets in a mapped network folder-- they are automatically

assigned the Ektron CMS400.NET default language (set in the siteroot/web.config file at the

ek_DefaultContent Language element).

And, you cannot work with assets of a language other than your computer’s default language.

For example, if your computer’s default language is English and your version of Ektron

CMS400.NET has Spanish content, you cannot edit that content in a mapped network folder.

Setting up a Mapped Network Drive
Prerequisites:

n The path to your Ektron CMS400.NET Web site. It is something like this:

http://server23/CMS400. If you do not know the path, ask your system administrator.

n an Ektron CMS400.NET user name and password

1. Right click the Windows Start button.

2. Choose Explore. Windows Explorer opens.

3. Click Tools > Map Network Drive.
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4. The Map Network Drive screen appears. Click Sign Up for Online Storage or Connect to

a Network Server.

5. A wizard screen appears. Click Next.

6. Another wizard screen appears. Click Choose another network location. Click Next.

7. A third wizard screen appears. Enter the path to your Ektron CMS400.NET site, followed

by the ekdavroot folder. For example, http://server23/CMS400/ekdavroot. Click Next.

Warning! If your computer runsMicrosoft Vista and you see this error message The folder you entered does

not appear to be valid. Please choose another, refer to thisEktron KB article: http://dev.ektron.com/kb_

article.aspx?id=15176.

8. A login screen appears (see below). Enter your Ektron CMS400.NET username and

password. Click OK.
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9. Another wizard screen appears. Name the folder. You will use this name to identify the

folder when you want to drag and drop assets to it. Click Next.

10. The Finish screen appears.

Dragging and Dropping Assets into a Mapped Network Drive
Use Windows Explorer to drag and drop folders or assets into the mapped network folder.

Warning! If aWindows folder hasmore than 1500 files,WindowsExplorer may time out while trying to open it. To

remedy this problem, divide your files in that folder into several child folders.

1. Open Windows Explorer. Resize it so it occupies the left half of the screen.

2. Open the folder that contains the folders or assets you want to upload to Ektron

CMS400.NET.

3. Open a second instance of Windows Explorer. Resize it so it occupies the right half of the

screen.

4. In that window, open My Network Places. Under that, find the mapped network folder

you created in "Setting up a Mapped Network Drive" on page 7-423.

5. A login screen appears. Enter your Ektron CMS400.NET username and password. Click

OK.

6. Open the Ektron CMS400.NET folder into which you want to upload assets or folders.

7. From the left window, drag and drop assets or folders into the mapped network folder.

If any of the assets being uploaded is not supported, an error message appears: An error

occurred copying some or all of the selected files. However, all supported assets are

uploaded. See Also: "Importing Office Documents" on page 7-415
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Viewing Managed Files in a Mapped Network Drive
If you want to view individual managed files within a mapped network drive folder, follow

this procedure.

1. Open the site root/web.config file.

2. Go to this line:
<!--remove verb="GET,HEAD,POST" path="*"/-->

3. Remove the comment characters (in red above).

4. In the following lines, insert beginning and ending comment characters as shown in red

below.
<!--add verb="GET,POST" path="*.doc"

type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.docx"

type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.xls"

type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.xlsx"

type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.ppt"

type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.pptx"

type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.vsd"

type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.vsdx"

type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/-->
<!-- Enable the line below and remove all office specific mappings above for Server 2003

with
private assets and enable remove verb command-->

5. Go to this line:

<!--add verb="GET,HEAD,POST" path="*" type="-

Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/-->

6. Remove the comment characters (in red above).

After you make this change, you can click to view any image file in the ekdavroot folder.

Removing Mapped Network Drives
Ektron CMS400.NET’s DMS feature creates a mapped, ekdavroot network drive for many

functions. For example, if you sign on to Ektron CMS400.NET and create a new folder, a new

mapped, ekdavroot network drive is created.
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If you find that ekdavroot folders clutter up your My Network Places folder, you can delete

them. Deleting ekdavroot folders has no impact on your ability to use Ektron CMS400.NET.

Editing an Office Document
There are two ways to edit an Office document if you are using the Internet Explorer browser

and Office is installed on your computer.

n "Edit in Microsoft Office" on page 7-427

n "Edit Using a Mapped Network Folder" on page 7-428

Note: Firefoxusers should download theOffice document to their computer, edit it usingOffice, then drag and

drop the asset back into CMS400.NET.

Edit in Microsoft Office

Prerequisites

n Your computer has MS Office.

n The Internet Explorer browser. You cannot use Firefox.

To use this option, click the document from the Ektron CMS400.NET folder and select Edit in

Microsoft Office from the dropdown menu.
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The document opens within Office. Make your changes and save it. When you do, the revised

version is saved to Ektron CMS400.NET.

Note: If you want to edit the document’sSummary, Metadata, Schedule, Comment, Task, or Taxonomycategory

information, click the asset from the Ektron CMS400.NET folder, then selectEdit Properties from the dropdown

menu.

When you begin to edit the document, its status changes to Checked Out (0). When you make

your changes and save, it is Approved.

See Also:

n "Working with Content Summary" on page 7-142

n "Working with Metadata" on page 7-146

n "Managing Tasks" on page 11-1

n "Scheduling Content to Begin and End" on page 7-195

n "Web Alert Feature" on page 20-1

Edit Using a Mapped Network Folder
You can edit an Office document directly from a mapped network folder. To do that, follow

these steps.

1. Set up a mapped network folder, as described in "Setting up a Mapped Network Drive" on

page 7-423.

2. Use Windows Explorer to open the folder.
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Note: If anyWindows folder hasmore than 1500 files,WindowsExplorer may time out while trying to open it. To

remedy this problem, divide your files in that folder into several child folders.

3. Open a document using Office, make changes, and save it.

You can also delete and move documents using the mapped network folder.

The document is now in checked into Ektron CMS400.NET, and can appear on your Web site

when approved. Also, a history of every saved version is retained so you can restore previous

ones if necessary. You cannot enter or change Ektron CMS400.NET document information

(Summary, Metadata, etc.) in the mapped network folder -- someone must use Ektron

CMS400.NET to do that.

Status of Document Saved to Mapped Network Folder
The status of a document saved to a mapped network folder depends on the approval chain

and the user who signed in when the mapped network folder was created.

n If you are the last approver, or if there is no approval chain, its status is Approved.

n If there is an approval chain and you are not the last approver, its status is Checked In (I).

Also, if the content’s folder requires metadata or a taxonomy category which has not been

entered, its status is Checked In (I).

Deleting an Office Document
Note: Youmust have delete permissions for the folder that contains the document. See Also: "Folder

Permissions" on page 5-43.

Note: It is good practice to check for broken quicklinksbefore deleting documents. See "LinkChecking" on page

7-132.

To delete an Office document, follow these steps.

1. Navigate to the Workarea’s Content folder.

2. Open the folder that contains the document.

3. Place the cursor over the document

4. Hover the cursor over the triangle ( ) on the right end of the document and click. A
dropdown menu appears.

5. Click Delete.
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Note: If you do not seeDelete, either you lackpermission to delete the content or its statusmakes it ineligible for

deleting.

6. The following message appears.

7. Click OK to delete the document.

Like publishing, deleted content must go through the approval chain before it is removed. If

you are the last approver in the approval chain, the content is deleted immediately. See Also:

"Approve/Decline One Content Item" on page 5-35

Checking Out, Saving, and Replacing an Office
Document
If you check out and save an Office document to your computer, you would typically edit it

using Office. While it is checked out, only you or a system administrator can check it back in.

Other users cannot edit it. You may use this feature to work on the document on your

computer, copy it to another computer, or even email it to someone who does not have access

to Ektron CMS400.NET.
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You can also use the Check Out and Save As option to edit an Office document if you use

the Firefox browser. Firefox does not let you edit Office documents within Ektron

CMS400.NET, as you can with Internet Explorer. To work around this limitation, check out

the Office document, save it to your computer, and edit it.

When all edits have been entered, drag and drop the document back to Ektron CMS400.NET.

Follow these steps to copy an Office document to your computer, edit it, then replace the

version in Ektron CMS400.NET.

Warning! There are severalways to import a document into Ektron CMS400.NET. Somemethods retain the orig-

inal file namewhile others let the user assign a name.

Warning! When you checkout and save a document to your computer, it is saved under the original file name,

whichmaybe different from itsEktron CMS400.NET name. The original file name is on the screen that appears

after you selectCheck out and Save as (circled below).

Warning!

Make note of the original file name, because you use it to identify the file after it is saved to your computer.

1. In Ektron CMS400.NET, open the folder that contains the Office document.

2. Hover the cursor over the triangle ( ) on the right end of the document and select Check
out and Save As.

3. You are prompted to open or save the document. Click Save.

4. Select a folder to which you want to save the document.

5. The document’s status changes to checked out (O).

6. Edit the document in Office.

Note: If you change your mind and do not change the document, but simply closeOffice, the document remains

CheckedOut (O). Use theCheck Inmenu option to check it in.

7. Drag and drop the edited document. See "Adding Documents Using Drag and Drop" on

page 7-419.

8. You are asked to confirm the file replace. Click Yes.

9. The document is submitted for approval.

10. The revised document is saved in Ektron CMS400.NET.
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Saving an Office Document
You would typically save an Office document to your computer in order to distribute it to

others, or if you want a personal copy. You should not save a document to your computer if

you plan to edit it then replace the version in Ektron CMS400.NET -- doing this may overwrite

edits made by other users.

If you want to edit a document, use the Edit in MS Office or Check out and Save As menu

option. Both options set the content to checked out status, which prevents non-administrator

users from editing it until you check it back in.

Follow these steps to save an Office document.

1. In Ektron CMS400.NET, open the folder that contains the Office document.

2. Hover the cursor over the triangle ( ) on the right end of the document and click Save
As.

3. You are asked if you want to open or save the document. Choose Save.

4. Select a folder to which you want to save the document.

Saving an Office Document in .html Format
This feature converts Office documents to HTML format, which means they are formatted to

display within a browser. As a result, anyone visiting your site can view the document,

whether or not Microsoft Office is installed on their computer.

Warning! OnlyMicrosoftWord and Excel documents can be published asHTML. Ektron CMS400.NET doesnot

support saving Powerpoint or Visio documents asHTML.

There are two ways to save an Office document in .html format.

Method Advantages For details, see

1. Drag and dropOffice doc-

ument into

CMS400.NET.

2. UseEdit in MS Office

option to save it in html

format.

You don’t need to know the

path to your Web site’s root

folder.

"Saving anOffice Document as .html

from Ektron CMS400.NET" on page 7-

434

1. Open anOffice document

on your computer.

2. Save it in html format to

the ekdavroot folder in

your Web root.

You don’t need to drag and

drop document to

CMS400.NET

"Saving Office Document as .html from

Your Computer" on page 7-434
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Warnings About Saving in .html Format
Regardless of how you save Office documents as HTML, be careful to set up procedures that

prevent HTML content from being overwritten. For example:

1. You save a Word document as .html.

2. Someone edits the .html version.

3. You save the original Office Document as .html again.

In this scenario, the edits made in step 2 are overwritten by step 3.

It is important to establish procedures that avoid such problems.

Saving an Office Document as a Web Page
When saving a Word document, after you choose Save as from Word’s File menu, there are

two choices for saving as .html.

Note: When saving an Excel document,Save as Web Page (*.htm, *.html) is the only option.

n save as Web Page

n save as Web Page Filtered

Note: For a description of the differencesbetween these options, see http://office.microsoft.com/en-

us/help/HP030852781033.aspx.

Ektron recommends save as Web Page, Filtered because the resulting HTML is almost

identical to the original document. The save as Web Page is not a good option because its

HTML content does not match the original document and may cause problems when being

edited.

Handling Images Embedded within a Word Document
If you save an Office document that includes images, they appear when anyone is editing the

document as well as when it appears on your Web site. In addition, the images are saved to the

Importing Office Documents

ReferenceManual

Version 8.0 Rev 1.3
7-433

http://office.microsoft.com/en-us/help/HP030852781033.aspx
http://office.microsoft.com/en-us/help/HP030852781033.aspx


corresponding Ektron CMS400.NET Library folder. In this way, other Ektron CMS400.NET

users can apply the images to HTML content as needed.

See Also: "Library Folder" on page 8-1

Saving an Office Document as .html from Ektron
CMS400.NET
This procedure assumes the Office document has been saved to Ektron CMS400.NET.

Procedures for doing this are explained in "Importing Office Documents" on page 7-415.

See Also: "Warnings About Saving in .html Format" on page 7-433

1. Within the Ektron CMS400.NET Workarea, open the Content area.

2. Open the folder that contains the Office document you want to save as .html.

3. Hover the cursor over the triangle ( ) on the right end of the document you want to save

4. Click Edit in Microsoft Office. The document opens within Office.

5. From Office’s File menu, select Save as Web Page.

6. In the Save as Type field, select Web page, Filtered (*,htm, *.html). See Also: "Saving an

Office Document as a Web Page" on page 7-433

7. Click the Save button.

8. You may be warned about formatting features not supported in HTML. Press Continue.

9. A dialog prompts you to enter your Ektron CMS400.NET user name and password.

10. Ektron CMS400.NET’s folders appear in a Save as window. The folder that contains the

Word document is the default folder. Select that or any other Ektron CMS400.NET folder

and click Save.

11. The Office document is saved as an .html file into Ektron CMS400.NET.

12. Close the document and exit from Office.

Saving Office Document as .html from Your Computer
1. Open the Office Document.

2. Click File > Save as (*,htm, *.html).
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3. Click My Network Places and navigate to ekdavroot folder on the server that hosts

Ektron CMS400.NET.

4. Ektron CMS400.NET’s folders appear. The folder that contains the Word document is the

default folder. Select that or any other Ektron CMS400.NET folder.

5. In the Save as Type field, select Web page (*.htm, *.html) orWeb Page, filtered (*.htm,

*.html). See Also: "Saving an Office Document as a Web Page" on page 7-433.

6. Click the Save button.

7. You may be warned about formatting features not supported in HTML. Press Continue.

8. A dialog prompts you to enter your Ektron CMS400.NET user name and password.

9. The Office document is saved as an .html file into Ektron CMS400.NET.

10. Close the document and exit from Office.

The status of the document depends on the approval chain and the user who signed in when

the mapped network folder was created.

n If you are the last approver, or if there is no approval chain, its status is Approved.

n If there is an approval chain and you are not the last approver, its status is Checked In (I).

Working with Managed Files
Ektron CMS400.NET can also track and manage any non-Office type of file that runs on your

computer (for example, .PDF, .gif and .zip).

You use a host application to create the file. For example, you might use Photoshop to create a

.jpg file. Next, save it to Ektron CMS400.NET using any method explained in "Importing

Office Documents" on page 7-415. While importing, add supporting information, such as

summary, metadata, taxonomy category and schedule. Use standard toolbar buttons to perform

actions like view history, submit for publishing, and delete.

If you want to edit a managed file, use the Check out and Save As menu option to place a

copy of it on your computer. Then, edit it using the host application. When done, drag and

drop the changed file to Ektron CMS400.NET.

This section explains how to work with managed files through the following subtopics.

n "Managed File Menu Options" on page 7-436

n "Creating a New Managed File" on page 7-437

n "Importing Managed Files" on page 7-437

n "Editing a Managed File" on page 7-437

n "Deleting a Managed File" on page 7-438
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Managed File Menu Options
Depending on a managed file’s status, your role, and position in the document’s approval

chain, any of the following options may be available when you display the dropdown menu

for a managed file. See Also: "Workarea Content Menu" on page 5-9.

Note: These sectionsdescribe working with Office documents. Everything works the samewithmanaged files.

Menu option Description
For more

information, see

View

View and edit managed file and itsCMS400.NET information

(Summary, Metadata, History, etc.). Can also be used to

replace file.

Save As Save copyof managed file to your computer

"Saving anOffice

Document" on page 7-

432

CheckOut and

Save As

Change amanaged file’s status to checked out and save a

copy to your computer

"Checking Out, Saving,

and Replacing anOffice

Document" on page 7-

430

Edit

Overwrite amanaged file in CMS400.NET with a version on

your computer.

The file name can be different but its typemust match the file

being edited. A file’s type appears after you clickEdit, on the

Edit Content in Folder screen (circled below). "Checking Out, Saving,

and Replacing anOffice

Document" on page 7-

430

Check In

Change a checked-out managed file’s status to checked in.

Useful if you checked out and saved amanaged file then it

became lost or corrupted. This option lets you change its

status back to checked in.

Submit/Publish Submit managed file into approval chain
"AssetWorkflow" on page

7-439

Delete Deletemanaged file; deleted file cannot be retrieved
"Deleting aManaged

File" on page 7-438

Content

7-436
ReferenceManual

Version 8.0 Rev 1.3



Creating a New Managed File
You cannot create a managed file within Ektron CMS400.NET. Instead, create it on your

computer using the host application then import it into DM.

Importing Managed Files
Warning! You cannot import fileswhose name includesa percentage sign (%) or ampersand (&).

You import managed files into Ektron CMS400.NET using the same methods you use to

import MS Office documents. See "Importing Office Documents" on page 7-415.

If you do not see a file you uploaded, verify that the View Menu box is displaying the type of

file you are looking for. Files upload to the correct type regardless of what is selected when

you drag and drop them.

Editing a Managed File
You do not edit a managed file within Ektron CMS400.NET. Instead, you check it out, save it

on your computer, edit it using the host application, then check it back in to Ektron

CMS400.NET. While it is checked out, only you or a system administrator can edit the

managed file within Ektron CMS400.NET.

Note: Alternatively, you can edit within amapped network folder. See "Edit Using aMappedNetworkFolder" on

page 7-428.

Follow these steps to edit a managed file.

1. From the Workarea, select the Content folder.

2. Select the managed file’s folder.

3. Select the managed file you want to edit.

4. Hover the cursor over the triangle ( ) on the right end of the file and click.

5. Click Check out and Save As from the dropdown menu.
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6. Select a folder on your computer in which to save the file.

7. Open the host application.

8. Edit and save the file.

9. Return to Ektron CMS400.NET and open the file’s folder.

10. Click the Add Assets button (circled below).

11. Drag the changed file to the Assets area in the middle of the screen.

Deleting a Managed File

Note: Youmust have delete permissions for the folder that contains the document. See Also: "Folder

Permissions" on page 5-43.

Note: It is good practice to check for broken quicklinksbefore deleting documents. See "LinkChecking" on page 7-

132.

1. From the Workarea, select the Content folder.

2. Select the managed file’s folder.

3. Find the managed file you want to delete.

4. Hover the cursor over the triangle ( ) on the right end of the file and click.
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5. Click Delete from the dropdown menu.

6. You are asked to confirm the deletion. Press OK.

7. The asset enters its approval chain.

Like publishing, deleted content must go through the approval chain before it is removed. If

you are the last approver in the approval chain, the content is deleted immediately. See Also:

"Approve/Decline One Content Item" on page 5-35

Asset Workflow
An asset proceeds through the same workflow as any other type of content. A diagram is

below.

AssetWorkflow

ReferenceManual

Version 8.0 Rev 1.3
7-439



See Also:

n "Approving Assets" on page 7-440

n "Adding Assets to Collections and Menus" on page 7-440

Approving Assets

Assets are placed into the approval chain, like other types of content. For more information, see

"Approve/Decline One Content Item" on page 5-35.

Adding Assets to Collections and Menus

You can add an asset to a collection or menu as you would any other type of content. For more

information, see "Working with Collections" on page 9-99 and "Working with Menus" on page

9-129.

Asset Reports
Ektron CMS400.NET provides several reports that track assets by status.
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Report
Displays assets in this

status
For more information, see

Approvals Requiring your approval "ApprovalsReports" on page 7-710

Checked In

Content
Checked in

"Checked In Report" on page 7-

712

CheckedOut

Content
Checked out

"CheckedOut Report" on page 7-

713

New Content
New (that is, created and saved but

never published)

"New Content Report" on page 7-

714

Submitted

Content
Submitted for publication "Submitted Report" on page 7-715

Pending Content Approved and pending a start date
"Content Pending Start Date

Report" on page 7-716

Refresh

Reminder

Report

End date hasbeen reached
"Refresh Reminder Report" on

page 7-717

Expired Content Expired date hasbeen reached
"Expired Content Report" on page

7-718

Content to

Expire

Will expire within specified number

of days

"Content to Expire Report" on page

7-719

Document Management
Configuration
This section explains configuring the Document Management feature. By changing these

settings, you can

n update Document Management server settings

n change which file types are allowed on the Document Management server

n set the View Type
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There are two ways you can configure a Document Management server:

n the Asset Server Setup screen in the Workarea See Also: "Updating Asset Configuration

Settings" on page 7-442

n the AssetManagement.Config fileSee Also: "The AssetManagement.Config File" on page

7-442

In either case, you are editing the AssetManagement.Config file. While the Workarea screen

provides a simple way to update this information, some tags can only be updated in the

AssetManagement.Config file. The table in "The AssetManagement.Config File" on page 7-442

indicates which tags can be edited in the Workarea.

Updating Asset Configuration Settings

You can update some AssetManagement.Config tags from the Ektron CMS400.NET Workarea.

To do that, follow these steps.

Note: Onlymembersof the Administrator User Group can view, add, or edit the Asset Server Setup.

1. In the Workarea, go to Settings > Configuration > Asset Server Setup.

2. The Asset Management Configuration screen appears.

3. The Value field for that tag changes to a text box.

4. Change the information in the text box.

5. Click the Save button ( ).

For more information on each tag, see "The AssetManagement.Config File" on page 7-442.

The AssetManagement.Config File

The following table describes the AssetManagement.Config file’s tags.
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Element Description

Editable

within

Workarea?

CatalogLocation=

The folder location of the Asset Catalog.

This location is used when setting up the index service. For example:

“C:\assetcatalog\”.

CatalogName=
The name of the Asset Catalog. This name is used when setting up

the index service.

DomainName=

Can be Domain Name, IP Addressor Machine Name. An example

is: localhost. This is the addressaWeb client system uses to open

managed documents through HTTP.

FileTypes=

Files types that users are allowed to upload to Document

Management. For more information, see "Allowing File Types" on

page 7-443.

The default file types installed are *.doc,*.xls,*.ppt,*.pdf,

*.gif,*.jpg,*.jpeg,*.txt,

*.log,*.vsd,*.dot,*.zip,*.swf,*.wma,*.wav,

*.avi, *.mp3, *.rm, *.wmv, *.ra, *.mov,

*.odt, *.odf, *.odp, *.odg, *.ods, *.odb

LoadBalanced=
EnablesLoad Balancing for assets. Set to “1” to enable. See Also:

"Load Balancing Assets" on page 19-34

Password=

The password for the user created during the install. This password

is encrypted during the install. If you are changing the user and need

to encrypt a new password, use the

dms400encryptpassword.exeencryption tool located in

C:\Program

Files\Ektron\CMS400versionnumber\Utilities\DMS.

ServerName= The name of the server that hostsEktron CMS400.NET.

StorageLocation=
The folder location where published assets are stored. For example:

“C:\assetslibrary”.

UserName= The user created during the install.

WebShareDir=
The folder where temporary data files that are waiting to be checked

in, saved, or published are stored. For example: ”dmdata”.
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Allowing File Types
Administrators control which file types are allowed in the Document Management

functionality by editing the AssetManagement.config file. Reasons for limiting the file types

include:

n Security - For example, you do not want users to load .exe files to your Document

Management server

n Ease of Management - For example, you want your Document Management server to store

.doc files only

The <FileTypes> tag in the AssetManagement.config file contain the file types users can

upload. The default file types are:
*.doc,*.xls,*.ppt,*.pdf,*.gif,*.jpg,*.jpeg,*.txt,*.log,*.vsd,*.dot,*.zip,*.swf,

*.wma,*.wav,*.avi, *.mp3, *.rm, *.wmv, *.ra, *.mov, *.odt, *.odf, *.odp, *.odg, *.ods,

*.png,*.docx,*.xlsx,*.pptx, *.vsdx, *.htm, *.html *.js,*.wmf,*.css,*.xml.

Adding or Removing a File Type
To add or remove a file type from the list, follow these steps.

1. Edit the Workarea > Settings > Configuration > Asset Server Setup > Update Asset

Configuration Settings screen.

Or

1. Open the AssetManagement.config file. The default location is (webroot)/(site root).

2. Find the FileTypes=”” element. All file types must appear between the quotes. For

example, FileTypes=”*.doc,*.xls”.

Note: Use a comma to separate file types. Also, file typesmust be formatted aswildcard.extension. For example,

adding an .mp3 file type to the list after *.zip looks like this: *.zip,*.mp3

3. Add or remove any file type.

4. Save and close the AssetManagement.config file.

Checking Document Management
Permissions
If you are having any problems with permissions, use this section to verify that your user and

folder settings are assigned properly.

See Also:
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n "User Permissions" on page 7-445

n "Folders Used by Document Management" on page 7-446

User Permissions

When the Document Management functionality is installed, permissions are granted to several

users for the following folders:

n webroot\site root\AssetManagement\dmdata

n webroot\site root\Assets

n root\assetlibrary

The assigned permissions vary depending on your server’s operating system.

The following table lists users and their permissions. Scan down the column of your server’s

operating system to determine which users and permissions should be enabled for the folders

listed above.

You can use this information to help troubleshoot potential permission problems.

User

Needs

these

permissions

Windows

2000 Pro

or XP

Pro

Windows

2003

Server

Windows

2003

Enterprise

Edition

IIS_WPGUser

See

"Advanced

Permissions"

on page 7-446

IUSR_

(The IUSR_ account is required only if

Impersonate is set to True in web.config,

and its username and password attributes

are not specified. If impersonate is set to

false (default setting), the IUSR_

account maybe harmlessly removed from

the folders listed.)

See

"Advanced

Permissions"

on page 7-446

IUSR_Group

See

"Advanced

Permissions"

on page 7-446
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User

Needs

these

permissions

Windows

2000 Pro

or XP

Pro

Windows

2003

Server

Windows

2003

Enterprise

Edition

ASP.NET User

See

"Advanced

Permissions"

on page 7-446

User Defined (The User Defined user

account is required only if Impersonate is

set to True in web.config, and its

username and password attributesare

specified.)

See

"Advanced

Permissions"

on page 7-446

Advanced Permissions
The following are extended permissions for use with the Document Management functionality.

n Traverse Folder / Execute File

n List Folder / Read Data

n Read Attributes

n Read Extended Attributes

n Create Files / Write Data

n Create Folders / Append Data

n Write Attributes

n Write Extended Attributes

n Delete Subfolder and Files

n Read Permissions

Folders Used by Document Management
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Folder Set by Description

assetLibrary User

Defined byuser during installation. The path to this folder can be

viewed and changed in theWorkarea under Settings >

Configuration > Asset Server Setup > Storage Location.

See Also: "The assetLibraryFolder" on page 7-447

dmdata Ektron CMS400.NET

Defined during Ektron CMS400.NET installation. Located in the

AssetManagement folder. Has settings for both the File System

and IIS.

assets Ektron CMS400.NET
Defined during Ektron CMS400.NET installation. Located in site

root folder.

The assetLibrary Folder
The Asset Library folder contains file assets uploaded to and managed by DMS. You can view

and update the path to this folder in the Workarea under Settings > Configuration >Asset

Server Setup > Storage Location.

Managing Multimedia Assets
Multimedia files contain audio, video, or both. File types include .wav, .mpeg., .swf, .avi, and

.wma.

Because of their unique characteristics, these files warrant special treatment within Ektron

CMS400.NET. This section explains how multimedia files are handled through the following

subtopics.

n "Supported Multimedia Players" on page 7-447

n "Multimedia File Types" on page 7-448

n "Working with Multimedia Files in Ektron CMS400.NET" on page 7-449

Supported Multimedia Players
Ektron CMS400.NET supports the following media players.

n WindowsMedia®

n Quicktime®

n Realplayer®

n Flash®
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This means that Ektron CMS400.NET only supports multimedia files that run on one of these

players. If you import a multimedia file that cannot play on any supported player, it is treated

like any other asset but cannot be played within Ektron CMS400.NET.

Downloading Media Players
If a Ektron CMS400.NET user within the Workarea, or a site visitor, tries to play a file and no

supporting media player exists on the user’s computer, the user is prompted to download and

install the player.

If the file uses the Quicktime or Flash media player, the web.config file contains information

that prompts the user to immediately download and install the player.

If the file uses the Realplayer or WindowsMedia media player, the user must go to the host

Web site and download them.

Multimedia File Types
Every multimedia file type has a corresponding MIME type. For example, an mp3 file's MIME

Type is audio/mpeg.

All supported MIME types are defined within the mediasettings element of the web.config file.

That section of the web.config file is reproduced below.

<add key="application/x-shockwave-flash" value="Flash" />
<add key="audio/x-wav" value="WindowsMedia, Quicktime, Realplayer" />
<add key="audio/x-wav-default" value="WindowsMedia" />
<add key="audio/x-pn-realaudio" value="WindowsMedia, Quicktime, Realplayer" />
<add key="video/x-avi" value="WindowsMedia, Quicktime, Realplayer" />
<add key="video/x-avi-default" value="Quicktime" />
<add key="video/x-msvideo" value="WindowsMedia, Quicktime"/>
<add key="video/x-msvideo-default" value="WindowsMedia"/>
<add key="audio/x-ms-wma" value="WindowsMedia"/>
<add key="audio/mpeg" value="WindowsMedia,Quicktime"/>
<add key="video/x-realvideo" value="Realplayer"/>
<add key="video/x-ms-wmv" value="WindowsMedia"/>
<add key="audio/x-realaudio" value="Realplayer"/>

<add key="video/quicktime" value="Quicktime"/>

Note: Agood reference of file and correspondingMIME types is http://www.w3schools.com/media/media_

mimeref.asp.

To determine if a multimedia file type is supported, go to the Web site listed above to find its

MIME type. Then, go to the web.config file section show above to see if the MIME type exists

and, if so, the supported media players.
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Adding Players for a MIME Type
You can add to the list of supported media players for any MIME Type. To do so, open the

web.config file, find the MIME type, and add the player name within the value element.

Here is an example: <add key="audio/mpeg" value="WindowsMedia"/>

As shown, WindowsMedia is the only supported player for mp3 files. If you know that other

players can run mp3 files, insert additional media players after WindowsMedia. To get the exact

name of the player, review the value elements in web.config file section shown above.

Adding MIME Types
If you want Ektron CMS400.NET to support additional MIME Types, add them within the

<mediaSettings> element using the following syntax:

<add key="MIME type/subtype" value="supported media player(s)"/>

For example

<add key="video/x-ms-asf" value="WindowsMedia"/>

You must also add the file type to the list of supported file types in the

assetmanagement.config file. See Also: "Allowing File Types" on page 7-443

Adding a MIME Type’s Default Player
To identify a player as the default for a MIME type, use the following syntax within

web.config.

<add key="MIME Type/subtype" value="default player"/>

For example

<add key="video/x-msvideo-default" value="WindowsMedia"/>
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Working with Multimedia Files in Ektron CMS400.NET

Importing Multimedia Files into Ektron CMS400.NET
You import multimedia files into Ektron CMS400.NET the same way you import other assets.

See "Working with Managed Files" on page 7-435 and "Adding Documents Using Drag and

Drop" on page 7-419.

Once imported into Ektron CMS400.NET, a document proceeds through the same workflow as

any other type of content. See Also: "Approval Chains" on page 5-28

Changing Supported Media Players
After a multimedia file is imported into Ektron CMS400.NET, you can view supported media

players’ properties on the Content tab of the Edit Content screen. All players defined for the

file’s MIME type are checked. You can uncheck any media players that you do not want to

operate a particular file.
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If a default media player is defined for a MIME type in web.config, you cannot uncheck its

checkbox. In the above graphic, WindowsMedia is the default player.

Changing File Properties
After a multimedia file is imported into Ektron CMS400.NET, you can edit its properties on

the Content tab of the Edit Content screen.

If the file is supported by several players, first check the player whose properties you want to

modify, then edit its properties.

The Width and Height fields determine the size (in pixels) of the media player when it appears

in the Workarea and on your Web site. The remaining properties are determined by the media

player (QuickTime in the example above).

Inserting a Multimedia File into Content
To insert a multimedia file into content, follow these steps.

1. Either create a new HTML content item or edit an existing one.
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2. Within the content, type text or insert an image that you want site visitors to click to

launch the multimedia file. For example: Click here to begin playing.

3. Select the image or text you inserted in Step 2.

4. Apply a quicklink to the multimedia file to the selection. This procedure is described in

"Quicklinks and Forms" on page 8-22.

Replacing Multimedia Files
If you want to replace a multimedia file but maintain all CMS information about that file (for

example, its properties, summary, metadata, etc.), follow these steps.

1. Browse to the folder that contains the multimedia content item.

2. Double click the item.

3. The bottom of the Edit screen has a gray rectangle with the text Drag files into this

window and drop to add.
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4. Open Windows Explorer and navigate to the folder that contains the updated multimedia

file.

5. Drag and drop the file into the lower section of the Edit Content screen.

6. Save, Check In, or Approve the content.

Note that after you complete the replacement, you can play and restore older versions of the

file through the content’s history. For more information, see "Viewing and Restoring Previous

Content" on page 7-117.

Viewing and Listening to Multimedia Files
Users in the Workarea and visitors to your Web site play interact with multimedia files in the

same way.

When either type of user visits a page that hosts a multimedia file, Ektron CMS400.NET tries

to match media players on the user’s computer with those defined in the web.config file for the

file’s MIME type. Ektron CMS400.NET then displays a list of choices for every supported

media player for the file. The user selects the preferred one.

Modifying Style Properties of the Multimedia Player
You can change the multimedia player’s style properties by modifying the EKTTabs.css style

sheet. This file is installed to site folder/Workarea/csslib.

For example, you can change the color of the text that selects a player to red by changing the

property highlighted below.

.EktTabActive
{
padding: 2px 2px 2px 2px;
top:10px;
text-decoration:none;
position: relative;
background-color:white;
border: solid thin navy;
color:Red;
font-weight:bolder;

}

Here is the result.
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PDF Generation
PDF (Portable Document Format) is a file type designed for distributing compact, platform-

independent documents. Each document is self-contained, packing text, graphics, and fonts into

a single file.

You can automatically convert Office documents stored in Ektron CMS400.NET to the PDF

format. As a result, when a site visitor accesses a page containing such a document, he sees the

PDF version. Since most computers have a PDF reader, the visitor needs no additional software

to view the file.

Warning! Upon installing Ektron CMS400.NET, the EktronWindowsservice begins communicating with Ektron’s

externalPDF-generation server. To terminate this communication, disable PDF generation. See "Disabling PDF

Generation" on page 19-14. Alternatively, you can generate PDFs locally. See "LocalPDF Generation" on page 7-

455.

Why use PDF?

n Files easily cross multiple platforms, including Microsoft, Apple, Linux, and Unix.

n Documents keep their formatting and appear the same on a computer screen or when

printing.

n File size is typically smaller, which means less bandwidth usage.

n Converted Office documents can be viewed by anyone with a PDF viewer.

n Site visitors do not need a different viewer for each file type.

Note: Ektron CMS400.NET also supports savingMSOffice documents in .html format, which is also formatted for

a browser.

The following sections explain creating PDFs with the Document Management feature:

n "PDF Conversion Process" on page 7-454

n "Local PDF Generation" on page 7-455
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n "Enabling or Disabling PDF Generation" on page 7-456

n "Designating a Folder to Generate PDFs Automatically" on page 7-456

PDF Conversion Process

The PDF conversion of an Office document starts when it is published. At that point, a copy of

the file is sent to an Ektron server for PDF generation. After the server generates the PDF, it is

returned to your Document Management server.

The PDF file doesn’t appear in the CMS400.NET Workarea -- only the originally-published

Office document appears. Ektron CMS400.NET stores the PDF file in a secure location.

Subsequent editing is done in the original Office document. Each time it’s published, a new

PDF is generated.

Once the Office document is added to a Web page, the Web page shows the PDF version. This

means site visitors only need a PDF viewer to view any Office document on your site.

The Ektron Windows Service runs the Office-to-PDF conversion process. See Also: "Ektron

Windows Service" on page 19-13

Local PDF Generation

If you purchase software from a PDF generation software vendor, you can create PDF

documents on a local network instead of sending them an Ektron server. Reasons for
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generating a PDF locally include:

n Speed: Office documents can be converted more quickly

n Security: Office documents never leave the local network

n Quality: You can configure the output quality

The following sections explain setting up local PDF generation.

Modifying the PdfGenerator Information in
AssetManagement.config
When setting up local PDF generation, use the PdfGenerator parameter in the

AssetManagement.Config file to provide the location of the local PDF generator. To modify

the file, follow these steps.

1. Open the AssetManagement.Config file, located in your site root folder.

2. Change the location of the PDF generator.

For example:

PdfGenerator=”http://aspnet20.ektron.com/PdfManager/PdfGeneratorService.asmx”

might become

PdfGenerator=”http://localhost/PdfManager/PdfGeneratorService.asmx”

3. Save and Close the file.

Enabling or Disabling PDF Generation

Administrators decide if this feature is enabled and to which folders it applies. After enabling

this feature, administrators can change any folder’s properties to allow PDF generation.

Follow these steps to enable or disable this feature.

1. In the CMS Workarea, go to Settings > Configuration > Setup.

2. Click the Edit button ( ).

3. Click the Enable Office Documents to be Published in other Format checkbox.

4. Click the Save button ( ).
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Designating a Folder to Generate PDFs Automatically

By setting a folder’s properties to allow PDF generation, all Office documents published in

that folder have a PDF created for them. For an introduction to PDF generation, see "PDF

Generation" on page 7-454.

The steps below explain how to change the folder property for PDF generation.

Note: Existing subfoldersdo not inherit PDF generation. Each subfolder needs to be set individually. However, a

new subfolder inherits the PDF generation setting from its parent folder. Administrators can change the setting

while creating a new subfolder.

1. In the Workarea, click the Content folder button.

2. Click the folder for which you want to enable PDF generation.

3. Click View > Properties.

4. Click the Edit Properties button ( ).View > Properties

5. Click the Publish Office Documents as PDF radio button.

6. Click Save ( ).

Adding Assets Automatically
The Auto Add Asset feature automatically transfers assets placed in a specified folder into

Ektron CMS400.NET.

It’s a very helpful feature if, for example, several users work with assets, you want to manage

them with Ektron CMS400.NET, but the users creating or updating the assets have neither

Ektron CMS400.NET licenses nor the client software installed. These users simply place the

assets in a folder, and the Auto Add Asset feature moves them to Ektron CMS400.NET.

The Auto Add Asset feature is very flexible. While setting it up, you can determine the

following aspects of how it works.

n whether it uploads a single asset, multiple assets, a folder, or a folder and its subfolders

n the location of the uploaded assets

n if subfolders are included, do you want to mirror that structure within Ektron

CMS400.NET?

n file types that can be uploaded

n how frequently the specified assets or folders are checked for new content

The rest of this section explains the Auto Add Asset feature through the following topics.
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n "Installing the Auto Add Asset Feature" on page 7-457

n "Updating the Configuration File" on page 7-458

n "Start the Auto Add Asset Service" on page 7-461

n "Testing the Auto Add Asset Feature" on page 7-462

Installing the Auto Add Asset Feature
Follow these steps to install the Auto Add Asset Feature.

1. Verify that Ektron CMS400.NET is running basic authentication in IIS. For information on

how to do this, see

- IIS 6 -

http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/abbca505-

6f63-4267-aac1-1ea89d861eb4.mspx?mfr=true.

- IIS 7 - http://technet.microsoft.com/en-us/library/cc772009.aspx

2. Create the following directories in the file system of the computer that will transfer the

assets to Ektron CMS400.NET.

n Input - place assets in this directory before uploading them to Ektron CMS400.NET

n Backup - assets are moved to this directory after they are uploaded to Ektron

CMS400.NET

n Error - assets are moved to this directory if there was a problem moving them to the input

folder

3. To each computer that will run the Auto Add Asset Feature, copy the C:\Program

Files\Ektron\CMS400versionnumber\Utilities\AssetWorkerSetup.msi file and run it.

This program creates a new folder, C:\Program Files\Ektron\AssetWorkerSetup.

4. Test that the Web Services are working. To do that, browse to the following page:

http://localhost/cms400min/workarea/webservices/assetservice.asmx

Note: Replace localhost with your server name andCMS400min with your site name.

The page displays two Web services: AddAsset and MakeFolderIfNoExists.

Updating the Configuration File
After installing the Auto Add Asset feature, you can modify the configuration file, which lets

you customize the feature to fit your particular needs.

The file’s name and folder path is C:\Program Files\Ektron\AssetWorkerSetup\maindata.config.

The following table describes its elements.
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Element Description

DmsUserName The user created during the install.

DmsPassword

The password for the user created during the install. This password is encrypted during the

install. If you are changing the user and need to encrypt a new password, use the

dms400encryptpassword.exeencryption tool located in C:\Program

Files\Ektron\CMS400versionnumber\Utilities\DMS.

DmsUserDomain The domain for the user created during the install.

DmsServer The name of the server on which DMS is running.

CmsUserName

Bydefault, Ektron CMS400.NET inserts the user name vs. This is a special user that lets you

work in VisualStudio.net while signing into CMSasan administrator.

Note:See "Remove Sample Users and SampleMembership Users" on page xxivSee

"Securing your Ektron CMS400.NET" on page xxiii advises you to remove the VS user. If you

do, youmust create a new user, assign him to the Administrators groups, and enter his

username and password in these fields.

CmsPassword

Bydefault, Ektron CMS400.NET inserts the password of the VS user. If you change the VS

user’s password, or change the CMSUserName, enter the new password here.

Note: See "Remove Sample Users and SampleMembership Users" on page xxivSee

"Securing your Ektron CMS400.NET" on page xxiiiadvises you to remove the VS user. If you

do, youmust create a new user, assign him to the Administrators groups, and enter his

username and password in these fields.

CmsUserDomain
Enter the Domain Name, IP Addressor Machine Name. An example islocalhost.

AWeb client system uses this address to openmanaged documents through HTTP.

Protocol Enter the protocol used to transfer the assets: httpor hhtps.

CmsSite
Enter the path to your Web site root. For example, one of Ektron CMS400.NET’s sample site’s

root ishttp://localhost/CMS400min.

DmsSite
Enter the path to your Asset Management folder. For example, one sample site‘sAsset

Management folder ishttp://localhost/CMS400min/AssetManagement.

ConfigType

Enter the type of file upload you want. Choicesare:

n file

n multifile

n folder

n autofile

n autofolder
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Element Description

n autofoldercreate

n multifolder

n automultifolder

n automultifoldercreate

These choicesare explained in "File Upload Types" on page 7-460.

Folder:

n Input

n Backup

n Error

Enter paths to the folders you created in Step 2 of "Installing the Auto Add Asset Feature" on

page 7-457. An example is below.

<Input>C:\Test\Input</Input>

<Backup>C:\Test\Backup</Backup>

<Error>C:\Test\Error</Error>

MultiFolder

If your choice at the ConfigTypeelement is listed below, use this element to specify the

folders.

n multifolder

n automultifolder

n automultifoldercreate

Separate each folder with the pipe character (|). Here is an example.

C:\AutoAddAsset\InputPhotos

|C:\AutoAddAsset\InputWorddocs|C:\AutoAddAsset\InputPDFs

CreateFolder

FileTypes

Enter all file types that can be added using the Auto Add Asset feature.

To identify a file type, enter an asterisk(*), a period (.) and the file’s extension. Separate each

file type with a comma. Here is the sample list that appears bydefault:

*.doc,*.xls,*.ppt,*.pdf,*.gif,*.jpg,*.jpeg,*.txt,*.log,*.vsd,*.dot,*.zip

Note: The FileTypes field in the Assetmanagement.config file determineswhich files can be

used within Ektron CMS400.NET. You should not enter file typeshere that are not listed in

AssetManagement.config. See Also: "Allowing File Types" on page 7-443

File Upload Types
There are nine methods for uploading files from the input folder into Ektron CMS400.NET.

The following table explains the options and how each works.
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File Upload Type
What is

uploaded

If folder, are

subfolders also

scanned for

assets?

Are new files

uploaded

automatically?

CMS folder structure

set up tomatch your

file system?

File One file na no no

Multifile

Multiple individual

files separated by

a pipe

na no no

Folder One folder no no no

Autofile One folder no yes no

Multifolder

All specified

folders

Note: Specify the

folders at the

Multifolder

element. See

"MultiFolder" on

page 7-460

yes yes no

Autofolder
All files in specified

folder
yes yes no

Autofoldercreate
All files in specified

folder
yes yes yes

Automultifolder

All files all specified

folders

Note: Specify the

folders at the

Multifolder

element. See

"MultiFolder" on

page 7-460

yes yes no

Automultifoldercreate

All files all specified

folders

Note: Specify the

folders at the

Multifolder

element. See

"MultiFolder" on

page 7-460

yes yes

Yes

Note: Changes to files

alreadyuploaded are

considered new assets
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Start the Auto Add Asset Service
The Auto Add Asset feature uses a Windows Service to transfer assets to Ektron CMS400.NET.

You must begin the service manually every time you start Windows. Follow these steps to start

the Auto Add Asset Service.

1. Go to Windows Control Panel > Administrative Tools > Computer Management.

2. Click Services and Applications > Services.

3. Click the start button (circled below) to start the Automatic Asset Adder service.

Testing the Auto Add Asset Feature
After completing the above steps, you should verify that the Auto Add Asset feature is

working. To do this, follow these steps.

1. Place files of the appropriate type into the specified input folder.

2. Open C:\Program Files\Ektron\AssetWorkerSetup\AssetWorker.exe.config with a text

editor such as Notepad.

3. Change the value of the PollInterval element to 10000. Save and close the file.

4. The input folders will be checked for files every 10 seconds. They should appear within

the Ektron CMS400.NET shortly.
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Merging Indexing Service Catalogs
This section explains how to merge two Windows Indexing Service catalogs. You need to do

this if your server has more than the maximum allowed number of 26 catalogs.

Note: Themaximum number of catalogs is determined byMicrosoft’sWindows Indexing Service.

See Also:

n "Windows Indexing Service Catalogs" on page 7-463

n "Conditions for Merging Catalogs" on page 7-464

n "Procedure for Merging Catalogs" on page 7-464

Windows Indexing Service Catalogs
Warning! When you installmore than threeWeb sites to a server, the catalogs for additional sites are auto-

maticallymerged with one of the three existingWeb site’s catalogs. An existingWeb site’s catalogsare chosen for

merging based on the site with the least amount of directories to index.When aWeb site’s catalogsaremerged

with another, the information for each site is kept separate.

Each Ektron CMS400.NET site has three catalogs. In addition, your server may have catalogs

for other applications that use the Windows Indexing service. Below is an example of what

your Indexing Service catalogs might look like.
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Note that the first six catalogs support two Ektron CMS400.NET web sites: Cms.example2.com

and CMS400Developer. Each site has three catalogs:

n Content

n Private (assets)

n Publish (assets)

Each catalog has a Directories folder, which lists the directories of the content being indexed.

Why Merge Catalogs?
The merge reduces the number of catalogs on your server, yet still indexes each site’s content

for the search. After you merge the catalogs, each site’s search is still limited to content on that

site -- the search does not find content from other sites even though several sites now reside in

one catalog.

When merging catalogs, you copy the directory of the “merge from” catalog to the Directories

folder of the “merge to” catalog. Then, you delete the “merge from” catalog.

Conditions for Merging Catalogs
n You can only merge Ektron CMS400.NET catalogs if the Web sites use the same major

point release. For example, you can merge catalogs from two sites with Release 7.0.4, or a

7.5.0 site with a 7.5.1 site. But you cannot merge a 7.0.4 site with a 7.5 site, because

catalog properties change between releases.

n Each Ektron CMS400.NET site has three catalogs.

- publish

- private

- content

You must merge the same catalog type between sites. So, for example, you cannot merge a pub-

lish with a private catalog.

Procedure for Merging Catalogs
As an administrator, you can merge different Web sites’ catalogs by using Ektron's

MergeCatalog.exe command line utility or by performing the merger manually. For information

on

n Ektron’s MergeCatalog.exe command line utility - see "Using the MergeCatalog.exe

Utility" on page 7-464

n performing the catalog merger manually - see "Manually Merging Catalogs" on page 7-465
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Using the MergeCatalog.exe Utility
There are two ways to use this utility. The first allows you to merge all of your Web sites’

catalogs until you have only three catalog sets. For example, if you have five Web sites, you

can merge their catalogs down to the equivalent of three sites. To merge your catalog sets

down to three, run the MergeCatalog.exe file located in the following folder.

C:\Program Files\Ektron\CMS400v8x\Utilities\MergeCatalog.exe

The second way allows you to merge catalogs from one specified Web site to another. For

example, you want to merge the catalogs from your CMS400Developer site to your eIntranet

site. See Also: "Merging Catalogs from One Web Site to Another" on page 7-465

Merging Catalogs fromOneWebSite to Another

To use Ektron’s MergeCatalog.exe utility, follow these steps:

1. Open a command prompt.

2. Change the directory to
C:\Program Files\Ektron\CMS400v8x\Utilities.

3. Run the MergeCatalog.exe utility.

Usage: MergeCatalog “<fromCMS400dir>” “<toCMS400dir>”

Below is an example of using the MergeCatalog.exe command line utility to merge the

CMS400DeveloperWeb site’s catalogs with the eIntranet site’s catalogs.

MergeCatalog "I:\inetpub\wwwroot\CMS400Developer" "I:\inetpub\wwwroot\eIntranet"

Once the merge is complete, the following message appears in the command box.

“Switching shared catalogs for site at <fromCMS400dir> into site at <toCMS400dir>
Restarting Ektron Windows Service
Catalogs Merged”

Manually Merging Catalogs
Follow these steps for all three catalogs on each site: Content, Private and Publish.

Part 1:Copy the “From”Catalog Path to aNew Directory in the “To”Catalog

In this part, you create a new directory in the “to” catalog. Point the new directory to the

“from” catalog folder. Then, delete the “from” catalog.

1. Open Computer Management > Services and Applications > Indexing Service.

2. Select the first catalog that you want to merge from (that is, the catalog you will delete

after merging).

3. Click its Directories folder.

4. The directory appears in the right pane.

5. Double click it. The Add Directory dialog appears.
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6. Press <Ctrl> + <C> to copy the Path field.

7. In the left panel, select the corresponding “to” catalog, the one into which you will merge

the “from” catalog.

Warning! Make sure the catalog typesmatch: content > content, publish > publish, private > private.

8. Right click the mouse and select New > Directory. The Add Directory dialog appears.

9. In the Path field, paste the path you copied in Step 7 and press OK.

10. Repeat these steps for the other two catalogs on the site that you are merging.

11. Click Indexing Service then stop the Indexing service.

12. Delete the three “from” catalogs.

13. Click Indexing Service then restart the Indexing Service. This action begins indexing the

files in the new directory.

Part 2:Update .Config Files with the New Catalog Location

In this part, you open Windows Explorer and navigate to “from” Web site, that is, the site

whose catalog you deleted above. There, you point its web.config and assetmanagement.config

files to the new catalog.

1. Open Computer Management > Services and Applications > Indexing Service.
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2. Find the catalogs that you have merged into.

3. Resize the window so that it occupies the left half of the screen.

4. Open Windows Explorer.

5. Navigate to the Web site whose catalog you deleted in "Part 1: Copy the “From” Catalog

Path to a New Directory in the “To” Catalog" on page 7-465.

6. In the site root folder, open the web.config file.

7. Resize the window so that it occupies the right half of the screen.

You should see the Computer Management screen on the left, and the web.config file on

the right.

8. In web.config, find the element <webSearch defaultProvider="MSIndexDialectServer">.

Note: Don’t confuse the MSIndexDialectServer tag with MSIndexServer. You only need to change

MSIndexDialectServer.

9. Shortly after that are catalogName and privateCatalogName.

10. Replace the value of catalogName with the name of the publish catalog, visible in the

Computer Management screen. For example:

catalogName="CMS400Developer11282007130734Publish"

11. Replace the value of privatecatalogName with the name of the private catalog. For

example:

catalogName="CMS400Developer11282007130734Private"

12. Save the web.config file.

13. In the site root folder, open the AssetManagement.config file.

14. Resize the window so that it occupies the right half of the screen.

You should see the Computer Management screen on the left, and the

AssetManagement.config file on the right.

15. In AssetManagement.config, find the element CatalogName.

16. Replace the value of CatalogName with the name of the content catalog, visible in the

Computer Management screen. For example:

catalogName="CMS400Developer11282007130734Content"

17. Replace the value of CatalogLoc with the path to the newly-merged catalog. To get the

path:

- open Windows Explorer.

- navigate to the folder to which the catalog is being copied. For example, C:\Program
Files\ Ektron\Catalogs\CMS400Developer11282007130734\Content

- right click the folder and select Properties.

- copy the Location field.
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- Select the assetmanagement.config file’s CatalogLoc tag.

- replace the path with the copied one. For example.

catalogName=”C:\Program Files\ Ektron\Catalogs\CMS400Developer11282007130734\Content”

18. Copy the “to” catalog name and path entered in steps 16 and 17 to the other catalogs and

locations: PublishCatalogName, PublishCatalogLoc, PrivateCatalogName, and

PrivateCatalogLoc.

19. Save the AssetManagement.config file.

20. Stop and restart the Ektron Windows Service.

TIP!

Note: If you still have the Computer Management screen open, you can quickly navigate to Servicesand

Applications>Services>EktronWindowsServices2.0.

Troubleshooting
This section explains how to fix problems that may occur with Ektron CMS400.NET assets.

Symptom See this section

Error message: Install Indexing Service "Setting Up the Indexing Service" on page 7-469

A search of asset files findsno assets on your Web site

"Turning on the Asset Indexing Service" on page

7-480

or

"Troubleshooting" on page 7-468

You cannot drag and drop assets into Ektron

CMS400.NET

"Removing Front Page Server Extensions" on

page 7-485
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Symptom See this section

When a user dragsa document, the file opens in the

browser instead of generating an “Uploading” notification

Ektron KBArticle: http://dev.ektron.com/kb_

article.aspx?id=14204

The server running Ektron CMS400.NET is running

slowly; much of its resourcesare being used even though

the computer is idle

"Disabling the System Indexing Service" on

page 7-476

Error message after trying to upload documents: Failed

with error -2147217911

"Removing aspnet_isapi.dll from the List of

Wildcard ApplicationMaps" on page 7-478

Error message:WindowsServer 2003 no longer ships

MSDAIPP.DLL, thus connecting to an FPSE server

throughWebfolders, is no longer possible.

"UsingMicrosoftWindowsServer 2003 asa

Client (Web FoldersSetup)" on page 7-481

While trying to drag and drop an asset, an error message

appears: The target directory already exists.

Check the impersonateelement of the

web.config file. If it is set to true, make sure the

anonymousaccessaccount hasat least write

access to the dmdataand assetsdirectories.

When you try to publish DMSdocuments, Ektron

CMS400.NET sometimesdoesnot allow them to update.

Make sure your production server is not running

WindowsXP. You cannot use XP asa

production server for DMS.

After recentlymoving the ASM database to a new SQL

server that hasnever hosted an ASM database, the

following error appearswhile adding a DMSasset:

AssetManagement error: Failed to save asset. Internal

Message: RAISERROR could not locate entry for error

2000000002 in sysmessages. at

Ektron.ASM.Documents.Asset.Create(enAssetStatus

state) at ... ....

"ERRMSG: AssetManagement error: Failed to

save asset" on page 7-483

Setting Up the Indexing Service
If you see the following error during installation, you need to set up the indexing service

manually.
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The following steps explain how to do that.

Step Screen

1. ClickStart > Control

Panel > Administrative

Tools > Computer Man-

agement.

The Computer Management

screen appears.

2. Click the plus sign (+) next

toServices and

Applications.

3. Click Indexing Service.
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Step Screen

4. Click the stop button to

halt the indexing service if

it is running.

Note: If the Index service is

running, the start button is

grayed out.

5. Right click Indexing

Service, then clickNew >

Catalog.

6. At the Add Catalog

Screen:

n In theName field, add the

catalog name.

n In the Location field, iden-

tify the folder that will store the

asset catalog.

Note: Bydefault, during

installation, Ektron

CMS400.NET names the

catalogAsset and associates it

with the location

c:\assetcatalog. The

installer can change the default

location.
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Step Screen

7. ClickOK.

The Computer Management

screen showsyour new

Indexing Service.

8. Right click theAsset

catalog, then clickNew >

Directory.

This is the directory the service

indexes.

9. In thePath text box, add

the folder of the secure

storage location. Make

sure the Include in

Index radio button is

markedYes.

Note: Bydefault, during

installation, Ektron

CMS400.NET uses

c:\(Domain Name, IP

Address or Machine

Name)\assetlibrary.
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Step Screen

10. ClickOK. Then, click the

plus sign (+) next toAsset

to view the Directories

folder.

In the Directories folder, the

new directory is displayed.

11. Right click Assets, then

clickProperties.
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Step Screen

12. On the Tracking tab,

uncheckall boxesand

chooseNone forWWW

Server.

13. On theGeneration tab,

uncheck Inherit above

settings from Service.

Then clickOK.

The Index files with

unknown extensions and

Generate abstracts check

boxes can be checked or

empty. It is your choice.
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Step Screen

14. Right click Indexing

Service, then clickAll

Tasks > Tune

Performance.

15. Click theCustomize

radio button.

16. Click theCustomize

button.

Troubleshooting

ReferenceManual

Version 8.0 Rev 1.3
7-475



Step Screen

17. Change Indexing to

Instant.

18. ClickOK and OK again to close both dialog boxes.

19. Click theStart button to

start the service again.

Disabling the System Indexing Service

Symptom
The server running Ektron CMS400.NET is running slowly; much of its resources are being

used even when the computer is idle.
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Cause
The Microsoft Windows Indexing service is turned on during installation. This service indexes

every file on the server, and the resources required to carry out that task slow down other

activities.

Note: Ektron recommends turning off all indexing servicesother than the DMSAsset indexing service.

Resolution
Follow these steps to disable the Windows indexing service. This change does not affect

DMS’s ability to find files because it uses a different indexing service.

Step Screen

1. ClickStart > Control Panel > Admin-

istrative Tools > Computer Management.

The Computer Management screen appears.

2. Click the plus sign (+) next toServices and

Applications.

3. Click Indexing Service.
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Step Screen

4. Click the Stop button to stop the indexing

service.

Removing aspnet_isapi.dll from the List of Wildcard
Application Maps

Symptom
When you try to upload an asset, you get the error message “Failed to upload documents.”

Cause
Remove the aspnet_isapi.dll from the list of Wildcard Application Maps.

Resolution
1. Open IIS.

2. Go to your Ektron CMS400.NET Web site.

3. Underneath the Web site, click Asset Management > dmdata.
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4. Right click dmdata and choose Properties.

5. Click the Virtual Directory tab.

6. Click the Configuration button.

7. Look in the Wildcard Application Maps area. If aspnet_isapi.dll appears, remove it.
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8. Click OK.

Turning on the Asset Indexing Service

Step Screen

1. ClickStart > Control Panel >

Administrative Tools > Com-

puter Management.

The Computer Management screen

appears.
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Step Screen

2. Click the plus sign (+) next to

Services and Applications.

3. Click Indexing Service.

4. Click the Start button to start the

indexing service.

Using Microsoft Windows Server 2003 as a Client
(Web Folders Setup)

Symptom
You receive the following error message:

n Windows Server 2003 no longer ships MSDAIPP.DLL, thus connecting to an FPSE server

through Webfolders, is no longer possible.
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Resolution
Per MS Licensing, you can obtain webfldrs.msi from any down-level OS, or any Office product

that shipped before Windows2003 (not Office 2003) and install the WebFolders client. Doing

so will keep you compliant with licensing.

Installing WebFolders from Office 2003 is only allowed if you have an Office 2003 license for

each Windows2003 server you plan to install WebFolders on.

Web Folders Setup for Microsoft Windows Server 2003

Note: You only need to run theWeb FoldersSetup if there is a problem during the install. The Ektron

CMS400.NET install performs the setup when needed.

The MSDAIPP.DLL is no longer shipped with Microsoft Windows Server 2003, making

communication with Web folders impossible. To correct this, Ektron CMS400.NET setup runs

the Web folder setup when it detects Microsoft Windows Server 2003.

The following steps explains installing Web Folders. You will need to obtain a copy of the

webfldrs.msi file.

Step Setup Screen

1. Double click thewebfldrs.msi file.

2. TheWeb Folders install screen appears.

ClickNext to continue.

3. TheWeb Folders Identity dialog boxappears.

n Add your Name.

n Add yourOrganization.

n ClickNext.
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Step Setup Screen

4. TheWeb FoldersProduct ID dialog box

appears.

This dialog boxdisplays the your product ID

number.

n ClickNext.

5. TheWeb FoldersSelection Choice dialog box

appears.

n Complete - installs all components.

n Custom - you choose the components to

install.

n Typical - installs themost frequently used

components.

After making a selection, clickNext.

6. The VerifyReadyAll dialog boxappears.

Click Install Now.

7. The Action dialog boxappears. The Setup is

installingWeb folders.

8. TheWeAre Done dialog boxappears. ClickOK.

ERRMSG: AssetManagement error: Failed to save
asset

Symptom
After recently moving the ASM database to a new SQL server that has never hosted an ASM

database, the following error appears while adding a DMS asset.

AssetManagement error: Failed to save asset. Internal Message: RAISERROR could not locate

entry for error 2000000002 in sysmessages. at Ektron.ASM.D-

ocuments.Asset.Create(enAssetStatus state) at Ektron.ASM.D-

ocuments.AbstractAssetManagement.Create(AssetMetaData assetMetaData, enAssetStatus state)
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at Ektron.ASM.PluginManager.PluginHandler.Create(AssetMetaData assetMetaData, enAs-

setStatus state) at AssetManagement.AssetManagementService.Create(AssetMetaData asset-

MetaData, enAssetStatus state) at Mojave.AssetManagementProxy.Create(AssetMetaData

assetMetaData, enAssetStatus state) at Ektron.Cms.DataIO.EkContentRW.AddContentv2_0(C-

ollection ContObj) at Ektron.Cms.EkException.ThrowException(Exception ex) at Ektron.Cms.-

DataIO.EkContentRW.AddContentv2_0(Collection ContObj) at

Ektron.Cms.Content.EkContent.AddNewContentv2_0(Collection ContObj)

Cause
During the creation of the ASM database, a total of 7 messages are written to the sysmessages

table in SQL Server’s master database. Each installation of SQL Server has its own master

database and, in a typical move from one location to another, changes to the master database

are not brought over.

If the ASM database was moved, and these messages are not in the sysmessages table in the

new location's master table, the above error appears instead of a standard error message.

Resolution
Run this set of SQL scripts against your database. They add appropriate messages to the

sysmessages table in the master database.

/****************************************************************************************-

********/
sp_addmessage 2000000001, 10, N'Error in %s: Error %d inserting into %s. %s', US_

ENGLISH, FALSE, REPLACE
go
/****************************************************************************************-

********/
sp_addmessage 2000000002, 10, N'Error in %s: Insert into %s returned %d rows. %s', US_

ENGLISH, FALSE, REPLACE
go
/****************************************************************************************-

********/
sp_addmessage 2000000003, 10, N'Error in %s: Failed creating record because primary key

already exists. %s', US_ENGLISH, FALSE, REPLACE
go
/****************************************************************************************-

********/
sp_addmessage 2000000004, 10, N'Error in %s: Error %d updating into %s. %s', US_ENGLISH,

FALSE, REPLACE
go
/****************************************************************************************-

********/
sp_addmessage 2000000005, 10, N'Error in %s: Update into %s returned %d rows. %s', US_

ENGLISH, FALSE, REPLACE
go
/****************************************************************************************-

********/
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sp_addmessage 2000000007, 10, N'Error in %s: Error %d deleting into %s. %s', US_ENGLISH,

FALSE, REPLACE
go
/***************************************************************************************-

*********/
sp_addmessage 2000000008, 10, N'Error in %s: Delete into %s returned %d rows. %s', US_

ENGLISH, FALSE, REPLACE

go

This snippet utilizes the sp_addmessage stored procedure from the master database, which adds

the appropriate messages to the correct table.

Note: Although it is possible to recode these asan INSERT statement that can run directly against the

sysmessages table, that procedure is not recommended.

Removing Front Page Server
Extensions
Follow these steps to remove FrontPage Server Extensions from the Web root. When you do,

the extensions are also removed from all folders below that.

1. Click the Windows Start button.

2. Click Control Panel > Administrative Tools > Computer Management.

3. Open Services and Applications > Internet Information Services > Web Sites > Default

Web Site.
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4. Right click the mouse and select All Tasks > Remove Server Extensions.

AssetControl Server Control
The AssetControl server control, when viewed on a Web form, displays a drag and drop icon

that lets users upload new assets or update an existing one. When this icon is clicked, a drag

and drop box appears. This box is similar to the upload box in the Workarea. See Also:

"Adding Documents Using Drag and Drop" on page 7-419”

The difference between the Workarea and the server control is, in the Workarea users can only

upload assets. With the AssetControl server control, users can upload a new asset or update an

existing one by overwriting it. Even though the asset is overwritten, the previous version is

still available through CMS400.NET’s history feature. See Also: "Viewing and Restoring

Previous Content" on page 7-117
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AssetControl Server Control Properties
The AssetControl server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMS

Explorer and can use it to browse to Content,

Collections, etc. See Also: "Using CMSExplorer

to Browse Your Ektron CMS400.NET Site" on

page 21-9

String

DefaultAssetID

The ID of the asset you want to update. This

property is used when the UploadType

property is set toUpdate. See Also:

"UploadType" on page 7-489

If you don’t know the ID number of the asset,

use the CMSExplorer to browse to it. See Also:

"Using CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9

Long

DefaultFolderID

The ID of the folder where assets are added.

This property is used when the UploadType

property is set toAdd. See Also: "UploadType"

on page 7-489

If you don’t know the ID number of the folder,

use the CMSExplorer to browse to it. See Also:

"Using CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9

Long
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Property Description Data Type

DynamicParameter

Gets or sets the QueryString parameter to read

a content ID or folder ID dynamically. The

content ID is read when the UploadType

property is set to Update. The folder ID is read

when UploadTypeproperty is set to Add. To

use the default content ID or default folder ID,

leave blank.

See Also: "UploadType" on page 7-489

String

Hide

Used to hide output of AssetControl in design

time and run time.

True =Hide AssetControl

False =DisplayAssetControl

Boolean

IsImage

Setting this control to 1 (one) restricts the control

so only images can be uploaded.

1 (one) - restrict the control to uploading images

only.

0 (zero) - upload all typesof assets.

Integer

Language

Set a language for viewing the collection. This

property shows results in design-time (in Visual

Studio) and at run-time (in a browser).

Integer

OverrideExtension

Allows you to restrict the type of asset that can

be uploaded by its extension. For example, to

restrict the control to uploadingWord

documents, enter doc in the property.

Warning! When using this property, enter only

the extension’s letters not the wildcard (*) or

the dot (.).

You can addmultiple extensionsby creating a

comma separated list of extensions. Ektron

recommends limiting the list to five extensions.

String

SuppressWrapperTags

Suppresses the output of the span/div tags

around the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TaxonomyID
The ID of the taxonomywith which to associate

the asset.
Long
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Property Description Data Type

UploadType

Select whether the control addsnew assets or

updatesexisting ones.

n SelectAdd to add assets and use the

DefaultFolderIDproperty. See Also: "Default-

FolderID" on page 7-487.

If a file of the same name alreadyexists in the

folder, the new file is created using the naming

convention filename(2).

n SelectUpdate to update assets. In this

case, youmust identify an asset at the Defaul-

tAssetID property. See Also: "DefaultAssetID"

on page 7-487.

The default isAdd.

UploadTypeEnum

WrapTag

Allowsa developer to specify a server control’s

tag.

The default isSpan.

Span - The <span> tag is used to designate an

inline portion of an HTML document asa span

element.

Div - The <div> tag is used when you want to

apply attributes to a blockof code.

Custom - Allows you to use a custom tag.

String

ImageControl Server Control
The ImageControl server control, when viewed on a Web form, displays an image stored

within the CMS400.NET document management feature. When a user is logged in and has

permission to edit the image, he can right click the image and select edit. This creates a drag

and drop box that the user can use to update the file.
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Warning! Imagesare stored asassets using the Document Management feature. This control doesnot use the

CMS400.NET Library.

ImageControl Server Control Properties
The ImageControl server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to

browse to Content, Collections, etc. See Also: "Using CMSExplorer to

Browse Your Ektron CMS400.NET Site" on page 21-9

String

DefaultImageID

The image asset’s content ID you want to display.

If you don’t know the ID number of the asset, use the CMSExplorer to

browse to it. See Also: "Using CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9

Long

DynamicParameter
Gets or sets the QueryString parameter to read an image asset’s ID

dynamically. To have the default image ID used, leave blank.
String

FolderID

The ID of the folder where imagesare added.

If you don’t know the ID number of the folder, use the CMSExplorer to

browse to it. See Also: "Using CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9

Long

Hide

Used to hide output of AssetControl in design time and run time.

True =Hide AssetControl

False =DisplayAssetControl

Boolean

Language
Set a language for viewing the collection. This property shows results in

design-time (in VisualStudio) and at run-time (in a browser).
Integer
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Property Description
Data

Type

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The

default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TaxonomyID The ID of the taxonomywhere assets are added. Long

Title Set the Image’s alt/title text. Bydefault the image file name is used. String

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a block

of code.

Custom - Allows you to use a custom tag.

String
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Blogs

Blogs (short for Web Logs) are a form of online information sharing. A blog is often set up so a

group of people can share their thoughts on a subject. One person creates the main post and

other comment on post. In addition, blogs can be used to create an online diary of everyday

life.

In the Ektron CMS400.NET Workarea, blogs and blog posts have a relationship similar to

folders and content. The blog is the equivalent of a folder, and blog posts are the equivalent of

content items. While blogs and blog posts have a few unique properties, they mostly work the

same as folders and content.

On your Web site, blogs are arranged so the latest post appears at the top. This differs from

paper diaries, because you are reading the newest material first, instead of the oldest. Because

blogs are laid out this way, site visitors can quickly find the most recent entries.

Blogs are made up of multiple elements. These elements allow site visitors to view or create a

blog post, add comments, and see a roll call of associated blogs. In addition, if a blog calendar

is present on the blog site, visitors can see which days have blog posts.
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Blogs in the Workarea appear as a language bubble in the folder structure. This distinguishes a

blog folder from a content folder.

The following table lists elements commonly found in a blog.

Element Description

Blog Title The name of your blog as you want it to appear on the site. For example, “MyLife Story.”

Blog Post

Themain entry for each topic. A blog post ismade up of several sub elements:

n Headline - the title of the post

n Commentary - the details of the post

n Comment Link - links to a comments page, where site visitors can view or add comments

n TrackBackURL - a URL visitors can use to notify you when theyare talking about the blog

post on their site
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Element Description

n PingBack - PingsbackanyURLs in the blog post

n Images - add images to a blog post. You add images to a blog post the samewayyou add

them to content. See Also: "Adding a LibraryFile to Content" on page 8-18

Blog

Comments

AComments link appears at the end of the blog post. The link includesa number in

parentheses, for example (3).

This number denoteshowmanycomments have beenmade. Click this link tomove to the

comments page, where you can read comments on the post and possibly enter your own.

Blog Roll Other blog sites that the blog’s creator wants site visitors to view.

Blog

Subjects

Subjects associated with the blog. If you click a subject, links to all posts associated with the

subject appear.

Calendar
Indicateswhen blog postsweremade. This lets site visitors navigate your blog by clicking a day

that hasblog posts.

Blog Workflow
The following table explains the workflow of a blog.

Workflow Description See Also

Phase 1

An administrator createsa blog in theWorkarea. During this phase,

he assignsblog subjects, createsa blog roll, and decideshow

comments are handled.

"Adding a Blog" on

page 7-495

Phase 2
A developer adds the blog to aWeb form using the blog server

control. He then publishes the form.

"Introduction to Blog

Server Controls" on

page 7-532

Phase 3

Ektron CMS400.NET users can add blog posts, either from the

Workarea or theWeb site.

Depending on the user’s permissions, the post is either published

immediately or submitted to the blog’s approval chain.

"Blog Posts" on page

7-517

Phase 4

The blog post is published. Now, site visitors can view it and possibly

add comments.

Depending on the blog’s comment settings, theyeither appear

immediately or must be approved first.

"Blog Comments" on

page 7-524
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The following sections explain using the blog feature in the Workarea.

n "Adding a Blog" on page 7-495

n "Blog Properties" on page 7-497

n "Blog Subjects" on page 7-501

n "The Blog Roll" on page 7-505

n "Permissions and Approvals" on page 7-511

n "Language Support" on page 7-513

n "Searching Blogs" on page 7-514

n "Subscribing/Unsubscribing to a Blog" on page 7-514

n "Deleting a Blog" on page 7-513

n "Blog Posts" on page 7-517

n "Blog Comments" on page 7-524

n "Adding or Editing Blog posts with Windows Live Writer" on page 7-530

n "Introduction to Blog Server Controls" on page 7-532

Adding a Blog

Note: To be able to create a blog, youmust have permission toAdd Folders on the blog’sAdvanced

Permissionsscreen. See Also: "Permissionsand Approvals" on page 7-511

To add a blog, follow these steps.

1. Go to the Workarea’s Content folder.

2. Click the folder in which the blog will reside.

3. Click New > Blog.

4. The Add a Blog screen appears.
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5. Fill out the Properties tab according to the table below.

Field Description

Blog Name The name of your blog as it appears in the content folder tree.

Blog Title The title of your blog as it appears on theWeb site.

Visibility

Choose whether the site is private or public.

Public Any site visitor can view the blog.

Private

A site visitor must log in to view the blog.

This includesmembership and Ektron

CMS400.NET users.

Comments
Choose how to handle comments by checking the appropriate boxes. For

more information, see "Controlling Blog Comments" on page 7-524.

6. On the Subjects tab, add subjects to the blog. For more information on blog Subjects, see

"Blog Subjects" on page 7-501.

7. On the Blog Roll tab, add blog sites that you want blog readers to visit. For more

information on blog rolls, see .

Warning! See "Editing a Blog’sProperties vs. Adding a Blog" on page 7-497 for additional properties that are only

available when editing a blog’s properties.
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Blog Properties

Note: To be able to edit blog properties, youmust have permission to Edit Folders on the blog’sAdvanced

Permissionsscreen.

By clicking the blog edit properties button, you can change the following groups of

information about a blog.

n "Editing a Blog’s Properties vs. Adding a Blog" on page 7-497

n "Blog Folder Properties" on page 7-499

n "Metadata" on page 7-500

n "Blog Subjects" on page 7-501

n "Web Alerts" on page 7-504

n "The Blog Roll" on page 7-505

n "Permissions and Approvals" on page 7-511

n "Purge History" on page 7-513

Editing a Blog’s Properties vs. Adding a Blog
When you edit a blog’s properties and settings, more properties and settings are available than

when you created it. This is done to save time when adding multiple blogs to a site.

The table below shows which properties or settings are available when adding and editing a

blog.
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Blog Properties and Settings Availability

Property or Setting
AvailableWhen

Adding a Blog

AvailableWhen

Editing a Blog

Visibility

Blog Name

Blog Title

Tagline

# of Visible Posts

Comment Control

Update Services

Style sheet filename for this folder

Template filename for this folder

Smart Forms

Metadata

Subjects

Web Alerts

Blog Roll

Permissions

ApprovalChain
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Blog Folder Properties
The following table shows the fields on the Blog’s Properties tab. To edit these properties

- View > Properties from the Workarea, navigate to the blog folder, click View >

Properties, then the Edit Properties button ( ).

- from the Web site, log in, navigate to the blog, open the menu for the blog and select

Properties

When you are finished, click Save ( ).

To learn about the other tabs on the Properties screen, see

n "Metadata" on page 7-500

n "Blog Subjects" on page 7-501

n "Web Alerts" on page 7-504

n "Smart Forms" on page 7-505

n "The Blog Roll" on page 7-505

n "Creating SiteMap Breadcrumbs" on page 9-278

Field Description

Visibility

Choose whether the site is a private blog or public.

Public
Anyone who visits the site is able to view the

blog.

Private

A site visitor must log into the site to be able

to

view the blog. This could include

membership users, CMS400 users or both.

Blog Name The name of your blog as it appears in the content folder tree.

Blog Title The title of your blog as it appears on theWeb site blog. It only appears if the
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Field Description

ShowHeaderblog server control property is set to true.

ID

The ID number of the blog. This number is assigned byEktron CMS400.NET and cannot be

changed.

Note: ID only appearswhen viewing the Properties screen. It doesnot appear while editing.

Tagline

A line of additional information that describes the blog. It appears below the title if the

ShowHeaderblog server control property is set to true.

For example, the title of a blog is “John’sBlog Page.” The tag line could be “A place to learn

about John's past, present, future, and his current state of mind!”

# Posts

Visible

The number of posts visible on the blog page. If the number of posts exceeds this number,

only thismanyof themost recent posts appear.

For example, if this property is set to 10 and you add 11 posts, only the tenmost recent posts

appear.

This number can be from 1 to 999.

If you leave this field blank, all postsmade during the current dayare visible.

Comments
Choose how to handle comments by checking the appropriate boxes. For more information,

see "Controlling Blog Comments" on page 7-524.

Update

Service

Enter a service that notifies a blog search site when blog posts are added to your blog site.

These blog search sites allowWeb users to search content contained in blogsaround the

world.

To use this feature, check theNotify blog search engines of new posts boxand enter a

path to a search site. An example path is: http://rpc.technorati.com/rpc/ping.

Style sheet

filename for

this folder.

If you want to provide a custom style sheet for the blog, enter the path to it relative to the site

root. For example, WorkArea/csslib/my_custom_blogs.css.

Leave this field blank to inherit the default style sheet, blogs.css, located in

Workarea/csslib.You can customize the default style sheet but your modificationswill get

overwritten when you upgrade Ektron CMS400.NET.

Page

Templates

Lets you specify one or more templates for content in this folder. For more information, see

"Creating/Updating Templates" on page 7-184.

Metadata
There is no difference when working with Metadata for blogs or folders. For more information,

see "Working with Metadata" on page 7-146.
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Blog Subjects
Subjects make it easier for site visitors scanning a blog page find posts that interest them.

Here’s how they work.

1. The creator of a blog post assigns one or more subjects to it.

2. When the post is published, a list of subjects assigned to all posts appears in the right

column.

3. A site visitor clicks any subject and see all posts relating to it.

For example, a blog’s subjects are General Information, Cancer, Neurology. A user creates a

new blog post about his favorite band, Ektronica, and assigns the music subject to the post.

When a site visitor views the blog page, he looks under Subjects and clicks Music. A list of

music-related posts appears, including the post about Ektronica.

A subject can only be assigned to the blog in which it is created -- it cannot be used with

other blogs. With each new blog, you need to create new subjects. This gives you the

flexibility to tailor unique subjects to each blog.

Adding Blog Subjects
To add a blog subject, follow these steps.

Note: To add a blog subject from theWeb site, youmust be logged in.

1. In the Workarea, navigate to the blog folder.

or

From the Web site

- open the menu for the blog.
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- click Properties.

2. Click View > Properties.

3. Click the Edit Properties button ( ).

4. Click the Subjects tab, then Add Subject.

5. A text box appears.

6. Enter the subject.

Note: Add asmanysubjects as you need by clickingAdd New Subjects.

7. Click Save ( ).

Editing Blog Subjects
To edit a blog subject, follow these steps.

Note: To edit a blog subject from theWeb site, youmust be logged in.

1. In the Workarea, navigate to the blog folder.

or

From the Web site

- open the menu for the blog.

- click Properties.

2. Click View > Properties.

3. Click the Edit Properties button ( ).

4. Click the Subjects tab.

5. Change the information in the text box for the subject you want to edit.View > Properties

6. Click Save ( ).

Note: You can edit several subjects before clicking Save.
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Removing Blog Subjects
There are two ways to remove blog subjects.

n Remove the last link that was added.

n Remove any link in the list.

Each task is explained below.

Removing the Last Blog Subject

Follow these steps to remove the last blog subject on the page.

Note: To remove a blog subject from theWeb site, youmust be logged in.

1. In the Workarea, navigate to the blog folder.

or

From the Web site

- open the menu for the blog.

- click Properties.

2. Click View > Properties.

3. Click the Edit Properties button ( ).

4. Click the Subjects tab.

5. Click Remove Last Subject.

6. A dialog box appears.

7. Click OK to remove the last subject.

Note: You can continue to remove subjects at the end of the list by clicking theRemove Last Subject link.

8. Click Save ( ).
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Removing a Blog Subject

Note: To remove a blog subject from theWeb site, youmust be logged in.

1. In the Workarea, navigate to the blog folder.

or

From the Web site

- open the menu for the blog.

- click Properties.

2. Click View > Properties.

3. Click the Edit Properties button ( ).

4. Click the Subjects tab.

5. Click Remove next to the subject to be removed.

6. A confirmation box appears.

7. Click OK if you want to remove the subject.

Note: You can continue to remove subjects from the list by clicking the Remove link next to each subject.

8. Click Save ( ).

Web Alerts
Web Alerts notify users when a blog post is published. This feature is explained in "Assigning

Web Alert Information to Content" on page 20-25.
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Smart Forms
Use a Smart Form when you want to create structured blogging. Structured blogging provides

a form for the blogger to fill out instead of free form writing. For example, you create a blog

for book reviews. You want to make sure that, when someone submits a review, he provides

the following information:

n Book title

n Author

n Date of review

n Review text

For information on working with Smart Forms, see "Working with Smart Forms" on page 7-

288.

Note: Unlike the Smart Formsyou can assign to regular folders, you cannot require the user to select a Smart

Formwhen creating a new post. It is only an option.

The Blog Roll
The blog roll lets you add a list of Web site links to your blog page. Think of this as a roll

call of blog pages, a list of blogs related to you or that you want visitors of your blog to also

visit. Below is an example of a blog roll on a Web page.
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Adding a Blog Roll Link
Follow these steps to add a blog roll link.

Note: To add a blog roll link from theWeb site, youmust be logged in.

1. In the Workarea, navigate to the blog folder.

or

From the Web site

- open the menu for the blog.

- click Properties.

2. Click View > Properties.

3. Click the Edit Properties button ( ).

4. On the Blog Roll tab, click Add New Roll Link.

5. The Add Blog Roll Link form appears.

6. Fill out the form according to the table below.
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Field Description

LinkName Describes the link in the blog roll.

URL
The URL of the blog you are adding to the blog roll. It must begin with

http://.

Short

Description
Add a short description of the site.

Relationship

Enter the relationship of the blog roll link to you or to the site. For example,

brother.

ClickEdit for a pop up screen that helps you choose the site's relationship.

The table below explains each relationship type.

Type of

Relationship
Description

URL Check this box if the address is owned by the same person or company.

Friendship

What level of friendship do you have with the person who owns the site?

Choose one.

n Contact

n Acquaintance

n Friend

n None

Physical Check this box if you have physicallymet the person who owns this blog.

Professional

Does the person who owns this site have a work level relationship with

you.? Select all that apply.

n Co-worker

n Colleague

Geographical

Select one.

n co-resident

n neighbor

n none
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Type of

Relationship
Description

Family

If the site owner is family, what is the relationship? Select one.

n Child

n Parent

n Sibling

n Spouse

n Kin

n None

Romantic

What are your feelings toward the owner of the site? Checkall that apply.

n Muse

n Crush

n Date

n Sweetheart

7. Click Close.

Note: Add asmany links to the blog boll as you would like. Just clickAdd a New Roll Link. To remove a blog roll

link, see "Removing a Blog Roll Link" on page 7-509.

8. Click Save ( ).

Editing a Blog Roll
To edit a blog roll link, follow these steps.

Note: To edit a blog roll link from theWeb site, youmust be logged in.

1. In the Workarea, navigate to the blog folder.

or

From the Web site

- open the menu for the blog.

- click Properties.

2. Click View > Properties.

3. Click the Edit Properties button ( ).

4. Click the Blog Roll tab.
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5. Find the Blog Roll Link for which the information needs to be edited.

6. Edit the information.

7. Click Save ( ).

Note: Aswith adding a blog roll link, you can edit multiple blog roll linksbefore clicking Save.

Removing a Blog Roll Link
There are two ways to remove blog roll links.

n Remove the last link that was added.

n Remove any link in the list individually.

The steps to perform each task are documented below.

Removing the Last Blog Roll Link
Using this method to remove the last blog link on the page.

1. In the Workarea,

- navigate to the blog folder.

or

From the Web site

- access the blog’s menu from the site.

- click Properties.

Note: To remove a blog roll link from theWeb site, youmust be logged in.

2. Click View > Properties.

3. Click the Edit Properties button ( ).

4. Click the Blog Roll tab.

5. Click Remove Last Roll Link.
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6. A dialog box asks you to confirm.

7. Click OK to remove the last blog roll link.

Note: You can continue to remove subjects at the end of the list by clicking theRemove Last Subject link.

8. Click Save ( ).

Removing a Blog Roll Link
To remove any blog roll link on the list, follow these steps.

1. In the Workarea,

- navigate to the blog folder.

or

From the Web site

- access the blog’s menu from the site.

- click Properties.

Note: To remove a blog roll link from theWeb site, youmust be logged in.

2. Click View > Properties.

3. Click the Edit Properties button ( ).

4. Click the Blog Roll tab.

5. Find the blog roll link to be removed.

6. Click Remove Roll Link above the Link Name to be removed.

Content

7-510
ReferenceManual

Version 8.0 Rev 1.3



7. A dialog box asks you to confirm.

8. Click OK to remove the blog roll link.

Note: Continue to remove subjects by clicking theRemove link.

9. Click Save ( ).

Permissions and Approvals
Permissions for blogs work like folder permissions. The same functionality and features are

available. For more information, see "Approval Chains" on page 5-28 and "Folder Permissions"

on page 5-43.

User Blog Permission/ Approval Table

Function
Permissions that affect this function when

performed fromWeb Site

Permissions that affect this

function when performed

fromWorkarea

Blog

View Published blogsare viewable byany site visitor
Blog properties standard

permissionView-Only

Add Not available
Blog properties advanced

permissionAdd Folders

Edit Not available
Blog properties advanced

permissionEdit Folders
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Function
Permissions that affect this function when

performed fromWeb Site

Permissions that affect this

function when performed

fromWorkarea

Delete Not available
Blog properties advanced

permissionDelete Folders

Post

View Published posts are viewable byany site visitor
Blog properties standard

permissionView-Only

Add Not available
Blog properties standard

permissionAdd

Edit Not available
Blog properties standard

permissionEdit

Delete Not available
Blog properties standard

permissionDelete

Approve Not available
User must bemember of blog’s

approval chain

Comment

Add

Three blog folder properties control how comments can

be submitted fromWeb site. See "Controlling Blog

Comments" on page 7-524.

Blog properties standard

permissionAdd

Edit Not available
Blog properties standard

permissionRead Only

Delete Not available
Blog properties standard

permissionRead Only

Approve Not available
Blog properties standard

permissionEdit

Membership User Blog Permission Table
Membership users can be given permission to edit and add blog posts in the blog. Depending

on the level of permissions, they can perform any of these functions:
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Permission Lets membership user

ReadOnly
Read blog posts.

This boxmust be checked before you can add Edit and Add permissions.

Edit Edit blog posts.

Add Add blog posts.

LibraryReadOnly Add items to the library.

Add Images Upload images to the corresponding library folder.

Add Files Upload files to the corresponding library folder.

Purge History
Purge History works the same way for blogs as it does for the rest of the Ektron CMS400.NET.

See Also: "Purge History" on page 5-21

Language Support
Language Support for blogs and blog posts work the same way as it does for folders and

content. See Multi-Language Support.

Deleting a Blog

Note: To delete a blog, youmust have permission toDelete Folderson the blog’sAdvanced Permissions

screen.

Deleting a blog removes the blog and all posts, comments, and quicklinks for the blog.

Warning! After a blog is deleted, you cannot retrieve its posts, comments, or quicklinks.

The following steps explain how to delete a blog.

1. In the Workarea, navigate to the blog folder.

Or

From the Web site, Open the menu for the blog and click Properties.
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Note: To delete a blog from theWeb site, youmust be logged in.

2. Click the Delete > This Blog.

3. A dialog box asks you to confirm.

4. Click OK to delete the blog.

Searching Blogs
Searching blogs works the same as searching HTML content. See the following topics for an

explanation of using the Search feature.

n "Web Site Search" on page 9-5

n "Searching the Library" on page 8-8

Subscribing/Unsubscribing to a Blog
Logged in Site users and Membership users can subscribe to a blog or a blog post.

By subscribing to a blog, users receive notification when posts are added to the blog. By

subscribing to a blog post, users are notified when comments are added to the post. When you

do not want to receive notices, you can unsubscribe.

The section contains the following topics:

n "Subscribe to a Blog" on page 7-514

n "Unsubscribe to a Blog" on page 7-515

n "Subscribe to a Blog Post" on page 7-516

n "Unsubscribe to a Blog Post" on page 7-516

Subscribe to a Blog
To subscribe to a blog, follow these steps.

1. Navigate to the blog on the site.

2. Click the Subscribe icon ( ) for the blog.
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3. The Subscribe/Unsubscribe screen appears.

4. Select the Notification Type.

5. Click Add Subscription.

A message states that you are now subscribed to the blog. You are forwarded to the blog page.

Unsubscribe to a Blog
To unsubscribe to a blog, follow these steps.

1. Navigate to the blog on the site.

2. Click the Subscribe icon ( ) for the blog.

3. The Subscribe/Unsubscribe screen appears.

4. Select a Notification Type.

5. Check the Unsubscribe check box.
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6. Click Update Subscription.

A message states that you are now unsubscribed to the blog.

Subscribe to a Blog Post
To subscribe to a blog post, follow these steps.

1. Navigate to the blog post on the site.

2. Click the Subscribe icon ( ) for the blog post.

3. The Subscribe/Unsubscribe screen appears.

4. Select the Notification Type.

5. Click Add Subscription.

A message states that you are now subscribed to the blog post. You are forwarded to the blog

post’s page.

Unsubscribe to a Blog Post
To unsubscribe to a blog, follow these steps.
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1. Navigate to the blog post on the site.

2. Click the Subscribe icon ( ) for the blog.

3. The Subscribe/Unsubscribe screen appears.

4. Select the Notification Type.

5. Check the Unsubscribe check box.

6. Click Update Subscription.

7. A message states that you are unsubscribed to the blog post.

Blog Posts
For a definition of blog posts, see "Permissions and Approvals" on page 7-511.

From your Web site, only published blog posts are visible. But, from the Workarea, you can

see all blog posts, regardless of status. Using the Workarea, you can also create, edit, delete,

and archive blog posts the same way you work with content.

This section contains the following subtopics.

n "Blog Posts on the Site" on page 7-518

n "Blog Posts in the Workarea" on page 7-519
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n "Adding a Blog Post" on page 7-521

n "Editing a Blog Post" on page 7-522

n "Deleting a Blog Post" on page 7-523

Blog Posts on the Site
You can view published blog posts on the Web site. The following is an example of one.

A blog post has a Title, Content, Comments Link, Post Time, Date, and Editor Information.

Below is a breakdown of a blog post on a site.
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Item Description

Title The headline of the post. Usuallywhat a site visitor scans through to find a post to read.

Permanent

Link

If you click this link, a new screen appears. The new screen indicates the permanent link to this

blog post. As long as the blog post is active within Ektron CMS400.NET, you can access it via

the URL in the browser’s addressbar.

Most blog pages show only recent posts. After a post ismoved off the blog’s front page, it is still

accessible via this link.

Content The bodyof the post.

Comments

Information

The comments link shows the number in parenthesesof comments for a post .When this link is

clicked, a new page of comments for the post appears.

Also on the page is a form to add comments about the post. The comments only appear if a site

visitor has logged in or authentication is not required for blog comments.

Editor

Information
The person who created or last edited the blog post.

Post Time

and Date
The date and time a blog post was created or last edited.

Blog Posts in the Workarea
Viewing a blog post in the Workarea is similar to viewing content in the Workarea. Navigate

to the folder that contains the blog. Next, in the View Posts in Blog screen, click the title of

the blog post. Below is an example of a viewing a blog post in the Workarea.
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The View Posts in Blog screen shows the following information about each blog post.

See Also: "Blog Posts" on page 7-517; "Permissions and Approvals" on page 7-511

Item Description

Title The headline of the post. Usuallywhat a site visitor scans through to find a post to read.

Comments

Information

The comments link shows the number in parenthesesof comments for a post .When this link

is clicked, the View Comments for Post screen appears.

If a red flag ( ) appears next to the comments icon, theyare awaiting approval.

Editor

Information
The person who created or last edited the blog post.
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Item Description

Post Time

and Date
The date and time the blog post was created or last edited.

Status
The status of the blog post. For example, if the blog post is checked in, the status is I.

See Also: "Content Statuses" on page 7-133

From this screen, you can perform all functions with a blog post that you can with content.

You can give it a summary, add metadata, associate a task, assign Web Alerts, etc. You must

have Edit permission for the blog to perform these functions.

Warning! You can also add a history comment to the blog post by clicking the Comment tab. This is not the same

asadding a comment to a blog post on a site.When you add a history comment, it has the same properties asa

comment associated with content.

Adding a Blog Post

Note: To be able to add a blog post, youmust haveAdd permission on the blog’sStandard Permissionsscreen.

Follow these steps to add a blog post.

1. In the Workarea, navigate to the blog folder. Click New > HTML Post.

Or

From the Web site, open the menu for the blog then choose New Post.

Note: To add a blog post from theWeb site, youmust be logged in.

2. When the Add Content screen appears, use the editor to create the blog post. You create a

blog post the same way you create content. See Also: "Adding HTML Content" on page

7-15.

Warning! If you are using subjects or tags, they can be assigned to a blog post by clicking the Summary tab and

choosing a subject. For more information on subjects, see "Blog Subjects" on page 7-501. For more information

on Tags, see "Tagson the SummaryPage" on page 7-522.
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3. If the user creating the post is a member of the blog’s approval chain, it is published

immediately. If not, it is surrounded by a yellow border, and a member of the approval

chain must approve it before it can appear on the Web site. (For more information on

working with permissions and approvals, see "Approval Chains" on page 5-28.)

4. Once the post is published, it appears within the blog on the Web site.

Tags on the Summary Page
You can add tags to a blog post to further define information about the post for blog search

engines. For example, you create a blog post about your favorite band, Ektronica, and enter the

following tags: Music, Guitars, Rock & Roll.

When a person visits a blog search site and searches for Rock & Roll music, your blog post

appears. Some blog search sites have a page specifically for searching blog tags.

Editing a Blog Post

Note: To be able to edit a blog post, youmust haveEdit permission on the blog’sStandard Permissionsscreen.
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Follow these steps to edit a blog post.

Warning! If another editor changesa blog post, the posting information reflects the new editor, the date, and the

time the information waschanged. This is important to remember if you want the original person who posted the

blog to get credit for the post.

1. In the Workarea, navigate to the blog folder.

Or

From the Web site, open menu for the blog then choose Properties. Next, choose the post.

Note: To add a blog post from theWeb site, youmust be logged in.

2. Click the blog post title you want to edit.

3. Click the Edit button ( ).

4. Change the blog post.

5. When the blog is published, the changes appear in the blog post on the Web site.

See Also: "Blog Posts" on page 7-517

Approving a Blog Post
If someone who is not a member of the blog’s approval chain creates or edits a blog post, its

status is set to Submitted. It will only appear on the Web site after a member of the chain

approves it. While its status is Submitted, it has yellow border on the View Posts in blog

screen.

To approve a blog post, see "Approve/Decline One Content Item" on page 5-35.

Deleting a Blog Post

Note: To be able to delete a blog post, youmust haveDelete permission on the blog’sStandard Permissions

screen.

The following steps explain how to delete a blog post.

1. In the Workarea, navigate to the blog folder.

Or

From the Web site, open the menu for the blog then choose Properties. Next, choose the

post.

Note: To delete a blog post from theWeb site, youmust be logged in.

2. From the menu, click the Delete > Posts.

3. The Delete Contents screen appears.
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4. Click the check box next to each post you want to delete. To select all posts, click the

check box next to Title.

5. Click the Delete Contents button ( ).

6. A dialog box asks you to confirm.

7. Click OK to delete the selected posts.

Blog Comments
Warning! Do not confuse blog commentswith history comments. You can add a history comment to the blog post

by clicking the Comment tab. This is not the same asadding a comment to a blog post on a site.When you add a his-

tory comment, it has the same properties asa comment associated with content.

Blog comments allow site visitors to interact with a blog by adding their thoughts about a

blog post. The blog administrator controls commenting by deciding who can add comments

and if they require approval for publication.

See Also:

n "Controlling Blog Comments" on page 7-524

n "Comments on the Site" on page 7-526

n "Comments in the Workarea" on page 7-527

Controlling Blog Comments
Ektron CMS400.NET provides three properties for controlling comments. Use the Blog

Properties screen to set them. See Also: . The following table describes these properties.
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Field Description

Enable

Comments

Allowsuser inWorkarea and site visitor to add blog

comments. Also displays comments on site and inWorkarea.

Note: Amember of the Administrators group can alwaysadd comments, regardlessof how

this checkbox is set.

Moderate

Comments

Determines if commentsmust be approved before theyappear on site.

If this field is checked, only userswith permission to edit the post can approve comments

(see illustration of this permission below).

If userswithout this permission add comments, theyonly appear on theWeb site after being

approved by someone with permission to edit the post.

If someone hasedit post permission and authenticates before submitting a comment, it is

approved automatically.

Appearance of Unapproved Comments

On theWorkarea’sView Posts in Blog screen, an unapproved comment is indicated bya red

flag .

On the View Comments for Post screen, an unapproved comment is indicated bya yellow

border.

Require

Authentication

Determines if a user must be authenticated (that is, logged in asa CMS400 user or

membership user) to add comments via theWeb site.

Comments by default are fully controlled. This means they are enabled, must be approved, and

a site visitor must be authenticated to create them.

If comments are enabled but not moderated, any site visitor can add a comment. If you don’t

want censorship, this is the way to go.
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Warning! While you can delete a comment at any time, if comments are not moderated, theyappear on your site

as soon asa site visitor submits them.

However, to make sure comments on your site meet certain criteria, moderate them.

The following topics are explained in this section.

n "Comments on the Site" on page 7-526

n "Comments in the Workarea" on page 7-527

Comments on the Site
On the site, comments for a blog post appear when one of the following blog post items is

clicked:

n the Comments link

n the Title of the blog post

The comment page contains the original post, any comments that have been added, and a form

to post new comments. Depending on how the page is designed, the calendar and blog roll can

also appear.
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The Comment Form

Note: See "Controlling Blog Comments" on page 7-524 to learn about how an administrator determines if and by

whom comments can be submitted.

Site visitors, regular users, and Membership users can add comments by filling out the form on

the comments page. The form has five fields.

Field Description

Name

The person submitting the comment. This information is required.

Note: This text boxappears onlywhen a site visitor, who is not a regular user or membership

user, is adding a comment. If a regular user or membership user addsa comment, their name

and email address is taken from their user profile.

Email

The email addressof the person submitting the comment. This information is required.

Note: This text boxappears onlywhen a site visitor, who is not a regular user or membership

user, is adding a comment. If a regular user or membership user addsa comment, their name

and email address is taken from their user profile.

Homepage AURL for the person’sweb site.

Comment

Section
A text area to insert comments about the post.

Post

Comment

button

Post a comment by clicking this button.

Depending on the comment’s settings, it either posts immediately or is submitted for approval.

See Also: "Controlling Blog Comments" on page 7-524

Comments in the Workarea
In the Workarea, you can add, view, approve, edit, and delete comments for a blog post. See

Also: "Blog Comments" on page 7-524

The comment link (illustrated below) indicates the number of comments. To work with

comments, navigate to the blog folder and click the comment link next to a blog post.
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This leads you to View Comments screen. Here, you can view approve, edit, delete, and add

new comments.

Note: To learn about recognizing unapproved commentsand approving them, see "Controlling Blog Comments"

on page 7-524.

See Also:

n "Adding a Comment" on page 7-528

n "Editing a Comment" on page 7-529

n "Deleting a Comment" on page 7-529

n "Approving a Comment" on page 7-529

Adding a Comment

Note: To be able to add a comment, youmust haveAdd permission on the blog’sStandard Permissionsscreen.

To add a blog post comment from the Workarea, follow these steps.

1. From the Content area, navigate to the blog.

2. Click the Comments icon to the left of the post that you want to comment on.

3. Click New > Comment.

4. The Add Comment screen appears.

For a description of the fields on this screen, see "The Comment Form" on page 7-527.

Note that Add Comment screen provides an additional field, State. This field lets the

submitting user set the comment’s state to approved or pending. Approved comments appear on

the site immediately. Pending comments must be approved before they appear.

To learn about the approval process for pending comments, see "Moderate Comments" on page

7-525. See Also: "Blog Comments" on page 7-524; "Permissions and Approvals" on page 7-511
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Editing a Comment
1. From the Content area, navigate to the blog.

2. Click the Comments icon to the left of the post whose comment you want to edit.

3. Locate the comment you want to edit.

4. Click edit.

5. The Edit Comment screen appears.

For a description of the fields on this screen, see "The Comment Form" on page 7-527.

Note that Edit Comment screen provides an additional field, State. This field lets the

submitting user set the comment’s state to approved or pending. Approved comments appear

on the site immediately. Pending comments must be approved before they appear.

To learn about the approval process for pending comments, see "Moderate Comments" on page

7-525.

See Also: "Blog Comments" on page 7-524; "Permissions and Approvals" on page 7-511

Deleting a Comment
Once a comment is deleted, you cannot retrieve it.

1. From the Content area, navigate to the blog.

2. Click the Comments icon to the left of the post whose comment you want to delete.

3. Click delete.

4. A dialog box asks you to confirm.

5. Click OK to delete the comment.

Approving a Comment
Comments can require approval if

n they are submitted from the Web site and Moderate Comments is checked in the blog’s

folder properties

n a user submits the comment from the Workarea set its state to Pending

Only users with permission to edit content (posts) within the blog folder can approve

comments. To learn about the approval process for pending comments, see "Moderate

Comments" on page 7-525.

To approve a comment, follow these steps.

1. From the Content area, navigate to the blog.
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2. Click the Comments icon to the left of the post whose comment you want to approve.

(Unapproved comments are indicated by a red flag ( ).

3. Click approve.

4. The comment’s status changes to approved.

See Also: "Blog Comments" on page 7-524;

Adding or Editing Blog posts with
Windows Live Writer
Ektron CMS400.NET authors and membership users can use Windows LiveTM Writer to add

and edit blog posts to your site. If users have the proper permissions, they upload images and

attach files from their system. See Also: "Permissions and Approvals" on page 7-511.

For additional Windows Live Writer help from Microsoft, click here.

Follow these steps to set up Windows Live Writer to work with your Ektron CMS400.NET

Blog. If you have previously set up Windows Live Writer, click Weblog > Edit Weblog

Settings. Then, skip to step four.

Step Windows LiveWriter Setup Screen

1. Download and StartWindowsLiveWriter.

When theWelcomewindow appears, click theNext button.

Do not create aWindowsLive Spacesaccount.

2. In the Choose Blog Type window, select theAnother

weblog service radio button.

ClickNext.
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Step Windows LiveWriter Setup Screen

3. In theWeblog Homepage and Login window, enter the

following information:

n Weblog Homepage URL - this is the page that con-

tains the blog. For example, http://<your

site>/CMS400Min/blogs.aspx.

n Username - your username to log on to the Ektron

CMS400.NET site.

n Password - your password to log on to the Ektron

CMS400.NET site.

n Edit Proxy Settings... - edit the proxy settingsas

needed.

ClickNext.

4. In the Select Provider widow, chooseCustom

(Metaweblog API) from the Type of weblog that

you are using dropdown box.
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Step Windows LiveWriter Setup Screen

5. In theRemote posting URL for your weblog

textbox, add a link to the xmlrpc.aspx file for the site.

The default location for the file in the demo site is
http://<your

site>/CMS400Min/Workarea/Blogs/xmlrpc.aspx

.

ClickNext.

6. When theWeblog Configuration Complete window

appears, Add a blog name in theWeblog Name field.

ClickFinish.

Introduction to Blog Server Controls

Note: In addition to reading this section on the Blog server controls, you should also read "Blogs" on page 7-492.

Ektron provides nine server controls that relate to displaying a Blog on a Web site. One of

these, the Blog server control, allows you to display all of the pieces that typically make up a

blog site on a Web form. These items are blog entries, blog posts, blog categories, a blog’s

recent posts, a blog’s RSS feed, an archive, a blog calendar and a blog roll.

The other seven Blog server controls allow you to display each of these items individually.

The eight individual Blog server controls offer additional ways to customize the page layout

and appearance of the items.

The nine Blog server controls provided by Ektron are

n "Blog Server Control" on page 7-533
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n "BlogEntries Server Control" on page 7-537

n "BlogPost Server Control" on page 7-540

n "BlogCalendar Server Control" on page 7-542

n "BlogRoll Server Control" on page 7-543

n "BlogCategories Server Control" on page 7-545

n "BlogRecentPosts Server Control" on page 7-546

n "BlogRSS Server Control" on page 7-547

n "BlogArchive Server Control" on page 7-548

Using the Blog Server Control vs. Using the Individual
Blog Server Controls
When you use the Blog server control to display a blog, you only have to deal with one server

control and its settings. This makes adding a blog to your site quick and easy.

Using the Individual Blog server controls to display a Blog, allows you the flexibility to

display the parts of a Blog you want to display. For example, you might to display the Blog

entries and a Blog roll, but not display a Blog calendar. In addition, using the individual Blog

server controls allows you to further define the display details of each control.

Blog Server Control
The Blog server control allows you to quickly add a blog to a Web form. It has all of the items

commonly found on a blog page in one server control. These items include blog posts, a

comments link, a blog roll, blog categories, recent blog posts, the RSS feed for a blog, an

archive and a blog calendar. If you want to learn more about each item, see "Blogs" on page 7-

492.

The Blog server control allows you to easily maintain the overall look of the blog. When you

change display properties, such as the background color or font, they change for the whole

blog, not just a piece of it.

While you can change display properties, you cannot change the location of each item in the

server control. The title always appears on the top, with the tagline below it. The blog posts

always appear to the left and the calendar, blog roll, blog categories, recent blog posts, RSS

feed, archive and blog roll to the right.
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The Blog server control is easy to use. Simply add it a Web form and set the BlogPath property

to the folder location in the CMS400.NET. Next, choose whether to enable RSS and whether

to show the header and tagline.

If you want to further customize the look of the blog, you can edit the Blog.css file located in

webroot\siteroot\Workarea\csslib.

Blog Server Control Properties
The following table explains the properties of the Blog control.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value
Data

Type

ArchiveMode

Select whether the archive appears inmonth format or year

format. The default ismonth.

String
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Property Value
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it

to browse to Content, Collections, etc. See Also: "Using CMS

Explorer to Browse Your Ektron CMS400.NET Site" on page 21-

9

String

BlogID

The ID of the blog in CMS400.NET. For example: 41.

If you don’t know the ID of the blog, use the CMSExplorer to

browse to it. See Also: "Using CMSExplorer to Browse Your

Ektron CMS400.NET Site" on page 21-9

Long

CacheInterval

Sets the amount of time the server control’s data is cached. The

default is 0 (zero). This is the amount of time, in seconds, a

control’s data is cached. For example, if you want to cache the

data for fiveminutes, set this property to 300 (three hundred).

See Also: "Caching with Server Controls" on page 21-31

Double

DateToStart

The date of the last blog entries you want to appear. For

example, if you want to display blog entries for January 1, 2007

and before, you enter 1/1/2007. Clicking the dropdown box

provides you with a calendar.

DateTime

DefaultUserID

The ID of the user who owns the blog to be displayed. This

property is used when the server control displaysa user's blog.

To display a blog not associated with a user, leave this property

set to 0 (zero) and enter the blog's ID in the BlogIDproperty.

Long

DynamicParameter

Gets or sets the QueryString parameter to read a Blog ID

dynamically. Set to “None - Use Default” if you want to always

display the default blog.

None - Use Default - use the default Blog ID list.

ID - readsa Blog’s ID dynamically

ekfrm - readsa form block’s ID dynamically

String

DynamicUserParameter

Gets or sets the QueryString parameter to read a user ID

dynamically. Set to “Use Default” if you wish to alwaysdisplay the

default user's blog (static.)

String

EditorHeight Sets the height of the blog editor in pixels. Integer

EditorWidth Sets the width of the blog editor in pixels. Integer

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean
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Property Value
Data

Type

JavascriptEditorHTMLMode

Note: Asof version 7.6, the JavaScript editor hasbeen removed

fromCMS400.NET. This property hasbeen deprecated.

Set to True to allow users to edit their posts and replies in HTML.

The default isFalse.

String

Language

Set a language for viewing blog posts. This property shows

results in design-time (in VisualStudio) and at run-time (in a

browser).

Integer

MaxResults

Set themaximum number of posts to display. If set to 0 (zero),

there is no limit. If set to -1, all posts for the dayare shown. If set to

-2, all posts for themonth are shown, If set to -3, the control uses

the # of Post Visible setting in theWorkarea. The default is -3.

See Also: "# of Visible Posts" on page 7-498

Integer

PostParameter

Works like the DynamicParameter for content blocks.When id

is selected, this server control passes the blog post ID asa URL

parameter.

The default setting is id.

Blank - the list of blog posts is static. The links in the blog posts

are inactive.

id - the id of the blog post is passed to the URL asa parameter.

None use default - the list of blog posts is static. The links in the

blog posts are inactive.

String

RecentPosts
The number of post links contained in the Recent Posts list. The

default is 5 (five).
Integer

ShowHeader

Shows the title and tagline when set to True.

The default isTrue.

True - show title and tagline.

False - do not show header and tagline.

Boolean

ShowRSS

Displays the icon for the RSS feed ( ) when set to True. The
default isTrue.

True - show RSS feed icon.

False - do not show RSS feed icon.

Boolean

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control.

The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean
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7-536
ReferenceManual

Version 8.0 Rev 1.3



Property Value
Data

Type

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of

an HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a

blockof code.

Custom - Allows you to use a custom tag.

String

BlogEntries Server Control
The BlogEntries server control allows you to display a list of multiple blog posts on from a

blog on a Web form. It also allows you to display a user’s Journal (personal blog). By using

this server control, you can display blog posts or journal entries to a Web form without having

to work with the other items normally contained in a blog.

Using this server control in combination with the other individual blog server controls, allows

you the flexibility to change the appearance of this control without changing other blog

controls. In addition, you can layout the controls any way you like, unlike the Blog server

control. Below is an example of a BlogEntries server control.
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To use this server control to dynamically display a blog’s entries, set the following properties:

n DynamicParameter - set this property to the parameter name used to pass a blog ID to the

QueryString. The default is blogid.

n BlogPostParameter - set this property to the parameter name used to pass a blog post’s ID

to the QueryString. The default is id.

To use this server control to dynamically display a user’s Journal, set the following properties:

n DynamicUserParameter - Set this property to the parameter name used to pass a user’s ID to

the QueryString.

n BlogPostParameter - set this property to the parameter name used to pass a blog post’s ID

to the QueryString. The default is id.

BlogEntries Server Control Properties
The following table explains the properties of the BlogEntries control.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to

browse to Content, Collections, etc. See Also: "Using CMSExplorer

to Browse Your Ektron CMS400.NET Site" on page 21-9

String

BlogID

The ID of the blog in CMS400.NET fromwhich blog entries are

displayed; for example, 41. This is the default ID that is used when a

blog ID is not passed dynamically to the QueryString. To passa blog

ID dynamically, set the DynamicParameter property.

If you don’t know the ID of the blog, use the CMSExplorer to browse

to it. See Also: "Using CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9

Long

BlogPostParameter

Set this property to the parameter name used to passa blog post’s

ID to theQueryString. The default is id. When a parameter is

defined, this server control passes the blog post’s ID asa URL

parameter. If you do not set this parameter to id, you will not be

forwarded to the blog post’s page when you click on any links in the

post.

The default setting is id.

Blank - the list of blog posts is static. The links in the blog posts are

inactive.

String

Content
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Property Value
Data

Type

id - the ID of the blog post is passed to the URL asa parameter.

None use default - the list of blog posts is static. The links in the

blog posts are inactive.

CacheInterval

Sets the amount of time the server control’s data is cached. The

default is 0 (zero). This is the amount of time, in seconds, a control’s

data is cached. For example, if you want to cache the data for five

minutes, set this property to 300 (three hundred). See Also:

"Caching with Server Controls" on page 21-31

Double

DateToStart

The date of the last blog entries you want to appear. For example, if

you want to display blog entries for January 1, 2006 and before, you

enter 1/1/2006. Clicking the dropdown boxprovides you with a

calendar.

DateTime

DefaultUserID

The ID of the user who ownsa Journal fromwhich to display journal

entries. To display journal entries not associated with a user, leave

this property set to 0 (zero) and enter the blog's ID in the BlogID

property.

Warning! If you define a DefaultUserID, it overrides the BlogID

property.

Long

DisplayXslt

Specify an externalXSLT file.

Warning! If you specify an external file, it is strongly recommended

that you do not store this file in theWorkarea folder. If you store this

file in theWorkarea folder, the file will be lost when you upgrade.

String

DynamicParameter

Gets or sets the QueryString parameter to read a Blog ID

dynamically. Set to “None - Use Default” if you want to alwaysdisplay

the default blog. The default isblogid.

Note: If an ID for this property is passed on theQueryString and a

an ID for the DynamicUserParameter property is passed the control

displaysblog entries for a user.

String
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Property Value
Data

Type

DynamicUserParameter

Gets or sets the QueryString parameter to read a User ID

dynamically. Set to “Use Default” if you wish to alwaysdisplay the

default user's blog (static.)

Note: If an ID for this property is passed on theQueryString and a

an ID for the DynamicUserParameter property is passed the control

displaysblog entries for a user.

String

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

Language

Set a language for viewing the blog entries. This property shows

results in design-time (in VisualStudio) and at run-time (in a

browser).

Integer

MaxResults

Set themaximum number of posts to display. If set to 0 (zero), there

is no limit. If set to -1, all posts for the dayare shown. If set to -2, the

all post for themonth are shown, If set to -3, the control uses the # of

Post Visible setting in theWorkarea. The default is -3.

See Also: "# of Visible Posts" on page 7-498

Integer

ShowHeader

Shows the title and tagline when set to True.

The default isTrue.

True - show title and tagline.

False - do not show header and tagline.

Boolean

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The

default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

BlogPost Server Control
The BlogPost server control allows you to display an individual blog post on a page.

There are two ways this server control displays a blog post. First, if a user is logged in as a

CMS400.NET user or a Membership user, the control displays the blog post, comments and

comments form on the Web page. The second way is if a user is not logged in, the control

displays only the blog post.

Content
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Note: TheEnable Comments property in theWorkareamust be enabled for commentsand the comments form

to appear.

BlogPost Server Control Properties
The following table explains the properties of the BlogPost control.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to

browse to Content, Collections, etc. See Also: "Using CMSExplorer to

Browse Your Ektron CMS400.NET Site" on page 21-9

String

CacheInterval

Sets the amount of time the server control’s data is cached. The default

is 0 (zero). This is the amount of time, in seconds, a control’s data is

cached. For example, if you want to cache the data for fiveminutes, set

this property to 300 (three hundred). See Also: "Caching with Server

Controls" on page 21-31

Double

DefaultContentID

The ID of a default blog post that appearswhere you inserted this

server control if no other content block is identified, or is not available.

If you don’t know the ID number of the blog post, use the CMSExplorer

to browse to it. See Also: "Using CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9

Long

DisplayXslt

Specify an externalXSLT file.

Warning! If you specify an external file, it is strongly recommended

that you do not store this file in theWorkarea folder. If you store this file

in theWorkarea folder, the file will be lost when you upgrade.

String

DynamicParameter
Tomake this blog post dynamic, select id. When you do, this server

control uses the blog post passed asa URL parameter.
String

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

Language
Set a language for viewing the blog posts. This property shows results

in design-time (in VisualStudio) and at run-time (in a browser).
Integer

ShowType
Showsa blog post’s content and its comments or just the blog post’s

comments. The default isContent. String
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Property Value
Data

Type

Content - Show a blog post’s content and its comments.

Description - Show a blog post’s comments only.

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The

default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a block

of code.

Custom - Allows you to use a custom tag.

String

BlogCalendar Server Control
The BlogCalendar server control allows a user to display a calendar on a Web page and

associate it with a blog. When a blog calendar is associated with a blog, the days that have

blog posts are highlighted on the calendar.

You can use a BlogCalendar server control with a BlogEntries server control. This gives site

visitors a way to view blog posts for a given day.

BlogCalendar Server Control Properties
The following table explains the properties of the BlogCalendar control.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value
Data

Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to

browse to Content, Collections, etc. See Also: "Using CMSExplorer to
String

Content
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Property Value
Data

Type

Browse Your Ektron CMS400.NET Site" on page 21-9

BlogID

The ID of the blog in CMS400.NET. For example: 41.

If you don’t know the ID of the blog, use the CMSExplorer to browse to

it. See Also: "Using CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9

Long

CacheInterval

Sets the amount of time the server control’s data is cached. The default

is 0 (zero). This is the amount of time, in seconds, a control’s data is

cached. For example, if you want to cache the data for fiveminutes, set

this property to 300 (three hundred). See Also: "Caching with Server

Controls" on page 21-31

Double

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

Language
Set a language for viewing the calendar. This property shows results in

design-time (in VisualStudio) and at run-time (in a browser).
Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The

default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a block

of code.

Custom - Allows you to use a custom tag.

String

BlogRoll Server Control
The BlogRoll server control displays the blog roll for a blog on a Web form. A blog roll is a

list of links to other blogs. Blog rolls are created in the Workarea for each blog. This control

BlogRoll Server Control

ReferenceManual

Version 8.0 Rev 1.3
7-543



reads that list and displays a clickable list of links. For more information on the blog roll,

see"The Blog Roll" on page 7-505.

Typically this control is displayed along side other individual Blog server controls. Using the

individual server controls, such as the BlogRoll server control, allows you more flexibility for

layout and appearance than using the Blog server control.

Note: Clicking a blog roll link opens the destination page in a new window.

BlogRoll Server Control Properties
The following table explains the properties of the BlogRoll control.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to

browse to Content, Collections, etc. See Also: "Using CMSExplorer to

Browse Your Ektron CMS400.NET Site" on page 21-9

String

BlogID

The ID of the blog in CMS400.NET. For example: 41.

If you don’t know the ID of the blog, use the CMSExplorer to browse to

it. See Also: "Using CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9

Long

CacheInterval

Sets the amount of time the server control’s data is cached. The default

is 0 (zero). This is the amount of time, in seconds, a control’s data is

cached. For example, if you want to cache the data for fiveminutes, set

this property to 300 (three hundred). See Also: "Caching with Server

Controls" on page 21-31

Double

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

Language
Set a language for viewing the Blog roll. This property shows results in

design-time (in VisualStudio) and at run-time (in a browser).
Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The

default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

Content
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BlogCategories Server Control
The BlogCategories server control displays a blog’s categories on a Web form. Blog categories

are created in the Workarea for each blog. This control reads that list and displays a clickable

list of links. When a link is clicked it displays all the posts associated with the category.

Typically this control is displayed along side other individual Blog server controls. Using the

individual server controls, such as the BlogCategories server control, allows you more

flexibility for layout and appearance than using the Blog server control.

BlogCategories Server Control Properties
The following table explains the properties of the BlogCategories control.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and

can use it to browse to Content, Collections, etc. See

Also: "Using CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9

String

BlogID

The ID of the blog in CMS400.NET. For example: 41.

If you don’t know the ID of the blog, use the CMS

Explorer to browse to it. See Also: "Using CMSExplorer

to Browse Your Ektron CMS400.NET Site" on page 21-

9

Long

CacheInterval

Sets the amount of time the server control’s data is

cached. The default is 0 (zero). This is the amount of

time, in seconds, a control’s data is cached. For

example, if you want to cache the data for fiveminutes,

set this property to 300 (three hundred). See Also:

"Caching with Server Controls" on page 21-31

Double

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean
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Property Value
Data

Type

Language

Set a language for viewing the Blog categories. This

property shows results in design-time (in VisualStudio)

and at run-time (in a browser).

Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the

control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

BlogRecentPosts Server Control
The BlogRecentPosts server control displays a list of recent blog posts links on a Web form.

when a link is clicked it takes you to the blog post. You can control how many recent post

links are displayed by setting the NumberofPosts property.

Typically this control is displayed along side other individual Blog server controls. Using the

individual server controls, such as the BlogREcentPosts server control, allows you more

flexibility for layout and appearance than using the Blog server control.

BlogRecentPosts Server Control Properties
The following table explains the properties of the BlogRecentPosts control.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to

browse to Content, Collections, etc. See Also: "Using CMSExplorer to

Browse Your Ektron CMS400.NET Site" on page 21-9

String

BlogID

The ID of the blog in CMS400.NET. For example: 41.

If you don’t know the ID of the blog, use the CMSExplorer to browse to

it. See Also: "Using CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9

Long

Content
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Property Value
Data

Type

CacheInterval

Sets the amount of time the server control’s data is cached. The default

is 0 (zero). This is the amount of time, in seconds, a control’s data is

cached. For example, if you want to cache the data for fiveminutes, set

this property to 300 (three hundred). See Also: "Caching with Server

Controls" on page 21-31

Double

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

Language

Set a language for viewing the blog’sRecent Posts list. This property

shows results in design-time (in VisualStudio) and at run-time (in a

browser).

Integer

NumberofPosts Sets the number of post links to display. The default is 5 (five). Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The

default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

BlogRSS Server Control
The BlogRSS server control displays the icon ( ) for the blog’s RSS feed on the Web form.
When the icon is clicked, the RSS feed for the blog appears.

Typically this control is displayed along side other individual Blog server controls. Using the

individual server controls, such as the BlogRSS server control, allows you more flexibility for

layout and appearance than using the Blog server control.

BlogRSS Server Control Properties
The following table explains the properties of the BlogRSS control.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

BlogRSS Server Control

ReferenceManual

Version 8.0 Rev 1.3
7-547



Property Value
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to

browse to Content, Collections, etc. See Also: "Using CMSExplorer to

Browse Your Ektron CMS400.NET Site" on page 21-9

String

BlogID

The ID of the blog in CMS400.NET. For example: 41.

If you don’t know the ID of the blog, use the CMSExplorer to browse to

it. See Also: "Using CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9

Long

CacheInterval

Sets the amount of time the server control’s data is cached. The default

is 0 (zero). This is the amount of time, in seconds, a control’s data is

cached. For example, if you want to cache the data for fiveminutes, set

this property to 300 (three hundred). See Also: "Caching with Server

Controls" on page 21-31

Double

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

Language
Set a language for viewing the RSS feed. This property shows results

in design-time (in VisualStudio) and at run-time (in a browser).
Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The

default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

BlogArchive Server Control
The BlogArchive server control displays a list of past months or years that have posts. This

server control can be used with the BlogEntries server control and the calendar control to allow

site users to scan for older Blog posts.

Content
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By clicking a month in the archive, the calendar changes and the entries appear for that month.

BlogArchive Server Control Properties
The following table explains the properties of the BlogArchive control.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value
Data

Type

ArchiveMode

Select whether the archive appears inmonth format or year format.

The default ismonth.

String

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to

browse to Content, Collections, etc. See Also: "Using CMSExplorer to

Browse Your Ektron CMS400.NET Site" on page 21-9

String

BlogID

The ID of the blog in CMS400.NET. For example: 41.

If you don’t know the ID of the blog, use the CMSExplorer to browse to

it. See Also: "Using CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9

Long
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Property Value
Data

Type

CacheInterval

Sets the amount of time the server control’s data is cached. The default

is 0 (zero). This is the amount of time, in seconds, a control’s data is

cached. For example, if you want to cache the data for fiveminutes, set

this property to 300 (three hundred). See Also: "Caching with Server

Controls" on page 21-31

Double

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

DynamicParameter
Sets the QueryString parameter to read a Blog ID dynamically. Leave

blank to alwaysdisplay the default blog.
String

Language
Set a language for viewing the Blog’s archive. This property shows

results in design-time (in VisualStudio) and at run-time (in a browser).
Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The

default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a block

of code.

Custom - Allows you to use a custom tag.

String

Content
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Web Calendars

Web Calendars in Ektron CMS400.NET perform the same function as a paper calendar - they

keep visitors informed about upcoming events. They can be displayed to all visitors to your

Web site, and any authorized user can add events to a calendar.

Typical calendar events could include

n company meeting

n reserving a conference room for an interview

n company holidays

n community group events

n personal events

n training dates

Web Calendars allow you to create many calendars for your Web site. Users may add events

that are posted for visitors to see.

Create a Web Calendar in Ektron CMS400.NET using three basic steps.

1. Create the Calendar within Ektron CMS400.NET. See Also: "Adding a System Calendar

Folder " on page 7-553
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2. Place either the WebCalendar Server control or the WebCalendar Widget on a template.

See Also: "Using the WebCalendar Server Control" on page 7-584 or "Web Calendar

Widgets" on page 7-569

3. Add appointments. See Also: "Adding Web Calendar Events" on page 7-562

Calendar Types
There are three basic calendar types in Ektron CMS400.NET system - the System, User, and

Group Calendar types. The calendar type determines where events are stored in the database

and what permissions are needed to edit them.

System Calendar User Calendar Group Calendar

Where events

are stored

Workarea Content

Calendar Folder

CommunityUser

Calendar

CommunityGroup

Calendar

Where events

are added or

edited

TheWeb page or

Workarea folder

The community user’s

profileWeb page

The community group’s

Web page

Where

permissionsare

set

Folder Permissions
CommunityUsers and

Colleagues

CommunityGroup

Membership

How it appears

on aWeb page
Web page with Server Control or Widgets

For more

information see

"Adding a System

Calendar Folder " on page

7-553

"Creating a Calendar in

MyProfile" on page 7-577

"Creating a Calendar in

MyGroup" on page 7-580

Displaying Calendars
There are two ways to display Web Calendars on a Web page.

n Web Calendar Server Control (see "Web Calendar Server Control" on page 7-584)

n Web Calendar Widget ("Web Calendar Widgets" on page 7-569).

The following sections explain using the Web Calendar feature.

n "Adding a System Calendar Folder " on page 7-553

n "Viewing System Calendar Folder Properties" on page 7-554

n "Changing System Calendar Permissions" on page 7-558

n "Using the Web Calendar page" on page 7-559

n "Adding Web Calendar Events" on page 7-562
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n "Web Calendar Widgets" on page 7-569

n "Using Community Web Calendars" on page 7-576

n "Web Calendar Server Control" on page 7-584

n "Customizing the Web Calendar" on page 7-587

n "Web Calendar Mashups" on page 7-590

n "Using Taxonomy with Web Calendars" on page 7-594

n "Using Previous Calendar Versions" on page 7-595

Adding a System Calendar Folder
A system calendar folder contains events shown in various places within a Web site.

To add a System Calendar into an Ektron CMS400.NET Web site, follow these steps.

Note: Youmust have permission toEdit Folders on the Advanced Permissionsscreen.

1. In the Workarea, click the Content Tab.

2. Right click the folder into which you will add a Calendar.

In the example below, we add a new calendar into the CMS400Demo folder.

3. Click Add Calendar.

You see this Add Calendar window.
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4. Enter the Calendar Name.

5. Enter the Description.

6. If needed, enter the path and name of the Style Sheet. See Also: "Style Sheet filename for

this folder: (leave blank to inherit)" on page 7-556.

7. Click the Add Calendar button ( ) to save your changes and create the new calendar
folder.

Notice that the System Calendar folder is different from the other Folder icons, as shown

below.

After you create a System Calendar folder, you can add events. See Also: "Adding Web

Calendar Events" on page 7-562.

Viewing System Calendar Folder
Properties
The Calendar folder properties screen lets you set permissions as well as modify the folder’s

metadata, taxonomy, templates, flagging, Web Alerts and Breadcrumbs.

This section covers the following topics.

n "Fields on the Calendar Folder Properties Tab" on page 7-555

n "Calendar Properties Template Tab" on page 7-556

n "Other Calendar Properties Tabs" on page 7-557
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n "Editing Calendar Folder Properties" on page 7-558

To view the System Calendar properties, follow these steps.

1. Open the Workarea.

2. Click the Content Tab.

3. Click the calendar folder you wish to view.

4. The View Events screen appears.

5. Click View > Properties.

6. The View Properties screen appears.

Fields on the Calendar Folder Properties Tab

Field Description

ID The Calendar Id is automatically assigned by the system.
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Field Description

Name The name of theWebCalendar folder.

Description The description of theWebCalendar folder.

Style Sheet

filename

for this

folder:

(leave

blank to

inherit)

Specify a style sheet that defines styles that maybe applied to event content in this folder. The

style sheet that you identifymust reside in the site root folder. Or, leave this field blank to inherit

the parent folder’s style sheet.

The style sheet populates the style dropdown list (see below) within the editor.

Note: This style sheet affects event content being edited. It doesnot necessarily affect the

content’s appearance on your Web site. To set or edit the style sheet that determines your Web

pages’ appearance, open the page’sWeb form and place a <link rel=”stylesheet”...

tag within its<HEAD> tags. If desired, you can identify the same style sheet in both locations. To

include user-selectable styles, theymust be generic classes.

Calendar Properties Template Tab

Field Description

Inherit Parent

Template

Configuration

Check this box to inherit the template from the parent content folder.

Or, do not check this boxand specify one or more templatesbelow. See Also: "Inheritance

of Folder Templates" on page 7-187.

Page

Templates

Specify one or more templates for Calendar events in this folder. This folder’s content uses

the specified template when appearing on your Web site. See Also: "Inheritance of Folder

Templates" on page 7-187.

Content

7-556
ReferenceManual

Version 8.0 Rev 1.3



Other Calendar Properties Tabs

Tab Description

Taxonomy

Tab

n If you want this folder to inherit taxonomyconfigurations from the parent folder, check

Inherit Parent Taxonomy Configuration.

If you uncheck Inherit Parent Taxonomy Configuration, you can then select taxonomies

that can be applied to content in this folder.

n If you want all content in this folder to be assigned at least one taxonomycategory, check

Required at least one category selection.

See Also: "Inheriting Taxonomies from a Parent Folder" on page 9-215; "Taxonomy" on page

9-200

Flagging

Tab

Check this box if content in this folder inherits a flagging definition from its parent folder. If you

do not check the box, use the dropdown list to apply a flagging definition to content in this

folder.

See Also: ”Flagging” on page 16-236, ”Assigning a Flagging Definition to a Folder” on page

16-239

Metadata

Tab
"AssigningMetadata to a Folder" on page 7-165

Web Alerts

Tab
"AssigningWeb Alert Information to Folders and Content" on page 20-21

Breadcrumb

Tab
"Creating SiteMap Breadcrumbs" on page 9-278

Folder Properties Toolbar
The Folder Properties screen contains these toolbar buttons.

Button Name Description More Information

Edit Properties
Access the Edit Folder

Properties screen

"Editing Calendar Folder Properties" on

page 7-558

Permissions
Access the folder’sPermissions

Table
"Folder Permissions" on page 5-43

Purge History
Access the folder’s purge history

table
"Purge History" on page 5-21

RestoreWeb

Alert

Assigns the folder’sWeb Alert

properties to all content in folder

"Inheriting Content-LevelWeb Alert

Information from ItsFolder" on page 20-
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Button Name Description More Information

Inheritance 28

Back Go to previous screen

Editing Calendar Folder Properties
To edit any properties for a calendar folder, follow these steps.

1. Access the View Properties screen for the folder you want to edit, as described in

"Viewing System Calendar Folder Properties" on page 7-554.

2. Click the Edit button ( ).

3. The folder’s Edit Properties screen appears.

4. Make the necessary changes to the content folder’s properties. See "Fields on the Calendar

Folder Properties Tab" on page 7-555.

5. Click the Update button ( ).

Changing System Calendar
Permissions
You control System Calendar permissions in the same way you set permissions for other

content folders.

For further information about setting permissions see "Folder Permissions" on page 5-43.
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Using the Web Calendar page
A Web Calendar shows the current day, month, or week when you first view it in either a Web

site page or in the Workarea.

When logged in, you can add or edit events to the calendar. See "Adding Web Calendar

Events" on page 7-562 .

You must have permission to add or edit events. See "Changing System Calendar Permissions"

on page 7-558 for more information.

Topics covered in this section.

n "Selecting the Day, Week or Month View" on page 7-561

n "Selecting the Previous or Next Period" on page 7-561

n "Choosing a Date " on page 7-562

n "Adding Web Calendar Events" on page 7-562

Month, Week, Day Views
The calendar displays a Month, Week or Day view. To change the view, use the settings in the

upper right corner of the calendar. See Also: "Selecting the Day, Week or Month View" on

page 7-561
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Month View

Week View
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Day View

Selecting the Day, Week or Month View
Click one of the buttons on the top right corner of the calendar to choose the view

The appearance of these buttons is controlled by the WebCalendar server control property

DisplayType=”All”. See Also: "WebCalendar Server Control Properties" on page 7-584

Selecting the Previous or Next Period
Click the left or right arrow (circled below) to move the calendar forward or backward by one

period of time.
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In the example above, if you click the right arrow, you see Nov, 2009. If you click the left

arrow, you see Sept, 2009.

Choosing a Date
Click the arrow shown circled below to open the Date popup.

Find and click the date you wish to show on your calendar.

Adding Web Calendar Events

Note: Youmust log in to Ektron CMS400.NET and have permission to edit events in the calendar folder. See Also:

"Setting Permissions through the PermissionsTable" on page 5-43

To add an event to a calendar, follow these steps.

n "Step 1 - Use the Edit Appointment page" on page 7-563

n "Step 2 - Edit the Event Title, Location and Description" on page 7-563

n "Step 3 - Change the Start Time and the All Day Option" on page 7-564

n "Step 4 - Set Recurrences " on page 7-565

n "Step 5 - Select a Taxonomy Category" on page 7-567

n "Step 6 - Set Metadata for the Event" on page 7-567
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Step 1 - Use the Edit Appointment page
To add or edit an event on the calendar, follow these steps

1. Navigate to your calendar from either the Web page containing the calendar or from the

Workarea -> Content Tab and select the appropriate calendar folder.

2. Double click any day to add a new event for it. The example below adds an event to the

27th of the month.

3. The Edit Appointment screen appears.

Step 2 - Edit the Event Title, Location and Description
1. Enter the title of the event into the Title text box. “Training Day” for example.This title

shows on the calendar and in the pop-up.

2. Enter the location. This appears in the pop-up.

3. Enter the Description. This appears in the pop-up.
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Mouse-over the event to see these fields as shown below.

This pop-up can be customized. See "Customizing the Web Calendar Tooltip" on page 7-587

for more information.

Step 3 - Change the Start Time and the All Day Option
At the bottom of the Edit Appointment page, notice that the selected date appears as the Start

Time, and All Day is checked as the time.

All day events appear differently in the calendar than those with fixed starting and ending

times. For example, in a weekly view, all day events appear at the top and others appear in

their proper time slot as show below.

To change the start and end date/time, follow these steps.

1. Uncheck the All Day option to add the time of day.

2. For start date, click the calendar button ( ) and set the start date.

3. For start time, enter the time text or click the clock button ( ).
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4. If you use the clock button, choose the values and click the Set button when finished.

5. To set the end date and time, repeat steps 2-4.

Time Zones for Events
Event times are stored in the Ektron CMS400.NET database as UTC (also known as

Greenwich Mean Time - GMT). For members or visitors that login, events show in the

member’s time zone. For visitors that are not logged in, the events show in the Web server’s

time zone.

For information about setting the User time zone, see "Time Zone Field" on page 15-23.

Step 4 - Set Recurrences
Appointments can be set to recur Daily, Weekly, Monthly, or Yearly. They can be spaced at

various intervals and have a finite duration or recur indefinitely.

Follow these steps to set a recurrence for a Weekly event that occurs on each Wednesday for

the next 5 weeks.

1. Click the Recurrence tab on the Edit Appointment window.

2. Check the Recurrence checkbox, as shown below.
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3. Click the Weekly option.

4. Enter 1 to set the recurrence to occur every week.

5. Click the Wednesday checkbox.

6. Enter 5 to end after this many occurrences.

7. Save your changes.

Editing a Recurring Appointment
When you edit a recurring event, you see the following prompt.

Edit only this occurrence to change just one event. Edit the series to change all events.
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Step 5 - Select a Taxonomy Category
A typical calendar taxonomy helps screen events a Web site visitor might wish to see. For

example, a College Sports Web site might show all sports, but the visitor may only want to

view Football games.

To show only those events related a specific category on your calendar page, use a Taxonomy.

See Also: "Taxonomy" on page 9-200.

Follow these steps to set taxonomy categories for your event.

1. Click the Taxonomy tab on the Edit Appointment window.

2. Check the appropriate categories.

In the example below, we selected the User Training and Training Center categories.

See Also: "Using a Taxonomy Filter for Calendar Events" on page 7-594

Step 6 - Set Metadata for the Event
Each event can have Metadata associated to it. To learn more about metadata, see "Working

with Metadata" on page 7-146.

In the example below, a map address is associated to an event so that the event’s location can

show on a map. See Also: "Map Server Control" on page 9-247

To set the metadata, follow these steps.

1. Click the Metadata tab on the Edit Appointment window.

2. Fill in the Metadata values in the fields provided.
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An example of metadata fields for an event is shown below.

Save Your Appointment
At any time, click the Save button to display it on the Calendar.
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When you finish, the calendar looks like this.

Web Calendar Widgets
You place Web Calendars on a Web page by using either a WebCalendar server control or a

Web Calendar Widget in a PageBuilder page.

The Web Calendar widget provides an easy way to add calendars to a Web page. It is one of

the standard widgets provided in Ektron CMS400.NET. See Also: "Standard Widgets" on page

21-404.
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You can drag-and-drop the web calendar widget into these page types.

n PageBuilder (See Also: "Building PageBuilder Pages" on page 6-1)

n Smart Desktop (See Also: "Personalizing the Smart Desktop" on page 4-4)

The web calendar widget looks like this when you are logged in.

For more information about using the Web Calendar interface, see "Using the Web Calendar

page" on page 7-559.

The following topics show how to configure the Web Calendar widget.

n "Adding a System Calendar to a Widget" on page 7-570

n "Adding User Calendars to a Widget" on page 7-571

n "Adding a Group Calendar to a Widget" on page 7-574

Adding a System Calendar to a Widget
A system calendar is managed as a Calendar folder within the Workarea content. For more

information, see "Adding a System Calendar Folder " on page 7-553.

To add System Calendars to this widget, follow these steps.

1. Click the edit icon (circled below) in the upper right corner of the Web Calendar widget.

Content

7-570
ReferenceManual

Version 8.0 Rev 1.3



2. Click the Folder tab.

3. Locate the Calendar Folder to add.

4. Click the Add button ( ).

5. The System Calendar (724) is added to the Selected Calendars list. .

Adding User Calendars to a Widget
To show one or more user calendars on a Web Calendar widget, follow the steps below.

1. Click the edit icon (circled below) in the upper right corner of the Web Calendar widget.

2. Click the User tab.
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3. Click Add My Calendar to add your own calendar.

Your calendar is added to the Calendar Widget.

Searching Users to Add to Your Personal Calendar Widget
In addition to your own calendar, you may wish to add colleagues calendars to yours. This

way you can quickly compare their important dates, vacations, meetings with your own.

To add additional users to your calendar, continue with these steps.

1. Click the User Tab.

2. In the Search box, enter a name, such as John.

3. Click the Search Users button.

The example below shows all the users named John.
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4. Click the Add Calendar button ( ) next to any user.

Now it appears on the Selected Calendars tab as shown below. You will see both

calendars together on your Web page.

5. Click the Event Color dropdown to choose the background color used for the event on the

calendar. AutoSelect will use the next available color in the list.
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6. To remove any calendar, click the Remove button ( ).

7. Click the Save button.

Adding a Group Calendar to a Widget
To show one or more Group calendars on a Web Calendar widget, follow the steps below.

1. Click the widget edit icon (circled below) in the upper right corner of the web calendar

widget.

2. Click the Group tab.

3. Search for other group calendars by entering their group name and click the Search

Groups button.

The example below shows a search for groups that contain “information” in their title.
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4. Click the Add Calendar button ( ) next to a calendar you wish to add.

The group calendar you selected appears on the Selected Calendars tab as shown below.

5. Click the Event Color dropdown to choose the background color used for the event on the

calendar. AutoSelect will use the next available color in the list.
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6. To remove any calendar, click the Remove button ( ).

7. Click the Save button.

Using Community Web Calendars
Both Community Groups and Community User profile pages can show a Web Calendar.

In the following example, the profile page contains a personal calendar
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The calendar displayed on a personal community page obeys the same community rules as

other features in the community. You can restrict the visibility of your events to only

colleagues or make them public.

Creating a Calendar in My Profile
A web calendar can be used inside of individual community profiles to track personal

appointments.

The following section describes how to use the WebCalendar server control on a user profile

template.

Note: An alternate way to use a personal calendar is to use aWebCalendar Widget on the user dashboard. See

"WebCalendar Widgets" on page 7-569 for more information.

Adding a WebCalendar ServerControl to a User Profile
The example below shows code to place a Web Calendar server control on a User Profile

template.

<CMS:WebCalendar ID="WebCalendar1" runat="server" >
<DataSource>
<CMS:CalendarDataSource sourceType="UserCalendar" dynamicParameter="id” />
</DataSource>
</CMS:WebCalendar>

The following properties must be set for CalendarDataSource.

Property Set to this value

sourceType UserCalendar

dynamicParameter id

Creating the User Calendar in the Database
To use a personal calendar, you must add your personal Calendar into the database. Each user

needs to do this one time when they decide to have a calendar for their own profile.

Add a User Calendar into the database by following these steps.

1. Login to your Website.

2. Navigate to your personal web page.
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3. Click the Edit Profile link.

In this example, the Edit Profile link (circled below) is located on a personal profile page

of the eIntranet Starter Site.

4. The Edit Profile window appears.

5. Click the Custom tab.

6. Check the Create User Calendar box (circled below) to create a User Calendar in the

database.
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Warning! After you save this profile, you cannot later uncheck this option.

7. Click the Save button.

Now, your calendar exists in the database and can appear on your profile page. To add events,

see "Adding Web Calendar Events" on page 7-562.
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Creating a Calendar in My Group
In any Ektron CMS400.NET Community Group, you can add a Web Calendar.

The following is an example of a calendar on a community group page

This calendar could show many types of events important to a group such as:

n Group meetings

n Team schedules

n Project Milestones

The calendar displayed on a community group page obeys the same community rules as other

features in the community. You can restrict the visibility of your group events to only group

members or you can make the calendar public.

The following section describes how to use the WebCalendar server control to do this.

Note: An alternate way to use group calendars is using theWebCalendar Widget on a group dashboard. See

"WebCalendar Widgets" on page 7-569 for more information.
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Adding a WebCalendar ServerControl to a Group
Profile
The example below shows code to place a Web Calendar server control on a Group Profile

template.

<CMS:WebCalendar ID="WebCalendar1" runat="server" >
<DataSource>
<CMS:CalendarDataSource sourceType="GroupCalendar" dynamicParameter="id” />
</DataSource>
</CMS:WebCalendar>

The following properties must be set for CalendarDataSource.

Property Set to this value

sourceType GroupCalendar

dynamicParameter id

Creating the Group Calendar in the Database
To use a group calendar, you must add the group calendar into the database. Each group needs

to do this one time when they decide to have a calendar for their group.

Add a group calendar database by following these steps.

1. Login to your Website.

2. Navigate to your group web page.

3. Click the Edit Group link.

In this example, the Edit Group link (circled below) is located on this group profile page

of the eIntranet Starter Site.
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4. The Edit Group Link window appears

5. Check the Create Group Calendar checkbox (circled below) to create a group calendar in

the database.
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Warning! After you save this profile, you cannot later uncheck this option.

6. Click the Save button.

Now, a group calendar exists in the database and can appear on the group page. To add events,

see "Adding Web Calendar Events" on page 7-562.
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Web Calendar Server Control
The Web Calendar server control displays any calendars managed by Ektron CMS400.NET.

The Web Calendar Server Control is explained in the following topics:

n "Using the WebCalendar Server Control" on page 7-584

n "WebCalendar Server Control Properties" on page 7-584

n "CalendarDataSource Properties" on page 7-586

n "See the following for additional information about the using the CalendarDataSource

properties." on page 7-587

Using the WebCalendar Server
Control
The Web Calendar server control code looks like this.

<cms:WebCalendar ID="webcalendar" runat="server" DynamicParameter="calendar_id"

DisplayType="Day">
<DataSource>
<cms:CalendarDataSource defaultId="724" sourceType="SystemCalendar" />
</DataSource>
</cms:WebCalendar>

The two parts of the WebCalendar Server Control are:

n cms:WebCalendar Server Control. See Also: "WebCalendar Server Control Properties" on

page 7-584

n cms:CalendarDataSource, located inside the WebCalendar tags. See Also:

"CalendarDataSource Properties" on page 7-586

WebCalendar Server Control
Properties
The WebCalendar server control properties are described in this table.
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Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value
Data

Type

AllowEventEditing

Determineswhether Events can be added and edited on the calendar.

Default is “True”. See Also: "Changing SystemCalendar Permissions"

on page 7-558

Boolean

DefaultDisplayType

Specify the Calendar view type. The default isMonth whichmeans

that theMonth view of the calendar will show on theWeb page. The site

visitor can change the view. See Also: "Selecting the Day,Weekor

Month View" on page 7-561.

String

DisplayTemplatePath

Specify the path to the code that controls how events are displayed.

Default is blank. See Also: "Customizing theWebCalendar Tooltip" on

page 7-587

String

DisplayType

Determineswhat time period choiceswill be presented on the

calendar. See Also: "Selecting the Day,Weekor Month View" on page

7-561

ChoicesareAll,Day,Month,Week.

Default is “All”

String

DynamicParameter

Tomake this calendar dynamic, select calendar_id. When you do, this

server control uses the calendar passed asa URL parameter. To

exclude this function, choose “None- Use Default”.

OnlyCalendarswith sourcetype=”SystemCalendar” maybe used in

the querystring for this value.

For example, where DyanamicParameter=”calendar_id”, the URL

may read http://mysite.com/calendar.aspx?calendar_id=”55”. In this

case, calendar 55must be of the SystemCalendar type.

String

Hide

Used to hide the output of a calendar in design time and run time.

True =Hide calendar

False =Display calendar (Default setting)

Boolean

Language
Set a language for viewing a calendar. This property shows results in

design-time (in VisualStudio) and at run-time (in a browser).
Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The

default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean
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Property Value
Data

Type

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a block

of code.

Custom - Allows you to use a custom tag.

String

CalendarDataSource Properties
The table below shows properties set inside the CalendarDataSource tag.

Property Value
Data

Type

backColor

The background color of the event shown on the calendar. This example shows

backColor=“yellow”.

If you set this value to “AutoSelect”, the next available color in the list is chosen

automatically. This is the list of color choices.

String
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Property Value
Data

Type

defaultId
The Id of the SystemCalendar, GroupCalendar or UserCalendar to display on the

Web page.
String

queryParam

The parameter that maybe in the query string tomash-up additional calendars.

This can be anyCalendar SourceType.

For example, if the value is set to uid, then the querystring can be:

.../calendar.aspx?calendar_id=”55”&uid=”440”

String

sourceType ChoicesareSystemCalendar, GroupCalendar, UserCalendar. String

See the following for additional information about the using the CalendarDataSource

properties.

n "Web Calendar Mashups" on page 7-590

n "Using Taxonomy with Web Calendars" on page 7-594

Customizing the Web Calendar
The Web Calendar can be customized in many ways. Two methods are shown as follows:

n "Customizing the Web Calendar Tooltip" on page 7-587

n "Changing Web Calendar Style Sheets" on page 7-589

Customizing the Web Calendar
Tooltip
When you hover over a Calendar event, a tooltip automatically shows its details.
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You can change how this tooltip looks and behaves. Do this by modifying the

telerik:RadToolTip properties.

Changing the Event Tooltip Control
You can apply many changes to a tooltip, but for a simple explanation, we will choose just

two. In this example, we make the tooltip appear without delay and have fade-in animation.

The example below uses the EktronTech starter site.

Before starting, be sure to add an event to your calendar so that you see the default behavior.

See Also: "Adding Web Calendar Events" on page 7-562.

Then follow these steps.

1. Open the EktronTech Website file folder in your editor.

2. Make a copy of the Display.ascx and Display.ascx.cs files from this folder

<siteroot>\workarea\WebCalendar\DefaultTemplate

3. Paste them into a new folder in the Web site such as <siteroot>\CustomUserControls.

Warning! Ektron recommends that youmake a copyof these files andmove them to a folder that is not inside the

\Workarea folder. Upgradesoverwrite files in the \workarea folder.

4. Edit the new ascx file you just created.

5. Change these properties on the Telerik:RadToolTip server control.

Property Value Default Value

ShowDelay 0 400

Animation Fade None

6. Save your changes.

7. Edit your template.

8. Change the following properties on the WebCalendar server control to set the location of

this revised display.ascx file.
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Property Value (example)

DisplayTemplatePath /CustomUserControls/display.ascx

See Also: "Using the WebCalendar Server Control" on page 7-584

9. Save your changes.

10. Refresh the browser page containing the calendar.

11. Mouse-over the event on the calendar to see the new behavior.

Changing Web Calendar Style Sheets
The Web Calendar style sheet is WebCalendar.css. It is located in the folder

<siteroot>\workarea\WebCalendar\View.

By modifying the various .RadScheduler classes, you can change style for your web calendar.

Below are some sample changes you can make.

Example CSS Style Change

Color
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Example CSS Style Change

Uppercase

Web Calendar Mashups
A Calendar Mashup shows events from different calendars combined into one calendar view.

As an example, you could combine upcoming company meetings from one calendar with a

special seminar series from another calendar.

There are several ways to combine the events on a calendar. Three methods are shown below.

n "Combining Calendars Using the Dynamic Method" on page 7-590

n "Combining Calendars Using the Static Method" on page 7-592

n "Combining a Static Mashup and Dynamic Parameter" on page 7-592

Combining Calendars Using the Dynamic Method
The dynamic method uses URL query string parameters to specify which calendars to see. This

allows you to maintain one calendar template that can be used by many calendars on your

Web site.

Using the EktronTech starter site, the exercise below combines calendars using a URL query

parameter cal2.

http://<servername>/ektrontech/calendar.aspx?cal2=376

Follow these steps to combine two calendars.

1. Log in to the site.
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2. Create two calendar folders in the workarea. See Also: "Adding a System Calendar Folder

" on page 7-553.

3. Determine the ID number (circled below) for each calendar by examining the Calendar

Folder Properties.

See Also: "Viewing System Calendar Folder Properties" on page 7-554. In our example,

we use Calendar folder Ids 375 and 376

4. Edit the calendar.aspx template that contains the web calendar. In this example, the

template is located on the web server in this folder: d:\inetpub\wwwroot\EktronTech.

5. Add two CalendarDataSource tags - one for a static calendar the other for a dynamic

calendar.

6. In the first (static) CalendarDataSource properties, add defaultId = “375”.

7. In the second (dynamic) CalendarDataSource properties, add queryParam = “cal2”.

8. In both CalendarDataSource tags, be sure to set the sourceType = “SystemCalendar”

property.

The finished code looks like this.

<cms:WebCalendar ID="webcalendar" runat="server" DynamicParameter="calendar_id"

DisplayType="All" SuppressWrapperTags="True">
<DataSource>
<cms:CalendarDataSource defaultId="375" sourceType="SystemCalendar"/>
<cms:CalendarDataSource queryParam="cal2" sourceType="SystemCalendar"/>
</DataSource>
</cms:WebCalendar>

The code above has a CalendarDataSource defaultId for calendar 375. By adding the

second CalenderDataSource line with a queryParam, we can display any calendar by

referring to it in the query string.

9. Save the calendar.aspx page.

10. Enter the following URL to see the calendar:

http://<servername>/ektrontech/calendar.aspx?cal2=376

You see the combined calendar events. When there are too many events to show on a specific

date, you will see a link that says “more...”. Click this link to see all of the events.
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Combining Calendars Using the Static Method
The static method of combining calendars hard codes the calendar id numbers instead of using

a query string parameter. This creates a calendar whose events source does not change

dynamically.

For example, follow these steps.

1. Log in to the EktronTech starter site.

2. Create two calendar folders in the workarea. See Also: "Adding a System Calendar Folder

" on page 7-553

3. Determine the ID number for each calendar by examining the Calendar Folder Properties.

See Also: "Viewing System Calendar Folder Properties" on page 7-554

4. Edit the calendar.aspx template.

In the CalendarDataSource properties, add the defaultId values for each calendar as shown

in the code below.

<cms:WebCalendar ID="webcalendar" runat="server" DynamicParameter="calendar_id"

DisplayType="All" SuppressWrapperTags="True">
<DataSource>
<cms:CalendarDataSource defaultId="375" sourceType="SystemCalendar"/>
<cms:CalendarDataSource defaultId="376" sourceType="SystemCalendar"/>

</DataSource>

In this example, all events for calendars 375 and 376 are combined on the calendar.aspx page.

Combining a Static Mashup and Dynamic Parameter
The following example show how to display a specific calendar according to a dynamic

parameter in the query string. If the query string parameter is not used, the calendar shows a

mashup of three calendars.

The following example assumes you created three calendars with events with ids 374, 375, and

376.
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This is the code for the events.aspx template.

<cms:WebCalendar ID="webcalendar1" runat="server">
<DataSource>
<cms:CalendarDataSource sourceType="SystemCalendar" >
</cms:CalendarDataSource>
</DataSource>

</cms:WebCalendar>

This is the code behind for events.aspx.vb, which listens for a query parameter. If none is

found, display a static calendar mashup.

‘This code is located in the Page_Load event

Protected Sub Page_Load(ByVal sender As Object, ByVal e As

System.EventArgs) Handles Me.Load
‘Create a CalendarDataSource instance and set the sourceType and queryParam

Dim cds As New Ektron.Cms.Controls.CalendarDataSource()
cds.queryParam = "calid"
cds.sourceType = Ektron.Cms.Controls.SourceType.SystemCalendar
‘Add the DataSource object

webcalendar1.DataSource.Add(cds)
‘If the queryString is used, show that calendar,

otherwise show the following mashup

If (Request.QueryString("calid") = String.Empty) Then
‘Create three CalendarDataSource instances and add the sourceType and defaultId for

each.

cds = New Ektron.Cms.Controls.CalendarDataSource()
cds.sourceType = Ektron.Cms.Controls.SourceType.SystemCalendar
cds.defaultId = 374
webcalendar1.DataSource.Add(cds)
cds = New Ektron.Cms.Controls.CalendarDataSource()
cds.sourceType = Ektron.Cms.Controls.SourceType.SystemCalendar
cds.defaultId = 375
webcalendar1.DataSource.Add(cds)
cds = New Ektron.Cms.Controls.CalendarDataSource()
cds.sourceType = Ektron.Cms.Controls.SourceType.SystemCalendar
cds.defaultId = 376
webcalendar1.DataSource.Add(cds)
End If
‘Fill and return

webcalendar1.Fill()

End Sub

To see a single calendar such as 376, use this URL:

http://<server>/cms400developer/events.aspx?calid=376

To see all calendars together, do not use the query string parameter, as shown below.

http://<server>/cms400developer/events.aspx
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Using Taxonomy with Web Calendars
You can use taxonomy categories to filter events on a calendar. The categories for a calendar

could include the meeting rooms, the audience, or whether the event should show on a special

public calendar.

To see more information about Taxonomy, see "Introduction to Creating a Taxonomy" on page

9-201.

An Example of a Calendar Taxonomy
The following example shows how to organize events based on locations and audience.

Once a Taxonomy is created, these categories can be assigned to events. See Also: "Step 5 -

Select a Taxonomy Category" on page 7-567

Using a Taxonomy Filter for Calendar Events
Use a CategoryID value in the CalendarDataSource to filter events according to taxonomy

categories.

In the example below, the calendar shows events for the Training Center (category 123) or

Administrators (category 124).

<cms:WebCalendar ID="webcalendar" runat="server">
<DataSource>
<cms:CalendarDataSource defaultId="726" sourceType="SystemCalendar">
<CMS:CategoryID categoryId="123" />
<CMS:CategoryID categoryId="124" />
</cms:CalendarDataSource>
</DataSource>
</cms:WebCalendar>

By using an id of a higher category in the taxonomy tree, you can show all events under it.

For example, this taxonomy has two higher level branches with id 100 and 200.
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If you set the category id to 100, you see any events associated with categories 100, 111 or

112.

Using Previous Calendar Versions
To enable Version 7.6.5 Calendar functionality, make the following change to the

siteroot\web.config file.

<add key="ek_enableClassicCalendar" value="True"/>

Both versions of the Calendar may exist on a Web Site.

For more information about using Calendar Version 7.6 and earlier, refer to Calendars in the

Version 7.6 Ektron Administrator Manual.
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Discussion Boards

The Discussion Board feature provides an opportunity for topic discussions on your Web site.

A site or membership user with Add Topic permission creates a topic and posts a starter

question. Site visitors can then reply.

An example of a Discussion Board is below. As you can see, the first screen has general topics,

the second screen’s topics are more specific, and a third screen displays posts to the forum.

As an administrator, you can determine the following Discussion Board features.

n The subjects being discussed

n A starter post, which initiates a discussion

n If users must sign in before posting to the forum

n If a post appears as soon as someone submits it, or must be approved first

- If a post requires approval, you can edit or delete it before it appears

Whether or not posts must be approved, anyone with permission to the board can perform the

following tasks on a post from the Workarea

n edit

n delete

n reply

This section explains Discussion Boards through the following topics.

n "Hierarchy of Discussion Board Elements" on page 7-597
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n "Implementing Discussion Boards" on page 7-600

n "Working with Discussion Boards and Subjects" on page 7-600

n "Working with Forums" on page 7-609

n "Working with Topics" on page 7-616

n "Working with Posts" on page 7-623

n "Restricting an IP Address" on page 7-634

n "Setting Up Post Reporting" on page 7-635

n "Assigning Permissions to a Discussion Board" on page 7-636

n "Sending Notifications When a New Forum Topic or Post is Created" on page 7-642

n "Inserting Discussion Board Server Controls" on page 7-645

n "Using Discussion Boards on Your Web Site" on page 7-646

n "Discussion Board Server Controls" on page 7-665

Hierarchy of Discussion Board
Elements
A Discussion Board consists of a five-level hierarchy, illustrated below. Before creating a

Discussion Board, it is important to understand the elements of the hierarchy.
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Ektron CMS400.NET supports an unlimited number of Discussion Boards. Each board must

follow the hierarchy. Below is the hierarchy with sample data, to explain how each element is

used.
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Within the Workarea, Discussion Boards appear as top-level folders in the folder structure.

Forums appears under them. Both folders us this icon ( ) to distinguish them from content
and blog folders.

If you click a Discussion Board, you see its Subjects and Forums on the right side of the

Workarea, as shown below.

If you click a Discussion Forum, you see its topics. If you click a topic, you see its posts, as

shown below.
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Implementing Discussion Boards
To implement a Discussion Board into your Web site, place a Forum server control on a Web

page. Then, select a Discussion Board.

All Subjects and Forums within that board appear on the Web page. You cannot selectively

suppress Subjects or Forums. Keep this in mind when determining the contents of a Discussion

Board.

Working with Discussion Boards and
Subjects
This section contains the following topics.

n "Creating a Discussion Board" on page 7-601

n "Viewing a Discussion Board" on page 7-605

n "Editing a Discussion Board" on page 7-606

n "Deleting a Discussion Board" on page 7-606

n "Changing Page Size for Discussion Boards" on page 7-606

n "Editing Subject Name and Sort Order" on page 7-607

n "Creating a New Subject" on page 7-607
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n "Terms & Conditions" on page 7-608

See Also: "Implementing Discussion Boards" on page 7-600

Creating a Discussion Board
To create a Discussion Board, follow these steps.

1. From the Workarea’s Content tab, navigate to the folder in which you want to place the

Discussion Board.

2. Click New > Discussion Board.

3. The Add a Discussion Board to folder screen appears.

Complete the screen using the following table.

Note: Some items in this table only appear when editing an existing Discussion Board’s properties.

Discussion Board Properties

Field Description
When

Available

Name
Enter the name of the Discussion Board. This text describes the board within

theWorkarea and on your Web site.

Enter or

edit

Title Enter the title of the board.
Enter or

edit
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Field Description
When

Available

Accepted

HTML

A comma-delimited list of HTML tagsallowed in the editor. When left blank, all

tagsare available.

The default list is:

br,hr,b,i,u,a,div,ol,ul,li,blockquote,img,span,

p,em,strong,font,pre,h1,h2,h3,h4,h5,h6,address,embed

Site visitors posting to the forum can apply these HTML tags to content when

their Forum editor iseWebEdit400, as set in the user profile.

Note: Youmust add the embed tag if you want users to be able to insert

WMV files into their posts. See Also: "Adding Video to a Post" on page 7-652

Enter or

edit

Accepted

Extensions

A comma delimited list of file extensions that can be uploaded. You can enter

the extension with or without the period (.). Use a comma to separate each

extension.

The default list is: bmp,conf,doc,gif,jpe,jpeg,jpeg,png

The list appears at the bottom of the editor screen to notify the person

entering a post which file typeshe can attach.

Edit only

MaxFile Size
Themaximum size of a file, in bytes, that a user can upload.

The default is 200000 bytes (.19megabytes).
Edit only

Topics:

Require

Authentication

Effect of this Field on the Web Site

Check this box if a site visitor must sign in before he can post to the Discussion

Board. If the user cannot accessa login screen, he cannot post.

If this box is unchecked, site visitors can post without signing in.

Effect of this Field within the Workarea

If this field is checked, only userswith Add Topic or Edit Topic permissions for

the Discussion Board can create or reply to posts.

See Also: "Assigning Permissions to a Discussion Board" on page 7-636

Enter or

edit
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Field Description
When

Available

Lock

Check this box if you want to prevent all posting to thisDiscussion Board. You

can do this temporarily or permanently.

If a Board is locked, onlyAdministrator user groupmembers can post to it, or

edit or delete posts. Those users can post from theWeb site or theWorkarea.

You can alternatively lockanyForum underneath thisBoard via the Forum

properties screen.

Edit only

CSSTheme

Choose a style sheet to determine the appearance of the Discussion Board on

your Web site. Select any theme available in the CSSTheme dropdown. The

default issite root/Workarea/threadeddisc/themes/standard.css.

Alternatively, enter a path below the site root folder to your customCSS file in

the path box.

Note: If you edit a CSS file, Ektron recommendssaving it under a new name.

This prevents your changes from being overwritten during an upgrade.

For additional information on creating custom themes, see "Using a Custom

Theme" on page 7-674.

Enter or

edit

Page

Template

Lets you specify a template for the Forum. If you do not specify a template, the

search results do not link properly to the Forum. See Also:

To preview what the Forum looks like within the selected template, click the

preview icon to the right ( ).

Enter or

edit

Taxonomy:

Required

category

selection

If you want all topics in thisDiscussion Board to be assigned a taxonomy

category, checkRequired category selection. If you do, a signed-in user is

prompted to select a taxonomycategorywhen creating a topic.

This checkboxhasno effect when creating new topicswithin the Ektron

CMS400.NET Workarea.

See Also: "Taxonomy" on page 9-200

Edit only
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Field Description
When

Available

Taxonomy:All

taxonomies

appear

Select a taxonomywhose categorieswill be assigned to Forum topics. The

Taxonomiesare created in the TaxonomyTab. The Discussion Board’s

taxonomydisplay represents another way to organize the Forum’s posts.

See Also: "Taxonomy" on page 9-200

Effect of Assigning Taxonomy Categories to a Topic

When aDiscussion Board server control is placed on aWeb page, its display

includesa small taxonomy icon (circled below).

When a site visitor clicks this icon, he seesall taxonomycategories.When he

selects a category, he sees its subcategories followed byall Forum posts

assigned to that category.

Below is an example of how aDiscussion Board’s postsmight be organized by

taxonomycategory.

See Also: "Using the TaxonomySearch" on page 9-235
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Field Description
When

Available

SubjectsTab

Enter asmanySubjects as you wish. Each Subject contains one or more

Discussion Forums.

Youmust create at least one Subject for each Discussion Board.

To learn how Subjects fit into the Discussion Board hierarchy, see "Hierarchy

of Discussion Board Elements" on page 7-597.

Note: You can also add a Subject by selecting a Discussion Board then

selectingNew > Subjects.

Subject Sort Order

Subjects are the highest level of the hierarchy that appears on your Web site.

In the sample Forum below, Latest Discoveries andPatient Care are

Subjects.

Subjects appear in alphabetical order unless you use the Sort Order field.

TheSort Order field accepts a number and uses it to arrange the Subjects of

a Discussion Board on theWeb site. The lowest numbers appear near the top

of the page.

To access theSort Order field, follow these steps.

1. Save the Discussion Board.

2. Click the Discussion Board in theWorkarea.

3. ClickView > Properties.

4. Click theSubjects tab.

5. Modify the number in the Sort Order field asneeded.

Enter or

edit

Terms&

Conditions

Tab

Add the Terms&Conditions for using the Discussion Board. Byentering text

in this text boxand saving, you activate the Termsand Conditions feature. See

Also: "Terms&Conditions" on page 7-608

Edit only

Viewing a Discussion Board
To view a Discussion Board, select it from the Folders display. When viewing the Board, you

see all of its Forums. You can click any Forum to see details about it.

See Also: "Implementing Discussion Boards" on page 7-600;
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Editing a Discussion Board
When editing a Discussion Board, you can change information entered when it was created

plus additional fields only available when editing. See the When Available column of the

"Discussion Board Properties" on page 7-601.

To edit a Discussion Board, follow these steps.

1. Click the Workarea’s Content tab.

2. Form the folder structure in the left frame, click the Discussion Board.

3. Click View > Properties.

4. Click the Edit button ( ).

5. Update the screen as needed. Fields are described in "Discussion Board Properties" on page

7-601.

6. Click Save ( ).

Deleting a Discussion Board
You can delete any Discussion Board. When you do, its Subjects, Forums, and posts are also

deleted. Once deleted, they cannot be retrieved.

1. Click the Workarea’s Content tab.

2. From the folder structure in the left frame, click the Discussion Board.

3. Click Delete > This folder.

4. A message appears asking you to confirm.

5. Press OK If you are sure.

Changing Page Size for Discussion Boards
You can change the number of Topics or Posts shown on a page by changing the ek_PageSize

value in the Web.config file.
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See Also: See "ek_PageSize" on page 1-77

Editing Subject Name and Sort Order
You can change any Subject’s name or sort order. To do so, follow these steps.

1. Click the Workarea’s Content tab.

2. From the folder structure in the left frame, click the Discussion Board that contains the

Subjects.

3. Click View > Properties.

4. Click the Subjects tab.

5. Click the Subject that you want to edit.

6. The current Subject name and sort order appear on a new screen. Edit as needed. See Also:

"Subject Sort Order" on page 7-605.

7. Click Save ( ).

Creating a New Subject
Use this procedure when you want to add a new Subject to a Discussion Board.

Note: For more information about how Subjects fit into the Discussion Board hierarchy, see "Hierarchyof

Discussion Board Elements" on page 7-597.

1. Click the Workarea’s Content tab.

2. From the folder structure in the left frame, click the Discussion Board to which you want

to add a Subject.

3. Click New > Subject.

4. Enter a Subject name and sort order. See Also: "Subject Sort Order" on page 7-605

5. Click Save ( ).
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Terms & Conditions
Adding Terms & Conditions to a discussion board allows you to convey to a user the

expectations when using the discussion board. Once Terms & Conditions are added, users can

only post to the Forum after agreeing to the Terms.

Once any text is entered into the Terms & Conditions editor and saved, anyone posting to the

site sees the following screen the first time he tries to post or reply to a Forum. The circled text

is an example of your entry in the Terms & Conditions editor. The rest of the text, checkbox,

and button are provided by Ektron CMS400.NET.
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Adding Terms and Conditions to a Discussion Board
1. Click the Workarea’s Content tab.

2. From the folder structure in the left frame, click the Discussion Board to which you want

to add terms and conditions.

3. Click View > Properties.

4. Click the Edit button ( ).

5. Click the Terms & Conditions tab.

6. Add the terms and conditions text to editor.

7. Click the Save ( ) button.

See Also: "Implementing Discussion Boards" on page 7-600

Working with Forums
A Forum is a particular thread within a Discussion Board. To learn about how Forums fit into

the Discussion Board hierarchy, see "Hierarchy of Discussion Board Elements" on page 7-597.

For each Forum, you define the following:

n name and Description

n whether posts to it must be approved before appearing on your Web site

n if it’s accepting new postings

n its sort order, which determines its sequence on the Web page within its Subject

n its Subject

This section contains the following topics.

n "Creating a Forum" on page 7-609

n "Editing a Forum" on page 7-611

n "Deleting a Forum" on page 7-611

n "Ranking Forum Users" on page 7-612

Creating a Forum
You can only create a Forum after a Discussion Board and at least one Subject have been

created.

1. In the Workarea, click the Content tab.

2. Select a Discussion Board.
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3. Click New > Discussion Forum.

4. The Add a Discussion Forum to Board screen appears.

Complete the screen using the following table.

Field Description

Name

Enter the name of the discussion Forum.

The name identifies the Forum in the left side of theWorkarea. The Forum’s name appears

next to a forum icon ( ). This icon distinguishes it from content and blog folders.

It also appears on theWeb site (see example below).

Description
Enter amore detailed description of the Forum.

The description appears on theWeb site, as illustrated above.

Moderate

Comments

Checking this box causes

n comments to require approval before appearing on theWeb site See Also: "Approving a

Topic" on page 7-622

n a post to be reported to allmoderators of the Forum. See Also: "Reporting a Post" on

page 7-650 and "Setting Up Post Reporting" on page 7-635

Only userswho are grantedModerate permission can approve comments, therebyallowing

them to be published on the site. See Also: "Discussion Board Permissions" on page 7-638

The Smart Desktop hasa Forum Topics and Posts category. This tells you howmanyposts

currently require your approval before theyappear on the site.
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Field Description

Lock

Forum

Check this box if you want to prevent all posting to this Forum. You can do this temporarily or

permanently.

If a Forum is locked, onlymembers of the Administrators user group can post to it, or edit or

delete posts. Those users can post from theWeb site or theWorkarea.

ADiscussion Board can also be locked. If a board is locked, amessage on this screen indicates

that. In that case, no posting is allowed to this Forum regardlessof this setting.

Sort Order
Enter a number if you want to arrange the sequence of Forumswithin the Subject.

If you do not, Forumsappear in alphabetical order within a Subject.

Subject

Enter the Subject within which this Forumwill appear on theWeb site. To learnmore about the

relationship of Subjects to Forums, see "Hierarchyof Discussion Board Elements" on page 7-

597.

5. Click Save ( ).

Editing a Forum
Follow these steps if you want to change any information about a Forum.

1. Click the Workarea’s Content tab.

2. From the folder structure in the left frame, click the Discussion Board that contains the

Forum.

3. Click the Forum.

4. Click the View Properties button ( ).

5. Click the Edit button ( ).

6. Update the screen as needed. The fields are described in "Complete the screen using the

following table." on page 7-610.

7. Click Save ( ).

Deleting a Forum
You can delete any Forum. When you do, its topics and posts are also deleted. Once deleted,

they cannot be retrieved.

To delete a Forum, follow these steps.

1. In the Workarea, click the Content tab.

2. Select the Discussion Board that contains the Forum.

3. Click the Forum.
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4. Click the Delete Forum button ( ).

5. A message appears asking you to confirm.

6. Press OK if you are sure.

Ranking Forum Users
The User Ranking feature lets you recognize users for their Forum contributions. You can

create a ranking system that determines the number of posts a user must submit to move up to

the next level. Here’s an example.

Rank Number of posts

Newbie 0 - 9

Intermediate 10 - 19

Expert 20 and up

This is known as a ladder system, because users move to the next level after a designated

number of posts.

This system lets Forum users build credibility. You can assign each rank an image, which

appears below the user’s name on any post (see illustration below).

The rank also appears on a user’s forum profile. See Also: "Suppressing User Information from

the Forum Profile Display" on page 7-653
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Ranks Independent of the Ladder System
You can also create ranks that are independent of the ladder system. Such a rank bears no

relationship to the number of posts a user has made. For example, after a Forum user acquires

Ektron Developer Certification, he is assigned the Ektron Developer rank.

Users can be moved from a non-ladder rank to the ladder system and vice versa. Whether or

not a user is in a ladder system, Ektron CMS400.NET keeps a tally of posts. So, if the user is

moved into a ladder system at any time, he is placed into the correct rank.

Adding a User Rank
To add a user rank, follow these steps.

Note: You can also access the User Ranks screen fromWorkarea >Settings>Configuration >Discussion Board

>User Ranks. If you havemore than one Forum, this screen lets you pick the Discussion Board to which a rank is

assigned.

1. In the Workarea, click the Content tab.

2. Select a Discussion Board.

3. Click New > User Ranks.

4. The User Ranks screen appears.

5. Complete the screen using the following table.

Field Description

Name The name of the rank. For example, Newbie, Expert, Developer, or Associate.

Rank

Image

Click the upload link to browse and select an image to upload. Once uploaded the path where the

image is stored appears in the text box. Imagesare optional.

If you assign an image, it appears below the user’s name on anypost.
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Field Description

Ladder

System

Check this box if this rank is part of a ladder system. That is, a rankbased on the number of posts a

user has submitted to thisDiscussion Forum. See Also: "Ranking ForumUsers" on page 7-612

If you uncheckLadder System, bothStarting Rank andNumber of Posts become inactive,

since those fields set up andmanage the ladder system.

Starting

Rank

If you are using a ladder system, use this checkbox to designate this rank the Starting Rank. A

user is assigned to this rankwhen he submits the first post.

ADiscussion Forum can only have one Starting Rank. Also, If this is the Starting Rank, you cannot

enter a number of posts.

Number

of Posts

Enter the number of posts it takes to reach this rank. If the Starting Rank checkbox is checked,

the number is 1 and cannot be changed.

Applies

To

If you accessed this screen fromWorkarea > Settings > Configuration > Discussion Board

> User Ranks, use this field to select the Discussion Forum to which this rankapplies.

6. Click the Save button ( ).

Deleting a User Rank
1. In the Workarea, click the Content tab.

2. Select a Discussion Board.

3. Click View > User Ranks.

4. Select the rank you want to delete.

5. Click the delete ( ) button.

6. Press OK to the confirmation message.

Changing a User’s Rank
In order to change a user’s current rank, you must know it. As mentioned above, a user’s rank

appears below the user name on any post he has made.
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You can only move a user into and out of a ladder system. You cannot change his rank within

a ladder system -- that is determined by the number of posts.

To change a user’s rank, follow these steps.

1. In the Ektron CMS400.NET Workarea, go to Content and navigate to the forum to which

the user has posted.

2. Click View > User Ranks.

3. Select the rank that you want to move the user out of.

4. The User Ranks screen appears. The lower half shows all users assigned that rank.

5. Click the user that you want to move out of the rank.

6. The screen display all ranks. The current one is selected.
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7. Click next to the desired rank.

8. Click the Save ( ) button.

Working with Topics
Topics are specific issues to be discussed in a Forum. For example, in a medical research

Forum, a topic might be New Cancer Treatments. Topics can only be started within the

Workarea.

Before creating a topic, you must create a Forum into which to place it. To learn more about

how Topics fit into the Discussion Board hierarchy, see "Hierarchy of Discussion Board

Elements" on page 7-597.

This section contains the following topics:

n "Adding a Topic to a Forum" on page 7-616

n "Setting and Changing the Topic Priority" on page 7-618

n "Locking a Topic" on page 7-619

n "Viewing a Topic" on page 7-620

n "Editing a Topic’s Title" on page 7-621

n "Approving a Topic" on page 7-622

n "Deleting a Topic" on page 7-622

Adding a Topic to a Forum
When a new Topic is created, the first post is created from the message of the Topic.

To create a Topic, follow these steps.
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Note: If the user adding the Topic is not a Forummoderator, that user doesnot see the Topic in the workarea

until it is approved. See Also: "Approving a Topic" on page 7-622.

1. In the Workarea, click the Content tab.

2. Select a Discussion Board, then a Forum from the folder structure.

3. Click the New Topic button ( ).

4. The Post New Topic screen appears.

5. Complete the screen using the following table.

Field Description

Subject

Enter a short description of the topic. The TopicSubject appears on the Forum page, as

shown below.

Priority

Set the priority level for the topic. This determineswhere the topic appears in the topic list

on the site. The default setting isNormal. See Also: "Setting and Changing the Topic

Priority" on page 7-618

Lock

Check this box if you want to prevent posting of replies to this Topic. You can do this

temporarily or permanently.

If a Topic is locked, onlyAdministrator user groupmembers can post to it, or edit or delete

posts. Those users can post from theWeb site or theWorkarea.
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Field Description

Message

Enter the topic text. This text appears on a newWeb page after aWeb site visitor clicks a

Topic’sSubject line.

6. Click Save ( ).

Setting and Changing the Topic Priority
You can set a topic’s priority when creating it. Within a Forum, topics are sorted by priority.

Anyone with Moderate permission can change a topic’s priority. To do so, edit a Forum’s

properties and click the View Properties button ( ).

Priority Levels
There are three priority levels:

n Announcement

n Sticky

n Normal

n Announcement - topic always appears at the top of the list. If a list has more than one

announcement, they are sorted by date with most recent on the top.

The Announcement icon ( ) indicates its priority to the left of the title.
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n Sticky - topic appears near the top of the list, just below the announcements. If a list has

more than one sticky topic, they are sorted by date with most recent on the top.

The Sticky icon ( ) indicates its priority to the left of the title.

.

n Normal - Topics with this priority follow Announcements and Sticky topics. The Normal

icon ( ) next to the topic indicates its priority.

Locking a Topic
Locking a Forum Topic prevents users from posting a reply to the Topic. For example, you

might create an announcement, but don’t want people replying to it. Or, you might feel as

though a topic has had enough discussion and want to stop further replies.

If a Topic is locked, only Administrator user group members can post to it, or edit or delete

posts. Those users can post from the Web site or the Workarea.
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To lock a Topic, follow these steps.

1. In the Workarea, click the Content tab.

2. Select a Discussion Board, then a Forum from the folder structure.

3. Click a topic.

4. Click the Properties button ( ).

5. Click the Lock Topic check box.

Note: To unlocka topic, remove the checkmark from the LockTopic checkbox.

6. Click Save ( ).

Viewing a Topic

Note: To learn about viewing a topic from your Web site, see "Using Discussion Boardson Your Web Site" on

page 7-646.

To view a topic from the Workarea, follow these steps.

1. In the Workarea, click the Content tab.

2. Select a Discussion Board, then select a Forum from the folder structure.

3. The Forum’s topics appear in the right frame. Click the one that you want to view.

The View Topic screen displays each post within the topic. If a post is surrounded by a yellow

border (illustrated below), it must be approved before it can appear on the Web site. Only users

Content

7-620
ReferenceManual

Version 8.0 Rev 1.3



with Moderate permission can approve a post. See Also: "Assigning Permissions to a

Discussion Board" on page 7-636

The following options may appear across the top of the screen, depending on your permissions.

Button Description For more information, see

Delete topic and all of its posts "Deleting a Topic" on page 7-622

View and edit the topic’s title and priority "Editing a Topic’s Title" on page 7-621

Return to previous screen

Under each post is a set of options that you may be able to perform on any post, depending on

your permissions and the status of the post.

If an option is underlined, you have authority to perform it. If not, you cannot. For example, if

a post’s status is approved, the approve option is not underlined because it is already

approved.

See Also:

n "Approving a Post in the Workarea" on page 7-624

n "Adding a Reply to a Post" on page 7-623

n "Editing a Post" on page 7-625

n "Deleting a Post" on page 7-625

Editing a Topic’s Title
The only part of topic you can edit is its title.

1. In the Workarea, click the Content tab.
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2. Select a Discussion Board, then select a Forum from the folder structure.

3. The Forum’s topics appear in the right frame. Click the one that you want to edit.

4. Click the View Properties button ( ).

5. The Edit Topic screen appears. Modify the title as needed.

6. Click Save ( ).

Approving a Topic
A topic needs approval when a user without moderate permissions for the Forum adds a Topic.

To approve a Topic, follow these steps.

1. In the Workarea, click the Content tab.

2. Select a Discussion Board, then select a Forum from the folder structure.

3. The Forum’s topics appear in the right frame. Click the one that you want to approve.

4. The View Topic screen appears

.

5. Click the Approve Topic link (shown in red box above).

6. The Topic is approved.

Deleting a Topic
You can delete any Topic. When you do, its posts are also deleted. Once deleted, they cannot

be retrieved.

1. In the Workarea, click the Content tab.

2. Select a Discussion Board, then select a Forum from the folder structure.

3. The Forum’s topics appear in the right frame. Click the one that you want to delete.

4. The View Topic screen appears.
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5. Click the Delete link (shown in red box above).

6. A confirmation message appears.

7. Click OK if you are sure you want to delete it.

Working with Posts
When a new Topic is created, the first post is created from the message of the Topic.

Essentially, all posts to the Topic are replies to the first.

This section contains the following topics, which explain working with posts.

n "Adding a Reply to a Post" on page 7-623

n "Approving a Post in the Workarea" on page 7-624

n "Editing a Post" on page 7-625

n "Deleting a Post" on page 7-625

n "Attaching Images and Files to a Post" on page 7-626

n "Searching a Forum’s Posts" on page 7-627

n "Moving a Topic and Its Posts to Another Forum" on page 7-627

n "Replacing Words in a Post" on page 7-628

n "Creating and Editing Emoticons" on page 7-631

Adding a Reply to a Post

Note: You can also reply to a post from theWeb site. See "Posting a Reply" on page 7-648.

1. In the Workarea, click the Content tab

2. Select a Discussion Board, then select a Forum from the folder structure.

3. The Forum’s topics appear in the right frame. Click the one that has the post that you

want to reply to.

4. The next screen, View Topic, displays all posts to the selected topic.
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5. Find the post that you want to reply to by reading its text (illustrated below).

6. Click reply.

7. Enter a Title for the post.

8. In the Description field, enter the text of your post.

Approving a Post in the Workarea
When defining a Forum, you can check the Moderate Comments field. If you do, posts to the

Forum must be approved before they appear on the Web site. Only users who are assigned the

Moderate permission are allowed to approve a post. See Also: "Discussion Board Permissions"

on page 7-638

You can approve a post from the Workarea or the Forum on the site. See also "Approving a

Post" on page 7-649.

To approve a post in the Workarea, follow these steps.

1. In the Workarea, click the Content tab.

2. Select a Discussion Board, then a Forum from the folder structure.

3. The Forum’s topics appear in the right frame. Click the one that has the post that you want

to reply to. (Unapproved posts have an “Approval Needed” icon in the left column, as

highlighted in red below.)
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4. The next screen, View Topic, displays all posts to the selected topic.

5. Find the post you want to reply to. Unapproved posts have a yellow border (Illustrated

below).

6. Click approve under the post icon.

Editing a Post
You can edit the text of a post but you cannot edit its title.

Note: You can also edit a post from theWeb site. See "Editing a Post" on page 7-649.

1. In the Workarea, click the Content tab.

2. Select a Discussion Board, then a Forum from the folder structure.

3. The Forum’s topics appear in the right frame. Click the one that has the post that you

want to edit.

4. The next screen, View Topic, displays all posts to the selected topic.

5. Find the post that you want to edit.

6. Click edit under the post icon.

7. The Edit Reply screen appears. Within the editor, update the text as needed.

8. Click Save ( ).

Deleting a Post
1. In the Workarea, click the Content tab.

2. Select a Discussion Board, then a Forum from the folder structure.

3. The Forum’s topics appear in the right frame. Click the one that has the post you want to

delete.

4. The next screen, View Topic, displays all posts to the selected topic.

5. Find the post that you want to delete.

6. Click delete under the post icon.
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Attaching Images and Files to a Post
When creating a topic or post, you can add an attachment. In the Attached Files field, A list of

the files of files that will be attached appears, In addition, a list of valid file extensions appear.

The list of valid file extensions and maximum size of the file upload are defined at the

Discussion Board level. See "Accepted Extensions" on page 7-602 and "Max File Size" on

page 7-602.

Attaching a File
To add an attachment to a topic or post, follow these steps.

1. Click the Attachments button below the editor.

2. The Attachments window appears.

3. Click the Browse... button to find the file.

4. Browse to the location of the file and select it.
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5. Click Open.

6. Click the Attach button to attach the file to the post.

7. The file appears in the list of Current File Attachments.

8. Click the Close button.

Viewing an Attached File
To view an attached file, click its name in the post.

Removing an Attached File
To remove a file from the list of attachments, follow these steps.

1. Click the Attachments button below the editor.

2. Highlight the attached item.

3. Click the Remove button.

4. Click the Close button.

Searching a Forum’s Posts
The Forum server control includes a search feature that lets site visitors search through all posts

on your site. Any user can access the search from the Forum screen (see below).

When a site visitor clicks Search, he can search the current Forum (the default value), select a

different Forum, or search all Forums.
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Moving a Topic and Its Posts to Another Forum
If you want to move a topic and its associated posts in one forum to another, follow these

steps.

Prerequisite: The forum to which you want to move the topic and posts must exist. See

"Creating a Forum" on page 7-609.

1. Access a page on your Web site that has a login button.

2. Sign in as a member of the Administrators group or as a Moderator of the board.

3. Navigate to a page with Discussion Board.

4. Select a forum from the Discussion Board.

5. Navigate to a topic page.

6. Click the Move to... dropdown list. (It appears in the right corner above the posts.)

7. Select the topic to which you want to move.

8. Confirm that you want to move all posts.

Replacing Words in a Post
You can configure Ektron CMS400.NET to replace unwanted words in a post. This feature is

useful for changing words that are obscene, indecent, or should not appear on your site. In

addition, Replace Words can fix commonly misspelled words. For example, the can replace teh.

See Also: "Adding a Replacement Word" on page 7-630

The Replace Words feature works with exact matches but does not append words. For example,

if you replace car with auto, the sentence I bought the car from the cartel becomes I bought

the auto from the cartel. Note that cartel did not change to autotel even though the word car

appears in cartel.

This feature is more fully explained through the following topics.

n "Using Regular Expressions" on page 7-628

n "Adding a Replacement Word" on page 7-630

n "Viewing Existing Replacement Words" on page 7-630

n "Editing a Replacement Word" on page 7-630

n "Deleting a Replacement Word" on page 7-631
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Using Regular Expressions
If you would like the Replace Words feature to modify words that contain a word you do not

want used, you can use Regular Expressions. A Regular Expression, often referred to as regex,

is a pattern of metacharaters placed around a word that describes a string. Used for string

manipulation, regex allows you to detail a succinct description of a group of words without

having to detail each word in the group.

Regular

Expression
Description

. Matchesany character, similar to a wildcard. For example, .ar matchesany three letter word
ending in ar, such as car, bar, tar or far.

| Acts asan or operator. For example, steak|stake would find steakor stake.

[ ]
Matchesone character that is between the brackets. For example, [rst] matches r, sor t. [d-

g] matchesd, e, f, or g. Another example, [bc]ar matchesbar and car. If you need tomatch a

dash (-), use it a the beginning or end of the group. For example, [xyz-] or [-xyz].

[^ ]
Matchesone character that is not in the group. For example, [^rst] matchesany character

other than r, sor t. Another example, [^bc]ar doesnot match bar or car, but doesmatch

words, such as tar or far.

^
Matches the beginning of any line. For example, ^[bc]ar matches bar or car, but only at the

beginning of a line.

$
Matches the end of any line. For example, ^[bc]ar matches bar or car, but onlywhen it

appears at the end of a line.

( ) Marksa sub expression. For example, alt(a|e)r findsaltar or alter.

*
When an expression is followed by *, it matches zero or more versionsof the expression. For

example, [rst]* finds (blank), r, s, t, rs, sr, rt, tr, st, ts, rst, rts, srt, str, trsand tsr.

+
When an expression is followed by+, it matchesone or more versionsof the expression. This

differs from * because it doesnot match (blank). It must match at least one character. For

example, r+matches r, rr, rrr and so on.

{x,y}

Must match at least x timesand not more than y times. For example, s{2,4} matches ss, sss

and sss. You can also use {x} to specify an exact match. For example, s{3} matches sss. You

can use {x,} to specify that thematch is at least xamount of times. For example, s{4} matches

ssss, sssss, ssssssand so on.

?
Must match the preceding character zero or one times. For example, Boa?rder matches

boarder and border.
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Adding a Replacement Word
To add a replacement word to a Forum, follow these steps.

Note: In addition to using ReplaceWords for a specific Forum, you can access the ReplaceWord feature from the

Workarea >Settings>Configuration >Discussion Board >ReplaceWords. If you havemore than one Forum, this

allowsyou select to which Discussion Boards the ReplaceWords feature is applied.

1. In the Workarea, click the Content tab.

2. Select a Forum from the folder structure.

3. Click New > Replace Word.

4. The Replace Word screen appears.

5. Add the word to be replaced in the Old Word textbox.

6. Add the replace word in the New Word textbox.

7. Select the language for the Replace Word.

8. Click the Save button ( ).

Viewing Existing Replacement Words
To view a list of existing words that are replaced, follow these steps.

1. In the Workarea, click the Content tab.

2. Select a Forum from the folder structure.

3. Click View > Replace Words.

4. A list of word to be replaced appears.

Editing a Replacement Word
1. In the Workarea, click the Content tab

2. Select a Forum from the folder structure.

3. Click View > Replace Words.

4. Click either the Old Word or the New Word to edit.

5. Click the Edit button ( ).

6. Change the Old Word, New Word or Language.

7. Click the Save button ( ).
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Deleting a Replacement Word
1. In the Workarea, click the Content tab.

2. Select a Forum from the folder structure.

3. Click View > Replace Words.

4. Click either the Old Word or the New Word to delete.

5. Click the Delete button ( ).

6. A dialog box asks if you are sure you want to delete.

7. Click OK.

Creating and Editing Emoticons
An emoticon is an icon used to express emotion in a Forum post. For example, .

There are two ways to insert an emoticon.

n A Forum participant clicks the emoticon toolbar button . Next, a small window
appears with available emoticons (shown below). The user clicks one to insert it.

n A Forum participant enters a few characters that resemble the image. For example, to insert

, the user enters O:\).

While working in a post, the user only sees the text. But when the post is saved, Ektron

CMS400.NET converts the text to the corresponding emoticon. In all subsequent work with

the post, users see only the emoticon.

"Viewing Emoticons" on page 7-632 explains how to find the list of available emoticons and

the characters used to insert each one.

You can view and modify or delete a standard set of emoticons. You can also create your own.
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Inserting Emoticon Images
Place emoticon images in the following folder: webroot\Workarea\threadeddisc\emoticons.

Administrators reference these files when editing or creating new emoticons.

Viewing Emoticons
A standard set of emoticons is supplied with Ektron CMS400.NET. After viewing them, you

can add new ones as well as delete or modify standard ones.

To see Ektron CMS400.NET’s emoticons, follow these steps.

1. Within the Ektron CMS400.NET Workarea, go to Settings > Configuration > Discussion

Boards > Emoticons.

2. A list of emoticon images and text appears.

Editing Emoticons
To edit an emoticon, follow these steps.

1. Within the Ektron CMS400.NET Workarea, go to Settings > Configuration > Discussion

Boards > Emoticons.

2. Click the emoticon text or image that you want to edit.

3. Click the Edit button ( ).

4. Use the following table to guide you through the screen’s fields.
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Fields on the Emoticons Properties Screen

Field Description

Emoticon

Text
Enter or update the characters a Forum participant would enter to insert this emoticon.

Emoticon

Image

Enter the name of the image file that will appear after a user enters the above Emoticon text

and saves the post. Administrators place emoticon images in the

siteroot\Workarea\threadeddisc\emoticons folder.

Regex See "Using Regular Expressions" on page 7-628

Language
Select the emoticon’s language from the dropdown list. If a Forum is language-specific, only

emoticonsassigned to that language or all languagesare available.

See Also: "Creating and Editing Emoticons" on page 7-631

Deleting Emoticons
To delete an emoticon, follow these steps.

1. Within the Ektron CMS400.NET Workarea, go to Settings > Configuration > Discussion

Boards > Emoticons.

2. Click the emoticon that you want to delete.

3. Click the Delete button ( ).

4. Reply to the confirmation message.

Creating Emoticons
To create an emoticon, follow these steps.

1. Within the Ektron CMS400.NET Workarea, go to Settings > Configuration > Discussion

Boards > Emoticons.

2. Click the Add button ( ).

3. Respond to the fields on the screen. See"Editing Emoticons" on page 7-632.

4. Click Save ( ).

See Also: "Working with Posts" on page 7-623
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Restricting an IP Address
If you are not using authentication for the Forums and want to block a site visitor from posting

to the Forum, you can use the Restricted IP feature to block site visitors from posting to the

Forum.

Adding an IP Address the Restricted List

Note: In addition to using Restricted IPs for a specific Forum, you can access the Restricted IP feature from the

Workarea >Settings>Configuration >Discussion Board >Restricted IPs. If you havemore than one Forum, this

allowsyou select to which Discussion Boards the Restricted IPsare applied.

To add an IP address to the restricted list, follow these steps.

1. In the Workarea, click the Content tab.

2. Select a Forum from the folder structure.

3. Click New > Restricted IP.

4. Enter the IP Address to be blocked.

5. Click the Save button ( ).

6. A list of restricted IP addresses appear.

Editing a Restricted IP Address

1. In the Workarea, click the Content tab.

2. Select a Forum from the folder structure.
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3. Click View > Restricted IPs.

4. A list of restricted IP addresses appears.

5. Click the IP address to be edited.

6. Click the Edit button ( ).

7. Edit the IP address in the Block IP text box.

8. Click the Save button ( ).

Deleting a Restricted IP Address

1. In the Workarea, click the Content tab.

2. Select a Forum from the folder structure.

3. Click View > Restricted IPs.

4. A list of Restricted IP addresses appears.

5. Click the IP address to be deleted.

6. Click the Delete button ( ).

7. A dialog asks if you are sure you want to delete the restricted IP address.

8. Click OK to continue.

9. A list of the remaining restricted IP addresses appear.

See Also: "Restricting an IP Address" on page 7-634

Setting Up Post Reporting
When you set up the Forum Post Reporting feature, it adds a Report button to the bottom of

each post. The button lets site visitors report posts to Forum moderators. For example, users can

report posts that are offensive or spam posts.
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When a user clicks the Report button, an email notification is sent to moderators. A moderator

can then view the post and decide whether to edit, delete or leave the post. See Also:

"Reporting a Post" on page 7-650

To set up a Forum for Post Reporting, follow these steps.

Warning! Your Ektron CMS400.NET Web server must be set up to send emails. See See "Configuring E-Mail for

Tasksand Content" on page 1-81 .

1. In the Workarea, click the Content tab.

2. Select a Discussion Board from the folder structure.

3. Click View > Permissions.

4. Make sure Forum moderators have Moderate permission. See Also: "Assigning Permissions

to a Discussion Board" on page 7-636

5. Click the Back button ( ).

6. Select a Forum.

7. Click the Properties button ( ).

8. Make sure the Moderate Comments box is checked. If it is not, click the Edit button ( )
and check the Moderate Comments box.

9. Click the Save button ( ).

Assigning Permissions to a
Discussion Board
Like regular content folders, Discussion Boards have a permission table that lets you determine

which users can perform which functions. (To learn more about folder permissions, see .)

Because Discussion Boards have different functions than folders, their permission table is

slightly different.

In addition, each Forum has permission settings. By default, a Forum inherits permissions from

its parent Discussion Board. But, you can break this inheritance and customize permissions for

a Forum. If you break a Forum’s inheritance, only the Forum’s permission table is checked --

the parent Discussion Board’s permissions are ignored.

Modifying a Discussion Board’s Permission Table

To access a Discussion Board’s permission table, navigate to and click the board so it appears

in the Workarea. Then, click View > Permissions.

Note: OnlyAdministratorsgroupmembers can access the Discussion Board Permission Table.
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Below is an example of a Discussion Board permission table for regular users. Membership

users have fewer permissions. See Also: "Discussion Board Permissions" on page 7-638

Discussion Board permissions are more fully explained through the following topics.

n "Initialization of Discussion Board Permission Values" on page 7-637

n "Discussion Board Permissions" on page 7-638

n "Discussion Forum Permissions for Membership Users" on page 7-639

n "Granting Discussion Board Permissions to CMS Users and User Groups" on page 7-640

n "Removing Discussion Board Permissions from CMS Users and User Groups" on page 7-

641

n "Editing Discussion Board Permissions for CMS Users and User Groups" on page 7-641

n "Assigning User Permissions to Forums" on page 7-641

Initialization of Discussion Board Permission Values
When you create a Discussion Board, Ektron CMS400.NET seeds its permission table with

values from the parent folder, as described in the following table.
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Parent Folder Permission Discussion Board Permission

Read only Read only

Edit Edit Topic

Add Add Topic

Delete Delete Topic

Add Folders Add Forum

Edit Folders Edit Forum

Delete Folders Delete Forum

Note: Because there are no corresponding permissions for the Discussion Board’sModerate andPost/reply

permissions, their initial value is blank.

So for example, if the user JSmith has permission to perform all functions for a folder, and a

Discussion Board is created in that folder, JSmith initially receives all permissions listed above

for the Discussion Board. However, you can edit the permissions as needed.

As soon as you create a Discussion Board, it is disconnected from the parent folder’s

permission table. Subsequent changes to the parent’s permissions have no effect on Discussion

Board permissions.

Discussion Board Permissions
The following table lists all permissions that may be granted to regular users. Only some

permissions can be granted to membership users (that is, site visitors who register to participate

in the Forum).

Permission Give the user ability to

Can be

assigned to

membership

users

For more

information,

see

Read only
View Forumsand posts; cannot submit a

post
Yes

Edit Topic Edit a topic’s title No

"Editing a

Topic’s Title"

on page 7-621
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Permission Give the user ability to

Can be

assigned to

membership

users

For more

information,

see

Add Topic Add new topics Yes

"Adding a

Topic to a

Forum" on

page 7-616

Delete Topic Delete a topic No

"Deleting a

Topic" on

page 7-622

Post/Reply
Post a new topic or reply to an existing

one, either from theWorkarea or the site
Yes

"Adding a

Topic to a

Forum" on

page 7-616;

"Adding a

Reply to a

Post" on page

7-623

Moderate

Warning! Everyone who

hasModerate permission

will receive notifications

when a post is reported.

See Also: "Reporting a

Post" on page 7-650

Approve and delete posts and topics.

Also, receive notificationswhen a post is

reported using the report post feature;

only applicable if the Forum’sProperties

fieldModerate Comments is checked.

Yes

"Moderate

Comments"

on page 7-610

Add Forum Create a new Forum No

"Creating a

Forum" on

page 7-609

Edit Forum Edit a Forum No

"Editing a

Forum" on

page 7-611

Delete Forum Delete a Forum No

"Deleting a

Forum" on

page 7-611

Discussion Forum Permissions for Membership Users
By default, membership users are assigned the following permissions:

n Read only
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n Add Topic

n Post Reply

They cannot be granted Edit or Delete topic nor advanced permissions (Add, Edit or Delete

Forum). However, if a membership user creates a new topic, he does have the ability to delete

it.

To change the default permissions, follow these steps.

1. Navigate to and click the Discussion Board so it appears in the Workarea.

2. Click View > Permissions.

3. Click the User Type dropdown field and choose Membership Users.

4. The View Permissions for Board screen appears.

5. Add new member users and groups, remove them, or change their permissions.

Granting Discussion Board Permissions to CMS Users
and User Groups
To give a CMS user or user group permissions to work with a Discussion Board, follow these

steps.

1. Navigate to and click the Discussion Board so it appears in the Workarea.

2. Click View > Permissions.

3. Click the Add button ( ).

4. All users and groups who are not currently assigned permissions appear. Click any user or

group.

5. The Add Permission for Folder screen appears with the selected user or group.

6. Assign appropriate standard and advanced permissions then click the Save button ( ).
See Also: "Assigning Permissions to a Discussion Board" on page 7-636
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Removing Discussion Board Permissions from CMS
Users and User Groups
To remove a user or user group from the Discussion Board permission table, follow these steps.

After you remove the user, Discussion Boards do not appear within his Workarea.

1. Navigate to and click the Discussion Board so it appears in the Workarea.

2. Click View > Permissions.

3. Click the Delete icon ( ).

4. Select the user or group that you want to remove from the Permission table.

5. A confirmation message. Click OK.

6. The user is removed.

Editing Discussion Board Permissions for CMS Users
and User Groups
To edit a user or user group’s Discussion Board permissions, follow these steps.

1. Navigate to and click the Discussion Board so it appears in the Workarea.

2. Click View > Permissions.

3. Click the user or group whose permissions you want to edit.

4. The Edit Permissions screen appears.

5. Change the settings as appropriate. See Also: "Discussion Board Permissions" on page 7-

638

6. Click the Save button ( ).

Assigning User Permissions to Forums
You can use all of the permission features available to Discussion Boards with any Forum. To

access a Forum’s Permission Table, follow these steps.

1. Open CMS Workarea > Content.

2. Click the Forum.

3. Click the View Permissions button on the Contents of Forum screen (circled below).
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4. A Permission Table appears.See Also: "Discussion Board Permissions" on page 7-638

Setting a Forum’s Permission Table Values
A Forum initially inherits (that is, copies all permissions from) its parent Discussion Board’s

permission settings.

When you first view a Forum’s permission table, you see these settings plus a check box that

allows you to maintain the inheritance or break it (circled above).

If you break inheritance by unchecking the Allow this object to inherit permissions box, the

Forum permission screens change from view-only to edit. At this point, you can modify the

Forum’s permissions as needed.

To later restore inheritance, check the box. When you do, the parent Discussion Board’s

permissions overwrite any Forum-specific changes. The Forum then reverts to a read-only state.

Any permission changes must be made at the Discussion Board level while inheritance is

enabled.

Sending Notifications When a New
Forum Topic or Post is Created
The Discussion Board’s Email Notification feature enables Ektron CMS400.NET to generate

email for a list of registered users whenever a new forum topic or post is created.

For example, anyone may register to be notified whenever a new forum topic or post is created.

As soon as the new forum topic or post is created on the discussion board, registered users

receive an email announcement with a link to the new topic or post. The recipient clicks the

link and immediately accesses the page.

Content

7-642
ReferenceManual

Version 8.0 Rev 1.3



As a result, a self-selected group of users can be instantly notified when user’s post information

to your discussion board relating to their interests. Once the messages are set up, you don’t

need to do anything -- everything happens in the background.

Sample Discussion Board Email Notification

See Also: "Creating the Email Message" on page 7-643

Creating the Email Message
You can create an email message to be sent when a new post is added to the discussion board

or when a new topic is added. A simple editor lets you apply some XHTML formatting the

message.

Including Variables in the Default Message
The messages can include variables that retrieve information about the new post or topic and

display it in the message text. The variables are surrounded by at signs (@). For example:

@appPosterDisplayName@ has created a thread you have subscribed to.

In the email, this text might read:

Alan Administrator has created a thread you have subscribed to.

You can use the following variables in the body of an email notifications.
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Variable Displays this information in the email

@appTopicTitle@ The title of the topic.

@appTopicId@ The integer ID of the topic.

@appRecipientDisplayName@ The display name of the person receiving the email.

@appRecipientId@ The recipient’s integer ID.

@appRecipientFirstName@ The first name of the person receiving the email.

@appRecipientLastName@ The last name of the person receiving the email.

@appRecipientEmail@ The email addressof the person receiving the email.

@appHostUrl@ The host site’sURL.

@appForumUrl@ The forum’sURL.

@appPostMessage@
The text of themessage that wasposted to the discussion

board.

@appPosterId@ The integer ID of the person who created the post.

@appPosterDisplayName@ The display name of the person who created the post.

@appPosterProfileUrl@ The profile URL for the person who created the post.

@appPostUrl@ TheURL of the post on theWeb site.

To create a message, follow these steps.

1. In the Workarea, go to Settings > Configuration > Discussion Boards > Messages.

2. Click the Add button ( ).

3. Enter a title that describes the message.

4. At the Type field, select either NewForumTopic or ForumPost.

5. Select whether to make the email message a Default message.

6. In the editor, enter the message text. Use the variables listed in the table above to retrieve

information about the about the new post or topic and display it in the message.

7. Click the Save button ( ).

.
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Inserting the Forum Server Control

After creating at least one hierarchy of Discussion Board elements, place a Forum server

control on a Web page. See "Forum Server Control" on page 7-666.

If you want require site visitors to authenticate, the web page that hosts the Forum should also

contain

n a Membership server control (or a link to page that has one). This lets site

visitors/membership users register for Discussion Boards.

n a Login server control that lets the site visitor/membership user log in

Note: Ektron recommendsadding text below the Login server control to remind the site visitor to enter his email

addressat theUser field. For example, “At theUser field, enter your email address.”

Inserting Discussion Board Server
Controls
Ektron CMS400.NET provides three server controls for use with the Discussion Boards. See

"Discussion Board Server Controls" on page 7-665.

Inserting the Forum Server Control

After creating at least one hierarchy of Discussion Board elements, place a Forum server

control on a Web page. See "Forum Server Control" on page 7-666.

If you want require site visitors to authenticate, the web page that hosts the Forum should also

contain

n a Membership server control (or a link to page that has one). This lets site

visitors/membership users register for Discussion Boards.

n a Login server control that lets the site visitor/membership user log in

Note: Ektron recommendsadding text below the Login server control to remind the site visitor to enter his email

addressat theUser field. For example, “At theUser field, enter your email address.”
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Using Discussion Boards on Your
Web Site
This section explains what can be done when using a Discussion Board on your site.

n "Approving a Topic" on page 7-646

n "Sorting Topics" on page 7-647

n "Posting a Reply" on page 7-648

n "Editing a Post" on page 7-649

n "Quoting a Post" on page 7-648

n "Approving a Post" on page 7-649

n "Deleting a Post" on page 7-650

n "Reporting a Post" on page 7-650

n "Adding Video to a Post" on page 7-652

n "Suppressing User Information from the Forum Profile Display" on page 7-653

n "Outputting a Forum as an RSS Feed" on page 7-656

n "Subscribing to a Discussion Board" on page 7-656

n "Sending a Private Message" on page 7-658

n "Using the Control Panel" on page 7-658

Approving a Topic
A Topic needs to be approved when a user who does not have moderate permission for the

Forum adds a Topic. When you view topics on the site, any that need approval are highlighted

with a different color background.
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From this screen, you can click the Approve link next to the topic’s title. You could also click

the Topic’s title to view it and click the Approve button ( ) on that screen.

Sorting Topics
Topics can be sorted by the columns of a Forum. To sort a Forum:

1. Go to the Web page that hosts the Discussion Board.

2. Click the Forum of interest.

3. Click any of the column titles to sort by alpha or numerical order.

On the first click, items are sorted first by any numeric (1-10) values, then by alpha values (A

to Z). Clicking a column title a second time sorts the items in reverse.

When the page is first viewed, the list is sorted by Last Post.

Deleting a Topic
Topics on the site can be deleted from a Forum by the users who created them or by users with

the Moderate permission. This includes Membership users. See Also: "Moderate" on page 7-

639 and "Discussion Board Permissions" on page 7-638.

Warning! When you delete a topic, any replies or posts associated with the topic are also deleted.

To delete a topic:

1. Go to the Web page that hosts the Discussion Board.

2. Click the Forum of interest.

3. Click the topic you wish to delete.

4. Click Delete Topic.

5. A dialog appears asking you to confirm the deletion.
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6. Click OK.

The topic and all associated posts and replies are deleted.

Posting a Reply
1. Go to the Web page that hosts the Discussion Board.

2. Click the Forum of interest.

3. Click Add Reply.

Note: If a topic ismoderated, amessage appears stating that your reply is pendingmoderator approval.

There are two editors that site visitors can use when replying:

n eWebEditPro (scaled-down version)

n eWebEdit400

For users who sign in before posting, this decision is made for the user at the Forum Editor

field on the Edit User screen.

If users does not sign in, eWebEdit400 is the editor.

If a site visitor is using an Apple Macintosh computer, eWebEdit400 is the editor regardless of

the Forum Editor field value on the Edit User screen.

Quoting a Post
Quoting a post’s comments means that your reply begins with the original post’s comments.

You can then add your comments and even edit the quoted post, so that you can include only

the portion on which you are commenting.

To quote a post, follow these steps.

1. Go to the Web page that hosts the Discussion Board.

2. Click the Forum of interest.

3. Click a Topic.

4. Find the post you want to quote.

Content

7-648
ReferenceManual

Version 8.0 Rev 1.3



5. Click the Quote button.

6. The editor appears with the quoted information at the top of the text area.

.

7. Add your comments below the quote.

8. Click Post.

Editing a Post
1. Go to the Web page that hosts the Discussion Board.

2. Click the Forum of interest.

3. Find the topic you want to edit.

4. Click Edit.

Approving a Post
When defining a Forum, you can check the Moderate Comments field. If you do, posts to the

Forum must be approved before they appear on the Web site. Only users who are assigned the

Moderate permission are allowed to approve a post. See Also: "Discussion Board Permissions"

on page 7-638

You can approve a post from the Workarea or the Forum on the site. See also "Approving a

Post in the Workarea" on page 7-624.

To approve a post from the Forum, follow these steps.

1. Log into the site.

2. Navigate to the Forum.

3. Click the Moderate button ( ).

4. The Forum’s Control Panel appears.
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5. Click the topic.

6. The topic appears. Posts requiring approval have an Approve button ( ).

7. Click the Approve button ( ).

8. A screen appears stating that the post has been approved.

9. The post now appears on your Web site.

Deleting a Post
1. Go to the Web page that hosts the Discussion Board.

2. Click the Forum of interest.

3. Find the topic you want to delete.

4. Click Delete.

Reporting a Post
You can allow site visitors to inappropriate report posts, such as spam or offensive posts.

When a site visitor clicks the Report Post button (located at the bottom of the post), an email

notification is sent to all Forum moderators. Any moderator can review the post and decide to
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Adding Video to a Post
A user can add video to a post by clicking the Add Video button ( ) in a Forum post using
eWebEdit400. The following prerequisites must be in place for a user to perform this action:

n the embed tag must be added to the Accepted HTML property in the Workarea Forum’s

properties. See Also: "Accepted HTML" on page 7-602.

n a user must be using eWebEdit400 See Also: "Using eWebEdit400" on page 7-22

n the video must be in the .wmv format

n the video must reside in a hosted location. For example,

http://www.example.com/myvideos/fridaylunch.wmv

Once you click the Add Video button ( ), enter the path to the video in the dialog box and
click OK. A place holder is then added to the post.
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Suppressing User Information from the Forum Profile
Display
Anyone browsing to a Discussion Forum can view information about its contributors by

clicking the user name, as shown below.

.
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However, if the Forum server control’s HideUserProfile property is true, non-administrator

users cannot see the profile, even if the Private Profile setting is set to Public. For more

information, see "How Users Suppress Profile Information" on page 7-655 and "How

Administrators Suppress Profile Information" on page 7-655.

Administrators can see the profile, regardless of how the HideUserProfile property is set.

What Information is Contained in the Profile?
The profile contains the following information about a user:

n First Name - the first name of the user

n Last Name - the last name of the user

n Email - the email address of the user

n Joined - the date the user joined

n Last Visit - the date the user last visited the site

n Number of Posts - the amount of posts a user has contributed

n Post History - a list of posts the user has contributed
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How Users Suppress Profile Information
Users can determine if their profile is viewable via the Private Profile drop down box on the

Membership Registration screen (shown below) and the Edit Profile screen. If Private Profile

is set to Private, profile information is suppressed. If it is set to Colleagues, only a user’s

colleagues can see his profile. When set to public, everyone can see a user’s profile

information.

Note: If the Forum server control’sHideUserProfileproperty is set to true, non-administrator Forum visitors

cannot see a user profile, even if thePrivate Profile drop down box is set to Public.

Note: TheMembership Registration screen appearswherever your developer inserts theMembership Server

Control. For more information, see "Membership Server Control" on page 16-24.

How Administrators Suppress Profile Information
If you want to suppress the display of user names as an administrator, follow these steps.

Note: If the Forum server control’sHideUserProfileproperty is set to true, non-administrator Forum visitors

cannot see the profile, even if thePrivate Profile checkbox is unchecked.

1. If the user is a regular user, go to Settings > Users and select the user whose information

you want to suppress.

If the user is a membership user, go to Settings > Community Management >

Memberships > Users and select the user whose information you want to suppress.

2. In the User Properties area of the screen, check the Private Profile checkbox.
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Outputting a Forum as an RSS Feed
You can output a Forum as an RSS feed by clicking the RSS feed button ( ). Each level of
the Forum has an RSS feed button. This allows you to output a specific topic as an RSS feed.

This following is an example of the output.

<?xml version="1.0" encoding="UTF-8" ?>

- <rss version="2.0">

<!-- Generated byEktron CMS400.NET -->

- <channel>

<title>Ektron Medical Center Forum</title>

 <link>http://test/webform.aspx</link>

<description>Ektron Medical</description>

- <item>

<title>Research</title>

<link>http://test/webform.aspx?g=topics&f=108</link>

- <description>

<![CDATA[ Latest medical research ]]>

</description>

<pubDate>Wed, 11 Oct 2006 17:50:04 GMT</pubDate>

</item> </

channel>  </

rss>

Subscribing to a Discussion Board
After logging in, discussion board users can subscribe to Forum posts and replies by clicking

the Subscribe button ( ) (highlighted below).

The button appears at each Discussion Board level, so that a user can subscribe to Forums and

topics of interest. After clicking the button, the following screen appears.
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The user selects a notification type, listed below.

n All Posts - notifies you when any post or reply is added

n Replies to Me - notifies you when someone replies to your post

Next, he clicks the Add Subscription button. A page notifies him that his subscription was

added.

Reviewing Subscriptions
To review your Forum subscriptions, go to the Control Panel and click Notifications in the

lower left corner. A screen indicates each Discussion Board level to which you have

subscribed, as illustrated below.

Deleting a Subscription
To delete any subscription, check the corresponding check box and click the Delete button

(highlighted above).
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Sending a Private Message
Logged in users can send a private message to the person who created a post or reply. Only the

sender and receiver can view private messages. This requires both users to be either a

CMS400.NET user or a Membership user.

To send a private message, follow these steps.

1. Navigate to a post.

2. Click the User’s name.

3. When the User Profile appears, click the Message button.

4. The Message screen appears.

Note: The To: field is filled automatically. Users cannot add additionalmembers.

5. Enter a Subject.

6. Enter a Message.

7. Click the Post button.

8. Users are notified that a message was sent.

Using the Control Panel
The Control Panel allows logged in users to view your profile, read, reply to and delete private

messages. It also allows users with moderate permissions to moderate the Forum. The Control

Panel button is located at the Forum level.

.
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Clicking the Control Panel button opens control panel.

The Inbox view appears by default. From this view, users can read a message by clicking on it.

Once a message is read, its icon changes from unread ( ) to read ( ).

In addition, users can view information about the person who sent the message by clicking

their name. Users can also delete the message by clicking the corresponding check box then

the delete button. To switch to a different view, click its link.

The user can also check his subscriptions. See "Reviewing Subscriptions" on page 7-657.

Viewing and Replying to Messages
From the Inbox or Sent Items in the Control Panel, users can view a message by clicking on it.

On the View Message screen, users can see who sent the message, to whom the message was

directed, when it was sent, the subject and the contents of the message.
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Users can reply to a message by clicking the reply button ( ). Once clicked, the editor opens
in the control panel, and a user can reply.

Warning! When replying to a privatemessage, users add their response to the existingmessage. Only onemes-

sage is created.

Once a user adds a reply to the private message, he clicks the Post button. He is then informed

that the message was sent.

Deleting a Private Message
To delete a private message, follow these steps.

1. Click the Control Panel button on the front page of the Discussion Board.
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2. Click the check box next to the message.

3. Click the Delete Selected button.

4. A confirmation box asks if you want to delete all selected messages. Click OK.

5. The message is deleted.

Viewing a User Profile From the Control Panel
To view a profile from the Control Panel, click the Profile link in the Control Panel. See Also:

"What Information is Contained in the Profile?" on page 7-654
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Once the Profile link is clicked, the user’s profile page appears.

Moderating From the Control Panel
Users who have permission to moderate a Forum can do so from from the Control Panel by

clicking the Moderate link.

Once Moderate is clicked, the user sees a list of items that need approval.
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Clicking an item opens the post. From this screen, you can edit, approve, or delete the post.

See Also: "Approving a Post" on page 7-649.

Using Discussion Boards in
Community Groups
Beginning in version 8 of Ektron CMS400.NET, the community groups can have their own

discussion board. This provides forum discussions for the community that are limited to the

forum members.

All of the features of the Discussion Board system are available to a forum in a Community

Group. However, only one step is needed to first create a Discussion Board in the database.

The following example shows a discussion forum on a community group page.
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Creating a Community Discussion Board in the
Database
To use a group discussion board, you must first add the group discussion forum into the

database. Each group needs to do this one time when they decide to have a discussion forum

for their group.

Add a group discussion forum database by following these steps.

1. Login to your Web site.

2. Navigate to your group web page.

3. Click the Edit Group link.

In this example, the Edit Group link (circled below) is located on this group profile page

of the eIntranet Starter Site.

4. The Edit Group Link window appears

5. Check the Create Group Forum checkbox (circled below) to create a group forum in the

database.
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Warning! You cannot uncheck this option at a later time after the group forum database hasbeen created.

6. Click the Save button.

Now a group forum exists in the database and can appear on the group page.

Discussion Board Server Controls
The Discussion Board feature provides a forum where topics can be discussed on your Web

site. A CMS or membership user with Add Topic permission creates a topic and posts a starter

question. Any site visitor can then reply.

Ektron provides three server controls for use with Discussion Boards.

n "Forum Server Control" on page 7-666 - use to place a Discussion Board on a Web page

n "ActiveTopics Server Control" on page 7-677 - use to display the most active or most

recent topics and posts

n "PostHistory Server Control" on page 7-679 - use to display a list of posts for a user

For more information about Discussion Boards, see "Discussion Boards" on page 7-596. When

using the Forum server control, see "Inserting the Forum Server Control" on page 7-645.
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Forum Server Control
Warning! After placing a Forum server control on a page, follow the procedure described in "Updating the Page

Command" on page 7-674. Otherwise, the user mayget an error when posting a reply.

The Forum server control displays a Discussion Board on a Web page.

Forum Server Control Properties

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value Data Type

AllowAnonymousPost

Set to True to allow site visitors the option of

posting anonymously to the forum.When true, a Post

Anonymous checkboxappears above the text editor used to

create a post.

If a site visitor addsa checkmark to this box, the word

Anonymousappearswhere the DisplayName normally

Boolean

Content
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Property Value Data Type

appears. The default isTrue.

True - make the Post Anonymouscheckboxavailable to site

visitorswhen they create a post.

False - disable Post Anonymouscheckbox.

Authenticated
Indicates if you are logged in to CMSExplorer and can use it to

browse to Content, Collections, etc.
Boolean

BoardID

The ID of the Discussion Board to display on this page if one is

not defined in a query string parameter.

If you don’t know the ID, click the Ellipsesbutton ( ), then
sign in and select a Discussion Board.

Long

CacheInterval

Sets the amount of time, in seconds, a server control’s data is

cached. The default is 0 (zero).

For example, if you want to cache the data for fiveminutes, set

this property to 300. See Also: "Caching with Server Controls"

on page 21-31

Double

CustomOrderBy

Provide a property’s FriendlyName defined in the Indexing

Service to order search results by that property. For example,

if you define DocAuthor, resultswill be sorted by the

document’s author. Results can be ascending or descending

based onOrderDirection. If you enter an invalid property, no

search results are returned. If you specify both

CustomOrderByandOrderBy, the OrderByproperty is

ignored. The FriendlyName of a property can be found in

Computer Management >Services and Applications >

Indexing Service >Your Index >Properties >Friendly

Name column.

String
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Property Value Data Type

DefaultObjectID The Static ID of a community group. Long

DynamicForumParameter

Gets or sets the QueryString parameter to read a forum ID

dynamically. The default is “f”. Note that a Forum residesone

level below aDiscussion Board.

String

DynamicGroupParameter
Gets or sets the QueryString parameter to read a group’s ID

dynamically. The default is “g”.
String

DynamicObjectParameter
DynamicParameter for the community group id. Default is

“id”.
String

DynamicParameter

Gets or sets the QueryString parameter to read a discussion

board’s ID dynamically. Set to “None - Use Default” if you

want to alwaysdisplay the default discussion board. Note that

a Discussion Board is one level above a Forum.

boardid - readsa Threaded Discussion Board’s ID

dynamically.

None - Use Default - use the default discussion board’s ID.

ID - readsa discussion board’s ID dynamically.

String

DynamicThreadParameter

Gets or sets the QueryString parameter to read an individual

thread’s ID dynamically. The default is “t”. Note that a Thread

resides two levels below aDiscussion Board and one level

below a Forum.

String

EditorCSS

Set the style sheet for the Editor when a site visitor createsor

edits a post. Bydefault, this property is blank.When a style

sheet is not supplied, the style sheet defined in the Theme

property is used.

String

EditorToolbar

Enter a comma separated list of items that you want to appear

on the Editor’s toolbar. The default is

StyleMenu,FontMenu,ParagraphMenu,

TextFormatMenu,LinkMenu,ClipBoardMenu,

SymbolsMenu,EmoticonSelect,WMV,Table

See Also: "Adding and Removing Toolbar ItemsFrom the

Editor" on page 7-675.

String
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Property Value Data Type

EnableForumQuickSelect

If you set this property to true, a dropdown list of all forums

appears below the Topic list.

The site visitor can click a forum and jump immediately to it.

Boolean

EnableThreadRating

If you set this property to true, a ContentReview server

control appears on any topic screen run by this server control.

The site visitor can use the control to rate the topic thread.

An average rating for the thread appears next to each topic on

the forum screen.

Boolean

ExcludeList

Enter a comma-separated list of custom user properties to

exclude from the Forum’s profile page. For example, to

suppress theSubscriptions field value, enter

subscriptions.

See Also: "CustomUser Properties" on page 15-12 and

"Suppressing User Information from the ForumProfile

Display" on page 7-653

String
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Property Value Data Type

FilterXslt

Enter the path to an XSLT file used to filter forum content,

such as, HTMLAttributes, Tagsand unwanted words in a

user’s forum post. This path can be relative or absolute. The

user’s post is filter once he clicks the Submit button.

Bydefault, this property points to <webroot>/<siteroot>

/Workarea/Xslt/ForumFilter.xslt

The above file removeshrefswith javascript:, vbscript: and

“on” events in the link. You canmodify this file or create a new

one.

Warning! If you want to edit this file, it is strongly rec-

ommended that youmake a copy, change its name and

move it outside of your Web site’sWorkarea folder. If you

make changes to this file and do not move it out of theWork-

area folder, this file and the changeswill be lost when you

upgrade.

For additional sample code used to create a filter XSLT, see

the following KB article:

http://dev.ektron.com/kb_article.aspx?id=485

String

Hide
Select False to display this server control on the page. Select

True to suppress it.
Boolean

HideUserProfile

Set to True to suppressuser profiles. The default isTrue.

True - hidesuser profiles from non-administrator users.

False - displaysuser profiles from non-administrator users.

However, an administrator can view a profile regardlessof

how this property is set.

On the other hand, if thePrivate Profile is set to Private for

anyuser, his profile information is not visible, regardlessof this

setting. If Private Profile is set to Colleagues, only colleagues

can see profile information.

When the profile is visible, only properties and their valuesnot

listed in the ExcludeListproperty (above) appear.

For more information, see "Suppressing User Information

from the ForumProfile Display" on page 7-653.

Boolean

JavascriptEditorHeight
Set the height in pixels for the eWebEdit400 content designer.

The default is400. Theminimum height is 300.
Integer

JavascriptEditorHTMLMode

Note: Asof version 7.6, the JavaScript editor hasbeen

removed fromCMS400.NET. This property hasbeen

deprecated.

Set to True to allow users to edit their posts and replies in

HTML. The default isFalse.

String
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Property Value Data Type

JavascriptEditorToolbar

Note: Asof version 7.6, the JavaScript editor hasbeen

removed fromCMS400.NET. This property hasbeen

deprecated.

Decide which buttonsare available in the JavaScript Editor.

String

JavascriptEditorWidth
Set the width in pixels for the eWebEdit400 content designer.

The default is625. Theminimumwidth is 500.
Integer

Language

Set a language for viewing content. This property shows

results at run-time (in a browser).

Setting this property to -1 (negative one) causes the Forum

server control to display topics from all available languages.

Integer

ObjectType

Describes the type of forum displayed by this server control.

CommunityGroup - Used for forums inside a Community

page.

DiscussionBoard - Used for forumson templates that are

not Community pages.

String

OrderBy

The order of search results. For example, you want to sort

search results by last modified date.

Title - The content title (alphabetical).

ID - The content ID number.

Date Created - The date the content was created.

Date Modified - The date the content wasmost recently

modified.

Editor - The user who last edited the content (alphabetical).

Rank - The rankassigned to the content. See Also: "Search

Result Ranking" on page 9-27

Note: TheOrderDirection field determines the direction of

the search results. For example, if you sort by ID and

OrderDirection is set toDescending, the results sort by

ContentID number with the highest number at the top of the

list.

Warning! Specifying a CustomOrderByproperty overrides

this property.

String

OrderDirection

The direction in which search results are sorted. The default is

Ascending.

Ascending - Alphabetical results from A to Z; numeric values

low to high; dates from oldest to most recent

Descending - Alphabetical results from Z to A; numeric

valueshigh to low; dates frommost recent to oldest

String
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Property Value Data Type

ProfileLink

Enter a link to the user’s social networking profile page, a part

of ektron’s community platform. This allowsa user to click

another user’s name link or avatar and be taken to the user’s

profile page. There are two variables used within the link that

represent the user’s ID and the user’s display name.

{0} - represents the user’s ID.

{1} - represents the user’s display name.

You need to have both variables in the link. TheWeb form can

be relative or absolute. Below is an example.

userprofilepage.aspx?uid={0}&dn={1}

The default for this property is?g=profileu={0}.

When the default for this property is used, users are

forwarded to a user’s profile page that is included with the

forum control.

ItemLinkTargets

ProfileLinkTarget

Determines the type of window that appears on thisWeb form

when a user clicks an item in the Friends control. The default is

_self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

String

ShowCategories

If set to true, when this server control appears, the user see a

Filter by Category option. This option helpsa site visitor

zero in on relevant content.

If false, the Filter by Category option doesnot appear.

See Also: "Filtering Search Results byCategory" on page 9-

81

Boolean

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the

control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

Content
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Property Value Data Type

TaxonomyCols

Use this property to determine the number of columnson the

Taxonomyscreen available from thisDiscussion Board.

In the illustration below, taxonomycategories are arranged in

three columns (the default value).

Integer

TaxonomyMarkupLanguage

If you want to use an .ekml file to format the Taxonomyscreen

available from thisDiscussion Board, enter it here.

If the *.ekml file is located in the same folder as theWeb form

containing the server control, just enter its name. If the file is in

another folder, enter the path relative to site root. For

example, \CMS400Developer

\workarea\customfiles\markup\mylistsummary.ekml.

See Also: "EktronMarkup Language" on page 21-414

String

Theme

Enter the custom theme’s folder name. The theme can be

relative to the site root or located in the current folder. For

example:

Relative - Theme=”/workarea/csslib/themes/winter”

Current Folder - Theme=”mytheme”

If you do not specify a theme, the property uses the location

defined by the Discussion Board’sCSS theme property in the

Workarea.

See Also: "Using a Custom Theme" on page 7-674

String

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion

of an HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes

to a blockof code.

Custom - Lets you use custom tag.

String
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Updating the Page Command
To prevent an error from appearing when a user posts a reply to the Web page that hosts the

Forum server control, follow these steps.

1. Open the Web form onto which you inserted the Forum server control.

2. Access Source view.

3. Go to the top line of the Web form, which begins with @ Page.
<%@ PageLanguage="VB"AutoEventWireup="false"

CodeFile="Default2.aspx.vb"Inherits="Default2" %>

4. Near the end of the line, enter validaterequest=false.

5. Build the page.

Using a Custom Theme
This property allows you to specify a custom location for your themes. By doing so, you

prevent them from being overwritten when you upgrade.

If you do not specify a theme in the server control, Ektron CMS400.NET uses what is defined

in the Discussion Board’s properties CSS Theme field located in the Workarea.

To create a custom theme, follow these steps.

1. Create a new subfolder on your site. In this example, we use a winter theme:
<web root>/<your site>/Workarea/csslib/winter.

2. Copy all files in the /Workarea/Threadeddisc/themes folder to the winter folder.

3. Change the image files to match your theme.

Warning! To find the name of an image, right click on it while viewing it in a browser. Next, select properties. The

name appears at the top of the dialog box.

4. Change the Discussion Board’s .css file to match your theme and save it with a custom

name. (You do not need to do this if an existing .css file meets your theme’s needs.)

Warning! Make sure theCSS theme property in theWorkarea is pointing to the proper CSS file. See Also: "Work-

ing with Discussion Boardsand Subjects" on page 7-600

5. View the Discussion Board in a browser to see the changes.

Adding Video to a Post
A user can add video to a post by clicking the Add Video button ( ) in eWebEdit400. The
following prerequisites must be in place for a user to perform this action:

n the embed tag must be added to the Accepted HTML property in the Workarea Forum’s

properties. See Also: "Accepted HTML" on page 7-602

n a user must be using eWebEdit400
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n the video must be in the .wmv format

n the video must reside in a hosted location. For example,
http://www.example.com/myvideos/fridaylunch.wmv

Once you click the Add Video button ( ), enter the path to the video in the dialog box and
click OK. A place holder is then added to the post.

Adding and Removing Toolbar Items From the Editor
Warning! You cannot create new buttonsand add them to the ForumEditor. You can only add and remove exist-

ing buttons.

Toolbar items on the Forum Editor can be added and removed by editing EditorToolbar

property. This property contains a series of string values that represent each item, listed below.

String Value Item Description

StyleMenu

Display a list of paragraph styles. Users can

select from the list to apply a style to selected

text.

FontMenu
Display a list of available font styles, sizesand

colors.

ParagraphMenu

Controls the display of buttons that affect a

paragraph. This includes:

n Numbered List

n Bullet List

n Outdent

n Indent

n Align Left

n Align Center

n Align Right

n Justify

n HorizontalRule
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String Value Item Description

TextFormatMenu

Controls the display of buttons that format text.

This includes:

n Bold

n Italics

n Underline

LinkMenu

Controls the display of buttons that allow a user

to add and remove hyperlinks links and workwith

the library. This includes:

n HyperlinkManager

n Remove Link

n Library

ClipBoardMenu

Controls the clip board buttons that allow a user

to cut, copyand paste content. This item also

controls the Undo and Redo buttons.

SymbolsMenu

Controls the display of the Symbol button which

allowsusers to insert symbols and special

characters.

EmoticonSelect Controls the display of the Emoticon button.

WMV Controls the display of the InsertWMVbutton.

Table Controls the display of the Insert table button.
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ActiveTopics Server Control
The ActiveTopics server control displays either the most active topics for a forum or the most

recent ones. The most active are determined by how many new posts are added to a topic or

how many replies a post receives. The most recent are determined by the date of the post.

Below is an example of two ActiveTopics server controls. One control is set to Active, the

other is set to Recent.

The items in the list are clickable links, which open to the topic.

ActiveTopics Server Control Properties

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value Data Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it

to browse to Content, Collections, etc.
Boolean

BoardID

The ID of the board fromwhich to get entries.

If you don’t know the ID, click the Ellipsesbutton ( ), then
sign in, browse to, and select a Discussion Board.

Long

CacheInterval

Sets the amount of time, in seconds, the server control’s data is

cached. The default is 0 (zero). For example, if you want to

cache the data for fiveminutes, set this property to 300. See

Also: See "Caching with Server Controls" on page 21-31

Double
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Property Value Data Type

DisplayMode

Choose between Active or Recent. In Activemode, the server

control displaysa list of themost active posts. In Recent mode,

the server control displaysa list of recently added posts. The

default isActive.

Active - display a list of themost active posts.

Recent - display a list of the recently added posts.

eDisplayMode

Hide
Select False to display this server control on the page. Select

True to suppress it.
Boolean

Language
Set a language for viewing content. This property shows results

in design-time (in VisualStudio) and at run-time (in a browser).
Integer

MaxNumber Themaximum number of topics listed. The default is10. Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control.

The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

URLPath

Enter the path to the Forum server control’sWeb page. For

example:

http://<your site>/siteroot/forum.aspx.

or

/CMS400Developer/forum.aspx.

If your Forum page and your Active Topics page are in the

same folder, you can just enter the name of the page. For

example:

forum.aspx.

String

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of

an HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes

to a blockof code.

Custom - Lets you use custom tag.

String
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PostHistory Server Control
The PostHistory server control displays a list of forum posts for a given user. The posts are

displayed in order by date and contain the following:

n Topic - the topic that contains the post

n Posted - the date the post was created

n Content - the content within the post

PostHistory Server Control Properties

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value
Data

Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to

browse to Content, Collections, etc.
Boolean

BoardID

The ID of the Discussion Board fromwhich to get a user's posts.

If you don’t know the ID, click the Ellipsesbutton ( ), then sign in,
browse to and select the Discussion Board.

Long
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Property Value
Data

Type

CacheInterval

Sets the amount of time the server control’s data is cached. The default

is 0 (zero). This is the amount of time, in seconds, a control’s data is

cached. For example, if you want to cache the data for fiveminutes, set

this property to 300 (three hundred). See Also: See "Caching with

Server Controls" on page 21-31

Double

Hide
Select False to display this server control on the page. Select True to

suppress it.
Boolean

Language
Set a language for viewing content. This property shows results in

design-time (in VisualStudio) and at run-time (in a browser).
Integer

MaxNumber Themaximum number of posts listed. The default is10. Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The

default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

URLPath
The URL path to the page the where the Forum server control is

located.
String

UserID The ID of the user for whom to get the post history. Long

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a

blockof code.

Custom - Lets you use custom tag.

String
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Validating XHTML Content and
Accessibility

By validating XHTML content and accessibility, you can ensure your content is XHTML

compliant and that individuals with disabilities can navigate and understand your site.

This chapter has three sections:

n Validating with eWebEditPro+XML

n "Validating with eWebEdit400" on page 7-682

n "Customizing Validation" on page 7-686

Validating XHTMLContent and Accessibility
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Validating with eWebEdit400
eWebEdit400 can check content for the following types of compliance.

n Design - checks for the design standards such as proper closing tags and unique field

names.

Note: There is nothing you need to do to enable this type of validation, nor can you customize it.

n XHTML standards - see "Validating Content for Compliance with XHTML Standards" on

page 7-684.

n Section 508 Validation - accessibility standards established by agencies such as W3C

Markup Validation Service - see "Setting up and Customizing Accessibility Validation" on

page 7-683.

n Smart Form Data - makes sure that data entered into a smart form’s field is the correct

type and format. This selection only checks smart form fields if validation for the field was

turned on when it was added to the Smart Form. Validation for each field type is explained

in "Data Designer Field Types" on page 7-308.

Note: An additional type of validation ensures that when a site visitor completesan HTML form, the information is

formatted correctly. For example, a SocialSecurity number must have three numbers, a dash, two numbers,

another dash, and four numbers. This type of validation is explained "FormValidation" on page 7-232.

An editor can validate content while editing by clicking the Validate button ( ) (illustrated
below).

In addition, eWebEdit400 automatically validates content whenever the user tries to save,

check in or (submit for) publish content. See Also: "Step 1: Enable Accessibility" on page 7-

683

When validation is checked, any errors appear on the screen. If the content passes validation, a

message states The content is valid.

The rest of this section provides details about validating XHTML content through these topics.

n "Validating Content for Compliance with XHTML Standards" on page 7-684

Content
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n "Setting up and Customizing Accessibility Validation" on page 7-683

Setting up and Customizing
Accessibility Validation
To have eWebEdit400 check content for compliance with accessibility standards, follow these

steps.

See Also:

n "Step 1: Enable Accessibility" on page 7-683

n See "Step 2: Use Dialogs to Enter Accessibility Information" on page 7-683

n "Customizing Accessibility Checks" on page 7-684

Step 1: Enable Accessibility
In the Ektron CMS400.NET Workarea, accessibility options appear on the Settings >

Configuration > Setup screen under Accessibility/Section 508 Evaluation (below Editor

Options). The options are explained below.

n Do not validate - do not check content for compliance with accessibility standards

n Warn if fails - the user is warned but allowed to publish the content

n Enforce - the user must bring the content into compliance before submitting it for

publication or publishing it; however, can save it or check it in after being warned.

Step 2: Use Dialogs to Enter Accessibility Information
Several dialog boxes let the content editor enter accessibility information. An example is

below.

Setting up and Customizing Accessibility Validation
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The table below lists dialog boxes in which accessibility information can be entered.

Dialog Field How filled if no value exists

Image Properties Image Alt Text: Uses the image’s title

TableWizard - Cell PropertiesTab
Abbreviation:

Categories:
Not automatically filled when no value exists

TableWizard - Accessibility Tab
Caption:

Summary:
Not automatically filled when no value exists

HyperlinkManager

(IncludesQuicklinks)
Tooltip: Contents of Link Text field copied

Customizing Accessibility Checks
All standard accessibility checks are stored in the site root/Workarea/Content

Designer/ektaccesseval.xslt file. If you want to customize which checks are applied, edit that

file.

To change or disable the .xslt file that eWebEdit400 uses to validate for accessibility, edit this

line of site root/Workarea/Content Designer/ValidateSpec.xml.

<validate>

<xslt id="ektaccesseval" name="Section 508 Validation" enabled="true" src="[srcPat-

h]/ektaccesseval.xslt"/>

Validating Content for Compliance
with XHTML Standards
Ektron CMS400.NET content can be validated against the XHTML 1.1 standard. To do so, you

must define the Web sites that validate schema files and schema namespaces.

Here are two sites that can validate content using the WC3 Markup Validation Services.

n schema files - http://www.w3.org/2002/08/xhtml/xhtml1-transitional.xsd

n schema namespaces - http://www.w3.org/1999/xhtml

Content
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Defining the XHTML Validation Schemas

To validate content against XHTML standards, follow these steps.

1. Using Visual Studio, open site root/Workarea/edit.aspx.vb.

2. Find the section indicated below.

3. Using Intellisense, enter SchemaFiles and SchemaNamespaces properties to define the

validating Web sites. They accept an array of strings and go in pairs. Here are examples.

C#
ContentDesigner1.SchemaFiles = new string[] {"http://www.w3.org/2002/08/xhtml/xhtml1-

transitional.xsd"};

ContentDesigner1.SchemaNamespaces = new string[] { "http://www.w3.org/1999/xhtml" };

VB.Net
With m_ ContentDesigner1
.SchemaFiles = New String() {" http://www.w3.org/2002/08/xhtml/xhtml1-transitional.xsd"}
.SchemaNamespaces = New String() {"http://www.w3.org/1999/xhtml”}

End With
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Customizing Validation
In the site root folder\Workarea\ewebeditpro\cms_config.aspx file, you can specify a set of

validation options for plain text and calculation field types. (Data in other field types cannot

be validated.) For these field types, you can assign standard and custom validation checks. The

checks are applied when data is inserted into one of the field types, and when the user tries to

save a Data Design document whose fields have validation attributes.

You can modify the standard options and enter your own criteria for each field. You can also

establish dependencies between fields. For example, a value is only required for a field if a

certain Checkbox field is checked.

Validation Elements in the Configuration Data
The default configuration file includes standard validation options for plain text and

calculation field types.

<validation name="calculation">
 <choice name="none" treeImg="text">

 <caption localeRef="dlgNV8n" />
 <schema datatype="string" />

and

<validation name="plaintext" visible="false">
 <choice name="none" treeImg="text">

 <caption localeRef="dlgNV8n" />

The validation sections let you control the drop-down list of validation choices for a field type

(for example, Plain Text). Here is an overview of that section of the cms_config.aspx file.

<datadesign>
<validation> (0 or more)
<choice> (0 or more)
<caption>
<schema>
<calculate>
<regexp> OR
<script> OR
<xpath>
<validate>
<regexp> OR
<script> OR
<xpath>
<errormessage> (optional)

Details are provided below.

Validation Attributes
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Attribute Description Possible values

visible
Controlswhether theValidation field appears on the

field'sProperties dialog.
true, false

enabled

Controlswhether theValidation field is active or

“grayed out” on the field'sProperties dialog.

If set to true, theValidation field is active; if false, it

appears but is grayed out.

true, false

name

The field type to which the validation configuration data

applies.

A separate <validation>element must exist for each

field type.

plaintext, calculation

Validation Sub-elements

Element Description For more information, see

Choice
The calculation or validation expression for

standard fields
"Choice Sub-element" on page 7-687

Custom
The calculation or validation expression for

custom fields

"Defining CustomValidation" on page 7-

691

Choice Sub-element
Every item in the validation drop-down list must be defined within a set of <choice> tags.

Within the <choice> tags, you define a caption, a schema, and either a calculation or validation

expression.

The default validation choices appear below.

Customizing Validation

ReferenceManual

Version 8.0 Rev 1.3
7-687



Choice Attributes

Attribute Description

name Assign a new name to each choice.

treeImg

The icon to display for this field in the Select Field or Group dialog.

See "Iconson the Select Field or Group Screen" on page 7-696.

Unlike toolbar icons, you cannot create your own icons.

Note: This attribute only applies to the Data Design of a Smart

Form -- it doesnot apply to HTML forms.

Choice Sub-Elements

Element Description
For more

information, see

caption
Defines the displayed text for this choice. The attributesand description

are the same as<caption>elements for commands.

schema

DefinesaW3C XML schema (WXS) definition for this choice. The

definitionmaybe a simple type defined by the datatypeattribute and/or

aWXS fragment.

Note: This attribute only applies to the Data Design of a Smart Form -- it

doesnot apply to HTML forms.

"Defining a Schema

Fragment" on page

7-688

calculate
Definesan expression which normalizesa value prior to checking

validation

"Defining a

Calculation" on

page 7-689

validate Definesan expression that determines if a value is valid

"Defining

Validation" on page

7-691

Defining a Schema Fragment
When defining a schema fragment, the “xs” namespace prefix is required for WXS tags. Also,

the WXS fragment must be valid for inclusion in an xs:restriction (simple type). That is,

<xs:simpleType>
<xs:restriction>
...fragment...
</xs:restriction>
</xs:simpleType>
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Simple Data Types

The simple data types are defined by W3C XML Schema definition language 1.0.

Note: The datatype value should not include a namespace prefix. For example datatype=”string” is correct;

datatype=”xs:string” is incorrect

Examples

n Using only a datatype attribute
<schema datatype="string"/>

n Using only a schema fragment
<schema>
<xs:simpleType>
<xs:union memberTypes="xs:nonNegativeInteger">
<xs:simpleType>
<xs:restriction base="xs:string">
<xs:length value="0"/>
</xs:restriction>
</xs:simpleType>
</xs:union>
</xs:simpleType>
</schema>

n Using a datatype attribute and a schema fragment
<schema datatype="string">
<xs:minLength value="1"/>
</schema>

Defining a Calculation
Use the <calculate> element to define an expression that normalizes a value prior to checking

validation. For example, a calculation can truncate digits in a decimal, remove excess white

space, or capitalize text. The expression must return a value of the same data type and format

as the original value.

Several sample calculations are delivered with Ektron CMS400.NET. They appear when the

user clicks the Examples drop-down on the Calculated Field dialog. These calculations are

explained in "Explanation of Examples" on page 7-336.

You can only define one expression for <calculate> and <validate>.

The expression element choices are listed below. Use whichever language is easiest.
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n Regular Expression (JScript)

n JavaScript

n XPATH

Expression Description

Regular Expressions (JScript)

<regexp>

Definesa regular expression supported by JScript. You can define a regular

expression either between the tagsor using attributes.

If between the tags, the expressionmust begin with a slash (/) character. The g, i,

andm flagsare allowed. For example: <regexp>/\S+/</regexp>.

<regexp patternings-

exp-pattern”
A regular expression pattern (without the “/” chars).

<regexp

global=”true|false”

Specifieswhether the patternmatchesonly the first occurrence or all occurrences

within the text. This corresponds to the g flag.

<regexp

ignorecase=”true|false”
Specifies if thematch is case-sensitive. This corresponds to the “i” flag.

<regexp

multiline=”true|false”

Specifies if thematch, when using ^ and $, is applied to each line in text that has

multiple lines. This corresponds to the “m” flag.

<regexp

wholeline=”true|false”

Specifieswhether the pattern applies to the whole text or not. This is the same as

placing “^(“at the beginning of

the pattern, and “)$” at the end of the pattern.

JavaScript

<script

value=”javascript-

expression”

Specifies a JavaScript expression to be evaluated. The field's value is available in a

property named 'this.text'. For example

<script value="this.text.toUpperCase()"/>

XPATH (See Also: "Learn More about XPath" on page 7-697)

<xpath select=”xpath-

expression”

Specifies an XPath expression to be evaluated. The field's value is available using

“.”.

Defining Validation
Use the <validate> element to define an expression that determines if a value is valid. The

expression must return a Boolean (true or false) result. For example:

<validate>
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 <regexp>/^\d+$/</regexp>
</validate>

To construct the <validate> element, use the same expression element options as <calculate>.

See Also: "Defining a Calculation" on page 7-689

Defining an Error Message
Use the <errormessage localeRef="id"> element to define a message to display when the data

is not valid. For example, “Must be a number between 1 and 10, inclusive.”

The text may be within the <errormessage> tags or referenced using localeRef into the

localeNNNN.xml file.

Defining Custom Validation

Note: This section only applies to the Data Design of a Smart Form -- it doesnot apply to HTML forms.

Use the <custom> element to change the standard values that appear in the following fields of

the Custom Validation dialog.

Field Screen image

Data Type

Examples

To change the list of options, modify the <custom> element of the cms_config.aspx file. This

section describes the <custom> element’s attributes and child elements.

<datadesign>
<validation>
:
<custom> (optional tag)
<caption>
<selections name="datatype">
<listchoice> (0 or more)
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<selections name="examples">
<listchoice> (0 or more)

Element or Attribute Description

<custom>
Specifies basic data typesavailable when customizing validation. The typesare

defined in the <listchoice>elements (see below).

<custom

visible=”true|false”

Controlswhether theCustomValidation field appears on the Properties

dialog.

<custom

enabled=”true|false”

Controlswhether theCustom Validation field is active or “grayed out” on the

Properties dialog.

If set to true, theCustom Validation field is active; if false, it is grayed out.

<caption localeRef=”id”>
Specifies text to display in the validation drop-down list. The default caption is

“(Custom)”.

Selections element for Data Type field

<selections

name=”datatype”>
The namemust be datatype.

<selections

enabled=”true|false”

Controlswhether the drop-down list is active or “grayed out” on the Properties

dialog.

<selections

visible=”true|false”
Controlswhether the drop-down list appears on the Properties dialog.

Listchoice element for Data Type field

<listchoice> Defines the values in the CustomValidation dialog Data Type drop-down list.

<listchoice value=”simple-

data-type”

Enter each data type that should appear in the CustomValidation dialog’sData

Type drop-down list.

The simple data typesare defined byW3C XMLSchema definition language

1.0.
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Element or Attribute Description

See Also: "Defining a Schema Fragment" on page 7-688

<listchoice treeImg=”id”

Specifies the icon to display for this field in the Select Field or Group dialog. See

"Iconson the Select Field or Group Screen" on page 7-696.

Unlike toolbar icons, you cannot create your own.

<listchoice localeRef=”id”

The text that describes thisData Type on the CustomValidation dialog.

This element can refer to a string in the localeNNNN.xml file. Or, you can enter

the string between the <listchoice> tags.

<listchoice

default=”true|false”

Use this attribute to indicate the default choice in the CustomValidation dialog’s

Data Type drop-down list.

Selections element for Examples field

<selections

name=”examples”>
The namemust be “examples”.

<selections

enabled=”true|false”

Determines if theExamples drop-down list and label are active or “grayed out”

in the CustomValidation dialog.

<selections

visible=”true|false”
Determines if theExamples drop-down list and label appear.
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Element or Attribute Description

Listchoice Element for Examples field

<listchoice> Defines the values in the Examplesdrop-down list.

<listchoice value=”xpath-

expression-example”

The XPath expression appears in the Examples drop-down list of the Custom

Validation dialog.

<listchoice localeRef=”id”

-

The text that describes the exampleson the CustomValidation dialog.

This element can refer to a string in the localeNNNN.xml file. Or, you can enter

the string between the <listchoice> tags.

Saving Invalid Documents
Use the publishinvalid attribute of the <standard> element to determine if an invalid document

should be saved. This attribute lets you decide if a user can save an XML document when the

data in one or more fields does not satisfy the validation criteria.

In Data Entry mode, an example would be if a field requires a non-negative whole number, but

the user does not insert a value in that field.

If the publishinvalid attribute’s value is true, content is not checked for validity when it is

saved.

If false, the content is checked for validity during a save. If the content is valid, it is saved. If

it is invalid, the user is notified, and a custom script can be created to allow the content to be

saved or prevent it.
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Note: If the publishinvalid attribute is not defined in the <standard>element, the default is true so that

Ektron CMS400.NET is backwardscompatible with previous releases.

Custom Script that Handles Saving Invalid Files
To determine whether or not an invalid XML document should be saved, write a client-side

script that is called when invalid content is found. The routine should ask if the user wants to

save the invalid content. The script should return True to save the content, or False to abort

the save.

Below is an example of such a script.

<script language="JavaScript1.2">
<!--
eWebEditPro.instances["MyEditor1"].onerror = myOnErrorHandler;

function myOnErrorHandler()
{
 if (EWEP_STATUS_INVALID == this.status && "save" == this.event.source)
 {
 var strMsg = "Content is invalid.";
 strMsg += "\nError Code: " + this.event.reason;
 strMsg += "\nError Reason: " + this.event.message;
 alert(strMsg);
 return false; // prevent save

 }
}
//-->

</script>

The onerror Event
If the content is invalid, an onerror event is generated. This event provides two additional

properties for the event object when it fires:

n reason (a numeric error code)

n message (text describing the error)

As with the regular onerror event, the source property is available. You can display the values

of these properties in an error message that informs the user why the document is not valid.

Calculated Fields
A Calculated Field lets you include values that are calculated, typically from values in other

fields. For example, you can multiply two field values. The equation used is an XPath

expression.

You can validate a Calculated Field, just like the Plain Text Field. For instance, the total of a

series of numbers should be less than 100.

For more information about calculated fields, see
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Icons on the Select Field or Group Screen

Note: This section only applies to the Data Design of a Smart Form -- it doesnot apply to HTML forms.

Use the following icons to denote a field on the Select A Field or Group Screen (illustrated

below). These are the valid values for the treeImg attribute.

Icon Name

calculation

calendar

checkbox

droplist

fieldset

hidden

hyperlink

number

password
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Icon Name

picture

richarea

text

textbox

Learn More about XPath

Xpath Operators
Content copied from www.w3schools.com/xpath.

Operator Description Example Result

Numerical expressions perform arithmetic operations on numbers. XPath converts each

operand to a number before performing an arithmetic expression.

+ addition 6 + 4 10

- subtraction 6 - 4 2

* multiplication 6 * 4 24

div division 8 div 4 2

mod division remainder 5mod 2 1

Equality/ greater/ less than expressions test equality between two values

= equals price = 9.80 true (if price is 9.80)

!= is not equal price! = 9.80 false

< less than price < 9.80 false (if price is 9.80)

< = less than or equal to price <=9.80 true

> greater than price > 9.80 false
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Operator Description Example Result

>= greater than or equal to price >=9.80 true

Boolean expressions compare two values

or or
price = 9.80 or price =

9.70
true (if price is 9.80)

and and
price <=9.80 and price =

9.70
false

Identifying a path and element

. the current element . >100 true if element exceeds100

..
the current element’s

parent
count(../*)

counts the number of

elements at the same level as

the current element

Grouping and separating

[ ] predicate ../*[0]
../*[0] - returns the parent's

first child element

| specifymultiple elements sum( X | Y | Z )
If X=1 and Y=2 and Z=3, sum(

X | Y | Z ) = 6

Xpath Functions
Content copied from .

Operator Description Example

last

Returns the position number of the last node in the processed node

list

Syntax: number=last()

position

Returns the position in the node list of the node that is currently being

processed

Syntax: number=position()

count
Returns the number of nodes in a node-set

Syntax: number=count(node-set)

name Returns the name of a node
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Operator Description Example

Syntax: string=name(node)

string
Converts the value argument to a string

Syntax: string(value)

string(314)

Result: '314'

concat
Returns the concatenation of all its arguments

Syntax: string=concat(val1, val2, ..)

concat('The',' ','XML')

Result: 'The XML'

starts-with

Returns true if the first string startswith the second string.

Otherwise, it returns false.

Syntax: bool=starts-with(string,substr)

starts-with('XML','X')

Result: true

contains

Returns true if the second string is contained within the first string.

Otherwise, it returns false.

Syntax: bool=contains(val,substr)

contains('XML','X')

Result: true

substring-

after

Returns the part of the string in the string argument that occurs after

the substring in the substr argument

string=substring-after(string,substr)

substring-

after('12/10','/')

Result: '10'

substring-

before

Returns the part of the string in the string argument that occurs

before the substring in the substr argument

Syntax: string=substring-before(string,substr)

substring-

before('12/10','/')

Result: '12'

substring
Returnsa part of the string in the string argument

Syntax: string=substring(string,start,length)

substring('Beatles',1,4)

Result: 'Beat'

string-

length

Returns the number of characters in a string

Syntax: number=string-length(string)

string-length('Beatles')

Result: 7

normalize-

space

Returns the whitespace-normalized version of a passed string. All

leading and trailing whitespace is stripped, and all sequencesof

whitespace get combined to one single space.

Syntax: normalize-space('string')

normalize-space('

some text ') would

return some text
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Operator Description Example

translate
normalize

Syntax: string=translate(value,string1,string2)

n translate

('12:30','30','45')

Result: '12:45'

n translate

('12:30','03','54')

Result: '12:45'

n translate

('12:30','0123','abcd')

Result: 'bc:da'

boolean
Converts the value argument to Boolean and returns true or false

Syntax: bool=boolean(value)

not

Returns true if the condition argument is false, and false if the

condition argument is true

Syntax: bool=not(condition)

not(false())

true
Returns true

Syntax: true()

number(true())

Result: 1

false
Returns false

Syntax: false()

number(false())

Result: 0

lang

Returns true if the language argument matches the language of the

xsl:lang element. Otherwise, it returns false.

Syntax: bool=lang(language)

number
Converts the value argument to a number

Syntax: number=number(value)

number('100')

Result: 100

sum
Returns the total value of a set of numeric values in a node-set

Syntax: number=sum(nodeset)
sum(/cd/price)

floor

Returns the largest integer that is not greater than the number

argument

number=floor(number)

floor(3.14)

Result: 3

ceiling

Returns the smallest integer that is not less than the number

argument

Syntax: number=ceiling(number)

ceiling(3.14)

Result: 4

round
Rounds the number argument to the nearest integer

Syntax: integer=round(number)

round(3.14)

Result: 3
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XPath References
To learn more about XPath, check these Web pages.

Topic URL

W3C Spec - XPath 1.0 spec http://www.w3.org/TR/xpath

Tutorial www.w3schools.com/xpath/default.asp
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Content Reports

The reports folder contains several reports to help you manage the workflow of content through

Ektron CMS400.NET. In most cases, you choose a report that corresponds to the content’s

status, then view all content in that status. If appropriate, you can perform tasks on selected

content. For example, you can check in checked-out content.

This chapter explains how to access the reports folder in your Workarea, set criteria that

determine the information on the reports, and actions you can perform on them.

See Also:

n Accessing the Reports Folder

n "List of Conte" on page 7-703

n "Common Report Topics" on page 7-704

n "eCommerce Reports and Widgets" on page 17-237

(continued in Accessing the Reports Folder)
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List of Conte
Report Displays content in this status For more information, see

Approvals Requiring your approval
"ApprovalsReports" on page 7-

710

Checked In Content Checked in
"Checked In Report" on page

7-712

CheckedOut

Content
Checked out

"CheckedOut Report" on page

7-713

New Content
New (that is, created and saved but never

published)

"New Content Report" on page

7-714

Submitted Content Submitted for publication
"Submitted Report" on page 7-

715

Content Pending

Start Date
Approved and pending a start date

"Content Pending Start Date

Report" on page 7-716

Refresh Reminder

Report
End date hasbeen reached

"Refresh Reminder Report" on

page 7-717

Expired Content Expired date hasbeen reached
"Expired Content Report" on

page 7-718

Content to Expire Will expire within specified number of days
"Content to Expire Report" on

page 7-719

Site Update Activity

Content Report

Content created or updated in selected folders

and within a selected date range

"Site Update ActivityReport" on

page 7-721

AsynchronousLog

File Report
A log report of the Asynchronousprocess

"AsynchronousLog File

Reporting" on page 20-13”

Search Phrase

Report
Frequencyof search terms

"Search Phrase Report" on

page 7-724

PreapprovalGroups
User groups that have been assigned to folders

in order to preapprove content

"PreapprovalGroupsReport"

on page 11-37

Bad LinkReport Invalid links to externalURLs
"Bad LinksReport" on page 7-

725
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Common Report Topics
The following topics apply to the reports.

n "Information on the Reports" on page 7-704

n "Report Toolbar Options" on page 7-705

n "Selecting Content by Folder" on page 7-705

n "Selecting Content by Type" on page 7-706

n "Sorting and Filtering Content Reports" on page 7-707

n "Performing an Action on Several Content Items" on page 7-707

n "Viewing/Editing Content on the Report" on page 7-708

n "Emailing Reports" on page 7-708

Information on the Reports
Each report displays the following information about its content.
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Field Description

Title Title of content.

ID
Internal number assigned to content byEktron

CMS400.NET.

DateModified
If a Start Date wasassigned to the content, it appears

here.

Last Editor The user who last edited the content.

Path Folder location of content.

Report Toolbar Options

Toolbar Button Description
For more

information, see

email this report to selected users
"Emailing Reports"

on page 7-708

Select a folder whose content appears

on the report. Content in other folders is

ignored.

"Selecting Content

byFolder" on page

7-705

Go to previous screen

Select the language of the content you

want to see on the report

Selecting Content by Folder
You can select a folder and only view the content in that folder that satisfies the other report

criteria. For example, the Checked in Content Report can show only content whose status is

checked in and which resides in the Contacts folder.
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Only content in the selected folder appears. The report does not include content from

subfolders of the selected folder.

To select content by a folder, follow these steps.

1. From the Smart Desktop, select a report.

2. Click the Select a Folder button ( ).

3. The top level folders appear.

4. If the folder you want is on the list, click the corresponding checkbox.

If the folder you want is a subfolder, click the parent folder’s name. A new screen appears,

showing the selected folder’s subfolders. Click the corresponding checkbox.

5. Click the Save button ( ) to finalize your folder selection.

6. The screen displays all content items in the selected folder that satisfy all report criteria.

Selecting Content by Type
After viewing any report, you can select a content type and only view the content of that type

that satisfies the other report criteria. For example, the Checked in Content Report can show

only Office documents.

To select a content type, follow these steps.

1. From the Smart Desktop, select a report.
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2. Use the file types pull-down to select a file type.

3. The screen refreshes and only displays files of that type.

Sorting and Filtering Content Reports
Upon viewing a report’s content, you have additional options for filtering report data by user

and content folder.

The filtering options for each content report are identical. The following section uses the

Checked-In Content report as an example.

Filter by User
To display only content that was checked in by a user, click the name of the user in the report

display. When you do, the report redisplays, showing only content which that user checked in.

Filter by Content Folder
To display only content checked in to a selected folder, click the folder on the report display.

When you do, the report redisplays, showing only content in that folder.

Note: You can also select a folder and view reports in that folder only. See Also: "Selecting Content byFolder" on

page 7-705

Performing an Action on Several Content Items
You can perform the following actions on several or all content items in the Approvals,

Checked in, and Checked out reports.

CommonReport Topics

ReferenceManual

Version 8.0 Rev 1.3
7-707



Report Action you can perform

Approval Approve

Checked in Submit for publication

Checked out Check in

To select several reports, check the relevant checkboxes (illustrated below). To select all

reports, click the Select All button in the upper left corner.

Then, click the button at the top left to perform the action on the selected content items.

Viewing/Editing Content on the Report
To view (and possibly edit) any content on a report, click it. It appears on the View Content

screen (illustrated below).

The View Content screen provides several toolbar options that you can perform on the content.

Emailing Reports
You can email any report. You might do this, for example, to notify a user that several content

items are checked out to him. All information in the report appears in the email. A sample

appears below.
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You can click any content item on the report and proceed to that page of your Web site.

To email any report, follow these steps.

1. Display the report you want to email.

2. Click the email button ( ).

3. A list of all users and user groups in your Ektron CMS400.NET appears.

Note: Usersappear fIrst in alphabetical order (byusername), followed byuser groups. The icon for user groups

has two heads (see below).

4. Click inside the checkbox of every user or group to receive a copy of the report.

Searching for Report Recipients
If you cannot easily find a user, a search of all users and groups is available. To use it, follow

these steps.

1. Display the report that you want to email.

2. Click the email button ( ).

3. A list of all users and user groups in your Ektron CMS400.NET appears.
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4. Click the Search for User button ( ).

5. The following screen appears.

6. Enter whatever information you know about the users.

7. Click the Send email button.

8. All users that satisfy the search criteria appear on a new screen.

9. Click the checkbox of every user or group to receive the report.

Approvals Reports
Each content item awaiting your approval appears on this report. Thus, you can quickly find

all such content without searching through every folder.

The View All Content Awaiting Approval screen displays the following information about

this content.

Field Description

Title Title of content.

Request Type Request made for the content. Either Publish or Delete.

Start Date
Start date, if any, assigned to the content. Determineswhen content will go live

onWeb site.

DateModified Date the content wasmost recently changed

Submitted By User who submitted content for approval.

ID The ID number if the content.

Language The language of the content.

Path Path to content folder where content resides.
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See Also:

n "Report Toolbar Options" on page 7-705

n "Selecting Content by Folder" on page 7-705

n "Selecting Content by Type" on page 7-706

n "Sorting and Filtering Content Reports" on page 7-707

n "Performing an Action on Several Content Items" on page 7-707

n "Viewing/Editing Content on the Report" on page 7-708

n "Emailing Reports" on page 7-708

Below is an example of the View All Content Awaiting Approval screen.

Approving/Declining Content

From the approvals report, you can approve or decline content that was submitted to you. The

steps below explain how to do so.

1. Access your Approvals report in the Workarea (see "Approvals Reports" on page 7-710).

2. Click the content you want to approve or decline.

3. The View Content Awaiting Approval page is displayed.

4. Perform an action using the following table as a reference.

Button Name Description

Publish

Accept changes to content and publish it to site.

Note: If there is a subsequent approver in the content’s approval chain, this

button is replaced bya Submit button.

If you clickPublish but the content item hasan incomplete taskassigned to

another user, the content cannot

be published. Instead, the following error message appears.

Approvals Reports
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Button Name Description

The user to whom the task is assignedmust complete it before you can

publish the content.

Decline

Reject changesand keep current version of content live onWeb site.

You are prompted to enter a comment that providesa reason for the decline.

The author whomade the change is notified byemail of the decline.

The content inserted by the last editor remains in the file. If you do not want it

to remain, choose theEdit option.

Edit Checkout content andmake changes to it if desired.

View

Published/Staged

Toggle between published and submitted versionsof content. This can help

you compare differences.

Back Go back to previous screen.

Approving Multiple Content Items
See "Performing an Action on Several Content Items" on page 7-707.

The selected content is either submitted to the next publisher, published immediately, or

deleted, depending on the content’s approval chain.

Checked In Report
The Checked In Content report displays all the content currently in a checked-in status.

The report displays the following information.

Column Description

Title Title of content.
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Column Description

ID ID number assigned to content byEktron CMS400.NET.

Last Editor Last user to edit the content.

DateModified Date and time content was last edited.

Path Folder location of content in Ektron CMS400.NET Web site.

See Also:

n "Report Toolbar Options" on page 7-705

n "Selecting Content by Folder" on page 7-705

n "Selecting Content by Type" on page 7-706

n "Sorting and Filtering Content Reports" on page 7-707

n "Performing an Action on Several Content Items" on page 7-707

n "Viewing/Editing Content on the Report" on page 7-708

n "Emailing Reports" on page 7-708

Submitting Multiple Content Items

After selecting content, use the submit toolbar option ( ) to submit it for approval or
publication, depending on your position in the approval chain.

Checked Out Report
The Checked Out Content report displays all content currently in a checked out status.

The report displays the following information.

Column Description

Title Title of content.

ID ID number assigned to content byEktron CMS400.NET.
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Column Description

Last Editor Last user to edit the content.

DateModified Date and time content was last edited.

Path Folder location of content in Ektron CMS400.NET Web site.

See Also:

n "Report Toolbar Options" on page 7-705

n "Selecting Content by Folder" on page 7-705

n "Selecting Content by Type" on page 7-706

n "Sorting and Filtering Content Reports" on page 7-707

n "Performing an Action on Several Content Items" on page 7-707

n "Viewing/Editing Content on the Report" on page 7-708

n "Emailing Reports" on page 7-708

After selecting content, check it in using the Checkin button ( ).

New Content Report
The New Content report displays content in a new state, that is, it was created and saved but

never published. The new content report contains the following information.

Column Description

Title Title of content.

ID ID number assigned to content byEktron CMS400.NET.

Last Editor Last user to edit the content.

DateModified Date and time content was last edited.

Path Folder location of content in Ektron CMS400.NET Web site.

See Also:
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n "Report Toolbar Options" on page 7-705

n "Selecting Content by Folder" on page 7-705

n "Selecting Content by Type" on page 7-706

n "Sorting and Filtering Content Reports" on page 7-707

n "Performing an Action on Several Content Items" on page 7-707

n "Viewing/Editing Content on the Report" on page 7-708

n "Emailing Reports" on page 7-708

Submitted Report
The Submitted Content report displays all content in a submitted state. The report contains the

following information.

Column Description

Title Title of content.

ID ID number assigned to content byEktron CMS400.NET.

Last Editor Last user to edit the content.

DateModified Date and time content was last edited.

Path Folder location of content in Ektron CMS400.NET Web site.

Viewing Position in Approval Chain

While viewing the Submitted Content report, you can view the content’s position is its

approval chain. You can use this information to contact the individuals in the chain and ask

them to complete their approval. To do so, follow these steps.

1. From the Submitted Content Report, click the content’s title.

2. The View Content page is displayed.

3. Click the Properties tab.

4. The content’s position in the approval chain is indicated by red text on the Approvals

line.
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See Also:

n "Report Toolbar Options" on page 7-705

n "Selecting Content by Folder" on page 7-705

n "Selecting Content by Type" on page 7-706

n "Sorting and Filtering Content Reports" on page 7-707

n "Performing an Action on Several Content Items" on page 7-707

n "Viewing/Editing Content on the Report" on page 7-708

n "Emailing Reports" on page 7-708

Content Pending Start Date Report
The Pending Start Date Report displays all content that was approved, but whose start dates

haven’t occurred. Each content item on the report contains the following information.

Column Description

Title Title of content.

ID ID number assigned to content byEktron CMS400.NET.

Last Editor Last user to edit the content.

Start Date Date and time content will go live onWeb site.

Path Folder location of content in Ektron CMS400.NET Web site.
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Editing Content with a Pending Start Date

You may edit content on the Pending Start Date Content report. To do so, follow these steps.

1. Click the content you want to view.

2. The View Content page is displayed.

3. Using the toolbar at the top of the page, perform any action available.

See Also:

n "Report Toolbar Options" on page 7-705

n "Selecting Content by Folder" on page 7-705

n "Selecting Content by Type" on page 7-706

n "Sorting and Filtering Content Reports" on page 7-707

n "Performing an Action on Several Content Items" on page 7-707

n "Viewing/Editing Content on the Report" on page 7-708

n "Emailing Reports" on page 7-708

Refresh Reminder Report
The Refresh Report displays all content whose end date has passed and whose archive option

is set to Refresh Report. This content is still visible on the Web site. Its appearance on this

report indicates that it is due for review. See Also: "Scheduling Content to Begin and End" on

page 7-195

Each item on the report contains the following information.

Column Description

Title Title of content.

ID ID number assigned to content byEktron CMS400.NET.

Last Editor Last user to edit the content.

DateModified Date and time the content was last updated.
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Column Description

Path Folder location of content in Ektron CMS400.NET Web site.

Removing Expired Content from Site

If you review content and decide it should no longer appear on your site, follow these steps to

remove it. The content will be visible if you browse to it through the Workarea, but won’t

appear to site visitors.

1. From the Expired Content Report, click the content.

2. From the View Content screen, click the Edit button ( ).

3. Click the Schedule tab.

4. Under Action on End Date:, click Archive and remove from site (expire).

See Also:

n "Report Toolbar Options" on page 7-705

n "Selecting Content by Folder" on page 7-705

n "Selecting Content by Type" on page 7-706

n "Sorting and Filtering Content Reports" on page 7-707

n "Performing an Action on Several Content Items" on page 7-707

n "Viewing/Editing Content on the Report" on page 7-708

n "Emailing Reports" on page 7-708

Expired Content Report
The Expired Content report displays all content whose end date has passed. Such content is no

longer visible on the Web site.

Each item on the list contains the following information.

Column Description

Title Title of content.
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Column Description

ID ID number assigned to content byEktron CMS400.NET.

Last Editor Last user to edit the content.

End Date Date and time the content expired.

Path Folder location of content in Ektron CMS400.NET Web site.

Editing Expired Content

You may edit any content on the Expired Content report. To do so, follow these steps.

1. Click the content you want to view.

2. The View Content page is displayed.

3. Using the toolbar at the top of the page, perform any action available.

See Also:

n "Report Toolbar Options" on page 7-705

n "Selecting Content by Folder" on page 7-705

n "Selecting Content by Type" on page 7-706

n "Sorting and Filtering Content Reports" on page 7-707

n "Performing an Action on Several Content Items" on page 7-707

n "Viewing/Editing Content on the Report" on page 7-708

n "Emailing Reports" on page 7-708

Content to Expire Report
The Content to Expire report lists all content whose end date will occur between today and a

number of days that you specify. For example, if today is January 1 and you select 10 days, the

report lists all content whose end date is January 1 through January 10.

After viewing the report, you can click any content and proceed to the View Content screen

for it. From there, you can edit information about it, including its end date if desired.

Each item on the list contains the following information.
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Column Description

Title Title of content.

ID ID number assigned to content byEktron CMS400.NET.

Last Editor Last user to edit the content.

End Date Date and time the content expired.

Path Folder location of content in Ektron CMS400.NET Web site.

Selecting the Report’s Date Range

To select the report’s date range, you have two options:

Option Illustration

Enter a number in theDays field. Then click the

View Reports button ( ).

Select a number from the dropdown list below

theDays field

After selecting a number of days, click the view icon ( ) to see all content that will expire
within that time frame.
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See Also:

n "Report Toolbar Options" on page 7-705

n "Selecting Content by Folder" on page 7-705

n "Selecting Content by Type" on page 7-706

n "Sorting and Filtering Content Reports" on page 7-707

n "Performing an Action on Several Content Items" on page 7-707

n "Viewing/Editing Content on the Report" on page 7-708

n "Emailing Reports" on page 7-708

Site Update Activity Report
The Site Activity Report provides a snapshot of the freshness of the content on your Web site.

Specifically, it lists how many content items were published within a folder and date range

you select, broken down by folder.

A sample report appears below.
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Selecting Information to Appear on the Report
To choose which content items will appear on the report, follow these steps.

1. By default, only content in the default language appears on the report. To change the

language, use the language pull-down near the top of the screen.

2. Choose a Start Date by clicking the calendar icon ( ).

3. A calendar appears. You can move to another month or year by clicking it. When you get

to the desired month, click inside the day. The selected date turns red (see below).

4. Click Done.

5. If desired, select an End Date using the same procedure.

Note: If you do not select an end date, the report uses todayas the end date.

6. At the Select field, choose a folder. The Root folder is the default selection.

Note: Only folders for which you have read-only or greater permission appear.

To change that selection, click the folder name. When you do, the Select Folder screen

appears.
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To select all folders on the screen, click the Select All checkbox. Otherwise, select folders

by clicking the corresponding checkbox. There is also an option to Include Sub-folders of

the selected folders.

7. Choose the Report type, which determines the information you will see on the report.

Options are explained below.

Report Type Description

Detail View

n name of each page that waspublished

n howmany times it waspublished

n date it was last published

n userswho published page

n total numbers are not provided

Detail View Example

Combined View information from Executive and Detail views

8. If you would like to exclude users or use groups from the report, use the Exclude Users

field. For example, you want to see all updates other than those you have completed.

When you click Exclude Users, an alphabetical list of users appears, followed by user

groups. (User groups have a two- headed icon ( )).

9. Click Get Result.
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Search Phrase Report
This report displays all terms that were entered into the Search Text Field within a selected

range of dates. You can use it to discover the kind of information site visitors are searching for.

Selection Criteria

You can narrow down the search by selecting any combination of these criteria.

n language - the language of the search page (either Workarea or Web site search). The user

performing the search can choose a language before inserting the search text. If he does not

explicitly choose a language, the search uses the default one. This report can show results

from all languages or any one that you select.

n a minimum number of occurrences of the word or phrase to return. For example, you only

want words or phrases entered into the Search Text field at least 10 times during the last

month.

n whether to include words or phrases entered into the Web site search (the search page that

site visitors use)

n whether to include words or phrases entered into the Workarea search (accessed from the

View Contents of Folder screen, this search page is used by authorized CMS users to find

content)

n date range
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Display of Search Results

The search results show the number of times each word or phrase that satisfies the selection

criteria appears. They are arranged in this order.

n words or phrases with the most occurrences appear first

n if several words or phrases have the same number of occurrences, they are arranged

alphabetically

Also, terms entered into the Web site search or the Basic Workarea search are surrounded by

parentheses (). Terms entered into the Advanced Workarea search have no parentheses. The

Microsoft search engine uses this syntax to find content.

Bad Links Report
The Bad Links Report notifies you of any invalid links to external URLs within your content.

(An invalid link returns an error code to your browser.)

Note: The report doesnot checkquicklinksembedded in the content.

To accomplish this, the report scans the following types of content.

n published HTML content

n published XML content

n HTML forms

n XML Smart Forms

n menus

n active system templates

When the scan is complete, the report lists any item that includes an invalid URL. From the

list, you can click a button to access the item, then update or remove the bad link.

Running the Bad Links Report

To run the Bad Links Report, go to Smart Desktop > Reports. When you select Bad Link

Report, you immediately see its status, either Done or Running.
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To begin scanning for bad links, click the Check Links Now button ( ). When you do,
existing data is replaced by new data being collected as the report progresses.

While the report scans content, you are free to work in other areas of Ektron CMS400.NET.

You can even sign off Ektron CMS400.NET. These actions have no effect on the report’s

collection of data.

If you want to stop the Bad Links Report at any time, click the Cancel button ( ).

After all content is scanned, the report’s status changes to Done. If desired, you can print the

report by clicking the print button ( ).

You can also launch the broken link in a browser by moving the cursor over it then clicking

when the cursor turns into a hand.

Fixing Errors

The report lists the following information about each item that contains a bad link.

n title

n error description

n Source, that is, item type (content, menu, etc.) followed in parentheses by information

about the item that has the error.

As examples
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- if the error is in a content block, you see Content followed by its id number and

language locale id

- if the error is in a Smart form, you see Smart form followed by its ID number

- If it’s a menu, you see Menu Item (11,0,1033). The three parameters are menu ID,

menu item ID, and language ID.

- An error in a template looks like this:

- The beginning of the bad link’s source code. Use this to help you find the bad link

from Source View.

n the anchor (<a>) tag to which the bad link is assigned

n URL that could not be resolved (labeled Invalid Link)

To fix an error, click the edit button next to the title (highlighted below). The item opens in

edit mode, so you can fix the bad link.

The error report’s Source: field also indicates the text to which the bad link is assigned. See

content highlighted in the above graphic.

Within the content, you select the indicated text, right click the mouse, and select Set Link

Properties to access the hyperlink dialog. From here, you can update or remove the bad link.
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Running the Bad Links Report on a Schedule

You can set the Bad Links Report to run in the background at predetermined times. If you do,

you can view the report‘s latest results at your convenience without having to wait while it

compiles.

To set up a schedule, follow these steps.

1. Open the following configuration file:

C:\Program Files\Ektron\EktronWindowsservice30\Ektron.ASM.EktronServices.exe.config

2. Within that file, go to the following line:

<add name="RunJob" type="Ektron.ASM.EktronServices.RunCMSJobManager.JobService,

Ektron.ASM.EktronServices" AbsoluteTime="Weekly|5, 2:27:00 PM" Enabled="true" />

3. Use the absoluteTime property to set the Bad Links Report’s start time and frequency. By

default, the report is scheduled to run every Thursday at 2:27 p.m. The following table

lists ways to indicate a schedule.

Frequency How to indicate Example

Hourly
Comma-separated list of integers representing the number of

minutes, secondsandmsbetween jobs

360,0,0 (every 360

minutesor 6 hours)

Daily A time in hh:mm:ssAM/PM format
11:30:00 PM (every day

11:30 pm)

Weekly

Weekly | followed byan

n is an integer that corresponds to a dayof the week, followed

by time. Use the time format described for the Daily frequency.

Use zero (0) to indicate Sunday, 1 for Monday, etc., through 7

for Saturday.

Weekly| 0 12:00:00 PM

(everySundayat noon)

Monthly

Monthly | followed byan integer that corresponds to a dayof

themonth, followed by time. Use the time format described for

the Daily frequency.

Use zero (0) to indicate Sunday, 1 for Monday, etc., through 6

for Saturday.

Monthly| 15 11:30:00

(the 15th of everymonth

at 11:30 PM)
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Content Reviews and Content
Ratings

Ektron provides two ways to rate and review content, Content Reviews and Content Rating.

These features allow you to determine how good your content is by the people reading it. You

can run reports to determine the highest rated content or assets and tweak poorly rated or

reviewed content to achieve optimal ratings.

Content Review
Ektron CMS400.NET provides a content review system so site visitors can provide reviews of

content on your Web site. A visitor can rate content on a scale of one through five stars and

comment. The reviews are collected from the Web page via the ContentReview server control.

Depending on the XSLT used with the ContentReview server control, you can allow half star

rating increments and let site visitors submit comments (see illustration below).

Note: If a visitor is not logged in asa CMSor membership user, his browser must have cookiesenabled in order to

submit a content review.

In addition to consuming site visitors’ reviews and displaying the information in the Workarea,

the ContentReview server control can be used to display reviews on your site. See Also:

"Displaying Reviews on the Site" on page 7-731
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Reviews can be moderated from the Smart Desktop or the Content Review screen associated

with a content item. See Also: "Moderating Reviews" on page 7-732

The content review feature is explained through the following topics.

n "Inserting the ContentReview Server Control" on page 7-730

n "Limiting Visitors to One Review" on page 7-730

n "Viewing the Content Reviews Report" on page 7-730

n "Moderating Reviews" on page 7-732

n "Purging Rating and Review Data" on page 7-736

Inserting the ContentReview Server Control
To allow site visitors to rate and review content on a Web page, your developer inserts a server

control. This procedure is described "ContentReview Server Control" on page 7-736.

Limiting Visitors to One Review
Ektron CMS400.NET assumes you want to limit a user to rating a content item once. If a

regular or membership user logs in before rating a piece of content, Ektron CMS400.NET

remembers the user ID. For any other site visitor, Ektron CMS400.NET places a cookie on his

computer.

So, whenever a page with a ContentReview server control is visited, Ektron CMS400.NET

checks for the user ID or cookie. If neither exists, it displays a rating scale. If the page has

already been rated by the user, the user can edit his existing rating and review by clicking a

star, editing the comments, and clicking the submit button.

Viewing the Content Reviews Report
All content review data for a content item can be displayed in detail and summary format. To

view this data, follow these steps.

1. Sign in to Ektron CMS400.NET.

2. Do one of the following:

n Navigate to the content item in the Workarea

- Go to Workarea > Content.

- Navigate to the folder that contains the content.

- Navigate to the content item.

- Click the View Content Reports toolbar button ( ).

n If the review is awaiting moderation, use the Content Review section of the Smart

Desktop.
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- Go to the Workarea > Smart Desktop

- Click Content Reviews

- Select the content item

The Content Review shows a summary of all ratings submitted for the content.

3. click the Get Reviews button to see the list of review comments at the bottom.

If desired, you can select a range of dates and limit the display of ratings data to those dates.

Select start and end dates (using calendar buttons at the top of the screen) and click Get

Reviews.

See Also: "Content Review" on page 7-729

Displaying Reviews on the Site
Reviews on your site communicate how other people in your site’s community feel about a

product or article. It also helps build the community by empowering site visitors and allowing

them to have voice.

If your site displays reviews and a user does not see his review, it is probably because

moderation is enabled for the content reviews. If a user’s review is pending or rejected, it is not

displayed. A site or membership user can determine the status of his review by logging into

the site and navigating to the Web page that hosts the review. Next to the title of his review is

Rejected or Pending. The user can submit another review if his review was rejected or has

been pending for too long.
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The ContentReview server control’s DisplayXSLT property handles the displays of site visitor

reviews on the site. The server control can display reviews for specific content or a specific

user. See Also: "DisplayXslt" on page 7-739.

Exporting Details to Excel
If Microsoft Excel is installed on your computer, you can export the ratings detail to Excel for

further manipulation of the data. To do so, the Click Export to Excel button located at the

bottom of the Content Report for the content.

Moderating Reviews
Since reviews can be displayed on your Web site, Ektron CMS400.NET lets you moderate

reviews. This capability is handled by the ContentReview server control’s Moderate property.

A site visitor can change his rating and review at any time, even if its status is pending or

rejected. When a visitor changes his rating or review, the information is updated immediately

in the Workarea, and the review’s status changes to pending.

There are two ways to moderate reviews.

n from the Workarea > Smart Desktop > Content Reviews area

n from the Content Rating screen associated with a content item

Viewing All Pending Reviews
You can view all pending reviews by clicking the View All link in the Smart Desktop >

Content Review screen.

From that screen you can:

n Approve or decline a review - select an Approve or Decline radio button for each item on

the list. Then, click the Submit button( ).
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n Mark all reviews approved or all declined - click the Mark all approved link to set all

the radio buttons to Approve. Click the Mark all declined link to set all the radio buttons

to Decline.

n Edit the rating, review or status of an individual review - click a review’s title and the

Edit screen appears. Change as needed. Click the Save button ( ).

Note: After editing a rating, click theBack Arrow to return to the content item’sContent Rating screen.

n Print a report of all pending content reviews - click the Print button ( ) to create an
HTML version of the pending content review report that is ready for printing.

n Email a pending content review report - click the Email button ( ) to email a pending
content review report to Ektron CMS400.NET users. Next, select the users to receive the

report. Then, click the Email button ( ) to send the report.

n Filter content reviews by folder - because reviews are associated with content items in a

folder, you can filter reviews by folder. This makes it easier to moderate reviews if you are

responsible for content in a specific folder. Click the Folder button ( ) and navigate to

the folder by which the reviews will be filtered. Then, click the Save button ( ).
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n Filter reviews by language - from the Language dropdown box, select the language by

which the reviews are filtered.

After you approve or decline reviews, click the Submit button ( ). Once reviews are
approved, they appear on the site.

Moderating Reviews From the Smart Desktop
To moderate reviews from the Smart Desktop, follow these steps.

1. From the Smart Desktop, choose the Content Reviews area.

2. The latest reviews awaiting moderation appear.

3. Select an Approve or Decline button for each item in the list.
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4. Click the Approve Selected Reviews button.

5. Once the reviews are approved, they appear on the site.

Note: AContentReview server control set to display reviewsmust be on the page for reviews to be displayed. See

"DisplayXslt" on page 7-739.

Moderating Reviews From the Content Review Screen
To moderate content reviews from Content Review screen, follow these steps:

1. Navigate to the Content Ratings screen for the content item using one of the methods in

"Viewing the Content Reviews Report" on page 7-730.

2. Click the Get Reviews button.

3. A list of reviews appear for the content.

4. Click the Title link of the content to be moderated.

5. The View Content Review screen appears.
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- To change information on this screen, click the Edit button ( ). From the Edit screen,
you can change the rating, review, and status. When finished, click the Save button (

).

- To delete the review, click the Delete button ( ).

Purging Rating and Review Data
You can remove content rating data to free up space in your database. First select the

individual content and view the Ratings Report. Next select the date range of the data you

want to purge using Start Date and End Date. Then click the Purge Reviews button. Click

OK to the confirmation message and the rating and review data will be purged.

ContentReview Server Control
The ContentReview server control allows site visitors to rate and review content on your site.

Place this control on a template page that’s used to display content items or eCommerce

products. For example, you might place this control on a Master page and set it’s

DynamicParameter property to ID. Then, when a Web form containing a content item or product

passes its ID to the QueryString, the control can be used by a site visitor to record their rating

and review.

The ContentReview server control can be used in two ways.

n It places a star-based rating scale on any page of your Web site. Site visitors use the scale

to rate a content item. Depending on the XSLT, they can also submit review comments.

n It displays visitor reviews and comments. In this mode, the control can display reviews of a

content item or reviews by a specific site or membership user. See Also: "Displaying

Content Reviews On the Site" on page 7-737 and "Displaying a User’s Reviews On the

Site" on page 7-737.

Ektron CMS400.NET maintains and reports content reviews and ratings data. For more

information, see "Content Review" on page 7-729.

The following topics appear in this chapter:

n "Displaying Content Reviews On the Site" on page 7-737

n "Displaying a User’s Reviews On the Site" on page 7-737

n "Retrieving the XML Structure of a ContentReview" on page 7-738

n "ContentReview Server Control Properties" on page 7-739
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Displaying Content Reviews On the Site
To display content reviews on the site, follow these steps:

1. Drag and drop a ContentReview server control on a Web form.

2. Set the DefaultContentID property to the ID of the content for which reviews will be

displayed.

Note: You canmake the reviews for the content item dynamicby leaving DefaultContentIDblankand setting

DynamicParameter to ID.

3. Set the DisplayXSLT property to Review List.

Note: If you want to change the lookand feel of the review list, modify an existing XSL file or create your own. If

youmodify an existing XSL, Ektron recommendssaving themodified file with a different name. Then, enter the

path to the file in the DisplayXSLTproperty.

4. Set the GetReviews property to Content.

5. Save the Web form.

Below is example of content reviews displayed on a Web page.

Displaying a User’s Reviews On the Site
To display reviews for a specific user on the site, follow these steps:

1. Drag and drop a ContentReview server control on a Web form.

2. Set the DisplayXSLT property to Review List.
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Note: If you want to change the lookand feel of the review list, modify an existing XSL file or create your own. If you

modify an existing XSL, Ektron recommendssaving themodified file with a different name. Then, enter the path to

the file in the DisplayXSLTproperty.

3. Set the GetReviews property to User.

4. Set the UserID property to the ID of the user for which reviews will be displayed.

Note: You canmake the list of reviews for a user dynamicby leaving the UserIDblankand setting the

DynamicParameter to ID.

5. Save the Web form.

Below is example of a user’s reviews displayed on a Web page.

Retrieving the XML Structure of a ContentReview
Retrieving the XML structure of XML content allows for greater control over developing

XSLs. The following is an example of how to retrieve the XML structure:

1. Open a new Web form.

2. Drag and drop a ContentReview server control onto it.

3. Set the DefaultContentID property.

4. Drag and drop a Textbox on the Web form.

5. Set its TextMode property to MultiLine.

Note: It is also recommended that you set the width of the text box to at least 400px.

6. On the code behind page, add the following line.
Textbox1.Text = ContentReview.XmlDoc.InnerXml

7. Build the project.

8. View the Web form in a browser.
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The XML structure of the collection appears in the textbox.

For an additional example, see the ContentReview XML page on the CMS400Developer

samples page. It is located at:

In a browser:

http://<site root>/CMS400Developer/Developer/ContentList/ContentListXML.aspx

In the source code:

<site root>/CMS400Developer/Developer/ContentList/ContentListXML.aspx and

ContentListXML.aspx.vb

ContentReview Server Control Properties
The following table explains the properties of the ContentReview server control.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to

browse to Content, Collections, etc. See Also: "Using CMS

Explorer to Browse Your Ektron CMS400.NET Site" on page 21-

9

Boolean

DefaultContentID

The ID of a content blockbeing rated by this server control.

If you don’t know the ID number of the content block, use the CMS

Explorer to browse to it. See Also: "Using CMSExplorer to

Browse Your Ektron CMS400.NET Site" on page 21-9

Long

DisplayXslt

Select the type of review to display, or enter the path to a custom

XSLT. For additional information, see "Using the DisplayXSLT

Property" on page 7-741

Choicesare:

Ajax 5 Stars - a five star rating system utilizing Ajax for display.

Ajax 5 Stars Comment - a five star rating system utilizing Ajax

for display. In addition, when you hover over the stars, a review

boxpops-up below the stars. Comments that are added are

submitted via an Ajax call.

Ajax 5 Stars with Increments - a five star rating systemwith

half star increments that utilizesAjax for display.

5 Stars - a five star rating system that allows visitors to add text

reviewsof content.

5 Stars with Increments - a five star rating systemwith half star

increments that allows visitors to add text reviewsof content.

String
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Property Value Data Type

Review List - displaysa list of reviews for content or a user. See

Also: "Displaying Content ReviewsOn the Site" on page 7-737

and "Displaying a User’sReviewsOn the Site" on page 7-737.

Path to Custom Xslt - enter the path to a customXSLT.

Warning! If you specify an external file or modify an existing file,

it is strongly recommended that you do not store this file in your

site'sWorkarea folder. If you store this file in theWorkarea

folder, the file will be lost when you upgrade.

DynamicParameter

Tomake this content review control dynamic, select id. When you

do, this server control is attached to the content blockpassed asa

URL parameter.

String

DynamicUserParameter
When using this control to retrieve a user’s reviews, set this

property toUserId to make the user’s ID dynamic.
String

GetReviews

Returnsa list of reviews for content or a user.

None - do not return reviews.

Content - returns reviewsbased on the content ID provided in

the DefaultContentIDproperty.

User - returns reviewsbased on the User ID provided in the

UserIdproperty.

ReviewTypes

Hide
Select False to display this server control on the page. Select

True to suppress it.
Boolean

Language
Set a language for viewing content. This property shows results in

design-time (in VisualStudio) and at run-time (in a browser).
Integer

MaxReviews

The number of reviews to retrieve if the GetReviewproperty is

set to Content or User. 0 (zero) = unlimited results.

See Also: "GetReviews" on page 7-740

Integer
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Property Value Data Type

Moderate

Setting this property to True allowsCMS400.NET users to

moderate reviews. See Also: "Moderating Reviews" on page 7-

732

Boolean

RatingsMinimum

Sets aminimum number of reviewsand ratingsbefore displaying

the average rating.When set to 0 (zero), the average rating is

displayed as soon as content is rated the first time.

Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control.

The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

UserID

The user ID for which to get reviews. If left blank, reviews from all

users are returned. If a user ID is specified, only reviews for that

user are returned.

Warning! The GetReviewspropertymust be set to User for the

control to use this property. See Also: "GetReviews" on page 7-

740

Long

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of

an HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a

blockof code.

Custom - Lets you use custom tag.

String

Using the DisplayXSLT Property
The table below shows an example of each XSLT as it appears on a Web page, a description

and the XSL file being used. The files are located in
[Web Root]\[Site Root]\Workarea\Xslt

Warning! If you want to edit an existing file, it is strongly recommended that youmake a copy, change its name

andmove it outside of your site'sWorkarea folder. If youmake changes to this file and do not move it out of the

Workarea, this file and the changeswill be lost when you upgrade. The files below are copiesof files built, trans-

formed and used, internally.
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DisplayXSLT

Selection
Description

Ajax 5 Stars

A five-star rating system utilizing Ajax for display.

File used: rating5star.xsl

Ajax 5 Stars

Comment

A five-star rating system utilizing Ajax for display.When you hover over the

stars, a review boxpops-up. Visitor comments are submitted via an Ajax call.

File used: rating5starComment.xsl

Ajax 5 Stars with

Increments

A five-star rating systemwith half-star increments that usesAjax for display.

File used: rating5starinc.xsl

5 Stars

A five-star rating system that lets visitors add text reviewsof content.

File used: rating5starAddEdit.xsl

5 Stars with

Increments

A five-star rating systemwith half star increments that allows visitors to add text

reviewsof content.

File used: rating5starincAddEdit.xsl
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DisplayXSLT

Selection
Description

Review List

Displaysa list of reviews for content or a user.

File used: ratinglist.xsl

See Also: "Displaying Content ReviewsOn the Site" on page 7-737 and

"Displaying a User’sReviewsOn the Site" on page 7-737.

Content Rating
Ektron CMS400.NET lets you place a rating scale on any content on your Web site. The scale

lets you collect feedback by giving site visitors the opportunity to rate the content. A visitor

can rank the content on a numerical scale of one through nine, as well as submit a text

comment (see illustration below).

Note: The user’s browser must have cookiesenabled in order to submit a content rating.

The content rating feature is explained through the following topics.

n "Inserting the Content Rating Server Control" on page 7-744

Content Rating
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n "Limiting Visitors to One Rating" on page 7-744

n "Viewing the Content Rating Report" on page 7-745

Inserting the Content Rating Server Control

To have a content ratings graph appear on a Web page, your developer inserts a server control.

This procedure is described in the Ektron CMS400.NET Developer Manual section “Content

Rating Server Control.”

Limiting Visitors to One Rating

Ektron CMS400.NET assumes you want to limit a user to rating a content item once. If a

regular or membership user logs in before rating a piece of content, Ektron CMS400.NET

remembers the user ID. If any other site visitor does not log in before rating content, Ektron

CMS400.NET places a cookie on the site visitor’s computer.

So, whenever a page with a Content Rating server control is visited, Ektron CMS400.NET

checks for the user ID or cookie. If neither exists, it displays a rating scale as displayed in

"Content Rating" on page 7-743. If the page has already been rated by the user, the following

version of the control appears.

Note: Your developer can customizemanyaspects of the control. So, it maynot match the illustration.
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Viewing the Content Rating Report

All Content Rating data for a content item is maintained and can be displayed in detail and

summary format. To view this data, follow these steps.

1. Sign in to Ektron CMS400.NET.

2. Either

- browse to the content item

- right click the mouse

- click View Advanced Report

or

- Go to Workarea > Content.

- Navigate to the folder that contains the content.

- Navigate to the content item.

- Click the View Rating Reports toolbar button ( ).

The Content Rating Report shows a summary of all ratings submitted for the content.
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If desired, you can select a range of dates and limit the display of ratings data to those dates.

Select start and end dates (using calendar buttons at the top of the screen) and click Get Result.

Viewing Content Rating Details
Also, to view details of the ratings data, click Get Result (see illustration below).

Exporting Details to Excel
If Microsoft Excel is installed on your computer, you can export the ratings detail to Excel for

further manipulation of the data. To do so, the Click Export to Excel button.

Purging Rating Data
You can to remove content rating data to free up space in your database. To do so, select the

date range of the data you want to purge using Start Date and End Date. Then click the Purge

button.
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ContentRating Server Control

Warning! This server control is deprecated asof the 7.0.1 Release. For optimal performance, Ektron rec-

ommends the ContentReview server control. See "ContentReview Server Control" on page 7-736

Use the ContentRating server control to place a rating scale on any page of your Web site. The

scale lets site visitors rate a content item. A visitor can rank the content on a numerical scale

as well as submit a text comment.

The control lets a site visitor rate a content item only once. On subsequent visits to the page, a

message informs the visitor that he has previously rated the page, which can optionally display

a summary of ratings for it. As a result, the control has two appearance modes: initial and

complete.

Ektron CMS400.NET maintains and reports content ratings data. For more information, see

"Content Rating" on page 7-743.

Content Rating Server Control Properties
The Ektron-specific Content Rating server control properties are divided into two groups:

n Ektron - settings that affect properties, such as the display

n Ektron labels - settings that affect the text labels within the control

These properties are described below.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Ektron Properties

Property Value Data Type

Authenticated

Indicates if you are logged in to the CMS

Explorer and can use it to browse to

Content, Collections, etc. See Also: "Using

CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9

Boolean
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Property Value Data Type

CompleteGraph

Display

Specify a value to indicate how the ratings

graph appears if a site visitor hasalready

rated content.

n horizontal - graph appears to the

right of the AlreadyRatedMessage

n vertical - graph appears below the

AlreadyRatedMessage

n none - graph doesnot appear

Ektron.Cms.ContentAPI

.RatingGraphDisplayType

DefaultContentID

The ID of a content blockbeing rated by this

server control. It typicallywould be the

content directly above the rating scale if no

other content block is identified, or is not

available.

If you don’t know the ID number of the

content block, use the CMSExplorer to

browse to it. See Also: "Using CMS

Explorer to Browse Your Ektron

CMS400.NET Site" on page 21-9

Long

DynamicParameter

Tomake this content rating control

dynamic, select id. When you do, this

server control is attached to the content

blockpassed asa URL parameter.

String

GraphBarColor The color of the bars in the graph. System.Drawing.Color

Hide
Select False to display this server control

on the page. Select True to suppress it.
Boolean

InitialGraphDisplay

Specify a value to indicate how the ratings

graph appears if a site visitor hasnot yet

rated content.

n horizontal - graph appears to the

right of the content rating scale

n vertical - graph appears below the

content rating scale

n none - graph doesnot appear

Ektron.Cms.ContentAPI

.RatingGraphDisplayType
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Property Value Data Type

Language

Set a language for viewing content. This

property shows results in design-time (in

VisualStudio) and at run-time (in a

browser).

Integer

Padding

Enter the number of pixels used to create

space between the rating scale and the

graph.

Note: If you do not display the graph, this

setting hasno effect.

Integer

SuppressWrapperTags

Suppresses the output of the span/div tags

around the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server

control’s tag.

The default isSpan.

Span - The <span> tag is used to

designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want

to apply attributes to a blockof code.

Custom - Lets you use custom tag.

String

Ektron Label Properties
The label properties determine the text that appears in the server control. Most of them are

illustrated below.

Note that the first illustration describes the initial graph, while the second describes the

complete graph.

Initial Graph Display
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Complete Graph Display

Property Description Default Text

AlreadyRatedMessage
Appears in place of the rating scale if the

user previously rated the page
You have already rated this content.

BadLabel The low end of the rating scale Poor

CharsRemainingLabel Number of additional characters a user may CharactersRemaining:
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Property Description Default Text

enter into the comment.

CookiesRequired

Message

Appears if browser cookies have been

disabled

We're sorry, but youmust enable

cookies in your browser to rate this

content.

FeedbackHeader Introduces rating scale
How would you rate the usefulness

of this content?

GoodLabel The high end of the rating scale Outstanding

RatingLevelLabel Appears above the graph Rating Level:

ThankYouMessage

Appears after site visitor selects a number,

optionally enters a comment, and presses

Submit.

Thank you for your feedback.

TotalRatingsLabel
Appears below the graph, and lists the

number of rating submissions received.
TotalRatings

UserCommentsHeader
Introduces free-text comment area below

rating scale

Tell uswhy you rated the content

thisway

ValidationMessage

Appears on initial display if user clicks

Submit button before selecting rating

number

Please select a rating before

submitting your feedback.
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Analytics

By analyzing the user traffic coming to and interacting with your site, you can better

understand key elements of your Web presence. Traditional Web analytics packages help you

understand where your traffic is coming from, when the traffic is occurring (including high and

low points) and what pages users are interacting with. But this information is often isolated

from the Web content and is, therefore, lacking the context needed to take advantage of it.

Ektron CMS400.NET has a fully-developed, Web traffic analytics provider model. By hooking

into best-of-breed analytics software, like Google Analytics, your Web site’s information is

integrated into CMS400.NET’s Workarea and so is at your fingertips as you use it to optimize

the site experience.

Analytics can help you

n determine the popularity of areas of your site

n examine click-through rates on your calls to action

n analyze site structure and navigation

n obtain key information about your site visitors

This information is essential to optimizing your site’s content. Its seamless integration into

CMS400.NET lets you fully leverage the data.

Using Analytics Data within Ektron
CMS400.NET
Ektron CMS400.NET’s Workarea provides customized reporting, reflecting exactly the

information you care about. The data can be broken down in many ways, such as

n number of visits per day

n browser usage

n visitor location

n visitor language

n top content

n referring sites

Analytics data is available for your entire site as well as individual pages. A sample Analytics

display is below.
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The Analytics widget can be placed on your dashboard, so that you have instant access. Also,

the software is integrated into the content history. This makes your traffic analytics more

relevant: you can see what modifications were made, when, and how they impacted traffic to

that page. You can react immediately, restoring content that performed better or changing the

current content to better reflect your goals.

This full integration makes your analysis more efficient; there is no reconfiguration of the

analytics tool and no learning curve. Customer reporting, segmentation, and legacy data are

easier to access, and Ektron CMS400.NET becomes the central hub for all of your Web site’s

information, bringing it together so that it is no longer siloed. Having all information in one

place puts it in context, making it easier to draw the conclusions you need to optimize your

Web presence.

This section explains the Analytics feature through the following topics.

n "The Flow of Analytics Data" on page 7-754

n "Google Analytics Provider" on page 7-754

n "Setting up Google Analytics" on page 7-755

n "Authorization to View Analytics Data" on page 7-758

n "Viewing Analytics Data" on page 7-758

- "Page Level Analytics Data" on page 7-758

- "Site Level Analytics Data" on page 7-764

Using Analytics Data within Ektron CMS400.NET
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The Flow of Analytics Data

As shown above, once you set up Analytics tracking, the Analytics Provider monitors every

site visit. In the Workarea, you can view this data from many angles.

Warning! No data is stored in Ektron CMS400.NET -- the CMS retrieves it upon demand from your Analytics pro-

vider.

Google Analytics Provider
Google Analytics is an enterprise-class, Web Analytics solution that gives you rich insights

into your Web site traffic and marketing effectiveness. Powerful, flexible and easy-to-use

features let you see and analyze your traffic data in an entirely new way. With Google

Analytics, you're more prepared to write better-targeted ads, strengthen your marketing

initiatives, and create higher converting Web sites.

Its main features are:

n Advertising ROI - Measure the success of your display, search, new media and offline

advertising efforts.
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n Cross Channel and Multimedia Tracking - Compare your site usage metrics with

industry averages and track Flash, video, and social networking sites and applications.

n Visualizing Data - Uncover trends, patterns, and key comparisons with funnel

visualization, motion charts, mapping, and more.

n Customized Reporting - Create the reports, dashboards, and segments that make the most

sense for your business.

n Sharing and Communicating - Administration controls and email reports allow you to

share data across your organization.

n Google Integration and Reliability - Google Analytics complements a suite of related

products, all running on the same world renowned infrastructure that powers Google.

For a product tour, see http://www.google.com/analytics/tour.html.

Setting up Google Analytics
Warning! No server control is needed to trackAnalytics. After you enable Analytics in the web.config file, the fol-

lowing JavaScript is automatically added to each PageBuilder page and any site page that contains an Ektron

CMS400.NET server control.

<!-- Start Google Code -->
<script type="text/javascript">
var gaJsHost = (("https:" == document.location.protocol) ? "https://ssl." :

"http://www.");
document.write(unescape("%3Cscript src='" + gaJsHost + "google-analytics.com/ga.js'

type='text/javascript'%3E%3C/script%3E"));
</script>
<script type="text/javascript">
try {
var pageTracker = _gat._getTracker("[USER ACCOUNT STRING]");
pageTracker._trackPageview();
} catch(err) {}</script>
<!-- End Google Code -->

Note: Your User account string is provided byGoogle Analytics.

Setup Procedure for Google Analytics

Tracking Your Entire Web Site
The following steps explain how to set up the default Analytics provider, Google Analytics, to

track your entire site.

See Also:

n "Setting up Analytics for Multiple Sites or Providers" on page 7-758
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n "Tracking a Single Page" on page 7-757

To do so, follow these steps.

Warning! Enabling the tracking codemaycause a significant increase in CPU usage.

1. Create a Gmail account (http://mail.google.com).

2. Sign up for Google Analytics (www.google.com/analytics/).

When you set up a Google Analytics profile for your site, you are assigned a profile ID

and a User Account. You will need those to complete Step 7.

3. On the server that hosts Ektron CMS400.NET, go to C:\Program

Files\Ektron\CMS400v80\Utilities\EncryptEmailPassword.exe.

4. Use that utility to encrypt the Gmail username and password that you obtained in Step 1.

5. Open your site’s siteroot/web.config file.

6. Find the AnalyticsDataProvider tag, shown below.
<AnalyticsDataProvider defaultProvider="Google">
<providers>
<add name="Google" type="Ektron.Cms.Analytics.Providers.GoogleAnalyticsProvider,

Ektron.Cms.BusinessObjects" Username="" Password="" ProfileId="" SiteURL=""

UserAccount=""

GoogleAnalyticsTrackingCodePath="Analytics\template\googletrackingcode.ascx" />
</providers>
</AnalyticsDataProvider>

Note: If your web.config has several analyticsprovidersand you want to turn off analytic tracking for one of them,

delete the value of the GoogleAnalyticsTrackingCodePath property.

7. Use the following table to complete the tag’s properties.

Element Enter

name

The free text name of the site being tracked.

Ektron suggests the site name followed by the provider name. For example,

www.ektron.com-Google.

Site-level displaysof Analytics data within the Ektron CMS400.NET Workarea

let you choose a site from a dropdown, as shown below.

Username TheGmail username you encrypted in Step 4.
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Element Enter

Password TheGmail password you encrypted in Step 4.

ProfileID

TheGoogle AnalyticsProfile ID you obtained in Step 2.

Note: Tip! If you go to your Google Analyticsdashboard at google.com, in the

addressbar, the &id=value in the URL is your ProfileIdassigned byGoogle.

SiteURL

Your site root names. For example, you could set up one <providers> tag for

the dev.ektron.com site, and another for the synergy.ektron.com site.

Do not include a protocol, such ashttp://.

UserAccount

TheGoogle AnalyticsSiteURL you obtained in Step 2.

Note: Tip! When you visit your Google AnalyticsSettingspage at google.com,

the UA-xxxxxx-x string next to your site domain is the UserAccount assigned

byGoogle.

8. Save web.config.

Tracking a Single Page
As an alternative to tracking your entire site, you can track any number of individual .aspx

pages. To do that, follow these steps on every page you wish to track.

Prerequisite: You completed all steps in "Tracking Your Entire Web Site" on page 7-755

1. Open your site’s siteroot/web.config file.

2. Find the ek_AutoInsertBeaconScript tag.

3. Change its value to false.

4. Save web.config.

Note: The above stepsdisable the tracking code on your Web site.

5. Open Visual Studio.

6. Open the .aspx page to which you want to apply the tracking code.

7. In the Solution Explorer tree, navigate to

Workarea/Analytics/template/googletrackingcode.ascx.

8. Drag and drop that user control onto the page.

9. Assign EktronAnalyticsTrackingCode as the ID of the control.
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Setting up Analytics for Multiple Sites or Providers
You can use more than one provider (such as Omniture), and you can track multiple sites. To

track multiple providers or sites, copy the contents of the <providers> tag, paste it below the

existing tag and above </AnalyticsDataProvider>, and modify the elements listed in Step 7

above.

Authorization to View Analytics Data

License Requirements
Ektron CMS400.NET Professional or Enterprise License

User Permissions
Only the following users can view Analytics data.

n Members of the Administrators Group

n Users assigned to the Analytics Viewer role. See Also: "Defining Roles" on page 15-32

Viewing Analytics Data
The Analytics feature provides two basic types of data:

n Page data - "Page Level Analytics Data" on page 7-758

n Site data - "Site Level Analytics Data" on page 7-764

Page Level Analytics Data
After you enable Analytics tracking, your provider retains data on every visited page (that is, a

unique URL) such as http://dev.ektron.com/articles.aspx or

http://dev.ektron.com/template.aspx?id=6572). Data is tracked when the quicklink is used, as

well as any alias assigned to the content. See Also: "URL Aliasing" on page 10-1

You can view any page’s Analytics data from the following locations.

n "Viewing Page-Level Analytics from the Site" on page 7-759

n "Viewing Page-Level Analytics from a PageBuilder Page" on page 7-760
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n "Viewing Page-Level Analytics from the Workarea" on page 7-761

Viewing Page-Level Analytics from the Site
Any authorized user can view Analytics for a page on your Web site by following these steps.

1. Log in to the Web site.

2. Navigate to the page whose Analytics data you wish to view.

3. Hover the cursor over the Web Site Content menu. See Also: "The Web Site Content

Menu" on page 7-4

4. Click View Page Activity, as shown below.

The SEO page’s Traffic tab appears.
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The SEOPage’s Traffic Tab

The Traffic tab of the SEO control graphs the Analytics data of any two search criteria. Below

the graph is data for the five visit criteria tracked by the Analytics provider.

Visit Data

n Pageviews - number of pageviews for this page over the selected date range

n Unique pageviews - number of unique visitors to this page over the selected date range

n Average time on page - how long a visitor spent on the page. It is calculated by

subtracting the initial view time for this page from the initial view time of the subsequent

page. So, this metric does not apply to exit pages.

n Bounce rate - the percentage of single-page visits (that is, visits in which the visitor exited

your site from the entrance page)

n % Exit - the percentage of site exits that occurred from this page

Note that you can change the date range, as well as either search criterion (Pageviews and

Time on Page in the example above).

You can also replace the URL with a different one, and view the page being analyzed (by

clicking Visit this page in the green bar).

Viewing Page-Level Analytics from a PageBuilder Page
Any authorized user can view Analytics for a PageBuilder page by following these steps.

Note: You cannot drag and drop the Analyticswidget onto a PageBuilder page.
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1. Use the right arrow button (circled below) to open the PageBuilder menu. See Also:

"Building PageBuilder Pages" on page 6-1

2. From the menu, select View > Analytics.

3. The SEO page’s Traffic tab appears.

See Also: "The SEO Page’s Traffic Tab" on page 7-760See Also:

Viewing Page-Level Analytics from the Workarea
The Ektron CMS400.NET Workarea provides two page-level views of Analytics data.

n The View Content History screen - compares Analytics data for any two published

versions

n The Analytics toolbar button - displays the SEO page’s Traffic tab. See "The SEO Page’s

Traffic Tab" on page 7-760.

To view a content item’s Analytics data from the Ektron CMS400.NET Workarea, follow these

steps.

1. Navigate to the folder containing the content whose Analytics data you want to view.

2. Click the content item.
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3. To compare Analytics data any two published versions, click the History button ( ). See
Also: "Comparing Two Published Versions of Content" on page 7-762

To view Analytics for the currently published version, click the Analytics button ( ).
When you do, you see the Traffic tab of the SEO page. See Also: "The SEO Page’s Traffic

Tab" on page 7-760

Comparing Two Published Versions of Content

On the View Content History screen, blue and orange radio buttons appear next to each

published version of content, as shown below.

To compare Analytics data, click the appropriately-colored radio button next to each version,

then click the Compare button ( ). The Compare screen for the two versions appears, as
shown below.
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You can change the date range for each content version. You can also

n Use the Display pull-down to graph any visit data. See "Visit Data" on page 7-760

n Click the URL Filtering tab to select the URLs being displayed. See Also: "URL

Filtering" on page 7-763

URL Filtering
Any content item can be viewed via several URLs, such as

n its quicklink. See Also: "A quicklink is a special kind of hyperlink that jumps to another

content item on your Web site. (A regular hyperlink jumps to a Web page on the

internet.)" on page 8-3

n manual alias

n automatic alias See Also: "URL Aliasing" on page 10-1

Note: While Regex-based aliasesaffect Analyticsdata, theydo not appear on the URL Filtering tab.

The URL Filtering tab of the Compare Analytics screen lets you break down the data by each

of these identifiers. So, for example, you can drill down to view only the data collected when

site visitors accessed a page by typing its manual alias into the browser.
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Site Level Analytics Data
You can view Analytics data for any site via the Analytics Report Widget and several reports.

See Also: "Standard Widgets" on page 21-404

Analytics Report Widget
You can drag and drop the Analytics Report Widget onto the Smart Desktop.

When you do, you initially see the Direct Traffic report for the past seven days. (See Also:

"Direct Traffic" on page 7-770)

You can click the Edit button ( ) to change the display using any of the options shown

below.
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To learn about the report data options, see "Site Report Descriptions" on page 7-765.

Note that there are three time interval choices:

n last 7 days (the default)

n last 30 days

n last 90 days

Site Report Descriptions
You can access site-level Analytics reports from within the Ektron CMS400.NET Workarea by

selecting Reports > Site Analytics.

The site level reports are described below.
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Note: The following text wasadapted fromGoogle AnalyticsHelp Center

(http://www.google.com/support/analytics/). Check that site for additional details on the reports.

Report Description

Overview

Direct traffic on left side, top content on the right. See Also:

"Direct Traffic" on page 7-770, "Top Content" on page 7-

771; "Analytics" on page 7-752

Searches

Search termsused by site visitors to find content on your site.

Note that this data is not retrieved fromGoogle Analytics.

Instead, it is retrieved from Ektron CMS400.NET’s site

search.

Visitors

The number of new and returning visitorswho came to your site and how extensively they

interacted with your content. This traffic overview allows you to view aspects of visit quality (i.e.

average pageviews, time on site, bounce rate) and visit characteristics (i.e. first time visitors,

returning visits).

Locations Countries of your site visitors.

New vs. Returning

The number of visitors to your site who are new or returning.

A high number of new visitors suggests that you are

successful at driving traffic to your site, while a high number of

return visitors suggests that the site content is engaging

enough to keep visitors coming back. You can see how

frequently visitors return and howmany times they return in

‘Recency’ report and the ‘Loyalty report’, both under ‘New vs.

Returning’ in the Visitors section.

Languages

Uses the language asprovided by the HTTPRequest for the

browser to determine site visitors’ language. Valuesare

given in 2- or 4-character language code (for example, en-br

for British English).

This report captures the preferred language that visitors
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Report Description

have configured on their computers. Understanding who

your visitors are is crucial to developing the right content and

optimizing your marketing spend. Many times, geo-location is

not enough. Many countries have diverse populations

speaking different languageswhich present important

market targeting opportunities.

User defined

If youmodified the tracking code to provide a user-defined

segment, this field identifies that segment by the string you

provide when setting up a user-defined segment.

Visitor Trending

Visits

The number of visits your site receives is themost basic

measure of how effectively you promote your site. Starting

and stopping ads, changing your keyword buys, viral

marketing events, and search rankare some examplesof

factors that influence the number of visits your site receives.

Absolute Unique Visitors

The number of unduplicated (counted only once) visitors to

your Web site over the specified time period. AUnique Visitor

is determined using cookies.

Pageviews

The total number of pages viewed on your site. It is a general

measure of howmuch your site is used.

It ismore useful as a basic indicator of the traffic load on your

site and server than asamarketingmeasure.
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Report Description

Average Pageviews

Average pageviews is one wayof measuring visit quality. A

high Average Pageviewsnumber suggests that visitors

interact extensivelywith your site. A high Average Pageviews

results from one or both of:

n Appropriately targeted traffic (that is, visitorswho are

interested in what your site offers)

n High quality content presented effectively

Conversely, a low average pageviews indicates that the

traffic coming to the site hasnot been appropriately targeted

to what the site offers or that the site doesnot deliver what

waspromised to the visitor.

Time on Site

One wayof measuring visit quality. If visitors spend a long

time visiting your site, theymaybe interacting with it

extensively. However, Time on site can bemisleading

because visitors often leave browser windowsopen when

theyare not actually viewing or using your site.

Bounce Rate

The percentage of single-page visits (that is, visits in which

the person left your site from the entrance page).

Bounce rate is ameasure of visit quality, and a high bounce

rate generally indicates that site entrance (landing) pages

aren't relevant to your visitors. You canminimize Bounce

Ratesby tailoring landing pages to each keyword and ad that

you run. Landing pages should provide the information and

services that were promised in the ad copy.

Browser Capabilities

Optimizing your site for the appropriate technical capabilities helpsmake your site

more engaging and usable and can result in higher conversion ratesandmore sales.

Browsers The browsers that your visitors use.

Operating Systems The operating systems that your visitors use.
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Report Description

Browsers andOS
The browser/operating system combinations that your

visitors use.

Screen Colors The number of screen colors your visitors use.

Screen Resolutions The screen resolutions that your visitors use.

Flash Versions The versionsof Flash that your visitors have installed.

Java Support Whether Java is supported on your visitors' platforms.

Network Properties

Network Location

The internet service providers that your visitors use. This

report allows you to track the internet service provider (ISP)

domains to which the user resolves.

The domain is determined by the internet service that owns

the user's internet _protocol (IP) identifier.

Hostnames

Hosts fromwhich people are visiting your site. Hostnames

sometimesprovide insight into organizations that are

interested in what you offer.

Connection Speeds

Connection speeds that your visitors are using. Optimizing

your site so that it loadsquickly for most visitors can result in

higher conversion ratesandmore sales.

Traffic Sources

This section providesan overview of the different kindsof sources that send traffic to your site. The

graph shows traffic trends; the pie-chart and tables show what is driving the trends.
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Report Description

Direct Traffic

Visits from people who clicked a bookmark to come to your

site or who typed your site URL directly into their browser.

Direct traffic can include visitors recruited via offline (i.e. print,

television) campaigns.

Referring Sites Externals sites fromwhich visitors linked to your site.

Search Engines
Visitorswho clicked to your site from a search engine result

page.

All TrafficSources

Visitors referred from search engines, sites, and tagged links.

The graph shows the overall trendswhile the table shows the

specific sources (i.e. search engines, sites, and tagged links)

driving the trends.

Keywords
Compares traffic from search keywords to overall traffic to

your site.

Campaigns

How people referred from your configured campaigns

compare to the “average” visitor to your site.

The graph showsoverall trends, while the table lists each

configured campaign. Since all traffic in this report results

from campaigns that you explicitly control, you can use this

information to add or delete campaigns, or to determine the

effectivenessof tests that you have set up using custom tags.

Ad Versions

Compares your AdWordsads (and configured campaigns in

which you use the “content” tag) against each other.

This report showsyou which ad copy (in AdWordsadsor in

configured campaigns) ismost effective. Adswith high

clickthrough rates show that the copy is effective at getting

the user to click, while high bounce rates, for example,

indicate a need for landing pages that are consistent with

what the ad promises.
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Report Description

Content

Providesan overview of pageview volume and lists the pages (Top Content) that weremost

responsible for driving pageviews. You can also reach some useful reports that reveal how users

interact with your site and statistics related to how they found your site in the first place.

Note: Content reports include a link icon ( ) and a hyperlink. If you click the link icon, you
go to the page. If you click the hyperlink, you see amore detailed Analytics report about that page.

Top Content

Themost commonly viewed pageson your site, and how

theyare used.

The table lists all pageswhich were viewed on your site. A

high bounce rate indicatesa landing page that should be

redesigned or tailored to the specific ad which links to it. A

high 'Time on Page' may indicate content that is particularly

interesting to visitors. The significance of exits varies

according to each page. For example, it maybe common for

visitors to exit your site from a receipt or “thank you” page

because theyhave completed a conversion activity. In

contrast, a high number of exits from a non-goal page (from

a funnel page, for example) may indicate that the page is

confusing or that it generatesuser errors.

Content byTitle

Themost commonly viewed groupsof pageson your site

(grouped by title), and how theyare used. This report

provides the same information in the “Top Content” report,

but aggregated by title tag value.

Top Landing Pages

Data on how effectively your landing pagesentice visitors to

click further into your site. You can lower bounce ratesby

tailoring landing pages to their associated adsand referral

links and placing a clear call-to-action on each landing page.

Top Exit Pages

Pages fromwhich people exit your site.

The significance of an exit rate varies according to each

page. For example, it maybe common for visitors to exit your

site from a receipt or “thank you” page because theyhave

completed a conversion activity. In contrast, a large number

of exits from a non-goal page (from a funnel page, for

example) may indicate that the page is confusing or that it

generatesuser errors
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The library folder stores images, files, quicklinks, and hyperlinks that can be inserted into

editor content. Before you can insert them into content, you must copy them from your

computer to a larger, file server computer that everyone editing your site can access.

This chapter explains how to copy such files and insert them into Web content through the

following topics.

n "Terms Used in this Chapter" on page 8-2

n "Accessing The Library" on page 8-3

n "Library Folder Properties" on page 8-6

n "Searching the Library" on page 8-8

n "Files" on page 8-11

n "Hyperlinks" on page 8-20

n "Images" on page 8-21

n "Quicklinks and Forms" on page 8-22

n "Library Folders and Permissions" on page 8-4

n "Library Load Balancing" on page 8-24

Terms Used in this Chapter
n An image is any graphic file, which can include illustrations and photos. Common image

file extensions are .gif., .jpg, .tiff, etc.

n A file is type of computer file that can be launched from a browser, such as Internet

Explorer. Examples include a Microsoft Word document and a .PDF file.

n A hyperlink is a commonly used or hard to remember Web address (also known as a URL).

After you add hyperlinks to the library, users can easily apply them to editor content.

So for example, if the editor content is “Contact Ektron,” the user can select the text, click the

library button, select hyperlinks to find the Ektron hyperlink, and apply that hyperlink to the

text.
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Once the page is published, a person reading it can click the text to “jump” to the Web

address www.ektron.com.

n A quicklink is a special kind of hyperlink that jumps to another content item on your Web

site. (A regular hyperlink jumps to a Web page on the internet.)

n A form is a quicklink to HTML form content. Whenever content is created, a form link is

automatically created for it.

Accessing The Library
1. Click the Workarea button ( ) or icon ( ).

2. Click the Library tab menu on top of the Workarea.

3. The Library folder appears.

4. The sub-folders appear in the left frame. Files in the root folder (library) appear in the right

frame.

You can use the dropdown list (circled above) to change the type of library files that appear.
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To work with any library file, click it. When you do, the View Library screen appears,

providing additional information about the item. From here, you can

n edit its title, file name, or description

n overwrite it

n find content linked to it

n delete it

For more information, see .

The following table explains the toolbar buttons on the library screen.

Note: Your system administrator determineswhich library folders you can access, and which functions you can

perform on library itemswithin the folders.

Button Description For more information, see

Search library
"Searching the Library" on

page 8-8

View the library’s properties screen
"LibraryFolder Properties" on

page 8-6

Add an image, file, quicklink, or

hyperlink to the library

"Copying Files to the Library"

on page 8-12

Select the type of Library file to work

with

Library Folders and Permissions
Whenever a new content folder is created and permissions given to it, a corresponding library

folder is created. The new folder inherits permissions from the content folder.

Items added to library folders are only accessible by users with permission to the corresponding

content folder. If items are added to a library folders directly under the main library folder, all

users with at least library Read-Only permissions can use those library items in their content.
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Conversely, if a library item is uploaded to a folder to which only one person has permissions,

that is the only user who can use that library asset.

Performing Actions on Library Items
The library is made up of images, files, form Quicklinks, hyperlinks, and regular Quicklinks

that were added by Ektron CMS400.NET users. The following table displays the actions that

can be performed for each library item type.

Action Files Images Hyperlinks Quicklinks
Form

Quicklinks

Add

Edit

View

Overwrite

Delete

Remove from

server

Check links

Update URL

Most actions can be performed by a user who is granted permission to do so.

Library Folder Properties
The library folder properties contains library-related information, including load balance

settings, image and file types that are allowed to be uploaded, as well as other settings.

The following buttons indicate actions you can perform on a library folder.
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Button Description For more information, see

Folder properties "Accessing the LibraryPropertiesScreen" on page 8-6

Search "Searching the Library" on page 8-8

Back to previous screen

Accessing the Library Properties Screen

Administrators have permission to change library properties. To view the properties of the

library folder, follow these steps.

1. Access a library folder, as explained in "Accessing The Library" on page 8-3.

2. Click the Properties button ( ).

3. The Library Management window appears, displaying the following settings.

Library Folder
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The Library Management Settings

Field Description

Image

Extensions

The typesof image files that a content contributor can upload to the library. You

can add asmany image file extensionsas you want, or have none. If no extensions

appear, no one can upload image files to the specified folder.

Image

Upload

Directory

Specifieswhere the uploaded imagesare saved on theWeb server. Bydefault,

the image upload directory isWeb root/ek_sitepath/

uploadedimages. The ek_sitepath value is set in theWeb.config file.

See Also: ”Managing the web.config File” on page 1-95

Make

Directory

Relative to

thisWeb

site

If you want to specify the image upload directory’s location as relative to your Web

site root, check this box. (Your Web site root’s location appears to the right of

Make Directory Relative to this Web site.)

File

Extensions

Specify the typesof non-image files that a content contributor can upload to the

library. You can add asmanynon-image file extensionsas you want, or have

none. If no extensionsappear, no one can upload non-image files to the specified

folder.

File

Upload

Directory

Specifieswhere the uploaded files are saved on theWeb server. Bydefault, the

file upload directory isWeb root/ek_sitepath/

uploadedfiles. The ek_sitepath value is set in theWeb.config file.

Note: Youmust create the directory in your Web root manually, before adding it in

CMS400.NET.

See Also: ”Managing the web.config File” on page 1-95”

Make

Directory

Relative to

thisWeb

site

If you want to specify the file upload directory’s location as relative to your Web site

root, check this box. (Your Web site root’s location appears to the right ofMake

Directory Relative to this Web site.)

Editing Library Properties

To edit library properties, follow these steps.

1. Go to the Library Properties screen, as explained in "Accessing the Library Properties

Screen" on page 8-6.

2. Click the Edit button ( ).
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Searching the Library
You can search the library to find items when you only know some information about them.

For example, you know that an image’s name includes Ektron but don’t know its filename or

folder.

To search the library, first select the folder in which you want to begin the search. The search

only considers files in that folder and its child folders. To search the entire library, begin by

selecting the Library (root) folder.

Next, click the Search button ( ) from the library toolbar. When you do, a search screen
appears with two tabs (shown below).

The left tab, Search Published, works the same as the regular search tab of that name. See "The

Search Published Tab" on page 9-87.

The right tab, Advanced Search, provides several fields that let you narrow your search.

Library Folder

8-8
ReferenceManual

Version 8.0 Rev 1.3



The fields are described below.

Field Description

Enter

Keyword(s)

Specify one or more keywords that the search will use. The search looks for

keywords in the file’s title. (The title is assigned by the user when the file is added

to the library.) If a file’s title matches the keywords, the file appears on the search

results screen.

The search also uses keywords to search through the file’s

n internal name (for example, airplane.gif) if the Filename Search check-

box is checked

n description if theDescription search checkbox is checked

A keyword can be a complete or partialword. But, you can only enter a partial

term for one word. For example, you can enter Adv and have the search return

the content titled “Adverse Drug Reactions.” But if you enter Adv Drug, the

search returnsnothing.

You can enter several complete search termsbut theymust be in the correct

sequence. For example, to find the topic titled “Adverse Drug Reactions,” you

can enter Adverse Reactions but cannot enter Reactions Adverse.

To find all files in a selected library folder, enter nothing in this field. Or, to find all

files in a selected library folder of a type (for example, images), select the type

and enter nothing in this field.

All Types The search considers all library asset types.
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Field Description

Imagesonly The search only considers images.

Quicklinks

Only
The search only considers quicklinks.

FormsOnly The search only considers forms.

FilesOnly The search only considers files.

Hyperlinks

Only
The search only considers hyperlinks.

Description

Search

If you check this box, the search considers the library item’s description when

returning search results. Otherwise, the search ignores the description.

For example, if you enter Ektron into the keyword field, the search returnsall

library files that include that string.

Filename

Search

If you check this box, the search considers the file namewhen returning search

results. Otherwise, the file name is not considered by the search.

For example, if you enter ppt into the keyword field, the search returnsall files

that include that string (such asall Powerpoint presentations).

Only search

items last

edited by

myself

The search only considers library assets that were last modified by you.

One or more of the search criteria set by your system administrator in theMetadata Definitions

screen.

Note: Some search field checkboxesare circleswhile othersare squares. If the box is a circle, you can only

choose one option. If it is a square, you can choose asmanyas you want.

The search displays library items that meet the search criteria on the search results screen. You

can click any item to view its properties (such as Library ID number, Last Edit Date and

Description).

Displaying Search Results

Search results appear in this order.

n images

n files

n hyperlinks

Library Folder
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n quicklinks

n form links

Result Display Options
At the top of the library search screen, a pull-down list lets you choose the how to display the

results.

View

option
Description

Mixed

If the item is an image, display the image in the left column. If not, display its title.

To the right, display the item’sDescription.

Note: Mixed search results require the Internet Explorer browser, version 6 or

greater.

Text

Display item’s title in the left column. To the right, display the file type and folder name.

Files
This section explains how to work with library files through the following subtopics:

n "Copying Files to the Library" on page 8-12

n "Viewing Files" on page 8-13

Files
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n "Editing a File" on page 8-15

n "Overwriting Files" on page 8-16

n "Library Link Searching" on page 8-18

n "Adding a Library File to Content" on page 8-18

For a definition of the term “files,” see "Terms Used in this Chapter" on page 8-2.

Copying Files to the Library
Files must be copied to the Ektron CMS400.NET library before users can insert them into

content. To copy a file to the library, follow these steps.

Warning! Ektron recommendsusing the Document Management system to add files. Unlike library files, DMS

files can be part of an approval chain, maintain a history, are searchable, and can have a summary, schedule, meta-

data, taxonomycategories, etc.

TECHNICALNOTE

Note: Microsoft lets usersupload files of anyname. However, IIS security blocks fileswhose name containsan

ampersand (&), colon (:), or percentage sign (%).Source: http://support.microsoft.com/kb/826437/en-us

To allow these characters, add the following registry key to your Web server then reset IIS.

Reg Key: DWORD HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\ASP.NET VerificationCompatibility =

1.

1. In the Workarea, browse the library folder and select a folder to which you want to copy a

file.

Note: When you copya file to a folder, only userswith permissions to that folder can insert the file into content.

2. A list of files in that folder appears.

3. Click the Add Library button ( ).

4. The Add File screen appears.

5. Enter the necessary information according to the following table.

Field Description

Title Enter a title for the file to be copied.

Filename
Enter the path to the file to be copied. You can use theBrowse

button to find it.

Library Folder
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Field Description

Description

You can enter a full text description to help other users identify

this file.

TheDescription appears on the View File screen.

It also accompanies the file on the Search Results screen if the

user selectsMixed when viewing results. See Also: "Displaying

Search Results" on page 8-10

After you enter the necessary information and click the Save button, the file is copied. Now,

users with permissions to the selected folder can insert the file into their content.

See Also: "Adding a Library File to Content" on page 8-18

Viewing Files
Once a file is copied to the library, you may preview it. To preview a copied file, follow these

steps.

1. Navigate to the library folder to which the file was copied.

2. Click the file you want to preview.

3. The View File screen appears.
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ReferenceManual

Version 8.0 Rev 1.3
8-13



The table below describes each field on the screen.

Field Description

Title Title assigned byuser who copied or edited it.

Filename Filename and location on the server.

Library ID ID number assigned byEktron CMS400.NET when file wasoriginally copied.

Parent Folder
File’s parent folder. Users need permissions to this folder to insert the file into

content.

Last User to

Edit
Last user who changed file.

Library Folder
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Field Description

Last Edit Date When file was last edited.

Date Created When file wasoriginally copied to library.

Description Optional, full-text description of file.

If the file can be displayed in your browser, a preview of it appears at the bottom of the screen.

If it cannot display in the browser, a link to preview it in its host application appears instead.

Note: Youmayneed to download some files before you can be view them (for example, .mdb, .mp3, .zip, etc.).

The following table describes the buttons on the View Library Item screen.

Button Description For more information, see

Edit the items title and description "Editing a File" on page 8-15

Overwrite the library item "Overwriting Files" on page 8-16

Find content linked to the library item "Library LinkSearching" on page 8-18

Delete library item "Deleting Library Items" on page 8-18

Return to previous screen

Editing a File
You can edit the title, filename and description of any file that was copied to the library. To

do so, follow these steps.

1. Access the View File screen, as described in "Viewing Files" on page 8-13.

2. Click the Edit button ( ).

3. The Edit File screen appears.
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4. Change the title, file name, and/or description of the file.

5. Click the Update button ( ).

Overwriting Files
If a library file becomes out of date or the wrong version was copied, you may replace it with a

new version. Overwriting files lets you minimize disk space and the number of library files.

Note: The ability to overwrite a library file is a privilege granted by the system administrator. If you do not see an

Overwrite button ( ) on the View Library Item in Folder screen, you do not have permission to overwrite.

Note: You can only overwrite imagesand files. The new image or file must have the same file extension as the file

being replaced.

Before You Overwrite an Image
When overwriting an image, the new image uses the same size dimensions and file extension

as the older image. Be sure that the two images have the same file extension and size or make

the adjustments at each occurrence of the image.

Before You Overwrite a File
Remember, all links that point to the overwritten file now point to the new file.

Overwriting Library Assets
To overwrite a library file, follow these steps.

Library Folder
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1. Navigate to the View File screen for the file you want to overwrite, as described in

"Viewing Files" on page 8-13.

2. Click the Overwrite button ( ).

3. The Overwrite File screen appears.

4. Click the Browse button.

5. A window lets you navigate to the new file.

6. Click the file, then click the Open button.

7. You return to the Overwrite File screen with the path to the new file in the Filename

field.

8. If desired, enter a Description for the new file.

9. To overwrite the current version of the file with this version, click the Update button ( ).

10. The following message appears.

11. To overwrite the file, click OK.
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Library Link Searching
Link searching indicates all content that includes a library link. It is useful when you want to

delete a library item. With the click of a button, you see all content that you need to update to

reflect the change you are making.

Performing a Library Item Link Search
To perform a library item link search, follow these steps.

1. Access the View Library Item for any type of library item, as described in "Viewing Files"

on page 8-13.

2. Click the Link Search button ( ).

3. A list of all content that references the library item is displayed.

You should edit that content before deleting the item.

Deleting Library Items
You can delete obsolete items from the library. By deleting an item, you prevent users from

adding it to their content. A deleted hyperlink, quicklink or form quicklink remains on your

Web server, so any existing links to them are not broken.

On the other hand, if an item is a file or image, the delete window displays an additional

prompt, Remove from the server, that lets you remove the item from the server. This feature is

available to help reduce disk space taken up by these files. Before removing an image or file

from your server, you should review all content with links to it and remove or update the link.

See Also: "Library Link Searching" on page 8-18

To delete an item from the library, follow these steps.

1. Access the View Library Item for any type of library item, as described in "Viewing Files"

on page 8-13.

2. Click the Delete button ( ).

3. The Delete Library Item screen is displayed.

4. If appropriate, check the box next to Remove from the server (see above).

5. Click the Delete button ( ).

Adding a Library File to Content
After a file is copied to the library, users can add it to content. (See "Adding a Library File to

Content" on page 8-19)
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You can also insert an item into the library while adding it to content. (See "Adding a File to

the Library and Inserting it into Content" on page 8-20)

If you insert an image file, it appears within the content. If you add any other type of file, the

file name appears as a hyperlink within the content. When a site visitor viewing that page

clicks the hyperlink, the inserted file is launched.

Adding a Library File to Content
1. Invoke the editor by adding or editing content in Ektron CMS400.NET.

2. Place the cursor within the content where you want the library file to appear.

3. Click the library button ( ).

4. The library opens.

5. Navigate to the folder that contains the file you want to insert.

6. From the file types dropdown list, select the kind of file you want to insert.

7. All library files of that type in the selected folder appear on the screen.

8. Click the file you want to insert.

9. Click the insert button ( ) to insert the file.

10. A hyperlink to the file appears in your content.

You can click the link to open the file.

The Insert QuickLink Dialog
If you select Files from the file types list, and Aliasing is enabled for your web site, the

following screen appears.
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For guidance on these choices, see http://dev.ektron.com/kb_article.aspx?id=26950.

Adding a File to the Library and Inserting it into Content
Use this procedure to insert an image into content that has not yet been copied to the library.

This procedure inserts the item into the library then into the content.

1. Invoke the editor by adding or editing content in Ektron CMS400.NET.

2. Place the cursor where you want the library item to appear.

3. Click the library button ( ).

4. The library opens.

5. Navigate to the folder that will contain the file after you insert it.

6. From the File types dropdown, select the type of file you want to insert. See Also: "Terms

Used in this Chapter" on page 8-2

7. Click the Add Library button ( ).

8. A new screen appears. Browse to the file you want to insert.

Or you can click the search button ( ) to search for a file to insert.

9. Enter a Title for the file.

10. If metadata is required for the library item, you must complete it. Metadata fields may

appear in the lower section of the screen.

11. Click the Add Library button ( ).

12. The file is inserted into the selected library folder and the content.

Hyperlinks
For a definition of the term hyperlinks, see "Terms Used in this Chapter" on page 8-2.
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8-20
ReferenceManual

Version 8.0 Rev 1.3

http://dev.ektron.com/kb_article.aspx?id=26950
http://dev.ektron.com/kb_article.aspx?id=26950


Adding Hyperlinks

You must copy hyperlinks to the library before content creators can insert them into content.

To copy a hyperlink to the library, follow the procedure described in "Copying Files to the

Library" on page 8-12. The only difference is that you insert a hyperlink instead of a file.

Viewing Hyperlinks

To view a hyperlink, follow the procedure described in "Viewing Files" on page 8-13. The

only difference is that you view a hyperlink instead of a file.

Editing Hyperlinks

To edit a hyperlink, follow the procedure described in "Editing a File" on page 8-15. The only

difference is that you edit a hyperlink title instead of a file title. You can also edit the URL.

Adding Hyperlinks to Your Content

Once a hyperlink is added to the library, users can add the hyperlink to their content.

To add a hyperlink to content, follow the procedure described in "Adding a Library File to

Content" on page 8-18. The only difference is that you add a hyperlink instead of a file.

Images
For a definition of the term images, see "Terms Used in this Chapter" on page 8-2.

Uploading Images

You must copy images to the library before content creators can insert them into content. To

copy an image to the library, follow the procedure described in . The only difference is that

you add an image instead of a file.

Note: When an image is uploaded to theMedia tab for a product in the eCommerce feature, the original image

and any thumbnails associated with it are added to the Library. For example, if you add an image named

“TestImage” (actual file name: “case.jpg”) with a 150pxand 50px thumbnails, you will see the following entries in

your library (File Name - Path):

TestImage - /~siteroot~/uploadedImages/case.jpg

Images

ReferenceManual

Version 8.0 Rev 1.3
8-21



case[filename]150 - /~siteroot~/uploadedImages/case[filename]150.jpg

case[filename]50 - /~siteroot~/uploadedImages/case[filename]50.jpg

Viewing Images

To view an image, follow the procedure described in "Viewing Files" on page 8-13. The only

difference is that you view an image instead of a file.

Editing Image Titles

To edit an image’s title, follow the procedure described in "Editing a File" on page 8-15. The

only difference is that you edit an image’s title instead of a file title.

Overwriting Images

When an image in the library becomes out of date, or if the wrong version of an image was

copied, you may overwrite that image with a new or correct version. Overwriting images

minimizes disk space and the number of copied library images.

Note: Overwriting images is a permission that your system administrator mayor maynot assign to you.

To overwrite an image, follow the procedure described in "Overwriting Files" on page 8-16.

The only difference is that you overwrite an image instead of a file.

Note: You can only overwrite an imagewith another image of the same extension. (that is, .gif > .gif, not .jpg > .gif)

Adding Images to Your Content

Once an image is added to the library, users can add it to content.

To add an image to content, follow the procedure described in "Adding a Library File to

Content" on page 8-18. The only difference is that you add an image instead of a file.

The image is placed into the picture properties dialog box, where you can change it before

inserting it.
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Quicklinks and Forms
For a definition of the terms quicklinks and forms, see "Terms Used in this Chapter" on page 8-

2.

Adding a Quicklink or Form to Content

Users can insert a quicklink to it within any content. To do so, follow the procedure described

in "Adding a Library File to Content" on page 8-18. The only difference is that you add a

quicklink or form instead of a file.

You can apply a quicklink to text or an image within the content. If you do, and a site visitor

moves the cursor over the text or image, the cursor indicates that a hyperlink is available. If he

clicks the link, he “jumps” to the source content or image.

If you do not select text or an image before inserting a quicklink, place the cursor where you

want it to appear. The title of the “jumped to” content appears in the content.

To test a quicklink or form, select hyperlinked text or image and double click it.

When the page is published, a reader can click the link to jump to the quicklink or form page.

Viewing Quicklinks or Forms

To view a quicklink or form, follow the procedure described in "Viewing Files" on page 8-13.

The only difference is that you view a quicklink or form instead of a file.

The table below describes each field on the quicklinks display.

Field Description

Title Title given to the hyperlink or form by the user who added it, or last edited it.

URL Link URL link for the quicklink or form.

Library

ID

ID number assigned automatically byEktron CMS400.NET when the quicklink or

formwasoriginally added.

Parent

Folder

Parent folder that the quicklink or form belongs to. Users need permissions to this

folder to be able to access the quicklink or form.
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Field Description

Last

User to

Edit

Last user that made changes to the quicklink or form.

Last Edit

Date
The date the quicklink or formwas last edited.

Date

Created

The date and time the quicklink or formwasoriginally added to the Ektron

CMS400.NET library.

To preview a quicklink or form, click the link at the bottom of the page.

Updating Default Template for Multiple Quicklinks

Warning! This procedure is only necessary if LinkManagement is set to false in your web. config file. If if Link

Management is set to true, Ektron CMS400.NET automatically updates the template within the quicklinkwhen

content ismoved. See your system administrator for help with the web.config file.

Note: This action can only be performed on quicklinks.

When content is moved in Ektron CMS400.NET, its quicklink does not get changed. After it is

moved, you need to update the default template called in the content’s quicklink.

To update the default template for one or more quicklinks, follow these steps.

1. In the library, access the quicklinks folder containing quicklinks you want to update.

2. Click the Update Quicklinks button ( ).

3. The Update URL Link Template Quicklinks screen is displayed.

4. Check the quicklinks you want to update.

Note: Check the box in the table header to select or deselect all.

5. In the To: text field, enter the name of the template you want to apply to the selected

quicklinks.

6. Click the Update Quicklinks button ( ) to update the changes.

A confirmation message is displayed.

7. Click OK to continue.

The selected quicklinks are updated to use the specified template.
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Library Load Balancing
See "Load Balancing Library Images and Files" on page 19-33.
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This chapter describes several tools that Ektron CMS400.NET provides to let site visitors

navigate around your site. Below is link to each feature.

n "Searching Your Web Site" on page 9-4

n "Working with Collections" on page 9-99

n "Working with Menus" on page 9-129

n "Taxonomy" on page 9-200

n "ListSummary Server Control" on page 9-270

n "Breadcrumbs" on page 9-278

n "Personalizing a Web Page" on page 9-302

n "Comparison of Collections, Menus, Taxonomy, and the List Summary Features" on page

9-2

Comparison of Collections, Menus,
Taxonomy, and the List Summary
Features
A menu, a collection, a taxonomy, and the ListSummary function are similar in that they let

you add a list of links to a Web page. The following table compares these features to help you

understand which one is best suited to your needs.

Note: To implement these features, the assistance of a developer is required.

Collection Menu
List

Summary
Taxonomy

Displayall content in a folder. As

folder’s content changes, display

changes.

(folder items

appear on a

menu)

Can display all content in a folder’s

subfolders

Display selected content
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Collection Menu
List

Summary
Taxonomy

Display external hyperlinks& library

assets

Display content summary (optional)

Display additional content

information:

n comment

n last modified date

n start date

n end date

n user who last edited it

n ID number

n path relative to your site’s root

Can bemulti-leveled

Main purpose is navigation

Main purpose is classification

For a detailed guide to Ektron CMS400.NET navigation, see the “Best Practice – Navigation

for your Web site pamphlet,” available from

http://dev.ektron.com/uploadedFiles/Resources/navigation%20best%20practice.pdf.

Comparison of Collections, Menus, Taxonomy, and

ReferenceManual

Version 8.0 Rev 1.3
9-3

http://dev.ektron.com/uploadedFiles/Resources/navigation best practice.pdf


Searching Your Web Site

Note: This chapter only describes searching HTML content. To learn about searching XMLSmart Form content,

see .

Ektron CMS400.NET provides two kinds of searches:

n the Web site search helps site visitors find published content on your Web site.

Your Web developer determines where to place the Web site search. The Ektron CMS400.NET

sample site provides a link to it from every page. When a site visitor clicks the link, he sees the

search screen.

For more information, see "Web Site Search" on page 9-5.

n the Workarea search helps anyone signed into Ektron CMS400.NET to find content. To

access the Workarea search, go to the folder whose content you want to search and click

Action > Search. The following screen appears.

The left tab lets you access the default version of the Web site search, while the right tab lets

you search content by properties (title, comments, creation date, status, etc.).

To learn more about the Workarea search, see "Searching the Workarea" on page 9-87.
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Web Site Search
Ektron CMS400.NET’s Web site search provides extremely fast results without impacting the

load on your database. To accomplish these goals, Ektron CMS400.NET stores a separate copy

of all published content in local index files (also known as a catalog). The Microsoft Windows

Indexing service constantly indexes the catalog so that search results are returned with

lightning speed.

Note: Actually, two catalogsare created: one for public content, and another for private content.

Another advantage of the indexing service is its robust query language. Site visitors can use it

to find Web site content by combining a rich collection of search criteria, including

n boolean and proximity operators

n wildcards

n free text queries

n vector space queries

n property value queries

These are explained in "Query Language" on page 9-52.

A third benefit of this architecture is scalability. If the amount of content or number of hits

begins to affect performance, you can move the catalog to a separate server to handle the

increased workload.

The Web site search is more fully explained through the following topics.

n "The Catalog and Index Files" on page 9-6

n "Basic versus Advanced Web Site Search" on page 9-18

n "Display of Search Results" on page 9-24

n "Synonym Sets and Suggested Results" on page 9-28

n "Using the Integrated Search" on page 9-42

n "Setting up a Multiple Site Search Using Virtual Directories" on page 9-49

n "Searching for Metadata" on page 9-52

n "Query Language" on page 9-52

n "Query Language" on page 9-52

n "Search Troubleshooting" on page 9-63

n "Web Search Server Control" on page 9-68

n "Using Ektron’s Search APIs" on page 9-84
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The Catalog and Index Files

Note: Be sure that your Web server is running Indexing Service 3.0. Earlier versionsof the service do not work

properly.

The Microsoft Windows Indexing Service uses catalogs to index Ektron CMS400.NET content.

The catalogs read copies of content that are saved to the local file system whenever they are

published.

This section explains the following topics about working with the Indexing Service and

catalogs.

n "Local Index Files" on page 9-6

n "The Catalogs" on page 9-7

n "Recreating a Catalog" on page 9-9

n "Restarting the Indexing Service" on page 9-15

Local Index Files
A separate copy of all published content is maintained in local index files (whose extension is

.txt), which are stored in the siteroot/assets folder. Within that folder is a reproduction of the

CMS folder structure. However, it uses the folder ID number, not name, to represent folders.

The following graphic illustrates this structure.
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Notice that each content item is saved as a .txt file for indexing. The file name is derived from

the content item’s

n ID number

n underscore (_)

n language ID

n file extension (content items have an .html extension)

n .txt file extension

The Catalogs
Ektron CMS400.NET stores a copy of all published content in two catalogs that can be

queried. Their default names are below.

n siteroot uniqueID Publish

n siteroot uniqueID Private

As indicated, the second catalog stores private assets. See Also:

To access these catalogs within the indexing service, go to Computer Management >

Services and Applications > Indexing Service.
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Within the file system, these catalogs reside in the c:\program Files\Ektron\Catalogs\siteroot

unique identifier folder. For example, C:\Program

Files\Ektron\Catalogs\CMS400Min312007131255.

View a catalog’s properties to see the fields you can use in queries. See Also: "Property Value

Queries" on page 9-57

Changing a Catalog’s Name
To change a catalog’s name, open the siteroot/web.config file with an editor such as Notepad.

Then, update the catalogName element for the published catalog name, and the

privateCatalogName element for the private catalog name.

<webSearch defaultProvider="MSIndexDialectServer">
<providers>
<add name="MSIndexDialectServer"

type="Ektron.Cms.WebSearch.SearchProviders.MSIndexDialectProvider, Ektron.Cms.WebSearch"

catalogName="localhostPublished" privateCatalogName="localhostPrivate" pageSize="10"

description="MS Index Server Dialect2 Provider"/>

<add name="MSIndexServer" type="Ektron.Cms.WebSearch.SearchProviders.MSIndexProvider,

Ektron.Cms.WebSearch" catalogName="localhostPublished"

privateCatalogName="localhostPrivate" pageSize="10" description="MS Index Server SQL

Provider"/>
</providers>

</webSearch>
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Recreating a Catalog
If a catalog is accidentally deleted or becomes corrupted, follow these steps to recreate one.

There are two ways to do this.

n "Manually Recreating a Catalog" on page 9-9

n "Automatically Recreating a Catalog" on page 9-10

Manually Recreating a Catalog

Part 1:Create aNew Catalog andCopyMetaconfig.docFile to it

1. Open the C:\Program Files\Ektron\Catalogs folder.

2. Create a folder for the new catalog.

3. From the Computer Management screen, select Services and Applications > Indexing

Service.

4. If the indexing service is running, right click Indexing Service and click Stop.

5. Right click the mouse and select New > Catalog.

6. Assign the catalog a name. At the Location field, browse to the folder you created in Step

2.

7. Navigate to the C:\Program Files\Ektron\CMS400releasenumber\Utilities directory and

find the metaconfig.doc file.

8. If you are creating a public catalog, copy that file to the site root/Assets folder.

If you are creating a private catalog, copy metaconfig.doc to the site root/PrivateAssets

folder.

9. From the Computer Management screen, click the new catalog you created in step 5.

Underneath it, a Directories folder appears.

10. Select the Directories folder and click New > Directory.

11. The Add Directory Screen appears. If you are creating a public catalog, browse to the site

root/Assets folder. If you are creating a private catalog, browse to the site

root/PrivateAssets folder.

12. Right click Indexing Service and click Start.

13. From the Computer Management screen, view the new indexing service. Make sure a

number appears in new catalog’s Total Docs column, and the Docs to Index number is

zero (0) before proceeding.

Part 2:UpdateMetaconfig.reg

1. Navigate to the C:\Program Files\Ektron\CMS400releasenumber\Utilities directory

2. Open the metaconfig.reg file with an editor like Notepad.
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3. Update the first line of that file with the location of the new catalog relative to the

C:\Program Files\Ektron\Catalogs folder. For example, if the new folder within the

catalog folder is named mytest, the first line of the metaconfig.reg file looks like this.

[HKEY_LOCAL_

MACHINE\SYSTEM\CurrentControlSet\Control\ContentIndex\Catalogs\mytest\Properties]

4. Save the file.

5. Double click the file. This action updates your Windows Registry with the new

information.

6. Stop and restart Windows Indexing Service. Both commands are available from the menu

that appears when you hover over the Indexing Service and right click the mouse.

7. View the new Indexing Service to verify that all properties exist as in the original service.

Part 3:Update web.config

Follow the directions in "Changing a Catalog’s Name" on page 9-8 to update the catalogs that

are updated as content is updated.

Automatically Recreating a Catalog
If you don’t want to perform the manual steps listed above, Ektron CMS400.NET provides a

utility that automatically creates a new catalog. You would typically use this if a catalog were

corrupted or accidentally deleted.

Warning! Before running the Search Data Configuration utility, if your server hasVisio documents, install the Visio

IFilter. See "Query Language" on page 9-52. Also, if your server hasOffice 2007 documents, install theMicrosoft

Office SharePoint Server 2007 IFilters. See http://technet2.microsoft.com/Office/en-us/library/c6c029bd-64ea-

4617-b2da-c269f13599e21033.mspx?mfr=true.

Warning! Make sure all Ektron CMS400.NET users are signed off before you begin this utility. If theyare not, the

utility logs them off.

To launch the utility, follow this path from the Windows Start button:

Start > Programs > Ektron > CMS400 version > Utilities > SearchConfigUI

Alternatively, click the following file: C:\Program
Files\Ektron\CMS400vversionnumber\Utilities\SOFTWARE\SearchConfig\searchconfigUI.exe

When you do, the following screen appears.
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To create a new published asset catalog, follow these steps.

1. In the Published Catalog field, enter the name of a new catalog. Or, leave the current

catalog name, and the utility will overwrite the catalog.

2. Do the same to create a new or replace the Private Catalog.

3. Check the Create New Catalogs box.

4. If you want to automatically generate a summary for all content in the new catalog, click

the Automatically generate summary for content checkbox. See Also:

5. Click the Advanced tab.

6. Check each type of content that you want to index for the search.

7. By default, new catalogs are created in the web site root/ catalogs folder. If you want to

create these in another folder, use the Specify directory for catalogs field to enter or

browse to that folder.

8. Press Start.

9. Ektron CMS400.NET creates a new catalog and index files for your content.
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After you run this utility, the old catalog remains but no new content is written to it. All

subsequent changes are written to the new catalog.

See Also: "SearchConfigUI.exe crashes while building search indexes and catalogs" on page 9-

65

The SearchConfig Log
All activity generated by the Search Data Configuration screen is tracked by a log. You can

view the log top obtain a history of these changes.

The log is located in the C:\Program

Files\Ektron\CMS400vversionnumber\Utilities\SOFTWARE\SearchConfig folder. Its name is date

time.LOG. The log is also available on the Search Data Configuration Screen’s Log output tab.

Search Data Configuration Screens
Use these screens to perform the following actions.

n make all Ektron CMS400.NET content searchable (do this if you recently switched to a

new database)

n make any of the following kinds of content searchable (do this if the search cannot find

this content)

- HTML

- assets

- XML Smart Forms

- users and groups

- forums

n reindex the catalogs

n create a new catalog and index it (do this if a catalog was corrupted or accidentally

deleted)

The following table explains the fields on the screens.

See Also: "The SearchConfig Log" on page 9-12

The Configuration Tab

See Screen Sample
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Field Description

WebSite Select the Ektron CMS400.NET site that you want to workwith

Connection String
Review the connection string to your Ektron CMS400.NET

database. Update if needed.

AssetsPath Review the path to your site’sAssets folder. Update if needed.

Private AssetsPath
Review the path to your site’sPrivate Assets folder. Update if

needed.

Re-indexexisting catalogs Check this box if you want to reindex the existing catalogs.

Create New Catalogs Check this box if you want to create a new catalog.

Published Catalog
Review the name of your published catalog. Update if needed.

See Also: "The Catalogs" on page 9-7

Private Catalog
Review the name of your private catalog. Update if needed. See

Also: "The Catalogs" on page 9-7

AutomaticallyGenerate

Summary for Content

If you want to automatically generate a summary for all content in

the new catalog, click this checkbox. See Also:
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Field Description

Status
After you click theStart button, this area indicates the status of the

new catalog creation.

The Advanced Tab

Field Description

Index the following for Search

n HtmlContent

n Users andGroups

n Documents

n Forums

n XMLContent

Checkeach type of content that the search can find.

Specify directory for catalogs

Use this field to change the location of the published and

private catalogs, if desired. Bydefault, they reside in the

your web site/catalogsdirectory.
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The Log Output Tab
All activity generated by the Search Data Configuration screen is tracked by a log. The Log

Output Tab displays a history of these changes.

A permanent copy of the log is saved in the C:\Program

Files\Ektron\CMS400vversionnumber\Utilities\SOFTWARE\SearchConfig folder. Its name is date

time.LOG.

Restarting the Indexing Service
Use the Indexing Service screen to restart Windows’ Indexing Service. You can also use the

screen to rescan the catalogs.

To access the Indexing Service screen, go to Workarea > Settings > Configuration
> Indexing Service.
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From this screen, you can

n "Restart the Indexing Service" on page 9-16

n "Run a Full Scan of a Catalog" on page 9-17

n "Run an Incremental Scan of a Catalog" on page 9-18

Restart the Indexing Service
Sometimes, when resolving issues with your search, you must stop and restart the indexing

service. To restart it via the Indexing Service screen, click the Restart Service button.

To restart the indexing service for a particular catalog only, click Restart to the right of the

catalog name.

Alternatively, you can stop and restart the Indexing service from the Computer Management

screen, as shown below.
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Run a Full Scan of a Catalog
Sometimes, when resolving issues with your search, you need to run a full scan of a catalog.

To do this, access the Settings > Configuration > Indexing Service screen. Then, click

Rebuild next to the affected catalog.

The following text explains the full scan. (Copied from Microsoft Management Console help)

A full scan takes a complete inventory of all documents in the cataloged folders and adds them

to the list of documents to be indexed. The Indexing Service does a full scan of disk drives

attached to your computer (except for removable devices) in the following situations:

n When it is run for the first time after installation

The Catalog and Index Files
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n When a folder is added to the catalog

n As part of recovery if a serious error occurs

Run an Incremental Scan of a Catalog
Sometimes, when resolving issues with your search, you need to run an incremental scan of a

catalog. To do this, access the Settings > Configuration > Indexing Service screen. Then, click

Update next to the affected catalog.

The following text explains the incremental scan. (Copied from Microsoft Management

Console help)

Microsoft Windows Indexing Service cannot track changes to documents when it is shut down.

When Indexing Service restarts, it does an incremental scan to detect all documents that were

modified while it was inactive so it can update its index.

An incremental scan may also be performed if Indexing Service loses change notifications. This

can happen if the update rate of documents is very high and the buffer used to get change

notifications from Windows XP overflows.

Basic versus Advanced Web Site
Search
When your developer places a Web Search server control on any page, and a site visitor

browses to it, he sees the following.
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This section now divides into two sections:

n Basic Search (shown above)

n Advanced Search (access this by clicking the Advanced Search tab)

This section also explains the search-related topics "The Content Searchable Field" on page 9-

23.

See Also: "The Advanced Search" on page 9-21

The Basic Search

Note: You can also create a folder with content outside of Ektron CMS400.NET that is searched. For more

information, see "Using the Integrated Search" on page 9-42.

The Basic Search finds content that satisfies these criteria.

n published

n active (archived content is ignored)

n its Searchable check box is checked (see "The Content Searchable Field" on page 9-23)

n public. However, private content is available to those with permission to view it, such as

membership users after logging in. See Also: .

n resides in the CMS folder specified in the Web search server control, or in one of that

folder’s subfolders if the control’s recursive property is set to true

n is not a non-image file added to the library. Images are searchable, while other files added

to the library are not. So, to make files searchable, add them as assets, not library files.

n matches selected language, if site is multilingual

n satisfies text and/or query entered in the search box (no value returns nothing) See Also:

"Query Language" on page 9-52

- The text inserted in the search field can appear in the content or metadata (See Also:

"Searching for Metadata" on page 9-52)
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n satisfies content type criterion selected on screen, if chosen (see below)

Note: The search doesnot find documents inside compressed files, such as *.zip, *.cab, etc.

Search Results by Content Type

Search Screen

Option
Finds submitted text in these content types

Site Content from all optionsbelow (except Tags) plusForums

HTML

n HTML

n Smart Form (XML)

Note: FindsXML field valuesbut not field labels. This hasnot

changed since prior releases.

n HTML Form

n Blog entries (not comments)

Documents

n MSOffice document (includesPowerpoint, Excel)

Note: The search finds text within Visio documents if the Visio IFilter

hasbeen installed. See "Query Language" on page 9-52.

n PDF file

n .txt file

Imagesadded asassets

and through the library
.gif, .jpeg, etc.
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Search Screen

Option
Finds submitted text in these content types

MultiMedia Flash, .mp3, etc.

Tags Tagsapplied to content and library items. See Also:

Note: The search cannot find calendar events.

Searching Multiple Terms
If a site visitor enters several terms, the search only returns pages that include all terms. This is

known as an ‘and’ relationship. For example, if the user enters cancer and cure in the Search

box, only content that includes both terms (and satisfies the other criteria) appears.

Ektron uses an ‘and’ relationship because we believe it’s what a site visitor expects. Consider a

simple Google search – the more you enter into the Google Search text box, the fewer results

you get, since your phrase is more precise.

The advanced search screen, on the other hand, lets the site visitor determine if he wants an

and, or, not, or exact phrase relationship. See Also: "The Advanced Search" on page 9-21

The Advanced Search

The Advanced Search uses nearly all the same search criteria as the Basic Search. (See "The

Basic Search" on page 9-19). The differences are additional options and filters (explained

below) and the fact that you cannot use queries.
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Advanced Search Options

SearchOption Finds these pages

with all of the

words

Web pagemust include all submitted terms; their position on the

page doesnot matter.

You cannot enter queries into this field.

with the exact

phrase

Web pagemust include the exact phrase. For example, if you enter

Ektron healthcare, a page with the term Ektron provides

healthcare is not found because it is not an exact match.

at least one of the

words
Web page can include anyone of the submitted terms

without the word
Web page doesnot contain the submitted word.

Only use this option if you also reply to one of the three fields above.

Advanced Result Filters
Below the Advanced Search Options is a list of additional fields you can use to refine the

search. These are titled Advanced Result Filters.
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Result Filter Prompts site visitor to enter

Author

Enter firstname<space>last name.

Can abbreviate byentering part of either name surrounded byasterisks (*). For

example, *Jo* findsanyauthor whose first or last name contains those letters.

Created

Before

All content created before date entered byuser.

Date format isYYYY/MM/DD.

Created After
All content created after date entered byuser.

Date format isYYYY/MM/DD.

Modified

Before

All content updated before date entered byuser.

Date format isYYYY/MM/DD.

Modified After
All content updated after date entered byuser.

Date format isYYYY/MM/DD.

File Size
Enter file size in kilobytes. You can use greater and less than operators (>, <) to

find content greater or less than a value. For example, > 10000.

To add a filter, click Add Filter. To remove a filter, click Remove to the right of the filter.

The Content Searchable Field
Each content item includes a Content Searchable field. The search only considers content

whose field is checked. See illustration below.
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By default, this field is checked when content is created.

Warning! Despite the value of this checkbox, if an Ektron CMS400.NET user places this content item in a Sug-

gested Results list, it will appear in the Suggested Results area of the Search Results screen. See Also: "Sug-

gested Results" on page 9-31. Also, this content can still be found by the AdvancedWorkarea search.

Display of Search Results
Below is an example of the Web Site Search and Search Published results screen. Your

developer can customize it using the Web Search server control.
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Below the search box is an optional Filter by Category link. If your developer enables the

link in the WebSearch server control, a site visitor can click it to see a folder structure of

taxonomy categories. He can then select categories of interest. When he does, only content

that includes the search term and which is assigned to the selected categories appears. For more

information, see"Filtering Search Results by Category" on page 9-81

The actual results begin with the title and last edited date. Following them is either

n an abstract of the content, which is automatically generated by the Windows Indexing

Service, or

n the content summary See Also: "Working with Content Summary" on page 7-142

Your developer makes this decision in the WebSearch server control.

Following the abstract or summary is additional information, such as content ID number, size,

last author, number of occurrences of the search term, and rank. Your developer determines

which criterion is used to order the results.

TECHNICALNOTE

Note: The Adobe IFilter, which is used to generate the abstract, is only supported in Tier 1 languages (English,

French, German, and Japanese). If your Web site usesother languages, the abstract maynot be legible. In such a

case, your developer should suppress the abstract from the search results. This procedure is documented in

"Determining the Displayof Search Results" on page 9-80.

When you click the title of any content item, it appears. The search term is highlighted (see

example below) if the following web.config property is set to true: <add key=”ek_

termHighlight” value=”true”/>. To remove highlighting, set the value to false.
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See Also:

n "Adjusting the Length of the Search Result Abstract" on page 9-26

n "Search Result Ranking" on page 9-27

Adjusting the Length of the Search Result Abstract
To adjust the length of the abstract, update the Indexing Service’s Properties window >

Generation tab > Maximum Size field (see below).
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The abstract’s text is taken from the content. (It ignores text in tables.) If the content text has

fewer characters than the Maximum Size, Ektron CMS400.NET tries to complete the abstract

by retrieving the title, summary, metadata, comments, and additional information stored in the

content item’s tabs.

Search Result Ranking
Each content item found by a catalog search is given a numerical rank between 0 and 1000.

Search results can be sorted by rank.

Criteria used to calculate rank include the

n number of occurrences of the search term

n proximity of search term to beginning of file

n proximity of search term to other occurrences of the term

n whether the term is in the title

Customizing the Postback Message
By default, if a search term yields no results, the following message appears on the screen.
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If you want to customize this message, follow these steps.

1. In your site root folder, find the workarea/resources folder.

2. Open the resource file that corresponds to your site’s language. For example, if your site is

in American English, open EkResource.en-US.resources.

Note: If your site supportsmultiple languages, follow these steps for each corresponding resource file. See Also:

3. Within the resource file, find the key lbl search no results.

4. The default text (shown above) follows this key. Modify the text as needed.

5. Save the file.

Synonym Sets and Suggested Results
This section describes two search enhancements that can be used independently but are more

powerful when used together.

n "Synonym Sets" on page 9-28

n "Suggested Results" on page 9-31

Synonym Sets
You can create sets of synonyms to work with the search. If a site visitor enters any term in a

synonym set into the Search box, Ektron CMS400.NET’s search looks for that term plus all

other terms in the set.

For example

Synonym Set: Tuition

Terms: tuition, bill, payment, pay, fee, charge, price, amount, cost, money, balance
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If a site visitor inserts bill into the search field, Ektron CMS400.NET uses bill or tuition or

payment or pay or fee or charge, etc. to gather search results.

The Synonym Set feature will typically produce more “hits.” So, while the user does no more

work, his chances of finding the right information on your Web site are greatly increased.

If a term exists in more than one Synonym Set, the search encompasses all terms in all sets.

The following sections explain how to work with Synonym Sets in more detail.

n "Synonym Set Best Practices" on page 9-29

n "Creating a Synonym Set" on page 9-29

n "Editing a Synonym Set" on page 9-30

n "Deleting a Synonym Set" on page 9-31

TECHNICALNOTE

Note: TheWeb Search server control hasa SearchSynonymsproperty. Thismust be set to true for a Synonym

Set’s terms to be included in the search logic.

Synonym Set Best Practices
n Synonyms are searched across all HTML content and documents indexed by Ektron

CMS400.NET (for example, Word documents).

n Ektron CMS400.NET’s search does not include plurals or verb forms. So, if you think a

site visitor might enter either ticket or tickets, enter both into the Synonym Set. Same with

bill, billing, etc.

n A search term can consist of several words as long as the term is entered the

same way in the Synonym Set. For example, love seat is part of a Synonym Set
that includes sofa.

As long as both love and seat are in a content item, the search finds it even if the words are

separated. But, entering a single term, like love, will not find that Synonym Set.

So, if you think people may search using loveseat or love seat, enter both terms into the Syn-

onym Set.

n The metadata search does not use or support Synonyms Sets.

Creating a Synonym Set
Follow these steps to create a Synonym Set.

See Also: "Synonym Sets" on page 9-28; "Editing a Synonym Set" on page 9-30

1. From the Ektron CMS400.NET Workarea, go to Settings > Configuration > Search >

Synonyms.
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2. From the language dropdown, select a language for the Synonym Set. (The search is

language-specific. When a site visitor begins using your site, he selects a language. Only

synonyms sets in that language are considered.)

3. Click the Add button ( ).

4. The following screen appears.

5. Enter a name for the set. Ektron CMS400.NET users will use this name to identify the

Synonym Set.

6. Enter all terms that make up the set. Separate each with a semicolon (;). You cannot enter

a comma (,) or a parenthesis character (() into the Terms field.

7. After entering all terms, click the Check for Duplicates button. Ektron CMS400.NET

compares terms in this set against the other Synonym Sets in this language. If the same

term is found in another set, you are notified.

It is not necessarily a problem for a term to exist in more than one Synonym Set. So,

review each Synonym Set that contains the duplicate and decide what to do.

8. Click Save ( ).

Editing a Synonym Set
Follow these steps to edit a Synonym Set.

See Also: "Synonym Sets" on page 9-28

1. From the Ektron CMS400.NET Workarea, go to Settings > Configuration > Search >

Synonyms.

2. From the language dropdown, select the Synonym Set’s language.

3. Click the Synonym Set that you want to edit.

4. Click the Edit button ( ).

5. The Edit Synonym Set screen appears.
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6. Add or remove terms. Be sure to separate each term with a semicolon (;).

7. Click the Check for Duplicates button. Ektron CMS400.NET compares terms in this set

against the other Synonym Sets in this language. If the same term is found in another set,

you are notified.

8. Click Save ( ).

Deleting a Synonym Set

Note: Deleting a SynonymSet also deletesanySuggested Results associated with the SynonymSet. The user is

warned about thiswhen deleting.

Follow these steps to delete a Synonym Set.

See Also: "Synonym Sets" on page 9-28

1. From the Ektron CMS400.NET Workarea, go to Settings > Configuration > Search >

Synonyms.

2. From the language dropdown, select the Synonym Set’s language.

3. Click the Synonym Set that you want to delete.

4. Click the Delete button ( ).

5. You are asked to confirm your action.

6. The Synonym Set is deleted.

7. Perform an IIS reset on your server. This utility clears the cache, so that the synonym set is

no longer available to Ektron CMS400.NET.

See Also: http://technet.microsoft.com/en-us/library/cc781553(WS.10).aspx

Suggested Results
For any term or Synonym Set, you can create a list of Suggested Result links. That is, links that

appear in a special area of the Search Results page whenever someone searches for a selected

term. These links can jump to your Web site or an external Web site.
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The Suggested Results feature is explained through the following topics.

n "Using Suggested Results to Direct Site Visitors" on page 9-32

n "Determining the Display of Suggested Results " on page 9-35

n "Creating a Set of Suggested Results" on page 9-36

n "Editing a Suggested Result Set" on page 9-38

n "Deleting a Suggested Results Set" on page 9-42

TECHNICALNOTE

Note: TheWeb Search server control hasa ShowSuggestedResultsproperty. Thismust be set to true for

suggested results to appear on the page that hosts that control.

Using Suggested Results to Direct Site Visitors
Use this feature to direct site visitors to pages that do not appear at the top of natural search

results. For example, you manage a university’s Web site. When a site visitor wants to know
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where to mail a tuition payment, he enters bill into the search field and gets these results.

Faculty member Bill McDermott

The Student Bill of Rights

How a Bill Becomes Law

Frustrated, many people call the business office to get information that exists on the Web site

but is difficult to find.

Using Ektron CMS400.NET, you can combine a Synonym Set with Suggested Results to direct

site visitors to the correct Web pages. To continue this example, you could create

n a Synonym Set (named tuition) that includes all terms people might enter when searching

for the tuition page on your Web site. See Also: "Synonym Sets" on page 9-28

n a Suggested Results list in which you assign the “Tuition & Fees” Web page to the

Tuition Synonym Set

These sets are illustrated below.

After you set up the Synonym Set and Suggested Results, here is a typical sequence of events.

1. A site visitor enters a phrase on your site's Search page.

Suggested Results

ReferenceManual

Version 8.0 Rev 1.3
9-33



2. The phrase matches a term in a Synonym Set that has Suggested Results.

3. Suggested Result hyperlinks assigned to the set appear in a special area of the results page.

They appear in the order you defined when setting up links.

4. The search term’s normal results can also appear. Your developer determines their location

on the results page.

Using Suggested Results to Enhance Business Opportunities
You can also use Suggested Results to direct site visitors to business partners' Web sites. One

example is a stop smoking clinic near your hospital that has been successful with your patients.

When someone visits your Web site and searches for smoking, you can set the clinic to be the

top Suggested Result.

As another example, your organization creates widgets but does not implement or customize

them. Over time, several agencies develop experience at deploying and customizing your

widgets. Therefore, you want to promote these supporting businesses on your site. To do so,
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create a Synonym Set (for example: deploy, install, implement, customize, modify, adapt) and

assign the Web sites of approved agencies to the Suggested Results list. Then, when a site

visitor searches for the word implement or customize, he gets links to those agencies’ Web

sites.

Suggested Results can also be used to advertise products, as used in the sponsored results

section of popular search engines like Google® search and Yahoo!® .

Determining the Display of Suggested Results
Suggested Results can appear on any page that contains a Websearch server control. They can

appear wherever you want: at the top of the search results page, in the right column, etc. You

can also choose if and where to display the search term's regular results.

In the Web Search server control, your Web developer determines where search results appear,

using either a style sheet or an XSLT. For more information, see "Web Search Server Control"

on page 9-68.

Note: TheWebSearch server control hasa ResultsPageSizeproperty. If your developer sets it to less than the

number of suggested results applied to a term or synonym set, the ResultsPageSizeproperty’s number of results

appears. For example, if you assign five links to a Suggested Result set but a developer setsResultsPageSize to

three, only the first three results appear.

What Happens when a Term Appears in More than One
Synonym Set
If more than one Synonym Set contains the same word, and each set has suggested search

results, the results appear in chronological order by Synonym Set creation date. Here is an

example.

Synonym Set Terms Creation Date

Milk production Cow;Milk; Dairy January 1, 2007

Animals Horse; Sheep; Cow April 16, 2007

When a site visitor searches for Cow, the Milk production set’s links appear above Animals

links because it was created first.
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Creating a Set of Suggested Results
Follow these steps to create a set of Suggested Results. You cannot enter more than 10 links

into any Suggested Results set.

1. From the Ektron CMS400.NET Workarea, go to Settings > Configuration > Search >

Suggested Results.

2. From the language dropdown, select a language for the Suggested Results. (The search is

language-specific. When a site visitor begins using your site, he selects a language. Only

Suggested Results in that language are considered.)

3. Click the Add button ( ).

4. The following screen appears.

5. Use the following table to complete the fields.

Field Description

Type

To apply thisSuggested Results set to a single term, proceed to the next field,

Term.

To apply this set to a SynonymSet, change this value to Synonym Set. (If you

do, the next field’s name changes to Synonym Set.)

Term/

Synonym

Set

If the above value isSingle Term, enter a search phrase that will trigger the

Suggested Results you will create below.

Note: You cannot enter a comma(,) or a parenthesis character (() into the

Terms field.

If the above value isSynonym Set, select from the dropdown the SynonymSet

that will trigger the Suggested Results you will create below. That is, if a user

enter a search phrase that matchesany term in the SynonymSet, the

Suggested Results appear.

Suggested

Results

Place the cursor in this field.When you click, a menu appears (see illustration

below).

WebSite Navigation Aids

9-36
ReferenceManual

Version 8.0 Rev 1.3



6. Click Add.

7. The following screen appears. Here, you add the URL, text, and summary for each

Suggested Result.

8. Use the following table to complete the fields.

Field Description

Link

To create a link to

n content on your Web site, click theBrowse to CMS content button. Then,

navigate to the folder that contains the content you want to link to. Select the con-

tent and clickSave.

n an externalWeb site, enter its full address, starting with http://.
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Field Description

Title

If you created a link to

n content on your Web site, its title is retrieved and displayed here. Youmay

edit it as needed.

n an external Web site, enter the text of the link that will appear

on the Suggested Results display.

Site visitors use this text to select the linkedWeb page. The title is circled in the

example below.

Summary

If you created a link to

n content on your Web site, its summaryappears here. Youmayedit it as

needed. The summary cannot exceed 320 characters (including HTML tags).

n an externalWeb Site, nothing appears. Enter up to 320 characters (includ-

ing HTML tags) to further describe this link on the search results page.

The summary is circled in the example below.

9. Click Save ( ).

10. The Add Suggested Results screen reappears. You can add more links, edit existing ones,

etc. When done, click Save ( ).

Editing a Suggested Result Set
The following sections explain how to perform the following edits on a Suggested Result Set.

n "Adding a Link to a Suggested Result Set" on page 9-39
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n "Editing a Link in a Suggested Result Set" on page 9-39

n "Removing a Link from a Suggested Result Set" on page 9-40

n "Rearranging the Sequence of Links in a Suggested Results Set" on page 9-41

n "Deleting a Suggested Results Set" on page 9-42

Adding a Link to a Suggested Result Set
1. From the Ektron CMS400.NET Workarea, go to Settings > Configuration > Search >

Suggested Results.

2. From the language dropdown, select a language for the Suggested Results. (The search is

language-specific. When a site visitor begins using your site, he selects a language. Only

Suggested Results in that language are considered.)

3. Select the Suggested Results set to which you want to add a link.

4. Click the Edit button ( ).

5. Place the cursor over the first result in the Suggested Results area of the screen.

6. Click once and a menu appears.

7. Click Add.

8. The Add New Suggested Results screen appears.

9. See "Use the following table to complete the fields." on page 9-37.

10. Click Save ( ).

11. Click Save ( ) again.

Editing a Link in a Suggested Result Set
1. From the Ektron CMS400.NET Workarea, go to Settings > Configuration > Search >

Suggested Results.
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2. From the language dropdown, select a language for the Suggested Results. (The search is

language-specific. When a site visitor begins using your site, he selects a language. Only

Suggested Results in that language are considered.)

3. Select the Suggested Results set that you want to edit.

4. Click the Edit button ( ).

5. Place the cursor in the Suggested Results area of the screen.

6. Place the cursor on the result that you want to edit.

7. Click once and a menu appears.

8. Click Edit.

9. See "Use the following table to complete the fields." on page 9-37.

10. Click Save ( ).

11. Click Save ( ) again.

Removing a Link from a Suggested Result Set
1. From the Ektron CMS400.NET Workarea, go to Settings > Configuration > Search >

Suggested Results.

2. From the language dropdown, select a language for the Suggested Results.

3. Select the Suggested Results set from which you want to remove a link.

4. Click the Edit button ( ).

5. Place the cursor in the Suggested Results area of the screen.

6. Place the cursor over the result that you want to delete.

7. Click once and a menu appears.
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8. Click Delete.

9. A confirmation message appears. Click OK.

10. Click Save ( ).

Rearranging the Sequence of Links in a Suggested Results
Set
Use this procedure to move Suggested Results up or down within a list.

1. From the Ektron CMS400.NET Workarea, go to Settings > Configuration > Search >

Suggested Results.

2. From the language dropdown, select a language for the Suggested Results.

3. Select the Suggested Results set from which you want to remove a link.

4. Click the Edit button ( ).

5. Place the cursor in the Suggested Results area of the screen.

6. Place the cursor over the result that you want to move up or down.

7. Click once and a menu appears.

8. Click Move Up orMove Down.
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9. Click Save ( ).

Deleting a Suggested Results Set
1. From the Ektron CMS400.NET Workarea, go to Settings > Configuration > Search >

Suggested Results.

2. From the language dropdown, select a language for the Suggested Results.

3. Select the Suggested Results set from which you want to remove a link.

4. Click the Delete button ( ).

5. Click OK to the confirmation message.

Using the Integrated Search
You can expand the Web search to any Web-accessible files on your server, even if they are

not part of Ektron CMS400.NET. This feature is called Integrated Web Search.

Note: The Integrated Search onlyworkswith aWeb Search server control that is placed on aWeb page. It does

not workwith theWorkarea search or anyother search server control.

Use an Integrated Search if your site’s search should include non-Ektron CMS400.NET files

which, nevertheless, need to be searchable by site visitors. For example, a folder of personnel

policy documents should be searchable on your intranet but you do not want to add them to

Ektron CMS400.NET.
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As another example, you have a Web site of static HTML pages, and are now deploying

Ektron CMS400.NET for certain parts of the site, such as job listings or a discussion forum.

You can create a page with an Integrated Search that encompasses your entire site.

The following topics explain the Integrated Search in more detail.

n "Integrated Search Overview" on page 9-43

n "Setting up a Virtual Directory" on page 9-43

n "Setting up an Integrated Search" on page 9-44

n "Searching for non-Ektron CMS400.NET Content" on page 9-48

n "Integrated Search Content in Search Results" on page 9-48

Integrated Search Overview
To set up an Integrated Search, create one or more Windows folders underneath the site root

folder. Place files to be searched within them or their subfolders.

Alternatively, Integrated Search can find content in any Web- accessible folder on the server’s

file system. In this case, create one or more virtual directories that point to the site root folder.

Then, identify the Integrated Search folder and, if desired, file types to include or exclude

when searching. The procedure for doing this is explained in "Setting up a Virtual Directory"

on page 9-43.

Setting up a Virtual Directory
The Integrated Search’s starting folders can reside anywhere on your server’s file system. If you

want a folder to reside somewhere other than under the site root folder, follow these steps to

set up a virtual directory. A virtual directory resides in the site root folder, but contains no

content -- instead, it points to a Web-accessible folder anywhere in the file system.

Warning! Although a virtual directory is not on the same server as your site, it must be on the same domain as

your site’s server.

Since creating a virtual folder is a Windows procedure, the procedure is explained in

http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/5adfcce1-

030d-45b8-997c-bdbfa08ea459.mspx?mfr=true.

On the Access Permissions screen that appears during the setup, only check Read (see below).
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Setting up an Integrated Search
There are three parts to setting up an Integrated Search.

n "Creating an Integrated Search Folder Structure" on page 9-44

n "Assign the Integrated Search folder to the WebSearch Server Control " on page 9-45

n "Identifying Integrated Search Folder Information in the Workarea" on page 9-45

After setting up an Integrated Search, you might want to do these things:

n "Viewing All Integrated Search Folders" on page 9-47

n "Viewing an Integrated Search Folder" on page 9-47

n "Editing an Integrated Search Folder" on page 9-48

Creating an Integrated Search Folder Structure
1. In the site root folder, create one or more folders for non-Ektron CMS400.NET files to be

searched. You can create child folders in as many levels as needed underneath these

folders.

Alternatively, create a virtual folder that points to any folder in your file system. See Also:

"Setting up a Virtual Directory" on page 9-43

2. Place all files to be searched in the parent or child folders.
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Assign the Integrated Search folder to the WebSearch
Server Control
To find Integrated Search content, users must access a Web page that contains a WebSearch

server control. Further, you must assign to that control’s CustomSearch property the names of

all top-level Integrated Search folders (see illustration below). Any child folders under the top-

level folders are included in the search.

Identifying Integrated Search Folder Information in the
Workarea
Follow this procedure for every folder that contains Integrated Search content.

1. In the CMS Workarea, go to Settings > Configuration > Integrated Search Folders.

2. Click the Add button ( ).

3. The Add Integrated Search Folder screen appears.
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4. Complete the fields as described in the table below.

To include all files in the folder (except those that would typically not be searched, such

as .exe and .dll files), do not modify the Include Extensions and Exclude Extensions

fields.

Field Description

Site Directory

Enter the name of the parent folder (or virtual folder) that contains the

searchable, non-Ektron CMS400.NET content. This folder must reside in the

site root folder. If you are using a virtual folder, enter its name, not the folder

that contains the content.

See Also: "Creating an Integrated Search Folder Structure" on page 9-44

Recursive
Check this box if you want the search to include all child folders under the

folder in the Site Directory field.

Exclude

Directories

If you want to exclude files in anydirectory underneath the directory listed in

theSite Directory field, enter the namesof the directories to exclude. You do

not need to enter the path to the directory -- only the name.

If you enter more than one directory, use a comma to separate them.

Bydefault, Ektron CMS400.NET places several directories that a search

would typically ignore. Edit as needed.

Exclude

Extensions

If you want the search to ignore certain file types, enter those extensions in

this format: *.filetype. For example *.xml. If you enter more than one,

separate themwith a comma (,).

Bydefault, Ektron CMS400.NET inserts several file types that a search would

typically ignore. Edit as needed.

Warning! - If you enter any value into the Include Extensions field, this

field is ignored.
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Field Description

Include

Extensions

If you want the search to include only certain file types, enter those extensions

in this format: *.filetype. For example *.xml. If you enter more than one,

separate themwith a comma (,).

Warning! - If you enter any value into this field, the Exclude Extensions

field is ignored.

Domain/User

Name,

Password and

Confirm

Password

If the parent folder is a virtual folder that points to another server, enter the

domain\user name and password needed to access that server.

The parent folder is identified at the Site Directory field.

Warning! Ektron’sWindowsservice runshourly to index these files. So, you will not see search results for at least

an hour after you set up this feature.

See Also: "Using the Integrated Search" on page 9-42

Viewing All Integrated Search Folders
To view all integrated search folders, go to Settings > Configuration > Integrated Search

Folders. The screen displays every folder that will be included in the Integrated Search. See

Also: "Using the Integrated Search" on page 9-42

Click any folder to edit its properties or delete it.

If you want to create a new Integrated Search folder, click the Add button ( ). See Also:
"Creating an Integrated Search Folder Structure" on page 9-44

Viewing an Integrated Search Folder
This screen displays all information about one Integrated Search folder. See Also: "Using the

Integrated Search" on page 9-42

To see documentation for any field on the screen, go to "Complete the fields as described in

the table below." on page 9-46.

To edit information assigned to this Integrated Search folder, click the Edit button ( ).

To delete this Integrated Search, click the Delete button ( ).
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Editing an Integrated Search Folder
To edit an integrated search folder, select if from the View Integrated Search Folders screen.

Then, click the Edit button ( ).

Edit the fields as needed. To see documentation for any field, go to "Complete the fields as

described in the table below." on page 9-46.

Searching for non-Ektron CMS400.NET Content
You can search for all non-Ektron CMS400.NET content by file title. For example, you can

find the file Ektron.gif by inserting Ektron into the search field.

You can search text files (.doc, .pdf, .txt, etc.) by either file name or text within them.

Finally, you can use the following syntax to find files by extension: #filename *.extension.

For example, to find all .gif files, use #filename *.gif. Be sure to click the Images button.

Note: Because Ektron CMS400.NET storesall content in .txt files, you cannot use this syntax to find fileswith a .txt

extension.

Integrated Search Content in Search Results
To distinguish Integrated Search content from regular content, the ID number of IS content

begins with 1,000,000,000. Also, the last author name is Non_Cms_User. See illustration

below.
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Setting up a Multiple Site Search
Using Virtual Directories
Use the following procedure if you want to set up two sites but use a single database. The

steps below allow you to search from either site to find the same content.

In this example, the first site contains the database, while the second site uses virtual

directories to point to content in the first site.

1. Set up the first site and create a database for it in the normal manner.

2. Set up the second site, but when you are prompted to set up the database, click No.

3. The following message appears. Press OK.

4. In the first site, open the web.config file.

5. Copy the database connection information for your database, as indicated below.
<connectionStrings>
<!--FOR SQLSERVER-->
<add name="Ektron.DbConnection" providerName="System.Data.SqlClient"

connectionString="server=(local);database=CMS400Min;Integrated

Security=TRUE;user=;pwd=;" />

Note: Your informationmaybe different from the sample above.

In the second site, open the web.config file. Then, overwrite the database information with the

text you copied in Step 5.
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6. Copy the catalog information from the first site to the second. To do this, open the first

site’s web.config file, and copy the contents of the <providers> element (illustrated below).
<providers>
<add name="MSIndexServer" type="Ektron.Cms.WebSearch.SearchProviders.MSIndexProvider,

Ektron.Cms.WebSearch" catalogName="CMS400Min3152007121250Publish"

privateCatalogName="CMS400Min3152007121250Private" pageSize="10" description="MS Index

Server Provider"/>
<add name="MSIndexDialectServer"

type="Ektron.Cms.WebSearch.SearchProviders.MSIndexDialectProvider, Ektron.Cms.WebSearch"

catalogName="CMS400Min3152007121250Publish"

privateCatalogName="CMS400Min3152007121250Private" pageSize="10" description="MS Index

Server Dialect2 Provider"/>
</providers>

Note: The catalog namesare examples. You catalog namesmaybe different.

7. In the second site, open the web.config file. Then, overwrite the <providers> information

with the text you copied in Step 7.

8. Open the folder that contains the first site. Copy the AssetManagement.config file.

9. Open the folder that contains the second site. Overwrite the AssetManagement.config file

in that folder with the file you copied in Step 9.

10. Set up the virtual directories. To do that, follow these steps.

- In IIS, open the second Web site you created in Steps 2 and 3

- Delete the Assets folder

- Create a new virtual directory named Assets
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- When prompted to specify a path to the new Assets folder, navigate to the first site’s

Assets folder

- When you finish setting up the virtual folder to Assets directory, set up virtual

directories in the same manner for the following directories: PrivateAssets, uploaded

files, and uploaded images. Remember to delete the folder in the second site before

creating the virtual directory.

- Make sure that none of the folders is set up as an application. To do that, open IIS,

right click each folder and select properties. On the Directory tab, the Application

name field should be grayed out, as shown below.
:
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Searching for Metadata

Note: You can use the SEOControl to identify how search enginesevaluate your Web pages’metadata tags, and

other search tools. See Also: "Using the Search EngineOptimization (SEO) Control" on page 21-515

n Searchable type metadata values are returned like regular content. See Also:

n It can take up to 30 minutes for newly-added metadata to be available to the search.

n Searchable metadata field names must not include a space. If they do, the search cannot

find the metadata.

n To find content with searchable metadata whose style is yes or no, enter true or false.

Installing the Visio IFilter
The search finds text within Visio documents if the Visio IFilter has been installed to the

Ektron CMS400.NET server. Use the following links to download the Visio IFilter.

Visio

Version
Link

2003

http://www.microsoft.com/downloads/

details.aspx?FamilyID=dcee9e09-448b-4386-

b901-efea29cac808&DisplayLang=en

2002
http://www.microsoft.com/technet/

prodtechnol/Visio/visio2002/deploy/ifilter.mspx

Query Language
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To search for any word or phrase on a Web site, enter the word or phrase into the Search field

and click the button to begin the search.

This section covers the following topics.

n "Rules for Formulating Queries" on page 9-53

n "Boolean and Proximity Operators" on page 9-54 - increase accuracy of searches by

inserting Boolean and proximity operators

n "Localized Symbols and Keywords" on page 9-56 - explains which keywords are

supported in foreign languages

n "Wildcards" on page 9-56 - find pages with words similar to your search term

n "Free-Text Queries" on page 9-56 - create a query based on a phrase’s meaning as opposed

to exact wording

n "Vector Space Queries" on page 9-57 - find pages that match a list of words and phrases

n "Property Value Queries" on page 9-57 - query a file’s properties

n "Query Examples" on page 9-62 - examples of various queries

Rules for Formulating Queries
When a search is executed, it returns a list of Web pages that contain the word or phrase that a

user entered, regardless of where it appears in text.

Follow these rules when formulating queries.

n Multiple words are treated as individual search terms. So, the term calendar server returns

pages that have both words.

To find pages that have calendar and server in that exact order, use quotes. “calendar server”

returns pages that include both terms in that exact order with no intervening words.

n Queries are case-insensitive. You can type a query in upper or lower case.

n The search ignores words in the noise files. Ektron CMS400.NET’s noise files screen from

the search every single letter of the alphabet as well as many common words, such as

about, after, all, and also. Avoid entering such words into the Search Text field, because

the search ignores them.

The list of noise words (noise.enu) is installed to your siteroot/Workarea and Windows/System

32 folders. You can open a noise file with a simple word processor program, such as Notepad,
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to view the noise words. You can also edit the files. For example, you can remove words that

users should be able to search on.

To make a word in the noise files searchable, remove it from both files then restart both cat-

alogs. See Also:

Exceptions:

- In the Ektron CMS400.NET Workarea, the Advanced Search disregards the noise file.

- You cannot make the indexing service operators (and, or, but) searchable.

n Words in the noise file are treated as placeholders in phrase and proximity queries. For

example, if you search for “Word for Windows”, the results could return “Word for

Windows” and “Word and Windows”, because “for” is in the exception list.

n Punctuation marks, such as period (.) and comma (,), are ignored by a search.

n To use special characters, such as &, |, ^, #, @, $, (,), in a query, enclose the query in

quotation marks (“).

n To search for a word or phrase containing quotation marks, surround the entire phrase with

quotation marks and double the quotation marks around the word to be surrounded with

quotes. For example, “World-Wide Web or ““Web””” searches for World-Wide Web or

“Web”.

n Use Boolean operators (AND, OR) and the proximity operator (NEAR) to specify

additional search criteria. See Also: "Boolean and Proximity Operators" on page 9-54

n Use the wildcard character (*) to find words with a given prefix. For example, the query

esc* finds Web pages with “ESC,” “escape,” and so on. See Also: "Wildcards" on page 9-

56

n You can specify free-text queries without regard to query syntax. See Also: "Free-Text

Queries" on page 9-56

n Vector space queries can be specified. See Also: "Vector Space Queries" on page 9-57

n You can search on ActiveX™ (OLE) and file attribute property values. See Also: "Property

Value Queries" on page 9-57

Boolean and Proximity Operators
Use boolean and proximity operators to create a more precise query.

To

Search

for

Example Results

Both terms

on a page

healthcare

insurance
Pageswith words “healthcare” and “insurance”

WebSite Navigation Aids

9-54
ReferenceManual

Version 8.0 Rev 1.3



To

Search

for

Example Results

Either term

on a page

kidneyor renal

—Or—

kidney | renal#

Pageswith “kidney” or “renal”

All pages

that match

a property

value

@CMSsize >

1000
Pagesgreater than 1000 kilobytes

Both terms

on a page,

close

together

treatment near

immunoglobulin

—Or—

treatment ~

immunoglobulin

Pageswith the word “treatment” near the word

“immunoglobulin” See Also: "The NEAR operator is like the

AND operator because it findspages that include both search

words." on page 9-55

Tips

n To nest expressions within a query, add parentheses. Expressions within parentheses are

evaluated before the rest of the query.

n Use double quotes (“) to ignore a Boolean or NEAR operator keyword. For example,

“Abbott and Costello” finds pages with the entire phrase, not pages that match the

Boolean expression. In addition to being an operator, the word “and” is a noise word in

English.

n The NEAR operator is like the AND operator because it finds pages that include both

search words.

However, the rank assigned by NEAR depends on the proximity of the search words. A page

with the searched-for words closer together has a higher rank than a page where they are

farther apart. If the search words are more than 50 words apart, the page is assigned a rank of

zero.

Note: TheNEAR operator can be applied only to wordsor phrases.

n The AND operator has a higher precedence than OR. For example, the first three queries

are equal, but the fourth is not:

- a AND b OR c

- c OR a AND b

- c OR (a AND b)

- (c OR a) AND b
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Localized Symbols and Keywords
The symbols (&, |,!, ~) and the English keywords AND, OR, and NEAR work the same in all

languages supported by Ektron CMS400.NET. Localized keywords are also available when the

browser locale is set to one of the following languages.

Language Keywords

German UND, ODER, NICHT, NAH

French ET, OU, SANS, PRES

Spanish Y, O, NO, CERCA

Dutch EN, OF, NIET, NABIJ

Swedish OCH, ELLER, INTE, NÄRA

Italian E, O, NO, VICINO

Wildcards
Wildcard operators find pages that contain words similar to a given word.

To Search For Example Results

Wordswith the

same beginning

letters

pharm*
Pageswith words that have the prefixpharm, such as

pharmaceutical, pharmacist, and pharmacology.

Wordsbased on

any form of a verb
fly**

Pageswith any form of a verb. For example, if you enter fly,

the search returnspages that contain flying, flown, flies,

and flew.

Free-Text Queries
A free-text query finds pages that match the meaning, not the exact wording, of submitted

words and phrases. Begin free-text queries with $contents.

You cannot use boolean, proximity, or wildcard operators in a free-text query.
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To Search For Example Results

Files that match

free-text

$contents how do I print in

Microsoft Excel?

Pages that mention printing and

Microsoft Excel

Vector Space Queries
The search supports vector space queries, which return pages that include a list of words and

phrases. Each page is ranked according to how well it matches the query.

To Search for Example Results

Pages that contain

specificwords
light, bulb Fileswith words that best match the search words

Pages that contain

weighted prefixes,

words, and phrases

invent*,

light[50],

bulb[10], “light

bulb”[400]

Files that contain wordsprefixed by “invent,” the

words “light,” “bulb,” and the phrase “light bulb”

(the termsare weighted)

Tips

n Separate terms in a vector query with commas (,)

n You can weight terms in vector queries by using the [weight] syntax (see example above)

n Pages found by vector queries do not necessarily match all words submitted in the query

n Vector queries work best when results are sorted by rank

Property Value Queries
Use a property value query to find files whose property values match a given criteria.

Properties you can query include file information (like file name and size), and ActiveX

properties, including the document summary stored in files created by ActiveX-aware

applications.

There are two types of property queries.

n Relational property queries - consist of an “at” character (@), a property name, a

relational operator, and a property value. For example, to find all files larger than one

million kilobytes, use @CMSsize > 1000000. See Also: "Relational Operators" on page 9-59
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n Regular expression property queries - consist of a number sign (#), a property name, and

a regular expression for the property value. For example, to find all .avi files, use #filename

*.avi. See Also: "Regular Expressions" on page 9-61

Regular expressions do not match the contents (#contents) and all (#all) properties.

In regular expression property queries, you can only use properties that are retrievable at query

time. Properties that are not retrievable include HTML META properties not stored in the prop-

erty cache.

Property Names
Property names are preceded by the “at” sign (@) for relational queries, and the pound sign (#)

for regular expression queries.

If no property name is specified, @contents is assumed.

Properties available for all files are listed below.

Property

Name
Description

All Matcheswords, phrases, and anyproperty

Contents

Wordsand phrases in the file

Note: The contents property doesnot support relational operators. If a relational

operator is specified, no results are found. For example, @contents Ektron finds

documents containing Ektron, but @contents=Ektron findsnone.

Filename Name of the file

CMSsize File size

Write Date file was created or last modified (whichever is later)

You can also use ActiveX property values in queries. You can search for files created by most

ActiveX-aware applications by querying for the following properties.

Property Name Description

DocTitle Title of the document
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Property Name Description

DocSubject Subject of the document

DocAuthor The document’s author

DocKeywords Keywords for the document

DocComments Comments about the document

Relational Operators
Use relational operators to create relational property queries.

To Search for Example Results

Property values in relation to a fixed

value

@CMSsize <

100

@CMSsize <=

100

@CMSsize =

100

@CMSsize !=

100

@CMSsize >=

100

@CMSsize >

100

Fileswhose sizematches the

query

Property valueswith all of a set of bits

on

@attrib ^a

0x820

Compressed fileswith the archive

bit on

Property valueswith some of a set of

bits on

@attrib ^s

0x20
Fileswith the archive bit on

Property Values

To Search

for
Example Results

A specific

value
@DocAuthor = “Bill Bailey” Files authored byBill Bailey
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To Search

for
Example Results

Values

beginning with

a prefix

#DocAuthor George*
Fileswhose author property begins

with George

Files of any

extension
#filename *.gif

Fileswith a .gif extension

Note: Because Ektron CMS400.NET

storesall content in .txt files, you

cannot use this syntax to find fileswith

a .txt extension.

Filesmodified

after a certain

date

@write > 2006/02/14

Note: You cannot use the equal

operator (=) with@write. Only

greater than (>) and less than (<)

operatorswork.

Filesmodified after February 14, 2006

Vectors

matching a

vector

@vectorprop = { 10, 15, 20

}

ActiveX documentswith a vectorprop

value of {10, 15, 20}

Vectorswhere

each value

matchesa

criterion

@vectorprop >^a 15

ActiveX documentswith a vectorprop

value in which all values in the vector

are greater than 15

Vectorswhere

at least one

valuematches

a criterion

@vectorprop =^s 15
ActiveX documentswith a vectorprop

value in which at least one value is 15

Tips for Using Property Queries

n Use the pound (#) character before the property name when using a regular expression in a

property value.

Use the “at” (@) character otherwise. The equal (=) relational operator is assumed for regular-

expression queries.

n File name (#filename) is the only property that efficiently supports regular expressions with

wildcards to the left of text.

n Dates use the format yyyy/mm/dd.

You can omit the first two characters of the year. If you do, 29 or less is interpreted as the year

2000, and 30 or greater is interpreted as the year 1900. All dates are in Greenwich Mean Time

(GMT).
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n Currency values use the format x.y, where x is the whole value amount and y is the

fractional amount. There is no assumption about units.

n Boolean values are (t) or (true) for TRUE and (f) or (false) for FALSE.

n Vectors (VT_VECTOR) are expressed as an opening brace ({), a comma-separated list of

values, and a closing brace (}).

n Single-value expressions that are compared against vectors are expressed as a relational

operator, then a (^a) for all of or a (^s) for some of. See Also: "Relational Operators" on

page 9-59

n Numeric values can be expressed in decimal or hexadecimal (preceded by 0x).

Regular Expressions
Regular expressions in property queries are defined as follows.

n Any character except asterisk (*), period (.), question mark (?), and vertical bar (|) defaults

to matching itself.

n A regular expression can be enclosed in matching quotes (“). It must be enclosed in quotes

if it contains a space () or closing parenthesis ()).

n The characters *, ., and ? behave as in Windows. They match any number of characters,

match (.) or end of string, and match any one character, respectively.

n The character | is an escape character. After |, the following characters have special

meaning:

- (opens a group. Must be followed by a matching).

- ) closes a group. Must be preceded by a matching (.

- [opens a character class. Must be followed by a matching (un-escaped)].

- {opens a counted match. Must be followed by a matching}.

- } closes a counted match. Must be preceded by a matching {.

- , separates OR clauses.

- * matches zero or more occurrences of the preceding expression.

- ? matches zero or one occurrences of the preceding expression.

- + matches one or more occurrences of the preceding expression.

Anything else, including |, matches itself.

n Between square brackets ([]), the following characters have special meaning.

- ^ matches everything but following classes. Must be the first character.

- ] matches]. May only be preceded by ^. Otherwise, it closes the class.

- - range operator. Preceded and followed by normal characters.

Anything else matches itself (or begins or ends a range at itself).
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n Between curly braces ({}), the following syntax applies.

- |{m|} matches exactly m occurrences of the preceding expression. (0 < m < 256).

- |{m,|} matches at least m occurrences of the preceding expression. (1 < m < 256).

- |{m,n|} matches between m and n occurrences of the preceding expression, inclusive. (0

< m < 256, 0 < n < 256).

n To match *, ., and?, enclose them in brackets (for example, |[*]sample matches “*sample”).

Query Examples

Example Results

@CMSsize > 10000 Pages larger than 10MB

@write > 2003/05/12

Note: You cannot use the equal operator (=) with@

write. Only greater than (>) and less than (<) operators

work.

Pagesmodified after the date

pear tree Pageswith the phrase “pear tree”

“pear tree” Same asabove

@contents pear tree Same asabove

Ektron and@CMSsize > 10000
Pageswith the word “Ektron” that are

larger than 10 thousand kilobytes

“Ektron and@CMSsize > 10000"
Pageswith the phrase specified (not

the same asabove)

#filename *.avi

Video files (the # prefix is used

because the query contains a regular

expression)

@attrib ^s 32 Pageswith the archive attribute bit on

@docauthor = “John Stanton” Pageswith the given author

$contentswhy is the skyblue? Pages that match the query
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Search Troubleshooting

Problem Solutions

You publish content but

cannot find it using the search

1. Wait 5 or 10minutes (dependson the load on the server).

2. Make sure theMicrosoft indexing service is running (Computer

Management > Services and Applications > Indexing Service). Verify

that the Run button is grayed out. If the service is not running, start it.

3. Query the catalog using the new content’s ID. See "Querying the Catalog for

the Content" on page 9-66.

4. Make sure the EktronWindowsservice is running (Computer Management

> Services and Applications > Services > Ektron Windows Services

2.0). Verify that the Run button is grayed out.

If the service is not running, start it. If you do, it may take a while for the service to

prepare the content for indexing.

(Continued below)

You publish content but

cannot find it using the search

(continued)

1. Make sure the siteroot/Assets folder’sAdvanced Attributes screen’sFor

fast searching, allow Indexing Service to index this folder checkbox

is checked. To access this screen, click theAdvanced button on the sit-

eroot/Assets folder properties screen.
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Problem Solutions

2. Check the priority of the database table. See "Checking the Priority of the

Database Table" on page 9-67

Indexing service uses too

muchmemoryor resources.

Or, toomany instancesof

cidaemon.exe are running.

Check the number of catalogsbeing serviced. To do so, follow these steps.

1. Go toComputer Management > Services and Applications > Index-

ing Service.

2. You should see three Ektron CMS400.NET catalogs (Public, Private, and

Content), plusSystem andWeb. Ektron CMS400.NET doesnot use the

system andWeb catalogs, so unless your server uses them for another

purpose, delete them.

3. Delete anyother unused catalogs.

4. Restart theMicrosoft Indexing Service.

The catalog size is growing

too quickly, or is really huge

The indexing service generatesan abstract for each content item. See . Bydefault,

the abstract length is 320 characters.

To reduce the catalog size, reduce the abstract length. See

Catalog ismistakenly deleted

or corrupted
Recreate it. See
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Problem Solutions

The Inheritable Settings

checkboxesare not checked

Make sure the Inheritable Settings checkboxeson theGeneration tab of the

Properties dialog are checked.

1. Go toComputer Management > Services and Applications > Index-

ing Service.

2. Select the first of the three Ektron CMS400.NET catalogs (Public, Private,

and Content).

3. Right click themouse and selectProperties.

4. Click theGeneration tab.

5. Make sure the two checkboxesare checked (illustrated below).

6. Repeat for the other two catalogs.

Verify thatWindowscan find

files on your server

1. OpenWindowsExplorer.

2. Right click your C drive and selectSearch.

3. In theAll or part of the file name field, enter *.*.

4. The search should find all files on your computer.

If it doesnot, ask your system or network administrator to help you determine why

your Windowssearch is not working. For example, he should verify that you have

permission to search for files.

SearchConfigUI.exe crashes

while building search indexes

and catalogs

1. Make sure themetaconfig.doc file exists in the siteroot/uploadedfiles

directory.

If it doesnot, askEktron TechnicalSupport to send you a new file.

2. If anyone uploaded Visio documents to your server, make sure the iFilter is

installed. See "Query Language" on page 9-52.
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Problem Solutions

MS Indexing Service cannot

find files in the

siteroot/assets folder.

1. OpenWindowsExplorer.

2. Navigate to the siteroot/assets folder.

3. Select the folder and right click themouse.

4. SelectProperties.

5. Click theAdvanced button.

6. Check the boxnext to For faster searching, allow Indexing Service to

index this folder.

7. PressOK.

Get error message.

An unhandled exception

has occurred: The type

initializer for

Ektron.CMS.

WebSearch.Manager

threw an exception.0

During installation, the user might have canceled the database setup. Check the

following.

1. Check the site root folder for the following folders. If theydo not exist, create

them.

n PrivateAssets

n Assets

n UploadedFiles

n UploadedImages

2. Make sureMetaConfig.docexists in the [sitepath]\UploadedFiles

folder. If it doesnot, askEktron TechnicalSupport for a copyof that file from

the same Ektron CMS400.NET version.

3. Make sure noise.enu file exists in the [sitepath] folder. If it doesnot, look in

the [sitepath]\workarea folder. If noise.enu is there, copy it to the

[sitepath] folder. If you cannot find noise.enu, askEktron Technical

Support for a copyof that file from the same Ektron CMS400.NET version.

4. Check the following registry key: HKEY_LOCAL_
MACHINE\SYSTEM\CurrentControlSet\Control\ContentIndexCommon

. For that key, make sureDefaultColumnFile has the value
C:\WINDOWS\system32\FriendlyNamesDefinitionFile.txt.

If the entry doesnot exist, create it and set the value as listed above.

Querying the Catalog for the Content
To query the catalog for a content item, follow these steps

1. Go to Computer Management > Services and Applications > Indexing Service >

sitenamePublishedAsset > Query the Catalog.
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2. Choose Advanced Query.

3. Use the syntax @contentID64=IDnumber. For example, if the content ID is 30, enter

@contentID64=30.

4. The content should appear as shown above.

Checking the Priority of the Database Table
To check how your database is processing the documents, follow these steps.

1. Launch a database management tool, such as SQL Server Management Studio.
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2. Find the Ektron CMS400.NET database.

3. Open Tables > dbo.perform.action.

4. A list of content blocks being processed appears.

5. Make sure the action_priority for each item is less than -8. If that is the case, the database

will process the record.

If the priority is -8 and the action status is inAction, there is a problem with the service

that processes the document. To resolve the problem, you can

- go to Computer Management > System Tools > Error Log to find any errors and fix

them

- reset the action_priority value to zero (0) and the action status to PerformAction

- contact Ektron Support

Web Search Server Control
The Web Search server control lets you customize the behavior of the search. You place this

control on any Web form from which a site visitor can search your site. For more information

about the site visitor experience, see "Web Site Search" on page 9-5
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Property Usage Table
Properties in the Search server control generally affect the control in one of three ways:

n Search Display - the Web Search server control’s appearance on your site.

n Search Criteria - criteria used to search the site

n Search Results Display - appearance of search results on your site

The following table shows which properties are associated with each category. See Also:
"WebSearch Property Descriptions" on page 9-69

Search Display Search Criteria Search Results Display

ButtonImgSrc

ButtonText

DisableForumSearch

EnableAdvanced Link

Hide

Language

MaxCharacters

ShowSearchOptions

Text BoxSize

WrapTag

CustomSearch

FolderID

Language

Recursive

SearchFor

ShowCategories

ShowSearchOptions

ShowSuggested Results

CustomOrderBy

DynamicContentTemplate

DisplayXslt

Hide

Language

LinkTarget

MaxTeaserLength

OrderBy

OrderDirection

RemoveTeaserHtml

ResultsPageSize

ResultTagId

ShowCustomSummary

ShowSearchBoxAlways

WebSearch Property Descriptions
The following table describes the Web Search server control properties. See Also: "Property

Usage Table" on page 9-69

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.
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Property Description Data Type

Authenticated

Indicates if you are logged in to the CMS

Explorer. If logged in, you can browse to

the folder needed for the FolderID

property.

More information: "Using CMSExplorer to

Browse Your Ektron CMS400.NET Site"

on page 21-9

String

ButtonImgSrc
If you want to display an image on the

submit button, enter the server path to it.
String

ButtonText

The text used for the button if no image

source is identified. If an image source is

identified, this is alternative text for the

button.

String

CustomOrderBy

Provide a property’s FriendlyName

defined in the Indexing Service to sort

search results by that property. For

example, if you define DocAuthor, results

will be sorted by the document’s author.

Results can be ascending or descending

based on OrderDirection. If you enter an

invalid property, no search results are

returned.

If you specifyCustomOrderBy and

OrderBy, the OrderByproperty is ignored.

The FriendlyName of a property can be

found inComputer Management >

Services and Applications > Indexing

Service >Your Index >Properties >

Friendly Name column.

String

CustomSearch

If you want the search to include folders

that are not part of Ektron CMS400.NET,

enter the folder nameshere. Separate

multiple itemswith a comma.

You do not need to enter the folder path,

but it must reside within the site root folder.

More information: "Using the Integrated

Search" on page 9-42

String

DisableForumSearch

Set to true if you want to remove Forums

from the dropdown list that appears on the

Search server control (see image below).

The default value is false.

Boolean
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Property Description Data Type

Regardlessof this setting, if a user selectsSite (the first option in the dropdown), forum posts are

searched.

DisplayXslt

Determines the display of the search

results page.

None - databind only

ecmNavigation - lists the title of every

content item found by the search

ecmTeaser - lists the title and summaryof

every content item found by the search.

ecmUnOrderedList - sorts the list in no

particular order. Shows the title and

content summary.

Path to Custom Xslt - Enter the path to

an Xslt that determines the display of the

page.

Warning! Important!: If you specify an

external file, it is strongly recommended

that you do not store this file in your site's

Workarea folder. If you store this file in the

Workarea folder, the file will be lost when

you upgrade.

Warning! Important! If you enter a valid

EkML file at the MarkupLanguageprop-

erty, this property value is ignored.

More information: "Determining the Display

of Search Results" on page 9-80

ecmNavigation -"Example of

ecmNavigation Display" on page 9-124

ecmTeaser - "Example of ecmTeaser

Display" on page 9-124

String

DynamicContentTemplate

Sets the template for dynamic content. This

property overridesanyquicklink template

for the content.

String
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Property Description Data Type

EnableAdvancedLink

Set to true to display an additional tab

(Advanced) on the Search control.

More information:"The Advanced Search"

on page 9-21

Boolean

FolderID

The folder at which the search begins. The

starting folder need not be the root folder.

The Recursiveproperty determines if the

search examines this folder’s subfolders.

More information: "Using CMSExplorer to

Browse Your Ektron CMS400.NET Site"

on page 21-9

String

Hide

Used to hideWebSearch Server Control in

design time and runtime.

True =Hide control

False =Show control

Boolean

Language

If the template on which this server control

resides includesa language selection

control, and you want to let the site visitor

select the language, enter zero (0).

Otherwise, click the field, then the ellipsis

button ( and a popup boxappears.
Select a language from the list.

This property shows results in design-time

(in VisualStudio) and at run-time (in a

browser).

Integer
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Property Description Data Type

LinkTarget

Defineshow a link on the search results

display actswhen clicked. The choicesare:

_blank - loads the link in a new blank

window. Thiswindow is not named.

_self - loads the link in the samewindow

the anchor was clicked in. This is useful for

overriding a globally assigned base target.

_parent - loads the link in the immediate

frameset parent of the document. This

defaults to acting like “_self” if the document

hasno parent.

_top - loads the link in the full bodyof the

window. This defaults to acting like “_self” if

the document is alreadyat the top. It is

useful for breaking out of an arbitrarily deep

frame nesting.

String

MarkupLanguage

Identify the templatemarkup file that

controls the display of search results. For

example, mysearchmarkup.ekml.

If the *.ekml file is located in the same folder

as theWeb form containing the server

control, just enter its name. If the file is in

another folder, enter the path relative to

site root. For example,

\siteroot\workarea\customfiles

\markup\mysearchmarkup.ekml.

Note: If you enter a valid EkML file, the

Displayxsltproperty is ignored.

More information:

n "Determining the Display of Search

Results" on page 9-80

n "EktronMarkup Language" on page

21-414

n "websearch.ekml" on page 21-474

String

MaxCharacters

Themaximum number of characters the

Search text boxaccepts.

If you enter a value less than 50, set the

TextBoxSizeproperty to the same

number.

Integer
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Property Description Data Type

MaxTeaserLength

Limits the length of any returned content’s

abstract. To allow unlimited length, set to

zero.

This property is active only if both of these

conditionsare true.

n you use the DisplayXsltproperty

to identify an xslt and ecmteaserasa value

of that property.

If you enter an .ekml file at the Mark-

upLanguageproperty, this value is ignored.

n the ShowCustomSummaryproperty is

set to false. If it is set to true, the entire sum-

maryappears in search results.

Integer

OrderBy

The order of search results. For example,

you want to sort search results by last

modified date.

Title - The content title (alphabetical)

ID - The content ID number

Date Created - The date the content was

created

Date Modified - The date the content was

most recentlymodified

Editor - The user who last edited the

content (alphabetical)

Rank - The rankassigned to the content.

See Also: "Search Result Ranking" on

page 9-27

Note: TheOrder Direction field

determines the direction of the search

results. For example, if you sort by ID and

Order Direction is set toDescending,

the results sort byContentID number with

the highest number at the top of the list.

String

OrderDirection

The direction in which search results are

sorted. The default isAscending.

Ascending - Alphabetical results from A to

Z; numeric values low to high; dates from

oldest to most recent

Descending - Alphabetical results from Z

to A; numeric valueshigh to low; dates from

most recent to oldest

String
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Property Description Data Type

Recursive

Determineswhether to search sub-folders

of the starting folder. The starting folder is

identified in the FolderIDproperty.

More information: ”FolderID” on page 9-89

Boolean

RemoveTeaserHTML

Set to true if you want to remove HTML

tags from the content summarywhen it

appears in search results.

Boolean

ResultsPageSize

Use to set themaximum number of results

on a page. If a search returnsmore than

this number of results, the following text

appears below the last one:

Result Page: 1 2 3 Next

The user can clickNext or a number to

view additional results.

This property defaults to the value set at the

ek_PageSize element in the

web.config file.

Property’s Effect on Suggested

Results

Only the number of Suggested Results up

to thismaximum appear. If more than this

number should display, theydo not.

This is unlike natural search results, whose

additional links are available via numbers

below themaximum page size.

More information: "Suggested Results" on

page 9-31

Integer

ResultTagId

Lets you designate where search results

appear. You can place search criteria in

one area of aWeb form and the results in

another.

For example, you have the following tag.

<span id=”results”></span>

In this case, enter results for this property

value.

More information: ”ResultTagId” on page

9-97

String
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Property Description Data Type

SearchFor

Choose the type of content to search.

n All

n HTML

n Documents

n Images

n Multimedia

n Discussion Forums

n Tags

n Products

If the value is anything other thanAll, this

server control only looks though the

selected content type.

Warning! Important: When this prop-

erty is set to anything other thanAll, the

search optionsdrop down doesnot

appear.

.

String

SearchSynonyms

If set to true, the SynonymSearch is

incorporated into the search logic.

If false, SynonymSets are ignored.

More information: "SynonymSets" on page

9-28

Boolean

ShowCategories

If set to true, when this server control

appears, the user see a Filter by

Category option. This option helpsa site

visitor zero in on relevant content.

If false, the Filter by Category option

doesnot appear.

Note: To see the Filter by Category

option, the ShowSearchBoxAlways

propertymust be set to true.

More information: "Filtering Search Results

byCategory" on page 9-81

Boolean
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Property Description Data Type

ShowCustomSummary

If set to true, the search results display the

content item’s summary instead of the

characterization.

Note: If this property is set to true, the

MaxTeaserLengthproperty is ignored. So,

the entire summaryappearswith search

results, regardlessof length.

If false, the search results display the

characterization.

The default is false.

More information: "Display of Search

Results" on page 9-24

Boolean

ShowSearchBoxAlways

If set to true, the search boxappears on

the PostBack screen.

If false, the search boxdoesnot appear on

the PostBack screen.

The default is true.

Boolean

ShowSearchOptions

If set to true, the following dropdown

optionsappear to the right of the Search

box.

A site visitor can click an option to limit the

search by content type. If the user accepts

the default value,Site, all content typesare

searched.

Warning! Important: If the SearchFor

property is set to anything other thanAll,

the search optionsdrop down doesnot

appear.See Also: "SearchFor" on

page 9-76

Note: If the DisableForumSearch

property is set to true, Forums doesnot

appear in the dropdown list.

Boolean
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Property Description Data Type

ShowSuggestedResults

If set to true, Suggested Results related to

the search term appear.

If false, Suggested Results do not appear.

Note: If the ResultsPageSizeproperty is

set it to less than the number of suggested

results applied to a term or synonym set,

only the property’s number of results

appears. For example, if you assign five

links to a Suggested Result set but set

ResultsPageSize to three, only the first

three results appear.

More information: "Suggested Results" on

page 9-31

Boolean

Stylesheet

Specify the location of a style sheet to use

for the search results page. Set the location

relative to the site root folder. For example:

Workarea\csslib\mytest.css

Leave blank to use the default style sheet,

\

webroot

\Workarea\csslib\search.css.

Warning! Important! If you enter a valid

EkML file at the MarkupLanguageprop-

erty, or a value at the DisplayXsltprop-

erty, this property is ignored.

More information: "Determining the Display

of Search Results" on page 9-80

String

SuppressWrapperTags

Suppresses the output of span/div tags

around the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean
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Property Description Data Type

TaxonomyOperator

Select whether to use anAnd orOr

operator when filtering results by

taxonomy. Bydefault, the property is set to

Or. This allows for a wider range of

returned results.

And - Only results that match all categories

selected in the Filter byCategory tree

appear. For example, if you are searching

for amedical document in the Hospital and

Doctor’sOffice categories, the document

must be assigned to both categories or it is

not shown.

Or - whenmore than one category is

selected in the Filter byCategory tree,

resultsmust match at least one category to

be shown.

Note: For this property to be active, the

ShowCategoriespropertymust be set to

True.

More information: "Filtering Search Results

byCategory" on page 9-81

Enum -

TaxCategoryOperator

TextBoxSize

The size of theSearch text box for user

input. The width is based on the number of

characters.

Integer

WrapTag

Use to specify a server control’s tag. The

default isSpan.

Span - designatesan in-line portion of an

HTML document asa span element.

Div - use when you want to apply attributes

to a blockof code.

Custom - use a custom tag.

String

ResultTagId
The ResultTagId property lets you designate where search results appear. So, you can place

search criteria in one area of a Web form and the results in another.

For example, you have the following tag.

<span id=”results”></span>

You would enter results for the property value, as shown below.

WebSearch Server Control

ReferenceManual

Version 8.0 Rev 1.3
9-79



(continued in Displaying WebSearch Results on a Separate Page)

Determining the Display of Search
Results
You have three options for determining the display of the search results.

Order of

Precedence
Option

Control

over

Styling

Control

over

Element

Placement

Difficulty

Level for

Novices

More

Information

1
websearch.ekml

file
limited excellent low

"websearch.ekml"

on page 21-474

2 XSLT excellent excellent high
"DisplayXslt" on

page 9-71

3 Style Sheet excellent not available medium

"Using a Style

Sheet" on page 9-

80

You can only use one option to determine the search results display. The options appear in the

table above in order of precedence.

That is, if an .ekml file is defined, the other two properties are ignored. If no .ekml file is

defined, then an XSLT can determine the display. Finally, if neither an ekml file nor a display

xslt is defined, a style sheet is used. If you do not specify a style sheet in the Stylesheet

property, the default one is used (siteroot\Workarea\csslib\search.css).

Using a Style Sheet
Style Sheets let you customize visual elements such as color, alignment, font, and size. Ektron

CMS400.NET’s search results style sheet has been carefully crafted to give you precise control
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of even the smallest elements of the page. For more information on working with style sheets,

visit http://www.w3.org/Style/CSS/.

You can create your own style sheet or modify the default one,
siteroot\Workarea\csslib\search.css.

Best Practice

Ektron recommendscopying and renaming the default style sheet. Then, enter the

new one into theWeb Search server control’sStylesheetproperty. This insures

you alwayshave a clean file to start with and gives you something to reference if you

are not getting expected results.

The style sheet must reside underneath the site root.

You can only define one Search style sheet for each Web page. If you place more than one

Web Search server control on a page, they share a style sheet.

Filtering Search Results by Category
The Filter by Category feature helps a site visitor zero in on relevant content.

As explained in ”Taxonomy” on page 9-253, the Taxonomy Feature lets users assign

information categories to content. For example, if your organization is a university, taxonomy

categories might be Athletics, Alumni, Admissions, Academic Departments, etc.

As new content is created, users should apply relevant taxonomy categories to it. This makes it

easier to find content on your site, because a site visitor can search by category along with

search terms. For example, if the search term is calendar, and the category is Athletics, the

search would typically return calendars of the sports teams but not other calendars, such as

those for graduation, exams, or parents weekend.

To let users filter search results by category, set the ShowCategories property to true. (The

ShowSearchBoxAlways property must also be true.)

TIP!

Note: This additional search criterion dependson the assignment of taxonomycategories to your content. If they

are not, the filter hides relevant but unclassified content. For example, someone authorsan article on “Treating

Heart Disease” but doesn't assign a taxonomycategory to it. If a site visitor on the search page selectsFilter by

Category then theMedical Forum>Heart Disease category, he will not find that article.

As a developer, you can control whether the results must match all categories selected in the

Filter by Category tree or match at least one category. To display results that must match all

categories, set the TaxonomyOperator property to And. To show results that match one or more
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categories, set TaxonomyOperator to Or. By default, the property is set to Or. This allows for a

wider range of returned results.

Effect of Setting ShowCategories to True
If you set the ShowCategories property to true, initially the site visitor sees no difference.

However, if he enters a search term that exists in content to which a taxonomy category is

assigned and clicks the Search button, he sees Filter by Category above the results (illustrated

below).

Note: If no categoriesare assigned to the content in the search results, the Filter by Category link doesnot

appear.

If he clicks Filter by Category, the visitor sees all taxonomies with at least one content item

that contains the search term. He can then select categories from the taxonomies. If he does, the

results refresh, and only content that contains the search term and is assigned to the selected

categories appears.

If a visitor selects more than one category, the TaxonomyOperator property determines which

content appears.

TaxonomyOperator

property value
This content appears in search results

and content assigned to all selected categories

or content assigned to any selected category

Note: If the visitor selects a parent category, all of its child categoriesare selected bydefault.
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In the sample below, the site has 15 content items with the word treatment that are assigned

to the Medical Forum taxonomy.

If the user drills down to the Treatment category, only one content item is found.

If a site visitor performs any of the following actions, all taxonomy category selections are

cleared, and a new search is performed.

n clicks the Search button

n presses <Enter>

n uses the document type dropdown (site, multimedia, images, etc.)

n performs an Advanced Search
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On the other hand, if a site visitor closes folders in the taxonomy structure, all selected

categories remain selected.

Using Ektron’s Search APIs
Ektron Provides two separate APIs for search. One is based on the “Web Search” architecture.

The other is based on Ektron’s previous “Search’ architecture.

n "Using the Web Search API" on page 9-84

n "Using the Search API" on page 9-85

Using the Web Search API
Ektron CMS400.NET provides an API that lets you create a programmatic Web Search.

To see an example of the search API, go to the Developer Starter Site’s developer page

(http://[your Web server]/cms400Developer/Developer/default.aspx) and click Search > Search

API. In this section there are several examples of using the Web Search API for programmatic

searches.
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Note that below each example on the page is run this example. Click this link to run the

search and view the results.

If you do not have the Developer Starter site installed, you can download it from:

http://www.ektron.com/products.aspx?id=5948

The Developer site is located in the Example site section.

Using the Search API

Warning! ThisSearch API is deprecated asof the 7.0 Release. For optimal performance, Ektron recommends

using Ektron’sWeb Search API. See "Using theWeb Search API" on page 9-84.

Note: The ProgrammaticSearch API doesnot support recursive searches. However, using code behind you can

use the Search server control to programmatically search recursively.See Also: "Web Search Server Control"

on page 9-68

Ektron CMS400.NET provides an API that lets you create a programmatic search on users and

content. For example, you could use it to find all membership users whose zip code is 03031.

Guidelines for Creating a Search
Here are guidelines to follow when creating a search.

1. A search consists of one or more conditions. Each condition consists of an operator (and,

OR, Like), a value, and the field whose value you are setting. See illustration below.

Dim isMemberShip As UserSearchCondition = New UserSearchCondition ’’’Condition
isMemberShip.setType = SearchType.Equal ’’’Operater
isMemberShip.setValue = 1 ’’’Value. The value can be integer,string,date and boolean

should be match with db type
isMemberShip.setVariable = Users.membership_user ’’’Field
Dim isInEktron As UserSearchCondition = New UserSearchCondition ’’’Condition
isInEktron.setType = SearchType.Equal ’’’Operater
isInEktron.setValue = "03031" ’’’Value. The value can be integer,string,date and boolean

should be match with dynamic_data_tbl labels type
isInEktron.setVariable = "customproperties.zip" ’’’Condition

Warning! If the field is a date, you can only use the following operators: EQUAL, NOT EQUAL, GREATERTHAN

or LESSTHAN.

2. After all conditions are declared, declare the logical relationship between them. In other

words, must the search criteria satisfy all or any conditions?

In the sample code below, the search only returns users that satisfy both declared

conditions. This is indicated by the AND operator.
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Dim condition As UserSearchCondition = New UserSearchCondition
condition.setType = SearchType.AND
condition.AddCondition(isInEktron)
condition.AddCondition(isMemberShip)

3. Execute the search.

Dim search As New SearchManager
Dim result As UserData() = search.Execute(condition)
search = Nothing
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Searching the Workarea
You can search any folder to quickly locate content within Ektron CMS400.NET. The

following sections explains how to use the content search through the following subtopics.

n Accessing the Search Content Folder Screen

n "The Search Published Tab" on page 9-87

n "The Advanced Search Tab" on page 9-90

n "Result Display Options" on page 9-96

n "Information on the Advanced Search Results Screen" on page 9-97

(continued in Accessing the Search Content Folder Screen)

The Search Published Tab
The Search Published tab within the Workarea finds content that satisfies these criteria.

n status is published

n active (archived content is ignored; however, the Advanced Search finds archived content.

See "The Advanced Search Tab" on page 9-90)

n you have read-only or greater permission for the content’s folder

n content is public. However, private content is available to those with permission to view

it, such as membership users after logging in. See Also: "Private Content" on page 7-191

n matches selected language, if site is multilingual. See Also: Multi-Language Support

n the content’s Content Searchable check box is checked

n is not a non-image file added to the library. Images are searchable, while other files added

to the library are not. So, to make files searchable, add them as assets, not library files.

n content resides in the folder you selected before launching the search or one of its

subfolders. To search the entire Web site, begin the search at the root folder.

n satisfies text and/or query entered in the search box (no value returns nothing). The text

inserted in the search field can appear in the content, summary, or metadata. See Also:

"Query Language" on page 9-52

n satisfies content type criterion, if chosen (see below). These are described in "Search

Screen Options" on page 9-88.
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Search Screen Options

Search ScreenOption Finds submitted text in these content types

Site Content from all options listed below.

HTML

n HTML

n Smart Form (XML)

Note: Finds field valuesbut not field labels. This hasnot changed

since prior releases.

n HTML Form

n Blog entries (not comments)

Documents

n MSOffice document (includesPowerpoint, Excel)

Note: The search finds text within Visio documents if the Visio IFilter

hasbeen installed on the server. See "Installing the Visio IFilter" on

page 9-52.

n PDF file

n .txt file

Imagesadded asassets or

through the library
.gif, .jpeg, etc.

MultiMedia Flash, .mp3, etc.

Forums Forum posts and topics
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Note: The search cannot find calendar events.

Searching for Metadata

n Searchable type metadata values are returned like regular content.

n It can take up to 30 minutes for newly-added metadata to be available to the search.

n Searchable metadata field names must not include a space. If they do, the search cannot

find the metadata.

n To find content with searchable metadata whose style is yes or no, enter true or false.

Display of Published Search Results

Below is an example of the Search Published results screen.

As you can see, content on the search results screen begins with the title and last edited

date/time. Following them is either an abstract or the summary of the content. This is

determined by your web developer in the Web Search server control.

Following the abstract is additional information, such as content ID number, size, last author,

etc.
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Search Result Ranking
Each content item found by a catalog search is given a numerical rank between 0 and 1000.

Search results can be sorted by rank.

Criteria used to calculate rank include the

n number of occurrences of the search term

n proximity of search term to beginning of file

n proximity of search term to other occurrences of the term

n whether the term is in the title

The Advanced Search Tab
The Advanced Search within the Workarea finds content that satisfies these criteria.

Warning! The Advanced search finds content whether or not it ismarked Searchable.

n user must have read-only or greater permission for content’s folder

n matches selected language, if site is multilingual

n satisfies criteria entered on the screen (see below)
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The Advanced Search Tab helps you find Ektron CMS400.NET content by specifying the

following criteria. All fields are optional. However, the search only finds content that satisfies

all criteria.

n the kind of content you want to search (for example, HTML content, forms, assets)

n a search word or words. Unlike the Search Published tab, you cannot use a query.

n how the search words must match the content in order for a document to be found

n whether the title is searched

n whether the comments are searched

n a range of created or modified dates

n the editor who updated the content most recently

n the content’s status

n any searchable metadata assigned to the folder

See Also:

n "Using the Advanced Search" on page 9-91

n "Specifying the Kind of Content to Search" on page 9-92

n "Specifying a Search Word or Phrase" on page 9-92

n "The Noise File" on page 9-93

n "Specifying Match Criteria" on page 9-93

n "Additional Search Criteria" on page 9-95

n "Custom Fields" on page 9-96

Each feature is explained below.

Note: To help track search activity, the Search Phrase Report providesa count of all wordsand phrases

searchedwithin a date range. In Ektron CMS400.NET, this report is available from the Smart Desktop >

Reports. See Also: "Search Phrase Report" on page 7-724

Using the Advanced Search
When performing a search, enter one or more words into the text box, select search preferences,

then click the Search button.

You can use an asterisk as a wildcard character, in other words, to stand for any character. For

example, the phrase CMS*00 returns topics that include the following text: CMS400,

CMS300, CMS200 and CMS100.
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Your system administrator can add custom search fields that only appear if a user is logged in.

For more information, see "Working with Metadata" on page 7-146.

Specifying the Kind of Content to Search
Near the top of the screen, check boxes let you determine the kinds of content to search.

Note: Assets only appears if your organization has implemented Ektron’sDocumentManagement feature.

Check

this

box

To search

Content HTML content, blogsentries, and XMLSmart Form field values

Forms HTML forms

Assets
Content that is neither HTML nor XML, such asOffice documents andmanaged

files. See Also: "Using the Document Management System" on page 7-408

Include

Archived

Content, formsand assets that have been archived. See Also: "Setting Archive

Options" on page 7-198

Specifying a Search Word or Phrase
In the Search Text field, enter one or more words that you want to find within content, forms,

and assets. The search returns content that includes these words.

Entering text here is optional. That is, you can use fields on the lower portion of the screen to

find content without entering words contained in the content. For example, you can find every

piece of HTML content that was modified by a certain user within the last 30 days.

If you check off HTML and Form content, you can enter no search criteria and get a list of all

HTML and Form content on your site. However, if you enter search text, the search only finds

items that include the search text and satisfy other criteria on the screen.
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The Noise File
Ektron CMS400.NET has a noise file that screens from the search every single letter of the

alphabet as well as common words. Examples of common words are about, after, all, and also.

Avoid entering such words into the Search Text field, because the search ignores them.

For information on managing the noise files, see "Rules for Formulating Queries" on page 9-53.

Specifying Match Criteria

Note: This field is only applicable if you entered one or more words in the Search Text field.

From this dropdown list, select criteria for how the search word or words must appear within

the content of the files being searched.

Your choices are described below.

Choice A search returns content that has
For more information,

see

All the words allwords in the search field "All theWords" on page 9-94

Anyof the

words
anyword in the search field

"Anyof theWords" on page

9-94

Exact Phrase
allwords in the order specified in the search

field
"Exact Phrase" on page 9-94

Content ID the submitted ID number "Content ID" on page 9-94

Match Criteria Examples
The examples below assume you entered these words into the Search Text field.
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n partners

n content

n Monday

n employee

n green

All the Words
All Words is an “and” function. The search returns only content that has the words partners

and content and Monday and employee and green. The words can be in any order within the

file.

Any of the Words
Any Word is almost the opposite of All of the Words. It is an “or” function.

When you select this option, the search returns all files that have at least one of the words

entered in the search text field. In other words, it returns files with the word partners or content

or Monday or employee or green.

Exact Phrase
Exact Phrase returns content that have all five words in the order specified in the search text

field.

A better example would be to search for a phrase, such as Content Management Solution. The

search yields only content with that exact phrase.

Content ID
You can find content by its ID number. To do so, select Content ID from the drop down box

below the Search Text field. Then, enter the ID number in the Search Text field and click

Search.
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Additional Search Criteria
The next section of the Advanced Search Tab lets you choose one or more customized search

criteria. Note that if you enter more than one criterion, only content satisfying all criteria

appears on the search results screen.

Fields that Apply to Content, Forms and Assets

Search

criterion
Description

Title

The title of the content. You can enter a partialword. For example, entering Part

yields the following results.

n Multi-HospitalNurse Executive Participation

n Ektron Partners and Customers

You can enter more than one word or phrase as long as theyare in the correct

sequence.

Comments The content’s comments, which can be inserted via theComment tab.

Date

Created

The file’s creation date. You can enter a single date or a range of dates.

The search returnsall content with that creation date that satisfy the other criteria.

Date

Modified

The last date when the file wasmodified. You can enter a single date or a range of

dates.

The search returnsall itemswith that edit date that satisfy the other criteria.
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Search

criterion
Description

Last

Editor’s

Last Name

The last name (surname) of the user whomost recently changed the content.

This is taken from the Last Name field on the User Information screen.

The search returnsall items last edited by that user that satisfy the other criteria.

Status

The content status. See Also: "Content Statuses" on page 7-133

Note: Although you can search for content byany status, the search results

display only themost recently published version. If a version hasnever been

approved, nothing appears.

Custom Fields
Custom fields are defined by your system administrator and applied to content by its author or

editor. They are custom-defined, so would be different for every site.

The custom search fields appear below the Status field.

Result Display Options
At the top of the Advanced Search Tab, a pull-down list lets you choose the how to display

the search results.

WebSite Navigation Aids

9-96
ReferenceManual

Version 8.0 Rev 1.3



View

option
Description Example

Graphical

If the item is content or a form, display a

thumbnail of it.

If the item is an asset, display a generic icon

that indicatesasset type.

In both cases, to the right are the item’s

n title

n summary

n last edited user, date and time

You can click the title to display the item inside

the View Contents screen. From there, you

can perform all available functionson the item.

Note: Graphical search results require the

Internet Explorer browser, version 6 or

greater.

Sample HTML content

Sample Microsoft Word

document

Text

Display item’s title in the left column. To the

right, display the

n last edit date/time

n folder name

n size (assets only)

n DMS rank (assets only)

n language

n status

Information on the Advanced Search
Results Screen
The following column headers describe the information displayed for all content items that

satisfy the search criteria.
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Column

Header
Description

Content

Title
The title of the content item

Last Edit

Date

Themost recent date on which content wasedited. If it wasnever edited, its

creation date.

Folder

name
The folder that contains the content

Size The size of the content item in kilobytes

DMS

Rank

An indication of how well a content item pagematches the search criteria, using a

range of 0 to 1000. The higher the rank, themore relevant content is to the search

criteria.

Language
The locale id value of the content’s language.

Status
A one-character abbreviation of the content item’s status. See Also: "Content

Statuses" on page 7-133

Note: If you install Ektron CMS400.NET then later select a different database to search, youmust run

C:\Program Files\ Ektron\releasenumber\utilities\software\searchconfig\SearchConfig.exe

against the new database. This program gets all required data from the new database.
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Working with Collections

A collection is a list of content links offered to readers of a Web page. The following

illustration shows a collection on a Web page.

You can also use a collection to display listings such as job postings, press releases, and

knowledge base articles. The following graphic illustrates a collection on the landing page of

Ektron’s Knowledge Base.

This section explains how to create collections. Your system administrator then creates or

updates a Web page to display the collections using the Collection server control.

This section explains how to find, create, and manage collections through the following

subtopics.

n "Finding Collections" on page 9-100

n "Viewing a Collection" on page 9-102

n "Creating a Collection" on page 9-104

n "Editing Content in a Collection" on page 9-110

n "Reordering Collections List" on page 9-111

n "Editing Collection Information" on page 9-112

n "Deleting a Collection" on page 9-112

n "Working with Collections in a Multi-Language System" on page 9-113

n "Collection Permissions" on page 9-114

n "Setting up Approval for Collections" on page 9-116
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n "Collection Server Control" on page 9-118

Finding Collections
Every collection is assigned to a folder. To find the collections assigned to any folder, navigate

to the folder and click the folder. Next, Click View> Collection menu.

For more information, see "Finding a Collection by Navigating to its Content Folder" on page

9-100.

Since collections can be assigned to any content folder, the Content Tab provides a central

Collections folder, which displays all collections, regardless of their content folder. For more

information, see "Finding a Collection Using the Collections Tab" on page 9-101.

Finding a Collection by Navigating to its Content
Folder

To access collections for a content folder, follow these steps.

1. Click the content folder that contains the collection.

2. If you are using Ektron CMS400.NET’s multi-language support features, select the

language by clicking View > Language. See Also:

3. Click View > Collection.

4. The View Collections screen appears.
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The screen displays each collection created for the folder. The following table explains each

column.

Column Description

Title The title assigned to the collection by the creator.

ID

The ID assigned to the collection byEktron CMS400.NET. This

number is used to store and retrieve the data to/from the

database.

DateModified When the collection was last edited.

URL The default template used to display the content.

To learn more about a collection and perform tasks on it, proceed to .

Finding a Collection Using the Collections Tab

To view all collections in all content folders, follow these steps.

1. From the Workarea, click the Content menu tab.

2. In the lower left, click the Collections tab.

3. The Collections screen appears.
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Note: The ek_PageSize setting in the web.config file determines themaximum number of collections that appear

on a page before it “breaks.” When a page breaks, additional collectionsappear on another screen, and the

following appearsat the bottom of the list:

Page 1 of 2[First Page] [Previous Page] [Next Page] [Last Page]

Note: If you have a large number of collections, use the Search box to help find one.

4. The screen has four columns, described below.

Column

Title
Description

Title Title given to collection byuser who created, or last edited, it.

ID
ID number assigned byEktron CMS400.NET. (Developers use this number to

reference the collection in ecmCollection custom function.)

Description Description given to collection byuser who created, or last edited, it.

Path Folder location of the collection.

You can click any collection to view information about it and perform tasks on it. See

"Viewing a Collection" on page 9-102.

You can also add a new collection. See "Creating a Collection" on page 9-104.

See Also: "Finding Collections" on page 9-100

Viewing a Collection
To view a collection, follow these steps.

1. Select a collection using the procedure described in "Finding Collections" on page 9-100.

2. The View Collection screen appears.
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To see more details about a collection, Click the Properties button ( ). The Collection
Properties screen appears.

The screen displays each item in the collection. To learn more about a collection, click More

Info. When you do, the lower section of the screen displays the following information about

the collection.

n title

n description

n ID number

n template

n last user who edited it

n last date when it was edited
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n date it was created

n whether or not the content folder’s subfolders can be included

n for each content item in the collection

- a link to the content (click this to view and edit the content)

- ID number

- quicklink

See Also: "Viewing a Collection" on page 9-102

Collections Toolbar

The following table describes the collection toolbar buttons.

Button Name Description More Information

Add
Add new collection or add

items to a collection.
"Adding a Collection" on page 9-105

Remove
Remove items from a

collection.

"Removing Content from the

Collection" on page 9-110

Reorder Reorder items in a collection.
"Reordering CollectionsList" on

page 9-111

Edit Edit collection information.
"Editing Collection Information" on

page 9-112

Delete Delete a collection.
"Deleting a Collection" on page 9-

112

Back Return to previous screen.

Creating a Collection
Creating a collection involves two steps:

n "Adding a Collection" on page 9-105

n "Assigning Content to the Collection" on page 9-107

The following sections explain each step.
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Note: This section explains creating a collection in a site that doesnot support multiple languages. If you want to

create collections in several languages, see "Working with Collections in aMulti-Language System" on page 9-113.

Adding a Collection
To add a new collection, follow these steps.

1. Navigate to the content folder in which you want to create the collection.

2. Click New > Collection.

Note: If you access the collection via the Collections folder, you cannot choose the collection’s folder. It is

automatically placed in the root folder.

3. The Add Collection screen appears.

4. Complete the screen using the following table.

Field Description

Title Assign a unique title to the collection.

Template
Enter the default template for the collection. This template is used to display the

content of the links generated if no template is assigned in the custom function.
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Field Description

If left blank, the links use their respective Quicklinks.

See Also: "Default Template vs. Quicklinks" on page 9-106

Description Add amore detailed description for the collection.

Include

Subfolders

Check if you want to add to the collection content in subfolders of the content

folder.

Approval is

Required
See "Setting up Approval for Collections" on page 9-116.

5. Click the Save button ( ).

You can now assign content to the collection. See "Assigning Content to the Collection" on

page 9-107.

See Also: "Creating a Collection" on page 9-104

Default Template vs. Quicklinks
You can specify a template that determines the screen display for a collection when it is

published on a Web page. (See your system administrator for information about Ektron

CMS400.NET templates.) Or, you can disable the template and, instead, use Quicklinks to

determine the page template. (See Also: "Quicklinks and Forms" on page 8-22)

If you specify a template, all content in the collection uses the same screen elements other than

the specific content. For example, the page header, footer and information in the right frame of

the screen are all the same. On the other hand, if you use Quicklinks, every page in the

collection uses its original template. As a result, the surrounding information may change for

every content item in the collection.

Here is an example of links using Quicklinks. Notice that content uses several templates. As a

result, when a user clicks content in the collection, the screen information around the content

changes according to its template.
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Here is an example of links when using a template named index.asp. In this case, all pages

have the same information surrounding the content.

Note: If a collection item is a form, ekfrm is used instead of id to denote form block .

To toggle between a default template and Quicklinks, follow these steps.

1. Access the Edit Collection screen for the collection you want to edit.

2. Modify the Template field.

3. Click the Save ( ) button.

Assigning Content to the Collection
After a collection is created, your next step is to assign content to it. To do so, follow these

steps.

Note: When viewing a Collection on theWeb site, the last published version of content appears. If the content has

never been published, nothing appears.

1. Access the collections screen for the content folder in which you want to add the

collection, as described in "Finding a Collection by Navigating to its Content Folder" on

page 9-100.

2. Access the View Collection Screen, as described in "Creating a Collection" on page 9-

104.

3. Click the collection to which you want to assign content.
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4. The View Collection screen appears.

5. Accept or change the language.

6. Click the Add button ( ).

7. The Add Items to Collection screen appears, displaying

n all subfolders within the selected folder (Subfolders are available if the Include subfolders

checkbox was checked for the collection.)

n content in the selected folder that is not part of the collection.

Note that the file types selection remembers your most recent choice and can filter which

files appear. You can change the selection if desired.
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8. Check boxes next to content to add to the collection. You can only add content from the

selected folder or its subfolders.

(Subfolders are available if the Include subfolders checkbox is checked for the collection.)

Click a subfolder to view its content. To return to the parent folder, click the folder with

the up arrow ( ).

Note: If you select content from a subfolder, click the Add button to add selected content to the collection.

Navigating between subfoldersdeselects content.

9. Click the Add button ( ).

See Also: "Creating a Collection" on page 9-104

Creating New Content for a Collection
You can create new content while adding content links to a collection. To add content, follow

these steps.

1. Access the View Collections screen for the content folder in which you want to add the

collection, as described in "Finding a Collection by Navigating to its Content Folder" on

page 9-100.

2. Access the View Collection Screen for a collection, as described in "Creating a

Collection" on page 9-104.

3. If you are using Ektron CMS400.NET’s multi-language support, select the language of the

collection.

4. Click the Add button ( ).

5. The Add Items to Collection screen appears.

6. If your collection includes subfolders and you want to add the content to one of them,

navigate to that subfolder. Otherwise, proceed to the next step.

7. Click the Add Content button ( ).

8. The Add Content screen appears. If you are using Ektron CMS400.NET’s multi-language

support, the content’s language appears next to the title. The language is derived from the

collection’s language and cannot be changed.
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9. Create the content.

Note: Refer to "Adding HTMLContent" on page 7-15 for additional information about creating new content.

10. Click a workflow option in the Add Content screen.

11. The Add Content screen closes, and the new content link appears in the list of links

available to the collection.

12. Check off the content you created and other content.

13. Click the Add button ( ) to add the content to the collection.

Editing Content in a Collection
After a collection is created, you can add or remove links to and from it.

Adding Content to the Collection

For information about adding content links to a collection, see "Assigning Content to the

Collection" on page 9-107.
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Removing Content from the Collection

To remove a content link from a collection, follow these steps.

1. Access the collections screen for the content folder in which you want to add the

collection, as described in "Finding a Collection by Navigating to its Content Folder" on

page 9-100.

2. Access the View Collection Screen, as described in "Editing Content in a Collection" on

page 9-110.

3. Click the Remove button ( ).

4. The Remove Items from Collection screen appears.

5. Check boxes next to links that you want to delete.

Click Select All to select all boxes.

Click Clear All to remove all check marks.

6. Click the Delete button ( ).

See Also: "Editing Content in a Collection" on page 9-110

Reordering Collections List
After a collection is created, and more than one content item is assigned to it, you can reorder

the collections list. To do so, follow these steps.

1. Access the collections screen for the content folder in which you want to add the

collection, as described in "Finding a Collection by Navigating to its Content Folder" on

page 9-100.
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2. Access the View Collection Screen, as described in "Reordering Collections List" on page

9-111.

3. Click the Reorder button ( ).

4. The Reorder Collection screen appears.

5. Click the content whose order you want to change.

6. Click the up or down arrow to move the content in either direction.

7. Repeat steps five and six until you set the desired order.

8. Click the Update button ( ).

See Also: "Reordering Collections List" on page 9-111

Editing Collection Information
To edit information about a collection, follow these steps.

1. Access the collections screen for the content folder in which you want to add the

collection, as described in "Finding a Collection by Navigating to its Content Folder" on

page 9-100.

2. Access the View Collection Screen, as described in "Viewing a Collection" on page 9-102.

3. Click the collection whose information you want to change.

4. Change any of the field values. For documentation of the fields, see "Complete the screen

using the following table." on page 9-105.

Deleting a Collection
When you no longer want a collection, you can delete it. To delete a collection, follow these

steps.
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1. Access the collections screen for the content folder in which you want to add the

collection, as described in "Finding a Collection by Navigating to its Content Folder" on

page 9-100.

2. Access the View Collection Screen, as described in "Editing Content in a Collection" on

page 9-110.

3. Click the Delete button ( ).

4. A confirmation message appears.

5. Click OK to proceed.

Working with Collections in a Multi-
Language System
In a multi-language Ektron CMS400.NET system, you can create a language-specific edition of

each collection. When a site visitor selects a language then navigates to a page with a

collection, Ektron CMS400.NET displays the collection in the selected language if available.

If not, Ektron CMS400.NET displays nothing.

Note: Note the contrast between the collectionsand content: if a collection is not available in the selected

language, nothing appears. But if content is not available in the selected language, content in the default language

appears.

When creating a collection for a foreign language, decide if you want to create

n a foreign edition of an existing collection, or

n a new collection in a foreign language

For example, if you want to provide several versions of a single page that change depending

on the language selected by the user, see "Creating a Language-Specific Collection if Another

Edition Exists" on page 9-113.

On the other hand, if you are creating a collection to appear only on a foreign language page,

and no other edition of the collection will appear on your site, see "Creating a Language-

Specific Collection if Another Edition Does Not Exist" on page 9-114.

You can only add content in the language of a collection. So, create the content first, then

create the collection that links to them.
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Creating a Language-Specific Collection if Another
Edition Exists
1. Click the content folder in which your collection exists. The folder’s contents are

displayed.

2. Click View > Collection.

3. The View Collections screen is displayed.

4. Select the collection that you want to translate.

5. From the Add drop-down list, select the language of the new collection.

6. Using the Add button ( ), select the content to add to the collection. Navigate through
the folders to the content you want to add. You can only add content in the selected

language.

Creating a Language-Specific Collection if Another
Edition Does Not Exist
1. Navigate to the folder in which you will create the collection.

2. Click View > Collections. The View Collections screen is displayed.

3. Click the Add button ( ) and enter basic information about the collection. (This screen
is described in "Working with Collections in a Multi-Language System" on page 9-113.)

4. The View Collections in Folder screen appears. Click the collection you just created.

5. From the Add drop-down list, select the language of the new collection.

6. Using the Add button ( ), select the content to add to the collection. Navigate through
the folders to the content you want to add. You can only add content in the selected

language.

Collection Permissions
Any of the following users have permission to create or edit a collection.

n a member of the Administrators group

n a user who has been assigned the Collection and Menu Admin role. See Also:

n a user who has been granted collection permission for the collection’s folder. Permission is

granted on the folder Permission screen (see graphic below). See Also:
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How a Folder is Assigned to a Collection

If you create a collection by going to the Workarea’s Content> Collections Tab, it is assigned

to the root folder.

If you create a collection by going to a folder then selecting New > Collection, it is assigned

to that folder.

A collection’s folder appears on the Content > Collections > Collection Report screen, in the

Path column. No value there indicates root folder.
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Setting up Approval for Collections
If desired, you can set up an approval system for any collection. As with a content approval

chain, you specify users who must approve changes to a collection before it can be published.

Any collection approver can either approve or decline the modified collection. And, if a user

who is not an approver tries to delete a collection, that action also requires approval.

See Also:

n "Differences Between Content and Collection Approval Systems" on page 9-116

n "Creating a Collection that Requires Approval" on page 9-116

n "Which Users Can Approve Collections" on page 9-117

n "What Happens When an non-Approver Submits Changes to a Collection" on page 9-117

n "How Approvals Affect Deleting a Collection" on page 9-118

Differences Between Content and Collection Approval
Systems
n While content can have a chain of approvers, a collection has a list of approvers. Any

collection approver can publish or decline changes. There is no concept of a “chain” of

approvers.

n While content approval is folder-specific, collection approval is not. Once set up,

collection approval affects the collection to which it was assigned, regardless of its folder.
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Creating a Collection that Requires Approval
Only administrators or users to whom the folder-admin role has been assigned see the

Approval is Required checkbox on the Add and Edit Collection screens. See Also: See

"Defining Roles" on page 15-32

When the collection is created, its status is set to checked out. This allows you to add items to

it. When ready, you can publish it.

Which Users Can Approve Collections
If you require a collection to be approved, only the following users have permission to create

or edit a collection and can approve a change to a collection.

n a member of the Administrators group

n users to whom the Collection Approver role has been assigned and who have permission

to work with the collection

n users to whom the Folder User Admin role has been assigned and who have permission to

work with the collection

See Also: See "Defining Roles" on page 15-32
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What Happens When an non-Approver Submits
Changes to a Collection
A user who has permission to edit collections but not approve changes sees the following

buttons.

After making the change, the user clicks the submit button ( ). This action triggers an email
notification to all approval users for the collection. It also changes the collection’s status to

checked out. No other users can edit it in this status.

Next, one of the approval users must open the Edit Collection screen and click the Publish or

Decline button. If he clicks Publish ( ), the new version of the collection is published to

your Web site. If Decline ( ), the user who submitted the changes is notified by email but
no changes are made to your Web site.

If the user who made the changes realizes he made a mistake, he can go to the screen and click

the Undo Checkout button at any time before the approval. In this case, his submitted changes

are deleted, and the collection reverts to its original state.

In fact, any user with permission to edit a collection can perform the undo function until the

content is approved.

How Approvals Affect Deleting a Collection
To delete a collection, a user who has permission to work with collections but not approve

changes clicks the Delete button ( ) from the View Collection screen. This action changes
the collection’s status to Marked for Deletion (M) and triggers an email notification to all

approval users for the collection. One of the approval users must open the Edit Collection

screen and click the Delete or Decline button.

WebSite Navigation Aids

9-118
ReferenceManual

Version 8.0 Rev 1.3



If the approval user clicks Delete ( ), the collection is removed from your Web site. If the

approval user clicks Decline ( ), the user who submitted the deletion is notified by email
but no changes are made to your Web site.

Collection Server Control
The Collection server control displays a collection, that is a list of content links that is created

in the Ektron CMS400.NET Workarea. The control lets you customize the display of the

collection on a Web page.

When added to a template and visited, collections can look like this. (The following

illustration shows three collections on the same page of a sample site.) You can modify the

display by editing its server control properties.

This section contains the following topics:

n "Collection Server Control Properties" on page 9-119

n "Example of ecmNavigation Display" on page 9-124

n "Example of ecmTeaser Display" on page 9-124

n "Retrieving the XML Structure of a Collection" on page 9-125

n "Using the Collection Server Control Programmatically Example" on page 9-126
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Collection Server Control Properties
The Collection server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description Data Type

AddText

Override the control’s default text for the Add Content menu item. For example,

If you have a NewsWeb site, you could change Add Content toAdd News

Item.

String

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to browse to

Content, Collections, etc.See Also: "Using CMSExplorer to Browse Your

Ektron CMS400.NET Site" on page 21-9

String

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0

(zero). This is the amount of time, in seconds, a control’s data is cached.

For example, to cache data for fiveminutes, set theCacheInterval

property to 300.See Also: "Caching with Server Controls" on page 21-31

Warning! If theEnablePaging property is set to True, theCacheIn-

terval property is disabled.

Double

ContentParameter
Checks the QueryString for this value and replaces the collection with a content

blockwhen specified. Leave blank to alwaysdisplay the Collection.
String

DefaultCollectionID

The ID of a collection that appearswhere you insert this server control if no

other collection is identified, or is not available.

If you don’t know the ID number of the collection, use the CMSExplorer to

Long
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Property Description Data Type

browse to it.See Also: "Using CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9

DisplayXslt

Determineshow the information on the page is displayed.

None-databind only

ecmNavigation - lists the title of every content block in the collection

See Also: "Example of ecmNavigation Display" on page 9-124

ecmTeaser - lists the title of every content block in the collection plus the

content summary

See Also: "Example of ecmTeaser Display" on page 9-124

Path to Custom Xslt - Enter the path to an Xslt that determines the display of

the page.

Warning! Important: If you specify a customXSLT, it is strongly rec-

ommended that you do not store this file in theWorkarea folder. If you store

this file in theWorkarea folder, the file will be lost when you upgrade.

Warning! If you enter a valid EkML file at theMarkupLanguage property,

theDisplayxslt property value is ignored.

String

DynamicParameter
Tomake this collection dynamic, select coll_id. When you do, this server

control uses the collection passed asa URL parameter.
String

EnablePaging

This property, in conjunction with theMaxResults property, lets site visitors

view an unlimited number of collection itemswhile controlling the amount of

screen space. To accomplish this, the collection display is limited to the number

set in theMaxResults property.

If you set this property to true, and the number of collection itemsexceeds the

MaxResults number, navigation aids appear below the last item. The site

visitor uses the aids to view additional items. See example below.

So, for example, if a collection has9 itemsand theMaxResults property is

set to 4, the screen displaysonly the first four items.When the site visitor clicks

[Next], he sees items5, 6, 7 and 8, etc.

Warning! If theEnablePaging property is set to True, theCacheIn-

terval property is disabled.

Boolean
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Property Description Data Type

GetHtml

Set to True if you want to retrieve and display content (html body) for all content

blocks in the collection. For example, to display content inside a web server

control such asaGridView.

Boolean

Hide

Used to hide output of collection in design time and run time.

True =Hide collection

False =Display collection

Boolean

IncludeIcons

Choose whether to display iconsnext to the collection list’s links.

Warning! Important: This property onlyworkswhen ecmSummaryor

ecmTeaser are used in theDisplayXslt property.When the [$Image-

Icon] variable is used in an EkML file and that file is assigned to the Mark-

upLanguage property, this property acts asTrue.

Boolean

Language
Set a language for viewing the collection. This property shows results in design-

time (in VisualStudio) and at run-time (in a browser).
Integer

LinkTarget

Defines the waya link actswhen a link is clicked.

Choicesare:

_blank - Target causes the link to alwaysbe loaded in a new blankwindow.

Thiswindow is not named.

_self - Target causes the link to always load in the samewindow the anchor

was clicked in. This is useful for overriding a globally assigned BASE target.

_parent - Target makes the link load in the immediate frameset parent of the

document. This defaults to acting like “_self” if the document hasno parent.

_top - Target makes the link load in the full bodyof the window. This defaults to

acting like “_self” if the document is alreadyat the top. It is useful for breaking

out of an arbitrarily deep frame nesting.

ItemLinkTargets
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Property Description Data Type

MarkupLanguage

Identify the templatemarkup file that controls the display of the collection. For

example, mycollectionmarkup.ekml.

If the *.ekml file is located in the same folder as theWeb form containing the

server control, just enter its name. If the file is in another folder, enter the path

relative to site root. For example,

..

\workarea\customfiles\markup\mycollectionmarkup.ekml

.

See Also: "EktronMarkup Language" on page 21-414 and

"collection.ekml" on page 21-441

Note: If you enter a valid EkML file, theDisplayxslt property value is

ignored. If the EkML file contains the[$ImageIcon] variable, the

IncludeIcons property acts asTrue.

String

MaxResults

Enter themaximum number of items to appear in the initial display of this server

control.

To set nomaximum, enter zero (0).

To let site visitors view more than themaximum but limit the amount of space

being occupied, enter themaximum number of results per page here. Then,

set theEnablePaging property to true.

If you do andmore than the number ofMaxResults are available, navigation

aids appear below the last item to help the site visitor view additional items. See

example below. Integer

MemberMenuActive

Set this property to True to hide the drop downmenu next to a content item

when amembership user is logged-in.

True - Hide the drop down next to a content item frommembership users.

False - Membership users can have access to the drop downmenu next to

content item.

Note: This only affectsmembership users. CMS400.NET user will always see

the drop downmenuwhen theyare logged-in.

Boolean

Random

Set to True if you want to randomly display one collection item. The item

changeseach time a site visitor views the page.

Note: If you use a customXSLT or EkML file, the type of content displayed can

bemanipulated. For example, if you use an EkML file that has the [$Html]

variable in it, the actual content is displayed instead of a link. See Also: "Ektron

Markup Language" on page 21-414 and "[$Html]" on page 21-429.

Boolean
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Property Description Data Type

SelTaxonomyID

Set the ID of the taxonomy that content will be associated with when a logged-in

site visitor uses the Silver AccessPoint’sAdd HTML Content to add content

to a Collection server control.

Integer

SuppressWrapperTags
This property is set tofalse because Ajaxuses<div> tags to rewrite the

region around the tag. You cannot change the value totrue.
Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

Custom - Allows you to use a custom tag.

String

Example of ecmNavigation Display
The following is an example of a collection being used as a navigation menu.

ecmNavigation XSL code
Below is the XSL code that is used to create ecmNavigation Display. You can use this code as

the basis to design your own XSLT.

Warning! If you create a custom file, it is strongly recommended that you do not store this file in theWorkarea

folder. If you store this file in theWorkarea folder, the file will be lost when you upgrade.

<?xml version="1.0" encoding="ISO-8859-1"?>
<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform">

<xsl:template match="/">
 <table border="0" cellspacing="0" cellpadding="0" width="100%">
 <xsl:for-each select="Collection/Content">
 <tr>

 <td>
 <a>
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 <xsl:attribute name="href">
 <xsl:value-of select="QuickLink"/>

 </xsl:attribute>
 <xsl:value-of select="Title"/>

 </a>
 </td>

 </tr>
 </xsl:for-each>
 </table>
</xsl:template>

</xsl:stylesheet>

Example of ecmTeaser Display
The following is an example of a collection using the ecmTeaser display style.

ecmTeaser XSL code
Below is the XSL code that is used to create ecmTeaser Display. You can use this code as the

basis to design your own XSLT.

Warning! If you create a custom file, it is strongly recommended that you do not store this file in theWorkarea

folder. If you store this file in theWorkarea folder, the file will be lost when you upgrade.

<?xml version="1.0" encoding="ISO-8859-1"?>
<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform">

<xsl:template match="/">
 <table border="0" cellspacing="0" cellpadding="0" width="100%">
 <xsl:for-each select="Collection/Content">
 <tr>
 <td>
 <a>
 <xsl:attribute name="href">
 <xsl:value-of select="QuickLink"/>
 </xsl:attribute>
 <xsl:value-of select="Title"/>

 </a>&#160;
 </td>

 </tr>
 <tr>

<td>
 <xsl:value-of select="Teaser" />
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 </td>
 </tr>
 <tr>

 <td>&#160;</td>
 </tr>

 </xsl:for-each>
 </table>

</xsl:template></xsl:stylesheet>

Retrieving the XML Structure of a Collection
Retrieving the XML structure of XML content allows for greater control over developing

XSLs. The following is an example of how to retrieve the XML structure:

1. Open a new Web form.

2. Drag and drop a Collection server control onto it.

3. Set the DefaultCollectionID property.

4. Drag and drop a Textbox on the Web form.

5. Set the TextMode property to MultiLine.

Note: It is also recommended that you set the width of the text box to at least 400px.

6. On the code behind page, add the following line.
Textbox1.Text = Collection1.XmlDoc.InnerXml

7. Build the project.

8. View the Web form in a browser.

9. The XML structure of the collection appears in the textbox.

For an additional example, see the Collection XML page on the CMS400Developer samples

page. It is located at:

In a browser:

http://<site root>/CMS400Developer/Developer/Collection/CollectionXML.aspx

In the source code:

<site root>/CMS400Developer/Developer/Collection/CollectionXML.aspx and

CollectionXML.aspx.vb

Using the Collection Server Control Programmatically
Example
The following is an example of using code behind, and a drag and drop Collection server

control to display random content from a collection.

1. Drag and Drop a Collection server control on your Web form.

2. Set the properties in the properties window.
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Note: In this example, theRandom property and theGetHtml propertymust be set to True.

3. Add the following code to the code behind.

Dim str As String
str = "<h1>Hello There</h1><br>"
str &= Collection1.EkItems(0).Html
Collection1.Text = str

4. Build and browse your web form.
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Working with Menus

Ektron CMS400.NET’s Menu feature lets users create and maintain a dropdown menu system

for your Web site. The menu options can link to content, library assets, external hyperlinks,

and submenus. Below is a sample menu.

In this example (delivered with Ektron CMS400.NET), the menu appears when a site visitor

moves the cursor over About Us on the home page.

However, if a content contributor with permission to edit menus signs in to Ektron

CMS400.NET then views the menu, it has additional options for editing the menu or adding

content.

Warning! If you chooses to hide the border that appears around content when you are logged in, the Add and

Edit optionsare also hidden. This allows you to view the page as it appearswhen you are not logged in. If the page

is set to show borders and you still do not see the Add and Edit buttons, the featuremaybe turned off. Ask your

administrator or Web site Developer for additional information.

Managing menus is a two-step process. The first sections in this chapter describe the first step:

how Ektron CMS400.NET users create and update menus. In the second step, a developer

placing a menu server control on a Web form. The control manages how the menu displays on

your Web site.
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What’s In This Chapter
The following topics explain Menus.

n "The Structure of Menus and Menu Items" on page 9-130

n "Access to the Menus Feature" on page 9-131

n "Permission to Use the Menus Feature" on page 9-132

n "Managing Menus" on page 9-133

n "Working with Menus in a Multi-Language System" on page 9-155

n "Assigning Folders or Templates to a Menu" on page 9-158

n "Introduction to Menu Server Controls" on page 9-162

n "Flexible Menu Server Control" on page 9-164

n "Smart Menu Server Control" on page 9-178

n "Menu Server Control" on page 9-184

n "DhtmlMenu Server Control" on page 9-191

The Structure of Menus and Menu
Items
Menus have the following structure:

n menu - top level structure that is a placeholder for menu items and submenus. It is assigned

to a content folder.

A menu identifies a page template used to display menu options that are content.

n menu item - the individual options on a menu; can be any of the following

- content of any type

- library asset

- external hyperlink (link to a page outside your Web site)

- submenu (a link to another menu. In the illustration below, the menu on the right is a

submenu. It appears when the user hovers the cursor over Company Profile. The right

arrow indicates a submenu is available.)
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Access to the Menus Feature
There are three ways to access the Menus feature:

n the Workarea, by choosing the associated content folder then clicking View > Menus

n the Workarea, by choosing Content > Menus

n the Edit Menu option on the sample menu displayed above

If you choose the first or second option, you select a specific menu. Then, it appears on the

View Menu screen. For the third option, the selected menu appears on the View Menu screen.

From the View Menu screen, you can perform the following actions on a menu.

n Create a new menu

n Edit its information (for example, the URL and template link)

n Translate it

n Delete it

n Add or remove items

n Change the sequence of menu items

n Edit menu items

n For submenus

- add /remove items

- change sequence of menu items

- edit menu information

- edit menu items
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Permission to Use the Menus
Feature
There are two ways to create a menu. Each has its own permission model.

MenuCreation

Method
Illustration How to set permissions

Via theWorkarea’s

Content>Menus

tab

The user must be one of the following.

n amember of the Administrators user

group

n assigned the Collection andMenu

Admin role. See Also: "Defining Roles" on

page 15-32

n granted permissions to Collections for

the root folder. This is advanced permission.

See Also: "Setting Permissions through the

PermissionsTable" on page 5-43

Via the View

Contents of Folder

screen’sNew >

Menu option

See "Permissions for MenusCreated from

the View Contents of Folder Screen" on

page 9-132

Permissions for Menus Created from the View
Contents of Folder Screen

Only users with permission to use the Collections feature (illustrated below) for a folder can

work with menus. If user does not have permission to Collections, the Menu option does not

appear on the New menu.
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Also, if a user has permission to Collections but Read Only permission for content and the

library, he cannot add content from a navigation link.

Managing Menus
Ektron CMS400.NET gives you the flexibility to add, edit, view and delete a menu. The

following sections explain how to do that.

n "Adding a New Menu" on page 9-133

n "Adding a Menu Item" on page 9-138

n "Editing a Menu" on page 9-146

n "Editing a Menu Item" on page 9-148

n "Viewing a Menu" on page 9-150

n "Reordering Menu Items" on page 9-153

n "Deleting a Menu" on page 9-153

n "Deleting a Menu Item" on page 9-154

Adding a New Menu
You can create a menu by navigating to a folder or by choosing Content > Menus from the

left frame of the Workarea. If you choose Content > Menus, it is automatically assigned to the

root folder. In contrast, if you create a menu after choosing a content folder, it is assigned to

the selected folder.

Adding a Menu via Content Folder
1. Navigate to a content folder.
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2. The current language appears as a flag next to the screen title. To create the menu in this

language, proceed to the next step.

To change the new menu's language, click View > Language and select the new

language.

3. Click New > Menu.

4. The Add Menu screen appears.

5. Use the following table to complete the screen.
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Fields on the Add/Edit Menu Screen

Field Description

Title
The name given to themenu by its creator. It appears on theWeb page to

indicate the kind of information on themenu.

Image Link

You can have an image appear next to or instead of themenu title. For example:

To do this, follow these steps.

Note: Before beginning these steps, the imagemust reside in the library. if it does

not, add it before proceeding. For more information, see "Copying Files to the

Library" on page 8-12.

1. Click the image icon ( ).

2. The librarywindow opens.

3. Navigate to the folder that contains the image you want to use.

4. Click the Insert button ( ) to insert it.

Using Image to Replace Title Text

Alternatively, you can have the image replace themenu text, so that only the

image appears on themenu. To do this, check theUse image instead of a

title checkbox.
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Field Description

URL Link

After you create amenu, your developer links it to text or an image on aWeb

page bymodifying a page template.When a site visitor reading thatWeb page

moves the cursor over the text or image, themenu appears. In the illustration

below, themenu appearswhen the site visitor moves the cursor over Products.

You can also assign a URL link to amenu using this field. If you do, and the user

clicks the link text or image, he jumps to the specified page.

For example, in this field you assign the product landing page,

siteroot/products.aspx. In the illustration above, if the usermoves the

cursor over Products, the assignedmenu appears. However, if the user clicks

Products (as indicated by the hand), he jumps to siteroot/products.aspx.

Entering the Path to the Landing Page

This path is relative to the site root. For example: siteroot/jobs.aspx

ThisURL path can be a static template path (like the onementioned above) or a

dynamic path, such as

wellness.aspx?id=40&wellness=Hemophilia
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Field Description

Template

Link

Note: This field applies to content only. It hasno effect on other typesof menu

items (such as images). Also, this field only affects content that dynamically

referencesa content block, such as/CMS400Min/therapies.aspx?id=84. If

themenu option is a template that includes content (for example,

/CMS400Min/news.aspx), the template you identify here is ignored.

If you want to apply a template to thismenu, enter the template here. If you do, all

content on thismenu uses this template when selected from themenu.

If you do not enter a template here, content on thismenu uses the template

specified in itsQuicklink.

Overriding the Template Link

You can override themenu template for any content item on thismenu and,

instead, use the template specified in itsQuicklink. To do so, follow these steps.

1. Add all items to themenu. (See "Adding aMenu Item" on page 9-138)

2. Go to the ViewMenusoption.

3. ClickMore Info.

4. Click themenu item you want to change.

5. At the Link field, change the value fromMenu Template toQuicklink.

Warning! If you createdmenusprior to upgrading to this version of Ektron

CMS400.NET, thosemenu itemsare assigned asQuicklinks. You cannot

change them to template links simply byentering a template link here. Instead,

youmust go to eachmenu item and change the Link field value from Quick-

Link to Menu Template (as illustrated above).

Description Add amore detailed description for themenu.

Folder

Associations
See "Effect of Assigning a Folder to aMenu" on page 9-158.

Template

Associations
See "Effect of Assigning a Template to aMenu" on page 9-160.

6. Click the Save button ( ).

With the menu added, you may assign menu items to it. See "Adding a Menu Item" on page 9-

138.

Adding a Menu via the Menus Tab
1. From the left frame of the Workarea, click Content > Menus.

2. Click the Add Menu button ( ).

3. The Add Menu screen appears.
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4. To complete the fields on the Add Menu screen, see "Fields on the Add/Edit Menu

Screen" on page 9-135.

With the menu added, you may assign menu items to it. See "Adding a Menu Item" on page 9-

138.

Adding a Menu Item
Similar to being able to add, edit, view or delete a menu, Ektron CMS400.NET also allows you

to add, edit, view and delete a menu items.

Adding a Menu Item via Content Folder
To add a menu item via a content folder, follow these steps.

1. Navigate to the content folder that contains the menu to which you want to add items.

2. Click View > Menus.

3. In the View Language dropdown list, select the language of the menu.

4. Click the menu.

5. The View Menu screen opens, displaying the items already on the menu. Submenus look

like a folder with a plus sign to the left ( ).

6. To add a new item to the menu , click the Add Items button ( ).

7. The Add New Item screen appears. Use the table below to select a type of menu item and

follow the steps to add it.

Assign this type of content to the

menu
For details, see

Content
"Adding Content asaMenu Item" on page

9-142

Any library asset: images, files, Quicklinks,

hyperlinks to themenu

"Adding a LibraryAsset asaMenu Item" on

page 9-143

External hyperlink
"Adding an ExternalHyperlink asaMenu

Item" on page 9-143

Submenu to themainmenu
"Adding a Submenu asaMenu Item" on

page 9-144

8. After you insert menu items, you can view and modify information about them. To do that,

click the item's title. When you do, the Edit Menu Item screen appears.See Also: See

"Managing Menus" on page 9-133
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Fields on the Add/Edit Menu Item Screen
Use the following table to complete the fields on the Edit Menu Item screen

Field Description

Title The name of themenu item. It appears on theWeb page to indicate the item.

Image Link

You can have an image appear next to or instead of themenu title. For

example:

To do this, follow these steps.

Note: Before beginning these steps, the imagemust reside in the library. if it

doesnot, add it before proceeding. For more information, see "Copying Files

to the Library" on page 8-12.

1. Click the image icon ( ).

2. The librarywindow opens.

3. Navigate to the folder that contains the image you want to use.
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Field Description

4. Click the Insert button ( ) to insert it.

Using Image to Replace Title Text

Alternatively, you can have the image replace themenu text, so that only the

image appears on themenu. To do this, check theUse image instead of a

title checkbox.

Description Add amore detailed description for themenu.

Target

This field determines the type of window in which thismenu item appears.

n Popup - opens in new window

n Self -opens in samewindow.

n Parent - opens in the parent frame

n Top - opens in parent window

Adding a Menu Item via Menus Tab
To add a menu item via the Menus tab, follow these steps.

1. From the top tabs of the Workarea, click Content > Menus.

2. Click the menu to which want to add a menu item.

3. In the View Language dropdown list, select the language of the menu.

4. To add a new item to the selected menu or any submenus on it, move the cursor to the left

panel then hover over the menu item and right click.

5. Click Add Items from the popup menu.
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6. The Add New Item screen displays a list of items that you can add to the menu. Use to

the table below to select the type of menu item and follow the steps to add it.

Menu item type Formore information, see

Content
"Adding Content asaMenu Item" on page 9-

142

Any library assets: images, files, Quicklinks,

hyperlinks to themenu

"Adding a LibraryAsset asaMenu Item" on

page 9-143

External hyperlinks
"Adding an ExternalHyperlink asaMenu

Item" on page 9-143

Submenu to themainmenu
"Adding a Submenu asaMenu Item" on

page 9-144

7. After you insert menu items, you can view and modify information about them. To do

that, click the item's title. When you do, the Edit Menu Item screen appears. See Also:

See "Managing Menus" on page 9-133

Adding a Menu Item via Navigation Link on a Web Page
1. Log in.

2. Access the Web page that contains the link to display the menu.

3. Place the cursor on the hyperlink that causes the menu to appear.

4. The menu appears.

5. Click Add.

6. The Add Menu screen displays a list of items you can add to the menu.

7. Use the table below to select the type of menu item and follow the steps to add it.
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Assign this type of content to the

menu
For details, see

Content
"Adding Content asaMenu Item" on page

9-142

Any library assets: images, files, Quicklinks,

hyperlinks to themenu

"Adding a LibraryAsset asaMenu Item" on

page 9-143

External hyperlinks
"Adding an ExternalHyperlink asaMenu

Item" on page 9-143

Submenu to themainmenu
"Adding a Submenu asaMenu Item" on

page 9-144

8. After you insert menu items, you can view and modify information about them. To do that,

click the item's title. When you do, the Edit Menu Item screen appears. See Also: See

"Managing Menus" on page 9-133

Adding Content as a Menu Item
To add content as a menu item, follow these steps.

Note: You can only add content that resides in themenu’s content folder or its subfolders.

1. Follow the directions in "Adding a Menu Item via Content Folder" on page 9-138,

"Adding a Menu Item via Menus Tab" on page 9-140, or "Adding a Menu Item via

Navigation Link on a Web Page" on page 9-141.

2. Click the radio button next to Content Item.

3. Click the Next... button.

4. The Add New item screen appears, listing all content in the folder (and its subfolders) in

which the menu was created.

5. By default, all content is available. To limit your selection to a type of content (for

example, Word documents), click the content types dropdown and select a type.
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6. Content items in the selected folder appear below any subfolders. You can click any

subfolder to display its content.

7. Check all content you want to add from any single screen to the menu.

Warning! If you check itemson a screen then proceed to another screen before clicking the Add button, the items

on the first screen are not added to themenu.

8. Click the Add button ( ).

9. The View Menu screen reappears, showing the new content.

10. To access the Edit Menu Item screen for the new content, hover the cursor over the title,

then click.

11. The Edit Menu Item screen lets you assign additional information to the menu item, such

as the target window. See "Fields on the Add/Edit Menu Screen" on page 9-135.

12. Continue to add menu items as needed.

Adding a Library Asset as a Menu Item
To add a library asset as a menu item via a content folder or menus tab, follow these steps.

1. Follow the directions in "Adding a Menu Item via Content Folder" on page 9-138,

"Adding a Menu Item via Menus Tab" on page 9-140, or "Adding a Menu Item via

Navigation Link on a Web Page" on page 9-141.

2. Click the radio button next to Library Asset.

3. Click the Next button.

4. The Add New Item screen appears. Enter a title for the library asset that will be on the

menu.

5. Click Browse Library.

6. The library screen opens.

7. In the right frame, select the type of asset to insert (image, hyperlink, etc.).

Note: To insert assets, themenu’s folder must contain library assets. However, you can insert library assets from

other folders for which you have permission.

8. Select a library asset and click the Insert button ( ).

9. The Add New Item screen reappears.

10. Click the Save button ( ).

Adding an External Hyperlink as a Menu Item
To add an external hyperlink as a menu item via a content folder or the Menus tab, follow

these steps.
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1. Follow the directions in "Adding a Menu Item via Content Folder" on page 9-138,

"Adding a Menu Item via Menus Tab" on page 9-140, or "Adding a Menu Item via

Navigation Link on a Web Page" on page 9-141.

2. Click the circle next to External Hyperlink.

3. Click the Next button.

4. The Add New Item screen is displayed.

5. Complete the fields as needed.

Field Description

Title Title of the new external hyperlinkmenu item.

URL Link
The URL of the external hyperlink. For example,

www.example.com.

6. Click the Save button ( ).

Note: When adding an ExternalHyperlinkmenu item, the URL doesnot get added to the library nor is an ID

assigned to it. So, when you save themenu item, it is not added to the CMSdatabase nor can it be retrieved for

future use.

Adding a Submenu as a Menu Item
To add a submenu as a menu item via content folder or menus tab, follow these steps.

1. Follow the directions in "Adding a Menu Item via Content Folder" on page 9-138,

"Adding a Menu Item via Menus Tab" on page 9-140, or "Adding a Menu Item via

Navigation Link on a Web Page" on page 9-141.

2. Click the radio button next to Submenu.

3. The Add Menu screen is displayed.

4. Complete the fields using "Fields on the Add/Edit Menu Screen" on page 9-135 as a

reference.

5. Click the Save button ( ).

Adding an Item to a Submenu
1. From the left frame of the Workarea, click Content > Menus.

2. Select the menu.

3. Find the submenu to which you want to add items. (Submenus have a folder icon ( )
next to them.)

4. Move the cursor over the submenu and click Add Items from the popup menu.
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5. The Add New Item screen opens, displaying items you can add.

6. Refer to the table below for selecting a menu item and follow the steps to add it.

Assign this type of content to the

menu
For details, see

Content
"Adding Content asaMenu Item" on page

9-142

Any library asset: images, files, Quicklinks,

hyperlinks to themenu

"Adding a LibraryAsset asaMenu Item" on

page 9-143

External hyperlink
"Adding an ExternalHyperlink asaMenu

Item" on page 9-143

Submenu to themainmenu
"Adding a Submenu asaMenu Item" on

page 9-144

Adding New Content to a Menu via Navigation Link on a
Web Page

Note: You can only use this feature after your Web developer hasmodified a page template to display themenu.

For more information, see "Introduction toMenu Server Controls" on page 9-162.

To add new content to a menu via a navigation link on a Web page, follow these steps.

1. Access the Web page that contains the link to display the menu.

2. Place the mouse on the hyperlink that causes the menu to appear.

3. The menu appears.
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4. Click ( ) Add.

5. The Add Menu screen opens, displaying items you can add.

6. Refer to the table below for selecting a menu item and follow the steps to add it.

Assign this type of content to the

menu
For details, see

Content
"Adding Content asaMenu Item" on page

9-142

Any library asset: images, files, Quicklinks,

hyperlinks to themenu

"Adding a LibraryAsset asaMenu Item" on

page 9-143

External hyperlink
"Adding an ExternalHyperlink asaMenu

Item" on page 9-143

Submenu to themainmenu
"Adding a Submenu asaMenu Item" on

page 9-144

Editing a Menu
You can edit a menu via:

n its content folder

n menus tab

n navigation link on a Web page

This section describes each option.

Editing a Menu via its Content Folder
To edit a menu from a content folder, follow these steps.

1. Access the Workarea and navigate to the content folder that contains the menu.
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2. Click View > Menus.

3. Click the menu you want to edit.

4. Move the cursor over the menu that you want to edit.

5. Click Edit from the popup menu.

Note: Whenmoving the cursor to the popupmenu, avoidmoving acrossother menusor options.When youmove

acrossanother menu or option, it maybecome selected instead of the item youwant to workwith.

6. The Edit Menu screen is displayed.

7. Change the fields in Edit Menu screen by referencing "Fields on the Add/Edit Menu

Screen" on page 9-135.

8. Click the Save button ( ).

Editing a Menu via Menus Tab
To edit a menu via the Menus tab, follow these steps.

1. From the left frame of the Workarea, click Content > Menus.

2. Click the menu you want to edit.

3. Move the cursor over the menu that you want to edit.

4. Click Edit from the popup menu.

Note: Whenmoving the cursor to the popupmenu, avoidmoving acrossother menusor options.When youmove

acrossanother menu or option, it maybecome selected instead of the item youwant to workwith.

5. The Edit Menu screen is displayed.

6. As necessary, update the fields in Edit Menu screen by referencing "Fields on the

Add/Edit Menu Screen" on page 9-135.

7. Click the Save button ( ).

Editing a Menu via Navigation Link on a Web Page
To edit a menu via a navigation link on a Web page, follow these steps.

1. Navigate to the Web page that contains the link to display the menu.

2. Click the menu link.

3. The menu appears.
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4. Click Edit Menu.

5. The View Menu screen for the menu appears.

6. Move the cursor over the menu that you want to edit.

7. Click Edit from the popup menu.

Note: Whenmoving the cursor to the popupmenu, avoidmoving acrossother menusor options.When youmove

acrossanother menu or option, it maybecome selected instead of the item youwant to workwith.

8. The Edit Menu screen is displayed.

9. Update the fields by referencing "Fields on the Add/Edit Menu Screen" on page 9-135.

10. Click the Save button ( ).

Editing a Menu Item
This section explains how to edit the following types of menu items:

n content on your Web site

n library asset

n link to an external Web site

n submenu

You can edit a menu item via:

n its content folder

n menus tab

n navigation link on a Web page

See Also: "Managing Menus" on page 9-133

Editing a Menu Item via its Content Folder
To edit a menu item from its content folder, follow these steps.

1. Access the Workarea and navigate to the content folder that contains the menu.
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2. Click View > Menus.

3. Click the menu you want to edit.

4. The View Menu screen for that menu appears, listing all menu items.

5. Move the cursor over the item you want to edit.

6. Click Edit from the popup menu.

Note: Whenmoving the cursor to the popupmenu, avoidmoving acrossother menusor options.When youmove

acrossanother menu or option, it maybecome selected instead of the item youwant to workwith.

7. To learn about the fields on the screen, see "Fields on the Add/Edit Menu Screen" on page

9-135.

Editing a Menu Item via Menus Tab
To edit a menu via the Menus tab, follow these steps.

1. Access the Menu Report screen, as described in "Viewing a Menu via the Menus Tab" on

page 9-151.

2. Click the menu you want to edit.

3. The View Menu screen for that menu appears, listing all items on the menu.

4. Move the cursor over the item you want to edit, and click Edit from the popup menu.
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Note: Whenmoving the cursor to the popupmenu, avoidmoving acrossother menusor options.When youmove

acrossanother menu or option, it maybecome selected instead of the item youwant to workwith.

5. To learn about the fields on the screen, see "Fields on the Add/Edit Menu Screen" on page

9-135.

Editing a Menu Item via Navigation Link on a Web Page
To edit a menu via navigation link on a Web page, follow these steps.

1. Access the template where you inserted the link to display the menu.

2. Click the Menu Navigation link title on the Web page.

3. A menu is displayed along with all menu items on the menu.

4. Click Edit Menu.

5. The View Menu screen appears.

6. Move the cursor over the item you want to edit, and click Edit from the popup menu.

7. To learn about the fields on the screen, see "Fields on the Add/Edit Menu Screen" on page

9-135.

Viewing a Menu
Just like editing a menu, you can view a menu via

n its content folder

n menus tab

n navigation link on a Web page

When viewing a menu via the content or menu folder, you get an internal view of information

entered by menu creator. When viewing via a navigation link on a Web page, you get an

external view of the menu, as seen by anyone navigating Web site.
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View a Menu via its Content Folder
To access a menu via its content folder, follow these steps.

1. Access the Workarea and navigate to the content folder that contains the menu.

2. Click View > Menus.

3. The View All Menus screen displays all menus in the folder.

4. Click the menu you want to view.

5. The menu’s options appear.

Viewing a Menu via the Menus Tab
To access the menu via the Content Tab, follow these steps.

1. From the left frame of the Workarea, click Content > Menus.

2. The Menus Report screen displays all menus.
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3. Click the menu you want to view.

4. The menu’s options appear.

ViewMenus via Navigation Link on a Web Page
To access the menu via a navigation link on a Web page, follow these steps.

1. Access the Web page on which your Web developer inserted the link to display the menu.

2. Click the link that launches the menu on the Web page.

3. A menu is displayed.

See Also: "Managing Menus" on page 9-133
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Reordering Menu Items
To rearrange the items on a menu, follow these steps.

1. Navigate to the View Menu screen for the menu that you want to rearrange. See "Viewing

a Menu" on page 9-150.

2. Move the cursor over the menu, and click Reorder.

3. The Reorder Items screen appears.

4. Click the item you want to move.

5. Click the up arrow to move it up, or the down arrow to move it down.

6. When finished, click Save ( ).

See Also: "Managing Menus" on page 9-133

Deleting a Menu
Similar to editing and viewing a menu, you can delete a menu via

n its content folder

n menus tab

You cannot delete a menu from the navigation link on a Web page.

Deleting a Menu via Content Folder
To delete a menu via its content folder, follow these steps.

1. Access the View Menu screen, as described in "View a Menu via its Content Folder" on

page 9-151.

2. Move the cursor over the menu, and click Delete.

3. A confirmation message is displayed.
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4. Click OK to delete the menu.

Note: Deleting amenu automatically deletesallmenu itemsassociated with it. Do not confuse themenu linkwith

the item itself. For example, deleting amenu deletes its links to content but hasno effect on the content.

Deleting a Menu via Menus Tab
To delete a menu via its menus tab, follow these steps.

1. Access the View Menu screen, as described in "Viewing a Menu via the Menus Tab" on

page 9-151.

2. Move the cursor over the menu, and click Delete.

3. A confirmation message is displayed.

4. Click OK.

Note: Deleting amenu automatically deletesallmenu itemsassociated with it. Do not confuse themenu linkwith

the item itself. For example, deleting amenu deletes its links to content but hasno effect on the content.

Deleting a Submenu
1. Access the View Menu page, as described in "Viewing a Menu via the Menus Tab" on

page 9-151.

2. Select the submenu.

3. Move the cursor over the menu, and click Delete.

Deleting a Menu Item
Similar to editing and viewing a menu, you can remove a menu item from a menu via

n its content folder

n its menu folder

Removing a Menu Item via its Content Folder
1. Access the View Menu screen, as described in "View a Menu via its Content Folder" on

page 9-151.

2. Move the cursor over the item.

3. Click Delete.
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Removing a Menu Item via Menus Tab
1. Access the View Menu screen, as described in "View a Menu via its Content Folder" on

page 9-151.

2. Move the cursor over the item.

3. Click Delete.

Working with Menus in a Multi-
Language System

Note: For background information about supportingmultiple languageson your Web site, see "Working with

Menus in aMulti-Language System" on page 14-25.

You can create an edition of any menu in every supported language. When a site visitor

selects a language, navigates to a page that has a menu and clicks the menu link, Ektron

CMS400.NET displays the menu in the selected language if it is available. If a menu in that

language is not available, nothing appears.

Before creating or translating a menu, it’s a good idea to create or translate all content that will

be on the menu. In this way, you can link this content to the new menu. However, after

creating a menu, you can add new items to it.

See Also: "Working with Menus" on page 9-129

Translating a Menu
To translate a menu into any supported language, follow these steps. You can navigate to the

menu via the Web site or from the Workarea. Each procedure is described below.

By Navigating the Site
1. Sign on to Ektron CMS400.NET

2. Select the menu’s current language.

3. Navigate to the page that has the menu you want to translate.

4. Click the menu and the Edit Menu option.
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5. The View Menu screen appears for the selected menu.

6. From the Add drop-down list, select the language into which you want to translate the

menu.

7. The Add Menu screen appears. Complete the screen for the menu in the selected language.

See "Fields on the Add/Edit Menu Screen" on page 9-135.

8. Click the Save button ( ).

9. The View Menu screen reappears. Now, the View In drop-down list displays the menu’s

new language.

10. Add items to the menu. See "Adding a Menu Item" on page 9-138. If adding content, you

can only insert an item in the selected language.

11. Later, you can add more menu items, edit them, delete them, view them, etc.

These capabilities are described in this chapter.

By Accessing the Menus Report Screen
1. From the Workarea screen, click Content > Menus.

2. Click the menu you want to translate.
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3. The View Menu screen appears for the selected menu.

4. From the Add drop-down list, select the language into which you want to translate the

menu.

5. The Add Menu screen appears. Complete the screen for the menu in the selected language.

See "Fields on the Add/Edit Menu Screen" on page 9-135.

6. Click the Save button ( ).

7. The View Menu screen reappears. Now, the View In drop-down list displays the menu’s

new language.

8. Add items to the menu. See "Adding a Menu Item" on page 9-138. If adding content, you

can only insert an item in the selected language.

Later, you can add more menu items, edit them, delete them, view them, etc.

Creating a Menu in Any Language
To create a menu in any language, follow these steps.

1. Form the Workarea screen, click Content > Menus.

2. From the language drop-down list, select the new menu’s language.

3. Create the menu. See "Adding a Menu via the Menus Tab" on page 9-137.
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Assigning Folders or Templates to a
Menu
The Advanced Settings on the Edit Menu screen has Folder Associations and Template

Associations sections (see image below). Any folders or templates currently assigned to the

menu appear. You can use this section of the screen to add new templates/folders or remove

existing ones.

For more information, see

n "Effect of Assigning a Folder to a Menu" on page 9-158

n "Effect of Assigning a Template to a Menu" on page 9-160

Effect of Assigning a Folder to a Menu
If

n you assign a folder to a menu

and

n a user navigates to any content item that resides in the folder
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and

n a Smart Menu whose EnableSmartOpen property is true appears on the screen

the Smart Menu automatically displays the items on the associated submenu.

Note: Navigation to the content item can consist of clicking a quicklink, amenu option, a list summary item, the

result of a search, etc.

In effect, you are instructing Ektron CMS400.NET to expose a menu whenever a content item

that resides in one or more selected folders appears on the screen. As a result, a user who

begins looking for a specific content item sees similar items on the screen.

As an example, assume your Web site sells books, and your folders are organized by genre.

One of your folders is “Teen Fiction.” You create a submenu that contains the top five sellers

in “Teen Fiction.” You then associate the Teen Fiction folder with that submenu.

If a site visitor uses the site search to find any book in that category, and proceeds to a page

describing the book, the Smart Menu in the page’s left column displays the five top Teen

Fiction titles.

Using the Select Folder Screen

The Select Folder screen lets you assign new folders to the menu, reorder the folders, and

delete folders from the menu association. These tasks are described below.

When you click Change below Folder Associations on the Edit menu screen, the Select

Folder screen appears (see image below).

The following table describes tasks you can perform on this screen.
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Task Instructions

Add folder to list

1. In the top of the screen, navi-

gate to the folder you want to

add.

2. Click the Add button ( ).

Remove folder from list

1. Click checkbox to the left of

the folder.

2. Click the Delete button ( ).

Remove all folders from list

1. Click checkbox to the left of

Folder.

2. Click the Delete button ( ).

Move a folder up or down on the list

Note: The sequence in which folders

appear hasno impact on how they

are used. It merely affects the

appearance of the folders on the

Select Folders screen.

1. Click checkbox to the left of

the folder.

2. Click the up or down arrow

buttons ( ).

Save changesand return to Edit

Menu screen Click the Save button ( ).

Exit screen; do not save changes
Click the Exit button ( ).

Effect of Assigning a Template to a Menu
If

n you assign a template to a menu

and

n a user navigates to any content item that uses the template

and

n a Smart Menu whose EnableSmartOpen property is true appears on the screen

the Smart Menu automatically displays the items on the associated submenu.
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Note: Navigation to the content item can consist of clicking a quicklink, amenu option, a list summary item, the

result of a search, etc.

In effect, you are instructing Ektron CMS400.NET to expose a menu whenever a content item

that uses one or more selected templates appears on the screen. As a result, a user who begins

looking for a specific content item sees similar items on the screen.

As an example, assume your Web site sells books, and your templates are organized by genre.

One of your templates is “Teen Fiction.” You create a submenu that contains the top five

sellers in “Teen Fiction.” You then associate the Teen Fiction template with that submenu.

If a site visitor uses the Web site search to find any book in that category, and proceeds to a

page describing the book, the Smart Menu in the page’s left column displays the five top Teen

Fiction titles.

Assigning a Template to a Menu
To add a new template, follow these steps.

1. Move to the Template Associations area of the Edit menu screen.

2. In the box on the right, enter the template that you are assigning to this menu. It can be a

CMS template, or any file that you wish.

3. Click Add.

To later change or remove the template, select it then click Change or Remove.
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Introduction to Menu Server Controls
Managing menus is a two-step process. The previous section describes the first step, which is

how Ektron CMS400.NET users create and update menus. The second step involves a

developer placing a menu server control on a Web form. The server control manages the

display of the menu on your Web site.

Ektron CMS400.NET provides four menu server controls:

n "Flexible Menu Server Control" on page 9-164

n "Smart Menu Server Control" on page 9-178

n "Menu Server Control" on page 9-184

n "DhtmlMenu Server Control" on page 9-191

This section introduces concepts that affect all of them, and explains the differences between

them.

Prerequisites
Before you can use the server controls, you must create menus in the Workarea. To learn about

creating menus, see "Working with Menus" on page 9-129.

Contrasting Menu Server Controls
n "Appearance" on page 9-162

n "Properties" on page 9-163

Appearance
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Flexand

Smart Menu

or

(Other styles are available)

DHTMLMenu

(Styling is very customizable)

Menu

Properties

Property
Flex

Menus
Smart Menu

DHTML

Menu
Menu

508 compliant

Shutter menu

(When you click amenu, it

opensdirectly below the

menu title)
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Property
Flex

Menus
Smart Menu

DHTML

Menu
Menu

Secondarymenu opens

when cursor hovers over it

(alternative:
secondarymenu

openswhen

clicked)

(alternative:

secondary

menu opens

when clicked)

Starts out collapsed;

expandsas site visitor

selects secondarymenu
(optional)

Allmenu levels open when

page displays (optional) (optional)

Can display secondary

menu to the right of the root

menu, instead of directly

below it

(optional)
(controlled

by style sheet)

How appearance is

modified

Server control

properties and

style sheet

Server control

properties and

style sheet

Server

control

properties

and style

sheet

Xslt

and

style

sheet

How behavior ismodified Xslt

Xslt

and

style

sheet

Option to launchmenu links

in a new window

Flexible Menu Server Control
The FlexMenu server control displays a menu on a Web form. Although it looks and acts like a

Smart Menu, its architecture is substantially different. Specifically, a FlexMenu creates XML.

So, you can modify its behavior using an XSLT file, and change its appearance using a

cascading style sheet (.css) file. This design is illustrated below.
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Note: Before you can use this server control, youmust create one or moremenus in the Ektron CMS400.NET

Workarea. To learn about creatingmenus, see "Working withMenus" on page 9-129.

This subsection contains the following topics.

n "Sample Menus" on page 9-166

n "Working with the Flex Menu Xslt File" on page 9-170

n "Setting up a Master/Slave Menu Relationship" on page 9-171

n "How the FlexMenu Server Control Determines Which Item is Selected" on page 9-172

n "Flex Menu Server Control Properties" on page 9-173

n Retrieving the XML Structure of a Flexible Menu

See Also: "Contrasting Menu Server Controls" on page 9-162
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Sample Menus
To facilitate the deployment of Flex menus, Ektron CMS400.NET provides several sample

menus that show their capabilities. You can use whichever sample meets your needs, then

modify it for your site.

The sample menus can be viewed from the Developer Sample Page

(siteroot/Developer/default.aspx) > Menu - Flex.

The samples are installed to the siteroot/developer/menu/flexmenu folder. Each sample has its

own subfolder that contains sample aspx pages, a css file, and an xsl file.

Description of the Sample Menus

WebSite Navigation Aids

9-166
ReferenceManual

Version 8.0 Rev 1.3



SampleMenu Description Location on Server

AjaxDemo

The only samplemenu for which Ajax is enabled by

default. Ajax providesa quicker response time because the

client only loadsmenu levels on an “asneeded” basis. This

feature eliminates the need to do a page refresh to get new

content.

Youmaynot notice the speed on smallmenus, but with

largemenus, the speed improvement is significant.

Note: The first time an Ajax-enabledmenu is invoked, it is

slow because the server is building it. After that, its

response time should be quicker than non-Ajaxmenus.

How the MenuWorks

n When you first click amenu, all text links are black.

When you click it a second time, theyare grayed out.

n Secondarymenusdo not change.

n There’s no way to close amenu after it opens.

siteroot/Developer/Menu

/FlexMenu/AjaxDemo/FMAjaxDemo.aspx

Expanding

n Menu hasgradient background, which changes

when you hover over it.

n Menu options that display content have a plain back-

ground. Submenus look likemainmenusbut are indented.

n When you first click amenu, it expands vertically.

When you click it a second time, it closes, so it looks like it did

when you first viewed it.

siteroot//Developer/Menu

/FlexMenu/Expanding/FMExpandDemo.aspx
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SampleMenu Description Location on Server

Fly-Out

n Menushave gradient background. The color

changeswhen you hover over it.

n Menu options that display content have a plain back-

ground. Their color changeswhen you hover over it. Sub-

menus look likemainmenusbut are offset to the right. (See

illustration below.)

n When you first click amenu, it expandshorizontally to

the right. When you click it a second time, it closes, so it

appears as it did when you first viewed it.

siteroot/Developer/Menu/FlexMenu

/FlyOut/FMFlyOutDemo.aspx

List

n Thismenu’s appearance is similar to the AjaxDemo

but it doesn’t use Ajax.

n Themenu is an unordered list.

n When you first click amenu, all text links are black.

When you click it a second time, it closes, so it appears as it

did when you first viewed it.

siteroot/Developer/Menu/FlexMenu

/List/FMListDemo.aspx

MasterSlave

Connects a slavemenu to amaster menu. In the graphic

below, the upper menu (master) shows the top two levels

while the lower (slave) menu shows levels three and on.

siteroot/Developer/Menu

/FlexMenu/MasterSlave/FMMSDemo.aspx
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SampleMenu Description Location on Server

XMLModify

Copying and Editing Sample Menus

To create your menu based on a sample, follow these steps.

1. Examine the sample menus and decide which one best meets your needs for a
particular page. See "Description of the Sample Menus" on page 9-166.

2. If you want to create a new template (.aspx page) for the menu, place the new
template in a new folder. Then, copy all files in the sample menu folder to the new
folder and rename each file. For example, change Ajaxdemo.aspx to
myflexmenu.aspx, AjaxDemo.css to myflexmenu.css, and demo.xsl to
myflexmenu.xsl.

To insert a FlexMenu server control onto an existing template, copy the .css and .xsl file

into the folder that contains the template.

Warning! If you specify an external file, it is strongly recommended that you do not store this file in your site'sWork-

area folder. If you store this file in theWorkarea folder, the file will be lost when you upgrade.

Warning! The renamed .css file namemust be all lowercase.
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3. Open the .aspx page. Update the stylesheet and DisplayXslt properties to refer to the new

.css and .xsl files.

If the files do not reside in the template’s folder, indicate their relative path using the

syntax where slash (/) indicates the site root.

4. Open the .css file. Update the parent class name to match the new file name. For
example, if you copied the AjaxDemo.css file, it looks like this.

Notice that every class begins with the file name, .AjaxDemo. Replace all occurrences of this

with the new file name. To continue the above example, begin all classes with .myflexmenu.

Working with the Flex Menu Xslt File
This section explains some non-intuitive elements of the*.xslt file.
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Element Context Description

MenuFragment

<xsl:when

test="/MenuDataResult/Info/

menuFragment='false'">

A flag that indicates the XML data is not

complete. Instead, it’s a fragment that

begins deeper than the top level (for

example, a submenu fragment).

Because the data is incomplete, the

XSLT processes the fragment

differently. For example, don’t

generate Javascript startup code.

menuConst

<xsl:attribute

name="id"><xsl:value-of

select="$menuConst"/>0_
ekflexmenu</xsl:attribute>

Eachmenu generates several

elements, which the client code

(Javascript) accesses via a unique ID.

For example, Javascript needs to

identify the selected submenu or item

when a user clicks on an element.

menuConst is only used iswhen

creating elementswithout a

corresponding XML block, such as

when creating a structure to hold the

menu.

#NoScroll

<xsl:attribute

name="href">#

NoScroll</xsl:attribute>

NoScroll is sent to the hrefportion of

a linkwhen there is nothing to put there

(for example, when the link is supposed

to run Javascript).

NoScrollprevents the page from

refreshing, going to another page, or

scrolling when it should not.

event

<xsl:attribute

name="onkeydown">return

ekFlexMenu.menuBtnKeyHdlr(

event);</xsl:attribute>

Tomake the xslt cross-browser

compatible, it must support different

methodsof obtaining/passing the event

object. In this example, the global event

object is passed to the handling

function.

Note: event corresponds to

window.event. window. is implied.

Setting up a Master/Slave Menu Relationship
A master/slave menu relationship is one in which a few top-level menu controls appear on the

master menu while all remaining menu levels appears on a slave menu (see graphic below).
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The best way to set up a master/slave menu relationship is to copy and edit the sample,

siteroot/Developer/Menu/FlexMenu/MasterSlave/FMMSDemo.aspx.

Whether you modify that sample or create your own from scratch, follow these guidelines.

n Ektron recommends starting with the .xsl files provided with the Master/Slave sample (FM

MasterDemo.xsl and FMSlaveDemo.xsl), since they are optimized to work with this kind

of menu relationship.

n Place both menu server controls (master and slave) on the same Web form (.aspx page).

n Both server controls must refer to the same DefaultMenuID.

- Give each server control a unique ID number. (This property is located under the Misc

properties, not Ektron.)

n For the master menu

- limit the MenuDepth property to the number of levels that will appear. In the above

example, the master menu‘s depth is set to 2.

- set the StartLevel to 0 or 1, since you want the highest level menu options to appear

n For the slave menu

- set the MenuDepth property to zero (0). The slave menu should show all lower menu

levels.

- set the StartLevel property to one number higher than the master menu’s MenuDepth

property. In this way, the slave menu takes over where the master menu leaves off.

- set the MasterControlID property to the ID number of the master menu. (This property

is located under the Misc properties, not Ektron.)

How the FlexMenu Server Control Determines Which
Item is Selected
The FlexMenu server control has the ability to select (highlight) options in a Flex menu as site visitors navigate
around the Web site. For example, a site visitor arrives at a Web page through a link in an email. If the
QueryString matches the an item in a Flex menu, the item is shown as selected.

Below is an overview of the logic that the Flex menu uses to decide when a menu item should show as selected.
The list is presented in the order in which the code checks to see if an item should be highlighted.
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If any menu item is selected, its parent menu is marked selected. If any menu is selected, all ancestor menus are
selected. When all tests have been performed and no matches are found, the Flex menu is rendered with no
items selected.

IMPORTANT!

Warning! Once a test is satisfied, the item is shown as selected and there are no further tests.

Note: Steps2 through 9 are each repeated recursively throughout themenu data hierarchyuntil either amatch is

found or the end is reached. If there are nomatches for a test, the control continueswith the next one.

1. Inspects the QueryString to see if the ekxmensel parameter is present with a matching menu node ID. This

parameter is used to specify the exact node a user clicked. The node, its parent, and ancestor menus are all

marked as selected.

2. Inspects the QueryString to see if a Content ID parameter with a given value matches an item in the menu.

If the Content ID passed in the QueryString matches an item in the Flex menu, that item is highlighted. For

example, the QueryString has ExamplePage.aspx?id=123 and there is an item on the menu item link that

matches the Content ID of 123.

3. Inspects the QueryString to see if a Form ID parameter with a given value matches an item in the menu. If

the Form ID passed in the QueryString matches an item in the Flex menu, that item is highlighted. For

example, the QueryString has ExamplePage.aspx?ekfrm=456 and there is an item on the menu item link

that matches the Form ID of 456.

4. Inspects the QueryString to see if there is a direct match with a menu item link. If there is a match, the

menu item is selected. For example, if the QueryString has ExamplePage.aspx and there is an item on the

menu that matches, the menu item is shown as selected.

5. Inspects the QueryString to see if the id, ekfrm or pageid parameter exists. If so, the control tests to see

if there is a folder association with any of it’s submenus and the folder that contains the object with the

given ID. If the association exists, the menu item is shown as selected.

6. Inspects the QueryString to see if there is a direct match with a menu button link. If there is a match, the

menu button is selected. For example, the QueryString has ExamplePage.aspx and there is a button on

the menu that matches.

7. Inspects the QueryString to see if there’s a template association with the filename. If there’s a match, the

menu item is shown as selected.

8. Inspects the QueryString for the id or ekfrm parameter and whether a value greater than zero is associated

with it. If so, the control then checks the menu buttons for use of LinkIt.aspx. If a button is using

LinkIt.aspx and either id or ekfrm parameter matches, the menu button is selected.

9. Tests to see if there is a URL-Aliasing issue. When the FlexMenu server control’s UseAliasRealId

property is set to True, the control scans the data to see if there is a MenuData item ID match.

Flex Menu Server Control Properties
The Flex Menu server control properties are described in this table.
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Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and

can use it to browse to Content, Collections, etc.

See Also: "Using CMSExplorer to Browse Your
Ektron CMS400.NET Site" on page 21-9

Boolean

AutoCollapseBranches

If you set to true, whenever a new submenu opens, all

other submenus close.

If false, other submenus remain open when a new one

opens.

Boolean

CacheInterval

Sets the amount of time the server control’s data is

cached. The default is 0 (zero). This is the amount of

time, in seconds, a control’s data is cached. For

example, if you want to cache the data for fiveminutes,

set this property to 300 (three hundred).See Also:
"Caching with Server Controls" on page 21-31

Double

DefaultMenuID

The ID of amenu that appearswhere you insert this

server control if no other menu is identified or available.

If you don’t know the ID number of themenu, use the

CMSExplorer to browse to it.

See Also: "Using CMSExplorer to Browse Your

Ektron CMS400.NET Site" on page 21-9

Long

DisplayXslt

The xsl file used to render themenu. If nothing is

specified, themenu is output as raw XML.

Flexmenusare designed to use the xsl file to control the

menu’s behavior, and the .css file to control its display.

Ektron CMS400.NET provides several samplemenus,

and each hasan xslt file. If this is a newmenu, youmay

find it easier to copyand edit an xslt file provided with a

samplemenu.See Also: . "SampleMenus" on
page 9-166

Warning! : If you want to edit this file, it is strongly rec-

ommended that youmake a copy, change its name

andmove it outside of your site'sWorkarea folder. If

youmake changes to this file and do not move it out of

theWorkarea, this file and the changeswill be lost

when you upgrade.

String
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Property Value
Data

Type

Set to true to enable Ajax, which only downloads sub-

menusasneeded.See Also: "AjaxDemo" on page
9-167

Boolean

EnableMouseOverPopup

If you set to true, submenusappear as soon as the

cursor movesover them.

If you set to false, submenusonly appear if a site visitor

clicks them or a keyboard equivalent.

Boolean

EnableSmartOpen

If you set to true, any submenu on the Smart Menu can

be set to open automatically. To learn about how to do

this, see "Assigning Folders or Templates to aMenu" on

page 9-158

If you set to false, even if all required conditionsare

present, submenuson a Smart Menu do not

automatically open.

This property lets you prevent submenus from opening

bydefault. Under some circumstances, such submenus

look cluttered.

Boolean

MasterControlId

Only use this property if you are setting up a

master/slavemenu relationship, and thismenu is the

slave. If both are true, enter the ID of themaster menu.

See Also: "Setting up aMaster/SlaveMenu
Relationship" on page 9-171

String
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Property Value
Data

Type

MenuDepth

To let site visitors browse through allmenu levels, enter

zero (0).

To restrict site visitors to amenu level, enter the number

of the lowest level.

In the following example, if you set this property to 1, a

site visitor can browse through theAbout Usmenu

optionsbut would not see the level 2 options (Company

Profile andCareers).

Integer

StartCollapsed
If you set to true, when themenu first appears, all

submenusare closed.
Boolean

WebSite Navigation Aids

9-176
ReferenceManual

Version 8.0 Rev 1.3



Property Value
Data

Type

StartLevel

Enter a number to indicate the level at which you want

thismenu to displaywhen it first appears. To begin the

menu display at the root level, enter zero (0).

In the following example. theHome folder is level 0. The

others are level 1.

A site visitor can click amenu option to navigate to

folders below the displayed level.

Integer

Stylesheet

Enter the style sheet that will determine the appearance

of themenus.

Flexmenususe an .xsl file to control their behavior, and

a .css file to control their display.

Ektron CMS400.NET provides several samplemenus,

and each hasa .css file. If this is a newmenu, youmay

find it easier to copyand edit a .css file provided with a

samplemenu.See Also: "SampleMenus" on page

9-166

String

SuppressAddEdit

When set to True, suppress the Add and Edit buttonson

themenu when a user is logged in to Ektron

CMS400.NET. The default is False.

True - suppress the Add and Edit button when a user is

logged in to Ektron CMS400.NET.

False - show the Add and Edit buttonswhen a user is

logged in to Ektron CMS400.NET.

Boolean

SuppressWrapperTags

This property is set to false because Ajaxuses<div>

tags to rewrite the region around the tag. You cannot

change the value to true.

Boolean
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Property Value
Data

Type

WrapTag

Allowsa developer to specify a server control’s tag. The

default isSpan.

Span - Use the <span> tag to designate an inline

portion of an HTML document asa span element.

Div - Use the <div> tag used to apply attributes to a

blockof code.

Custom - Use a custom tag.

String

(continued in Section 508 Compliance Features of Smart Menus)

Smart Menu Server Control
The Smart Menu server control displays a menu on a Web page.

Before you can use this server control, you must create a menu in the Ektron CMS400.NET

Workarea. To learn about creating menus, see "Working with Menus" on page 9-129l.

To learn about how the Smart Menus compare to other Ektron CMS400.NET menus, see

"Contrasting Menu Server Controls" on page 9-162.

Smart Menu Server Control Properties
The Smart Menu server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and

can use it to browse to Content, Collections, etc.

See Also: "Using CMSExplorer to Browse Your

Ektron CMS400.NET Site" on page 21-9

String
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Property Value
Data

Type

AutoCollapseBranches

If you set to true, whenever a new submenu opens, all

other submenus close.

If false, other submenus remain open when a new one

opens.

Boolean

CacheInterval

Sets the amount of time the server control’s data is

cached. For example, if you want to cache the data for

fiveminutes, set this property to 300. The default is zero.

See Also: "Caching with Server Controls" on page

21-31

Double

DefaultMenuID

The ID of amenu that appearswhere you insert this

server control if no other menu is identified or available.

If you don’t know the ID number of themenu, use the

CMSExplorer to browse to it.

See Also: "Using CMSExplorer to Browse Your

Ektron CMS400.NET Site" on page 21-9

Long

DynamicParameter
Selectmenu_id. When you do, this server control uses

themenu passed asa URL parameter.
String

Enable508compliance If you set to true, themenu will complywith Section 508. Boolean

EnableMouseOverPopup

If you set to true, submenusappear as soon as the

cursor movesover them.

If you set to false, submenusonly appear if a site visitor

clicks them or a keyboard equivalent.

Boolean

EnableSmartOpen

If you set to true, any submenu on the Smart Menu can

be set to open automatically. To learn about how to do

this, see "Assigning Folders or Templates to aMenu" on

page 9-158.”

If you set to false, even if all other conditionsare

present, submenuson a Smart Menu do not

automatically open.

This property lets you design pageswhose submenus

do not normally open bydefault. Under some

circumstances, such submenus look cluttered.

Boolean

Hide

Used to hide amenu in design time and run time.

True =Hidemenu

False =Showmenu

Boolean
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Property Value
Data

Type

Language

Set a language for viewingmenus. This property shows

results in design-time (in VisualStudio) and at run-time

(in a browser).

For more information, see "Working with Menus in a

Multi-Language System" on page 9-155.

Integer

LaunchLinksinNew

Window

If you set to true and a site visitor selects amenu option,

it appears in a new browser window.

If false, the new page replaces the current page in the

browser.

Boolean

ShowRootFolder

If you set to true, a menu option listing the title of the root

folder appears. If you set to false, the title of the root

folder doesnot appear.

Boolean

SingleEditButton

Set to true if you want to a single edit button (and no add

button) to appear on themenu when you are logged in.

If you set to false,Edit Menu and Add Menu options

appear at the bottom of everymenu and submenu.

Example of SingleEditButton = true

Boolean
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Property Value
Data

Type

SingleEditButton

(continued)

Example of SingleEditButton = false

Boolean

StartCollapsed
If you set to true, all submenusare closed when the

menu initially displays.
Boolean

StartWith RootCollapsed

If you set to true, themenu initially displayswith its root

menu closed.

Note: This property is ignored if the ShowRootFolder

property is set to set to false.

Boolean
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Property Value
Data

Type

Stylesheet

Enter the style sheet that will determine the appearance

of themenus. Menu style sheets reside in the site

root/workarea/csslib/smartmenu folder. You can

modify any standard style sheet or create your own.

Creating a Custom Style Sheet

To support more than one SmartMenu server control

per page, the CSS file's name is used asa classand is

prefixed to all selectors (without the path or extension).

The server controlwraps the entire SmartMenu in a

<div> tag, whose classname is derived from the

filename.

Only the base ASCII character set is supported. Also,

spacesand periodsbefore the extension are converted

to underscores, since these are not permitted within the

selector.

So, to create your own style sheet, each selector must

begin with the style sheet name. For example, .my_

custom_style_sheet .ekmenu.

String

SuppressAddEdit

When set to True, suppress the Add and Edit buttonson

themenu when a user is logged in to Ektron

CMS400.NET. The default is False.

True - suppress the Add and Edit button when a user is

logged in to Ektron CMS400.NET.

False - show the Add and Edit buttonswhen a user is

logged in to Ektron CMS400.NET.

Boolean

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the

control. The default is False.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag. The

default isSpan.

Span - Use the <span> tag to designate an inline portion

of an HTML document asa span element.

Div - Use the <div> tag used to apply attributes to a

blockof code.

Custom -Use a custom tag.

String
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Section 508 Compliance Features of Smart Menus
Ektron CMS400.NET’s Smart Menus are 508 compliant because they adhere to the following

principles. They

n are accessible - the navigation functionality is accessible to all users who interact with a

text-based Web page.

n can work without DHTML - Underneath the surface, Smart Menus are

rendered as an unordered list. By default, they are styled with CSS and made
dynamic with JavaScript. But, if you don’t use these features, the menu still
works although its look and feel are different.

n are 100% navigable via the keyboard; no mouse actions are required - Each

Smart Menu has an <H2> header, which is used by some screen readers (such
as Jaws) to assist visually impaired users with page navigation A list of all
headers is available via a key sequence.

Also, all menu items are wrapped in links, which allow screen readers to assist a visually

impaired user with page navigation. A list of links is available via a key sequence.

n do not rely on color to convey important information - the standard style sheets

use underlining and bold to (in addition to color) to distinguish normal from
selected menu options.

Also, “(Selected)” follows the title of selected items. This text is suppressed when viewed with

graphical browsers (such as IE6 and FireFox1.5) but is visible in text browsers and announced

when a screen reader is used.

n provide sufficient contrast - the standard style sheets emphasize contrasting

colors. In addition, because of the flexibility of Smart Menus, you can use your
creative and artistic resources to develop menus that are attractive and have
proper contrast.

n are understandable even when the style sheet is turned off

n let a screen reader skip repetitive navigation links

n when a user clicks a menu option, the screen reader proceeds to the new page -

it does not read the remaining menu items.

Note: To be sure your menusare 508 compliant, use either the treemenuex.cssor treemenuex_images.css style

sheet.

Retrieving the XML Structure of a Smart Menu
Retrieving the XML structure of XML content allows for greater control over developing

XSLs. The following is an example of how to retrieve the XML structure:

1. Open a new Web form.
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2. Drag and drop a SmartMenu server control onto it.

3. Set the DefaultMenuID property.

4. Drag and drop a Textbox on the Web form.

5. Set the TextMode property to MultiLine.

Note: It is also recommended that you set the width of the text box to at least 400px.

6. On the code behind page, add the following line.
Textbox1.Text = SmartMenu1.XmlDoc.InnerXml

7. Build the project.

8. View the Web form in a browser.

The XML structure of the Smart Menu appears in the textbox.

Menu Server Control
The Menu server control calls a menu to be displayed on a page. Using the Menu server

control, you can manipulate a menu by using the DisplayXslt property. Below is a menu

display with the SampleMenu XSLT.

Before you can use the Menu server control, you must create a menu in the Ektron

CMS400.NET work area. To learn about creating menus, "Working with Menus" on page 9-

129.

This subsection contains the following topics:

n "Menu Server Control Properties" on page 9-185

n "Using DisplayXslt Samples" on page 9-187

n "Retrieving the XML Structure of a Menu" on page 9-190

See Also: "Contrasting Menu Server Controls" on page 9-162
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Menu Server Control Properties
The Menu server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can

use it to browse to Content, Collections, etc.

See Also: "Using CMSExplorer to Browse Your

Ektron CMS400.NET Site" on page 21-9

String

CacheInterval

Sets the amount of time the server control’s data is

cached. The default is 0 (zero). This is the amount of time,

in seconds, a control’s data is cached. For example, if you

want to cache the data for fiveminutes, set this property to

300 (three hundred).See Also: "Caching with

Server Controls" on page 21-31

Double

DefaultMenuID

The ID of amenu that appearswhere you insert this

server control if no other menu is identified or available.

If you don’t know the ID number of themenu, use the

CMSExplorer to browse to it.

See Also: "Using CMSExplorer to Browse Your

Ektron CMS400.NET Site" on page 21-9

Long

DisplayXslt

The XSLT to use to render themenu.

None - databind only

SampleMenu - A sample display, formatted asa bulleted

menu list

TreeMenu - A sample display, formatted asa folder tree.

You can expand the tree by clicking on the folder icon.

Path to Custom Xslt - Enter the path to an XSLT that

determines the display of the page

For more information on using the SampleMenu and

TreeMenuDisplayXslt, see "Using DisplayXslt Samples"

on page 9-187.

Warning! : If you want to edit this file, it is strongly rec-

String
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Property Value
Data

Type

ommended that youmake a copy, change its name and

move it outside of your site'sWorkarea folder. If you

make changes to this file and do not move it out of the

Workarea, this file and the changeswill be lost when you

upgrade.

DynamicParameter
Selectmenu_id. When you do, this server control uses

themenu passed asa URL parameter.
String

Hide

Used to hide amenu in design time and run time.

True =Hidemenu

False =Showmenu

Boolean

Language

Set a language for viewingmenus. This property shows

results in design-time (in VisualStudio) and at run-time (in

a browser).

For more information, see "Working with Menus in a

Multi-Language System" on page 9-155.

Integer

Stylesheet

Specify the location and style sheet for themenu. For

example: \Workarea\csslib\mytest.css.

Leave blank to use the default.

global.css is the default style sheet. It is located in

\webroot\siteroot\Workarea\csslib.

String

SuppressAddEdit

When set to True, suppress the Add and Edit buttonson

themenu when a user is logged in to Ektron

CMS400.NET. The default is False.

True - suppress the Add and Edit button when a user is

logged in to Ektron CMS400.NET.

False - show the Add and Edit buttonswhen a user is

logged in to Ektron CMS400.NET.

Boolean
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Property Value
Data

Type

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the

control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline

portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply

attributes to a blockof code.

Custom - Allows you to use a custom tag.

String

Using DisplayXslt Samples
Two DisplayXslt samples are provided with the Menu server control, SampleMenu and

TreeMenu. This section explains how to use them.

Warning! If you want to edit either of these files, it is strongly recommended that youmake a copy, change its

name andmove it outside of your site'sWorkarea folder. If youmake changes to this file and do not move it out of

theWorkarea, this file and the changeswill be lost when you upgrade.

SampleMenu
The SampleMenu DisplayXslt lets you display an Ektron CMS400.NET menu as a bulleted

item list. See below for an example.
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When you are logged in to your Ektron CMS400.NET site, two menu items are added to each

section of the menu: Add and Edit Menu. The user can use these to add a new menu item or

edit an existing one. See example below.

For Information on a adding a menu Item, see"Adding New Content to a Menu via Navigation

Link on a Web Page" on page 9-145.

For Information on a editing a menu, see"Editing a Menu via Navigation Link on a Web Page"

on page 9-147.

SampleMenu XSL code
For an example of the XSL code used in the SampleMenu, click the following link and choose

the appropriate version.

http://dev.ektron.com/kb_article.aspx?id=2114

TreeMenu
The TreeMenu DisplayXslt lets you display an Ektron CMS400.NET menu as a clickable

folder list. You can expand and collapse the menu by clicking on the folder icons. See below

for an example.
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When you are logged in to your Ektron CMS400.NET site, two menu items are added to each

section of the menu: Add and Edit Menu. The user can use these to add a new menu item, or

edit an existing menu item. See example below.

For Information on a adding a menu Item, see "Adding New Content to a Menu via

Navigation Link on a Web Page" on page 9-145.

For Information on a editing a menu, see "Editing a Menu via Navigation Link on a Web

Page" on page 9-147.

Note: When using the TreeMenu server controlwith VisualStudio andWindows2003, the folder imagesdo not

displayduring design-time. Theydo, however, display correctly during run-time.
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TreeMenu XSL Code
For an example of the XSL code used in the MenuTree, click the following link and choose

the appropriate version.

http://dev.ektron.com/kb_article.aspx?id=2114

Retrieving the XML Structure of a Menu
Retrieving the XML structure of XML content allows for greater control over developing

XSLs. The following is an example of how to retrieve the XML structure:

1. Open a new Web form.

2. Drag and drop a Menu server control onto it.

3. Set the DefaultMenuID properties.

4. Drag and drop a Textbox on the Web form.

5. Set the TextMode property to MultiLine.

Note: It is also recommended that you set the width of the text box to at least 400px.

6. On the code behind page, add the following line.
Textbox1.Text = Menu1.XmlDoc.InnerXml

7. Build the project.

8. View the Web form in a browser.

9. The XML structure of the menu appears in the textbox.
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For an additional example, see the Menu XML page on the CMS400Developer samples page.

It is located at:

In a browser:

http://<site root>/CMS400Developer/Developer/Menu/MenuAsXML.aspx

In the source code:

<site root>/CMS400Developer/Developer/Menu/MenuAsXML.aspx and MenuAsXML.aspx.vb

DhtmlMenu Server Control

Note: For optimal performance, Ektron recommendsusing at minimum Internet Explorer 5.5 or Mozilla Firefox

1.0. Also, the following KBarticle describesa possible problem using a DHMTLmenuwith Internet Explorer 8:

http://dev.ektron.com/kb_article.aspx?id=26942.

The DhtmlMenu server control lets you display a menu with drop down boxes and submenus.

This lets developers add a menu to a page without taking up a lot space. You can modify the

menu’s style properties via a style sheet.

Before using the DhtmlMenu server control, you must create menus in the Ektron

CMS400.NET workarea. See "Working with Menus" on page 9-129.

The DhtmlMenu server control also lets logged in users add content to a menu. When you are

logged in to your Ektron CMS400.NET site, two items are added to each menu: Add and Edit

Menu. Use them to add a new menu item or edit an existing one. See example below.
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For Information on a adding a menu item, see "Adding New Content to a Menu via Navigation

Link on a Web Page" on page 9-145.

For Information on a editing a menu, see "Editing a Menu Item via Navigation Link on a Web

Page" on page 9-150.

Warning! You cannot create a DHTMLmenu using code behind -- youmust drag and drop it. Once a DHTML

menu is on aWeb form, you canmanipulate its properties using the code behind.

This subsection contains the following topics:

n "DhtmlMenu Server Control Properties" on page 9-192

n "Using a Style Sheet" on page 9-197

n "Formatting the DhtmlMenu Server Control" on page 9-198

See Also: "Contrasting Menu Server Controls" on page 9-162

DhtmlMenu Server Control Properties
The DhtmlMenu server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.
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Property Value Data Type

Align

Specifies the horizontal alignment of

the root menu text.

The default isCenter.

NotSet - Use the default setting.

Left - Aligns text to the left.

Center - Aligns text to the center.

Right - Aligns text to the right.

Justify - Aligns text justified to bothmargins.

HorizontalAlign

Authenticated

Indicates if you are logged in to the CMSExplorer

and can use it to browse to Content, Collections, etc.See
Also: "Using CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9

String

CssClass

Apply a .css class to the root menu. Enter the classname from the

.cssdefined in the Stylesheetproperty.See Also:
"Stylesheet" on page 9-195

Since pop_style.css is the default style sheet, you can use its

classeswithout defining it in the Stylesheetproperty.

For example, if you enter lowtext in the property, the root menu

changesas shown below.

String

DefaultMenuID

The ID of amenu that appearswhere you inserted this server

control if no other menu is identified or is available.

If you don’t know the ID number of themenu, use the CMS

Explorer to browse to it.See Also: "Using CMSExplorer to

Browse Your Ektron CMS400.NET Site" on page 21-9

Long

DynamicParameter
Selectmenu_id. When you do, this server control uses themenu

passed asa URL parameter.
String

EnableIE6FormsFix

This should only be enabled when you have a DHTMLmenu

rendering over an HTML select element. In IE6, the DHTML

renders below the drop down. This temporarily disables the

element when the DHTMLMenu is rendered.

Boolean

Hide

Used to hide amenu in design time and run time.

True =Hidemenu

False =Showmenu

Boolean
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Property Value Data Type

HorizontalDisplay

Displays submenu to the right of the root menu. This only affects

the first submenu of the root menu. All subsequent submenus

appear to the right of each submenu.

The default isFalse

True =Submenu appears to the right of the root menu

False =Submenu appears below the root menu

Boolean

Language

Set a language for viewing DhtmlMenus. This property shows

results in design-time (in VisualStudio) and at run-time (in a

browser).

For more information, see"Working with Menus in aMulti-

Language System" on page 9-155

Integer

MenuHoverOverColor
Sets the background color for the root menu when hovering over

it.
Color

MenuStyle

A specified inline style that defines the root menu. For example:

font: bold 18px Arial;color:royalblue; background-

color:slateblue
String
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Property Value Data Type

Stylesheet

Specify the location and style sheet for the submenu. For

example: \Workarea\csslib\mytest.css.

Leave blank to use the default.

pop_style.css is the default style sheet. It is located in

\siteroot\Workarea\csslib. For more information on style

sheets, see "Using a Style Sheet" on page 9-197.

You can use the Stylesheetproperty in conjunction with the

CssClassproperty to define the root menu.See Also:
"CssClass" on page 9-193

String

SubMenuBackColor Sets the background color for the submenu. Color

SubMenuHoverOverColor
Sets the background color for the submenuwhen the cursor

hovers over it.
Color

SubMenuItemHeight

Sets the height of each submenu item in pixels. The default is 20.

Example set to 20:

Example set to 30:

Int16

SubMenuItemWidth

Sets the width of each submenu item in pixels. The Default is 150

Example set to 150:

Example set to 130:

Int16
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Property Value Data Type

SubMenuTopOffset

Sets the location of the top of the submenu relative to its parent.

This number, in pixels, refers to the number of pixels the

submenu appears below the parent menu. The default is 5.

Example set to 5:

Example set to 0 (zero):

Example set to -10:

Int16

SuppressAddEdit

When set to True, suppress the Add and Edit buttonson the

menu when a user is logged in to Ektron CMS400.NET. The

default is False.

True - suppress the Add and Edit button when a user is logged in

to Ektron CMS400.NET.

False - show the Add and Edit buttonswhen a user is logged in to

Ektron CMS400.NET.

Boolean

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control.

The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline portion of

an HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a

blockof code.

Custom - Allows you to use a custom tag.

String
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Using a Style Sheet
You can create your own style sheet, or modify the existing default one, pop_style.css. It is

located in \site root\Workarea\csslib.See Also: "pop_style.css" on page 9-197

Style Sheets let you choose different text colors, text alignment, text fonts, and text size to

create a customized menu.

Best Practice

Ektron recommendscopying and renaming the default style sheet. This insures you

alwayshave a clean file to start with. This also gives you something to reference if you

are not getting the results you expect.

The style sheet must be located below the site root.

You can only define one menu style sheet for each Web page. If you have more than one

menu on a single Web page, they share a style sheet.

For more information on style sheets, visit http://www.w3.org/Style/CSS/.

pop_style.css
This file is located in webroot/siteroot/Workarea/csslib. It is used to customize the look of

the DhtmlMenu server control. The following is a list of style sheet properties that can be

modified.

Style Class Description Attribute
Default

Value

.lowText

Text of the

floatingmenu

asdisplayed

on themenu.

n color

n font

n text-

align

n text-

decoration

n
#000000

(Black)

n 12px

Arial, sans-

serif

n left

n none
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Style Class Description Attribute
Default

Value

.highText

Text of the

floatingmenu

when

highlighted.

n color

n font

n text-

align

n text-

decoration

n
#000000

(Black)

n 12px

Arial, sans-

serif

n left

n none

.roothighText

Note: This classonly

workswhen called by the CssClass

property. Use the Fontproperty

in the Appearance category

to define root menu text.

Text of the

root menu as

displayed on a

Web page.

n color

n font

n text-

align

n text-

decoration

n
#000000

(Black)

n 16px

Arial, sans-

serif

n
center

n none

.itemBorder

Border color

and size of the

menu.

n bor-

der

n 1px

solid

#666666

.itemBorderBlank

Separator

border color

and size of the

menu.

n bor-

der

n 1px

solid

#CCCCDD

Formatting the DhtmlMenu Server Control
Additional information on formatting the DhtmlMenu server control can be found in the

following Knowledge Base article.

http://dev.ektron.com/kb_article.aspx?id=2441
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Retrieving the XML Structure of a DhtmlMenu
Retrieving the XML structure of XML content allows for greater control over developing

XSLs. The following is an example of how to retrieve the XML structure:

1. Open a new Web form.

2. Drag and drop a ContentList server control onto it.

3. Set the DhtmlMenuID property.

4. Drag and drop a Textbox on the Web form.

5. Set the TextMode property to MultiLine.

Note: It is also recommended that you set the width of the text box to at least 400px.

6. On the code behind page, add the following line.
Textbox1.Text = DhtmlMenu1.XmlDoc.InnerXml

7. Build the project.

8. View the Web form in a browser.

The XML structure of the DhtmlMenu appears in the textbox.
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Taxonomy

Large amounts of content can be an organizational nightmare, and it takes a far

reaching categorization model to allow content to be efficiently repurposed,

searched for, and organized on a site. Ektron’s taxonomy, a one-to-many

relationship model, follows natural and organic methods all the way down to the

content level, enabling an intuitive organization scheme that reflects how people

think.

Click the following link to see a video introduction to taxonomy in Ektron CMS400.NET:

http://www.ektron.com/learningcenter/taxonomy/taxonomy.html.

Ektron’s taxonomy is a content-level categorization system that uses one-to-many relationships

to create a scalable organization of content. Content is categorized in the database by how it

relates to multiple categories, allowing it to be accessed in multiple ways for multiple

purposes. The hierarchy of the content is arranged from the general to the specific, and there

may be multiple “routes” that define the content at the end of the hierarchy.

This type of categorization lets you create a navigation structure (independent of the folder

structure) that matches the way different site visitors want to find what they are looking for.

For example, Arnold Schwarzenegger can be thought of as an actor, Mr. Olympia or as a

California governor. Taxonomy creates a one-to-many relationship with any content about
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Schwarzenegger and auto-generates navigation which can support all of the approaches to

accessing any content about him. Site visitors can find the content whichever way that they

think about it.

Ektron’s taxonomy system plays key roles in more than just organizing content.

CMS400.NET’s URL Aliasing is able to auto-generate human readable and SEO-friendly

addresses based on the taxonomic structure of the page. Because it is using the various ways

that people relate to the content to determine the alias, search engines will find it based on

multiple terms as well.

A taxonomy directory control can automatically create the navigation on your Web site. Once

the content is tagged, it automatically shows up in the correct section of the site. The author

doesn’t need to know where the content is going to show up, the taxonomy tagging will

determine that. If you are managing large amounts of information, this use of taxonomy is

especially powerful.

Taxonomy can also improve search functionality, and Ektron’s integrated search takes full

advantage of it.

Introduction to Creating a Taxonomy
When working with content, you can place a listing of those categories (a taxonomy) on a

Web page. When that page displays, the taxonomy’s categories appear, followed by all

published items in the taxonomy.

To help site visitors find your Web site’s content via a taxonomy, your developer places a

Directory server control on a Web page. It looks something like this.
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See Also: "Directory Server Control" on page 9-241

There is no limit to the number of category levels you can assign to a taxonomy.

Also, a taxonomy can provide a link to all content in a folder, so the display is based on folder

structure. Alternatively, you can assign content items from various folders to a taxonomy.

To illustrate the benefits of a content-based taxonomy, assume your Web site is for a college.

Several items relating to the graduate school are organized under major departments:

Admissions, Academics, Faculty, Library, etc. You can create a Graduate School taxonomy, use

it to categorize all content relevant to graduate students (regardless of their department), and

display them on a graduate students page.

The following sections explain Taxonomies in more detail.

n "Creating a Taxonomy" on page 9-202

n "Assigning a Taxonomy/Category to Content or Users" on page 9-212

n "Additional Taxonomy/Category Tasks" on page 9-221

n "Directory Server Control" on page 9-241

Creating a Taxonomy
Follow these steps to create and deploy a taxonomy.

1. "Planning the Taxonomy " on page 9-202

2. "Creating a Taxonomy" on page 9-203

3. "Applying a Template to a Taxonomy or Category" on page 9-207

4. "Assigning a Taxonomy Configuration" on page 9-210

Planning the Taxonomy
It helps to design a taxonomy on paper before creating it in Ektron CMS400.NET. This can let

you determine relationships among the kinds of information before you try to implement the

taxonomy.

As an example, here is a hierarchy of some content in the Ektron CMS400.NET sample site.

The top level item is the taxonomy. All levels below it are categories.

WebSite Navigation Aids

9-202
ReferenceManual

Version 8.0 Rev 1.3



Next, review the site content and decide which content items and folders to assign to which

taxonomy categories. Some categories may map directly to a folders. Other categories may use

content from several folders.

Once you determine how content and folders will be assigned to taxonomy categories, sign on

to Ektron CMS400.NET and set up those relationships.

Creating a Taxonomy

Note: Onlyadministratorsor users to whom the Taxonomy-Administrator role hasbeen assigned see the

Content > Taxonomy option. See Also: "Defining Roles" on page 15-32

1. From the Workarea, go to Content > Taxonomies.

2. Use the language selector pull-down to choose a language for the taxonomy (see below).

See Also: See "Creating a Taxonomy in a Multi-Language Environment" on page 9-236
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3. Click the Add Taxonomy button ( ).

4. The Add Taxonomy screen appears.

5. Use the following table to complete the screen.
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Taxonomy Field Description

Field Description

For more

information,

see

CategoryTitle
Give the taxonomya title. The title identifies the taxonomy

wherever it appears.

Category

Description

If desired, enter amore complete description of the

taxonomy. It appears only on the Edit Taxonomyscreen.

Taxonomy

Image

If desired, you can assign an image to this taxonomy. For

example, in the eCommerce feature, you could display this

taxonomy image to indicate the type of products that make

up the taxonomy.

To display the taxonomy image, use Ektron CMS400.NET’s

API. A sample of how to do this is provided in the following

file: site root/developer/taxonomy/taxonomy_

image.aspx.

To see the sample on aWeb page, go to theDeveloper

sample page > Taxonomy > Taxonomy Image. To

download the developer sample site, go to

http://www.ektron.com/solutions/startersites/.

Template
If desired, select a template to apply to the taxonomyor

category.

"Applying a

Template to a

Taxonomyor

Category" on

page 9-207

Inherit (only

appearswhen

creating a

category

underneath a

taxonomy)

Check this box if you want this category to inherit its

template from the parent category or taxonomy. If not,

assign a template using the Template field (above).

Category Link

Use this field to direct aWeb site visitor who clicks this

taxonomy/category to anypage on your Web site. For

example, when someone is using your site’s company

directory and clicksHumanResources>Benefits, he is

directed to that area of your Web site.

Without a Category Link, if a site visitor clicks a taxonomy

category, the results appear on the same page.

Enter a path to a destination page relative to your site root

folder. For example, aboutus.aspx. When a site visitor
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Field Description

For more

information,

see

clicks this taxonomy/category, he is directed to

http://your URL/Site root folder/aboutus.aspx.

You could also direct the user to a content ID, such as

aboutus.aspx?id=62.

Display?

Check this box if you want this taxonomy/category and its

subcategories to appear when this taxonomyappears on

your Web site.

Use this field to block certain categories from appearing as

part of this taxonomy. For example, you have not finished

creating content for the category, so you don’t want it to

appear yet.

If you uncheck this box, this node and its child nodesare

indicated bya graybackground (see image below).

The graybackground also appearswhen usersworkwith

this taxonomy/category on the Edit Content screen’s

Category tab.

This setting doesnot prevent you from assigning

taxonomies/categories in the Ektron CMS400.NET

Workarea.

Configuration

Select a configuration with which to associate the

taxonomy.

n Content

n User

n Group

Notes:

* Bydefault, a new taxonomy’s configuration is content.

* This field only appears for a taxonomy. It doesnot appear

for categories, which are below the taxonomy.

"Assigning a

Taxonomy

Configuration"

on page 9-210

6. Click the Save button ( ).

7. The View Taxonomies screen appears.

8. Next, add categories to this new taxonomy. To do this, Click the Add Category button (

) .
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9. The Add Category screen appears.

10. Enter the Category information. When finished, Click the Save button ( ) to save this
category.

11. Repeat this process for each category you wish to add to this taxonomy.

.

Note: You can also assign a Taxonomy to content using the Edit Content in Folder screen’sCategory tab.

12. If you want to add categories and subcategories underneath the top level taxonomy, Right

Click on the taxonomy and choose Add Taxonomy.

Applying a Template to a Taxonomy or Category
Taxonomy categories are designed to help site visitors find content. To provide a taxonomy-

based search, your developer places a Directory server control on a Web page.

By default, when a user clicks a hyperlink on such a Web page, it uses the template assigned

to the linked content (as illustrated below). See Also: "Creating/Updating Templates" on page

7-184
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If you want to display the linked content using a different template, follow these steps.

1. When creating or editing a taxonomy or category, select the appropriate template at the

Template pull-down field.
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Note: Anycategorybelow the root level can inherit its parent’s taxonomy template. Use the Inherit checkbox to

do this.

You may need a developer’s help with the rest of these steps.

2. In Visual Studio.Net, open the .aspx page that contains the directory server control.

3. Look at the server control’sMarkupLanguage property.

4. If the property is blank, open the following file: site

root/workarea/template/taxonomy/taxonomy.ekml.

If the property displays an .ekml file, open that file. Its path may be listed in the property.

If the .ekml file’s path is blank, it is workarea/template/taxonomy/.

5. Find the following line:
[$HyperLink]<br/>[$Teaser]

6. Replace it with the following:
<a href="[$TemplateQuickLink]">[$Title]</a><br/>[$Teaser]

7. Save the .ekml file.

The content selected from this Directory server control will now use the template assigned to

the taxonomy/category.
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Assigning a Taxonomy Configuration
There are three taxonomy configurations (that is, types). Each taxonomy is one of these types -

content, user, or group.

Configuration Result

Content

Associate this taxonomywith content.When this configuration is selected

n you can assign content to the taxonomy/category

n the taxonomycategory appears on every folder’s properties screen

(shown below)

User

Associate this taxonomywith CMSor membership users. You select users

for this taxonomyon the Assign Items to Taxonomyscreen.

After users are assigned to a taxonomy, they can be found via the

CommunitySearch server control’sAdvanced tab. From theAdvanced

tab, selectCategory from theUsers dropdown. Next ClickSelect and a

User Categories selector appears (shown below).
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Configuration Result

See Also:

Group

This taxonomy‘s categories can be assigned to community groups from the

Category tab of the Edit CommunityGroup screen. See example below.

If you do not check this box, users can only view taxonomy/category

assignments on theCategory tab.

Whether or not this box is checked, you can assign taxonomycategories to

community groups via the View AllCategories of Taxonomyscreen.

Numbers on the View Categories Screen
When editing content, when you choose the Category tab, you will see the Taxonomy that

applies to this content. The number to the right of any taxonomy/category is a cumulative total

of all items assigned to it and its subcategories. In the example below, the three subcategories

have a total of 13 items (2 + 1 + 10).

Creating a Taxonomy

ReferenceManual

Version 8.0 Rev 1.3
9-211



Since the number to the right of the parent category equals the number assigned to all

subcategories, you know that no items are assigned to the parent category.

Also, the number includes individual items plus all items in any assigned folders. So, for

example, if one content item and one folder are assigned to a category, and the folder has five

items, the category’s number is six.

Assigning a Taxonomy/Category to
Content or Users
There are three ways to assign a taxonomy or category to content or users.

To assign a a

taxonomy category

to

Available

methods
Prerequisites

For more information,

see

Content

Note: Regardlessof the

method you use to assign

a taxonomy to content,

the result is the same.

from the

Edit

Content in

Folder

screen

n Must be

authorized to edit

the folder’s con-

tent

n You can only

select from tax-

onomiesassigned

to the content’s

folder

"Content Editor-Based

TaxonomyAssignment" on

page 9-213

from the

Content

Tab >

Taxonomy

screen

Must bemember

of administrators

group or

Taxonomy

administrator

"Administrator-Based

TaxonomyAssignment" on

page 9-216

Users

from a

community

group

Taxonomy’s

Configuration >

Group checkbox

is checked

"Assigning a Taxonomyor

Category to Community

Group via the Edit

CommunityGroup Screen"

on page 9-220
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Content Editor-Based Taxonomy Assignment
Ektron CMS400.NET lets content editors assign a taxonomy category to content. They do this

by navigating to a content block, clicking its Category tab, opening a taxonomy, and

checking the correct level.

However, all taxonomies may not be available to every content item. Use a folder property's

Taxonomy area to control which taxonomies can be assigned to a content in that folder.
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For example, a folder’s content consists of restaurants, and you want to restrict users to the

Restaurant taxonomy -- users cannot assign other categories to that folder’s content.

The following topics explain how administrators set up a folder’s taxonomy properties, and

how a user assigns taxonomy categories to content in that folder.

n "Assigning Taxonomies to a Folder" on page 9-214

n "Inheriting Taxonomies from a Parent Folder" on page 9-215

n "Requiring Content to Have at Least One Category Assigned" on page 9-215

n "Assigning a Taxonomy or Category to Content via the Edit Content Screen" on page 9-

215

Assigning Taxonomies to a Folder
To make a taxonomy available to a folder, follow these steps.

1. Navigate to the folder by Clicking Content> Folders.

2. Choose View > Properties.

3. Click Edit ( ).

4. In the Taxonomy tab, uncheck the Inherit Parent Taxonomy Configuration checkbox.

See Also: "Inheriting Taxonomies from a Parent Folder" on page 9-215

5. Check taxonomies that should be available to this folder.

6. From now on, users editing content in this folder can assign categories from the selected

taxonomies.
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Inheriting Taxonomies from a Parent Folder
Unlike some folder properties, Taxonomy settings are not inherited from a parent folder by

default. But you can cause them to be inherited if that is appropriate.

If you are not working on the root folder and the appropriate set of Taxonomies is applied to a

folder’s parent folder, go to the folder’s properties screen and check the Inherit Parent

Taxonomy Configuration checkbox.

Requiring Content to Have at Least One Category Assigned
In the folder properties, you can require all content to be assigned at least one taxonomy

category. If you do, when content in that folder is saved, Ektron CMS400.NET checks for at

least one taxonomy category. If none is found, the user is notified that he must assign a

taxonomy category before he can save the content.

To set a folder-level requirement for all content to be assigned a taxonomy category, follow

these steps.

1. Navigate to the folder.

2. Choose View > Properties.

3. Choose the Taxonomy Tab.

4. Check the Require at Least One Category Selection checkbox.

Assigning a Taxonomy or Category to Content via the Edit
Content Screen

1. Select the content and Click the Edit button ( ).

2. Click the Category Tab.
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3. Check the taxonomies or categories to apply.

4. Save the content.

Administrator-Based Taxonomy Assignment

Assigning Content to a Taxonomy/Category
Members of the administrators group or taxonomy administrators can assign taxonomy

categories to content via the View All Categories of Taxonomy screen. See Also: "Defining

Roles" on page 15-32

1. From the Workarea, go to Content > Taxonomies.

2. Select a language whose taxonomies you want to work with (see image below). You can

choose All.
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3. Select a taxonomy.

4. Select the category to which you want to assign content.

5. Right Click and choose Assign Item(s).

6. Choose the object type of the item to associate.

7. If you selected Content as the object type, you can narrow down the type of content you

wish to see via the Type pulldown.

n All types - both archived and active content

n Content - active content only
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n Archived Content - only content that has been archived and set to remain on site. See

Also: "Setting Archive Options" on page 7-198

8. Navigate to the folder that contains the content you want to assign to the taxonomy or

category.

or

Search for the user or community group to assign to the taxonomy or category.

Note: Folder content appearsbelow the folder list (see below). Also, only content in the selected language

appears.

9. Check the box to the left of content, user or community group you want to assign. You

can assign all types of content, even blogs.

Assigning a Folder to a Taxonomy/Category
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Note: If you assign a folder, the internal relationship is between the folder’s content and a taxonomycategory.

The folder ismerely a convenience for creating this relationship. There is no data connection between a folder and

a taxonomycategory.

You can assign a folder to a taxonomy, thereby displaying published content in the folder

when the page is viewed. As content is added to or removed from the folder, the taxonomy on

the Web page changes dynamically.

For example, you have a “Top News Stories” folder, in which old news items are frequently

replaced by newer ones. The taxonomy only shows the latest news items. The updating of the

content is handled by the taxonomy automatically.

Note: Onlyadministratorsor users to whom the Taxonomy-Administrator role hasbeen assigned see the

Content > Taxonomies option. See Also: "Defining Roles" on page 15-32

To assign a folder to a taxonomy category, follow these steps.

1. From the Workarea, go to Content > Taxonomies.

2. Select the language of the taxonomy on which to work.

3. Select the taxonomy or category under which you want to assign a folder.

4. Right Click and choose Assign Folder(s).

5. Navigate to the folder you want to assign to the taxonomy or category.

6. Check the box to the left of all folders you want to assign.
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Warning! Only checked folders are assigned to the taxonomy/category. Checking a parent folder hasno effect on

its child folders.

Assigning a Taxonomy or Category to Community
Group via the Edit Community Group Screen
Prerequisite

You can perform this procedure only if a taxonomy’s Configuration > Group check box is

checked.

If it is not checked, you can view the taxonomy categories assigned to a Community Group on

the Edit Community Group Screen. And, you can assign Community Groups to a Taxonomy

via the View all Categories of Taxonomy screen.

1. In the Workarea, navigate to Settings > Community Management > Community Groups

> Groups.

2. Select a community group.

3. Click the Edit button.
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4. Select the Category Tab.

5. Check the taxonomies or categories to apply.

6. Click the Save button.

Additional Taxonomy/Category Tasks
The following sections explain additional tasks you can perform when working with a

Taxonomy or its categories.

n "Viewing All Taxonomies" on page 9-221

n "Viewing a Taxonomy" on page 9-222

n "Edit a Taxonomy/Category’s Fields" on page 9-226

n "Delete a Taxonomy/Category" on page 9-226

n "Add a Category to a Taxonomy/Category" on page 9-227

n "Remove Content from a Taxonomy/Category" on page 9-228

n "Remove Folder from a Taxonomy/Category" on page 9-229

n "Change Order of Categories Assigned to a Taxonomy/Category" on page 9-230

n "Change Order of Content Assigned to a Taxonomy/Category" on page 9-231

n "Importing and Exporting a Taxonomy" on page 9-232

Viewing All Taxonomies
The View All Taxonomies screen displays all taxonomies currently in Ektron CMS400.NET.

The language pull down lets you filter the list by a language.

Additional Taxonomy/Category Tasks

ReferenceManual

Version 8.0 Rev 1.3
9-221



To work with any taxonomy, select it. When you do, it appears within the View All

Categories of Taxonomy screen.

You can also use the View All Taxonomies screen to perform these tasks.

Button Task For more information, see

Add new taxonomy See "Creating a Taxonomy" on page 9-202

Delete one or more

taxonomies

"Deleting a Taxonomy from the View All Taxonomies

Screen" on page 9-227

Import a taxonomy "Importing and Exporting a Taxonomy" on page 9-232

Export for Translation See "Exporting a Taxonomy" on page 9-233

Viewing a Taxonomy
The View All Categories of Taxonomy screen exposes all categories in a selected taxonomy.

Use this screen to perform tasks on a taxonomy or one of its categories, such as adding new

categories, assigning content to a category, and changing the order of items.

Note: On the View AllCategoriesof Taxonomyscreen, a box indicates the selected Taxonomy/category (see

below).

To access the View All Categories of Taxonomy screen, follow these steps.

1. From the Ektron CMS400.NET Workarea, go to Content > Taxonomies and Click on the

top Taxonomy node to see all taxonomies.
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2. Use the language pull-down to select the language of the taxonomy you want to work

with.

3. Click a taxonomy item. The View Taxonomy screen appears.

Tasks you can perform from this screen are listed below.
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Task How to initiate
For more information,

see

View Languages

Choose from the drop down

selector the language of the

taxonomyyou wish to view/change.

View Types

Choose from the drop down
selector the type of taxonomy
you wish to view/change.

Edit a taxonomy’s fields

and properties ClickEdit toolbar button ( )

Delete a taxonomyor

category ClickDelete toolbar button ( )

"Deleting a Taxonomy from

the View All Taxonomies

Screen" on page 9-227

Export a taxonomy
ClickExport Taxonomy toolbar

button ( )

"Exporting a Taxonomy" on

page 9-233

Add a taxonomy

category

1. Select the taxonomy/category

under which the new category

should appear.

2. Click the Add Category

button( ).

Change the order of

items in a

taxonomy/category

1. Select the taxonomy/category

you wish to reorder

2. Click the Reorder button (
)

from the toolbar.

"ChangeOrder of

CategoriesAssigned to a

Taxonomy/Category" on

page 9-230

Assign content items to

a category

1. Select the taxonomy/category

to which you wish to add items.

2. ClickAssign Items ( )
from the toolbar.

Assign folders to a

category

1. Select the taxonomy/category

to which you wish to assign

folders.

2. ClickAssign Folders ( )
from the toolbar.
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Viewing a Taxonomy or Category
To view any taxonomy or category, click it. The screen on the right shows all items associated

with this category.

The View Taxonomy screen displays the Title of the items assigned to this taxonomy category.

Additionally, the ID and Language ID are shown.

From the View Taxonomy screen, you can choose to filter the list by taxonomy type (Folders,

Content, Users, Community Groups) by selecting the View dropdown.

From here, you can perform these tasks.

Task Directions

Edit taxonomy/category fields (title,

description, image, etc.)

See "Edit a Taxonomy/Category’s Fields" on

page 9-226.

Remove items (content, folders, users or

community groups) from the

taxonomy/category

See "Deleting a Category from the View All

Categories of TaxonomyScreen" on page 9-

227
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Edit a Taxonomy/Category’s Fields
To edit a Taxonomy’s fields, follow these steps.

Note: Onlyadministratorsor users to whom the TaxonomyAdministrator role hasbeen assigned see the

Content > Taxonomies option. See Also: "Defining Roles" on page 15-32

1. From the Workarea, go to Content > Taxonomies.

2. Select the taxonomy from the list of taxonomies.

3. Click the Edit button ( ).

4. For a description of these fields, see

"Taxonomy Field Description" on page 9-205

Delete a Taxonomy/Category
There are two ways to delete a taxonomy or category.

n "Deleting a Taxonomy from the View All Taxonomies Screen" on page 9-227

n "Deleting a Category from the View All Categories of Taxonomy Screen" on page 9-227
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After you delete a taxonomy, it can no longer be assigned to content and folders. Further,

existing links to content (via the Category tab) are deleted. And, if the taxonomy was assigned

to a folder (via the Folder Properties screen), it is no longer assigned.

See Also: "Deleting a Taxonomy in a Multi-Language Environment" on page 9-237

Deleting a Taxonomy from the View All Taxonomies Screen

Note: Onlyadministratorsor users to whom the TaxonomyAdministrator role hasbeen assigned see the

Content > Taxonomies option. See Also: "Defining Roles" on page 15-32

1. From the Workarea, go to Content> Taxonomies.

2. From the View All Taxonomies Screen, check the box to the left taxonomy you want to

delete.

3. Click the delete button ( ).

Note: The delete button doesnot appear if the language selector is set toAll.

Deleting a Category from the View All Categories of
Taxonomy Screen
1. From the Workarea, go to Content > Taxonomies.

2. Select the taxonomy from the list of taxonomies. The taxonomy items and properties will

show on the right side of the screen.

3. To delete the taxonomy, Click on the Delete button ( ) and Click “Ok” on the pop-up
screen.

4. A confirmation message appears. Click OK.

Add a Category to a Taxonomy/Category
Follow these steps to add a category to a taxonomy, or to add a subcategory to a category.

Note: Onlyadministratorsor users to whom the TaxonomyAdministrator role hasbeen assigned see the

Content > Taxonomies option.See Also: "Defining Roles" on page 15-32

1. From the Workarea, go to Content Tab > Taxonomy.
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2. Select the taxonomy or category under which you want to create a new category.

3. Click the Add button ( ) from the popup menu.

4. The Add Category screen appears.

5. Complete the fields for the new category. See Also: "Taxonomy Field Description" on

page 9-205

6. Click the Save button ( ).

Remove Content from a Taxonomy/Category

Note: Onlyadministratorsor users to whom the TaxonomyAdministrator role hasbeen assigned see the

Content > Taxonomies option. See Also: "Defining Roles" on page 15-32

See Also:

1. From the Workarea, go to Content > Taxonomies.

2. Select a taxonomy or category from the Taxonomies tree on the left side of the screen that

you wish to change.

3. Check the box to the left of content you want to remove.
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Tip!To remove all content, check the box in the title bar.

4. Click the Remove Items button ( ).

Remove Folder from a Taxonomy/Category

Note: Onlyadministratorsor users to whom the TaxonomyAdministrator role hasbeen assigned see the

Content > Taxonomies option. See Also: "Defining Roles" on page 15-32

n "Background Information" on page 9-229

n "Steps for Removing a Folder from a Taxonomy" on page 9-229

Background Information
If you assign a content folder to a taxonomy category, the internal relationship is between the

folder’s content and a taxonomy category. A folder is merely a convenience for creating this

relationship. There is no data connection between a folder and a taxonomy category.

Therefore, if you delete a content folder from a taxonomy category, all content in that folder

remains assigned to it. To remove the folder’s content from the category, see "Remove Content

from a Taxonomy/Category" on page 9-228.

However, after deleting a content folder, the connection between the folder and taxonomy

category is broken. So, content subsequently added to the folder is not assigned to the

taxonomy.

Steps for Removing a Folder from a Taxonomy
1. From the Workarea, go to Content > Taxonomies.

2. Select the taxonomy or category that has the folder that you want to delete.

3. From the View dropdown, select Folder(s).
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4. Check the box to the left of folders you want to remove.

TIP!

Note: To remove all folders, check the box in the title bar.

5. Click the Remove Items button ( ).

Change Order of Categories Assigned to a
Taxonomy/Category

Note: Onlyadministratorsor users to whom the TaxonomyAdministrator role hasbeen assigned see the

Content > Taxonomies option. See Also: "Defining Roles" on page 15-32

You can reorder (that is, change the sequence of) the categories below a taxonomy or one of its

categories. Reordered subcategories appear only within the Ektron CMS400.NET Workarea.

To reorder the categories assigned to a taxonomy or category, follow these steps.

See Also:

1. From the Workarea, go to Content Tab > Taxonomy.

2. Select the taxonomy or category that has the folder that you want to reorder.

3. Select the taxonomy or category that has content that you want to reorder.

4. Click the Reorder button( ).

5. Set the Type pull-down list to Category.

6. Select an item that you want to move up or down.

7. Click the up or down arrow to move the item in that direction.

8. Continue steps 6 and 7 until all content is in the desired order.

9. If there are several language versions of this taxonomy, you can automatically reorder all

versions. To do that, check Apply ordering for all languages.
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10. Click the Save button ( ).

Change Order of Content Assigned to a
Taxonomy/Category
You can reorder (that is, change the sequence of) content within a category. Reordered content

appears within the Ektron CMS400.NET Workarea and can appear on your Web site of the

Directory server control’s ItemSortOrder property is set to taxonomy_item_display_order.

To reorder the content assigned to a category, follow these steps.

Note: Onlyadministratorsor users to whom the Taxonomy-Administrator role hasbeen assigned see the

Content > Taxonomies option. See Also: "Defining Roles" on page 15-32

1. From the Workarea, go to Content > Taxonomies.

2. Select the taxonomy or category that has the folder that you want to reorder.

3. Click the Reorder button( ).

4. Set the reorder pull-down list to items.

5. All items assigned to the category appear.
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6. Select a content block that you want to move up or down.

7. Click the up or down arrow to move the item in that direction.

8. Continue steps 7 and 8 until all content is in the desired order.

9. Click the Save button ( ).

Importing and Exporting a Taxonomy
You can export any taxonomy as an xml file. Then, you can reuse it or send it to someone else,

who would import it in order to bring a copy of it onto their computer.

You can use the Export/Import feature like a “save as” feature. For example, you want to create

a taxonomy that is similar to an existing one but has some differences. The easiest way to do

this is to export an existing one, import it under a new name, and edit it.

Below is an example of part of a taxonomy saved as an XML document.

<?xml version="1.0" ?>
- <TaxonomyData xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"

xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<TaxonomyName>MapCategory</TaxonomyName>
<TaxonomyDescription>map</TaxonomyDescription>
- <Taxonomy>
- <TaxonomyData>
<TaxonomyName>Sports</TaxonomyName>
<TaxonomyDescription>sports</TaxonomyDescription>
</TaxonomyData>
- <TaxonomyData>
<TaxonomyName>Banks</TaxonomyName>
<TaxonomyDescription>Banks</TaxonomyDescription>
</TaxonomyData>
- <TaxonomyData>
<TaxonomyName>Pharmacies</TaxonomyName>
<TaxonomyDescription>Pharmacies</TaxonomyDescription>
</TaxonomyData>
- <TaxonomyData>
<TaxonomyName>Travel</TaxonomyName>
<TaxonomyDescription>Travel</TaxonomyDescription>
</TaxonomyData>
- <TaxonomyData>
<TaxonomyName>Restaurant</TaxonomyName>
<TaxonomyDescription>Restaurant</TaxonomyDescription>
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- <Taxonomy>
- <TaxonomyData>
<TaxonomyName>American</TaxonomyName>
<TaxonomyDescription>American</TaxonomyDescription>
</TaxonomyData>
- <TaxonomyData>
<TaxonomyName>Indian</TaxonomyName>
<TaxonomyDescription>Indian</TaxonomyDescription>

</TaxonomyData>

Exporting a Taxonomy
Exporting a taxonomy means saving it as an .xml file on your computer or network drive. To

export a taxonomy, follow these steps.

1. From the Workarea, go to Content > Taxonomies.

2. Select the language of the taxonomy that you want to export.

3. All taxonomies in that language appear.

4. Click a taxonomy that you want to export.

5. Click the Export Taxonomy button ( ).

6. You are prompted to select a folder into which to save it.

Importing a Taxonomy
1. From the Workarea, go to Content > Taxonomies.

2. Click the Import Taxonomy button ( ).

3. The Import Taxonomy screen appears.
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4. In the Title field, enter a name for your new taxonomy.

5. Click the Browse button.

6. Navigate to the taxonomy file you want to import.

7. The path appears in the File field.

Note: Alternatively, you can enter or paste the xml into the XML box.

8. Determine the taxonomy’s configuration.

9. Click the Save button ( ).

Note: If you assign a name that is alreadygiven to a taxonomy, Ektron CMS400.NET appendsa number to the

title, beginning with 1.

Displaying a Content Item Taxonomy
Search on your Web Site
When your Web developer places a Directory server control on a Web page, he can use the

Enable Search property to include a Search box with the taxonomy display (circled below).

See Also: "EnableSearch" on page 9-243

The box helps site visitors find content by returning only items that include a search phrase

and are assigned to a selected category.
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When placing a Directory server control, your Web developer defines a Taxonomy ID number.

The ID determines the top level of the taxonomy that appears below the Search box, to the

right of Breadcrumb. Below that are categories that exist directly below the Taxonomy ID.

Using the Taxonomy Search

To use the search, a site visitor enters a search term and clicks the Directory radio button

(above the Search box). The screen may return links in two areas below Breadcrumb.

n Category - all categories below the selected level with content that includes the search

term. Click a category to see a list of content that includes the search term in that

taxonomy/category level or one of its subcategories.

n Articles - content within the currently selected taxonomy/category level that includes the

search term

As illustrated below, within the Editor category, one category (eWebEditPro) includes

content with the word library. And, one content block (The best Microsoft Word content

processing) includes library.
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Multi-Language Support for
Taxonomies
This section explains of how Taxonomy is supported in a multi-language environment. It

consists of the following topics.

n "Creating a Taxonomy in a Multi-Language Environment" on page 9-236

n "Deleting a Taxonomy in a Multi-Language Environment" on page 9-237

n "Enabling/Disabling a Language in a Multi-Language Environment" on page 9-237

n "Taxonomy Properties in a Multi-Language Environment" on page 9-237

n "Assigning Content to a Multi-Language Taxonomy" on page 9-238

n "Removing Content from a Multi-Language Taxonomy" on page 9-238

n "How a Folder’s Taxonomy Properties are Affected by Multi-Language Support" on page

9-238

n "Assigning Folders to a Multi-Language Taxonomy" on page 9-239

n "Removing Folders from a Multi-Language Taxonomy" on page 9-240

n "Reordering Content in a Multi-Language Taxonomy" on page 9-240

n "Reordering Categories in a Multi-Language Taxonomy" on page 9-240

Creating a Taxonomy in a Multi-Language
Environment
When you create a new taxonomy, you select a language. At that point, a version of that

taxonomy is also created for each enabled language.

For example, you create a taxonomy in English, and French and Spanish are also enabled (in

the Settings > Language Settings screen). Ektron CMS400.NET now has versions of that

taxonomy in English, French, and Spanish. The ID of each taxonomy is the same, but the

language ID is different. You do not need to use all language versions.

The three versions now linked and cannot be unlinked. So, for example if you assign a

category to the English taxonomy, that category is also assigned to the French and Spanish

versions. Of course, since the text is English, it will probably have to be translated. See Also:
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Upgrading and Multi-Language Taxonomy Support
As of version 7.6.5, any new taxonomies are synchronized. That is, if you create a taxonomy in

English, one is created with the same taxonomy ID but a different language ID in all other

enabled languages. And, if you add categories to one language taxonomy, those categories are

automatically added to the other language versions of that taxonomy.

Previously, CMS400.NET allowed multiple language versions of a taxonomy, but changes to

one language did not affect the language-related versions. If your Ektron CMS400.NET has

such versions, the 7.6.5 upgrade does not synchronize your taxonomy. Furthermore, no

additional versions of that taxonomy will be created in other enabled languages. Ektron

assumes that, since taxonomies in those languages already exist, you want to keep them as

they are. So, for example, assume you created a taxonomy in a previous version of Ektron

CMS400.NET in English and Spanish. The upgrade does not synchronize them.

Enabling Taxonomy Synchronization for Taxonomies that
Existed Prior to 7.6.5 Upgrade
Suppose that, after the 7.6.5 upgrade, you want to transform an unsynchronized taxonomy to a

synchronized multi-language taxonomy, so that changes to one are automatically reflected in

the others. To accomplish this, upgrade to 7.6.5 and delete the Spanish version. At that point, a

version of that taxonomy will be created for every enabled language and synchronized with

the English version. You now have the option of translating category names manually or

exporting the taxonomy, translating it and then importing back in. See Also:

Deleting a Taxonomy in a Multi-Language
Environment
If you delete a taxonomy, all related language versions are also deleted.

Enabling/Disabling a Language in a Multi-Language
Environment
If you enable a new Workarea language, a version of every taxonomy created in version 7.6.5

and above is automatically created in that language.

If you disable a language, all of its taxonomies are deleted.

See Also: "Determining Which Languages are Available" on page 14-5
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Taxonomy Properties in a Multi-Language
Environment
Initially, all related-language versions of a taxonomy take their properties from the original

language version. For example, if you create a taxonomy in English and French is also enabled,

the French Taxonomy description is the same as the English one, as are the taxonomy image,

taxonomy template, value of Display? checkbox, etc.

However, after the initial creation of the multiple-language versions, changes to taxonomy

properties affect the current language only -- they do not affect the related-language versions.

Exception - When you edit the taxonomy Display? property, you are prompted to apply the

change to all languages or the current language only. See Also: "Display?" on page 9-206

Assigning Content to a Multi-Language Taxonomy
Ektron CMS400.NET supports multiple language versions of content, as shown below.

As you can see, Content ID=35 exists in English and Spanish.

When applying content to a taxonomy category, you can only apply content whose language

matches the taxonomy language. If that content exists in other languages, the related-language

version is also applied to the related-language taxonomy.

So, to continue the above example, assume there is a taxonomy in English and you apply

content item ID=30, Sample Content Block to one of its categories. If that taxonomy exists in

German, the content block titled Ektron CMS400.NET Server Kontrollen (also ID=30) is

applied to the corresponding category in the related German taxonomy.

If there is no corresponding German content, nothing is applied to the German taxonomy

category.
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Removing Content from a Multi-Language Taxonomy
If you remove content from a taxonomy in any language, it is removed from all language-

related taxonomies.

How a Folder’s Taxonomy Properties are Affected by
Multi-Language Support
If there are several language-related versions of a taxonomy and you select one of them then

edit a folder’s taxonomy properties, content in the related language inherits the taxonomy

folder properties.

For example, assume I select English, then edit a folder’s taxonomy properties and apply

taxonomy categories. See Also:

If I later edit French content in that folder, the corresponding French taxonomy’s categories are

available to be assigned via the Category tab.

Further, the value of the At least one category is Required check box is also inherited. This

means that if a category must be applied to English content, it is also required for French

content.

Assigning Folders to a Multi-Language Taxonomy
When you assign a folder to a taxonomy category, you indicate that all folder content is

assigned to that node. Ektron CMS400.NET folders are language-neutral, so the folder is also

applied to the corresponding taxonomy category in every language. However, only folder

content that matches the taxonomy’s language is assigned to the taxonomy category.

So, for example, a folder has three content blocks.
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Language Content in folder in this language

English

n 100

n 101

n 102

German n 100

If you apply that folder to a taxonomy, the English version of the taxonomy has three content

blocks assigned, but the German version only gets one content block (ID 100).

If content is later added to the folder, new English content is assigned to the English

taxonomy, and new German content is assigned to the German taxonomy.

TIP!

Note: If you apply a folder to a taxonomy, numberson the View Taxonomyscreen indicate howmanycontent

itemsare applied to it. Unless you have the same number of content items in each language, this number is different

for every language.

Removing Folders from a Multi-Language Taxonomy
If you remove a folder from its assignment to a taxonomy category, the content in that folder is

still applied. So, you must also remove all of its content, as described in "Removing Content

from a Multi-Language Taxonomy" on page 9-238.

Reordering Content in a Multi-Language Taxonomy
If you reorder the content assigned to a taxonomy category, there is no change to

corresponding categories in other languages. This is because there is no guarantee that content

that exists in one language exists in the other languages.

Reordering Categories in a Multi-Language Taxonomy
If you reorder categories assigned to a Taxonomy/Category, you have the option of applying

the changes to all language-related categories (see below).
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Using Taxonomies with Social
Networking
If you have a community or social networking Web site, you can assign users and community

groups to a taxonomy. This allows site visitors to search for users and groups by category.

To enable a taxonomy-based search of users and community groups, a developer uses the

following server controls on your site.

n CommunityGroupBrowser control - lets a site visitor browse a taxonomy category for

community groups

n CommunitySearch control - lets a site visitor search for users and community groups

based on selected criteria

See Also: ”CommunitySearch Server Control” on page 16-301

Directory Server Control
The Directory server control lets you customize the behavior of the Taxonomy feature. You

place this control on any Web form to display a taxonomy. For more information about the site

visitor experience with Taxonomy, see "Taxonomy" on page 9-200.

Improving Taxonomy Performance
To minimize taxonomy’s impact on the performance of your production server, follow these

guidelines.
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n Use the default page size (50). If you need to customize page size, use Ektron CMS400’s

API, but do not increase it above 800.

n For large databases, do not increase the value of the TaxonomyDepth property above 1.

Changing this value dramatically slows down your production server’s performance.

However, you can increase depth on your staging server for testing purposes.

Directory Server Control Properties
The Directory server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Response Data Type

AddItemFolderID

Define the Ektron CMS400.NET folder ID where content is stored

when an item is added to the taxonomyvia the Add Asset link or the

Add Content link. To enable adding content itemsvia the Directory

server control, youmust use an EkML file with the [$AddAsset] and

[$AddArticle] variables.See Also: "taxonomy.ekml" on page

21-467

Long

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to

browse to Content, Collections, etc.See Also: "Using CMS
Explorer to Browse Your Ektron CMS400.NET Site" on page 21-9

String

CacheInterval

Sets the amount of time, in seconds, the server control’s data is

cached. The default is 0 (zero).

For example, to cache data for fiveminutes, set this property to 300.

See Also: "Caching with Server Controls" on page 21-31

Warning! Important! If the EnablePaging

property is set to True, the CacheIntervalproperty is disabled.

Double

DisplayXslt

If you want to use an XSLT to control the display of the directory

server control on this page, enter the path to the XSLT file.

Warning! Important!: If you specify an external file, it is strongly

recommended that you do not store this file in your site'sWorkarea

folder. If you store this file in theWorkarea folder, the file will be lost

when you upgrade.

Warning! Important! If you enter a valid EkML file at the Mark-

upLanguageproperty, the Displayxsltproperty value is

ignored.

String
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Property Response Data Type

DynamicParameter
Gets or sets the QueryString parameter to read a content ID

dynamically.
String

EnableAjax

Set to true to enable Ajax searches.When enabled, the

MaxResultsproperty determines themaximum number of results

per page.

True =Enable AjaxSearch (default value)

False =OriginalHTMLSearch

Boolean

EnablePaging

This property, in conjunction with the MaxResultsproperty, lets site

visitors view an unlimited number of taxonomy itemswhile

controlling the amount of screen space. To accomplish this, the

taxonomydisplay is limited to the number set in the MaxResults

property.

If you set this property to true (the default), and the number of

taxonomy itemsexceedsMaxResults, navigation aids appear

below the last item. The site visitor uses them to view additional

items. See example below.

So, for example, if a taxonomyhas9 itemsand MaxResults is set to

3, the screen displaysonly the first three items.When the site visitor

clicks [Next], he sees items4, 5 and 6, etc.

Warning! Important! If the EnablePagingproperty is set to

True, the CacheIntervalproperty is disabled.

Boolean

EnableSearch

Set to true if you want a search box (shown below) to appear above

this taxonomydisplay. A site visitor can use the search to find

content within a taxonomy/category that includes termsof interest.

To suppress the search box, set to false.

Boolean
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Property Response Data Type

Hide

Used to hide the directory control in design time and run time.

True =Hide Sitemap trail

False =Show Sitemap trail

Boolean

IncludeIcon

Choose whether to display iconsnext to the taxonomy’s links.

Warning! Important: This property onlyworkswhen ecmSum-

maryor ecmTeaser are used in the DisplayXsltproperty.When

the [$ImageIcon] variable is used in an EkML file and that file is

assigned to the MarkupLanguageproperty, this property acts as

True.

True =Show icons

False =Hide icons

Boolean

ItemSortOrder

Specify the sort order of results. Choicesare:

taxonomy_item_display_order - the order of taxonomy itemsas

set in theWorkarea. For additional information, see "ChangeOrder

of Content Assigned to a Taxonomy/Category" on page 9-231.

content_title - the content is listed in alphabetical order by title.

date_created - content is listed in the order bywhich it was created.

last_edit_date - content is listed in order by its last edit date.

You can specify the direction of the itemswith the SortDirection

property.

Language
Set a language for viewing content. This property shows results in

design-time (in VisualStudio) and at run-time (in a browser).
Integer
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Property Response Data Type

LinkTarget

Defines the waya link actswhen it is clicked. The choicesare:

_blank - loads the link in a new blankwindow. Thiswindow is not

named.

_self - loads the link in the samewindow the anchor was clicked in.

This is useful for overriding a globally assigned base target.

_parent - loads the link in the immediate frameset parent of the

document. This defaults to acting like “_self” if the document hasno

parent.

_top - loads the link in the full bodyof the window. This defaults to

acting like “_self” if the document is alreadyat the top. It is useful for

breaking out of an arbitrarily deep frame nesting.

ItemLinkTargets

MarkupLanguage

Identify the templatemarkup file that controls the display of the

taxonomy. For example, mytaxonomymarkup.ekml.

If the .ekml file is located in the same folder as theWeb form

containing the server control, just enter its name. If the file is in

another folder, enter the path relative to site root. For example,

..\workarea\customfiles\markup\mytaxonomymarkup.ekml

.

This property is blankbydefault. If nothing is entered, the following

EkML file is used:

\[site_

root]\workarea\template\taxonomy\taxonomy.ekml

See Also: "EktronMarkup Language" on page 21-414and

"taxonomy.ekml" on page 21-467

Note: If you enter a valid EkML file, the DisplayXsltproperty value

is ignored. If the EkML file contains the [$ImageIcon] variable, the

IncludeIconsproperty acts asTrue.

String

MaxResults

Enter themaximum number of items to appear in the initial display of

this server control.

To set nomaximum, enter zero (0).

To let site visitors view more than themaximum but limit the amount

of space being occupied, enter themaximum number of results per

page here. Then, set the EnablePagingproperty to true.

If you do andmore than the number of MaxResultsare available,

navigation aids appear below the last item to help the site visitor view

additional items. See example below.
Integer
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Property Response Data Type

Recursive Set to True to include child folders of the parent folder. Boolean

ShowAllChecked When set to True, a checkboxappears in the Show All checkbox. Boolean

ShowCount

Indicates if the number of taxonomy itemsappears next to each

categorywhen displayed in theWeb site. (See example below.)

Default value is false.

Boolean
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Property Response Data Type

ShowRoot

Set to False if you want Top to represent the first node of the

taxonomypath.

Set to True if you want the name of the first node of the taxonomy

path to appear instead of Top.

Boolean

SortDirection
Select the direction of the ItemSortOrderproperty. Choose

Ascending or Descending.
String

TaxonomyCols
Enter the number of columns in which this taxonomy/categorywill

appear on the page.
Integer

TaxonomyDepth

Enter the number of taxonomy levels to retrieve below each

taxonomy/category if you are accessing a taxonomy’sXML using

code behind. For example, if the taxonomy isBusinesses >

Restaurants > Pizza, and you set Taxonomy Depth to 2, only

Businessand Restaurants are available in code behind.

This setting hasno effect on the display generated by the Directory

server control, which alwaysdisplaysonly one level below the

current.

To retrieve all categories for a taxonomy recursively, enter -1.

The default value is 1.

Warning! Important! - For a live site, Ektron strongly rec-

ommends leaving this value at 1. Increasing this value can slow

down your liveWeb server. However, for testing on a staging

server, you can increase the depth.

Integer

TaxonomyId

Enter the ID number of the taxonomyor category to appear in this

server control. If you don’t know the number, click the button and

navigate to the taxonomyor category.

Long

TaxonomyItemCols
Enter the number of columns in which this taxonomy/category items

(articles) will appear on the page.
Integer
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Property Response Data Type

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a

blockof code.

Custom - Allows you to use a custom tag.

String

Map Server Control
The Map server control displays a map that flags locations of interest to your site visitors. Each

location is a CMS content item to which map information was added. For example, if your site

hosts a school district, each map location could represent one school in the district.

A visitor can zoom the map in and out, get directions to any location, and narrow the list of

locations using a text search. For example, if your map initially flags all schools in a

geographic area, the visitor can redraw the map to show only schools with a gym.

If you want the map to show events, you can apply dates to Ektron CMS400.NET content. If

you do, a site visitor using the map can search by date as well as location to find events of

interest.

Warning! Asamap’s location boundaries change, only locationswithin the boundaries appear. Likewise, if a date

is assigned to content, only content within the selected date range appears.
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If a map has at least one flagged location, a box can appear to its right with information about

each flagged location. The locations are sorted by distance to starting location. From this box,

you can

n view the content to which the location is assigned

n find the distance to a location

n center the map on a location

n get directions to a location

If you click any flagged location, a box appears showing a link to that content in Ektron

CMS400.NET, additional information about the item, and a link to directions.

This section explains how site visitors can use the map’s features, as well as how you can

control the map’s operation through the following sections.

n "Using Maps on the Sample Site" on page 9-249

n "Controlling the Visitor Experience with Maps" on page 9-256

n "Map Server Control Properties" on page 9-260

Using Maps on the Sample Site
You can view maps on Ektron CMS400.NET’s sample site. To do so, open the home page

(http://your server address/siteroot/default.aspx). Then, click Contact Information > Map VE

or Contact Information > Map Google.

Note: If you want to workwith thesemaps in VisualStudio.NET, the BingMaps for Enterprisemap is on the

map.aspxpage. TheGooglemap is onmapgoogle.aspx.
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Note: Ektron CMS400.NET providesaGooglemap key that you can use for testing on localhost. But, if you want

to useGooglemapwith your production server, youmust install a license key. See "Obtaining a License to Use

GoogleMaps" on page 9-249.

Obtaining a License to Use Google Maps
Before your production server can use Google’s map feature, follow these steps to obtain and

install a license key. For Google Map’s terms and conditions, see

http://code.google.com/apis/maps/terms.html

1. Go to http://www.google.com/apis/maps.

2. Click Sign up for a Google Maps API key.

3. Read the terms and conditions. At the bottom of the page, check the box next to I have

read and agree with the terms and conditions.

4. Enter your URL in the My web site URL: field. For example,

http://www.example.com/maps.

Warning! A singleMapsAPI key is valid for a single “directory” on your web server. If you sign up for the URL

http://www.example.com/maps, the key you get is good for all URLs in the http://www.example.com/maps/ direc-

tory.

5. Click the Generate API Key button.
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6. You are asked to sign in to Google. If you don’t have an account, create one.

7. A new page appears with your license key at the top. Copy the key.

8. Without closing that page, open the web site root/web.config file.

9. Go to the line that begins <add key="GoogleMap".

10. Within that line, replace the localhost key (shown below) with the one copied in Step 7
key=ABQIAAAAKS0eaO74jIASu1UolJlxPRQAPC5zwhKxdscXMmLMOnW7z2LmSRQrVhfXVp1hq2cv_

ZsOvqP4GQ69eg"/>

Changing the Map's Zoom Level
If the map has a zoom control, the site visitor can use it to zoom in and out. As the map’s

boundaries change, flagged locations may appear or disappear. This is because the map only

shows content whose location lies within the map’s boundaries. See Also: "Controlling the

Visitor Experience with Maps" on page 9-256

Using the Search Tab to Recenter the Map
The Search tab lets a site visitor recenter the map on a location. He can enter any combination

of street address, city, state and zip code.
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When he does and presses Search, only content within that geographic area which satisfies

other search criteria appears.

Using the Find What Tab to Find Locations with a Search
Term
The site visitor can use the Find What tab to find only locations that include a search term. For

example, if a map flags hotels, the visitor can click the Find What tab then insert pool in the

text box above to view only hotels with a pool.

The Find What tab uses the same logic used in the Web Search to find content on your site.

This is described in” "Searching Your Web Site" on page 9-4.

Using the Directions Tab
The site visitor can use the Directions tab to get directions between any two locations. Simply

enter any combination of street address, city, state, and zip code into both text boxes above the

tabs (circled below).
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When you do this and press Get Directions, the map screen displays text directions on the left,

and a map of the directions on the right.

The Display on Map Button
If you use Ektron CMS400.NET’s Taxonomy feature to classify mapped content, a site visitor

can click the Display on Map button to restrict the map’s locations to content in your

categories.

Note: The popupwindow also prompts the site visitor select one or a range of dates, and only retrievescontent to

which one of the selected dates is assigned. See "DateSearch" on page 9-262.
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A good example is presented in Ektron CMS400.NET’s sample site. Here, the Taxonomy “Map

Category” has the following categories.

Notice that the category Restaurant has five subcategories.

When a site visitor is using the map, he can click the Display on Map button, see your

content’s categories, and select those of interest. When he does, the map updates to show

content in selected categories only.

Note: While anOR logical relationship among selected categories is themost intuitive and common, you can

alternatively set up an AND or NOT logical relationship among selected categories. See

"SelectedCategoryLogicalType" on page 9-266.

To learn about assigning taxonomy categories to content, see "Taxonomy" on page 9-200.

Displaying Icons on the Category Popup Screen
See "CustomIcon" on page 9-261.

Text Box
The text box appears to the right of the map if at least one location is flagged.
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The text box’s columns are described below.

Column

Header
Description

No.
Map item’s number. The lowest numbered item is closest to themap’s

center.

Title

The content item that corresponds to the numberedmap location. The site

visitor can click the title to proceed to that content on your Web site.

The text below the title is theMetadataMap Address field, followed by the

MetadataDescription field (see illustration below).

Distance Distance from themap’s center to this content location.

Map
Click icon to recenter map on this content’s location.

Directions

Click icon to select theDirections tab and paste this content location’s

address into the end location box. The site visitor could then enter a

starting location to get directions to this location.

Bubble Text
When a site visitor hovers the cursor over a numbered map location, a text “bubble” appears.
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The bubble shows the following information.

n Title - The content item that corresponds to the numbered map location. The site visitor

can click the title to proceed to that content on your Web site.

n Summary - Whatever is entered into the content item’s Summary tab.

n Metadata description - Whatever is entered into the content item’s Metadata Description

field.

n Get Directions - Click To Here or From Here to select the Directions tab and paste this

location’s address into the To or From location box. The site visitor would then supply the

missing (starting or ending) location to get directions between the locations.

Controlling the Visitor Experience with Maps
Tip!

Warning! Within VisualStudio, you cannot see themap in designmode. But, you can right click themouse and

selectView in Browser to see the effect of changing properties in a browser.

This section explains how to customize the following elements of the map display.

n "Displaying/Suppressing Map Elements" on page 9-256
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n "Determining a Map’s Initial Boundaries" on page 9-257

n "Determining which Content is Found by a Map" on page 9-258

For information on customizing the display using the Ektron Markup Language, see

"map.ekml" on page 21-451.

Displaying/Suppressing Map Elements
You can use Map server control properties to display or suppress the following map elements.

Screen Area
Use this Map server control property to display or

suppress

Tabs/Search box GeoControl

Text box DisplayTextResult

Zoom/direction

ZoomControl

Note: For BingMaps for Enterprisemaps, this property also

controls theMap type selection.

Map type (road, satellite,

combination)

TypeControl

Note: Only affectsGooglemaps.
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Determining a Map’s Initial Boundaries
Because the map only displays content whose address lies within the map’s boundaries, focus

the initial display on your businesses/locations. Map server control properties let you specify a

beginning address (or longitude/latitude) and a starting zoom level. All content with address

data within that area is flagged on the map.

If your locations are too spread out to appear on a single map, create several regional maps.

Each map server control must appear on a separate web form.

Warning! You cannot placemore than onemap server control on aWeb form.

Determining which Content is Found by a Map

Preparing CMSContent to Appear on aMap

Whether you use Google or Bing Maps for Enterprise maps, content must have latitude and

longitude values in order to appear on a map.

Google maps provides a service that takes the address of content and returns its latitude and

longitude.
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Note: You don’t need to useGoogle’s automatic retrieval of latitude and longitude. Instead, you can enter the

valuesmanually. To do so, open the content item, go to itsmetadata, and enter the latitude and longitude values

under Search Data.

To automatically obtain latitude and longitude information for any content item, follow these

steps.

Warning! The following procedure assumesyou are using Ektron CMS400.NET’s sample site. If you are using

theMin site, youmust create searchablemetadata definitions forMap Address,Map Latitude andMap Lon-

gitude. When defining Map Latitude andMap Longitude, set their Style to Double. If you are using dates

with metadata, setMapDate’s style toDate.

1. Obtain a Google maps license key. See "Obtaining a License to Use Google Maps" on

page 9-249

2. Create the content if necessary. On the content’sMetadata tab, under Search Data, enter

a MapAddress (that is, any combination of street, city, state, and zip code).
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If you enter only a zip code, the latitude and longitude are set to that post office.

3. Publish the content. This action creates the Web Service call to Google maps, which

retrieves the latitude and longitude for each address.

If Google maps cannot find a latitude and longitude (usually due to insufficient or conflicting

information), it writes failure information to your server. You can view this under Windows

Event Viewer > EktronLog. Any event’s properties explain why the retrieval of latitude and

longitude failed.

Restricting Content for a Particular Map
You may want a map to show a subset of all content with a latitude and longitude. For

example, your business includes restaurants and bakeries, and you want a map to show only

bakeries.

To accomplish this, place content for restaurants in one folder, and bakeries in another. Then,

in the map server control that shows bakeries only, at the FolderID property, identify the

bakeries folder.

If you want another map to show both restaurants and bakeries, create the restaurant and bakery

folders under a parent folder. Then, in that map server control’s FolderID property, identify the

parent folder, and set the Recursive property to true.

Map Server Control Properties

Warning! You cannot placemore than onemap server control on a form.
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Tip!

Warning! Within VisualStudio, you cannot see themap in designmode. However, you can right mouse click the

mouse and selectView in Browser to see the effect of changing the properties.

The following table explains the Map server control properties.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Note: Do not use a percentage value to set the native .NET propertiesHeightand Width. Percentagesdo not

workwith these properties.

Property Value Data Type

Address

To set a default map center, enter its

addresshere.

If you only enter a zip code, themap centers on its post office.

The addressappears in the Search field when themap first

displays.

If you enter an address, the latitudeand longitude

properties are ignored.

String

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it

to browse to content and a Taxonomy. If you are not logged it but

want to, change the value to true.

See Also: "Using CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9

Boolean

ContentId

Use this field in conjunction with theEnableSearchResult field

to limit themap to a single content item. Here, you identify the

content item to bemapped.See Also: "EnableSearchResult

" on page 9-263

Asexplained in "Preparing CMSContent to Appear on aMap" on

page 9-258, contentmust have latitude and longitude values in

order to appear on amap.

Long
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Property Value Data Type

CustomIcon

Use this field if you want the Category popup box to display an

icon to the left of each category, as shown below.

Prerequisite

To use this value, open the

webroot/Workarea/images/application/maps/tree

folder. In that folder, create a new folder whose name is the same

as the Taxonomycategory assigned to theMap server control at

the MapCategoryproperty. In the sample site, this Taxonomy’s

name isMapCategory.

Then, place the icons in that folder by category title namewith a

.png extension. Use an underscore (_) to separate taxonomy

levels. For example, the image for the categoryRestaurant >

Americanmust be named Restaurant_American.png.

Boolean

DateSearch

If you want to assign a date to content so that site visitors can

select bydate, enter true. This feature is helpful for date-related

content, such as concerts, meetings, or sporting events. The site

visitor can filter what appears on themap bydate.

If you set this property to true, assign a date to date-related

content using theMapDate standardmetadata field. Then,

publish the content.

When a site visitor clicks amap’sDisplay on Map button, the

popup screen includesdate criteria, as shown below.See
Also: "The Display onMap Button" on page 9-252

The site visitor can select map itemsbya single date or a range of

dates. If he does, only content to which one of the selected dates

is assigned appears.

Boolean

DisplayTextResult

If you want the site visitor to see a boxof information about each

map item to the right of amap, enter true. To suppress the text

box, enter false.

See Also: "Displaying/SuppressingMap Elements" on page

9-256

Boolean
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Property Value Data Type

DistanceUnit
Enter the units of distance on themap. Choicesaremiles and

kilometers. The default value ismiles.
Unit

EnableSearchResult

Use to determine if theMap server control accesses the CMS

search to return results. True is the default value.

You would change it to False if you want to display amapwith

only one content item, that is, a single location. Specify this item at

the ContentIDproperty. In this case, themap doesnot find other

CMS content whose longitude and latitude are within themap’s

boundaries.

Site visitors viewing themap can still use the Search and

Directions tabs to get directions to the location.See Also:
"Using the Search Tab to Recenter theMap" on page 9-251;

"Using the DirectionsTab" on page 9-252

For example, your site featureshomes for sale, and you want a

map to show a featured home of the week. To do so, set this

property to False, and enter the content block that describes that

home in theContentID field.See Also: "ContentId" on page
9-261

Boolean

FolderId

Enter the ID number of the folder whose content is searched on

thismap. If the recursiveproperty is true, folders below this

folder are also searched.

Long

ForceCategory

When set to true, this property causes themap to only show

content associated with the taxonomycategory defined in the

MapCategoryproperty.When set to false, themap showsall

content within themap’s boundaries.

For example, if you have five content blocks that appear on amap

and three of them are associated with a taxonomy, set this

property to True and the MapCategoryproperty to the ID of the

taxonomy.When a user views themap, it will only display the

three content itemsassociated with the taxonomy.

See Also: "MapCategory" on page 9-264

Boolean

GeoControl

If you want the site visitor to see a search boxwith tabsabove a

map, enter true. To suppress the text box, enter false.

See Also: "Displaying/SuppressingMap Elements" on page

9-256

Boolean

Hide

Used to hide themap server control in design time and run time.

True =Hidemap server control

False =Showmap server control

Boolean
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Property Value Data Type

Language

Set a language for theMap server control. To allow the language

to be set dynamically, enter zero (0).

This property shows results in design-time (in VisualStudio) and

at run-time (in a browser).

Integer

Latitude
To set a default map center via latitude and longitude (as

opposed to an address), enter the latitude here.
Decimal

Longitude
To set a default map center via latitude and longitude (as

opposed to an address), enter the longitude here.
Decimal

MapCategory

Enter the ID number of the taxonomywhose categories appear

when a site visitor clicks thismap’sDisplay on Map button.

When amap first appears, all eligible content appears. If a site

visitor clicks theDisplay on Map button, he can choose one or

more categories and limit themap to itemsassigned to them. For

example, the user could view restaurants only (as shown below).

Asanother example, your map could display all campuses in your

state’s college system. A site visitor could use theDisplay on

Map popup window to limit themap to community colleges.

Note:While anOR logical relationship among selected categories

is themost intuitive and common, you can alternatively set up an

AND or NOT logical relationship among selected categories. See

"SelectedCategoryLogicalType" on page 9-266.

To learnmore about Taxonomy, see "Taxonomy" on page 9-

200.

Long

MapProvider
Select the service that provides themap, either Google or Bing

Maps for Enterprise.
Provider

MapStyle
Enter themap’s displaymode: Road, Satellite or Hybrid.

Note: This setting only affectsBingMaps for Enterprisemaps.
Style
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Property Value Data Type

Markup Language

Enter the templatemarkup file that is used to control the display of

themap page. For example, mymapmarkup.ekml.

If you enter no EkML file, the default one at

Workarea\Template\map\map.ekml is used.

If the *.ekml file is located in the \workarea\template\map

folder, just enter its name. If the file is in another folder, enter the

path relative to site root. For example,

\workarea\customfiles\markup\mymapmarkup.ekml.

See Also: "EktronMarkup Language" on page 21-414 and

"map.ekml" on page 21-451

String

MinZoomLevel

If you want to set amap zoom level below whichmap locationswill

not appear, enter that value.

The default value is 4. Possible valuesare between 1 (most

detailed) and 19.

Integer

PageSize

Enter the number of locations that can appear on one page of the

text boxafter a search is executed.See Also:
"Displaying/SuppressingMap Elements" on page 9-256

If more than this number of locationsare available, the site visitor

sees [First] [Previous] [Next] [Last] at the bottom of the

page. He can use the navigation aids to view additional locations.

Integer

Recursive

In the FolderIDproperty, you specify a folder whose content is

searched on thismap. To extend the search to all folders below

this folder, set this property to true.

Boolean
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Property Value Data Type

SelectedCategoryLogicalType

Use this property to determine the logical relationship among

several categories on the Display onMap tab. (See "The Display

onMap Button" on page 9-252). There are three choices: OR,

AND, and NOT.

Bydefault, an OR relationship exists among the site visitor’s

selections. So, for example, if all three Restaurant categories are

checked, then any restaurant that is defined asAmerican,

Chinese or Pizza appears on themap.

If you change this property’s value to AND, only content to which

all selected categories apply appear on themap. In the above

example, only restaurants defined asAmerican andChinese and

Pizza appear on themap.

Alternatively, you can set the property’s value to NOT. In this

case, only content to which the selected categories are not

applied appear on themap. To continue the above example, if

the site visitor selectsChinese, only restaurants that are not

assigned the Chinese category appear on themap.

LogicalType
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Property Value Data Type

StartZoomLevel

Enter the zoom level at which themap initially appears.See
Also: "Determining aMap’s Initial Boundaries" on page 9-257

Zoom level 1 is the least detailed, showing the entire world map.

Zoom level 19 is themost detailed, showing the smallest streets.

Bydefault, maps in the sample site have a zoom level of 12, which

showsan area of about 10miles (16 kilometers).

A site visitor viewing themap can adjust the zoom level using the

zoom control (circled below).

Integer

Stylesheet

Specify the path to a style sheet for use with this server control.

The location can be relative or absolute. Leave blank to use the

default style sheet.

Warning! If you enter a valid EkML file at the MarkupLanguage

property, the Stylesheetproperty is ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control.

The default isFalse.

True - Suppresswrap tags

False - Allow wrap tags

Boolean

TemplateParamName

Sets a QueryString parameter for the ID of users that are

returned in the search results. This parameter is passed to the

template page defined in the TemplateUserProfileproperty

when a user clicks the Location (map) icon associated with a

user.

String
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Property Value Data Type

TemplateUserProfile
The URL path of the user profile template. This path can be

relative or absolute.
String

TypeControl

If thismap usesBingMaps for Enterprisemaps, this property

enablesor disables the zoom/direction/type control (highlighted

below). It lets a site visitor zoom themap in and out, move the

center in anydirection, and change the display style (Road or

Aerial).

If thismap usesGoogle Earth maps, this property enablesor

disables the type control (highlighted below). It lets the site visitor

change the display style (Map, Satellite, or Hybrid). Use the

ZoomControlproperty to display or suppressGoogle Earth’s

zoom and direction controls.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of

an HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a

blockof code.

Custom - Allows you to use a custom tag.

String
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Property Value Data Type

ZoomControl

Use this property to display or suppress the Googlemap zoom

control (highlighted below).

For BingMaps for Enterprisemaps, the display of the zoom

control is determined by the TypeControlproperty.

Boolean
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ListSummary Server Control

The ListSummary server control is used to display, on a Web page, a list of content blocks in a

selected folder. Optionally, the display can include content in all subfolders of the selected

folder.

When added to a template and visited, a List Summary looks like this.

It displays each content block’s title and summary information. You can modify the display to

suit your needs by modifying its properties.

This subsection contains the following topics:

n "ListSummary Server Control Properties" on page 9-271

n "OrderKey Property" on page 9-276

n "Retrieving the XML Structure of a List Summary" on page 9-277

Note: In contrast to a List Summary, a ContentList server control displays selected content items from any

CMS400.NET folder.See Also: "ContentList Server Control" on page 7-210
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ListSummary Server Control
Properties
The ListSummary server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description Data Type

AddText

Override the control’s default text for the Add Content menu item.

For example,

If you have a NewsWeb site, you could change Add Content toAdd News

Item.

String

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to browse to the

folder needed for the FolderID property.See Also: "Using CMSExplorer to

Browse Your Ektron CMS400.NET Site" on page 21-9

String

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0 (zero).

This is the amount of time, in seconds, a control’s data is cached. For example, if

you want to cache the data for fiveminutes, set this property to 300 (three

hundred).See Also: "Caching with Server Controls" on page 21-31

Warning! If the EnablePaging

property is set to True, the CacheIntervalproperty is disabled.

Double

ContentParameter
Checks the QueryString for this value and replaces the list summarywith a content

blockwhen specified. Leave blank to alwaysdisplay the list summary.
String
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Property Description Data Type

ContentType

Determines the type of content that appears in the list summary. The default is

Content. Choicesare:

AllTypes - displaysall of the content types for the given folder

Content - displaysa list of content items. Content itemsconsist of HTML content,

PageBuilder pages, XML Smart Formsand Blogs

Forms - formsappear in the list summary

Archive_Content - archived content blocksappear in the list summary

Archive_Forms - archived formsappear in the list summary

Assets - assets, such asofficesdocuments, appear in the list summary

Archive_Assets - archived assets appear in the list summary

LibraryItem - library itemsappear in the list summary

Multimedia - multimedia itemsappear in the list summary

Archive_Media - archivedmultimedia itemsappear in the list summary

NonLibraryContent - all typesof content appear in the list summaryexcept for

library items.

DiscussionTopic - forum topics appear in the list summary.

CatalogEntry - displaysall of catalog entries (products) for a specified catalog.

String

DisplayXslt

Determineshow the information on the page is displayed

None-databind only

ecmNavigation - lists the title of every content block in the folder

See Also: "Example of ecmNavigation Display" on page 9-124

ecmTeaser - lists the title of every content block in the folder plus the content

summary

See Also: "Example of ecmTeaser Display" on page 9-124

Path to Custom Xslt - Enter the path to an Xslt that determines the display of the

page

Warning! : If you specify an external file, it is strongly recommended that you do

not store this file in your site'sWorkarea folder. If you store this file in theWork-

area folder, the file will be lost when you upgrade.

Warning! If you enter a valid EkML file at the MarkupLanguageproperty, the

Displayxsltproperty value is ignored.

String
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Property Description Data Type

EnablePaging

This property, in conjunction with the MaxResultsproperty, lets site visitors view

an unlimited number of List Summary itemswhile controlling the amount of screen

space. To accomplish this, the List Summarydisplay is limited to the number set in

the MaxResultsproperty.

If you set this property to true, and the number of List Summary itemsexceeds the

MaxResultsnumber, navigation aids appear below the last item. The site visitor

uses the aids to view additional items. See example below.

So, for example, if a List Summaryhas9 itemsand the MaxResultsproperty is set

to 3, the screen displaysonly the first three items.When the site visitor clicks

[Next], he sees items4, 5 and 6, etc.

True =Use paging feature

False = Ignore paging feature

Warning! If the EnablePagingproperty is set to True, the CacheInterval

property is disabled.

Boolean

FolderID

The folder that contains the itemswhich appear in the list summary.See Also:
"Using CMSExplorer to Browse Your Ektron CMS400.NET Site" on page 21-9

The Recursiveproperty determineswhether content blocks in this folder’s child

folders also appear.

Long

GetHtml

Set to True if you want to retrieve and display content (that is, the HTML body) for

all content in the list summary. For example, to display content inside aWeb server

control such asaGridView.

True =Get and displayHTML for each content block in the list summary

False =Do not get and displayHTML.

Boolean

Hide

Used to hide output of the list summary in design time and run time.

True =Hide results

False = show results

Boolean

ListSummary Server Control Properties

ReferenceManual

Version 8.0 Rev 1.3
9-273



Property Description Data Type

IncludeIcons

Choose whether to display iconsnext to the list summary’s links.

Warning! Important: This property onlyworkswhen ecmSummaryor

ecmTeaser are used in the DisplayXsltproperty.When the [$ImageIcon]

variable is used in an EkML file and that file is assigned to the MarkupLanguage

property, this property acts asTrue.See Also: st. "EktronMarkup Lan-
guage" on page 21-414

Boolean

Language
Set a language for viewing the list summary. This property shows results in design-

time (in VisualStudio) and at run-time (in a browser).
Integer

LinkTarget

Defines the waya link actswhen a link is clicked.

_blank - This target causes the link to alwaysbe loaded in a new blankwindow.

Thiswindow is not named.

_self - This target causes the link to always load in the samewindow the anchor

was clicked in. This is useful for overriding a globally assigned base target.

_parent - This target makes the link load in the immediate frameset parent of the

document. This defaults to acting like “_self” if the document hasno parent.

_top - This target makes the link load in the full bodyof the window. This defaults

to acting like “_self” if the document is alreadyat the top. It is useful for breaking out

of an arbitrarily deep frame nesting.

String

MarkupLanguage

Identify the templatemarkup file that controls the display of the list summary. For

example, mylistsummary.ekml.

If the *.ekml file is located in the same folder as theWeb form containing the server

control, just enter its name. If the file is in another folder, enter the path relative to

page hosting this control. For example,

..

\CMS400Developer\workarea\customfiles\markup\mylistsummary.ekml

.

See Also: "EktronMarkup Language" on page 21-414 and

"listsummary.ekml" on page 21-447

Note: If you enter a valid EkML file, the DisplayXsltproperty value is ignored. If

the EkML file contains the [$ImageIcon] variable, the IncludeIconsproperty

acts asTrue.

String
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Property Description Data Type

MaxResults

Enter themaximum number of items to appear in the initial display of this server

control.

To set nomaximum, enter 0 (zero).

To let site visitors view more than themaximum but limit the amount of space being

occupied, enter themaximum number of results per page here. Then, set the

EnablePagingproperty to true.

If you do andmore than the number of MaxResultsare available, navigation aids

appear below the last item to help the site visitor view additional items. See

example below.

Integer

OrderbyDirection

How to order the hyperlinks on the list.

The sort field is determined by the OrderKeyproperty.

ascending - theyare arranged A, B, C or 1,2,3.

descending - theyare arranged. Z, Y, X or 3,2,1

If sorting bydate, descending puts themost recent first.

Data Type: Ektron.Cms.Controls.CmsWebService.OrderByDirection.

OrderKey

Sort the list by one of the values.

Title

DateModified

DateCreated

LastEditorFname

LastEditorLname

See Also: "OrderKeyProperty" on page 9-276

Data Type: Ektron.Cms.Controls.CmsWebService.TeasersOrderBy

Random

Set to True if you want to randomly display one content block in the specified

folder. The content changeseach time a user views the page.

True - randomly display one content block.

False - display the list summarynormally.

Note: If you use a customXSLT or EkML file, the type of content displayed can be

manipulated. For example, if you use an EkML file that has the [$Html] variable in

it, the actual content is displayed instead of a link.See Also: "EktronMarkup

Language" on page 21-414 and "[$Html]" on page 21-429

Boolean
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Property Description Data Type

Recursive

Determines if the display includes content blocks in child folders of the selected

folder.

True - include content blocks from child folders.

False - do not include content blocks from child folders.

Boolean

SelTaxonomyID

Set the ID of the taxonomy that content will be associated with when a logged in

site visitor uses the Silver AccessPoint’sAdd HTML Content to add content to a

list summary server control.

Integer

SuppressWrapperTags
This property is set to false because Ajaxuses<div> tags to rewrite the region

around the tag. You cannot change the value to true.
Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

Custom - Allows you to use a custom tag.

String

OrderKey Property
The OrderKey property determines the order of the content in the list summary based on the

value chosen.

Value Sorts by

DateModified Date content last modified

DateCreated Date content created

LastEditorFname First name of user who last edited content

LastEditorLnames Last name of user who last edited content
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Retrieving the XML Structure of a
List Summary
Retrieving the XML structure of XML content allows for greater control over developing

XSLs. The following is an example of how to retrieve the XML structure:

1. Open a new Web form.

2. Drag and drop a ListSummary server control onto it.

3. Set the FolderID property.

4. Drag and drop a Textbox on the Web form.

5. Set the TextMode property to MultiLine.

Note: Ektron recommendssetting the width of the text box to at least 400px.

6. On the code behind page, add the following line.
Textbox1.Text = ListSummary1.XmlDoc.InnerXml

7. Build the project.

8. View the Web form in a browser.

9. The list summary’s XML structure appears in the textbox.

For an additional example, see the ListSummary XML page on the CMS400Developer samples

page. It is located at:

In a browser:

http://<site root>/CMS400Developer/Developer/ListSummary/ListSummaryXML.aspx

In the source code:

<site root>/CMS400Developer/Developer/ListSummary/ListSummaryXML.aspx and

ListSummaryXML.aspx.vb
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Breadcrumbs

A breadcrumb is display of the trail a site visitor took to arrive at the page. Breadcrumbs are

commonly found on Web sites to help navigate the site. For example, a simple text breadcrumb

such as Products->Monitors->Flat Panel shows that you arrived at this page by clicking

Products, then Monitors, then Flat Panel.

Sitemap Breadcrumbs versus History
Breadcrumbs
Ektron CMS400.NET provides two kinds of breadcrumbs:

n sitemap

n history

Sitemap breadcrumbs display the path through the sitemap to the current page, like the path

shown in a Yahoo! directory listing. Sitemap breadcrumbs always show the same path to a

page, regardless of how it is reached. To use a sitemap breadcrumb, see "Creating SiteMap

Breadcrumbs" on page 9-278.

History breadcrumbs more accurately fulfill the breadcrumb trail metaphor. They display a

history of links to the most recently visited pages. The BreadCrumb server control displays

history breadcrumbs. Site visitors can use a breadcrumb trail to jump to previously visited

pages. To user history breadcrumbs, see "BreadCrumb Server Control" on page 9-285.

Creating SiteMap Breadcrumbs
Use the Breadcrumb tab to define a folder’s site map or to inherit one from the parent folder.

Below is an example.
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The following topics explain how to create and manage sitemap Breadcrumbs within the

Workarea. "BreadCrumb Server Control" on page 9-285 explains how to place them on a Web

page.

n "Inheritance and Breadcrumbs" on page 9-279

n "Adding a Breadcrumb" on page 9-279

n "Reordering Breadcrumb Items" on page 9-282

n "Editing a Breadcrumb Item" on page 9-283

n "Removing a Breadcrumb Item" on page 9-284

Inheritance and Breadcrumbs
A folder’s breadcrumbs can be inherited from the parent folder, or you can break inheritance

and assign a path of breadcrumbs. Use the Folder Properties screen’s Inherit Parent

Configuration checkbox to retain or break inheritance.

Adding a Breadcrumb
The example below adds three breadcrumbs to the trail.

1. Navigate to the folder for which you want to add the breadcrumbs.

2. On the View Contents of Folder screen, click View > Properties.

3. Click the Edit Properties button ( ).

4. Click the Breadcrumb tab.

5. The Edit Breadcrumbs screen appears.
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6. In the Add New Item section of the screen, add the following information.

n Title - the name of the breadcrumb as you want it to appear in the breadcrumb trail

n URL Link - the URL path to the breadcrumb’s destination, typically a Ektron

CMS400.NET content item. For example, default.aspx.

If you are not sure what the file’s name is, click the Binoculars ( ), and the library for quick-
links appears. Select the content item to add to the breadcrumb.

You can also enter a URL, for example, www.example.com.

n Description - add a description for the breadcrumb

7. Click the Add button.

8. The first item in the breadcrumb path appears.
.
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9. Repeat steps 6 and 7 for each item in the breadcrumb path.

10. The items in the breadcrumb now appear like this.

11. Click the Save button ( ).
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Reordering Breadcrumb Items
1. Navigate to the folder for which you want to reorder breadcrumbs.

2. On the View Contents of Folder screen, click View > Properties.

3. Click the Edit Properties button ( ).

4. Click the Breadcrumb tab.

5. The Edit Breadcrumbs screen appears.
.

6. Click a breadcrumb item.

Warning! Clicking the Remove button deletes the breadcrumb item. See Also: "Removing a Breadcrumb Item"

on page 9-284.
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7. Click the green Up and Down buttons to move the item around in the list.

8. Click the Save button ( ).

Editing a Breadcrumb Item
1. Navigate to the folder for which you want to edit breadcrumbs.

2. On the View Contents of Folder screen, click View > Properties.

3. Click the Edit Properties button ( ).

4. Click the Breadcrumb tab.

5. The Edit Breadcrumbs screen appears.
.

6. Click a breadcrumb item.
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Warning! Clicking the Remove button deletes the breadcrumb item. See Also: "Removing a Breadcrumb Item"

on page 9-284.

7. Edit the Title, URL Link and Description information.

8. Click the Save button ( ).

Removing a Breadcrumb Item
1. Navigate to the folder for which you want to remove a breadcrumb.

2. On the View Contents of Folder screen, click View > Properties.

3. Click the Edit Properties button ( ).

4. Click the Breadcrumb tab.

5. The Edit Breadcrumbs screen appears.
.
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6. Click the Remove button ( ) next to the breadcrumb item you want to remove.

7. The breadcrumb item is deleted.

8. Click the Save button ( ).

BreadCrumb Server Control

The Trail Created by the Breadcrumb Server Control
The breadcrumb trail can appear vertically or horizontally on a Web page. In addition, you can

define how many breadcrumbs are left for site visitors to navigate back. You can also use an

image and Alt text instead of, or in addition to, text to display the breadcrumb trail. These

variations are illustrated below.

Note: If a site visitor revisits a page that is in the breadcrumb trail already, the breadcrumb trail reverts back to that

point in the trail. For example, if you visit the following pagesDev>FAQ>WebForm >PR, and then return to FAQ,

the breadcrumb trail looks like this:Dev > FAQ.

Breadcrumb Trail Type Example

Horizontal; text only
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Breadcrumb Trail Type Example

Horizontalwith images

Horizontalwith imagesand Alt text

Vertical; text only

Verticalwith images

Verticalwith imagesand Alt text

You should add a BreadCrumb server control to every Web form in your site. Doing this

ensures that a breadcrumb trail is created for each Web page.

This subsection contains the following topics:

n "BreadCrumb Properties Apply to Web Forms, Not Web Pages" on page 9-287

n "Types of BreadCrumb Server Control Properties" on page 9-287

n "BreadCrumb Server Control Properties" on page 9-288

n "Using the BreadCrumb Server Control" on page 9-292

n "Making a Content Block’s Title Appear in the Breadcrumb Trail" on page 9-293
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BreadCrumb Properties Apply to Web Forms, Not Web
Pages
Keep in mind that your Web site is made up of Web forms. Each page depends on a form to

determine much of its appearance. Forms and pages have a parent > child relationship. That is,

any form can be associated with any number of pages.

When defining breadcrumb properties, you define them for a form. All pages that use that form

inherit its breadcrumb properties.

Assume, for example, that a Web form is used for the Human Resources section of your Web

site. You might use the title Human Resources to identify the form in the BreadCrumb server

control. Whenever a page is visited that uses that form, Human Resources appears on the

breadcrumb trail -- that is, the form title appears, not the individual page.

Types of BreadCrumb Server Control Properties
BreadCrumb server control properties are divided into two categories:

n "Properties that Determine a Breadcrumb Trail’s Appearance" on page 9-287

n "Properties that Determine How Pages Associated with the Form Appear on a Breadcrumb

Trail" on page 9-288

Properties that Determine a Breadcrumb Trail’s Appearance
For each Web form, you can customize the breadcrumb trail. For example, you might want the

breadcrumb trail to appear horizontally on one Web form and vertically on another.

Property

Determines this aspect of the

breadcrumb trail’s appearance on

this form

Formore

information, see

CurrentPageIndicator
Symbols or characters to identify the current

page

"CurrentPageIndicator"

on page 9-289

DisplayStyle Whether it appears horizontally or vertically
"DisplayStyle" on page

9-289

LinkLastItem Whether the last item is a hyperlink
"LinkLastItem" on page

9-290

LinkTarget
The type of window that appearswhen a

user clicks an item

"LinkTarget" on page 9-

290
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Property

Determines this aspect of the

breadcrumb trail’s appearance on

this form

Formore

information, see

MaxItems Themaximum number of items
"MaxItems" on page 9-

291

Mode
whether the breadcrumb trail appears as

hyperlinked text or plain text.
"Mode" on page 9-291

Separator
Symbols or characters used to separate

items

"Separator" on page 9-

291

Properties that Determine How Pages Associated with the
Form Appear on a Breadcrumb Trail
Use these properties define how any page that uses this form appears within a breadcrumb trail.

It does not matter where the trail appears.

Note that you can use text, an image, or both to describe the form within the breadcrumb trail.

If you use both, the image appears first, followed by the text.

Property
Determines this aspect of Web form when it

appears on breadcrumb trail

For more

information,

see

DisplayTitle Text to describe it
"DisplayTitle" on

page 9-289

IconAlt
“Alt” text associated with image specified in IconPath

property

"IconAlt" on page

9-290

IconPath Image to define it
"IconPath" on page

9-290

BreadCrumb Server Control Properties
The BreadCrumb server control properties are described in this table.
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Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Response
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can

use it to browse to Content, Collections, etc.See Also:
"Using CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9

String

CurrentPageIndicator

If desired, enter one or more symbols or characters that

identify the current page in the breadcrumb trail. See

example below.

These characters appear after the image or title that

identifies the current page in the breadcrumb trail.

String

DefaultContentID
Gets or Sets the ContentID for the BreadCrumb display

title.
Long

DisplayStyle

Indicate how to display the breadcrumb trail: horizontally

or vertically. The default isHorizontal.See Also:
"Breadcrumb Trail Type" on page 9-285

String

DisplayTitle

Enter text to describe thisWeb formwhen it appears in

the breadcrumb trail. For example, if theWeb form’s

properties you are defining is used for all Human

Resourcespageson your site, enter Human

Resources.See Also: "BreadCrumb Properties
Apply toWeb Forms, NotWeb Pages" on page 9-287

If you define an image in the IconPathproperty below,

the image appears in the trail, followed by this text.

Warning! Important: This property is for code behind

only. It cannot be set in design time.

String

DynamicParameter
Gets or sets the QueryString parameter to read a content

ID dynamically.
String

Hide

Used to hide the breadcrumb trail in design time and run

time.

True =Hide breadcrumb trail

False =Show breadcrumb trail

Boolean
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Property Response
Data

Type

IconAlt

If you define an image in the IconPathproperty, enter

any “Alt” text that should appear when a site visitor hovers

the cursor over that image. Here is an example.

String

IconPath

If you want the breadcrumb trail to display an image to

identify thisWeb form, enter the path to the image.

Warning! Important: The image locationmust be rel-

ative to theWeb root.

For example:

\CMS400Developer\Workarea\Images\bc_meta_

icon.gif

On the breadcrumb trail, the image precedesany text

defined in the DisplayTitleproperty.

String

Language

Set a language for viewing content. This property shows

results in design-time (in VisualStudio) and at run-time (in

a browser).

Integer

LinkLastItem

Use this property to determine whether the last

breadcrumb item appears asa hyperlink on thisWeb

form. If this property is set to true, and a user clicks the

item, the current page reappears.

True = last item is a hyperlink

False = last item is an image and/or text only; the user

cannot click on it

Boolean

LinkTarget

Determines the type of window that appears on thisWeb

formwhen a user clicks an item in the breadcrumb trail.

The default is_self.

_Self -opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

String
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Property Response
Data

Type

MaxItems

Enter themaximum number of items in the breadcrumb

trail on thisWeb form.

The default is5.

If you set a value of 1 or greater and the user navigates

beyond that number of pages, only themost recent pages

appear. The older pagesdisappear from the trail.

To allows an unlimited number of breadcrumb

trail items on this Web form, enter zero (0).

Integer

MetadataName

Specify the name of aMetadata Type that you want to

associate with the page. For more information, see

"BreadCrumbMetadata Type" on page 9-292

String

Mode

Allowsyou tomake the breadcrumb trail appear asnon-

hyperlinked plain text. The default isNormal.

Normal =breadcrumb trail is hyperlinked

DisplayOnly =breadcrumb trail is plain text

String

Separator

Enter one or more characters to separate the items in a

breadcrumb trail on thisWeb form.

The default character is the greater than sign (>).
String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the

control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line

portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply

attributes to a blockof code.

Custom - Allows you to use a custom tag.

String
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BreadCrumbMetadata Type
To associate a Metadata Type with the BreadCrumb server control, follow these steps.

1. In the properties window for the BreadCrumb server control, click on the MetadataName

property.

2. Click the Ellipses button ( ).

If you are not logged in, log in now using the CMS Explorer window.

3. The Browsing Metadata screen appears.

4. Select a Metadata Type to apply to the BreadCrumb server control.

5. Set the DynamicParameter to ID. This allows the metadata to reflect what ever content

block appears on the page.

Using the BreadCrumb Server Control
Add the BreadCrumb server control to each Web form for which you want to create a

breadcrumb trail. Follow these steps to use the BreadCrumb server control.

Warning! It is recommended that you do not add a BreadCrumb server control to aWeb form that contains a Cal-

endar server control. When both server controls appear on the same page and a site visitor clicks on different

months, the BreadCrumb trail could look like this: Calendar >Calendar >Calendar >Calendar >Calendar. This

happensbecause each time a site visitor clicks on amonth, you are in effect opening a newWeb form.

1. Open a Web form for which you want to create a breadcrumb trail.

2. Drag and drop the BreadCrumb server control onto an appropriate location of the Web

form.

3. Set the DisplayTitle property. See "DisplayTitle" on page 9-289.

Note: To customize the lookof your breadcrumb trail, configure the other properties. For more information,

see"BreadCrumbServer ControlProperties" on page 9-288.
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4. Save the Web form.

5. Repeat steps one through four for all Web forms to be included in the breadcrumb trail.

6. Open a browser.

7. View a Web page with a BreadCrumb server control in it.

8. Navigate to the rest of the Web pages that contain BreadCrumb server controls.

9. As you move around, the pages are added to the breadcrumb trail.

Making a Content Block’s Title Appear in the
Breadcrumb Trail
By adding a line or two of code, the breadcrumb trail can display the title of a content block.

You can add a line of code to each Web form or if your content is dynamic, add the code once

and each time a new piece of content is called dynamically a new breadcrumb is created.

Only one content block per Web form can be used with the breadcrumb. If you have multiple

content blocks on a page, select the one that describes the overall page best.

Steps to Use a Content Block’s Title as a Breadcrumb
1. Drag and drop a ContentBlock server control on a Web form.

2. Choose a DefaultContentID for the content block.

3. Drag and drop a BreadCrumb server control on the same form.

4. Remove the word Title from the DisplayTitle property.

5. Add the following line code to the page load event code behind:
BreadCrumb1.DisplayTitle = ContentBlock1.EkItem.Title

6. Build the project.

7. View the Web form in a Web browser.

The following is an example content block titles used as breadcrumbs:
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The word Title appears in the breadcrumb trail when the DisplayTitle property is left empty.

Even with the added code, if the breadcrumb loads before the content block, the breadcrumb

has no information in the DisplayTitle property and therefore displays the word title by

default.

If the word Title appears in the breadcrumb trail, check to make sure the word Title does not

appear in the DisplayTitle property. Next, if Title still appears, add the following line of code

to the page load event of the code behind:

ContentBlock1.Fill()

The code in the page load event should now look like this:

ContentBlock1.Fill()
BreadCrumb1.DisplayTitle = ContentBlock1.EkItem.Title

This ensures that the content block information is loaded first.

FolderBreadcrumb Server Control
The FolderBreadcrumb server control displays sitemap breadcrumbs. This trail typically consists

of the current content’s folder path. For example, the FolderBreadcrumb below matches the

content’s folder structure.
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The FolderBreadcrumb server control does not simply read your folder structure and display its

path. Instead, administrators define a folder’s breadcrumb trail on the content’s folder properties

> Breadcrumb tab.

See Also: "Creating SiteMap Breadcrumbs" on page 9-278; "The Trail Created by the

Breadcrumb Server Control " on page 9-285

This subsection contains the following topics:

n "BreadCrumb Server Control Properties" on page 9-295

n "Using the BreadCrumb Server Control" on page 9-297

BreadCrumb Server Control Properties

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer

and can use it to browse to Content, Collections,

etc.See Also: "Using CMSExplorer to Browse

Your Ektron CMS400.NET Site" on page 21-9

String

DefaultContentID

Display the breadcrumb trail for the folder in which

the given content ID resides. To use this property,

breadcrumb information for a folder must be

defined in theWorkarea > [Specified Folder] >

Folder properties>Breadcrumb tab.

Long
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Property Description Data Type

DefaultFolderID

The folder ID for which you want the breadcrumb

trail to display. If a DefaultContentID is given, it

overrides this property. To use this property,

breadcrumb information for a folder must be

defined in theWorkarea > [Specified Folder] >

Folder properties>Breadcrumb tab.

Long

DisplayStyle
Indicate how to display the breadcrumb trail:

horizontally or vertically. The default isHorizontal.
DisplayStyles

DynamicParameter
Gets or sets the QueryString parameter to read a

content ID dynamically.
String

Hide

Used to hide the breadcrumb trail in design time

and run time.

True =Hide breadcrumb trail

False =Show breadcrumb trail

Boolean

Language

Set a language for viewing content. This property

shows results in design-time (in VisualStudio) and

at run-time (in a browser).

Integer

LinkTarget

Determines the type of window that appears on this

Web formwhen a user clicks an item in the

breadcrumb trail. The default is_self.

_Self -opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

ItemLinktargets

Mode

Allowsyou tomake the breadcrumb trail appear as

non-hyperlinked plain text. The default isNormal.

Normal =breadcrumb trail is hyperlinked

DisplayOnly =breadcrumb trail is plain text

Modes

Separator

Enter one or more characters to separate the items

in a breadcrumb trail on thisWeb form.

The default character is the greater than sign (>).

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround

the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WebSite Navigation Aids

9-296
ReferenceManual

Version 8.0 Rev 1.3



Property Description Data Type

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-

line portion of an HTML document asa span

element.

Div - The <div> tag is used when you want to apply

attributes to a blockof code.

Custom - Allows you to use a custom tag.

String

Using the BreadCrumb Server Control
Add the FolderBreadcrumb server control to each Web form for which you want to create a

breadcrumb sitemap. Follow these steps to use the FolderBreadcrumb server control.

1. In the CMS400.NET Workarea, define breadcrumb information for a folder. See "Adding a

Breadcrumb" on page 9-279.

2. Open a Web form for which you want to create a folder breadcrumb map.

3. Drag and drop the FolderBreadcrumb server control onto an appropriate location of the

Web form.

4. Set the DefaultContentID or DefaultFolderID property. If using DefaultContentID, make

sure the content is in a folder where breadcrumb information has been defined. If using

DefaultFolderID, make sure breadcrumb information has been defined for that folder.

5. Save the Web form.

6. Open a browser.

7. View a Web page with the FolderBreadCrumb server control in it.

8. The FolderBreadcrumb now appears on your site as a sitemap breadcrumb.
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SiteMap Server Control
The Sitemap server control utilizes the folder breadcrumb information in the Workarea to

display a sitemap of your site. By choosing the starting point of the sitemap, the max levels to

display and applying a style class, you can customize the sitemap. The sitemap is displayed as

indented list when viewed on a Web page.

The contents of the sitemap are defined on the Breadcrumb tab located in the Workarea folder

properties. See Also: "Breadcrumbs" on page 9-278

This subsection contains the following topics:

n "Sitemap Server Control Properties" on page 9-298

n "Using the Sitemap Server Control" on page 9-300

n "Retrieving the XML Structure of a Site Map" on page 9-301

Sitemap Server Control Properties
The Sitemap server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.
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Property Response
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can

use it to browse to Content, Collections, etc.See Also:
"Using CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9

String

CacheInterval

Sets the amount of time the server control’s data is

cached. The default is 0 (zero). This is the amount of time,

in seconds, a control’s data is cached. For example, if you

want to cache the data for fiveminutes, set this property to

300 (three hundred).See Also: "Caching with

Server Controls" on page 21-31

Double

ClassName

The style sheet classname used to format the HTML.

Leave blank to use the default. To use a new class, add it

to the following file:

webroot\siteroot\Workarea\csslib\sitemap.css

Then, add the classname to the property.

String

DisplayXslt

(Code behind only)

Specify an externalXSLT file to render the control.

Warning! Important: If you want to edit this file, it is

strongly recommended that youmake a copy, change its

name andmove it outside of your site’sWorkarea folder.

If youmake changes to this file and do not move it out of

theWorkarea, this file and the changeswill be lost when

you upgrade.

String

FlatTopLevel

When set to True, include site nodes from the parent

folder but not their items. Set to False to include all nodes

and items.

Boolean

FolderID
The folder ID for the starting point of the sitemap. To

choose the root folder, enter 0 (zero).
Long

Hide

Used to hide the Sitemap in design time and run time.

True =Hide Sitemap trail

False =Show Sitemap trail

Boolean

Language

Set a language for viewing content. This property shows

results in design-time (in VisualStudio) and at run-time (in

a browser).

Integer

MaxLevel
Set themaximum amount of levels to show. Set it to 0

(zero) for unlimited.
Integer

StartingLevel
Set to the starting level of the site map. If set to 0 (zero),

starts from the root.
Integer
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Property Response
Data

Type

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the

control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line

portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply

attributes to a blockof code.

Custom - Allows you to use a custom tag.

String

Using the Sitemap Server Control

Note: Make sure you have added the sitemap information to your folders’Breadcrumb tab in the CMS400.NET

Workarea.

Follow these steps to use the Site server control.

1. Open a Web form for which you want to create a sitemap.

2. Drag and drop the Sitemap server control onto an appropriate location of the Web form.

3. Add the starting folder’s ID to the FolderID property.

4. Set any of the other properties. See Also: "Sitemap Server Control Properties" on page 9-

298.

5. Save the Web form.

6. Open a browser.

7. View a Web page with the Sitemap server control in it.

8. The sitemap now appears on your site.
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Retrieving the XML Structure of a Site Map
Retrieving the XML structure of XML content allows for greater control over developing

XSLs. The following is an example of how to retrieve the XML structure:

1. Open a new Web form.

2. Drag and drop a SiteMap server control onto it.

3. Set the FolderID property.

4. Drag and drop a Textbox on the Web form.

5. Set the TextMode property to MultiLine.

Note: It is also recommended that you set the width of the text box to at least 400px.

6. On the code behind page, add the following line.
Textbox1.Text = SiteMap1.XmlDoc.InnerXml

7. Build the project.

8. View the Web form in a browser.

The XML structure of the Site Map appears in the textbox.

For an additional example, see the XML Site Map page in the CMS400Developer samples

page. It is located at:

In a browser:

http://<site root>/CMS400Developer/Developer/Sitemap/SiteMapXML.aspx

In the source code:

<site root>/CMS400Developer/Developer/Sitemap/SiteMapXML.aspx and SiteMapXML.aspx.vb
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Personalizing a Web Page

Personalization is fast becoming an integral part of Web sites like

iGoogle and Facebook, and organizations see personalization as a way to

make their sites stickier and more engaging.

The following video introduces Personalization:

http://www.ektron.com/personalization/

Ektron CMS400.NET provides tools to let membership users personalize their experience on

your site, bringing relevant information to their fingertips. By letting users add widgets,

applications, and feeds to a Web site, CMS400.NET provides a framework on which to easily

build true, personalized portals.
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Make Your Site, Their Site with CMS400.NET

When membership users can choose and organize content on their digital dashboard, your site

becomes their site. Everyone has different needs and preferences, and CMS400.NET’s portal

functionality lets you create a more interactive, engaging experience by giving power to the

user.

How Personalization Works

On an Ektron CMS400.NET Web site, personalized areas can have multiple tabs, letting users

organize content by subject – think of tabbed browsing. Users can easily add new tabs, switch

between them, and define each one as public or private. For example, a tab that displays

personal financial information can be private, so only that user can see it. Each tab can have

multiple columns, to further customize the view.

Ektron CMS400.NET widgets can be dragged and dropped into each tab. These widgets can

range from RSS feeds to applets to Ektron server controls. They make it possible for a site

visitor to access all information from one location, rather than using many mouse clicks to log

into separate Web sites or applications.

Developers can give users access to any pre-built Ektron CMS400.NET widgets, and even

build their own widgets that talk to third-party systems to customize the way site visitors are

engaged. See Also: "Creating Your Own Widgets" on page 21-386 and "Standard Widgets" on

page 21-404

Empower your Intranet ...

Building personalization into your intranet empowers employees with customization that fits

their work and personal life. Widgets can range from photos, local weather, and updated news

to a personal work calendar, a sales time line and tracker, or a feed to a discussion board about

a new product release.
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Managers can use widgets to enhance their access to their team’s information. A human

resources department can update job postings on a weekly basis via a widget rather than

navigating to the company’s careers site.

… and Public Facing Web Sites

Personalization revolutionizes the way visitors interact with sites, and Ektron CMS400.NET

provides the tools to make that happen. See what some organizations can do with

personalization.

n Healthcare portals have regular site visitors who desire the same information each time

they visit. Enable visitors to receive allergy, fitness, nutrition, and appointment information

whenever they log in – your site visitors may even save recipes to their nutrition tab.

n Clothing store customers are fashion-minded individuals who like to view the latest styles

on these Web sites. Let them view the department they always go to first with the click of

a button. Clothing widgets can show what’s available in their size. This personalization

will increase site traffic and sales.

n Banking sites can allow users to access personal account widgets, and separate it from their

business financial information. Calculator widgets can keep them on the site as they make

financial decisions.

n Schools personalize their Web site for each student and parent. Personalized portals let

students have widgets such as school e-mail, personalized school calendars (with their

homework, project due dates and social events), feeds linked directly to their grades, a

school library search tool, and more to keep them connected and informed.

Personalization enables membership users to access information they want with the click of a

button. No longer do they have to navigate all over a Web site (or sites) to find content.

Ektron CMS400.NET’s personalization functionality lets organizations create iGoogle-like

interfaces integrated within content management, so that they can serve their customers and

members in a more powerful and personal way, building user adoption and increasing site

traffic.

The following topics explain personalization in more detail.

n "Personalization versus PageBuilder Pages" on page 9-305

n "Individual versus Group Personalization Pages" on page 9-305

n "Sample Personalization Pages" on page 9-306

n "Creating an Individual Personalization Page" on page 9-306

n "How a Membership User Interacts with an Individual Personalization Page" on page 9-

311

n "Creating a Community Group Personalization Page" on page 9-313

n "How a User Interacts with a Community Group Personalization Page" on page 9-316
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Personalization versus PageBuilder
Pages
Personalization lets a membership user or community group member customize a single page

on your site for their own use. A PageBuilder page, on the other hand, lets an Ektron

CMS400.NET user create pages that make up your Web site.

Both page types use widgets. See Also: "Standard Widgets" on page 21-404

Individual versus Group
Personalization Pages
An individual personalization page is used by a membership or an Ektron CMS400.NET user

to personalize a page on your Web site. A page consists of tabs, and each tab can contain

several widgets.

If a tab is private, only that user can view and edit it. If the tab is public, anyone can view it

but only the signed-in user can create and edit the content.

A group personalization page is used by group members to set up a portal page that addresses

that group’s unique needs. Any group member can view and create or edit the page’s content.

If a tab on a group page is private, only group members can view and create or edit it. If the

tab is public, anyone can view it but only the group members can create and edit the content.
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Sample Personalization Pages
You can find examples of personalization pages in these Ektron sample sites. You can copy

and edit the samples as needed to build your personalization pages.

To download sample sites, go to http://www.ektron.com/solutions/startersites/.

Individual Personalization Pages

n Technology site > Login > My Profile > Dashboard

n Intranet Site > Login > My Profile > Dashboard

n Developer Sample site > Personalization

Group Personalization Pages

n Technology site > Login > Community > Community Groups > select group, such as

Ektron Tech Web Design > Dashboard

n Intranet Site > Login > Groups > select group > Dashboard

Creating an Individual
Personalization Page
Follow these steps to create a personalization page from scratch. After you create the page,

place a link to it on your site. Then, any authenticated membership user can use the page to

create his own personal portal.

This section consists of the following subtopics.

n "Widget Spaces" on page 9-307

n "Steps for Creating a Personalization Page" on page 9-307

n "Verify that the User is Authenticated" on page 9-310
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Widget Spaces
A widget space is a mechanism that lets you determine which widgets individual users or a

community group can drop onto a personalization page.

For example, one group of users should only be allowed to drop weather and news feed

widgets onto their personalization page. In this case, you would

n Create a widget space.

n Select only weather and news feed widgets.

n Sign on to Visual Studio to create the .aspx page.

n Drop a Personalization user control onto the page.

n In the control’s widgetspaceID property, identify the widget space you created in bullet 1.

Steps for Creating a Personalization Page
1. Go to Ektron CMS400.NET Workarea > Settings > Configuration > Personalization >

Widgets. See Also: "Standard Widgets" on page 21-404

2. Click the Sync button ( ) make sure all widgets are available.

3. Go to Settings > Configuration > Personalization > Widget Space.

4. Click the add button ( ).

5. Enter a Title.

6. Only check the Group Space checkbox if this widget space will be used for a community

group personalization page.

7. Select widgets that authorized users will be able to drop onto a page.
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As you select a widget, its background color changes.

These widgets appear in the personalization screen’s widget tray (shown below) when a

membership user is personalizing a page.

8. Click the Save button ( ).

Note: Remember your widget space’s ID number. You need it when setting up the Personalization user control.

9. Open Visual Studio.

10. Create a new Web Form.

11. Switch to design view.

12. From the Toolbox, drag and drop an Ajax Extensions > Script Manager control.
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If you do not see a Script Manager control, install the Microsoft AJAX Library 3.5. To do

this, go to http://www.asp.net/ajax/downloads/.

13. In the Visual Studio folder browser, open the workarea/personalization/ folder.

14. Drag and drop a Personalization user control (personalization.ascx).

15. Set the control’s widgetspaceid property (circled below) to the ID number of the widget

space you added in Step 6.
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16. Save the Web Form.

Verify that the User is Authenticated
Your page should redirect the user to the personalization page, or use an ASP.NET panel to

verify that user is authenticated.

Note: The asp.net panels are implemented in eIntranet and ektron Tech site.

Here is sample code you can use.

Aspx.cs

// To check if user is logged in or not
Ektron.Cms.CommonApi IsUserLoggedIn = new Ektron.Cms.CommonApi();
if (IsUserLoggedIn.IsLoggedIn)
{
Response.Redirect(“dashboard.aspx”);
Or
pnlDashboard.Visible= true;
}
Else
{
pnlDashboard.Visible=false;

}

Aspx
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<asp:Panel ID="pnlDashboard" runat="server" Visible="False">
<asp:ScriptManager ID="ScriptManager1" runat="server"

EnablePartialRendering="true"></asp:ScriptManager>
<ucEktron:Personalization ID="widgetSpace" WidgetSpaceID="1"

DynamicForeignIDParameter="id" runat="server" />

</asp:Panel>

The Synchronize Widgets Screen
This screen helps you synchronize widgets in your Web site’s site root/widgets folder with

those in your Ektron CMS400.NET Workarea. So, for example, you recently created two new

widgets. To make them available within the Workarea, click this screen’s Synchronize button (

).

After you click the button, you see new widgets on this screen and other Workarea screens

that let you select widgets. Conversely, clicking this button removes any widgets that you

delete from the site root/widgets folder.

How a Membership User Interacts
with an Individual Personalization
Page
To access a personalization page, a membership user logs in then clicks My profile >

Dashboard. Initially, the dashboard looks like this.

Inserting a Tab and Column

The user adds a tab by clicking the down arrow circled above and choosing Add Tab.

How aMembership User Interacts with an Individual
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Public vs. Private Tab
When creating a tab, the user must decide if it is public or private.

Any logged-in user can see a user’s public tab by visiting his profile and clicking Dashboard.

A private tab is visible only to the user who created it.

Adding Columns
Next, the user must add at least one column. To do this, he clicks the down arrow circled

below and chooses Add Column.

Here is an example of a tab with three columns.

WebSite Navigation Aids

9-312
ReferenceManual

Version 8.0 Rev 1.3



Adding Widgets
To add a widget, the user clicks the other down arrow (circled below), then drags and drops

the desired widgets.

The selection of widgets was determined when the widget space was created. See Also: "How

a Membership User Interacts with an Individual Personalization Page" on page 9-311

Creating a Community Group
Personalization Page
A community group personalization page is similar to an individual page. It lets group

members customize a page’s content by dropping widgets. For an introduction to these
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concepts, see

n "Personalizing a Web Page" on page 9-302

n "Individual versus Group Personalization Pages" on page 9-305

n "Sample Personalization Pages" on page 9-306

n "Creating an Individual Personalization Page" on page 9-306

n "How a Membership User Interacts with an Individual Personalization Page" on page 9-

311.

Setting up a Community Group Personalization Page
To create a Community Group personalization page, follow the instructions in "Creating an

Individual Personalization Page" on page 9-306, with the following differences

n When creating a Widget space, check the Group Space checkbox.

n When a developer creates an .aspx page and drops a personalization control, the selected

Widget space must be one whose Group Space box is checked.
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n A private tab is visible only to group members.
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How a User Interacts with a Community Group
Personalization Page
To access a Community Group personalization page, a membership or Ektron
CMS400.NET user group member logs in then navigates to the group’s
personalization page. See Also: "Group Personalization Pages" on page 9-306

Initially, a group personalization page looks like this.

Community group members work with a personalization page in the same way they work with

individual personalization pages. See "Inserting a Tab and Column" on page 9-311 and

"Adding Widgets" on page 9-313.
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Search engine optimization (SEO) plays a key role in every Web marketing strategy. Ektron

CMS400.NET’s URL aliasing makes it easy to create descriptive, meaningful and SEO-friendly

URL aliases consistently, maximizing your Web site’s placement in search results.

For a video introduction to Ektron CMS400.NET’s Aliasing feature, go to:

http://media.ektron.com/flash/urlaliasing/480x360/ektronaliasing/ektronaliasing.html

There are four important aspects of URL Aliasing.

n Automatic Aliasing - Normally-generated URLs are barely human readable, let alone

search engine-friendly. With search engines using the text in a URL to define where a

page shows up on a search return, it has never been more important to have descriptive

URLs. While you can manually create aliases that will do the job, CMS400.NET gives

you the tools you need to generate them automatically, with consistent structure.

These human-readable URLs are predicable and scalable, following consistent patterns that can

apply to all of your sites. The use of words and phrases that actually define the page itself

increases these aliases’ search engine rankings. By following a pattern, they are scalable, and

that pattern can be used across your sites as they grow.

Sites that are currently built migrate easily to CMS400.NET, adopting the new aliasing scheme.

No longer do you have to make changes to the web.config, and aliasing can keep old links

valid. Once the URL aliasing function is configured and enabled, all content inherits the new

aliasing structure.

URL aliases generated by CMS400.NET don’t require an extension of how the page is built;

search engines find “real” words. Web site performance affects search engine returns as well,

and Ektron’s URL aliasing takes this into account: these aliases are cached, improving per-

formance.

URLAliasing
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n Taxonomy-Based Alias - URL aliases can be auto-created by Ektron CMS400.NET based

on the taxonomy of your Web site. It uses the levels of the taxonomy plus the title of the

page itself to produce an alias. Search engines will find those words, increasing the page’s

relevancy in any search for them. And because it is based on the taxonomy (which lets

content be established in one-to-many relationships), multiple aliases can be created that

will have relevancy to multiple search criteria.

n Folder-Based Alias - Ektron CMS400.NET can also automate the creation of folder-based

URL aliases. Similar to taxonomy-based aliases, deriving an alias from the folder structure

produces one that is relevant to the content’s actual location. With descriptive folder

names and good organization, this produces SEO-friendly addresses comprised of folder

structure plus title of page.

n Manual & RegEx Based Alias - For some pages with content that follows a pattern,

Regex aliasing may be the answer. It looks for a pattern in the current URL, and then

replaces it with a different pattern to create a relevant alias. For example, a blog site may

be best served by Regex aliases that rely on entry date.

Manual aliasing is also available in Ektron CMS400.NET. By enabling it, you can define the

pages very specifically, including adding metadata to further improve SEO for that page.

Effects of Aliasing Content
Once your content is aliased, a site visitor can enter either the original URL or the alias into

the browser to view the page. Also, if someone selects a content link on your Web page, the

alias frequently replaces the original URL in the browser.

Also, when an Ektron CMS400.NET user is editing content and inserts a quicklink whose

content has several aliases, a screen appears, and he must select one of the aliases. (If only one

alias is assigned to the content, it is applied to the quicklink.)

This chapter explains how to alias Ektron CMS400.NET content through the following topics.

n "Benefits of Aliasing" on page 10-4

n "Types of URL Aliasing" on page 10-4

n "Features Not Supported by Aliasing" on page 10-6

n "Aliasing and Relative Links" on page 10-7

n "Configuring URL Aliasing" on page 10-8

n "Manually Clearing the Cache" on page 10-17

n "Automatic URL Aliasing" on page 10-19

n "Manual Aliasing" on page 10-27

n "Using RegEx Expressions" on page 10-37

n "Site Aliasing" on page 10-42

Effects of Aliasing Content
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n "Upgrading from Previous Releases" on page 10-44

n "Assigning an Alias to Multi-Language Content " on page 10-45

n "Using Classic ASP with Windows 2008 Server 64 Bit" on page 10-46

Benefits of Aliasing
Here are some examples of why you’d want to alias Ektron CMS400.NET pages.

n To provide shorter, more user-friendly URLs, which map to longer paths. For example,

www.ektron.com/training/ may be preferable for marketing materials.

n If you have a PHP site, you can alias all php pages and use the same query string names to

pass needed information to the new .aspx pages.

Note: Anyquery stringsappended to an aliased page pass to the .aspxpage andmaybe used if necessary.

n If you have a static Web site (for example, all HTML pages) that is indexed in a search

engine, you can alias your site and retain complete content management without affecting

your search engine ranking.

n Some search engines work better without the URL parameters that make up an Ektron

CMS400.NET Web page name. URL Aliasing creates page names that search engines

might more easily recognize.

Types of URL Aliasing
There are three types of URL aliasing, described below.

n Automatic Aliasing - can automatically change the page name format of a group of

content blocks. You determine the group by selecting a taxonomy or a top-level Ektron

CMS400.NET folder.

For example, you might choose a folder and alias its content using the content title followed

by slash (/). So, while the original URL might be www.example.com/Human_resources/Post-

ings/hr.aspx?id=8745, the aliased one might be www.example.com/jobs/.

For more information, see "Automatic URL Aliasing" on page 10-19.

n Manual Aliasing - You can manually alias any content block using whatever unique

name you wish. For example, you can alias your technical support page as

www.example.com/help.htm, even though its real name is www.example.com/help.aspx?id=27.

URLAliasing
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You can assign several manual aliases to content then decide which one is the primary. For

more information, see "Manual Aliasing" on page 10-27.

If both alias types are provided for a content item, a user can enter any alias into the browser

address field to access that content. If someone hovers the cursor over (or clicks) a link to

aliased content, the primary manual alias appears.

n Site Aliasing - If your site supports the multi-site feature, you can enter aliases for any site.

For example, your company‘s name just changed from Bionics to NewGen. You could use

the site aliasing feature to resolve the url www.bionics.com to www.newgen.com. For more

information, see "Site Aliasing" on page 10-42.

Example of an Alias in the Browser

Types of URL Aliasing
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Features Not Supported by Aliasing
Aliasing is not supported in the following areas of Ektron CMS400.NET.

n search results

n images

n content in root folder * (cannot be automatically aliased, although you can alias it

manually and by taxonomy)

n forums (discussion boards) * (links within forum posts can be aliased)

n forms/polls/surveys *- the form is aliased but the postback screen is not (for a workaround,

see http://weblogs.asp.net/scottgu/archive/2007/02/26/tip-trick-url-rewriting-with-asp-

net.aspx > “Handling ASP.NET PostBacks with URL Rewriting”)

n a link to an HTML form

n content links within the directory server control

n If a template is assigned to a taxonomy (see below), the template takes precedence over an

alias for content found by a directory server control

URLAliasing
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* - looking to support in future release

n eCommerce - items in a Shopping Cart control use an alias unless you assign an .aspx

page in the control’s TemplateProduct property. If you assign a page there, that page is

used in the product’s URL, not the alias.

n If you enable .asp as an extension, the alias does not appear when a site visitor hovers the

cursor over an asset. Instead, the actual file name appears. See Also: "Extension" on page

10-11

If a site visitor hovers the cursor over HTML content, the alias does appear.

n The alias does not appear when a site visitor viewing an RSS page hovers the cursor over

an asset. Instead, the actual file name appears.

FeaturesNot Supported by Aliasing
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Aliasing and Relative Links
After you enable Aliasing, any relative links embedded in your Web pages that are not

preceded by a slash (/) may demonstrate symptoms such as:

n Runtime error notifications

n Broken images (you see a red X where the image should be)

n Missing text styling

The following Ektron CMS400.NET Knowledge Base article analyzes this problem and

presents solutions: http://dev.ektron.com/kb_article.aspx?id=19254.

Configuring URL Aliasing
Before you can set up aliases, you must enable the features using the URL Aliasing

Configuration screen (shown below).

See Also:

n "Manually Clearing the Cache" on page 10-17

n "Setting Default Documents" on page 10-18

URLAliasing
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Warning! If you performed a database syncand the site being synched usesURL aliasing, youmust go to itsURL

Aliasing Configuration screen and click the Refresh button ( ) to update its aliasing information.

To edit the Aliasing Configuration screen, go to Ektron CMS400.NET Workarea > Settings

> Configuration > URL Aliasing > Settings. Then, click the Edit button ( ).

Note: After changing the configuration screen, if your Ektron CMS400.NET supportsmultsite configurations, you

must log into each site, navigate to the URL Aliasing Configuration screen, and click the Refresh button ( ).

Use the following table to complete the screen.

See Also: "URL Aliasing" on page 10-1

Field Description

Manual

Enabled
Check this box to enablemanual aliasing. See Also: "ManualAliasing" on page

10-27

Caching

Check this box to improve your server’s performance. It minimizes the number of

database hits byplacing allmanual aliasing information in your server’smemory.

Note: A developer might want to uncheck this boxwhile developing a site, to make

sure that everything is coming out of the database.

Cache Size

If you checked theManual Caching box, enter themaximum number of manual

aliases that your server will cache. Bydefault, this is set to 1000.

An alias is cached whenever anyone uses it. It remains in the cache for the

number of seconds set in theCache Duration field.

If more than this number of aliasesneeds to be added to the cache, Ektron

CMS400.NET makes room for new onesby removing aliases that have been in

the cache for the longest time.

If you increase the number, it is possible that your performance will improve. But

at some point, the size of the cachemaydegrade your server’s performance. See

Also: "ManuallyClearing the Cache" on page 10-17

Cache

Duration

(Seconds)

Enter the number of seconds for which anyalias is retained in the server’s cache.

After this number of secondshaspassed, the alias is flushed from the cache. See

Also: "ManuallyClearing the Cache" on page 10-17

Note: If your Ektron CMS400.NET supportsmulti-site configurations, this setting

only affects the site to which you are logged on. To set a cache duration for other

sites, sign in to each site’sWorkarea > Settings > Url Aliasing > Settings,

then set its cache duration values.
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Field Description

Automatic

Enabled
Check this box to enable automatic aliasing. See Also: "AutomaticURL Aliasing"

on page 10-19

Caching

Check this box to improve your server’s performance. It minimizes the number of

database hits byplacing themost frequently used automatic aliases in your

server’smemory.

You set the number of cached automatic aliasesat theAutomatic Alias Cache

Size field.

Cache Size

If you checked theAutomatic Caching box, enter themaximum number of

automatic aliases that your server will cache. Bydefault, this is set to 1000.

An alias is cached whenever anyone uses it. It remains in the cache for the

number of seconds set in theCache Duration field.

If more than this number of aliasesneeds to be added to the cache, Ektron

CMS400.NET makes room for new onesby removing aliases that have been in

the cache for the longest time.

If you increase the number, it is possible that your performance will improve. But

at some point, the size of the cachemaydegrade your server’s performance. See

Also: "ManuallyClearing the Cache" on page 10-17

Cache

Duration

(Seconds)

Enter the number of seconds for which anyalias is retained in the server’s cache.

After this number of secondshaspassed, the alias is flushed from the cache. See

Also: "ManuallyClearing the Cache" on page 10-17

RegEx

Enabled
Check this box to enable the RegEx feature. See Also: "Using RegEx

Expressions" on page 10-37

Caching

Check this box to improve your server’s performance. It minimizes the number of

database hits byplacing themost frequently used RegExaliases in your server’s

memory.

You set the number of cached aliasesat theRegEx Cache Size field.

Cache Size

If you checked theRegEx Caching box, enter themaximum number of RegEx

aliases that your server will cache. Bydefault, this is set to 1000.

An alias is cached whenever anyone uses it. It remains in the cache for the

number of seconds set in theCache Duration field.

If more than this number of aliasesneeds to be added to the cache, Ektron

CMS400.NET makes room for new onesby removing aliases that have been in

the cache for the longest time.

If you increase the number, it is possible that your performance will improve. But

at some point, the size of the cachemaydegrade your server’s performance. See

Also: "ManuallyClearing the Cache" on page 10-17
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Field Description

Cache

Duration

(Seconds)

Enter the number of seconds for which anyalias is retained in the server’s cache.

After this number of secondshaspassed, the alias is flushed from the cache. See

Also: "ManuallyClearing the Cache" on page 10-17

Extension

Enter file extensionsof pages for which aliases can be created. Begin each

extension with a period (.), and separate themwith a comma (,).

Bydefault, Ektron CMS400.NET supplies the following extensions.

n .aspx

n / (the slash is actually the lackof an extension at the end of a page’s name)

If you are editing this screen and delete an extension, all aliases that use it are

immediately disabled.

Where Extensions Appear

The values in this field appear asdropdowns in the Add a NewManualAlias and

Add a New AutomaticAlias screens.

See Also: "Restrictionson Extensions" on page 10-12

Override

Template

A template and an alias can have the same name, for example,

www.example.com/dynamic.aspx. If this happens, and a site visitor types such an

address into the browser, this checkboxdetermines if the template page or the

alias appears.

If this box is checked, the alias appears instead of the template.

Note: The templatemust be defined within theWorkarea Settings>Template

Configuration screen.
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Field Description

Disable

Language

Awareness

Use this checkbox to determine what happensunder the following conditions:

1. A site visitor browses to content using an alias.

2. The site visitor changes the site language.

If this box is checked - If the content exists in the new language, it appears. If not

the content appears in the original language.

If this box isunchecked - Site visitor seesa 404 error.

Examples if box is checked and a site visitor browses to content using an alias.

n Content ID 33 exists in both English and Spanish. Site visitor views this con-

tent in English then switches the site language to Spanish. The Spanish version of

content ID 33 appears.

n (Assume English is the default language). Content ID doesnot exist in Ger-

man. Site visitor views this content in English then switches the site language to

German. The English content appears.

Query

String

Action

Use this field to set up a rule to handle an alias’s query string parameters. You can

set one rule for your entire site (via this field), and separate ones that override the

system-wide rule for specificmanual aliases (using theManualAliased Page

NameMaintenance screen).

Four optionsare available.

n None - If an aliased URL hasa query string, it is ignored. Anyquery string on

the target URL is used.

n Resolve matched parameters within alias - Ektron CMS400.NET tries

to resolvematching parameters (it is case sensitive). If a match is found, the alias’s

query string parameter takesprecedence. Example:

alias’s query string parameter:
http://www.example.com/Contact.aspx?id=84
Target: http://www.example.com/aboutus.aspx?id=35&UserId=10
Result: http://www.example.com/aboutus.aspx?id=84&UserId=10

(id=35 is replaced by id=84 since it matched the query string parameter.

UserId=10 wasnot affected because it did not match the alias query string

parameter.)

n Replace all parameters within alias - Ektron CMS400.NET replacesall

of a target’s query parameterswith the alias’ s query parameter. Example:

alias’s query string parameter:

http://www.ektron.com/Contact.aspx?id=84
Target: http://www.ektron.com/aboutus.aspx?id=35&Userid=1
Result: http://www.ektron.com/aboutus.aspx?id=84

(The target parameters id=35&Userid=1 are replaced by the alias parameter

id=84)

n Append parameters to alias - Ektron CMS400.NET appends

the alias’s parameters to the target URL. Example:
Alias: http://www.ektron.com/Contact.aspx?id=84&lang=1033
Target: http://www.ektron.com/aboutus.aspx?id=35&Userid=1
Result: http://www.ektron.com/aboutus.aspx?id=35&Userid=1 &

id=84&lang=1033
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Field Description

(The parameter from the alias is appended to the target)

Restrictions on Extensions

The following restrictionsonly apply if your server runs IIS7.

This section explains how IIS7 handles Web page extensions other than .aspx. There are two

scenarios.

n Some of your site’s pages have non-.aspx extensions. So, IIS7 needs to handle requests for

those pages. See "Your Site Has non-aspx Pages" on page 10-13.

n You site previously had non-.aspx pages but no longer does. You want to set up aliases

for these pages, so site visitors’ bookmarks will still work. See "You Want to Set up

Aliases for non-aspx Pages" on page 10-14.

YourSite Has non-aspxPages

If any of your site’s pages have extensions other than .aspx (for example, .asp, .php, .cfm),

follow these steps to move them above ek* in the Handler Mappings list. (Extensions below

ek* are handled by aliasing.)

1. Open IIS7.

2. Right click your Web site.

3. Click Handler Mappings.

4. Click View Ordered List.

5. Move non-aspx extensions used on your site above ek*. For example, if your site uses .asp

pages, move ASPclassic above ek*. See below.
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Once you do this, you cannot use these extensions as part of an alias. So, do not enter them

into the Extension field of the URL Aliasing Configuration screen.

YouWant to Set up Aliases for non-aspxPages

If you want to use extensions other than .aspx for aliasing Web pages, follow these steps.
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1. Open IIS7.

2. Right click your Web site.

3. Click Handler Mappings.

4. Click View Ordered List.

5. On the Handler Mappings screen, move non-aspx extensions that you want to alias below

ek*. For example, if your site uses .asp pages, move ASPclassic below ek*.

6. Enter the extensions in the Extension field of the URL Aliasing Configuration screen. See

Also: "Configuring URL Aliasing" on page 10-8

Activating Custom Extensions
By default, Ektron CMS400.NET supplies the following extensions.

n .aspx

n / (the slash is actually the lack of an extension at the end of a page’s name)

If you want to enable other extensions, follow these steps.

1. Go to the Ektron CMS400.NET Workarea > Settings > Configuration > URL Aliasing

> Settings screen.

2. Enter the new extension into the Extension field and click Save ( ). See Also:
"Extension" on page 10-11

3. If Wildcard Mapping in IIS is turned on, you are done.

If Wildcard Mapping in IIS is turned off, you must enter the new extension into IIS. To do

this, go to the Windows Start button > Administrative Tools > IIS manager.

4. Open the Web Sites folder, right click your Web site then choose Properties.

5. Click the Home Directory tab.

6. Click the Configuration button.

7. Scroll down to and double click the .aspx extension.
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8. Copy the path to aspnet_isapi.dll. (The path is found in the Executable field.)

9. On the Application Configuration window, click Add.

10. The Add/Edit Application Extension Mapping screen appears.

11. In the Executable field, paste the path to aspnet_isapi.dll (which you copied in Step 8).

12. In the Extension field, enter the extension that you are activating. See example below.
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13. Uncheck the Verify that file exists checkbox.

14. Click OK.

Manually Clearing the Cache
Each aliasing type (Automatic, Manual, and RegEx) has Cache Size and Cache Duration

fields, which let you determine conditions that automatically clear each cache. However, you

can manually clear a cache at any time. To do so, follow these steps.

Warning! If your Ektron CMS400.NET supportsmulti-site configurations, youmust sign in to each site’sWork-

area, thenmanually clear its cache.

1. Click the appropriate Settings > URL Aliasing screen. For example, to clear the Manual

Aliasing cache, click Settings > URL Aliasing > Manual.

2. Click the Clear Cache button ( ).
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Setting Default Documents
The concept of default document is explained in the following Microsoft KB article:

http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/dc6eb1b4-

9028-4308-9935-52b64edfad36.mspx. Essentially, it lets you establish a default document for

client requests to a Web site that do not specify a document name. For example,

www.example.com/jobs. If the default document is default.aspx, this URL resolves to

www.example.com/jobs/default.aspx.

When using Ektron CMS400.NET Release 7.6 or higher, you identify one or more default

documents in the siteroot/web.config file’s ek_DefaultPage element (shown below).

Note: The ek_DefaultPageelement determinesyour Web site’s default document whether or not you are using

URL Aliasing.

So when a site visitor enters an address that includes your domain but no page name, Ektron

CMS400.NET refers to ek_DefaultPage’s values. In the above example, the first page is

default.aspx. If found, that page displays. If not, it looks for the second page listed, etc.

If none of the pages is found or a page is not specified in ek_DefaultPage, what happens next

depends on the IIS version that your server is running.

IIS

version
Result if pages listed in ek_DefaultPage are not found

6

n if ek_DefaultPage is blank in web.config, default documents listed in IIS6 are

used.

n if ek_DefaultPage hasone or more pagesbut none of them exists on the

server, a Page not Found (404) message appears.

7

Page not foundmessage appears in browser.

Because Ektron CMS400.NET assumes responsibility for letting you define the

default document, default documents specified in IIS 7 are ignored.
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Automatic URL Aliasing
Automatic aliasing lets you assign an alias to several content items at once. You identify

content by either taxonomy or folder. Then, select additional elements of the alias pattern and

save all information as a configuration.

You can create one automatic aliasing configuration for each folder or taxonomy. Since a

single content block can be assigned to several taxonomies, it can have many automatic

aliases.

When an automatic alias configuration is activated, an alias is assigned to all content in the

taxonomy or folder (and its subfolders). From then on, that content can be identified by its

automatic alias. In addition, any content added to the folder/taxonomy in the future will be

assigned that alias as long as the configuration is active.

Automatic Aliasing is further described through the following topics.

n "Permissions for Working with Aliasing" on page 10-19

n "Enabling/Disabling Automatic URL Aliasing" on page 10-20

n "Setting up Automatic Aliasing" on page 10-21

n "Viewing and Editing Automatic Alias Configuration" on page 10-25

n "Inactivating an Automatic Aliasing Configuration" on page 10-26

n "Deleting an Automatic Aliasing Configuration" on page 10-27

Permissions for Working with Aliasing
Members of the Administrators group or those assigned to the Alias-Admin Role have full

permissions to work with aliasing. They can do things like

n Turn aliasing on and off

n View all manual aliases

n Activate or deactivate manual aliases

n Change the primary alias

n Create automatic aliases

n Create RegEx aliases
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To give a user a limited ability to work with aliasing, you can assign them the Alias-Edit role.

These users can only

n view and assign a manual alias to content

n view secondary aliases assigned to content

Enabling/Disabling Automatic URL Aliasing
To enable automatic aliasing, follow this path: Settings > Configuration > URL Aliasing >

Settings. The screen indicates if automatic aliasing is currently on or off.

To change its state, click the Edit button ( ), check or uncheck the box, and click the Save

button ( ).

See Also: "URL Aliasing" on page 10-1
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Setting up Automatic Aliasing
After enabling automatic URL aliasing, you can create a configuration, which lets you

n identify the content source (that is, a taxonomy or a folder)

n choose elements of the aliasing pattern

n preview sample original and aliased URLs

To create an automatic alias configuration, follow these steps.

1. Open the Settings > Configuration > URL Aliasing > Automatic screen.

2. If you are creating an alias based on Taxonomy, select its language from the language

dropdown.

If you creating an alias based on folder, go to Step 3.

Note: On the Auto Aliased PageNameMaintenance screen, a folder-based alias’Lang column showsa United

Nations flag ( ). This indicates that foldersare language-neutral.

3. Click the plus sign ( ) to access the Add a New Alias screen (shown below).
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4. Use the following table to complete the screen.

Field Description

Active

Check this box to apply this configuration to content. If you do, the aliasesare

applied when you save the screen.

If you uncheck this box, automatic aliases set up via this configuration are

deleted from the associated content.

Source Type Automatic aliasesare based on either a taxonomyor a folder. Choose one.

AliasRoot

Navigate to and choose a taxonomyor folder to which you want to assign an

automatic alias.

If you choose a taxonomy, the automatic alias is applied to all content assigned

to it and all of its child nodes. See Also:

Furthermore, if your Ektron CMS400.NET supportsmulti-site configurations,

the automatic aliaswill apply to content in all sites. This is because taxonomy is

site independent.

Note: If the language selector was set toAll on the Auto Aliased Page Name

Maintenance screen, and you chose Taxonomy as theSource Type,No

Taxonomy appears here. This indicates that youmust return to the Auto

Aliased Page NameMaintenance screen and select a language before you can

select a taxonomyas the AliasRoot.
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Field Description

If you choose folder, the automatic alias applies to all content in that folder and

its subfolders. See Also:

The taxonomyor folder is part of the automatic alias pattern. See Also: "The

AutomaticAliasPattern" on page 10-24

AliasFormat

Use this field to help construct the automatic alias pattern. Choose one of the

following items to identify the content within the alias.

ContentTitle - Example: Sample Content Block

ContentID - Example: 30

ContentIDandLanguage - Example: 30/1033

See Also: "The AutomaticAliasPattern" on page 10-24

Extension

Use this field to help construct the automatic alias pattern. Choose an extension

from the list to identify the end of the aliased URL.

Extensionsare defined in the Extension field of the URL Aliasing Configuration

screen.

See Also: "The AutomaticAliasPattern" on page 10-24; "AutomaticURL

Aliasing" on page 10-19

Replacement

Character

Enter the character that replacesprohibited characters in content titleswhen

theyappear within an automatic alias. Examplesof prohibited characters are a

space and questionmark (?).

So, for example, if the content title is About Us, and you enter an underscore

(-) here, the aliased version of the title isAbout_Us.

You cannot enter one of the following as the replacement character: [, \ / < >

(Space): |? '] # * &%

Note: If you're using IISdmin (Microsoft Vista or Server 2008), and specify a

plus sign (+), you get this error: HTTP Error 404.11 Not Found The

request filtering module is configured to deny a request

that contains a double escape sequence. For a solution, see

http://support.microsoft.com/kb/942076/en-us.
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Field Description

Customize

AliasPath

Bydefault, the automatic alias pattern displaysall folders or taxonomy levels

from the top to the level you select. (See Also: "The AutomaticAliasPattern" on

page 10-24)

You can use this field to controlwhich folders/taxonomy levels appear in the

pattern.

For example, your AliasRoot is based on the following folder path:

/CMS400Demo/About Us/Careers. Using this field, you can choose anyof the

following to indicate the folder or taxonomypath in the automatic alias pattern.

Preview Alias

This area of the screen displays

n a sampleOriginal URL

n an aliased example of that URL, based on the information entered on the

screen

To see any content item’s fully aliased URL, navigate to it and click itsAlias tab.

Uniqueness Requirement for Automatic Alias Configuration
A configuration must have a unique combination of Source Type, Alias Root, Alias Format,

and Extension. For example

n Source Type = taxonomy

n Alias Root = the taxonomy named Products

n Alias Format = Content title

n Extension

You cannot create a configuration whose values match an existing one.

The Automatic Alias Pattern
The Automatic Alias pattern combines the following elements in this order. Each element is

separated by a slash (/).

1. site root
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2. folder or taxonomy path (Spaces are replaced by the Replacement Character specified on

the Add/Edit Alias screen).

Note: Either a taxonomyor a folder is selected when creating an automatic aliasing configuration.

By default, a taxonomy path has all taxonomy nodes from the top to the level at which

content is assigned. Here is an example: www.example.com/Medical_Conditions/Kidney_

Disease/.

By default, a folder path has all folders from the top-level to the folder that contains the

content. Here is an example: www.example.com/CMS400Developer/CMS400Demo/About_

Us/Company_Profile/Board_of_Directors.aspx.

Note: You can use theCustomize Alias Path field to determine which path componentsappear in the pattern.

See Also: "Customize AliasPath" on page 10-24

3. content name source (Spaces are replaced by the Replacement Character specified on the

Add/Edit Alias screen)

4. extension

Examples:

Folder-based automatic alias

www.example.com/CMS400Demo/About_Us/Company_Profile/Awards_and_Honors/
www.example.com/CMS400Demo/About_Us/Company_Profile/12548/

www.example.com/CMS400Demo/About_Us/Company_Profile/12584/1033

Taxonomy-based automatic alias

www.example.com/cms400/MapCategory/Restaurant/Chinese/You_You_Japanese_Bistro/

Note: Ektron CMS400.NET lets users create content with the same title in different folders. If an automatic alias

based on a taxonomy is created, and the same taxonomynode is applied to two content itemswith the same title,

both itemswill have the same automatic alias. To avoid this problem, do not allow users to assign the same name to

more than one content item.

Viewing and Editing Automatic Alias Configuration
To view and edit an automatic alias configuration, go to the Settings > Configuration > URL

Aliasing > Automatic screen.

TIP!

Note: Use the screen’s language selector to find taxonomy-based configurationsof a selected language.

From the Auto Aliased Page Name Maintenance screen, click the alias configuration that you

want to view.
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To edit an automatic alias, view it then click the Edit button ( ). To learn about the screen’s
fields, see "Use the following table to complete the screen." on page 10-22.

Viewing an Automatic Alias
To view the automatic alias assigned to a specific content item, navigate to and view the

content. Then, click the Alias tab (shown below). A primary manual alias appears near the top,

followed by all automatic aliases.

Inactivating an Automatic Aliasing Configuration
Follow these steps if you want to temporarily inactivate an automatic alias configuration.

When you do, automatic aliases created by that configuration are removed from all content to

which they are applied. The configuration is saved, so if you later want to reactive it, simply

undo these steps.

1. Open the Settings > Configuration > URL Aliasing > Automatic screen.

2. Click the alias that you want to inactivate.

3. Click the Edit button ( ).

4. Uncheck the Active checkbox.
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5. Click the Save button ( ).

Deleting an Automatic Aliasing Configuration
Follow these steps if you want to delete an Automatic Aliasing Configuration. When you do,

automatic aliases are removed from all content to which they are applied.

1. Open the Settings > Configuration > URL Aliasing > Automatic screen.

2. Click the delete button ( ).

3. Check each configuration that you want to delete.

4. Click the delete button ( ).

5. You are asked if you are sure.

6. Click OK.

Manual Aliasing
When using manual aliasing, you choose a page name. Next, you specify the content to appear

whenever anyone enters the URL using that name into a browser address field. For example,

you can alias www.example.com/cms/index.aspx as www.example.com/cms/Launch.html. From then

on, the content can be identified either by its original URL or its alias.

You can assign any number manual of aliases to a content block.

Note: You cannot manually alias the root of your Web site (for example, www.example.com). You can, however,

alias everything below that.

This section explains manual aliasing through the following topics.

n "Manual Aliasing and Multi-Site" on page 10-28

n "Enabling/Disabling Manual Aliasing" on page 10-28

n "Assigning a Manual URL Alias to Content" on page 10-28

- "Adding a Manual Alias via the Page Name Maintenance Screen" on page 10-29

- "Adding a Manual Alias via the Alias Tab" on page 10-33

n "Editing a Manual URL Alias" on page 10-34

n "Removing a Manual Alias" on page 10-35
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Manual Aliasing and Multi-Site
If your Ektron CMS400.NET deployment uses multi-site, the following restrictions apply to

manual aliasing.

n Any manual alias applied to the root site cannot be applied to any of the additional sites

n Any manual alias applied to an additional site cannot be applied to the root site

However, the same manual alias can be applied to any number of additional sites.

Enabling/Disabling Manual Aliasing
To activate manual aliasing, follow this path to the URL Aliasing Configuration screen:

Settings > Configuration > URL Aliasing > Settings.

The screen indicates if manual aliasing is currently on or off. To change its state, click the Edit

button ( ), check or uncheck the box, and click the Save button.

Assigning a Manual URL Alias to Content
Two screens let you manually alias content.

Screen/tab

Who is

authorized

to use

Can create/update

these manual aliases

For more information,

see

Page Name

Maintenance

members of

Administrators

group

an unlimited number of

primary and secondary

"Adding aManualAlias via

the Page Name

Maintenance Screen" on

page 10-29
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Screen/tab

Who is

authorized

to use

Can create/update

these manual aliases

For more information,

see

Alias tab of View

Content screen

(see image

below)

n
membersof

Administrators

group

n users

assigned

Alias-Edit role

primary (Alias tab

displaysbut doesnot let

users change secondary

aliases)

"Adding aManualAlias via

the AliasTab" on page 10-

33

Adding a Manual Alias via the Page Name
Maintenance Screen
Prerequisites

n Manual aliasing is enabled. See Also: "Enabling/Disabling Manual Aliasing" on page 10-

28

n You are a member of the Administrators group

To add a manual alias via the Page Name Maintenance screen, follow these steps.

1. Go to Workarea > Settings > Configuration > URL Aliasing > Manual.

2. The Manual Aliased Page Name Maintenance screen appears.
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The following table explains the buttons on the screen.

Button Description For more information, see

Addmanual

alias
"If creating new alias" on page 10-32

Delete

manual alias

"Removing aManualAlias via theManualAliased Page Name

Maintenance Screen" on page 10-36

Manually

clear cache
"ManuallyClearing the Cache" on page 10-17

The following table explains the fields on the screen.

Field Description

Primary

If you assignmore than onemanual alias to content, this field designates the primary

one. If you only assign one, it is the primary bydefault.

The primary alias appears in the browser when a user hovers the cursor over a link to

associated content, such aswithin a List Summaryor a Collection. It also appears in

the browser address field after the content is selected. See "Example of an Alias in

the Browser" on page 10-5.

If a user viewsa content block’sAlias tab, he can only see and edit the primary

manual alias. See Also: "Adding aManualAlias via the AliasTab" on page 10-33

Active Indicates if this alias is active.

Lang The alias’s language flag.

Alias
The alias (that is, the page name) that site visitors can enter aspart of the URL into a

browser to see the associated content.

Original

Link
The content template and variable being aliased.

Content

ID
The ID number of the content assigned to the alias.

3. To edit an existing manual alias, use the language selector dropdown (see image below) to

choose the language of the aliases you want to work with.
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If you are creating a new alias, click the Add Alias button ( ) and skip to Step 8.

4. If your Ektron CMS400.NET version supports multi-site configurations, use the Site

dropdown to choose the site.

5. Click the alias you want to edit.

Note: If there aremanyaliases, use the search to help find one. You can filter aliasesbyaliasname, Content ID,

etc.

6. The View Alias screen appears. Click the Edit button ( ).

7. The Add/Edit Manual Alias screen appears.

8. If editing existing alias

If this is not the primary alias, you can check or uncheck the Active checkbox. Only

active aliases can be entered into the browser address field to display the assigned content.
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If this is the primary alias, you cannot uncheck it. If you want to inactivate a primary alias,

first assign another alias to be the primary for this content block. Then, return to this

screen and make this alias inactive. Alternatively, you can delete a primary alias.

If creating new alias

Check the Active checkbox if you want this alias to be active.

9. Check the Primary box if you want this to be the primary alias. See Also: "Primary" on

page 10-30

If another alias is the primary when you check this box, the other alias is no longer the

primary.

10. In the Alias field, enter the alias name. It cannot include the following characters:

(comma), (space), \, <, >, “,:, |. Also, it must be unique within this site and language.

To the right of Alias Name is a pull-down of valid extensions. Select one to apply to this

alias. Extensions are defined on the URL Aliasing Configuration screen. See Also:

"Extension" on page 10-11

11. Click Select a Content Block to choose content. The QuickLink Select window appears.

Note: Only content in the language chosen on the PageNameMaintenance screen appears.

12. Navigate through the folder structure and click the content to which you are assigning the

alias.

TIP!

Note: A folder’s content appearsbelow its subfolder list. Youmayhave to scroll down to see the content.

13. The Title, Link and Quick Link fields fill in, using information from the selected content.

If the content has more than one quicklink assigned to it, select the one to which you are

assigning the alias.

14. To learn about the QueryString Action field, go to .

15. Enter the Additional Variables. These are used as query string parameters that can track

how visitors arrived at the aliased page. You might use these for marketing campaigns, to

analyze the source of an aliased page’s visitors.
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For example, the Additional Variables field has ?gclid=CO7gs_L0_ZICFRkTIgodBgV9CQ.

Your Web site's analytics software can track the source of the query through the variable.

TECHNICALNOTE

Note: Within the page load event that returns the query string parameters, use the Request.RawURL()property

instead of request.querystring.

16. Click the Save button ( ).

See Also: "Manual Aliasing" on page 10-27

Adding a Manual Alias via the Alias Tab
Once manual aliasing is enabled, every content block includes an Alias tab. You can use that

tab to view and update the content’s primary alias.

Note: If you insert/update an alias via the Alias tab, it only goes live after the content is published.

See Also: "Manual Aliasing" on page 10-27

Prerequisites

n Manual aliasing is enabled. See Also: "Enabling/Disabling Manual Aliasing" on page 10-

28

n You are a member of the Administrators group or assigned to the Alias-edit Role. If

neither, you do not see the Alias tab.

To add a manual URL alias via the Alias tab, follow these steps.

1. In the Workarea, select Content.

2. Navigate to and click the content you want to work with.

3. Click the Edit button ( ).The Edit Content screen appears.

4. Click the Alias tab.
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5. In the Primary Alias Name field, enter the name of the primary alias.

The name cannot include the following characters: (comma), (space), \, <, >, “,:, |. Also, it

must be unique within this site and language.

6. To the right of Primary Alias Name is a pull-down of valid extensions. Select one to

apply to this manual alias.

The extensions are set up in the URL Aliasing Configuration screen’s Extension field. See

Also: "Extension" on page 10-11

7. Save and publish the content.

Viewing a Manual Alias
See Also: "Manual Aliasing" on page 10-27

To view a manual URL alias, follow these steps.

1. Go to Workarea > Settings > Configuration > URL Aliasing > Manual.

2. On Manual Aliased Page Name Maintenance screen, click the alias you want to view.

3. The alias information appears. To learn about the screen’s fields, see "The Add/Edit

Manual Alias screen appears." on page 10-31.

Editing a Manual URL Alias
You can edit any manual alias via the Edit Alias screen. This lets you change all fields

completed when the alias was created: name, assigned content, etc.

Note: You can also edit a content block’s primaryalias name via theAlias tab on the content screen. See "Adding

aManualAlias via the AliasTab" on page 10-33.

See Also: "Manual Aliasing" on page 10-27

To edit a manual URL alias, follow these steps.

1. Go to Workarea > Settings > Configuration > URL Aliasing > Manual.

2. On Manual Aliased Page Name Maintenance screen, click the alias you want to edit.

3. The View Alias screen appears. Click the Edit button ( ).

4. The Edit Alias screen appears.
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5. Make any changes. To learn about the fields, see "If editing existing alias" on page 10-31.

If this is the only alias assigned to the content, you cannot uncheck Primary or Active.

If other aliases are assigned to the content, and you want to make one of them the primary,

edit that alias and check the Primary checkbox. You cannot uncheck Primary from this

screen.

Also, only secondary aliases can be inactivated by unchecking the Active checkbox.

6. Click the Save button ( ).

Removing a Manual Alias
Just as there are two ways to add a manual alias, there are two ways to remove one.

n "Removing a Manual Alias via the Content Alias Tab" on page 10-35

n "Removing a Manual Alias via the Manual Aliased Page Name Maintenance Screen" on

page 10-36

Removing a Manual Alias via the Content Alias Tab
Using a content block’s Alias tab, you can delete a primary manual alias only if no secondary

aliases exist. If secondary aliases exist and you want to delete or replace the primary alias, you

must use the Manual Aliased Page Name Maintenance screen. See Also: "Removing a Manual

Alias via the Manual Aliased Page Name Maintenance Screen" on page 10-36

You can neither see nor delete secondary manual aliases from the Alias tab.
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Note: If you delete an alias via the Alias tab, the change only goes live after the content is published.

To remove the primary manual alias by editing the associated content block, follow these steps.

1. Browse to the content block associated with the alias.

2. Click Edit.

3. Click the Alias tab.

4. Delete or replace the value in the Primary Alias Name field.

5. Click Save, Check in, or Publish.

Removing a Manual Alias via the Manual Aliased Page Name
Maintenance Screen
Using the Page Name Maintenance Screen, you can delete the primary and any secondary

manual aliases.

Warning! If you want to delete a primarymanual aliaswhile secondary aliasesexist, youmust first designate one

of the secondary aliasesas the primary. You can only delete the primary alias if no secondary aliasesexist.

To remove a manual alias via the Page Name Maintenance Screen, follow these steps.

1. Go to Workarea > Settings > Configuration > URL Aliasing > Manual.

2. On Manual Aliased Page Name Maintenance screen, click the Remove button ( ).

3. Check the box next to all aliases you want to remove.

4. Click the Delete button ( ).

5. Click OK to confirm.

See Also: "Manual Aliasing" on page 10-27
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Using RegEx Expressions
RegEx expressions allow site visitors to enter a human-readable URL into the browser address

field and transform that entry into the query string component of an Ektron CMS400.NET

page. The benefit is that the site visitor can “guess” other pages based on an easily

recognizable pattern.

For example, a RegEx expression aliases blogs.aspx?blogmonth=3&blogyear=2006&blogid=41 as

blogs/2006/03/41. From that, a site visitor can infer that he can enter blogs/2006/03/40 to see

the previous post, enter blogs/2006/03 to see all March 2006 posts, etc.

This section provides a description of the screen’s fields, then a step-by-step explanation of

how to create and validate a RegEx expression.

See Also:

n "Add a Regular Expression Screen" on page 10-37

n "Instructions for Creating a RegEx Expression" on page 10-40

n "Viewing a Regular Expression" on page 10-41

n "Editing a Regular Expression" on page 10-41

n "Deleting a Regular Expression" on page 10-41

Add a Regular Expression Screen
To access the Regular Expression screen, follow these steps.

See Also: "Using RegEx Expressions" on page 10-37; "Instructions for Creating a RegEx

Expression" on page 10-40

1. In the Ektron CMS400.NET Workarea, go to Settings > Configuration > URL Aliasing >

RegEx.

2. Click the Add button ( ).

3. The Add a Regular Expression screen appears.
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4. Use the following table to complete the screen.

Field Description
For more

information, see

Active

Check this box to activate the expression. If the expression

is

active, site visitors can enter an aliased URL to accessa

page on your site.

For example, they can enter

www.example/com/blogs/2006

/03/41 to accessa blog page even though the actualURL

iswww.example/com/blogs/

blogs.aspx?blogmonth=3&

blogyear=2006&blogid=41

Expression

Name

Assign an easily recognizable name to this regular

expression. It appears on the RegExAliased Page Name

Maintenance screen to help users identify it.

Expression

Enter a RegExexpression that will replace the variables

(for example, $1, $2, etc.) in the Expressionmap.

If you want to insert a questionmark into the Expression,

youmust precede it with a backslash (\).

n "Instructions

for Creating a

RegExExpression"

on page 10-40

n http://-

regexlib.com/
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Field Description
For more

information, see

Expression

Map

Enter amap of originalURL elements. Themap lets you

replace query string parameterswith variables, such as$1,

$2, etc. Asa result, a site visitor can identify anypage that

uses this pattern by changing the variable values.

You can clickExpression Library to view examplesof

RegExexpressionmaps. To copyanymap that resembles

your page pattern, click it. You can thenmodify is as

necessary.

"Instructions for

Creating a RegEx

Expression" on

page 10-40

Example

URL
Displaysan example ofWeb page that follows this pattern.

Priority

Assign a priority to this expression from the following

choices.

n high

n medium

n low

n none

Assign high to expressions that will be usedmost

frequently.

This field helps the aliasing feature respond quicklywhen

site visitors enter expressions into the browser address

field. This is because aliasing first tries tomatch a site

visitor’s entrywith high priority expressions, thenmedium,

then low.

Requested

URL

Enter a user-friendly pattern that site visitors can insert to

accesspageson your site. This pattern replaces the query

string component of a URL.

For example, blogs/2006/03/41.

"Instructions for

Creating a RegEx

Expression" on

page 10-40

Transform

button

After completing all fields on the screen exceptResulting

URL, use this button to check the validity of the

Expression,Expression Map andRequested URL

fields.

Resulting

URL

Valuesappear in this field after you click the Transform

button. It uses theExpression andExpression Map field

values to translate a Requested URL (one a site visitor will

enter) into a Resulting URL (the page’s actual query string

parameter).
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Instructions for Creating a RegEx Expression
Use the following steps as a guide to creating a Regex expression.

1. Find a site page (such as a blog) whose query string parameters allow users to guess

similar pages using a pattern. For example
http://ecmintranet/blogs.aspx?blogmonth=3&blogyear=2006

2. In the Ektron CMS400.NET Workarea, go to Settings > Configuration > Url Aliasing >

RegEx.

3. Click the Add a Regular Expression button ( ).

4. Give your expression a name.

5. Click Expression Library.

6. Find and click an Expression Map similar to the page you found in Step 1. To continue

our example, choose
PageName.aspx?year=$1 & month=$2

7. The Expression and Example URL field values fill in, using information from the

Expression Map.

8. As needed, adjust the values in the Expression map or the RegEx expression to match your

page name. For example, change PageName to blogs, and delete Default.aspx

See Also: http://regexlib.com/

9. To continue the example, change the Expression Map field so that it looks like this.
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10. Click the Transform button to verify that the resulting URL matches the original page

pattern. If it does not, check all steps, especially the Expression field.

Viewing a Regular Expression
To view a regular expression, follow these steps.

1. In the Ektron CMS400.NET Workarea, go to Settings > Configuration > URL Aliasing >

RegEx.

2. Click the expression whose information you want to view.

To learn more about the fields on the screen, see "Use the following table to complete the

screen." on page 10-38.

See Also: "Using RegEx Expressions" on page 10-37

Editing a Regular Expression
To edit a regular expression, follow these steps.

1. In the Ektron CMS400.NET Workarea, go to Settings > Configuration > URL Aliasing >

RegEx.

2. Click the expression whose information you want to edit.

To learn more about the fields on the screen, see "Use the following table to complete the

screen." on page 10-38.

See Also: "Using RegEx Expressions" on page 10-37

Deleting a Regular Expression
To delete a regular expression, follow these steps.

1. In the Ektron CMS400.NET Workarea, go to Settings > Configuration > URL Aliasing >

RegEx.

2. Click the delete button ( ).

3. Check the box next to the expression you want to delete.

4. Click the delete button ( ).

See Also: "Using RegEx Expressions" on page 10-37
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Site Aliasing
If your site supports the multi-site feature, you can enter aliases for any site. For example, your

company’s name just changed from Bionics to NewGen. You can use the site aliasing feature

to resolve the url www.bionics.com to www.newgen.com.

Note: If your Ektron CMS400.NET supportsmulti-site configurations, an automatic alias assigned to a taxonomy

will apply to content in all sites. This is because taxonomy is site independent.

Warning! If the site being aliased resides in a folder under your server’sWeb root folder (for example,

ser4325/min), youmust add the subfolder to the alias. So, to continue the above example, you could not enter

http://www. myalias.com asan alias for that site. Instead, you would enter http://www.myalias.com/min/.

See Also:

n "Creating Site Aliases" on page 10-42

n "Editing a Site Alias" on page 10-43

n "Deleting a Site Alias" on page 10-44

Creating Site Aliases
Enabling site aliasing has two steps.

n "Setting up a Site Alias in the Ektron CMS400.NET Workarea" on page 10-42

n Add each site alias as an IIS host. To learn how do this for your server, please consult IIS

help.

Setting up a Site Alias in the Ektron CMS400.NET Workarea
To set up site aliases, follow these steps.

Note: You cannot assign a site alias to the site root folder.

1. Open the site folder for which you want to create aliases. (Site folders have a globe icon,

like this: ).

2. Click View > Properties.

3. Click the Edit button ( ).
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4. Click the Site Alias tab.

5. Enter the alias into the Alias Name field.

Note: The alias cannot end with a slash (/).

From now on, if a site visitor enters the alias into a browser address field, he is redirected to

the site URL (set on the folder properties tab’s Production Domain field).

Editing a Site Alias
Follow these steps to edit a site alias.

1. Open the site folder for which you want to create aliases. (Site folders have an icon, like

this: ).
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2. Click View > Properties.

3. Click the Edit button ( ).

4. Click the Site Alias tab.

5. From the Alias list, click the alias that you want to edit. When you do, it is highlighted in

yellow and appears in the Alias Name field.

6. Change the alias text.

7. Click the Save button directly below the Alias Name field.

8. Click the screen’s Save button ( ).

Deleting a Site Alias
Follow these steps to delete a site alias.

1. Open the site folder for which you want to create aliases. (Site folders have a globe icon,

like this: ).

2. Click View > Properties.

3. Click the Edit button ( ).

4. Click the Site Alias tab.

5. From the Alias list, click the alias that you want to delete. When you do, it is highlighted

in yellow and appears in the Alias Name field.

6. Click the delete icon ( ).

7. The alias is deleted.

Upgrading from Previous Releases
See the following Ektron CMS400.NET Knowledge Base article to learn about 7.6 and up

URL Aliasing upgrade issues: http://dev.ektron.com/kb_article.aspx?id=21358

URLAliasing

10-44
ReferenceManual

Version 8.0 Rev 1.3

http://dev.ektron.com/kb_article.aspx?id=21358
http://dev.ektron.com/kb_article.aspx?id=21358


Assigning an Alias to Multi-
Language Content
If Ektron CMS400.NET has several foreign-language versions of content that share an ID, you

can alias only one of them and check the URL Aliasing Configuration screen’s Disable

Language Awareness checkbox. Then, when a site visitor selects a language in which to view

your site and enters the alias, Ektron CMS400.NET displays the aliased content in the selected

language.

If you prefer, you can assign a different alias to each language version of content. To do this,

select the content, language, go to the Alias tab, and assign a language-specific alias. For

example, your English Careers page’s alias is careers, while your Spanish alias is carreras,

and your German alias is Karrieren.

Also, alias names must only be unique within a language. So, for example, you cannot have

two aliases named Ektron within U.S. English content. But, you can create two aliases named

Ektron if one is applied to U.S. English content, and the other applies to Spanish content.
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Using Classic ASP with Windows
2008 Server 64 Bit
If you want to use aliasing on a 64-bit server running Windows 2008, follow these steps.

1. Install classic ASP onto the server. It is not installed by default. See Also:

http://technet.microsoft.com/en-us/library/cc753918.aspx

2. Open your site root/web.config file.

3. Go to the <handlers> section.

4. Find this tag:
<add name="ek*" path="*" verb="GET,HEAD,POST"

type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"

modules="ManagedPipelineHandler" scriptProcessor="" resourceType="Unspecified"

requireAccess="Script" preCondition="" />

5. Add the following ASP handler above the ek handler shown above.

<add name="ASPClassic" path="*.asp" verb="GET,HEAD,POST" modules="IsapiModule"

scriptProcessor="%windir%\system32\inetsrv\asp.dll" resourceType="File" />
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A task is a request from one user to another to perform an action within Ektron CMS400.NET.

Examples of a tasks include:

n updating content

n publishing content

n updating an image

n reordering a collection

If you are not in the administrators group or assigned the Task-create role, the Tasks folder only

displays tasks assigned to you or that you assigned to another user or user group. You can also

assign tasks to yourself.

Administrators can view all tasks, regardless of who they are assigned to or by.

A task may or may not be related to a specific piece of content. If it is, you can access content

then “attach” a task to it. This kind of task is managed just like the other tasks, but you can

also view and update it via the attached content.

This chapter explains how to work with tasks through the following topics.

n "Task Permissions" on page 11-3

n "Task Categories and Types" on page 11-3

n "Task States" on page 11-10

n "Creating a Task via the Task Folder" on page 11-13

Note: Tasks can also be created automaticallywhen formsare submitted. See Also: "Assigning a Task to a Form"

on page 7-260

n "Creating a Task from the Web Site" on page 11-22

n "Creating a Task via the Content Folder" on page 11-23

n "Viewing a Single Task" on page 11-24

n "Viewing a Task’s History" on page 11-29

n "Editing a Task" on page 11-29

n "Adding Comments to Tasks" on page 11-30

n "Archiving a Task" on page 11-32

n "Purging a Task" on page 11-33

n "Deleting a Task" on page 11-34

n Deleting Several Tasks at Once

n "Task Email Notification" on page 11-40

n "Automatic Creation of Tasks Associated with Content" on page 11-34
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Task Permissions
Members of the Administrators group have permission to perform all task activities.

Alternatively, you can assign roles to give users specific task-related permissions, as indicated

below.

Permission Role

Create task Task-Create

Redirect task (that is, assign to another user) Task-Redirect

Delete task Task-Delete

Task Categories and Types
Tasks can be assigned a Task Category, then a Task Type. This gives users an additional way

to filter their tasks.

Task Categories and Task Types have a hierarchical relationship: the Task Category is the

parent, and the Task Type is the child. So, several types can be assigned to each category.

Some examples of Task Categories might be Engineering, Sales, Documentation, or Web

Design. Examples of Task Types might be Edit Content, Update Documents, or Contact

Customer.

Note: Onlymembersof the Administrator User Group or usersassigned the following roles can view, add, or edit

task categoriesand types: Task-Create, Task-delete, Task-Redirect. See Also: "Defining Roles" on page 15-32

You can create Task Categories and Task Types on these occasions.

n When adding a task. See Also: "Creating a Task via the Task Folder" on page 11-13

n When working in the View Categorization screen.
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View Categorization Screen

The View Categorization screen allows administrators to create, edit, and delete Task

Categories and Task Types.

See Also: "Task Categories and Types" on page 11-3

To access the View Categorization Screen, access the Workarea > Settings > Configuration >

Task Types.

The following screen appears.

Viewing Task Categories

Note: The View Categorization screen hasa system-defined category (Form Submission Task) that can only be

used with forms. You can change its name but cannot delete it. For more information, see "Working with HTML

Forms" on page 7-220.

While in the View Categorization screen, you can collapse and expand Task Categories. To

collapse a Task Category, click the ( ) button next to the Task Category name. To expand

one, click the ( ) button next to the Task Category name.

The following example shows the View Categorization screen with one Task Category

minimized.
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Creating Task Categories and Task Types
From the View Categorization screen, you can create Task Categories and Task Types by

clicking the Add Task button ( ). When you do, the following screen appears.

From this screen, you can perform these tasks.

n "Adding a New Task Category and Task Type" on page 11-6

n "Adding a New Task Type to an Existing Task Category" on page 11-7

n "Editing Task Category" on page 11-7
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n "Editing a Task Type" on page 11-8

n "Task Type Availability" on page 11-8

Adding a New Task Category and Task Type
To add new Task Category and Task Type, follow these steps.

See Also: "Task Categories and Types" on page 11-3

1. Click the Add Task Type button ( ).

2. The Add Task Type Screen appears.

3. Click the Add Task Type to New Task Category radio button or in the text box.

4. Enter a name in the New Task Category field.

5. Add a Task Type name in the Task Type field.

6. Enter a Task Type Description.

7. Choose a Task Type Availability. See Also: "Task Type Availability" on page 11-8

8. Click Save ( ).

9. Your new Task Categories and Task Types appear on the View Categorization screen.
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Adding a New Task Type to an Existing Task Category
To add a new Task Type to an existing Task Category, follow these steps.

1. Click the Add Task Type button ( )

2. The Add Task Type Screen appears.

3. Click the Add Task Type to New Task Category radio button or click the drop down

box.

4. Choose a category from the drop down box.

5. Add a Task Type name in the Task Type field.

6. Enter a Task Type Description.

7. Choose a Task Type Availability. See Also: "Task Type Availability" on page 11-8

8. Click Save ( ).

9. Your new Task Categories and Task Types appear on the View Categorization screen.

Editing Task Category
You can edit a Task Category names. To edit a Task Category, click the Task Category link.

A text box screen appears next to the category name. Use the text box to change the name.

You can either save ( ) the changes, or cancel ( ) the edit.
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Editing a Task Type
From the View Categorization screen, you can edit a Task Type. This allows you to change the

Task Type name, Task Type description, and Task Type availability.

To edit a Task Type, follow these steps.

1. On the View Categorization screen, click a Task Type.

2. The Edit Task Type screen appears.

From this screen you can edit the following:

n Task Type

n Task Type Description

n Task Type Availability. See Also: "Task Type Availability" on page 11-8

3. Edit the information.

4. Click Save ( ).

5. The Task Type information is changed.

Task Type Availability
Task Types can be hidden from users by clicking the Not Available check box in the Add

Task Type and Edit Task Type screens. By making a Task Type not available, you can

suppress without deleting it.

When you make a Task Type not available, you see the following warning.
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After you make a Task Type not available, the assigned tasks’ Type and Category are changed

to Not Specified.

Deleting Task Categories and Task Types
You can delete Task Types by Task Category or individually.

To delete a Task Type, click the check box next to the Task Type, then click the Delete ( )
button.

When you delete a Task Type, the following appears.

To delete all Task Types, check the Delete all check box.

The following example shows which check boxes on the screen are associated with All Task

Types, Task Categories, and individual Task Types.
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Task States
During the life of a task assigned to content, it normally progresses through a series of states.

The state helps track a task’s progress from creation to completion and even removal from the

database. When reviewing the history of a task, the state can be used to review which actions

changed the task’s state by whom and when.

User-Assigned versus System-Assigned States

Some states can only be assigned by users while others are only assigned when an event occurs

to the associated content. For example, when content is first submitted for approval, the

associated task’s state changes to Not Started.

Warning! The administrator user can always change a task’s state to anyother state.

The following graphic illustrates the sequence of user and system actions that change a task’s

state.

Managing Tasks

11-10
ReferenceManual

Version 8.0 Rev 1.3



Progression of Task States

State Description Assigned by

Not

Started
Assigned when task is created. User

Active The task’s content is checked out. System

Awaiting

Data

The task is started but the assigned-to user is

awaiting data from an external source. You can

use comments to indicate the data being waited

for.

User

OnHold Task cannot be worked on at this time. User
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State Description Assigned by

Pending

The content is submitted for approval.

A task remainspending while its content is in the

approval process.When the last person in the

approval chain approves the content, the task’s

state changes to Completed.

If anyapprover declines the content, the task’s

state changes to Reopened.

If an editor edits the content and then checks it

back in, the task’s state changes to Reopened.

System

Reopened

Content is declined byan approver in the

approval process. Also, if someone edits content

whose task state is pending, the tasks’s state

changes to Reopened.

System

Completed
The last user in the approval chain approves the

content and it is being published.
System

Archived

After a task is completed, administrators can

assign this state. It no longer appears on open

task lists but is kept for reviewsand reports.

Only the administrator can view Archived tasks.

See Also:

User

Deleted

When an archived task is no longer needed for

reporting or reviewing, administrators can assign

this state.While in this state, the task remains in

the database. See Also:

When you purge the task, it and all of its

transactionsare removed from the database.

See Also:

User (user with delete

permission can delete; only

admin and user with Task-

Delete role can purge)

Restrictions on the Task Flow Process

n Only users with archive and delete permissions can set a task’s status to archived or

deleted. This can be done at any stage of the task flow process.

n Notes can be entered for the task at any time.

n An administrator can assign a task to any state at any time.
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Creating a Task via the Task Folder
This topic consists of the following subtopics:

n "Accessing the Tasks Folder" on page 11-13

n "Creating a Task via the Task Folder" on page 11-14

n "Adding a Task Category and Task Type" on page 11-18

Accessing the Tasks Folder
To access the Tasks folder, follow these steps.

1. From the workarea, click the Reports Menu tab.

2. Click the Tasks folder.

3. Click the Tasks folder. The following subfolders appear:

n Assigned To Me - tasks assigned to you

n Assigned By Me - tasks you assigned to someone else

n Created By Me - tasks you created

n Assigned To User - search for tasks assigned to a user
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n Not Started - tasks whose state is set to not started

n Active - tasks whose state is set to Active

n Awaiting Data - tasks whose state is set to Awaiting Data

n On Hold - tasks whose state is set to On Hold

n Pending - tasks whose state is set to Pending

n Reopened - tasks whose state is set to Reopened

n Complete - tasks whose state is set to Complete

You can click any folder to view only tasks in that category.

Also, the View Tasks screen appears in the right frame, listing all tasks assigned to you, or

assigned by you.

From this page, you can view, sort, update, or add tasks. To learn more about the View Tasks

screen, see "Viewing a Single Task" on page 11-24.

To learn about sorting by Task Type, see "Sorting Tasks By Task Type" on page 11-27.

Creating a Task via the Task Folder
To create a task, follow these steps.

1. Access your Tasks folder, as described in "Accessing the Tasks Folder" on page 11-13.

2. Click the Add button ( ).

Warning! The Add button only appears if your system administrator hasgranted you permission to add tasks. For

more information, see "TaskPermissions" on page 11-3.

3. The Add Task screen appears.

Enter information for the task using the following table
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Field Description

TaskTitle
Enter a title for the task (for example, Update Content). The title appears in the

left column of the View Tasks screen.

Assigned

To

Your user name appears.

n If you do not have Redirect permissions, you cannot assign tasks to other

users.

n If you have Redirect permissions, your user name appears followed by

Select User or Group. To assign the task to yourself, proceed to the next field.

To assign the task to someone else, clickSelect User or Group and choose a

user or group. (The user to whom the task is being assignedmust have per-

mission to edit the content.)

When you complete the screen, an email is sent to the selected user or user group

informing him of the assigned task.

Note: email is only sent if email notification is enabled for Ektron CMS400.NET.

Language Select the language of the user who will perform the task.

Content

If this task involvesa piece of content, select it. When you clickSelect, a new

window appears. From thiswindow, you can navigate through folders to find the

content.

You can only select a piece of content whose languagematches the user

language selected above.

See Also: "Selecting Content for the Task" on page 11-17

Priority

Select the priority of the task. Your choicesare High, Normal and Low.

The priority appears on the View Tasks screen. A user can sort taskson the

screen bypriority.

Task

Category

Select a category for the task.When a TaskCategory is chosen, the TaskType

drop down box is auto filled with task typesassociated with that category.See
Also: "Adding a TaskCategory and TaskType" on page 11-18.

TaskType

Select the TaskType for this task. Youmust specify a TaskCategory before you

assign a task type. See Also: "Adding a TaskCategory and TaskType" on page

11-18.

Add

Byclicking the Add link, you can add TaskCategories and TaskTypes. See Also:

"Adding a TaskCategory and TaskType" on page 11-18

Note: If you Add a TaskCategory or TaskType while adding a task, the task

information (TaskTitle, Assigned To, Language, etc.) entered will be lost when

the screen refreshes.

Edit
By clicking the Edit link, you can edit the TaskType chosen in the TaskType drop

down box. See Also: "Editing a TaskType" on page 11-21
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Field Description

Note: If you edit a TaskType while adding a task, the task information (TaskTitle,

Assigned To, Language, etc.) entered will be lost when the screen refreshes.

State

Choose a status for the task. Your choicesare:

n Not Started

n In Progress

n Completed

n Waiting on Someone else

n Deferred

If the task is not linked to content, you can assign it to any state. However, if you

later link the task to content (via theContent link above), the state switches to Not

Started.

The state appears on the View Tasks screen. A user can sort taskson the screen

by state.

Start Date

Using the calendar button, choose a start date for the task. The start date

appears on the View Tasks screen. A user can sort taskson the screen by start

date.

Technical note: If you see amix-up of themonth and date of your entry (for

example, you select March 2 but see February 3), make sure the date format

specified in theWindowsControl PanelRegionalSettingsdialogmatches your

current language. Also, make sure the settingsapply to the default user.

Due Date

Using the calendar button, choose the date bywhich the taskneeds to be

completed.

The due date appears on the View Tasks screen. A user can sort taskson the

screen bydue date.

Technical note: If you see amix-up of themonth and date of your entry (for

example, you select March 2 but see February 3), make sure the date format

specified in theWindowsControl PanelRegionalSettingsdialogmatches your

current language. Also, make sure the settingsapply to the default user.
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Field Description

Description

Add additional information to describe the task. The description appears on the

View Task screen (circled below).

4. Click the Save button ( ).

If email notification is enabled, an email is sent to the user/user group to which the task was

assigned.

Selecting Content for the Task
When you click Select Content from the Add Task screen, the Select Content screen appears. It

shows only content in the selected language.
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You should only select a content folder for which you have permissions.

To select a piece of content to assign to the task, follow these steps.

1. Navigate to the content. (Click any folder to open it.)

2. Click the circle to the left of the content.

3. Press the Save button ( ).

Adding a Task Category and Task Type
Task Categories and Task Types let users and administrators sort task by user defined

categories and types.

By clicking the Add link, located next to the Task Type drop down box, you can add Task

Categories and Task Types. This allows you to add categories and types without leaving the

Add Task screen.

Note: Administrators can also add and edit TaskCategoriesand TaskTypes from theWorkarea by clicking

Settings > Configurations > Task Types. See Also: "Adding a TaskCategoryand TaskType" on page 11-18

Managing Tasks

11-18
ReferenceManual

Version 8.0 Rev 1.3



To add a Task Category and a Task Type, follow these steps.

1. Go to the Add Task screen, as described in "Creating a Task via the Task Folder" on page

11-14.

2. Click the Add link, next to the Task Type dropdown box.

3. The Add Task Type screen appears.
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From this screen you can perform the following:

n Add a task type to an existing task category

n Create a new task category

n Add a new task type

n Add a task type description

n Define task type availability

Note: Asa user, if you set the Task type to Not Available, you cannot edit the TaskType after that. Tomake the

TaskType available, see your administrator. TaskType availability is explained in "TaskType Availability" on page

11-21.

4. Enter your information.

5. Click Save ( ).

6. Your new Task Category and Task Type appear in the drop down boxes.
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Task Type Availability
Task types can be hidden from users by clicking the Not Available check box in the Add Task

Type and Edit Task Type screens. By making Task Types not available, you can make the

Task Type unavailable without deleting it.

Editing a Task Type
From the Add Task screen, you can edit a Task Type. This will allow you to change the Task

Type name, Task Type description, and Task Type availability.

To edit a task type, follow these steps.

1. Go to the Add Task screen, as described in "Creating a Task via the Task Folder" on page

11-14.

2. Choose a Task Category and the Task Type to edit.

3. Click Edit, next to the Task Type dropdown box.

4. The Edit Task Type screen appears.

Creating a Task via the Task Folder

ReferenceManual

Version 8.0 Rev 1.3
11-21



From this screen you can edit the following:

n Task Type

n Task Type Description

n Task Type Availability. See Also: "Task Type Availability" on page 11-21

Note: Asa user, if you set the Task type to Not Available, you cannot edit the TaskType after that. Tomake the

TaskType available, see your administrator. TaskType availability is explained in "TaskType Availability" on page

11-21.

5. Edit the information.

6. Click Save ( ).

7. The Task Type information is changed.

Creating a Task from the Web Site
To create a task from a Web page, follow these steps.

1. Browse to the content for which you want to assign a task.

2. Right click the mouse to display a menu.

3. Click the Add Task button ( ).

Warning! The Add Taskbutton only appears if your system administrator hasgranted you permission to add

tasks. For more information, see "TaskPermissions" on page 11-3.

4. The Add Task screen appears. The content you were viewing is assigned to the task.

5. Follow the directions in . The only differences are

n the content’s ID number and title appear on the screen
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n the language of the content is the default language

See Also: "Creating a Task from the Web Site" on page 11-22

Creating a Task via the Content
Folder
The above section describes assigning tasks from the Tasks folder. You can also assign task via

the content folder, as illustrated below.

Assigning a Task from the View Content Screen

To assign a task from the View Content screen, follow these steps.

1. Access the View Content screen for the content to which you want to “attach” in a task,

as described in "Viewing Content" on page 7-9.

2. Click the Add Task button ( ).

Warning! The Add Taskbutton only appears if your system administrator hasgranted you permission to add

tasks. For more information, see "TaskPermissions" on page 11-3.

3. Follow the directions in "Creating a Task via the Task Folder" on page 11-13. The only

differences are

n the content’s ID number and title appear on the screen

n the language of the content is the default language
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Viewing a Single Task
Once a task is added, (with the exception of Administrators and users assigned to the Task-

Create role) only the user who assigned the task and those to whom the task was assigned can

view it.

To view a task, follow these steps.

Viewing a Task from the Content Folder

1. Access the Contents folder from the left side of your Workarea.

2. Open the folder that contains the content.

3. Click the content associated with the task.

4. Click the Tasks tab.

5. The page lists all tasks assigned to the content.

6. Select a task.

From the view task page, you can add a comment to the task.

Viewing a Task from the Tasks Folder

To view a task from the Tasks folder, follow these steps.

1. From the Smart Desktop, select the Tasks folder. See Also: "Personalizing the Smart

Desktop" on page 4-4

2. Click the task you want to view.

3. The View Task screen is displayed. From here, you can perform these tasks.

n "Editing a Task" on page 11-29

n "Deleting a Task" on page 11-34

n "Adding Comments to Tasks" on page 11-30

See Also: , "Sorting Tasks By Task Type" on page 11-27,; "Viewing a Single Task" on page

11-24;
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Viewing All Tasks
Beneath the Smart Desktop >Tasks folder, 14 view screens display all tasks filtered by

specified categories. The categories appear in the table below.

After viewing tasks in any category, most screens let you perform an action on the tasks (see

table below). For example, you can redirect your tasks to another user. To select all tasks on a

screen, click the check box in the header row (illustrated below).

Screen Displays these tasks
Action you can perform from

view screen

Tasks

Open tasksassigned to yourself, and

open tasks you have assigned to other

users.

n Create a new task

n Delete a task

n View a task

n Sort tasksby column

AllOpen

Tasks

All open tasks (that is, tasks in one of

these states) for all users

n not started

n active

n awaiting data

n on hold

n reopened

n pending

n Edit a task

n Sort tasksby column

Assigned

ToMe
All open tasksassigned to you

n Assign tasks to a different user

n View a task

n Sort tasksby column

Assigned

ByMe

All open tasks you assigned to yourself

or others

n Assign tasks to a different user

n View a task
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Screen Displays these tasks
Action you can perform from

view screen

n Sort tasksby column

Created by

Me
All open tasks you created

n View a task

n Sort tasksby column

Assigned

to User

All open tasksassigned to a user you

select

n Select anyuser and view all tasks

assigned to that user.

To do so, select new user fromAssign

to User drop down list and clickGet

Tasks.

n View a task

n Sort tasksby column

Not

Started

Allwhose state isNot Started

See Also:

n Change to anyother state

n View a task

n Sort tasksby column

Active Allwhose state isActive

n Change to anyother state

n View a task

n Sort tasksby column

Awaiting

Data
Allwhose state isAwaiting Data

n Change to anyother state

n View a task

n Sort tasksby column

OnHold Allwhose state isOnHold

n Change to anyother state

n View a task

n Sort tasksby column

Pending Allwhose state isPending

n Change to anyother state

n View a task

n Sort tasksby column

Reopened Allwhose state isReopened

n Change to anyother state

n View a task

n Sort tasksby column
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Screen Displays these tasks
Action you can perform from

view screen

Completed Allwhose state isCompleted

n Change to anyother state

n View a task

n Sort tasksby column

Archived Allwhose state isArchived

n Change to anyother state

n View a task

n Sort tasksby column

Deleted Allwhose state isDeleted

n Change to anyother state

n Purge tasks

n View a task

n Sort tasksby column

Sorting Tasks By Task Type

On every View Task page, you can sort tasks by the Task Type assigned to the task. You sort

by Task Type using the Show Task Type drop down box. It is located in the upper right corner

of the Workarea.

Note: TaskTypesonly appear in the Show TaskType dropdown boxwhen theyhave been added to a task.

To sort by Task Type, click the drop down box and choose a Task Type. Words in bold Italics

are Task Categories. You cannot sort by Task Categories.
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Determining Which Tasks a User Can View

To provide security, Ektron CMS400.NET restricts which users can use the task views. These

restrictions are listed on the following table.

View

option

Administrator

group

member

User or group to

whom task

assigned

User who

assigned

task

User

who

created

task

All

users

AllOpen * X

Assigned

byMe
X X

Assigned

toMe *
X

Created by

Me *
X

Assigned

to User
X X X X X

Not

Started

all tasks in

specified state

only tasksassigned

to user in specified

state

Active | |

Awaiting

data
| |

On hold | |

Pending | |

Reopened | |

Completed | V

Archived |

Deleted V
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* - user can only view open tasks, that is, not started, active, awaiting data, on hold, pending, or reopened

Viewing a Task’s History
Ektron CMS400.NET maintains a history of all events in the life of a task, as well as any

comments entered. As examples, the task history shows when and by whom the task was

created, when it changed to Active, when it was linked to content, when its state changed,

when it was approved, etc.

You can view the task’s history until the task is purged. To view a task’s history, follow these

steps.

1. Navigate to the View Task screen, as explained in .

2. Click the History button ( ).

3. The history of task events appears (example below).

Editing a Task
You can change task information, such as

n Title

n Assigned to

n Language

n Content

n Priority

n Task Category

n Task Type

n Status (State)
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n Due Date

n Start Date

n Description

To edit a task, perform the following steps.

1. Access the View Task page for the task, as described in .

Note: You cannot edit a taskafter viewing it from the Content folder.

2. Click the Edit button ( ).

3. The Edit Task screen appears.

4. Edit the task.

5. Click the Update button ( ) to save the changes.

Adding Comments to Tasks
You can add comments to an assigned task if you want to provide additional information

about its status. For example, if you update a task’s status from In progress to Waiting on

Someone Else, you can use a comment to describe the status change, such as:

left voice mail with John with questions about his changes
to the home page

Comments appear on the Comments Tab of the View Task screen (illustrated below).

Several comments can be added to a task to record its progress from assignment to completion.

To add a comment to a task, follow these steps.
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Note: When an approver approves/declinescontent from the Content Awaiting Approval screen, if the content

hasan active task, the AddComments to Task screen appears. The screen lets the approver insert comments

about the taskassociated with the content.

1. Access the View Task screen for the task, as described in "Viewing a Task from the Tasks

Folder" on page 11-24.

2. Click the Add Comment button ( ).

3. The Comments window appears.

4. Enter your comment in the editor. Note that you can format and spell check the text using

the toolbar buttons.

5. Click the button.

6. The View Task screen reappears with the comment at the bottom of the page.

See Also: "Adding Comments to Tasks" on page 11-30

Updating Comments

To update a comment, follow these steps.

1. Access the View Task screen that contains the comment you want to update, as described

in .

2. Click the Comments Tab.

3. Click the comment’s Date/Time link (illustrated below).
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4. The Comments window opens with the comment displayed.

5. Update the comment.

6. Click the button.

Archiving a Task
After a task is completed, you may want to change its state to Archived. Archiving moves

selected tasks from the Completed tasks list to the archived list. This change cleans up the

completed tasks list and makes it and easier to use.

Archived tasks are typically kept for a predetermined time period, at which point an

administrator deletes them (depending on your organization’s policies).

To archive a task, follow these steps.

1. From the Smart Desktop, open the Tasks folder.

2. Click the view option corresponding to the state of tasks you want to archive. Typically,

you would archive completed tasks.
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3. A list of Completed tasks appears. Select tasks one at a time, or click the check box on the

top left corner to select all.

4. Next to the Change to State field, click the down arrow to display the drop down list and

select Archived.

5. Click the Set button.

Purging a Task
If you want to remove deleted tasks from the system, you purge them. Purging removes a task

and its history from the database.

To purge one or more tasks, follow these steps.

1. From the Smart Desktop, click the Tasks folder.

2. Click the Deleted view option.

3. Select tasks one at a time, or click the check box on the top left corner to select all.
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4. Click the Purge button.

Deleting a Task
You can easily delete a task that is no longer needed. For example, the user who assigned a

task would typically delete it when it is completed.

An administrator can change any task’s state to deleted. He would typically do so after it is

completed or archived, depending on your organization’s policies.

Note that a deleted task remains in the system until you purge it. It is visible only on the View

Deleted Tasks option.

To delete a task, follow these steps.

1. Access the View Task screen for the task, as described in .

2. Click the Delete button ( ).

Warning! The Delete button only appears if your system administrator hasgranted you permission to delete

tasks. For more information, see "TaskPermissions" on page 11-3.

3. A confirmation message appears.

4. Click OK.

Automatic Creation of Tasks
Associated with Content
In addition to the manual assignment of tasks, they can be automatically generated whenever

content, an asset, or a form is created. You would enable and use the Automatic Task Creation

feature if you want to set up a preapproval process, which requires one or more users to review

and approve content before it enters the regular approval process. (The regular approval process

is described in .)

The most common scenario illustrated below.
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In this example, an automatically-generated task assigns the content to a preapproval group.

When any member of that group reviews his tasks, he inspects the corresponding content and

assigns it to an editor. After the editor reviews and possibly edits the content and submits it for

approval, it enters the normal approval process.

This section explains the automatic task creation process through the following subtopics:

n "Enabling Automatic Task Creation" on page 11-35

n "Assigning a Preapproval Group to a Folder" on page 11-36

n "How Automatic Task Creation Works" on page 11-37

Enabling Automatic Task Creation
The Settings > Configuration > Setup screen > Workarea tab's Enable PreApproval Group

field controls Ektron CMS400.NET’s Automatic Task feature. Check this box to turn

Automatic Tasks on.
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Next, you create user groups and assign them to folders whose content must complete the

preapproval process before it enters the regular approval process. See "Assigning a Preapproval

Group to a Folder" on page 11-36.

Assigning a Preapproval Group to a Folder
The ability to select or update a folder’s preapproval group is determined by the advanced

permission Modify Preapproval. Only users with this permission can see the Modify

Preapproval button ( ) when viewing the Folder Properties screen.

If you have permission to modify a folder’s preapproval group, go to the Folder Properties

screen and click the Modify Preapproval button ( ) to access the PreApproval Group field.
(The field only appears if you have enabled the Preapproval Feature. See "Enabling Automatic

Task Creation" on page 11-35.)

If you assign a user group, an automatic task can be assigned to that group whenever content

in that folder is created or updated.
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If you select Inherit, this folder gets its preapproval group from the parent folder. If you select

None, you disable the preapproval feature for the folder.

Preapproval Groups Report
The Preapproval Groups Report lists all preapproval groups assigned to folders within Ektron

CMS400.NET. To access it, go to Smart Desktop > Reports > Preapproval Groups. See

Also: "Personalizing the Smart Desktop" on page 4-4

How Automatic Task Creation Works
When a user submits a content item for approval, Ektron CMS400.NET checks to see if an

open task exists for it. (An open task is one whose state is Not Started, Active, Awaiting Data,

on Hold, or Pending.) If none exists and a preapproval group is assigned to its folder, a task is

created and associated with the content.

At this point, all members of the folder's preapproval group see the task on their Smart

Desktop.

A task has the following information.

.
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Field Value

Title

A string formulated by joining the

n content title

n content ID number

n underscore

n Task

For example, Private Content2_Task

Assigned to The preapproval group

Assigned by The user who submitted the content

Content The content being submitted for approval

Priority Normal

State Not Started

Due date none

Start date none

Created by User who submitted content

Description none

Next, the task can be reviewed by any member of the preapproval group. The member then has

two choices.

n review the content and submit it for publishing. This action completes the preapproval

process and submits the content into the regular approval chain.

n assign the task to another user, such as an editor. (The user to whom the task is being

assigned must have permission to edit the content.) The editor reviews the content, updates

it as needed, and submits it into the regular approval chain.

Note: The user submitting the content doesnot need permission to create tasks. Also, the user assigned to the

task should not change its state using the task system. Instead, he should review and approve content using the

regular content workflowmechanism. That mechanism automatically changes the task’s state.

The tables below explain the sequence of changes to content and its associated task. All

changes are logged into the task’s history. See Also: "Viewing a Task’s History" on page 11-29

Managing Tasks

11-38
ReferenceManual

Version 8.0 Rev 1.3



Also, email is automatically generated for automatic tasks as it is for manually-created tasks.

See Also:

Sequence of Task/Content Statuses (Author Lacks
Permission to Approve Content)

Event
Content

Status

Task

Status

Content is created and checked in Checked In

No auto

task

assigned

Content is submitted for approval

Note: The above action creates the automatic task for the

content.

Waiting for

completion of

associated

tasks

Not

Started

Content is assigned byamember or preapproval group to an

editor

Waiting for

completion of

associated

tasks

Not

Started

Editor updates content then checks it in Checked In Active

Content is submitted for approval; it enters anyapproval chain

set for the folder

Note: Since the task requires an approval, it appears in the task

list of the current approver.When the content is approved, the

task ismoved to the next approver's task list.

Submitted for

Approval
Pending

Approver denies request Checked In Reopened

Approver approves content Approved Complete

Sequence of Task/Content Statuses (Author Can Approve
Content)
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Event
Content

Status

Task

Status

Content is created then checked in Checked In

No auto

task

assigned

Content is edited then checked in Checked In Active

Content is submitted for approval

Note: Although an author can approve content, hemust click

publish twice: once to change content status to Awaiting

Completion of Associated Task, and a second time to change it to

Approved.

Waiting for

completion

of

associated

tasks

Not

Started

Content is published Approved Complete

Task Email Notification
email notification for tasks is sent on these occasions.

Warning! For email notifications to be sent, the following itemsmust be true:

 - Users have email enabled in their user profile.

 - Users have a valid email address in their user profile.

 - CMS400.NET is set up and configured to send emails.

n A task is assigned to a user.

n A task is redirected to a user.

n A task is submitted for content approval. Sent to the first user in the approval chain.

n The approval process moves on to the next approver.

n The content is declined at an approval stage. This is sent to the assigned user.

n The content is published. This goes to the creator, assigned user, and the approvers.

See Also: ”Configuring E-Mail for Tasks and Content” on page 1-109
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Business Rules allow you to define conditions for Web pages on your site. You choose an

action based on whether the conditions are true or false when a site visitor browses your site.

For example:

n Condition - a site visitor visits your site for the first time

n Action - add a cookie to the site visitor’s system and pop up a welcome message

With Business Rules, you do not write code to set conditions and initiate actions. You simply

complete the information requested in the Business Rules wizard, have your developer add a

Business Rules server control to your Web form, and assign the server control the Business

Rules Ruleset. See Also: "BusinessRules Server Control" on page 12-13

Business Rules start out with a Ruleset that is assigned an ID. Each Ruleset is made up of one

or more rules. Rules are made up of conditions and actions. There are several predefined

conditions and actions for rules in CMS400.NET.

Conditions include:

n Cookie Parameter = value

n Form Parameter = value

n QueryString Parameter = value

n Server Variable = value

n Custom Parameter = value

Actions include:

n Displaying a calendar

n Displaying a message

n Opening a URL in a new window

n Popping up a message

n Redirecting to a new URL

n Setting a cookie value

n Displaying a content block.

Once a rule is defined, you can add it to multiple Rulesets. This is useful if you have several

groups of rules that use a common rule.

Business Rules are more fully explained through the following topics.

n "Permission to Work with Business Rules" on page 12-3

n "Selecting a Rule" on page 12-3

n "Creating a New Business Rule Ruleset" on page 12-4

n "Working with Rulesets" on page 12-5
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n "BusinessRules Server Control" on page 12-13

Permission to Work with Business
Rules
Only members of the Administrators user group and those defined in the Manage Members for

Role: Add Role Member Business Rule Editor screen can work with Business Rules. See Also:

"Defining Roles" on page 15-32

Selecting a Rule
There are two ways to select a rule. The first, check boxes, allows you to select a rule by

clicking the check box. This method is used when turning a rule on or off in the Ruleset.

Checked, the rule is active. Unchecked the rule is inactive.

The second, highlighting a rule, is used to when you want to work with the rule. For example,

you want to add or remove a rule from a Ruleset. To highlight a rule, click its title. Once a

rule is highlighted, it is ready for an action, such as Remove or Edit.
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Creating a New Business Rule
Ruleset

Note: Onlymembersof the Administratorsgroup or those defined inManageMembers for Role: Rule Editor

screen can create or edit BusinessRulesand Rulesets.

See Also: "Creating a New Business Rule Ruleset" on page 12-4

You create Business Rules Rulesets from the Business Ruleset screen in the Workarea.

The Business Ruleset screen contains these columns:

n ID - the numerical ID assigned to the Ruleset.

n Name - a unique name you give to the Ruleset to help you understand what the Ruleset

does.

To add a new Ruleset, follow these steps:

1. In the Workarea, click Settings > Business Rules.

2. Click the Add New Ruleset button ( ).

3. The Add New Ruleset screen appears.

4. In the Name: text box, add a name for the rule.

5. Click the Save button ( ).

6. The View Ruleset screen appears.
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At this point, you can continue to add a rule or click the Back button ( ) and return to add a
rule later.

Working with Rulesets
After creating a Ruleset, you typically add rules to it via the View Ruleset screen.

The View Ruleset screen is the launch pad for working with existing Rulesets. From this

screen you can:

n "Edit a Ruleset" on page 12-5

n "Remove a Rule From a Ruleset" on page 12-6

n "Change the Order of Rules in the Ruleset" on page 12-7

n "Delete a Ruleset" on page 12-7

n "Add a New Rule to a Ruleset" on page 12-7

n "Add an Existing Rule to a Ruleset" on page 12-11

n "Edit a Rule in a Ruleset" on page 12-12

n "Viewing a Rule in a Ruleset" on page 12-13

Edit a Ruleset
See Also: "Working with Rulesets" on page 12-5

You can initiate editing a Ruleset from two different locations, the Web page or the Workarea.

To edit a Ruleset from the Web page, navigate to a Business Rule on a Web page while

logged in. Then, right click the Business Rule icon and click Edit.
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If editing from the Workarea, click Settings > Business Rules and then click the Ruleset to

edit. Next, click Action > Edit Ruleset.

The Edit Ruleset screen appears.

Remove a Rule From a Ruleset
Follow these steps to remove a rule from the Ruleset.

1. Navigate to the Edit Ruleset screen, as explained in "Edit a Ruleset" on page 12-5.

2. Highlight the rule you want to remove.

Warning! The checkboxassociated with the rule must be empty for you to remove the rule. If the checkbox is not

empty, the rule will lookas though it hasbeen removed

3. Click the Remove Rule button ( ).

4. A pop up appears letting you know that the rule will be removed from this Ruleset only.

5. Click OK.

6. The rule is removed from the Edit Ruleset screen.

7. Click the Save button ( ).
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Change the Order of Rules in the Ruleset
The order of rules in a Ruleset affects how rules are applied when a site visitor views a page.

For example, you want to display a welcome message before a content item. To accomplish

this, move the rule for the welcome message above the rule for a content item.

Follow these steps to change the order of the rules in a Ruleset.

1. Navigate to the Edit Ruleset screen, as explained in "Edit a Ruleset" on page 12-5.

2. Highlight the rule you want to reorder.

3. Click the Move Up or Move Down buttons ( ) ( ) to move the rule up or down the
list.

4. Click the Save button ( ).

Delete a Ruleset
When you delete a Ruleset, it is removed from the system permanently. However, rules

included in a Ruleset are not deleted. This is because a rule can be used in multiple Rulesets.

Follow these steps to delete a Ruleset.

1. Navigate to the Edit Ruleset screen, as explained in "Edit a Ruleset" on page 12-5.

2. Click the Delete Ruleset button ( ).

3. A dialog asks you to confirm the deletion.

4. Click OK.

Add a New Rule to a Ruleset
Adding a new rule is easy with Ektron CMS400.NET. Just click the Add button on the View

Ruleset screen. The Rules Wizard launches and helps you define a rule.

Follow these steps to add a new rule to your Ruleset.

1. If you arrived here from the section, continue to the next step.

Otherwise, navigate to the Business Rules screen in the Workarea by clicking Settings >

Business Rules. Next, click the Business Rule for which you want to create a new rule.

2. Click New > Add New.

3. The Rules Wizard launches.
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4. Step 1 prompts you to create conditions for the rule and decide whether a site visitor needs

to match Any or All conditions. Clicking the param and value links opens a dialog to

enter information.

Place a check next to any condition you want to use. Use the table below to help you fill

out the param and value fields.

Conditions Table

Condition Description Example

The Cookie param

equals value

Use a cookie for this

condition.

param - enter Name

in this field.

value - enter the

name of the cookie in

this field.

Does the site visitor's system have an Ektron

cookie?

Usage:

The Cookie param “Name” equals value

“Ektron”
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Condition Description Example

The Form param

equals value

Use a form elements

field name and

match the value

entered into the

element.

param - enter a

form’s element Field

Name from a form.

value - enter the

value you want the

form element to

match.

A form hasa ChoicesField element with the

Field Name “Favorite_Food” and choicesof

Pizza, Steakand Chicken.When a site visitor

choosesPizza and clicks submit, your rule

launchesa Pizza company’sWeb site.

Usage:

The Form param “Favorite_Food” equals

value “Pizza”

TheQueryString

param equals value

Use theQueryString

for this condition

param - the name of

the QueryString. For

example, ID.

value - the value

associated with the

parameter. For

example, 18.

Is content with the ID of 18 being displayed?

Usage:

TheQueryString param “ID” equals value “18”

The Server Variable

param equals value

Use server variables

from the site visitor.

param - enter the

name of a server

variable. For

example, HTTPS.

value - the value

associated with the

parameter. For

example, On.

Is the site visitor’s browser using SSL?

Usage:

The Server Variable param “HTTPS” equals

value “On”

A list of server variables and their descriptions can be found at

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/iissdk/html/21b3be8f-d4ed-

4059-8e21-6cba2c253006.asp.

Working with Rulesets

ReferenceManual

Version 8.0 Rev 1.3
12-9

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/iissdk/html/21b3be8f-d4ed-4059-8e21-6cba2c253006.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/iissdk/html/21b3be8f-d4ed-4059-8e21-6cba2c253006.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/iissdk/html/21b3be8f-d4ed-4059-8e21-6cba2c253006.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/iissdk/html/21b3be8f-d4ed-4059-8e21-6cba2c253006.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/iissdk/html/21b3be8f-d4ed-4059-8e21-6cba2c253006.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/iissdk/html/21b3be8f-d4ed-4059-8e21-6cba2c253006.asp


Condition Description Example

The Custom param

equals value

Use custom

parameters from the

user. User

parameters are

defined in the

codebehind of a web

page.

param - enter the

name of a custom

parameter. For

example, AcctBlnc

value - the value

associated with the

parameter. For

example, 1000

Is the user's account balance $1000?

Usage:

The Custom param “AcctBlnc” equals value

“1000”

5. Click Next.

Step 2 of the Wizard prompts you select an action to take if conditions are true. Check the

boxes for the actions to take. Click the blue links to add the appropriate information.

Conditions Table

Action Description

Display

Calendar ID
Enter a CMS400.NET Calendar ID.

Display a

Message
Enter amessage to be displayed.

BusinessRules
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Action Description

OpenURL Enter a URL. This opensa new window with the URL.

Popup A

Message
Enter amessage that appears in a popup dialog box.

Redirect to a

URL
Enter a URL to redirect a the site visitor’s browser.

Set Cookie to

Value

Createsa cookie on the site visitor’s system. Enter Name for Cookie and the

name of the cookie for Value.

DisplayContent

Block ID
Enter a CMS400.NET content block’s ID.

6. Click Next.

7. Step 3 of the Wizard lets you select actions to take when conditions are false. This works

the same as Step 2 of the Rules Wizard. For descriptions of the actions, see "Conditions

Table" on page 12-8.

8. Click Next.

9. Step 4 of the Wizard asks you to enter a name for the rule in the text box.

10. Click Done.

11. The View Ruleset screen appears. Your rule appears in the Ruleset box.

Add an Existing Rule to a Ruleset
Because rules are not tied to a Ruleset once they are created, you can add a rule to more than

one Ruleset. To add an existing rule to a Ruleset, follow these steps:

1. If you arrived here from the section, continue to the next step.

Working with Rulesets
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Otherwise:

Navigate to the Business Rules screen in the Workarea by clicking Settings > Business

Rules. Next, click the name of the Business Rule for which you want to add an existing

rule.

2. Click New > Add Existing.

3. The Add an Existing Rule screen appears.

4. Check the rules to add to the Ruleset.

5. Click the Save button ( ).

Edit a Rule in a Ruleset
Following these steps to edit a rule in a Ruleset.

1. In the Workarea, navigate to Settings > Business Rules.

2. Select the Ruleset that contains the rule to be changed.

3. Highlight the rule to be changed.

BusinessRules
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4. Click Action > Edit Rule.

5. The Rules Wizard appears with the rule loaded. Edit as necessary. The Rules Wizard is

explained in "Add a New Rule to a Ruleset" on page 12-7.

Viewing a Rule in a Ruleset
To help you understand the contents of a rule, a (View) link appears next to each rule in a

Ruleset. Click this link to launch a view window for the rule. This window displays settings

for each Rules Wizard step applied to a rule.

Note: The stepsare not editable from thiswindow. To edit rules in a Ruleset, see "Edit a Rule in a Ruleset" on

page 12-12.

To navigate through the steps, use the Previous and Next Step buttons ( ). To close the
window, click the Close button.

BusinessRules Server Control
The BusinessRules server control allows you to add a Business Rule created in the Workarea

to a Web form. It also allows you to add a place holder for a Business Rule. Then, a

CMS400.NET administrator can create a business rule at a later date.

For an explanation of Business Rules and how they work, see "Business Rules" on page 12-1.

BusinessRules Server Control Properties
The following table explains the properties of the Business Rules server control.

BusinessRules Server Control
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Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can

use it to browse to Content, Collections, etc.See Also:
"Using CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9.

String

Hide

Used to hide a control in design time and run time.

True =Hide BusinessRule

False =Show BusinessRule

Boolean

Language

Set a language for viewing form content. This property

shows results in design-time (in VisualStudio) and at run-

time (in a browser).

Integer

RuleID

The ID of the Ruleset to evaluate. If you don’t know the ID

number of the Ruleset, use the CMSExplorer to browse

to it.See Also: "Using CMSExplorer to Browse Your

Ektron CMS400.NET Site" on page 21-9

Long

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the

control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line

portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply

attributes to a blockof code.

Custom - Allows you to use a custom tag.

String

BusinessRules

12-14
ReferenceManual

Version 8.0 Rev 1.3



Chapter 13

Multivariate Testing

ReferenceManual
Version 8.0 Rev 1.3

13-1



Multivariate testing helps determine the optimum page layout for Web pages. By adjusting

page layouts, Web site managers increase the number of visitors to a target page. With Ektron

CMS400.NET Multivariate Testing, these adjustments occur automatically and the optimal

page layout becomes the actual page web site visitors see.

Content variations appear to site visitors during an experiment. The page variation that the site

visitor sees is randomly selected by the system. When a visitor navigates to a special page

called the target, it is logged as a conversion. Conversions are counted, and the variation that

produces the most conversions is automatically promoted to the Web site.

Sometimes, this type of testing is called “A/B Testing”, but Multivariate Testing is far more

than that. A/B testing provides only a few variations. With Multivariate Testing, the number of

page combinations grows exponentially as the number of layout and content combinations

increase.

Warning! In order to use theMultivariate Testing feature, youmust have PageBuilder templatesavailable on your

Web Site. For more information about Pagebuilder templates, see "Building Pages" on page 6-5.

An Example of Multivariate Testing

In the example below, the marketing manager wants to know which of three ads produces the

most visits to a registration page.

Multivariate Testing
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n The page containing the ads with a link to a registration form is the experiment page.

n A page containing the registration form is the target page.

n Results are calculated by counting visits to the target page produced by each ad - these are

called conversions.

When the target number of conversions occurs, the variation achieving it automatically

becomes the permanent page on the site. The optimum ad runs on the web site without further

effort by the Web site Admin.

See Also:

n "Widgets used by Multivariate Testing" on page 13-4

n "Using PageBuilder Pages and Content " on page 13-5

n "Creating a Multivariate Experiment" on page 13-5

n "Starting and Running an Experiment" on page 13-9

n "Additional Information" on page 13-12
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n "Multivariate Target Widget Details" on page 13-16

n "Multivariate Experiment Widget Details" on page 13-17

n "Multivariate Section Widget Details" on page 13-18

Widgets used by Multivariate Testing
You use three PageBuilder widgets for Multivariate Testing. =

n Multivariate Experiment Widget

n Multivariate Section Widget

n Multivariate Target Widget

The widgets look like this in the PageBuilder Widget tray.

The following table describes each widget type.

Widget

Name

Page

Used
Description

For

details,

see

Multivariate

Target

WIdget

Target

Page

When a page view occurs on a page containing

thiswidget, the conversion count is increased.

"Multivariate

Target

Widget

Details" on

page 13-16

Multivariate

Experiment

Widget

Experiment

Page

This controls the experiment. Settings include the

target content number, start/stop button and the

Report hide/show button. This is only available

when logged in and editing the PageBuilder

experiment page.

"Multivariate

Experiment

Widget

Details" on

page 13-17
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Widget

Name

Page

Used
Description

For

details,

see

Multivariate

Section

Widget

Experiment

Page

Thiswidget allows you to drag and drop various

content widgets into it. These produce the

variationsused during the experiment.

A slider control selects each specific content used

in the variations.

More than oneMultivariate Section widget can be

used on a page.

"Multivariate

Section

Widget

Details" on

page 13-18

Using PageBuilder Pages and
Content
Before you create a Multivariate Experiment, you will need to have two web pages - the

Target page and the Experiment page.

Both pages are created with PageBuilder which allows you to drag and drop widgets into your

page. For more information about PageBuilder, see "Building PageBuilder Pages" on page 6-1.

You may choose any type of widget for your pages.

Creating a Multivariate Experiment

Note: To runMultivariate Tests, youmust be an Administrator or have theMultivariate Tester Role assigned. For

more information see "Defining Roles" on page 15-32.

To create a Multivariate experiment, follow these steps:

1. Create a target page that contains the Target Widget. See "Creating a Multivariate Target

Page" on page 13-6

2. Create an experiment page that contains the content variations with the Experiment and

Section widgets. See "Creating a Multivariate Experiment Page" on page 13-6

3. Run the experiment until it automatically ends or you stop it. See "The image below

shows a completed experiment page that has two Section Widgets." on page 13-8
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ReferenceManual

Version 8.0 Rev 1.3
13-5



Creating a Multivariate Target Page
The target page is the Web page you wish your visitors to view. It contains the Multivariate

Target Wizard. Visitors arrive here by clicking links on the experiment page.

To create the target page, follow these steps.

1. Create or edit the PageBuilder page with the target content.

2. Note the ID of the content number on this page. (For example: 948.) This ID number is

used in Step 3 below "Creating a Multivariate Experiment Page" on page 13-6.

3. Add the Multivariate Target widget to any location on the page.

This is how the Multivariate Target widget appears on the Pagebuilder page.

4. Publish this page

After creating the Target Page, create the Multivariate Experiment Page using the following

procedure.

Creating a Multivariate Experiment Page
The Experiment page contains:

n the Experiment Widget

n the Section Widget(s)

n the content variations

Multivariate Testing
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The illustration below shows the basic steps to create an experiment page with Multivariate

Test widgets.

Follow these steps.

1. Create or edit the PageBuilder page you wish to use during the experiment. See Also:

"Building PageBuilder Pages" on page 6-1

2. Place the Multivariate Experiment widget in any location on your web page. For more

information see "Multivariate Experiment Widget Details" on page 13-17

Note: Do not worry about the appearance of thiswidget. Multivariate TestWidgets do not appear on aWeb page

when you are not logged in. Only the content shows.

3. Enter the Target Page Content Id number. (For example, 948.) (See step 2 of "Creating a

Multivariate Target Page" on page 13-6)

To help find the content, browse the content folders by clicking the button circled below.

Creating aMultivariate Experiment
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4. Enter the Conversions before promote value. Setting this to 1000 tells the experiment to

automatically end when one variation has reached 1000 conversions.

5. Place at least one Multivariate Section widget into the location where your content

variations should appear. For more information, see "Multivariate Section Widget Details"

on page 13-18

6. Drag any type of content widget into the Multivariate Section widget.

7. Configure the content widget with the appropriate settings.

Note: Youmayuse anywidget inside theMultivariate SectionWidget. The ContentWIdget was chosen for

illustration purposeshere.

8. Add more variations by clicking the Add Variations button ( ) and repeat steps 6 and
7. You now have variation 2 of 2.

9. If you wish to add another section and variations, go back to step 5 and continue.

The image below shows a completed experiment page that has two Section Widgets.

Multivariate Testing
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10. Publish the PageBuilder page.

Now you are ready to run the experiment.

Starting and Running an Experiment
Once you create the Target Page and Experiment Page, follow these steps.

1. Select the PageBuilder page that contains the Multivariate Experiment Widget.

2. Click File > Edit to see the Experiment Widget.

3. On the Experiment Widget, click the Start button.

After you press Start, you see the Stop and Reports buttons.

Starting and Running an Experiment
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Now that the experiment is running, visitors see the page variations. (Also see "Visitors See

Randomized Variations" on page 13-10.)

Note: During an experiment, testersmaymodify variationsand content within theMultivariate Section widget.

Visitors See Randomized Variations
When an experiment is running, visitors see a specific variation that is chosen randomly. The

visitor continues to see this particular page variation until the experiment is ended.

Clicking the Reports Button During an Experiment

Click the Show Reports button ( ) to see the experiment’s progress.

The reports show:

n the percent conversions compared to visits

n the number of conversions

n the total number of visits to each variation

Multivariate Testing
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For more information about Reports, see "Multivariate Experiment Widget Details" on page

13-17.

The experiment continues until it is either stopped or ends automatically or manually.

Previewing a Variation

Click the Preview button ( ) to see the page variation that the progress bar represents.

Enabling or Disabling a Variation
At any time during the experiment, you may Disable any variation. Do this by clicking the (

) button which currently shows the variation is enabled. The variation then becomes
disabled and cannot be viewed by site visitors.

When a variation is disabled, visitors who have seen this page no longer see it but see another

variation instead.

You may re-enable a variation by pressing the ( ) button which currently shows the
variation as disabled. The variation then becomes enabled and visitors can view it.

Stopping the Experiment
At any time during the experiment, click the Stop button on the Experiment Widget.

Starting and Running an Experiment
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This suspends the experiment. Counters stop incrementing even though visitors continue to see

the page variations.

While the experiment is stopped, cookies are neither set nor read. For more information about

cookies see "Cookies in Multivariate Testing" on page 13-12.

Note: When you stop an experiment, theMultivariate SectionWidget remainson the experiment page.

You may restart the experiment again by pressing the Start button. All counters are reset to 0

and restarted.

Automatically Ending the Experiment
When one variation reaches the target number of conversions, it automatically becomes the

page variation all visitors see. All other variations are disabled.

Manually Ending the Experiment
During the experiment, you may click on the Promote button ( ) of the specific variation
you wish to promote. This ends the experiment and it becomes the page variation all visitors

see. All other variations are disabled.

Note: When the experiment automatically or manually ends, theMultivariate SectionWidget is removed from the

experiment page.

Additional Information

Cookies in Multivariate Testing
When visitors view the experiment page, a cookie is set in the browser. This cookie indicates

the specific variation seen by the visitor. From this point forward, if they next visit the target

page, this cookie is read and the proper variation counter is increased.

Multivariate Testing
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A cookie persists forever or until the cookies are removed from the browser cache. The cookie

gives a visitor a consistent page variation each time they revisit during the experiment.

Visitors that block cookies are not counted in conversions. Also, they see random page

variations each time they visit the page.

Using a Target Page Outside of the CMS
When your target page is outside of your Web Site, you must create an intermediate page that

contains the Target Widget and also code to redirect the visitor to the outside address.

For example, if you want to test visitors from your page to http://www.NFL.com, do the

following:

n create a new Pagebuilder page

n Add the target widget to it.

n Add the code that will redirect the visitor from this page to www.NFL.com

n Create content with links to the target page you just created

Now when the experiment is running, the experiment page links the visitor to this intermediate

page and the conversion is counted. Then the redirect will take the visitor to the external page.

Repeating an Experiment
To repeat an experiment after it has ended, you first must restore the history of this page.To

restore history of a PageBuilder page, follow the steps found in the section entitled "Restoring

a Previous Version" on page 7-128.

After you have restored the previous version, you may edit the parameters of the experiment,

modify the content, and run the experiment again.

Scheduling an Experiment
The PageBuilder page has the same properties as other content types including the Schedule

Property. To set the beginning and ending date of the page, edit the PageBuilder page and

follow the procedure for setting content schedules located in the section "Scheduling Content

to Begin and End" on page 7-195.

Be sure to set the Schedule End Date to be long enough past the time you believe the

experiment will automatically end.

More Information About the Reports
Reports show how each variation has performed during the experiment. Click on the Show

Report button in the Experiment Widget to see the progress and results.
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The bar graph shows the conversion percentage.

The numbers to the right of the bar graph show two values. The first value is the percent of

conversions compared to the total number of visits to the experiment page. On variation #2

above, the “79%” means that 568 visitors to this variation have successfully reached the target

page 451 times.

The numbers after the percentage show the actual conversations. The first number before the “/”

indicates the total number of conversions during the experiment. The second number is the

total number of times this variation was viewed by a visitor.

Note: Users that are logged in are counted asa page view to the experiment page but not counted on the target

page asa conversion.

The following table describes how to use each button.

Button Description

Preview shows the page configurations for this specific variation.

Notice that not only does the content in theMultivariate Section

wizards change, but also the slider number changes too.

Variation Enabled.

When this shows, this variation is currently selected to run.

Clicking on this button disables this variation.

Variation Disabled.

When this shows, this variation is currently not selected to run.

Clicking on this button enables the variation.

Promote.

Clicking this button promotes this specific variation to become the

Multivariate Testing
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Button Description

actual page seen by visitors. All other variationsare disabled and

the experiment is ended.

Using More Than One Section Widget on a Page
You may create a PageBuilder page with more than one Section Widget. This provides greater

flexibility in helping to identify combinations of content and images that provide the best

conversion results.

A page containing two Multivariate Section Widgets is shown below.

Additional Information
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The contents inside the Section Widgets are part of the variations shown randomly during the

experiment.

The Quantity of Variations Tested
The number of variations in a Multivariate Experiment grows exponentially as you add

sections and variations.

For example, if you have two sections with 3 variations in each section, there are a total of 8

(23) pages to be tested. If you increase this to 4 variations each, there are 16 (24) pages.

Multivariate Target Widget Details
The target widget is placed on the page containing the content you wish people to find.

The target widget does not have any configurations and need only reside somewhere on the

page.

Note: Use only one TargetWidget per PageBuilder page

Below is an example of the target widget placed on a PageBuilder page.

The Target or Results Page
The Target page contains the Multivariate Target widget.

Whether you arrive at the target page (results page) by browsing to the variations page first or

you arrive by browsing to the target page directly, the views are counted.

The exceptions to this are:

n if you are logged in

n if you have not first visited the experiment page to receive the cookie

n if you have cleared the cookies before visiting the target page

Note: Users that are logged in are counted asa page view of the experiment page but not counted on the target

page asa conversion.
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Multivariate Experiment Widget
Details
The Multivariate Experiment Widget contains all of the information about the variations you

use in an experiment. It also contains the Start/Stop button and the conversion limits.

Note: Use only one ExperimentWidget per PageBuilder page.

The image below is an example of the Multivariate Experiment Widget before the experiment

is started.

Field Definition

Target Page This is the content ID of the target page.

Conversionsbefore

Promote

This i the number of conversionsany variationsmust have

before the experiment is stopped automatically.

Set the target page ID number and the value of the “Conversions before promote”. Once this

value is reached, the experiment will promote the variation with the highest percent of success

and disable all other variations.

To start the experiment, click the Start button.

Below is an example of a Multivariate Experiment widget while an experiment is running. If

desired, you can click the Stop button to stop the experiment.

Multivariate ExperimentWidget Details
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The experiment widget also shows reports to indicate how each variation has performed during

the experiment.

Click on the Show Report button to see the conversion information during the experiment. For

further information about reports, see "More Information About the Reports" on page 13-13.

Automatic Promotion

Automatic promotion occurs when the target number of conversions occur on one of the

variations. For more information see "Automatically Ending the Experiment" on page 13-12.

Manual Promotion

During an experiment, you may choose a specific variation to be the page that all visitors see

and end the experiment. For more information see "Manually Ending the Experiment" on page

13-12.

Multivariate Section Widget Details
The Multivariate Section widget contains the content variations for the experiment. By using a

variety of content combinations, the experiment tests the best arrangement of content to

accomplish the desired conversion goals. The content is presented randomly to the site visitor.

Note: Youmayuse one or more SectionWidgets per PageBuilder page.

Below is a web page containing the Multivariate Section widget.
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Variation Selector Slider
The slider bar at the top of the Multivariate Section widget is used to select the variation.

The examples below demonstrates the slider control for variation 1/2 and 2/2.

Move the slider to see each variation.

Click the Add Variation button ( ) to add another variation. Drag and drop the content
widget into this section. After configuring it, this content widget is now one of the variations

used in the experiment cycle.

Progress Bar
During the experiment, statistics are collected on:

n the number of page visits to the target page

n the number of page visits to a specific variation

The experiment will continue to progress until it is either stopped or ended.

For more information, see "More Information About the Reports" on page 13-13.
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Ektron CMS400.NET supports the creation of content in any language supported by the

Unicode standard. This section explains how to create and work with content in any language.

Overview

First, determine the languages in which your site’s content should appear (see "Determining

Which Languages are Available" on page 14-5). Then, for any content, you can provide

editions in each supported language.

To provide multi-language content, you can either create new content or copy and edit existing

content. For example, you can begin the creation of German content by copying English

content into it, then translating that content into German and deleting the English content.

All editions of content have the same ID number but are differentiated by the language

attribute. As a result, your Web page template can link to a single content item, but what is

displayed is determined by the selected language. There are two ways that content’s language

can be selected:

n a language cookie, which is created when a visitor enters your site and selects a language

n the link to another page includes the language (langType) parameter. For example,

mytemplate.aspx?LangType=1033.

Note: For a list of the decimal values for each supported language, see Ektron CMS400.NET Workarea >

Settings > Configuration > Language Settings.

The View Contents of Folder screen’s View field lets you choose a language then view and

create content in that language. You can also view all content in the folder, regardless of

language. This field makes to easy to find and work on content editions in a selected language.

Working with Multi-Language Content
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The View Contents of Folder screen also displays the language of each content item. This

helps you distinguish them when viewing all content.

Finally, you can set up a separate approval chain for each edition of a content, and can assign

collections and tasks in any supported language.

This section describes how to work with a multiple language Web site through the following

topics.

n "Enabling/Disabling Support for Multiple Language Content" on page 14-4

n "Viewing Your Site in Another Language" on page 14-4

n "What Happens if Chosen Language is Not Available" on page 14-5

n "Determining Which Languages are Available" on page 14-5

n "The Default Language" on page 14-7

n "Creating New Content" on page 14-8

n "Translating Content" on page 14-8

n "Additional Multi-Language Topics" on page 14-23

n "Setting Up a Multilingual Web Site" on page 14-25

n "Using a Language Other than American English as the Default" on page 14-29

Working with Multi-Language Content

ReferenceManual

Version 8.0 Rev 1.3
14-3



Enabling/Disabling Support for Multiple Language
Content
Support for multi-language content is enabled in the web.config file. To enable or disable it,

follow these steps.

1. Open the file webroot\yourwebsite\web.config.

2. To enable multi-language content, set the value of ek_EnableMultilingual to 1. To disable

it, set it to zero (0).

3. Save and close web.config.

Viewing Your Site in Another Language
It’s easy for your site visitors to view your site in any enabled language. On any screen, your

developer can display a language drop-down list (circled in red below).

(For more information about the LanguageSelect Server Control which displays this drop-down

list, see See "LanguageSelect Server Control" on page 14-46.) On the sample site provided

with Ektron CMS400.NET, this drop-down list appears in the lower left corner of the home

page, but your developer can place it anywhere on any page.

Another way to indicate which language-edition of content to display is by adding the

language parameter (langType) to the Quicklink. For example, products.aspx?LangType=1033

displays the English (US) edition of the products.aspx content. This syntax automatically sets

the language cookie.
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Note: For a list of the decimal values for each supported language, see Ektron CMS400.NET Workarea >

Settings > Configuration > Language Settings.

See Also: "What Happens if Chosen Language is Not Available" on page 14-5

What Happens if Chosen Language is Not Available
A visitor to your site uses one of the methods listed above to select a language. Ektron

CMS400.NET uses the following criteria to determine which language edition to display for

content.

1. If an edition of the content is available in the selected language, display that.

2. If option 1 is not available, display an edition of the content in the default language

(defined in the ek_DefaultContentLanguage variable in web.config).

Note: When Ektron CMS400.NET is installed, the default language isEnglish.See Also: "The Default Language"

on page 14-7

3. If neither edition is available, display nothing.

Determining Which Languages are Available
To determine which languages are available for creating content, go to the Workarea and click

Settings > Configuration > Language Settings. The Language Settings screen lists all

languages in which content can be created on your site.

Note: Onlymembersof the Administrator User Group can view, add, or edit language settings.

See Also: "Working with Multi-Language Content" on page 14-1

To change the list, follow these steps.

1. Click the Edit button ( ).

2. The Edit Language Setting screen appears.

Working with Multi-Language Content

ReferenceManual

Version 8.0 Rev 1.3
14-5



3. Each language has two check boxes. They are described below.

n To enable a language in the Workarea only, click ( ). If this column is checked, the
language populates the language drop-down lists within Ektron CMS400.NET, as shown

below.

n To enable a language in the Workarea and let site visitors select it when viewing the site,

click ( ).

So, you can enable languages in the column when you are translating the site but are not
ready to make those content items publicly available. When you complete the translation,

check the column.

Note: If you select , the checkbox in the column is checked automatically. This is because, if you let users
view the language on the site, it must be enabled in theWorkarea.
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Note: The default content language on a dropdown list is determined in the ek_DefaultContentLanguage

element of the web.config file.

If you choose only one language on the Language Settings screen, fields that prompt the user

to select a language do not appear in Ektron CMS400.NET. Instead, all content is created in

that language.

The Default Language
The default language determines which edition of content to display when a visitor to your

site does not select a language.

It is also used if a visitor selects a language other than the default, then navigates to page for

which content does not exist in the selected language. In that case, Ektron CMS400.NET

displays that content in the default language (if available).

Within Ektron CMS400.NET, the default language determines the default value on the

language drop-down lists that appear on every page on which a user can select a language.

When you install Ektron CMS400.NET, the default language is English.

Use the following procedure to change the default language for your multi-language Web site.

1. Open webroot\yourwebsite\web.config.

2. Set the value of ek_DefaultContentLanguage to the locale id of the default language. For

example, 1031 for German.

Note: For a list of locale ids, see Ektron CMS400.NET Workarea > Settings > Configuration > Language

Settings.

3. Save and close web.config.

See Also: "Using a Language Other than American English as the Default" on page 14-29

Disabling a Language
To disable any language, uncheck the accompanying checkbox on the Edit Language Setting

screen. (For more information, see "Determining Which Languages are Available" on page 14-

5.)

If you want to disable the default language, you must first assign a new default language. See

Also: "The Default Language" on page 14-7 explains what a default language is and how to

assign one.

What Happens to Content When You Disable Its Language
If you disable a language for which content exists, that content remains in the database but no

one can access it, either from within Ektron CMS400.NET or when visiting your site.
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If you later enable that language, the content is once again available.

Creating New Content
To create content in a non-English language, follow these steps.

1. Navigate to the content folder in which you want to create the content. (You must have

permission to add content to the folder.)

2. From the language drop-down list, select the language in which you want to create the

content.
.

If the desired language is not available, see "Determining Which Languages are Available"

on page 14-5.

3. Click the Add Content button ( ) and create the content as you would any content.

4. In order to add metadata to a content, metadata specifications must have been created for

the selected language.See Also: "Working with Metadata" on page 7-146

Translating Content
When translating content into a foreign language, you have three options.
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Option For more information, see

Copyoriginal content into a new content item in a new

language.

Then, translate content manually.

"Translating Content Manually" on

page 14-9

Use the computer-based translation tool provided

with Ektron CMS400.NET.

"UsingMachine Translation" on page

14-10

Create an XLIFF or XHTML file from existing content.

The file is sent to a translation agencyand returns

translated to the new language(s). Then, import the

translated files into Ektron CMS400.NET.

"Using the Language Export Feature"

on page 14-13

Translating Content Manually
Use this procedure when you want to initialize new foreign language content with content

from a source language, then translate the content manually. This copying should facilitate the

translation.

For example, an editor is translating content from French to German. The editor copies the

French edition to new content whose language is German. As the editor translates the French

edition into German, he deletes the French content. Any images in the content would usually

remain, and all formatting (tables, bullets, etc.) is retained.

After signing in to Ektron CMS400.NET, you copy content into new content of a different

language by either

n navigating the Web site, or

n accessing the Workarea and navigating the folder structure

After copying the original content, translate it into the new language then delete the original

text. Both procedures are described below.

Accessing Content via the Web Site

1. Navigate to a page on which you can select the site language. See Also: "Viewing Your

Site in Another Language" on page 14-4

2. Select the language into which you want to translate the content.

3. Navigate to content that you want to translate. You must have privileges to add content

to this folder. See Also:

4. Right click within the content’s border and a small menu appears.

5. Click the Add New Language option ( ).

6. The original language content appears. Translate into the new language then delete the

original content.
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Note: At this point, you can click the Translate Content button ( ) to have the software translate the content.
You can then edit it as needed to perfect the translation.

7. In order to add metadata to content, metadata specifications must have been created for the

selected language. See Also: "Working with Metadata" on page 7-146

8. When you save the content, it is saved as the edition of that content in the selected

language.

Accessing Content via its Content Folder

To copy content into a new content of a different language, follow these steps.

1. Go to the View Content screen for the content you want to translate. Its status must allow

editing (it cannot be submitted or pending).

2. From the View drop-down list, select a original language.

3. Click the content you want to translate.

4. It appears on the View Content screen.

5. Use the Add drop down list in the upper right corner to select the language into which

you want to translate the content.

6. The original language content appears. Translate into the new language then delete the

original content.

7. In order to add metadata to content, metadata specifications must have been created for the

selected language.See Also: "Working with Metadata" on page 7-146

8. When you save the content, it is saved as the edition of that content in the selected

language.

Using Machine Translation
Ektron CMS400.NET includes a machine translation feature, which can automatically translate

content from/to the following languages.

n Chinese Simplified

n Chinese Traditional

n Dutch
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n English

n French

n German

n Greek

n Italian

n Japanese

n Korean

n Portuguese (Brazilian)

n Russian

n Spanish

Note: Currently, machine translation is not supported for all languages in the Language Settings screen.

Like most software-based translation, someone fluent in the new language should review the

translated content to verify that the translation is appropriate within the context of the page.

The machine translation feature lets you choose a glossary (that is, a field, industry, or subject

area). This helps the software find the best translation for a term or phrase with different

meanings in different fields.

To use the machine translation feature, follow these steps.

Accessing Content via the Web Site
1. Navigate to a page on which you select the site language. See Also: "Viewing Your Site

in Another Language" on page 14-4

2. Select the language into which you want to translate. If you do not see the language on

the language selector dropdown, you need to enable the language. See Also: "Determining

Which Languages are Available" on page 14-5

3. Navigate to content you want to translate.

Note: Youmust have privileges to add content to the folder.See Also:

4. Right click within the content’s border. A menu appears.

5. Click the Add Content button ( ).

6. The original language content appears.

7. If the screen uses a Smart Form, select the text that you want to translate.

Note: You cannot useMachine Translation to translate field names in a Smart Form. XLIFF files are a good way

to translate XML field names.See Also: "Using the Language Export Feature" on page 14-13

8. Click the Translate Content button ( ).
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9. The Translation screen appears.

10. Select the source (old) and target (new) languages.

11. If the content should refer to a specific glossary, select one from the dropdown list.

12. Click the Translate button.

13. The translation appears. If it looks OK, press Paste Content.

14. The translated content replaces the original content in the editor. Modify as needed.

15. In order to add metadata to content, metadata specifications must have been created for the

selected language.See Also: "Working with Metadata" on page 7-146

16. When you save the content, it is saved as the edition of that content in the selected

language.

Accessing Content via its Content Folder
To machine translate content by identifying its content folder, follow these steps.

1. In the Workarea, navigate to the content folder that contains the content you want to edit.

2. Click View > Language and select an original language (that is, the language from which

it will be translated).

3. Click the content you want to translate. Its status must allow editing (that is, its status

cannot be submitted or pending).

4. It appears on the View Content screen.

5. Use the Add dropdown list in the upper right corner to select a new language for the

content.

If you do not see the language on the dropdown, you need to enable the language. See

Also: "Determining Which Languages are Available" on page 14-5
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6. The original language content appears. Edit the title if appropriate.

7. Click the Translate Content button ( ).

8. The Translation screen appears.

9. Select the source (old) and target (new) languages.

10. If the content should refer to a specific glossary, select one from the dropdown list.

11. Click the Translate button.

12. The translation appears. If it looks OK, press Paste Content.

13. The translated content replaces the original content in the editor. Modify as needed.

14. In order to add metadata to content, metadata specifications must have been created for the

selected language.See Also: "Working with Metadata" on page 7-146

15. When you save the content, it is saved as the edition of that content in the selected

language.

Note: When the View Contents of Folders screen reappears, it is probably set to the source language. In this

case, you do not see the new content in the target language. To see it, clickView > Language and selectAll or the

target language.

Using the Language Export Feature
The Language Export feature lets you copy content into XLIFF files that can be submitted to a

translation agency. The agency translates the files and returns them. In the final stage, you

import the translated content back into Ektron CMS400.NET.
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The Language Export feature lets you translate the following kinds of CMS information.

n content, including summary, comments, and meta data

n forms, including response message, comments, and meta data

n all menus (you cannot choose individual menus)

n file assets (files managed by the DMS, including Office documents, Open Office

documents, managed files, etc.)

n taxonomies

The Language Export Feature is explained through the following topics.

n "What is XLIFF?" on page 14-14

n "Overview of Exporting/Importing Translation Files" on page 14-15

n "Creating the .zip File" on page 14-15

n "Importing Translated Files into Ektron CMS400.NET" on page 14-19

n "Applying Translated Metadata to Translated Content" on page 14-21

What is XLIFF?
XLIFF (XML Localization Interchange File Format) is a format that's used to exchange

localization data between participants in a translation project. This special format enables

translators to concentrate on the text to be translated, without worrying about text layout. The

XLIFF standard is supported by a large group of localization service providers and localization

tools providers.

To learn more about XLIFF, visit these Web sites:

n http://www-106.ibm.com/developerworks/xml/library/x-localis/

n http://www.xliff.org/

See Also:

n "Overview of Exporting/Importing Translation Files" on page 14-15

n "Creating the .zip File" on page 14-15

n "Importing Translated Files into Ektron CMS400.NET" on page 14-19

Supported Versions of XLIFF
Ektron CMS400.NET supports the following versions of the XLIFF standard: 1.0, 1.1, and 1.2.

You specify the version you are exporting in the web.config file, using the ek_XliffVersion

element. Any version listed above can be imported.
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SDL Trados Studio 2009

Trados is a commonly used translation tool.

SDL Trados Studio 2009 supports XLIFF 1.1 and 1.2, which are the recommended versions for

use with Ektron CMS.

If you are using Trados (an earlier version of the product), it only supports XLIFF 1.0. Note

that CMS 400 6.1.4 and older default to XLIFF 1.1, you need to change the XLIFF version in

the web.config file as described in "Supported Versions of XLIFF" on page 14-14.

Overview of Exporting/Importing Translation Files
1. You select content to translate. You can select:

n a content item

n a folder (all content in the selected folder is selected; all subfolders of the selected folder

may be included)

n all menus

n one or more taxonomies

2. Ektron CMS400.NET converts the selected content to XLIFF files. You can prepare the

files for translation into several languages at once.

A separate .xlf file is created for each item. Then, all .xlf files for a language are

compressed into one .zip file. A separate .zip file is created for each language.

3. Transmit the.zip files to a translation agency, which converts them into the new

language(s).

4. The translation agency returns the files.

5. Import them into Ektron CMS400.NET. If the editions of the content do not exist in the

target language, they are created.

Creating the .zip File
To create one or more .zip files for translation, follow these steps.

See Also: "Using the Language Export Feature" on page 14-13

Note: Onlymembersof the Administrator User Group and those defined in theManageMembers for Role:

XLIFF-Admin screen can create or import XLIFF files. See Also: "Using the RolesScreens" on page 15-33.

1. To translate one content item, navigate to its folder then click it.

To translate all content in a folder (and, if desired, all of its subfolders), navigate to its

View Contents of Folder screen.

To translate a menu, go to Content Tab > Menus.
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To translate a taxonomy, go to Content Tab > Taxonomy and check the taxonomies to

translate.

2. Click the Export for Translation button ( ). (On the View Contents of Folder Screen,
click Action > Export for Translation.)

3. The Export for Translation screen appears.

Note: The Include Subfolders field only appears if you click the Export for Translation button from the View

Contents of Folder screen.

4. If you want to include content in all of the selected folder’s subfolders, check Include

Subfolders. To translate just the selected folder, uncheck it.

5. The language of items being translated appears in the Source Language pull-down. If this

is not the correct source language, click the down arrow and select the correct one.

6. All languages enabled in the Language Settings screen are selected under Target

Language(s). (See Also: "Determining Which Languages are Available" on page 14-5).

7. To translate the content into all languages, proceed to the next step.

To translate the content into some languages, uncheck the languages that you do not want.

You can uncheck the box in the header row (illustrated below) to uncheck all, then only

check the ones you want.

8. Click the Create XLIFF Files for Translation button ( ).
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9. Ektron CMS400.NET creates one .zip file for each language. The .zip file includes an

XLIFF file for each selected content item.

Note: If any selected folder contains content in a target languagewhose edit date ismore recent than the source

language edition, that content is excluded from the .zip file. Ektron CMS400.NET assumes that, since amore

recent target-language edition exists, you do not want to translate the corresponding source language edition.

The History section of the Export for Translation screen displays the translated files.

The history lists the .zip file created for each language. (.zip files are indicated by the

WinZip icon ( ).) To the right of the icon are

n the flag of the source language

n an arrow indicating the direction of the translation

n the flag and name of the destination language

n the size of the zip file

Note: The top of the historywindow displays themost recently exported/imported files.

10. If you want to review the items in a zip file, click the plus button next to Extracted.

When you do, each content item’s ID number, title, and last edit date appear.
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11. Click the blue text of a .zip file. The File Download window appears.

Note: If you want to review the XLIFF fileswithin the .zip file, clickOpen.

12. Click the Save button. The Save As window appears. Navigate to the folder where you

want to place the zip file and click Save.

13. Transmit the files to the translation agency.

Note: When XLIFF files are returned by the translation agency, their extensionmust be .xlf. Other than that, the

file name is not important.

File Naming Patterns
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File

Type
Pattern

XLIFF

item identifier[item ID]_[new language hexadecimal code][two letter new language

code].xlf

n item identifier options:

- content: cont

- form: form

- menu: s

- menu item: s

- taxonomy: t

n item ID varies, depending on whether the item is content, a form, amenu, or a

menu item

- content: content ID number

- form: form ID number

- Menu: menu ID number

- Menu item: menu ID number

Zip

xlf[timestamp in format yyyymmddThhmmss]_u[user ID] _ [new language

hexadecimal code]-[two letter language code].zip

The user ID indicateswhich user performed the export or import.

Importing Translated Files into Ektron CMS400.NET
To import translated files into Ektron CMS400.NET, follow these steps.

See Also: "Using the Language Export Feature" on page 14-13

Note: Onlymembersof the Administrator User Group and those defined in theManageMembers for Role:

XLIFF-Admin screen can create or import XLIFF files. See Also: "Using the RolesScreens" on page 15-33.

1. Go to Workarea > Settings > Import XLIFF Files.

2. Click the Browse button and navigate to the folder that contains the translated files.

3. Select the files to import.

4. Click the Upload and Import button ( ).

5. Ektron CMS400.NET creates new or updates existing foreign-language editions of the

imported content/menu/taxonomy.

6. Information about the imported file appears in the history area of the Import XLIFF Files

screen. You can click plus signs (+) to reveal increasing levels of information about the

imported content.
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When you import the file, the comment Translated appears next to it.

For each new edition:

n If the content title is the same as the source edition, the next available number is appended

to the title to distinguish it from the source. For example: Henry Williams(1).

n its status matches the status of the source content. Typically, its status is checked out.

When imported, it can enter the approval process just like other content.

n its history indicates it was checked in at the time the report was run

n for content, the following properties are inherited from the original content:

- status

- Smart Form

- content searchable

- approval method

n date created and last edit date are captured from when the content is imported

n the last user to edit is captured by user who imported the file

After you import the translation files, Ektron CMS400.NET removes them from the file system.
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Note: If an error exists in anyof the files, the erroneous files aremoved into a subdirectory. The directory is

created using a timestamp. For example: uploadedFiles\localization\merged\xlf20060208T141841_
u1\error\.

Viewing Foreign Language Content
1. Navigate to the folder that contains the content.

2. Click View > Language and select the desired language.

3. Only content in that folder and the selected language appears.

You can perform the same activities with this content as any other content.

Applying Translated Metadata to Translated Content
Unfortunately, translated metadata is ignored when importing XLIFF files. This section

describes how to have translated metadata applied to the translated content.

Background Information

Although metadata exists in the XLIFF files, it does not appear in the content's metadata even

if metadata is defined for that language. This is because metadata definitions have unique IDs

across languages.
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Note: While a content ID is the same for a corresponding content block in other languages, the same is not true for

metadata.

As a result, the ID for the source language (for example, English) metadata is not automatically

mapped to metadata for other languages (for example, Spanish).

To solve this problem, create a mapping between the IDs of metadata definitions of different

languages that are synonymous. For example, consider the following metadata definitions.

ID Name Language

102 Paper form number en-US

104 Original page count en-US

106 Número de papel de la forma es-ES

108 Cuenta de la página original es-ES

110 Estado de laminoría es-ES

In this example, IDs 102 and 106 are synonymous as are 104 and 108. Definition 110,

however, only exists in Spanish.

The mapping is stored in an XML file. The mapping informs the XLIFF import process that

metadata for ID 102 in English corresponds to ID 106 in Spanish and likewise with 104 and

108.

Setting up the Process to Apply TranslatedMetadata to Content

1. Open the folder site root/workarea/xslt/ and look for the file metadatadefinitions.xml. If

it exists, go to step 2. If it does not, download it from Ektron at
http://dev.ektron.com/uploadedFiles/DevCenter/Support/KB_Articles/XliffMetadata.zip.

The zip file includes modified XSLT files that access the XML file.

2. Create metadata definitions in the other language(s). Be sure to use the same data type.

To do this, log in, open the workarea, go to Settings > Configuration > Metadata

Definition.

3. Make note of the definitions in the original language (for example, English).

4. Switch to view another language (for example, Spanish) and add a new definition. Assign

it the same data type and other properties as the original. Make note of the new ID

numbers.

Create metadata definitions in all languages you wish to support. You may add other

languages and define more metadata definitions at any time.

5. Edit workarea/xslt/metadataDefinitions.xml. For each Metadata Definition, enter a <dd>

element within the <dl> element. The <dd> element has the following form.
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<dd title="Name of the metadata definition">
<dfn id="ID" xml:lang="language-country code"/>
<dfn id="ID" xml:lang="language-country code"/>
:
</dd>

For example,

<dl>
<dd title="Paper form number">
<dfn id="102" xml:lang="en-US"/>
<dfn id="106" xml:lang="es-ES"/>
</dd>
<dd title="Original page count">
<dfn id="104" xml:lang="en-US"/>
<dfn id="108" xml:lang="es-ES"/>
</dd>
</dl>

The definition for ID 110 is not included because it applies to only one language.

Now that you have set up the xml file, the XLIFF import process accesses the

metadataDefinitions.xml file to determine which definitions in the target language (for

example, Spanish) correspond to the definitions in the source language (for example, English).

Additional Multi-Language Topics
n "Multi-Language Approval Chains" on page 14-23

n "Working with Tasks in a Multi-Language System" on page 14-24

n "Working with Collections in a Multi-Language System" on page 14-24

n "Working with Calendars in a Multi-Language System" on page 14-24

n "Working with Menus in a Multi-Language System" on page 14-25

n "Creating an External Link to a Page of Foreign Content" on page 14-25

Multi-Language Approval Chains

Just as you can create separate editions of content for each enabled language, you can set up a

language-specific approval chain and method. When determining a folder’s approval chain,

first select a language then select users and groups with authority to approve content in that

folder and that language.

The screen below shows the language selection drop-down list on the View Approvals screen.
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Only users in the language-specific approval chain for a folder can approve content in that

language.

You can also set a language-specific approval method. See Also:

Working with Tasks in a Multi-Language System

If you create content then add a task to it, the task can be in any enabled language. This would

be helpful if, for example, you review English content then want to assign the task of

translating it into another language in that language.

If you create a task then try to assign content to it, you can only choose from content in the

language of the task.

Working with Collections in a Multi-Language System

In a multi-language Ektron CMS400.NET system, you can create a language-specific edition of

each collection. For information about doing this, see "Working with Collections in a Multi-

Language System" on page 9-113.

Working with Calendars in a Multi-Language System

Calendars can be created in any supported language. Once you enter the calendar and event

information in the foreign language, the calendar display (that is, day and month names)

automatically appears in that language. Also, regional conventions for first-last days of the

week, and date and time formats are maintained.
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Working with Menus in a Multi-Language System

Note: If you are not familiar with the Ektron CMS400.NET’smenus feature, see "Working withMenus" on page 9-

129.

You can create an edition of any menu in every supported language. When a site visitor

selects a language, navigates to a page that has a menu and clicks the menu link, Ektron

CMS400.NET displays the menu in the selected language if it is available. If a menu in that

language is not available, nothing appears.

Before creating or translating a menu, it’s a good idea to create or translate all content that will

be on the menu. In this way, you can link these content items to the new menu. However, after

creating a menu, you can always add new items to it.

For details about translating menus, see "Working with Menus in a Multi-Language System"

on page 14-25.

Working with Taxonomies in a Multi-Language System

See "Multi-Language Support for Taxonomies" on page 9-236

Creating an External Link to a Page of Foreign
Content

If another Web site links to a multilingual page on your site, the URL must include the

language ID parameter. For example:

www.ektron.com/web-content-management-solutions.aspx?LangType=1036

Setting Up a Multilingual Web Site
Ektron CMS400.NET supports multilingual content. This section lists steps to follow when

setting up such a site.

See Also: "Creating Web Pages that Support Several Languages" on page 14-27
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Step For details, see

1. In web.config, make suremultilingual support is enabled.

"Enabling/Disabling

Support for Multiple

Language Content" on

page 14-4

2. Set a default content language, one that will be used by the

majority of your site’s content.

If you had a previous version of Ektron CMS400.NET and selected

a default language on the Database Upgrade Utility, be sure that

default languagematches the one in web.config.

"The Default Language"

on page 14-7

3. Enable languages your site will support.

"DeterminingWhich

Languagesare Available"

on page 14-5

4. Add language selection function to templates.

"Viewing Your Site in

Another Language" on

page 14-4

5. Create ametadata definition for each supported language.
"Adding aMetadata

Definition" on page 7-156

6. Create or translate content.

n "Adding HTMLCon-

tent" on page 7-15

n "Translating Con-

tent" on page 14-8

7. Set up approval chains for new content.

"Multi-Language

ApprovalChains" on page

14-23

8. Set upmultilingual collections.

"Working with Collections

in aMulti-Language

System" on page 14-24

9. Set upmultilingualmenus.

"Working with Menus in a

Multi-Language System"

on page 14-25

10. Modify text on templates.

"Modifying Page Content

Based on Language

Selection" on page 14-27

11. Translate graphics.

"Modifying ImagesBased

on Language Selection"

on page 14-28
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Creating Web Pages that Support Several Languages
When thinking about setting up your Web site to support content in multiple languages,

consider these three actions.

Action For more information, see

Create

language-

specific

content,

menus,

collections

n "Translating Content" on page 14-8

n "Working with Collections in aMulti-Language System" on page 14-24

n "Working with Menus in aMulti-Language System" on page 14-25

After you create these items, have the page invoke that item dynamically.When

Ektron CMS400.NET receivesa request to display an item that includesa

language and item id number, it returns the language-specific edition. To learn

about letting the user select a language from aWeb page, see "Viewing Your Site

in Another Language" on page 14-4.

Adjust

template

content to

user

language

"Modifying Page Content Based on Language Selection" on page 14-27

Translate

text in

images

"Modifying ImagesBased on Language Selection" on page 14-28

Modifying Page Content Based on Language
Selection
If a template’s text should change according to a user’s language selection, use a case

statement to provide the language-specific content. A good example of this is the template

used on the RC international sample site (Illustrated below).

Assume you want to create editions of the menu that runs across the header (Home, Products,

etc.) in three languages:

n English

n French
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n German

To do so, follow these steps.

Note: This procedure uses the header.asp file delivered with the RC international sample site asan example.

1. In the template file, declare each menu option a variable. For example:

Dim t_search, t_products, t_support, t_news, t_careers, t_calendar, t_home, t_login, t_site_lang,

t_contact, t_copyright, calendar_id

2. Enter case statements that provide the value of each variable in each language. (1031 is

the decimal code for German, 1036 for French.) The following illustrates how to do this

for the search menu option.
Select Case ContentLanguage
Case "1031"
t_search = "Suche"
Case "1036"
t_search = “Recherche"
Case else
t_search = "Search"
End Select

Now, when a user visits a page controlled by this template and selects French or German as the

site language, the page is refreshed and the translated values appear on the template.

Modifying Images Based on Language Selection
Many Web page templates also include images that require translation. You can set up

templates to invoke images in the user-selected language by following these steps.

1. Add to the library each image that should change when the language changes. For

example, if your company’s tag line is translated into three languages, upload the three

images into the library.

It‘s a good idea to include the language in the title of the image. For example, tagline_

English, tagline_French.

2. Create a separate content block for each language-specific image. Each content block must

have a unique ID number.

3. Insert the appropriate image into a content block for each language. For example, insert the

tagline_English image into the English content block.

4. Insert the content blocks into the appropriate templates. For example, insert the English

content block into the English template.
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Using a Language Other than
American English as the Default
Use this procedure if your site supports one language only, and it is not American English

(1033).

To set your site’s default language to something other than American English, follow these

steps.

1. Install a new site. Do not log in at this point.

2. Open your site’s web.config file (located in your site root folder.) Set ek_

EnableMultilingual to zero (0). Set ek_DefaultContentLanguage to the four digit locale id

for the desired language.

3. Log in to Ektron CMS400.NET.

4. Go to Settings > Configuration > Language Settings.

5. Enable the desired language, and disable all other languages.

6. Go to Settings > Configuration > Setup.

7. Make sure the desired language is the Default Application Language.

8. Go to Settings > Users > Edit User Information. Set the User Language to the desired

language. Do not leave App Default as the value.

9. Repeat Step 7 for every Ektron CMS400.NET user.

Set the Language of Spell Checking
Since Ektron CMS400.NET provides two editors, there are two procedures for doing this.

n "Setting the Spell Check Language for eWebEditPro+XML" on page 14-29

n "Setting the Spell Check Language for eWebEdit400" on page 14-30

Setting the Spell Check Language for
eWebEditPro+XML
To specify which dictionary to reference when checking spelling, specify a language in

Microsoft Word, version 2000 or later. To do this, open Word and select Tools > Language >

Set Language.
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Setting the Spell Check Language for eWebEdit400

Note: "Checking Spelling" on page 7-36 providesbasic information about spell checking. Please read that before

reading this section.

eWebEdit400’s spell checker refers to a standard dictionary of the content’s language. So, for

example, if the content is U.S. English, the U.S. English dictionary is referenced.

The spell checker also references a language-specific custom dictionary. Words are added to

this list when a user stops at a misspelled word and chooses the Add to Dictionary option.

Both dictionaries reside on the server that hosts Ektron CMS400.NET.

The spell checker compares each word against both sources. If a word is in either one, the spell

checker moves to the next word. If a word is missing from both sources, the spell check options

shown below appear, and the user decides what to do.

The following topics provide more information about eWebEdit400’s spelling dictionaries and

custom word lists.

n "What Happens if No Dictionary Matches the Content Language" on page 14-30

n "List of Standard Dictionaries" on page 14-31

n "Accessing the Spell Check Dictionary Update Screen" on page 14-32

n "Editing eWebEdit400’s Standard Spell Check Dictionaries" on page 14-32

n "Editing eWebEdit400’s Custom Dictionary" on page 14-39

What Happens if No Dictionary Matches the Content
Language
If eWebEdit400 does not have a dictionary that matches the content language, it proceeds

through these steps in the order shown below.

1. If the language begins with en (for example, en-AU), use the en-GB dictionary.
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If it begins with zh, use zh-CHS.

2. Each language has a default version, indicated by letters before the dash matching the

ones after the dash. For example fr-FR. If the default version’s dictionary is available, use

it.

3. Use the first dictionary (alphabetically) that begins with the content language. For

example, the content language is es-AR, but its dictionary does not exist. The first

dictionary alphabetically beginning with es that is available is es-CO, so use that.

4. If none of the above is available, use en-US.

List of Standard Dictionaries
eWebEdit400 provides the following standard dictionaries.

Code Language

uk-UA Afrikaans

ar-AR Arabic

bg-BG Bulgarian

cs-CZ Czech

da-DK Danish

de-CH German (Switzerland)]

de-DE German

en-GB English (Great Britain)

en-US English (United States)

es-ES Spanish

fr-FR French

he-IL Hebrew

it-IT Italian

nl-NL Dutch

nn-NO Norwegian (Nynorsk)
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Code Language

pl-PL Polish

pt-PT Portuguese

pt-BR Portuguese (Brazil)

ru-RU Russian

sl-SL Slovenian

sv-SE Swedish

uk-UA Ukrainian

Editing eWebEdit400’s Standard Spell Check
Dictionaries
The following topics explain how to access a screen for working with standard dictionaries,

and how to update, edit, replace, and delete individual words as well as entire dictionaries.

n "Accessing the Spell Check Dictionary Update Screen" on page 14-32

n "Adding a Word" on page 14-33

n "Deleting a Word" on page 14-34

Note: There is no option for editing a word. Instead of editing, delete a word then add the correct version.

n "Adding a Word List" on page 14-36

n "Importing a Dictionary" on page 14-37

n "Deleting a Dictionary" on page 14-38

n "Replacing a Dictionary " on page 14-39

Accessing the Spell Check Dictionary Update Screen
eWebEdit400 provides a special screen that allows you to create, update, and delete the

standard dictionaries. To access this screen, use this URL:

http://your server/site root

folder/workarea/contentdesigner/dictionaryconfigurator/dictionaryconfigurator.aspx

This screen looks like this.
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Note: If you want to remove the red text from the top of the screen, open the .aspx file and delete that text.

In order to use this screen. the ASP.NET user must be granted read and write permission to the

following folder: your server\site root folder\Workarea\Foundation\RadControls\Spell\TDF.

TIP!

Note: If ASP.NET user has full permission but you still cannot edit a dictionary, open the folder listed above, right

click the TDF file and verify it is not read-only.

Adding a Word
To add a word to any dictionary, follow these steps.

1. Open the Dictionary Update screen. See "Accessing the Spell Check Dictionary Update

Screen" on page 14-32.

2. Click Edit Dictionary.

3. At the Select Dictionary dropdown, choose the language of the dictionary you want to

update. ("List of Standard Dictionaries" on page 14-31 describes the codes on the list.)
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4. In the Add a word field in the lower right corner of the screen, enter the word to add.

5. Click the Add button.

Note: Tip! Enter the word you just added into the Find Word field and clickFind to verify that the word was

successfully added.

Deleting a Word
To delete a word from any dictionary, follow these steps.
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1. Open the Dictionary Update screen. See "Accessing the Spell Check Dictionary Update

Screen" on page 14-32.

2. Click Edit Dictionary.

3. At the Select Dictionary dropdown, choose the language of the dictionary you want to

update. (The "List of Standard Dictionaries" on page 14-31 describes the codes on the list.)

4. In the Find word field in the top left of the screen, enter the word to delete.
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5. Click the Find button.

6. In the results box below, click the word.

7. Click the Delete Selected button.

Note: Enter the deleted word into the Find Word field and clickFind to verify that the word wassuccessfully

removed.

Adding a Word List
You may add a list of words to a standard dictionary. For example, you work in a hospital and

want to add medical terms. While you can add words one at a time using "Adding a Word" on

page 14-33, it is more efficient to place all words in a text file then import the file into a

dictionary.

To add a list of words, follow these steps.

1. On your server, create a .txt file.

2. Place all words into the .txt file, one on each line.

3. Save the file using the language code of the dictionary you are updating. For example, if

you are adding to the French dictionary, name the file fr-fr.txt. See Also: "List of Standard

Dictionaries" on page 14-31

4. Open the Dictionary Configurator screen. See "Accessing the Spell Check Dictionary

Update Screen" on page 14-32.

5. Click Edit Dictionary.

6. Next to Import Wordlist, click Browse.

7. Navigate to the text file you saved in Step 3.

8. Click the Import button.

9. All words on the list are added to the dictionary whose name matches the .txt file. For

example, words in the fr-fr.txt file are added to the fr-FR.TDF dictionary file.
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Note: While on the screen, enter one of the words in the word list into the Find word field, then clickFind to verify

that the import succeeded.

Importing a Dictionary
Typically, you want to import a dictionary because the language of some Ektron

CMS400.NET content is not on the "List of Standard Dictionaries" on page 14-31. For

example, your content is Japanese.

You could also delete a standard dictionary then import one to replace it if you have a word

list that you consider superior to the standard dictionary. See Also: "Deleting a Dictionary" on

page 14-38.

To import a dictionary, follow these steps.

Note: The following procedure assumes the wordsdo not yet exist in a .TDF file. If theydo, open the Dictionary

Configurator screen, click the Browse button, select the file, and click Import.

Part one: Create a Blank TDF File

1. On your server, use Notepad to create a blank .tdf file named after the language code of

the dictionary you are importing. For example, if you are importing a French dictionary,

name the file fr-fr.tdf. See Also: "List of Standard Dictionaries" on page 14-31

2. Open the Dictionary Configurator screen. See "Accessing the Spell Check Dictionary

Update Screen" on page 14-32.

3. Next to the Pick a file to import field, click Browse.

4. Navigate to the .tdf file you created in Step 1.

5. Click the Import button. This action places the TDF file into the correct folder.

Part two: Create and Import the Word List

1. Follow the procedure described in "Adding a Word List" on page 14-36 to insert all

dictionary words into a .txt file.

2. Click Edit Dictionary.

3. Next to Import Wordlist, click Browse.
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4. Select the text file you created in Step 1.

5. Click the Import button.

6. All words in the list are added to the dictionary whose name matches the .txt file name.

TIP!

Note: Use the Edit dictionary screen to select the dictionary. Then, use the Find word field to verify that the import

succeeded.

Deleting a Dictionary
You would typically delete a standard dictionary in order to replace it if you have a word list

that you consider superior to the standard dictionary.

To delete dictionary, follow these steps.

1. Open the Dictionary Configurator screen. See "Accessing the Spell Check Dictionary

Update Screen" on page 14-32.

2. In the available dictionaries list, find the language whose dictionary you want to import.
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3. To the right of the language, click Delete.

Replacing a Dictionary
You would typically want to replace a standard dictionary if you have a word list that you

consider superior to the one provided. The procedure for replacing a dictionary is documented

in "Importing a Dictionary" on page 14-37.

Editing eWebEdit400’s Custom Dictionary
A language’s custom dictionary is created the first time a user uses the Add to Dictionary

option while spell checking content in that language.
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From then on, the dictionary is updated when anyone using that server edits content in that

language and uses the Add to Dictionary option.

How the Custom Dictionary is Named
The name of the custom dictionary is formed by stringing together

n the language code of the content

n a dash (-)

n the word custom

n the file extension .txt

So, if the content is French, the file’s name is fr-fr-custom.txt. The file is saved to the

root/Workarea/Foundation/RadControls/Spell/TDF folder.

Editing the Custom Dictionary
Edit the custom dictionary using any application that updates .txt files, such as Notepad.

Character Encoding
The following Ektron Knowledge Base articles describe issues surrounding the display of

special characters within Ektron CMS400.NET. Note that these articles refer to eWebEditPro,

Ektron’s WYSIWYG editor embedded within Ektron CMS400.NET.

Wherever these articles contain references to eWebEditPro’s configuration data or file

(config.xml), you should instead update the web.config file, located in your site’s root folder.

n HOWTO: produce UTF-8 (www.ektron.com/developers/ewebeditpro_tutorials.cfm?id=403)
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n INFO: Character Encoding (www.ektron.com/developers/ewebeditprokb.cfm?id=1807)

n INFO: Encoding special characters

(www.ektron.com/developers/ewebeditprokb.cfm?id=384)

Translating the Workarea
When Ektron CMS400.NET is delivered, the Workarea is in English. If you want to translate it

to another language, read this section.

Note: Ektron providesAmerican English strings in a text file. Youmust translate them.

Prerequisites

n The alphabetical, four-character identifier of the country/ language into which you are

translating. See CultureInfo Class from the MSDN Web site

(http://msdn2.microsoft.com/en-

us/library/system.globalization.cultureinfo(vs.71).aspx).

n The server that hosts Ektron CMS400.NET must have Visual Studio.NET

Procedure for Translating Workarea Strings

All Workarea text (that is, screen titles, Workarea menus, messages, alt text for buttons, etc.) is

stored in a resource file. Resource files are installed to the siteroot\Workarea\resources

directory.

Note: Workarea images that include text are stored in the workarea/images/language folder. For example,

Workarea\images\french_standard.

Ektron CMS400.NET provides a resource files for the following languages. The English

resource file is complete. The others are partially complete.

n German

n English (United States)

n Spanish

n French

n Italian

n Dutch - Netherlands
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n Dutch - Belgium

Regardless of the list above, to translate your Workarea, translate the English file into the

desired language.

Procedure Overview
A resource file is not human-readable. To make it so, use Microsoft’s resgen utility. Next,

translate the human-readable, .txt version of the file. Here is a portion of it.

add menu title=Add Menu
lbl ad serverip=Domain Controller IP
alt: remove collection items text=Click here to remove items from this collection

Notice that, for each string in the file, an English description appears first. The description

includes information about where the text appears. For example, btn text appears on a button.

Next is an equal sign (=), then English text.

Translate the text to the right of the equal sign. You can send the file to an agency or do it

yourself.

Then, run the resgen utility on the .txt file again, indicating the translate-to language. This

converts the file back to a machine-readable format. Finally, move that file to the appropriate

language folder under workarea/images, and enable the new language in the Workarea.

Step by Step Instructions
To perform this procedure, follow these steps.

1. The resgen.exe utility is located in C:\Program Files\Microsoft Visual Studio

8\SDK\v2.0\Bin. Copy it to the your web site\Workarea\resources folder.

2. Go to Windows Start button > Microsoft Visual Studio 2005 > Visual Studio Tools >

Visual Studio 2005 Command Prompt to open a command window.
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3. Within the command window, change the directory to the your web

site\Workarea\resources folder. For example, cd

C:\Inetpub\wwwroot\CMS400Min\Workarea\resources.

4. Insert the following text: resgen EKResource.en-US.resources anyfilename.txt

Note: You can assign anyname to the .txt file.

5. A .txt file of resource strings converted to a human-readable format is created in the

resources directory. (You assigned its name in Step 4.) Open the file.

6. Replace any single backslashes (\) with a double backslash (\\).

7. Translate the text following every equal sign (=). Be careful not to change any

occurrences of n surrounded by double backslashes (\\n\\).

Note: You can send the file to a translation house or translate the strings yourself.

8. Save and close the .txt file.

9. Open the command window (as described in Step 2) and insert the following: resgen

anyfilename.txt EKResource.two-character country code-two-character language
code.resources

Replace anyfilename.txt with the file you named in Step 4. In this example, the .txt file

is named span_translation.txt.

For example, to indicate that the Workarea is being translated into the Spanish/Spain,

enter resgen.exe span_translation.txt EKResource.es-ES.resources.

When the conversion is complete,Writing Resource File ...Done appears in the command

window.

10. The Workarea\resources folder includes several resource files. If one exists for the

translate-to language, it is overwritten. If one does not exist, it is created.

To follow our example, the EkResource.es-ES.resources file was updated with changes

you made in Step 7.

11. Move the updated resource file to the appropriate language folder under Workarea/images.

To continue our example, move the file to the Workarea/images/spanish_traditional_Sort

folder.

If a folder does not exist for the new language, create one under Workarea/images.

12. Enable the new language in the Language Settings screen. See "Determining Which

Languages are Available" on page 14-5

13. Make the new language the default language in the Configuration Setup screen. See See

"Updating Setup Information" on page 19-3"Fields on the Application Setup Screen:

Workarea Tab" on page 19-7.
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LanguageAPI Server Control
The LanguageAPI server control lets a developer force a particular language for a Web site.

You can do this by dropping the server control on the page and setting a language in the

SiteLanguage property box. You can also override site language logic by programmatically

using the LanguageAPI server control to detect the browser’s language, and display the site in

that language.

This subsection contains the following topics:

n "LanguageSelect Server Control vs. LanguageAPI Server Control" on page 14-44

n "LanguageAPI Server Control Properties" on page 14-44

n "Code Behind Only Properties and Methods" on page 14-45

LanguageSelect Server Control vs. LanguageAPI
Server Control
The LanguageSelect server control lets users view your site in the language they choose. The

LanguageAPI server control, on the other hand, forces users to view a site in a particular

language. For information on LanguageSelect, see "LanguageSelect Server Control" on page

14-46.

LanguageAPI Server Control Properties
The LanguageAPI server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value
Data

Type

SiteLanguage
Sets the site language. Runs through the IsValid function to verify

that the language is an active language in the system.
String

SiteLanguageID
Numeric value of the site language. This is the property you will

use if you are using code behind to set the sites language ID. Integer

Working with Multi-Language Content

14-44
ReferenceManual

Version 8.0 Rev 1.3



Property Value
Data

Type

Example: 1036 =French

For a list of supported languages, go to Ektron CMS400.NET

Workarea >Settings>Configuration > Language Settings.

Code Behind Only Properties and Methods
The following is a list of LanguageAPI specific properties and methods that can only be used

programmatically.

Property Value
Data

Type

CurrentLanguage Read only. Returns the current language. String

CurrentLanguageID Read only. Returns the current language ID. Integer

DefaultLanguage

Read only. What the default language of the

site is set to. For example, the demo site is

“English (Standard)”.

String

DefaultLanguageID

Read only. Returns the value that is the

default language ID of the site. For example,

the demo site is “1033” for English.

Integer

GetLanguage
Thismethod returnsa string. Pass in a valid language ID

and it will return the language name.

Integer

Argument

GetLanguageID
Thismethod returnsan integer. Pass in a valid language

name and it will return the language ID.

String

Argument

IsValid

Thismethod returnsa boolean. You can pass in a

language ID or a string and it will tell you if the system is

supporting it.

Argument

LanguageIdList

Read only. Lists all the language IDs that are activated

in Ektron CMS400.NET.

For information on how to enable languages, see

"DeterminingWhich Languagesare Available" on page

14-5.

Arrayof

Integers

LanguageTitleList
Read only. Lists all the languages that are activated in

Ektron CMS400.NET.

Arrayof

Strings
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Property Value
Data

Type

MultiLanguageEnabled

Read only. Tells if the site supports multi-

language mode.

True = Multi-language enabled

False = Multi-language not enabled

Multi-language is enabled bydefault. To disable it, see

"Enabling/Disabling Support for Multiple Language

Content" on page 14-4.

Boolean

Using the LanguageAPI Server Control
Programmatically
This example uses a logo that is not managed through Ektron CMS400.NET. It retrieves the

current language from the LanguageAPI control, and uses that information to choose the logo

version to display. The codebehind looks like this.

Select Case LanguageAPI1.CurrentLanguageID

Case 1031

Image1.ImageUrl = "germanlogo.gif"

Case 1033

Image1.ImageUrl = "englishlogo.gif"

Case 1036

Image1.ImageUrl = "frenchlogo.gif"

End Select

LanguageSelect Server Control
The LanguageSelect server control displays a language selection dropdown list on an Ektron

CMS400.NET Web page.

This control lets a site visitor select a language in which to view the site. Here is what the

control looks like when published on a Web page.
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It lists all languages selected on the Settings > Configuration > Language settings screen.

(For more information, see Multi-Language Support.)

You can place this control in any location of any page on your site. On the sample site, it

appears in the lower left corner of the home page.

This subsection contains the following topics:

n "LanguageSelect Server Control vs. LanguageAPI Server Control" on page 14-47

n "LanguageSelect Server Control Properties" on page 14-47

LanguageSelect Server Control vs. LanguageAPI
Server Control
The LanguageSelect server control lets users view your site in the language they choose. The

LanguageAPI server control, on the other hand, forces users to view a site in a particular

language. For information on LanguageAPI, see "LanguageAPI Server Control" on page 14-44.

LanguageSelect Server Control Properties
The following table explains the properties of the LanguageSelect control.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value
Data

Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can

use it to browse to Content, Collections, etc.See Also:
String
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Property Value
Data

Type

"Using CMSExplorer to Browse Your Ektron

CMS400.NET Site" on page 21-9

Hide

Used to hide language select dropdown boxand label in

design time and run time.

True =Hide language select dropdown boxand label

False =Show language select dropdown boxand label

Boolean

LabelName
Lets you define the label next to the language select

dropdown box.
String

Language

Set a language for the Language Select Box. This

property shows results in design-time (in VisualStudio)

and at run-time (in a browser).

Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the

control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line

portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply

attributes to a blockof code.

Custom - Allows you to use a custom tag.

String
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Introduction
Users are people who administer the Web site, create content, or publish content. Without

users, the Web site would be blank. In Ektron CMS400.NET, you can add, edit, and delete

users to and from the application through the Settings folder in the Workarea.

Every Ektron CMS400.NET user belongs to a User Group. User groups are used when creating

permissions and an approval chain for content folders. User groups can be departments in your

company (Human Resources, Sales, Engineering) or indicate a user’s role (Publishers,

Administrators, Editors, etc.).

Warning! If your system uses the Active Directory Integration Feature, proceed to "Active DirectoryFeature" on

page 15-48 to learn about user management functions. This chapter only applies to systems that do not use Active

Directory Integration.

Warning! If your system usesLDAPAuthentication, proceed to "LDAPAuthentication" on page 15-94. Some func-

tionality in this chapter doesapply to LDAP. The LDAP chapter explainswhich information is applied.

This section explains the most common actions that you will perform on users and user groups.

These actions include:

n "Accessing the Users and User Groups Folders" on page 15-2

n "Custom User Properties" on page 15-12

n "Viewing a User" on page 15-10

n "Editing a User" on page 15-10

n "Deleting a User" on page 15-11

n "Creating a New User" on page 15-3

Note: Onlymembersof the AdministratorsUser Group and those defined in theManageMembers for Role: User

Admin screen can view, add, or edit users and user groups.

Accessing the Users and User Groups
Folders
All user and user group information is accessible from the Workarea.
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Accessing the User Folder

To access the user folder in Ektron CMS400.NET, follow these steps.

1. Access the Workarea > Settings > Users.

2. All Ektron CMS400.NET users appear.

From this screen, you can add, edit, and delete users. These procedures are explained in the

next sections.

Accessing the User Group Folder

To access the user group folder in Ektron CMS400.NET, follow these steps.

1. Access the Workarea > Settings > User Groups.

2. All user groups appear.

From this screen, you can add, edit, and delete user groups. These procedures are explained in

the next sections.

Managing Users
Warning! If you are using Active Directory to Manage users, see "Associating User Information in AD with Ektron

CMS400.NET" on page 15-61.

The following topics explain how to manage users.

n "Creating a New User" on page 15-3

n "Viewing a User" on page 15-10

n "Editing a User" on page 15-10

n "Deleting a User" on page 15-11

Creating a New User
Warning! If you are using Active Directory to add a new user, see "ManuallyAdding AD User Information to

Ektron CMS400.NET" on page 15-62. If you are using LDAP, see "Adding User Information from an LDAPServer

to Ektron CMS400.NET" on page 15-99.

Before you can assign a user to a user group, you must add the user to the system. To create a

new user, follow these steps.
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1. Access the User folder, as described in "Accessing the Users and User Groups Folders" on

page 15-2.

2. Click the Add User button ( ).

3. The Add a New User to the System screen appears.

4. Enter the following information about the user.

Note: Adminstratorsgroupmembers can edit all fields for anyuser. Non-admin users can edit their own profiles

only, and only fields indicated in theEditable by non-admin users column below.

Field Description

Editable

by non-

admin

user

General Tab (Tabs only appear when editing)

Username Insert a username for the user you want to create.

Organization

Organizational

Unit

Domain

These fields are only available when using LDAPAuthentication. See

Also: "Adding User Information from an LDAPServer to Ektron

CMS400.NET" on page 15-99.

First Name Enter the first name of the user.

Last Name Enter the last name of the user.

DisplayName

The name that is used to identify a user in theWorkarea and on theWeb

site. This can be different from the Username, which is the name used

to log in.

Warning! Important: This name needs to be unique inside

CMS400.NET and it cannot be blank.

Password
Enter a password for the user. See Also: "PasswordManagement" on

page 3-12.

Confirm

Password
Confirm the password by typing it again.

Managing Users and User Groups
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Field Description

Editable

by non-

admin

user

User

Language

Select the language in which the user will viewEktron
CMS400.NET screensandmessages. The language also

determines the default value whenever a drop-down list of languages

appearswithin Ektron CMS400.NET.

The dropdown list is derived from the Language Settings screen,

available from theSettings > Configuration folder.

Do not confuse the system language with the user’s ability to create and

edit foreign editionsof content. This field doesnot prevent a user from

working with multiple language content.

See Also: Multi-Language Support

Note: If the selected language is not English, French or German, it is

only supported after you download the Ektron CMS400.NET Language

Support Program fromEktron and translate theWeb site.

Email Address

Enter the email addressof the user. Notification email is sent to this

addressunless theDisable E-mail Notification field is checked. Also,

this address identifies the user sending Instant email. See Also: "Instant

eMail" on page 1-91

Content and

ForumEditor

Determineswhich editor will be used when this user

n replies to a Discussion Board. See Also: "Using Discussion Boards

on Your Web Site" on page 7-646

n edits content from the Ektron CMS400.NET Workarea or after

signing into your Web site if the user is operating aWindowscomputer

and the system administrator has set UserPreferred as the value of

the web.config file’sek_EditControlWin key. See Also: "Setting the

Editor for Ektron CMS400.NET Users" on page 7-21

Your choicesare eWebEditPro and eWebEdit400. See Also: "Ektron

CMS400.NET Editors" on page 7-20
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Field Description

Editable

by non-

admin

user

Avatar

An image or icon to represent you in the Forum.

Type in a web path to image. For example:

http://www.example.com/smileyface.gif

Bydefault, themaximum file size of an avatar is limited to 200 kilobytes

and the height and width of the avatar will be reduced 125 pixels

preserving the aspect ratio.

To change the file size limit, edit this file:

C:\inetpub\<wwwroot>\<YourSite>\Workarea\Upload.aspx.vb

In this file, change the line shown below to the size file you wish to allow.

For example, to allow 500kb files, change 200 to 500.

If (numFileSize > 200) Then

Remember, this number is in kilobytes.

To change the default height and width of the avatar, edit this file:

C:\intetpub\wwwroot\<YourSite>\App_

Code\VBCode\Utilities.vb

In this file, change the following lines to the size you wish to allow. For

example, to make avatars have a height and width of 166 pixels, change

125 to 166 in both these lines.

Dim Width As Integer = 125
Dim Height As Integer = 125

Disable

Receiving of

System

Notification

Email

Select to disable the email notifications for the user. If you do, the user

doesnot receive the automatic email notification described in

"Automatic eMailNotification" on page 1-86. However, this field hasno

effect on the user’s ability to receive instant email.

Address
Enter the addressused to find this user’s location when a search based

on location is being performed.
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Field Description

Editable

by non-

admin

user

Latitude

The latitude used to find this user’s location when someone performsa

search based on location.

Googlemapsprovidesa service that takes the addressof user and

returns its latitude and longitude.

Note: You don’t need to useGoogle’s automatic retrieval of latitude and

longitude. Instead, you can enter the valuesmanually.

Longitude

The longitude used to find your location when a user is performing a

search based on location.

Googlemapsprovidesa service that takes the addressof content and

returns its latitude and longitude.

Note: You don’t need to useGoogle’s automatic retrieval of latitude and

longitude. Instead, you can enter the valuesmanually.

Forum

Signature

Addsa signature to this user’s posts in the forum. The user doesnot see

the signature in the editor. It is added after he clicks the Post button.

Tags

Select from a predefined list of Tags that describe yourself. Or, create a

new tag by clicking theClick To Add A NewTag link. Placing a check

mark in the checkboxnext to a tag activates it for your profile. See Also:

"Tags" on page 16-228

Workarea Tab (Tabs only appear when editing)

Full Screen

When a checkmarkappears in this checkbox, theWorkarea opensup

to the size of the full screen. In addition, theWidth and Height options

are hidden.

Width

If desired, change the width of the screen in which Ektron CMS400.NET

appears for this user. The width in pixelsmust be between 400 and

2400.

This field accommodatesuserswho have larger monitors and/or prefer

a smaller resolution, such as1280 x1024.

If a checkmarkappears in the Full Screen checkbox, this option is

hidden.

Height

If desired, you can change the height of the screen in which Ektron

CMS400.NET appears for this user. The height in pixelsmust be

between 300 and 1800.

This field accommodatesuserswho have larger monitors and/or prefer

a smaller resolution, such as1280 x1024.

If a checkmarkappears in the Full Screen checkbox, this option is

hidden.
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Field Description

Editable

by non-

admin

user

Display button

caption in the

title bar

Check this box if you want anybutton’s caption text to appear in the

screen title’s bar whenever a user moves themouse over the button.

Note the wordPublish, describing the button, in the illustration below.

If you do not check this box, the screen’s title remains in the title bar

when the user moves themouse over the button, as illustrated below.

Landing Page

after login

If you want one page in your Web site to appear after this user signs in,

enter that page’sURL. Youmight select a page that leads to a group of

pages that youmaintain.

If you don’t know the URL, navigate to the page, go to the browser

addressbar and select the text following the directory in which Ektron

CMS400.NET resides. For example, if the browser addressbar says

http://www.example.com/customers.aspx?id=945, enter

customers.aspx?id=945.

Set smart

desktop as the

start location

in the

Workarea

If you want the Smart Desktop to appear as soon as this user enters the

Workarea, click inside this checkbox.

See Also: "Personalizing the Smart Desktop" on page 4-4

If you leave this checkboxblank, when this user enters theWorkarea,

he goes to the folder of the content specified at the Landing Page

after login field.

Inherit Task

Permissions

FromUser

Groups

This area indicates your taskpermissionsand whether you inherit them

from user groups to which you belong.

For more information, see "TaskPermissions" on page 11-3.

Custom Tab

Anycustom

user

properties

See "CustomUser Properties" on page 15-12
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Field Description

Editable

by non-

admin

user

Activities Tab (Tabs only appear when editing)

Note: Note: If you disable Notifications, theActivities tab (which lets the user pickNotifications to

receive and send) disappears.

Colleagues

Sub Tab

Select the notifications you want to receive when a colleague performs

an activity, and the agent that transmits the notification. For example, if

you want to receive email notificationswhen a colleague posts a blog

message, you would place a checkmark in the box for Blog Post in the

email column. See Also: "Notifications" on page 16-129

GroupsSub

Tab

Select notifications you want to receive when amember of a community

group performsan activity relating to the group, the agent that transmits

the notification.

For example, you want to receive email notificationswhen a co-member

of a community group posts a blogmessage to group’s blog. To enable

this, would place a checkmark in the box for Group Blog Post in the

email column.

See Also: "Notifications" on page 16-129

This tab sets preferences for all community groups.

For Developers: Ektron has created a UserGroupPreferencesuser

control that a you can add to a community group’s profile page that

allowsusers to specify notification preferences for individual groups.

This control comeswith CMS400.NET and is located in:

[Drive:]

\[webroot]\[siteroot]\Workarea\Notifications\Controls

To see this user control in an example site, download Ektron’s

eIntranet starter site.

http://www.ektron.com/cms400-web-cms.aspx?id=5748

In this site, when a logged inmember of a community group accesses

his group’s profile page, there is an Edit Group Notifications

Preferences link. Clicking this link opensa thick boxwhich contains the

user control. When the user selects his preferences, theyare stored for

that group only.

PrivacySub

Tab

Select notifications you want publish when performing variousactivities

on theWeb site. For example, if you want to publish notificationswhen

you posts a blogmessage to your blog, place a checkmark in the box for

Blog Post in thePublish column.

See Also: "Notifications" on page 16-129
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Note: If email notification is turned off in the setup page, you are notified when editing, adding, or viewing a user.

5. Click the Save button ( ).

6. The View Users in Group Everyone screen appears with the new user included in the

table.

Note: When you add a new user, he is automatically placed in the Everyone user group. To assign users to other

groups, see "Assigning UsersTo User Groups" on page 15-30.

7. Continue this process until you add all users of your Web site, or are allowed to

depending on your license.

Note: Contact Ektron Sales for pricing of addingmore users to your license.

Viewing a User
After adding a user, you can view that information. While viewing a user, you can edit or

delete the user.

To view a user, follow these steps.

1. Access the user folder as described in "Accessing the User Folder" on page 15-3.

2. Click the Username of the user you want to view.

3. The View User Information screen is displayed.

To learn about the fields, see "Enter the following information about the user." on page 15-

4.

From the View User screen, you can edit or delete users. These actions are described in the

next sections.

Editing a User
Warning! If you are using Active Directory to edit a user, see "Editing User Information in Ektron CMS400.NET"

on page 15-81.

When editing a user, you can change the username, first name, last name, password, user

language, and email address. Also, while editing, you can change three fields that were not

available when the user was created.

n Account Locked

n Work Page Size

n Landing Page after login

To edit a user, follow these steps.

1. Access the view user screen of the user you want to edit as described in "Viewing a User"

on page 15-10.
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2. Click the Username of the user you want to edit.

3. The View User Information screen is displayed.

4. Click the Edit button ( ).

5. The Edit User screen is displayed. To learn about most fields, see "Enter the following

information about the user." on page 15-4.

The following fields are only available when editing a user.

.

Field Description

Account

Locked
See "Restricting Login Attempts" on page 3-9

Content and

ForumEditor
See "Content and ForumEditor" on page 15-5

Forum

Signature

Addsa signature to your posts in the forum. You do not see the signature in

the editor. It is added after you click the Post button.

WorkPage

Size
See ”Workarea Page Size” on page 19-8

Landing Page

after login
See "Landing Page after login" on page 15-11

6. Make the necessary changes to the user information.

7. Click the Update button ( ).

Deleting a User
Warning! If you are using Active Directory to delete a user, see "Deleting Users" on page 15-81.

When you need to remove a user from the application, you can easily do it from the User’s

Folder in the Workarea.

Warning! Once a user is deleted from the database, he is deleted permanently. The process cannot be undone.
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To delete a user, follow these steps.

1. Access the view user screen for the user you want to delete, as described in "Viewing a

User" on page 15-10.

2. Click the Username of the user you want to delete.

3. The View User Information screen is displayed.

4. Click the Delete button ( ).

5. A confirmation message is displayed.

6. Click OK.

Removing Users from User Groups
Warning! If you are using Active Directory to remove a user from a group, see "Removing Users from aGroup"

on page 15-59.

Note: Removing a user from a user group doesnot delete the user fromEktron CMS400.NET. Also, you cannot

remove users from the Everyone group.

To remove a user from a user group, follow these steps.

1. Access the User Groups folder, as described in "Accessing the Users and User Groups

Folders" on page 15-2.

2. Click the User Group that includes the user you want to remove.

3. Members of the selected group appear.

4. Click the user to remove.

5. The View User Information screen is displayed.

6. Click the Delete button ( ) to delete the user from the group.

7. A confirmation message is displayed. Click OK.

Custom User Properties
Custom User Properties allow you to create custom fields. These custom fields appear on the

User Properties and Membership User Properties screens, and on the Membership server control.

They are used to define information about a user beyond the standard Ektron CMS400.NET

user properties, such as Username, First Name, Password and email Address.

Examples of Custom User Properties might be:

n employee ID

n phone number

n phone extension
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n instant message screen name

n position

n start date

n department

n birthday

n the IP address of the user’s machine

Your ability to create and manage custom user properties is explained through the following

topics.

n "The View Custom Properties Screen" on page 15-13

n "Adding a Custom User Property" on page 15-14

n "Editing Custom User Properties" on page 15-23

n "Deleting a Custom User Property" on page 15-24

n "Setting the Custom User Properties Order" on page 15-24

n "Using Custom User Properties for Non-English Languages" on page 15-26

Note: Onlymembersof the Administrator User Group can workwith CustomUser Properties.

The View Custom Properties Screen
Use the View Custom Properties screen to create custom properties for users and membership

users. From the View Custom Properties screen, you can:

n add a new custom property. See "Adding a Custom User Property" on page 15-14

n edit a custom property. See "Editing Custom User Properties" on page 15-23

n reorder the way custom properties appear on the users and membership users screen. See

"Setting the Custom User Properties Order" on page 15-24

n work with custom properties in different languages. See "Using Custom User Properties for

Non-English Languages" on page 15-26

Below is an example of the View Custom Properties screen.
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The table below describes the View Custom Properties screen.

Buttons, Dropdown

Boxes or Fields
Description

For More

Information

Add button ( ) Add custom user properties.

"Adding a

CustomUser

Property" on

page 15-14

Reorder button ( )

Change the order in which the custom

properties appear on the Users or Membership

User Properties screen.

"Setting the

CustomUser

Properties

Order" on

page 15-24

Language Selection

Dropdown List (

)

Allowsyou to view custom user properties by

language.

"Viewing

CustomUser

PropertiesBy

Language" on

page 15-28

Title Field

Displays the title of a custom user property.

When viewing by language, the title changes to

the title used in a specific language if it hasbeen

defined. Click a Title to edit the property.

Note: The title and label are the same field. On

some screens, Title is used; on othersLabel is

used.

"Editing

CustomUser

Properties" on

page 15-23

Type Field
Shows the Type that was chosen for a custom

user property.

"Type" on

page 15-16
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Adding a Custom User Property
After you add a custom user property, it appears on all User and Membership User Information

screens, under the Custom Tab. When new users and membership users are added, custom user

properties appear during the creation process.

Follow these steps to add a custom user property.

1. In the Workarea, click Settings > Configuration > User Properties > User Properties.

2. Choose the standard language used in your Ektron CMS400.NET Workarea.

3. Click the Add Property button ( ).

4. The Add Custom Property screen appears.

5. Complete the screen according to the table below.
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The Custom User Properties Fields
The following table describes the custom user properties fields

Field Description
More

Information

Label

Title of the property you are adding. For example, Employee ID.

Note: The Title and Label are the same field. On some screens

the word Title is used, on others the word Label is used.

Type

The property’s data type. Once a type is selected and saved, you

cannot change it. Youmust delete the custom property and re-

enter it.

"The Type

Field" on

page 15-16

Input

Type
Choose how a user is able to enter a response to the property.

"The Input

Type Field"

on page 15-

18

Validation Ensures the right type of data is entered in a text boxor text area.

"Validation"

on page 15-

18

Min Value

If desired, enter theminimum value you want to allow. TheMin

Value only appearswhen the following Validationsare used:

NumericOnly, Date Only and U.S. Zip Code.

The following is an example of a Date OnlyMin Value:

01/01/1900.

Max

Value

If desired, enter themaximum value you want to allow. TheMax

Value only appearswhen the following Validationsare used:

NumericOnly, Date Only and U.S. Zip Code.

The following is an example of a Date OnlyMaxValue:

01/01/1987.

Message

Amessage that appearswhen information entered in a user

property violates the validation criteria.

For example, if the validation isU.S. Zip Code, youmight use the

followingmessage:Please enter a valid zip code

6. Click the Save button ( ).

7. The new property appears on the View Custom Properties screen.
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The Type Field
The following table describes the types available in the Type field.

Types Description

Input

Types

Available

Validations

Available

String
Accepts all alpha, numeric, and

symbol characters

n Text

Box

n Text

Area

n Hid-

den

All validations

See Also:

"Validation" on page

15-18

Boolean
Accepts a true or false

response
n Check

Box
None

Numeric Accepts numbers only n Text

Box

n NoValidation

n Cannot be

blank

n NumericOnly

n U.S. Zip Code

n Dollar Amount

Date Only a date can be entered. n Text

Box

n NoValidation

n Cannot be

blank

n Date Only

SelectList

Select a response from a list of

choices.

See Also: "SelectList Field" on

page 15-20

NA NA

Multi

SelectList

Select anynumber of

responses from a list of

choices. See Also:

"MultiSelectList Field" on page

15-22

NA NA
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Types Description

Input

Types

Available

Validations

Available

Category

A system-defined type that

appearswhen the first

subscription is created. One

entry covers all subscriptions.

See Also: "Defining

Subscriptions" on page 20-18.

NA NA

The Input Type Field
The following table describes possible responses to the Input Type field.

Input

Type
Description

An

Option

When

Used

With

Text

Box

Createsa standard text box. Below is an example of a text box.

n
String

n
Numeric

n Date

Text

Area

Createsamulti-lined area for entering text. Typically used whenmore

than one line of text needs to be added. Below is an example.
n
String

Hidden

Hides the input field. This can be used byan administrator to add

additional valuesat postback time. This requires a developer to add

client-side JavaScript.

Note: If you change a String field’s Input Type from Text Box or

Text Area toHidden, then sign in asamember of the Administrators

group, the field and its value still appear on the user’s profile.

n
String

Check

Box

Createsa checkbox. Used when the field requires a boolean (true /

false) response. Below is an example of a checkbox.

= True =False

n Bool-

ean
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Validation
The following table describes the validations available in the Validation field.

Validation Description

An

Option

When

Used

With

No Validation The entry is not checked.

n
String

n
Numeric

n Date

Cannot be

blank
A responsemust be entered.

n
String

n
Numeric

n Date

Numeric Only The responsemust be a number.

n
String

n
Numeric

Text Only The responsemust be characters. n
String

Date Only
The responsemust be entered in the following format:

mm/dd/yyyy.

n
String

n Date

Email Only
The responsemust be entered asan Email address. For

example, username@domain.domainextention.
n
String

Credit Card

Only

The responsemust be entered asa credit card number.

For example, nnnn nnnn nnnn nnnn
n
String

Social Security

Only

The responsemust consist of nine digits in this pattern: nnn-

nn-nnnn.
n
String
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Validation Description

An

Option

When

Used

With

U.S. State

Code

A two letter state code. For example: NH =New

Hampshire.
n
String.

U.S. Zip Code

The responsemust consist of 5 (nnnnn) or 9 digits

separated bya dash after the fifth (nnnnn-nnnn).

Note: If you use the Numeric Type, you cannot have a dash

or space when using a nine digit Zip Code

n
String

n
Numeric

Valid US Phone

Number

The responsemust consist of a 10 digits in this pattern: nnn-

nnn-nnnn.
n
String

Canadian

Postal Code

The responsemust consist of 6 (xnxnxn) alpha or numeric

characterswith a space after the first three characters.
n
String

Time HH:MM

or HH:MM:SS

or

HH:MM:SS.mm

Time is entered in one of the following three formats.

HH:MM - Hours andMinutes09:30

HH:MM:SS - Hours, Minutesand Seconds09:30:45

HH:MM:SS.mm - Hours, Minutes, Secondsand

milliseconds09:30:45.002

n
String

IP Address The responsemust be in the form of an IP address. n
String

Dollar Amount

This validation worksdifferently depending on the Type

used. If used with theString Type, you can have a dollar

sign ($) along with themoneyamount in the text field.

When used with theNumericType, you are not allowed to

have a dollar sign ($) in the text field. The following are

examplesof each type with validation:

String - $3.00

Numeric - 3.00

n
String

n
Numeric

Canadian

Social

Insurance

Number

The responsemust consist of nine digits in this pattern (nnn

nnn nnn).
n
String
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SelectList Field
Use a SelectList field to present the user completing the User Information or Membership User

Properties screen with a list of choices. See example below.

When you create a custom user property and specify its type to be Select List, the screen

changes as shown below.

Completing a SelectList Field Entry

To add an item to the list, enter its text in the Text field, then click the Add button. Added

items then appear in the larger box on the left.

You can then

n remove any item from the list by clicking it. It appears in the Text field. Click Remove.

n change the text of any list item by clicking it. It appears in the Text field. Make changes

then click Change.

n change the sequence of list items by selecting an item then clicking the up or down arrow

to move the item
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Using the First List Item to Prompt a Response

You can use the first list item to prompt the user to make a selection instead of being a valid

response. For example, the first list item may say Select from a list of choices. To do this,

check the First item is not a valid selection for example, “[Select]” check box.

If you do, the field has an asterisk (*) next to it (indicating it is required) on the User

Information and Membership User Properties screens. The user completing the screen must

choose any selection other than the first item. If he tries to file the screen without choosing a

different item, the following error message appears:

Please fill in all required fields (*)

MultiSelectList Field
Use a MultiSelectList field to present the user completing the User Information or Membership

User Properties screen with a list of choices. The user can choose as many responses as

appropriate. See example below.

Selected items are indicated by a blue background.

When you create a custom user property and specify its type to be MultiSelect List, the screen

changes as shown below.
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For information about completing the screen, see "Completing a SelectList Field Entry" on

page 15-21.

Features Field
This field is automatically included in the User or Member profile Custom Tab. The field

included in this section is provided to allow the profile owner to edit events on a web

calendar. Once this is checked, it cannot be unchecked.

For more information about Web Calendar, See Also: "Adding Web Calendar Events" on page

7-562.

Time Zone Field
The Time Zone property field is a special field used by the Web Calender feature.

Select the time zone of the User or Member here. When they are logged in, appointment times

will show in this time zone. For more information, See Also: "Adding Web Calendar Events"

on page 7-562.

Editing Custom User Properties
When you click a custom user property’s title, you are brought to the Edit Custom Property

Screen. From this screen, you can edit and delete a custom property or create a version of the

custom property in a non-English language.
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When you edit a custom user property, the changes are applied to all users and membership

users. These changes are also applied to any other language versions of the custom properties

that exist.

To learn how to:

n edit a custom user property. See "Editing a Custom User Property" on page 15-23.

n delete a custom property. See "Deleting a Custom User Property" on page 15-24.

n create a custom property for a non-English language. See "Create a Custom User Property

for a Non-English Language" on page 15-26.

Editing a Custom User Property

When editing a custom user property, the changes are available to users and membership users

when the save button is clicked.

Follow these steps to edit a custom user property.

1. In the Workarea, click Settings > Configuration > User Properties > User Properties.

2. Click the Title of the Custom User Property you want to edit.

3. Choose the field you want to change. You can edit the following fields:

n Label

n Input Type

n Validation

n Min Value

n Max Value

n Message

For descriptions of these fields, see "The Custom User Properties Fields" on page 15-15.

Note: You cannot edit the Type field. If you need to change the type, youmust delete the custom user property

and create a new one.

Warning! If you delete a custom user property, it is removed from all users andmembership users. Any infor-

mation that hasbeen collected about users andmembership users for that propertywill be lost. In addition, any lan-

guage versionsof the custom user property are deleted.

4. Click the Save button ( ).

5. When you click a user or membership user, you see your changes.
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Deleting a Custom User Property
If you delete a custom user property, it is removed from all users and membership users. Any

information that has been collected about users and membership users for that property will be

lost. In addition, any language versions of the custom user property are deleted.

Follow these steps to delete a custom user property.

1. In the Workarea, click Settings > Configuration > User Properties > User Properties.

2. Click the Title of the custom user property you want to delete.

3. Click the Delete button ( ).

4. A dialog box appears asking if you are sure you would like to delete the item.

5. Click OK.

6. The View Custom Properties screen appears, and the property is no longer available.

Setting the Custom User Properties Order
From the View Custom Properties screen, you can set the order in which the properties appear

on the User and Membership Users Properties screen. To set the custom user properties order,

complete these steps.

1. In the Workarea, click Settings > Configuration > User Properties > User Properties.

2. Click the Reorder button ( ).

3. The Reorder Custom Properties screen appears.

4. Click a property.

5. Click the Up or Down arrows to move the property up or down the list.

6. Click the Save button ( ).
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7. On the View Custom Properties screen, you now see the properties in the new order. If you

go to the User or Membership User Properties screen, the order of the properties there now

reflects the changes.

Using Custom User Properties for Non-English
Languages
Like content, custom user properties have a language attribute. This is useful if you have users

or membership users that only use a specific language. It can also be used if you want a custom

user property to appear in the language in which the user is signed in.

Unless a language other than English is defined for a custom user property, the property

defaults to the English version. For example, if you have two properties called Birthday and
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Phone Number in English and you can translate the French version of Birthday to

Anniversaire, when you view the properties in French, you see the English version of Phone

Number and the French version of Birthday.

Create a Custom User Property for a Non-English Language
When creating a custom user property, it must be created in English then translated to the

desired language. This is done by editing the property, changing languages, filling out the

Translate Custom Property Label screen and saving the property.

Warning! All custom user properties in languagesother than English are tied to the English version of the prop-

erty. If you delete the English version of the property, all other language versionsof the properties are deleted

also. However, you can remove a non-English language version of the custom propertieswithout deleting the Eng-

lish version. See "Removing a Non-English CustomUser Property Title" on page 15-27

The following steps illustrate how to translate the Title/Label of a property into French.

1. In the Workarea, click Settings > Configuration > User Properties > User Properties.

2. Choose a custom property to be defined in another language.

3. Choose a language from the language select dropdown box.

4. The Translate Custom Property Label screen appears.

5. Enter a Label for the property in the language you have chosen. For example, if you are

creating a French version of a Birthday custom user property, you would enter

Anniversaire in the label text field. For information on the Label property, see "Label" on

page 15-16

6. Click the Save button ( ).

Removing a Non-English Custom User Property Title
Removing a non-English version of a custom user property title does not remove the english

version of the property. When you remove the non-English version of a property, you are

basically removing the label for that specific language in the custom property.

1. In the Workarea, click Settings > Configuration > User Properties > User Properties.

2. Choose the language in which the custom user property appears from the Language

Dropdown Box.
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3. Click the Title you want to delete.

4. The Translate Custom Property Label screen appears.

5. Click the Delete button ( ).

6. A dialog box appears asking if you would like to remove the translated custom property

title.

7. Click OK.

8. The English version of the Edit Custom Property screen appears.

9. Click the Back button ( ).

Warning! Do not click the delete button on the Edit CustomProperty screen. This action deletes the English ver-

sion of the custom user property. If you click the delete button, you lose all information collected by the property and

all language versionsof the property.

Viewing Custom User Properties By Language
From the View Custom Properties screen, you can view the custom users properties by

languages. When viewing by languages, it is important to remember that if there is only an

English version of the property, the English version appears in all the languages.
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All custom user properties, in languages other than English, are tied to the English version of

the property. If you delete the English version of the property, all other language versions of

the properties are deleted.

To view the custom user properties by language, follow these steps.

1. In the Workarea, click Settings > Configuration > User Properties > User Properties.

2. Choose the language in which to view the properties from the language dropdown box.

3. The View Custom Languages screen for that language appears.

Note: In the example below, some propertieshave not been translated, so the English versionsappear instead.

n

Managing User Groups
Warning! If you are using Active Directory to manage user groups, see "The Screensof the Active DirectoryFea-

ture in User AuthenticationMode" on page 15-82.

The following topics explain how to manage User Groups.

n "Creating a New User Group" on page 15-30

n "Assigning Users To User Groups" on page 15-30

n "Viewing the Users in a User Group" on page 15-31
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n "Editing a User Group" on page 15-31

n "Deleting a User Group" on page 15-32

n

Creating a New User Group
Warning! If you are using Active Directory to create a new user group, see "Adding User Groups" on page 15-60.

To create a new User Group in Ektron CMS400.NET, follow these steps.

1. Access the User Groups folder in the administrator Workarea, as described in "Accessing

the User Group Folder" on page 15-3.

2. Click the Add User Group button ( ).

3. The Add a New User Group to the System screen is displayed.

4. Enter a name and brief description of the user group you want to create.

5. Click the Save button ( ).

Assigning Users To User Groups
Warning! If you are using Active Directory to assign a user to a user group, see "Adding a User to a Group" on

page 15-60.

To add a user to a user group, follow these steps.

1. Access the Workarea > Settings > User Groups.

2. Click the user group to which you want to add a user.

3. The View Users in Group screen appears with all current group members.

Note: When you create a new user group, no user is initially assigned to it.

Note that you can select any number of users by checking the box to the left of their

name. To select all users, check the box in the column header row.

You can also sort the display by Username, Lastname or Firstname.
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And, you can enter characters into the Search field and find only users that match them.

For example, you could enter bill, click the Search button, and see only users with those

characters in their name.

4. Click the Add User button ( ).

5. Users who do not belong to the group appear.

6. Click the user you want to add.

7. A confirmation message is displayed.

8. Click OK.

9. The selected user is now a member of the selected group.

10. Continue this process until you add all users into User Groups.

Viewing the Users in a User Group
To view a list of users who are members of a user group, follow these steps.

1. Access the User Group folder in the administrator Workarea, as described in "Accessing

the User Group Folder" on page 15-3.

2. Click the user group whose members you want to view.

3. The View Users in Group screen appears with a list of users who are members of the

group.

From this screen, you can edit or delete user groups, as well as add and remove users to and

from the user group.
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Editing a User Group
When editing a User Group, you can only change its name.

Note: You cannot edit the default Administratorsand Everyone user groups.

To edit a user group, follow these steps.

1. Access the View Users in Group screen for the user group you want to edit, as described

in "Viewing the Users in a User Group" on page 15-31.

2. Click the User Group you want to edit.

3. The View Users In Group screen is displayed.

4. Click the Edit button ( ).

5. The Edit User Group screen is displayed.

6. Make the necessary changes.

7. Click the Update button ( ).

Deleting a User Group
Warning! If you are using Active Directory to delete a user group, see "Deleting a User Group" on page 15-60.

When you do not need a User Group anymore, you can delete it from the system.

Note: You cannot delete the Administrator and Everyone groups.

To delete a user group, follow these steps.

1. Access the View Users in Group screen for the user group you want to delete, as described

in "Viewing the Users in a User Group" on page 15-31.

2. Click the User Group you want to delete.

3. The View Users In Group screen is displayed.

4. Click the Delete button ( ).
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5. A confirmation message is displayed.

6. Click OK.

7. The User Group is deleted from the Ektron CMS400.NET Web site.

Removing Users from User Groups
See "Removing Users from User Groups" on page 15-12.

Defining Roles
Ektron CMS400.NET contains an Administrators User Group. Any user who is a member of

that group automatically has full administrator privileges. See Also: "Guidelines for Using the

Folder-User Admin Role" on page 15-37

The Roles feature lets you assign limited or specific administrator privileges to users who

should not have full administrator privileges. For example, you can let certain users create,

redirect, or remove tasks but deny them other privileges normally granted to administrators.

Best Practice

When creating new user groups to use with roles, assign namesasamnemonic aid

for the role, especially for folder-specific rules. For example, theMarketing Folder

Adminsuser group could be used for all role memberswho can administer the

marketing folder.

Note: The PermissionsTable lets you controlwhich users canmanage a folder’s properties, its content, library

items, and create or edit collections. (See Also: "Folder Permissions" on page 5-43) So, together, the Roles feature

and the Permission Table give you the ability to assign administrative privileges to userswho are not members of

the Administrators group.

This section explains the use of Roles through the following topics.

n "Using the Roles Screens" on page 15-33

n "Guidelines for Using the Folder-User Admin Role" on page 15-37

n "List of Administrator Privileges" on page 15-39

Using the Roles Screens
Use the Roles screens to assign limited administrator privileges. To access the Roles screens,

go to the Ektron CMS400.NET Workarea and select Settings > Roles.
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Note: In the screens listed below, you can select users or groups. However, you can never select the

Administratorsgroup, because that group alreadyhasall permissions.

The following table describes the Roles screens.

Screen
Lets you give a user or user group the

ability to

For more

information,

see

System-Wide Roles

Alias-Admin

This user hasall the permissions that amember of the

administrators group has, such as the ability to

n Turn aliasing on and off

n View allmanual aliases

n Activate or deactivatemanual aliases

n Change the primary alias

n Create automatic aliases

n Create RegExaliases

"URL Aliasing" on

page 10-1

Alias-Edit
n View and assign amanual alias to content

n View secondary aliases

"Permissions for

Working with

Aliasing" on page

10-19

BusinessRule

Editor
Create or edit BusinessRulesand Rulesets

"BusinessRules"

on page 12-1

Calendar-

Admin
Create, edit and delete calendars

Collection and

Menu Admin

Create, edit and delete CollectionsandMenus via the

Content tab

Note: Tomanage permissions for creating collections

andmenus via the folder’sNew >Collection or New>

Menu option, use folder permissions. See Also:

"Folder Permissions" on page 5-43

"Collection

Permissions" on

page 9-114;

"Working with

Menus" on page 9-

129

Collection

Approver

If approval is required for a collection, approve

changes to it, including the deletion of a collection.

"Setting up

Approval for

Collections" on

page 9-116

Commerce

Admin

Access the eCommerce screens in the Ektron

CMS400.NET Workarea.

”eCommerce” on

page 17-1
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Screen
Lets you give a user or user group the

ability to

For more

information,

see

Community

Lets role members perform the following community

activities:

n Set system default preferences

n View and create new

- Activity Types

- Agents

- Messages

n Enable or Disable Notifications

”Notifications” on

page 16-160

Community

Group Admin

Create, edit and delete andmanage allCommunity

Groups.

”Community

Groups” on page

16-113

Community

Group Create

Create andmanage CommunityGroups. A user with

this role can onlymanage community groupshe has

created.

”Community

Groups” on page

16-113

Message Board

Admin

A user with this role can approve pending comments

or delete existing comments on amessage board.

Message board comments for users and community

groupsare administered on theWeb site. Message

Board comments for content can be administered on

theWeb site or from the Content Report screen in the

Workarea.

"Content Rating"

on page 7-743 and

”MessageBoard

Server Control” on

page 16-97

Metadata-

Admin
View, create and edit metadata definitions

"Working with

Metadata" on page

7-146

Smart Forms

Admin
Create or edit Smart Forms

"Working with

Smart Forms" on

page 7-288

Synchronization

Admin

Access the Workarea > Settings > Configuration

> Synchronization screen, which lets the user

perform all synchronization activities, such as

n manage sync configurationsand profiles

n run a sync

n perform content and folder-level sync

”Synchronizing

ServersUsing

eSync” on page 18-

1

TaskCreate Create tasks
"TaskPermissions"

on page 11-3
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Screen
Lets you give a user or user group the

ability to

For more

information,

see

TaskDelete Delete tasks
"TaskPermissions"

on page 11-3

TaskRedirect Redirect tasks
"TaskPermissions"

on page 11-3

Taxonomy

Administrator
Create andmanage taxonomies

"Taxonomy" on

page 9-200

Template

Configuration
View, create, update, and delete system templates

"Creating/Updating

Templates" on

page 7-184

User-Admin Create, view, edit, and delete users and user groups

"Managing Users

and User Groups"

on page 15-1

XLIFF-Admin

Use the Language Xport feature, which copies

content into XLIFF files that can be submitted to a

translation agency.

"Using the

Language Export

Feature" on page

14-13

Folder Specific Roles

Folder-User

Admin

View and edit folder properties. These users can

update properties, permissions, the approval chain,

metadata,Web alerts, purge history, etc.

For example, create a user group and give it

permission tomanage the top-levelmarketing folder.

Members of the group can do everything to that folder

and its subfolders, but lack authority over other

folders.

See Also: "Guidelines for Using the Folder-User

Admin Role" on page 15-37

"Folder Properties"

on page 5-13

Move or Copy

Move or copy content.

An Ektron best practice is to create a User Group for

this purpose, then assign the group to this role. Ektron

recommendsagainst assigning the role to individual

users.

After assigning the User Group here, go to the folders

whose content these userswill be allowed tomove or

copy, and assign to that User Group at least Read

Only and Traverse permissions. See Also: "Folder

Permissions" on page 5-43

"Moving or Copying

Content" on page

7-113
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Screen
Lets you give a user or user group the

ability to

For more

information,

see

Custom

Permissions

Used bya developer to extend Ektron

CMS400.NET’s standard features

"Guidelines for

Using a Custom

Role" on page 15-

37

Guidelines for Using the Folder-User Admin Role
When setting up users and groups for administrative access over folders, keep these in mind.

n After being identified on the Manage Members for Role: Folder User Admin screen, users

or groups must also be given at least Read-Only permission for individual folders on the

Folder Properties > View Permissions for Folder screen. See Also: "Folder Permissions"

on page 5-43

n You must use the same identity on the Manage Members for Role: Folder User Admin and

Folder properties screens. So, if a user group is listed for the role, use the same group when

assigning folder permissions, not simply a group member. Conversely, if individual users

are listed on the role screen, they must be specified in the folder permission.

n Ektron strongly recommends adding only user groups to the Folder User Admin role, not

individual users.

If you set up an individual user as a role member, he could accidentally receive administrative

rights to other folders.

Guidelines for Using a Custom Role

Note: The developer sample page installed with the sample site (http://site

root/cms400developer/developer/default.aspx) demonstrateshow to use custom roles. From the home

page, clickRoles > Custom Roles.

To download the developer sample site, go to http://www.ektron.com/solutions/startersites/.

The custom permissions role lets your Web developer create a site page, and then restrict

access to that page’s content (or areas with a page) to users assigned to a custom role.

Items you could show and hide could be as simple as a content block. But they could be more

complicated, such as displaying buttons and fields for one user group, and something

completely different for another.

Custom roles have no effect inside the workarea.
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Examples of Custom Roles

n Most of your site visitors belong to different political parties, while some are not registered

with any party. By checking the user’s ID against custom roles, you could present

registered voters with selections for their party’s primary, and prevent unregistered voters

from participating.

n Your CMS site visitors fall into two categories: suppliers and buyers. You could check the

current user against a custom role and show buyers one set of data and suppliers a different

set.

n On your eCommerce site, registered students see a list of coupons that are not displayed for

anyone else. Or, only registered adults can order age-controlled items, such as tobacco or

alcohol.

n Control your pages’ background colors, images, and skins based on custom roles. For

example, mothers get family-oriented background images while teenagers get rock images

and related styling.

Steps for Setting up a Custom Role
To set up a custom role, follow these steps.

1. Set up user groups and add to them users who will have some level of access to the

custom page. See Also: "Creating a New User Group" on page 15-30

To continue the above example, create one group of auditors (who will have read-only

access), and another group of administrators (who will have edit access).

2. Create an Ektron CMS400.NET folder to hold the content that will appear on the custom

page. Use the folder’s permission table to assign users and groups appropriate access to the

folder’s content. See Also: "Folder Permissions" on page 5-43

3. Set up a Custom role. To do this, go to Workarea > Settings > Roles > Custom

Permissions.

4. Create a new role.

5. From the Manage Custom Roles screen, click the role you created.

6. From the user type selector, click the type of users you want to add to the role.

7. Click the Add button ( ).
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8. Check the box next to the users or groups that you want to add to the role.

9. Your Web developer creates the custom page. See Also: "Information about Custom Roles

for your Developer" on page 15-39

10. You create content to appear on the custom page. Place the content in the folder you

created in Step 2.

Information about Custom Roles for your Developer
The API provides two methods that determine if the current user is logged in, and if he is a

member of the Administrators group. The methods let you test customizable roles with

conditions outside the standard Is-Logged-In / Is-Admin tests.

API methods are listed below.

Method Returns

GetRolePermissionSystem(RoleName

As String, nUserId As Long)

a Boolean value indicating if the user belongs to the

system-wide custom role

GetRolePermissionFolder(RoleName

As String, nFolderId As Long,

nUserId As Long)

a Boolean value indicating if the user belongs to the

custom role for the given folder. The procedure for

assigning a user to a custom role is "Guidelines for

Using a CustomRole" on page 15-37

Usage is demonstrated in the Developer sample file site
root\CMS400Developer\Developer\Roles\CustomRoles.aspx.vb.

List of Administrator Privileges
Administrator privileges include access to most screens that appear when you select Settings >

Configuration.
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Administrators can also

n edit folder properties (including Web alerts, metadata, permissions, and the approval chain)

n manage aliasing features, such as turn aliasing on or off, activate and deactivate manual

aliases, and create automatic aliases

n manually alias content

n add, edit, or delete a calendar

n add, edit, or delete a business rule

n create, view, edit, and delete metadata definitions

n create, view, edit, and delete taxonomies

n create, redirect, and delete tasks

n require a collection to go through an approval process

n export content for translation to another language using XLIFF

n run an eSync

n access the eCommerce Module
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Screen Descriptions for Online Help

Manage Members for Role: Alias Admin
Use this screen to determine which users or user groups have the following abilities related to

aliasing.

n Turn aliasing on and off

n View all manual aliases

n Activate or deactivate manual aliases

n Change the primary alias

n Create automatic aliases

n Create RegEx aliases

Note: Membersof the administratorsgroup also have these abilities.

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "URL Aliasing" on page 10-1; "Defining Roles" on page 15-32

Manage Members for Role: Alias-Edit
Use this screen to determine which users or user groups are allowed to assign a manual alias to

content, as well as view its secondary aliases.

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "URL Aliasing" on page 10-1; "Defining Roles" on page 15-32

Manage Members for Role: Analytics Viewer
Use this screen to determine which users or user groups are allowed to view Analytics data.

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "Analytics" on page 7-752; "Defining Roles" on page 15-32
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Manage Members for Role: Business Rule Editor
Use this screen to determine which users or user groups can work with Business Rules. For

example, a Business Rule Editor can create a new ruleset, or edit an existing one.

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "Business Rules" on page 12-1; "Defining Roles" on page 15-32

Manage Members for Role: Calendar-Admin
Use this screen to determine which users or user groups are allowed to create, edit and delete

calendars.

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: ; "Defining Roles" on page 15-32

Manage Members for Role: Collection and Menu
Admin
Use this screen to determine which users or user groups are allowed to create, edit and delete

collections and menus.

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "Working with Menus" on page 9-129; "Working with Collections" on page 9-99;

"Defining Roles" on page 15-32

Manage Members for Role: Collection Approval
Use this screen to determine which users or user groups are allowed to approve collections.

(Collections can be set to require approval.)

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "Setting up Approval for Collections" on page 9-116; "Defining Roles" on page 15-

32
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Manage Members for Role: Commerce Admin
Use this screen to determine which users or user groups are allowed use the eCommerce feature

from within the Ektron CMS400.NET Workarea (Settings > Commerce.)

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "eCommerce" on page 17-1; "Defining Roles" on page 15-32

Manage Members for Role: Community Admin
Use this screen to determine which users or user groups can perform the following community

activities:

n Set system default preferences

n View and create new

- Activity Types

- Agents

- Messages

n Enable or Disable Notifications

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "Notifications" on page 16-129; "Micro-messaging Server Control" on page 16-175;

"Defining Roles" on page 15-32

Manage Members for Role: Community Group Admin
Use this screen to determine which users or user groups are allowed to edit and delete

Community Groups. These users have the same privileges as the group Administrator and

members of the Administrators group.

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "Community Groups" on page 16-91; "Defining Roles" on page 15-32

Manage Members for Role: Community Group Create
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Use this screen to determine which users or user groups are allowed to Create Community

Groups.

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "Community Groups" on page 16-91; "Defining Roles" on page 15-32

Manage Members for Role: Metadata-Admin
Use this screen to determine which users or user groups are allowed to view, create and edit

metadata definitions.

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "Working with Metadata" on page 7-146; "Defining Roles" on page 15-32

Manage Members for Role: Multivariate Tester
Use this screen to determine which users or user groups are allowed to perform Multivariate

testing.

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "Multivariate Testing" on page 13-1; "Defining Roles" on page 15-32

Manage Members for Role: Smart Forms Admin
Use this screen to determine which users or user groups are allowed to create and edit Smart

Form configurations.

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "Working with Smart Forms" on page 7-288; "Defining Roles" on page 15-32

Manage Members for Role: Task-Create
Use this screen to determine which users or user groups are allowed to create tasks.
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To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "Creating a Task via the Content Folder" on page 11-23 and "Creating a Task from

the Web Site" on page 11-22; "Defining Roles" on page 15-32

Manage Members for Role: Task-Delete
Use this screen to determine which users or user groups are allowed to delete tasks.

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "Deleting a Task" on page 11-34; "Defining Roles" on page 15-32

Manage Members for Role: Task-Redirect
Use this screen to determine which users or user groups are allowed to assign tasks to other

users.

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "Editing a Task" on page 11-29; "Defining Roles" on page 15-32

Manage Members for Role: Taxonomy Administrator
Use this screen to determine which users or user groups are allowed to view, create, delete and

edit Taxonomies.

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "Taxonomy" on page 9-200; "Defining Roles" on page 15-32

Manage Members for Role: Template Configuration
Use this screen to determine which users or user groups are allowed to view, create, delete and

edit System Templates.

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "Creating/Updating Templates" on page 7-184; "Defining Roles" on page 15-32
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Manage Members for Role: User Admin
Use this screen to determine which users or user groups are allowed to create, view, edit, and

delete users and user groups.

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "Managing User Groups" on page 15-29; "Defining Roles" on page 15-32

Manage Members for Role: XLIFF-Admin
Use this screen to determine which users or user groups are allowed to use the Language Xport

feature, which copies content into XLIFF files that can be submitted to a translation agency.

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "Using the Language Export Feature" on page 14-13; "Defining Roles" on page 15-

32

Manage Members for Role: Synchronization Admin
Use this screen to determine which users or user groups are allowed to perform all

synchronization activities. These involve all screens available via Settings > Configuration >

Synchronization, as well as the content and folder-level Synchronize options.

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "Synchronizing Servers Using eSync" on page 18-1; "Defining Roles" on page 15-32

Manage Members for Role: Message Board Admin
Use this screen to determine which users or user groups are allowed to approve pending

comments or delete existing comments on a message board.

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "Content Rating" on page 7-743 and "MessageBoard Server Control" on page 16-76;

"Defining Roles" on page 15-32
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Manage Members for Role: Folder User Admin
Use this screen to determine which users and groups can view and edit folder properties. These

users can update properties, permissions, the approval chain, metadata, web alerts, purge

history, etc.

Note: After being identified on theManageMembers for Role: Folder User Admin screen, usersor groupsmust

also be given permission for individual folderson the Folder Properties>View Permissions for Folder screen.

For example, create a user group and give it permission to manage the top-level marketing

folder. Members of the group can do everything to that folder and its subfolders, but lack

authority over other folders.

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "Folder Properties" on page 5-13; "Defining Roles" on page 15-32

Manage Members for Role: Move or Copy
Use this screen to determine which users or user groups are allowed to move or copy content.

To add members, click the Add toolbar button ( ). To remove members, click the Drop

toolbar button ( ).

See Also: "Move or Copy" on page 15-36; "Defining Roles" on page 15-32

Manage Custom Roles
Use this screen to extend Ektron CMS400.NET’s standard Roles feature. After creating roles on

this screen, you can manipulate the roles using the developer API.

To add a custom role, click the Add toolbar button ( ). To remove a custom role, click the

Drop toolbar button ( ).

See Also: "Defining Roles" on page 15-32
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Active Directory Feature

The Active Directory feature allows you to retrieve user and user group information from the

Microsoft Windows Active Directory (AD) into Ektron CMS400.NET. As a result, you can

administer user information from one place only, and users need to remember only one

password/username combination to sign on to the network and Ektron CMS400.NET.

To learn more about Active Directory, see
http://www.microsoft.com/windowsserver2003/technologies/directory/activedirectory/default.mspx.

This feature is described through the following top-level topics.

n "Setup Guidelines" on page 15-49

n "Implementing Active Directory Integration" on page 15-52

n "Active Directory Integration" on page 15-53

n "User Authentication Only Mode" on page 15-80

n "Logging into a System that Uses AD Integration" on page 15-83
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Setup Guidelines

Warning! Ektron strongly recommendsconfiguring a secure socket layer (SSL), especially if you are using Active

Directory Integration. SSL encrypts passwords that are otherwise sent as clear text to the Ektron CMS400.NET

server .See Also: ”Configuring SSL” on page 1-124

The two ways to set up Active Directory are contrasted in the table below. Below the table are

instructions for each setup option.

Method When to Use How setup is done

Advanced

Domains

n You are using a firewall

n The Ektron CMS400.NET

server need not be part of an

Active Directory domain

n You are connecting tomul-

tiple Active Directory domains,

even ones that do not see each

other

Ektron CMS400.NET Workarea. For setup

instructions, see "Setting Up Active Directory

via the Advanced DomainsMethod" on page

15-49.

Legacy

You are using auto discovery

and Active Directory single

signon.

The domain connects to the AD domain within

the web.config.

For setup instructions, see "Setting Up Active

Directory via the LegacyMethod" on page 15-

50

Setting Up Active Directory via the
Advanced Domains Method
1. Make sure each AD user to be used in Ektron CMS400.NET is defined correctly in the

Active Directory. Remember that, when you enable AD integration, logon name and

domain are copied from AD to Ektron CMS400.NET.

2. If you have multiple domains in your Active Directory Forest, decide if you want Ektron

CMS400.NET to reference all domains or if you want to choose a specific one. (You will

use this when completing the Domain field of the Active Directory Setup Screen.)
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3. Set the following elements in the Web.config.

- Set the ek_ADEnabled element to true. It should look like this:
<add key="ek_ADEnabled" value="true"/>

- Set the ekADAdvanced element to true. It should look like this:
<add key="ekADAdvanced" value="true"/>

- Set the ek_AUTH_Protocol element to LDAP. It should look like this:
<add key="ek_AUTH_Protocol" value="LDAP"/>

4. Set up your domains on the Edit Domains screen. See "The Edit Domains Screen" on page

15-64.

5. Configure the AD setup page. See "The Active Directory Setup Screen" on page 15-66.

6. Assign AD groups to Ektron CMS400.NET user groups. See "Copying User Groups from

AD to Ektron CMS400.NET" on page 15-56.

Setting Up Active Directory via the
Legacy Method
1. Make sure each AD user to be used in Ektron CMS400.NET is defined correctly in the

Active Directory. Remember that, when you enable AD integration, logon name and

domain are copied from AD to Ektron CMS400.NET.

2. If you have multiple domains in your Active Directory Forest, decide if you want Ektron

CMS400.NET to reference all domains or if you want to choose a specific one. (You will

use this when completing the Domain field of the Active Directory Setup Screen.)

3. Set the following elements in the Web.config.

- For the authentication element, change the value of the impersonate attribute to false.

It should look like this:
<identity impersonate="false" userName="" password=""/>

- Set the ek_ADEnabled element to true. It should look like this:
<add key="ek_ADEnabled" value="true"/>

- Make sure the ekADAdvanced element is set to false. (This is the default value.)

- Set the ek_AUTH_Protocol element to GC. It should look like this:
<add key="ek_AUTH_Protocol" value="GC"/>

- declare a domain account through ek_adusername and ek_adpassword. It should look

like this:
<add key="ek_ADUsername" value="[username]@domain" />
<add key="ek_ADPassword" value="YourPasswordHere" />
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Note: Before entering the password, encrypt it using Ektron’s password encryption utility. To access that utility, go

to theWindowsStartmenu >All Programs > Ektron > current release > Utilities > Encrypt Email Password.

4. Configure the AD setup page. See "The Active Directory Setup Screen" on page 15-66.

5. Assign AD groups to Ektron CMS400.NET user groups. See "Copying User Groups from

AD to Ektron CMS400.NET" on page 15-56.
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Implementing Active Directory
Integration
The Active Directory feature has two implementation modes, described in the following table.

Choose the mode that best meets your needs.

.

Mode

Information

Shared

between

AD and

CMS

How to Implement

For more

information,

see

user

authentication

only

n user

logon name

n domain

n pass-

word

On the Active DirectorySetup screen,

checkEnable Active Directory

authentication.

"User

Authentication

OnlyMode" on

page 15-80

active

directory

integration

n user

logon name

n domain

n pass-

word

n user’s

first and last

name

n email

address

n user

groups

n user’s

groupmem-

berships

On the Active DirectorySetup screen,

checkEnable Active Directory

authentication andEnable Active

Directory integration.

Youmayalso want to checkEnable

automatic addition of user from AD

andEnable automatic addition of

user to groups.

"Active

Directory

Integration"

on page 15-53
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Active Directory Integration
This section covers the following topics:

n "How Information is Transferred from AD to Ektron CMS400.NET" on page 15-53

n "Which Information is Transferred from AD to Ektron CMS400.NET" on page 15-53

n "Copying User Group Information from AD to Ektron CMS400.NET" on page 15-55

n "Associating User Information in AD with Ektron CMS400.NET" on page 15-61

n "The Screens of the Active Directory Feature in Active Directory Integration Mode" on

page 15-64

n "Disabling AD Integration" on page 15-78

How Information is Transferred from AD to Ektron
CMS400.NET
Ektron CMS400.NET does not write to the AD – it only reads from it. This results in the

following changes to how user information is handled within Ektron CMS400.NET.

n Once you enable AD integration, all changes to user and user group information must be

made in the AD -- the Ektron CMS400.NET Edit User and User Group screens change to

primarily view screens.

n When adding a new user or user group to Ektron CMS400.NET, you can only select users

and groups in the AD. If the user or user group does not exist in the AD, create them there

first, and then import the user or group into Ektron CMS400.NET.

Which Information is Transferred from AD to Ektron
CMS400.NET
Ektron CMS400.NET accesses the following AD user information.

n Authentication (password, user logon name, and domain) for signing in to Ektron

CMS400.NET.

The password is not stored in Ektron CMS400.NET – the application only refers to the pass-

word during sign in.

n User information, listed in the following table

Field in AD AD attribute Corresponding field in Ektron CMS400.NET
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User logon name

(pre-Windows

2000)

sAMAccountName

Domain and Username

Note: Users can share a name in different domains. For example,

juser/example.com and juser/example.net. Otherwise, user names

must be unique.

Last Name sn Lastname

First Name givenName Firstname

Email mail email Address

n user group information, listed in the following table.

Field in AD
AD

attribute
Corresponding field in Ektron CMS400.NET

Group Name

(pre-Windows

2000)

cn

Domain and User group name

Note: User groups can share a name in different domains. For example,

editors/example.com and editors/example.net. Otherwise, user group names

must be unique.

The following diagram illustrates the components of the Active Directory feature.
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Copying User Group Information from AD to Ektron
CMS400.NET
This section explains how a user’s group membership is copied from the AD to the Ektron

CMS400.NET system when integration is first enabled, and then on an ongoing basis. Once

assigned to a group, the user automatically receives all Ektron CMS400.NET privileges and

workflow responsibilities associated with it.

Note: The Active Directoryhas two kindsof user groups: security and distribution.Ektron CMS400.NET
doesnot distinguish between them – as long asa user is amember of either kind of group, group information is

imported toEktron CMS400.NET.
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This section explains the following topics.

n "Copying User Groups from AD to Ektron CMS400.NET" on page 15-56

n "Associating a User’s AD Group Information with Ektron CMS400.NET" on page 15-57

n "Mapping the Administrator Group" on page 15-58

n "User Belongs to AD Group that Does Not Exist in Ektron CMS400.NET" on page 15-59

n "User Belongs to Ektron CMS400.NET Group that Does Not Exist in AD" on page 15-59

n "Removing Users from a Group" on page 15-59

n "Adding User Groups" on page 15-60

n "Adding a User to a Group" on page 15-60

n "Replacing a User Group" on page 15-60

n "Deleting a User Group" on page 15-60

Copying User Groups from AD to EktronCMS400.NET

Before using the AD integration feature, copy all AD groups you will use in your Web site

into Ektron CMS400.NET. To do that, follow these steps.

1. From the left side of the Workarea, click Settings > User Groups.

2. Click the Add Groups button ( ).

3. The Search Active Directory for Groups screen appears.

4. From the Domain drop-down list, select the domain from which you want to add a user

group.

Note: The Active DirectorySetup screen can restrict AD integration to one domain. If it does, you can only search

within that domain.

5. Enter as much information as you know into the Active Directory Group field.

6. Click the Search button.

7. A new screen displays all groups that satisfy the search criteria.

8. Click the check box under the Add column to add the user group to Ektron CMS400.NET.
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9. Click the Save button ( ).

Associating a User’s AD Group Information with EktronCMS400.NET

When Integration is First Enabled

Ektron CMS400.NETUser Database Already Exists

If Auto Add User To Group is checked (on the Active Directory Setup screen), a user’s group

membership is first copied from the AD to Ektron CMS400.NET when a user logs in or is

added. At this time, any AD group memberships overwrite Ektron CMS400.NET group

memberships except the Everyone group, to which all users belong.

Note: The Everyone group, unlike otherEktron CMS400.NET groups, is not associated with an AD

group. It is an all-encompassing group with no special permissions.

If a user belongs to an AD user group that does not exist in Ektron CMS400.NET, nothing

happens because the feature assumes that all AD groups are not meaningful in Ektron

CMS400.NET.

If a user belongs to an Ektron CMS400.NET user group that does not exist in AD, the

discrepancy is flagged on the Active Directory Setup and Active Directory Status screens.

From these screens, you can copy the AD group information into Ektron CMS400.NET.

See Also: "Associating User Group Membership with Active Directory User Group

Membership" on page 15-73 and "Associating Groups with Active Directory Groups" on page

15-73

To learn how membership is updated from then on, see "After Integration is Enabled" on page

15-57.

Ektron CMS400.NET is Being Installed, so No UserGroups Exist

Follow the procedure described in "Copying User Groups from AD to Ektron CMS400.NET"

on page 15-56 to copy AD user groups to Ektron CMS400.NET. As users in those groups are

added to Ektron CMS400.NET, their group membership is copied from AD to Ektron

CMS400.NET.

After Integration is Enabled

A user’s group membership is updated in Ektron CMS400.NET when all of the following are

true:

n The Enable automatic addition of user to groups field is checked on the Active

Directory Setup screen
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n A user is added to Ektron CMS400.NET or his group membership changes in the Active

Directory

n The user logs in or someone clicks on the Refresh button ( ) on the user’s View User
Information screen

On the other hand, if Enable automatic addition of user to groups field is unchecked, you can

add the user to groups and remove him from groups independently of his AD group

memberships.

Mapping the Administrator Group
On the Ektron CMS400.NET Active Directory Setup screen, you can identify an AD user

group that maps to the Ektron CMS400.NET Administrator group.
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Administrators have access to all functions documented in this documentation. (Unlike other

Ektron CMS400.NET user groups, whose names are copied from the AD, the Administrator

and Everyone group names cannot be changed.)

For example, if the AD has a user group named CMSAdmin whose members should have the

privileges of Ektron CMS400.NET administrators, assign that group to Administrators on the

Active Directory Setup screen. If such a group does not exist in AD yet, you should create it

and then assign it on the Active Directory Setup screen.

Note that only one AD group can be mapped to the Ektron CMS400.NET Administrator group

-- you cannot have an AD administrator group within each AD domain.

See Also: "The Active Directory Setup Screen" on page 15-66
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User Belongs to AD Group that Does Not Exist in EktronCMS400.NET

If user is assigned to an AD user group that does not exist in Ektron CMS400.NET, nothing

happens. The AD integration feature assumes that an Ektron CMS400.NET administrator only

maintains user groups that are meaningful to Ektron CMS400.NET, and not all AD groups may

be meaningful to Ektron CMS400.NET.

Note: If a user belongs to a user group that is givenMembership permissions, but also to a group that hasCMS

permissions, the user will only receiveMembership permissions if logged into Ektron CMS400.NET.

User Belongs to EktronCMS400.NET Group that Does Not Exist in AD
If a user was a member of a user group in Ektron CMS400.NET before integration was enabled,

but does not belong to that group in the AD, this discrepancy is flagged on the Active

Directory Setup and Active Directory Status screens.

If the user should belong to the AD group, add the group membership within the AD. Then,

refresh the user on these screens to copy AD group information into Ektron CMS400.NET.

See Also: "Associating Groups with Active Directory Groups" on page 15-73

Removing Users from a Group
If you delete a user from an AD group, the user is automatically removed from the associated

Ektron CMS400.NET group the next time the user’s information is updated (as explained in

"Copying User Group Information from AD to Ektron CMS400.NET" on page 15-55).

Adding User Groups
Once AD integration is enabled, you can only add new user groups in the AD. In Ektron

CMS400.NET, use the Search Active Directory for Groups screen to copy an AD user group to

Ektron CMS400.NET. You can only add groups that do not already exist in Ektron

CMS400.NET. This procedure is described in "Copying User Groups from AD to Ektron

CMS400.NET" on page 15-56.

Adding a User to a Group
You cannot add a user to a user group within Ektron CMS400.NET -- you must do so in the

Active Directory.
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Replacing a User Group
If you realize that you have associated the wrong AD user group with an Ektron CMS400.NET

user group, you can replace the user group. Follow these steps to do so.

1. From the left side of the Workarea, click User Groups.

2. Click the user group that you want to replace.

3. Click the Associate Ektron CMS400.NET Group with Different AD Group button ( ).

4. Select a group to replace the group you selected in Step 2.

5. Click the Save button ( ) to finalize the change.

Deleting a User Group

Deleting aUserGroup in AD

If you delete a user group in AD and users are assigned to the group within Ektron

CMS400.NET, the group is not automatically deleted in Ektron CMS400.NET. However, any

Ektron CMS400.NET users who were members of the group are no longer members the next

time their Ektron CMS400.NET information is updated. The discrepancy is flagged on the

Active Directory Setup and Active Directory Status screens.

Deleting aUserGroup in EktronCMS400.NET

If you delete a user group in Ektron CMS400.NET and users are assigned to that group within

AD, nothing happens. This is because the AD Integration Feature assumes that, in Ektron

CMS400.NET, the administrator only sets up user groups that are meaningful to Ektron

CMS400.NET, and some AD groups are not meaningful to Ektron CMS400.NET.

Associating User Information in AD with Ektron
CMS400.NET
A key component of the Active Directory Integration feature is to maintain consistent

information between the AD and Ektron CMS400.NET. This section explains the transfer of

user information between AD and Ektron CMS400.NET when integration is first enabled and

on an ongoing basis.

This section covers the following topics.

n "Automatically Copying AD User Information When Integration is First Enabled" on

page 15-61

n "Automatically Copying AD User Information after Integration is Enabled" on page 15-62

n "Manually Adding AD User Information to Ektron CMS400.NET" on page 15-62
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n "Editing User Information in Ektron CMS400.NET" on page 15-63

n "Deleting Users" on page 15-63

n "Replacing a User" on page 15-63

Automatically Copying AD User Information When
Integration is First Enabled

EktronCMS400.NETDatabase Already Implemented

If Enable automatic addition of user from AD is checked on the Active Directory Setup screen,

user information is copied from the AD to Ektron CMS400.NET when that user logs in or is

added to Ektron CMS400.NET.

See Also: "The Active Directory Setup Screen" on page 15-66

The first time the user information is copied, the AD information overwrites all Ektron

CMS400.NET information. To learn how information is updated from then on, see "Copying

User Group Information from AD to Ektron CMS400.NET" on page 15-55.

If two or more AD users have the same Ektron CMS400.NET user logon name but different

domains (for example, JDoe in Eng.Example.com and JDoe in Mkt.Example.com) and that

username (JDoe) also exists in Ektron CMS400.NET, the Active Directory Setup and Active

Directory Status screens indicate this discrepancy by the following message:

CMS users need to be associated with Active Directory users.

Click the message to proceed to the Associate Ektron CMS400.NET Users to Active Directory

Users screen and associate an AD user with the Ektron CMS400.NET user.

See Also: "Associating Ektron CMS400.NET Users with Active Directory Users" on page 15-

72

EktronCMS400.NET is Being Installed, so No UserDatabase Exists

Go to the Search Active Directory for Users Screen and select AD users that will use Ektron

CMS400.NET. When you add a user, the user information is copied from the AD to Ektron

CMS400.NET.

See Also: "The Search Active Directory for Users Screen" on page 15-76

Note: You can only select AD users that do not alreadyexist inEktron CMS400.NET. Also, the Active
DirectorySetup screen can restrict AD integration to one domain. If it does, you can only search for userswithin that

domain.
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Automatically Copying AD User Information after Integration
is Enabled
User information is copied from the AD to Ektron CMS400.NET when either of these events

occurs:

n the user logs in

n someone clicks the Refresh button ( ) on the user’s View User Information screen

See Also: "The View User Information Screen" on page 15-74

If a user’s last name, first name, email field, or group membership changed in the AD, those

changes are copied to Ektron CMS400.NET. However, if a user’s logon name changed in the

AD, that change is not copied to Ektron CMS400.NET because Ektron CMS400.NET uses that

field to identify the user. Instead, that discrepancy is flagged on the Active Directory Setup

and Active Directory Status screens. You should proceed to the Associate Ektron

CMS400.NET Users to Active Directory Users screen, where you can update the AD user

associated with the Ektron CMS400.NET user.

See Also: "Associating Ektron CMS400.NET Users with Active Directory Users" on page 15-

72

Manually Adding AD User Information to EktronCMS400.NET

Before using the AD integration feature, add all AD users that will use your Web site to

Ektron CMS400.NET. This can be done automatically, as explained "Automatically Copying

AD User Information When Integration is First Enabled" on page 15-61.

If you want to manually add an AD user to Ektron CMS400.NET, follow these steps.

1. From the left side of the Workarea, click Users.

2. Click the Add Users button ( ).

3. The Search Active Directory for Users screen appears.

4. From the Domain pull-down list, select the domain from which you want to add a user.

5. Enter as much information as you know into the other fields.

6. Click the Search button.
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7. A new screen displays all users that satisfy the search criteria.

8. Click the check box under the Add column to add users to Ektron CMS400.NET.

9. Click the Save button ( ).

Editing User Information in EktronCMS400.NET

Because Ektron CMS400.NET does not write to the AD, you can only change the User

Language and Disable email Notifications fields within the Ektron CMS400.NET Edit User

screen. You must edit all other user fields from the AD.

Deleting Users
If a user is deleted in AD, Ektron CMS400.NET does not automatically delete the user.

However, the user’s login fails because he cannot be authenticated.

The user remains in Ektron CMS400.NET, and the discrepancy is flagged on the Active

Directory Setup and Active Directory Status screens. You should delete the user from Ektron

CMS400.NET using the Delete User function.

See Also: "Deleting a User" on page 15-11

Note: If youmistakenlydelete all userswith administrative privileges, you can still sign in using the builtin user’s

username and password. For more information, see "BuiltIn User" on page 19-11.

Replacing a User
If you associate the wrong AD user with a Ektron CMS400.NET user, you can replace the user.

If you do, all Ektron CMS400.NET privileges and workflow responsibilities assigned to the old

user transfer to the new one.

Follow these steps to associate a Ektron CMS400.NET user with a new AD user.

1. From the left side of the Workarea, click Users.

2. Click the user you want to replace.

3. Click the Associate CMS User with Different AD User button ( ).

4. Select a user to replace the user you selected in Step 2.

5. Click the Save button ( ).

When you complete this procedure, the first user is deleted from Ektron CMS400.NET.
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The Screens of the Active Directory Feature in Active
Directory Integration Mode
The Active Directory feature uses the following screens:

n "The Edit Domains Screen" on page 15-64

n "The Active Directory Setup Screen" on page 15-66

n "The Active Directory Status Screen" on page 15-71

n "The View Users Screen" on page 15-74

n "The View User Groups Screen" on page 15-76

This section explains how to use each screen.

The Edit Domains Screen
Use this screen to identify each network domain you will use with Ektron CMS400.NET’s

Active Directory feature. You would use this when you want to define domains, as opposed to

using auto discovery to find them.

This feature is described through the following subtopics.

n "Enabling the Edit Domains Screen" on page 15-64

n "Accessing the Edit Domains Screen" on page 15-65

n "Fields of the Edit Domains Screen" on page 15-65

n "How Domains are Used" on page 15-66

See Also: "Active Directory Feature" on page 15-48

Enabling the EditDomains Screen

To have the Edit Domains screen appear, set the following web.config file values as shown

below.

web.config value Setting

ek_ADEnabled True

ek_ADAdvancedConfig True

ek_ADUsername blank (username entered in Edit Domains screen)
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web.config value Setting

ek_ADPassword blank (username entered in Edit Domains screen)

ek_AUTH_Protocol LDAP

Accessing the EditDomains Screen

After you modify web.config as described above, access the Edit Domains screen by going to

Workarea > Settings > Configuration > Active Directory > Domains.

Below is a sample of the screen.

The screen lets you add new domains, modify existing ones, or delete obsolete ones.

Fields of the EditDomains Screen

When defining a domain, enter the following information.

Field Description

Domain

DNS

Enter the domain’sDNS. Contact your server administrator for this

information. For example, corp.example.com.

NetBIOS

If your NetBios is the same asyour domain name, leave the checkboxbox

checked. Otherwise, uncheck the boxand enter your NetBIOS setting.

Contact your server administrator for this information.
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Field Description

Username

Enter the name of the user with permission to sign on to the domain

server. The name is in the format username@domainDNS. For example,

jsmith@corp.example.com.

Password Enter the password of the user identified above.

Domain

Controller IP

Enter the IP addressor DNSname of your domain controller.

Note: If using Active Directory acrossa firewall, the IP address should be

that of the firewall. On the firewall, traffic on port 389 (LDAP) should be

allowed.

How Domains are Used

Domains defined on this screen are referenced when defining the user group that maps to the

hard coded Ektron CMS400.NET administrator group. See Also: "The Screens of the Active

Directory Feature in Active Directory Integration Mode" on page 15-64

While defining the user group, first select a domain. Ektron CMS400.NET creates a selection

list of Active Directory user groups in that domain. In this way, you must choose a user group

within the selected domain.

The Active Directory Setup Screen
The Active Directory Setup screen (illustrated below) lets you enable and disable the Active

Directory feature, as well as determine other aspects of AD management, such as whether users

and groups are automatically updated. To access the screen, click Settings > Configuration >

Active Directory > Setup from the left panel of the Workarea.
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The following table describes the fields on the screen.

See Also: "Messages Near the Top of the Active Directory Setup Screen" on page 15-70

Field Description For more information, see

Active Directory Installed

Disable Active

Directory and

LDAP

Authentication

Disables the use of Active Directory

and LDAPAuthentication.
"Disabling AD Integration" on page 15-78
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Field Description For more information, see

Enable LDAP

Authentication

If enabled, you need to fill out the

following five fields. These fields are

explained in the LDAP

Authentication chapter.

"Enabling LDAP" on page 15-95

LDAPServer
Explained in LDAPAuthentication

chapter.
"Enabling LDAP" on page 15-95

Port
Explained in LDAPAuthentication

chapter.
"Enabling LDAP" on page 15-95

Organization
Explained in LDAPAuthentication

chapter.
"Enabling LDAP" on page 15-95

Domain
Explained in LDAPAuthentication

chapter.
"Enabling LDAP" on page 15-95

Organizational

Unit

Explained in LDAPAuthentication

chapter.
"Enabling LDAP" on page 15-95

Active

Directory

Authentication

If enabled, user authentication is

functional, and you can enable the

following three fields.

"User Authentication OnlyMode" on page

15-80

For information on LDAP, see "LDAP

Authentication" on page 15-94

Active

Directory

Integration

If enabled, the Active Directory

feature is functional.

Note: Can only be enabled if Active

DirectoryAuthentication is enabled.

"Active Directory Integration" on page 15-53

Auto Add User

If enabled, user information is

copied from the AD to Ektron

CMS400.NET when that user logs

in or when the user is added to

Ektron CMS400.NET.

Note: Can only be enabled if Active

Directory Integration is enabled.

"Associating User Information in AD with

Ektron CMS400.NET" on page 15-61

Auto Add User

ToGroup

If enabled, a user’s group

membership is first copied from the

AD when a user logs in or is added.

Note: Can only be enabled if Active

Directory Integration is enabled.

"The Screensof the Active DirectoryFeature

in Active Directory IntegrationMode" on page

15-64

User Property Mapping
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Field Description For more information, see

FirstName

Enter the Active DirectoryProperty

that maps to the user’s first name in

Ektron CMS400.NET. Bydefault,

this is set to givenName, but you

can change it to anyAD property.

MSDN Library

(

http://msdn.microsoft.com/library/default.asp

)>Active Directory, ADSI and Directory

Services>DirectoryServices>Active

Directory >Active DirectoryReference >

Active DirectoryUser InterfaceMappings.

LastName

Enter the Active DirectoryProperty

that maps to the user’s last name in

Ektron CMS400.NET. Bydefault,

this is set to sn, but you can change

it to anyAD property.

same reference asFirstName (above)

EmailAddr1

Enter the Active DirectoryProperty

that maps to the user’s last name in

Ektron CMS400.NET. Bydefault,

this is set to mail, but you can

change it to anyAD property.

same reference asFirstName (above)

Ektron CMS400.NET Administrator Group Mapping

AD Group

Name @

AD Domain

Enter the Active Directory user

group and domain name that maps

to the hard coded Ektron

CMS400.NET administrator group.

If you do not have an AD user group

that includesall Ektron

CMS400.NET administrators, you

should create one and enter its

name and domain here.

"Mapping the Administrator Group" on page

15-58
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Field Description For more information, see

Domain

If you want to restrict the search of

new users and groups to one AD

domain, select that domain.

If you do, the Search Active

Directory for Users and Search

Active Directory for Groups screens

let you search in the selected

domain only.

Also, if anyEktron CMS400.NET

user or group names include a

domain (for example,

admin@saturn.example.com) that

is excluded by your selection, those

users/groupsare flagged on the

Active DirectorySetup and Active

DirectoryStatus screensbecause

the namesnow include an invalid

domain.

Messages Near the Top of the Active Directory Setup Screen

Message Explanation

Active Directory

Authentication isEnabled

and RequiresMore

Configuration.

Some Ektron CMS400.NET users are not associated with AD users. Also, if

you are using full active directory integrationmode, user groupsand/or user

group relationshipsmaynot be associated.

Active Directory

Authentication is disabled,

but needs further

configuration

SomeEktron CMS400.NET users and/or groupsare no longer unique.

This happensbecause, in the AD, users and groups can share a logon name

as long as their domainsare different.

But, when AD authentication is disabled, two Ektron CMS400.NET users or

groups can no longer share a name -- eachmust be unique.
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If you see either message, click it. You proceed to the Active Directory Status screen, which

helps you resolve the discrepancies.

See Also: "The Active Directory Status Screen" on page 15-71

The Active Directory Status Screen
Use the Active Directory Status screen to resolve the following discrepancies between Ektron

CMS400.NET and AD.

n an Ektron CMS400.NET user needs to be associated with an AD user

n an Ektron CMS400.NET user group needs to be associated with an AD user group

n an Ektron CMS400.NET user’s group membership need to be associated with the same AD

user’s group membership

To access the screen, click Configuration > Active Directory > Status from the left panel of

the Workarea.

.

There are several reasons why such discrepancies may occur. To learn more about why
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n an Ektron CMS400.NET user is not associated with an AD user, read "Associating User

Information in AD with Ektron CMS400.NET" on page 15-61.

n an Ektron CMS400.NET user’s group membership is not associated with the user’s AD

group membership, read "Associating a User’s AD Group Information with Ektron

CMS400.NET" on page 15-57

n an Ektron CMS400.NET group is not associated with an AD group, read "The Screens of

the Active Directory Feature in Active Directory Integration Mode" on page 15-64

If you click any link on the Active Directory Status screen, a new screen appears that allows

you to resolve the discrepancy. For information on how to use these screens, see the following

topics.

n "Associating Ektron CMS400.NET Users with Active Directory Users" on page 15-72

n "Associating User Group Membership with Active Directory User Group Membership" on

page 15-73

n "Associating Groups with Active Directory Groups" on page 15-73

Associating EktronCMS400.NETUsers with Active Directory Users

If you click CMS users need to be associated with Active Directory users on the Active

Directory Status screen, the Associate Ektron CMS400.NET Users with Active Directory Users

screen appears (illustrated below). Use this screen to associate Ektron CMS400.NET users with

AD users.

If a user with the same username exists in the AD, that name and domain appear by default in

the AD Username and AD Domain fields. If the user exists in the more than one AD domain

(as illustrated in the first example above), select a domain from the pull-down list.
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If there is no default and you know the AD user name to associate with an Ektron

CMS400.NET user, enter that in the AD Username and AD Domain fields. If you do not

know the AD username, click Search to find the user in the AD.

If you decide to change the username in AD to match the Ektron CMS400.NET username,

make the change in the AD. Then, click the Refresh button ( ) to update Ektron
CMS400.NET and resolve the discrepancy.

Finally, if a user should not exist in Ektron CMS400.NET, click the box under the Delete

column to delete the user from Ektron CMS400.NET.

After you make all necessary changes, click the Save button ( ).

Associating UserGroupMembershipwith Active Directory UserGroupMembership

If you click CMS relationships need to be associated with Active Directory relationships on

the Active Directory Status screen, the Associate Ektron CMS400.NET Relationships with

Active Directory Relationships screen appears (illustrated below). Use this screen to coordinate

Ektron CMS400.NET user group membership with AD user group membership.

The screen displays a user’s group membership that exists in Ektron CMS400.NET, but does

not exist in the AD.

See Also: "Associating a User’s AD Group Information with Ektron CMS400.NET" on page

15-57

After viewing the discrepancy on the screen, you have two choices:

n To associate the user with the same user group in AD, go to the AD and assign the user to

the group. Then, return to this screen and click the Refresh button ( ) to update the user
group information in Ektron CMS400.NET.

n To remove the user’s group membership in Ektron CMS400.NET, check the box under the

Delete column and click the Save button ( ).

Associating Groups with Active Directory Groups

If you click CMS groups need to be associated with Active Directory groups on the Active

Directory Status screen, the Associate Ektron CMS400.NET User Groups with Active Directory

Managing Users and User Groups

15-74
ReferenceManual

Version 8.0 Rev 1.3



Groups screen appears (illustrated below). Use this screen to associate Ektron CMS400.NET

groups with AD groups.

If a group with the same groupname exists in the AD, that name appears by default in the AD

Group Name field. If the group exists in the more than one domain within the AD, select a

domain from the pull-down list.

If there is no default and you know the AD group name to associate with an Ektron

CMS400.NET group, enter that in the AD Group Name and AD Domain fields. If you do not

know the AD groupname, click Search to find the group in the AD.

Finally, if this group should not exist in the Ektron CMS400.NET database, click the box

under the Delete column to delete the group from Ektron CMS400.NET.

After you make all necessary changes, click the Save button ( ) to save them.

The View Users Screen
The View Users screen (illustrated below) lists all users in the Ektron CMS400.NET database.

To access the screen, click Users from the left panel of the Workarea. To view more

information for a user, click that user to move to the View User Information screen.

The View Users screen also provides a toolbar button ( ) that lets you add AD users to the
Ektron CMS400.NET database. When you click it, the Search Active Directory for Users

Screen appears.

The View User Information Screen
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The View User Information Screen displays the user’s

n username and domain

n first and last name

n language

n email address and whether the user receives email notifications

n user groups

If you are using user authentication mode, username and domain can only be edited in the

AD. You can edit all other fields on this screen.

If you are using full AD Integration mode, you can only edit language and whether the user

receives email notifications. You must edit the other fields in the AD.

The screen also displays the following buttons.

Button Description

Edit information on screen

Delete user

See Also: "Deleting Users" on page 15-63

Retrieve latest information from AD into Ektron CMS400.NET

See Also: "Copying User Group Information from AD to
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Button Description

Ektron CMS400.NET" on page 15-55

Note: This toolbar button doesnot appear if you are using user

authenticationmode.

Replace user

See Also: "Replacing a User" on page 15-63

Return to previous screen

The Search Active Directory forUsers Screen

Use this screen to add AD users to Ektron CMS400.NET. To access the screen, click Users

from the left panel of the Workarea, then click the Add button ( ).

Enter as much search criteria as you know to reduce the number of users that the search yields.

For example, if you know that the user’s last name is Jackson and the user is in the planets

domain, enter those criteria and you will get fewer hits.

When the Active Directory Users screen appears, click the box next to users that you want to

create in Ektron CMS400.NET. Then, click the Save button ( ) to copy their information into
Ektron CMS400.NET.

The View User Groups Screen
The View User Groups Screen displays all AD user groups that have been copied into Ektron

CMS400.NET. (See "Copying User Groups from AD to Ektron CMS400.NET" on page 15-56).

To access the screen, click User Groups from the left panel of the Workarea.
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To view more information for a group, click that group to move to the View Users in Group

screen.

The View User Groups screen also provides a toolbar button ( ) that lets you add AD groups
to the Ektron CMS400.NET database. When you click it, the Search Active Directory for

Groups screen appears.

View Users in Group Screen

The View Users in Group Screen displays, for each user in the group

n username and domain

n first and last name

n language

The screen also displays the following buttons.

Button Description

Replace group

See Also: "Replacing a User Group" on page 15-60
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Button Description

Return to previous screen

The Search Active Directory forGroups Screen

Use this screen to add AD groups to Ektron CMS400.NET. Enter as much search criteria as

you know to reduce the number of groups that the search yields.

Note: You can only select AD groups that do not alreadyexist in Ektron CMS400.NET. Also, the Active Directory

Setup screen can restrict AD integration to one domain. If it does, you can only search for groupswithin that

domain.

For example, if you know that a group begins with S and is in the planets domain, enter those

criteria and you will get fewer hits.

After you click Search, a new screen appears listing all AD groups that satisfy the search

criteria. Click the box next to groups that you want to create in Ektron CMS400.NET. Then,

click the Save button ( ) to copy their information.

Disabling AD Integration
If you decide to disable AD authentication or integration, edit the Active Directory Setup

screen and uncheck the box next to Enable Active Directory Authentication or Enable

Active Directory Integration.

See Also: "The Active Directory Setup Screen" on page 15-66

If you do this, and any users or groups share the same name within different domains, the

following message appears on the screen.

Active Directory Authentication is disabled, but needs further configuration

For example, two users are named JJackson@example.net and JJackson@example.com. When

AD was enabled, the domain names made the two users unique. However, when you disable
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integration, the domain names are dropped, so the user names are now identical. You need to

make the users unique.

If you click the message (above) on the Active Directory Setup screen, you move to the Active

Directory Status screen. The following messages may appear.

Click the message to proceed to the Make Ektron CMS400.NET Users Unique screen

(illustrated below).

This screen lists all users whose user names are not unique and suggests a new, unique Ektron

CMS400.NET username. The new name consists of the user name, underscore, at sign (@),

underscore, the domain name. So, for example, JJackson@example.net would appear as

JJackson_@_example.net.

The same is true for user groups. For example, if you had two groups name Account Operators,

one in the example.com domain and another in the saturn.example.com domain, the Make

Ektron CMS400.NET Groups Unique screen would look like this.

Ektron recommends that you accept the suggested new names. Click the Save ( ) button to
do so.

One advantage of using the new name format is that, if you later decide to re-enable AD

integration, the software can automatically associate the AD and Ektron CMS400.NET users or

groups.
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User Authentication Only Mode
In user authentication mode, the sharing between AD and Ektron CMS400.NET is limited to

user logon name, domain, and password.

The following topics explain how to work with user authentication mode.

n "How Information is Transferred from Active Directory to Ektron CMS400.NET" on page

15-80

n "Which Information is Transferred from Active Directory to CMS400.NET" on page 15-80

n "User Groups" on page 15-81

n "Adding User Information from AD to Ektron CMS400.NET" on page 15-81

n "Editing User Information in Ektron CMS400.NET" on page 15-81

n "Deleting Users" on page 15-81

n "Replacing a User" on page 15-81

n "The Screens of the Active Directory Feature in User Authentication Mode" on page 15-82

n "Disabling AD Authentication" on page 15-82

How Information is Transferred from Active Directory
to Ektron CMS400.NET
Ektron CMS400.NET does not write to the AD – it only reads from it. This results in the

following changes to how the username, domain, and password are handled within Ektron

CMS400.NET.

n Changes to user logon name, domain and password must be made in the AD — you

cannot update these fields in the Ektron CMS400.NET Edit User screens.

n When adding a new user to Ektron CMS400.NET, you can only select AD users. If the

user does not exist in the AD, create the user there, and then import the user into Ektron

CMS400.NET.

Which Information is Transferred from Active
Directory to CMS400.NET
CMS refers to the following AD sign-in authentication information during sign-in: password,

user logon name, and domain. Note that the password is not stored in CMS — CMS only refers

to the password during sign-in.
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User Groups
User authentication mode has no effect on user groups. To learn more about user groups, see

"Managing User Groups" on page 15-29.

Adding User Information from AD to Ektron
CMS400.NET
See "Manually Adding AD User Information to Ektron CMS400.NET" on page 15-62

Changing the User Login Name in AD
If a user’s logon name changes in the AD, it no longer matches the Ektron CMS400.NET

logon name. This discrepancy is flagged on the Active Directory Setup and Active Directory

Status screens. You should proceed to the Associate Ektron CMS400.NET Users to Active

Directory Users screen, where you can update the user information.

Alternatively, you could

1. Go to the View User Information screen.

2. Select the user whose AD name changed.

3. Click the Associate the Ektron CMS400.NET user with Different AD user toolbar button (

).

4. Select the AD user and domain.

See Also: "Associating Ektron CMS400.NET Users with Active Directory Users" on page 15-

72

Editing User Information in Ektron CMS400.NET
Ektron CMS400.NET does not write to the AD. This means that you can only change the

Username and Domain fields from the AD.

You can change the First Name, Last Name, email Address, User Language and Disable

email Notifications fields on the Ektron CMS400.NET Edit User screen.

Deleting Users
See "Deleting Users" on page 15-63

Replacing a User
See "Replacing a User" on page 15-63
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Warning! If you replace a user in user authentication-onlymode, the user’s first name, last name, and email

addressare not overwritten with information in the active directory.

The Screens of the Active Directory Feature in User
Authentication Mode
Since the scope of user authentication mode is limited, only some fields on the AD screens are

used. For example, on the Active Directory setup screen, the only relevant fields are

authentication and domain.

See Also: "The Active Directory Setup Screen" on page 15-66

Also, on the Active Directory Status Screen, only one discrepancy message may appear:

CMS user needs to be associated with an AD user

See Also: "Associating Ektron CMS400.NET Users with Active Directory Users" on page 15-

72

The View Users Screen works the same for both modes.

See Also: "The View User Information Screen" on page 15-74

Disabling AD Authentication
See "Disabling AD Integration" on page 15-78
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Logging into a System that Uses AD
Integration
Because usernames and passwords are stored in the AD by domain, the AD sign on procedure

requires you to select a domain name. So, if AD integration is enabled, the sign on screen

includes a drop-down list that prompts the user to select a domain.

Note: Your organization determinesAD domain names .

For more information about logging in, see "Logging into an Ektron CMS400.NET Web Site"

on page 3-2.

This feature is explained through the following topics.

n "Single Sign On" on page 15-83

n "Setting up Single Sign On" on page 15-84

Single Sign On
You can implement a Single Sign On feature that lets a user bypass the Login screen. The

feature retrieves the user’s Windows login information from the server to authenticate access to

Ektron CMS400.NET.
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How Single Sign on Works

The feature uses a variable called User.Identity.Name. This holds the user's account\domain in

Active Directory, and has the format [domain]\[username]. For example, EKTRON1\skearney.

This variable is set when a user authenticates against a Windows server.

When a user clicks the login server control, if the variable is passed and Active Directory is

enabled, the server control opens the autologin.aspx page. Next, the opening window refreshes

just like a normal login, except the user is not prompted to enter a username, password, and

domain.

However, if the user‘s computer is not on a domain, not on the same domain as Ektron

CMS400.NET, or does not include the Ektron CMS400.NET server as a trusted site, the

following login screen appears.

If Active Directory is not enabled, the normal login.aspx page appears.

Setting up Single Sign On
The Single Sign On login process uses the autologin.aspx file (in the workarea/SSO directory) .

Once set up, user authentication is enabled from any domain that this server can reach. For

example, if Ektron CMS400.NET is located in a third level domain, users from third, second,

and first level domains can authenticate.

n "Setting up Single Sign On Using IIS6" on page 15-85

n "Setting up Single Sign On Using IIS7" on page 15-89
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After completing these procedures, enable Active Directory within Ektron CMS400.NET (if it

isn’t already enabled). See Also: "Setup Guidelines" on page 15-49

Ektron recommends turning on the auto add options (user and group).

Setting up Single Sign On Using IIS6
Setting up Single Sign On with IIS 6 involves these procedures.

n "Modifying Web.config for Single Sign On" on page 15-85

n "Adjusting Security Settings for the Site Root Folder" on page 15-85

n "Adjusting Security Settings for autologin.aspx" on page 15-87

n "Adjusting the Login Server Control" on page 15-88

Modifying Web.config for Single Sign On
1. Open your site root folder.

2. Open the web.config file.

3. Find the ek_AUTH_protocol element.

4. Change its value to GC. It should look like this:
<add key="ek_AUTH_Protocol" value="GC" />

5. Find the authentication element.

6. Change the value of the impersonate attribute to true. It should look like this:
<authentication mode="Windows" />

<identity impersonate="true" userName="" password=""/>

Adjusting Security Settings for the Site Root Folder
1. Go to Windows Control Panel > Administrative Tools > Internet Information Services.

2. Within IIS, go to Web Sites and select your Ektron CMS400.NET site.

3. Right click your Ektron CMS400.NET site folder and select Properties.
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4. Click the File/Directory Security tab then the top Edit button.

5. Uncheck everything except Anonymous Access. The Account used for anonymous access

should specify a domain account, preferably the root of the Active Directory tree.

Setting up Single Sign On

ReferenceManual

Version 8.0 Rev 1.3
15-87



Adjusting Security Settings for autologin.aspx
1. Go to Windows Control Panel > Administrative Tools > Internet Information Services.

2. Within IIS, go to Web Sites > your Web site’s root folder > Workarea > SSO >

autologin.aspx.

3. Right click autologin.aspx and select Properties.

4. Click the File security tab and the top Edit button.

5. Under Authenticated Access, uncheck all except Integrated Windows Authentication.
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As a result, autologin.aspx will pass credentials from the logged-in user's desktop.

Adjusting the Login Server Control
In Visual Studio.NET, open the Login server control and set the AutoLogin property to True.
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Setting up Single Sign On Using IIS7
n "Modifying Web.config for Single Sign On" on page 15-85

n "Adjusting Security Settings for the Site Root Folder" on page 15-85

n "Adjusting Security Settings for autologin.aspx" on page 15-87

n "Adjusting the Login Server Control" on page 15-88

After completing these procedures, enable Active Directory within Ektron CMS400.NET (if it

isn’t already enabled). See Also: "Setup Guidelines" on page 15-49

Ektron recommends turning on the auto add options (user and group).

Modifying Web.config for Single Sign On
1. Open your site root folder.

2. Open the web.config file.

3. Find the ek_AUTH_protocol element.

4. Change its value to GC. It should look like this:
<add key="ek_AUTH_Protocol" value="GC" />

5. Find the authentication element.

6. Change the value of the impersonate attribute to true. It should look like this:
<authentication mode="Windows" />

<identity impersonate="true" userName="" password=""/>

7. Comment out the following lines.
<!-- <httpModules>
<add name="DigestAuthenticationModule"

type="Ektron.ASM.EkHttpDavHandler.Security.DigestAuthenticationModule,Ektron.ASM.EkHttpDavHandler

" />
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<add name="ScriptModule" type="System.Web.Handlers.ScriptModule, System.Web.Extensions,

Version=1.0.61025.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35" />
</httpModules>

-->

Adjusting Security Settings for the Site Root Folder
1. Go to Windows Control Panel > Administrative Tools > Internet Information Services.

2. Within IIS, go to Sites and select your Ektron CMS400.NET site.

3. From the right panel, select Authentication.

4. On the Authentication screen, enable Anonymous Authentication.
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5. Select Anonymous Authentication and click Edit.

6. Set the credentials to a specific user with a domain account, preferably the root of the

Active Directory tree.

Click Set to select the user.

7. Enter the username and password. Confirm the password.
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Adjusting Security Settings for autologin.aspx
1. Go to Windows > Control Panel > Administrative Tools > Internet Information

Services.

2. Within IIS, go to Web Sites > your Web site’s root folder > Workarea > SSO >

autologin.aspx.

3. From the right panel, enable Windows Authentication.

As a result, autologin.aspx will pass credentials from the logged-in user's desktop.
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Adjusting the Login Server Control
In Visual Studio.NET, open the Login server control and set the AutoLogin property to True.

(Server Controls are explained "Introduction to Ektron CMS400.NET Server Controls" on page

21-2.)
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LDAP Authentication

LDAP is short for Lightweight Directory Access Protocol. It is a set of protocols that enable

corporate directory entries to be arranged in a hierarchical structure which reflects geographic

and organizational boundaries.

Ektron CMS400.NET’s LDAP feature lets you retrieve user Login information from an LDAP

server to Ektron CMS400.NET. As a result, you can administer user information from one

place, and users only need to remember one password/username combination to sign on to the

network and Ektron CMS400.NET.

The hierarchical structure of LDAP authentication can look a few different ways. For example,

if you had the following LDAP structure, the domain would typically span multiple countries.

Note: Here is a list of the abbreviations: CN =CommonName, OU =OrganizationalUnit, O=Organization, DN =

DistinguishedName.

CN=Pitchers Name, OU=Pitchers, O=Baseball Team, C=US, DN=example.com

By changing the order of C and DN, the hierarchy indicates that the domain example.com is

located in the US.

CN=Pitchers Name, OU=Pitchers, O=Baseball Team, DN=example.com, C=US.

In some instances, it may be necessary to have an Organization appear below an

Organizational Unit. This might happen if you have your Organization Unit has it own

Organizations.

Below is a visual example of an LDAP hierarchical structure.
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This chapter covers the following topics:

n "Using LDAP with Ektron CMS400.NET" on page 15-95

n "LDAP Screen Descriptions" on page 15-105

n "Disabling LDAP Authentication" on page 15-109

Using LDAP with Ektron CMS400.NET

Note: Active Directoryand LDAPare not the same.While they can perform some similar functions, LDAPwhen

used with Ektron CMS400.NET only verifiesuser login information and creates the user in the everyone group.

Active Directory can be used to verify user login information only or it can become completely integrated with Ektron

CMS400.NET. To learnmore about using Active Directorywith Ektron CMS400.NET, see "Active Directory

Feature" on page 15-48.

The following sections explain how to use LDAP with Ektron CMS400.NET.

n "Enabling LDAP" on page 15-95

n "Adding an Organizational Unit During Setup" on page 15-98

n "Adding User Information from an LDAP Server to Ektron CMS400.NET" on page 15-99

n "Editing User Information in Ektron CMS400.NET" on page 15-104

n "Deleting Users" on page 15-105

Enabling LDAP
You enable LDAP through the Active Directory Setup screen. To enable the LDAP

functionality in Ektron CMS400.NET, follow these steps. See Also: "The Active Directory

Setup Screen" on page 15-105

Warning! Before enabling LDAP in Ektron CMS400.NET, make sure your LDAP server is set up and ready for

use. Be sure to include an Ektron CMS400.NET administrator account for yourself. Once you enable LDAP, the

only account available to accessEktron CMS400.NET without LDAPauthentication is the BuiltIn account. For

more information on the BuiltIn account, see ”BuiltIn User” on page 19-11.

1. In the webroot\siteroot\web.config file, change the following line:
<add key="ek_AUTH_Protocol" value="None"/>

becomes

<add key="ek_AUTH_Protocol" value="GC"/>

2. Save and close the Web.config file.

3. In the Workarea, navigate to the Settings > Configuration > Active Directory > Setup.

4. Click the Edit button ( ).

Managing Users and User Groups

15-96
ReferenceManual

Version 8.0 Rev 1.3

#
#
#
#
#
#


5. On the Active Directory Setup screen, choose Enable LDAP Authentication.

6. Fill in the following fields.

Field Description For more information, see

Type

Choose the type of LDAP

authentication you are using.

Note: Depending on your choices, the

fields below maybe required or

disallowed.

The following choicesare available:

n Active Directory (LDAP) - Domain

allowed, Organization is not.

n Novell eDirectory/NDS - Organ-

ization allowed, Domain is not.

n Sun Iplanet/JSDS - Domain

allowed, Organization is not.

n Other - Allowsboth Domain and

Organization

"Using Active Directory for LDAP" on

page 15-97

LDAP

Server

The IPAddressor name of the LDAP

server.

Port

The LDAP server port that Ektron

CMS400.NET communicateswith.

If you are unsure, consult the

documentation provided with your

DirectoryService (such as, Novell,

iPlanet, Microsoft, or Red Hat).

Organization

The name of your companyor

organization. For example, Ektron, Inc.

This field can be blank if you enter a

domain in theDomain field.

Domain

The name of the domain you are using.

For example, www.ektron.com. This

should be the same name you used

when you received your license key.

This field can be blank if you enter an

organization in theOrganization field.

Path

The next levels below your

Organization or Domain. These can

includemultiple levels of Organizational
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Field Description For more information, see

Units. For example, Content Editors,

Marketing, East Coast.

Add

Enter your the path you would like

access to in the text field and click the

Add link.

When adding OrganizationalUnits, the

pathsare comma separated and run

from specific to general. For example,

ou=Amherst,ou=New

Hampshire,o=US

Do not add individualCommonNames

here. Only addOrganizationalUnits

that contain the people who should

have access to Ektron CMS400.NET.

Warning! Important: You can have

additionalOrganizationsbelow your

Organization Units as long as the path

on your LDAP server is the same.

"Adding anOrganizationalUnit

During Setup" on page 15-98

To add a single individual from a

different OrganizationalUnit, see

"Adding User Information from an

LDAPServer to Ektron

CMS400.NET" on page 15-99

Delete

Choose anyOrganizationalUnit from

themulti-selection boxand click the

Delete link.

7. Click the Save button ( ).

Using Active Directory for LDAP
In the webroot\siteroot\Web.Config file, add the Username and Password for ek_ADUsername and

ek_ADPassword. For example:

<add key="ek_ADUsername" value="mwright@ektron.com" />

<add key="ek_ADPassword" value="mypasswordisthis" />

When using LDAP to connect to Active Directory, use the following settings in the Workarea.

Note: LDAPusing AD isNOT the same asAD integration. LDAP integration (independent of server type) does

not support groups, only user authentication.
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Field Needed Information

Type Active Directory (LDAP)

LDAPServer [IP Addressof the AD domain controller]

Port 389

Organization [leave this blank]

Domain
[dnsname of the AD domain]

For example: intra.ektron.com

Organizational

Unit

[anyOUs that you want to draw users from]

For example: Support,Users,Ektron Corporate also

Engineering,Users,Ektron Corporate

Adding an Organizational Unit During Setup
Things to consider when adding Organizational Units are:

n Should everyone in the OU have access to Ektron CMS400.NET?

Once LDAP is enabled, users are added to the everyone group upon login. While everyone in

the OU has access to Ektron CMS400.NET, every user does not necessarily have permission to

edit content. To control permissions, set up user groups, adding each user to a group, and

assigning permissions to the group. For more information on user groups, see "Managing Users

and User Groups" on page 15-1. For more information on assigning permissions, see "Folder

Permissions" on page 5-43.

n Do users in other Organizational Units need access?

Sometimes, managers or editors are in a different OU. They need to be added manually, or you

need to add their OU.

When adding an Organizational Unit, several entries might cover the same hierarchical path.

For example, you might have:

n ou=Pitchers,ou=Players,o=Team

n ou=Players,o=Team

n o=Team

This allows you to authenticate users listed in Pitchers, Players, and Team.
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Adding User Information from an LDAP Server to
Ektron CMS400.NET
Users at each level are automatically available for adding to Ektron CMS400.NET. You do not

have to be at the OU or CN level to add a user. If a user is at the DC or OU level, they are

available.

There are three ways to add LDAP user information to Ektron CMS400.NET.

n Have the user log in after LDAP is enabled. As a result, the user appears in the Users list

and is added to the Everyone group.

Note: After a user logs in, some fieldson the AddUser screen can be filled in manually, such as first and last name.

For a description of these fields, see "Fill out the fieldsaccording to the table below." on page 15-101.

n Search an LDAP server for LDAP users using the LDAP Search feature. See Also:

"Searching an LDAP Server for Users" on page 15-99

n Add the user’s LDAP information manually. See Also: "Steps to Manually Add an LDAP

User" on page 15-101.

n A combination of browsing for the user, then manually completing the remaining fields.

See Also: "Using the Browse Feature to Add an LDAP User" on page 15-103

Searching an LDAP Server for Users
The following steps explain how to search for a user on an LDAP server an add them to the

CMS400.NET.

1. Enable LDAP by following the instructions in "Enabling LDAP" on page 15-95.

2. From the left side of the Workarea, click Users.

3. Click the Add Users button ( ).

4. The Add a New User to the System screen appears.
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5. Click the Browse LDAP button ( ).

6. The Search LDAP Users screen appears.

7. Enter search criterion for any of the categories to search.

n Username - the username of the user on the LDAP server.

n Firstname - the first name of the user on the LDAP server.

n Lastname - the last name of the user on the LDAP server

n Path - select a path from the drop down list. The paths that are available are the same

paths that are enabled when configuring the CMS400.NET for use with your LDAP server.

If you select a path and enter no other information, you get back all of the users in that

path.

8. Click the Search button.

9. The search returns any users that match the criteria entered.

10. Click the check box next to the user to be added.
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11. Click the Save button ( )

12. The user is now added to Ektron CMS400.NET and added to the Everyone group. To learn

about how to assign this user to a specific group, see "Assigning Users To User Groups"

on page 15-30.

Steps to Manually Add an LDAP User
The following steps explain how to add an LDAP user manually.

1. Enable LDAP by following the instructions in "Enabling LDAP" on page 15-95.

2. From the left side of the Workarea, click Users.

3. Click the Add Users button ( ).

4. The Add a New User to the System screen appears.

5. Fill out the fields according to the table below.
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Field Description

Username The username of the person logging in, as found on the LDAP server.

Path
The path on the LDAP server to the user. For example:

ou=Amherst,ou=New Hampshire,o=US,dc=local

First Name The first name of the user.

Last Name The last name of the user.

Display

Name

The name of the user that is displayed in the Forumswhen using Discussion

Boards feature. See Also: "Discussion Boards" on page 7-596

User

Language

Select the language in which the user will view Ektron CMS400.NET screensand

messages. The language also determines the default value whenever a drop-

down list of languagesappearswithin Ektron CMS400.NET.

The dropdown list of choicesat this field is derived from the Language Settings

screen, available from the Settings>Configuration folder.

Do not confuse the system language with the user’s ability to create and edit

foreign editionsof content. This field doesnot prevent a user fromworking with

multiple language content.

See Also: Multi-Language Support

Note: If the selected language is not English, French or German, it is only

supported after you download the Ektron CMS400.NET Language Support

Program fromEktron and translate theWeb site.

E-Mail

Address
Enter the email addressof the user.

Forum

Editor

If you are using Discussion Boards feature, specifywhich editor this user uses

when editing in the Forums. Choose from eWebEditPro or the eWebEdit400

Editor. For information on Discussion Boards, see "Discussion Boards" on page

7-596

Disable

Email

Notification

Select to disable email notifications for this user. If you do, the user will not receive

the automatic email notification described in ”Automatic eMailNotification” on

page 1-116. However, this field hasno effect on the user’s ability to receive instant

email.

6. Click Save ( ) to add LDAP users to Ektron CMS400.NET.

7. The View Users in Group Everyone screen appears, displaying the new user and the other

Ektron CMS400.NET users. To learn about how to assign this user to a specific group, see

"Assigning Users To User Groups" on page 15-30.
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Using the Browse Feature to Add an LDAP User
The Browse LDAP feature provides a more friendly and intuitive way to find the username,

domain/organization and organizational unit(s).

Important

Warning! The default server IP/DNSname and port are taken from the settings specified in theConfiguration >

Setup page. These settingsmust be specified before connecting to the LDAP server. See Also: "Enabling LDAP"

on page 15-95

Important

Warning! AnOrganizationalUnit that can see the user to be addedmust be specified in theConfiguration >

Setup page before using the browse feature.See Also: "Enabling LDAP" on page 15-95

1. Enable LDAP by following the instructions in "Enabling LDAP" on page 15-95.

2. From the left side of the Workarea, click Users.

3. Click the Add Users button ( ).

4. The Add a New User to the System screen appears.

5. Click the Browse LDAP button ( ).

6. The LDAP Explorer appears.
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7. Navigate the LDAP server’s folders by clicking on the folder images. Each folder

represents an Organizational Unit (OU). When you choose an OU level, its users appear.

Note: In the LDAPExplorer, the Path andOrg/Domain fieldsupdate dynamically as you navigate through the

LDAP tree.

8. Select a user.

9. The user is now added to Ektron CMS400.NET and added to the Everyone group. To

learn about how to assign this user to a specific group, see "Assigning Users To User

Groups" on page 15-30.

Editing User Information in Ektron CMS400.NET
It is important to note that Ektron CMS400.NET does not write to the LDAP server. So, while

you can change any fields when editing a user in Ektron CMS400.NET, you also need to make

these changes in the LDAP server.

Steps to Edit an LDAP User’s Information
The following steps explain how to edit an LDAP user’s information.

1. In the Workarea, click Settings > Users.

2. In the Username column, click a user to edit.

3. The View User Information screen appears.

4. Click the Edit button ( ).

5. Change the information as needed. For more information on the fields you can edit, see

"Fill out the fields according to the table below." on page 15-101.

6. Click Save ( ).
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Deleting Users
If a user is deleted in an LDAP server, Ektron CMS400.NET does not automatically delete the

user. However, the user’s login fails because he cannot be authenticated.

In this case, you should delete the user from Ektron CMS400.NET using the Delete User

function. See Also: "Deleting a User" on page 15-11

Note: If youmistakenlydelete all userswith administrative privileges, you can still sign in using the builtin user’s

username and password. For more information, see ”BuiltIn User” on page 19-11.

LDAP Screen Descriptions
The LDAP feature uses the following screens:

n "The Active Directory Setup Screen" on page 15-105

n "The View Users Screen" on page 15-106

This section explains how to use each screen.

The Active Directory Setup Screen
The Active Directory Setup screen (illustrated below) lets you enable and disable the Active

Directory or LDAP features, as well as determine other aspects of AD management, such as

whether users and groups are automatically updated. To access the screen, click Settings >

Configuration -> Active Directory -> Setup from the left panel of the Workarea.
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For a description of the fields, see the Active Directory section "The Active Directory Setup

Screen" on page 15-105.

The View Users Screen
The View Users screen (illustrated below) lists all users in the Ektron CMS400.NET database.

To access the screen, click Users from the left panel of the Workarea. To view more

information for a user, click that user to move to the View User Information screen.
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The View Users screen also provides a toolbar button ( ) that lets you add LDAP users
manually to the Ektron CMS400.NET database. This is useful if you want to add a single user

from an Organization that is does not have the same Organizational Unit as the rest of your

users, and you do not want to add any other users from that Organization.

The View User Information Screen
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The View User Information Screen displays the user’s

n username

n Path

n first and last name

n language

n email address and whether the user receives email notifications

n whether the account is locked

n which Forum Editor the user is using

n user groups

n user properties (if any)

The screen also displays the following buttons.
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Button Description

Edit information on screen

Delete user

See Also: "Deleting Users" on page 15-105

Return to previous screen

Disabling LDAP Authentication
If you decide to disable LDAP authentication or integration, edit the Active Directory Setup

screen and select Disable Active Directory and LDAP Authentication.

See Also: "The Active Directory Setup Screen" on page 15-105
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A community is a group of people who network with each other to share information, ideas,

likes and dislikes. Typically, people or members in the community are connected by a

relationship. For example, they work for the same company, went to the same school, share the

same values, or have a friendship.

When a person visits a community site, he can look around to see what type of information,

people and groups are on the site. Typically, the person can see only limited information on

the site. To see all information, he needs to become a member.

When a person signs up to be member, he defines information about himself. This is known as

his member profile. After becoming a member, he can

n search for other members and add them to his friends list

n invite non-members to join the community and become a friend

n join or create a community group

n add photos

n add documents

n leave messages on another member’s message board

n write a private message to another member

n keep a journal of his thoughts

n create a list of favorite CMS400.NET content links

n have a list of content he’s added

n write content reviews

n flag content

The Community Platform in CMS400.NET is a group of features that allow users to network

socially on a Web site. Access to the community platform is available from the Web site or the

Workarea. Only CMS400.NET users and administrators can access their information via the

Workarea. Membership Users, CMS400.NET users, and administrators can access their profile

pages via a Web site.

As an Administrator, you can manage Community features from the Workarea. These features

are described in the following topics:

n "Membership Users and Groups" on page 16-4

n "Accessing a Profile" on page 16-37

n "PhotoGallery Server Control" on page 16-60

n "Message Board Comments Associated with Content in the Workarea" on page 16-76

n "Community Groups" on page 16-91

- "Community Group Server Controls" on page 16-99

n "Distributing Content to Another Ektron CMS400.NET Folder" on page 16-261

CommunityManagement
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n "Flagging" on page 16-193

n "Email Invites for Community Management" on page 16-207

n "Tags" on page 16-228

n Reviews - see ”Content Rating” on page 7-991

n "Assigning Templates to Groups and Members" on page 16-20
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Membership Users and Groups

Membership users are a category of users who have limited privileges to Ektron CMS400.NET.

Unlike regular CMS users, they cannot use the Workarea. When a membership user logs in, he

can view, add and edit content from the Web site (as permitted) -- all other functionality is

disabled.

Membership users can also be granted permission to view private content. This is helpful if

your organization has partners who need access to Web pages that should not be visible to the

general public.

When you have a Social Network or Community Web site, membership users can create an

online area for themselves.

You can use Membership groups to group similar membership users.

The following topics explain membership users and groups in more detail.

n "Privileges of Membership Users" on page 16-4

n "Accessing the Membership Folder" on page 16-5

n "Working with Membership Users" on page 16-6

n "Membership User Groups" on page 16-16

n "Assigning Permissions for Memberships" on page 16-19

n "Troubleshooting Problems with Membership Users and Groups" on page 16-23

n "Membership Server Control" on page 16-24

Privileges of Membership Users
n They can create, edit, and view content after log in.

n They can be granted permission to view private content. See Also: "Membership User/User

Group Example" on page 16-5 and ”Private Content” on page 7-237

n They can self-subscribe to receive Web Alerts. See Also: ”Web Alert Feature” on page 20-

1

n If your site is a Community Web site, they become members of the community and can use

the following features provided by Ektron’s Community Platform. See Also: "Community

Management" on page 16-1”

- Share their Document Workspace and Photo Gallery with other site visitors

- Join a Community Group

CommunityManagement
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- Mark content the member likes and allow site visitors to see the list of these Favorites

- Mark other members or site users as Colleagues.

- Keep a Journal about themselves.

- Add and read comments left on a Message Board

- Send and receive Messages with other registered users.

n If a Discussion Board requires sign in, they can view and post to them. See Also:

”Discussion Boards” on page 7-785

n If a blog requires authentication, they can post blog comments. See Also: ”Blogs” on page

7-640

n If a poll or survey is set up to track participating users, membership users’ names appear on

the Form reports.

Membership User/User Group Example

A typical membership scenario is a Partners section of your Web site that contains private

content for partners only. Set up a membership user group to include users from your partner’s

organization. The group is given add and edit permissions to the Partners section. As a result,

any partner can log into Ektron CMS400.NET and view, add, or edit the private content.

This topic is more fully explained through the following subtopics.

n "Accessing the Membership Folder" on page 16-5

n "Working with Membership Users" on page 16-6

n "Membership User Groups" on page 16-16

n "Assigning Permissions for Memberships" on page 16-19

n "Troubleshooting Problems with Membership Users and Groups" on page 16-23

.

Accessing the Membership Folder
Use the Membership Module folder to enter and edit membership users and user groups. To

access the folder, follow these steps.

1. Navigate to Workarea > Settings > Community Management.

2. Click the Memberships folder to view its subfolders.

Accessing theMembership Folder
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Folder Name More Information

Users "Working with Membership Users" on page 16-6

Users not Verified
”What Happens if Verification email isUsed” on page 20-

36

User Groups "Membership User Groups" on page 16-16

Messages
”What Happens if Verification email isNot Used” on page

20-36

Working with Membership Users
The following sections explain all actions that may be performed on membership users via the

following topics.

n "Adding Membership Users" on page 16-6

n "Adding Membership Users to a Membership User Group" on page 16-17

n "Setting Permissions on Private Content for Membership Users" on page 16-9

n "Viewing Membership User Information" on page 16-9

n "Editing Membership Users" on page 16-11

n "Deleting Membership Users" on page 16-15

Adding Membership Users

Note: If you are using theWeb Alert feature, any site visitor can sign up to be amembership user. That represents

another way to addmembership users. For more information, see ”How UsersSign up for Subscriptions” on page

20-35.

To add a new membership user, follow these steps.

1. Form the Workarea, click Settings > Community Management > Memberships > Users.

2. Click the Add Membership User button ( ).

3. The Add Membership User screen is displayed.

4. Complete the form using the following table as a reference.

CommunityManagement
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Field Description

Username Enter a unique username for themembership user.

First

Name
Enter the first name of the user.

Last

Name
Enter the last name of the user.

Display

Name

The name that is used to identify aMembership user on theWeb site. This can be

different from their Username, which is the name you use to log into the Ektron

CMS400.NET Web site.

Warning! Important: This name needs to be unique inside CMS400.NET and it

cannot be blank.

Password Enter a password for the user.

Confirm

Pwd
Re-type the password to confirm it is correct.

User

Language

Select the language in which the user will viewEktron CMS400.NET
screensandmessages. The language also determines the default value

whenever a drop-down list of languagesappearswithin Ektron CMS400.NET.

The dropdown list of choicesat this field is derived from the Language Settings

screen, available from theSettings> Configuration folder.

Do not confuse the system language with the user’s ability to create and edit

foreign editionsof content. This field doesnot prevent a user fromworking with

multiple language content.

See Also: ”Multi-Language Support” on page 14-1

Note: If the selected language is not English, French or German, it is only

supported after you download the Ektron CMS400.NET Language Support

Program fromEktron and translate theWeb site.

Email

Address
Enter an email address for the user.

Forum

Editor

Determineswhich editor will be used when this user replies to a Discussion Board.

See Also: ”Using Discussion Boardson Your Web Site” on page 7-850

Working with Membership Users
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Field Description

Avatar

An image or icon to represent the user in the Forum.

Type in a web path to image. For example:

http://www.example.com/smileyface.gif

Changing Maximum File Size

Bydefault, an avatar’smaximum size is 200 kilobytes. The height and width of the

avatar is reduced 125 pixels preserving the aspect ratio.

To change the file sizemaximum, edit this file:

C:\inetpub\<wwwroot>\<YourSite>\Workarea\Upload.aspx.vb

In this file, change the line shown below to the desired size:

If (numFileSize > 200) Then

For example, to allow 500kb files, change 200 to 500.

Remember, this number is in kilobytes.

Changing Default Height andWidth

To change the default height and width of the avatar, edit this file:

C:\intetpub\wwwroot\<YourSite>\App_Code\VBCode\Utilities.vb

In this file, change the following lines.

Dim Width As Integer = 125
Dim Height As Integer = 125

For example, to set avatars to a height and width of 166 pixels,
change 125 to 166 in both lines.

Address
The addressused to find your location when a user is performing a search based

on location.

Latitude

The latitude used to find your location when a user is performing a search based

on location.

Googlemapsprovidesa service that takes the addressof user and returns its

latitude and longitude.

Note: You don’t need to useGoogle’s automatic retrieval of latitude and longitude.

Instead, you can enter the valuesmanually.

CommunityManagement
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Field Description

Longitude

The longitude used to find your location when a user is performing a search based

on location.

Googlemapsprovidesa service that takes the addressof content and returns its

latitude and longitude.

Note: You don’t need to useGoogle’s automatic retrieval of latitude and longitude.

Instead, you can enter the valuesmanually.

Any

custom

user

properties

See ”CustomUser Properties” on page 15-16

5. Click the Save button ( ).

See Also: "Working with Membership Users" on page 16-6

Adding Membership Users to a Membership User
Group
See "Adding Membership Users to a Membership User Group" on page 16-17.

Setting Permissions on Private Content for
Membership Users
See "Assigning Permissions for Memberships" on page 16-19.

Viewing Membership User Information
To view membership user information, follow these steps.

1. Access the membership users folder, as described in "Accessing the Membership Folder"

on page 16-5.

Note: The ek_PageSize setting in the web.config file determines themaximum number of users that can appear

on a page before it “breaks.” When a page breaks, additional entriesappear on another screen, and the following

text appearsnear the bottom of the list:

Page 1 of 2[First Page] [Previous Page] [Next Page] [Last Page]

The View Users in Group All Members screen lets you add new users, as well as sort and

search for existing users. See "Sorting Membership Users" on page 16-10 and "Searching

for Membership Users" on page 16-10.

2. Click the user you want to view.

3. The View Membership User Information screen is displayed.

Working with Membership Users
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From this screen, you can edit or delete membership users.

Sorting Membership Users
You can arrange users on the View Users in Group All_Members screen by clicking the

following column headers:

n Username

n Last Name

n First Name

By default, users are arranged alphabetically by Username, starting with the beginning of the

alphabet. To switch that arrangement so that users whose username is last when sorted

alphabetically, click the column header. To revert to the original arrangement, click the header

again.

You can also sort the list by last name or first name. Like username, clicking the column

header reverses the arrangement.

Searching for Membership Users
You can use the Search field (circled below) to display only users who meet your criteria. This

would be especially helpful to filter out a large number of membership users.

Use the Search field to enter unique characters to find members you seek. For example, to find

all members whose username includes @example.com, enter that into the Search field and

click the Search button. Only users with those characters in that exact sequence in their

username, first name, or last name appear on the screen.

You can also search by First and Last name fields. Click the down arrow to the left of the

Search button to select a field to search.

CommunityManagement
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The sequence of search characters must match your entry in the Search field. For example, if

you are searching by last name and enterMI, anyone whose name is Smith appears. But, if you

enter IM, users with the last name of Smith do not appear.

Also, the search is case-insensitive, so MI produces the same results as mi.

See Also: "Working with Membership Users" on page 16-6

Editing Membership Users
To edit a membership user, follow these steps.

1. Access the View Membership User screen of the membership user you want to edit, as

described in "Viewing Membership User Information" on page 16-9.

2. Click the Edit button ( ).

3. The Edit Membership User Information screen is displayed.

4. Use the following table to assist with editing the membership user’s information.

Field Description

General tab (Tabs only appear when editing)

Username Enter a unique username for themembership user.

First Name Enter the first name of the user.

Last Name Enter the last name of the user.

DisplayName

The name used to identify aMembership user on theWeb site. This can be

different from their Username, which is the name theyuse to log in to the

Ektron CMS400.NET Web site.

Warning! Important: This name needs to be unique inside

CMS400.NET and it cannot be blank.

Password Enter a password for the user.

Working with Membership Users
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Field Description

Confirm Pwd Re-type the password to confirm it is correct.

User Language

Select the language in which the user will viewEktron
CMS400.NET screensandmessages. The language also

determines the default value whenever a drop-down list of languages

appearswithin Ektron CMS400.NET.

This field’s list of choices is derived from the Settings > Configuration >

Language Settings screen.

Do not confuse the system language with the user’s ability to create and edit

foreign editionsof content. This field doesnot prevent a user fromworking

with multiple language content.

See Also: ”Multi-Language Support” on page 14-1

Note: If the selected language is not English, French or German, it is only

supported after you download the Ektron CMS400.NET Language

Support Program fromEktron and translate theWeb site.

Email Address Enter an email address for the user.

Content and

ForumEditor

Determineswhich editor will be used when this user replies to a Discussion

Board.

See Also: ”Using Discussion Boardson Your Web Site” on page 7-850

CommunityManagement

16-12
ReferenceManual

Version 8.0 Rev 1.3

#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#


Field Description

Avatar

An image or icon to represent the user in the Forum.

Type in a web path to image. For example:

http://www.example.com/smileyface.gif

Bydefault, themaximum file size of an avatar is limited to 200 kilobytesand

the height and width of the avatar will be reduced 125 pixels preserving the

aspect ratio.

To change the file size limit, edit this file:

C:\inetpub\<wwwroot>\<YourSite>\Workarea\Upload.aspx.vb

In this file, change the line shown below to the size file you wish to allow. For

example, to allow 500kb files, change 200 to 500.

If (numFileSize > 200) Then

Remember, this number is in kilobytes.

To change the default height and width of the avatar, edit this file:

C:\intetpub\wwwroot\<YourSite>\App_

Code\VBCode\Utilities.vb

In this file, change the following lines to the size you wish to allow. For

example, to make avatars have a height and width of 166 pixels, change

125 to 166 in both these lines.

Dim Width As Integer = 125

Address
Enter the addressused to find this user’s location when a search based on

location is being performed.

Latitude,

Longitude

The latitude and longitude used to find this user’s location when someone

performsa search based on location.

Googlemapsprovidesa service that takes the addressof user and returns

its latitude and longitude.

Note: You don’t need to useGoogle’s automatic retrieval of latitude and

longitude. Instead, you can enter the valuesmanually.
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Field Description

ForumSignature

Addsa signature to themembership user’s posts in the forum. You do not

see the signature in the editor. It only appears after you click the Post

button.

Tags

Select from a predefined list of Tags that describe yourself. Or, create a

new tag by clicking theClick To Add A NewTag link. Placing a checkmark

in the checkboxnext to a tag activates it for your profile. See Also: "Tags"

on page 16-228

User Groups (Tabs only appear when editing) - displays user groups to which

member belongs. See Also: "Membership User Groups" on page 16-16

Custom tab (Tabs only appear when editing)

Anycustom user

properties
See ”CustomUser Properties” on page 15-16

Activities tab (Tabs only appear when editing)

ColleaguesSub

Tab

Select the notifications you want to receive when a colleague performsan

activity, and the agent that transmits the notification. For example, if you

want to receive email notificationswhen a colleague posts a blogmessage,

you would place a checkmark in the box for Blog Post in the email column.

See Also: "Notifications" on page 16-129
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Field Description

GroupsSub Tab

Select notifications you want to receive when amember of a community

group performsan activity relating to the group, the agent that transmits the

notification.

For example, you want to receive email notificationswhen a co-member of

a community group posts a blogmessage to group’s blog. To enable this,

would place a checkmark in the box for Group Blog Post in the email

column.

See Also: "Notifications" on page 16-129

This tab sets preferences for all community groups.

For Developers: Ektron has created a UserGroupPreferencesuser

control that a you can add to a community group’s profile page that allows

users to specify notification preferences for individual groups. This control

comeswith CMS400.NET and is located in:

[Drive:]

\[webroot]\[siteroot]\Workarea\Notifications\Controls

To see this user control in an example site, download Ektron’seIntranet

starter site.

http://www.ektron.com/cms400-web-cms.aspx?id=5748

In this site, when a logged inmember of a community group accesseshis

group’s profile page, there is an Edit Group Notifications Preferences

link. Clicking this link opensa thick boxwhich contains the user control.

When the user selects his preferences, theyare stored for that group only.

PrivacySub Tab

Select notifications you want publish when performing variousactivities on

theWeb site. For example, if you want to publish notificationswhen you

posts a blogmessage to your blog, place a checkmark in the box for Blog

Post in thePublish column.

See Also: "Notifications" on page 16-129

5. Click the Update button ( ).

See Also: "Working with Membership Users" on page 16-6

Deleting Membership Users
To delete a membership user, follow these steps.

1. Access the View Membership User screen of the membership user you want to edit, as

described in "Viewing Membership User Information" on page 16-9.

2. Click the Delete button ( ).

3. A confirmation message is displayed.

4. Click OK.

See Also: "Working with Membership Users" on page 16-6

Working with Membership Users

ReferenceManual

Version 8.0 Rev 1.3
16-15



Membership User Groups
Warning! Membership User Groupsand CommunityGroupsare two different concepts. CommunityGroups

allow userswith similar interest to join together in a social networking environment. See "CommunityGroups" on

page 16-91. Membership User Groupsare explained below.

Membership user groups organize similar membership users, reducing the effort required to

assign identical permissions to many users. You can assign them permission to any folder by

going to Folder Properties > View Permissions for Folder > User Type: MemberShip users.

The following sections explain membership user group management.

n "Adding Membership User Groups" on page 16-16

n "Viewing Users in a Membership User Group" on page 16-17

n "Adding Membership Users to a Membership User Group" on page 16-17

n "Setting Permissions on Private Content for Membership User Groups" on page 16-17

n "Editing Membership User Group Name" on page 16-17

n "Deleting User from Membership User Group" on page 16-18

n "Deleting Membership User Groups" on page 16-18

Adding Membership User Groups
To create a new membership user group, follow these steps.

1. Access the membership user group folder, as described in "Accessing the Membership

Folder" on page 16-5.

2. Click the Add Membership User Group button ( ).

3. The Add a New User Group screen is displayed.

4. Enter a unique name for the group.

5. Click the Save button ( ).
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See Also: "Membership User Groups" on page 16-16

Viewing Users in a Membership User Group
To view the information about a membership user group, follow these steps.

1. Access the membership user group folder, as described in "Accessing the Membership

Folder" on page 16-5.

2. Click the membership user group you want to view.

3. The View Users In Group screen is displayed.

See Also: "Membership User Groups" on page 16-16

Adding Membership Users to a Membership User
Group
To add a membership user to a membership user group, follow these steps.

Note: Onlymembership users can be added tomembership user groups.

1. Access the View Membership User Group screen for the membership user group to which

you want to add a membership user, as described in "Viewing Users in a Membership User

Group" on page 16-17.

2. Click the Add Membership User button ( ).

3. The Add User to Group screen is displayed.

Note: Onlymembership userswho do not belong to the group appear.

4. Click the user you want to add.

5. A confirmation message is displayed.

6. Click OK.

See Also: "Membership User Groups" on page 16-16

Setting Permissions on Private Content for
Membership User Groups
See "Assigning Permissions for Memberships" on page 16-19

Editing Membership User Group Name
To edit a membership user group name, follow these steps.

Membership User Groups
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Note: Themembership user group, All_members, cannot be edited.

1. Access the View Membership User Group screen for the membership group you want to

edit, as described in "Viewing Users in a Membership User Group" on page 16-17.

2. Click the Edit button ( ).

3. The Edit User Group screen is displayed.

4. Change the membership group name.

5. Click the Update button ( ).

See Also: "Membership User Groups" on page 16-16

Deleting User from Membership User Group
To remove a user from a membership user group, follow these steps.

1. Access the View Membership User Group screen for the membership user group that

contains the membership user you want to delete, as described in "Viewing Users in a

Membership User Group" on page 16-17.

2. Click the name of the membership user you want to remove.

3. The View User Information screen is displayed.

4. Click the Delete button ( ).

5. A confirmation message is displayed.

6. Click OK.

See Also: "Membership User Groups" on page 16-16

Deleting Membership User Groups
To delete a membership user group, follow these steps.

1. Access the View Membership User Group screen for the membership user group you want

to delete, as described in "Viewing Users in a Membership User Group" on page 16-17.

2. Click the Delete button ( ).

3. A confirmation message is displayed.

4. Click OK.

See Also: "Membership User Groups" on page 16-16

CommunityManagement

16-18
ReferenceManual

Version 8.0 Rev 1.3



Assigning Permissions for
Memberships
After you create membership users and groups, you can assign them permissions to Community

folders only. See Also: ”Community Folders” on page 5-26

To do so, follow these steps.

1. Access the permissions table for the content or folder to which you want to assign

membership permissions.

For See

Content folders ”Setting Permissions for a Content Folder” on page 5-63

Content ”Setting Permissions for Content” on page 5-68

2. If necessary, break the inheritance for the content or folder. See Also: ”Inheritance” on

page 5-60

3. If desired, set the folder or item to Private. See Also: ”Private Content” on page 7-237

4. Click View MemberShip Users on the right side of the permissions table.

5. The membership users/user groups added to the permissions table are displayed.

6. Click the Add button ( ).

7. The Add Permissions screen is displayed.

8. Click a username or user group name to add to the permissions table.

9. The Add Permissions Options screen is displayed.

10. Check appropriate permissions for the membership user or group.

11. Click the Save button ( ).

Assigning Permissions for Memberships
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Assigning Templates to Groups and
Members
As mentioned in "Community Management" on page 16-1, Ektron CMS400.NET ‘s

Community Management feature supports both community and individual member pages. Like

other Ektron CMS400.NET content, Community Management content appears on a dynamic

Web page. Page templates determine each page’s layout and location of elements (menus,

content, blogs, etc.). Below is a sample Community Management template. See Also:

"Creating/Updating Templates" on page 7-184

Sample Group Template within Visual Studio.NET

Sample Group Template on a Web Page

The Community Management feature includes six templates:

n Community Group

- documents

- photos

- journal

n User

- documents

CommunityManagement
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- photos

- journal

Ektron CMS400.NET provides a sample for each template. You can use the sample or create

your own. If you begin with a sample template and modify it, be sure to save it under a

different name to prevent it from being overwritten when you upgrade.

See Also: "The Templates Screen" on page 16-21

The Templates Screen
Use the Templates screen to assign templates to Community Management pages.

See Also: "Assigning Templates to Groups and Members" on page 16-20

The following table explains the fields on the Templates screen.

Assigning Templates to Groups andMembers
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Field Page that displays template

Group Templates

Community

Document

Page hosts the CommunityDocumentsServer Control; ObjectType property is

set toGroup

Photo

Gallery

Page hosts the PhotoGalleryServer Control; ObjectType property is set to

Group

Journal Page hosts the Blog Server Control, and the blog wascreated for a group page

Profile

Page that hosts a CommunityGroup Profile server control.

Note, however, that a site visitor, while viewing a page, mayclick an icon to visit a

CommunityGroup profile from there. See image below.

In this case, if the original control hasa TemplateUserProfiledefined, that

value overrides this field and defines the template in which the CommunityGroup

profile is displayed.

User Templates

Community

Document

Page hosts the CommunityDocumentsServer Control; ObjectType property is

set toUser

Photo

Gallery
Page hosts the PhotoGalleryServer Control; ObjectType property is set toUser

Journal Page hosts the Blog Server Control, and the blog wascreated for a user page

CommunityManagement
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Field Page that displays template

Profile

Page that hosts a User Profile server control.

Note that a site visitor mayclick an user icon to visit a user profile from another

page. See image below.

In this case, if the original control hasa TemplateUserProfileproperty value

defined, that value overrides this field and defines the template in which the user

profile is displayed.

Troubleshooting Problems with
Membership Users and Groups

Symptom Problem Solution

Error message:

Response object

error 'ASP 0251 :

80004005'

Response

Buffer

exceeded its

limit

Increase limit. To do so, follow these steps.

1. Stop IIS.

2. Locate the file
%WinDir%\System32\Inetsrv\Metabase.xml

3. Modify the AspBufferingLimit value.

4. Restart IIS.
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Symptom Problem Solution

Response Buffer

Limit Exceeded

The default value is 4194304, which is about 4MB.

Suggest changing it to 20MB (20971520) and see if

that helps.

Membership Server Control
The Membership server control creates a tabbed form on a Web page that allows a site visitor

to create or update a profile of themselves. The control creates the form provides tabs for site

visitors to enter the following types of information.

n General - see "Items on the General Tab" on page 16-25

n Forum - see "Items on the Forum Tab" on page 16-27

n Tags - see "Items on the Tags Tab" on page 16-28

n Custom - see "Items on the Tags Tab" on page 16-28

n Category - see "Items on the Category Tab" on page 16-29

n Activities - see "Items on the Activities Tab" on page 16-30

It also provides a way to have new membership users read and accept the terms and conditions

for using Discussion Boards (Forums) when needed.

Below is an example of the Membership server control when viewed on a Web page.
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It is recommended that you review the following documentation when using the Membership

server control.

n ”Managing Users and User Groups” on page 15-1

n ”Web Alert Feature” on page 20-1

n ”Terms & Conditions” on page 7-798

Understanding these topics along with using this server control extends the most functionality

to your membership users.

Tabs on the Membership Server Control
A member’s profile on this server control is separated by tabs. This allows for the most

functionality in the least amount of space.

Items on the General Tab
The items on the General tab define information about a membership user. When an item has

an asterisk next to it, it must be filled out before the form can be submitted. The following

items appear on the General Tab.
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Field Description

First

Name
Auser’s first name.

Last

Name
Auser’s last name.

Password

If desired, enter a new password into this field.

Note: If you change your password, you do not need to log out then log back in.

However, the next time you log in, youmust use the new password.

Confirm

Pwd
Confirm your new password by retyping it into this field.

E-Mail

Address

Enter a new valid email address. Notification email is sent to this addressunless the

Disable E-mail Notification field is checked.

To understand how email notification operateswithin the content workflow, see

”Example of an ApprovalChain” on page 5-47.

Also, this address identifies the user sending Instant email.See Also: ”Instant

eMail” on page 1-121

Display

Name

The name that is used to identify the user on theWeb site. This can be different

from the user’sUsername, which is the name you use to log into the Ektron

CMS400.NET Web site.

User

Language

Select a language in which to view Ektron CMS400.NET. Click the blackdown

arrow on the right of the drop down box to see a list of choices.

Address
The addressused to find your location when a user is performing a search based

on location.

Latitude

The latitude used to find your location when a user is performing a search based on

location.

Googlemapsprovidesa service that takes the addressof user and returns its

latitude and longitude.

Note: You don’t need to useGoogle’s automatic retrieval of latitude and longitude.

Instead, you can enter the valuesmanually.

Longitude

The longitude used to find your location when a user is performing a search based

on location.

Googlemapsprovidesa service that takes the addressof content and returns its

latitude and longitude.

Note: You don’t need to useGoogle’s automatic retrieval of latitude and longitude.

Instead, you can enter the valuesmanually.
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Field Description

Avatar

An image or icon to represent you on theWeb site. Click theClick to upload your

avatar link to upload an avatar to the system. This link is controlled by the

AllowAvatarUpload property.

By default, themaximum file size of an avatar is limited to 200

kilobytes and the height and width of the avatar will be reduced 125

pixels preserving the aspect ratio.

To change the file size limit, edit this file:

C:\inetpub\<wwwroot>\<YourSite>\Workarea\Upload.aspx.vb

In this file, change the line shown below to the size file you wish to

allow. For example, to allow 500kb files, change 200 to 500.

If (numFileSize > 200) Then

Remember, this number is in kilobytes.

To change the default height and width of the avatar, edit this file:

C:\intetpub\wwwroot\<YourSite>\App_Code\VBCode\Utilities.vb

In this file, change the following lines to the size you wish to allow.

For example, to make avatars have a height and width of 166

pixels, change 125 to 166 in both these lines.

Dim Width As Integer = 125
Dim Height As Integer = 125

Items on the Forum Tab
The Forum tab allows a user select settings for the Forum. The following items appear on the

General Tab.
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Field Description

Forum

Editor
Select the type of editor to use when creating Forum posts.

Topics per

Page
The amount of Forum topics displayed on a page.

Forum

Signature

In the text area, add a signature. This signature will be appended to all posts

submitted bya user. For example:

Regards,

John Edit

Content Creator

Custom Content Creations, Inc.

Items on the Tags Tab
Tags allow users to identify themselves by means of a common term. A user can select from a

predefined list of Tags. Or, create a new tag by clicking the Click To Add A New Tag link.

Placing a check mark in the check box next to a tag activates it for a user’s profile.

Items on the Custom Tab
The Custom tab displays custom settings for Message Boards and User calendars as well as

Privacy Settings and User Properties that are created by the administrator of the site.
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Put a check mark in the Moderate Message Board checkbox to allow the member to moderate

or approve comments made on their personal message board.

Put a check mark in the checkbox that says Allow Event Edits on User Calendars to let this

person edit events on their calendar. If this is unchecked, the calendar is displayed but events

cannot be added

Select whether this profile is displayed to any visitor or privately to only colleagues.

The fields that follow are created by the administrator in the Settings > User Properties section.

See Also: ”Custom User Properties” on page 15-16

For example, subscriptions, an employee ID or a user’s birthday might appear on this tab.

Unlike items on the General tab, these items change from organization to organization. If an

administrator creates a property such as Employee ID number, it appears even when a

membership user views this form. The Membership server control’s ShowExtended property

allows you to decide if want the custom user properties to appear when the form is viewed.

Items on the Category Tab
The Category tab allows a user to select from a list of taxonomy categories that they wish to

be associated with. You can choose which taxonomy appears on the tab by setting the

TaxonomyID property.

Warning! The Category tab appears onlywhen an ID is assigned to the TaxonomyIDproperty.
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Items on the Activities Tab
The Activities tab allows a user to select the activities for which he will receive notification

messages and the means by which these messages are sent. Notifications are messages that are

sent from one user to another when certain activities happen.

Notification messages are sent through an “agent” which determines how the notification is

handled. For example, users can receive notifications via the ActivityStream server control,

email or SMS. The agents that are available are determined by an Administrator in the

Workarea > Settings > Community Management > Notifications > Agents screen. See
Also: "Review Notification Agents" on page 16-136

The Activities tab has three sub tabs,

n Colleagues tab - used to select which notifications are received from colleagues when they

perform certain actions.

n Groups tab - used to select which notifications are received from members of a community

group when a user in the group performs an action related to the group.

n Privacy tab - allows a user to decide which activities generate notifications when he

performs an action.

The image below show a user who has chosen to receive all notification messages through the

ActivityStream server control.
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Membership Server Control Properties
The following table explains the properties of the Membership server control.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value
Data

Type

AllowAvatarUpload

When set toActive, theClick to upload your avatar link appears

on theGeneral tab. This allows site visitors to upload an avatar

when registering for the site.

When set toDisable, the link is hidden.

If you want to force site visitors to choose from a predefined gallery

of avatars, enter a path to the template containing the avatars.

The predefined gallery appears in a pop-up window. If you want to

adjust the properties of thiswindow, edit the

<siteroot>\<webroot>\workarea\java\membershiptabs.js

file.

String
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Property Value
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to

browse to Content, Collections, etc.See Also: ”Using CMS

Explorer to Browse Your Ektron CMS400.NET Site” on page 21-12

String

BoardID

The ID of the Discussion Board for which to show the Termsand

Conditions.See Also: "ShowTerms" on page 16-36.

If you don’t know the ID, click the Ellipsesbutton ( ), then sign in,
browse to and select the Discussion Board.See Also: ”Using

CMSExplorer to Browse Your Ektron CMS400.NET Site” on page

21-12

Long

DisplayMode

The type of membership form displayed. Choose from the following.

n UserRegistration - Lets a site visitor register asamem-

bership user.

n ResetPassword - Lets amembership user reset his pass-

word.

n UnsubscribeSecured - Lets amembership user unsub-

scribe. He needs to enter his username and password.

n UnsubscribeUnsecured - Lets amembership user unsub-

scribe byentering hismembership username only.

n AccountActivate - Let a site visitor activate hismembership

account byentering the ID number in the account verification email.

For more information, see "DisplayMode" on page 16-35.

Mode

DynamicParameter
Tomake this control dynamic, select id.When you do, this server

control is attached to the user passed asa URL parameter.

Hide

Used to hide login button in design time and run time.

True =Hide login button

False =Show login button

Boolean

JavascriptEditorHeight

Note: Asof version 7.6, the JavaScript editor hasbeen removed

from the product. This property hasbeen deprecated.

Set the height in pixels for the Signature editor. The default is 300.

Integer

JavascriptEditorWidth

Note: Asof version 7.6, the JavaScript editor hasbeen removed

from the product. This property hasbeen deprecated.

Set the width in pixels for the Signature editor. The default is 360.

Integer

Language
Set a language for the server control. This property shows results in

design-time (in VisualStudio) and at run-time (in a browser).
Integer
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Property Value
Data

Type

RedirectFailedURL

The URLwhere amembership user is sent if the registration fails.

n If the page resides in the same folder as the registration page,

enter the name of the page. For example,RegFailed.aspx.

n If the redirect page is located in a subfolder, add the folder

path. For example,members\RegFailed.aspx.

String

RedirectSucessURL

The URLwhere amembership user is sent when the registration

succeeds.

n If the page resides in the same folder as the registration page,

enter the name of the page. For example,RegSucceed.aspx.

n If the redirect page is located in a subfolder, add the folder

path. For example,members\RegSucceed.aspx.

String

RegisterButtonImg

Lets you add an image in place of the text on the register button.

Enter a path to the image. For example:

http://www.example.com/buttons/registerbutton.gif

If the image is located in the site root, you do not need to enter the

full path. Only enter the subfolder path and image name. For

example:

/buttons/registerbutton.gif

String

RegisterButtonText
Text that appears on the Register button. The default isRegister.

If you use a register button image, you do not see this text.
String

ResetButtonImg

Lets you add an image in place of the text on the reset button. Enter

a path to the image. For example:

http://www.example.com/buttons/resetbutton.gif

If the image is located in the site root, you do not need to enter the

full path. Only enter the subfolder path and image name. For

example:

/buttons/resetbutton.gif

String

ResetButtonText
Text that appears on the reset button. The default isReset. If you

use a reset button image, you do not see this text.
String

SaveButtonImg

Lets you add an image in place of the text on the save button. Enter

a path to the image. For example:

http://www.example.com/buttons/savebutton.gif

If the image is located in the site root, you do not need to enter the

full path. Only enter the subfolder path and image name. For

example:

/buttons/savebutton.gif

String
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Property Value
Data

Type

SaveButtonText
Text that appears on the save button. The default isSave. If you use

a save button image, you do not see this text.
String

ShowExtended

Decide if the CustomUser PropertiesTab is available when using

this control. The default setting isTrue.

True - Show CustomUser Properties tab.

False - Hide CustomUser Properties tab.

Note: For more information, see ”CustomUser Properties” on

page 15-16.

String

ShowTerms

When set to True, this property shows the Termsand Conditionsas

defined in theWorkarea. In addition, users are asked to checka box

stating theyhave read and agree to abide by the termsand

conditionsof the forum. Default isFalse.

See Also: "ShowTerms" on page 16-36 and ”Terms&

Conditions” on page 7-798

Boolean

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The

default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TaxonomyID

The numeric ID of the taxonomy that is available to users. A user

editing or creating a profile can select which categories to associate

with their profiles.

See Also: "Itemson the CategoryTab" on page 16-29 and

”Taxonomy” on page 9-253

Long

UserExists

Message

Themessage that appearswhen amembership user already

exists. The default message is:Username(email) already exists!
String

UserSuccessMessage

Themessage that appearswhen amembership user successfully

registers. The default message is:You have registered

successfully.

You can also use this property to set themessage that appears

when users successfully unsubscribe or reset their password. To do

this, enter the successmessage in this property and set the

DisplayModeproperty to the proper usage.

String

UserUpdateSuccessMessage

Themessage that appearswhen amembership user successfully

updates their information. The default message is: You have

successfully updated your information.

String
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Property Value
Data

Type

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a

blockof code.

Custom - Allows you to use a custom tag.

String

DisplayMode
Lets a developer decide what type of membership form is added to the Web form. The

following table describes settings for the DisplayMode property.

Setting Description Example

User

Registration

Lets a site visitor register asamembership

user.

Thismode also allowsmembership users to

update their information and preferences

when theyare logged in.

Reset

Password
Lets amembership user reset his password.

Unsubscribe

Secured

Lets amembership user unsubscribe. The

membership user needs to enter his

username and password to unsubscribe.

Unsubscribe

Unsecured

Lets amembership user unsubscribe by

entering hismembership username only.

Account

Activate

Let a site visitor activate hismembership

account byentering the ID number sent him

in the account verification email.
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ShowTerms
Setting the ShowTerms property to True allows you to show the Terms and Conditions for the

forum. In addition, users are asked to check a box stating they have read and agree to abide by

the terms and conditions of the forum.

Terms and Conditions are added in the Workarea. See Also: ”Terms & Conditions” on page

7-798

Note: If there are no Termsand Conditionsdefined in theWorkarea, setting the ShowTermsproperty to True

doesnothing.

Setting this property to False hides the terms and conditions of the forum. If Terms and

Conditions are defined in the Workarea and this property is set to False, users will still have to

read and accept the Terms and Conditions the first time they create a post or a reply.
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Accessing a Profile
A Profile provides users with information about a user. Administrators can access user profiles

from the Workarea. CMS400.NET users can access their profile from the Workarea or the Web

site. Membership users can only access their profile page from the Web site.

Warning! For CMS400.NET users, some profile information in theWorkarea’sViewUser Information screen is

not available on theWeb site profile page. That information involvesWorkarea settings.

Profiles in the Workarea

In the Workarea, profiles are located in the following areas:

n For CMS400.NET Users - navigate to Settings > Users. See "Managing Users" on page 15-

3

n For Membership Users - navigate to Settings > Community Management > Memberships

> Users. See the "Working with Membership Users" on page 16-6

UserProfile Server Control
The UserProfile control displays information about a user. A user’s Profile page is their home

on the Web site. The following information is displayed in a user’s profile.

n The user’s Avatar

n Any Personal Tags associated with the user

n The user’s Screen Name

n Any Custom Properties associated with the user
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In addition to displaying profile information, logged in users can edit their profile by clicking

the Edit Profile link. When a user clicks this link, a dialog appears allowing the user to edit

any of the available information.

This dialog box is the same dialog that a membership user uses to create an account on the site.

See "Tabs on the Membership Server Control" on page 16-25 for a description of the tabs an

fields contained in this dialog.
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UserProfile Server Control Properties
The UserProfile server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMS

Explorer and can use it to browse to

Content, Collections, etc. See Also: ”Using

CMSExplorer to Browse Your Ektron

CMS400.NET Site” on page 21-12

String

AvatarHeight
The display height of the avatar in the

profile area.
Integer

AvatarWidth
The displaywidth of the avatar in the profile

area.
Integer

CacheInterval

Sets the amount of time the server control’s

data is cached. The default is 0 (zero). This

is the amount of time, in seconds, a

control’s data is cached. For example, if

you want to cache the data for fiveminutes,

set this property to 300 (three hundred).

Double
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Property Description Data Type

See Also: ”Caching with Server Controls”

on page 21-42

DefaultUserID

The default user ID for this control to use

when there is nomatching dynamic

parameter value passed.

Long

DisplayXslt

Determineshow information is displayed

on the page. Enter the path to the XSL file.

It can be relative or absolute.

Warning! : If you specify an external file, it

is strongly recommended that you do not

store this file in your site'sWorkarea

folder. If you store this file in theWorkarea

folder, the file will be lost when you

upgrade.

String

DynamicParameter

Gets or sets the QueryString parameter to

read a user ID dynamically. To use the

default object ID, leave blank.

String

EnableEmailDisplay

Set to True to display a user’s email

address in his profile. If a user’sPrivate

Profile setting is set to Private, his profile

information is not visible, regardlessof this

property’s setting. If Private Profile is set to

Colleagues, only a user’s colleagues can

see email information.

True - display a user’s email address in his

profile.

False - do not display a user’s email

address in his profile.

Boolean

Hide

Used to hide output of the control in design

time and run time.

True =Hide control

False =Display control

Boolean

Language

Set a language for viewing the server

control. This property shows information in

design-time (in VisualStudio) and at run-

time (in a browser).

Integer

CommunityManagement

16-40
ReferenceManual

Version 8.0 Rev 1.3

#
#
#
#
#
#
#
#


Property Description Data Type

Stylesheet

Specify the path to a style sheet for use with

the Documents server control. The location

can be relative or absolute. Leave blank to

use the default style sheet.

String

SuppressWrapperTags

Suppresses the output of the span/div tags

around the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TagTemplate

TheWeb page template that contains the

CommunitySearch server control. This

allowsusers to perform a search for users

with the same tags.When template is

entered, Personal Tags in the Profile

appear as links. Clicking a tag forwards the

user to the User Search page that displays

the search results for thematching tag.

String

TagTemplateTarget

Determines the type of window that

appears on thisWeb formwhen a user

clicks an item in the server control. The

default is _self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

ItemLinkTargets

TaxonomyId

The numeric ID of the taxonomy that is

available to users. A user editing a profile

can select which categories to associate

with their profiles.

See Also: "Itemson the Category

Tab" on page 16-29; ”Taxonomy” on page

9-253

Long

WrapTag

Allowsa developer to specify a server

control’s tag.

The default isSpan.

Span - The <span> tag is used to

designate an inline portion of an HTML

document asa span element.

Div - The <div> tag is used when you want

to apply attributes to a blockof code.

Custom - Allows you to use a custom tag.

String
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Friends Server Control
Part of the Community Platform, the Friends server control displays a list of users who are

colleagues of the member you are viewing. This control is typically located on a User’s profile

page. The control can be set to display a list of:

n current colleagues

n current colleagues sorted into folders

n pending colleagues

n invited colleagues

In addition, you can set the control to allow a user to navigate between these views. Clicking a

user link in the list takes you to user’s profile page.

When the Friends server control is in Pending Colleagues mode, a logged in user can approve

or decline his pending colleague requests. When it’s in Invited mode, a logged in user can

cancel colleague invites he has sent, but have yet to be accepted.

The control also allows a user to mark a colleague as a Selected Colleague. Selected colleagues

are allowed to view documents and photos that regular colleagues and the public cannot view.

The following topics are covered in this section:

n "Setting the Friends Server Control’s Display Mode" on page 16-43

n "Managing Existing Colleagues" on page 16-46

n "View Pending Colleagues" on page 16-47

n "Viewing Invited Colleagues" on page 16-47

n "Marking a Colleague as a Selected Colleague" on page 16-48

n "Changing a Folder’s Name or Description" on page 16-49

n "Friends Server Control Properties" on page 16-50

CommunityManagement

16-42
ReferenceManual

Version 8.0 Rev 1.3



Setting the Friends Server Control’s Display Mode
The DisplayMode property controls whether a user’s colleagues are displayed as a basic list,

grouped by common themes in folders, colleagues who have requested you to become their

colleague or people you invited to become your colleague.

Grouping colleagues allows a user to sort colleagues into different groups by folder. For

example, a user might group all colleagues that are family under a folder named Family. You

can only group current colleagues, not colleagues that are pending or invited.

Grouping Colleagues by Folder

To move a colleague to a folder, follow these steps.

1. Make sure the DisplayMode property for the Friends server control is set to

Directory.

2. Log into the Web site.

3. Navigate to your profile page or the page the contains the Friends server control.

4. Create a folder by clicking the Add Folder link in the Friends server control.
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5. Enter a Name and Description for the folder in the provided text boxes.

6. Click the OK link to add the folder.

7. Click the Move link on the Friends server control.

CommunityManagement

16-44
ReferenceManual

Version 8.0 Rev 1.3



8. Mark a Colleague and select the folder to which it will be moved.

9. Click the OK link to move the colleague.
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10. A dialog box appears asking you confirm moving the items. Click OK.

11. The colleague can now be found under the folder. Click the folder to see all colleague in

that folder.

Managing Existing Colleagues
To manage existing colleagues on the Web site, find the Colleague area of your profile page.

From this area, users can view, approve and remove colleagues.

Viewing the Existing Colleagues List

The colleagues list provides a quick and easy way to view your colleagues. This list contains

the following information.

Field Description

Avatar An image representing the user.

DisplayName
The user’s display name as it appears in blogs, forumsposts and

message board comments.

Removing Colleagues

If you would like to end your association with another user, you can remove the colleague. To

remove a colleague on the Web site, follow these steps.

1. Navigate to Colleagues area of your profile page.

2. Place a check mark in the check box next to each colleague you want to remove.

3. Click the Remove Selected link.

4. A dialog box appears and asks you to confirm that colleague is to be removed.
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5. Click OK.

The page refreshes and the user is removed from your colleagues list.

View Pending Colleagues
Pending Colleagues are users that have sent you a colleague request which you have yet to

accept. To view pending colleagues on the Web site, navigate to the Pending Colleagues area

of your profile page. From this area, you can accept and decline colleague requests.

Accepting a Pending Colleague Request

Accepting a colleague request adds the user to your colleagues list. This allows you to access

additional information on their profile page. To accept a pending colleague request, follow

these steps.

1. Navigate to the Pending colleagues area of your profile page.

2. Place a check mark in the check box next to each colleague whose request you want to

accept.

3. Click the Approve link.

The page refreshes and the users are removed from the Pending Colleagues list and added to

the colleagues list. See Also: "Viewing the Existing Colleagues List" on page 16-46

Declining a Pending Colleague Request

Declining a colleague request cancels the request. Once you decline the request, it is removed

from your Pending Colleagues list and the requester’s Invited list. To decline a colleague

request, follow these steps.

1. Navigate to the Pending Colleagues area of your profile page.

2. Place a check mark in the check box next to each colleague whose request you want to

decline.

3. Click the Remove Selected link.

4. A dialog box appears asking you to confirm that you are declining the colleague.

5. Click OK.

The page refreshes and the users are removed from the Pending Colleagues list and requester’s

Invited list.

Viewing Invited Colleagues
The Invited Colleagues list allows you to view a list of users to whom you’ve sent Colleague

invites. From this screen, you can also delete requests that have yet to be accepted. See Also:

"Canceling Invited Colleagues" on page 16-48

To view sent colleague requests, navigate to the Invited Colleagues area of your profile page.
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Canceling Invited Colleagues

If you want to cancel a colleague request, follow these steps.

1. Navigate to the Invited Colleagues area of your profile page.

2. Place a check mark in the check box next to each colleague whose invite you want to

cancel.

3. Click the Remove Selected link.

4. A dialog box appears asking you to confirm that you are canceling the colleague invites.

5. Click OK.

The page refreshed and the invited colleague is removed from the Invited Colleagues list and

the colleague’s Pending list.

Marking a Colleague as a Selected Colleague
Selected Colleagues are colleagues that are allowed to view additional documents and photos

that regular colleagues cannot view. When a user shares a Workspace containing documents or

photos, the user can select whether to share the photos with the Public, Colleagues or Selected

Colleagues. See Also: "Sharing Workspace Content" on page 16-123.

Follow these steps to mark a colleague as a Selected Colleague.

1. Navigate to the Colleagues area of your profile page.

2. Place a check mark in the check box next to each colleague you want to make a Selected

Colleague.

3. Click the Update link.

4. A dialog box appears asking you to confirm the status change of the colleague.
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5. Click OK.

Selected Colleague appears in parentheses next to the colleague.

You can change a selected colleague back to a colleague by placing a check mark in the

check box next to a selected colleague and clicking the update link.

Changing a Folder’s Name or Description

A user can change a folder’s name or its description by clicking the Edit Folder icon ( ) next
to the folder’s title. Clicking the icon launches a dialog box that allows you to enter a new

name or description.

Once the changes are made, click the Save button.
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Friends Server Control Properties
The Friends server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer

and can use it to browse to Content, Collections, etc.

See Also: ”Using CMSExplorer to Browse Your

Ektron CMS400.NET Site” on page 21-12

String

AvatarHeight
The display height of the avatar in the results box. 0

(zero) = unlimited.
Integer

AvatarWidth
The displaywidth of the avatar in the results box. 0

(zero) = unlimited.
Integer

CacheInterval

Sets the amount of time the server control’s data is

cached. The default is 0 (zero). This is the amount of

time, in seconds, a control’s data is cached. For

example, if you want to cache the data for five

minutes, set this property to 300 (three hundred).

See Also: ”Caching with Server Controls” on page

21-42.

Double

DefaultUserID
The default user ID for this control to use when there

is nomatching dynamic parameter value passed.
Long

DisplayMode

Select the way this control displays colleagues.

Choicesare:

Directory - this selection allowsusers to group their

colleaguesby folders.When this selection is chosen,

the followingmenu itemsare added to the control:

- Add Folder - allows a user to add a

sub folder.

- Move - allows a user to move users

into a folder. This item only appears

when there is a folder.

List - showsa list colleagues in alphabetical order.

eDisplayMode
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Property Description Data Type

Pending - showsa list pending colleagues. This list is

made up of user who have sent you colleague

requests.

SentInvites - showsa list of users to whom you’ve

sent colleague requests.

See Also: "Setting the FriendsServer Control’s

DisplayMode" on page 16-43

DisplayXslt

Determineshow information is displayed on the

page. Enter the path to the XSL file. It can be relative

or absolute.

Warning! If you specify an external file, it is strongly

recommended that you do not store this file in your

site'sWorkarea folder. If you store this file in the

Workarea folder, the file will be lost when you

upgrade.

Warning! If you enter a valid EkML file at theMark-

upLanguage property, theDisplayXslt prop-

erty value is ignored.

String

DynamicParameter

Gets or sets the QueryString parameter to read a

user ID dynamically. To use the default user ID, leave

blank.

String

FriendLabel
Set the singular text to be used asa title for the

Friends server control.
String

FriendsLabel
Set the plural text to be used asa title for the Friends

server control.
String

Hide

Used to hide output of the control in design time and

run time.

True =Hide control

False =Display control

Boolean
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Property Description Data Type

Language

Set a language for viewing the Friends control. This

property shows results in design-time (in Visual

Studio) and at run-time (in a browser).

Integer

Link

Enter a link to the user profile page. This allowsa

user to click a link in the Friends control and be taken

to the user’s profile page. There are two variables

used within the link that represent the user’s ID and

the user’s display name.

{0} - represents the user’s ID.

{1} - represents the user’s display name.

You need to have both variables in the link. TheWeb

form can be relative or absolute. Below is an

example.

userprofilepage.aspx?uid={0}&dn={1}

String

LinkTarget

Determines the type of window that appears on this

Web formwhen a user clicks an item in the Friends

control. The default is _self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

ItemLinkTargets

MarkupLanguage

Identify the templatemarkup file that controls the

display of the server control. For example,

mymarkup.ekml. If the *.ekml file is located in the

same folder as theWeb form containing the server

control, just enter its name. Otherwise, the path to the

file can be relative or absolute. See Also: ”Ektron

Markup Language” on page 21-35

String

MaxResults
TheMaximum number of items to fetch. 0 (zero) =

unlimited.
Integer

ShowSortingOptions

Select whether the sorting options should be shown

on the control. The following sorting optionsare

available when this property is set to True:

Colleagues - a list of current colleagues.

Pending Colleagues - a list of colleagueswho have

sent you colleague requests, but you have yet to

accept.

Invited - a list of colleagues to whom you have sent

colleague requests.

Boolean
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Property Description Data Type

Stylesheet

Specify the path to a style sheet for use with the

server control. The location can be relative or

absolute. Leave blank to use the default style sheet.

Warning! If you enter a valid EkML file at theMark-

upLanguage property, theStylesheet prop-

erty is ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround

the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline

portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply

attributes to a blockof code.

Custom - Allows you to use a custom tag.

String

Favorites Server Control
The Favorites server control displays a list of content items that the user has designated as their

favorite content. Clicking a link in the list takes you to the content. To learn about

designating content as a favorite, see "SocialBar Server Control" on page 16-219. Users can

also add URL links to their favorites via the Add Link item in the Favorites server control or a

Social Bar’s Add to Favorites link.

Note: To learn about to setting up the SocialBar for users to add URLs to their Favorites, see "Adding aWeb

Page’sURL to a User’sFavoritesVia the SocialBar" on page 16-220.

In the control, content items and URLs are contained in separate lists. To view a list of content

items, click on the Content link. To view a list of URLs, click the Link link.
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Adding a URL to Your Favorites
User’s can add a URL to their Favorites by either clicking the Add Link on the Favorites

server control and entering the link’s information or the Add to Favorites link on the Social

Bar server control.

Note: To learn about to setting up the SocialBar for users to add URLs to their Favorites, see "Adding aWeb

Page’sURL to a User’sFavoritesVia the SocialBar" on page 16-220.

To add a URL using the Favorites server control, follow these steps.

1. Log-in and navigate to the profile Web page where the Favorite control is located.

2. Click the Add Link link.

3. In the Name text box, add a name for the URL link.

4. In the Link text box, add the URL.

5. In the Description text area, add a description for the URL. This is optional.

6. Click OK.

Once a URL is added, it appears on the Links list in the control.

Grouping Favorites by Folder
The DisplayMode property controls whether a user’s Favorites are displayed as a basic list

or if the user can group his Favorites by common theme in a folder. For example, a user might

group all content created by a certain author under a folder with that author’s name.

When a folder is added to a user’s favorites, content items in the folder appear in the Content

list; URLs in the folder appear in the Links list.

Moving Favorites to a Folder

To move a Favorite to a folder, follow these steps.

CommunityManagement

16-54
ReferenceManual

Version 8.0 Rev 1.3



1. Make sure the DisplayMode property for the Favorites server control is set to

Directory.

2. Log into the Web site.

3. Navigate to your profile page or the page the contains the Favorites server control.

4. Create a Folder by clicking the Add Folder link in the Favorites server control.

5. Enter a Name and Description for the folder in the provided text boxes.

6. Click the OK link to add the folder.
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7. Click the Move link on the Favorites server control.

8. Mark a favorite item(s) and select the folder to which it will be moved.

9. Click the Move link to move the favorite items.
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10. A dialog box appears asking you confirm moving the items. Click OK.

The Favorite content can now be found under the folder. Click the folder to see all content in

that folder.

Changing a Folder’s Name orDescription

A user can change a folder’s name or its description by clicking the Edit Folder icon ( ) next
to the folder’s title. Clicking the icon launches a dialog box that allows you to enter a new

name or description.

Once the changes are made, click the Save button.

Favorites Server Control Properties
The Favorites server control properties are described in this table.
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Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer and

can use it to browse to Content, Collections, etc. See Also: ”Using

CMSExplorer to Browse Your Ektron CMS400.NET Site” on

page 21-12

String

CacheInterval

Sets the amount of time the server control’s data is cached. The

default is 0 (zero). This is the amount of time, in seconds, a

control’s data is cached. For example, if you want to cache the

data for fiveminutes, set this property to 300 (three hundred).

See Also: ”Caching with Server Controls” on page 21-43.

Double

DefaultUserID
The default user ID for this control to use when there is no

matching dynamic parameter value passed.
Long

DisplayMode

Select the way this control displays community group information.

Choicesare:

List - showsa list of Favorites sorted in alphabetical order.

Directory - this selection allowsusers to group their favorites by

folders.When this selection is chosen, the followingmenu items

are added to the control:

- Add Folder - allows a user to add a sub folder.

- Move - allows a user to move content into a

folder. This item only appears when there is a

folder. See Also: "Grouping Favorites by

Folder" on page 16-54

eDisplayMode

DisplayXslt

Determineshow information is displayed on the page. Enter the

path to the XSL file. It can be relative or absolute.

Warning! If you specify an external file, it is strongly rec-

ommended that you do not store this file in your site'sWorkarea

folder. If you store this file in theWorkarea folder, the file will be

lost when you upgrade.

Warning! If you enter a valid EkML file at theMark-

upLanguage property, theDisplayXslt property value is

ignored.

String

DynamicParameter
Gets or sets the QueryString parameter to read a user ID

dynamically. To use the default user ID, leave blank.
String
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Property Description Data Type

FavoritesTitle

The title shown at the top of the control.

String

Hide

Used to hide output of the control in design time and run time.

True =Hide control

False =Display control

Boolean

Language

Set a language for viewing the Favorites control. This property

shows results in design-time (in VisualStudio) and at run-time (in

a browser).

Integer

Link

Enter a link to the contentWeb page. This allowsa user to click a

link in the Favorites control and be taken to the content. There are

three variables used within the link that represent the content’s ID,

the language and the content’s title.

{0} - represents the content’s ID.

{1} - represents the content’s language.

{2} - represents the content’s title.

You need to have all three variables in the link. TheWeb form can

be relative or absolute. Below is an example.

contentpage.aspx?cid={0}&lang={1}&title={2}

String

LinkTarget

Determines the type of window that appears on thisWeb form

when a user clicks an item in the Favorites control. The default is _

self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

ItemLinkTargets

MarkupLanguage

Identify the templatemarkup file that controls the display of the

server control. For example, mymarkup.ekml. If the *.ekml file is

located in the same folder as theWeb form containing the server

control, just enter its name. Otherwise, the path to the file can be

relative or absolute. See Also: ”EktronMarkup Language” on

page 21-35

String

MaxResults TheMaximum number of items to fetch. 0 (zero) = unlimited. Integer
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Property Description Data Type

Stylesheet

Specify the path to a style sheet for use with the server control.

The location can be relative or absolute. Leave blank to use the

default style sheet.

Warning! If you enter a valid EkML file at theMark-

upLanguage property, theStylesheet property is ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control.

The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a

blockof code.

Custom - Allows you to use a custom tag.

String

PhotoGallery Server Control
The PhotoGallery server control helps users and community groups track and manage images.

They can organize them in any number of taxonomy categories. For example, a user might have

the following organization.

n Science

- Biology

- Animals

- Mammals

- Lions

- Bears

Once a user uploads an image to the their Photo Gallery, site visitors can navigate through its

taxonomy and view the image.

When the PhotoGallery server control is added a user’s profile page, a logged in user can:

n add a taxonomy category - see "Adding Categories" on page 16-61

n edit a category’s name - see "Edit a Category’s Name" on page 16-62
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n delete a category - see "Deleting a Category" on page 16-63

n drag and drop a photo - see "Adding Photos to a Photo Gallery" on page 16-64

n change a photo’s description - see "Changing a Photo’s Title, Map Address or Description"

on page 16-65

n move or copy a photo to another folder - see "Moving and Copying Photos" on page 16-

66

n delete a photo - see "Deleting a Photo" on page 16-68

n select whether to share a category with the Public, Colleagues, Selected Colleagues or

keep the category private - see "Sharing Photos" on page 16-69

n save a photo to a local system - see "Saving a Photo to User’s Local System" on page 16-

70

n allow members of a community group to add, remove and share folders - see "Allowing

Community Group members to Work with Folders" on page 16-71

To see a list of properties for this server control, see "PhotoGallery Server Control Properties"

on page 16-72.

Adding Categories
Users can add categories to their photo gallery to help them sort their photos. The categories

represent a taxonomy of the items contained in the photo gallery. To add folders, follow these

steps.

1. On the Web site, navigate to a User’s Profile Page > Photo Gallery.

2. Click the Manage Folder Button ( ).

3. The Add box appears.

4. Enter a Name for the folder.

5. In the Share area, select with whom you want to share your photos.

6. Click the Add button.
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7. When the page refreshes, it opens to the newly added folder.

Edit a Category’s Name
Sometimes, it is necessary to change the name of category. To accomplish this, follow these

steps.

1. On the Web site, navigate to a User’s Profile Page > Photo Gallery.

2. Click the category’s Edit button ( ). This button is located to the left of the category’s
title.

3. The Edit box appears.

4. Change the name of the category.

5. Click the Save button.

6. When the page refreshes, it opens to the category with the changed name.
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Deleting a Category
A user can delete obsolete categories in his photo gallery. To delete a category, follow these

steps.

Note: You can not delete the top-level folder, Albums.

Warning! Deleting a category permanently deletes all photos, aswell as its subcategories.

1. On the Web site, navigate to a User’s Profile Page > Photo Gallery.

2. Click the category’s Edit button ( ). This button is located to the left of the category’s
title.

3. The Edit box appears.

4. Click the Delete button.

5. A dialog box appears asking you to confirm deletion.

6. Click OK.

PhotoGallery Server Control

ReferenceManual

Version 8.0 Rev 1.3
16-63



7. The page refreshes and the category is removed.

Adding Photos to a Photo Gallery
To add a photo to a user’s photo gallery, follow these steps.

1. On the Web site, navigate to a User’s Profile Page > Photo Gallery.

2. Select a category where the photo will be added. If you want to create a new category, see

"Adding Categories" on page 16-61

3. Click the Add Photo button ( ).

Note: If you see the following error at this point, make sure your server’s clock is set to the correct time.

Error: Object Expected

4. The Add Photo box appears

5. In the Photo Data area, enter a Description, Location and Maximum Width.

6. Click Next.

7. The Add box appears.
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8. Drag and drop a photo in the Add box.

9. A status box appears and shows the files being uploaded.

10. Once the upload is complete, the page refreshes and the photo appears in the gallery.

Changing a Photo’s Title, Map Address or Description
If a user wants to change a photo’s title, map address or description, follow these steps.

1. On the Web site, navigate to a User’s Profile Page > Photo Gallery.

2. Select the category which contains the photo you want to change.

3. Click the drop down triangle to the right of the photo’s title.
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4. From the drop down list, select Edit Properties

5. Edit the photo’s Title, Map Address or Description.

6. Click Save.

Moving and Copying Photos
A user can change the category where photos are stored in a user’s photo gallery by moving a

photo from one category to another. In addition to moving photos, you can copy photos to

another category. To accomplish either of these actions, follow these steps.

1. On the Web site, navigate to a User’s Profile Page > Photo Gallery.
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2. Select the category from which to move or copy the photo.

3. Click the drop down triangle to the right of the photo’s title.

4. From the drop down list, select Copy.

5. Select the category to which the photo will be moved.

6. Click the Manage link.
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7. Click the Move Items ( ) or Copy button ( ).

8. A dialog box appears asking you to confirm the move or copy action.

9. Click OK.

10. The page refreshes and the moved or copied photo appears in the category.

Deleting a Photo
As photos become obsolete or are no longer wanted, users can delete them. This permanently

removes the photo from the user’s photo gallery. To delete a photo, follow these steps.

1. On the Web site, navigate to a User’s Profile Page > Photo Gallery.

2. Select the category which contains the photo you want to delete.

3. Click the drop down triangle to the right of the photo’s title.

4. From the drop down list, select Delete.
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5. A dialog box appears asking you to confirm the deletion.

6. Click OK.

7. The page refreshes and the photo is removed.

Sharing Photos
The photo gallery area allows users to share photos with their colleagues. Users can share

photos with the Public, Colleagues, Selected Colleagues or keep the photos private. Users

apply sharing options to categories not individual photos. To share a category, follow these

steps.

1. On the Web site, navigate to a User’s Profile Page > Photo Gallery.

2. Click the Manage Folder Button ( ).

3. The Add box appears.

4. Click the Share Folder button ( ).
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5. The Share Workspace box appears.

6. Select with whom to share your photos. The table below describes each option.

Viewer

Type
Description

Public All site visitors viewing your photo gallery can view your photos.

Colleagues
Only people who are your colleagues can view your photos. See Also:

"PhotoGalleryServer Control" on page 16-60.

Selected

Colleagues
Only colleagueswho aremarked as selected colleagues can view your photos.

Private You are the only one who can view your photos.

7. Click the Share button.

Photos in the category are now available for viewing by the selected viewer type.

Saving a Photo to User’s Local System
Users can save a copy of a photo to their local system. This enables the owner of the photo

gallery to give the photo to other members of the community. For example, I add a photo of

my child to my photo gallery. My parents can then save the photo to there system and either

change it, print it out or upload it to there own photo gallery.

To save a photo to a local system, follow these steps.

1. On the Web site, navigate to a User’s Profile Page > Photo Gallery.

2. Select the category which contains the photo you want to delete.

3. Click the drop down triangle to the right of the photo’s title.
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4. Select Save As... from the drop down list.

5. A dialog appears asking you to open or save the file.

6. Click Save.

Allowing Community Group members to Work with
Folders
When you associate this control with a community group, you can allow members of the

group to add, remove and control the sharing of folders in a workspace. Because this feature is
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implemented on a group by group basis, it is controlled in the Workarea on the Edit

Community Group screen. See Also: "Adding a New Community Group" on page 16-93”.

PhotoGallery Server Control Properties
The PhotoGallery server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer

and can use it to browse to Content, Collections,

etc. See Also: ”Using CMSExplorer to Browse

Your Ektron CMS400.NET Site” on page 21-12

String

CacheInterval

Sets the amount of time the server control’s data is

cached. The default is 0 (zero). This is the amount

of time, in seconds, a control’s data is cached. For

example, if you want to cache the data for five

minutes, set this property to 300 (three hundred).

See Also: ”Caching with Server Controls” on page

21-42.

Double

DefaultObjectID

The default object ID for this control to use when

there is nomatching dynamic parameter value

passed.

Long

DisplayXslt

Determineshow information is displayed on the

page. Enter the path to the XSL file. It can be

relative or absolute.

Warning! : If you specify an external file, it is

strongly recommended that you do not store this

file in your site'sWorkarea folder. If you store this

file in theWorkarea folder, the file will be lost

when you upgrade.

String

DynamicContentBoxHeight The height of the dynamic content box in pixels Integer

DynamicContentBoxWidth TheWidth of the dynamic content box in pixels Integer

DynamicContentTemplate
The template to use when displaying dynamic

content. Leave blank to use the dynamic box.
String
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Property Description
Data

Type

Dynamic

Parameter

Gets or sets the QueryString parameter to read a

object ID dynamically. To use the default object ID,

leave blank.

String

EnablePaging

This property, in conjunction with the

MaxResults property, lets site visitors view an

unlimited number of document itemswhile

controlling the amount of screen space. To

accomplish this, the display is limited to the number

set in theMaxResults property.

If you set this property to true, and the number of

itemsexceeds theMaxResults number, navigation

aids appear below the last item.

Boolean

Hide

Used to hide output of the control in design time

and run time.

True =Hide control

False =Display control

Boolean

IncludeIcon

Choose whether to display iconsnext to the

navigation list’s links.

True =Show icons

False =Hide icons

Boolean
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Property Description
Data

Type

ItemSortOrder

Specify the sort order of results. Choicesare:

taxonomy_item_display_order - the order of

taxonomy itemsas set in theWorkarea. For

additional information, see ”ChangeOrder of

Content Assigned to a Taxonomy/Category” on

page 9-295.

content_title - the content is listed in alphabetical

order by title.

date_created - content is listed in the order by

which it was created.

last_edit_date - content is listed in order by its

last edit date.

You can specify the direction of the itemswith the

SortDirection property.

Language

Set a language for viewing the server control. This

property shows results in design-time (in Visual

Studio) and at run-time (in a browser).

Integer

LinkTarget

Determines the type of window that appears on

thisWeb formwhen a user clicks an item in the

dynamic content box. The default is _self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

String

MarkupLanguage

Identify the templatemarkup file that controls the

display of the server control. For example,

mymarkup.ekml. If the *.ekml file is located in the

same folder as theWeb form containing the server

control, just enter its name. Otherwise, the path to

the file can be relative or absolute. See Also:

”EktronMarkup Language” on page 21-35

String

MaxResults
TheMaximum number of items to fetch. 0 (zero) =

unlimited.
Integer

ObjectType

The type of object to which this control is assigned.

Choicesare:

User - this control is assigned to an individual.

Group - this control is assigned to a community

group.

String
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Property Description
Data

Type

ShowCount

Indicates if an integer representing the number of

taxonomy items in the category appears next to

each categorywhen displayed on theWeb site.

The default is False.

True - Show taxonomy itemsnumber next to

category.

False - Do not show taxonomy itemsnumber next

to category.

Boolean

SortDirection
Select the direction of theitemSortOrder

property. Choose Ascending or Descending.
String

Stylesheet

Specify the path to a style sheet for use with the

server control. The location can be relative or

absolute. Leave blank to use the default style

sheet.

Warning! If you enter a valid EkML file at the

MarkupLanguage property, theStyle-

sheet property is ignored.

String

TaxonomyCols
Enter the number of columns in which this

taxonomy/category appear on the page.
Integer

TaxonomyItemCols
Enter the number of columns in which the

taxonomy item appear on the page.
Integer

WrapTag

Allowsa developer to specify a server control’s

tag.

The default isSpan.

Span - The <span> tag is used to designate an

inline portion of an HTML document asa span

element.

Div - The <div> tag is used when you want to apply

attributes to a blockof code.

Custom - Allows you to use a custom tag.

String

PhotoGallery Server Control

ReferenceManual

Version 8.0 Rev 1.3
16-75



Message Board Comments
Associated with Content in the
Workarea
Message Board comments can be associated with content. This allows a user who views the

content on the site to add comments about the content.

Note: Message Boards can also be associated with usersand groups.See Also: "MessageBoard Server

Control" on page 16-76

Warning! Message Board comments are not the same as the Comments tab on the View Content screen.

You can view these comments in the Workarea. To do so, follow these steps:

1. Click the Content folder button.

2. Navigate to the content block for which to view messages.

3. Click that content item. The View Content screen appears.

4. Click the View Content Reports button ( ).

5. Click the Messages tab.

6. A list of comments associated with the content appears.

MessageBoard Server Control
The Message Board server control allows a user to submit comments on a Web page about a

user, community group or content item. Comments are presented in a “wall” type format, where

the newest one appears at the top, and older comments are pushed down as new ones arrive.

See example below.
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You can associate a Message Board with a user, a community group, or content.

Comments are posted to the Message Board immediately unless the board is moderated. See

Also: "Moderating the Message Board" on page 16-79

This section contains the following topics.

n "Message Board Controls on Sample Sites" on page 16-78

n "Who is Authorized to Add Comments to a Message Board" on page 16-78

n "Moderating the Message Board" on page 16-79

n "Replying to a Message Board Comment" on page 16-81

n "Message Board Notifications" on page 16-82

n "Filtering Spam" on page 16-83

n "Changing the Location of the Comment Box" on page 16-85

n "MessageBoard Server Control Properties" on page 16-85
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Message Board Controls on Sample Sites
You can find examples of the MessageBoard Server Control in these Ektron sample sites. You

can copy and edit the samples as needed to build your own pages.

Group Message Board

n Ektron Technology site > Login > Community > Community Groups > select a group >

right side, bottom of page

n Intranet Site > Login > Groups > select a group > right side, bottom of page

n Developer Sample Site > Community > Community Groups

User Message Board

n Intranet Site > Login > My Profile > right side, bottom of page

n Ektron Technology site > Login > My Profile > right side, bottom of page

n Developer Sample Site > Community > User Message Board

Content Message Board

n Developer Sample Site > Community > Content Message Board

To download sample sites, go to http://www.ektron.com/solutions/startersites/.

Who is Authorized to Add Comments to a Message
Board

If Message

Board

Associated

with

These users can add comments

User

n the logged-in user

n his colleagues

n users assigned to theMessage Board Admin role

n Administrators groupmember

Group
n groupmembers

n users assigned to CommunityGroup Admin role

CommunityManagement

16-78
ReferenceManual

Version 8.0 Rev 1.3



If Message

Board

Associated

with

These users can add comments

n Administrators groupmember

Content item

n anyone who can view the content

For example, if a content item is set to private, a user must have at

least Read-Only permission for the folder containing the content.

Moderating the Message Board
A moderated Message Board is one whose comments must be approved by an authorized user

before they appear. Those users can either approve or delete the comment. To learn which users

are authorized to moderate, see "Users Who Can Moderate Message Board Comments" on page

16-80.

You can force all message boards associated with a MessageBoard control to moderate

comments. To do this, set the Moderate property to True.

On the other hand, you can allow the users and community group administrators who own a

Message Board to decide if it will be moderated. To do this, set the control’s Moderate
property to False. Then, users and community group administrators can set this property in

their user or group profile.

Users determine whether their Message Board is moderated by checking their profile’s

Moderate check box (see below).

Community group members place a check mark in the MessageBoard Moderation check box.

Note: If a Group administrator submits a comment to amoderatedGroupMessage Board, it is automatically

approved.
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Appearance of Comments on a Moderated Message Board
If a comment is submitted to a moderated Message Board, users who can see it notice a green

dot border. The user who submitted the comment sees an hour glass icon ( ) until it’s

approved. At any time, he can delete the comment using the delete button ( ).

Approving Comments on a Moderated Message Board

To approve a Message Board comment, an authorized user clicks the approval button ( ). To

delete a comment, he clicks the delete button ( ).

Users Who Can Moderate Message Board Comments

User
Can perform these

actions on a comment

Who submitted comment
n view

n delete

Individual or groupmember who ownsMessage Board to

which comment wasadded

n view

n approve pending com-

ments

n delete

n community group administrator

n assignedMessage Board Admin role

n view

n approve pending com-

ments

n delete

If Message Board assigned to a content item, administrators

or userswith Message Board Admin role

n view

n approve pending com-

ments

n delete
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Replying to a Message Board Comment
Users can reply to comments on a user’s, community group’s, or content item’s Message Board.

For community groups, the group must be public and not restricted; otherwise, only group

members can reply.

The ability to reply to Message Board comments facilitates community building by allowing

members to share information and, thereby, feel they have a personal stake in that information.

To add a reply, click the Reply button ( ) in a comment’s lower right corner (circled below).

Next, a dialog box displays the original comment and a Reply field.

When the reply is submitted, a Replies link appears directly below the comment. The number

of replies appears next to the link.
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Click the link to view comments. They are arranged from the oldest at top to the newest at the

bottom.

Deleting a Reply

To remove a reply, click the Delete button ( ). Only the user who replied and the Message
Board owner can delete it.

Message Board Notifications
You can send e-mail notifications to Message Board owners and community group members

when someone posts a message to a board.

When a user posts a message to a user’s Message Board, its owner receives an e-mail

notification. When a user posts a message to a community group’s Message Board, all group

members are notified.

IMPORTANT!

Warning! Usersmust have a valid email address in their profile to receive email notifications.

Enabling Message Board Notifications
You can turn this feature on or off in the site root’s Web.config file. By default, the feature is

turned off. To turn it on, open the Web.config file and set the following key’s value to True.

<add key="ek_EnableMessageBoardEmail" value= "False"/>

Note: Currently, Message Board notificationsare sent from the same e-mail addressas the invite system.

Once activated, this feature applies to all user and community group message boards.
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Filtering Spam
CMS400.NET lets you filter spam from your message boards. Ektron defines spam filtering as

setting the following limits.

Limitation

To set, select this value in

MessageBoard server control’s

SpamControlType property

User cannot post the samemessage to a

boardmore than once per day
SameUserSameMessageSameDay

User cannot post another message for a

period of time, specified in the

SpamTimeSpanproperty.

SameUserTimeDelay

User cannot post the samemessage for a

period of time, specified in the

SpamTimeSpanproperty.

SameMessageTimeDelay

You can also define custom spam filters. See "Creating a Custom Spam Filter" on page 16-84.

SpamFilterUsage Examples

The table below provides examples of setting up the control to filter spam.

As a

developer I

want to...

So I set the SpamControlType

property to...

And I set the

SpamTimeSpan

property to…

Prevent a user

from posting

the same

messagemore

than once a day

SameUserSameMessageSameDay

Prevent a user

from posting

anyother

message for 30

minutes

SameUserTimeDelay 1800
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As a

developer I

want to...

So I set the SpamControlType

property to...

And I set the

SpamTimeSpan

property to…

Prevent a user

from posting

identical

messages for 2

hours

SameMessageTimeDelay 7200

Usemyown

spam filter code

Customand add the code to the code

behind page of the template containing the

MessageBoard server control.

Creating aCustomSpamFilter

You can create your own spam filter in the codebehind of the page that hosts the Message

Board. To do this, set the SpamControlType property to Custom, call the

CustomSpamMethod in the page load event, and point it to your custom spam filter

method. Your method’s signature must include the following parameters:

n long objectId - the numeric ID of the object defined in the object type

n Ektron.Cms.Common.EkEnumeration.MessageBoardObjectType
objectType - the type of object with which the Message Board is associated. See

Also: "" on page 16-87

n long userId - The numeric ID of a user. For example, you want to block a user with

the ID 18 from posting to the board.

n string messageText - a string of text you want to block

n int interval - the amount of time, in seconds, to block posting on the Message

Board. For example, if you want to block a user from posting for 30 minutes, set this

property to 900.

Below is a C# example that blocks the text Hello World.

using System;
using System.Data;
using System.Configuration;
using System.Collections;
using System.Web;
using System.Web.Security;
using System.Web.UI;
using System.Web.UI.WebControls;
using System.Web.UI.WebControls.WebParts;
using System.Web.UI.HtmlControls;

public partial class WebformCB : System.Web.UI.Page
{
protected void Page_Load(object sender, EventArgs e)
{
this.MessageBoard1.CustomSpamMethod(SpamControl);
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}
private bool SpamControl(long objectId,

Ektron.Cms.Common.EkEnumeration.MessageBoardObjectType objectType, long userId, string

messageText, int interval)
{

if (messageText == "Hello World")
{

return true;

}

return false;

}

}

Changing the Location of the Comment Box
By default, the user comments box is located at the bottom of a Message Board. You can move

it to the top by setting the CommentBoxLocation property to Top. To move the comment

box to the bottom, set the property to Bottom.

MessageBoard Server Control Properties
The MessageBoard server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it

to browse to Content, Collections, etc. See Also: ”Using CMS

Explorer to Browse Your Ektron CMS400.NET Site” on page 21-

12

String

CacheInterval

Sets the amount of time the server control’s data is cached. The

default is 0 (zero). This is the amount of time, in seconds, a

control’s data is cached. For example, if you want to cache the

data for fiveminutes, set this property to 300 (three hundred).

See Also: ”Caching with Server Controls” on page 21-43

Double

CommentBoxLocation

Defines the location of the comment box. Bydefault, bottom is

selected. Choicesare:

Bottom= comment boxappears below the comments
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Property Description
Data

Type

Top = comment boxappears above the comments

Data Type:

 EkEnumeration.MessageBoardCommentBoxLocation

DefaultObjectID
The default object ID for this control to use when there is no

matching dynamic parameter value passed.
Long

DisplayXslt

Determineshow information is displayed on the page. Enter the

path to the XSL file. It can be relative or absolute.

Warning! If you specify an external file, it is strongly rec-

ommended that you do not store this file in your site'sWorkarea

folder. If you store this file in theWorkarea folder, the file will be

lost when you upgrade.

Warning! If you enter a valid EkML file at theMark-

upLanguage property, theDisplayXslt property value is

ignored.

String

DynamicObjectParameter
Gets or sets the QueryString parameter to read a object ID

dynamically. To use the default object ID, leave blank.
String

EnablePaging

This property, in conjunction with theMaxResults property,

lets site visitors view an unlimited number of document items

while controlling the amount of screen space. To accomplish this,

the display is limited to the number set in theMaxResults

property.

If you set this property to true, and the number of itemsexceeds

theMaxResults number, navigation aids appear below the

last item.

Boolean

Hide

Used to hide output of the control in design time and run time.

True =Hide control

False =Display control

Boolean

Language

Set a language for viewing the server control. This property

shows results in design-time (in VisualStudio) and at run-time (in

a browser).

Integer

MarkupLanguage

Identify the templatemarkup file that controls the display of the

server control. For example, mymarkup.ekml. If the *.ekml file is

located in the same folder as theWeb form containing the server

control, just enter its name. Otherwise, the path to the file can be

relative or absolute. See Also: ”EktronMarkup Language” on

page 21-35

String
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Property Description
Data

Type

MaxResults Themaximum number of items to fetch. 0 (zero) = unlimited. Integer

Moderate

Set to True to forcemoderation of theMessage Board. If set to

false, moderation is controlled by the user or community group

with which theMessage Board is associated. See Also:

"Moderating theMessage Board" on page 16-79

Boolean

ObjectType

The type of object to which theMessage Board is assigned.

Choicesare:

Content - a content item

User - an individual

CommunityGroup - a community group

Data Type: EkEnumeration.MessageBoardObjectType

ProfileParamName

The parameter name to pass in the QueryString to the

TemplateUserProfile page, if you want it to be anything other

than id.

For example, youmayprefer userid, because it ismore

descriptive, as shown in the following example.
String

ShowMaxCharacter

Themaximum number of characters to display in themessage.

If the number of characters in amessage exceeds this, a... more

>> link appears. Users click the link to see the full text.

Integer

SpamControlType

Assignsa spam filter to theMessage Board. Ektron

CMS400.NET provides three spam filters, and the ability to

define your own.

Note: Spam control is turned off by default.

Filter choicesare:

SameUserMessageDay - a user cannot post the same

message to a boardmore than once per day

SameUserTimeDelay - prevents user from posting another

message for period of time, specified in theSpamTimeSpan

property.

SameMessageTimeDelay - prevents user from posting an

identicalmessage for a period of time, specified in the

SpamTimeSpan property.

Custom - Message Board uses your custom spam filter code.

See "Creating a CustomSpam Filter" on page 16-84

See Also: "Filtering Spam" on page 16-83

Data Type: EkEnumeration.MessageBoardSpamControlType
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Property Description
Data

Type

SpamTimeSpan

The number of seconds for which the SameUserTimeDelayor

SameMessageTimeDelay spam filters delay a user from posting

a second time.

See Also: "Filtering Spam" on page 16-83

Integer

Stylesheet

Specify the path to a style sheet for use with the server control.

The location can be relative or absolute. Leave blank to use the

default style sheet.

Warning! If you enter a valid EkML file at theMark-

upLanguage property, theStylesheet property is

ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control.

The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TemplateUserProfile

The URL path to a page that contains a UserProfile server

control. The path can be relative or absolute.

If you enter a path, a user can click anyuser’s name or avatar

from theMessage Board server control and be forwarded to his

profile page. See illustration below.

String

TemplateUserProfile

(Continued)

Note that user templates can be defined in the Ektron

CMS400.NET Workarea > Settings > Community

Management > Templates screen.

However, if you assign a template in this field, this setting takes

precedence over the setting on theWorkarea Template screen.
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Property Description
Data

Type

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline portion of

an HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a

blockof code.

Custom - Allows you to use a custom tag.

String

Calendars for Community Users and
Groups
Ektron’s Web Calendar provides the same function as a paper calendar - it keeps visitors

informed about upcoming events. Combined with the powerful community features of the

Ektron CMS400.NETplatform, the calendar enhances the communications between individuals

and groups.

Communities calendars events could include

n personal vacations

n special personal occaisons

n group milestones

n group meetings

The following example shows a calendar on a personal profile page.
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To use this feature, each group must add Calendar into the database before events can be

added. To do this, see "Adding a WebCalendar ServerControl to a User Profile " on page 7-577

or "Creating the User Calendar in the Database" on page 7-577.

For more information about using the Calendar feature, see the following topics.

n "Web Calendars" on page 7-551

n "Web Calendar Widgets" on page 7-569

n "Using Community Web Calendars" on page 7-576

n "Creating a Calendar in My Profile" on page 7-577

n "Creating a Calendar in My Group" on page 7-580

Discussion Boards for Community
Groups
Using the Ektron CMS400.NET discussion board feature within a community group provides

web based discussions targeted to topics of interest to a community group.

Types of topics that a group may discuss include

n project requirements

n scope and scheduling

n team issues
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n frequently asked questions

The following example shows a discussion board on a community group page.

To use this feature, each group must add the Discussion Board for their group into the database

before posts can be added. To do this, see ”Creating a Community Discussion Board in the

Database” on page 7-850.

For more information about using the Discussion Board feature, see the following topics.

n ”Web Calendars” on page 7-727

n ”Web Calendar Widgets” on page 7-750

n ”Using Community Web Calendars” on page 7-759

n ”Creating a Calendar in My Profile” on page 7-760

n ”Creating a Calendar in My Group” on page 7-762

Community Groups
Warning! Membership User Groupsand CommunityGroupsare two different concepts. Membership User

Groupsallow an administrator to create a group of membership users, thereby reducing the effort required to

assign identical permissions tomanyusers. See "Membership User Groups" on page 16-16. CommunityGroups

are explained below.

Community Groups are another aspect of a community sites. Being a part of a group allows

you to meet people with a similar interest; for example, car racing.

Groups have features and functions similar to users. A Community Group can have its own

Message Board, Discussion Board, show a list of members in the group, and keep a journal

about the group. Community Groups can be managed from the Web site or the Workarea.

Community Groups can also be assigned to a Taxonomy. This allows users to browse and

search for groups by category.
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You can also assign Tags to a community group. This allows users to find the group when

searching via tag name. Tag information for a group appears in the Group’s profile on the Web

site. In the Workarea, Tag information can be found on the View Community Group’s > Tag

tab. From this tab, you can add a Default Group Tag or a new tag associated with the group.

See Also:

n "Community Groups in the Workarea" on page 16-92

n "Managing Community Groups" on page 16-92

n "Distributing Content to Another Ektron CMS400.NET Folder" on page 16-261

Community Groups in the Workarea
You can access community group information in the following areas of the Workarea:

n My Workspace > Community Groups - this area allows you to see what groups you

belong to and remove yourself from them.

n Settings > Community Management > Community Groups - this area allows you to see

all groups that exist. You can define a group’s details or add and remove members from

the group when you are:

- a Group’s Leader (Group’s Administrator)

- a CMS400.NET Administrator

- a CMS400.NET User or Membership user with the Community Group Admin or

Community Group Create role

Managing Community Groups
To view a list of all community groups in the Workarea, click the Settings Tab> Community

Management > Community Groups > Groups.

From this screen, the following actions and information are available.

n Information

- Group Name

- How many members are in the group

- The language of the group

- The ID of the group

- Whether the group is Public or Restricted

- The short description of the group

- The location of the group

n Actions
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- "Adding a New Community Group" on page 16-93

- "Viewing a Community Group’s Details" on page 16-95

- "Editing a Community Group’s Information" on page 16-95

- "Assigning Tags to a Community Group" on page 16-95

- "Viewing Members of a Community Group" on page 16-96

- "Adding Members to a Community Group" on page 16-97

- "Accepting/Declining Requests to Join a Community Group" on page 16-97

- "Removing Members from a Community Group" on page 16-98

- "Deleting a Community Group" on page 16-98

- "Searching for a Community Group" on page 16-99

Adding a New Community Group
Administrators or CMS400.NET users with the Community Group Administrator role can add

a new community group in the Workarea. After you create a group, you can add members to it.

See Also: "Adding Members to a Community Group" on page 16-97 and "Community Groups"

on page 16-91

To add a new community group, follow these steps:

1. Click Settings > Community Management > Community Groups > Groups.

2. Click the Add New Community Group button ( ).

3. The Add Community Group screen appears.

4. Use the table below to assist you with filling out this screen.

Field Description

Properties Tab

Group Name The name of the group.

Administrator

A group administrator hasprivileges to delete a group or edit its

properties.

Note: Members of the Administrators group and users assigned to

the CommunityGroup Admin role also have these privileges.

Bydefault, the person who created the group is the group

administrator. Click theBrowse button if you want to select a

different group administrator.

Membership
Select whether the group is open to the public, or if members can

only join when invited.
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Field Description

Image Upload an image to use asan avatar for the group.

Location The geographical location associated with the group.

Short Description A brief description of the group.

Description A fully detailed description of the group.

Enable Distribute

Check this box if you want the group and system administrator to be

able to distribute content to anyEktron CMS400.NET folder. See

Also: "Distributing Content to Another Ektron CMS400.NET Folder"

on page 16-261

Allow member to

manage

photo/workspace folders

Checking this boxallowsmembers to add, remove and control the

sharing of folders in a community group’sPhoto Gallery or

Document’sWorkspace. See Also: "Allowing CommunityGroup

members toWorkwith Folders" on page 16-94.

Tags Tab

Group Tags

From this screen, you can either create a new tag or select from a

default list of community group tags. See Also: "Assigning Tags to a

CommunityGroup" on page 16-95.

Categories Tab

Category List

The categories tab lists all of the categories associated with the

community group.

Note: If you have not defined at least one taxonomy for community

groups, this tab doesnot appear. See Also: "Creating a Taxonomy"

on page 9-202.

5. Click the Save button ( ).

Allowing Community Group members to Work with Folders
When you associate the CommunityDocuments or PhotoGallery server control with a

community group, you can allow members of the group to add, remove and control the sharing

of folders in these controls. To allow a member to work with Photo Gallery and Workspace

folders, follow these steps.

1. In the Workarea, navigate to Settings > Community Management > Community Groups

> Groups.

2. Click a community group.

3. Click the Edit button ( ).
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4. Place a check mark in the Allow member to manage photo/workspace folders check

box.

5. Click the Save button ( ).

Viewing a Community Group’s Details
Any user with access to the Workarea can view a group’s details. However, they cannot see

the members of the group.

If a user is the Group Leader (Group’s Administrator), an Administrator, or CMS400.NET User

with the Community Group Administrator role, he can edit the group’s information, add and

remove members, or delete the group.

See Also: "Community Groups" on page 16-91

To view a group’s details, follow these steps.

1. Click Settings > Community Management > Community Groups > Groups.

2. Click the Group Name link.

3. The group’s detailed information appears.

Editing a Community Group’s Information
Editing a group’s information allows you change certain details about the group. Only the

Group Leader (Group’s Administrator), Administrators, CMS400.NET Users with the

Community Group Admin, or Community Group Create role can edit a group’s information.

See Also: "Community Groups" on page 16-91

To edit a group’s details, follow these steps:

1. Click Settings > Community Management > Community Groups > Groups.

2. Click the Group Name link.

3. Click the Edit button ( ).

4. Change any fields as needed. These fields are described in See "Adding a New

Community Group" on page 16-93"Adding a New Community Group" on page 16-93.

5. Click the Save button ( ).

Assigning Tags to a Community Group
You can either create a new tag for a community group or select from a default list of group

tags.

See Also: "Tags" on page 16-228
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Creating New Tags for a Community Group

To create a new tag for a community group, follow these steps.

1. In the Workarea, navigate to the Settings > Community Group > Groups.

2. Click the community group for which to create a new tag.

3. Click the Edit button ( ).

4. Click the Tags tab.

5. Click the Click To Add A New Group Tag link.

6. Add a tag to the Name text box.

7. Select a Language.

8. Click Save.

9. Click the Save button ( ).

Once the Tag is saved, it appears in the Group Tags area with a check mark in the check box,

which means the tag is active for the community group.

Adding aDefault Tag to aCommunity Group

To add a default tag to a community group, follow these steps.

1. In the Workarea, navigate to the Settings > Community Group > Groups.

2. Click the community group for which to create a new tag.

3. Click the Edit button ( ).

4. Click the Tags tab.

5. Place a check mark in the tag’s check box that you want to use.

6. Click the Save button ( ).

Viewing Members of a Community Group
Only the Group Leader (Group’s Administrator), Administrators or CMS400.NET Users with

the Community Group Administrator role can view members of the group. In addition to

viewing community group members, you can see add and remove members. You can also

accept or decline members’ requests to join the group if the group’s membership is set to

Restricted.

See Also:

n "Adding Members to a Community Group" on page 16-97

n "Removing Members from a Community Group" on page 16-98

n "Accepting/Declining Requests to Join a Community Group" on page 16-97

n "Community Groups" on page 16-91
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To view members of a community group, follow these steps:

1. Click Settings > Community Management > Community Groups > Groups.

2. Click the Group Name link.

3. Click the View Community Group Members button ( ).

4. A list of group members appears.

Adding Members to a Community Group
Only the Group Leader (Group’s Administrator), Administrators or CMS400.NET Users with

the Community Group Administrator role can add members to a group.

See Also: "Community Groups" on page 16-91

To add members to a group, follow these steps:

1. Click Settings > Community Management > Community Groups > Groups.

2. Click the Group Name link.

3. Click the View Community Group Members button ( ).

4. The View Community Group Members for the group screen appears.

5. Click the Add User(s) button ( ).

6. The Add Members screen appears.

7. Using the drop down box, select the type of name for which to search.

8. Enter a name in the text box.

9. Click the Search button.

TIP!

Note: If you leave the text boxblankand click the Search button, all results for the name type are returned.

10. The results are returned.

11. Place a check mark in the box next to each member to add.

12. Click the Add button ( ).

13. The View Community Group Members screen appears with all members of the group.

Accepting/Declining Requests to Join a Community Group
If a group’s membership is set to Restricted (on the Add or Edit Community Group screen),

users must request to join the group. If membership is set to Open, on the other hand, users

join a group immediately.
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Use the Pending tab on the View Community Group Members to accept or decline a user’s

request to join a group. Only a Group Leader (Group’s Administrator), Administrators, or

Ektron CMS400.NET users with the Community Group Administrator role can accept new

members to a group.

See Also: "Community Groups" on page 16-91

To accept or decline members’ request to join a group, follow these steps.

1. From the Ektron CMS400.NET Workarea, go to Settings > Community Management >

Community Groups > Groups.

2. Click the group for which you want to accept or decline requests to join.

3. Click the View Community Group Members button ( ).

4. Click the Pending tab.

5. Check the box next to each member whose request you want to approve or decline.

6. To approve the selected members’ request to join, click the approve button ( ).

To decline the request, click the decline button ( ).

Removing Members from a Community Group
Only the Group Leader (Group’s Administrator), Administrators, or CMS400.NET Users with

the Community Group Administrator role can remove members from a group.

To remove members from a group, follow these steps.

1. Click Settings > Community Management > Community Groups > Groups.

2. Click the Group Name link.

3. Click the View Community Group Members button ( ).

4. The View Community Group Members for the group screen appears.

5. Place a check mark in the box next to members you want to remove.

6. Click the Remove button ( ).

7. A dialog box appears asking you to confirm you are removing the selected members.

8. Click OK to remove the members.

9. The page refreshes, and the selected members are removed.

Deleting a Community Group
Only the Group Leader (Group’s Administrator), Administrators or CMS400.NET Users with

the Community Group Administrator role can delete a group.

To remove a community group, follow these steps:
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1. Click Settings > Community Management > Community Groups > Groups.

2. Click the Group Name link.

3. Click the Delete button ( ).

4. A dialog box appears asking you to confirm that the community group will be deleted.

5. Click OK.

6. The page refreshes and the View All Community Groups screen appear.

You could

Searching for a Community Group
You can search for a Community Group in the Workarea by using the Search box located at

the top of the View All Community Groups page. To search for Community Groups, click

Settings > Community Management > Community Groups > Groups. Enter text in the

search box and click the Search button. A list of Community Groups that match the search

term appears.

Community Group Server Controls

CommunityGroupProfile Server Control
The CommunityGroupProfile server control displays the profile of a community group. This

profile includes:

n an image associated with the group

n a description of the group

n a list of tags assigned to the group

n whether the group is Public or Restricted

n the date the group was founded

n location information for the group

n how many members are in the group

n the group’s administrator

n an Edit link that allows you to change information displayed in the profile box and edit

settings for the group.
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Editing a Community Group’s Information
Editing a group’s information allows you change certain details about the group. Only the

Group Leader (Group’s Administrator), Administrators, CMS400.NET Users with the

Community Group Admin, or Community Group Create role can edit a group’s information.

To edit a group’s details, follow these steps:

1. Log in to the community Web site.

2. Navigate to the group’s profile page.

3. Click the Edit Group link.

4. Change any fields as needed or click the Delete button ( ) to delete the group.

5. Click the Save button ( ).

CommunityGroupProfile Server Control Properties
The CommunityGroupProfile server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer and

can use it to browse to Content, Collections, etc. See

Also: ”Using CMSExplorer to Browse Your Ektron

CMS400.NET Site” on page 21-12

String
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Property Description Data Type

DefaultGroupID

The default community group ID for this control to use

when there is nomatching dynamic parameter value

passed.

Long

DisplayXslt

Determineshow information is displayed on the page.

Enter the path to the XSL file. It can be relative or

absolute.

Warning! If you specify an external file, it is strongly

recommended that you do not store this file in your

site'sWorkarea folder. If you store this file in theWork-

area folder, the file will be lost when you upgrade.

Warning! If you enter a valid EkML file at theMark-

upLanguage property, theDisplayXslt prop-

erty value is ignored.

String

DynamicParameter

Gets or sets the QueryString parameter to read a

community group ID dynamically. To use the default

community group ID, leave blank.

String

GroupAdminLink

Add a link to the administrator’s profile page. This

allowsa user to click a link in the profile area of the

community group’s page and be taken to the

administrator’s profile page. There are two variables

used within the link that represent the administrator’s

ID and the administrator’s name.

{0} - represents the administrator’s ID.

{1} - represents the administrator’s name.

You need to have both variables in the link. TheWeb

form can be relative or absolute. Below is an example.

adminprofilepage.aspx?aid={0}&an={1}

String

GroupAdminLinkTarget

Determines the type of window that appears on this

Web formwhen a user clicks the Admin’s display name

link. The default is _self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

ItemLinkTargets

Hide

Used to hide output of the control in design time and

run time.

True =Hide control

False =Display control

Boolean
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Property Description Data Type

Language

Set a language for viewing the

CommunityGroupProfile control. This property shows

results in design-time (in VisualStudio) and at run-time

(in a browser).

Integer

Stylesheet

Specify the path to a style sheet for use with the server

control. The location can be relative or absolute. Leave

blank to use the default style sheet.

Warning! If you enter a valid EkML file at theMark-

upLanguage property, theStylesheet property

is ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the

control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TagTemplate

Add a path to another Web form to create links for the

tag text. This path can be relative or absolute. By

providing the path to CommunitySearch server

control, a user viewing the profile can click a tag and

search for other groupswith the same tag.

There are five parameters that are automatically

added to the link’sQueryString that allow you to pass

information about tag.

n searchgrptag - represent the tag’s text for com-

munity groups.

n TagId - represents the tag’s ID.

n TagLanguage - represents the tag’s language.

n TagCount - represents the tag’s count. The

tag’s count is the amount of timesa tag hasbeen used.

n TagType - represents the tag’s type. The tag’s

type will be user or community group.

In addition to these parameters, you can add your own

bydefining them in the path.When you do, these

parameterswill be appended to your parameters.

See Also: "Linking Tag Cloud Items" on page 16-
239

String
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Property Description Data Type

TagTemplateTarget

Determines the type of window that appears on this

Web formwhen a user clicks an item in the dynamic

content box. The default is _self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

ItemLinkTargets

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline

portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply

attributes to a blockof code.

Custom - Allows you to use a custom tag.

String

CommunityGroupBrowser Server Control
The CommunityGroupBrowser server control allows a user to browse a taxonomy structure for

community groups that have been assigned a taxonomy category. As a user browses through a

taxonomy structure, community groups at each level appear in a results box.

In addition to browsing a site’s taxonomy for a community group, a user can click the Create

Group link to create a new group. When the group is created, it is automatically added to the

taxonomy you are viewing.
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CommunityGroupBrowser Server Control Properties
The CommunityGroupBrowser server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer and

can use it to browse to Content, Collections, etc. See

Also: ”Using CMSExplorer to Browse Your Ektron

CMS400.NET Site” on page 21-12

String
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Property Description Data Type

AvatarHeight The display height of the avatar in the results box. Integer

AvatarWidth The displaywidth of the avatar in the results box. Integer

CacheInterval

Sets the amount of time the server control’s data is

cached. The default is 0 (zero). This is the amount of

time, in seconds, a control’s data is cached. For

example, if you want to cache the data for fiveminutes,

set this property to 300 (three hundred). See Also:

”Caching with Server Controls” on page 21-42

Double

DisplayXslt

Determineshow information is displayed on the page.

Enter the path to the XSL file. It can be relative or

absolute.

Warning! If you specify an external file, it is strongly

recommended that you do not store this file in your

site'sWorkarea folder. If you store this file in theWork-

area folder, the file will be lost when you upgrade.

Warning! If you enter a valid EkML file at theMark-

upLanguage property, theDisplayXslt prop-

erty value is ignored.

String

Hide

Used to hide output of the control in design time and

run time.

True =Hide control

False =Display control

Boolean

Language

Set a language for viewing the

CommunityGroupBrowser control. This property

shows results in design-time (in VisualStudio) and at

run-time (in a browser).

Integer

Link

Add a link to the group’s profile page. This allowsa

user to click a link in the community group list and be

taken to the group’s profile page. There are two

variables used within the link that represent the group

ID and the group name.

{0} - represents the group’s ID.

{1} - represents the group’s name.

You need to have both variables in the link. TheWeb

form can be relative or absolute. Below is an example.

groupprofilepage.aspx?gid={0}&gn={1}

String
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Property Description Data Type

LinkTarget

Determines the type of window that appears on this

Web formwhen a user clicks an item in the dynamic

content box. The default is _self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

ItemLinkTargets

MarkupLanguage

Identify the templatemarkup file that controls the

display of the server control. For example,

mymarkup.ekml. If the *.ekml file is located in the same

folder as theWeb form containing the server control,

just enter its name. Otherwise, the path to the file can

be relative or absolute. See Also: ”EktronMarkup

Language” on page 21-35

String

MaxResults
TheMaximum number of items to fetch. 0 (zero) =

unlimited.
Integer

Stylesheet

Specify the path to a style sheet for use with the

Documents server control. The location can be relative

or absolute. Leave blank to use the default style sheet.

Warning! If you enter a valid EkML file at theMark-

upLanguage property, theStylesheet property

is ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the

control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean
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Property Description Data Type

TagTemplate

Add a path to another Web form to create links for the

tag text. This path can be relative or absolute. By

providing the path to CommunitySearch server

control, a user viewing the list of groups can click a tag

and search for other groupswith the same tag.

There are five parameters that are automatically

added to the link’sQueryString that allow you to pass

information about tag.

n searchgrptag - represent the tag’s text for com-

munity groups.

n TagId - represents the tag’s ID.

n TagLanguage - represents the tag’s language.

n TagCount - represents the tag’s count. The

tag’s count is the amount of timesa tag hasbeen used.

n TagType - represents the tag’s type. The tag’s

type will be user or community group.

In addition to these parameters, you can add your own

bydefining them in the path.When you do, these

parameterswill be appended to your parameters.

See Also: "Linking Tag Cloud Items" on page 16-

239

String

TagTemplateTarget

Determines the type of window that appears on this

Web formwhen a user clicks an item in the dynamic

content box. The default is _self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

String

TaxonomyId

Enter the ID number of the taxonomyor category to

appear in this server control. If you don’t know the

number, click the button and navigate to the taxonomy

or category.

When you select one, it appears in the center of the

VisualStudio window.

Long

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline

portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply

attributes to a blockof code.

Custom - Allows you to use a custom tag.

String
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CommunityGroupList Server Control
The CommunityGroupList server control is a part Ektron’s Community Platform. This server

control displays a list of community groups and can be configured to display them by name,

newest or most popular.

When associated with a user, this control can also be used to show community groups with

which a user is associated, a list of community groups the user has been invited to join or any

restricted community groups the user has asked to join, but his acceptance is pending.

The following information about each community group is displayed in the

CommunityGroupList server control.

Field Description

Community

Group Avatar
an image representing the group.

Community

Group Name
The name of a community group.
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Field Description

Type Whether the community group isPublic or Restricted.

Short Description
The community group’s description that is entered in the Short Description

field of the group’s properties.

Tags Any tagsassociated with the community group.

Founded When the community group wascreated.

Members The number of current users in the community group.

CommunityGroupList Server Control Properties
The CommunityGroupList server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description Data Type

AllowGroupCreation

If the user haspermissions to create community

groupsand this property is set to True, the Create

Groups link appears in the control.

True =Create Group link appears on the control.

False =Create Group link is hidden on the control.

Boolean

Authenticated

Indicates if you are logged in to the CMSExplorer and

can use it to browse to Content, Collections, etc. See

Also: ”Using CMSExplorer to Browse Your Ektron

CMS400.NET Site” on page 21-12

String

AvatarHeight The display height of the avatar in the results box. Integer

AvatarWidth The displaywidth of the avatar in the results box. Integer

CacheInterval

Sets the amount of time the server control’s data is

cached. The default is 0 (zero). This is the amount of

time, in seconds, a control’s data is cached. For

example, if you want to cache the data for fiveminutes,

set this property to 300 (three hundred). See Also:

”Caching with Server Controls” on page 21-42

Double
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Property Description Data Type

DefaultUserID
The default User ID for this control to use when there is

nomatching dynamic parameter value passed.
Long

DisplayMode

Select the way this control initial displays community

group information. Choicesare:

Newest - showsa list of newly added community

groups.

MostPopular - showsa list of community groupswith

themost members.

Name - showsa list of community groups sorted

alphabetically.

MyGroups - showsa list of community groups to

which a user belongs.

MyPendingGroups - showsa list of community

groups to which a user hasasked to join, but has yet to

be accepted.

eDisplayMode

DisplayXslt

Determineshow information is displayed on the page.

Enter the path to the XSL file. It can be relative or

absolute.

Warning! If you specify an external file, it is strongly

recommended that you do not store this file in your

site'sWorkarea folder. If you store this file in theWork-

area folder, the file will be lost when you upgrade.

Warning! If you enter a valid EkML file at theMark-

upLanguage property, theDisplayXslt prop-

erty value is ignored.

String

DynamicUserParameter
Gets or sets the QueryString parameter to read a user

ID dynamically. To use the default user ID, leave blank.
String

Hide

Used to hide output of the control in design time and

run time.

True =Hide control

False =Display control

Boolean

Language

Set a language for viewing the CommunityGroupList

control. Thelanguage property shows results in

design-time (in VisualStudio) and at run-time (in a

browser).

Integer
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Property Description Data Type

Link

Add a link to the group’s profile page. This allowsa

user to click a link in the community group list and be

taken to the group’s profile page. There are two

variables used within the link that represent the group

ID and the group name.

{0} - represents the group’s ID.

{1} - represents the group’s name.

You need to have both variables in the link. TheWeb

form can be relative or absolute. Below is an example.

groupprofilepage.aspx?gid={0}&gn={1}

String

LinkTarget

Determines the type of window that appears for this

Web formwhen a user clicks an item in the

CommunityGroupList control. The default is _self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

ItemLinkTargets

MarkupLanguage

Identify the templatemarkup file that controls the

display of the server control. For example,

mymarkup.ekml. If the *.ekml file is located in the same

folder as theWeb form containing the server control,

just enter its name. Otherwise, the path to the file can

be relative or absolute. See Also: ”EktronMarkup

Language” on page 21-35

String

MaxResults
TheMaximum number of items to fetch. 0 (zero) =

unlimited.
Integer

ShowMySortingOptions

When this control is associated with a user and this

property is set to True, the controls displays the

following sorting options:

MyGroups - a list of community groups to which the

user belongs.

Group Requests - a list of community groups to which

a user has requested to join, but has yet to be

accepted.

Group Invitations - a list of community group that the

user hasbeen invited to join, but has yet to accept.

When set to False, Leave Selected Group is the only

option that appears.

Note: Note: Depending on how the DisplayMode

property is set, youmaysee additional sorting options.

Boolean
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Property Description Data Type

ShowSortingOptions

When this control is used to display a general list of

community groupsand this property is set to True, the

following sorting optionsare shown:

Newest - showsa list of newly added community

groups.

Most Popular - showsa list of community groupswith

themost members.

Group Name - showsa list of community groups

sorted alphabetically.

Boolean

Stylesheet

Specify the path to a style sheet for use with the server

control. The location can be relative or absolute. Leave

blank to use the default style sheet.

Warning! If you enter a valid EkML file at theMark-

upLanguage property, theStylesheet property

is ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the

control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TagTemplate

Add a path to another Web form to create links for the

tag text. This path can be relative or absolute. By

providing the path to CommunitySearch server

control, a user viewing the list of groups can click a tag

and search for other groupswith the same tag.

There are five parameters that are automatically

added to the link’sQueryString that allow you to pass

information about tag.

n searchgrptag - represent the tag’s text for com-

munity groups.

n TagId - represents the tag’s ID.

n TagLanguage - represents the tag’s language.

n TagCount - represents the tag’s count. The

tag’s count is the amount of timesa tag hasbeen used.

n TagType - represents the tag’s type. The tag’s

type will be user or community group.

In addition to these parameters, you can add your own

bydefining them in the path.When you do, these

parameterswill be appended to your parameters.

See Also: "Linking Tag Cloud Items" on page 16-
239

String
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Property Description Data Type

TagTemplateTarget

Determines the type of window that appears on this

Web formwhen a user clicks an item in the dynamic

content box. The default is _self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

ItemLinkTargets

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline

portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply

attributes to a blockof code.

Custom - Allows you to use a custom tag.

String

CommunityGroupMembers Server Control
The CommunityGroupMembers server control allows you display a list of members associated

with a community group, a list of members pending approval to join the group or a list of

members who have been invited to group. In addition, if a user is the community group’s

administrator or a site administrator, he can approve pending members, remove current

members and cancel invitations.

The following links appear on the CommunityGroupMembers Server Control when a

community group’s administrator or CMS400.NET administrator is logged in and viewing the

control.
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Link Description

Members A list of current members.

Pending

Members

A list of memberswho have asked to join the community group, but have yet to be

accepted. This link is used when access to the community group is restricted.

Invitations A list of memberswho have been invited to join the group.

Remove
When amember is selected, this link removes themember from the community

group.

CommunityGroupMembers Server Control Properties
The CommunityGroupMembers server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer

and can use it to browse to Content, Collections, etc.

See Also: ”Using CMSExplorer to Browse Your

Ektron CMS400.NET Site” on page 21-12

String

AvatarHeight The display height of the avatar in the results box. Integer

AvatarWidth The displaywidth of the avatar in the results box. Integer

CacheInterval

Sets the amount of time the server control’s data is

cached. The default is 0 (zero). This is the amount of

time, in seconds, a control’s data is cached. For

example, if you want to cache the data for five

minutes, set this property to 300 (three hundred).

See Also: ”Caching with Server Controls” on page

21-42

Double

DefaultCommunityGroupID

The default community group ID for this control to

use when there is nomatching dynamic parameter

value passed.

Long
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Property Description Data Type

DisplayMode

Select whether this control displaysa community

group’s current members or their pendingmembers.

Choicesare:

Members - showsa list of current community group

members.

PendingMembers - showsa list of user who have

asked to join the community group.

eDisplayMode

DisplayXslt

Determineshow information is displayed on the

page. Enter the path to the XSL file. It can be relative

or absolute.

Warning! If you specify an external file, it is strongly

recommended that you do not store this file in your

site'sWorkarea folder. If you store this file in the

Workarea folder, the file will be lost when you

upgrade.

Warning! If you enter a valid EkML file at theMark-

upLanguage property, theDisplayXslt prop-

erty value is ignored.

String

DynamicParameter

Gets or sets the QueryString parameter to read a

community group ID dynamically. To use the default

community group ID, leave blank.

String

Hide

Used to hide output of the control in design time and

run time.

True =Hide control

False =Display control

Boolean

Language

Set a language for viewing the

CommunityGroupMembers control. This property

shows results in design-time (in VisualStudio) and at

run-time (in a browser).

Integer

Link

Add a link to themember profile page’sWeb form.

This allowsa user to click a link in the community

groupmembers list and be taken to amember’s

profile page. There are two variables used within the

link that represent the user’s ID and the user’s name.

{0} - represents the user’s ID.

{1} - represents the user’s name.

You need to have both variables in the link. TheWeb

form can be relative or absolute. Below is an

example.

userprofilepage.aspx?gid={0}&gn={1}

String
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Property Description Data Type

LinkTarget

Determines the type of window that appears for this

Web formwhen a user clicks an item in the

CommunityGroupMembers control. The default is _

self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

ItemLinktargets

MarkupLanguage

Identify the templatemarkup file that controls the

display of the server control. For example,

mymarkup.ekml. If the *.ekml file is located in the

same folder as theWeb form containing the server

control, just enter its name. Otherwise, the path to the

file can be relative or absolute. See Also: ”Ektron

Markup Language” on page 21-35

String

MaxResults
TheMaximum number of items to fetch. 0 (zero) =

unlimited.
Integer

Stylesheet

Specify the path to a style sheet for use with the

server control. The location can be relative or

absolute. Leave blank to use the default style sheet.

Warning! If you enter a valid EkML file at theMark-

upLanguage property, theStylesheet prop-

erty is ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround

the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline

portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply

attributes to a blockof code.

Custom - Allows you to use a custom tag.

String
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CommunityDocuments Server Control
Part of the Community Platform, this server control allows Web site users to create and upload

their own personal content to the site. Once content is added or uploaded, the control displays

a list of the content filtered by category. In addition, a logged in users can manage files, create

categories and decide which users can view the documents. This server control is typically

placed on a user’s profile page.

Note: When you drag and drop this control on aWeb form in VisualStudio, the followingmessage appears in the

label of the control: “Workspace for user doesnot exist”. This happensbecause there is no ID assigned to the

control. Once you assign an ID, the control’s name and the ID are displayed. If you use the DynamicParameter

property to dynamically passan ID from theQueryString, the abovemessage is displayed because an ID is not

assigned to the control.

When the CommunityDocuments server control is added a user’s profile page, he can:

n add a folder - see "Adding Folders" on page 16-117

n edit a folder’s name - see "Edit a Folder Name" on page 16-118

n delete a folder - see "Deleting a Folder" on page 16-119

n drag and drop an asset - see "Adding Assets to a Workspace" on page 16-120

n create an HTML file - see "Creating HTML content" on page 16-121

n move a content item to another folder - see "Moving and Copying Content" on page 16-

122

n select whether to share the folder with the Public, Colleagues, Selected Colleagues or keep

the folder private - see "Sharing Workspace Content" on page 16-123

n allow members of a community group to add, remove and share folders - see "Allowing

Community Group Members to Work with Folders" on page 16-124

To see a list of properties for this server control, see "CommunityDocuments Server Control

Properties" on page 16-125.

Adding Folders
Users can add folders to their Workspace to help them sort assets and content into categories.

The folders represent a taxonomy of the items contained in the documents area. To add folders,

follow these steps.

1. On the Web site, navigate to a User’s Profile Page > Workspace.

2. Click the Manage Folder Button ( ).

3. The Add Folder box appears.
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4. Enter a Name for the folder.

5. Click the Add button.

6. When the page refreshes, it opens to the newly added folder.

Edit a Folder Name
Sometimes, it is necessary to change the name of folder. To accomplish this, follow these steps.

1. On the Web site, navigate to a User’s Profile Page > Workspace.

2. Click the folder’s Edit button ( ). This button is located to the left of the folder’s title.

3. The Edit Folder box appears.
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4. Change the name of the folder.

5. Click the Save button.

6. When the page refreshes, it opens to the folder with changed name.

Deleting a Folder
A user can delete obsolete folders from his Workspace. To delete a folder, follow these steps.

Note: You can not delete the top-level folder,Workspace.

Warning! Deleting a folder permanently deletes all of the assets and HTML content in the folder, aswell as its sub-

folders.

1. On the Web site, navigate to a User’s Profile Page > Workspace.

2. Click the folder’s Edit button ( ). This button is located to the left of the folder’s title.
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3. The Edit Folder box appears.

4. Click the Delete button.

5. A dialog box appears asking you to confirm deleting the folder.

6. Click OK.

7. The page refreshes and the folder is removed.

Adding Assets to a Workspace
Assets are files that are not HTML content, such as Office documents and PDFs. To add an

asset to a user’s Workspace, follow these steps.

1. On the Web site, navigate to a User’s Profile Page > Workspace.

2. Select a folder where the asset will be added. If you want to create a new folder, see

"Adding Folders" on page 16-117

3. Click the Add Asset button ( ).

4. The Add Asset box appears.

5. Drag and drop an asset in the Add Asset box.

6. A status box appears and shows the files being uploaded.

7. Once the upload is complete, the page refreshes and the asset appears in the file list.
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Creating HTML content
To create HTML content in a user’s Workspace, follow these steps.

1. On the Web site, navigate to a User’s Profile Page > Workspace.

2. Select a folder where the content will be added. If you want to create a new folder, see

"Adding Folders" on page 16-117

3. Click the Add HTML Content button ( ).

4. The Add HTML Content window appears.

The editor page looks like this.

5. Add a title and content.

6. Click the Publish button to publish the content.

7. The page refreshes and the HTML content appears in the file list.
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Moving and Copying Content
You can change the folder where assets and HTML content are stored in a user’s Workspace by

moving content from one folder to another. In addition to moving files, you can copy files to

another folder. To accomplish either of these actions, follow these steps.

1. On the Web site, navigate to a User’s Profile Page > Workspace.

2. Select the folder from which to move or copy the content.

3. Click the drop down triangle to the right of the content title.

4. From the drop down list, select Copy to Buffer.
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5. Select the folder to which the content will be moved.

6. Click the Manage link.

7. Click the Move Items ( ) or Copy button ( ).

8. A dialog box appears asking you to confirm the move or copy action.

9. Click OK.

10. The page refreshes and the moved or copied content appears in the folder.

Sharing Workspace Content
The Workspace area allows users to share content with their colleagues. Users can share

content with the Public, Colleagues, Selected Colleagues or keep the content private. Users

apply sharing options to folders not individual content. To share a folder, follow these steps.

1. On the Web site, navigate to a User’s Profile Page > Workspace.

2. Click the Manage Folder Button ( ).

3. The Add Folder box appears.
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4. Click the Share Folder button ( ).

5. The Share Workspace box appears.

6. Select with whom to share your folders. The table below describes each option.

Viewer Type Description

Public All people viewing your Workspace can view your documents.

Colleagues
Only people who are your colleagues can view your documents.

See Also: "FriendsServer Control" on page 16-42.

Selected Colleagues
Only colleagueswho aremarked as selected colleagues can view

your documents.

Private You are the only one who can view your documents.

7. Click the Share button.

Documents in the folder are now available for viewing by the selected viewer type.

Allowing Community Group Members to Work with Folders
When you associate this control with a community group, you can allow members of the group

to add, remove and control the sharing of folders in a workspace. Because this feature is

implemented on a group by group basis, it is controlled in the Workarea on the Edit

Community Group screen. For additional information, see "Adding a New Community Group"

on page 16-93.
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CommunityDocuments Server Control Properties
The CommunityDocuments server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the

CMSExplorer and can use it to browse

to Content, Collections, etc. See Also:

”Using CMSExplorer to Browse Your

Ektron CMS400.NET Site” on page

21-12

String

CacheInterval

Sets the amount of time the server

control’s data is cached. The default is

0 (zero). This is the amount of time, in

seconds, a control’s data is cached.

For example, if you want to cache the

data for fiveminutes, set this property

to 300 (three hundred). See Also:

”Caching with Server Controls” on

page 21-42

Double

DefaultObjectID

The default object ID for this control to

use when there is nomatching

dynamic parameter value passed.

Long

DisplayXslt

Determineshow information is

displayed on the page. Enter the path

to the XSL file. It can be relative or

absolute.

Warning! : If you specify an external

file, it is strongly recommended that

you do not store this file your site’s

Workarea folder. If you store this file

in theWorkarea folder, the file will be

lost when you upgrade.

Warning! If you enter a valid EkML

file at theMarkupLanguage prop-

erty, theDisplayXslt property

value is ignored.

String
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Property Description Data Type

DynamicContentBoxHeight
The height of the dynamic content box

in pixels
Integer

DynamicContentBoxWidth
TheWidth of the dynamic content box

in pixels
Integer

DynamicContentTemplate

The template to use when displaying

dynamic content. Leave blank to use

the dynamic box.

String

DynamicParameter

Gets or sets the QueryString

parameter to read a object ID

dynamically. To use the default object

ID, leave blank.

String

EnablePaging

This property, in conjunction with the

MaxResults property, lets site

visitors view an unlimited number of

document itemswhile controlling the

amount of screen space. To

accomplish this, the display is limited to

the number set in theMaxResults

property.

If you set this property to true, and the

number of itemsexceeds the

MaxResults number, navigation aids

appear below the last item.

Boolean

Hide

Used to hide output of the control in

design time and run time.

True =Hide control

False =Display control

Boolean
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Property Description Data Type

IncludeIcon

Choose whether to display iconsnext

to the navigation list’s links.

True =Show icons

False =Hide icons

Boolean

ItemSortOrder

Specify the sort order of results.

Choicesare:

taxonomy_item_display_order -

the order of taxonomy itemsas set in

theWorkarea. For additional

information, see ”ChangeOrder of

Content Assigned to a

Taxonomy/Category” on page 9-295.

content_title - the content is listed in

alphabetical order by title.

date_created - content is listed in the

order bywhich it was created.

last_edit_date - content is listed in

order by its last edit date.

You can specify the direction of the

itemswith theSortDirection

property.

Language

Set a language for viewing the

CommunityDocuments control. This

property shows results in design-time

(in VisualStudio) and at run-time (in a

browser).

Integer

LinkTarget

Determines the type of window that

appears on thisWeb formwhen a user

clicks an item in the dynamic content

box. The default is _self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

String
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Property Description Data Type

MarkupLanguage

Identify the templatemarkup file that

controls the display of the server

control. For example, mymarkup.ekml.

If the *.ekml file is located in the same

folder as theWeb form containing the

server control, just enter its name.

Otherwise, the path to the file can be

relative or absolute. See Also: ”Ektron

Markup Language” on page 21-35

String

MaxResults
TheMaximum number of items to

fetch. 0 (zero) = unlimited.
Integer

ObjectType

The type of object to which this control

is assigned. Choicesare:

User - this control is assigned to an

individual.

Group - this control is assigned to a

community group.

CommunityDocumentsObjectType

ShowCount

Indicates if an integer representing the

number of taxonomy items in the

category appears next to each

categorywhen displayed on theWeb

site. The default is False.

True - Show taxonomy itemsnumber

next to category.

False - Do not show taxonomy items

number next to category.

Boolean

SortDirection

Select the direction of the

itemSortOrder property. Choose

Ascending or Descending.

String

Stylesheet

Specify the path to a style sheet for use

with the Documents server control.

The location can be relative or

absolute. Leave blank to use the

default style sheet.

Warning! If you enter a valid EkML

file at theMarkupLanguage prop-

erty, theStylesheet property is

ignored.

String

TaxonomyCols

Enter the number of columns in which

this taxonomy/category appear on the

page.

Integer
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Property Description Data Type

TaxonomyItemCols

Enter the number of columns in which

the taxonomy item appear on the

page.

Integer

WrapTag

Allowsa developer to specify a server

control’s tag.

The default isSpan.

Span - The <span> tag is used to

designate an inline portion of an HTML

document asa span element.

Div - The <div> tag is used when you

want to apply attributes to a blockof

code.

Custom - Allows you to use a custom

tag.

String

Notifications
Ektron’s Notification system creates and transmits Notification messages through various

agents, based on CMS400.NET activities. The activities may be performed by a community

group, membership user, or Ektron CMS400.NET user.

n Activities are events, such as adding content, joining a Community Group, and

submitting a micro-message

n Notification messages are made up of text and a triggering activity. When the activity

occurs, the message is sent to eligible recipients.

n Notification recipients include a user’s colleagues and members of community groups to

which a user belongs

n Agents are providers that transmit the messages

For example, Paul is a membership user who wants to notify his colleagues whenever he

uploads a document to his profile page. When he does, a CMS400.NET event is fired, which

causes a Notification agent to send the following email to his colleagues.

“Paul added a new document, ‘How to Write Code’, to his profile page.”

Users can decide

n which of their activities should send a Notification to their colleagues or Community

Groups
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n which Notifications they want to receive from colleagues and community groups

Notifications help you build a tighter, more robust community. They drive users to your site by

notifying them of a recent event, then directing them to the affected page.

Notifications are more fully explained through these topics.

n "Notification System Overview" on page 16-130

n "Conditions for Notification Messages" on page 16-130

n "Setting Up and Sending a Notification Example" on page 16-131

n "Managing the Notification System" on page 16-135

n "Notifications and Multi-Site" on page 16-158

n "Using Notifications with SSL" on page 16-160

n See "Using eSync with Notifications" on page 16-160

Notification System Overview
The following section presents an architectural overview of the Notification system. It is

intended for developers and database administrators.

1. A user performs an activity in Ektron CMS400.NET.

2. Ektron CMS400.NET raises a corresponding event.

3. The activity’s data is written to the Activity table in the database.

4. Activity information is sent to the activity queue.

5. Ektron CMS400.NET verifies that the Notification system is enabled.

6. The Notification service gets a list of users who signed up to be notified about that

activity when performed by that user. That list also includes the agents that send the

message (for example, SMS).

7. The Notification service gets the message associated with the activity, formats it, and

sends it to the appropriate Notification agents.

8. Notification agents send the message to the users compiled in Step 6.

Conditions for Notification Messages
Notification messages require the following conditions.

Note: This section presentsan overview of requirements. Following sectionsexplain the how to set up each

requirement.

n Notifications must be turned on in Workarea > Settings > Community Management >

Notifications > Settings.
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n A message for the activity must be enabled in Workarea > Settings > Community

Management > Notifications > Messages. (By default, a message is enabled for each

activity.)

n A user who wants to receive Notifications must enable each type of Notification for each

agent in his profile’s Activities tab.

Note: If a user wants to receive colleague and community group Notifications, hemust enable activities for both.

n The user performing the action must allow the Notification to be published by enabling it

on his profile’s Activities tab.

n To receive Notifications for

- another user’s activities, you must be his colleague

- a community group’s activities, you must be a group member

n The Notification system respects CMS400.NET’s content permissions. As a result, content-

related Notifications are only sent to users with at least read-only permission for the

content. See Also: ”Folder Permissions” on page 5-56

For example, Julia adds content to an Ektron CMS400.NET folder for which her colleague,

Tyler, does not have permission. Tyler is not notified when content is added, even though he

signed up to be notified about colleagues’ activities.

However Kristin, another colleague who has permission to edit the folder’s content and who

signed up to be notified about colleagues’ activities, does receive Notification of that event.

Similarly, private content is only viewable by authorized CMS users or membership users with

at least Read-Only permissions for its folder.

Setting Up and Sending a Notification Example
This section illustrates how to set up email Notification to alert a user when another user

uploads a document to his Workspace. This example uses the following characters.

Miles - CMS400.NET administrator who wants Notifications to be sent when a user uploads a

document. He needs to enable this capability and review the message.

Paul - the user who uploads the document to his profile page’s Workspace. He needs to edit

his user profile to enable the publishing of Notifications when he adds a document to his

Workspace.

Chris - Paul’s colleague, he wants to receive email Notifications when Paul uploads a

document to his Workspace. He needs to edit his user profile to enable the receipt of

Notifications when colleagues upload documents to their Workspace.

StepsMiles Needs To Perform
To set up CMS400.NET to send Notifications, Miles follows these steps.
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Note: For this example to work, Ektron CMS400.NET must be set up to send emails. See ”Configuring E-Mail for

Tasksand Content” on page 1-109.

1. Navigate to Settings > Community Management > Notifications > Settings.

2. Verify that Notifications can be published. If not:

- click the Edit button ( ).

- click the Publish Notifications check box.

- click the Save button ( ).

3. Make sure the email agent is enabled by navigating to Settings > Community

Management > Notifications > Agents.

- if the EktronEmail agent does not appear in the list of agents, click the Add Agent

button

- select EktronEmail from the Name dropdown

- click the Enabled check box

- click the Save button ( )

4. Ektron provides a standard Notification message that is sent when a user adds content to

his Workspace. The message’s name is User Workspace Content Added.

Since Miles wants to edit the message, he follows these steps.

- navigate to Settings > Community Management > Notifications > Messages.

- click User Workspace Content Added.

- click the Edit button( ).

- update the email’s subject in the Subject text box.

- edit the message in the Text editor using a combination of Tokens and text:
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The document @Content.Title@ was added to @SubjectUser.UserName@’s
Workspace.

Note: BecauseMiles is not dealing with SMS typemessages, he leaves the Plain Text text boxempty. If he were

using SMSmessages, he would typically create a shorter version of themessage in that text box.

- Click the Save button ( ).

From now on, an email is sent whenever a user uploads a document to his Workspace to

colleagues who signed up to receive them.

Steps Paul Needs To Perform
Next, Paul needs enable the Add User Workspace Content activity in his profile. This way,

whenever he adds content to his Workspace, a Notification is sent. To do this, Paul follows

these steps.

1. Log in to the site.

2. Navigate to his profile page.

3. Click the Edit Profile link.

4. Click the Activities tab.

5. Click the My Activities sub tab.
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6. Click the Add User Workspace Content check box.

7. Click the Save button.

Steps Chris Needs To Perform
Next, Chris enables the receipt of Notifications that are sent whenever colleagues upload an

item to their Workspace. To do this, Chris follows these steps.

1. Log into the site.

2. Navigate to his profile page.

3. Click the Edit Profile link.

4. Click the Activities tab.

5. Click the Colleagues sub tab.
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6. Click the Add User Workspace Content check box in the Email column.

7. Click the Save button.

Managing the Notification System
To manage the Notification system, follow these steps.

1. "Enable/Disable the Notification System" on page 16-136

2. "Activity Types" on page 16-136

3. "Review Notification Agents" on page 16-136

4. "Review Notification Messages" on page 16-141

5. "Set Default Notification Preferences" on page 16-153

6. "Enable/Disable a User’s Notification Activities" on page 16-156

Warning! To performNotification activities, youmust be amember of the Administrators group or be assigned

the CommunityAdmin role. See Also: ”Defining Roles” on page 15-40
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Enable/Disable the Notification System
The Notification Settings controls the Notification engine. To turn Notifications on or off,

follow these steps.

Note: If you are upgrading to Version 8.0, Notificationsare disabled bydefault.

1. Log in to the Workarea.

2. Navigate to Settings > Community Management > Notifications > Settings.

3. Click the Edit button ( ).

4. Add or remove the check mark from the Publish Notifications check box. When a check

mark appears in the box, this feature is activated.

5. Click the Save button ( ).

Note: TheNotification system requiresEktron CMS400.NET to be set up to send email. See ”Configuring E-Mail

for Tasksand Content” on page 1-109.

Note: If you disable Notifications, theActivities tab on the User profile (which lets the user pickNotifications to

receive and send) disappears.

Activity Types

Activity Types list all Ektron CMS400.NET events that may trigger a notification. For a list

and explanation of all types, see "Activities that Trigger a Notification Message" on page 16-

157.

Review Notification Agents
A Notification agent is a pluggable component that sends Notification messages. Each Agent

is responsible for sending notifications to users when CMS activity occurs. How that

notification is sent is up to the Notification Agent itself. Once a Notification Agent is created

and registered, users can begin setting up their notification preferences to use that agent.
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CMS400.NET has predefined Notification agents, including email, SMS and activity streaming

agents.

n SMS Notifications are sent to a cell phone or any other device that receives SMS messages

n Activity stream Notifications are posted via the ActivityStream server control. See Also:

"Activity Streams" on page 16-160

You can customize these providers or create your own using the extendable Notification agent

architecture.

Agents are more fully explained through these topics.

n "Enabling an Agent" on page 16-137

n "Disabling an Agent" on page 16-137

n "Creating a Custom Agent" on page 16-138

n "Adding an Agent" on page 16-139

n "Removing an Agent" on page 16-140

Enabling an Agent

For an agent to be available for sending Notifications, it must be enabled in CMS400.NET.

See Also: "Review Notification Agents" on page 16-136

Note: Ektron CMS400.NET’spredefined agentsare enabled bydefault.

To enable an agent, follow these steps.

1. Log in to the Workarea as an administrator.

2. Navigate to Settings > Community Management > Notifications > Agents.

3. Click the name of an agent.

4. Click the Edit button.

5. Click the Enabled check box.

6. Click Save button.

Disabling an Agent

To disable an agent, follow these steps. See Also: "Review Notification Agents" on page 16-

136

1. Log in to the Workarea as an administrator.

2. Navigate to Settings > Community Management > Notifications > Agents.

3. Click the name of an agent.

4. Click the Edit button.

5. Uncheck the Enabled check box.
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6. Click the Save button.

Creating aCustomAgent

CMS 400.NET comes with several standard Notification Agents, including email, SMS, and

Activity Stream. You can customize these agents or create your own using the extendable

Notification Agent provider architecture. This section explains how to extend the object model

to build a customized Notification Agent.

Each type of Notification Agent accepts configuration parameters. For example, email and SMS

require an SMTP server, username, and password. These parameters can be specified in the

web.config file, and read when the Agent is initialized the first time.

Each agent may also require storing settings for each user receiving notifications. For example,

the SMS agent requires the user’s cell phone number and carrier, which it stores as an SMS

email address. To save these properties, each Notification Agent has an associated

NotificatAgentSettingsData class. This class defines any properties needed to be supplied by

the user. The CMS provides APIs for storing and retrieving this information, but the developer

must create an interface for users to supply the information. The SMSAgentSettings.aspx page,

supplied with the Developer and Intranet starter sites. provides a good example.

The following sections describe how to extend the functionality of the Ektron CMS400.Net

Notification Agent and create your own.

Implementing YourOwnNotification AgentProvider

Object Model

The NotificationAgent is the abstract base class you must extend to implement your own

notification agent. Details on the class, available properties, and methods you are required to

implement are below.

The following describes the methods that must be implemented for a Notification Agent.
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Method Description

virtual void Initialize(string name, Amenable

config);

The initializemethod comes from the

ProviderBase base class. It supplies all name

value pairs specified in the Providers

web.config section.

If you have custom settings that need to be

provided to your agent, add them to your

provider’sweb.config key, and theywill be

provided to you at runtime in the Initialize

method. If you have no custom settings, this

classdoesnot need to be overridden.

abstract NotificationAgentSettingsData

GetAgentSettings();

Thismethod should return a new instance of

the NotificationAgentSettingsData class

associated with your Agent.

abstract void Send(NotificationMessageData

message);

Thismethod should send the actual

notification. It will be called by the notification

engine for each user that needs to be notified.

The NotificationMessageData hasall the

information you need for sending the

notification including themessage itself, the

user to be notified and the

NotificationAgentSettingsData for the user to

be notified. If your agent hasa custom

NotificationAgentSettingsData you will need

to cast the supplied

NotificationAgentSettingsData to the

appropriate type so that you can access the

appropriate properties.

Next, add the agent. See See "Adding an Agent" on page 16-139.

Adding an Agent

To add a custom agent to CMS400.NET, follow these steps. See Also: "Review Notification

Agents" on page 16-136

1. Insert the provider between the Notification agent’s providers tags in the site

root/web.config file. Below is an example.

<notificationAgent>
<providers>
<add name="CustomAgent1" type="Ektron.Cms.Notifications.Agents.CustomAgent1,

Ektron.Cms.BusinessObjects" setting1="" setting2=""/>
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<add name="EktronEmail" type="Ektron.Cms.Notifications.Agents.EktronEmailAgent,

Ektron.Cms.BusinessObjects" useSystemSettings="false" smtpServer="amh010" smtpPort="25"

userName="" password="" fromEmail="admin@example.com"/>
<add name="SMSAgent" type="Ektron.Cms.Notifications.Agents.SMSAgent,

Ektron.Cms.BusinessObjects" smtpServer="amh010" smtpPort="25"

fromEmail="SMSAgent@example.com" validationRequired="true"/>
<add name="ActivityFeed" type="Ektron.Cms.Notifications.Agents.ActivityFeedAgent,

Ektron.Cms.BusinessObjects" validationRequired="false"/>
</providers>
</notificationAgent>

After you add an agent to web.config, it appears in the list of available agents in the Workarea.

2. Log into the Workarea as an administrator.

3. Navigate to Settings > Community Management > Notifications > Agents.

4. Click the Add button.

5. Select the custom agent from the Name drop down box.

Note: If you do not see the custom agent in theName dropdown, check the web.config file to verify it is listed

between the <notificationAgent><providers> tags.

6. Place a check mark in the Enabled check box.

7. Click the Save button.

Removing an Agent

When you no longer need an agent, you can remove it. This can be a two step process,

depending on the level of removal you are trying to achieve.

First, remove the agent from the list of agents in the Workarea. At this time, you can easily

return the agent to the list. In the second step, you remove the agent from the web.config file.

To remove an agent from the list of available agents, follow these steps.

1. Log in to the Workarea as an administrator.

2. Navigate to Settings > Community Management > Notifications > Agents.

3. Click the title of the agent.

4. Click the Delete button ( ).
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5. In the Delete Agent dialog box, click OK.

The page refreshes, and the agent is removed from the agents list.

To completely remove the agent from Ektron CMS400.NET, follow these additional steps.

6. Open the site root folder’s web.config file.

7. Between the <notificationagent>’s <providers> tags, remove the agent.

Below is an example of agents that might appear in the web.config file.

<notificationAgent>
<providers>
<add name="CustomAgent1" type="Ektron.Cms.Notifications....
<add name="EktronEmail" type="Ektron.Cms.Notifications....
<add name="SMSAgent" type="Ektron.Cms.Notifications...
<add name="ActivityFeed" type="Ektron.Cms.Notifications...
</providers>
</notificationAgent>

Review Notification Messages
Messages are used by the Notification system to communicate site activities. You can view

each activity’s default message from the Workarea > Settings > Community Management >

Notifications > Messages screen.

You can edit any default message as well as create new ones.

Messages are more fully explained through these topics.

n "Message Types" on page 16-142
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n "Assigning the Default Message for a Type and Sub Type" on page 16-143

n "Composing a Message" on page 16-143

n "Working with Tokens" on page 16-143

n "Adding a Message" on page 16-150

n "Editing a Message" on page 16-152

n "Removing a Message" on page 16-152

Message Types

There are two message types:

n User

n Community Group

Each type contains several sub types. The sub type is the activity that triggers the message. For

example, to edit the message that notifies colleagues when a user uploads a document to his

Workspace, select User from the Type drop down and AddWorkspaceItem from the Sub Type

drop down.

For a list of Sub types, see "Activities that Trigger a Notification Message" on page 16-157.
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Assigning the DefaultMessage for a Type and Sub Type

When you create a new message, you assign it to a type and sub type, such as User Activity >

Blog Post. Only the default message is active for any combination of type and subtype.

So, while creating a new message, you must make it the default (via the Add Notification

Message screen’s Default check box) if you want it to be sent.

When you do, if another message was the default for that type and sub type, it is no longer

used.

Composing aMessage

You can create an HTML-based and a plain text message for each activity. Typically, HTML

messages are sent as email or to the ActivityStream server control, while plain text is used in

SMS style messages.

Messages typically combine text and tokens. See Also: "Working with Tokens" on page 16-

143

Working with Tokens

Tokens are Ektron-defined variables surrounded by at signs (@). When a message is generated,

tokens retrieve information about CMS400.NET users, groups, and objects. For example, the

following message:

@SubjectUser.FirstName@ added a new document, ‘@Content.title@’, to his profile page.

might look like this:

“Paul added a new document, ‘How to Write Code’, to his profile page.”

In this example, @SubjectUser.FirstName@ is the first name of the user performing the action.

@Content.title@ is the title of the object that was uploaded.
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See Also:

n "Token Types" on page 16-144

n "Message Tokens: User and Content-Based" on page 16-144

n "Message Tokens: Community Group-Based" on page 16-146

n "Making Tokens into Hyperlinks" on page 16-148

Token Types

A message can include several token types.

n SubjectUser tokens - represent the user who performs the activity

n DirectObjectUser tokens - represent the user to which the activity is happening

n Content tokens - represent the content that was a part of the activity

n CommunityGroup tokens - represent the community group that was involved in the

activity

n Blog tokens - represent the blog use in the activity

n MicroMessage tokens - represent micromessages used in the activity

The table below lists Message Sub Types and the Tokens available to each one.

Message Tokens:User andContent-Based

Message Sub Type Associated Tokens

AddColleague

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@DirectObjectUser.Id@

@DirectObjectUser.UserName@

@DirectObjectUser.FirstName@

@DirectObjectUser.LastName@

AddContent

@System.SiteURL@

@System.GroupProfileTemplate@

@System.UserProfileTemplate@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@Content.Id@

@Content.Title@
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Message Sub Type Associated Tokens

@Content.Quicklink@

@Content.Icon@

AddWorkspaceItem.

@System.SiteURL@

@System.GroupProfileTemplate@

@System.UserProfileTemplate@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@Content.Id@

@Content.Title@

@Content.Quicklink@

@Content.Icon@

BlogComment

@BlogComment.Id@

@BlogComment.Message@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

BlogPost

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@Content.Id@

@Content.Title@

@Content.Quicklink@

CreateCommunityGroup

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@CommunityGroup.Id@

@CommunityGroup.Name@
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Message Sub Type Associated Tokens

ContentMessageBoardPost

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@Content.Id@

@Content.Title@

@Content.Quicklink@

@MessageBoard.ObjectId@

@MessageBoard.ObjectType@

@MessageBoard.Message@

JoinCommunityGroup

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@CommunityGroup.Id@

@CommunityGroup.Name@

MicroMessage

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@MicroMessage.Id@

@MicroMessage.Message@

UserMessageboardPost

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@DirectObjectUser.Id@

@DirectObjectUser.UserName@

@DirectObjectUser.FirstName@

@DirectObjectUser.LastName@

@MessageBoard.ObjectId@

@MessageBoard.ObjectType@

@MessageBoard.Message@

Message Tokens:Community Group-Based
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Message Type Associated Tokens

AddWorkspaceItem

@System.SiteURL@

@System.GroupProfileTemplate@

@System.UserProfileTemplate@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@DirectObjectUser.Id@

@DirectObjectUser.UserName@

@DirectObjectUser.FirstName@

@DirectObjectUser.LastName@

@CommunityGroup.Id@

@CommunityGroup.Name@

@Content.Id@

@Content.Title@

@Content.Quicklink@

@Content.Icon@

BlogComment.

@BlogComment.Id@

@BlogComment.Message@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

BlogPost

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@Content.Id@

@Content.Title@

@Content.Quicklink@

CreateCommunityGroup

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@CommunityGroup.Id@

@CommunityGroup.Name@

JoinCommunityGroup

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@CommunityGroup.Id@

@CommunityGroup.Name@
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Message Type Associated Tokens

UserMessageboardPost

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@DirectObjectUser.Id@

@DirectObjectUser.UserName@

@DirectObjectUser.FirstName@

@DirectObjectUser.LastName@

@MessageBoard.ObjectId@

@MessageBoard.ObjectType@

@MessageBoard.Message@

Making Tokens into Hyperlinks

Message tokens represent CMS400.NET users, groups and content. They can become links that,

when clicked, bring the user to content, a user’s profile, or community group’s profile, as

shown below.

To make tokens into clickable links, follow these steps.

1. Create the message as described in "Adding a Message" on page 16-150.
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2. While editing the message text, highlight a token and click the Hyperlink Manager

button (circled below).

3. In the URL field, enter the path to the page that displays the content, user, or community

group.

Make sure you include the QueryString parameter used to identify the object. The

parameter to should point to an ID token. For example, a message notifies a user’s

colleagues whenever he adds a new colleague. The message might be:

@SubjectUser.UserName@ and @DirectObjectUser.UserName@ are now colleagues.

When creating a link for@SubjectUser.UserName@, insert the path to the user’s profile

page into the URL field. It might look like this:

http://localhost/Intranet/UserProfile.aspx?id=@subjectUser.Id@

Note, the QueryString parameter (?id=) points to a token that represents the logged-in

user’s ID, @subjectUser.Id@. See Also: "Token Types" on page 16-144

For@DirectObjectUser.UserName@, enter the same path and change the dynamic

parameter token to ?id=@DirectObjectUser.Id@.
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When hyperlinking content, use its QuickLink token in the path defined in the URL field.

For example, a message that sends a Notification when a user adds content might look

like:

@SubjectUser.username@ added new content, @Content.Title@.

4. Make sure the original token text appears in the Link Text field.

5. Click OK.

Adding a Message

Warning! Amessage is limited to 3000 charactersafter its tokensare converted to text. After 3000, any remaining

characters are removed.

To create a message, follow these steps. See Also: "Review Notification Messages" on page 16-

141

1. Log into the Workarea as an administrator.

2. Navigate to Settings > Community Management > Notifications > Messages.
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3. If you are using the Multi-Site feature, select the site with which this message will be

associated.

4. Click the Add Notification Message button ( ).

5. The Add Notification Message screen appears.

6. Complete the fields as described below.

Field Description

Title Enter a name for themessage.

Type

Select the type of message you want to create. Choicesare:

User - message sent when user activity occurs

Community Group - message sent when group activity occurs

The activity is specified at theSub Type field.

Sub

Type

Select the activitywhich triggers the sending of thismessage. See Also: "Message

Types" on page 16-142.

Tokens

A list of available tokens for the selected Sub Type appears.

Tip! To easily insert a token into amessage, highlight a token, then copyand paste it

into themessage.

For a list of tokensand their sub typeswith, see "Message Tokens: User and Content-

Based" on page 16-144.

To learn about how tomake tokens into hyperlinks, see "Making Tokens into

Hyperlinks" on page 16-148.
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Field Description

Default
Click this checkbox if you want themessage to be the default one that is sent. See

Also: "Assigning the Default Message for a Type and Sub Type" on page 16-143

Subject Enter a subject to be used if themessage is sent asemail.

Text

Enter the text and tokens that comprise themessage. The editor allows you to format

the text.

Use this editor for HTML, email, and activity streammessages. See Also: "Composing

aMessage" on page 16-143 and "Making Tokens into Hyperlinks" on page 16-148

Plain

Text

Enter the text and tokens that comprise themessage you want to send. Use this field

for SMS typemessagesandmessages to be sent asplain text.

Tip! If you already composed themessage in the editor above, you can select that

text, then copyand paste it into the Plain Text field.

Warning! Most SMS systems impose a 160 character limit onmessages. If you

create a plain text message greater than 160 characters, CMS400.NET divides it

into several, smaller messages.

7. Click the Save button ( ).

The message now appears in the list of Notification messages. If it is the default and an activity

occurs on your Web site that matches the type and sub type, the message is sent.

Editing a Message
To edit a message, follow these steps. See Also: "Review Notification Messages" on page 16-

141

1. Log into the Workarea as an administrator.

2. Navigate to Settings > Community Management > Notification > Messages.

3. If you are using Ektron’s Multi-Site feature, select the site for which this message is used.

4. Click the title of the message you want to edit.

5. Make changes as needed. For a description of the fields on this screen, see "Adding a

Message" on page 16-150.

6. Click the Save button ( ).

Removing a Message
When you no longer need a message, you can remove it from CMS400.NET. To remove a

message, follow these steps.

1. Log into the Workarea as an administrator.

2. Navigate to Settings > Community Management > Notification > Messages.
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3. Click the title of the message you want to delete.

4. Click the Delete button ( ).

5. Click OK on the confirmation message.

6. The message is removed.

Set Default Notification Preferences
Ektron CMS400.NET provides a default set of Notifications that apply to all newly-created

users. After a user is created, he can change his preferences by editing his profile, selecting the

Activities tab, and checking or unchecking activities and agents.

For a list of activities, see "Activities that Trigger a Notification Message" on page 16-157. To

learn about agents that appear across the top of the screen (for example, SMS), see "Review

Notification Agents" on page 16-136.

You can apply three types of default settings via screens on the Workarea Settings tab

(illustrated below).

n Notification of colleagues’ activities

n Notification of Community Group activities

n Notification of your activities to other users or Community Groups

Note: If you are upgrading to Version 8.0, all activitiesare checked for the ActivityStream agent bydefault. No

activitiesare checked for the other agents bydefault.
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Setting Default Colleague Notifications
To set default Notifications for colleagues, follow these steps. See Also: "Set Default

Notification Preferences" on page 16-153

1. Log in to the Ektron CMS400.NET Workarea as an administrator.

2. Navigate to Settings > Community Management > Notifications > System Default

Preferences > Colleagues.

3. Click the Edit button ( ).

4. Place a check mark next to each a default Notification.

5. Click the Save button ( ).

Setting Default Community Group Notifications
To set the default Notifications of Community Group activities, follow these steps. See Also:

"Set Default Notification Preferences" on page 16-153

1. Log into the Workarea as an administrator.

2. Navigate to Settings > Community Management > Notifications > System Default

Preferences > Community Groups.
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3. Click the Edit button ( ).

4. Place a check mark in each box you want to be a default Notification.

5. Click the Save button ( ).

Setting Default Notifications For Your Activities
To set the default Notifications of the logged-in user’s activities that will be sent to other users

and groups, follow these steps. See Also: "Set Default Notification Preferences" on page 16-

153

1. Log into the Workarea as an administrator.

2. Navigate to Settings > Community Management > Notifications > System Default

Preferences > My Activities.

3. Click the Edit button ( ).

4. Place a check mark in each box you want to be a default Notification.

Notifications

ReferenceManual

Version 8.0 Rev 1.3
16-155



5. Click the Save button ( ).

Enable/Disable a User’s Notification Activities
Each user determines which activities he wants to be notified about, and about which he wants

to notify others, on the User Profile screen’s Activities tab.

Three sub-tabs group the activities.

Sub-tab Description

Colleagues Activities involving colleagues that the logged-in user wants to be notified about

Groups
Activities involving CommunityGroups that the logged-in user wants to be notified

about

My

Activities

Activities involving the logged-in user about which he wants to inform colleagues

and CommunityGroup

The enabling of activities in the User Profile is fully explained in these topics.

n "Activities that Trigger a Notification Message" on page 16-157

n "Set Default Notification Preferences" on page 16-153
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Activities that Trigger a Notification Message
The table below lists activities that can trigger a Notification message, and the Activities sub-

tab on which they can be enabled or disabled.

Activity Type &

Description

Colleague

Action

(available

from

Colleagues

sub-tab)

Community

Group Action

(available

from Groups

sub-tab)

User Action to

Notify Others

about (available

onMy Activities

sub-tab

Add Colleague - message

sent when user addsa

colleague

Add Content - message sent

when user adds content to

CMS400.NET

Add Group Content -

message sent when user

uploads content to Community

GroupWorkspace

Add User Workspace

Content - message sent

when user uploads content to

his profile

Blog Comment - message

sent when user comments on

a blog post

Blog Post - message sent

when user posts to a blog

Content Messageboard

Post - message sent when

user posts to amessage board

associated with content

Create Community Group -

message sent when user

createsa community group
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Activity Type &

Description

Colleague

Action

(available

from

Colleagues

sub-tab)

Community

Group Action

(available

from Groups

sub-tab)

User Action to

Notify Others

about (available

onMy Activities

sub-tab

Forum Post - message sent

when user posts to a Forum

Forum Reply - message sent

when user replies to a Forum

post

Group Blog Comment -

message sent when user

comments on a community

group’s blog post.

Group Blog Post - message

sent when user posts to

community group blog

Group Messageboard Post

- message sent when user

posts to amessage board

associated with a Community

Group

Join Community Group -

message sent when user joins

community group

Status Update - message

sent when user updateshis

status

User Messageboard Post -

message sent when user posts

to amessage board

associated with a user

Notifications and Multi-Site
In a Multi-site environment, Notifications stay within the site where the activity happened. For

example, I have two sites: an Intranet and Social Club site. When a user from the Intranet site
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performs an activity that generates a message, it does not trigger Notifications on the Social

Club site.

Exception: A user’s colleagues receive notifications regardless of the site from
which the message originated.

Notification Messages and Multi-Site
When creating Notification messages in a Multi-Site environment, you specify the site

associated with message. This allows you to create customized messages for each site.

When a message type is created, it becomes the default message and is used by all sites. New

messages of the same type can be assigned to each site in your environment.

To view the messages assigned to each site, go to the View All Notification Messages screen,

click the Site dropdown, and select the site.

For example, you want a “Status Update” message targeted one way for an Intranet site and

another way for your Social Club site. To accomplish this, create a two messages. The message

for the Intranet site might state:

@SubjectUser.username@ has updated his status on Intranet with the following:
@MicroMessage.Message@.

While your Social Club site might have a message that states:

@SubjectUser.username@ has updated his status on the Social Club with the following:
@MicroMessage.Message@
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Using Notifications with SSL
If your site uses SSL, you need to update the link in the Ektron notification service

configuration file with that information. The file is located here: your server\Program
Files\Ektron\EktronNotificationService\Ektron.Notification.Service.exe.config.

Below are the tags to be changed.

<siteNotification>
<sites>
<add name="769723537" url="https://your server" connectionString="server=your

server;database=Intranet2;Trusted_Connection=true;User ID=;Password=;" />
</sites>
</siteNotification>

You must restart the Ektron Notification Service in order to enable these changes.

Using eSync with Notifications
When using eSync with Notifications, any new agents are not synched. This means that you

must manually add new agents to each server in your configuration.

Once the agent exists on all servers in your configuration, eSync keeps them updated. For

example, assume a membership user logs into the production server and updates his profile’s

Activities tab by changing the activities a custom agent will perform. eSync will sync those

changes with the staging server.

See Also: "Adding an Agent" on page 16-139

Activity Streams
As explained in "Notifications" on page 16-129, CMS400.NET users are notified by agents

such as

n SMS

n Ektron email

n Activity Stream

This section explains how to manage the display of notification messages via the Activity

Stream agent.
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Sample Activity Stream

As you can see, an Activity Stream is a series of chronologically-arranged notification

messages describing activities within Ektron CMS400.NET.

Before reading this section, you should be familiar with "Notifications" on page 16-129, which

describes when messages get generated, for whom, how their text is created, etc.

Displaying an Activity Stream on Your Web Site
The following table describes the various ways of presenting an Activity Stream on your Web

site.
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For this kind

of Web page
Use this To see Notifications for

For more

information, see

.aspx
ActivityStream

server control The user or group identified in

the page’s query string.

If none is identified, the logged-

in user seeshis own

notifications.

"ActivityStream

Server Control" on

page 16-169

PageBuilder
ActivityStream

widget

"The ActivityStream

Widget on a

PageBuilder Page"

on page 16-168

Ektron

CMS400.NET

Personalization

ActivityStream

widget

n Yourself

n Your colleagues

n Your community groups

"The ActivityStream

Widget on a

PageBuilder Page"

on page 16-168

Community

Feature: your

profile page

No action

required -

ActivityStream

appears by

default

Yourself

Community

Feature: a

colleague’s

profile page

Colleagues

See Also: "Viewing the

ActivityStreamWidget on

Another User’sPersonalization

Page" on page 16-164

Community

Feature: group

profile page

CommunityGroup of which you

are amember

Making the ActivityStream Widget Available
The ActivityStream widget is installed with Ektron CMS400.NET. However, if you are

upgrading from a previous version, you should sync your Widget list to make sure

ActivityStream is available. To do this:

1. Navigate to the Workarea > Settings > Configuration > Personalizations > Widgets

screen.

2. Click the Sync button ( ).

The ActivityStream Widget on a Personalization Page

Note: To learn about CMS400.NET‘sPersonalization feature, see "Personalizing aWeb Page" on page 9-302.
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There are two scenarios to explain how the Activity Stream widget works on a personalization

page.

n "Viewing the ActivityStream Widget on Your Personalization Page" on page 16-163

n "Viewing the ActivityStream Widget on Another User’s Personalization Page" on page 16-

164

Viewing the ActivityStreamWidget on Your Personalization
Page
When you drag and drop an ActivityStream widget on a Personalization page, it displays

activities performed by

n you, the logged-in user

n your colleagues

n community groups to which you belong

See sample screen below.
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Viewing the ActivityStreamWidget on Another User’s
Personalization Page
When you view another user’s personalization page containing this widget, the activities you

see are controlled by that user’s Private Profile setting (see illustration below) and whether he

is your colleague.

The table below describes when you can see another user’s Activity Stream.

If the user’s Private

Profile Setting is...
and the user is... you can...

Public a colleague view his activities

Public not a colleague view his activities

Private a colleague view his activities

Private not a colleague
only view his activities if you are an

administrator

Colleague a colleague view his activities

Colleague not a colleague not view his activities
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If you can view another user’s activities, you see activities that he performs and activities his

colleagues perform that relate to him.

From this widget, you can filter the Activity Stream to view only activities from specific users

and community groups. See Also: "Filtering the ActivityStream Widget" on page 16-165

Filtering the ActivityStreamWidget
Filtering means restricting the display of notifications in the ActivityStream widget to those

from selected users or groups. For example, you only want to see activities performed by Kay

Milford. In the filter, select Kay Milford, and the ActivityStream widget shows messages only

from her.

As another example, you are the head of the Engineering department and want to see your

employees’ activities. To accomplish this, add them as colleagues. Then, in an ActivityStream

widget, create a filter with their names. That widget only shows your employees’ activities.

If your department has a community group, you could add that group to the filter. Then, in

addition to your employees’ activities, you would see the group’s activities.

This feature, combined with the ability to add multiple ActivityStream widgets to a page,

allows you to create separate activity streams that focus on people and groups of interest.
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Below is an image showing one ActivityStream widget that displays all of a user’s colleagues

(on the left), and three other widgets with filters that focus on individual users.

You could take this example one step further. If Leah Mathis and Scott Markey both work in

“Sales & Marketing” and Bill Smith, Works in “Engineering,” you might only have two

widgets, one for Scott and Leah and another for Bill.

Filtering an ActivityStreamWidget
To filter the ActivityStream widget, follow these steps.

1. Click the Filter button at the bottom of the widget.
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2. Enter the name of a user or community group in the Users and Groups text box by which

to filter.

As you start typing, an AutoComplete feature helps you narrow down the selection.

3. Once a valid name is in the text box, click the Add button.

Warning! A valid name is one that exactlymatchesa user’sDisplayName or community group’sGroup Name. If

your entry doesnot match, the widget refreshesand no filter is added.

4. The ActivityStream widget refreshes, and only activities performed by the selected user or

Community Group members appear.

Also, the users or Community Groups you selected in Step 3 appear in the widget’s filter

area (see example below).
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You can add as many users or Community Groups to the filter as you like, one at time. After

you finish, you can hide the filter by clicking the Hide button.

Removing an Entry from the ActivityStreamWidget Filter
To remove a user or Community Group from an ActivityStream widget filter, follow these

steps.

Note: If you remove all users and groups from the filter, the widget showsnotifications from alluserswhose

activities you can view.

1. If you cannot see the filter’s users or Community Groups, click the Filter button at the

bottom of the widget.

2. Click the Delete button ( ) next to the user or Community Group you want to remove.

3. The ActivityStream widget refreshes, and the removed user or Community Group’s

activities disappear from the stream.

The ActivityStream Widget on a PageBuilder Page

Note: To learn about Ektron’sPageBuilder functionality, see See "Building PageBuilder Pages" on page 6-1.

When used on PageBuilder page, the ActivityStream widget shows the logged-in user’s

activities by default. However, you can modify the widget to focus on another user’s or

community group’s activities.

For example, you create a PageBuilder page about the CEO of your company and want to

display notifications about activities that he, his colleagues, and his community groups perform

on the site.
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To accomplish this, add the ActivityStream Widget to a “See what the CEO is Up To” page.

While doing that, specify the user ID assigned to your CEO (available from his User Profile).

When an Intranet user visits the page, he sees a list of the CEO’s activities.

Displaying a Colleague’s or Group’s Notifications in the
Activity StreamWidget
To display another user’s or Community Group’s activities in the ActivityStream widget,

follow these steps.

Prerequisite: The ID number of the user or Community Group whose notifications will appear

1. Drag and drop the ActivityStream widget.

2. The following dialog appears.

3. Use the Feed Type dropdown to select User or Community Group.

4. In the Object ID Field, enter the user’s or Community Group’s ID.

5. Click Save.

ActivityStream Server Control
The ActivityStream server control displays notification messages generated by Ektron

CMS400.NET’s Notification system. For background information on the Activity Streams, see

"Activity Streams" on page 16-160.

Below are some pages where you might use this control.

n a landing page where a user arrives after logging in

n a user’s profile page

n a group’s profile page

n any page where you want to show a user’s or group’s activities
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The image below shows an intranet Home page with the ActivityStream server control

highlighted. Whenever a user logs into the site, he sees a list of his colleagues’ activities.

How the Control Determines the User or Group for
which to Display Activities
When this control is added to a Web page, Ektron CMS400.NET looks for a DefaultObjectID

defined in server control properties. If one is found, the activity stream is based on that user or

group. If none is found, notifications are based on the pages’s dynamic query string parameter,

which typically identifies the logged-in user.

Quick Setup Instructions
To add this control to a page, drag and drop it on a Web form and set the following properties.

n DefaultObjectID - If you want a user’s or community group’s activity stream to appear in

the control, enter that ID.

n DefaultObjectParameter - enter the default object parameter used on the QueryString to

define an object’s ID. For example, if you are passing the ID value of a community group,

you might enter ‘gid’ for this property.
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So, if you pass http://~yoursite~/CGHome.aspx?gid=21 in the query string

to a page containing this control, you see the activity stream for the Community Group whose

ID is 21.

n ObjectType - select the whether the control is associated with a user or Community Group

n TemplateUserProfile and ProfileParamName - If you want a user’s avatar in the activity

stream to be a clickable link that leads to his profile page, set these properties.

ActivityStream Server Control Properties
The ActivityStream server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMS

Explorer and can use it to browse to Content, Collections, etc.

See Also: ”Using CMSExplorer to Browse Your Ektron

CMS400.NET Site” on page 21-12

String

CacheInterval

Sets the amount of time the server control’s data is cached. The

default is 0 (zero). This is the amount of time, in seconds, a

control’s data is cached. For example, if you want to cache the

data for fiveminutes, set this property to 300 (three hundred).

See Also: ”Caching with Server Controls” on page 21-42.

Double

DefaultObjectID

The ID of the object whose activity streamwill appear where

you place this server control.

For example, if you want this control to displayScott Markey’s

activities, and hisUSER ID is 142, place 142 here, and set the

ObjectTypeproperty toUser.

To display the activity stream for the logged-in user, enter zero

(0).

Long

DisplayXslt

Determineshow information is displayed on the page. Enter the

path to the XSL file. It can be relative or absolute.

Warning! If you specify an external file, it is strongly rec-

ommended that you do not store this file your site’sWorkarea

folder. If you store this file in theWorkarea folder, the file will be

lost when you upgrade.

String
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Property Description Data Type

DynamicObjectParameter

Gets or sets the QueryString parameter to read a object ID

dynamically. To use the default object ID, leave blank.

For example, if you are passing the ID value of a community

group, youmight enter ‘gid’ for this property. So, if you passed

http://~yoursite~/CGHome.aspx?gid=21 on the

QueryStrings to a page containing this control, you would see

the activity stream for the group with an ID of 21.

String

EnablePaging

This property, in conjunction with theMaxResults property,

lets site visitors view an unlimited number of notificationswhile

controlling the amount of screen space. To accomplish this, the

display is limited to the number set in theMaxResults

property.

If you set this property to true, and the number of itemsexceeds

theMaxResults number, navigation aids appear below the last

item.

Boolean

Hide

Used to hide output of the control in design time and run time.

True =Hide control

False =Display control

Boolean

Language

Set a language for viewing the ActivityStream control. This

property shows results in design-time (in VisualStudio) and at

run-time (in a browser).

Integer

MarkupLanguage

Identify the templatemarkup file that controls the display of the

server control. For example, mymarkup.ekml. If the *.ekml file is

located in the same folder as theWeb form containing the

server control, just enter its name. Otherwise, the path to the file

can be relative or absolute. See Also: ”EktronMarkup

Language” on page 21-35.

String

MaxResults
TheMaximum number of notifications to fetch. 0 (zero) =

unlimited.
Integer

ObjectType

The type of object to which this control is assigned. Choicesare:

User - control is assigned to an individual

Group - control is assigned to a community group

ActivityFeedType
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Property Description Data Type

ProfileParamName

The parameter name to pass in the QueryString to the

TemplateUserProfile page, if you want it to be anything other

than id.

For example, youmayprefer userid, because it ismore

descriptive, as shown in the following example.

String

Stylesheet

Specify the path to a style sheet for use with the Documents

server control. The location can be relative or absolute. Leave

blank to use the default style sheet.

String

Suppress

WrapperTags

Suppresses the output of the span/div tagsaround the control.

The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TemplateActivity

The URL path to a page that contains another ActivityStream

server control.

When this property contains a path and the destination page

hasan ActivityStream control

whose ObjectType property is set

to Activity, a user can click an ActivityStream’s time span on

the first page to open a second page that contains just that activ-

ity.

String
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Property Description Data Type

Template

UserProfile

The URL path to a page that contains the UserProfile server

control. This path can be relative or absolute.

If you enter a path, a user can click anyuser’s name or avatar

from theMessage Board server control and be forwarded to his

profile page. See illustration below.

Note that user templates can be defined in the Ektron

CMS400.NET Workarea > Settings > Community

Management > Templates screen.

However, if you assign a template in this field, this setting takes

precedence over the setting on theWorkarea Template

screen.

String

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline portion of

an HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to

a blockof code.

Custom - Allows you to use a custom tag.

String
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Micro-messaging Server Control
The Micro-messaging server control allows users to post brief messages. It resembles micro-

blogging services like Twitter.

An example of the Micro-messaging control, within Ektron CMS400.NET’s sample Intranet

site, is circled below.

A user can reply to another user’s micro-message, as illustrated below. See Also: "Replying to

a Micro-message" on page 16-187.

The control

also lets

users search

micro-

messages.

See Also:

"Searching

for Micro-

messages"

on page

16-184
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This feature facilitates the building of tighter knit communities by allowing members to share

information and feel as though they have a personal stake in that information.

The following topics explain Micro-messaging in more detail.

n "Micro-messages are an Activity Type" on page 16-177

n "Display Modes" on page 16-178

n "Making a Hyperlink to a Single Page Version of a Micro-message" on page 16-182

n "Searching for Micro-messages" on page 16-184

n "Replying to a Micro-message" on page 16-187

n "Filtering Micro-message Spam" on page 16-188

n "Micro-messaging Server Control Properties" on page 16-189

Note: Auser’sPrivate Profile setting has three possible values:Public,Private andColleague. When

discussing this control and these settings,Private andColleague both act as Colleague.

Micro-Message Controls on Sample Sites
You can find examples of the Micro-message server control in these Ektron sample sites. You

can copy and edit the samples as needed to build your own pages.

n Ektron Technology site > Login

- user or colleague mode - User Profile page (top right corner)

- time line mode - http://your server/Intranet/timeline.aspx

n Intranet Site > Login >

- user or colleague mode - User Profile page (top right corner)

- message mode - http://your server/Intranet/MicroMessage.aspx?id=message id

- time line mode - http://your server/Intranet/timeline.aspx

n Developer Sample Site > Social Networking > MicroMessage and MicroMessage Api
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To download sample sites, go to http://www.ektron.com/solutions/startersites/.

Micro-messages are an Activity Type
A micro-message is type of Ektron CMS400.NET activity, like adding content or joining a

Community Group. As such, a new micro-message can generate a notification. To learn more,

see "Notifications" on page 16-129.

Like other notifications, Micro-messages can appear on an Activity Stream control. Micro-

messages are circled in the example below.

Also like other activities, Micro-messaging appears on the User Profile > Activities Tab >

Colleagues and My Activities subtabs, and has a Notification Message.
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Display Modes
This Micro-messaging server control has four modes, which let you control the messages being

displayed.

Mode Displays
For more

information, see

User
Micro-messages from the user associated with the

control

"User Mode" on page

16-179

Colleagues
Micro-messages from the user associated with the

control and his colleagues

"ColleaguesMode" on

page 16-180

TimeLine
Micro-messages for all site userswhosePrivate

Profile setting is set toPublic

"TimeLineMode" on

page 16-181

Message
"MessageMode" on

page 16-182
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Associating the Control with a User
Like other Ektron CMS400.NET server controls, there are two ways to specify the user

associated with the control.

n you manually specify a user in the control’s DefaultObjectID property. Do this when you

want to display a particular user’s micro-messages on a page.

n the user ID is retrieved from the page URL, which typically contains the logged-in user ID

(see example below). Do this when you want to display the micro-messages of whoever is

logged in.

User Mode
This mode displays micro-messages from the user associated with the control. See Also:

"Associating the Control with a User" on page 16-179

Use this mode to show micro-messages for a specified user such as on a User Profile page. For

example, when Mark views his own page in User Mode, he can

n see his messages

n submit a new micro-message. For example, he updates his status.

n search all micro-messages. See Also: "Searching for Micro-messages" on page 16-184.

Below is an example of the Micro-messaging server control with the Mode property set to

User.
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Using UserMode while Viewing AnotherUser’s Profile

A user can also view the control in User Mode when the control is associated with another

user. For example, one user views another user’s profile, which contains the Micro-messaging

control in User Mode.

The visitor only sees micro-messages from the user who owns the profile. The first user cannot

submit a micro-message from his colleague’s profile page, nor can he search micro-messages.

For example, Bob and Steve are colleagues. When Bob views Steve’s profile page, he

n sees all of Steve’s messages

n sees messages from colleagues they have in common

n cannot update his status

n cannot search messages

ColleaguesMode
Colleagues Mode displays micro-messages from the user associated with the control and his

colleagues. Use this mode on pages where you want to show micro-messages for these users,

such as a user profile page.

When a logged-in user visits his page that contains a Micro-messaging control in colleagues

mode, he can

n see his messages

n see his colleagues’ messages

n update his profile

n search micro-messages. See Also: "Searching for Micro-messages" on page 16-184
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Using ColleaguesMode while Viewing AnotherUser’s Profile

A user can also view the control in Colleagues Mode when the control is associated with

another user. For example, one user views another user’s profile, which contains the Micro-

messaging control in Colleagues Mode.

The first user only sees micro-messages from the user who owns the profile and colleagues he

has in common with the other user. The first user cannot submit a micro-message from his

colleague’s profile page, nor can he search micro-messages.

For example, Bob and Steve are colleagues. When Bob views Steve’s profile page, he

n sees all of Steve’s messages

n sees messages from colleagues they have in common

n cannot update his status

n cannot search messages

TimeLine Mode
This mode displays micro-messages for all of a site’s users whose Private Profile setting is set

to Public. Use this mode to display an ongoing stream of micro-messages from all such users in

chronological order, with the most recent at the top.

Whenever a user whose profile is set to Public submits a micro-message, it’s added to the time

line.

From the time line page, logged in users can also reply to and search micro-messages. See

Also: "Replying to a Micro-message" on page 16-187, "Searching for Micro-messages" on page

16-184
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Message Mode
This mode displays a single micro-message on a page.

For example, John sends his boss a link to a micro-message that praises his work. When his

boss clicks the link, he is taken to a page that contains this control. See Also: "Making a

Hyperlink to a Single Page Version of a Micro-message" on page 16-182

Making a Hyperlink to a Single Page Version of a
Micro-message
Each micro-message includes a time lapse, that is, the time between when the message was

submitted and now. See example below.

Each micro-message’s time lapse can become a hyperlink that contains the ID of that message

and a destination window. As a result, users can click the link to view that message in the new

window, as shown below.
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The destination window must

n be identified in the properties of the Micro-messaging server control that displays the

original message

n contain a Micro-messaging server control in Message Mode

Users can also copy the link and send it to another user, who can then view the message. To

copy a time lapse’s link information, hover over the link, right click, and select Copy Shortcut

(if using Internet Explorer) or Copy Link Location (if using Firefox).

Note: If someone sendsamicro-message link to another user who is ineligible to see themessage, it doesnot

appear. To see themessage, either the user who submitted it hashis profile set to Public, or the link recipient must

be themessage creator’s colleague.

Below is an example of how to set up this capability.

n Page1.aspx contains a Micro-messaging server control that displays a user’s micro-

messages. The messages’ time lapses are hyperlinks.

n Page2.aspx has a Micro-messaging server control in Message Mode. It displays the

individual message whose time lapse was clicked on the first page.

Note: For a full description of theMicro-message server control properties, see "Micro-messaging Server

ControlProperties" on page 16-189.

1. On Page1.aspx, add a Micro-messaging server control.

2. Set the DynamicObjectParameter to id.

3. Set the TemplateMessage to the path to Page2.aspx.

4. Set the Mode property to anything other than Message.

5. Save Page1.aspx.
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6. On Page2.aspx, add a Micro-messaging server control.

7. Set the DynamicObjectParameter to id.

8. Set the Mode property to Message.

9. Save Page2.aspx.

Now, when you log in to your site and navigate to Page1.aspx, you see a list of your micro-

messages. If you click the time lapse on any message, Page2.aspx loads, showing the message

you clicked.

Searching for Micro-messages
The Micro-messaging server control includes search functionality that lets a user enter terms

and returns micro-messages that match them. The search works with micro-messages only. It

does not search content, products, users, or groups.

Also, when searching, a user can find micro-messages submitted by

n himself

n his colleagues

n users whose profile is set to public

The following topics explain how to enable and use the micro-message search.

n "Enabling the Micro-message Search" on page 16-184

n "Entering Multiple Search Terms" on page 16-186

Enabling the Micro-message Search
The micro-message search requires your server to have the Full Text Search component of

Microsoft SQL Server.
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You can install the Full Text Search component during the installation of Microsoft SQL

Server.

Installing the Full Text SearchComponent

If the Full Text Search component is not installed, and you want to use the Micro-messaging

search functionality, insert the SQL Server installation disc into your computer and look for

Full Text Search.

After the Full Text Search is installed, run the FullTextIndex.sql script on your database. This

script is located in:

Program Files\Ektron\CMS400v80\Utilities\SiteSetup\Database\FullTextIndex.sql

Running aMicro-message Search

When Micro-message search is enabled, a Search tab appears on the control. To use the search,

click the tab and enter search terms.
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When results appear, you can click any message’s time span to proceed to the message itself. If

a reply appears among search results, you can click the link indicated below to view the

original message.

Entering Multiple Search Terms
You can enter more than one search term. If you do, the terms have an “and” relationship. For

example, if you enter Community and Group, only messages containing both Community and

Group are found.

Multiple Search TermExample

Consider the following micro-messages:

Peter: Wow, this is a great community.

Paul: I just joined the Motorcycle group
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Mary: I just created a new community group for Scrapbooking called “Clippers”

If you enter Community Group in the search box, the search returns only Mary’s message,

since it is the only one with both words.

Replying to a Micro-message
The Micro-message control allows users to reply to micro-messages and nests the reply with

the original message. Anyone who can see a message can reply to it, and see all other replies.

To add a reply, hover over a message and click the Reply button ( ).
When you do, a dialog box appears in which you can enter a reply of up to 2000 characters.

The box also displays the original comment.

Replies do not appear when a micro-message is viewed. Instead, a Replies link appears below

the comment. The number of replies appears next to the link.

Click Replies to view them. They are ordered from newest at the top to oldest at the bottom.
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To remove a reply, click the Delete button ( ); which appears when you hover over the
reply. Only the user who submitted the reply and the message board owner can delete replies.

Filtering Micro-message Spam
You can filter spam from Micro-messages. Ektron defines spam filtering as preventing users

from posting a micro-message or replying using:

n the same message more than once a day

n any second message within a specified time period after posting a first

n the same message within a specified time period

Note: If a user enters amicro-message and a reply that have the same text, each can be sent once without being

stopped by the spam filter. However, if either is sent a second timewithin the specified time period, the spam filter

blocks it.

The Micro-messaging server control also lets you define custom spam filters.

To define a spam filter, use the SpamControlType property on the MessageBoard server

control. The table below provides possible values and examples of how to set that property.

As a developer I

want to...

So I set the SpamControlType property

to...

And I set the

SpamTimeSpan

property to…

Prevent the same

user from posting

the samemessage

more than once a

day

SameUserSameMessageSameDay

Prevent a user from

posting any

additional

messages for 30

minutes

SameUserTimeDelay 1800
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As a developer I

want to...

So I set the SpamControlType property

to...

And I set the

SpamTimeSpan

property to…

Prevent a user from

posting the same

message for 2

hours

SameMessageTimeDelay 7200

Usemyown spam

filter code

Customand add the code to the code behind

page of the template containing theMicro-

messaging server control. See Also: "Creating a

CustomSpam Filter" on page 16-189

Creating a Custom Spam Filter
You can create your own spam filter in the code behind of the page that contains the Micro-

messaging control. To do this, set the SpamControlType property to Custom, call the

CustomSpamMethod in the page load event, and point it to your custom spam filter

method.

Below is a Visual Basic example that blocks the text “Hello World.”

Partial Class Default
Inherits System.Web.UI.Page

Protected Sub Page_Load(ByVal sender As Object, ByVal e As System.EventArgs) Handles

Me.Load

Me.MicroMessaging1.CustomSpamMethod(AddressOf SpamHandler)

End Sub

Private Function SpamHandler(ByVal data As Ektron.Cms.MicroMessageData) As Boolean

If data.MessageText = "Hello World" Then

Return True

End If
End Function
End Class

Micro-messaging Server Control Properties
The Micro-messaging server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.
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Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer and

can use it to browse to Content, Collections, etc. See

Also: ”Using CMSExplorer to Browse Your Ektron

CMS400.NET Site” on page 21-12

String

CacheInterval

Sets the amount of time the server control’s data is

cached. The default is 0 (zero). This is the amount of

time, in seconds, a control’s data is cached.

For example, if you want to cache the data for five

minutes, set this property to 300 (three hundred). See

Also: ”Caching with Server Controls” on page 21-43.

Double

DefaultObjectID
The default object ID for this control to use when there

is nomatching dynamic parameter value passed.
Long

DisplayXslt

Determineshow information is displayed on the page.

Enter the path to the XSL file. It can be relative or

absolute.

Warning! : If you specify an external file, it is strongly

recommended that you do not store this file your site’s

Workarea folder. If you store this file in theWorkarea

folder, the file will be lost when you upgrade.

String

DynamicObjectParameter

Gets or sets the QueryString parameter to read a

object ID dynamically. To use the default object ID,

leave blank.

For example, if you are passing the ID value of a user,

youmight enter ‘uid’ for this property. So, if you passed

http://~yoursite~/UPpage.aspx?uid=21

on theQueryStrings to a page containing this control,

you would see the list of Micro-messages for the user

with an ID of 21.

String

EnablePaging

This property, in conjunction with theMaxResults

property, lets site visitors view an unlimited number of

notificationswhile controlling the amount of screen

space. To accomplish this, the display is limited to the

number set in theMaxResults property.

If you set this property to true, and the number of items

exceeds theMaxResults number, navigation aids

appear below the last item.

Boolean

Hide

Used to hide output of the control in design time and

run time.

True =Hide control

False =Display control

Boolean
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Property Description Data Type

Language

Set a language for viewing the ActivityStream control.

This property shows results in design-time (in Visual

Studio) and at run-time (in a browser).

Integer

MaxResults
Themaximum number of messages to return. 0 (zero)

= unlimited.
Integer

MaxSearchResults

Themaximum number of messages to return when

performing amicro-message search.

0 (zero) = unlimited.

Integer

Mode

Specify the type of micro-messages you want to

display. Choicesare:

User - micro-messages for logged-in user

with search option

Colleagues - micro-messages for logged-in user and

colleaguesof a specified user with search option

TimeLine - micro-messages from all site userswhose

Private Profile setting is set to Public; includes search

option

Message - a single specifiedmessage

See Also: "DisplayModes" on page 16-178

ActivityFeedType

ProfileParamName

The parameter name to pass in the QueryString to the

TemplateUserProfile page, if you want it to be anything

other than id.

For example, youmayprefer messageid, because it is

more descriptive.

String
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Property Description Data Type

SpamControlType

Assignsa spam filter to themicro-messages. The

control supplies three predefined spam filters, and the

ability to define your own.

Note: Spam control is turned off by default.

Filter choicesare:

SameUserMessageDay - prevents a user from

posting the samemessage to the boardmore than

once per day

SameUserTimeDelay - prevents a user from posting

another message for specified period of time. The

amount of time is specified, in seconds, in the

SpamTimeSpan property.

SameMessageTimeDelay - prevents a user from

posting an identicalmessage for a specified period of

time. The amount of time is specified, in seconds, in the

SpamTimeSpan property.

Custom - control uses custom spam filter code. See

"Creating a CustomSpam Filter" on page 16-189.

See Also: "FilteringMicro-message Spam" on page

16-188

SpamTimeSpan

Sets the amount of time, in seconds, for which the

SameUserTimeDelayor SameMessageTimeDelay

spam filter delaysa user from posting. These values

can be selected in theSpamControlType property.

See Also: "FilteringMicro-message Spam" on page

16-188

Integer

Stylesheet

Specify the path to a style sheet for use with the

Documents server control. The location can be relative

or absolute. Leave blank to use the default style sheet.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the

control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TemplateMessage

The URL path to a page that contains another Micro-

messaging server control.

When this property contains such a path, and the

destination page hasaMicro-messaging control

whose Modeproperty is set to Message, a user can

click amicro-message’s time span on the first page to

open a second page that contains just that message.

See Also: "Making a Hyperlink to a Single Page

Version of aMicro-message" on page 16-182

String
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Property Description Data Type

TemplateUserProfile

The URL path to the page that contains the

UserProfile server control. This path can be relative or

absolute.

If you enter a path, a user can click anyuser’s name or

avatar from theMicro-message server control and be

forwarded to his profile page. See illustration below.

String

Template

UserProfile (Continued)

Note that user templates can be defined in the Ektron

CMS400.NET Workarea > Settings > Community

Management > Templates screen.

However, if you assign a template in this field, this

setting takesprecedence over the setting on the

Workarea Template screen.

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline

portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply

attributes to a blockof code.

Custom - Allows you to use a custom tag.

String

Flagging
Flagging allows a site visitor to flag a piece of content and provide feedback. Flagging enables

your site visitors to moderate your site. This is especially important for sites with large

amounts of visitor-generated content. Flagging also helps site visitors feel invested in the site.
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For example, you create a flagging definition with the following options that let your site

visitors decide if content is inappropriate.

n Sexually Explicit

n Mature (over 18 only) content

n Graphic Violence

n Hate Speech

Flagging can also be used to let site visitors leave an opinion about a content item. Below is a

sample list of options.

n Loved This Content

n Hated This Content

n I Could Take It or Leave It

Flagging is similar in function to the ContentReview server control. The main differences are

n Flagging feedback is not displayed on the site

n The Flagging control provides a user-defined list describing the reason for the flag

So, a flagging definition describes how a content item may be reviewed, and provides a list of

choices that may be applied to content in a folder. Here is what one might look like on your

site.

After you create a flagging definition, you assign it to relevant folders. All content in the

folders can then be flagged with that definition.

As the final step in allowing site visitors to flag content, a developer must add a

ContentFlagging server control to a Web page, and assign to it the ID of the content being

flagged. See Also: "ContentFlagging Server Control" on page 16-204.

Flagged content appears in the following Workarea locations.

n Content Flags list on the Smart Desktop
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n Settings > Community Management > Flagging > Flagged Content

n a content item’s View Content Reports > Flagging tab

This section contains the following topics.

n "Flagging Definitions" on page 16-195

n "Flagged Content" on page 16-198

Flagging Definitions
The Flagging Definitions screen is located in the Workarea > Settings > Community

Management > Flagging. From here, you can view a list of flagging definitions, work with

them, or create new ones. In addition, you can filter the list by language.

This screen contains the following information about a flagging definition.

Field Description

ID The ID of the flagging definition.

Name The name of the flagging definition.

Description A description of the flagging definition.

Language
An image of a national flag associated with the language. For example,

American English appears as .

Items

The number of flags in a definition. For example, if you have a flag definition

for thesemovie ratings:

n G

n PG

n PG-13

n R

The itemscount for this flag definition would be four.

This section contains the following topics.

n "Adding a Flagging Definition" on page 16-196

n "Edit a Flagging Definition" on page 16-196

n "Deleting a Flagging Definition" on page 16-196

n "Assigning a Flagging Definition to a Folder" on page 16-197
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Adding a Flagging Definition
To create a flagging definition, follow these steps.

1. In the Workarea, navigate to Settings > Community Management > Flagging >

Flagging Definitions.

2. Select a language with which the flagging definition will be associated.

3. Click the Add button ( ).

4. The Add Flagging Definition screen appears.

5. Enter a Name and Description for the flagging definition.

6. Click the Option button ( ) to add a flag to this flagging definition.

7. Continue to click the Option button to add additional flags.

8. If necessary, change the order of the flags by clicking the Sorting buttons ( ). If

you create a flag you want to remove, click the Remove button ( ).

9. Click the Save button ( ).

Edit a Flagging Definition
To edit a flagging definition, follow these steps.

1. In the Workarea, navigate to Settings > Community Management > Flagging >

Flagging Definitions.

2. Click the flagging definition Name link or the ID link.

3. Edit the available fields.

4. Click the Save button ( ).

Deleting a Flagging Definition
When you no longer want to use a flagging definition, delete it. When a flagging definition is

deleted, it is removed from all folders with which it is associated.

To delete a flagging definition, follow these steps.

1. In the Workarea, navigate to Settings > Community Management > Flagging >

Flagging Definitions.

2. Click the flagging definition Name link or the ID link.

3. Click the Delete button ( ).
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Assigning a Flagging Definition to a Folder
After creating a flagging definition, you assign it to one or more folders. When you do, the

flagging definition may be applied to content in that folder.

Like other folder properties, a folder’s flagging definitions may be inherited by its child

folders, although this does not occur by default.

To assign a flagging definition to a folder, follow these steps.

1. Create a flagging definition, as explained in "Adding a Flagging Definition" on page 16-

196.

2. Click the Content tab on the Smart Desktop.

3. Navigate to the folder that contains the content that may be flagged.

4. Select View > Properties from the View menu.

5. The View Properties screen appears.

6. Click the Edit button ( ).

7. Click the Flagging tab.
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8. Make sure the Inherit Parent Flagging Configuration check box is not checked.

9. Select a flagging definition from the Flagging drop down.

10. Click the Save button ( ).

Flagged Content
There are three places in the Workarea to work with flagged content.

n The Smart Desktop, which indicates the most recent flags applied to any content. See

"Content Flags on the Smart Desktop" on page 16-198.

n Settings > Community Management > Flagging > Flagged Content shows all flagged

content. See "Flagged Content in Settings > Community Management" on page 16-199.

n A tab on the Content Reports screen displays a list of content flags for a specific content

item - See "Viewing a Content Item’s Flags" on page 16-201.

Flagged content is more fully explained through the following topics.

n "Content Flags on the Smart Desktop" on page 16-198

n "Flagged Content in Settings > Community Management" on page 16-199

n "Viewing a Content Item’s Flags" on page 16-201

n "Viewing a Flag’s Details" on page 16-203

n "Editing a Flag’s Details" on page 16-203

n "Deleting a Flag" on page 16-204

Content Flags on the Smart Desktop
This area lists the ten most recently added content flags. From there, you can view a flag by

clicking its Title.
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To view all recent flags, click the View recent flags link. Clicking this link takes you to the

Content Reports: Recent Flags screen. See Also: "Flagged Content in Settings > Community

Management" on page 16-199

Flagged Content in Settings > Community Management
The Flagged Content area in Settings > Community Management > Flagging > Flagged

Content allows you to display a list of flags assigned to content. By default, the list shows

flags for the last ten days. You can change this by entering a new number in the Show flags

for the last # days field.

See Also: "Flagging" on page 16-193

The information for each flag is explained in this table.

Field Description

Title
The title of the content blockbeing flagged. Clicking this link brings you to a

detailed description of the content’s flag.

DisplayName
The name of the user who flagged the content as it is displayed on theWeb

site.

Date The date the content was flagged.
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Field Description

Flag The specific flag from the flagging definition for this content.

Comment Comments added by the site visitor who flagged the content.

From this screen, you can perform the following actions:

n View the details of a submitted content flag - see "Viewing a Flag’s Details" on page 16-

203

n Generate a Flagged Content report - see "Generating a Flagged Content Report" on page

16-200

n Print a list of flagged content - see "Printing a List of Flagged Content" on page 16-200

n Filter flagged content by folder - see "Filtering Flagged Content by Folder" on page 16-

201

n Filter flagged content by language - "Filtering Flagged Content by Language" on page 16-

201

Generating a FlaggedContentReport

By default the Content Reports: Recent Flags screen shows content flagged within the last ten

days. To view a different date range, follow these steps.

1. In the Workarea, navigate to Settings > Community Management > Flagging > Flagged

Content.

2. In the Showing flags for the last # days field, enter a new number of days for which to

show Flagged Content.

3. Click the Report button ( ).

4. The page refreshes and displays the new report.

Printing a List of FlaggedContent

On the Content Reports: Recent Flags screen, you can output the flagged content report to a

printer by clicking the Print button ( ). This creates an HTML version of the list that opens

CommunityManagement

16-200
ReferenceManual

Version 8.0 Rev 1.3



in a browser. From there, you can print the list using the browser’s print options.

Filtering FlaggedContent by Folder

From the Content Reports: Flagged Content screen, you can filter flagged content by folder.

This allows you to see flagged content for one folder. To do so, follow these steps.

1. In the Workarea, navigate to Settings > Community Management > Flagging > Flagged

Content.

2. Click the Filter button ( )

3. The Select Folder screen appears.

4. Select a folder.

5. Click the Save button ( ).

6. The page refreshes, and any flagged content in the folder is shown.

Note: Only flagged content that fallswithin the time frame for the Showing flags for the past # days field is

shown. For example, if the field is set to five when you filter bya folder, only content that’s been flagged in the last

five daysappears.

Filtering FlaggedContent by Language

To see flagged content for a specific language, select the language from the Language drop

down box. When the page refreshes, only flagged content associated with the language

appears.
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Viewing a Content Item’s Flags
You can also view flags for a specific content item. To see them, go to the Content Report

screen > Flagging tab. From this screen, you can filter flags by a date range or see all flags

associated with the content.

In addition, this screen contains a purge button, which allows you to remove all flags

associated with this content. This subsection contains the following topics:

n "Viewing Flags Applied to a Content Item" on page 16-202

n "Purging a Content Item’s Flags" on page 16-203

Viewing Flags Applied to aContent Item

Follow the steps below to get flags for a content item.

1. In the Workarea, find the content block for which to retrieve content flags.

2. Click the title of the content block.

3. The View Content screen appears.

4. Click the Content Reports button ( ).

5. Click the Select Date button ( ) next to Start Date to select a start date.

6. Click the Select Date button ( ) next to End Date to select an end date.
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Note: To retrieve all flags for a content item, leave the Start Date and EndDate blank.

Note: To remove a Start Date or End Date, click the Delete Date button ( ).

7. Click the Get Flags button.

8. A list of flags applied to that content within the selected date range is displayed.

Purging aContent Item’s Flags

If you need to delete flags for a content item, follow these steps.

1. In the Workarea, find the content block for which to purge content flags.

2. Click the title of the content block.

3. The View Content screen appears.

4. Click the Content Reports button ( ).

5. Click the Select Date button ( ) next to Start Date to select a start date.

6. Click the Select Date button ( ) next to End Date to select an end date.

Note: To purge all flags for a content item, leave the Start Date and EndDate blank.

Note: To remove a Start Date or End Date, click the Delete Date button ( ).

7. Click the Purge Flags button.

8. The flags are removed.

Viewing a Flag’s Details
Viewing a flag’s detail information allows you to read the entire comment if it is truncated in

one of the lists. You can also edit or delete a flag from this screen.

To view detailed flag and comment information, follow these steps.

1. Navigate to one of these area in the Workarea:

- Smart Desktop > Content Flags widget

- Settings > Community Management > Flagging > Flagged Content

- Reports > Contents > Content Flags

2. Click either a flag’s content title or the flag’s date.

3. The flag’s detail information appears.

See Also: "Editing a Flag’s Details" on page 16-203; "Deleting a Flag" on page 16-204
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Editing a Flag’s Details
Editing a flag allows you to change the flag’s selection or the comments for a flagged content

item. This can be useful if a user selects a flag by mistake, or you want edit a flag’s comments.

For example, a user selects the “Offensive Content” flag and he meant to click “Copyright

Violation”.

To edit a flag or its comment information, follow these steps.

1. Navigate to one of these area in the Workarea:

- Smart Desktop > Content Flags

- Settings > Community Management > Flagging > Flagged Content

- Reports > Contents > Content Flags

2. Click either a flag’s content title or the flag’s date.

3. The flag’s detail information appears.

4. Click the Edit button ( ).

5. Change the flag or edit the comments.

6. Click the Save button ( ).

7. The flag’s information is changed.

Deleting a Flag
When you do not need a flag, you can delete it from the system. When you do, the flag is

permanently removed.

To delete a flag, follow these steps.

Note: To remove all flagsassociated with a specific content item, see "Purging a Content Item’sFlags" on page

16-203.

1. Navigate to one of these area in the Workarea:

- Smart Desktop > Content Flags

- Settings > Community Management > Flagging > Flagged Content

- Content Reports > Flagging tab for a content item

2. Click either a flag’s content title or the flag’s date.

3. The flag’s detail information appears.

4. Click the Delete button ( ).

5. A dialog appears asking you to confirm the deletion.

6. Click OK.
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ContentFlagging Server Control

Note: To learn about creating andmanaging the content flagsused in this server control, see "Flagging" on page

16-193.

After you add this control to a Web form, a site visitor who views nearby content can flag it

and provide feedback. This is similar to the ContentReview server control. The main

differences are:

n The feedback is not displayed on the site

n The control provides is a user-defined list describing the reason for the flag

Lists can be centered on content that is inappropriate for some viewers. For example:

n Sexually Explicit

n Mature (over 18 only) content

n Graphic Violence

n Hate Speech

Flagging can also be used to notify administrators about the quality of the content, helping

you to create a recommended content list. Below is an example of a flagging definition’s

options.

n Loved This Content

n Hated This Content

n I Could Take It or Leave It

Having a way to flag content is a necessity for sites with a large quantity of site-visitor

generated content. Content flagging spreads moderation of your site to your visitor base and

helps site visitors feel invested in the site.

ContentFlagging Server Control Properties
The ContentFlagging server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.
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Property Description
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and

can use it to browse to Content, Collections, etc. See

Also: ”Using CMSExplorer to Browse Your Ektron

CMS400.NET Site” on page 21-12

String

DefaultContentID

The default content ID for this control to use when

there is nomatching dynamic parameter value

passed.

Long

DisplayXslt

Determineshow information is displayed on the page.

Enter the path to the XSL file. It can be relative or

absolute.

Warning! : If you specify an external file, it is strongly

recommended that you do not store this file in your

site'sWorkarea folder. If you store this file in theWork-

area folder, the file will be lost when you upgrade.

String

DynamicParameter

Gets or sets the QueryString parameter to read a

content ID dynamically. To use the default content ID,

leave blank.

String

FlagImage

Enter a path to an image that overrides the text in the

FlagTextproperty.When the image is clicked, the

flag dialog appears.

String

FlagText

Text for the link that is shown to allow flagging. For

example, youmight use “Click here to flag this

content.” The FlagImageproperty overrides this

property.When the text link is clicked, the flag dialog

appears.

String

Hide

Used to hide output of the control in design time and

run time.

True =Hide control.

False =Display control.

Boolean

Language

Set a language for viewing the ContentFlagging

control. This property shows results in design-time (in

VisualStudio) and at run-time (in a browser).

Integer

Stylesheet

Specify the path to a style sheet for use with this server

control. The location can be relative or absolute.

Leave blank to use the default style sheet.

String
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Property Description
Data

Type

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the

control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline

portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply

attributes to a blockof code.

Custom - Allows you to use a custom tag.

String

Email Invites for Community
Management
The Community Platform’s email notification feature enables Ektron CMS400.NET to generate

email that invites a user to join the site, a community group or become a colleague of another

user.

For example, a message might be sent when someone in a community group wants another

user to join the group.

Creating the Email Message

You can create an email message to be sent when a user invites another user to join a group,

the site or invite them to be a friend. A simple editor lets you apply some XHTML formatting

the message.

Including Variables in the Default Message
The messages can include variables that retrieve information about the person who’s sending

the invite or the link to join a group and display it in the message text. The variables are

surrounded by at signs (@). For example:

@appSenderName@ is used to display the name of the user sending the invite.

In the email, this text might read:
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Alan Administrator has invited you to join the Marketing Community Group.

You can use the following variables in the body of an email notifications.

Variable Displays this information in the email

@appOptionalText@
Text that the user types into the Optional Text boxon the Invite

server control.

@appSenderName@ The name of the person sending the invitation

@appFriendDisplayName@ The name of the person to which the invite is being sent.

@appInvitedEmail@ The email addressof the person being invited.

@appInviteId@

Used for appending the invite ID to the registration URL. For

example:

Click <a

href=http://www.example.com/register.aspx&fInvId=

@appInviteId@>here</a> to accept.

@appGroupName@ The name of the group a person is being invited to join.

To create a message, follow these steps.

1. In the Workarea, go to Settings > Community Management > Messages.

2. Click the Add button ( ).

3. Enter a title that describes the message.

4. At the Type field, select either FriendInvitation, SiteInvitation or GroupInvitation.

5. Select whether to make the email message a Default message.

6. In the Subject box, add a subject for the email.

7. In the editor, enter the message text. Use the variables listed in the table above to retrieve

information about the about the invitation and display it in the message.

8. Click the Save button ( ).

Invite Server Control
IMPORTANT!
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Warning! The default From email addressused to send all invitations is invitation@example.com. Ektron, Inc.

strongly recommendsyou change this address for use with your site. See Also: "Changing an Invitation’s From

Email Address" on page 16-209.

The Invite server control allows site users to invite people via email to join the site and

become their colleagues. The server control displays a dialog box that allows a user to enter

multiple email addresses separated by commas, semi-colons, spaces or separate lines.

The dialog box also has an area for an optional message which you define in the

OptionalMessageText property. On the Web page, a user can add additional information

to this message or remove it completely. The message is the message that appears in the email.

The From address that’s used when the control sends an invite is a single address for all users.

The default is invitations@example.com. You or your site’s administrator should change this

address. See Also: "Changing an Invitation’s From Email Address" on page 16-209

Changing an Invitation’s From Email Address
To change the From email address that is used when an invitation is sent, open your site’s

web.config file and change the value of following key.

<add key="ek_InvitationFromEmail" value="invitations@example.com"/>

Invite Server Control Properties
The Invite server control properties are described in this table.
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Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description
Data

Type

Authenticated

Indicates if you are logged in to the CMS

Explorer and can use it to browse to Content,

Collections, etc. See Also: ”Using CMSExplorer

to Browse Your Ektron CMS400.NET Site” on

page 21-12

String

DisplayXslt

Determineshow information is displayed on the

page. Enter the path to the XSL file. It can be

relative or absolute.

Warning! If you specify an external file, it is

strongly recommended that you do not store

this file in your site'sWorkarea folder. If you

store this file in theWorkarea folder, the file will

be lost when you upgrade.

Warning! If you enter a valid EkML file at the

MarkupLanguage property, theDis-

playXslt property value is ignored.

String

FriendMessageId

The ID of themessage to send in the link section

of the colleague request email. This type of

request is sent when the Invite server control’s

system detects that an email in the list is already

registered with the site. Thismessage is defined

in theWorkarea >Settings >Community

Management >Messages.

If set to 0 (zero), the server control uses the

default message.

Long

Hide

Used to hide output of the control in design time

and run time.

True =Hide control

False =Display control

Boolean

InviteMessageId

The ID of themessage to send in the link section

of the Invite request email. This type of request is

sent to people who are not registered with the

site. Thismessage is defined in theWorkarea >

Settings >Community Management >

Messages.

If set to 0 (zero), the server control uses the

default message.

String
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Property Description
Data

Type

Language

Set a language for viewing the Invite server

control. This property shows results in design-

time (in VisualStudio) and at run-time (in a

browser).

Integer

OptionalMessageText

The body text of the emailmessage. The text

appears in the Invite server control’s dialog box

and can be edited byuserswhen theyuse the

Invite control.

String

Stylesheet

Specify the path to a style sheet for use with the

server control. The location can be relative or

absolute. Leave blank to use the default style

sheet.

Warning! If you enter a valid EkML file at the

MarkupLanguage property, theStyle-

sheet property is ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tags

around the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s

tag.

The default isSpan.

Span - The <span> tag is used to designate an

inline portion of an HTML document asa span

element.

Div - The <div> tag is used when you want to

apply attributes to a blockof code.

Custom - Allows you to use a custom tag.

String

Messaging Server Control
The Messaging server control allows site users to send and receive messages. This control

utilizes an Inbox and Sent Items system to control where messages are displayed. Messages
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that have been sent to a user appear in the Inbox of recipients. These messages also appear in

the Sent Items list of the users who have sent them.

Messages are created using the provided editor. Developers can customize the height and width

of the editor. They can also control toolbar items in the editor and whether or not the user can

edit a message using HTML.

Message recipients can be limited to a user’s colleagues, or they can be expanded to include all

CMS400.NET users.

To learn how a site user interacts with this control on the site, see "Messaging" on page 16-

216.

Pre-Populating the To: Field of a Message
You can pre-populate the To: field of a message with one or more users’ names by setting the

RecipientParamName property to a given QueryString parameter. This allows you to create

a link on a page, such as “Send a Message to this user” or “Send a message to all users in this

group.”

For example, if you create a link on a Web page to the template containing the Messaging

server control, pass a user’s ID in the QueryString as UID and populate the

RecipientParamName property with “UID”, the server control reads the user’s ID and

fills in the To: field with the user’s name. Here is how the Link might look:

messaging.aspx?g=pmessage&uid=1

You can pass multiple user IDs by creating a list of ID parameters and IDs. For example:

messaging.aspx?g=pmessage&uid=1&uid=20&uid=12&uid=18

IMPORTANT!

Warning! Youmust include theg=pmessage parameter in the QueryString to open theMessaging server con-

trol to its editor. Otherwise, the server control opens to the Inbox.

The VB example below creates a dynamic hyperlink that populates the To: field of a message

with all of a logged in user’s colleagues. For this example to work, you need to add a Literal

control to the Web form and name it Lit1.

Notes are included as green comment text.
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Protected Sub Page_Load(ByVal sender As Object, ByVal e As System.EventArgs) Handles

Me.Load
Dim frnds As New Ektron.Cms.API.Community.Friends()
Dim apicontent As New Ektron.Cms.ContentAPI
Dim dirUsrData() As Ektron.Cms.DirectoryUserData

If (apicontent.UserId > 0) Then
dirUsrData = frnds.GetFriends(apicontent.UserId)
If ((Not IsNothing(dirUsrData)) AndAlso (dirUsrData.Length > 0)) Then
Dim idx As Integer
Dim friendsList As String = String.Empty
For idx = 0 To dirUsrData.Length - 1
friendsList += "&uid=" dirUsrData(idx).Id.ToString()
Next
Lit1.Text = "<a href=""webformPM.aspx?g=pmessage&uid=" + friendsList + """>Send a

message to my friends</a>" '''Replace webformPM.aspx with the Web form containing your

messaging server control and make sure the ReciepientParamName property of that control

is set to “uid” for this example.
Else
lit1.Text = "The logged in user currently has no friends"
End If
Else
lit1.Text = "You must be logged in to run this demo"
End If

apicontent = Nothing
frnds = Nothing
End Sub

Messaging Server Control Properties
The Messaging server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description
Data

Type

Authenticated

Indicates if you are logged in to the CMS

Explorer and can use it to browse to Content,

Collections, etc. See Also: ”Using CMSExplorer

to Browse Your Ektron CMS400.NET Site” on

page 21-12

String

DisplayXslt

Determineshow information is displayed on the

page. Enter the path to the XSL file. It can be

relative or absolute.

Warning! If you specify an external file, it is

strongly recommended that you do not store

String
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Property Description
Data

Type

this file in your site'sWorkarea folder. If you

store this file in theWorkarea folder, the file will

be lost when you upgrade.

EnablePreSearch

When set to True, all users are pre-loaded and

displayed in the search resultswhen browsing

for users (an empty string search). If the

FriendsOnly property is set to True, only

colleaguesare pre-loaded and displayed.

Boolean

FriendsOnly

When set to True, users can only send

messages to people on their colleagues list.

Default is True.

True = sendmessages to colleaguesonly.

False = sendmessages to all CMS400.NET

users.

Boolean

GroupParamName

Enter the QueryString parameter used to pass

the ID of a community group. The default isgid.

Use this propertywhen you want to email all the

group’smembers.

String

Hide

Used to hide output of the control in design time

and run time.

True =Hide control

False =Display control

Boolean

JavascriptEditorHeight
Set the height in pixels for the editor. The default

is400.
Integer

JavascriptEditorHTMLMode

Note: Asof version 7.6, the JavaScript editor

hasbeen removed fromCMS400.NET. This

property hasbeen deprecated.

Set to True to allow users to edit their posts and

replies in HTML. The default isFalse.

String

JavascriptEditorToolbar

Note: Asof version 7.6, the JavaScript editor

hasbeen removed fromCMS400.NET. This

property hasbeen deprecated.

Decide which buttonsare available in the

Javascript Editor.

String
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Property Description
Data

Type

JavascriptEditorWidth
Set the width in pixels for the editor. The default

is625.
Integer

Language

Set a language for viewing the server control.

This property shows results in design-time (in

VisualStudio) and at run-time (in a browser).

Integer

ProfileParamName

This property identifies the QueryString

parameter used to pass the ID of a user to a

profile page or location template when a user

name is clicked in the Browse User screen. The

default is ID. The parameter defined in this

property is appended to the QueryString of the

path defined in theProfileUrl property. The

default is ID.

Warning! Important: This parameter needs

tomatch the parameter set in the UserProfile

server control’sDynamicParameter prop-

erty on the page defined in theProfileUrl

property.

String

ProfileUrl

The URL of the profile page template. This page

is opened in a new window when a user clicks a

display name on the Browse Users screen. This

allowsa user to get additional profile information

about the potentialmessage recipient.

String

RecipientParamName

Enter the QueryString parameter used to pass

the ID of a user. For example, if the QueryString

is?uid=1, then enter “uid” in this property.

By creating a comma separated list of user IDs in

the QueryString, you can passmultiple users.

For example:

?uid=1,20,12,18

This property is typically used when you want to

pre-populate the To: field of amessage. See

Also: "Pre-Populating the To: Field of a

Message" on page 16-212

String

Stylesheet

Specify the path to a style sheet for use with the

server control. The location can be relative or

absolute. Leave blank to use the default style

sheet.

Warning! If you enter a valid EkML file at the

MarkupLanguage property, theStyle-

sheet property is ignored.

String
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Property Description
Data

Type

SuppressWrapperTags

Suppresses the output of the span/div tags

around the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

UserSearchDisplayXslt

The XSLT used to display the user search

control inside theMessaging server control. The

default isMsgUserSelect.xsl.

Warning! : If you want to edit this file, it is

strongly recommended that youmake a copy,

change its name andmove it outside of your

site'sWorkarea folder. If youmake changes to

this file and do not move it out of theWorkarea,

this file and the changeswill be lost when you

upgrade.

String

WrapTag

Allowsa developer to specify a server control’s

tag.

The default isSpan.

Span - The <span> tag is used to designate an

inline portion of an HTML document asa span

element.

Div - The <div> tag is used when you want to

apply attributes to a blockof code.

Custom - Allows you to use a custom tag.

String

Messaging
By default, when a logged in user visits the Messages page, the Inbox appears. You can see

who sent the message, the subject and the date the message was sent.

From this screen, users can:

n view a list of messages sent to them. See "Viewing a Message" on page 16-217.

n compose a new message. See "Compose a New Message" on page 16-219.

n delete a message. See "Delete a Message" on page 16-218.

n navigate to the sent messages list. See "Sent Messages" on page 16-216.

Sent Messages
Sent Messages provides a list messages you’ve sent to other users. On this screen, you can see

to whom the message was sent, the subject and date it was sent.
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From the Sent Messages list you can:

n view a messages details. See "Viewing a Message" on page 16-217.

n compose a new message. See "Compose a New Message" on page 16-219.

n delete a sent message. See "Delete a Message" on page 16-218.

Viewing a Message
To view a message’s details, click the message’s subject. The details of a message include who

the message is from, to whom it was sent, the subject, date sent, and body of the message.

Actions you can take from the message details screen include:

n Reply to a message. See "Reply to a Message" on page 16-217.

n Forward a message. See "Forward a Message" on page 16-218.

n Moving to the Next or Previous message. See "Moving to the Next or Previous Message"

on page 16-218

n Print a message. See "Print a Message" on page 16-218.

n Delete the message. See "Delete a Message" on page 16-218.

n Compose a new message. See "Compose a New Message" on page 16-219.

Reply to a Message
When replying to a message, you reply only to the person who sent you the original message.

A reply contains the details of the original message. The details of the original message can be

edited or removed from the new message.

To reply to a message, follow these steps:

1. Find the message to which you want to reply and click the subject.

2. Click Reply.

3. The message editor screen appears with the original message’s details in the body of the

message.

4. Add your reply.
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5. Click the Send button.

6. The message is sent.

Forward a Message
When forwarding a message, you can select to whom the message is sent. A forwarded message

contains the details of the original message which can be edited or removed from the new

message.

To forward a message, follow these steps:

1. Click Forward.

2. The message editor screen appears with the original message’s details in the body of the

message.

3. Add any additional information to the message.

4. Click the Send button.

5. The message is sent.

Moving to the Next or PreviousMessage
Web site users can navigate through their messages by clicking the Next or Previous link

located in the header of a message. Clicking the Next link opens the next newest message in

the list. Clicking the Previous link opens the next oldest message in the list. Once you have

reached the end of the list, that option’s link is unavailable. For example, when a user reaches

the newest message in the list, the Next link is greyed out and cannot be clicked.

Print a Message
To print a message, follow these steps:

1. Click Print.

2. The Print dialog box appears.

3. Select a printer.

4. Click the Print button.

Delete a Message
Deleting a message permanently deletes it from CMS400.NET.

To delete a message, follow these steps:

1. Click the Delete button ( ).

2. A dialog appears asking you to confirm the deletion.
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3. Click OK.

4. The message is deleted and you are returned to the Inbox or Sent Messages.

Compose a NewMessage
Clicking Compose launches the Compose a Message screen. To compose a message, follow

these steps:

1. Click Compose.

2. The Compose Message screen appears.

3. Click the Browse Users link.

4. Select people to be entered in the To: field.

5. Add a subject to the Subject field.

6. Add text to the body of the message in the editor.

7. Click the Send button.

SocialBar Server Control
The SocialBar server control allows users of the community Web site to bookmark colleagues,

community groups and content. When the Social Bar is associated with users, it is used to send

colleague requests and remove colleagues when a user visits another user’s profile page. When

it’s associated with a group, it can be used to join and leave community groups or invite

people to join the group. When associated with content, the Social Bar can be used to add and

remove content items and URLs in a user’s Favorites.

The Social Bar is also used to bookmark Web pages with Social Bookmarking services, such

as Digg.com or del.icio.us. By default, Digg.com and del.icio.us are loaded in the Items
property of the server control. See Also: "Items Property" on page 16-226

In addition to these features, users can use the Social Bar to print or email the Web page and

invite non-site users to become members of the site. Clicking the Invite item forwards a user to

a Web page where the Invite server control is located. See Also: "Invite Server Control" on

page 16-208.
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Note: Facebook is available in version 8.01.

Adding a Web Page’s URL to a User’s Favorites Via the
Social Bar
You can allow users to add a Web page’s URL to their Favorites when they click Add to

Favorites on the Social Bar. Typically, this would be done when more than one content item

appears on a Web page and you do not want to have more than one Social Bar on the page.

The first image below shows a web page with multiple content items and a Social Bars

associated with each item. In this example, when a user clicks Add to Favorites on a Social

Bar, the content item associated with it is added to his Favorites. In the second image, one

Social Bar appears on the Web page with multiple content items. In this example, when a user

clicks Add to Favorites on the Social Bar, the Web page’s URL is added to his Favorites.
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To allow users to add a URL to their Favorites from the SocialBar server control, follow these

steps.

1. Drag and drop a SocialBar server control on a Web form.
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2. Make sure the DefaultObjectID property is set to 0 (zero).

3. Leave the DynamicObjectParameter property blank.

4. If it is not already there, add the Addto item to the comma separated list of items in the

Items property.

5. Set the ObjectType property to Content.

Private Messaging from the Social Bar
You can send private messages to another user or the administrator of a Community Group

from the Social Bar by adding either PrivateMessageUser or PrivateMessageAdmin to the

Items property list. See "Items Property" on page 16-226 for additional information.

When a Social Bar appears on a user’s profile page, you can use the PrivateMessageUser item

to create a link that allows another user to message the user whose profile page is being

viewed.

When the Social Bar is used on a Community Group’s page, you can use the

PrivateMessageAdmin item to create a link that allows a user to message the administrator of

the group.

For the private message link to appear in the Social Bar, the page that contains the Messaging

server control must be defined in the MessagingUrl property. See Also: "Messaging

Server Control" on page 16-211

To allow users to send private messages from the SocialBar server control, follow these steps.

1. Drag and drop a SocialBar server control on a user’s profile or community group’s page.

2. Set the ObjectType property to either Group or User.

3. Add either PrivateMessageUser or PrivateMessageAdmin to Items property.

4. Add the URL where the Messaging server control appears to the MessagingUrl

5. Make sure the DynamicObjectParameter is set, if necessary.

Tweeting the URL a User is Currently Browsing
You can allow site visitors to use Twitter to tweet their current browsing location by adding

the Twitter item to the list of parameters in the SocialBar’s Items property. Once the item is

added, a Twitter icon and link appear in the Social Bar. When a user clicks the link, Twitter is

launched. Once the user logs into their Twitter account, his current browsing location is loaded

in the “What are you doing?” status box. The user can then click Twitter’s Update button to

post the status.

To allow users to tweet the URL they are currently browsing, follow these steps.

1. Drag and drop a SocialBar server control on a Web form.

2. Make sure the DefaultObjectID property is set to 0 (zero).
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3. Leave the DynamicObjectParameter property blank.

4. If it is not already there, add the Twitter item to the comma separated list of items in the

Items property.

5. Set the ObjectType property to Content, User or Group depending on the type of

page you are creating.

SocialBar Server Control Properties
The SocialBar server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer

and can use it to browse to Content, Collections, etc.

See Also: ”Using CMSExplorer to Browse Your Ektron

CMS400.NET Site” on page 21-12

String

CacheInterval

Sets the amount of time the server control’s data is

cached. The default is 0 (zero). This is the amount of

time, in seconds, a control’s data is cached. For

Double
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Property Description Data Type

example, if you want to cache the data for fiveminutes,

set this property to 300 (three hundred). See Also:

”Caching with Server Controls” on page 21-42

DefaultObjectID

The default object ID for this control to use when there

is nomatching dynamic parameter value passed. If you

set this property set to 0 (zero) and leave the

DynamicObjectParameter blank, the social bar can be

used to addWeb pages to your favorites.

Long

DisplayXslt

Determineshow the Social Bar itemsare displayed on

the page. Enter the path to a customXSLT file. The

path can be relative or absolute.

Warning! : If you specify an

external file, it is strongly recommended that you do

not store this file in your site'sWorkarea folder. If you

store this file in theWorkarea folder, the file will be lost

when you upgrade.

String

DynamicObjectParameter

Gets or sets the QueryString parameter to read a

object ID dynamically. To use the default object ID,

leave blank.

String

Hide

Used to hide output of the control in design time and run

time.

True =Hide control

False =Display control

Boolean

IncludeIcons

Select whether iconsare displayed next to each item.

True =Display iconsnext to each item.

False =Do not display iconsnext to each item.

Boolean

InviteURL

The URL to the Invite server control’sWeb page. There

are two variables used within the URL that represent

the Object ID and theObject Type.

{0} - represents the object’s ID.

{1} - represents the object type.

You need to have both variables in the link. TheWeb

form can be relative or absolute. Below is an example.

invitepage.aspx?id={0}&type={1}

String

Items

A comma separated list of items that you want to

appear on the Social Bar. See "ItemsProperty" on

page 16-226 for information.

String
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Property Description Data Type

Language

Set a language for viewing the server control. This

property shows results in design-time (in VisualStudio)

and at run-time (in a browser).

Integer

MarkupLanguage

Identify the templatemarkup file that controls the

display of the server control. For example,

mymarkup.ekml. If the *.ekml file is located in the same

folder as theWeb form containing the server control,

just enter its name. Otherwise, the path to the file can

be relative or absolute. See Also: ”EktronMarkup

Language” on page 21-35

String

MessagingUrl

TheWeb page where theMessaging server control is

contained. This property is used when you have either

the PrivateMessageUser or PrivateMessageAdmin

item in the Itemsproperty. See "ItemsProperty" on

page 16-226 for information on these items.

If a value appears in theek_

RedirectFromLoginKeyName key in the

web.config file, the user will be returned to the original

URL after sending themessage. Bydefault, this value is

RedirectUrl. If you remove this value and do not

add another, the person sending amessage seesa

note stating “Your message hasbeen sent.” For more

informationless ”Settings in the web.config File” on

page 1-95.

String

ObjectType

The type of object to which this control is assigned. Choicesare:

Content - this control is assigned to content.

User - this control is assigned to an individual.

Group - this control is assigned to a community group.

Data Type: Ektron.Cms.Common.EkEnumeration.CMSSocialBarTypes

Stylesheet

Specify the path to a style sheet for use with the server

control. The location can be relative or absolute. Leave

blank to use the default style sheet.

Warning! If you enter a valid EkML file at theMark-

upLanguage property, theStylesheet property

is ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the

control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean
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Property Description Data Type

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline

portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply

attributes to a blockof code.

Custom - Allows you to use a custom tag.

String

Items Property

The Items property controls which items appear in the Social Bar. Below is a list of items

that can appear in the Social Bar.

Item Description

Addto

When this server control is associated with a user the Addto item

appears as:

n Add aColleague - when the user is viewing another user’s

profile page and can add them asa colleague.

n Cancel Colleague Request - when the user is viewing

another user’s profile page who he asked to be a colleague but

the user has yet to accept.

n Remove FromColleagues - when the user is viewing a

current colleague’s profile page.

When the control is associated with a CommunityGroup, the

Addto item appear as:

n Join Group - when the user visits a community group that

he hasnot joined.

n LeaveGroup - when the user alreadybelongs to a com-

munity group.

n Cancel Request to Join - when the user has tried join a

group that is restricted and has yet to be accepted.

When the control is associated with Content, the Addto item

appears as:

n Add to Favorites - when the user viewscontent that is not

in their Favorites.

n Remove Favorites - when the user viewscontent that is in

their Favorites.
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Item Description

Invite

A link to the Web page that contains the Invite server

control. This control allows you to invite people to

register on the site and become a colleague.

Warning! : For the Invite item to be active, a link to the page con-

taining the Invite controlmust be entered in the InviteURL

property. See Also: "InviteURL" on page 16-224.

GroupInvite

Opens a dialog that allows you to invite colleagues or

people who are not registered on the site to join the

group.

Email

Email this Web page. Clicking this item launches a

user’s email with the subject and body loaded with the

information about the content, user or community

group.

Digg
Appears as Digg It. Launches Digg.com, a social

bookmarking service.

Delicious
Appears as Bookmark It. Launches del.icio.us, a social

bookmarking service.

Facebook
Appears as Facebook. Launches Facebook, a social

network servuce. (Available in version 8.01.)

Google
Appears as Google It. Launches Google’s social

bookmarking service.

Furl
Appears as Furl It. Launches Furl, a social

bookmarking service.

Technorati
Appears as Technorati. Launches Technorati, a social

bookmarking service.

Twitter

LaunchesTwitter, a social network service, which allowsusers to

communicate what theyare doing to other Twitter users.When

the Twitter link is clicked and a user logs in to a Twitter account,

the link for the page which contains the Social Bar control is

added to the Statusbox. See Also: "Tweeting the URL aUser is

CurrentlyBrowsing" on page 16-222

Yahoo
Appears asYahoo! It. LaunchesYahoo’s social bookmarking

service.

Print Print theWeb page. Clicking this item launchesa print dialog box.
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Item Description

PrivateMessageUser

Createsa link that allows you to send a PrivateMessage to a

user. See Also: "PrivateMessaging from the Social Bar" on page

16-222

PrivateMessageAdmin

Createsa link that allows you to send a PrivateMessage to a

CommunityGroup’s administrator. See Also: "PrivateMessaging

from the Social Bar" on page 16-222

Tags

Note: This section discussesTags for use with the CommunityPlatform. Information on tagging blog entries can

be found in ”Tagson the SummaryPage” on page 7-681.

Tags are keywords that can be assigned to users, groups, content, and library items.

On a Web site, tags for a user or group appear in a profile, helping site visitors to learn about a

user or group.

Tags also allows users to perform tag-based searching, as shown below.
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So, for example, you could tag all content related to a new product release with the name

“Widgets 2.0.” Anyone could enter that term into the Search box, click Tags from the

dropdown list (shown above), then the Search button to find all related content.

In the Workarea, tags are used in the following locations.

Location Image

User Information screen’sTags area,

for users or membership users

The CommunityGroup screen’sTags

tab

Tags
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Location Image

A content item’sMetadata tab >Tags

area

A library item’sMetadata tab >Tags

area

Settings > Community

Management > Tags

DEVELOPER’S NOTE

Note: TheCommunityGroupBrowser, CommunityGroupProfile, and CommunityGroupList Server Controls can

displaygroup tagsand link them to a list of all groups that share the tag. Also, the TagCloud server control displaysa

weighted list of tags. See Also: "TagCloud Server Control" on page 16-238

The rest of this section explains tags through the following topics.

n "Tag Types" on page 16-231

n "Creating Default Tags" on page 16-231

n "Creating User-Created Tags" on page 16-235
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n "Managing Tags" on page 16-236

n "Viewing a Tag’s Details" on page 16-237

n "Deleting Tags" on page 16-237

Tag Types
There are basic two types of tags, and they are contrasted below.

Type Description
For more

information, see

Default

n created by system administrator inSettings >

Community Management > Tags area

n appear as checkboxoptionswherever tags can

be applied

"Creating Default Tags"

on page 16-231

User-

created
n created byuser asneeded wherever tags can

be applied

"Creating User-Created

Tags" on page 16-235

Creating Default Tags
An Ektron CMS400.NET administrator can create default tags for each object (user, user group,

content or library item). For example, you want to allow users to associate themselves with a

favorite race car driver. You create a default user tag for each driver’s name.

When a user creates or edits an item for which you created the default tags, they appear and

the user clicks inside check boxes to assign them.
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Ektron CMS400.NET provides separate screens for creating default tags for user groups, users,

content and library items. They are available via Settings > Community Management > Tags

(shown below).

See Also:

n "Adding Default Group Tags" on page 16-233

n "Adding Default User Tags" on page 16-233

n "Adding Default Content Tags" on page 16-234

n "Adding Default Library Tags" on page 16-234
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Adding Default Group Tags
The Default Group Tags screen lets you add tags that may be assigned to community groups.

See Also: "Tags" on page 16-228

To add a Default Group Tag, follow these steps.

1. In the Workarea, navigate to Settings > Community Management > Tags > Default

Group Tags.

2. Select a language for the tag.

3. Add the tag in the empty text box. If no empty box appears, click the Add button ( )
then enter the tag.

4. Click the Save button ( ).

Adding Default User Tags
The Default User Tags screen allows you to add tags that may be assigned to a user.

See Also: "Tags" on page 16-228

To add a Default User Tag, follow these steps.
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1. In the Workarea, navigate to Settings > Community Management > Tags > Default User

Tags.

2. Select a language for the tag.

3. Add the tag in the available text box. If no text box is available, click the Add button (
) then enter the tag.

4. Click the Save button ( ).

Adding Default Content Tags
The Default Content Tags screen allows you to add tags that may be assigned to a content.

See Also: "Tags" on page 16-228

To add a Default Content Tag, follow these steps.

1. In the Workarea, navigate to Settings > Community Management > Tags > Default

Content Tags.

2. Select a language for the tag.

3. Add the tag in the available text box. If no text box is available, click the Add button (
) then enter the tag.

4. Click the Save button ( ).

Adding Default Library Tags
The Default Library Tags screen allows you to add tags that may be assigned to a library.
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See Also: "Tags" on page 16-228

To add a Default Library Tag, follow these steps.

1. In the Workarea, navigate to Settings > Community Management > Tags > Default

Library Tags.

2. Select a language for the tag.

3. Add the tag in the available text box. If no text box is available, click the Add button (
)

then enter the tag.

4. Click the Save button ( ).

Creating User-Created Tags
In addition to applying default tags, users, community group leaders, and content editors can

create their own tags. This allows for a more diverse and creative list of tags.

For example, a user is editing content. He reviews the default tags but decides that none is

correct. So, he creates and assigns a new tag: Rosebud. That tag is now applied to that content.

The user-created tag also appears on the Settings > Community Management > Tags screen,

where you can see its ID number.
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If someone creates another tag with the same exact name, the new tag will share the ID number

with the previous one, and the Times Used will increase from 1 to 2. However, the new tag

will not appear as a default on any screen.

Managing Tags
Administrators manage tags from the Settings > Community Management > Tags screen. This

screen displays all default and user-created tags. You can filter the list by language. Click any

tag’s name to see its details. See Also: "Viewing a Tag’s Details" on page 16-237 and "Tags"

on page 16-228

This screen displays the following information about each tag.
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Field Description

ID Its integer ID

Name Its title

TimesUsed The number of timesa tag hasbeen assigned

Language
Its language. This appears asa national flag. For example,

American English appears as .

Viewing a Tag’s Details
When you click a tag’s name, its details appear on the View Tag screen.

Field Description

ID The integer ID of the tag.

Language The language assigned to the tag.

Name The title of the tag.

Tagged Type

Showshow the tag is assigned: to a community group, user,

content, or library item. See Also: "Adding Default Group Tags" on

page 16-233 and "Adding Default User Tags" on page 16-233

TimesUsed The number of times this tag is assigned to each Tagged Type.

Deleting Tags
As mentioned above, there are two basic tag types: user-created and default. (See Also: "Tag

Types" on page 16-231). The following table contrasts how to delete tags.
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Tag

Type
Result Procedure

User-

created

Delete a single tag

1. Open the item’sTags area. For example,

for content, edit theMetadata tab.

2. Uncheck the checkboxnext to the tag.

3. Publish the content.

Delete all occurrencesof a tag

1. Go to theSettings > Community Man-

agement > Tags screen.

2. Click the tag.

3. Click the delete button ( ).

4. A confirmation screen appears.

5. ClickOK.

Default

There are twomethods for deleting default tags. Each hasdifferent results.

Deleting a Default Tag

n No longer available for

assignment to users, content, etc.

n Existing links to it remain

1. Go toSettings > Community Man-

agement > Tags

2. Select the screen for the kind of tag you

want to delete (group, user, content or

library).

3. Select the language.

4. Click the red ( ) to the right of the tag
you want to delete (see below).

5. You are asked if you are sure. ClickOK.

6. Click the save button ( )

Deleting a Default Tag and

All of its Links

n No longer available for

assignment to users, content, etc.

n Existing links to it are deleted

1. Go to theSettings > Community Man-

agement > Tags screen.

2. Click the tag.

3. Click the delete button ( ).

4. A confirmation screen appears.

5. ClickOK.

TagCloud Server Control
The TagCloud server control depicts a weighted list of tags assigned to users, community

groups, content, or library items. Each tag’s size is proportional to the number of times it is

assigned.

For example, there are two tags, Mom and Dad. If the Mom tag is used five times and the Dad

tag is used twice, the Mom tag is approximately twice as large.
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See Also: "Tags" on page 16-228

Determining the Contents of the Tag Cloud
Use the TagType property to determine which types of tags appear in the cloud. For

example, set TagType to User to display user tags.

Setting a Maximum Number of Tags

You can set a maximum number of tags to display via the MaxTagsDisplayed property.

This property makes sense if the Orderby property is set to Taggedcount. In this case,
the cloud only displays items with the highest number of tags.

Sorting the Tags

Use the OrderBy property to sort tags within a cloud. Your choices are alphabetical
or by Taggedcount (the number of times an item is tagged). Then, use the

OrderByDirection property to determine if items are sorted in ascending or descending

order.

Linking Tag Cloud Items
Within a tag cloud, you can link tags to their source items. If you do, site visitors can click a

tag to launch a search of all users, community groups, content, or library items to which the

tag is assigned. For example, if someone views a user-based tag cloud and clicks Motorcycles,

the community search page appears, showing all users tagged with Motorcycles.
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To make a tag cloud’s items searchable, add a path to the Web form containing the Search

server control in the TagTemplate property.

TagCloud Server Control Properties
The TagCloud server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMS

Explorer and can use it to browse to Content,

Collections, etc. See Also: ”Using CMS

Explorer to Browse Your Ektron

CMS400.NET Site” on page 21-12

String

CacheInterval

Sets the amount of time the server control’s

data is cached. The default is 0 (zero). This is

the amount of time, in seconds, a control’s

data is cached. For example, if you want to

cache the data for fiveminutes, set this

Double
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Property Description Data Type

property to 300 (three hundred). See Also:

”Caching with Server Controls” on page 21-

42

DisplayXslt

Determineshow information is displayed on

the page. Enter the path to the XSL file. It can

be relative or absolute.

Warning! : If you specify an external file, it is

strongly recommended that you do not store

this file in your site'sWorkarea folder. If you

store this file in theWorkarea folder, the file

will be lost when you upgrade.

String

DynamicParameter

Bydefault, theTagTemplate property

passesaTagId parameter, whose value is

the tag that a site visitor clicked in the tag

cloud. Use this property to manually override

that parameter and set the TagID value by

hand.

String

Hide

Used to hide output of the control in design

time and run time.

True =Hide control

False =Display control

Boolean

Language

Set a language for viewing the server control.

This property shows results in design-time (in

VisualStudio) and at run-time (in a browser).

Integer

MarkupLanguage

Identify the templatemarkup file that controls

the display of the server control. For example,

mymarkup.ekml.

If the *.ekml file is located in the same folder as

theWeb form containing the server control,

just enter its name. Otherwise, the path to the

file can be relative or absolute. See Also:

”EktronMarkup Language” on page 21-35

String
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Property Description Data Type

MaxTagsDisplayed

Themaximum number of tags to display. Set

to 0 (zero) for unlimited.

If you set amaximum, andmore than that

number of tagsare applied, then only themost

frequently-used tagsappear. For example, if

you enter ten, the ten tagsapplied themost

number of timesappear.

Integer

OrderBy

The criteria bywhich the tagsare ordered

within the tag cloud. Choicesare:

n TaggedCount - sort by how many

times a tag is assigned

n Text - sort alphabetically by tag

name

String

OrderByDirection
Select the direction of theOrderBy property.

Choose Ascending or Descending.
String

Stylesheet

Specify the path to a style sheet for use with

this server control. The location can be relative

or absolute. Leave blank to use the default

style sheet.

Warning! If you enter a valid EkML file at the

MarkupLanguage property, theStyle-

sheet property is ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tags

around the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean
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Property Description Data Type

TagTemplate

If you want a tag cloud’s items to link to a page

that showsall itemswith that tag, add a path to

aWeb form page that hosts the appropriate

search control. The path can be relative or

absolute.

See Also: "Linking Tag Cloud Items" on page

16-239

n If theTagType isUser or Com-

munity Group, enter a page hosting a

CommunitySearch server control.

n If theTagType isContent or

Library, enter a page hosting aWeb

Search server control.

For example, in the Ektron CMS400.NET

Intranet starter site’stagcloud.aspx

page, the first two TagCloud controls link to

users and community groups. So, this

property is set to

CommunitySearch.aspx, aWeb form

that hosts the CommunitySearch server

control.

When a site visitor clicks a tag cloud item, the

CommunitySearch page displays, populated

with search results for the clicked tag. The

visitor can click any result to seemore about it.

String
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Property Description Data Type

TagTemplate

(continued)

The following five parameters are added to

the link’sQueryString, and pass tag

information to the destinationWeb form. Its

search server control uses the parameters to

populate the search.

n searchtag or searchgrptag - search-

tag represents the tag’s text for users;

searchgrptag represent the tag’s text for com-

munity groups

n TagId - the clicked tag’s ID

n TagLanguage - the clicked tag’s lan-

guage; only search results in this language

appear

n TagCount - the number of times the tag

hasbeen assigned

n TagType - the tag’s type: user, com-

munity group, content or library item. This

value is obtained from theTagType property

(described below).

In addition to these parameters, you can add

your own bydefining them in the path. If you

do, the above five parameters are appended

to yours.

TagTemplateTarget

Determines the type of window that appears

on thisWeb formwhen a user clicks an item in

the dynamic content box. The default is _self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

ItemLinkTargets

TagType

Select the type of tags that appear in the tag

cloud. Choicesare:

n User

n CommunityGroup

n Content

n Library

String
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Property Description Data Type

WrapTag

Allowsa developer to specify a server control’s

tag. The default isSpan.

Span - The <span> tag is used to designate

an inline portion of an HTML document asa

span element.

Div - The <div> tag is used when you want to

apply attributes to a blockof code.

Custom - Allows you to use a custom tag

String

CommunitySearch Server Control
The CommunitySearch server control allows a site user to find users or community groups

registered on the Web site. Once the results are returned, a user can add a colleague or join a

community group.

When a user hovers over the display name or community group name link, profile information

appears. How much information appears depends on the status of the user performing the

search and the profile settings of the user or group returned in the results.

The CommunitySearch control provides three types of searches:

n Directory - filter users by a letter in the alphabet. A user can select whether to sort by first

or last name. See "Using the Directory Tab to Filter for Users" on page 16-246.

n Basic Search - allows users to search for users and groups on the site. See "Performing a

Basic Community Search" on page 16-246.

n Advanced Search - allows users to search based on individual or multiple criteria. See

"Advanced Community Searching" on page 16-247.

n Location Search - Allows a user to search based the given location of a user or

community group. See "User Location Searches" on page 16-248.

The following additional topics are covered in this section.

n "Using Community Search Results" on page 16-249

n "Restricting the CommunitySearch to Return Membership Users" on page 16-252

n "Filtering Search Results by Category" on page 16-252

n "Showing a User’s Custom Properties" on page 16-255

n "CommunitySearch Server Control Properties" on page 16-256
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Using the Directory Tab to Filter for Users
The Directory tab in the Community Search allows a user to filter the list of users based on the

selection of a letter in the alphabet. For example, John wants to find all users whose first name

begin with the letter S. John navigates to the CommunitySearch control on his site, clicks the

Directory tab and selects First Name from the Sort By list. Then, he selects the letter S from list

of letters. Next, the control displays a list of users whose first name begins with S.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Performing a Basic Community Search
A Basic search is the easiest to perform and returns the widest array of results.

A Basic search uses the following criteria:

n Email

n Display Name

n First Name

n Last Name

n Custom User Properties

n Personal Tags

n Group Name
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n Group Description

n Group Tags

To use a basic search, a user enters a name, email, group name, tag, or a word he believes

might appear in a group’s description into the text box. Then, he clicks the Search button.

Any matches are returned in the results. See Also: "Using Community Search Results" on page

16-249.

Users can also perform wildcard searches, but the wildcard must appear after the first letter in

the search. For example, you can search for J*, but not *J. The example, J*, returns all users

and community groups that start with J or have a word that starts with J in their email, tags, or

description.

Advanced Community Searching
The Advanced tab on the CommunitySearch server control allows a user apply multiple criteria

on community groups and users.

While the criteria are mostly same as a basic search, the advanced search also lets users search

on taxonomy category when a taxonomy ID is defined either in the GroupTaxonomyID

property, UserTaxonomyID property or both properties.

IMPORTANT!

Warning! If both the GroupTaxonomyIDand UserTaxonomyIDproperties are set to 0 (zero) or if there are no

users or groupsassigned to the selected taxonomy, the category option doesnot appear on theGroup or User

drop down list.

See Also: "Performing a Basic Community Search" on page 16-246
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Multiple search criteria have an “and” relationship, so results must match each filter. For

example, if you select the Tags filter and the Display Name filter, users or groups must match

both criteria to appear in the results. If a user or community group matches only one criterion,

it does not appear in the results.

To search using the Advanced tab, follow these steps.

1. Navigate to a Web page that hosts the CommunitySearch control.

2. Click the Advanced Search tab.

3. Select the criteria by which to filter the search results.

4. Click Add Filter to add additional filter.

5. Enter text in one of the text boxes.

TIP!

Note: If a user enters text in both the UsersandGroups text boxes, the search returnsanymatching usersor

groups.

6. Click the Search button.

User Location Searches
The Location tab lets a user search for another user based on location. User results are

displayed as pins on a map.

For users to be found in the search, they must fill out the Address field in their profile.

CMS400.NET retrieves the longitude and latitude for the address to populate the user location

search.
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IMPORTANT!

Warning! This tab imports theMap server control. To learn about theMap server control and how to enable loca-

tion searches for your site, it is strongly recommended that you review theMap server control chapter. See ”Map

Server Control” on page 9-318.

If you have not enabled location searches for you site, you can prevent the Location tab from

being shown by setting the EnableMap property to false. This also prevents the Map icon

from being displayed next to a user’s name in the search results when the user has entered an

address in the Address field of his profile.

Using Community Search Results
Once a search is complete, a list of users and groups who match the search term appears. This

list shows an avatar, display name and status for each user or group. In addition, if a user has

entered a valid address in his profile, a map icon ( ) appears below the user’s name.
Clicking this icon launches the location tab with a map showing the user’s location.
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The Status column indicates whether the user is already a colleague, or if you can add them as

a colleague via a colleague request. It also allows you to join a Community Group if you are

not already a member.

Click the Add as Colleague link to send the colleague request or the Join this Group link to

join the community group. Status information for each user or group is only displayed when

you are logged into the site.

When is aUser’s Profile Accessible in SearchResults

When a user is logged in and hovers the mouse over the display name link, a floating profile

window pops-up. Several factors determine whether a user’s profile is displayed in the pop-up.

The table below shows an example of when a user’s profile is accessible in the search results.

This example uses John and Jane. John is a user with a profile and Jane is a user performing a

search.

John’s

Profile is

...

Jane is

a ...

and Her Login

Status is ...

The

ResultsProfile

Property is ...

Therefore

John’s Profile

is ...

Public User LoggedOut Full Accessible

Public User LoggedOut NonPrivate Accessible
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John’s

Profile is

...

Jane is

a ...

and Her Login

Status is ...

The

ResultsProfile

Property is ...

Therefore

John’s Profile

is ...

Public User LoggedOut
NonPrivate-

Authenticated
Not accessible

Public User LoggedOut None Not accessible

Public User Logged In Full Accessible

Public User Logged In NonPrivate Accessible

Public User Logged In
NonPrivate-

Authenticated
Accessible

Public User Logged In None Not accessible

Public Colleague LoggedOut Full Accessible

Public Colleague LoggedOut NonPrivate Accessible

Public Colleague LoggedOut
NonPrivate-

Authenticated
Not accessible

Public Colleague LoggedOut None Not accessible

Public Colleague Logged In Full Accessible

Public Colleague Logged In NonPrivate Accessible

Public Colleague Logged In
NonPrivate-

Authenticated
Accessible

Public Colleague Logged In None Not accessible

Private Colleague LoggedOut Full Accessible

Private User LoggedOut NonPrivate Not accessible

Private User LoggedOut
NonPrivate-

Authenticated
Not accessible

Private User LoggedOut None Not accessible

Private User Logged In Full Accessible

Private User Logged In NonPrivate Not accessible
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John’s

Profile is

...

Jane is

a ...

and Her Login

Status is ...

The

ResultsProfile

Property is ...

Therefore

John’s Profile

is ...

Private User Logged In
NonPrivate-

Authenticated
Not accessible

Private User Logged In None Not accessible

Private Colleague LoggedOut Full Accessible

Private Colleague LoggedOut NonPrivate Not accessible

Private Colleague LoggedOut
NonPrivate-

Authenticated
Not accessible

Private Colleague LoggedOut None Not accessible

Private Colleague Logged In Full Accessible

Private Colleague Logged In NonPrivate Accessible

Private Colleague Logged In
NonPrivate-

Authenticated
Accessible

Private Colleague Logged In None Not accessible

Restricting the CommunitySearch to Return Membership
Users
When searching for users, the CommunitySearch server control can return all users or only

return Membership Users. As a developer, you can restrict users to searching for Membership

Users by setting the MembersOnly property to True.

You might want to restrict user searches to Membership Users when creating a public facing

site. This prevents site visitors from finding CMS400.NET users. Alternatively, when you

create an internal site, such as a company intranet, you might want to allow searching for all

users.

Filtering Search Results by Category
The Filter by Category feature helps a site visitor zero in on relevant users and groups. As

explained in ”Taxonomy” on page 9-253, the Taxonomy Feature lets users assign information

categories to user and groups. For example, you might categorize employees by department:

n accounting
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n human resources

n purchasing

n manufacturing

As new users and groups are created, you should apply relevant taxonomy categories to them.

This makes it easier to find them on your site, because a site visitor can search by category

along with search text. For example, you might quickly find all employees in manufacturing

whose first name is Tom.

TIP!

Note: This additional search criterion relieson the assignment of taxonomycategories to usersand groups. If

theyare not categorized, the filter hides relevant but non-categorized users/groups. For example, someone enters

a new user (Tom inManufacturing) but doesn't assign a department to him. If a site visitor on the search page

entersTom and selects themanufacturing category, he will not find that user even though he exists in Ektron

CMS400.NET.

Effect of Setting EnableFilteringResults to True

If you set the EnableFilteringResults property to true, initially the site visitor

sees no difference. However, if he enters a search term that returns one ore more users or groups

to whom a taxonomy category is assigned and clicks the Search button, he sees Filter by

Category above the results (illustrated below).

Note: If no categoriesare assigned to the users in the search results, the Filter by Category link doesnot

appear.
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If he clicks Filter by Category, the visitor sees all taxonomies with at least one user or group

that contains the search text. He can then select categories from the taxonomy structure. If he

does, the results refresh, and only user and groups that contain the search text and are assigned

to the selected categories appear. If a visitor selects several categories, content that is assigned

to any selected category appears.

Note: If the visitor selects a parent category, all of its child categoriesare selected bydefault.

In the example above, the site has four users or groups with the letter S.

If the user selects Filter by Category then drills down to Management, only one user is found.
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If a site visitor performs any of the following actions, all taxonomy category selections are

cleared, and a new search is performed.

n clicks the Search button

n presses <Enter>

n performs an Advanced Search

On the other hand, if a site visitor closes folders in the taxonomy structure, all selected

categories remain selected.

Showing a User’s Custom Properties
In search results, you can have a user’s custom properties appear in the information pop-up box

when his link is hovered over. To have custom properties appear, add a comma delimited list

of custom property IDs to the CustomPropertyID property.

Custom properties are created by the site administrator and applied by a user. See Also:

”Custom User Properties” on page 15-16
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CommunitySearch Server Control Properties
The CommunitySearch server control properties are described in this table.

Property Description Data Type

Authenticated

Indicates if you are logged in to

the CMSExplorer and can use it to browse to Content,

Collections, etc. See Also: ”Using CMSExplorer to Browse

Your Ektron CMS400.NET Site” on page 21-12

String

CacheInterval

Sets the amount of time the server control’s data is cached.

The default is 0 (zero). This is the amount of time, in

seconds, a control’s data is cached. For example, if you

want to cache the data for fiveminutes, set this property to

300 (three hundred). See Also: ”Caching with Server

Controls” on page 21-42

Double
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Property Description Data Type

CustomPropertyID

Specify a comma delimited list of custom property IDs.

These custom properties appear in the pop-up information

box for a user when search results are returned. See Also:

"Showing a User’sCustomProperties" on page 16-255

Integer

DisplayXslt

Determineshow information is displayed on the page. Enter

the path to the XSL file. It can be relative or absolute. The

default file isCommunitySearchDirectory.xsl.

Warning! : If you want to edit this file, it is strongly rec-

ommended that youmake a copy, change its name and

move it outside of your site'sWorkarea folder. If youmake

changes to this file and do not move it out of theWorkarea,

this file and the changeswill be lost when you upgrade.

String

EnableFilteringResults

Set to true to display a Filter by Category option when

this server control appears. This option helpsa site visitor

zero in on relevant content by selecting taxonomy

categories.

Set to false to suppress the Filter by Category option.

See Also: "Filtering Search Results byCategory" on page

16-252

Boolean

EnableGroup

Results

Set to true to include community groups in the search

results. Set to false to prevent community groups from

appearing in search results.

Boolean

EnableMap

Set to false to hide themap functionality in this control. This

hides the Location tab when the control is displayed on a

Web site and themap properties in VisualStudio.See
Also: "" on page 16-259

Boolean

EnableMouseOver

When set to False, the profile pop-up is disabled when

hovering over a display name in the search results.

True =Enable the profile pop-up when hovering over a

display name.

False =Disable the profile pop-up when hovering over a

display name.

Boolean
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Property Description Data Type

EnableMouseOutHidesInfo

When this property is set to True and user moves their

mouse away from a search result’s information pop-up box,

the boxdisappears.When this property is set to False, a

user needs to click the close button in the upper right corner

of the information pop-up box to hide it.

Boolean

EnableUnauthorizedSearching

When set to True, a user doesnot need to be logged in to

perform a user search.When set to False, a user must

logged in to perform a user search, otherwise the control

displaysamessage stating that log-in is required.

True =a user doesnot need to be logged in to perform a

user search.

False =a user must be logged in to perform a user search.

Boolean

EnableUserResults
Set to true to include users in the search results. Set to false

to prevent users from being returned in the search results.
Boolean

FriendsOnly
Set to True to limit the results to a user’s colleagues.When

set to False, returnsallmatches
Boolean

GroupTaxonomyID

Enter the ID of the taxonomyyou want to associate with this

control. This allowsusers to search for community groups

based on the taxonomywith which theyarea associated. If

set to 0 (zero), the Category option doesnot appear in the

Group drop down list on the Advanced tab.

Long

Hide

Used to hide output of the control in design time and run

time.

True =Hide control

False =Display control

Boolean

InfoBoxShowsEmail

Setting this property to True causesa user’s email to appear

when his name is hovered over in the search results.

Boolean

Language

Set a language for viewing the server control. This property

shows results in design-time (in VisualStudio) and at run-

time (in a browser).

Integer
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Property Description Data Type

LoadingImage

The image to displaywhile the User Search is loading. The

default is<site

root>\Workarea\images\application\ajax-

loader_circle_lg.gif.

String

MapControl

This property allows you to set properties for the Location

Tab’smap. These properties are identical to the properties

in theMap server control. For information on theMap

control’s properties, see ”Map Server Control” on page 9-

318. TheEnableMap propertymust be set to true to see

theMap control properties. See Also: "" on page 16-257

Note: OnlyEktron’sMap server control properties are

described in this section. It doesnot describe native .NET

properties such as font, height, width and border style. For

documentation of these properties, see VisualStudio help.

Datatype: Ektron.Cms.Controls.Map

MarkupLanguage

Identify the templatemarkup file that controls the display of

the server control. For example, mymarkup.ekml. If the

*.ekml file is located in the same folder as theWeb form

containing the server control, just enter its name. Otherwise,

the path to the file can be relative or absolute. See Also:

”EktronMarkup Language” on page 21-35

String

MaxTagCount
Themaximum number of personal tags to display for each

user in the search results.
Integer

MembersOnly

When set to True, this server control only returns

Membership Users.When set to False, the control returns

CMS400.NET Users andMembership Users.

Boolean

PageSize Themaximum number of user results to show per page. Integer

ResultsProfile

Determineswhether profile information is displayed. This is

based on the state of the user performing the user search.

See "When is a User’sProfile Accessible in Search Results"

on page 16-250.

Choicesare:

full - always show user profile information.

nonprivate - display user profile information onlywhen a

user’s profile is not marked private.

nonprivate-authenticated - display user profile

information onlywhen a user’s profile is not marked private

and the user performing the search is logged in.

none - never show user profile information.

String
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Property Description Data Type

SearchPrivate

When set to False, this property prevents userswith profiles

marked asprivate from being returned with user search

results.

Boolean

ShowNameEmail

When set to True, populates the drop down list with these

additional options:

First Name - perform searchesbased on a user’s first

name.

Last Name - perform searchesbased on a user’s last

name.

Email - perform searchesbased on a user’s email address.

When set to False, the drop down list is populated with these

properties:

Tags - perform searchesbased on a user’s tags.

Display Name - perform searchesbased on a user’s

display name.

Boolean

StartingTab

Select which tab appearswhen the control is first rendered

on aWeb page. Choicesare:

n basic

n advanced

n location

String

Stylesheet

Specify the path to a style sheet for use with this server

control. The location can be relative or absolute. Leave

blank to use the default style sheet.

Warning! If you enter a valid EkML file at theMark-

upLanguage property, theStylesheet property is

ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the

control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TemplateGroupProfile
The URL path of the community group template. This path

can be relative or absolute.
String

TemplateParamName

Sets a QueryString parameter for the ID of users or groups

that are returned in the search results. This parameter is

passed to the template page defined in the

TemplateUserProfile or

TemplateGroupProfile propertywhen a user clicks

the Location (map) icon associated with a search result.

String
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Property Description Data Type

TemplateTarget

Defines the waya the template appearswhen the Location

link is clicked.

Choicesare:

_blank - This target causes the link to alwaysbe loaded in a

new blankwindow. Thiswindow is not named.

_self - This target causes the link to always load in the same

window the anchor was clicked in. This is useful for

overriding a globally assigned BASE target.

_parent - This target makes the link load in the immediate

frameset parent of the document. This defaults to acting like

“_self” if the document hasno parent.

_top - This target makes the link load in the full bodyof the

window. This defaults to acting like “_self” if the document is

alreadyat the top. It is useful for breaking out of an arbitrarily

deep frame nesting.

ItemLinkTargets

TemplateUserProfile
The URL path of the user profile template. This path can be

relative or absolute.
String

UserTaxonomyID

Enter the ID number of the taxonomyassociated with users

to appear in this server control. This allowsa user to search

for another user based on the taxonomywith which they

area associated. If set to 0 (zero), the Category option does

not appear in the User drop down list on the Advanced tab.

Long

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline portion

of an HTML document asa span element.

Div - The <div> tag is used when you want to apply

attributes to a blockof code.

Custom - Allows you to use a custom tag.

String

Distributing Content to Another
Ektron CMS400.NET Folder
Ektron CMS400.NET supports the distribution of Community Documents to any CMS folder.

(A community document is either HTML content or an asset created via the Community

Documents server control.)
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For example, your Marketing Department uses the Community Documents server control to

create and edit content. After completing a press release, they use the Distribute menu option

to copy it from the private collaboration folder to a public content folder. Once there, the

document can pass through an approval chain or be published immediately.

The Distribute option can insert new content or overwrite existing content in any folder.

The Distribute Option is more fully explained through these topics.

n "Enabling the Distribute Option" on page 16-262

n "Distributing a Community Document" on page 16-263

Enabling the Distribute Option
Only a member of the Ektron CMS400.NET Administrators group can enable the Distribute

option. Do this for every Community Group that will use it. You can do so from the Workarea

or after logging in to the Web site.

From the Workarea
1. From the Ektron CMS400.NET Workarea, go to Settings > Community Management >

Community Groups > Groups.

2. Click the group for which you want to enable the Distribute option.

3. Click the Edit button ( ) .

4. Check the Enable Distribute check box.

5. Click the Save button ( ).

From the Web Site
1. Log into a site that uses the Community Management features as a CMS administrator or a

Group Administrator.
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2. Navigate to a Web page that hosts a Group Profile page.

3. Click the Edit Group link (circled below).

4. Check the Enable Distribute check box.

5. Click the Save button ( ).

Distributing a Community Document
There are two procedures for distributing a community document the first time. When doing

so, ask yourself the following question.

What are you doing?
Read this

procedures

Replacing an existing file in an Ektron

CMS400.NET folder. The file typesmust match.

"Distributing

a New

Community

Document

that

Overwrites

an Existing

One" on

page 16-267

Placing a file in an Ektron CMS400.NET folder for

the first time

"Distributing

a New

Community

Document"

on page 16-

264

Warning! After a community document is distributed the first time, the original document is forever linked to the

destination document. You cannot break the link.
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If you want to later revise the document, you would typically edit it in the collaboration folder

and select the Distribute option again. When you do, you are asked to confirm replacing the

document in the destination folder. You are not allowed to select another folder.

If you really must distribute it to another folder, delete the document in the destination folder.

This action breaks the link between documents. Once the link is broken, you can distribute the

document to another folder.

"Distributing Content After the First Time" on page 16-269 explains how subsequent edits are

handled.

Prerequisites

n You log in as one of the following

- Administrator of the group whose documents are being distributed

- Ektron CMS400.NET user assigned Community Group Administrator role for that

group

- CMS administrator

n The content’s status is Approved.

n You have permission to add, delete, and restore content to the destination folder. (If you

do not, the folder doesn’t appear on the folder selection screen.) See Also: "Folder

Permissions" on page 5-43

Distributing a New Community Document
When distributing a Community Document that does not exist in Ektron CMS400.NET for the

first time, you identify a destination folder and, if required, metadata and taxonomy categories.

This information is collected through a series of screens that guide you through the process.

Note: If you are using Ektron CMS400.NET withMicrosoft Sharepoint Integration, after selecting the folder (in

Step 8), the document is copied to that folder even if you later click the screen’s Close button. See Also: "Ektron’s

Microsoft Office SharePoint Server Connector" on page 19-41.

1. Log in to the Web site that contains content you want to distribute.

2. Navigate to the Web page that contains content you want to distribute.

3. Click the triangle to the right of the content or asset you want to distribute.

4. Click Distribute from the dropdown menu.
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5. The following screen appears.

6. Click in the top box, which begins I want to distribute a copy of this item.

7. The following screen appears
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8. Select the folder to which you want to distribute the content.

9. Click Next.

10. The following screen appears if metadata or a taxonomy category is required for the folder.

11. Enter any required metadata or taxonomy. See Also: "Working with Metadata" on page 7-

146 andSee "Taxonomy" on page 9-200 .

12. A confirmation screen appears. Click Done.
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13. Ektron CMS400.NET copies the selected document to the selected folder.

Distributing a New Community Document that Overwrites an
Existing One

Note: This processonly occurs the first time you overwrite a document. For a description of subsequent updates,

see See "Distributing Content After the First Time" on page 16-269"Distributing Content After the First Time" on

page 16-269.

During this procedure, you identify a destination folder and content to be replaced. Since the

content’s type that you are distributing must match the content being replaced, you only see

content whose types match.

Upon replacing, any metadata and taxonomy categories applied to the existing content are

applied to the new. Also, the content title and ID number from the existing content are

maintained -- they are not replaced by the title and ID number of the new content. Finally, the

existing content’s summary is maintained and can be edited if needed.

This information is collected through a series of screens that guide you through the process.

1. Log in to the Web site that contains the content you want to distribute.

2. Navigate to the page that contains that content.

3. Click the triangle to the right of the document you want to distribute.

4. Distribute appears on the dropdown menu.
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5. Click Distribute.

6. The following screen appears.

Note: The following screen only appears the first time you overwrite a file. To overwrite the file subsequently, see

"Distributing Content After the First Time" on page 16-269.

7. Click the lower box, which begins I want to replace an existing item.

8. The following screen appears.
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9. Navigate to and select the content you want to replace. Only content whose type matches

the document you selected in Step 3 appears.

10. Press Next.

11. A confirmation screen appears. Click Done.

12. Ektron CMS400.NET overwrites the selected document with the one you selected in Step

3.

Distributing Content After the First Time
If you later try to Distribute the same document (whether you added a new document or

overwrote an existing one), a screen like the following appears.
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You can copy the latest version of the document to the distribution folder by clicking in the

gray box whose text begins I want to redistribute... However, you cannot distribute the

document to another folder. (If you want to do so, first delete the document from the

destination folder. Then, you can use either procedure to distribute the document to any folder.)

When distributing content after the first time, its metadata and taxonomy categories appear on

the Metadata/Category screen by default. You can change them if desired.

As with the replace option, existing content’s title and ID number are maintained -- they are

not replaced by the new content’s title and ID number. And, the existing content’s summary is

maintained and can be edited if needed.
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Note: The eCommerce feature requires special license fromEktron, Inc. If you do not see this feature under

Ektron CMS400.NET’sSettings area, it maybe because your license doesnot support eCommerce. For

licensing information, contact sales@ektron.com.

eCommerce documentation consists of the following top level topics.

n Introduction

n "Sample eCommerce Site" on page 17-2

n "Access to eCommerce" on page 17-27

n "Steps to Set Up a Basic eCommerce Web Site" on page 17-29

n "eCommerce Configuration Screens" on page 17-47

n "eCommerce Shipping Screens" on page 17-85

n "eCommerce Tax Screens" on page 17-95

n "eCommerce Products" on page 17-106

n "eCommerce Order Management" on page 17-197

- "Messages" on page 17-81

n "eCommerce Coupons" on page 17-225

n "Using eSync with eCommerce" on page 17-234

n "The eCommerce Audit Screen" on page 17-235

(continued in Introduction)

Sample eCommerce Site
To see a sample eCommerce site, download the Developer Sample Site. Within that site, you

can try out a customer shopping experience by going to http://site

root/cms400developer/developer/default.aspx then Commerce > Cart. The following

shopping cart screen appears.
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You can add items to the cart then proceed through a sample checkout process.

The following eCommerce server controls are used to facilitate this process.

n "Cart Server Control" on page 17-3

n "Checkout Server Control" on page 17-16

Cart Server Control
The Cart server control allows a site visitor to work with products they have selected to

purchase. Think of this as a shopping basket. As a site visitor navigates around your site

selecting products to purchase, they are added to a cart.

A site visitor typically reaches the Cart server control from a product description or list page.

A product description page is one that contains a Product server control. Product list pages

contain server controls that create a list of products; for example, the ProductList,

ProductSearch or RecommendationAdding an Item to a Cart controls. Inside these controls,

there is a button or link that allows a site visitor to add the product to the cart.

Cart Server Control

ReferenceManual

Version 8.0 Rev 1.3
17-3



You could also create a link from a master page or menu that allows site visitors to view their

cart. This allows a site visitor to navigate directly to their cart when they arrive at your site.

Cart Server Control Areas
The Cart server control is made up of two major areas. The top part of the control represents the

current cart a site visitor is working with. This area is known as Your Cart. The bottom

represents a site visitor’s saved carts. This area is known as Your Saved Carts. The saved cart

information appears only when a site visitor is logged in. See Also: "Creating a New Cart" on

page 17-7.
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The Your Cart area displays the Item, SKU, Quantity, Manufacturer’s Suggested Retail Price,

Sale Price, Subtotal and Total. From this cart, a site visitor can update the quantity and

subtotal information, apply coupons and check out. The site visitor can also choose to

continue shopping or empty the cart.

The Your Saved Cart area contains a list of carts the site visitor has saved and are awaiting

checkout. This allows the site visitor to select products and save them for future purchase. This

area contains:

n the name of each cart

n the last time it was updated

n how many products in each cart

n the subtotal of each cart

n an option to delete a saved cart

n an option to create a new cart

Clicking a saved cart makes it the current cart and its products are displayed in the Your Cart

area. A site visitor can then proceed with checking out.

The following topics are discussed in this section:

n "Flow of the Cart Server Control" on page 17-6

n "Working with a Cart" on page 17-6

n "Cart Server Control Properties" on page 17-13
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Flow of the Cart Server Control
A site visitor typically arrives at this control by clicking the Add to Cart button in the

Product, ProductList, ProductSearch or Recommendation server controls.

Below is an image depicting the flow of the Cart server control.

Working with a Cart
This section explains how a logged in site visitor would use the Cart server control. It contains

these subsections.

n "Adding an Item to a Cart" on page 17-7

n "Creating a New Cart" on page 17-7

n "Displaying an Item’s information" on page 17-8

n "Assigning or Changing the Name of the Cart" on page 17-9

n "Changing an Item’s Quantity" on page 17-10

n "Removing an Item from the Cart" on page 17-10
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n "Continuing to Shop" on page 17-10

n "Applying Coupons" on page 17-11

n "Emptying the Current Cart" on page 17-12

n "Checking Out" on page 17-12

n "Deleting a Saved Cart" on page 17-12

Adding an Item to a Cart
Items are added to a cart when a site visitor clicks the Add to Cart link or button in the

following server controls.

n Product

n ProductList

n ProductSearch

n Recommendation

Once Add to Cart is clicked, the item is appended to the current cart’s list of items. If the site

visitor does not have an existing cart, a new one is created.

Creating a New Cart
A site visitor automatically creates a new cart the first time he adds a product to the cart. If

needed, a site visitor can create multiple carts while using the Cart server control. This allows

for the grouping of products being purchased. For example:

n site visitors might wish to create carts based on concepts, such as, Son’s Birthday or Item

Type.

n site visitors want to use separate payment types. For example, a site visitor might want to

place some products on one credit card and place the rest on another. By having two carts,

the site visitor can proceed with two separate checkouts allowing them to use multiple

credit cards.

n site visitor needs to prioritize purchases. For example, a site visitor knows they want to

purchase certain products, but cannot afford them until a later date. He can add these

products to a separate cart then continue to purchase products he can afford now. This

helps the site visitor remember purchases they want to make and drives additional sales for

your site.

To create a new cart, click the Create New Cart button in the Saved Cart area.
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The button is replaced with a text box. Next, enter the name of the new cart in the text box

and click the OK button.

Once the site visitor clicks OK, the cart is added to the list of Saved Carts and becomes the

active cart. A site visitor can then click the Continue Shopping button to select products to

add to the new cart.

Displaying an Item’s information
In the Cart server control, a product’s title is a link. When clicked, it takes you to the product’s

detail page. To navigate back to the cart, click the back button. By default, the server control

uses the product’s QuickLink information to provide a path to the product. You can override

this functionality by adding a new path to the TemplateProduct property.
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Assigning or Changing the Name of the Cart
Assigning a name to a cart makes it easier for site visitors to identify a cart in their saved cart

list. A site visitor can assign or change the name of a cart by clicking the Edit button located

next to the cart’s name.

Once clicked, the button and name are replaced with a text box that allows the site visitor to

enter a new name for the cart. When finished, click the OK button.
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Changing an Item’s Quantity
To change a product’s quantity, enter the new amount in the Quantity column’s textbox

located in the same row as the product you want to change. Next, click the Update Subtotal

button. This will recalculate the total price for the product and update the subtotal. The image

below shows the Atrium Table quantity change to three.

Removing an Item from the Cart
A site visitor can remove a product from the cart by clicking its Remove From the Cart button (
) in the Remove column. Once the site visitor clicks the button, the product is removed from

the cart and the Subtotal is updated.

Continuing to Shop
A site visitor can continue to shop by clicking the Continue Shopping button. This takes the

site visitor back to a template defined in the cart server control’s TemplateShopping
property. For example, you might send the site visitor to a page containing a ProductList or

ProductSearch server control. See Also: "Product List Server Control" on page 17-165 and

"ProductSearch Server Control" on page 17-170.

As a developer, you need to add the path to this page to the TemplateShopping property.

If the page is in the same folder as the page that contains the Cart server control, just enter the

page’s name.
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Applying Coupons
If you have coupons defined in the Workarea and the EnableCoupons property is set to

True, a site visitor can enter coupons to discount the purchase. How coupons affect the

purchase is defined in the Workarea > Settings > Commerce > Catalog > Coupons. See Also:

"eCommerce Coupons" on page 17-225

To apply a coupon, a site visitor clicks the Apply Coupon button.

The button area changes to text box where the site visitor can enter the Coupon Code. The

site visitor then enters a code and clicks the OK button.

Once a site visitor clicks OK, the discount appears above the Subtotal and he can continue to

shop, checkout, view other carts or delete the coupon.
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A site visitor can remove the coupon by clicking the Remove Coupon button.

Emptying the Current Cart
To clear all of the products in the current cart, a site visitor clicks the Empty Cart button.

Once clicked, a dialog box appears and the site visitor can click the OK or Cancel button.

Checking Out
Once a site visitor is satisfied that the current cart contains all products they want, the quantity

of each product is correct and all coupons have been applied, he can click the Checkout

button. At that point, the site visitor is taken to the page that contains the Checkout server

control. The path to the page is defined in the TemplateCheckout property. If the page

containing the Checkout server control is in the same folder as the Cart server control, just

enter the page name. See Also: "" on page 17-16.

If a site visitor has an item in his cart that is out of stock, the Checkout button is disabled

(hidden).

Deleting a Saved Cart
A site visitor can delete a saved Cart by clicking on the Delete Cart button. Clicking this

button instantly deletes the cart.
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Controlling the Cart’s Displaywith aUserControl
Ektron provides the ability to control the Cart server control’s display through a user control. This allows you to
easily change the look and feel of the Cart server control in a visual environment; for example, in Microsoft
Visual Studio. To do this add the path of the user control to the UserControlUrl property.

For example, you could create multiple user controls with different “skins” for the Cart server control. Then,
dynamically populate the UserControlUrl property with the location of the user control (skin) as needed.

Lets say you have an eCommerce site that sells books and toys. When some one is purchasing books, you
might want to have a more library looking cart. If someone is purchasing toys, you might have a colorful cart
with bright images.

Ektron provides a sample user control for the Cart server control. Its location is
<siteroot>\Workarea\ControlTemplates\Commerce\Cart\CartUserControl.ascx.

Code behind for this user control is in the CartUserControl.ascx.cs file.

Warning! If you want to edit this file, it is strongly recommended that youmake a copy, change its name andmove

it outside of theWorkarea folder. If youmake changes to this file and do not move it out of theWorkarea, this file

and the changeswill be lost when you upgrade.

Note: If there is an error in the code behind for the user control, the page will appear blankwhen the server

control loads.

Cart Server Control Properties
The following table explains the properties of the Cart control.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.
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Property Description
Data

Type

Authenticated
Indicates if you are logged in to the CMSWorkarea

and can use it to browse to Content, Collections.
String

CustomXml

(Code Behind Only)

Enter a string of XML. This property providesamechanism to inject custom

XML into the generated XML before being processed by the XSLT. The

injected XML is appended to the end of the XML produced by this control.

See Also: "Displaying CustomXML in Ektron’sServer Controls" on page 21-37

String

DisplayXslt

Specify an externalXSLT file to render the control. Bydefault, the control uses

Cart.xsl. This file is located in

<Site Root>\Workarea\Xslt\Commerce

Important: If you want to edit this file, it is strongly recommended that you

make a copy, change its name andmove it outside your site’sWorkarea folder.

If youmake changes to this file and do not move it out of theWorkarea folder,

this file and the changeswill be lost when you upgrade.

String

DynamicProductParameter

TheQueryString parameter namewhich is used to pass the product ID to the

product details page. For example, if your QueryString parameter for products

is ID, enter that in this property. Then, when site visitors clicks a product’s title,

this parameter is passed with the product’s ID to the product details page.

String

EnableCoupons

Set to true to allow a site visitor to enter coupon codes for discounts.When set

to false, theApply Coupon button is hidden. See Also: "Applying Coupons" on

page 17-11

True = coupon entry is available.

False = coupon entry is not available.

Note: Couponsare created in theWorkarea >Settings>Commerce >Catalog

>Coupons section. See Also: "eCommerce Coupons" on page 17-225

Boolean

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

Language
Set a language for viewing the cart. This property shows results in design-time

(in VisualStudio) and at run-time (in a browser).
Integer

LoadingImage

The image to displaywhile the cart is loading.

The default isajaxloader_circle_lg.gif.

This file is located in<siteroot>\Workarea

\images\application.

String
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Property Description
Data

Type

MarkupLanguage

As of 7.6.1 this property

does not work. It should

work in a future

release.

Identify the template markup file that controls the display of the

server control. For example, mymarkup.ekml. If the *.ekml file is

located in the same folder as the Web form containing the server

control, just enter its name. Otherwise, the path to the file can be

relative or absolute. See Also: ”Ektron Markup Language” on page

 3636

There is a sample Basket.ekml file located in

<siteroot>\Workarea\Template\Basket

If you enter a file in this property, it overrides the DisplayXslt

properties.

String

Stylesheet

Specify the path to a style sheet for use with this server control. The location can

be relative or absolute. Leave blank to use the default style sheet. The default is

Cart.css.

This file is located in:

<Site Root>\Workarea\csslib\Commerce

Important: If you want to edit this file, it is strongly recommended that you

make a copy, change its name andmove it outside of theWorkarea folder. If

youmake changes to this file and do not move it out of theWorkarea, this file

and the changeswill be lost when you upgrade.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The default is

False.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TemplateCheckout

The template location that contains the Checkout server control. This is the

page a site visitor is sent to when he clicks theCheckout button. If the template

file is located in the same folder as theWeb form containing this server control,

just enter its name. Otherwise, the path to the file can be relative or absolute.

See Also: "Checking Out" on page 17-12

String

TemplateProduct

The template location that contains the Product server control. This is the page

a site visitor is sent to when he clicks the name of a product in his cart. This page

providesdetails about the product. See Also: "Displaying an Item’s information"

on page 17-8.

When this property is left blank, the server control uses the Product’sQuickLink

information.

If the template file is located in the same folder as theWeb form containing this

server control, just enter its name. Otherwise, the path to the file can be relative

or absolute. See Also: "Displaying an Item’s information" on page 17-8

String
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Property Description
Data

Type

TemplateShopping

The URL to navigate to when the site visitor clicks theContinue Shopping

button. ThisURL could lead to a template containing a ProductSearch or

ProductList server control that would allow a site visitor to select additional

products. See Also: "Continuing to Shop" on page 17-10.

For information the ProductSearch or ProductList controls, see

"ProductSearch Server Control" on page 17-170 or "Product List Server

Control" on page 17-165

String

UserControlUrl

The URL of the User Control that manages the display of the Cart.
This path can be relative or absolute. A sample user control is
located in <siteroot>\Workarea

\ControlTemplates\Commerce\Cart\CartUserControl.ascx

.

Warning! Important: If you want to edit this file, it is strongly recommended

that youmake a copy, change its name andmove it outside your site’sWork-

area folder. If youmake changes to this file and do not move it out of theWork-

area folder, this file and the changeswill be lost when you upgrade.

Warning! Important: If you use this property, theDisplayXslt property

is ignored and the server control is hidden.

See Also: "Controlling the Cart’s Display with a User Control" on
page 17-13

String

Checkout Server Control
Warning! When using the Checkout server control, you should alwayshave an SSL certificate installed for your

Web site and set the control’sIsSSLRequiredproperty to True. This protects your customers’ payment infor-

mation while it is being transmitted. Do not use a self-signed SSL certificate -- obtain one from a trusted certificate

authority.

The Checkout server control allows a site visitor to navigate through the checkout process.

This process includes:

n adding billing and shipping information

n selecting a shipping method

n reviewing the order

n submitting the order and credit card information

n notification that checkout process is complete

eCommerce

17-16
ReferenceManual

Version 8.0 Rev 1.3



Site visitors typically arrive at this server control by clicking the Checkout button on the Cart

server control. They also might reach this server control from a Checkout link you create on

your site.

The control provides a navigational aid that indicates the customer’s step in the checkout

process. At any point, the customer can move forward to the next step or backwards to

previous ones.

As appropriate, some of the wizard’s steps do not appear. For example, if merchandise is not

tangible, the shipping screen does not appear.

Logging In or Setting Up an Account
Warning! When using the Checkout Server Control, the Enable Verify Email setting in theWorkareamust be

unchecked. Otherwise, new userswill receive an error message when they sign-up using this control. To verify this

setting, access theWorkarea asan administrator and navigate to Settings >Configuration >Setup. Next,

make sureEnable Verify Email is unchecked. If not, click theEdit button, uncheck the boxand click the Save but-

ton.

If a site visitor is an existing user and is not logged in when he reaches this server control, the

control provides a way for him to log in. Optionally, this screen could also show a link that

allows existing users to recover their password. To enable this link, add a template path to the

TemplateRecoverPassword property. Your organization should decide how to handle

this functionality. For example, you could create a template with a Membership Server Control

and set that control’s DisplayMode property to ResetPassword. See Also: ”Membership Server

Control” on page 16-30.
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If the site visitor is not an existing user in the system, he can proceed with checking out by

clicking Next Page. here, he can enter billing information.

After completing the Billing Information screen, a membership user account is created, and he

is logged in. The new user can then proceed through the checkout.

Storing a Site Visitor’s Information
When a logged-in site visitor has previously purchased products from this site, using this

system, billing and shipping information are already filled out. This information is stored in

Ektron CMS400.NET and can be edited each time a user checks out. However, because

CMS400.NET does not store credit card numbers, that information must be entered each time.

Checkout Server Control Screens
The Checkout server control is broken up into several sections. Each section represents a

portion of the checkout process.

n "Billing Information" on page 17-18

n "Shipping Information" on page 17-19

n "Shipping Method" on page 17-19

n "Review Order" on page 17-20

n "Submit Order" on page 17-20

n "Order Complete" on page 17-21

Billing Information
This section allows site visitors to add their billing information including:

n First Name, Last Name

n Company (Optional)

n Address, City, State, Postal Code

Note: If a site visitor choosesa country other than the United States, no field validation is applied to the postal code

bydefault. To apply country-specific postal code validation, see thisEktron Knowledge Base article:

http://dev.ektron.com/kb_article.aspx?id=26072.

n Phone

n E-mail Address (Only appears when a person creates a new account.)

n Password
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Shipping Information
This page allows site visitors to add or edit shipping information. By default, it uses the

billing address as the shipping address. From this screen, site visitors can add new addresses,

proceed to the next step, or navigate to the previous page. When a site visitor adds a new

address, it’s stored with the account information in CMS400.NET.

Shipping Method
This page allows site visitors to select the type of shipping for their products. Shipping

methods that appear here are defined in the Workarea > Settings > Commerce > Shipping >
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. For information on setting up shipping methods, see "Shipping Methods" on page 17-90.

Review Order
The Review Order page displays information about the products being purchased, their price,

shipping charges, discounts, and taxes. At this point, if a site visitors wants to modify their

cart, they click the Edit your cart link. For example, a site visitor wants to apply a coupon to

his cart.

n For this link to work properly, you need to add the path of the template that contains the

Cart server control to the Checkout server control’s TemplateCart property.

Submit Order
On the Submit Order page, a site visitor enter payment information. He can pay by check,

credit card, or PayPal, depending on what has been set up in your CMS400.NET Workarea’s

eCommerce > Configuration > Payment Options screen.

Once a site visitor enters the information, he clicks the Submit button. At that point, the charge

is submitted to the payment gateway, and the order is posted in CMS400.NET. See Also:

"Orders" on page 17-197
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Order Complete
This page displays a Thank You note, the order ID, and links to continue shopping or view an

order’s history.

The Continue Shopping link appears when you add the path of a template that allows a site

visitor to find products to the TemplateShopping property. For example, you might send

them to a template containing a ProductSearch or ProductList server control.

The Order History link appears when you add the path of a template containing the OrderList

server control to the TemplateOrderHistory property.

Flow of the Checkout Server Control
Below is a flow chart that represents the options & processes in the Checkout Server Control.
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Checkout Server Control Properties
The following table explains the properties of the Checkout control.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the

CMSExplorer and can use it

to browse to Content, Collections, etc.

String
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Property Description Data Type

See Also: ”Using CMSExplorer to Browse Your Ektron

CMS400.NET Site” on page 21-12

CacheInterval

Sets the amount of time the server control’s data is cached. The

default is 0 (zero). This is the amount of time, in seconds, a

control’s data is cached. For example, if you want to cache the

data for fiveminutes, set theCacheInterval property to

300 (three hundred).

See Also: ”Caching with Server Controls” on page 21-43

Double
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Property Description Data Type

CurrentPhase

(Code Behind Only)

Reports or selects the current page (or phase) of the checkout

control. This allows you to customize the flow of the control. For

example, if you only have one shipping option, you would skip

the ShippingInfoEntry phase.

For an example of working with the CurrentPhase property in

code behind, download Ektron’sDeveloper Sample Site and

view these files.

[Site Root]/Developer/Commerce

/CheckoutDemo_Advanced.aspx

[Site Root]/Developer/Commerce

/CheckoutDemo_Advanced.aspx.cs

Phasesare listed below in the order which theyhappen within

the control.

Login - phase with option for existing users to log in. See Also:

"Logging In or Setting Up an Account" on page 17-17.

BillingInfo - phase for displaying a site visitor’s billing

information. See Also: "Billing Information" on page 17-18

BillingInfoEntry - phase for entering a site visitor’s billing

information. See Also: "Billing Information" on page 17-18.

ShippingInfo - phase that displaysa site user’s shipping

information.

ShippingInfoEntry - phase for entering a site visitor’s shipping

information. See Also: "Shipping Information" on page 17-19.

ShippingMethodSelect - phase for selecting themethod of

shipping. See Also: "ShippingMethod" on page 17-19.

ReviewOrder - phase that displays the current order’s details

for review. See Also: "Review Order" on page 17-20.

SubmitOrder - phase where site visitors add payment

information. See Also: "Submit Order" on page 17-20.

Complete - phase that displays completionmessage. See Also:

"Order Complete" on page 17-21.

Error_EmptyBasket - phase used when a cart hasno items

and the site visitor somehow enters the control.

Error_UnhandledException - phase occurswhen there’s an

error that the control cannot resolve.

ControlPhase

CustomXml

(Code Behind Only)

Providesamechanism to inject custom XML into the generated

XML before being processed by the XSLT. The injected XML is

appended to the end of the XML produced by this control.

See Also: ”Displaying CustomXML in Ektron’sServer Controls”

on page 21-50

String
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Property Description Data Type

DefaultCountryId

The ID of the default country that appears in the Billing Address

and Shipping Address. Set this ID to the country fromwhich the

majority of your customerswill bemaking purchases. If the site

visitor is from a different country, he can change it when editing

the Billing or Shipping Address.

To find a country’s numeric ID, sign into the Ektron

CMS400.NET Workarea. Then go toSettings > Commerce >

Configuration > Countries. The Numeric ID is in the left

column of that screen.

Integer

DynamicPhaseParameter
The name of the parameter on theQueryString that identifies

desired phase ID.
String

DisplayXslt

Specify an externalXSLT file to render the control. Bydefault,

the control usesCheckout.xsl. This file is located in

<SiteRoot>\Workarea\Xslt\Commerce

\Checkout\Standard

Important: If you want to edit this file, it is strongly

recommended that youmake a copy, change its name and

move it outside your site’sWorkarea folder. If youmake

changes to this file and do not move it out of theWorkarea

folder, this file and the changeswill be lost when you upgrade.

String

FriendlyErrorMessage

Themessage that is shown to a site visitor when an unhandled

error occurs. Details are sent to the event log. The default

message is

“We're sorry, an error occurred while processing your request.

Please try again later...”

String

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

IsSSLRequired

When set to True, switches to an SSL encrypted URL. For the

SSL encryption to work, youmust have an SSL certificate

installed for your site. Information on SSL can be found at the

followingWeb sites.

http://www.tech-faq.com/understanding-ssl.shtml

http://www.verisign.com/ssl/ssl-information-

center/how-ssl-security-works/index.html

Installing and using an SSL is one of themost important things

you can do to protect your customer’s credit card data.

Note: Ektron, Inc. is not associated with TechFAQor VeriSign.

However, both sites offer good explanationsof Secure Sockets

Layer.

Boolean
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Property Description Data Type

Language

Set a language for viewing the checkout control. This property

shows results in design-time (in VisualStudio) and at run-time

(in a browser).

Integer

LoadingImage

The image to displaywhile the control is fetching data. The

default is<siteroot>\Workarea\images

\application\ajax-loader_circle_lg.gif.

String

MarkupLanguage

As of 7.6.1 this property

does not work. It should

work in a future release.

Identify the template markup file that controls the

display of the server control. For example,

mymarkup.ekml. If the *.ekml file is located in the

same folder as the Web form containing the server

control, just enter its name. Otherwise, the path to the

file can be relative or absolute. See Also: ”Ektron

Markup Language” on page Right.

String

Stylesheet

Specify the path to a style sheet for use with this server control.

The location can be relative or absolute. Leave blank to use the

default style sheet.

String

SuppressWrapperTag

Suppresses the output of the span/div tagsaround the control.

The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TemplateCart

The URL path of the template that contains the Cart server

control. This path can be relative or absolute.

When a path is entered, a link appears in the Review Order part

of the process that allowsa user to navigate to the template

containing the Cart server control. See Also: "Review Order" on

page 17-20 and "Cart Server Control" on page 17-3.

String

TemplateOrderHistory

The URL path of the template that contains the OrderList server

control. This path can be relative or absolute.

When a path is entered, a link appears at the end of checkout

process that allowsa user to navigate to the template containing

the OrderList server control. See Also: "Order Complete" on

page 17-21 and "OrderList Server Control" on page 17-205.

String

TemplateRecoverPassword

The URL path of the template that helps site visitors recover

their password. This path can be relative or absolute.

When a path is entered and a site visitor hasnot logged in, a link

appears at the beginning of checkout process that allowshim to

navigate to a template containing information to recover his

password. TheMembership server control contains an option

for recovering passwords. See Also: "Logging In or Setting Up

String
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Property Description Data Type

an Account" on page 17-17 and ”Membership Server Control”

on page 16-30

TemplateShopping

The URL path of the template that allows the site visitor to

continue shopping.

When a path is entered, a link appears at the end of checkout

process that allowsa user to navigate to the template that would

allow them to continue shopping; for example, the template

containing a ProductList or ProductSearch server control. See

Also: "Order Complete" on page 17-21, "Product List Server

Control" on page 17-165 and "ProductSearch Server Control"

on page 17-170

String

Access to eCommerce
Only members of the Administrators group or those assigned the eCommerce Admin role can

access the eCommerce screens within the Ektron CMS400.NET Workarea. See Also: ”Defining

Roles” on page 15-40

Images in eCommerce
When using eCommerce, a site visitor sees images that represent products or services for sale.

The following table lists each image that appears on an eCommerce Web site, and the source

of each one.
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Where Image

Appears
Example

Image Location in

Workarea

Product Server

Control, main

image

Image on Product control

On the catalog entry’sContent

tab

Note: The sample catalog

entries are based on Product

Typeswhose XMLSmart Form

includesan Image field. Asa

result, the product description,

(which appears at the top of the

Product Server control) includes

an image. This is not required,

merely a suggested

implementation.

Product Server

Control,

thumbnails

Thumbnails on lower portion of

Product control

Note: To control the thumbnail display,

use the Xslt files generated by the

Product, Product List, Product Search,

and Recommendation server controls.

On the catalog entry’sMedia

screen.

If an image’sGallery Display

field is set toYes, its smallest

thumbnail appears on the

Product server control, below

the content area. (This assumes

you are using the control’s

default xslt.)

When a site visitor clicks a

thumbnail, the corresponding full

image appears.

Since theMedia screen can have

several images, several

thumbnails can appear. They

appear left to right reflecting their

sequence (top to bottom) on the

Media screen.

See Also: "Determining

Thumbnail Size" on page 17-148

Product List,

Product Search,

and

Recommendation

server controls

Image on Product List control

On the catalog entry’sMedia

tab, the image designated as

Product Icon

See Also: "Entering a Catalog

Entry’sMedia" on page 17-146
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Steps to Set Up a Basic eCommerce
Web Site
This section describes how to set up a basic eCommerce Web site. This walk through explains

everything you need to set in the web.config file and the Workarea. It also includes a list of

templates needed and how to set up Ektron’s eCommerce Server Controls on them.

Steps Description

Step 1.

In theWeb

site’s

web.config file,

set the following

keys:

<add key=”ek_ecom_DefaultCurrencyId” value=”840” />

n this keydetermines the base currency for your Web site. The default is

840 (the USDollar). If needed, change this to the Numeric ISOcode for the

default currency. See Also: "The Default Currency" on page 17-55

Warning! Important: Do not change this once the site is live.

<add key=”ek_MeasurementSystem” value=“English” />

n For each item sold on your Web site, you define a height, length, depth,

and weight. If English, the units are inchesand pounds. If Metric, the units are

centimeters and kilograms.

This information is used to calculate shipping costs. Bydefault, this is set to

English. Change to “Metric” to use theMetric system. See Also: "Packages"

on page 17-87

Warning! Important: Do not change this once the site is live.

<add key=”ek_ecom_ComplianceMode” value=”false” />

n set this key to “true” when you want your site to be SecurityCompliant.

Thismeans theWorkarea will be encrypted in an SSL session and Logging is

started.

More Information:

A list of currencies and their Numeric ISO code can be found in

theWorkarea > Settings > Commerce > Configuration >

Currencies section. The ID is the Numeric ISO code.

Step 2.

Decide whether

you want to use

CMS400.NET’s

inventory

system or

another

inventory

system.

If you are not using CMS400.NET’s inventory system, create a custom

inventory provider and add it to the web.config file’s InventoryProvider.

Ektron’s InventoryProvider feature allows you to workwith an existing

inventory system. This is set in the web.config file.

n Add the custom provider between the InventoryProvider’s <providers>

tagsand change the default provider to the name of your custom inventory

provider. For example:

<inventoryProvider defaultProvider=”MyCustomInventoryProvider”>
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Steps Description

More Information: "Customizing the Inventory Provider" on

page 17-290

Step 3.

Select a

default

Payment

Gateway.

To use one of the payment gateways shipped with CMS400.NET, you can

set it in theWorkarea.

1. Navigate to Settings > Commerce > Configuration > Pay-
ment Gateway.

2. Click a payment gateway’s name.

3. Click the Edit button.

4. Add your User ID, Password and any needed Custom
Values.

5. Click the Default check box to make that selection the
default.

6. Click the Save button.

If you are not using one of these gateways, create a custom payment

provider and add it to the web.config file’sEktronPaymentGateway. Add the

custom provider between the EktronPaymentGateway’s <providers> tags.

Once added, the option should appear in theWorkarea’sPayment Gateway

screen.

If you want to override theWorkarea settings, change the default provider in

the web.config file from “Automatic” to the name of the desired payment

gateway. For example:

<EktronPaymentGatewaydefaultProvider=”AuthorizeNet”>

More Information: "Payment Gateway" on page 17-69

Step 3a

(optional) Set

up PayPal

Support

See "PayPalSupport" on page 17-61
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Steps Description

Step 4.

Set up a

shipping

provider.

If you are not using the default flat rate shipping provider, open the

shipment.config file and set the default provider in formation in:

<shipmentProvider defaultProvider=”FlatRateShipmentProvider”> to either

“FedExShipmentProvider” or “UPSShipmentProvider”. If you are using

either of these shippingmethods, make sure you fill in the following

information in the <providers> tags. This information is provided byFedEx

and UPS. (If you don’t see these items, scroll the window to the right.)

n key=””

n password=””

n accountNumber=””

n meterNumber=””

In addition to using these providers, you can add additional

providers.

More Information: "Defining Shipping Providers" on page 17-

90

Step 5.

Enable

countries

where your

Web site will

sell its

products

Note: The

United States is

enabled by

default.

Enabling a country in CMS400.NET:

n makes it available for site visitors to use aspart of an address for ship-

ping and billing purposes

n makes it available when you add a warehouse

n automatically enables its corresponding tax table in the CountryTax

Table section of theWorkarea

Enable Countries in the Workarea.

1. Navigate toSettings >Commerce >Configuration >Countries.

2. Click a country’s name.

3. Click theEdit button.

4. Click theEnabled checkbox.

5. Click theSave button.

More Information: "Countries" on page 17-47
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Steps Description

Step 6.

Add and

enable

regions for

each country

your

eCommerce

site will

service.

Note: All states

in the USare

enabled by

default.

Regions can represent states, provinces, territories, etc. and further define

areasof a country. Adding and enabling regions:

n makes it available for site visitors to use aspart of an address for ship-

ping and billing purposes

n makes it available when you add a warehouse

n automatically enables its corresponding tax table in the RegionsTax

Table section of theWorkarea

Add Regions in theWorkarea.

- Prerequisite: The region’s country is defined in the

Countries screen.

1. Navigate toSettings >Commerce >Configuration >Regions.

2. ClickNew>Region.

3. Enter a Name.

4. Click theEnabled checkbox.

5. In the Code box, enter an abbreviation for this region.

6. Select this region’s country from the pull down list.

7. Click theSave button.

More Information: "Regions" on page 17-50

Step 7.

Enable

Currencies

for your

eCommerce

site.

Note: By

default, U.S.

dollar, Euro and

Australian

dollar are

enabled.

If your Web site is selling products in another country and you

want to display prices in that country’s currency, enable it in the

Workarea.

1. Navigate to Settings > Commerce > Configuration > Currencies.

2. Click a currency.

3. Click the Enable button.

4. Set the Exchange Rate.

Note: Note: The default currency set in the web.config file is the base

reference currencywhen setting an exchange rate.

5. Click the Save button.

More Information:"Currencies" on page 17-53
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Step 8.

Decide which

credit cards

your

eCommerce

site will

accept.

Credit cards are used during the checkout process, by the

Checkout server control, during the submit phase. During this

phase, all enabled credit cards appear in a drop down which site

visitors use to select their choice.

Add credit card types in the Workarea.

1. Navigate toSettings >Commerce >Configuration >Credit Card.

2. ClickNew>Credit Card Type.

3. Enter the credit card’s name; for example, Visa.

4. Check theAccepted checkbox.

5. Add an image.

6. Add a RegexExpression to validate the credit card number.

7. Click theSave button.

More Information: "Credit Card Types" on page 17-77

To learn about the Checkout server control, see "Checkout

Server Control" on page 17-16.

Step 9.

Add or edit

eCommerce

notification

messages.

email notificationsare sent to your customersafter their order hasbeen

received, cancelled, shipped or completed. Ektron provides four predefined

messages, one for each event.

For messages to be sent, content notifications must be enabled

and the customer must enter a valid email address.

Add or edit messages in theWorkarea. To edit a message:

1. Navigate toSettings >Commerce >Configuration >Messages.

2. Click the title of themessage.

3. Click theEdit button.

4. Change the properties and fields asnecessary.

5. Change the text asneeded.

More Information: "Messages" on page 17-81

To learn about content notifications, see ”Configuring E-Mail for

Tasks and Content” on page 1-109.
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Steps Description

Step 10.

Create Tax

Classes.

(Optional)

If you are collecting taxes for transactionson your eCommerce site, create a

TaxClass for each taxable category of products. For example, if your

eCommerce site sells alcohol and tobacco, set up a tax class for each type.

Ektron provides four tax classes by default:

n Alcohol

n Goods

n Services

n Tobacco

Tax classesare applied to Postal, Regional and CountryTaxTables. In those

tables you define a separate rate for each TaxClass.

Tax Classes are created in the Workarea.

1. Navigate toSettings >Commerce >Tax >Tax Classes.

2. Click theNew>Tax Class.

3. Enter a name; for example, Food.

4. Click theSave button.

More Information: "The Tax Class Screens" on page 17-97
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Step 11.

Set your tax

rates in

CMS400.NET

TaxTables

Once your TaxClassesare set up, you need to set a tax rate for each class in

the Postal, Regional, or CountryTaxTables.

n Postal TaxTables - use when there is a city or county tax. If there are

postal, regional and country taxesapplied to a given area, roll them all into this

table.

n Regional Tax Tables - use when there is a state, provincial

or territorial tax. If only regional and country taxes are applied to a

given area, roll them into this table.

n Country Tax Tables - use when there is country-wide tax. If

only country level taxes are applied to a given area, use this

table.

CMS400.NET checks these tables in the following order: Postal,

Regional, then Country. Once it finds a tax, it stops. Therefore, if a

postal zone has several taxes (for example, a local tax and a

regional tax), build the combined percentage into the postal code

tax. So, assume New York City has a 4% tax, and New York state

has a 3% tax. In this case, enter a combined total of 7% into all

Postal Tax Tables within New York City.

While you need to create each Postal Tax Table, Regional and

Country Tax Tables are automatically generated when a country

or region is added to CMS400.NET. However, there are no tax

rates defined in these tables.

Create Postal TaxTablesor edit Region and CountryTaxTables in the

Workarea.

To create a new Postal TaxTable:

1. Navigate toSettings >Commerce >Tax >Postal Tax Tables.

2. Click theNew>Postal Code.

3. Enter a PostalCode.

4. Select the Country and Region.

5. Enter a tax rate for each TaxClassasneeded.

6. Click theSave button.

To edit a Region’s or Country’s TaxTable:

1. Navigate toSettings >Commerce >Tax >Regional Tax Tables or

Country Tax Tables.

2. Click the Id or Code of the Region or Country.

3. Click theEdit button.

4. Change the information asneeded.

5. Click theSave button.

More Information: "Postal Tax Tables" on page 17-99,

"Regional Tax Tables" on page 17-101, "Country Tax Tables"

on page 17-103
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Step 12.

Add and

select

shipping

methods in

the

Workarea.

Note: If you

have not set up

a shipping

provider, see

"Set up a

shipping

provider." on

page 17-31.

Once you have a shipping provider set up (see "Set up a

shipping provider." on page 17-31), define the shipping options

from which your site visitors can select. For example, if you use

UPS, define whether to allow Next Day, 2nd Day, 3rd Day,

Ground, World Wide Standard, etc. Once a Shipping Method is

enabled, it will appear in the Shipping Method phase of the

Checkout server control. Shipping Methods are defined in the

Workarea.

1. Navigate toSettings >Commerce >Shipping >Methods.

2. ClickNew>Shipping Method.

3. Enter a Name. This name represents the option in the ShippingMethod

phase of the checkout server control.

4. Click theActive checkbox to enable thismethod.

5. Click theViewOptions link.

6. From the Provider Service drop down, select a shippingmethod.

7. Click theSave button.

Repeat these steps until you’ve added all the necessary shipping

methods.

More Information: "Shipping Methods" on page 17-90

Step 13.

Add a

warehouse

from which

your products

will be

shipped.

This does not have to be the actual shipping address for the

products. CMS400.NET uses this information to determine the

“from” address when calculating shipping cost.

Add warehouse information in the Workarea.

1. Navigate to settings >Commerce >Shipping >Warehouses.

2. ClickNew>Warehouse.

3. Complete the address information fields.

Note: Only countries and regions that have been enabled for eCommerce

appear in the drop down lists.

4. Click theDefault Warehouse checkbox if you want this to be the

default warehouse. Only the default warehouse is used in the checkout

process.

5. Click theSave button.

More Information: "Warehouse" on page 17-85
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Step 14.

Define each

package size

your shipping

department

uses to ship

your products.

Tangible products have size and weight dimensions. CMS400.NET’s

shipping calculator uses this information with the package size information to

fit the order into the smallest-sized and fewest packages. It then passes

packaging information (number, sizesand weight) to the shipping provider,

which returns the order’s shipping costs.

Define package information in the Workarea.

1. Navigate toSettings >Commerce >Shipping >Packages.

2. ClickNew>Package.

3. Enter aName, Length,Height,Width andMaximumWeight a

package can handle.

4. Click theSave button.

Repeat these stepsuntil you’ve added all the package sizes your company

uses.

More Information: "Packages" on page 17-87

Step 15a.

Create

Product Type

definitions for

each type of

product you

are selling.

Note: The

remaining steps

in this example

are based on

selecting a

Product for the

Product Type

Class.

Product typesare applied to your catalog folders and allow you to control the

wayproduct information is added to a catalog. This concept is similar to the

waySmart Form configurationsare applied to content folders to control the

waycontent blocksare created. You can applymultiple product types to a

catalog.

Define product types in theWorkarea.

1. Navigate toSettings >Commerce >Catalog >Product Types.

2. ClickNew>Product Type.

3. Define the Product Type.

4. Click theSave button andmove to the next step.

More Information: "Product Types" on page 17-106

Step 15b.

Create the

content page.

After clicking the Save button from the previous step, a content editor

appears and allows you to enter XML Smart Form information. ThisSmart

Form iswhat a user fills out when creating a Catalog Entry (Product).

The information added bya user appears on a product’s details page on your

Web site.

Here are some fields youmight want to create in your smart form.

n Title

n Description

n Image

Once you have the Smart Form complete, click the Save button.

More Information: "Product Types" on page 17-106, ”Working

with Smart Forms” on page 7-369
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Steps Description

Step 16.

Create a

catalog and

assign it a

product type.

A catalog folder is a CMS400.NET folder designed to hold eCommerce

entries (products). This is similar to the waycontent folders hold HTML or

Smart Form content. Byassigning a product type to the folder, you can

control the wayproducts are added to the catalog.

Catalogsare created in theWorkarea.

1. Click theContent folder bar to display the list of content folders.

2. Click New > Catalog.

3. Set the catalog’s Properties, Metadata, Web Alerts and
Breadcrumb information. (Similar to creating a Content
Folder.)

4. On the Product Types Tab, select a Product Type from the
drop down list.

5. Click the Add link.

6. Click theSave button.

More Information: "Creating a Catalog Folder" on page 17-126,

"Assigning a Catalog Folder’s Product Type" on page 17-127
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Step 17.

Add Catalog

Entries to a

Catalog.

Catalog Entries are the products you are offering on your

eCommerce Web site. For example, a catalog entry could be a

CD, a subscription-based service, or a computer that a site visitor

can customize and the price adjusts accordingly.

Create catalog entries in theWorkarea.

1. Navigate to a catalog folder.

2. ClickNewand select a product type.

3. In the Title field, enter a name for the catalog entry.

4. Fill out the fields in the Smart Form asnecessary.

5. Select the Summary tab and add a summary. (Optional)

6. Select the Properties tab and enter an SKU and the number of units that

equal one purchase. Next, select a TaxClass. If the product is a tangible

product, click theExpand link next to Dimensions, click the Tangible

checkboxand enter the product’s physical dimensions. If you are using

CMS400.NET asyour inventory system, click the Expand link next to

Inventoryand enter the information.

7. Select the Pricing tab and enter the product’s list price and salesprice. If

you are offering a quantity discount, click the Add Pricing Tier button and

add a quantity and a tier price. If you enabledmultiple currencies, select

a currency from the drop down and add pricing information asneeded.

8. Select the Attributes tab and fill-out or change attributesasneeded.

Note: if you did not define attributes in "Step 15a." on page 17-37, the

Attributes tab doesnot appear.

9. Select theMedia tab and click theAdd Images button to associate

imageswith the catalog entry.

10. The Items tab is used to create a complexproduct. This allows you to

offer variants of a product at different price points. For this example, we

will skip this tab. See Also: "Creating a ComplexProduct" on page 17-

117.

11. Enter information asneeded on these tabs: Metadata, Taxonomyand

Schedule.

12. ClickAction >Publish.

Continued on the next page.

Step 17.

Continued.

To add CrossSell or Up Sell itemsassociated with this catalog entry, click its

Title and then clickView>Cross Sell or Up Sell. These itemsappear in the

Recommendation server controlwhen it is associated with this catalog entry.

More Information: "Creating a Catalog Entry" on page 17-128
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Overview:

CreateWeb

site templates

site visitorswill

use to interact

with your

eCommerce

site.

Here is a list of templates needed to create a basic eCommerce site.

n Master page - recommended, but not absolutely necessary. This tem-

plate could contain anyof the following:

- CurrencySelect server control - allow site visitors to

choose a currency.

- View Cart link - links to the template containing the Cart

server control.

- View My Account / Orders link - links to the template

containing the MyAccount and OrderList server control.

- Login server control - allows site visitors and users to log

in from any page.

n Landing page - this page should have a way for site visitors to start the

shopping processand could contain a ProductList, ProductSearch server con-

trol.

n Product Display page - use the Product server control on a template

to display the details of a catalog entry (product). If you are using the Cross

Sell or Up Sell functionality, add a recommendation server control to this tem-

plate.

n Product Search page - use the ProductSearch server control on a

template to allow site visitors to search for product.

n Cart page - use the Cart server control on a template to allow a site vis-

itor to workwith the items theyhave selected to purchase.

n Checkout page - use the Checkout server control on a template to facil-

itate the checkout process.

n My Account / Order History page - use aMyAccount server control

and anOrderList server control to display a site visitor’s account information

and a list their order history.

The steps below are an example of creating a Web site using

Ektron’s eCommerce Server Controls.
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Step 18.

Create a

Master page.

Create amaster page and add the following items to a header area or left

side column.

n CurrencySelect server control - allows site visitors to select from

available monetary types. This control displays currencies that have been ena-

bled in theWorkarea during "Step 7." on page 17-32.AMy Cart link that

leads to a template containing the Cart server control.

n My Account / Order History link that leads to a template containing

theMyAccount andOrderList server controls.

n Product Search link - (optional) add a link that leads to a template con-

taining a ProductSearch server control.

n Product Search server control - (optional) allowsa user to search

for a product from anywhere on the site. Note: Adding this option is involves

more than just dragging and dropping a server control to the header or the

left side column. It includes some advanced customizationsand coding that

allowsa search term to be passed from one form to another. Ektron’sDevel-

oper Sample site showsan example of doing thiswith theWebSearch server

control.

n Login server control - (optional) this allowsexisting customers to

login once theyarrive at your site. If you onlywant site visitors logging in

through this control, set theOnlyAllowMemberLogin property to True.

More Information:

"CurrencySelect Server Control" on page 17-59

"MyAccount Server Control" on page 17-213

"OrderList Server Control" on page 17-205

"ProductSearch Server Control" on page 17-170

”Login Server Control” on page 3-8
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Step 19.

Create a

Landing

page.

This template should be the first page a site visitor sees when

they arrive at your site. It should have a mechanism that lets site

visitors start shopping. Make sure this page has one of the

following:

n ProductList server control - use this control to display products by

Taxonomy, Catalog or ID.

- To display a single taxonomy, set the SourceType

property to Taxonomy and enter a single Taxonomy ID in

the SourceId property.

- To display multiple taxonomies, set the SourceType

property to TaxonomyList and enter a comma separated

list of Taxonomy IDs in the IdList property.

- To display a single catalog, set the SourceType property

to Catalog and enter a single catalog ID in the SourceId

property. If you want to display sub catalogs for a given

ID, set the Recursive Property to True.

- To display multiple catalogs, set the SourceType

property to CatalogList and enter a comma separated

list of catalog IDs in the IdList property.

- To display products by their ID, set the SourceType

property to IdList and enter a comma separated list of

product IDs in the IdList property.

- Set the TemplateProduct property to the template

containing the Product server control.

n ProductSearch server control - this control provides themeans for

site visitors to search your Web site for products. If this control is not on your

landing page or part of your master page, you should create a separate tem-

plate containing this control.

- Set the CatalogId property to the ID of the catalog to

search.

- Set the TemplateCart property to the template

containing the Cart server control.

- Set the TemplateProduct property to the template

containing the Product server control.

More Information:

"Product List Server Control" on page 17-165

"ProductSearch Server Control" on page 17-170
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Step 20.

Create a

Product page

This is the template where a site visitor views a product’s details.

It contains a Product server control and optionally a

Recommendation server control.

n Product server control - this control displays a product’s

details.

- Make sure the DynamicParameter property is set to the

parameter name used to pass product IDs to the

QueryString.

- If you want a default product to display when no ID is

passed, set the DefaultProductID property to the ID of

a product.

- Set the TemplateCart property to the template

containing the Cart server control.

n Recommendation server control- this control displays

Cross Sell and Up Sell opportunities associated with a

product. These are set in Workarea, under the View menu’s

Cross Sell and Up Sell selections for a catalog entry

- Set the RecommendationType property to CrossSell or

UpSell.

- Make sure the DynamicProductParameter property is

set to the parameter name used to pass product IDs to

the QueryString.

- If you want a product’s default Cross Sell or Up Sell items

to display when no ID is passed, set the

DefaultProductID property to the ID of a product.

- Set the TemplateCart property to the template

containing the Cart server control.

- Set the TemplateProduct property to the template

containing the Product server control.

More Information:

"Product Server Control" on page 17-154

"Recommendation Server Control" on page 17-190
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Step 21.

Create a

Product Search

page.

This page allows site visitors to search for products on your Web

site.

n ProductSearch server control - this control provides themeans for

site visitors to search your Web site for products. If this control is not on your

landing page or part of your master page, you should create a separate tem-

plate containing this control.

- Set the CatalogId property to the ID of the catalog to

search.

- Set the TemplateCart property to the template

containing the Cart server control.

- Set the TemplateProduct property to the template

containing the Product server control.

More Information:

"ProductSearch Server Control" on page 17-170

Step 22.

Create a Cart

page.

This template contains a Cart server control.

n Cart server control - this control allowsa site visitor to workwith prod-

ucts theyhave selected to purchase. Asa site visitor navigatesaround your

site selecting products to purchase, theyare added to a cart.

- Set the TemplateCheckout property to the template

containing the Checkout server control.

- Set the TemplateProduct property to the template

containing the Product server control.

- Set the TemplateShopping property to the Landing

page template or a template containing a ProductList or

ProductSearch server control.

- If you are using coupons, make sure the EnableCoupons

property is set to True.

More Information:

"Cart Server Control" on page 17-3
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Steps Description

Step 23.

Create a

Checkout

page

This template contains a Checkout server control.

n Checkout server control - this control allowsa site visitor to navigate

through the checkout process.

- Set the DefaultCountryID property to the country you

want to be the default selection in the Billing and

Shipping address sections.

- Set the TemplateCart property to the template

containing the Cart server control.

- Set the TemplateOrderHistory property to the

template containing the OrderList server control.

- Set the TemplateShopping property to the landing page

template or a template containing a ProductList or

ProductSearch server control.

- If you are using SSL Encryption, set the IsSSLRequired

property to True.

Warning! Important: Because Credit Card information is entered into the

Checkout server control, Ektron strongly recommendsusing SSL Encryp-

tion for this page.

More Information:

"Checkout Server Control" on page 17-16
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Steps Description

Step 24.

Create a My

Account

page.

This template contains a MyAccount and an OrderList server

control.

n MyAccount server control - this server control allows site visitors to

view billing, shipping and alternative shipping information associated with

their account.

- Set the DefaultCountryID property to the country you

want to be the default selection in the Billing and

Shipping address sections.

- (Optional) Set the CustomPropertyID property to the ID

or list of comma separated IDs that represent custom

properties associated with users. Custom Properties are

set up in CMS400.NET’s Workarea > Settings >

Configuration > User Properties.

n OrderList server control - this server control allows site

visitors to view a list of their processed orders.

- Make sure the DynamicOrderParameter is set to the

parameter name used to pass order IDs to the

QueryString.

- Make sure the DynamicProductParameter is set to the

parameter name used to pass product IDs to the

QueryString.

More Information:

"MyAccount Server Control" on page 17-213

"OrderList Server Control" on page 17-205
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eCommerce Configuration Screens

n "Countries" on page 17-47

n "Regions" on page 17-50

n "Currencies" on page 17-53

n "Credit Card Types" on page 17-77

n "Payment Options" on page 17-61

n "Messages" on page 17-81

Countries
Use the Countries screen to modify existing country information or add new countries to

eCommerce.

How Countries are Used

n to define country tax tables. For example, assume Canada has a national tax of 5% that

applies to the sale of certain goods. National tax tables are defined in the Country Tax

Tables screen.

n to determine shipping costs. In the Order checkout process, the purchaser selects a

shipping address, which includes country. So, be sure to enable all countries from which

site visitors can enter orders.

Countries are also part of the location on the Warehouse screen. An order’s shipping cost is

determined by the distance between the warehouse and the destination.

See Also:

n "Default Countries" on page 17-48

n "Creating a Country" on page 17-48

n "Editing a Country" on page 17-49

n "Deleting a Country" on page 17-50
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Default Countries
By default, Ektron CMS400.NET provides information for all countries on the ISO list of

English country names and code elements (http://www.iso.org/iso/country_codes/iso_3166_

code_lists/english_country_names_and_code_elements.htm).

The following is provided for each country.

n name

n numeric ISO code

n long alphabetical ISO code

n short alphabetical ISO code

The countries screen lets you enter new countries, as well as edit information for any provided

countries.

Creating a Country
Prerequisite: The new country’s ISO codes

To add a new country, follow these steps. See Also: "Countries" on page 17-47

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Configuration >

Countries.

2. Click New > Country.

3. Use the following table to complete the screen.
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Field Description

Name Enter the country’s name.

Numeric

ISO

Enter the country’s ISO3166-1 three digit numeric ISOcode. See Also:

http://en.wikipedia.org/wiki/ISO_3166-1_numeric

Enabled

Check this box if you want this country to be active. Only active countries can be

selected on the Edit Billing Information screen, which appears during the

Checkout procedure.

Long ISO
Enter the country’s ISO3166-1 alpha-3, three letter country code. See Also:

http://en.wikipedia.org/wiki/ISO_3166-1_alpha-3

Short ISO
Enter the country’s ISO3166-1 alpha-2, two letter country code. See Also:

http://en.wikipedia.org/wiki/ISO_3166-1_alpha-2

Editing a Country
Follow these steps to edit a country. See Also: "Countries" on page 17-47

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Configuration >

Countries.

2. Click the name of the country that you want to edit.

3. Click the Edit button ( ).
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4. Edit any of the fields, which are described in "Use the following table to complete the

screen." on page 17-48

Deleting a Country
Follow these steps to delete a country. See Also: "Countries" on page 17-47

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Configuration >

Countries.

2. Click the name of the country that you want to delete.

3. Click the Delete button ( ).

4. A confirmation message appears. Click OK.

5. The country is deleted.

Regions
The Regions screen lets you define geographic regions within countries that your eCommerce

site services. For example, in the United States of America, each state is a region.

Regions are used in the same way that countries are used. See Also: "How Countries are Used"

on page 17-47
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Default Regions

By default, the Regions screen includes all 50 United States of America, the District of

Columbia, and 9 Canadian Provinces.

See Also:

n "Creating a Region" on page 17-51

n "Editing a Region" on page 17-52

n "Deleting a Region" on page 17-53

Creating a Region
Prerequisite: The region’s country is defined in the Countries screen

To add a new region, follow these steps. See Also: "Regions" on page 17-50

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Configuration >

Regions.

2. Click New > Region.

3. Use the following table to complete the screen.
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Field Description

Name Enter the region’s name.

Enabled

Check this box if you want this region to be active. Only active regions can be

selected on the Edit Billing Information screen, which appearswhen site

visitors enter billing information during the Checkout procedure.

Code Enter an abbreviation for this region.

Country
Select this region’s country from the pull down list. If the country is not there,

exit this screen, and create the country using the Countries screen.

Add another

region to this

country?

This field saves the effort of selecting a countrywhen entering several regions

for one country.

To addmore regions for this country, check this boxand press the Save button

( ). When you do, the screen refreshes, and themost recently selected
country appears as the default.

Editing a Region
Follow these steps to edit a region. See Also: "Regions" on page 17-50
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1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Configuration >

Regions.

2. Click the name of the region that you want to edit.

3. Click the Edit button ( ).

4. Edit any of the fields, which are described in "Use the following table to complete the

screen." on page 17-51

Deleting a Region
Follow these steps to delete a region. See Also: "Regions" on page 17-50

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Configuration >

Regions.

2. Click the name of the region that you want to delete.

3. Click the Delete button ( ).

4. A confirmation message appears. Click OK.

5. The region is deleted.

Currencies
eCommerce supports all currencies. However, site visitors can only choose enabled currencies.

The Currency screen lets you enable and edit information for all installed currencies.

See Also:

n "Installed Currencies" on page 17-54
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n "The Default Currency" on page 17-55

n "How Currencies Are Used in the Currency Select Server Control " on page 17-56

n "How Exchange Rate Affects an Item’s Price" on page 17-57

n "Updating the Exchange Rate" on page 17-57

n "Editing a Currency" on page 17-58

n "Deleting a Currency" on page 17-59

n "CurrencySelect Server Control" on page 17-59

Installed Currencies
By default, Ektron CMS400.NET provides all currencies on the ISO 4217 currency names and

code elements list (http://www.iso.org/iso/support/faqs/faqs_widely_used_standards/widely_

used_standards_other/currency_codes/currency_codes_list-1.htm).

The following information is provided for each installed currency.

n name

n enabled (yes or no)

n numeric ISO code

n alpha ISO code

n exchange rate

Enabled Currencies
When users are setting prices in the Ektron CMS400.NET Workarea or site visitors are

shopping, they can only choose enabled currencies. When you install Ektron CMS400.NET,

the following currencies are enabled.

n U.S. dollar (the default currency. See Also: "The Default Currency" on page 17-55)

n Euro

n Australian dollar

TIP!

Note: To see which currencies (other than the default) are enabled, clickAction > Edit Exchange Rates from

the Currencies screen. Only non-default, enabled currenciesappear.

Warning! The Euro and Australian dollar are shipped with a default exchange rate.
If you will support these currencies, you should update the rate to its current value
before going live. See Also: "Updating the Exchange Rate" on page 17-57

To enable any installed currency, follow these steps.
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1. Click Ektron CMS400.NET Workarea > Settings > Commerce> Configuration >

Currencies.

2. Click the currency you want to enable.

TIP!

Note: Use the Search box to quickly find a currency.

3. The Edit Currency screen appears.

4. Check the Enabled check box.

5. Click Save .

The Default Currency
The default currency is the reference currency when setting the exchange rate on the Edit

Currency screen. For example, if the default is US dollars, USD appears on the left of the

exchange rate equation, as shown below.

The default currency is also used as the default choice in the Currency Selector server control,

and on the Pricing tab of the View/Edit Catalog Entry screen (shown below).
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See Also: "CurrencySelect Server Control" on page 17-59

Viewing and Changing the Default Currency
When you install Ektron CMS400.NET, the default currency is the Numeric ISO code for U.S.

dollars (Id 840). At that time, you can change this in the web.config file’s ek_ecom_

DefaultCurrencyId tag. However, once you set your default currency in web.config and begin

to deploy eCommerce, do not change it.

Warning! After your eCommerce feature goes live, do not change the ek_ecom_DefaultCurrencyId value in

web.config.

How Currencies Are Used in the Currency Select
Server Control
If your developer places a Currency Select server control on a page, a site visitor can use it to

select any enabled currency.

After a currency is selected, the prices on the page change to that currency. See Also: "How

Exchange Rate Affects an Item’s Price" on page 17-57
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From that point on, the cart and order use the selected currency. See Also: "CurrencySelect

Server Control" on page 17-59

How Exchange Rate Affects an Item’s Price
The Edit Currency screen lets you define an exchange rate between the default and any other

currency. See Also: "The Default Currency" on page 17-55; "Updating the Exchange Rate" on

page 17-57

The exchange rate can dynamically adjust prices when the rate changes. See Also: "Alternate

Currency Pricing" on page 17-141

Updating the Exchange Rate

Using the Ektron CMS400.NET API
The following Ektron API supports calling an exchange rate service to update rates

automatically: Ektron.Cms.Commerce.ExchangeRateApi. For more information, see the Ektron

CMS400.Net API documentation.

Using the Update Exchange Rates Screen
The Edit Exchange Rates screen lets you update the exchange rate for enabled currencies. See

Also: "How Exchange Rate Affects an Item’s Price" on page 17-57;"Currencies" on page 17-53

TIP!

Note: AgoodWeb site for finding exchange rates is http://www.xe.com/ucc/.

To use the screen, follow these steps.

1. In the Ektron CMS400.NET Workarea, go to Settings > Commerce > Configuration >

Currencies.

2. Click Action > Edit Exchange Rates.
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3. The Edit Exchange Rates screen appears, showing all enabled currencies and their

exchange rates.

4. Update rates as needed.

5. Click Action > Update.

Editing a Currency
Follow these steps to edit a currency. See Also: "Currencies" on page 17-53

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Configuration >

Currencies.

2. Click the currency you want to edit.

3. You can only edit the Name, Enabled, and Exchange Rate fields. All fields are described

below.

Field Description

Name Enter the currency’s name.

Numeric ISO

Code

The currency’s ISO4217 three-digit numeric ISOcode appears. See Also:

"Installed Currencies" on page 17-54

Alpha ISOCode
The country’s ISO4217 alphabetic, three-letter currency code appears. See

Also: "Installed Currencies" on page 17-54

Enabled
Check this box to enable this currency. See Also: "Enabled Currencies " on

page 17-54

Exchange Rate

Enter the exchange rate between this currencyand the default one. See

Also: "How Exchange Rate Affects an Item’sPrice" on page 17-57; "The

Default Currency" on page 17-55

4. Click the Save button ( ).
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Deleting a Currency
Follow these steps to delete a currency. See Also: "Currencies" on page 17-53

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Configuration >

Currencies.

2. Check the box next to the currency that you want to delete.

3. Click Action > Delete Selected.

4. A confirmation message appears. Click OK.

5. The currency is deleted.

CurrencySelect Server Control
Warning! In addition to reading this section on the CurrencySelect server controls,
Ektron strongly recommends reading "Currencies" on page 17-53.

The Currency server control allows site visitors to select the monetary type they will use to

make purchases. Once the site visitor selects his currency, all eCommerce server controls use it

for that order. If a site visitor closes the browser, the currency will need to be selected the next

time he visits the site.

For a currency to appear in the CurrencySelect server control, it must be enabled in the

CMS400.NET Workarea > Settings > Commerce > Currencies screen. To enable a currency,

click its name in the list and place a check in the enable checkbox. Next, click the Save

button ( ).

CurrencySelect Server Control Properties
The following table explains the properties of the CurrencySelect control.

CurrencySelect Server Control
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Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can

use it to browse to Content, Collections, etc. See Also:

”Using CMSExplorer to Browse Your Ektron

CMS400.NET Site” on page 21-12

String

CacheInterval

Sets the amount of time the server control’s data is

cached. The default is 0 (zero). This is the amount of time,

in seconds, a control’s data is cached. For example, if you

want to cache the data for fiveminutes, set the

CacheInterval property to 300 (three hundred). See

Also: ”Caching with Server Controls” on page 21-42

Double

CustomXml

(Code Behind Only)

Providesamechanism to inject custom XML into the

generated XML before being processed by the XSLT.

The injected XML is appended to the end of the XML

produced by this control.

See Also: ”Displaying CustomXML in Ektron’sServer

Controls” on page 21-49

String

DisplayXslt

Specify an externalXSLT file to render the control. By

default, the control usesCurrencySelect.xsl. This

file is located in

<Site Root>\Workarea\Xslt\Commerce

Important: If you want to edit this file, it is strongly

recommended that youmake a copy, change its name

andmove it outside your site’sWorkarea folder. If you

make changes to this file and do not move it out of the

Workarea folder, this file and the changeswill be lost

when you upgrade.

String

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

Language

Set a language for viewing the currency selection tool.

This property shows results in design-time (in Visual

Studio) and at run-time (in a browser).

Integer

Stylesheet

Specify the path to a style sheet for use with this server

control. The location can be relative or absolute. Leave

blank to use the default style sheet.

String
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Property Description
Data

Type

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the

control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

Payment Options
The Payment Options screen lets you determine which options are available for your customers

to pay for their purchases.

n PayPal - See Also: "PayPal Support" on page 17-61

n a Payment Gateway, such as AuthorizeNet - See Also: "Payment Gateway" on page 17-69

Both options can be enabled, but only one gateway can be enabled at a time.

PayPal Support
“PayPal is an eCommerce business allowing payments and money transfers to be made through

the Internet. PayPal serves as an electronic alternative to traditional paper methods such as

checks and money orders.

A PayPal account can be funded with an electronic debit from a bank account or by a credit

card. The recipient of a PayPal transfer can either request a check from PayPal, establish their

own PayPal deposit account or request a transfer to their bank account. PayPal is an example

of a payment intermediary service that facilitates worldwide e-commerce.” source: wikipedia

See Also:

n "Using PayPal with Ektron CMS400.NET’s eCommerce" on page 17-62

n "PayPal Documentation" on page 17-63

n "Enabling PayPal Support" on page 17-63

n "Customizing the PayPal Page" on page 17-68
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Using PayPal with Ektron CMS400.NET’s eCommerce
Your customers can use PayPal to pay for purchases from either of two points in the checkout

process

n the shopping cart screen

n the payment screen

If a site visitor accesses PayPal via the shopping cart screen, he follows these steps.

SeeChart

Here is the sequence illustrated above.

1. From the Cart screen, a site visitor clicks the PayPal button.

2. He logs into his PayPal account.

3. Information from that account is used to populate the default shipping and billing

addresses.

4. The site visitor can change addresses if needed.

Note: If the PayPal account address is used for the order, it is saved aspart of the site visitor’sEktron

CMS400.NET eCommerce account information.

5. Shipping costs are added.

6. The order is confirmed.
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7. Site visitor checks out via PayPal.

Alternatively, the site visitor can use the standard eCommerce checkout process, select PayPal

on the payment screen, and complete his order using the PayPal payment screen. That sequence

is illustrated below.

PayPal Documentation
Use the following resources to familiarize yourself with integrating PayPal into your

eCommerce site.

n PayPal Technical Documentation - https://cms.paypal.com/us/cgi-bin/?cmd=_render-

content&content_ID=developer/library_documentation

n PayPal Express Checkout Integration Guide - https://cms.paypal.com/cms_

content/ennuis/files/developer/PP_ExpressCheckout_IntegrationGuide.pdf

n Payflow ACH Payment Service Guide - https://cms.paypal.com/cms_content/US/en_

US/files/developer/PP_ACHPayment_Guide.pdf

Warning! An important PayPal requirement is to place the Paywith PayPal option on both the shopping cart and

payment screens.

Enabling PayPal Support
To enable PayPal support in Ektron CMS400.NET, follow these steps.
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n "Create a Sandbox Account" on page 17-64. This step includes updating Ektron

CMS400.NET’s web.config file.

n "Enable PayPal in the Ektron CMS400.NET Workarea" on page 17-68

Create a SandboxAccount

1. Sign on to http://www.sandbox.paypal.com.

2. Sign up for an account.

3. After a short while, you receive an email confirmation that directs you to another page.

4. Log in using the information you provided in Step 2.

5. Under Test Accounts, click Create a preconfigured buyer or seller account.

6. Create a buyer account. You will use this to test the customer experience.

TIP!

Note: Change the password to one you can easily remember.
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7. Click Home > Test Accounts > Create a preconfigured buyer or seller account.

8. This time, click Account Type Seller.

9. Create a seller account. You will use this to test the merchant experience.

TIP!

Note: Change the default password to one that you can easily remember.

10. In the upper left corner of the screen, click API Credentials.

11. Open your siteroot/web.config file.

12. Copy the following values from the API Credentials screen into the web config’s

providers/paypal element. Save web.config.

PayPal Test Account Value web.config PayPal Element

API Username PayPalUser

Payment Options

ReferenceManual

Version 8.0 Rev 1.3
17-65



PayPal Test Account Value web.config PayPal Element

API Password PayPalPwd

Signature PayPalSignature

The following illustration shows the PayPal API Username copied into the web.config

file’s PayPalUser property.

If you want to encrypt these values, see "Encrypting PayPal Authentication Values" on page

17-66.

Encrypting PayPal Authentication Values

Follow these steps to encrypt the following values in the web.config file’s providers/paypal

element.

n PayPalUser

n PayPalPwd (password)

n PayPalSignature

1. Open the site root/web.config file.

2. Set the AuthValuesEncrypted element to true.
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3. Save and close web.config.

4. Open C:\Program Files\Ektron\CMS400v8x\Utilities.

5. Run EncryptEmailPassword.exe.

6. The Encrypt Utility dialog appears.

7. Enter the PayPal user name into the Text field.

8. Click the Encrypt button.

9. The screen displays encrypted text in the Encrypted field.

10. Copy the encrypted text and paste it into the web.config file’s PayPalUser element value.

11. Repeat Steps 7 through 10 for PayPalPwd and PayPalSignature.

Test the SandboxAccount

After creating a sandbox account, you should test it.

1. Sign into the Developer Sample site > eCommerce > Cart.

2. Click the PayPal button.
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3. Enter the buyer account user name and password that you created in "Create a Sandbox

Account" on page 17-64.

4. You proceed to the Ektron CMS400.NET Checkout screen.

After completing these steps, you have verified your PayPal buyer experience.

Enable PayPal in the Ektron CMS400.NETWorkarea

To enable PayPal in the Ektron CMS400.NET Workarea, follow these steps.

1. Ektron CMS400.NETWorkarea > Settings > Commerce > Configuration > Payment

Options.

2. Click Action > Edit Payment options.

3. Check PayPal.

4. Click the Save button ( ).

Customizing the PayPal Page
If you are using Ektron CMS400.NET’s sample site and PayPal is enabled, the login screen

contains an Ektron logo for demonstration purposes.
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You can replace the logo using the following property of the web config’s providers/add

name=”PayPal” element.

To change the logo, change the referenced image.

To learn how to customize other aspects of the page, see PayPal’s “Express Checkout

Integration Guide” section “PayPal Page Style.” (https://cms.paypal.com/cms_content/en_

US/files/developer/PP_ExpressCheckout_IntegrationGuide.pdf)

When setting values in the web.config’s providers/add name=” PayPal” element, prefix any

variable with apiparam. For example, to set the header background color, enter

apiparamHDRBACKCOLOR=”FFF666”.

Payment Gateway
A payment gateway is a “service that automates the payment transaction between a shopper

and merchant. It is usually a third-party service that processes, verifies, and accepts or declines

credit card transactions or checks on behalf of the merchant through secure Internet

connections.” (source: webopedia)
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Ektron CMS400.NET provides two standard payment gateways authorize.net and Payflow,

along with manual. The manual gateway accepts all credit cards. In this case, the merchant

emails the credit card information to the credit card company.

Note: For details on implementing a custom payment gatewayprovider, see "Customizing the Payment Gateway

Provider" on page 17-273

Within Ektron CMS400.NET, a gateway can support credit cards, checks, or both, depending

on how you implement it.

Ektron CMS400.NET lets you edit information on any provided gateway as well as create a

new one.

See Also:

n "How a Payment Gateway Works" on page 17-70

n "The Default Gateway" on page 17-72

n "Adding a Payment Gateway" on page 17-72

n "Editing a Payment Gateway" on page 17-73

n "Deleting a Payment Gateway" on page 17-73

n "Check Support" on page 17-74

n "Credit Card Types" on page 17-77

n "PayPal Support" on page 17-61

How a Payment Gateway Works

Processing Credit Card Transactions
The following sequence explains how credit card transactions are typically processed. (source:
www.authorize.net)

1. The payment gateway provider (PGP) receives secure transaction information and passes it

via secure connection to the Merchant Bank’s Processor.

2. The Merchant Bank’s Processor submits the transaction to the Credit Card Interchange (a

network of financial entities that manage credit card transactions).

3. The Credit Card Interchange sends the transaction to the customer’s Credit Card Issuer.

4. The Credit Card Issuer approves or declines the transaction, based on the customer’s

available funds. It then passes the transaction results and, if approved, the appropriate

funds back through the Credit Card Interchange.

5. The Credit Card Interchange relays the transaction results to the Merchant Bank’s

Processor.

6. The Merchant Bank’s Processor relays the transaction results to PGP.
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7. The PGP stores transaction results and sends them to the customer and/or the merchant.

This communication process averages three seconds or less.

8. The Credit Card Interchange passes the transaction’s funds from the Credit Card Issuer to

the merchant’s bank account.

Processing Check Transactions
The following sequence explains how a payment gateway processes checks. (source:
www.authorize.net)

1. Customer authorizes merchant to charge his bank account for an amount.

2. Order and payment information is securely transmitted via the Internet to the payment

gateway.

3. The transaction is accepted or rejected based on initial data validation and security criteria

defined by the payment gateway.

4. If accepted, the transaction is sent to the ACH Network for settlement.

5. The ACH Network uses the transaction’s bank account information to determine the bank

that holds the customer’s account (the RDFI).

6. The ACH Network instructs the RDFI to charge or refund the customer’s account.

7. The RDFI transfers funds from the customer’s account to the ACH Network. The RDFI

also notifies the ACH Network of any returns (if funds could not be collected from the

customer’s bank account) or charge backs (if a customer disputes a purchase).

8. The ACH Network transfers funds for the transaction to the payment gateway’s bank.

9. After a holding period, the payment gateway provider initiates a ACH transaction that

deposits the funds into the merchant’s bank account.

Establishing a Relationship with a Payment Gateway
Provider
You need to set up an account with a third-party payment service before using a payment

provider. This includes payment providers such as Authorize.NET and PayFlow, which are

included with CMS400.NET’s eCommerce Module.

To do this with Authorize.Net, go to

http://www.authorize.net/solutions/merchantsolutions/onlinemerchantaccount/.

To set up an account with PayFlow, go to https://www.paypal.com/cgi-bin/webscr?cmd=_

payflow-gateway-overview-outside.

Each payment gateway provider accepts configuration parameters. For example, Authorize.NET

requires a username and password, while PayFlow requires a Username, password, vendor, and

partner.
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In addition, some payment gateways do not support subscription payments. This is something

to consider if your site relies on subscriptions. See Also: "Creating a Subscription" on page 17-

119

The Default Gateway
The eCommerce checkout process only uses the default gateway. Additional gateways are

unused unless one is changed to be the default.

You cannot delete the default gateway. If you want to delete it, you must first make another

gateway the default.

To change the default gateway, follow these steps.

1. Go to Settings > Commerce > Configuration > Payment Options.

2. The currently-defined default has a check in the Default column.

3. Click the radio button to the left of the gateway you want to make the default.

4. Click Action > Mark as Default.

5. A confirmation message appears. Click OK.

Adding a Payment Gateway

Note: To learn how to create a new payment gatewayprovider, see "Customizing the Payment Gateway

Provider" on page 17-273.

To add a new payment gateway to Ektron CMS400.NET, follow these steps. See Also:

"Payment Options" on page 17-61

1. In Ektron CMS400.NET, go to Settings > Commerce > Configuration > Payment

Options.

2. Click New > Payment Gateway.

3. Use the following table to complete the screen.
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Field Description

Name Enter the name of the gateway.

Default

Check this box if this is the default gateway. If you do, and another gateway is

currently the default, it is replaced by this one. See Also: "The Default Gateway" on

page 17-72

User ID Enter your User ID. This ID will identify your account with this gatewayprovider.

Password Enter the password for your account with this gatewayprovider.

Expand

Custom

Values

If this gatewayprovider needsadditional fields of information, enter those values

into theCustom 1 andCustom 2 fields.

Credit

Cards
Check if this payment gatewayaccepts credit cards.

Checks Check if this payment gatewayaccepts checks.

Editing a Payment Gateway
Follow these steps to edit a payment gateway. See Also: "Payment Options" on page 17-61

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Configuration >

Payment Options.

2. Click the payment gateway that you want to edit.

3. Click the Edit button ( ).

4. Edit any of the fields, which are described in "Use the following table to complete the

screen." on page 17-72.

5. Click the Save button ( ).

Deleting a Payment Gateway
Follow these steps to delete a payment gateway.

Note: The default gatewaycannot be deleted. If you want to delete it, youmust first make another gateway the

default.

See Also: "Payment Options" on page 17-61

Payment Options

ReferenceManual

Version 8.0 Rev 1.3
17-73



1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Configuration >

Payment Options.

2. Click the payment gateway that you want to delete.

3. Click the Delete button ( ).

4. A confirmation message appears. Click OK.

5. The payment gateway is deleted.

Check Support
Payment gateways generally offer two payment mechanisms: credit cards and checks. You can

enable or disable check support for a gateway via the Settings > Commerce > Configuration

> Payment options > Edit Payment Gateway screen (shown below).

When checks are enabled for the default payment gateway, a site visitor can choose to pay by

Check on the payment screen. If check support is not enabled, the Payment Method field does

not appear.
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Check Support Integration Documentation
Use the following resources to familiarize yourself with integrating checks into your

eCommerce site.

n Authorize.Net

http://www.authorize.net/files/echecknetuserguide.pdf

n PayFlow

https://cms.paypal.com/cms_content/US/en_US/files/developer/PP_PayflowLink_Guide.pdf

See the chapter “Integrating TeleCheck Transactions.”

Effect of Check Payment on Order Processing
The following describes a typical sequence of events when processing a check for eCommerce

payment.

However, Ektron CMS400.NET is very flexible and does not enforce this sequence. For

example, you can enter a tracking number and mark an order shipped even though its payment

has not been captured yet.

1. eCommerce user accesses the View Payment screen’s Capture option, which submits a

payment request to the customer’s bank.
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2. A few days later, the funds are transferred to the merchant’s account.

3. The eCommerce user accesses the View Payment screen’sMark as Settled option to

confirm that the funds have been received.

4. If the goods are tangible

The eCommerce user ships the merchandise, using the View Payment screen’s Enter

Tracking Number option to insert the tracking number and confirm the shipment.

eCommerce

17-76
ReferenceManual

Version 8.0 Rev 1.3



If the goods are not tangible

The workflow sends the customer an email with details about the purchase, such as how

to download it.

Credit Card Types
Use this screen to enter all types of credit cards that your eCommerce system may use. By

default, Ektron CMS400.NET’s developer sample site provides the following card types.

n American Express

n Diners Club (not accepted by default)

n Discover

n MasterCard

n Visa

You can edit the information provided for these types or enter a new one.

See Also:

n "Where Credit Card Types are Used" on page 17-78

n "Creating a Credit Card Type" on page 17-78

n "Editing a Credit Card Type" on page 17-80

n "Deleting a Credit Card Type" on page 17-80
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Where Credit Card Types are Used
During the checkout process (managed by the Checkout server control), screen 5 (Submit

Order) has a dropdown list of all enabled credit cards. See below.

Creating a Credit Card Type
To create a new credit card within Ektron CMS400.NET, follow these steps.

1. In Ektron CMS400.NET, go to Settings > Commerce > Configuration > Credit Card.

2. Click New > Credit Card to see the Add Card Type screen.
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3. Use the following table to complete the screen.

Field Description

Name Enter the credit card’s name.

Accepted

Check this box if site visitors can use this card tomake purchaseson your Web site.

OnlyAccepted cardsappears in the Checkout procedure >Submit Order screen’s

Credit Card Type dropdown, as shown below.

Image

Use this field to specify an image for the credit card.

The image doesnot appear on the standard checkout screen. But it is a field in the

XML, so you can enable it using an XSLT.

Adding or Changing the Image

If you are entering a new credit card image or editing an existing one, follow these

steps.

Prerequisite: The image resideson your computer.

1. ClickChange.

2. The LibraryUpload screen appears.

3. Click the Add button ( ).

4. ClickBrowse and navigate to the folder that contains the image.

5. Choose the image.

6. Assign a Title.

7. Click the Add Library button ( ).

8. The image appears on the screen.
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Field Description

Regex

ARegexexpression is a simple way to validate a credit card account number. (See

Also: http://regexlib.com/.) Validation occurswhen a site visitor completes the

Checkout procedure’sSubmit Order screen, as shown below.

Regexprevents the submission of invalid account numbers to a payment gateway,

whichmaycharge a fee for such failures.

Ektron CMS400.NET providesasRegexexpression for the credit cards supplied

with medical sample site. You canmodify them asneeded. If you enter a new credit

card, you can enter a Regexexpression for it.

Editing a Credit Card Type
Follow these steps to edit a Credit Card Type. See Also: "Credit Card Types" on page 17-77

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Configuration > Credit

Card.

2. Click the Credit Card Type that you want to edit.

3. Click the Edit button ( ).

4. Edit any of the fields, which are described in "Use the following table to complete the

screen." on page 17-79.

5. Click the Save button ( ).

Deleting a Credit Card Type
Follow these steps to delete a Credit Card Type. See Also: "Credit Card Types" on page 17-77

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Configuration > Credit

Card.

2. Click the Credit Card Type that you want to delete.

3. Click the Delete button ( ).
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4. A confirmation message appears. Click OK.

5. The Credit Card Type is deleted.

Messages
Ektron’s eCommerce feature provides a messaging feature that can notify a purchaser when

these events occur:

n Order is submitted

n Order is cancelled

n Order is shipped

Each message has a unique type that corresponds to an event. The message types are

n OrderReceived

n OrderCancelled

n Order Shipped

You can create any number of messages for each event, assigning one as the default. Only the

default message is sent when the corresponding event occurs.

Here is a sample message as set up within Ektron CMS400.NET.
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Here is the same message as delivered to a recipient’s inbox.

See Also:

n "How Messages are Created and Generated" on page 17-82

n "Creating or Editing an eCommerce Message" on page 17-83

How Messages are Created and Generated
Ektron CMS400.NET provides sample text for each type of message. To view and edit a

message, go to Ektron CMS400.NET Workarea > Settings > Commerce > Configuration >

Messages.
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The Message Type determines the event that causes a message to be sent. For example, the

Orderreceived message is sent to a purchaser when he submits an order.

If regular content notification emails are being generated, the site visitor provided a valid

email address, and a message has been defined for the event, emails are sent as eCommerce

events occur. No additional set up is required.

Note: eCommercemessagesare distributed in the sameway that content notification emails are. For information

on setting this up, see ”Configuring E-Mail for Tasksand Content” on page 1-109.

Creating or Editing an eCommerce Message
1. Go to Workarea > Settings > Commerce > Configuration > Messages.

2. If a message of the type you want to create already exists, select it. Otherwise, click the

Add Message button ( ).

3. Assign a Title, Subject (for the email subject line), Message Type, and message text.

Message Variables
eCommerce message text can use the following variables to retrieve order information from the

database into the message text.

Variable Description

@CustomerFirstName@ Customer’s first name

@CustomerLastName@ Customer’s last name

@OrderId@ The order’s ID number

@OrderSubTotal@
The order’s subtotal, that is the amount of all ordered itemsprior to

shipping costs, taxes, and coupon discounts
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Variable Description

@OrderTotal@
The order’s final cost (which includes taxes, shipping, and coupon

discounts)

@OrderShippingTotal@ The order’s shipping cost

@OrderCouponTotal@ The order’s coupon discounts

@OrderTaxTotal@ The order’s tax amount

@OrderItemTitle@ The title of any item on the order

@OrderItemSalePrice@ The sale price of any item on the order

@OrderItemQuantity@ The quantity of any item on the order

@OrderItemTotal@
The total cost of one item. For example, if orderItemSalePrice=

$10 and orderItemQuantity=2, orderItemTotal=$20.

@OrderItemStart@ and

@OrderItemEnd@

Use the start and endmarkers to show information for all ordered

items.

Themarkers show no information by themselves. Instead, they

repeat the variables between them for every item on the order.

So, for example, assume an order has10 items, and your message

looks like this:

@OrderItemStart@

@OrderItemTitle@

@OrderItemQuantity@

@OrderItemSalePrice@

@OrderItemTotal@

@OrderItemEnd@

Themessage prints the title, quantity, sale price, and total for each

item on the order.

@TrackingUrl@
The link to aWeb page that tracks your package. It is usually a

combination of the shipper’sURL and the tracking number.
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eCommerce Shipping Screens

n "Warehouse" on page 17-85

n "Packages" on page 17-87

n "Shipping Methods" on page 17-90

Warehouse
Use the Warehouses screen to enter information about warehouses that stock your catalog

entries. eCommerce uses this location to determine the “from” address when calculating

shipping costs.

Only the default warehouse is used by the checkout process. Additional warehouses are

unused until they are made the default. See Also: "Changing the Default Warehouse" on page

17-86

Prerequisite: Regions and countries must be set up. See Also: "Regions" on page 17-50

See Also:

n "Creating a Warehouse" on page 17-85

n "Changing the Default Warehouse" on page 17-86

n "Editing a Warehouse" on page 17-87

n "Deleting a Warehouse" on page 17-87

Creating a Warehouse
To create a new warehouse within Ektron CMS400.NET, follow these steps. See Also:

"Warehouse" on page 17-85

1. In Ektron CMS400.NET, go to Settings > Commerce > Shipping > Warehouses.
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2. Click New > Warehouse.

3. Use the following table to complete the screen.

Field Description

Name Enter the warehouse’s name.

Street1, Street2 Enter the warehouse’s street address.

City Enter the warehouse’s city.

PostalCode Enter the warehouse’s postal code.

Country Select the warehouse’s country from the pull-down list.

State/Province Select the warehouse’s state or province from the pull-down list.

Default Warehouse

This box indicates if this is the default warehouse. If you want to make this

warehouse the default, use theMarkasDefault toolbar button (

Only the default warehouse is used by the checkout process. Additional

warehousesare unused until theyaremade the default.

4. Click the Save button ( ).

Changing the Default Warehouse
To change the default warehouse, follow these steps.

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Shipping > Warehouses.

2. Click the radio button next to the warehouse that you want to make the default.

3. Click Action > Mark Default Warehouse.

Note: You can also specify a warehouse as the default via the EditWarehouse screen’sMark Default

Warehouse toolbar button .

4. A confirmation dialog appears. Click OK.
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Editing a Warehouse
Follow these steps to edit a warehouse. See Also: "Warehouse" on page 17-85

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Shipping >

Warehouses.

2. Click the warehouse that you want to edit.

3. Click the Edit button ( ).

4. Edit any of the fields, which are described in "Use the following table to complete the

screen." on page 17-86.

5. Click the Save button ( ).

Deleting a Warehouse
Follow these steps to delete a warehouse. See Also: "Warehouse" on page 17-85

Note: You cannot delete the default warehouse. However, you can designate another warehouse as the default,

then delete the one that was the default. See Also: "Changing the DefaultWarehouse" on page 17-86

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Shipping > Warehouse.

2. Click the warehouse that you want to delete.

3. Click the Delete button ( ).

4. A confirmation message appears. Click OK.

5. The warehouse is deleted.

Packages
The Packages screen lets you define standard sizes of packaging. Use it to define every

package size that your shipping department uses to ship your products.

If you use a provider such as UPS® or FedEx®, it is likely they provide boxes.
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How Packaging Information Is Used

Each item in an order has size and weight dimensions. The shipping calculator uses this

information to fit the order into the smallest-sized and fewest packages. It then passes

packaging information (number, sizes and weight) to the shipping provider, which returns the

order’s shipping costs.

If a catalog entry’s dimensions exceed all box sizes, eCommerce passes that product’s

dimensions to the shipping provider.

Note: Some shipping providers, FedExand UPS for example, have limits on the size &weight of packages they

are willing to ship. If the size or weight exceeds their limits, shipping ratesmaynot be returned when a site visitor is

going through the checkout process. If shipping ratesare not returned during checkout, an Application error is

logged in the Event Viewer. This preventsa site visitor from continuing the checkout process.

See Also:

n "Size and Weight Units of Measure" on page 17-88

n "Creating a New Package" on page 17-88

n "Editing a Package" on page 17-89

n "Deleting a Package" on page 17-89

Size and Weight Units of Measure
Packages use size and weight measurements. By default, Ektron CMS400.NET uses English

units of measure (inches and pounds). At the beginning of your eCommerce implementation,

you can change to metric units of measure by updating the web.config file’s ek_

measurementsystem tag value to metric.

Warning! After your eCommerce feature goes live, do not change the ek_measurementsystem value in web.co-

nfig.

Creating a New Package
To create a new package, follow these steps. See Also: "Packages" on page 17-87

1. Go to Settings > Commerce > Shipping > Packages.

2. Click New > Package.

3. Use the following table to complete the screen.
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Field Description

Name Enter a text description of this package size.

Length
Enter the package’s length in the units of measure that appear to the right (inchesor

centimeters). See Also: "Size andWeight Units of Measure" on page 17-88

Height
Enter the package’s height in the units of measure that appear to the right (inchesor

centimeters).

Width
Enter the package’swidth in the units of measure that appear to the right (inchesor

centimeters).

Max

Weight

Enter the package’sweight in the units of measure that appear to the right (poundsor

kilograms).

4. Click the Save button ( ).

Editing a Package
Follow these steps to edit a package. See Also: "Packages" on page 17-87

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Shipping > Packages.

2. Click the package that you want to edit.

3. Click the Edit button ( ).

4. Edit any of the fields, which are described in "Use the following table to complete the

screen." on page 17-88.

5. Click the Save button ( ).

Deleting a Package
Follow these steps to delete a package. See Also: "Packages" on page 17-87

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Shipping > Packages.

2. Click the package that you want to delete.

3. Click the Delete button ( ).

4. A confirmation message appears. Click OK.

5. The package is deleted.
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Shipping Methods
Use the Shipping Methods to define all choices your site visitors will have for delivering their

purchases.

Prerequisites:

n Default warehouse with an address

n A default shipping provider is defined in the siteroot\shipment.config file

See Also:

n "Defining Shipping Providers" on page 17-90

n "Defining a Custom Shipping Provider" on page 17-91

n "Defining the Default Shipping Provider" on page 17-91

n "Adding a Shipping Method" on page 17-92

n "Editing a Shipping Method" on page 17-93

n "Deleting a Shipping Method" on page 17-93

n "Changing the Order of the Shipping Method" on page 17-93

Defining Shipping Providers
When you install Ektron CMS400.NET, several providers exist in the

siteroot\shipment.config file:

n FedExShipmentProvider

n FlatRateShipmentProvider

n UPSShipmentProvider
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However, the FedEx and UPS information is for testing purposes only. In order to use FedEx,

UPS or another shipping provider, obtain the following information from them.

n service URL

n key

n password

n account number

n meter number

n transactionId

Note: The above list can vary slightly for each provider.

Then, enter that information into shipment.config, following the format of providers already in

the file.

The shipment.config file also contains name and type properties for each provider (shown in

red below).

name="FedExShipmentProvider" type="Ektron.Cms.Commerce.Shipment.Services.FedEx-

ShipmentProvider, Ektron.Cms.Commerce"

The red text that you insert (above) is not important, but the two strings must match.

Defining a Custom Shipping Provider
See "Customizing the Shipment Provider" on page 17-281.

Defining the Default Shipping Provider
While you can define any number of shipping providers in the shipment.config file, only one

can be active. The active provider appears on the Settings > Commerce > Shipping >

Methods > New > Shipping Method screen when you click View Options.
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Specify the default (active) shipping provider via the defaultprovider property (highlighted in

red below) in siteroot\shipment.config.

<?xml version="1.0" encoding="utf-8" ?>

<shipmentProvider defaultProvider="FedExShipmentProvider">

<providers>

<add name="FedExShipmentProvider" .

.

.</shipmentProvider>

Adding a Shipping Method
Use the Add Shipping Method screens to select shipping methods you will support. When a

site visitor submits an order, these shipping choices appear on the Shipping screen. See Also:

"Shipping Methods" on page 17-90

To add shipping methods, follow these steps.

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Shipping > Methods.

2. Click New > Shipping Method.

3. The Add Shipping Method screen appears.

4. Use the following table to complete the screen.

Field Description

Name

Enter the name of the shippingmethod. Site visitors select a shippingmethod

for their order using this name (see example below).

Tip! First clickView Options and select a shippingmethod. Then enter its
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Field Description

name here.

Active Check this box if you want site visitors to be able to select this shippingmethod.

Provider

Service

Asexplained in "Defining the Default Shipping Provider" on page 17-91, a

default shipping provider is defined in your site’s shipment.config file. To view all

methodsoffered by that provider, clickView Options. Then, select from the

dropdown list that appears.

Editing a Shipping Method
See Also: "Shipping Methods" on page 17-90

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Shipping > Methods.

2. Click the Shipping Method that you want to edit.

3. The View Shipping Method screen appears.

4. Click the Edit button ( ).

5. See "Use the following table to complete the screen." on page 17-92.

Deleting a Shipping Method
See Also: "Shipping Methods" on page 17-90

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Shipping > Methods.

2. Click the Shipping Method that you want to edit.

3. The View Shipping Method screen appears.

4. Click the Delete button ( ).

Changing the Order of the Shipping Method
Each shipping method you define has an Order field. This determines the sequence in which

shipping methods appear on the Shipping Rates screen when a site visitor is submitting an

order.

The shipping method with 1 in the Order field appears at the top of the list.

By default, every shipping method’s order is set to 1. To set a sequence for shipping methods,

follow these steps

See Also: "Shipping Methods" on page 17-90

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Shipping > Methods.
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2. Click Action > Reorder.

3. Use the selection bar and arrows to arrange methods in the desired sequence.

4. Click Action > Save.
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eCommerce Tax Screens

eCommerce provides a set of tax screens in the Ektron CMS400.NET Workarea that lets you

n set up tax classes (for example, goods, services, tobacco)

n define tax rates for these geographic entities (from most to least specific)

- postal code

- region

- country

See Also:

n "How an Order’s Tax Amount is Calculated" on page 17-95

n "The Tax Class Screens" on page 17-97

n "Postal Tax Tables" on page 17-99

n "Regional Tax Tables" on page 17-101

n "Country Tax Tables" on page 17-103

How an Order’s Tax Amount is
Calculated
During checkout, Ektron CMS400.NET tries to find a tax rate for each catalog entry’s Tax

Class (shown below) and the shipping address’s postal code.
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The following table describes what happens next.

Ektron CMS400.NET

checks for this tax

If it finds a tax rate for

geographic entity

If it does not find a tax rate

for geographic entity

1. Postal code

It adds that amount and

stops.

For example

n an item costs $100.00

n the postal code tax

rate = 5%

n the adjusted cost is

$105.00

It checks the customer’s address

for a regional tax code.

2. Region

It adds that amount and

stops.

For example

n an item costs $100.00

n the regional tax rate =

7%

n the adjusted cost is

$107.00

It checks the customer’s address

for a country tax code.

3. Country

It adds that amount.

For example

n an item costs $100.00

n the country tax rate =

No tax is added to the order.
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Ektron CMS400.NET

checks for this tax

If it finds a tax rate for

geographic entity

If it does not find a tax rate

for geographic entity

10%

n the adjusted cost is

$110.00

TIP!

Note: If a postal zone has several taxes (for example, a local tax and a regional tax), build the combined

percentage into the postal code tax. So, assumeNew YorkCity hasa 4%tax, and New York state hasa 3%tax. In

this case, enter a combined total of 7% into all postal zoneswithin New YorkCity. See Also: "The TaxClass

Screens" on page 17-97

The Tax Class Screens
Use the Tax Class screen to define all classes of catalog entries that can be taxed. When you

install eCommerce, the following tax classes are installed.

n alcohol

n goods

n service

n tobacco

You can modify or delete these, and add new classes at any time.

You assign a tax class to a catalog entry via its Properties tab’s Tax Class field (shown

below).
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See Also:

n "How an Order’s Tax Amount is Calculated" on page 17-95

n "eCommerce Tax Screens" on page 17-95

n "Creating a New Tax Class" on page 17-98

n "Editing a Tax Class" on page 17-99

n "Deleting a Tax Class" on page 17-99

Creating a New Tax Class
To create a new tax class, follow these steps. See Also: "The Tax Class Screens" on page 17-97

1. Go to Settings > Commerce > Tax > Classes.

2. Click New > Tax Class.

3. Enter the name of the tax class.

4. Press the Save button ( ).
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Editing a Tax Class
To edit a tax class, follow these steps. See Also: "The Tax Class Screens" on page 17-97

1. Go to Settings > Commerce > Tax > Classes.

2. Click the Tax Class that you want to edit.

3. Click the Edit button ( ).

4. Edit the name of the tax class.

5. Press the Save button ( ).

Deleting a Tax Class
Warning! If a tax classhasbeen assigned to a catalog entry that appears on anyorder, the Delete button does

not appear.

To delete a tax class, follow these steps.

1. Go to Settings > Commerce > Tax > Classes.

2. Click the Tax Class that you want to delete.

3. Click the Delete button ( ).

4. A confirmation message appears. Click OK.

5. The Tax Class is deleted.

Postal Tax Tables
Use postal code tax tables to identify local areas (cities, counties, etc.) that apply taxes to

eCommerce catalog entries. The areas are identified by their postal code. For example, London,

England taxes alcohol delivered to addresses within it.

You only need to create a postal tax table if the area that applies the tax is smaller than a

country’s geographical regions (states, provinces, etc.). If an entire region applies a tax, use a

regional tax table.

See Also:

n "How an Order’s Tax Amount is Calculated" on page 17-95

n "eCommerce Tax Screens" on page 17-95

n "Creating a New Postal Code Tax Table" on page 17-100

n "Editing a Postal Code Tax Table" on page 17-101

n "Deleting a Postal Code Tax Table" on page 17-101
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Creating a New Postal Code Tax Table
Prerequisite: The postal code’s country and region are defined in the Regions and Countries

screens

To create a new postal code tax table, follow these steps. See Also: "Postal Tax Tables" on

page 17-99

1. Go to Settings > Commerce > Tax > Postal Tax Tables.

2. Click New > Postal Code.

3. Use the following table to complete the screens.

Field Description

PostalCode
Enter the postal code for which you want to enter a tax rate. If this is for a US

state, the codemust consist of five or nine digits.

Country Enter the country in which the postal code resides.

Region
Enter the geographic region (for example, state or province) in which the postal

code resides.
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Field Description

TaxRates:

Alcohol

Goods

Services

Tobacco

Note: Your

list may

vary.

For any tax class, enter a tax rate asa whole number. For example, if the tax is

7%, enter 7. See Also: "The TaxClassScreens" on page 17-97

4. Press the Save button ( ).

Editing a Postal Code Tax Table
To edit a postal code tax table, follow these steps. See Also: "Postal Tax Tables" on page 17-

99

1. Go to Settings > Commerce > Tax > Postal Tax Tables.

2. Click the ID of the tax table that you want to edit.

3. Click the Edit button ( ).

4. Edit the fields as needed. See "Use the following table to complete the screens." on page

17-100

5. Press the Save button ( ).

Deleting a Postal Code Tax Table
To delete a postal code tax table, follow these steps.

1. Go to Settings > Commerce > Tax > Postal Tax Tables.

2. Click the ID of the tax table that you want to delete.

3. Click the Delete button ( ).

4. A confirmation message appears. Click OK.

5. The postal code tax table is deleted.
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Regional Tax Tables
Use regional tax tables to identify regions (states, provinces, etc.) that apply taxes to

eCommerce catalog entries. For example, within the United States of America, the state of New

Jersey applies a 5% tax on goods purchased on the internet and shipped to it.

You only need to define a regional tax table if the area that applies the tax is smaller than a

country. If an entire country applies a tax, use a country tax table.

See Also:

n "Regional Tax Tables" on page 17-101

n "eCommerce Tax Screens" on page 17-95

n "Editing a Regional Tax Table" on page 17-102

n "Deleting a Regional Tax Table" on page 17-103

Editing a Regional Tax Table
A regional tax table is automatically created for every existing region. By default, all tax rates

are zero (0). To change any tax rate, follow these steps. See Also: "Regional Tax Tables" on

page 17-101

1. Go to Settings > Commerce > Tax > Regional Tax Tables.

2. Click on the name of the region for which you want to set tax rates.

3. The View Region Tax Rate screen appears.

4. Click the link that says “Click here to edit the tax rates”.
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5. Click the Edit button ( ).

6. Use the following table to complete the screen.

Field Description

Name Select the region for which you want to enter a tax rate.

TaxRates:

Alcohol

Goods

Services

Tobacco

Note: Your list may

vary.

For any tax class, enter a tax rate. See Also: "Regional TaxTables" on

page 17-101

7. Press the Save button ( ).

Deleting a Regional Tax Table
To delete a regional tax table, follow these steps.

1. Go to Settings> Commerce > Tax > Regional Tax Tables.

2. Click the ID of the tax table that you want to delete.

3. Click the Delete button ( ).

4. A confirmation message appears. Click OK.

5. The regional tax table is deleted.
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Country Tax Tables
Use country tax tables to identify nations that apply taxes to eCommerce catalog entries. For

example, Ethiopia applies a 5% tax on goods purchased on the internet and shipped to it.

See Also:

n "How an Order’s Tax Amount is Calculated" on page 17-95

n "eCommerce Tax Screens" on page 17-95

n "Editing a Country Tax Table" on page 17-104

n "Deleting a Country Tax Table" on page 17-105

Editing a Country Tax Table
A country tax table is automatically created for every existing country. By default, all tax rates

are zero (0). To change any country tax rate, follow these steps. See Also: "Country Tax

Tables" on page 17-103

1. Go to Workarea > Settings > Commerce > Tax > Country Tax Tables.

2. Select the country for which you want to edit a tax table.

3. The View Country Tax Rate screen appears.

4. Click the link that says “Click here to edit the tax rates”.

5. Click the Edit button ( ).
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6. Use the following table to complete the screen.

Field Description

Name Select the country for which you want to enter a tax rate.

TaxRates:

Alcohol

Goods

Services

Tobacco

Note: Your list may

vary.

For any tax class, enter a tax rate. See Also: "The TaxClassScreens" on

page 17-97

7. Press the Save button ( ).

Deleting a Country Tax Table
To delete a country tax table, follow these steps.

1. Go to Workarea > Settings > Commerce> Tax > Country Tax Tables.

2. Click the ID of the tax table that you want to delete.

3. Click the Delete button ( ).

4. A confirmation message appears. Click OK.

5. The country tax table is deleted.
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eCommerce Products

As mentioned in "Steps to Set Up a Basic eCommerce Web Site" on page 17-29, you typically

set up configuration screens before you build eCommerce products. Next, you build the

products in the sequence listed below

1. "Product Types" on page 17-106

2. "Creating a Catalog Folder" on page 17-126

3. "Creating a Catalog Entry" on page 17-128

See Also:

n "eCommerce Analytics" on page 17-188

n "eCommerce Recommendations" on page 17-188

Product Types
Create a separate product type definition for each category of catalog entries that you sell. For

example, you might have a product type for movies, another for books, a third for electronics,

etc.

When thinking about creating new product types, the most significant differences are the Class

field (described below) and the content page, which defines the XML Smart Form for products

you will create of a Product Type.

See Also:

n "Product Classes" on page 17-106

n "How Product Types Affect the Creation of Catalog Entries" on page 17-107

n "Creating a Product Type Step 1: Properties, Attributes & Media Defaults" on page 17-108

n "Creating a Product Type Step 2: Creating the Content Page" on page 17-124

n "Deleting a Product Type" on page 17-126

Product Classes
A catalog entry’s product class affects site visitors’ purchasing options. Classes are explained

below.
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Class Description Example

Kit

Let a site visitor select from anynumber of

free-text options. Options can increase or

decrease the overall price. See Also:

"Creating a Kit" on page 17-113

A computer whose price

changesasa site visitor

selectsRAM, hard drive,

monitor, etc.

Bundle

A catalog entry consisting of several other

catalog entries bundled together. Its pricing,

shipping, images, etc. are independent of the

individual items. See Also: "Creating a Bundle"

on page 17-116

A living room set: couch, end

tables and lamps. Instead of

buying each item separately,

the site visitor buysall for a

“package” price.

Product

Simple or complex catalog entries.

A complexproduct is a “wrapper” that provides

links to related simple products. Each simple

product has its own SKU, price, inventory data,

etc. See Also: "Creating a ComplexProduct"

on page 17-117

Amovie in three formats and

prices:

n VHS ($12.95)

n DVD ($14.95)

n Blu-ray ($17.95)

Subscription

A catalog entrywhich can provide access to

designated site pages, andmaybilled on a

recurring basis. See Also: "Creating a

Subscription" on page 17-119

Web site content that is only

available to subscribed

members

How Product Types Affect the Creation of Catalog
Entries
Catalog folders generally contain the same kind of catalog entries, such as DVDs or digital

cameras. Some information applied to a catalog folder is inherited by all entries in the folder.

After you create product types, apply appropriate ones to catalog folders using the Catalog

Properties screen’s Product Types tab (shown below).
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Then, when creating a new catalog entry, you first navigate to a catalog folder. Next, click

New and choose a product type assigned to the folder (shown below).

A product type determines the following aspects of the catalog entries based on it.

Catalog entry property For more information, see

Product class "Product Classes" on page 17-106

Content page
"Creating a Product Type Step 2: Creating the

Content Page" on page 17-124

Attributes "AttributesTab" on page 17-110

Media defaults (that is, size of thumbnail

imagesadded to a catalog entry)
"Media Defaults Tab" on page 17-113

There are two steps to creating a product type.

n "Creating a Product Type Step 1: Properties, Attributes & Media Defaults" on page 17-108

n "Creating a Product Type Step 2: Creating the Content Page" on page 17-124

See Also: "Deleting a Product Type" on page 17-126

Creating a Product Type Step 1: Properties, Attributes
& Media Defaults
To create a product type, go Workarea > Settings > Commerce > Catalog > Product Types

> New > Product Type. Use the following table to complete the Add Product Type screens.
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Tab/Field Description

Properties Tab

Title

Give the product type a unique title. The title identifies this entry on the View

Product Types screen.

Also, when creating a new catalog entry, usersmust pick a product type from

the catalog’sNewmenu (shown below).

Description Enter a description for the product type.

Class Enter a class for the product type. See Also: "Product Classes" on page 17-106
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Tab/Field Description

Attributes

Tab

Define additional information about catalog entries based on this product type.

Bydefault, Attributesappear on the Product server control (illustrated below).

Asanother example, if the Product Type is for movies, attributesmight be

Actors,Running Time,Rating,Year Released, etc.

Follow these steps to define a Product Type’s attributes.

1. Click the Product Type Attributes tab.

2. Click theAdd Attribute button.

3. Assign a name to the attribute, such ascolor.

4. Choose from these data types.

n text

n date

n number

n boolean (yesor no)

5. ClickOK.

(continued on next page)
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Tab/Field Description

Attributes

Tab

(continued)

For example, you want an attribute that describesa chair’s dimensions. You

create a text-based attribute for the Product Type you will use to add chairs to a

catalog.

Then, whenever you add a new chair to the catalog, you enter its dimensions

into theAttributes tab’sDimensions field.
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Tab/Field Description

Attributes

Tab

(continued)

When a site visitor views the chair’s product page, he sees the attribute text

below the thumbnails.

Attribute Statuses

Note: You can delete an attribute only if it isnot applied to a catalog entry. If you

try to delete an attribute applied to a catalog entry, it ismarked “Inactive.”

Inactive attributes can no longer be assigned.

n Active - Attribute can be assigned to catalog entries

n Inactive - Attribute alreadyassigned to one or more catalog entries, but

can no longer be assigned. Tomake an attribute inactive, click the cor-

respondingMark for Delete button ( ).

n Not Published - Attribute hasbeen created but Product Type not saved

yet

n Active - Marked for delete. Attribute will be deleted when Prod-

uct Type is saved.
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Tab/Field Description

Media

Defaults Tab

If desired, enter sizesof thumbnail images. If you do, thumbnails are

automatically generated for images (added on theMedia tab) applied to

catalog entries based on this product type.

To add a new thumbnail size, clickAdd Thumbnail. To remove one, click the

correspondingRemove button ( ).

To edit a thumbnail, click the corresponding Edit button ( ). After making

the edit, click the Save button ( ).

Viewing a Catalog Entry’s Thumbnails

You can see a catalog entry’s thumbnails by clicking itsMedia tab, thenView

Thumbnails.

See Also: "Product Server Control, thumbnails" on page 17-28

Creating a Kit
A kit is a type of catalog entry that allows a site visitor to select from free-text options, which

can affect the item’s price. The options can also be placed into logical groups.

For example, if a catalog entry is a laptop computer, one group may let you enter options for

RAM, another for operating system version, and a third could present hard drive options. This

is illustrated below.
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There is no limit to the number of groups you can add, nor the number of options in a group.

All groups and options are simple text, created on a kit’s Items tab as needed, and can

accommodate a price modifier. The example below shows how to set up chair color

combinations.

In this example, the options do not affect the price. Here is how the options appear on a

product page.
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Consider another example in which the price does change. In this case, use the Item screen’s

Price Modifier field to adjust price based on the chair frame. As shown below, if the chair

frame is teak, the sale price increases by $25.00.

Other chair materials might adjust the price as shown below.

Framematerial PriceModifier

Wrought Iron $0.00

Aluminum +$15.00

Steel -$10.00

Note how the Price Modifier can either increase or decrease the sale price. Here are these

options on the product page.
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The chair’s base price is $79.99, and the teak frame increases it to $104.99.

Creating a Bundle
A bundle consists of several simple products. You would use it to combine several existing

products into one “umbrella” catalog entry. That entry captures pricing, SKU number, shipping,

and inventory information for the bundle. The information for the individual entries that make

up the bundle are not affected when one is ordered.

As an example of a bundle using furniture, assume your eCommerce site sells a chair, a table,

and an ottoman separately. You also sell them together as a set.

Use a bundle to define the set, add pictures, pricing, etc. On the bundle’s Items tab, you select

the individual catalog entries that make up the bundle, as shown below.

Here is how this bundle looks on a product page.
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Creating a Complex Product
A Complex Product is similar to a bundle in that one catalog entry serves as an “umbrella” for

other entries. However, unlike a bundle, a site visitor must select one of the catalog entries. So,

the price is that of the selected entry, not the umbrella item.

The advantage of a Complex Product is its ability to consolidate several related items under

one title, yet allow site visitors to choose the item they want. Because each item under the

umbrella is its own catalog entry, it is priced and tracked separately.

For example, a site sells movies in three formats: VHS, DVD, and Blu-ray. Each is priced

differently. To accommodate this, create catalog entries for the movie in each format, assigning

images, SKU number, pricing, dimensions, etc. Then, create a Complex Product, make its title

the title of the movie, and use the Items tab to select the catalog entries of the individual

formats.

The Product List or Product Search control displays the Complex Product, which is the movie

title. When a site visitor selects that, he sees the product page, which lists the format and price

of each assigned catalog entry. He can only choose one. See example below.
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Steps in Creating aComplexProduct

Unlike the Kit or Bundle, a complex product does not have its own product class. Instead, you

create a catalog entry whose product class is product, then assign other catalog entries to it via

the Items tab. As soon as you assign one catalog entry via the Items tab, the original catalog

entry is converted to a Complex Product.
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Note that the price of the “umbrella” product appears on the Product List and Product Search

server controls. This can be misleading, since the price of individual items within the complex

product can vary.

Note: You cannot apply tier pricing to a complexproduct. See Also: "Tier Pricing" on page 17-142

Creating a Subscription
A subscription is a good or service which

n can be billed on a one-time or a recurring basis

n places users who purchase it into a designated membership group, letting you grant them

access to private content

Examples include

n content only available to members who purchase a subscription

n a gym membership

n a book club, in which a customer makes the same payment and receives a different book

each month

n anti-virus software that expires after 12 months

n a 3-year maintenance contract on a digital television, payable yearly

If you use the recurring billing feature, the bill can be generated for any number of months or

years, but no other time increments. Each payment must be the same for the subscription’s

term. The term begins when a customer submits the order.

Below is an example of a subscription-based product.

Note: Site visitors cannot apply a cart-level coupon to a subscription-based catalog entry. See Also: "Creating a

Coupon" on page 17-225
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Creating a SubscriptionBasedCatalog Entry

Creating a subscription is the similar to creating a regular catalog entry. The table below lists

everything you need to do, highlighting tasks that are unique to subscriptions.

Step Formore information, see

1. Create a subscription-based Product Type.

On the Product Type screen’sProduct Class dropdown,

selectSubscription (illustrated below).

"Product Types" on page 17-106

2. Assign the Product Type to a catalog folder.

n "How Product TypesAffect

the Creation of Catalog Entries"

on page 17-107

n "Creating a Catalog Folder"

on page 17-126

3. In that folder, create a catalog entry for each

subscription.

"Creating a Catalog Entry" on

page 17-128

4. On thePricing tab, enter the cost. If using recurring

billing, enter the term of the subscription.

If this product doesnot use recurring billing, clickNo at the

Use Recurring Billing dropdown.

n To learn about theUnit Pric-

ing fields, see "Entering a Catalog

Entry’sPrice Information" on page

17-140

Note: Subscription-based

products do not support tier

pricing. See Also: "Tier Pricing" on

page 17-142
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Step Formore information, see

n To learn aboutRecurring

Billing fields, see "Entering Recur-

ring Billing Information" on page

17-121

5. On the Items tab, assignmembership and CMSuser

groups.

"AssigningMembership and User

Group to a Subscription-Based

Catalog Entry" on page 17-123

6. If a subscription providesaccess to Ektron

CMS400.NET content, use its folder Permission

Table to grant permission to themembership and

CMSuser groups you defined in Step 5.

"Subscriptions that Involve Ektron

CMS400.NET Content" on page

17-123

Entering Recurring Billing Information

Warning! Due to differences in the waypayment gatewayswork, Ektron recommends testing recurring pay-

mentswith your gatewaybefore processing live transactions.

The Pricing tab’s Recurring Billing area of a subscription-based catalog entry (highlighted

below) lets you determine if a subscription is billed on a one-time or a recurring basis. If

recurring, it helps you define the terms.
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To set up recurring billing (that is, a series of scheduled payments), click Yes at the Use

Recurring Billing dropdown. The recurring billing term begins when a customer submits an

order, and is based on a number of months or years. You use the Billing Cycle dropdown to

choose a time interval.

Next, enter a number of Billing Intervals for which a customer is charged. For example, if a

customer should be charged once a month for 12 months, complete the screen as shown above.

If a customer purchases the item on June 1, 2008, his credit card will be billed on these dates.

n June 1, 2008 (purchase date)

n July 1, 2008

n August 1, 2008

n September 1, 2008

n October 1, 2008

n November 1, 2008

n December 1, 2008

n January 1, 2009

n February 1, 2009

n March 1, 2009

n April 1, 2009

n May 1, 2009

As another example, if a customer should be charged once a year for 3 years, complete the

screen as shown below.

If a customer purchases the item on June 1, 2008, his credit card will be charged on the

following dates.

n June 1, 2008 (purchase date)

n June 1, 2009

n June 1, 2010
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AssigningMembership andUserGroup to a Subscription-BasedCatalog Entry

You must assign a membership user group to a subscription-based catalog entry. Optionally,

you can assign an Ektron CMS400.NET user group. You assign groups via the subscription’s

Items tab.

See Also: ”Membership User Groups” on page 16-18; ”Managing User Groups” on page 15-36

So, as part of setting up a subscription, you must either create new membership and (possibly

user) groups, or use existing groups.

All users (identified by their email address) who purchase the product are automatically added

to one of the groups.

n Ektron CMS400.NET users are added to the group defined in the CMS Author Group

field

n Non-Ektron CMS400.NET users are added to the membership group defined at the

Member Group field

Note: Ektron CMS400.NET checksa user’s email address to determine if he is a CMSor amembership user.

Subscriptions that do not Involve Ektron CMS400.NET Content

If a subscription does not involve access to Ektron CMS400.NET content, the membership

group provides a list of customers who purchased the subscription. You can use the list to

manage the accounts, notify them when the subscription is about to expire, etc.

Subscriptions that Involve Ektron CMS400.NET Content

If a subscription involves access to Ektron CMS400.NET content, create a folder and enable

one or more subscription-based product types on its Product Type screen (illustrated below).
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Place the subscription products in that folder. Site visitors shop for and purchase this content

on your Web site as they do all products, via eCommerce server controls.

Then, create a regular content folder in which to create the confidential content. Next, use the

content folder’s permission table to grant the subscription user groups access to that folder

(illustrated below).

See Also: ”Folder Permissions” on page 5-56 and ”Assigning Permissions for Memberships” on

page 16-22

Creating a Product Type Step 2: Creating the Content
Page
After you complete and save the Add Product Type screen, a new screen allows you to enter

XML Smart Form information. On this screen, you set up fields to collect information for the

content page of catalog entries based on this product type. See example below.

eCommerce

17-124
ReferenceManual

Version 8.0 Rev 1.3

#
#
#
#
#
#
#
#
#
#
#
#
#
#


The content page appears on the Product server control, describing this catalog entry to site

visitors. See example below.

The process of creating a product type content page is the same as creating an XML Smart

Form, described in ”Before You Manage Smart Forms” on page 7-373.

Editing a Product Type
1. In the Ektron CMS400.NET Workarea, go to Settings > Commerce > Catalog > Product

Types.

2. Click the product type that you want to edit.

3. See "A product type determines the following aspects of the catalog entries based on it."

on page 17-108.

Note: You cannot edit a Product Type’sClass.
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Deleting a Product Type
Prerequisite: The product type is not assigned to any catalog entries

1. In the Ektron CMS400.NET Workarea, go to Settings > Commerce > Catalog > Product

Types.

2. Click a product type you want to delete.

3. Click the Delete button ( ).

4. A confirmation message appears.

5. Click OK.

TIP!

Note: Although you cannot delete a product type that is being used, you can prevent users from creating new

catalog entriesbased on it. To do this, go to each applicable folder’sCatalog Properties>Product Typesscreen

and remove that product type.

Creating a Catalog Folder
Prerequisite: One or more product types (See Also: "Product Types" on page 17-106)

A catalog folder is a special kind of Ektron CMS400.NET folder designed to hold eCommerce

entries. Its unique icon ( ) distinguishes it from other folder types. If you are familiar with
content folders, much of that information applies to catalog folders. See Also: ”Managing

Folders” on page 5-1

Catalog folders have several tabs/screens, as shown below.
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These screens are the same as regular content folders.

n Properties - see ”Fields on the Folder Properties Screen” on page 5-15

n Web Alerts - see ”Web Alert Feature” on page 20-1

n Metadata - see ”Assigning Metadata to a Folder” on page 7-203

n Breadcrumb - see ”Breadcrumbs” on page 9-358

The unique screen is Product Types. See Also: "Assigning a Catalog Folder’s Product Type"

on page 17-127

Like content folders, the following catalog folder information can be inherited from its parent

or uniquely set for each catalog. You can only make changes after creating the catalog.

n Permissions - see ”Setting Permissions for a Content Folder” on page 5-63

n Approvals - ”Creating an Approval Chain for a Content Folder” on page 5-38

n Purge History - ”Purge History” on page 5-24

n Restore Web Alert Inheritance - ”Inheriting Content-Level Web Alert Information from Its

Folder” on page 20-34

See Also: "Deleting a Catalog Folder" on page 17-128

Assigning a Catalog Folder’s Product Type
A catalog folder’s Product Types screen lets you identify product types upon which catalog

entries can be based. See Also: "Product Types" on page 17-106 and "How Product Types

Affect the Creation of Catalog Entries" on page 17-107

For example, you created a lawn mower Product Type, and want only lawn mowers to be

entered in a catalog folder. In this case, open a catalog folder’s Product Types tab, break

inheritance if necessary, and select Lawn Mower as the catalog’s only product type.
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Then, when a Ektron CMS400.NET user creates an entry in this catalog, he must use the Lawn

Mower product type.

Deleting a Catalog Folder
Prerequisite: No catalog entries in the folder have been placed on an order

To delete a catalog folder, follow these steps.

1. Navigate to the folder that you want to delete.

2. Click Delete > This Catalog.

3. A confirmation message appears.

4. Click OK.

Creating a Catalog Entry
Prerequisite: One or more catalog folders (See Also: "Creating a Catalog Folder" on page 17-

126)
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A Catalog entry is the eCommerce term that describes a product sold on your Web site. It is

similar to content in the rest of Ektron CMS400.NET, so those concepts apply to catalog

entries.

Catalog entries are built from Ektron CMS400.NET XML Smart Forms, so use the same

content and folder structure as other Smart Forms. See Also: ”Working with Smart Forms” on

page 7-369

Catalog entries share the following features with regular content.

n content status

n approvals and permissions

n metadata

n schedule

n history and the ability to restore previous versions

n search

n taxonomies to categorize products

Catalog entries also have unique information, such as

n Tax Class - determines which taxes apply to item

n Physical dimensions - used to calculate shipping costs

n Inventory tracking

n Pricing - can be fixed or variable for any currency

- tier pricing, that is, price adjusts when quantity reaches new plateau. For example, 1-9

items cost $500 each. But if 10 are sold, the price drops to $450 each.

n Images (full sized and thumbnail) to display the product on your Web Site

Because there is so much information to provide about managing catalog entries, this section

takes two approaches

n "Catalog Entry Screens and Menu Options" on page 17-129 describes all accessible

options (tables, menus, etc.) from the catalog entry screen

n "Catalog Entry Tasks" on page 17-130 describes how to do things with catalog entries:

create them, delete them, etc.

Catalog Entry Screens and Menu Options

n "Tabs on the Catalog Entry Screen" on page 17-132

n "Menu Options on the Catalog Entry Screen" on page 17-135

n "Folder View Menu options" on page 17-149
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n "Content View Menu Options" on page 17-151

Catalog Entry Tasks

n "Creating/Updating Content" on page 17-130

n "Deleting a Catalog Entry" on page 17-131

n "Adding Cross Sell and Upsell Recommendations to a Catalog Entry" on page 17-188

n View and restore a previous version of a catalog entry - Navigate to catalog folder > select

catalog entry > View Menu > Content History option. See Also: "Content History" on

page 17-152

n Edit permissions for a catalog entry - To enable this, break permission inheritance. Then,

assign permissions to selected users. See Also: ”Setting Permissions for Content” on page

5-68

n Edit inherited approval chain - First break permission inheritance, and assign permission to

users who need to be in the approval chain. Then, update the catalog entry’s approval

chain. See Also: ”Editing an Approval Chain For Content” on page 5-43

n Make a catalog entry private, so that the Web site search does not find it - See ”Private

Content” on page 7-237

n Archive a catalog entry - See "Archived" on page 17-138

n "Displaying Catalog Entries on your Web Site" on page 17-154

Creating/Updating Content
Follow these steps to create a new catalog entry or update an existing one.

1. Navigate to a catalog folder in which you want to create or update a catalog entry. See

Also: "Creating a Catalog Folder" on page 17-126

2. Click New then select a product type on which to base the entry. See Also: "Product

Types" on page 17-106

3. Complete the screens as needed. The required fields are:
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- content Title

- Properties tab > SKU Number

- any fields on the content screen that your Ektron CMS400.NET administrator has

designated as required

For information on the catalog entry screens, see "Tabs on the Catalog Entry Screen" on

page 17-132

4. Check in or submit/publish the content. See "Action Menu" on page 17-153.

Note: After signing in to your Web site, you can also update a catalog entry’s information from there.

Note:

Note: See Also: ”TheWeb Site Content Menu” on page 7-2

Deleting a Catalog Entry
Prerequisites:

n Catalog entry is not on an order, or checked out.

n You have delete permission for this catalog folder. See Also: ”Folder Permissions” on page

5-56

EKTRONBESTPRACTICE

Note: Do not delete catalog entries. For example, if you delete an entry from your staging site, then run an eSync,

that entry is removed from all active carts on your live site.

Instead of deleting entries, Ektron recommendsarchiving them using the Properties tab’sArchived checkbox

(shown below).
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TIP!

Note: If you want to prevent site visitors from purchasing an item, but you cannot delete it because it hasbeen

placed on existing orders, you have two options.

Note: * Uncheck itsBuyable checkbox, located on the Properties screen (circled below). If you do, the product still

appearson your Web site, but theAdd to Cart button doesnot appear next to it.

Note: * Archive it, using theArchived checkboxon the Properties screen (circled above). In this case, the product

doesnot appear on your Web site. See Also: "Archived" on page 17-138

Follow these steps to delete a catalog entry.

1. Navigate to the catalog folder that contains the entry.

2. Click the entry.

3. Click Action > Delete.

4. A warning message appears. Click OK.

5. The catalog entry is deleted.

Tabs on the Catalog Entry Screen
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Tab Description
For more

information, see

Content The entry’s content page.

"Entering a Catalog

Entry’sContent" on page

17-136

Summary
The content summary, bydefault the first 40

characters of the content text.

”Auto Generating

Summaries” on page 7-

14 and ”Working with

Content Summary” on

page 7-170

Properties

eCommerce information about the catalog entry:

n SKU number

n Number of Units

n TaxClass

n Archived

n Buyable

n Dimensions

n Inventory

"Entering a Catalog

Entry’sProperties" on

page 17-137

Pricing

n Lets you define list and sales price

n For each enabled currency, you can set a fixed

price or have it float with exchange rate

n Allows tier pricing

n For subscription products, you enter recurring

billing interval and term

"Entering a Catalog

Entry’sPrice

Information" on page 17-

140

Attributes
Additional information to help describe a catalog

entry

"Entering a Catalog

Entry’sAttributes" on

page 17-144

Media
Lets you add images that appear on several

eCommerce server controls

"Entering a Catalog

Entry’sMedia" on page

17-146

Items

Catalog entries that you are adding to this “umbrella”

item.

n If you add catalog entries to a simple product, it

becomesa complexproduct.

n For bundles, add catalog entries that make up a

"Entering a Catalog

Entry’s Items" on page

17-149

"Creating a Complex

Product" on page 17-

117

"Creating a Bundle" on
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Tab Description
For more

information, see

bundle.

n For kits, enter groupsand their options.

n For subscription products, definemembership

and Ektron CMS400.NET user groups to which

users are assigned when theypurchase the sub-

scription.

page 17-116

"Creating a Kit" on page

17-113

"Creating a

Subscription" on page

17-119

Metadata

Enter meta tags, title tags, etc.

Note:When viewing themetadata screen in view

mode only, you see the catalog entry’sProduct

Icon. The product icon is set on themedia tab. See

Also: "Product List, Product Search, and

Recommendation server controls" on page 17-28

”Working withMetadata”

on page 7-176

Alias

Note: This tab only appears if Aliasing is enabled.

n View and edit the catalog entry’s primaryman-

ual alias

n View all automatic aliasesassigned to this cat-

alog entry

”Adding aManualAlias

via the AliasTab” on

page 10-43

”URL Aliasing” on page

10-1

Schedule

Lets you controlwhen a version of a catalog entry

becomesvisible on theWeb site. Similarly, you can

remove a catalog entry on a predetermined date and

time.

Note: TheArchive and remain on the site option

is not available with catalog entries.

”Scheduling Content to

Begin and End” on page

7-242
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Tab Description
For more

information, see

Comment

View comments on changesmadewhen editing a

catalog entry.

Note: To view and edit catalog entry comments, open

the editor and chooseChange > Comment.

The comment also appears on the View Content and

Content History screens. Use it to help distinguish

one version from another.

Tasks

View tasksassigned to this catalog entry.

Note: To add a task from the View Entry screen, click

Action > Add Task.

”Managing Tasks” on

page 11-1

Category

Add a taxonomycategory to the catalog entry.

A list of available taxonomiesand whether one is

required are defined on the Catalog properties

screen.

Note: This tab only appears if at least one taxonomy

is assigned to the catalog folder.

”Taxonomy” on page 9-

253; ”Assigning a

Taxonomyor Category

to Content via the Edit

Content Screen” on

page 9-274

”Fieldson the Folder

PropertiesScreen” on

page 5-15

Menu Options on the Catalog Entry Screen
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Menu

Option
Description

Action Menu

Save
Saves the catalog entry without leaving the editor. It is a good idea
to save your work frequently.

Check in

Save and check-in the document. This action returns the changed content to

the database and exits the editor. It doesnot submit the content into the

approval chain. Rather, it allows you and other users to continue changing it.

Submit/Publish

Submit the content into the approval chain. This action also returns the new

or updated content to the database and exits the editor.

Publish the content to theWeb site.

Note: Only the last approver in the approval chain sees this button. If no

approval chain is assigned to the content’s folder, every authorized user sees

this button. See Also: ”ApprovalChains” on page 5-33

This action also returns the changed content to the database and exits the

editor.

Undo checkout
Exit screen and do not save changesmade since you began editing this

catalog entry.

Change Menu

Comment

Enter comments on changesmadewhen editing a catalog entry.

The comment also appears on the View Content and Content History

screens. Use it to help distinguish one version from another.

Template

A folder’s default template is automatically applied to all content in the folder.

However, you can change a content item’s template to anyof those assigned

to the folder. See Also: ”Creating/Updating Templates” on page 7-228

Entering a Catalog Entry’s Content
The Content tab displays the content page of this catalog entry’s product type. See Also:

"Creating a Product Type Step 2: Creating the Content Page" on page 17-124

Because the format is customized for your system, this documentation cannot explain how to

respond to the fields.

To learn about working with the editor, see ”Ektron CMS400.NET Editors” on page 7-21
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Entering a Catalog Entry’s Summary
See ”Auto Generating Summaries” on page 7-14 and ”Working with Content Summary” on

page 7-170.

Entering a Catalog Entry’s Properties
The Properties screen collects eCommerce-specific information about your catalog entries.

Use the following table to complete the Properties screen.
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Property Description

SKU
Enter a unique SKU code for this catalog entry. This is a required field

that doesnot accept a value of zero (0) or a space character.

Number of Units

If this item hasa quantity other than one (1) for internal record-keeping

purposesonly, enter that number.

For example, a 12 packof soda. SetQuantity is 12 to represent the

number of units. But a site visitor still orders 1 of the item.

The quantity is not used when this item is ordered, nor does it affect

inventory levels. It is used for clerical purposesonly.

TaxClass
Select the catalog entry’s TaxClass. See Also: "The TaxClass

Screens" on page 17-97

Archived

Check this box if you want to archive this catalog entry. Once archived,

site visitors can no longer see nor order it.

Also, Ektron CMS400.NET users cannot view an archived catalog

entry in its catalog folder via the View Folders screen. To view it, open

its catalog folder then selectView > Archive.

Tomake the entry available again on your Web site, open its archive

folder, edit the entry byunchecking theArchived checkbox, and

publish it.

Note: A catalog entry can also be set to Archived status if it reaches its

expiration date and itsSchedule tab >Action on End Date field is

set toArchive and remove from site (expire).See Also: ”Setting

ArchiveOptions” on page 7-247

Buyable
To let site visitors add this catalog entry to a shopping cart, check this

box. Otherwise, uncheck it.
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Property Description

If a product isnot buyable, it can still be seen by site visitors, but its

product page doesnot display anAdd to Cart button.

Tip! To remove a catalog entry from your site, use theArchive field.

Dimensions - Used to calculate packaging containers and shipping costs. See

Also: "Packages" on page 17-87

Tangible Item

Check this box if the item is tangible, that is, it hasdimensions, weight,

and will be shipped to a customer. Examplesof non-tangible itemsare

services, warranties, and downloadable software.

If a catalog entry is tangible, youmust enter its height, width, length,

and weight.

Height

Enter the catalog entry’s height. The units of measure are specified in

the web.config file’sek_measurementsystemproperty.

Required if Tangible Item is checked.

Width Enter the catalog entry’swidth. Required if Tangible Item is checked.

Length Enter the catalog entry’s length. Required if Tangible Item is checked.

Weight
Enter the catalog entry’sweight. Required if Tangible Item is

checked.

Inventory - eCommerce’s inventory system is a provider model, allowing you

to connect with third-party inventory systems.

Disable Inventory

Check this box if you do not want to track inventory activity for this

catalog entry. Asexamples, it is a service contract or a subscription to

confidential content on your site.

In Stock

Enter the number of itemson hand for this catalog entry.

This number is automatically adjusted when an order containing this

entry is submitted. For example, there are 100 items in stock.When an

order for 10 is submitted, the In Stock value changes to 90.

If the amount placed on an order exceeds the In Stock amount, the

site visitor see thismessage “The item ... is not available for purchase.

Please remove from cart before submitting order.”

OnOrder
The number of items that have been ordered but not yet delivered

appears.

Reorder

Enter the In Stock quantity at which you need to reorder this item.

When the In Stock quantity reaches this level, an event is triggered

which can be used byan external inventory system to generate a new

order.
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Entering a Catalog Entry’s Price Information
Use the Pricing screen to enter price information for catalog entries.

Use the following table to complete the Pricing screen.

Field Description

Currency selector

Use this dropdown to select a currency for the prices. See Also:

"Alternate CurrencyPricing" on page 17-141

Only enabled currencies appear. See Also: "Enabled Currencies " on

page 17-54
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Field Description

List price

Enter the catalog entry’s list, or manufacturer’s suggested retail,

price.

The list price appears onmost eCommerce controls (see examples

below) but isnot used in any calculations.

Cart server control

Product Search server control

Our SalesPrice

Enter the catalog entry’s sale price. This price is used to calculate line

item totals, coupon discounts, shipping costs, etc.

The sales price appears onmost eCommerce controls. See

examplesabove.

Add Pricing Tier

button
"Tier Pricing" on page 17-142

Recurring Billing

(appears only for

subscription-based

products)

"Creating a Subscription" on page 17-119

Alternate Currency Pricing

By default, the Pricing screen converts prices to every enabled currency (see screen below),

using the exchange rate. Site visitors who select a non-default currency see these prices. See

Also: "Updating the Exchange Rate" on page 17-57
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The Float checkbox (checked by default) indicates that prices change as the exchange rate

changes.

If you do not want to float a catalog entry’s price, but instead fix it for a currency, select the

currency, uncheck Float, edit the price, and publish. From then on, if a site visitor selects that

currency and catalog entry, the price set on this screen is used. The exchange rate is ignored.

For example, a television costs 700 Euros, regardless of its cost in US dollars or the exchange

rate. To incorporate this, do not check the Float checkbox.

When you first select EUR on the Pricing screen, the default currency’s prices are converted

using the exchange rate. For example, the television’s sale price is $1000 US dollars, and

today’s exchange rate is .7811. When you select Eur from the Pricing screen’s currency

selector, the television’s cost is set at 781.10 Euros. You change the price to 700.00 Euros.

From that point on, the Euro price only changes if an authorized user accesses this screen and

changes it manually.

Tier Pricing

eCommerce supports tier pricing, that is, a pricing schedule that adjusts according to order

quantity. Typically, the price is reduced as more items are ordered. For example, if a visitor

orders 1-5, items are $10.00 each; 6-10, $9.00 each; 11 or more, $8.50 each.

Note: Tier pricing is not supported for subscription products, nor for complexproducts. See Also: "Creating a

Subscription" on page 17-119, "Creating a ComplexProduct" on page 17-117

To set up tier pricing, follow these steps.

1. In the Workarea, open the catalog folder containing the entry to which you want to apply

tier pricing.

2. Edit the catalog entry.

3. Click the Pricing tab

4. Click the Add Pricing Tier button (shown below).
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5. The following screen section appears.

6. In the left column, enter the quantity of items above which the tier price is used.

7. In the right column, enter the price to be used when an order quantity exceeds the number

in the left column.

8. Enter as many tiers as necessary.

Note: To remove a tier, check the box to its left, then click theRemove Pricing Tier button.

Tier Pricing andNon-Default Currencies:When Floated

If a non-default currency is floated, then that currency’s pricing tiers mirror the default

currency’s pricing tier values. The amounts are adjusted by the exchange rate.

These values appear on pricing screen in view-only mode and cannot be changed. This is

illustrated below.
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If pricing tiers are set up for the default currency and the user unchecks the Float box, he is

notified that the pricing tiers can now be edited. Next, Tier Pricing fields are loaded with the

existing values but the user can change values, remove existing tiers, and add new ones.

Tier Pricing andNon-Default Currencies:WhenNotFloated

If a non-default currency is not floated, its pricing tiers are independent of the default

currency’s. That is, they do not exist initially regardless of whether they exist for the default

currency. If the user clicks Add Pricing Tier, Tier Pricing fields appear and let the user enter

number of units and corresponding tier price per unit.

If pricing tiers are set up for a non-default currency and the user checks the Float box, the

pricing tiers are changed to mirror those of the default currency. If the default currency has no

pricing tiers, then that currency has none. You cannot independently edit a non-default

currency’s pricing tiers if Float is checked.

Entering a Catalog Entry’s Attributes
Attributes are additional pieces of information that help describe a catalog entry. To illustrate

the concept, the following attributes are applied to furniture in Ektron CMS400.NET’s sample

site.
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In the Workarea, you select a catalog entry then click the Attributes tab to enter or modify

attribute values. In the above example, you could change model year to 2009, or style to

Woodland. You cannot however change fields, field names, or data types.

Note: If no attributesare assigned to the product type on which a catalog entry is based, you will not see an

Attributes tab whenworking with that catalog entry.

On your Web site, a catalog entry’s Attribute field names and values appear by default on the

Product server control, as shown below.
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Origin of Attributes

Attribute fields, data types, and default values are created as part of a Product Type. See Also:
"Attributes" on page 17-133

When you create a catalog entry, you base it on a product type. The product type’s Attribute

information is imported to the catalog entry.

WhatHappens to aCatalog Entry’s AttributesWhenMoved

Like metadata that follows Ektron CMS400.NET content, if a catalog entry is moved to

another folder, its attributes stay with it.

Entering a Catalog Entry’s Media
Use the Media tab to add product images that appear on the following server controls.

n Product (the smallest thumbnail may appear)

n Product List
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n Product Search

n Recommendation

See Also: "Images in eCommerce" on page 17-27

Adding aNew Image

Follow these steps to add a new image. See Also: http://www.w3schools.com/tags/tag_

IMG.asp

1. Click the Media tab.

2. Click Add New Image .

3. Enter an image Title. This is a required field.

4. Enter the image’s Alt text. This is a required field.

5. Click the Browse button and navigate to the image you want to add.

6. Click the Upload button.

7. The image is uploaded to the siteroot/uploadedimages folder.

Note: When an image is uploaded to theMedia tab, the original image and any thumbnails associated with it are

added to the Library. For example, if you add an image named “TestImage” (actual file name: “case.jpg”) with a

150pxand 50px thumbnails, you see the following entries in your library (File Name - Path):

TestImage - /~siteroot~/uploadedImages/case.jpg

case[filename]150 - /~siteroot~/uploadedImages/case[filename]150.jpg

case[filename]50 - /~siteroot~/uploadedImages/case[filename]50.jpg

8. The image appears on the screen, below any existing images.

9. Determine if you want the image’s smallest thumbnail to appear on the product server

control by selecting Yes or No next to Gallery Display. (See example below). See Also:

"Product Server Control, thumbnails" on page 17-28

10. If you want to designate the image as the product icon, click Set as Product Icon. See

Also: "Product List, Product Search, and Recommendation server controls" on page 17-28

To learn about the image thumbnails, see "Determining Thumbnail Size" on page 17-148.

Editing an Existing Image
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Note: You cannot change an existing image. If you need to do this, delete the image you do not want, then add the

correct one. You can only edit the Title andAlt Text.

1. Click the Media tab.

2. Move the cursor to the field that you want to edit.

3. Click the pencil icon to the right of the field (shown below).

4. Update the text as needed.

5. Click the OK button ( ).

Determining Thumbnail Size

When you create a catalog entry, you base it on a Product Type. The selected product type’s

Media Defaults information determines the sizes of thumbnails created for each image assigned

to the Media tab. See Also: "Media" on page 17-133

n If the image is less than both thumbnail dimensions (height and width), it appears full size.
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n If the image is greater than the thumbnail’s dimensions, the image is reduced

proportionately, scaling its dimensions to the thumbnail size.

The Default Image

If you do not assign an image to a catalog entry, but one is assigned to appear on a server

control, the following default image is used.

If you want to change the default image, edit the following file:

site root/WorkArea/images/application/Commerce/productImageBackground.gif

Entering a Catalog Entry’s Items
Use the Items tab to add additional information to the current entry. It is used in these

situations.

n to select the catalog entries that make a product into a complex product. See Also:

"Creating a Complex Product" on page 17-117

n to select the catalog entries that make up a bundle. See Also: "Creating a Bundle" on page

17-116

See Also: "Product Classes" on page 17-106

n to select the groups and their options that make up kits. See Also: "Creating a Kit" on

page 17-113

Note: You can only choose a catalog entrywhose languagematches the language of the original item.

n to select a subscription-based catalog entry’s user groups. See Also: "Assigning

Membership and User Group to a Subscription-Based Catalog Entry" on page 17-123

Folder ViewMenu options
The following menu options are available when you open a catalog folder.
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Menu option Description

New Menu

Catalog
Create a new catalog folder underneath the current one. See Also:

"Creating a Catalog Folder" on page 17-126

product types

assigned to folder

Create a new catalog entry based on one of the displayed product

types. Your product typesmaynot match the ones shown below.

Product typesare assigned to a catalog’s via the Product Types

screen. See Also: "Product Types" on page 17-106

View Menu

All types, products,

kits, bundles

Lets you change the display of catalog entries. You can see all entries in

folder, or only those of a selected product class. See Also: "Product

Classes" on page 17-106

Language

Limits display of catalog entries to one language.

Also determines the language of anynew catalog entries you create in

this folder.

Archive
Displaysarchived catalog entries. See Also: "Archived" on page 17-

138

Catalog Properties
Lets you view and edit catalog folder information. See Also: "Creating a

Catalog Folder" on page 17-126
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Menu option Description

Delete Menu

Note - You cannot

delete a catalog entry

that hasbeen placed

on anyorder. The

order’s status is

irrelevant.

Lets you delete a catalog folder or a catalog entrywithin it.

See Also: "Deleting a Catalog Entry" on page 17-131, "Deleting a

Catalog Folder" on page 17-128

Catalog ”Deleting Folders” on page 5-23

Entries

See

n "Deleting a Catalog Entry" on page 17-131

n ”Deleting SeveralContent Items in a Folder” on page 7-158

Action Menu

Move entry
”Viewing and Restoring PreviousContent” on page 7-140

Note: You can onlymove catalog entries -- you cannot copy them.

Search ”The Search Published Tab” on page 9-109

Content ViewMenu Options
The following menu options are available when you are viewing a catalog entry.
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Menu option Description

Action Menu

Edit
Edit the catalog entry. See Also: "Tabson the Catalog EntryScreen"

on page 17-132

Delete

See

n "Deleting a Catalog Entry" on page 17-131

n ”Deleting Content” on page 7-157

LinkSearch

Locatesall content that includesaQuicklink to the displayed catalog

entry.

This feature is useful before deleting a catalog entry, because it informs

you of every entry that will include a “dead” link if you delete that entry.

You should then edit those catalog entries and remove or change the

obsolete Quicklinks.

Add Task ”Managing Tasks” on page 11-1

View Menu

Content History

Lists every version of the content available in Ektron CMS400.NET.

After viewing the View Content Historywindow, you can click any

version to see its detail.

See Also: ”Viewing and Restoring PreviousContent” on page 7-140

View Approvals
Access the catalog folder’s approval chain. See Also: ”Approval

Chains” on page 5-33

View Permissions
Access the catalog folder’s permissions table. See Also: ”Folder

Permissions” on page 5-56

CrossSell

Lets you assign cross sell items to this catalog entry. See Also: "Adding

CrossSell and UpsellRecommendations to a Catalog Entry" on page

17-188

Up Sell

Lets you assign up sell items to this catalog entry. See Also: "Adding

CrossSell and UpsellRecommendations to a Catalog Entry" on page

17-188

View Properties

Lets you

n view the

- catalog entry’s product type See Also: "Product

Types" on page 17-106
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Menu option Description

- Flagging Definitions assigned to the catalog entry’s

folder See Also: ”Flagging” on page 16-236

n view and edit theContent Searchable setting - The search only

considers content if this field is checked. Bydefault, this field is checked

when an entry is created.

Reports Menu

Content Statistics ”Content Rating” on page 7-991

Analytics
Providesa visual display of order information for a selected catalog

entry. See Also: "eCommerce Analytics" on page 17-188

Editor View Menu Options
The following options are available when you are editing a catalog entry’s content.

Menu

Option
Description

Action Menu

Save
Save the content without leaving the editor. It is a good idea to save your work

frequently.

Check in
Save and check-in the document. This action returns the changed content to

the database and exits the editor. It doesnot submit the content into the
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Menu

Option
Description

approval chain. Rather, it allows you and other users to continue changing it.

Submit or

Publish

Submit the content into the approval chain. This action also returns the new

or updated content to the database and exits the editor.

Publish the content to theWeb site.

Note: Only the last approver in the approval chain sees this button. If no

approval chain is assigned to the content’s folder, every authorized user sees

this button. See Also: ”ApprovalChains” on page 5-33

This action also returns the changed content to the database and exits the

editor.

Undo

Checkout
Close the editor without saving changes.

Change Menu

Comment

Briefly describe the content, or comment on changesmadewhen editing

content. The history comment appears on the View Content and Content

History screens.

Template

Lets you specify one or more templates for catalog entries in this folder. These

entries use the specified template when appearing on your Web site. See

Also: ”Assigning Templates to Content” on page 7-235

Displaying Catalog Entries on your Web Site
The eCommerce Module provides three server controls for displaying catalog entries on your

Web site.

n "Product Server Control" on page 17-154

n "Product List Server Control" on page 17-165

n "ProductSearch Server Control" on page 17-170

Product Server Control
The Product server control allows site visitors to view the details of a product and add it to

their cart. To display a product on a Web page, drag and drop a Product server control on a

template and enter a product ID in the DefaultProductID property. You could also
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dynamically pass a product’s ID to the control by setting DynamicProductParameter

property to the QueryString parameter used for product IDs.

This control handles each class of product Ektron provides. This means the Product server

control displays Products, Kits, Bundles or Subscriptions without having to make any

adjustments to the control.

See Also:

n "Displaying a Product" on page 17-155

n "Displaying a Bundled Product" on page 17-157

n "Displaying a Complex Product" on page 17-158

n "Displaying a Kit" on page 17-159

n "Product Server Control Properties" on page 17-160

Site visitors typically reach this server control when they click a product from either the

ProductSearch or ProductList server control. When site visitors clicks a product, title or image

in either of these controls, they are forwarded to the Product server control.

In addition, site visitors can reach this control from the Cart server control. In that control, site

visitors click a product’s title and are taken to the Product server control.

Once a site visitor has viewed the product and decided to purchase it, they click the Add to

Cart button displayed in the control.

Displaying a Product
A product is an item that has no kit, bundle or subscription information associated with it.
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When displaying a simple product, the Product server control displays the following

information:

Area Where information comes from

Title

(This field

is optional.)

The Title field in the product’sSmart Form. A content editor enters this

information when creating a product in theWorkarea. This area doesnot use the

title of the product in CMS400.NET’sWorkarea.

Description

(This field

is optional.)

The Description field in the product’sSmart form. A content editor enters this

information when creating a product in theWorkarea.

Image

Gallery

TheMedia tab when creating or editing a product. TheGalleryDisplay property

for each image on theMedia tabmust be set to Yes.

In the ImageGallery, imagesare displayed at their smallest size. Once a site visitor

clicks an image, the full size version is displayed. Below is an example of a

product’s image gallery.

See Also: "Entering a Catalog Entry’sMedia" on page 17-146

Price

The Pricing tab when creating or editing a product. This is the price defined in the

OurSales Price area. This is not the list price.

See Also: "Entering a Catalog Entry’sPrice Information" on page 17-140

Add to

Cart

button

This button appears in the server controlwhen

n a path to the Cart server control is defined in theTemplateProduct prop-

erty

n the product is buyable.When a product is not buyable, information about the

product is displayed, but site visitors cannot add it to their cart. This property is set

in theWorkarea when creating or editing a product.

n theShowAddToCart property is set to True

When site visitors click this button, the product is added to their cart and theyare

sent to a template containing the Cart server control.

You can hide this button by setting the ShowAddToCart property to false. This

allows you to show details of a product, but not offer it for sale. For example, you

have a product that is no longer for sale, but you want to allow people who

purchased the product to view its details.

Also, byusing code behind to dynamically set the property, you could create code

that looksat your inventory system and hides the button depending on whether a

product is in stock.

See Also: "Using the Add to Cart Button with Aliasing" on page 17-157
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Using the Add to Cart Button with Aliasing
When a product has an alias path associated with it, you need to do the following:

n Make sure the TemplateCart property’s path is relative to the site root. For example:

n TemplateCart="Developer/Commerce/CartDemo.aspx"

n Add the following to the code behind page. This example is in C#:
protected void Page_Init(object sender, EventArgs e)

{

Utilities.RegisterBaseUrl(this.Page);

}

Displaying a Bundled Product
A bundled product is made up of multiple products that have been grouped together for sale as

one product.

See Also: "Creating a Bundle" on page 17-116
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When displaying a bundled product, the Product server control displays all information

displayed in a Product as well as the following information.

Area Where the information comes from:

This

Bundle

Includes:

Products listed on the Items tab for a Product Bundle in theWorkarea. A content

editor addsexisting products to this tab when creating the bundle.

Anyproducts on the tab are displayed with the image, title and description for each

product. A link to additional information about each product is also displayed.

Displaying a Complex Product
A Complex Product allows the site visitor to choose between variations of a product. For

example, if your site sells books, variant selections might be Paperback or Electronic.

See Also: "Creating a Complex Product" on page 17-117
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When displaying a Complex Product, the Product server control displays all of the information

displayed in a Product in addition to the following information:

Area Where the information comes from:

Variants:

Products listed on the Items tab. A content editor addsproducts to this tab when

creating content.

Products on the Items tab are displayed with a radio button, image, title and

description. A link to additional information about each product is also displayed. The

radio buttonsare used to select which product will be added to the cart.

Displaying a Kit
A kit allows the site visitor to select product options, which can affect the product’s price.

There is no limit to the types of options you can add, nor to the number of items in an option.

For example, a site visitor purchasing a computer can add RAM, a hard drive, and a larger

monitor.

See Also: "Creating a Kit" on page 17-113
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When displaying a kit, the Product server control displays all information displayed in a

product in addition to the following information.

Area Where the information comes from:

Options

The Item tab for a kit in theWorkarea. Optionsare divided into groups. A radio

button, name and price appears for each item. The radio button allows you to select

one item from each group.

Subtotal: The updated cost of the product with all options.

Product Server Control Properties
The following table explains the properties of the Product control.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description Data Type

AddToCartAction

This property is has

been removed. If it

is not added back in

by the release,

remove.

Specifies the action to take when an item

is added to the cart. Choices are:

GoToCartPage - once the site visitor clicks

the Add to Cart button, the item is added

to his cart and he is taken to the page

containing the Cart server control.

This option has been suppressed by Scott

K. Per Defect #40615

StayOnPage - once the site visitor clicks

the Add to Cart button, the item is added

to his cart, but he remains on this page.

If you are using StayOnPage, Ektron

recommends that you add a link to a

master page or menu that allows a user to

navigate to the template containing the

Cart server control.

AddToCartActionType

Authenticated
Indicates if you are logged in to the CMSExplorer

and can use it to browse to Content, Collections,
String
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Property Description Data Type

etc. See Also: ”Using CMSExplorer to Browse

Your Ektron CMS400.NET Site” on page 21-12

CacheInterval

Sets the amount of time the server control’s data is

cached. The default is 0 (zero). This is the amount

of time, in seconds, a control’s data is cached. For

example, if you want to cache the data for five

minutes, set theCacheInterval property to

300 (three hundred). See Also: ”Caching with

Server Controls” on page 21-42.

Double

CustomXml

(Code Behind Only)

Providesamechanism to inject custom XML into

the generated XML before being processed by

the XSLT. The injected XML is appended to the

end of the XML produced by this control.

See Also: ”Displaying CustomXML in Ektron’s

Server Controls” on page 21-49

String

DefaultProductID

Enter a default product’s ID. This is the default

product that’s displayed when the template

containing this control is viewed bya site visitor

and a product ID is not dynamically passed.

Tomake this server control dynamic, enter zero

(0) for this property and set the

DynamicProductParameter to the

QueryString parameter used to pass the product

ID.

Integer

DisplayXslt

Specify an externalXSLT file to render the control.

Bydefault, the control usesproduct.xsl. This

file is located in

<SiteRoot>\Workarea\Xslt\Commerce

Important: If you want to edit this file, it is strongly

recommended that youmake a copy, change its

name andmove it outside your site’sWorkarea

folder. If youmake changes to this file and do not

move it out of theWorkarea folder, this file and the

changeswill be lost when you upgrade.

See Also: "TheOverrideXslt and DisplayXslt

Properties" on page 17-163

String

DynamicParameter

TheQueryString parameter namewhich is used

to read the product ID. For example, if your

QueryString parameter for products is ID, enter

that in this property. Then, when site visitors views

a product’s details, the product’s ID is passed to

this control.

String
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Property Description Data Type

Hide

Used to hide the control in design time and run

time.

True =Hide the control

False =Show the control

Boolean

ImageGallery

Determine if the image gallery is displayed along

with a product’s information. Images that appear

in the gallery are set in theWorkarea’sMedia tab

when creating or editing a product. TheGallery

Display property for each image on theMedia tab

must be set to Yes.

Note: To set imageson theMedia tab, thumbnail

informationmust be defined on theMedia

Defaults tab at the Product Type level. See Also:

"Media Defaults Tab" on page 17-113

Choicesare:

List =display gallery images

None =hide gallery images

In the ImageGallery, imagesare displayed at their

smallest size. If a site visitor clicks an image, a full

size version is displayed.

See Also: "ImageGallery" on page 17-156

ImageGalleryType

Language

Set a language for viewing product information.

This property shows results in design-time (in

VisualStudio) and at run-time (in a browser).

Integer

OverrideXslt

Specifies an XSLT identified in the Edit Product

Type Configuration screen. See Also: "The

OverrideXslt and DisplayXslt Properties" on page

17-163.

Integer
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Property Description Data Type

ShowAddToCart

Set to true if you want to theAdd to Cart button to

appear. The default is True. See Also: "Add to

Cart button" on page 17-156

Setting this property to false allows you to show

details of a product, but not offer it for sale. For

example, you have a product that is no longer for

sale, but you want to allow people who purchased

the product to view its details.

Also, byusing code behind to dynamically set the

property, you could create code that looksat your

inventory system and hides the button depending

on whether a product is in stock.

You could also accomplish this for a specific

product by removing the check from the Buyable

propertywhen creating or editing a product in the

Workarea.

Boolean

SuppressWrapperTags

Suppresses the output of the span/div tags

around the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

Stylesheet

Specify the location of a style sheet to use for the

product page. Set the location relative to the site

root folder.

String

TemplateCart

Enter the URL path of the template that contains

the Cart server control. This path can be relative

or absolute. See Also: "Cart Server Control" on

page 17-3 and "Using the Add to Cart Button with

Aliasing" on page 17-157.

String

The OverrideXslt and DisplayXslt Properties

The DisplayXslt property is optional. If used, it specifies an external XSLT file. If the

DisplayXslt property is not defined, the OverrideXslt property specifies an XSLT

identified in the Edit Product Type screen. The following table provides more information

about these properties.
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To use this display XSLT
Enter this value

for DisplayXslt

Enter this

value for

OverrideXslt

The default XSLT specified in the Edit Smart

Form Configuration screen (illustrated
below). Note that, in this example, the XSLT

Packaged option is the default XSLT, since it is

selected.

XSLT Packaged is the XSLT from the Edit

Smart Form Configuration screen (that is,

the XSLT created in the Data Designer).

0

XSLT 1 from the Edit Smart FormConfiguration

screen
1

XSLT 2 from the Edit Smart Form

Configuration screen
2

XSLT 3 from the Edit Smart Form

Configuration screen
3

An absolute or relative path to an XSLT file.

An externalXSLT file

not specified in the

EditProduct Type

Configuration
screen.

For example

sample.xslt

doesnot

matter - if

XSLT value

exists,

OverrideXSLT

is ignored
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Product List Server Control
The ProductList Server control displays a list of products on a Web page.

You decide which products appear by selecting a SourceType and populating either the

SourceId or the IdList property, depending on the source type. You can choose from

these source types.
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Source Type Table

If you want to:

Set the

SourceType

property to:

In the SourceId

property, enter:

In the IdList

property, enter:

Display all products for a

selected catalog
Catalog

The ID of the

catalog.

Display all products

acrossmultiple catalogs
CatalogList

A comma

separated list of

catalog IDs

Display all products for a

selected taxonomy
Taxonomy

The ID of the

Taxonomy.

Displaysall products

acrossmultiple

taxonomies

TaxonomyList

A comma

separated list of

taxonomy IDs

Display a list of products IdList

A comma

separated list of

product IDs

Sorting the Product List
The ProductList server control allows a site visitor to sort by: Title, SKU, Price High to Low,

Price Low to High, Highest Rated, Lowest Rated and Most Ratings. You can set the default

sort order by setting the SortMode property.

For the Highest Rated, Lowest Rated and Most Ratings sorting options to work as intended,

you should have ContentReview server control associated with each product. (See Also:

"ContentReview Server Control" on page 7-736) This allows site visitors to rate your products.

For example, place a ContentReview control on the Master page of the template that display

products, and set its DynamicParameter property to ID. Then, when site visitors view

the product, they can rate and comment on it.

Flow of the ProductList Server Control
There are several ways site visitors might arrive at the ProductList server control, such as

n when a list of products appears on the side of a page

n through a link in a master page

n when they click the Continue Shopping button on the Cart or Checkout server control.
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ProductList Server Control Properties
The following table explains the properties of the ProductList server control.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer

and can use it to browse to Content, Collections, etc. See Also:

"Using CMSExplorer to Browse Your Ektron CMS400.NET Site"

on page 21-9

String

CacheInterval

Sets the amount of time the server control’s data is cached. The

default is 0 (zero). This is the amount of time, in seconds, a

control’s data is cached. For example, if you want to cache the

data for fiveminutes, set theCacheInterval property to 300

(three hundred). See Also: "Caching with Server Controls" on

page 21-31

Double

CustomXml

(Code Behind Only)

Providesamechanism to inject custom XML into the generated

XML before being processed by the XSLT. The injected XML is

appended to the end of the XML produced by this control.

See Also: "Displaying CustomXML in Ektron’sServer Controls"

on page 21-37

String
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Property Description Data Type

DisplayXslt

Specify an externalXSLT file to render the control. Bydefault, the

control usesProductList.xsl. This file is located in

<SiteRoot>\Workarea\Xslt\Commerce

Important: If you want to edit this file, it is strongly recommended

that youmake a copy, change its name andmove it outside your

site’sWorkarea folder. If youmake changes to this file and do not

move it out of theWorkarea folder, this file and the changeswill be

lost when you upgrade.

String

DynamicParameter

Sets the QueryString parameter to read a source’s ID

dynamically. For example, if your QueryString parameter for a

source ID isSID, enter that. See Also: "SourceId" on page 17-

169.

String

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

IdList

Enter a comma separated list of IDswhen the SourceType

property is set to IdList, TaxonomyList or CatalogList. See Also:

"Source Type Table" on page 17-166

String

Language

Set a language for viewing a product list. This property shows

results in design-time (in VisualStudio) and at run-time (in a

browser).

Integer

LoadingImage

The image to displaywhile the Product List is loading.

The default is<siteroot>\Workarea\images

\application\ajaxloader_circle_lg.gif.

String

PageSize

Specify the number of items to show per page when a site visitor

views the product list. If the number of itemsexceeds the quantity

defined in this property, the list is paged and the site visitor can use

the paging navigation system tomove through the list.

Integer

PageSpan

The number of pages to show before and after the current page.

Enter zero to show all pages.

For example, if you set this property to 2 and you are on page four

of the product list, you see:
Integer
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Property Description Data Type

SortMode

Select the default way the product list is sorted when a site visitor

first views the page. Once the page is loaded, a site visitor can

change the sort via a drop down list. Choicesare:

Title - sorts in alphabetical order.

SKU - sorts by the product number. This number is typically a

unique number supplied by the producer of the product.

Price Descending - sorts byprice from highest to lowest.

Price Ascending - sorts byprice from lowest to highest.

Highest Rated - sorts by rating from highest to lowest.

Lowest Rated - sorts by rating from lowest to highest.

Most Rated - sorts byproducts that havemost ratings from

highest to lowest.

See Also: "Sorting the Product List" on page 17-166

SortModes

SourceId

The ID of the catalog or taxonomy that is being used asa product

list. This property is used when the SourceTypeproperty is set to

Catalog or Taxonomy.

See Also: "Source Type Table" on page 17-166

Integer

SourceType

The type of source being used to create the list. Choicesare:

Catalog - use the SourceIdproperty to specify the ID of a single

catalog when this source type is selected.

CatalogList - use the IdListproperty to specify a list of catalog

IDswhen this source type is selected.

Taxonomy - use the SourceIdproperty to specify the ID of the

single taxonomywhen this source type is selected.

TaxonomyList - Use IdList property to specify a list of

taxonomy IDswhen this type is selected.

IdList - Use the IdListproperty to specify a list of product IDs

when this source type is selected.

See Also: "Source Type Table" on page 17-166

SourceObjectType

Stylesheet
Specify the path to a style sheet for use with this server control.

The location can be relative or absolute.
String

SuppressWrapperTags
Suppresses the output of the span/div tagsaround the control.

The default isFalse. Boolean
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Property Description Data Type

True - Suppresswrap tags.

False - Allow wrap tags.

TaxonomyDepth

Enter the number of taxonomy levels to retrieve below each

taxonomy/category. Only the top level is displayed in the control.

The rest of the levels are available through XML in code behind.

For example, if the taxonomy isDVDs > Movies > Comedies,

and you set Taxonomy Depth to 2, onlyDVDsandMoviesare

available in code behind.

To retrieve all categories for a taxonomy recursively, enter -1.

A depth greater than 1 or using -1 is only useful if you create a

custom output using the Taxonomy’sXML.

The default value is 1.

- For a live site, Ektron strongly recommends leaving this value at

1. Increasing this value can slow down your liveWeb server.

However, for testing on a staging server, you can increase the

depth.

Integer

TemplateProduct

Specify the URL that contains the Product server control. This

allowsa site visitor to see the details of the product when the

product link is clicked.

String

ProductSearch Server Control
The ProductSearch server control allows site visitors to search for products on your site.

Products are the same as catalog entries in the Workarea. For an eCommerce site, the ability to

find products or services on your site is key to generating more sales.

The ProductSearch server control is based on Ektron’s WebSearch server control. Products are

similar to content, and information about them is stored in Ektron’s Indexing Catalogs. This

provides extremely fast results without impacting the load on your database.

For information on how the Indexing Service works with search, see ”The Catalog and Index

Files” on page 9-7.

Note: While the ProductSearch server control is based on theWebSearch server control, some functionality

described in ”Searching Your Web Site” on page 9-4 doesnot apply to the ProductSearch server control. For

example, the ProductSearch only searches for products added to a Catalog in theWorkarea. It doesnot find

images, documentsor multimedia.
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When you place a ProductSearch server control on a Web page, and a site visitor browses to it,

he sees the following.

The control is divided into two sections:

n Basic Search (shown above)

n Advanced Search (access this by clicking the Advanced Search tab from the Basic Search

screen)

Basic Search
The Basic Search finds content that satisfies these criteria.

n published

n active (archived content is ignored)

n its Searchable check box is checked. See Also: "The Content Searchable Field" on page

17-174.

n public. However, private content is available to those with permission to view it, such as

membership users after logging in. See Also: ”Private Content” on page 7-237

n resides in the CMS catalog specified in the ProductSearch server control’s CatalogId

property, or in one of that folder’s subfolders if the control’s Recursive property is set

to true

n satisfies text and/or query entered in the search box (no value returns nothing)

- The text inserted in the search field can appear in the content or metadata

Searching Multiple Terms
If a site visitor enters several terms, the search only returns pages that include all terms. This is

known as an ‘and’ relationship. For example, if the site visitor enters cancer and cure in the

Search box, only content that includes both terms (and satisfies the other criteria) appears.

Ektron uses an ‘and’ relationship because we believe it’s what a site visitor expects. Consider a

simple Google search – the more you enter into the Google Search text box, the fewer results

you get, since your phrase is more precise.
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The advanced search screen, on the other hand, lets the site visitor determine if he wants an

and, or, not, or exact phrase relationship.

Advanced Search
The Advanced Search uses nearly all the same search criteria as the Basic Search. See Also:

"Basic Search" on page 17-171.

The differences are additional options and filters (explained below) and the fact that you

cannot use queries.
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Advanced Search Options

Search

Option
Finds these pages

with all of

the words

Web pagemust include all submitted terms; their position on the page doesnot

matter.

You cannot enter queries into this field.

advanced

search

exact

phrase

Web pagemust include the exact phrase. For example, if you enter Large

Round Window, a page with the term Large Round Tinted Window is not

found because it is not an exact match.

at least one

of the

words

Web page can include anyone of the submitted terms.

without the

words

Web page contains none of the submitted terms.

Only use this option if you also reply to one of the three fields above.

Advanced Result Filters
Below the Advanced Search Options is a list of additional fields you can use to refine the

search. These are titled Filter Results.

Result

Filter
Prompts site visitor to enter

Price

Below

the highest price for which a site visitor iswilling to search. This is based off of a

product’sSale Price not its List Price.

Price

Above

the lowest price for which a site visitor iswilling to search. This is based off a product’s

Sale Price not its List Price. For example, if you are searching for a product above

$350.00, products that lists for $400.00 and are on sale for $300.00 do not show up

in the results.

Product

SKU

the StockKeeping Unit for product. This information is set on the product’s

Properties tab in theWorkarea. See Also: "Entering a Catalog Entry’sProperties"

on page 17-137

To add a filter, click Add Filter. To remove a filter, click Remove to the right of the filter.
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The Content Searchable Field
Each content item includes a Content Searchable field. The search only considers catalog

entries whose field is checked. See illustration below.

By default, this field is checked when a product is created.

Display of Search Results
Below is an example of the ProductSearch server control’s results page. You can customize it

through the use of XSLTs and CSS files.
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Optionally, below the search box, a Filter by Category link can appear. When you set the

ShowCategories property to True, a site visitor can click it to see a folder structure of

taxonomy categories. He can then select categories of interest. When he does, only products

that include the search term and which are assigned to the selected categories appear.

Note: Filtering by categoryworks the samewayas in theWebSearch server control. See the section ”Filtering

Search Results byCategory” on page 9-99 in that chapter for additional information.

Query Language
Searching by Query Language is described in ”Query Language” on page 9-65. This

functionality works the same for product searches as it does for Web searches except for

properties related to documents, images and multi-media. Instead, the following properties can

be queried for products.

Product Search Query Properties Table
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Property Descriptions Example Results

edescription

Searchesonly the description of a product

for thematching text.

The description of a product is set in the

Content tab’s editor for a product in the

Workarea. See Also: "Creating a Product

Type Step 2: Creating the Content Page" on

page 17-124

@edescription

chair

Productswith

“chair” in the

description.

eheight

Searchesbased on the height of a product.

The height of a product is set on the

product’sProperties tab in theWorkarea.

See Also: "Entering a Catalog Entry’s

Properties" on page 17-137

@eheight = 40

@eheight > 40

@eheight < 40

Products that

have a height

equal to 40

inchesor

centimeters.

Products that

have a height

greater than

40 inchesor

centimeters.

Products that

have a height

less than 40

inchesor

centimeters.

eimage

Searchesbased on an image name

associated with a product; for example,

chair.jpg.

Imagesare associated with a product when

theyare added to a product’sMedia tab in

theWorkarea. See Also: "Entering a

Catalog Entry’sMedia" on page 17-146

@eimage

chair.jpg

Productswith

an associated

“chair.jpg”

image.

elength

Searchesbased on the length of a product.

The length of a product is set on the

product’sProperties tab in theWorkarea.

See Also: "Entering a Catalog Entry’s

Properties" on page 17-137”

@elength = 15

@elength > 15

@elength < 15

Products that

have a length

equal to 15

inchesor

centimeters.

Products that

have a length

greater than

15 inchesor

centimeters.

Products that

have a length

less than 15

inchesor

centimeters.
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Property Descriptions Example Results

elistprice

Searchesbased on the list price of the

product.

The list price for a product is set on the

product’sPricing tab in theWorkarea. See

Also: "Entering a Catalog Entry’sPrice

Information" on page 17-140

@elistprice =

299.00

@elistprice >

299.00

@elistprice <

299.00

Products that

have a list

price equal to

299.00.

Products that

have a list

price greater

than 299.00.

Products that

have a list

price less

than 299.00.

ereorderlevel

Searches for a product based on its reorder

level.

The reorder level for a product is set on the

product’sProperties tab in theWorkarea.

See Also: "Entering a Catalog Entry’s

Properties" on page 17-137

@ereorderlevel

= 125

@ereorderlevel

> 125

@ereorderlevel

< 125

Products that

have a

reorder level

equal to 125.

Products that

have a

reorder level

greater than

125.

Products that

have a

reorder level

less than 125.
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Property Descriptions Example Results

esaleprice

Searchesbased on the sale price of the

product.

The sale price for a product is set on the

product’sPricing tab in theWorkarea.See

Also: "Entering a Catalog Entry’sPrice

Information" on page 17-140

@esaleprice =

249.00

@esaleprice >

249.00

@esaleprice <

249.00

Products that

have a sale

price equal to

249.00.

Products that

have a sale

price greater

than 249.00.

Products that

have a sale

price less

than 249.00.

eskunumber

Searchesbased on the StockKeeping Unit

for product.

This information is set on the product’s

Properties tab in theWorkarea. See Also:

"Entering a Catalog Entry’sProperties" on

page 17-137”

@eskunumber

52-154

Products that

have a

matching

SKU.

eunitsinstock

Searches for a product based on its level of

units in stock.

The units in stock for a product is set on the

product’sProperties tab in theWorkarea.

See Also: "Entering a Catalog Entry’s

Properties" on page 17-137

@eunitsinstock

= 63

@eunitsinstock

> 63

@eunitsinstock

< 63

Products that

have a unit

stock level

equal to 63.

Products that

have a unit

stock level

greater than

63.

Products that

have a unit

stock level

less than 63.

eunitsonorder

Searches for a product based on the

amount of units on order.

The amount of units on order for a product is

set on the item’sProperties tab in the

Workarea. See Also: "Entering a Catalog

Entry’sProperties" on page 17-137

@eunitsonorder

= 30

@eunitsonorder

> 30

@eunitsonorder

< 30

Products that

have an on

order level

equal to 30.

Products that

have an on

order level

greater than

30.

Products that

have an on

order level

less than 30.
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Property Descriptions Example Results

eweight

Searchesbased on the weight of a product.

The weight of a product is set on the

product’sProperties tab in the

Workarea.See Also: "Entering a Catalog

Entry’sProperties" on page 17-137”

@eweight = 45

@eweight > 45

@eweight < 45

Products that

have a weight

equal to 45

units.

Products that

have a weight

greater than

45 units.

Products that

have a weight

less than 45

units.

ewidth

Searchesbased on the width of a product.

The width of a product is set on the product’s

Properties tab in theWorkarea. See Also:

"Entering a Catalog Entry’sProperties" on

page 17-137

@ewidth = 7

@ewidth > 7

@ewidth < 7

Products that

have a width

equal to 7

inchesor

centimeters.

Products that

have a width

greater than

7 inchesor

centimeters.

Products that

have a width

less than 7

inchesor

centimeters.

The Add to Cart Link in a Search Result
Site visitors can add a product to their cart directly from the search results by clicking an Add

to cart link in a search result. This link appears below the price and allows them to skip the

product’s information page and add the product directly to their cart.
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By default, this link appears when the following conditions are met:

n The product is a simple product, kit or bundle. The link does not appear for complex

product types. In complex product types, site visitors must select one variation of a

product. For example, you are selling movies and the site visitor needs to select between

either DVD or Blue-Ray format.

The product is buyable. That is, there is a check mark in the Buyable property for a product in

the Workarea. See Also: "Entering a Catalog Entry’s Properties" on page 17-137”

n The product has an In Stock quantity of at least one.

n The TemplateCart property has a cart’s template location defined.

Property Usage Table
Properties in the ProductSearch server control generally affect the control in one of three ways:

n Search Display - the ProductSearch server control’s appearance on your site.

n Search Criteria - criteria used to search the site

n Search Results Display - appearance of search results on your site
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The following table shows which properties are associated with each category. See Also:

"ProductSearch Server Control Properties" on page 17-182

Search Display Search Criteria Search Results Display

ButtonImgSrc

ButtonText

EnableAdvancedLink

Hide

Language

MaxCharacters

TextBoxSize

CatalogId

Language

Recursive

ShowCategories

TaxonomyOperator

CustomOrderBy

CustomXml

DisplayXslt

Hide

Language

LinkTarget

LoadingImage

MaxTeaserLength

OrderBy

OrderDirection

ResultsPageSize

ResultTagId

ShowCustomSummary

ShowSearchBoxAlways

Stylesheet

SuppressWrapperTags

TemplateCart

TemplateProduct

Flow of the ProductSearch Server Control
The following image depicts the flow of the ProductSearch Server Control.
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ProductSearch Server Control Properties
The following table explains the properties of the ProductSearch control.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer

and can use it to browse to Content, Collections, etc.See
Also: ”Using CMSExplorer to Browse Your Ektron
CMS400.NET Site” on page 21-12

String

ButtonImgSrc
If you want to display an image on theSubmit button, enter

the server path to it.
String

ButtonText

The text used for theSubmit button if no image source is

identified. If an image source is identified, this is alternative

text for the button.

String

eCommerce

17-182
ReferenceManual

Version 8.0 Rev 1.3

#
#
#
#
#
#
#
#
#
#
#
#
#


Property Description Data Type

CatalogId

The catalog at which the search begins. The starting folder

need not be the root folder.

The Recursive property determines if the search

examines this folder’s subfolders.

See Also: ”Using CMSExplorer to Browse Your Ektron
CMS400.NET Site” on page 21-12

String

CustomOrderBy

Provide a property’s FriendlyName defined in the Indexing

Service to sort search results by that property.

Results can be ascending or descending based on

OrderDirection. If you enter an invalid property, no search

results are returned.

If you specifyCustomOrderBy and OrderBy, the

OrderByproperty is ignored. The FriendlyName of a

property can be found inComputer Management >

Services and Applications > Indexing Service >Your

Index >Properties >Friendly Name column.

String

CustomXml

(Code Behind Only)

Providesamechanism to inject custom XML into the

generated XML before being processed by the XSLT. The

injected XML is appended to the end of the XML produced by

this control.

See Also: ”Displaying CustomXML in Ektron’sServer

Controls” on page 21-50

String

DisplayXslt

Specify an externalXSLT file to render the control. By

default, the control usesProductSearch.xsl. This file

is located in

<SiteRoot>\Workarea\Xslt\Commerce

Important: If you want to edit this file, it is strongly

recommended that youmake a copy, change its name and

move it outside your site’sWorkarea folder. If youmake

changes to this file and do not move it out of theWorkarea

folder, this file and the changeswill be lost when you

upgrade.

String

DynamicProductParameter

TheQueryString parameter namewhich is used to pass the

product ID to the product details page. For example, if your

QueryString parameter for products is ID, enter that in this

property. Then, when site visitors click a product in their

search results, this parameter is passed with the product’s ID

to the product details page.

String
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Property Description Data Type

EnableAdvancedLink

Set to True to display anAdvanced Search tab on the

ProductSearch control.

Boolean

Hide

Used to hide ProductSearch Server Control in design time

and runtime.

True =Hide control

False =Show control

Boolean

Language

If the template on which this server control resides includesa

language selection control, and you want to let the site visitor

select the language, enter zero (0).

Otherwise, click the field, then the ellipsis button ( ) and a
popup boxappears. Select a language from the list.

This property shows results in design-time (in VisualStudio)

and at run-time (in a browser).

Integer

LinkTarget

Defineshow a link on the search results display actswhen

clicked. The choicesare:

_blank - loads the link in a new blankwindow. Thiswindow is

not named.

_self - loads the link in the samewindow the anchor was

clicked in. This is useful for overriding a globally assigned

base target.

_parent - loads the link in the immediate frameset parent of

the document. This defaults to acting like “_self” if the

document hasno parent.

_top - loads the link in the full bodyof the window. This

defaults to acting like “_self” if the document is alreadyat the

top. It is useful for breaking out of an arbitrarily deep frame

nesting.

String

LoadingImage

The image to displaywhile the product search is loading.

The default isajaxloader_circle_lg.gif.

This file is located in:<siteroot>

\Workarea\images\application

String
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Property Description Data Type

MarkupLanguage

As of 7.6.1 this property

does not work. It should

work in a future

release.

Identify the template markup file that controls the

display of search results. For example,

myproductsearchmarkup.ekml.

If the *.ekml file is located in the same folder as the

Web form containing the server control, just enter

its name. If the file is in another folder, enter the

path relative to site root. For example,

\siteroot\workarea\customfiles

\markup\myproductsearchmarkup.ekml.

If you enter a valid EkML file, the Displayxslt and

Stylesheet property values are ignored.

See Also: ”Ektron Markup Language” on page

 Right.

String

MaxCharacters

Themaximum number of characters theSearch text box

accepts.

If you enter a value less than 50, set the TextBoxSize

property to the same number.

Integer

MaxTeaserLength

Limits the length of any returned content’s abstract. To allow

unlimited length, set to zero.

This property is active only if both of these conditionsare

true.

you usethe DisplayXslt property to identify an XSLT and

ecmteaser asa value of that property.

the ShowCustomSummaryproperty is set to false. If

ShowCustomSummary is set to true, the entire summary

appears in search results.

Integer

OrderBy

The order of search results. For example, you want to sort

search results by last modified date.

Note: TheOrder Direction field determines the direction of

the search results. For example, if you sort by ID and

OrderDirection is set toDescending, the results sort by

ContentID number with the highest number at the top of the

list.

String

OrderDirection

The direction in which search results are sorted. The default

isAscending.

Ascending - Alphabetical results from A to Z; numeric

values low to high; dates from oldest to most recent

Descending - Alphabetical results from Z to A; numeric

valueshigh to low; dates frommost recent to oldest

String

Recursive
Set to True to search sub-folders of the starting folder. The

starting folder is identified in the CatalogIDproperty.
Boolean
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Property Description Data Type

ResultsPageSize

Set themaximum number of results on a page. If a search

returnsmore than this number of results, the following text

appears below the last one:

Result Page: 1 2 3 Next

The site visitor can clickNext or a number to view additional

results.

This property defaults to the value set at the ek_

PageSize element in the web.config

file.Property’s Effect on Suggested Results

Only the number of Suggested Results up to this

maximum appear. If more than this number should

display, they do not.

This is unlike natural search results, whose

additional links are available via numbers below

the maximum page size.

See Also: Ektron CMS400.NET Administrator Manual

“Searching Your Web Site” > “Suggested Results”

Integer

ResultTagId

Lets you designate where search results appear. You can

place search criteria in one area of aWeb form and the

results in another.

For example, you have the following tag.

<span id=”results”></span>

In this case, enter results for this property value.

Additional information can be found in theWebSearch

server control section ”ResultTagId” on page 9-85.

String

ShowCategories

If set to true, when this server control appears, the site visitor

see a Filter by Category option. This option helpsa site

visitor zero in on relevant content.

If false, the Filter by Category option doesnot appear.

Note: To see the Filter by Category option, the

ShowSearchBoxAlwayspropertymust be set totrue.

Additional information can be found in theWebSearch

server control section ”Filtering Search Results byCategory”

on page 9-99.

Boolean

ShowCustomSummary

If set to true, the search results display the content item’s

summary instead of the characterization.

Note: If this property is set to true, the MaxTeaserLength

property is ignored. So, the entire summaryappearswith

search results, regardlessof length.

If false, the search results display the characterization.

The default is false.

See Also: ”Displayof Search Results” on page 9-30

Boolean
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Property Description Data Type

ShowSearchBoxAlways

If set to true, the search boxappears on the PostBack

screen.

If false, the search boxdoesnot appear on the PostBack

screen.

The default is true.

Boolean

Stylesheet

Specify the location of a style sheet to use for the search

results page. Set the location relative to the site root folder.

For example:Workarea\csslib\mytest.css

String

SuppressWrapperTags

Suppresses the output of span/div tagsaround the control.

The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TaxonomyOperator

Select whether to use anAnd orOr operator when filtering

results by taxonomy. Bydefault, the property is set toOr.

This allows for a wider range of returned results.

And - Only results that match all categories selected in the

Filter byCategory tree appear. For example, if you are

searching for amedical document in the Hospital and

Doctor’sOffice categories, the document must be assigned

to both categories or it is not shown.

Or - whenmore than one category is selected in the Filter by

Category tree, resultsmust match at least one category to

be shown.

Note: For this property to be active, the ShowCategories

propertymust be set to True.

See Also: ”Filtering Search Results byCategory” on
page 9-99

Enum -

TaxCategoryOperator

TemplateCart

Controlswhether theAdd to Cart link appearswith search

results. Enter the URL path of the template that contains the

Cart server control. This path can be relative or absolute.

See Also: "The Add to Cart Link in a Search Result" on
page 17-179 and "Cart Server Control" on page 17-3.

String

TemplateProduct

Specify the URL that contains the Product server control.

This allowsa site visitor to see the details of the product when

the product link is clicked. This path can be relative or

absolute.

String

TextBoxSize
The size of theSearch text box for user input. The width is

based on the number of characters.
Integer
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eCommerce Analytics
The eCommerce Analytics screen provides a visual display of order information for a selected

catalog entry.

n The top left section graphs the quantity of this catalog entry ordered over the past seven

days

n The top right charts the number of orders that used a coupon versus the number that did

not

n Below that pie chart is another that shows the number of returning customers versus the

number of new ones

n The lower part of the screen shows the following order information

- order number

- date/time when order was entered

- site from which order was entered

- order status

- customer information: new or returning, name, number of orders entered, value of all

orders entered, average order monetary value

- order monetary value

- whether or not a coupon was used

eCommerce Recommendations

Adding Cross Sell and Upsell Recommendations to a
Catalog Entry

Cross sell and upsell tactics are designed to increase the amount of cart sales.
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Cross sell offers items related to a catalog entry. So, for example, if someone is purchasing a

digital camera, cross sell items might be a carrying bag, digital photo printer, larger memory

cards, additional warranty, etc.

Up Sell refers to similar but more expensive items. So, for example, if someone is viewing a 7

megapixel digital camera, upsell items might be a 10 megapixel camera, or a digital SLR

camera.

The following sections explain how to assign cross sell and up sell items to any catalog entry,

and how to display those options on your Web site.

See Also:

n "Assigning Cross Sell and Upsell Items to a Catalog Entry" on page 17-189

n "Displaying Cross Sell and Upsell Items on Your Web Site" on page 17-190

Assigning Cross Sell and Upsell Items to a Catalog Entry
1. Open the catalog folder containing the catalog entry to which you want to assign cross

sell items.

2. Click that entry.

3. Click View > Cross Sell or View Upsell.

4. Click the Add button ( ).

5. A screen displays all catalog folders.

6. Open the folder that contains the cross sell or upsell catalog entry.

7. Click that catalog entry.

8. Press OK.

9. Enter additional cross sell entries as needed.

10. Click Action > Save.
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Displaying Cross Sell and Upsell Items on Your Web Site
Use the Recommendation server control to place cross sell or upsell items anywhere on a Web

page. A single control can only show either cross sell or upsell items.

See Also: "Recommendation Server Control" on page 17-190

Recommendation Server Control
Prerequisite: Cross sell or upsell products have been assigned to a catalog entry. See Also:

"eCommerce Recommendations" on page 17-188

The Recommendation server control allows you to cross-sell or up-sell products to a site visitor

based on another product’s ID. After a user creates a product in the Workarea, he can define a

list of other products he wants to associate with the newly-created product. This can be done

while viewing a product in the Workarea and selecting the View menu > Cross Sell or Up sell.

Then, by adding the Recommendation server control to a Web form that contains a Product

server control, the site visitor sees the recommendations when he views the details of the

product.

Typically, this control appears on a page along with a “Product server control.” By using this

control in conjunction with the Product control, a site visitor can view the details of a product
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and also receive suggestions on additional purchases. A site visitor can click the title to view

the suggested product to view its details.

For example, if your site is selling a hat, mitten and scarf set, you might use this server control

to cross-sell winter jackets. You could also use the control to up-sell a more expensive hat,

mitten and scarf set, or a set that includes additional items.

For information on adding cross sell and upsell information to a product in the Workarea, see

"Adding Cross Sell and Upsell Recommendations to a Catalog Entry" on page 17-188”.

Setting the RecommendationType property determines whether the Recommendation server

control is used for up-selling or cross-selling.

Enabling the Add to Cart Button
Site visitors can add a product to their cart directly from the Recommendation server control

by clicking an Add to cart button next to a product. This link appears below the price and

allows them to skip the product’s information page and add the product directly to their cart.
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By default, this button appears when the following conditions are met:

n The product is buyable. That is, there is a check mark in the Buyable property for a

product in the Workarea. See Also: "Buyable" on page 17-138”

n The product has an In Stock quantity of at least one.

n The TemplateCart property has a cart’s template location defined.

In addition, when a product has an alias path associated with it, you need to do the following:

n Make sure the TemplateCart property’s path is relative to the site root. For example:
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TemplateCart="Developer/Commerce/CartDemo.aspx"

n Add the following to the code behind page. This example is in C#:

protected void Page_Init(object sender, EventArgs e)

{

Utilities.RegisterBaseUrl(this.Page);

}

Recommendation Server Control Properties
The following table explains the properties of the Recommendation control.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the

CMSExplorer and can use it to browse to

Content, Collections, etc. See Also: ”Using CMS

Explorer to Browse Your Ektron CMS400.NET

Site” on page 21-12

String

CacheInterval

Sets the amount of time the server control’s data is

cached. The default is 0 (zero). This is the amount

of time, in seconds, a control’s data is cached. For

example, if you want to cache the data for five

minutes, set theCacheInterval property to

300 (three hundred). See Also: ”Caching with

Server Controls” on page 21-42

Double

CustomXml

(Code Behind Only)

Providesamechanism to inject custom XML into

the generated XML before being processed by

the XSLT. The injected XML is appended to the

end of the XML produced by this control.

See Also: ”Displaying CustomXML in Ektron’s

Server Controls” on page 21-49

String

DefaultProductID

Enter a default product ID that contains either

cross sell or up sell products. Tomake the server

control dynamic, enter zero (0) in this property

and set theDynamicProductParameter to

QueryString parameter used to pass the product’s

ID.

Integer
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Property Description Data Type

DisplayXslt

Specify an externalXSLT file to render the control.

Bydefault, the control uses

Recommendation.xsl. This file is located in

<SiteRoot>\Workarea\Xslt\Commerce

Warning! Important: If you want to edit this file,

it is strongly recommended that youmake a copy,

change its name andmove it outside your site’s

Workarea folder. If youmake changes to this file

and do not move it out of theWorkarea folder,

this file and the changeswill be lost when you

upgrade.

String

DynamicCartParameter

The QueryString parameter name which is

used to pass the product ID to the Cart

server control. For example, if your

QueryString parameter for products is

Product, enter that in this property. Then,

when site visitors click the Add to Cart

button, this parameter is passed with the

product’s ID Web form containing the Cart

server control. See Also: "Cart Server

Control" on page 17-3

String

DynamicProductParameter

TheQueryString parameter namewhich is used

to pass the product ID to the product details page.

For example, if your QueryString parameter for

products is ID, enter that in this property. Then,

when site visitors click a product’s title, this

parameter is passed with the product’s ID to the

product details page.

String

Hide

Used to hide the Server Control in design time and

runtime.

True =Hide control

False =Show control

Boolean

Language

If the template on which this server control resides

includesa language selection control, and you

want to let the site visitor select the language,

enter zero (0).

Otherwise, click the field, then the ellipsis button (

) and a popup boxappears. Select a
language from the list.

This property shows results in design-time (in

VisualStudio) and at run-time (in a browser).

Integer
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Property Description Data Type

MarkupLanguage

As of 7.6.1 this property

does not work. It should

work in a future

release.

Identify the template markup file that

controls the display of the server control.

For example, mymarkup.ekml. If the *.ekml

file is located in the same folder as the

Web form containing the server control,

just enter its name. Otherwise, the path to

the file can be relative or absolute. See

Also: ”Ektron Markup Language” on page

 3636.

String

PageSize

Specify the number of items to show per page

when a site visitor views recommendations. If the

number of itemsexceeds the quantity defined in

this property, the list is paged and the site visitor

can use the paging navigation system tomove

through the list.

Integer

RecommendationType

The type of recommendation to show. Choicesare:

n CrossSell - used to help sell additional products that a site visitor

might be interested in. For example, if you are selling Denim Jackets, you

might want to cross sell them pants or shirts.

n UpSell - used to sell additional products that improve on the product

being purchased. For example, if you are selling 7megapixel digital cam-

eras, youmight want show the site visitor 10megapixel digital cameras.

See Also: "Adding CrossSell and UpsellRecommendations to a Catalog

Entry" on page 17-188

Data Type: EkEnumeration.RecommendationType

Stylesheet

Specify the location of a style sheet to use for the

recommendation. Set the location relative to the

site root folder. For example:

Workarea\csslib\mytest.css

Leave blank to use the default style sheet.

String

SuppressWrapperTags

Suppresses the output of span/div tagsaround

the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean
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Property Description Data Type

TemplateCart

The URL to navigate to when the site visitor clicks

theAdd to Cart button. This path can be relative

or absolute.

When a path is entered, theAdd to Cart button

appears next to the product and allowsa site

visitor to add the product directly to their cart. See

Also: "Enabling the Add to Cart Button" on page

17-191 and "Cart Server Control" on page 17-3.

String

TemplateProduct

Specify the URL that contains the Product server

control. This allowsa site visitor to see the details

of the product when the product link is clicked. This

path can be relative or absolute.

String
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eCommerce Order Management

The fulfillment aspect of eCommerce involves

n tracking submitted orders, including

- order status

- charge capture

- shipping

- cumulative sales information on customers

For more information, see "Orders" on page 17-197.

n customer information, such as

- orders submitted

- addresses

- current shopping carts

For more information, see "Customer Information" on page 17-211.

Orders
The orders screen provides information about all orders in your eCommerce system. To access

it, go to Ektron CMS400.NET Workarea > Settings > Commerce > Fulfillment > Orders.

Warning! In order to processorders, the Distributed Transaction Coordinator (DTC) Windowsservicemust be

running. It is started bydefault when you install Ektron CMS400.NET.

Initially, orders are sorted by submission date and time, with the most recent at the top.
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See Also:

n "Selecting Orders by Criteria" on page 17-198

n "Order Statuses" on page 17-198

n "The View Order Screen" on page 17-199

n "Capturing the Order" on page 17-200

n "Cancelling the Order" on page 17-202

n "Entering a Tracking Number" on page 17-202

n "Marking the Order as Fraud" on page 17-203

Selecting Orders by Criteria
You can select orders by any of the following criteria.

n entry date range

n customer

n catalog entry

To use any filter, click Reporting (see below) then the appropriate filter option.

Note: TheMost Recentmenu option is the default select and sort order: all orderswith themost recent on top.

See Also: "Orders" on page 17-197

Order Statuses

Note: The following table assumesyou use the default workflow installed with eCommerce. If you customize the

workflow, the following tablemaybe inaccurate. See Also: "CustomizingWorkflows" on page 17-249”
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Status Description How Set

Received Order hasbeen submitted. Site visitor submits order

Fraud
Your organization hasdetermined

that the order is fraudulent.

View Order Screen >ActionMenu >Mark

asFraud

Shipped

Order hasbeen shipped

Note: This status can be the

workflow’s end point. You do not

need to use the Completed status.

View Order Screen >ActionMenu >Ship

Order

or

View Order Screen >ActionMenu >

Enter/Edit Tracking Number >Check

Mark as Shipped checkboxand save

Completed

All order activities are finalized. No

events can occur to a Completed

order.

View Order Screen >ActionMenu >

ProcessOrder

Cancelled Order hasbeen cancelled.
View Order Screen >ActionMenu >

CancelOrder

InProcess
Automatically assigned when order

is submitted.
Order placed but not yet captured

The View Order Screen
To view the details of any order, click it. When you do, the View Order screen appears. From

this screen you may view the following about the order.

n Summary (shown below)

n Status

n Payment

n Coupons

n Address

n Description

n Workflow
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Note: If the ViewWorkflow option doesnot displaya flowchart, verify that the server’sDistributed Transaction

Coordinator (DTC) Windowsservice is running. It is started bydefault when you install Ektron CMS400.NET, but if

it stops for some reason, theWorkflow doesnot appear on this screen.

The View Order screen’s Action menu has the following options.

n Capture - See "Capturing the Order" on page 17-200

n Mark as Fraud - "Marking the Order as Fraud" on page 17-203

n Edit Tracking Number - "Entering a Tracking Number" on page 17-202

n Cancel Order - "Cancelling the Order" on page 17-202

You can also edit the order’s billing and shipping addresses. See "Editing an Order’s Billing

and Shipping Addresses" on page 17-203.

These options are explained below.

Capturing the Order

Authorization versus Capture
Authorization occurs while a customer is using the Checkout server controls. It submits a

customer’s payment information to a payment gateway, bank, or PayPal, and returns either an

approval with an authorization number (transaction ID) or a decline along with an explanation.

Capture is the process of submitting encrypted order information (including the transaction ID)

to a payment gateway account, bank, or PayPal. At this time, the account is charged for the

order amount.

NOTES
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Note: * In manystates, youmust ship an item before you can charge a customer’s credit card for it.

* Items that are not tangible are automatically captured if paid byPayPal or a credit card. See Also: "Tangible Item"

on page 17-139

Next, you receive confirmation from the paying agency that the money has been deposited to

your account and is available. At this time, you use the Mark as Settled option to inform the

eCommerce feature that payment has been received. This changes the order status to Complete.

Payment Method Tangible item Intangible Item

PayPal or credit card When goodsare shipped When customer submits order

Check When check clears When check clears

See Also: "Payment Options" on page 17-61

The Capture
To capture an order, follow these steps.

1. Workarea > Settings > Commerce > Fulfillment > Orders.

2. Click the order that you want to capture.

3. Click the Payment link (see illustration below).

4. The View Payment screen appears, showing information about the transaction captured

when the site visitor submitted his payment information.
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5. Click Action > Capture.

6. You are asked to confirm the action.

7. Click OK.

Cancelling the Order
Click Action > Cancel Order to stop all processing on the order. If you do, the order’s status

changes to Cancelled.

Entering a Tracking Number
When an order is shipped, the shipping provider typically provides a tracking number to help

locate the shipment within the delivery chain. Use the Enter Tracking Number option to

enter this part of the order information.
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After entering the tracking number, you can indicate whether the order has shipped.

Viewing the Tracking Number
You can see an order’s tracking number on the View Order screen, under the Shipping

Address (as illustrated below).

Marking the Order as Fraud
Use this option if your organization determines that the order is fraudulent. These orders

cannot be processed any further.

Marking the Order as Shipped
To denote that an order has shipped, follow these steps.

Note: If that order hasnot yet been captured, it will be captured aspart of the shipping of the order.

1. Go to Settings > Commerce > Fulfillment > Orders.

2. Click the order that is being shipped.

3. Click Action > Ship Order.

Alternatively, you can mark the order as shipped while entering its tracking number. See Also:

"Entering a Tracking Number" on page 17-202

Editing an Order’s Billing and Shipping Addresses
To edit an order’s billing or shipping address, click Edit as circled below.
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Order Workflow
Ektron CMS400.NET uses Microsoft’s Windows Workflow Foundation to create and

implement order process workflows to handle the ordering process. The workflow can be as

simple or complex as your business requires.

For example, you could have a simple workflow that sends one email to the customer when an

order is received, and another to your shipping department. Or, you could have a more complex

workflow that:

n sends an email to the customer when the order is received

n checks to see whether the item is a tangible product or a virtual product. Then, continues

down the workflow path that’s appropriate for the item.

n handles shipping notifications and updates the account throughout the

n shipping process

n handles the order if it is canceled

n handles the order if it is determined to be fraudulent

n marks the order as complete once all activities are finished

For more information on workflows, see "Customizing Workflows" on page 17-249.
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OrderList Server Control
The OrderList server control allows site visitors to view a list of processed orders. Site visitors

typically reach this server control by clicking a link on your site, such as the View Order

History link (shown below).

Site visitors can also reach this control is through a link at the end of the Checkout process.

The link appears when the Checkout server control’s TemplateOrderHistory property

contains the path to the template containing the OrderList server control. See Also: "Checkout

Server Control" on page 17-16.

Viewing a Site Visitor’s Orders List
When site visitors arrive at this server control, they see the View All Orders portion of the

server control.

This part of the server control allows site visitors to view a list of submitted orders. They can

view the date of each order, its confirmation number and its status. When the number of orders

exceeds the number defined in the MaxResults property, the list is paged and a user can

navigate from page to page with the links and buttons provided.

A site visitor can click the confirmation number to access (or view) the Order Details screen.
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To navigate back to the list of all orders, site visitors click the View All Orders button.

Viewing an Order’s Details
The order details portion of this control displays the following information.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Field Description

Status The status of the order. See Also: "Order Statuses" on page 17-198

Order Date
The date the order was submitted. This is the date an order went through the

checkout process.

Order

Number
The ID number of the order.
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Field Description

Ship To:

Information needed to ship the order to customer. The following information is

included in this area.

Person to which the product is being shipped

CompanyName (optional)

Street Address

City and State or Region

Country

Zip Code

Tracking Number - this field appears if a tracking number hasbeen entered in the

View Order screen in theWorkarea.See Also: "Entering a Tracking Number" on

page 17-202”

Bill To:

Displays information about who is being billed for the order.

Person paying for the order

Credit Card information - For security purposes, only the last four digits appear.

CompanyName (optional)

Street Address

City and State or Region

Country

Zip Code

Description

A list of products in the order.When the path to the product server control is

entered in the TemplateProductproperty, the product’s title becomesa

hyperlink.

Quantity The total number of each product.

Sale Price The per unit price of each product.

Total
The total amount paid for each product ordered. This is the Unit Pricemultiplied

by the Quantity.

Subtotal
The sum of all the order’s line products before additional chargesor discounts,

such as tax, shipping and coupons.

Coupon

Total
The total amount discounted, based on all applied coupons.

Tax
The taxamount applied to this order. See Also: "How anOrder’s TaxAmount is

Calculated" on page 17-95

Shipping
This is the amount being charged to ship the order to the recipient. See Also:

"eCommerce Shipping Screens" on page 17-85

Total The sum of all charges, including all line items, tax, shipping and handling.
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Flow of the OrderList Server Control
The following image depicts the flow of the OrderList Server Control.

OrderList Server Control Properties
The following table explains the properties of the OrderList control.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer

and can use it to browse to Content, Collections,

etc. See Also: ”Using CMSExplorer to Browse

Your Ektron CMS400.NET Site” on page 21-12

String

CacheInterval

Sets the amount of time the server control’s data is

cached. The default is 0 (zero). This is the amount

of time, in seconds, a control’s data is cached. For

example, if you want to cache the data for five

Double
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Property Description
Data

Type

minutes, set theCacheInterval property to

300 (three hundred). See Also: ”Caching with

Server Controls” on page 21-42

CustomXml

(Code Behind Only)

Providesamechanism to inject custom XML into

the generated XML before being processed by

the XSLT. The injected XML is appended to the

end of the XML produced by this control.

See Also: ”Displaying CustomXML in Ektron’s

Server Controls” on page 21-49

String

DefaultUserId
The default ID of the user for which to display a list

of orders.
Long

DisplayXslt

Specify an externalXSLT file to render the control.

Bydefault, the control usesOrderList.xsl.

This file is located in

<SiteRoot>\Workarea\Xslt\Commerce

Important: If you want to edit this file, it is strongly

recommended that youmake a copy, change its

name andmove it outside your site’sWorkarea

folder. If youmake changes to this file and do not

move it out of theWorkarea folder, this file and the

changeswill be lost when you upgrade.

String

DynamicProductParameter

TheQueryString parameter namewhich is used

to pass the product ID to the product details page.

For example, if your QueryString parameter for

products is ID, enter that in this property. Then,

when site visitors click a product in their order list,

this parameter is passed with the product’s ID to

the product details page.

String

DynamicOrderParameter

Sets the QueryString parameter namewhich is

used to passan order ID dynamically. Bydefault,

this parameter isOID.

String

Hide

Used to hide the control in design time and run

time.

True =Hide the control

False =Show the control

Boolean
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Property Description
Data

Type

Language

Set a language for viewing theOrderList control.

This property shows results in design-time (in

VisualStudio) and at run-time (in a browser).

Integer

MarkupLanguage

As of 7.6.1 this property

does not work. It should

work in a future release.

Identify the template markup file that

controls the display of the server control.

For example, mymarkup.ekml. If the *.ekml

file is located in the same folder as the

Web form containing the server control,

just enter its name. Otherwise, the path to

the file can be relative or absolute. See

Also: ”Ektron Markup Language” on page

 3636.

String

MaxResults

Specify the number of orders to show per page

when a site visitor views their order history. If the

number of orders exceeds the quantity defined in

this property, the list is paged and the site visitor

can use the paging navigation tomove through

the list. Integer

PageSize
Themaximum number of orders to show per

page.
Integer

Stylesheet

Specify the path to a style sheet for use with this

server control. The location can be relative or

absolute. Leave blank to use the default style

sheet.

String

SuppressWrapperTags

Suppresses the output of the span/div tags

around the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TemplateProduct

The URL path of the template that allowsa site

visitor to view the details of a product in an order.

When a path is entered, the product’s title

becomesa link that allows site visitors to navigate

to the template containing details of the product;

for example, the template containing a Product

server control. See Also: "" on page 17-211.

String
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Customer Information
Customers create an account the first time they complete the checkout procedure. The

Customers screen provides information about all customers who order from your Web site. The

first screen presents the

n customer ID number

n user name

n number of orders

n amount of all orders

n average order amount

You can click any customer’s ID number or name to see more details about his order history.

The View Customer screen (shown below) provides information about the customer’s

n summary information (name, number of orders, total of all orders, average order amount)

n orders (see "Customer Information" on page 17-211)

n addresses

- You can edit any address or enter a new one (see "Entering a New Customer Address"

on page 17-212)

- Whenever a user creates a new order and enters a new or selects an existing

billing/shipping address, that becomes the new default

n shopping carts (see "Viewing a Customer’s Shopping Cart" on page 17-213)
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The My Account Server Control
While you use this screen to view and update customer information within the Ektron

CMS400.NET Workarea, your site visitors use the My Account server control on your Web site

to enter and update their information. For more information, see "MyAccount Server Control"

on page 17-213.

Entering a New Customer Address
Use this screen to enter a new address for a customer or edit an existing one. It may be used as

the default billing address, shipping address, or both.

Use the following table to complete the screen.

Field Description

Name Enter the customer’s name.

Company If available, enter the name of the customer’s company.

Street Address Enter the customer’s street address.

City Enter the customer’s city.

PostalCode Enter the customer’s postal code.

Country
Select the customer’s country from the pull-down list. See Also:

"Countries" on page 17-47

State/Province
Select the customer’s state or province from the pull-down list.

See Also: "Regions" on page 17-50

Phone

Enter the customer’s phone number.

You can add characters or spacesbetween groupings if you

wish. For example: 603-594-0249.

Default Billing
If you want this address to appear bydefault as the billing address

whenever this customer makesa purchase, check this box.

Default Shipping

If you want this address to appear bydefault as the shipping

addresswhenever this customer makesa purchase, check this

box.
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Viewing a Customer’s Shopping Cart
To view active shopping carts for a customer, follow these steps. After viewing the carts, you

can delete any of them.

1. Settings > Settings >Commerce > Customers.

2. Click a customer ID number.

3. Click the Baskets tab.

4. Click the ID number of the shopping cart that you want to view.

5. A View Cart screen shows information for items in the cart.

Deleting a Shopping Cart from the Workarea
Follow these steps to delete a shopping cart from the Ektron CMS400.NET Workarea.

1. Access the View Cart screen by following the steps in "Viewing a Customer’s Shopping

Cart" on page 17-213.

2. Click the delete button ( ).

3. A confirmation message appears. Click OK.

MyAccount Server Control
The MyAccount server control allows logged in site visitors to view and edit their Personal

Information, Billing Address and Shipping Address. If the site visitor is not logged in and

arrives at this control, one of the following happens:

n he receives a message that states he is not logged in. This happens when the server

control’s RedirectUrl property is empty and the web.config file’s <add
key=”ek_RedirectToLoginURL” value=”” /> value is blank.

n he is redirected to a login page and once logged in, he is sent back to the template

containing the MyAccount server control. This happens when either the server control’s

RedirectUrl property contains the path of a template that contains a Login server
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control or when the web.config file’s <add key=”ek_
RedirectToLoginURL” value=”” /> value is set to the path of a template

that contains a Login server control. If the control’s RedirectUrl property and the

web.config file contain different locations, the RedirectUrl property in the

control overrides the web.config file.

Typically, the information displayed in this control is collected the first time a site visitor goes

through the checkout process. A site visitor’s information might appear in the Personal

Information area before they have been through the checkout process if they are a current

CMS400.NET user or registered membership user.

If a logged in site visitor arrives at this server control and is missing required information, he

must enter it before continuing. For example, a site visitor needs to provide his Last Name or

E-mail Address.

As a developer, you need to create a link to this control in a site location that appears only

after log in. For example, you might place the link on a menu or on a master page that appears

after a site visitor logs in.

This section includes the following topics:

n "Flow of the MyAccount Server Control" on page 17-215
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n "The Personal Information Area" on page 17-216

n "The Billing Address Area" on page 17-217

n "The Shipping Address Area" on page 17-219

n "MyAccount Server Control Properties" on page 17-222

Flow of the MyAccount Server Control
A site visitor typically arrives at this control by clicking a link placed on a main page, master

page, or menu. Below is an example image.

Below is an image depicting the flow of the MyAccount server control.
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The Personal Information Area
The Personal Information area allows site visitors to view and edit some information contained

in their profile. By default, a site visitor can edit their First Name, Last Name, email Address,

and Password. By adding a list of Custom User Property IDs to the CustomPropertyID

property, you can allow site visitors to view and edit custom properties in their profile. See

Also: ”Custom User Properties” on page 15-16
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Editing Personal Information
A site visitor can change the information in the Personal Information area by clicking Edit in

the lower left corner of this area.

If the site visitor clicks the link, a page allows him to change any information in this area.

When done, the site visitor clicks Save Changes to save the changes and return to the My

Account page.

The Billing Address Area
The Billing Address area allows site visitors to view and edit their billing address information.

A site visitor can edit their Name, Company, Address, City, State, Postal Code, Country, and

Phone number.
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This information is used for billing purposes when the site visitor makes a purchase. Credit

card companies typically want part or all of this information to match a customer’s credit card

account information when making a purchase.

Editing the Billing Address
To edit a site visitor’s billing address, click the Edit link in the lower left corner of the Billing

Address area.

Once a site visitor clicks the link, a page allows him to change any information in this area.
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When done, a site visitor clicks Save Changes to save the changes and return to the My

Account page.

The Shipping Address Area
The Shipping Address area allows site visitors to view, edit or add a new address to their

shipping address information. The fields in this area are the same as those in the Billing

Address area with two exceptions: a Same as Billing check box, and a Default Address check

box.

The Same as Billing Address check box allows site visitors to place a check mark in the box

and use their billing address information as their shipping address.

The Default Address check box allows site visitors to specify the current shipping address as

the default they want to use when making future purchases.

Editing the Shipping Address
To edit a site visitor’s shipping address, click the Edit link located in the lower left corner of

the Shipping Address area.
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Note: The image below shows the (Same asBilling Address)message because this person has the Same as

Billing checkboxchecked.

If a site visitor clicks the link, a page allows him to change any information in this area. Note

that a site visitor must uncheck Same as Billing to be able to edit the shipping address.

Otherwise, it is locked to the billing address.

When done, a site visitors clicks Save Changes to save the changes and return to the My

Account page.
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Adding a New Shipping Address
To add a new shipping address, the site visitor clicks the Add New Address link located in

the bottom center of the Shipping Address area.

If a site visitor clicks the link, a page appears where he can enter new shipping address

information. Note that the Same as Billing checkbox is not available when adding a new

address.

When done, a site visitor clicks Save Changes to save the changes and return to the My

Account page.
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MyAccount Server Control Properties
The following table explains the properties of the MyAccount control.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Description
Data

Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to

browse to Content, Collections, etc.See Also: ”Using CMS
Explorer to Browse Your Ektron CMS400.NET Site” on page 21-12

String

CacheInterval

Sets the amount of time the server control’s data is cached. The

default is 0 (zero). This is the amount of time, in seconds, a control’s

data is cached. For example, if you want to cache the data for five

minutes, set theCacheInterval property to 300 (three

hundred).See Also: ”Caching with Server Controls” on page
21-42

Double

CustomerPropertyID

An ID or comma separated list of IDs for a CustomUser Property

(or properties) to expose in the UI. These properties are used to

define information about a user beyond the standard Ektron

CMS400.NET user properties; such asUsername, First Name,

Password and email Address.See Also: "The Personal
Information Area" on page 17-216.

IDs for these properties can be found in theWorkarea >Settings>

Configuration >User Properties>User Properties screen.See
Also: ”CustomUser Properties” on page 15-16

String

CustomXml

(Code Behind Only)

Providesamechanism to inject custom XML into the generated

XML before being processed by the XSLT. The injected XML is

appended to the end of the XML produced by this control.

See Also: ”Displaying CustomXML in Ektron’sServer Controls”

on page 21-49

String

DefaultCountryID

The ID of the default country that appears in the Billing Addressand

Shipping Address. Set this ID to the country fromwhich themajority

of your customerswill bemaking purchases. If the site visitor is from

a different country, he can it change when editing the Billing or

Shipping Address.

Note: If a site visitor enters information in the Billing Addressarea,

Integer
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Property Description
Data

Type

hisBilling Country seeds the Shipping Countrywhen adding a new

Shipping Address.

To find a country’s numeric ID, sign into the Ektron CMS400.NET

Workarea. Then go toSettings > Commerce > Configuration >

Countries. The Numeric ID is in the left column of that screen.

DisplayXslt

Specify an externalXSLT file to render the control. Bydefault, the

control usesMyAccount.xsl. This file is located in

<Site Root>\Workarea\Xslt\Commerce

Important: If you want to edit this file, it is strongly recommended

that youmake a copy, change its name andmove it outside your

site’sWorkarea folder. If youmake changes to this file and do not

move it out of theWorkarea folder, this file and the changeswill be

lost when you upgrade.

String

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

Language

Set a language for viewing the account information. This property

shows results in design-time (in VisualStudio) and at run-time (in a

browser).

Integer

LoadingImage

The image to displaywhile the control is fetching data. The default is

<siteroot>\Workarea\images\application\ajax-

loader_circle_lg.gif.

String

MarkupLanguage

As of 7.6.1 this

property does not

work. It should work

in a future release.

Identify the template markup file that controls the display

of the server control. For example, mymarkup.ekml. If the

*.ekml file is located in the same folder as the Web form

containing the server control, just enter its name.

Otherwise, the path to the file can be relative or absolute.

See Also: ”Ektron Markup Language” on page 3636.

String

RedirectUrl

Enter the path of a template that contains the Login server control.

When a site visitor arrivesat this control and is not logged in, the

control checks this property for a path to template containing a

Login server control. If one exists, the site visitor is sent to that

template. Once he’s logged in, he’s returned to the template

containing theMyAccount server control.

If no path exists, the control checks theweb.config file’s <add

key=”ek_RedirectToLoginURL” value=”” /> value for a path.

String
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Property Description
Data

Type

Stylesheet

Specify the path to a style sheet for use with this server control. The

location can be relative or absolute. Leave blank to use the default

style sheet.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The

default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean
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eCommerce Coupons

Most eCommerce sites periodically offer coupons to provide discounts to customers, either to

attract new business or reward loyalty. Ektron CMS400.NET’s eCommerce feature provides a

coupon generation capability with the following features.

n discount can be an amount or percentage

- if percentage, you can set a maximum coupon value regardless of the amount

calculated by percentage

n restrict coupon to catalog entries that you accept

n restrict coupon to most or least expensive entry

n limit to one use per customer

n prevent coupon from being used with other coupons

n specify a maximum number of redemptions

n specify a minimum order amount required to activate coupon

n designate a date range when coupon is active

See Also: "Creating a Coupon" on page 17-225

Creating a Coupon
Create coupons in the Ektron CMS400.NET Workarea by going to Settings > Commerce >

Catalog > Coupons. To make it easy to complete the information, the screens are arranged in

numbered steps. Subsequent screens are context-sensitive, so that you only see fields that are a

logical result of previous decisions.

The following table summarizes the information collected on each screen.

Screen Information collected For more information, see

1. Type

n code (that is, unique identifier)

n description

n whether discount is based on

amount or percentage

n currency (applicable to amount-

"Completing the First Coupon

Screen (Type)" on page 17-226
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Screen Information collected For more information, see

based couponsonly)

n enabled or disabled

2. Discount

n If amount, dollar amount

n If percentage, percentage and

maximum coupon value

"Completing the Second Coupon

Screen (Discount)" on page 17-

228

3. Scope

n applies to entire cart, accepted

itemsonly, most/least expensive item

only

n limit to one per customer?

n allow combination with other cou-

pons?

n maximum number of redemptions

n minimum cart value

n start and end dates

"Completing the Third Coupon

Screen (Scope)" on page 17-229

4. Items
If coupon is restricted to certain items,

designate the items

"Completing the Fourth Coupon

Screen (Items)" on page 17-231

See Also:

n "Disabling a Coupon" on page 17-233

n "Deleting a Coupon" on page 17-234

Completing the First Coupon Screen (Type)
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Use the following table to complete the first coupon screen.

Field Description

Type

Select the type of coupon you are creating/editing.

n Amount - discount is a dollar amount.

If you select this type, choose a currencyat theCurrency field

(below). Then, enter the dollar amount on theDiscount

screen. See Also: "Amount Based Coupon" on page 17-228

n Percentage - discount is a percentage.

If you select this type, enter the percentage on theDiscount

screen. That screen also lets you enter amaximum amount.

See Also: "Percentage Based Coupon" on page 17-229

Also, if the coupon type ispercentage, theCurrency field is

disabled. Percentage-based couponsare currencyneutral.

Code

Enter the coupon code. The code cannot contain

n spaces

n angle brackets (<, >)

n single (‘) or double quotes (“)

n ampersand (&)

n slash (/) or back slash (\)

n plus sign (+)

When done, click theValidate Code button.When you do,

Ektron CMS400.NET verifies that the code contains the

correct characters and is not already in use.

Tip! The following page gives suggestionsabout eCommerce

coupons, including coupon-naming strategies:

http://www.ecommerce-

guide.com/solutions/advertising/article.php/3667331

Site visitors enter this code to redeem the coupon on a page

that hosts the Cart server control (see image below).

Description

Enter a free text description of the coupon. This helps describe

it on the initialCoupons screen in the Ektron CMS400.NET

Workarea.
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Field Description

Currency

Select the currency to which this coupon applies. A dropdown

list of all enabled currencies is available. See Also:

"Currencies" on page 17-53

If the coupon type is percentage, this field is disabled.

Warning! The coupon is only valid if a site visitor selects this

currency. So, for example, if you create a coupon for a USD

amount, and a site visitor selectsEuroswhen shopping on

your site, the coupon is not accepted. To work around this

restriction, create a coupon for every applicable currency.

Status

Set to enabled to let site visitors uses this coupon (providing all

other conditionsaremet).

Or, set to disabled to keep the coupon in the eCommerce

feature but prevent it from being used.

Completing the Second Coupon Screen (Discount)
n "Amount Based Coupon" on page 17-228

n "Percentage Based Coupon" on page 17-229

Amount Based Coupon

Use the following table to complete the second coupon screen if the coupon is based on

amount.

Field Description

Amount

Enter the coupon’s discount amount.

Note: If the coupon amount exceeds the sum of all items to which it is applied, it is

reduced to the sum of the items. For example, a coupon amount is $10.00 and

applies to the least expensive item. If that item is $3.00, the amount changes to $3.00.
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Percentage Based Coupon

Use the following table to complete the second coupon screen if the coupon is based on

percentage.

Field Description

Percentage Enter the percentage of the discount.

Maximum

Amount

Enter themaximum value of this coupon.

For example, if you set a discount of 10%and aMaximum Amount of $20.00,

the discount will never exceed $2.00 (that is, 10%of theMaximum Amount)

regardlessof the amount of the goodsordered.

Typically, you would include aMaximumAmount in the email or announcement

that describes the coupon.

Completing the Third Coupon Screen (Scope)
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Use the following table to complete the coupon Scope screen.

Field Description

Apply

Coupon to

n Entire cart - coupon applies to all items in cart

n All accepted items - coupon applies allaccepted items in cart. Itemsare

accepted on the Items screen.

n Most expensive accepted item - coupon applies tomost expensive

accepted item in the cart. Itemsare accepted on the Items screen.

n Least expensive accepted item - coupon applies to least expensive

accepted item in the cart. Itemsare accepted on the Items screen.

Important: If you select All accepted items,Most expensive

accepted item, or Least expensive accepted item, you must

identify accepted items on the Items tab. If you do not, the coupon

is effectively inactive.

Note: You cannot apply a cart-level coupon to a subscription

product. However, you can apply an item-level coupon to a

subscription product. (An an item-level coupon is one that applies

to all accepted items, or the most or least expensive item.) See

Also: "Creating a Subscription" on page 17-119

One Per

Customer

Check this box if you want to limit each customer to one use of the coupon. If you

do and a site visitor completesan order with the coupon then tries to use it a

second time, he is notified that the coupon is not valid.

Can be

combined

with other

coupons

Check this box if this coupon can be combined with other coupons in the same

order.

If you do not check this boxand a site visitor tries to add this coupon to an order

to which a coupon is alreadyapplied, he is notified that the coupon is not valid.

Maximum

Redemptions

If desired, enter amaximum number of times this coupon can be used. It does

not matter which site visitors use the coupon.

If you set amaximum, and the coupon is applied that number of times, the next

time someone tries to use the coupon, he is informed it is not valid.

Minimum

Required

Cart Value

If desired, enter theminimum order amount required to activate this coupon.

The order amount doesnot include taxor shipping charges.

For example, enter $50.00. If a shopping cart total is $40.00, and a site visitor

adds this coupon to an order, he is informed the coupon is not valid.

Start

Date/End

Date

Enter the date range within which this coupon is valid.

For example, you enter aStart Date of January 1, 2008 and anEnd Date of

December 31, 2008. If a site visitor inserts this coupon on February 9, 2009, he

is informed the coupon is not valid.
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Completing the Fourth Coupon Screen (Items)

Use the following table to complete the Items coupon screen.

Field Description

Include/

Exclude

Use this screen to identify items to which this coupon applies if the Coupon Scope

screen’sApply Coupon to field is set to

n All accepted Items

n Most Expensive accepted Item

n Least Expensive accepted Item

Warning! - Item-level coupon typesapplyonly to itemsselected on this screen. If a

site visitor orders a catalog entry that’s not defined on this screen, an item-level cou-

pon doesnot apply to the item.

For example, you create a coupon worth 10%off anydigital camera. The coupon is

only applicable if a digital camera is in the shopping cart. Typically, the email or

announcement that describes the coupon includes item restrictions.

The discount is applied to each accepted item in the cart. For example, a coupon

providesa 10%savingson items1, 3, and 5 but not 2 and 4 because 2 and 4 are not

on the accepted items list.

See Also: "Selecting a Coupon’sAccepted Items" on page 17-231; "Include vs.

Exclude" on page 17-232

Selecting a Coupon’s Accepted Items
There are three ways to select items to add to the Include or Exclude list. You can select

n individual items - click the Include Product button and navigate through the Ektron

CMS400.NET folder system to that content. You can only select items in a category folder

(which are blue to distinguish them from regular folders).
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n all items in a catalog folder - click the Include Catalog button and navigate through the

Ektron CMS400.NET folder system to that folder. You can only select items in a category

folder (which are blue to distinguish them from regular folders).

n all items in a taxonomy or category - click the Include Category button and navigate

through the Ektron CMS400.NET taxonomies to the desired taxonomy or category. All

content applied to the category will be eligible for the coupon.

Include vs. Exclude
You can both include and exclude using any of the criteria listed above. If any product appears

on both lists, it is excluded from coupon eligibility.

So for example, one of your folders contains 500 digital cameras that your site offers. You want

the coupon to apply all but a few cameras.

On the Include tab, select the cameras folder. Then, use the Exclude tab to select the few

cameras to which the coupon does not apply. In this way, you can easily select the majority of

items but exclude a few.
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Disabling a Coupon
When the coupon’s status is Disabled, site visitors can no longer apply it to an order.

Coupons can be disabled automatically (according to a schedule) or manually.

Using an Expiration Date to Disable a Coupon

When you create a coupon, a default end date is set for 10 years from the end of the current

year. At that time or at any time the coupon is active, you can change its end date.

When the coupon’s end date is reached, its status changes to Disabled.

Manually Disabling a Coupon

To disable an active coupon, follow these steps.

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Coupons.

2. Locate the coupon that you want to delete.

3. Go to its Type screen.

4. Change its Status field to Disabled (see below).
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Deleting a Coupon
Warning! You cannot delete a coupon that is applied to anyorder within Ektron CMS400.NET.

Follow these steps to delete a coupon that is not applied to an order. If a coupon is applied to

an order, you cannot delete it but you can disable it. See "Deleting a Coupon" on page 17-234.

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce > Coupons.

2. Locate the coupon that you want to delete.

3. Click the delete button on the far right of the coupon information (circled below).

4. A strike through line appears over all coupon text, and a Restore button ( ) replaces the
delete button.

Note: If you change your mind and do not want to delete the coupon, click the Restore button.

5. Click the Save button ( ).

If the coupon cannot be deleted (because it is applied to an order), it remains on the main

Coupons screen and No appears in the Enabled field. This coupon can no longer be used.

Using eSync with eCommerce
When using eSync with an eCommerce site, you will want to prevent orders from being

processed on your staging server. This is to prevent orders from being processed twice.

For example, a customer on your production site purchases a product. If the staging server and

production server are synced before the credit card is processed, the potential exists for the

customer’s credit card to be charged twice; once from the production server and again from the

staging server.

To prevent orders from being processed on your staging server, edit your staging site’s

web.config file. Next, set the following property to true.

<add key="ek_ecom_OrderProcessingDisabled" value="true" />
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Once the property is set to true, you cannot process or edit orders from the Workarea’s View

Order screen on the staging server. Also, if you try to create an order from the staging server’s

Web site, you receive the following message.

“We're sorry, an error occurred while processing your request. Please try again later...”

It is important to note that all other eSync functions still work properly. For example, when

you create catalog entries on a staging server and perform a sync, the entries will be moved to

the production server. This key only affects the processing of orders.

The eCommerce Audit Screen
As an administrator, you should regularly review the eCommerce Audit log. This is vital to

keeping your site secure and will help you determine the source when data is compromised.

While it is important that CMS400.NET captures this information, it is even more important

that you review, analyze and use it. For example, while reviewing eCommerce event logs in

CMS400.NET, you might find that one of your eCommerce administrators has an unusually

large amount of login failures. This could be a sign someone is trying to break into your

system.

You can view a log of your CMS400.NET Web site's eCommerce activity in the Workarea >

Settings >Commerce >Audit.

To turn eCommerce Logging on, open the Web site’s web.config file and change the following

key to true.

<add key="ek_ecom_ComplianceMode" value="false"/>
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When compliance mode is turned on, Ektron CMS400.NET logs and displays the following

events.

n Actions affecting administrators (Administrator Group member, Commerce Admin Role,

Builtin Account).

- An administrator logs in or out

- An administrator's login attempt fails

- An administrator password is changed

n Actions affecting an Ektron CMS400.NET user’s rights to eCommerce.

- Adding a user to the Commerce Admin Role

- Removing a user from the Commerce Admin Role

- Adding a user to the Admin group

- Removing a user from the Admin group

n Actions affecting order information.

- Updates to an order's address

- The transaction ID and response from the payment gateway

- Any action conducted with the payment gateway. For example, when capturing a

previously authorized transaction.

- Workflow activities. For example, sending an email.

- Whenever the default gateway or payment options are changed in the Workarea.
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eCommerce Reports and Widgets

eCommerce provides a set of standard reports to measure your commerce activity. View these

reports by clicking the Settings Tab then choose the Commerce > Reports folder. These are

also found in the Reports > Commerce section.

The following reports are described below.

n "Customer Reports" on page 17-237

n "Key Performance Indicators Report" on page 17-238

n "Payment Reports" on page 17-240

n "Sales Trends Report" on page 17-241

n "Top Products Report" on page 17-242

eCommerce Reports Widgets
The eCommerce reports are also available as Widgets for the Smart Desktop. See also

”Personalizing the Smart Desktop” on page 4-6.

Customer Reports
The Customer Report shows 5 customers ranked according to account date, sales, and orders.

eCommerce Reports andWidgets

ReferenceManual

Version 8.0 Rev 1.3
17-237

#
#
#
#
#
#
#
#


The following table describes the report’s fields.

Field Description

Name Customer first and last name

Orders Total number of orders by this customer

Order Value Total amount of sales to this customer

Date Created The date this person first became a customer

To change the report type, do the following.

1. Click the Most Recent link next to the Calendar Button ( )

2. Click the type of report to view.

The types of reports are:

n Most Recent - the newest customers joining the site

n Most Valuable - customers ranked by order value

n Most Active - customers ranked by number of orders

Key Performance Indicators Report
The Key Performance Indicators report lets you compare the sales and orders for two different

time periods.
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Change the current and previous periods for comparison by doing the following.

1. Click the link called This Month in the Period column. The list of choices is shown

below.

2. Click the appropriate period.

3. Repeat steps 1 and 2 for the current period.

4. Click the Refresh button ( ) to update the report.

Customizing Key Performance Indicators
You may create your own Key Performance Indicators and display it on the report.

To do this....

Insert steps here???
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Add the new Key Performance Indicator provider to the siteroot\web.config file.

<KPIProvider>
<providers>
<add name="Orders" type="Ektron.Cms.Commerce.Providers.KPI.OrdersKPI,

Ektron.Cms.Commerce.Providers" />
<add name="Sales" type="Ektron.Cms.Commerce.Providers.KPI.SalesKPI,

Ektron.Cms.Commerce.Providers" />
</providers>
</KPIProvider>

Payment Reports
The Payments report lists payments for a specific time period. It may be used by the accounting

department to reconcile bank statements with the order system.

The following table describes the report’s fields.

Field Description

Date Captured
Date the payment was captured. See Also: "Capturing the

Order" on page 17-200.

CardID The last four digits of the credit or debit card used for payment.

Type
Type of payment used. See Also: "Payment Options" on page 17-

61.

TransactionId
The unique number returned from the Payment Provider for this

payment. See Also: "Capturing the Order" on page 17-200.

Amount Total amount of the payment for this transaction.

Voided Total amount voided in the transaction.

To run a report, do the following.

1. Click the Calendar button ( ) next to Start Date to open the calendar.
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2. Click the date on the calendar to set the start date.

3. Click the Calendar button ( ) next to End Date to open the calendar.

4. Click the date on the calendar to set the end date.

5. Click the Set New Dates link (circled below) to refresh the report.

Sales Trends Report
The Sales Trends reports shows the number of orders for the past 8 periods. You can choose

monthly or daily orders. At the top of the graph, you see the total number of orders and sales.

Set the time period for the graph by doing the following.

1. Click the period link circled below.
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2. Click the proper time period .

Top Products Report
The Top Products reports shows the most popular products on your site.

Create the report by doing the following.

1. Click the link next to the calendar icon ( ).

2. Click the time period of sales from the choices shown in the select box.
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3. Click the Quantity link (circled below) to change this value.

4. Enter the maximum number of products to show.

5. Click the Update button.

Top Products Report
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eCommerce Server Controls

Introduction
Ektron provides a complete set of eCommerce server controls that allow you to set up an

online marketplace where site visitors can purchase merchandise, services or content. Site

visitors interact with these server controls on your site to

n select the type of currency

- see the "CurrencySelect Server Control" on page 17-59

n search for products or view a list of products

- see the "ProductSearch Server Control" on page 17-170 and the "Product List Server

Control" on page 17-165

n view the details of a product and add it to their shopping cart

- see the "Product Server Control" on page 17-154

n get recommendations on other products

- see the "Recommendation Server Control" on page 17-190

n view products in a shopping cart, create new carts, and apply discounts

- see the "Cart Server Control" on page 17-3

n go through the checkout process

- see the "Checkout Server Control" on page 17-16

n view a list of processed orders

- see the "OrderList Server Control" on page 17-205

n view and change their account information

- see the "MyAccount Server Control" on page 17-213

Most eCommerce server controls allow site visitors to move from one control to another. In

these controls, there are template properties that allow you to define the location of another

server control. For example, if you define the path to the Cart server control in the Product

server control’s TemplateCart property, site visitor are sent to the Cart control when they click

the Add to Cart button in Product control.

Using the eCommerce Server Controls
The following table shows typical actions a site visitor might perform when visiting your

eCommerce site and how you can facilitate these actions.
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Site

Visitor

Action

How you accomplish this When to Use

View

account

information

Create a link in themaster page that leads to

the template containing theMyAccount server

control.

This link should be available

from anypage.

View

previous

and

current

orders

Create a link in themaster page that leads to

the template containing the OrderList server

control.

This link should be available

from anypage.

Change

the

currency

type

Add the CurrencySelect server control to a

master page.

This server control should be

available from anypage.

Search for

products

Either create a link to the template containing

the ProductSearch server control.

- Or -

On themaster page, add a textbox that passes

the text to a hidden ProductSearch server

control and post the results to a separate

template.

This link or textbox should be

available from anypage.

View a list

of products

Create a template that contains the

ProductList server control. This template

might be the first page site visitors see when

they view the eCommerce portion of your site.

Whenever you want to display

a list of products based on a

catalog, taxonomyor a list

content IDs. For example, you

could create a list of products in

a panel on the right side of your

Web site.

View a

product’s

details

Create a template that contains the Product

server control. Set anyof the following server

control’sTemplateProductproperty to the

path of this control. Thismakesa product’s title

being displayed byone of these controls a

clickable link that takes the site visitor to this

control.

n ProductSearch

n ProductList

n OrderList

n Cart

n Recommendation

When ever a site visitor needs

to view details of a product.
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Site

Visitor

Action

How you accomplish this When to Use

View

additional

products

associated

with

another

product

Add the Recommendation server control to a

template that contains a Product server

control and set the Recommendation control’s

DynamicProductParameterproperty to the

QueryString parameter that’s used to passa

products ID.

When ever you want to

present a site visitor with cross-

sell and upsell opportunities

associated with a given

product.

Add a

product to

their

shopping

cart

Set the TemplateCartproperty in the

following server controls to the path of the Cart

server control. Setting this property is one of

the requirements for theAdd to Cart button

or link to appear in these controls.

n ProductSearch

n ProductList

n Product

n Recommendation

Note: In addition to setting the above

property, a product must be in-stock, not

archived and buyable. Otherwise, theAdd to

Cart button or link doesnot show for a

product.

When you want to allow site

visitors to add products to their

shopping cart.

View

products in

their

shopping

cart

When a site visitor addsa product to their cart,

theyare sent to the Cart server control. You

should also create a link in themaster page

that leads to a template containing this control.

The link should be available

from anypage.
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Site

Visitor

Action

How you accomplish this When to Use

Checking

out and

paying for

their

selected

product.

Add the Checkout server control to a template

and add that template’s path to the Cart server

control’s TemplateCheckoutproperty.

When you do, the Checkout button in the Cart

server control becomesactive.

Youmust set this up in order

for site visitors to checkout.

Using eCommerce Server Control Events
The eCommerce server controls contain event hooks that allow you to customize or manipulate

them.

To use these event hooks, create a handler for each needed event in the code behind of the

ASPX page that contains an eCommerce server control. Then, in that page’s OnInit method,

hook each event.

For an example of working with the eCommerce server control’s event hooks in code behind,

download Ektron’s Developer Sample Site and view these files.

For the Checkout server control:

[Site Root]/Developer/Commerce/CheckoutDemo_Advanced.aspx

[Site Root]/Developer/Commerce/CheckoutDemo_Advanced.aspx.cs

For the Cart server control:

[Site Root]/Developer/Commerce/CartDemo_Advanced.aspx

[Site Root]/Developer/Commerce/CartDemo_Advanced.aspx.cs

For the Product server control:

[Site Root]/Developer/Commerce/ProductDemo_Advanced.aspx

[Site Root]/Developer/Commerce/ProductDemo_Advanced.aspx.cs

Event

This Hook

is

Called...

Description

PhaseChange
when the

current

Supervise phase changesand allow or prevent changing

asneeded. It also allows you to jump to a specified phase.

For example, you could jump to a passed phase, prevent
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Event

This Hook

is

Called...

Description

(Used only in the

Checkout server

control.)

phase is

about to

change.

the phase from changing from the current one under

certain conditions, or jump to a phase that is not

necessarily the next one in line.

PreProcessXml

immediately

before the

control’s

XML is

transformed.

Inspect or manipulate the server control’sXML before

being processed.

This is the only time the XmlDocproperty should be used

to access the controlsXML.

PostProcessXml

immediately

after the

control’s

XML is

transformed.

Workwith processed transformed XML output inside the

Text property before sending it to the browser. This allows

simple stringmanipulation of the server control’smarkup.

FilterAjaxCallback

when an

Ajax-

Callback

event

occurs.

Inspect or modify callbackparameters. For example, you

could use this event to receive custom valuesentered in a

page.

PostLogin

(Used only in the

Checkout server

control.)

immediately

after a

(possibly

new) user

logs in with

this control

Calls custom code immediately after a returning user logs

in with his email and password. Or, immediately after a

new customer fills out the billing info screen. For example,

you could add code that allowsnew customers to sign up

for Web Alerts after theyadd their information to the billing

screen.

Using the EkItems Property with eCommerce Server Controls
When using the EkItems property with eCommerce server controls it can only be used with the

Product and ProductList server controls. This property gets EntryData for a product and can

only be called during the PreProcessXml or PostProcessXml event. If you use it outside of these

events, it will return empty values for the entry data.
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Customizing eCommerce

Introduction
Ektron’s CMS400.NET eCommerce Module allows you to set up an eCommerce Web site which delivers a full
set of functionality for building an online marketplace.

As a developer, you can use Ektron’s standard functionality and out of the box Server Controls to quickly
create an eCommerce Web site. Ektron also provides the ability to partially or fully customize your Web site.
For example, you can customize your site’s order process workflow.

The following topics are covered in this chapter.

n "Customizing Workflows" on page 17-249

n "Customizing the Payment Gateway Provider" on page 17-273

n "Customizing the Shipment Provider" on page 17-281

n "Customizing the Inventory Provider" on page 17-290

Customizing Workflows

Introduction
Ektron utilizes Microsoft’s Windows Workflow Foundation to create and implement order process workflows
in CMS400.NET. Within CMS400.NET eCommerce functionality, you use a workflow to handle the ordering
process after your site has received an order. The workflow can be as simple or complex as your business
requires.

For example, you could have a simple workflow that sends an email to the customer when their order is
received and sends another to the person shipping product for you. Or, you could have a more complex
workflow that:

n sends an email to the customer when the order is received

n checks to see whether the item is a tangible product or a virtual product. Then, continues down the

workflow path that’s appropriate for the item.

n handles shipping notifications and updates the account throughout the shipping process

n handles the order if it is canceled

n handles the order if it is determined to be fraudulent

n marks the order as complete once all activities are finished

Ektron’s default sample workflow is shown below.

Customizing eCommerce

ReferenceManual

Version 8.0 Rev 1.3
17-249



Windows Workflow Foundation is a development tool that allows you to automate a business process. Released
with Microsoft’s .NET 3.0, it allows you to create an activities based workflow that has the ability to persist
over a given length of time or be paused and restarted depending on events. FromMicrosoft’s MSDN:

Windows Workflow Foundation (WF), originally introduced as part of the .NET Framework 3.0 with

extensions for Visual Studio 2005’s designers, has continued to be enhanced for the .NET Framework 3.5

and Visual Studio 2008. WF makes it possible, and for many workflow scenarios, even easy to create

robust, manageable workflow-based applications. WF is actually many things: It’s a programming

model, and runtime engine, and a set of tools that help you create workflow-enabled applications hosted

by Windows. For more information on WF, drop by the portal site here:

http://msdn.microsoft.com/en-us/netframework/aa663328.aspx.

Workflows are comprised of Activities; each activity represents a portion of your Business Process. Once all
activities have finished within a workflow, the workflow terminates. There are two types of activities:

n Activities - executed inside the workflow once the activity is reached. For example, an email might be sent

to a customer once their order is received by using the AdvancedEmailActivity placed after the

OrderReceivedEventActivity. This email would be automatically sent with no human interaction needed

and the workflow would continue on.

n Event Activities - cause the workflow to pause until the event has taken place. Once the event takes place,

the activity associated with it is executed. Think of events as road blocks in the workflow that don’t open

unless a matching action happens. Once the event happens, the workflow follows the path associated with
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that event. For example, an OrderFraudEventActivity in a workflow would keep the workflow from going

through the Fraud Event portion of the workflow unless the order is marked as fraud.

Ektron supports Sequential Workflows and State Machine Workflows. Sequential Workflows are structured; a
step based process where one activity leads to the next. State Machine Workflows typically move from one
activity to another when their state has changed.

Only one workflow project can be run at a time. You can have multiple workflows projects associated with
your eCommerce site and you can change workflow projects at anytime. Note however, once an order process
is started with a specified workflow, it will continue through that Workflow.

Installing Ektron’s Sample Workflow Template
Prerequisites - Ektron’s CMS400.NET SDK is installed

IMPORTANT!

Warning! If you use VisualStudio 2005 and want to workwith MicrosoftWindowsWorkflow Foundation, install

Microsoft’sVisualStudio 2005 Extensions for WindowsWorkflow Foundation.

http://www.microsoft.com/downloads/details.aspx?FamilyId=5D61409E-1FA3-48CF-8023-E8F38E70-

9BA6&displaylang=en

Ektron provides a C# workflow template sample for a sequential workflow. This sample can be modified or
used to create new workflows. It is based on the default workflow included with Ektron CMS400.NET.

To install Ektron’s sample workflow template, simply copy the “Ektron Ordering Sequential Flow.zip” file
using the From & To information below.

Note: If you are using VisualStudio 2005, replace 2008 with 2005 in pathsbelow.

From:

C:\Program Files\Ektron\CMS400SDK\Commerce\Workflow\Templates\VS2008

To:

Note: Make sure you replace ~user name~ in the path below with the user name under which VisualStudio

project templatesare saved.

C:\Documents and Settings\~user name~\My Documents\Visual Studio

2008\Templates\ProjectTemplates\Visual C#\Workflow

Once the Workflow zip file is saved to the ProjectTemplate location, you are ready to start working with a
sample workflow.

Working with the Sample Workflow
Follow the steps below to open and work with Ektron’s sample workflow.

Prerequisites - Install Ektron’s sample workflow template. See "Installing Ektron’s Sample Workflow
Template" on page 17-251.

1. Open Visual Studio.
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2. Click File > New > Project.

3. If you are using C#, expand the Visual C# project type. Otherwise, expand the Visual Basic project type.

4. ClickWorkflow.

5. Select Ektron Ordering Sequential Flow from the My Templates area.

6. Select a new Name, and if necessary, change the Location, Solution and Solution Name.

7. Click OK.

8. Copy Ektron.Cms.Common.dll and Ektron.Workflow.dll from the Bin folder of your Ektron site to

the Bin folder for newly created project. For example, copy the files to C:\Documents and

Settings\~user name~\My Documents\Visual Studio

2008\Projects\MyWorkFlow\MyWorkFlow\bin.

9. Open theWorkflow.cs file in the Solution Explorer.

10. Make any necessary changes to the workflow. For information on Ektron’s Workflow Activities, see "List

of Workflow Activities" on page 17-256. For information on Microsoft’s Workflow Activities, see

11. Debug as needed.

12. Build the workflow. This creates a DLL of the workflow and places it in the project’s bin/debug folder.
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13. Navigate to the folder where the DLL is stored. For example, C:\Documents and

Settings\~user name~\My Documents\Visual Studio

2008\Projects\MyWorkFlow\MyWorkFlow\bin\Debug.

14. Move or copy the newly created workflow DLL file to your Web site’s bin folder.

Making Ektron’s Workflow Activities Available
To add Ektron’s Workflow Activities to your Toolbox, follow these steps.

1. Open or create a Workflow in Visual Studio 2005/2008.

2. Display the Toolbox (View > Toolbox).

3. Right click the mouse within the Toolbox.

4. Click Add Tab.

5. Type Ektron Workflow Activities then press enter.

6. Click the Ektron Workflow Activities tab.

7. Right click the mouse in the empty area.

8. Click Choose Items.

9. The Choose Toolbox Items dialog appears.
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10. Select the Activities tab.

11. Browse to the directory that stores Ektron CMS400.NET’s DLL files, [Web root]\[Site

Root]\bin

. file. This file provides access to Ektron CMS400.NET’s workflow activities.

Alternatively, you could use the following location, C:\Program

Files\Ektron\CMS400v8x\bin. The file is identical in both places.

Using the bin folder in your site provides better speed. However, if you use the bin folder located in

Program Files, you do not have to worry about deleting the .dll file if you change or delete your site.

12. Click OK.

For easier viewing, once the workflow activities are installed, you can right click on them and select Sort Items
Alphabetically.

Note: Ektron’sworkflow activitiesappear onlywhen the workflow is opened in designmode.

Removing Ektron’s Workflow Activities
1. Display the Visual Studio toolbox (View > Toolbox).

2. Right click the mouse within the Toolbox.

3. Click Choose Items.

4. Click the Activities tab.

5. Click Namespace or Assembly Name to sort the Workflow Activities by manufacturer.

6. Uncheck all boxes that are Ektron.Workflow.Activities.
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7. Click OK.

8. Right click the Ektron Workflow Activities tab.

9. Click Delete Tab to remove it.

Updating Ektron’s Workflow Activities
To update the workflow activities, you must first remove the existing ones in Visual Studio, then add the new
workflow activities.

For information on removing workflow activities, see "Removing Ektron’s Workflow Activities" on page 17-
254.

For information on adding workflow activities, see "Making Ektron’s Workflow Activities Available" on page
17-253.

Inserting Workflow Activities Using Drag and Drop
Because Visual Studio is a visual environment, you can see the workflow change as you add or remove
activities. Lines that connect the different events and activities change depending on what you add, move, or
remove.

Adding an Activity to a Workflow
1. Display the Visual Studio toolbox (View > Toolbox).

2. Click the Ektron Workflow Activities tab. Ektron’s Workflow Activities appear.

3. Drag an activity and drop it into the desired location in the Workflow.

4. As desired, modify the activity’s properties using the Properties area of Visual Studio.
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For a description of server control properties, see "List of Workflow Activities" on page 17-256.

List of Workflow Activities
You can customize your workflow using the following activities.

Activity Description More Information

AdvancedEmailActivity

Send an email based on the

order ID and a specified

message type.

"AdvancedEmailActivity" on

page 17-257

BasicEmailActivity

Send a generic email

message when this activity is

reached in the workflow.

"BasicEmailActivity" on page

17-260

CaptureOrderActivity

Submits order

information to a

payment gateway.

"CaptureOrderActivity" on

page 17-262

CheckStockActivity
Verifieswhether the item is

an in-stock item or not.

"CheckStockActivity" on page

17-263

OrderCancelledEventActivity
Customize the handling of

an order when it’s cancel.

"OrderCancelledEventActivity"

on page 17-264

OrderCapturedEventActivity
Customize the handling of

an order when it’s captured.
OrderCapturedEventActivity
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Activity Description More Information

OrderFraudEventActivity

Customize the handling of

an order when it’smarked

as fraud.

"OrderFraudEventActivity" on

page 17-265

OrderProcessedEventActivity

Customize the handling of

an order when it’s being

processed.

"OrderProcessedEventActivity"

on page 17-267

OrderReceivedEventActivity

Customize the handling of

an order when it’smarked

as received.

"OrderReceivedEventActivity"

on page 17-268

OrderShippedEventActivity

Customize the handling of

an order when it’smarked

as shipped.

"OrderShippedEventActivity"

on page 17-269

OrderUpdatedEventActivity
Customize the handling of

an order when it’s updated.

"OrderUpdatedEventActivity"

on page 17-270

UpdateOrderActivity
Updates the order when

once this activity is reached.

"UpdateOrderActivity" on page

17-271

AdvancedEmailActivity
Add the Advanced Email activity to a workflow when you want to send an email notification, based on an order
ID in CMS400.NET, after an event takes place in the workflow. For example, after an order is shipped, you
might choose to send an email that notifies customers when their orders are shipped. Or, you might send an
email to a customer when their order is received.

With this activity you can choose to send a predefined email message. These messages are defined in the
Workarea under Settings > Commerce > Configuration >Messages. For more information, see "Messages"
on page 17-81.

There are two event handler properties in this activity that allow you to add custom code to the
SendingEmail and SentEmail events. The SendingEmail event fires right before the email is sent. The
SentEmail event fires right after the email sent.

Key Properties

n EventArgs - Set this property to OrderId to associate the activity with orders in CMS400.NET.

n MessageTypes - Set this property to the type of email message this activity sends.
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ReferenceManual

Version 8.0 Rev 1.3
17-257



AdvancedEmailActivity vs. BasicEmailActivity
The AdvancedEmailActivity allows you to associate email activity with orders in CMS400.NET. You can either
supply information such as, To:, From:, Body:, etc. or use information associated with the order. It also allows
you to specify the type of message type that’s sent.

The BasicEmailActivity, on the other hand, is a generic email activity where you specify To:, From:, Body:, and
other email information.

AdvancedEmailActivity Properties
The following table explains the properties of the AdvancedEmailActivity workflow activity.

Property Description
Data

Type

Activities

(Name) Enter a name for the Activity. String

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Email Message

Bcc

A blind carbon copyof the email is sent to the addressentered in

this property.

If you selectOrderId for the EmailArgsproperty, theBcc

property is dynamically populated with the order’s information.

String

Body

Enter themain content of the email.

If you select a parameter from the MessageTypeproperty, the

Body property uses the corresponding content for that message

type.

String

CC

A carbon copyof the email is sent to the email addressentered in

this property.

If you selectOrderId for the EmailArgsproperty, theCC

property is dynamically populated with the order’s information.

String
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Property Description
Data

Type

From

The address fromwhich the email is sent.

If you selectOrderId for the EmailArgsproperty, theCC

property is dynamically populated with the order’s information.

String

HtmlBody

Select whether to send the email in HTML or plain text. Default is

True.

Choicesare:

True - send the bodyof the email in HTML.

False - send the bodyof the email as plain text.

Boolean

ReplyTo Specify the address to which the recipient of the email replies. String

Subject

Enter subject information for the email.

If you select a parameter from the MessageTypeproperty, the

Subject property uses the subject information for that message

type.

String

To

The email is sent to the address in this property.

If you selectOrderId for the EmailArgsproperty, theTo

property is dynamically populated with the order’s email

information.

String

Email Server

Port

Set this value to the port your system usesaccess to retrieve email.

In most cases, the port is set to 25. If that is not the case, see your

SystemAdministrator.

The default is25

If blank, this property uses theek_SMTPPort value in the site’s

web.config file.

Integer

SmtpHost

The addressof the server hosting the email system.

If blank, this property uses theek_SMTPServer in the site’s

web.config file.

String

Handlers

SendingEmail
Event handler to add custom code to the sending email event. This

event fires right before the email is sent.
String

SentEmail
Event handler to add custom code to the sent email event. This

event fires right after the email is sent.
String

Misc
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Property Description
Data

Type

EmailArgs

SelectOrderId to dynamically associate this activitywith orders

in CMS400.NET.

Click the Ellipsis ( ) button and selectOrderId from the list.

NEED

DATA

TYPE

MessageType

Select the type of message that is sent for this activity. If you select

None, themessage is sent with the text in the Bodyproperty, The

default isNone. Choicesare:

n None - uses the text in the Bodyproperty.

n OrderReceived - Sends theOrder Received email defined

in theWorkarea >Settings > eCommerce >Configuration >

Messages screen when an order is received.

n OrderCancelled - Sends theOrder Cancelled email defined

in theWorkarea >Settings > eCommerce >Configuration >

Messages screen when an order is received.

n OrderShipped - Sends theOrder Confirmation email

defined in theWorkarea >Settings > eCommerce >Con-

figuration >Messages screen when an order is received.

For additional information on defining thesemessages, see

"Messages" on page 17-81.

NEED

DATA

TYPE

BasicEmailActivity
Add the Basic Email activity to a workflow when you want to send an email after an event takes place in the
workflow. These emails are usually generic and contain the same information for To:, From:, Subject, Body, etc.

There are two event handler properties in this activity that allow you to add custom code to the SendingEmail
and SentEmail events. The SendingEmail event fires right before the email is sent. The SentEmail event fires
right after the email sent. For example, you want to notify a supervisor when orders are received, but you don’t
want the notification to contain any order specific information.

Key Properties

n To - enter the address to receive the email.

n From - enter the address from which the email is being sent.

n Subject - enter a brief summary for the email.

n Body - enter the main subject text of the email.
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BasicEmailActivity vs. AdvancedEmailActivity
BasicEmailActivity sends a generic email. In the activity, you specify To:, From:, Body:, and other email
information.

The AdvancedEmailActivity, on the other hand, allows you to send an email associated with orders in
CMS400.NET. You can either supply information such as, To:, From:, Body:, etc. or use information
associated with the order. It also allows you to specify the type of message type that’s sent.

BasicEmailActivity Properties
The following table explains the properties of the BasicEmailActivity workflow activity.

Property Description
Data

Type

Activities

(Name) Enter a name for the Activity. String

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Email Message

Bcc
A blind carbon copyof the email is sent to the addressentered in

this property.
String

Body Enter themain content of the email. String

CC
A carbon copyof the email is sent to the email addressentered in

this property.
String

From The address fromwhich the email is sent. String

HtmlBody

Select whether to send the email in HTML or plain text. Default is

True.

Choicesare:

True - send the bodyof the email in HTML.

False - send the bodyof the email as plain text.

Boolean
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Property Description
Data

Type

ReplyTo Specify the address to which the recipient of the email replies. String

Subject Enter a brief summary for the email. String

To The email is sent to the address in this property. String

Email Server

Port

Set this value to the port your system access to retrieve email. In

most cases, the port is set to 25. If that is not the case, see your

SystemAdministrator.

The default is25

If blank, this property uses theek_SMTPPort value in the site’s

web.config file.

Integer

SmtpHost

The addressof the server hosting the email system.

If blank, this property uses theek_SMTPServer in the site’s

web.config file.

String

Handlers

SendingEmail Event handler to add custom code to the sending email event. String

SentEmail Event handler to add custom code to the sent email event. String

CaptureOrderActivity
The CaptureOrderActivity initiates the capture of an order in CMS400.NET. When the Workflow reaches this
activity, the process of submitting encrypted order information (including the transaction ID) to a payment
gateway account happens. At this time, the account is changed for the order amount.

Use this activity when you want the capture to take place automatically in the Workflow. This activity is the
same as a CMS400.NET user going to the Workarea and marking an order as Captured. For information on
how a Capture works in the Workarea, see "Capturing the Order" on page 17-200.

Key Properties

n orderId - associate this activity with orders in CMS400.NET.
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CaptureOrderActivity Properties
The following table explains the properties of the CaptureOrderActivity workflow activity.

Property Description
Data

Type

Activity

(Name) Enter a name for the Activity. String

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Handlers

MethodInvoking Select amethod to call before the order is captured.

Misc

orderId

SelectOrderId to dynamically associate this activitywith

orders in CMS400.NET.

Click the Ellipsis ( ) button and selectOrderId from the list.

CheckStockActivity
Add the CheckStockActivity to a workflow when you want to verify the quantity of items ordered is available
for shipping. When the workflow reaches this activity, the quantity of each product in the order is checked. If
the required quantity exists for each item, the activity returns True. Otherwise, the activity returns False.

Key Properties

n orderId - dynamically associate this activity with orders in CMS400.NET.
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CheckStockActivity Properties
The following table explains the properties of the CheckStockActivity workflow activity.

Property Description
Data

Type

Activity

(Name) Enter a name for the Activity. String

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Handlers

MethodInvoking Select amethod to call before the stock level is checked.

Misc

orderId

SelectOrderId to dynamically associate this activitywith

orders in CMS400.NET.

Click the Ellipsis ( ) button and selectOrderId from the list.

ReturnValue

Default isFalse.Choicesare:

True - the quantity of each product ordered is in stock.

False - there is not enough product in stock to fulfill the order.

Boolean

OrderCancelledEventActivity
Add the OrderCancelledEventActivity to a workflow when you want to block the workflow from going down a
cancel path until the order has actually been cancelled.

This activity does not cancel the order. It waits for a user, API code or UpdateOrderActivity to mark the order
cancelled in CMS400.NET before it continues down the order cancel path. Think of it as gate that’s waiting for
a certain event to happen before it can continue. Once the event happens, the path is opened in the workflow.

For information on how to cancel an order in the Workarea, see "Cancelling the Order" on page 17-202.
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Key Properties

n OrderId - dynamically associate this activity with orders in CMS400.NET.

OrderCancelledEventActivity Properties
The following table explains the properties of the OrderCancelledEventActivity workflow activity.

Property Description
Data

Type

Activity

(Name) Enter a name for the Activity. String

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Roles

Handlers

Invoked Specify code that executeswhen the order is cancelled. String

Misc

OrderId

SelectOrderId to dynamically associate this activitywith orders in

CMS400.NET.

Click the Ellipsis ( ) button and selectOrderId from the list.

OrderFraudEventActivity
Add the OrderFraudEventActivity to a workflow when you want to block the workflow from going down a
path that handles fraudulent orders until the order has actually been marked as fraud.
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This activity does not mark the order as fraudulent. It waits for a user, API code or the UpdateOrderActivity to
mark the order as fraud in CMS400.NET before it continues down the path. Think of it as gate that’s waiting for
a certain event to happen before it can continue. Once the event happens, the path is opened in the workflow.

For information on how to mark an order as fraud in the Workarea, see "Marking the Order as Fraud" on page
17-203.

Key Properties

n OrderId - dynamically associate this activity with orders in CMS400.NET.

OrderFraudEventActivity Properties
The following table explains the properties of the OrderFraudEventActivity workflow activity.

Property Description
Data

Type

Activity

(Name) Enter a name for the Activity. String

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Roles

Handlers

Invoked
Specify code that executeswhen the order hasbeenmarked as

fraud.
String

Misc

OrderId

SelectOrderId to dynamically associate this activitywith orders in

CMS400.NET.

Click the Ellipsis ( ) button and selectOrderId from the list.
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OrderProcessedEventActivity
Add the OrderProcessedEventActivity to a workflow when you want to block the workflow from going down
an order process path until the order has actually been processed. This is a generic event activity that allows you
to specify custom code to somehow process the order.

This activity does not start the process. It waits for a user, API code or the UpdateOrderActivity to kick off the
Process Order action in CMS400.NET before it continues down the path. Think of it as gate that’s waiting for a
certain event to happen before it can continue. Once the event happens, the path is opened in the workflow.

For information on how to cancel an order in the Workarea, see "Cancelling the Order" on page 17-202.

Key Properties

n OrderId - dynamically associate this activity with orders in CMS400.NET.

OrderProcessedEventActivity Properties
The following table explains the properties of the OrderProcessedEventActivity workflow activity.

Property Description
Data

Type

Activity

(Name) Enter a name for the Activity. String

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Roles

Handlers

Invoked Specify code that executeswhen the order hasbeen processed. String

Misc
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Property Description
Data

Type

OrderId

SelectOrderId to dynamically associate this activitywith orders in

CMS400.NET.

Click the Ellipsis ( ) button and selectOrderId from the list.

OrderReceivedEventActivity
The OrderReceivedEventActivity is usually the first item in an order workflow. This activity does not mark the
order as received, but instead waits for CMS400.NET to register a new order. Once the order is received, this
activity allows the workflow to start. Think of it as gate that’s waiting for a certain event to happen before it can
continue. Once the event happens, the path is opened in the workflow.

Key Properties

n OrderId - dynamically associate this activity with orders in CMS400.NET.

OrderReceivedEventActivity Properties
The following table explains the properties of the OrderReceivedEventActivity workflow activity.

Property Description
Data

Type

Activity

(Name) Enter a name for the Activity. String

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Roles
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Property Description
Data

Type

Handlers

Invoked Specify code that executeswhen the order hasbeen received. String

Misc

OrderId

SelectOrderId to dynamically associate this activitywith orders in

CMS400.NET.

Click the Ellipsis ( ) button and selectOrderId from the list.

OrderShippedEventActivity
Add the OrderShippedEventActivity to a workflow when you want to block the workflow from going down a
shipped order path until the order has actually been shipped.

This activity does not mark the order as shipped. It waits for a user, API code or UpdateOrderActivity to mark
the order as shipped in CMS400.NET before it continues down the path. Think of it as gate that’s waiting for a
certain event to happen before it can continue. Once the event happens, the path is opened in the workflow.

For information on how to mark an order as shipped in the Workarea, see "Marking the Order as Shipped" on
page 17-203.

Key Properties

n OrderId - dynamically associate this activity with orders in CMS400.NET.

OrderShippedEventActivity Properties
The following table explains the properties of the OrderShippedEventActivity workflow activity.

Property Description
Data

Type

Activity

(Name) Enter a name for the Activity. String
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Property Description
Data

Type

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Roles

Handlers

Invoked Specify code that executeswhen the order is shipped. String

Misc

OrderId

SelectOrderId to dynamically associate this activitywith orders in

CMS400.NET.

Click the Ellipsis ( ) button and selectOrderId from the list.

OrderUpdatedEventActivity
Add the OrderUpdatedEventActivity to a workflow when you want to block the workflow from going down an
updating order path until the order has actually been updated.

This activity does not update the order as shipped. It waits for a user, API code or UpdateOrderActivity to
update an order in CMS400.NET before it continues down the path. Think of it as gate that’s waiting for a
certain event to happen before it can continue. Once the event happens, the path is opened in the workflow.

Key Properties

n OrderId - dynamically associate this activity with orders in CMS400.NET.

OrderUpdatedEventActivity Properties
The following table explains the properties of the OrderUpdatedEventActivity workflow activity.
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Property Description
Data

Type

Activity

(Name) Enter a name for the Activity. String

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Roles

Handlers

Invoked Specify code that executeswhen the order hasbeen updated. String

Misc

OrderId

SelectOrderId to dynamically associate this activitywith orders in

CMS400.NET.

Click the Ellipsis ( ) button and selectOrderId from the list.

UpdateOrderActivity
Add the UpdateOrderActivity to a workflow when you want to automate the updating of an order’s status in
one of the these ways:

n Received - marks an order as received

n InProcess - marks the order as in process

n Shipped - marks the order as shipped

n Completed - marks the order as completed

n Cancelled - marks the order as cancelled

n OnHold - puts the order on hold

n Fraud - marks the order as fraud

This activity is the same as a CMS400.NET user going to the Workarea and performing any of the above
actions on an order. For information on how to manually complete these tasks in the Workarea, see "Orders" on
page 17-197.

UpdateOrderActivity

ReferenceManual

Version 8.0 Rev 1.3
17-271



UpdateOrderActivity Properties
The following table explains the properties of the UpdateOrderActivity workflow activity.

Property Description
Data

Type

Activity

(Name) Enter a name for the Activity. String

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Handlers

MethodInvoking

Misc

OrderId

SelectOrderId to dynamically associate this activitywith

orders in CMS400.NET.

Click the Ellipsis ( ) button and selectOrderId from the list.

orderStatus

Default isReceived. Choicesare:

Received - marksan order as received

InProcess -

Shipped - marks the order as shipped

Completed - marks the order as completed

Cancelled - marks the order as cancelled

OnHold - puts the order on hold

Fraud - marks the order as fraud
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Customizing the Payment Gateway
Provider
A Payment Gateway Provider is a pluggable component that is integrated into Ektron’s

CMS400.NET eCommerce module. A Payment provider handles eCommerce customer

payments by utilizing third party payment gateways. CMS400.NET’s eCommerce module

accepts payments such as credit cards. Then, it passes that information to a third party service.

The third party service processes the payment, and returns a transaction ID that’s stored with

the customer's order.

Note: Your companyneeds to set up an account with a third party payment service before utilizing the payment

provider. This includespayment providers such asAuthorize.NET and PayFlow, which are includedwith

CMS400.NET’seCommerceModule.

CMS400.NET comes with several payment providers, including Authorize.NET and PayFlow.

You can customize these providers or create your own using the extendable Payment Gateway

Provider architecture.

Each type of payment gateway provider accepts configuration parameters. For example,

Authorize.NET requires a username and password while PayFlow requires a username,

password, vendor, and partner.

In addition, some payment gateways may support recurring payments, while others may not.

Recurring payments provide the ability to create a payment that recurs at a given interval for a

specified period of time. For example, you could create a payment for $9.99 that occurs on the

first of every month for the next 12 months. This is something to consider if your site relies on

a subscription service. Contact your provider to find out if they support recurring payments.

The following table shows the flow of payment information for a customer purchasing a

product from your site through you receiving the money in your account.

Step Description

1.
A customer purchasesa product from your site and submits his payment

information.

2. Ektron CMS400.NET’spasses the information to your payment gateway.

3.
Your payment gatewayprovider passes the information to your bank’s

processor.

4.
The bank’s processor submits the information to a credit card interchange

for processing, clearing and settlement.

Customizing the Payment Gateway Provider

ReferenceManual

Version 8.0 Rev 1.3
17-273



Step Description

5.
The interchange notifies the customer’s credit card companyof the

transactionsdetails.

6.
The credit card companyaccepts or declines the transaction based on the

customersaccount information.

7.
If the transaction is approved, the fundsare transferred to the

interchange.

8.
The credit card interchange sends information about whether the

transaction is approved or not to your bank’s processor.

9. This information is passed to your payment gatewayprovider.

10.
The provider notifies your site of the information. The results of the

transaction are displayed on the page the customer is viewing.

11. The credit card interchange sends funds to your merchant account.

This section explains how to extend Ektron’s Payment Gateway Provider Architecture to build

your own customized Payment Gateway Provider.

See Also: "Payment Options" on page 17-61

Payment Gateway Provider Object Model
Below is the Object Model for Ektron’s Payment Gateway Provider.
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The PaymentGatewayProvider is the abstract base class you must extend to implement your

own payment gateway. Details and descriptions of the PaymentGatewayProvider API can be

found in the Ektron CMS400.NETAPI Reference Manual’s Providers API >

PaymentGatewayProvider section.

Creating a Custom Payment Gateway Provider
In addition to the out-of-the-box payment gateways providers shipped with CMS400.NET, you

can create your own custom payment providers that connect with any payment gateway you

choose. Below are the basic code steps you need to complete when creating a custom gateway

provider. Additional code examples used by Ektron to create the PayFlow and

Authourize.NET providers are located in:

C:\Program Files\E-

ktron\CMS400SDK\Commerce\Providers\Commerce.Providers\PaymentGateways

Note: The complete C# code sample used in this example is available at the end of this section. See

"CustomGatewayProvider Code Example" on page 17-280

1. Create a class library project in Visual Studio.

2. Add references to these DLLs:

- Ektron.Cms.Commerce

- Ektron.Cms.Common
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- Ektron.Cms.ObjectFactory

- Ektron.Cms.Instrumentation

- System.Configuration

3. Add these using statements to the code behind:

- using System;

- using System.Collection;

- using System.Collection.Specialized;

- using Ektron.Cms;

- using Ektron.Cms.Common;

- using Ektron.Cms.Commerce;

4. Change the namespace to:
namespace Ektron.Cms.Extensibility.Commerce.Samples
{

5. Rename your class and inherit as below:
public class CustomPaymentProvider : Ektron.Cms.Commerce.PaymentGatewayProvider

{

6. Add the following constructor.

#region constructor, member variables
public CustomPaymentProvider() { }
#endregion

7. Add the methods required by the PaymentGatewayProvider base class. The Initialize

method reads configuration information, the others are related to the payments and will be

completed later in the example.

#region PaymentProvider Implementation

public override void Initialize(string name,

System.Collections.Specialized.NameValueCollection config)
{
if (config == null)
throw new ArgumentNullException("config");

// Assign the provider a default name if it doesn't have one
if (String.IsNullOrEmpty(name))
name = "CustomPaymentProvider";

if (string.IsNullOrEmpty(config["description"]))
{
config.Remove("description");
config.Add("description", "CustomPaymentProvider");
}

// Call the base class's Initialize method
base.Initialize(name, config);

// Throw an exception if unrecognized attributes remain
if (config.Count > 0)
{
foreach (string key in config.AllKeys)
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{
EkException.WriteToEventLog("Unrecognized Payment Gateway Provider attribute: " + key,

System.Diagnostics.EventLogEntryType.Warning);
}
}
}

public override string Authorize()
{
}

public override string AuthorizeAndCapture()
{
}

public override string CapturePreauthorization(string transactionId)
{
}

public override string VoidPreAuthorization(string transactionId)
{
}

#endregion

8. Implement the Authorize method that you added in the previous step. This method is

called to authorize a given amount of money when an order is submitted.
public override string Authorize()
{
if (PaymentMethod.GetType() != typeof(CreditCardPayment))
throw new Ektron.Cms.Commerce.Exceptions.AuthorizationException("Invalid Payment Type");

CreditCardPayment creditCard = (CreditCardPayment)this.PaymentMethod;

if (creditCard.ExpirationDate.IsExpired())
throw new Ektron.Cms.Commerce.Exceptions.Payment.CreditCard.CardExpiredException("Card

Is Expired");
IsSubmissionSuccess = true;

Authorization.AuthorizedOn = DateTime.Now;
Authorization.TransactionId = new Guid().ToString();

return Authorization.TransactionId;

}

Note: In this example, the card number and the card holder name are not checked. In a realworld scenario, there

would be additional validation (for example, via checksum) and the authorizationmaybe obtained via aWeb

service or HTTPpost.

Note: If the authorization fails, you can choose to either throw an exception or manually set the failure. For

example:

SubmissionError = "Not enough Funds";IsSubmissionSuccess =

false;

9. Implement the AuthorizeAndCapture, CapturePreauthorization and VoidPreAuthorization

methods you added earlier.
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- AuthorizeAndCapture requires that Authorization.CapturedOn be set, as the capture

occurs at the same time as the Authorization.

- For CapturePreauthorization and VoidPreAuthorization, set the appropriate dates for

these actions, so they are recorded in the system properly.

public override string AuthorizeAndCapture()
{
IsSubmissionSuccess = true;

Authorization.AuthorizedOn = DateTime.Now;
Authorization.CapturedOn = DateTime.Now;
Authorization.TransactionId = new Guid().ToString();

return Authorization.TransactionId;
}

public override string CapturePreauthorization(string transactionId)
{
IsSubmissionSuccess = true;

Authorization.CapturedOn = DateTime.Now;
return Authorization.TransactionId;
}

public override string VoidPreAuthorization(string transactionId)
{
IsSubmissionSuccess = true;

Authorization.VoidedOn = DateTime.Now;
return Authorization.TransactionId;

}

10. Save and build the project.

11. Copy your project’s DLL file to your Ektron Web site’s bin directory.

12. Register the provider in your site’sWeb.config file. The Web.config file provides the

facility to manage payment gateway providers within CMS400.NET. Locate the

EktronPaymentGateway section and change the defaultProvider parameter to the name

of your custom provider. Note that changing this from “Automatic” to the name of your

provider overrides the settings in Workarea > Settings > Commerce > Configuration >

Payment Gateways and CMS400.NET will now use the new provider.

Note: If you start your search from the top of the file, it will be the second instance.

<EktronPaymentGateway defaultProvider="CustomPaymentProvider">

13. Add your custom payment provider between the EktronPaymentGateway’s

<providers> tags. Note that the name defined here needs to match the name defined

as the defaultProvider in the previous step.
<providers>
<add name="CustomPaymentProvider"

type="Ektron.Cms.Extensibility.Commerce.Samples.CustomPaymentProvider,

CustomPaymentProvider" />

</providers>

14. Save the Web.config file.
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Next add the payment gateway to the Workarea with the following steps.

15. Go to Workarea > Commerce > Configuration > Payment Options.

16. Select New > Payment Gateway.

17. In the Name dropdown, select customerPaymentProvider.

18. Check both Cards and Checks checkboxes.

19. Save these changes.

Your custom payment provider is now the default provider. Whenever a payment provider

needs to be contacted, the information routes through the new custom provider.

Making Your Custom Provider Appear as an Option in the
Workarea
In the example above, you changed the web.config file’s EktronPaymentGateway

defaultProvider parameter to the name of your custom payment provider. This overrides the

payment provider settings in the Workarea. If you want to manage all payment providers from

the Workarea > Settings > Commerce > Configuration > Payment Gateways screen, follow

these steps:

1. In the Web.config file, locate the EktronPaymentGateway section and make sure the

defaultProvider parameter is set to “Automatic”.
<EktronPaymentGateway defaultProvider="Automatic">

2. Save the Web.config file.

3. Navigate to the Workarea > Settings > Commerce > Configuration > Payment

Gateways screen.

4. Click New > Payment Gateway.

5. Use the following table to complete the screen.

Field Description

Name From the drop down list, select the name of the your new custom gateway.

Default

Check this box if you want this to be the default payment gateway. The

default payment gateway is the gatewayall payment information is routed

through.

User ID
Enter the User ID for this payment gateway. This ID will identify your

account with this gatewayprovider.

Password Enter the password for your account with this gatewayprovider.

Expand Custom

Values

If this gatewayprovider expects additional parameterswhen contacting it,

enter those values into the Custom 1 and Custom 2 fields.
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6. Click the Save button ( ).

The custom gateway provider has been added and can now be managed from the Workarea.

CustomGatewayProvider Code Example

Warning! Copying and pasting the code below and using it without modification to create a DLLwill not result in a

working custom payment provider. This code is provided asan outline of what is needed to create an actual custom

payment provider.

Below is the full C# code example used in this section. See Also: "Creating a Custom Payment

Gateway Provider" on page 17-275.

using System;
using System.Collections;
using System.Collections.Specialized;
using System.Configuration.Provider;

using Ektron.Cms;
using Ektron.Cms.Common;
using Ektron.Cms.Commerce;

namespace Ektron.Cms.Extensibility.Commerce.Samples
{
public class CustomPaymentProvider : Ektron.Cms.Commerce.PaymentGatewayProvider
{
public CustomPaymentProvider() { }

public override void Initialize(string name,

System.Collections.Specialized.NameValueCollection config)
{
if (config == null)
throw new ArgumentNullException("config");

// Assign the provider a default name if it doesn't have one
if (String.IsNullOrEmpty(name))
name = "CustomPaymentProvider";

if (string.IsNullOrEmpty(config["description"]))
{
config.Remove("description");
config.Add("description", "CustomPaymentProvider");
}

// Call the base class's Initialize method
base.Initialize(name, config);

// Throw an exception if unrecognized attributes remain
if (config.Count > 0)
{
foreach (string key in config.AllKeys)
{
EkException.WriteToEventLog("Unrecognized Payment Gateway Provider attribute: " + key,

System.Diagnostics.EventLogEntryType.Warning);
}
}
}
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public override string Authorize()
{
if (PaymentMethod.GetType() != typeof(CreditCardPayment))
throw new Ektron.Cms.Commerce.Exceptions.AuthorizationException("Invalid Payment Type");

CreditCardPayment creditCard = (CreditCardPayment)this.PaymentMethod;

if (creditCard.ExpirationDate.IsExpired())
throw new Ektron.Cms.Commerce.Exceptions.Payment.CreditCard.CardExpiredException("Card

Is Expired");

IsSubmissionSuccess = true;

Authorization.AuthorizedOn = DateTime.Now;
Authorization.TransactionId = new Guid().ToString();

return Authorization.TransactionId;
}

public override string AuthorizeAndCapture()
{
IsSubmissionSuccess = true;

Authorization.AuthorizedOn = DateTime.Now;
Authorization.CapturedOn = DateTime.Now;
Authorization.TransactionId = new Guid().ToString();

return Authorization.TransactionId;
}

public override string CapturePreauthorization(string transactionId)
{
IsSubmissionSuccess = true;

Authorization.CapturedOn = DateTime.Now;
return Authorization.TransactionId;
}

public override string VoidPreAuthorization(string transactionId)
{
IsSubmissionSuccess = true;

Authorization.VoidedOn = DateTime.Now;
return Authorization.TransactionId;
}
}
}

Customizing the Shipment Provider
A Shipping Provider is a pluggable component integrated into Ektron's CMS400.NET

eCommerce module. The Shipping provider handles eCommerce real-time shipping rate

retrieval by utilizing third party shipping services such as FedEx or UPS, or you can create

your own fixed rate logic. CMS400.NET's eCommerce shipping module calculates the

package(s) needed for an order and then passes the following information to the company

providing the shipping services via a Shipping Provider.
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n package information - for example, how many, height, width, depth and weight of each

package.

n warehouse address - the address from which the items will be shipped. A warehouse’s

information can be set in the Workarea > Settings > Commerce > Shipping >

Warehouses screen.

n destination address - the address a customer entered as his shipping address when making

the purchase.

n desired shipping options - for example, if you have Next Day, 2-Day Ground and 3-Day

Ground as shipping options, you can pass the option chosen by the customer.

CMS400.NET comes with several shipping providers, including FedEx and UPS. You can

customize these providers or create your own using the extendable Shipping Provider

architecture.

Note: Your companywill need to set up or have an existing account with a third party shipping service before

utilizing the shipping provider. This includesshipping providers such as, FedExor UPS, which are includedwith

CMS400.NET'seCommerceModule.

Each type of shipping provider accepts configuration parameters. For example, FedEx requires a

username, password, account number, and meter number while UPS requires a Username,

password, and account number. These configuration parameters along with the provider

definitions are stored in the SiteRoot/shipment.config file. Below is a provider

definition example for FedEx.

<add name="FedExShipmentProvider" type="Ektron.Cms.C-

ommerce.Providers.Shipment.FedExShipmentProvider, Ektron.Cms.Commerce.Providers" serv-

iceUrl="https://gatewaybeta.fedex.com/web-services" key="" password="" accountNumber=""

meterNumber="" transactionId="Ektron FedEx v3 based transaction" />

The following steps show the flow of shipping calculations for a customer purchasing a

product from your site.

1. A customer adds two books his to cart and clicks checkout.

2. The shipping calculator looks for the smallest possible package that will fit the items.

3. The shipping calculator calls the registered shipping provider for each package in the

order.

4. The shipping calculator combines all the rates received if more than one package is being

shipped and returns the shipping method rates to the checkout control.

5. The customer selects the desired shipping method and it is saved with the cart.

Note: ManyCMS400.NET settingsaffect your shipping calculations. A default warehousemust be defined with a

valid shipping address. Shippingmethodsyou would like to offer customersmust be defined. For example, the

FedExprovider supports over 10 possible shippingmethods, but youmayonly be concernedwith Priority, 2 Day,

andGround. Thismust be defined in CMS400.NET. You can also define the shipping packagesyour businessuses.

The Shipping calculator will try and fit the order items into anypackagesdefined in the CMS. If no packagesare

defined, the item's dimensionsare passed to the provider instead.
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Shipment Provider Object Model
Below is the Object Model for Ektron’s Shipment Provider.

The ShipmentProvider is the abstract base class you must extend to implement your own

Shipping Provider. Details and descriptions of the ShipmentProvider API can be found in the

Ektron CMS400.NET API Reference Manual’s Providers API > Shipment > Provider >

ShipmentProvider.

Creating a Custom Shipment Provider
In addition to the out-of-the-box shipment providers that come with CMS400.NET, you can

create a custom provider that connects with any shipping company you choose. Below are the

basic code steps you need to complete when creating a custom shipment provider. Additional

code examples used by Ektron to create FedEx, Flat Rate and UPS shipment providers are

located in:

C:\Program Files\Ektron\CMS400SDK\Commerce\Providers\Commerce.Providers\Shipping

Note: The complete C# code sample used in this example is available at the end of this section. See

"CustomShipmentProvider Code Example" on page 17-287

1. Create a class library project in Visual Studio.

2. Add references to these DLLs:

- Ektron.Cms.Commerce

- Ektron.Cms.Common

- Ektron.Cms.ObjectFactory
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- Ektron.Cms.Instrumentation

- System.Configuration

3. Add these using statements to the code behind:

- using System.Configuration.Provider;

- using Ektron.Cms.Commerce.Shipment.Provider;

- using Ektron.Cms.Commerce;

- using Ektron.Cms.Instrumentation;

4. Change the namespace to:

namespace Ektron.Cms.Extensibility.Commerce.Samples

{

5. Rename your class and inherit as below:

public class CustomShipmentProvider : ShipmentPovider

{

6. Add the following constructor private variables and properties. The items added to the

shippingOptionList are the shipping methods exposed as a service type in the

management screen inside the Workarea.

#region constructor, member variables
public CustomShipmentProvider()
{
IsTrackingSupported = false;
_shippingOptionList = new List<string>();
_shippingOptionList.Add("CustomOption_1");
_shippingOptionList.Add("CustomOption_2");
}

private List<string> _shippingOptionList;
#endregion

7. Add the following methods required by the ShipmentProvider base class.

- Initialize - reads configuration information

- GetServiceTypes - returns a List <string> of the shipping options available

- GetTrackingUrl - exposes tracking support

- GetRates - returns a list of shipping rates for the items being shipped. The contents of

this method will be added in the next step.

#region ShipmentProvider Implementation

public override void Initialize(string name,

System.Collections.Specialized.NameValueCollection config)
{
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if (config == null)
throw new ArgumentNullException("config");

// Assign the provider a default name if it doesn't have one
if (string.IsNullOrEmpty(name))
name = "CustomShipmentProvider";

if (string.IsNullOrEmpty(config["description"]))
{
config.Remove("description");
config.Add("description", "CustomShipmentProvider Provider");
}

// Call the base class's Initialize method
base.Initialize(name, config);

// Throw an exception if unrecognized attributes remain
if (config.Count == 0)
throw new ProviderException("Shipment provider attribute missing.");
else
{
//read all config attributes.
ServiceUrl = config["serviceUrl"];
Key = config["key"];
Password = config["password"];
AccountNumber = config["accountNumber"];
MeterNumber = config["meterNumber"];
TransactionId = config["transactionId"];
}
}

public override List<string> GetServiceTypes()
{
return _shippingOptionList;
}

public override string GetTrackingUrl(string trackingId)
{
return "";
}

public override List<ShippingOptionData>

GetRates(IEnumerable<ShippingMethodData> expectedOptions, AddressData

origin, AddressData destination, Weight weight, Dimensions dimensions)
{
}

#endregion

8. Implement the GetRates method. Add this code to public override for GetRates which was

added during the previous step. When complete, the code should look like this.

Note: This example uses flat rates for your shippingmethods. In a realworld scenario, the shippingmethodsand

their corresponding rates can be obtained via FedEx, UPS, a third party application or aWeb service.
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public override List<ShippingOptionData>

GetRates(IEnumerable<ShippingMethodData> expectedOptions, AddressData

origin, AddressData destination, Weight weight, Dimensions dimensions)
{
List<ShippingOptionData> availableOptions = new

List<ShippingOptionData>();

try
{
foreach (ShippingMethodData expectedOption in expectedOptions)
{
Log.WriteInfo("Custom Shipping Provider. ExpectedOption:" +

expectedOption.Name);
switch (expectedOption.ProviderService.ToLower())
{
case "customoption_1":
ShippingOptionData customOption1 = new ShippingOptionData();
customOption1.Id = expectedOption.Id;
customOption1.Name = expectedOption.Name;
customOption1.ShippingFee = 25.00M;
customOption1.ProviderService = "CustomOption_1";
availableOptions.Add(customOption1);
break;
case "customoption_2":
ShippingOptionData customOption2 = new ShippingOptionData();
customOption2.Id = expectedOption.Id;
customOption2.Name = expectedOption.Name;
customOption2.ShippingFee = 50.00M;
customOption2.ProviderService = "CustomOption_2";
availableOptions.Add(customOption2);
break;
}
}
}
catch (Exception e)
{
Log.WriteError("Custom Shipping Provider: Error retrieving shipping rates."

+ e.Message);
throw;
}

return availableOptions;

}
}
}

Note: You can use theGetRatesmethod to restrict countries to which you ship. For example, if you want to

prevent shipping to all countriesexcept Canada, add these linesof code to theGetRatesmethod.

if (destination.Country.Id != 124)
throw new

Ektron.Cms.Commerce.Exceptions.Shipping.InvalidAddressException("We only

ship to Canada.");
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9. Save and build the project.

10. Copy your project’s DLL file to your Ektron Web site’s bin directory.

11. Register the provider in your site’s shipment.config file. This file provides the facility to

manage shipping providers within CMS400.NET. Locate the shipmentProvider section

and change the defaultProvider parameter to the name of your custom provider.

<shipmentProvider defaultProvider="CustomShipmentProvider">

12. Add your custom shipping provider between the shipmentProvider’s <providers>
tags. Note that the name defined here needs to match the name defined as the

defaultProvider in the previous step.

<providers>
<add name="CustomShipmentProvider"

type="Ektron.Cms.Extensibility.Commerce.Samples.CustomShipmentProvider,

CustomShipmentProvider" serviceUrl="" key="" password="" accountNumber=""

meterNumber="" transactionId="CustomShipmentProvider based transaction" />
</providers>

13. Save the Web.config file.

Your custom shipping provider is now the default provider. Whenever you need to obtain

shipping rate information, the information routes through the new custom provider.

14. Add the shipping methods that are available for your provider in the Workarea > Settings

> Commerce -> Shipping > Methods screen.

- Select New > Shipping Method.

- Enter a name. This is what a customer sees during the checkout process. An example is

“Ground” or “Next Day”. For this example, use “Custom1”.

- Check the Active checkbox.

- Click the View Options link and select CustomOption_1 from the list.

- Click the Save button ( ).

- Repeat this process for the CustomOption2 shipping method type.

The options are now available in the checkout process, and are shown on the shipping method

selection screen.

CustomShipmentProvider Code Example

Warning! Copying and pasting the code below and using it without modification to create a DLL doesnot result in

a working “real time” shipping provider. This example uses fixed ratesand should bemodified tomeet your needs.
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Below is the full C# code example used in this section. See Also: "Creating a Custom

Shipment Provider" on page 17-283.

using System.Configuration.Provider;
using Ektron.Cms.Commerce.Shipment.Provider;
using Ektron.Cms.Commerce;
using Ektron.Cms.Instrumentation;

namespace Ektron.Cms.Extensibility.Commerce.Samples
{
public class CustomShipmentProvider : ShipmentProvider
{
#region constructor, member variables
public CustomShipmentProvider()
{
IsTrackingSupported = false;
_shippingOptionList = new List<string>();
_shippingOptionList.Add("CustomOption_1");
_shippingOptionList.Add("CustomOption_2");
}

private List<string> _shippingOptionList;

#endregion

#region ShipmentProvider Implementation

public override void Initialize(string name,

System.Collections.Specialized.NameValueCollection config)
{
if (config == null)
throw new ArgumentNullException("config");

// Assign the provider a default name if it doesn't have one
if (string.IsNullOrEmpty(name))
name = "CustomShipmentProvider";

if (string.IsNullOrEmpty(config["description"]))
{
config.Remove("description");
config.Add("description", "CustomShipmentProvider Provider");
}

// Call the base class's Initialize method
base.Initialize(name, config);

// Throw an exception if unrecognized attributes remain
if (config.Count == 0)
throw new ProviderException("Shipment provider attribute missing.");
else
{
//read all config attributes.
ServiceUrl = config["serviceUrl"];
Key = config["key"];
Password = config["password"];
AccountNumber = config["accountNumber"];
MeterNumber = config["meterNumber"];
TransactionId = config["transactionId"];
}
}

public override List<string> GetServiceTypes()
{
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return _shippingOptionList;
}

public override string GetTrackingUrl(string trackingId)
{
return "";
}

public override List<ShippingOptionData> GetRates(IEnumerable<ShippingMethodData>

expectedOptions, AddressData origin, AddressData destination, Weight weight, Dimensions

dimensions)
{

List<ShippingOptionData> availableOptions = new List<ShippingOptionData>();

try
{
foreach (ShippingMethodData expectedOption in expectedOptions)
{
Log.WriteInfo("Custom Shipping Provider. ExpectedOption:" + expectedOption.Name);

switch (expectedOption.ProviderService.ToLower())
{
case "customoption_1":
ShippingOptionData customOption1 = new ShippingOptionData();
customOption1.Id = expectedOption.Id;
customOption1.Name = expectedOption.Name;
customOption1.ShippingFee = 25.00M;
customOption1.ProviderService = "CustomOption_1";
availableOptions.Add(customOption1);
break;

case "customoption_2":
ShippingOptionData customOption2 = new ShippingOptionData();
customOption2.Id = expectedOption.Id;
customOption2.Name = expectedOption.Name;
customOption2.ShippingFee = 50.00M;
customOption2.ProviderService = "CustomOption_2";
availableOptions.Add(customOption2);
break;
}
}
}
catch (Exception e)
{
Log.WriteError("Custom Shipping Provider: Error retrieving shipping rates." +

e.Message);
throw;
}

return availableOptions;

}

#endregion

}
}
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Customizing the Inventory Provider
An Inventory Provider is a pluggable component that’s integrated into Ektron's CMS400.NET

eCommerce module. An Inventory Provider handles the retrieving and updating of inventory

information for products within the CMS. Out of the Box, the CMS400.NET comes with a

default Ektron Inventory Provider that tracks inventory within the CMS database.

If your business has an Accounting or Enterprise Resource Management solution that manages

inventory, you can create a custom Inventory Provider that retrieves and updates inventory

information directly from that system. Inventory data can be stored in any number of locations,

including databases, ERP or CRM systems, or even XML files.

Inventory Provider Object Model
Below is the Object Model for Ektron’s Inventory Provider.

The InventoryProvider is the abstract base class you must extend to implement your own

Inventory Provider. Details and descriptions of the InventoryProvider API can be found in the

Ektron CMS400.NET API Reference Manual’s Providers API > Inventory > Provider >

InventoryProvider.

Creating a Custom Inventory Provider
In addition to the out-of-the-box inventory provider that comes with CMS400.NET, you can

create your own custom provider that connects with an existing inventory system. Below are

the basic code steps you need to complete when creating a custom inventory provider. A code

example for the inventory provider used by CMS400.NET is located in:

C:\Program Files\Ektron\CMS400SDK\Commerce\Providers\Commerce.Providers\Inventory
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Note: The complete C# code sample used in this example is available at the end of this section. See

"CustomInventoryProvider Code Example" on page 17-292

1. Create a class library project in Visual Studio.

2. Add references to these DLLs:

- Ektron.Cms.Commerce

- Ektron.Cms.Common

- Ektron.Cms.ObjectFactory

- System.Configuration

3. Add these using statements to the code behind:

- using Ektron.Cms.Commerce.Inventory.Provider;

- using Ektron.Cms.Commerce.Data;

- using Ektron.Cms.Commerce;

- using Ektron.Cms.Common;

- using Ektron.Cms.Extensibility;

- using Ektron.Cms.Extensibility.Commerce;

4. Change the namespace to:
namespace Ektron.Cms.Extensibility.Commerce.Samples
{

5. Rename your class and inherit as below:
public class CustomInventoryProvider : InventoryPovider
{

6. Add the following constructor, private variables and properties.
public CustomInventoryProvider() { }private CmsInventory _inventory;
protected CmsInventory Inventory
{
get
{
if (_inventory == null)
{
_inventory = new CmsInventory(RequestInformation);
}
return _inventory;
}

}

7. Override the following methods. These methods area called when the inventory system is

queried.

- GetInventory - returns an InventoryData data class for a given product id.

- SaveInventory - persists updates to the stock levels inside the inventory system.

Note: In this example, we trigger CMS400.NET extensibility events, such asOnBeforeInventorySave() and

OnAfterInventorySave(). In a realworld scenario, your existing inventory systemmayhave its own inventoryevents

that are used.
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public override InventoryData GetInventory(long entryId)
{
return Inventory.GetInventory(entryId);
}

public override void SaveInventory(InventoryData inventory)
{
OnBeforeInventorySave(inventory);
Inventory.SaveInventory(inventory);
OnAfterInventorySave(inventory);

if (inventory.UnitsInStock < inventory.ReorderLevel)
{
OnInventoryReorderLevelReached(inventory);
}
}
}
}

8. Save and build the project.

9. Copy your project’s DLL file to your Ektron web site’s bin directory.

10. Register the provider in your site’sWeb.config file. The Web.config file provides the

facility to manage inventory providers within CMS400.NET. Locate the

InventoryProvider section and change the defaultProvider parameter to the name of your

custom provider.

Note: If you start your search from the top of the file, it will be the second instance.

<inventoryProvider defaultProvider="CustomInventoryProvider">

11. Add your custom payment provider between the EktronPaymentGateway’s

<providers> tags. Note that the name defined here needs to match the name defined

as the defaultProvider in the previous step.

<providers>
<add name="CustomInventoryProvider"

type="Ektron.Cms.Extensibility.Commerce.Samples.CustomInventoryProvider,

CustomInvnetoryProvider" />
</providers>

12. Save the Web.config file.

Your custom inventory provider is now the default provider. Whenever the inventory is

queried, the call routes through the new custom provider.

CustomInventoryProvider Code Example

Warning! Copying and pasting the code below and using it without modification to create a DLL doesnot result in

a working “real time” shipping provider. This example uses fixed ratesand should bemodified tomeet your needs.
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Below is the full C# code example used in this section. See Also: "Creating a Custom

Inventory Provider" on page 17-290.

using Ektron.Cms.Commerce.Inventory.Provider;
using Ektron.Cms.Commerce.Data;
using Ektron.Cms.Commerce;
using Ektron.Cms.Common;
using Ektron.Cms.Extensibility;
using Ektron.Cms.Extensibility.Commerce;

namespace Ektron.Cms.Extensibility.Commerce.Samples
{
public class CustomInventoryProvider : InventoryProvider
{
public CustomInventoryProvider() { }private CmsInventory _inventory;
protected CmsInventory Inventory
{
get
{
if (_inventory == null)
{
_inventory = new CmsInventory(RequestInformation);
}
return _inventory;
}
}

public override InventoryData GetInventory(long entryId)
{
return Inventory.GetInventory(entryId);
}

public override void SaveInventory(InventoryData inventory)
{
OnBeforeInventorySave(inventory);
Inventory.SaveInventory(inventory);
OnAfterInventorySave(inventory);

if (inventory.UnitsInStock < inventory.ReorderLevel)
{
OnInventoryReorderLevelReached(inventory);
}
}
}
}
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Ektron’s eSync revolutionizes the way that Web sites are built, deployed and maintained and is

the only synchronization solution that can keep Web sites up-to-date efficiently, giving you a

level of control over your site that was impossible before. From single sites, to global multi-

sites, to server farms, eSync gives you scalable, geo-synchronization capabilities that allow you

to easily update exactly what you want, when you want to.

The following videos introduce eSync.

n http://media.ektron.com/flash/esync/800x600/esync.html

n http://media.ektron.com/webinars/esync/esyncwebinar.html

eSync moves only the changes you want to move, from single pieces of content to entire sites,

making updates efficient and eliminating site downtime. With its intelligent synchronization

technology, eSync is able to securely move selected content bidirectionally: Web 2.0 sites

have a wealth of user-generated content and membership information. That data can now be

synchronized back to the development side of the firewall.

By employing certificate-based authentication to secure your Web site, Ektron’s eSync lets

CMS users update content anywhere safely, whether it is on a production server or within the

development environment. Alternatively, all of your updates can take place on the safe side of

your firewall before they are moved to the live site.

If conflicting versions of content exist, eSync’s configurable conflict resolution engine ensures

that you won’t lose your most up-to-date content. The version that isn’t posted is saved in a

history, along with other previous versions, enabling you to track changes or restore content if

the need arises.

Within complex IT infrastructures, eSync can synchronize content, assets, HTML pages and

other components of your Web site, whether it is managed by CMS400.NET or not.

Synchronization can be scheduled to take place at strategic times that assure optimal

performance while facilitating site updates. Global multi-site setups can take advantage of this
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to coordinate synchronizations with servers around the world, taking advantage of low traffic

periods. Or, use eSync’s scheduling feature to set up time-sensitive events. Synchronization can

take place with single or multiple servers, whatever your needs are.

eSync’s ability to move and copy data is unparalleled, and it offers a host of options for

managing multiple servers. If there is a need for multiple development servers, eSync can create

another copy of the live site for you to work with. As your developers build out changes to

the site, their updates can by synchronized to the staging and production servers. eSync can

also support advanced infrastructures, including load balancing and failover server

configurations.

Ektron’s eSync is the only solution in the marketplace today that gives you the level of

control you need to keep your Web sites completely up-to-date. Whatever your Web site

structure is, Ektron’s synchronization technology lets updates happen efficiently and quickly,

and provides the tools to deal with today and tomorrow’s information-hungry world.

eSync is more fully explained through these topics.

n "Setting Up eSync" on page 18-4

n eSync Requirements

n "Characteristics of eSync" on page 18-36

n "Managing eSync Security Certificates" on page 18-43

n Using eSync to Initialize a New Site

n Running a Sync

n "Content and Folder Sync Options" on page 18-71

n "eSync in a Load Balanced Environment" on page 18-76

n Using eSync in a Multi-site Environment

n "Using eSync with eCommerce" on page 18-88

n "Using eSync with Notifications" on page 18-88

n eSync Troubleshooting
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Setting Up eSync
This chapter helps you install and start using Ektron CMS400.NET’s eSync. For full details

about the feature, see "Using eSync" on page 18-35.

For this configuration See this section

Two sites on same server
"Scenario 1: Synching Two Sites on the SameServer" on

page 18-4

One Local to one Remote

server

"Scenario 2: Synching an Ektron CMS400.NET Server with

Another Server" on page 18-5

Development to Staging to

Production servers

"Scenario 3: Setting up a Development >Staging >Production

Environment" on page 18-15

Scenario 1: Synching Two Sites on
the Same Server
Although it is unlikely that you will use this configuration in “real-life” situations, it the

simplest way to begin testing and learning how eSync works.

1. Install the first site.

2. See Also: ”Installing Ektron CMS400.NET” on page 1-20 and ”Installing the Minimum

and Starter Sites” on page 1-23

3. Near the end of the installation, the following dialog appears.

4. Click Yes.

5. Install a second site on the same server.

6. Near the end of the installation, the same dialog appears.

7. Click Yes.

Both sites’ security certificates have been set up and configured. Continue from "Part Three:

Connect the Local and Remote Servers" on page 18-9
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Scenario 2: Synching an Ektron
CMS400.NET Server with Another
Server

This scenario assumes you have Ektron CMS400.NET on one server (call it local), and want to

sync it with another (call it remote). To accomplish this, you install a minimal Ektron

CMS400.NET site to the new, remote server. Next, use eSync to upload your Ektron

CMS400.NET site from the local to the remote server.

After the you complete the initial and template syncs explained in this chapter, the two sites

are a mirror image of each other.

Follow these steps to configure two servers to sync with each other.

Prerequisites - See eSync Requirements

n "Part One: Set up a Min Site on the Remote Server" on page 18-5

n "Part Two: Generate and Copy Security Certificates" on page 18-6

n "Part Three: Connect the Local and Remote Servers" on page 18-9

n "Part Four: Upload the Local Server’s Database to the Remote Server" on page 18-11

n "Part Five: Upload the Local Server’s Templates to Remote" on page 18-13

Part One: Set up a Min Site on the Remote Server
1. Upgrade the local server to the latest version of Ektron CMS400.NET if necessary.

2. On the remote server, install a minimum site whose Ektron CMS400.NET version matches

the version on the local server.

3. To do this, run the Ektron CMS400.NET base installation file (CMS400Base8x.exe). For

more information, see t”Installing Ektron CMS400.NET” on page 1-20.
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4. If the current site with which you will sync is precompiled, you must also precompile the

min site.

Part Two: Generate and Copy Security Certificates
Security certificates authorize the synchronization of files between servers. In this part, you

generate security certificates on the local server, then copy them to the remote.

Follow these steps to complete this procedure.

1. Sign on to the local server.

2. Click the Windows Start Button> All programs > Ektron > CMS400 v8x > Utilities >

Security Configurator.

3. The following screen appears.

4. At the Web Site Description field, select the Web site on the local server.

5. Press Generate.

6. The certificates are created on the local server.
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7. Close the Security Configurator dialog.

8. Open two Windows Explorer windows side-by-side: one showing the local server’s file

system, and the other showing the remote server’s file system.

9. In the remote server window, create a folder underneath the root folder. Name the folder

local security certificates.

Warning! Do not create the new folder under the web root, C:\inetpub\wwwroot.

10. In the local server window, open the following folder:

C:\ProgramFiles\Ektron\CMS400v8x\Utilities\Software\SecurityConfigurator.

11. From that folder, copy these files.

n servername_SyncClient.pfx

n servername_SyncClient.pvk

n servername_SyncClient.cer

n servername_SyncServer.pfx

n servername_SyncServer.pvk

n servername_SyncServer.cer

12. Paste the files into the folder you created in Step 9. Make sure there are no other security

files in the folder.

13. Close both windows you opened in Step 8.

Note: After copying security certificates to the remote folder, you need to register andmove them to the correct

folders. The SecurityConfigurator screen does this.

14. Sign on to the remote server.

15. Open the security configurator screen using this path: Windows Start Button > All

programs > Ektron > CMS400 v8x > Utilities > Security Configurator.

16. The security configurator screen appears.
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17. Click the Apply Remote Server Certificates button (circled above).

18. Click the Browse button next to that field.

19. Browse to the folder to which you pasted the security certificates in Step 12.

20. Click the Apply button.

21. The security configurator copies the certificates you pasted in Step 12 to the correct folder,

and configures them for the remote server.

Next, you need to generate security certificates on the remote server, then copy them to the

local.

To accomplish this, follow all steps in "Part Two: Generate and Copy Security Certificates" on

page 18-6, but this time, consider the remote server to be the local server and vice versa.

Now that you have generated and copied security certificates between servers, you can set up

eSync.
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Part Three: Connect the Local and Remote Servers

Warning! Backup your database before beginning this procedure!

1. On the local server, sign on to Ektron CMS400.NET.

2. In the Ektron CMS400.NET Workarea, go to Settings > Configuration >

Synchronization.

3. The View All Synchronization Configurations screen appears.

4. Click the Add button ( ).

5. The Create Synchronization Server Relationship screen appears.

6. At the Remote Server field, enter the name of the remote server.

7. At the Choose Certificate field, the name of the remote server appears.

8. Click the Connect button. This action connects the local with the remote server.

9. After you connect to the remote server, a new screen appears showing its database.
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10. A new screen appears, showing both servers.

11. Click the Switch Synchronization Direction button.

12. Now the screen indicates that the database will be uploaded from your local server (which

contains the CMS400 Developer site) to the new, remote server. See below.
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13. Click Create. This action connects the local and remote servers.

Part Four: Upload the Local Server’s Database to the
Remote Server

1. From the View All Synchronization Configurations screen, click the Start Initial Sync

button.

2. The initial sync uploads the local server’s database to the remote server.
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3. A screen tracks the progress.

4. When the sync is finished, Synchronization is Complete appears.

The initial sync also creates a default database profile. The profile remembers information

about the sync, such as source and destination databases, sync direction, and the fact that it

syncs the database and resource files (see example below). You can reuse this profile to sync

your database/resource files any time in the future.
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Part Five: Upload the Local Server’s Templates to Remote

1. From the View All Synchronization Configurations screen, click the Add Sync Profile

button ( ).

2. The Add Synchronization Profile screen appears.

3. At the Synchronization name field, give this profile a name, such as Local - Remote

Template Sync.

4. At the Items to Synchronize field, select Templates.

5. For Direction, choose Upload.
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6. For Schedule, choose None. (See example below.)

7. Save the profile.

8. Click the Run button to the right of the template sync (circled below).

9. A screen tracks the sync’s progress.

10. When the sync is complete, Synchronization is Complete appears.
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You can reuse the template sync profile to sync templates any time in the future.

Scenario 3: Setting up a
Development > Staging > Production
Environment
Before

In this scenario, a version of Ektron CMS400.NET resides on one server. You will consider

that your production server and use it to initialize the staging and development servers.

Here’s a preview of the steps you will follow.

n "Part One: Set up a Min Site on the Staging and Development Servers" on page 18-16

n "Part Two: Generate and Copy Security Certificates" on page 18-16

n "Part Three: Connect Staging and Production Servers" on page 18-24

n "Part Four: Download the Production Server’s Database to the Staging Server" on page 18-

26
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n "Part Five: Download the Production Server’s Templates to Staging" on page 18-28

n "Part Six: Connect the Development and Staging Servers" on page 18-30

n "Part Seven: Download the Staging Server’s Database to the Development Server" on page

18-32

n "Part Eight: Download the Staging Server’s Templates to Development" on page 18-33

Prerequisites - See eSync Requirements

Part One: Set up a Min Site on the Staging and
Development Servers
1. Upgrade your existing server to the current version of Ektron CMS400.NET if necessary.

2. Install a minimum site on the staging and development servers.

3. To do this, run the Ektron CMS400.NET base installation file (CMS400Base8x.exe)

version 7.6 or higher. (For more information, see ”Installing Ektron CMS400.NET” on

page 1-20.)

Part Two: Generate and Copy Security Certificates
Security certificates authorize synchronization between servers. In an eSync configuration,

every server needs a security certificate from every other server, as shown below.

To generate and copy these certificates, follow these steps.

n "A. Generate Security Certificates on Production and Copy Them to Staging and

Development" on page 18-17
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n "B. Generate Security Certificates on Staging and Copy Them to Development and

Production" on page 18-19

n "C. Generate Security Certificates on Development and Copy them to Staging and

Production" on page 18-22

A.Generate Security Certificates on Production andCopy Themto Staging andDevelopment

Follow these steps to complete this procedure.

1. Sign on to the production server.

2. Click the Windows Start Button> All programs > Ektron > CMS400 v8x > Utilities >

Security Configurator.

3. The following screen appears.
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4. At the Web Site Description field, select the Web site on the production server.

5. Press Generate.

6. The certificates are created on the production server.

7. Open two Windows Explorer windows: one showing the production server’s file system,

and the other showing the staging server’s file system.

8. In the staging server window, create a folder underneath the root folder. Name the folder

Prod security certificates.

Warning! Do not create the new folder under the web root, C:\inetpub\wwwroot.

9. In the production server window, open the following folder:

C:\ProgramFiles\Ektron\CMS400v8x\Utilities\Software\SecurityConfigurator.

10. From that folder, copy these files.

n servername_SyncClient.pfx

n servername_SyncClient.pvk

n servername_SyncClient.cer

n servername_SyncServer.pfx

n servername_SyncServer.pvk

n servername_SyncServer.cer

11. Paste the files into the folder you created in Step 9. Make sure there are no other security

files in the folder.

12. Close both windows you opened in Step 8.

13. After copying the security certificate files to the staging folder, you need to register and

move them to the correct folders. The Security Configurator screen does this.

14. Sign on to the staging server.

15. Open the security configurator screen using this path: Windows Start Button > All

programs > Ektron > CMS400 v8x > Utilities > Security Configurator.

16. The security configurator screen appears.
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17. Click the Apply Remote Server Certificates button (circled above).

18. Click the browse button next to that field.

19. Browse to the folder to which you pasted the security certificates in Step 12.

20. Click the Apply button.

21. The security configurator copies the certificates you pasted in Step 12 to the correct folder,

and configures them for the staging server.

22. Follow the same procedure to move production certificates to the development server. To

do this, begin at Step 8 and follow all steps. Wherever the instructions mention a staging

server, substitute the development server.

B.Generate Security Certificates on Staging andCopy Themto Developmentand Production
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Follow these steps to complete this procedure.

1. Sign on to the staging server.

2. Click the Windows Start Button> All programs > Ektron > CMS400 v8x > Utilities >

Security Configurator.

3. The following screen appears.

4. At the Web Site Description field, select the Web site on the staging server.

5. Press Generate.

6. The certificates are created on the staging server.

7. Open two Windows Explorer windows: one showing the staging server’s file system, and

the other showing the production server’s file system.

8. In the production server window, create a folder underneath the root folder. Name the

folder staging security certificates.

Warning! Do not create the new folder under the web root, C:\inetpub\wwwroot.

9. In the staging server window, open the following folder:

C:\ProgramFiles\Ektron\CMS400v8x\Utilities\Software\SecurityConfigurator.

10. From that folder, copy these files.

n servername_SyncClient.pfx

n servername_SyncClient.pvk

n servername_SyncClient.cer

n servername_SyncServer.pfx

n servername_SyncServer.pvk

n servername_SyncServer.cer
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11. Paste the files into the folder you created in Step 9. Make sure there are no other security

files in the folder.

12. Close both windows you opened in Step 8.

13. After copying the security certificate files to the production folder, you need to register

and move them to the correct folders. The Security Configurator screen does this.

14. Sign on to the production server.

15. Open the security configurator screen using this path: Windows Start Button > All

programs > Ektron > CMS400 v8x > Utilities > Security Configurator.

16. The security configurator screen appears.

17. Click the Apply Remote Server Certificates button (circled above).

18. Click the browse button next to that field.

19. Browse to the folder to which you pasted the security certificates in Step 12.

20. Click the Apply button.

21. The security configurator copies the certificates you pasted in Step 12 to the correct folder,

and configures them for the production server.

22. Follow the same procedure to move staging certificates to the development server. To do

this, begin at Step 8 and follow all steps. Wherever the instructions mention a production

server, substitute the development server.
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C.Generate Security Certificates onDevelopmentandCopy themto Staging and Production

1. Sign on to the development server.

2. Click the Windows Start Button> All programs > Ektron > CMS400 v8x > Utilities >

Security Configurator.

3. The following screen appears.

4. At the Web Site Description field, select the Web site on the development server.

5. Press Generate.

Synchronizing Servers Using eSync

18-22
ReferenceManual

Version 8.0 Rev 1.3



6. The certificates are created on the development server.

7. Open two Windows Explorer windows: one showing the development server’s file system,

and the other showing the staging server’s file system.

8. In the staging server window, create a folder underneath the root folder. Name the folder

Dev security certificates.

Warning! Do not create the new folder under the web root, C:\inetpub\wwwroot.

9. In the development server window, open the following folder:

C:\ProgramFiles\Ektron\CMS400v8x\Utilities\Software\SecurityConfigurator.

10. From that folder, copy these files.

n servername_SyncClient.pfx

n servername_SyncClient.pvk

n servername_SyncClient.cer

n servername_SyncServer.pfx

n servername_SyncServer.pvk

n servername_SyncServer.cer

11. Paste the files into the staging server folder you created in Step 9. Make sure there are no

other security files in the folder.

12. Close both windows you opened in Step 8.

13. After copying the security certificate files to the staging folder, you need to register and

move them to the correct folders. The Security Configurator screen does this.

14. Sign on to the staging server.

15. Open the security configurator screen using this path: Windows Start Button > All

programs > Ektron > CMS400 v8x > Utilities > Security Configurator.

16. The security configurator screen appears.
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17. Click the Apply Remote Server Certificates button (circled above).

18. Click the browse button next to that field.

19. Browse to the folder you created in Step 9.

20. Click the Apply button.

21. The security configurator copies the certificates you pasted in Step 12 to the correct folder,

and configures them for the staging server.

22. Follow the same procedure to move development certificates to the production server. To

do this, begin at Step 8 and follow all steps. Wherever the instructions mention a staging

server, substitute the production server.

Part Three: Connect Staging and Production Servers

Warning! Backup your database before beginning this procedure!

1. On the staging server, sign on to Ektron CMS400.NET.

2. In the Ektron CMS400.NET Workarea, go to Settings > Configuration > Synchronization.
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3. The View All Synchronization Configurations screen appears.

4. Click the Add button ( ).

5. The Create Synchronization Server Relationship screen appears.

6. At the Remote Server field, enter the name of the production server.

7. At the Choose Certificate field, the name of the production server appears.

8. Click the Connect button. This action connects the staging with the production server.

9. After you connect to the production server, a new screen appears showing its database.

10. Click Next.

11. A new screen appears, showing both servers.

Scenario 3: Setting up a Development > Staging >
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12. Click Create. This action connects the staging and production servers.

Part Four: Download the Production Server’s Database to
the Staging Server

1. From the View All Synchronization Configurations screen, click the Start Initial Sync

button.

2. The initial sync downloads the production server’s database to the staging server.

3. A screen tracks the sync’s progress.
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4. When the sync is complete, Synchronization is Complete appears.

The initial sync also creates a default database profile. The profile remembers information

about the sync, such as the source and destination databases, sync direction, and the fact that it

syncs the database and resource files (see example below). You can reuse this profile to run

database/resource syncs any time in the future.
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Part Five: Download the Production Server’s Templates to
Staging

1. From the View All Synchronization Configurations screen, click the Add Sync Profile

button.

2. The Add Synchronization Profile screen appears.

3. At the Synchronization name field, give this profile a name, such as Prod - Staging

Template Sync.

4. At the Items to Synchronize field, select Templates.

5. For Direction, choose Download.

6. For Schedule, choose None. (See example below.)
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7. Save the profile.

8. Click the Run button to the right of the template sync (circled below).

9. A screen tracks the sync’s progress.

10. When the sync is complete, Synchronization is Complete appears.

You can reuse the template sync profile to sync templates any time in the future.
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Part Six: Connect the Development and Staging Servers

1. Sign on to Ektron CMS400.NET development server.

2. In the Ektron CMS400.NET Workarea, go to Settings > Configuration > Synchronization.

3. The View All Synchronization Configurations screen appears.

4. Click the Add button ( ).

5. The Create Synchronization Server Relationship screen appears.

6. At the Remote Server field, enter the name of the staging server.

7. At the Choose Certificate field, the name of the staging server appears.

8. Click the Connect button. This action connects the development with the staging server.

9. After you connect to the staging server, a new screen appears showing its database.
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10. Click Next.

11. A new screen appears, showing both servers.

12. Click Create. This action connects the development and staging servers.
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Part Seven: Download the Staging Server’s Database to the
Development Server

1. From the View All Synchronization Configurations screen, click the Start Initial Sync

button.

2. The initial sync downloads the staging server’s database to the development server.

3. A screen tracks the sync’s progress.

4. When the sync is complete, Synchronization is Complete appears.
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The initial sync also creates a default database profile. The profile remembers information

about the sync, such as the source and destination databases, sync direction, and the fact that it

syncs the database and resource files (see example below). You can reuse this profile to sync

the database/resources between these two servers at any time in the future.

Part Eight: Download the Staging Server’s Templates to
Development

1. From the View All Synchronization Configurations screen, click the Add Sync Profile

button.

2. The Add Synchronization Profile screen appears.

3. At the Synchronization name field, give this profile a name, such as Staging-Dev

Template Sync.

4. At the Items to Synchronize field, select Templates.
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5. For Direction, choose Download.

6. For Schedule, choose None. (See example below.)

7. Save the screen.

8. Click the Run button to the right of the template sync (circled below).

9. A screen tracks the sync’s progress.

10. When the sync is complete, Synchronization is Complete appears.

You can reuse the template sync profile to sync templates any time in the future.
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Using eSync
This section explains the following eSync topics.

n eSync Requirements

n "Characteristics of eSync" on page 18-36

n "Managing eSync Security Certificates" on page 18-43

n Using eSync to Initialize a New Site

n "Setting up eSync Profiles" on page 18-53

n Optional Steps before Running a Sync

n Running a Sync

n Synchronization Screens

n Reviewing Resolved Collisions

n "Content and Folder Sync Options" on page 18-71

n "eSync in a Load Balanced Environment" on page 18-76

n Using eSync in a Multi-site Environment

n Using eSync with Web Alerts

n "Using eSync with eCommerce" on page 18-88

n eSync Troubleshooting

eSync Requirements

Ektron Software and Files

n Ektron CMS400.NET version 7.6 or higher

Warning! The version of Ektron CMS400.NET on every server in the sync configurationmust match. You cannot

upgrade nor downgrade Ektron CMS400.NET using eSync.

n An Ektron CMS400.NET base installation file (for example, cms400Base7x.exe). Use this

file to install a second site with which you will sync your current site.

n Ektron CMS400.NET licenses that support Enterprise or Professional with eSync on every

server being synched.

n Matching security certificates on every server being synched. See Also: "Managing eSync

Security Certificates" on page 18-43
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Microsoft Software

n Windows Server 2003 or higher; Vista Ultimate or Business

n Microsoft .NET Framework 3.5

Ektron CMS400.NET’s installation checks for this version of the framework during instal-

lation/upgrade. If it’s not on your server, you are asked for permission to install it.

Note: It is not a problem if your templateswere created using the 2.0 Framework.

n Microsoft SQL 2005 SP2 or higher

User Permissions

n You are a member of the Administrators group or assigned the Synchronization Admin

role. See Also: "Defining Roles" on page 15-32

n The user performing the sync has either a db_ddladmin or dbowner role for the SQL

database

Server

The GMT time on each server’s clock must be within 5 minutes of each other.

Characteristics of eSync
n "Easy and Flexible Setup and Usage" on page 18-36

n "Sync Configurations" on page 18-37

n "Unique ID Numbering" on page 18-42

n "eSync Moves Changes Only" on page 18-43

Easy and Flexible Setup and Usage
You administer eSync through Ektron CMS400.NET’s Workarea > Settings > Configuration

> Synchronization screens. The screens let you establish a sync configuration between two

databases, then specify any number of sync profiles for each configuration.
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Each profile lets you specify data to sync, a direction, and a schedule. You can always sync

immediately by clicking the sync ( ) button.

You create profiles to sync these kinds of data.

n all content, assets, and library assets

n all Workarea folder files

n the remaining site files (with a few exceptions)

n a selection of Windows files in your site root folder and its subfolders

See Also: "Setting up eSync Profiles" on page 18-53

Individual file types can be included or excluded from the sync. In addition, you can sync

Ektron CMS400.NET content or folders. See Also: "Content and Folder Sync Options" on page

18-71

Sync Configurations
Several eSync configurations are shown below. You can synchronize any server to or from any

other server with one important exception: you cannot initiate a sync from a server outside the

firewall. You can only initiate a sync from a server inside the firewall and copy to a server

outside the firewall. This is because the outside server does not know the address of servers

inside the firewall. However, you can use a staging server to push and pull updated

information to and from a production server.

Warning! All eSync transmissionsuse port 8732. This is not configurable.

Configuration 1: One Staging Server, One Production Server
This is the most basic eSync configuration, showing one staging and one production server.

Each server has a database and one site.
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The eSync feature can automatically create a production server from your staging server. See

Also: "Using eSync to Initialize a New Site" on page 18-52

For installation instructions for this configuration, see "Scenario 2: Synching an Ektron

CMS400.NET Server with Another Server" on page 18-5.

Configuration 2: One Development Server, One Staging
Server, One Production Server
This configuration includes a development server. Developers can use it to create new features

and modify existing ones. When they are done, they can sync the changes to the staging server,

where the changes can be verified before being moved to production.

For installation instructions for this configuration, see "Scenario 3: Setting up a Development >

Staging > Production Environment" on page 18-15.

Configuration 2a: Multi-site Staging Server, Multi-site
Production Server
The following configuration illustrates synching several sites on a staging server with those

sites on production.
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Configuration 3: Several Development Servers, One Staging
Server, One Production Server
As shown in the illustration, any number of development servers can sync to each other and to

your staging servers.

Configuration 4: One Development Server, One Staging
Server, One Production Site Server, One Production
Database Server
In this configuration supported by eSync, the production site has two servers: one for site files,

and another for the database.

To synchronize these servers, set up several eSync profiles. One syncs the database, assets, and

templates to the production database server. Use additional profiles to sync the staging server’s

workarea files with the production site server.

Note: When using separate site and database servers, assets are stored on the site server.
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Configuration 5: Configuration 4 Plus Pre-Production Server
This eSync configuration adds an extra server between staging and production. The

preproduction server can be used for review and testing of changes before they are moved to

production.

Configuration 6: Multi-site Configurations, Each Site and
Database on its own Production Server
In this configuration, each production server has its own database plus the site files. As an

alternative, you could have a separate server for each production database, with all sites on one

production server.
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Note: The above configuration also supports separate site and database servers.

To synchronize this type of configuration, set up several eSync profiles, one for each site.

n Three database and template profiles

n Three Workarea profiles

The Server Number
Every server in a sync configuration is assigned a unique number. The originating server is

numbered 1, the first server with which it establishes a relationship is numbered 2, etc.

The server number is in the serverinfo.xml file, located in the c:\sync\inetpub\wwwroot\siteroot

folder, as shown below.

<SyncServerInfoList>
<SyncServerInfo IsSyncRunning="true" MaxId="2" ServerNumber="1" IsMulti-

SiteStaged="false">
<ServerId>b0cccb5a-1d45-4262-8857-79f1333696dc</ServerId>

<ServerUrl>http://localhost:8732/Ektron.Sync.Communication/SyncCommunicationScheduleService.svc</ServerUrl>

Characteristics of eSync

ReferenceManual

Version 8.0 Rev 1.3
18-41



<ConnectionInfo>server=WS10080\SQLExpress;database=CMS400Developer;Integrated

Security=TRUE;user=;pwd=;</ConnectionInfo>
</SyncServerInfo>

</SyncServerInfoList>

Unique ID Numbering
All Ektron CMS400.NET data is assigned a unique ID number to distinguish it from similar

objects. Examples are content (see illustration below), folders, menus, users, etc.

When you create a sync relationship, Ektron CMS400.NET applies to each server a new ID

numbering range to ensure that, from then on, objects created on either server have a unique

ID. This prevents collisions when synching between servers. For example, since membership

users created on a production server have a different ID number range from those created on the

staging server, eSync does not overwrite them.

To view a server’s ID number range, open its serverinfo.xml file, located in the

c:\sync\inetpub\wwwroot\siteroot folder, and check the MaxId value (highlighted in red

below).

<SyncServerInfoList>
<SyncServerInfo IsSyncRunning="true" MaxId="1" ServerNumber="1" IsMulti-

SiteStaged="false">
<ServerId>b0cccb5a-1d45-4262-8857-79f1333696dc</ServerId>

<ServerUrl>http://localhost:8732/Ektron.Sync.Communication/SyncCommunicationScheduleService.svc</ServerUrl>
<ConnectionInfo>server=WS10080\SQLExpress;database=CMS400Developer;Integrated

Security=TRUE;user=;pwd=;</ConnectionInfo>
</SyncServerInfo>

</SyncServerInfoList>

Multiply that number by 1 trillion to get the largest ID number which that server can assign.

So for example, if MaxId = 3, possible ID numbers range from 2,000,000,000,001 to

3,000,000,000,000.
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eSync Moves Changes Only
eSync only copies data that changed since the last sync. So, for example, if your site has 100

menus but only 3 changed since the last sync, it only copies three. As a result, eSync is very

quick.

To track changes to Ektron CMS400.NET data between syncs, eSync sets up a c:\sync folder

structure that mirrors your site’s Windows folder structure. This structure is created on each

server when sync relationships are first established.

No Ektron CMS400.NET files reside in the \sync folders. Instead, each folder has four .sync

files that monitor changes to the Ektron CMS400.NET files in the corresponding folder.

Managing eSync Security
Certificates
Ektron CMS400.NET’s eSync feature uses security certificates to ensure secure communication

between servers. That is, all servers in an eSync configuration must have matching, encrypted

security certificates in order to establish an eSync relationship.

Note: If your configuration features separate database servers, you do not need to install security certificateson

them. You only need to install certificateson servers that host Ektron CMS400.Net.
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This section explains how to create and replace security certificates on a server through the

following topics.

n "The Client and Server Certificates" on page 18-44

n "Installing Security Certificates" on page 18-45

n "Regenerating Security Certificates" on page 18-50

n "Troubleshooting Security Certificates" on page 18-51

See Also: "Create eSync Security Certificates for a Load Balanced Cluster" on page 18-79

The Client and Server Certificates
Before you can establish an eSync relationship between servers, each server must have its own

(local) security certificate and one from every other server in the configuration, as shown

below.

As another example, if an eSync configuration consists of five servers, each server would

require five security certificates: one local and four remote certificates.

Each server creates two sets of certificates: a server and a client set. Then, you copy the

certificates to the other server. The local machine’s server certificate must match a client

certificate on the remote server, and vice versa.

Certificates are typically copied only when you first establish an eSync relationship between

servers. After that, any eSync activity triggers a background check, and the user can proceed

only if the certificates match.

Each certificate consists of the following files.

n Server certificate
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- servername_SyncServer.pfx

- servername_SyncServer.pvk

- servername_SyncServer.cer

n Client certificate

- servername_SyncClient.pfx

- servername_SyncClient.pvk

- servername_SyncClient.cer

The security certificates can apply to one site or all sites on a server. You determine this when

installing them.

See Also: "Installing Security Certificates" on page 18-45

Installing Security Certificates
Prerequisite: Permission to copy and paste files between local and remote servers

To create and place eSync security certificates in the correct locations, follow these steps.

n "Step 1: Create Security Certificates on Your Local Server" on page 18-45

n "Step 2: Create Security Certificates on the Remote Server" on page 18-47

n "Step 3: Copy Local Client Certificate to Remote Server" on page 18-48

n "Step 4: Copy Remote Client Certificate to Local Server" on page 18-49

n "Step 5: Test the Security Certificates" on page 18-50

Step 1: Create Security Certificates on Your Local Server
1. At the end of the Ektron CMS400.NET installation, you are asked if you want to install

eSync security certificates. If you agree, the following screen prompts you to enter

information needed to create the certificates.

Note: You can access this screen at any time screen byopeningWindows Start Button> All programs >

Ektron > CMS400 v7x > Utilities > Security Configurator.
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Use the following table to complete this screen.

Field Description

Generate Certificates - Use this screen area to create security certificates

that must be copied to a remote server with which you want to sync.

WebSite Description

If more than one site is set up on this server, use the pull-

down list to select theWeb site for which you are installing

security certificates. Or, clickAll to apply the certificates to

all sites on this server.

Apply Remote Server Certificates - Use this screen area to apply eSync security certificates

that were copied from a remote server to your local server. See Also: "Step 3: CopyLocalClient

Certificate to Remote Server" on page 18-48

2. Click Generate.

3. Local security certificates are created and configured (illustrated below).

- See Illustration
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Note: Only clickOK once. The status field at the bottom of the screen updates the statusas it progresses. If you

clickOKmore than once, you delay the certificates’ creation.

Step 2: Create Security Certificates on the Remote Server
1. Sign on to remote server.

2. Generate security certificates for the remote server, following instructions in "Step 1:

Create Security Certificates on Your Local Server" on page 18-45.

3. When you complete this procedure, remote client and server security certificates are

created and configured (illustrated below).

- See Illustration
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Step 3: Copy Local Client Certificate to Remote Server

1. On the local server, open two Windows Explorer windows: one showing the local server’s

file system, and the other showing the remote server’s file system.

2. In the remote server window, create a folder underneath the root folder. The folder name is

not important.

Warning! Do not place it under the web root folder, C:\inetpub\wwwroot.

3. In the local server window, open the following folder:

C:\ProgramFiles\Ektron\CMS400V7x\Utilities\Software\SecurityConfigurator.

4. Copy the following files.

n servername_SyncClient.pfx

n servername_SyncClient.pvk

n servername_SyncClient.cer

n servername_SyncServer.pfx

n servername_SyncServer.pvk

n servername_SyncServer.cer

Note: These fileswere created when you completed the eSyncSecurityConfigurator Screen in Step 1.

5. Paste the files into the remote server folder that you created in Step 2. Make sure there are

no other security files in the folder.

After the local server’s security certificates are copied to the remote server, you need to register

and move them to the correct folders. The Security Configurator screen does this.

6. On the remote server, open the security configurator screen using this path: Windows Start

Button > All programs > Ektron > CMS400 v7x > Utilities > Security Configurator.

7. The security configurator screen appears.
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8. Click the Apply Remote Server Certificates button (circled above).

9. Click the browse button next to that field.

10. Browse to the folder to which you pasted the security certificates in Step 5.

11. Click the Apply button.

12. The utility copies the security certificates you pasted in Step 5 to the correct folder, and

configures them for the remote server.

Step 4: Copy Remote Client Certificate to Local Server

1. Sign on to the remote server.
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2. Follow the steps described in "Step 3: Copy Local Client Certificate to Remote Server" on

page 18-48, except substitute remote for local.

Step 5: Test the Security Certificates
1. From the local server, sign on to Ektron CMS400.NET.

2. In the Workarea, go to Settings > Configuration > Synchronization.

3. Click the plus sign ( ).

4. Insert the name of the Remote Server.

5. Select the security certificate you are testing.

6. Click Connect.

7. If the next screen appears, the security certificates are working properly.

Regenerating Security Certificates
Follow these steps to regenerate security certificates. You may need to do this if they stop

working, or you are concerned about a security breach.

1. Access the eSync Security Configurator screen via Windows Start Button > All programs

> Ektron > CMS400 v7x > Utilities > Security Configurator.

2. Use the Web Site pulldown field to select a site on your server, or choose All sites.

3. Click the Discard Existing Keys checkbox (circled below).

4. Click Generate.
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5. The existing security certificates are removed from your local server.

6. Reopen the Security Configurator screen.

7. Choose the correct Web Site, verify the other settings, and click Generate. See Also: "Step

1: Create Security Certificates on Your Local Server" on page 18-45

8. This action generates new security certificates on your server.

9. Copy the new certificates to all other servers in the eSync configuration. This is explained

in "Step 3: Copy Local Client Certificate to Remote Server" on page 18-48.

Troubleshooting Security Certificates
n "Could Not Connect Error" on page 18-51

n "No Endpoint Error" on page 18-52

Could Not Connect Error
When trying to connect to a remote server, after selecting a security certificate, you may see

the following message.

Here are some steps to resolve the problem.

n Check the Windows Event Viewer > EktronL2 log for the error. If the service is hosted

but already exists, stop then start the service (do not restart).
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n The certificates may be corrupted. To resolve this, see "Regenerating Security Certificates"

on page 18-50.

No Endpoint Error

The above error indicates that

n the remote site may not be on the same Ektron CMS400.NET version as the local site, or

n the Ektron Windows Service is not started

Using eSync to Initialize a New Site
Typically, before you begin using eSync, one server hosts an Ektron CMS400.NET Web site,

and you want to bring other servers into the configuration. After the servers are synchronized,

one will be the staging server (the one on which content is created or updated, then approved).

Another server, production, hosts your live Web site.

Warning! The namesof the site and all foldersmustmatch on both servers. This is because paths to images, xslt

files, etc. refer to a site and its folders. If the servers’ site and folder namesdo not match, the links break.

First, use eSync to initialize the new servers from the existing one. This process is described in

"Setting Up eSync" on page 18-4. Afterwards, use eSync to periodically sync updated content,

folders, users, menus, etc.
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Setting up eSync Profiles
To minimize data entry, eSync saves your specifications about an individual eSync job in a

sync profile. So, after you enter specifications the first time, just select the profile every

subsequent time you want to sync. A profile contains information about the

n source and destination databases

n type of data being synched

n files to include/exclude

n direction

n schedule

Use the Add Synchronization Profile screen to create and update eSync profiles.

While following the steps in "Setting Up eSync" on page 18-4, you created a default database

and a template profile. This section explains how to modify those profiles and create new ones.

To eSync an entire Web site, you need a minimum of two profiles: one for your web site

root/Workarea folder, and another for all other site files.

To create a profile for

n your Workarea folder, click Workarea Files under Items to Synchronize.
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n all other site files, click Database/Resources, Templates and Bin under Items to

Synchronize.

The following table explains the kinds of files synched by each category.

Items to

Synchronize
Type of data synched Exceptions

For setup

instructions,

see

Database/Resources

The database plus the following

site root folders

n assets

n Privateassets

n uploadedimages

n uploadedfiles

See "Global File Type

Exceptions" on page 18-

56

"Setting up a

Profile to Sync

a Database

and Assets" on

page 18-56
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Items to

Synchronize
Type of data synched Exceptions

For setup

instructions,

see

Workarea Files
All files in the site’sWorkarea

folder other than the exceptions

Files in these folders:

n ewebeditpro

n help

n explorer

n ewebdiff

n documents

n foundation

n resources

n sync

See Also: "Global File

Type Exceptions" on

page 18-56

"Setting up a

Profile to Sync

Workarea

Files" on page

18-57

Templates

Warning! If you run a

template syncandBin

is checked, and one

server is running is 32-

bit mode while the

other is running in 64-

bit mode, userswill not

be able to drag and

drop DMS files on the

staging server.

All files in your site root folder

other than the exceptions

Note: If you perform an initial

syncof a recently-installedmin

site with your staging site, the

min site’s templates could

overwrite templateson your

staging site. This is because,

when two templateshave the

same name, themost recently

modified one overwrites the

other.

To avoid this, rename the only

template installed with themin

site (login.aspx) before

performing the initial template

sync. You should also rename

login.aspx’s supporting files,

such as login.aspx.vb.

Files in these folders:

n workarea (covered

byWorkarea Files sync)

n assets, pri-

vateassets, upload-

edfiles, uploadedimages

(covered byData-

base/Resources sync)

n bin (covered byBin

checkbox, below)

n app_webref-

erences

n latestchanges

n app_glob-

alresources

These files:

n asset-

Management.config

n web.config

See Also: "Global File

Type Exceptions" on

page 18-56

"Setting up a

Profile to Sync

Template and

Bin Files" on

page 18-59

Bin The bin folder
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You can also set up a profile that syncs Windows folders. See Also: "Synchronizing Windows

Files" on page 18-62

Global File Type Exceptions
The following file types are not synched by default.

n .config files

n .txt files

n .sln files

Note: Ektron CMS400.NET createsa large number of .txt files to support the search functionality.

However, you can add these file types to a sync profile via the Include/Exclude Files field. See

Also: "At the Include/Exclude files field, include files not normally synched, or exclude files

that are synched by default. " on page 18-58

Setting up a Profile to Sync a Database and Assets
To set up a profile to sync an Ektron CMS400.NET database and its assets, follow these steps.

Prerequisite

n You created a Sync configuration and ran an initial sync. See Also: "Setting Up eSync" on

page 18-4

1. Go to the Settings > Configuration > Synchronization screen.

2. If you are eligible to add a profile to a configuration, Add Sync Profile appears, as shown

below.

3. Click the Add Sync Profile button. The Add Synchronization Profile screen appears.

4. At the Synchronization name field, enter a name for this profile.

5. At the Items to Synchronize field, select database and assets.

Synchronizing Servers Using eSync

18-56
ReferenceManual

Version 8.0 Rev 1.3



6. At the Synchronization Direction field, select the direction of the data copy that will

occur. Your choices are:

n Bidirectional (that is, both directions). Changed data on either server is updated on the

other. If the same data (for example, a membership user profile) is updated on both servers,

the conflict resolution policy determines the outcome. See Also: "Bidirectional Sync" on

page 18-61; "Conflict Resolution Policy" on page 18-62

Note: If you are using bidirectional syncand only one version wasupdated since the last sync, the updated version

overwrites the unchanged version.

n Upload - the database and assets are copied from the local server (the one to which you

signed on) to the remote server (specified at the Remote Site field above). Items on the

remote server are overwritten.

n Download - the database and assets are copied from the remote server to the local server.

Items on the local server are overwritten.

7. At the Conflict Resolution Policy field, decide what to do if Synchronization Direction is

Bidirectional, and the data has changed on both servers since the last sync. Your choices

are.

n Version on Remote Site Wins - the remote version overwrites the local version

n Version on Local Site Wins - the local version overwrites the remote version

8. If desired, select a schedule for when the sync will run automatically. The choices are

n None - Don’t set up a schedule. Run this sync profile as needed via the Sync Profile

screen‘s Start Now button.

n One Time - you specify a start time and date

n Hourly - you specify a start date and time. eSync begins on the start date and time,

then runs every hour at that time.

n Daily - you specify a start time and date; this sync profile will run every day at this

time

n Weekly - you specify a start time, date, and day. After the start date, this sync profile

will run this day every week at this time.

n Monthly - you specify a start time and date (numbers 1 through 31). After the start

date, this sync profile will run this day every month at this time.

Warning! You cannot schedulemore than one sync to begin at the same time.

Note: While the following options let you schedule a syncprofile, you can syncat any time byaccessing the Sync

Profile and clicking the Syncbutton ( ). See Also: "Running a Sync" on page 18-64

Note: If you enter a date greater than 28, the syncwill not run in amonth that doesnot include that date. For

example, if you enter 31, the syncwill not run in February, April, June, September, and November.

Setting up a Profile to Sync Workarea Files
Prerequisite
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n You created a Sync configuration and ran an initial sync. See Also: "Setting Up eSync" on

page 18-4

1. Go to the Settings > Configuration > Synchronization screen.

2. If you are eligible to add a profile to a configuration, Add Sync Profile appears on the

right side, as shown below.

3. Click the Add Sync Profile button. The Add Synchronization Profile screen appears.

4. At the Synchronization name field, enter a name for this profile.

5. At the Items to Synchronize field, select Workarea files.

6. At the Include/Exclude files field, include files not normally synched, or exclude files that

are synched by default.

7. For example, .txt files are not normally included in a sync, but you want to copy several

on your staging server to the production server. In this case, check Include and enter *.txt

into the adjacent field (illustrated below). If you do, only files with that extension are

synched.

8. As an example of the Exclude option, assume you do not want to sync Flash (.swf) files. If

you check the Exclude button, and enter .swf into the text field, eSync ignores them.

Note: Bydefault, eSync ignores .config and .txt files.

9. At the Synchronization Direction field, select the direction of the data copy that will

occur. Your choices are:

n Bidirectional (that is, both directions). Changed data on either server is updated on the

other. If the same data (for example, a membership user profile) is updated on both servers,
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the conflict resolution policy determines the outcome. See Also: "Bidirectional Sync" on

page 18-61; "Conflict Resolution Policy" on page 18-62

Note: If you are using bidirectional syncand only one version wasupdated since the last sync, the updated version

overwrites the unchanged version.

n Upload - if the file on the local server was modified more recently than the one on the

remote server, the local file replaces the remote. Otherwise, nothing happens.

n Download - if the file on the remote server was modified more recently than the one on

the local server, the remote file replaces the local. Otherwise, nothing happens.

10. At the Conflict Resolution Policy field, decide what to do if Synchronization Direction is

Bidirectional, and the data has changed on both servers since the last sync. Your choices

are.

n Version on Remote Site Wins - the remote version overwrites the local version

n Version on Local Site Wins - the local version overwrites the remote version

11. If desired, select a schedule for when the sync will run automatically. The choices are

n None - Don’t set up a schedule. Run this sync profile as needed via the Sync Profile

screen‘s Start Now button.

n One Time - you specify a start time and date

n Hourly - you specify a start date and time. eSync begins on the start date and time,

then runs every hour at that time.

n Daily - you specify a start time and date; this sync profile will run every day at this

time

n Weekly - you specify a start time, date, and day. After the start date, this sync profile

will run this day every week at this time.

n Monthly - you specify a start time and date (numbers 1 through 31). After the start

date, this sync profile will run this day every month at this time.

Warning! You cannot schedulemore than one sync to begin at the same time.

Note: While the following options let you schedule a syncprofile, you can syncat any time byaccessing the Sync

Profile and clicking the Syncbutton ( ). See Also: "Running a Sync" on page 18-64

Note: If you enter a date greater than 28, the syncwill not run in amonth that doesnot include that date. For

example, if you enter 31, the syncwill not run in February, April, June, September, and November.

Setting up a Profile to Sync Template and Bin Files
Prerequisite

n You created an eSync configuration and ran an initial sync. See Also: "Setting Up eSync"

on page 18-4

1. Go to the Settings > Configuration > Synchronization screen.
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2. If you are eligible to add a profile to a configuration, Add Sync Profile appears, as shown

below.

3. Click the Add Sync Profile button. The Add Synchronization Profile screen appears.

4. At the Synchronization name field, enter a name for this profile.

5. At the Items to Synchronize field, select Templates and Bin.

6. At the Include/Exclude Files field, include files not normally synched, or exclude files

that are synched by default. For example, .txt files are not normally included in a sync, but

you want to copy several on your staging server to the production server. In this case,

check Include and enter *.txt into the adjacent field (illustrated below). If you do, only

files with that extension are synched.

7. As an example of the Exclude option, assume you do not want to sync Flash (.swf) files. If

you check the Exclude button, and enter .swf into the text field, eSync ignores them.

Note: Bydefault, eSync ignores .config and .txt files.

8. At the Synchronization Direction field, select the direction of the data copy that will

occur. Your choices are:

n Bidirectional (that is, both directions). Changed data on either server is updated on

the other. If the same data (for example, a membership user profile) is updated on both

servers, the conflict resolution policy determines the outcome. See Also: "Bidirectional

Sync" on page 18-61; "Conflict Resolution Policy" on page 18-62

Note: If you are using bidirectional syncand only one version wasupdated since the last sync, the updated version

overwrites the unchanged version.

n Upload - if the file on the local server was modified more recently than the one on the

remote server, the local file replaces the remote. Otherwise, nothing happens.

n Download - if the file on the remote server was modified more recently than the one

on the local server, the remote file replaces the local. Otherwise, nothing happens.
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9. At the Conflict Resolution Policy field, decide what to do if Synchronization Direction is

Bidirectional, and the data has changed on both servers since the last sync. Your choices

are.

n Version on Remote Site Wins - the remote version overwrites the local version

n Version on Local Site Wins - the local version overwrites the remote version

10. If desired, select a schedule for when the sync will run automatically. The choices are

n None - Don’t set up a schedule. Run this sync profile as needed via the Sync Profile

screen‘s Start Now button.

n One Time - you specify a start time and date

n Hourly - you specify a start date and time. eSync begins on the start date and time,

then runs every hour at that time.

n Daily - you specify a start time and date; this sync profile will run every day at this

time

n Weekly - you specify a start time, date, and day. After the start date, this sync profile

will run this day every week at this time.

n Monthly - you specify a start time and date (numbers 1 through 31). After the start

date, this sync profile will run this day every month at this time.

Warning! You cannot schedulemore than one sync to begin at the same time.

Note: While the following options let you schedule a syncprofile, you can syncat any time byaccessing the Sync

Profile and clicking the Syncbutton ( ). See Also: "Running a Sync" on page 18-64

Note: If you enter a date greater than 28, the syncwill not run in amonth that doesnot include that date. For

example, if you enter 31, the syncwill not run in February, April, June, September, and November.

Bidirectional Sync
Although most CMS data is created and updated on the staging server, certain types of data are

collected on the production server. This information can be viewed and edited on the staging

server. Here are some examples:

n membership users

n content ratings data

n forum and blog posts

n community folders

When you set up a sync profile to copy this kind of data (maintained in the database), you

typically would choose Bidirectional as the direction. In this case, if a membership user

creates or updates his profile on the production server, those changes are transmitted to staging.
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On the other hand, if your administrator needs to change that membership user’s information,

the next eSync transfers that from staging to production.

If changes are made to the same file on both servers since the last sync, your conflict resolution

policy determines which data is saved. See Also: "Conflict Resolution Policy" on page 18-62

Note: The first time you run a sync for templatesor Workarea files, the sync is bidirectional, regardlessof the

direction you specify on the Synchronization Direction screen.

Conflict Resolution Policy
If you are using bidirectional synchronization (See Also: "Bidirectional Sync" on page 18-61),

and the same item changed on both servers since the last sync, eSync must decide which

version should be kept, and which version overwritten.

Note: If you are using bidirectional syncand only one version wasupdated since the last sync, the updated version

overwrites the unchanged version.

Use the Conflict Resolution Policy field to determine which version ends up on both servers

after synchronization. The following choices are available.

n Version on Remote Site Wins - the remote version overwrites the local version

n Version on Local Site Wins - the local version overwrites the remote version

Synchronizing Windows Files
As an alternative to selecting a type of data to sync (using the File types radio button), you

can sync individual Windows files. For example, you updated a few template files and their

related .css files on the staging server, and now want to update the production server without

moving everything else.

Note: If you create new HTML content and insert a Library image into it, then sync just that content, the image is

not inserted into the destination library nor is it searchable from the destination site. To remedy this problem,

perform a database/ resourcessync.

Unlike the full sync, you cannot schedule a Windows file sync. Instead, you select files then

sync immediately.

Like the profile sync, the local file replaces the corresponding remote one only if the local file

was modified more recently than the one on the remote server. Otherwise, nothing happens.

To synchronize Windows files, follow these steps.

1. Create a sync configuration between the two servers whose files you want to sync. See

"Setting Up eSync" on page 18-4.

2. From the View All Synchronization Configurations screen, click the Add Sync Profile

button (see below).
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3. Complete the fields on the screen except for Schedule, which the file sync ignores. See

"Setting up a Profile to Sync Workarea Files" on page 18-57.

4. Save the profile.

5. From the View All Synchronization Configurations screen, click the profile then the

Synchronize files button ( ).

6. All folders in your Ektron CMS400.NET site root folder appear. Open folders as needed,

and check all files to be synched.

7. Click the Sync now button ( ).

8. A dialog tracks the sync’s progress, and notifies you when it is completed.

Optional Steps before Running a
Sync
You may want to adjust the web.config and db.config settings before running a Sync. The

following topics explain eSync features that you control via the .config files.

n "Content and Folder Sync Options" on page 18-71
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n "Using eSync with Web Alerts" on page 18-87

n "Using eSync with eCommerce" on page 18-88

n "Force Initial Sync" on page 18-65

n "Backing up the Destination Server During an eSync" on page 18-67

Running a Sync
Warning! The namesof the site and all foldersmustmatch on both servers. This is because paths to images, xslt

files, etc. refer to a site and its folders. If the servers’ site and folder namesdo not match, the links break.

Warning! You cannot run two eSyncs simultaneously.

Prerequisites

n "eSync Requirements" on page 18-35

n You created an eSync configuration and profile. See "Setting Up eSync" on page 18-4.

n You are not signed on to a production server that is outside the firewall. This is because

you cannot sync from a production server outside the firewall to other servers - you can

only sync to this production server.

As mentioned in "Setting up eSync Profiles" on page 18-53, you can set up eSync to run on a

schedule. However, you can also sync at any time. Follow these steps to sync a profile

immediately.

1. Go to the Settings > Configuration > Synchronization screen.

2. If a profile is ready for you to sync, a sync button appears in the right column, as circled

below.

3. Click the sync button ( ).

Note: If another sync is running, you are notified. You cannot begin a new syncuntil the current one finishes.

4. A screen monitors the sync’s progress.
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5. The screen indicates when the sync is complete.

Note: You can close the window and reopen it at any time by clicking the syncbutton ( ). If you do, the sync’s
current statusappears.

Warning! If you performed a database syncand the site being synched usesURL aliasing, youmust go to itsURL

Aliasing Configuration screen and click the Refresh button ( ) to update its aliasing information.

Force Initial Sync
Use the Force Initial Sync button to reinitialize a server that was previously initialized.

Here’s a scenario in which you would want to use Force Initial Sync.

1. You initialized a test server from your current Ektron CMS400.NET server.

2. You experimented on the test server by adding new content, deleting content, etc.
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3. You no longer want the test server’s database. Instead, you want to reinitialize the test

server from the Ektron CMS400.NET server.

To accomplish step 3, use the Force Initial Sync button. The button only appears when all

prerequisites are present. See Also: "Force Initial Sync Prerequisites" on page 18-66

TECHNICALNOTE

Note: The Force Initial Syncprocedure ignores the following checks that are normallymade prior to synching:

Note: * the destination database is smaller than the source database

Note: * the site hasnot been previously staged

Force Initial Sync Prerequisites
In order to use the Force Initial Sync feature, these conditions must exist.

n The server’s web.config file’s ek_ForceReInit property is set to true.

Note: If the ForceReInitproperty is set to false, and you click the Force Initial Syncbutton, you are informed

that you need to change the property to true if you want to force an initial sync.

n The site to which you are signed on is not part of a multi-site configuration.

n The server has only one sync server relationship.

n The server is the destination in the sync server relationship. In other words, the server must

be on the download side of the relationship.

The following image illustrates the last two conditions.
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Backing up the Destination Server
During an eSync
You can create a backup of the destination server’s database. If you do and problems occur

during the sync, the database is automatically restored to its state prior to beginning the

backup.

You can specify the backup to occur on the initial sync only, or every time you sync.

Note: No backup ismadewhen you synca folder or content. SeeAlso" />"Content and Folder SyncOptions" on

page 18-71

Setting up the Destination Database Backup

To set up the database backup, follow these steps.

1. Open

C:\Program Files\Ektron\EktronWindowsServcie30\dbsync.config.

2. Find the following line (near the top).
<DatabaseRuntime name="EktronDbSync" logPath="C:\Program

Files\Ektron\EktronWindowsService30\Database\">

3. Add the following properties to that tag

n device - Following device, enter the path to the backup file. Ektron recommends using

C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Backup\.

n backupOption - possible values

- 1 - backup on initial sync only

- 2 - backup every time you run a sync

4. The line should now look something like this:
<DatabaseRuntime name="EktronDbSync" device="C:\Program Files\Microsoft SQL

Server\MSSQL.1\MSSQL\Backup\" backupOption="1" logPath="C:\Program

Files\Ektron\EktronWindowsService30\Database\">

5. Save the file.

6. Restart the Ektron Windows Service.
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Once this is set up, a backup file is created either after the initial sync (if backupOption="1") or

after every sync (if backupOption="2").

Here is the file’s format: [dbname][yyyy][mm][dd][hh][mm][ss][mmm].[product].bak

For example: cms400min20090216075946765.esync.bak.

- See "Setting Up eSync" on page 18-4

Reviewing Resolved Collisions
To verify the accuracy of the data being synchronized, eSync checks for and resolves the

following matching items

n user names

n folder names

n metadata definitions

n messages

For example, on the staging server, a user creates a folder directly under the root folder called

Marketing, and a user on the production server does the same.

NOTES
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Note: * In order for folders tomatch, theymust have the same name and folder path.

Note: * Both CMSandmembership usersare included.

This problem only occurs if the matching items were both entered since the last

synchronization.

Although matching items have different ID numbers, users cannot tell them apart. So, eSync

appends the ID number to the more recently-created one to distinguish it from the other. For

example, Marketing becomes Marketing11329.

The Review Resolved Collisions Button
To help track these changes, the View All Synchronization Configurations screen has a button

( ) that appears only after such a collision is resolved.

The server on which the button appears is explained below.

eSync Direction
Collision Resolution Information

Appears on this Server

download local

upload remote

When you click this button, the Review Synchronization Collisions screen appears, showing

the original and changed items.

The Review Synchronization Collisions Screen
This screen shows how collisions between matching items were resolved. See Also:

"Reviewing Resolved Collisions" on page 18-68

Each type of resolved collision appears on its own tab.
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After noting these changes, you can click the box to the left of each change, then click the

Mark Reviewed button to remove it from the screen. Alternatively, you can click the box in

the header row to select all.

The Users tab has an additional button,Mark Reviewed and Email. Use it to remove the user

from the screen and send an email to him/her (using the address from the Add/Edit User

screen’s E-Mail Address field). The email text is below.

lbl sync collision email subject = Your username has been changed
lbl sync collision email body = For security purposes, your username has been changed.

Your new username is {0}. You will need to use this new username the next time you

login. Thank you.

Note: You can change the text in the resource file. To learn about editing it, see ”Procedure for Translating

Workarea Strings” on page 946.

Synching Custom Database Tables
You can use eSync to synchronize a custom SQL database table. To do so, follow these steps.

1. Add a new, empty table to the target SQL database.

2. On the server that hosts the source database, navigate to C:\Program

Files\Ektron\EktronWindowsService30.

3. Open the DbSync.config file.

4. Find the section that begins <Release version="7.6.6.

5. Within the 7.6.<Groups> tag, you see these names:
<add name="default" scope="ektron"
<add name="folder" scope="ektron"
<add name="content" scope="ektron"
<add name="folderrecursive" scope="ektron"
<add name="workflow" scope="workflow"
<add name="custom" scope="custom" schema=""/>

6. Enter your custom table schema within the last line’s schema="" tag.
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Note: Follow the pattern of the existing schemata when adding yours.

7. Save DbSync.config.

8. Sign on the source server.

9. Follow steps 1 through 7 on that server.

10. Restart the Ektron Windows Service on both servers.

11. Run a DB sync from local to remote (local win).

Content and Folder Sync Options
Members of the Administrators group or those assigned to the Synchronization Admin role can

sync individual content items and Ektron CMS400.NET folders using context menu options, as

shown below.

See Also:

n "Prerequisites for Content/Folder Sync" on page 18-72

n "Enabling the Content and Folder Level Sync" on page 18-73

n "Using Content and Folder Level Sync" on page 18-73

n "Synching a Content Item" on page 18-74

n "Synching a Folder" on page 18-76
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Prerequisites for Content/Folder Sync
See Also: "eSync Requirements" on page 18-35

n You are a member of the Administrators group or assigned to the Synchronization Admin

role

n Content/folder sync is enabled in web.config. See "Enabling the Content and Folder Level

Sync" on page 18-73.

n The server has a sync configuration whose initial sync has been run

n Existing folders: folder information has not been updated since the last database sync

using the selected profile.

If any folder property is changed (for example, a new metadata value is assigned), a database

sync must be run before you can synchronize content in that folder and the folder itself.

Furthermore, any child folder (and its content) that inherits that property from the parent folder

can only be synchronized after the next database sync.

n New folders: a database sync must be run before you can synchronize content in the new

folder and the folder itself

n Content: No new tags or taxonomy categories have been added since the last time the

selected profile was synched. If either event has occurred, a database sync must be run

before you can synchronize that content. You must also run a database sync for all other

profiles that use those tags or taxonomy.

The following graphic illustrates adding new tags and a taxonomy category to content.

n For a folder sync, the content is not a blog or forum post. For a content sync, the content is

not a forum post.
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Enabling the Content and Folder Level Sync
To set up the content and folder Synchronize options, follow these steps.

1. Log on to the server on which content editors will sync content and folders.

2. Open Windows Explorer > your site root folder > the web.config file.

3. Go to the following area.
<eSyncSettings>
<!-- enables or disables eSync feature -->
<add key="eSyncEnabled" value="false"/>
</eSyncSettings>

4. Set the value of eSyncEnabled to true.

5. Save web.config.

Using Content and Folder Level Sync
You would typically use eSync in the following manner.

1. Create, update, and get content approved on a staging server.

2. Synchronize content blocks or an Ektron CMS400.NET folder with the production server.

The eSync feature is available if you see Synchronize menu options (shown below) on

Approved content or a folder.
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Synching a Content Item
Content sync copies a selected content item to another computer. The sync also copies library

resources within that content, such as images and quicklinks.

Only Approved content can be synchronized. See Also: "Prerequisites for Content/Folder Sync"

on page 18-72

To sync a content item, follow these steps.

1. Navigate to the content. You can

n go to the Web page that displays it

n sign into the Ektron CMS400.NET Workarea and

- navigate to its folder, or

- use the Search to find it (see below)

2. Click the arrow to the right of the content to see its dropdown menu.
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Note: ASynchronize button (shown below) is also available from the View Content screen.

Note:

3. Click Synchronize.

4. All relationships with at least one Database profile whose direction is Upload or

Bidirectional appear. Select the appropriate one. See Also: "Setting up eSync Profiles" on

page 18-53

5. Click Sync Now.
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6. The content is synchronized with the selected database.

Synching a Folder
The folder sync updates all content in a folder with another computer. It does not affect content

in folders underneath the selected folder. See Also: "Prerequisites for Content/Folder Sync" on

page 18-72

To sync a folder, follow these steps.

1. Navigate to the folder.

2. Click Action > Synchronize Folder.

3. A screen asks you to select a sync relationship.

4. Click the Start Sync button.

5. All content in the folder is synched with the selected database.

eSync in a Load Balanced
Environment
Ektron CMS400.NET supports a load-balanced environment, in which several servers share

your Web site’s processing load. This feature is explained in ”Load Balancing Support” on
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page 123.

If your site uses load balancing, you can set up eSync such that, after one server in a load

balance cluster is synchronized, the other servers will be automatically synchronized. Note that

if a separate database server is outside the load balance cluster (as shown below), eSync only

synchronizes documents and files used by the search among the clustered servers. It does not

touch the database.

A typical load balanced cluster is below.

Warning! Ektron’s eSync feature doesnot synchronize all databases in a SQL database cluster. If you have such

a configuration, it is your responsibility to ensure that eSyncupdatesall the databases.

Warning! In a load balanced environment, only update templateson the staging server. Do not update them on

the production server and assume theywill be synchronized with the staging server.

Warning! Assume your load balanced cluster consists of two staging servers (S1 and S2) and two production

servers (P1 and P2).

If you add/modify/delete a file on S1, to get the file to S2, youmust run either a download syncon S2, or an upload

syncon S1, or a bidirectional sync from either server. If you run a download syncon S2, you also need to run an

upload sync to push the file to P2, which will then Load Balance with P1.

The best way tomake sure that the added/modified/deleted file is changed on all servers is to initiate the sync from

the server on which the file was changed. In this example, since you changed the file on S1, if you initiate a sync

from S1, it will be automatically updated on S2, P1, and P2.

Prerequisites

n The connection string on all servers in the cluster match

n You must initiate eSync relationships, and the actual synchronization, from a staging

server
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n If your staging servers are clustered, you must remove one from the cluster before you can

sync

Follow these steps to set up this capability.

n "Install a Min Site on Every Server in the Cluster" on page 18-78

n "Update the Assetmanagement.config File" on page 18-78

n "Update the Ektron Windows Service Config File" on page 18-78

n "Create eSync Security Certificates for a Load Balanced Cluster" on page 18-79

Install a Min Site on Every Server in the Cluster
1. Upgrade each server to the same version of Ektron CMS400.NET. If Ektron CMS400.NET

is already installed to one server, you can install a minimum site on the other servers.

2. To do this, run the Ektron CMS400.NET base installation file (CMS400Base8x.exe). For

more information, see the Ektron CMS400.NET Setup manual.

3. If the current site with which you will sync is precompiled, you must also precompile all

min sites.

Update the Assetmanagement.config File

1. Sign on to the first server in your load balanced cluster.

2. In the site root folder, open site root\assetmanagement.config.

3. Change the value of LoadBalanced to 1 and save.

4. Do this on every server in the cluster.

Update the Ektron Windows Service Config File

1. Sign on to the first server in your load balanced cluster.

2. Open
C:\ProgramFiles\Ektron\EktronWindowsService30\Ektron.ASM.EktronServices30.exe.Config

.

3. Change the value of LoadBalanced to 1 and save.

4. Do this on every server in the cluster.
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5. Stop and then Start the Ektron Windows Service on every server in the cluster.

Create eSync Security Certificates for a Load
Balanced Cluster

You should be familiar with eSync security certificates before beginning this procedure. If you

are not, read the following section: "Managing eSync Security Certificates" on page 18-43.
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Assume the load balance cluster has three servers: mach1, mach2, and mach3.

This procedure has two major parts.

n Generating Security Certificates on mach1.

n Applying Security Certificates to mach2 and mach3

Generate Security Certificates on mach1
In the first nine steps, you copy mach1’s security certificate files, then paste them into the same

folder, and rename them beginning with mach2 and mach3.

1. Sign on to mach1 and generate security certificates. To do this, click the Windows Start

Button> All programs > Ektron > CMS400 v7x > Utilities > Security Configurator.

2. The security configurator screen appears.

3. See "Use the following table to complete this screen." on page 18-46.

4. Click Generate Certificates then click OK. This action creates security certificates on

mach1.

5. On mach1, open the following folder:

C:\ProgramFiles\Ektron\CMS400V7x\Utilities\Software\SecurityConfigurator.

6. Copy the following files.

n mach1_SyncClient.pfx

n mach1_SyncClient.pvk

n mach1_SyncClient.cer

n mach1_SyncServer.pfx

n mach1_SyncServer.pvk

n mach1_SyncServer.cer

7. Paste them into the same folder.

8. Rename each file according to the following pattern: mach2_file name. (This assumes the

second server in your load balance cluster is mach2.)

9. Repeat steps 7 and 8 for every server in your load balance cluster. So the number of

certificate files in the folder is 6 x the number of servers.

10. Copy all security certificate files to the following mach1 folder: C:\Program

Files\Ektron\EktronWindowsService30.

11. Stop and start the Ektron Windows Service.

In the second part of this procedure, you

n open the Ektron.ASM.EktronServices30.exe.config file

n copy mach1’s certificate’s key value

n create new keys, and apply mach1’s encoded value to them

Synchronizing Servers Using eSync

18-80
ReferenceManual

Version 8.0 Rev 1.3



So, when you finish, the affected part of the file looks like this:

<add key="mach1_SyncClient.cer" encodedValue="MIIB7TCCAVag....
<add key="mach2_SyncClient.cer" encodedValue="MIIB7TCCAVag....
<add key="mach3_SyncClient.cer" encodedValue="MIIB7TCCAVag....

Note: The encodedvalueabove is abbreviated to fit the page.

12. Open the following file:

C:\Program Files\Ektron\CMS400v7x\Uti-
lities\EWSUpdates\3.0\Ektron.ASM.EktronServices30.exe.config

13. Find the <publickCertKeys> element.

14. Following that line is the encoded certificate value for mach1, which looks something like

this.

<add key="mach1_SyncClient.cer" encodedValue="MIIB7TCCAVag....

Note: The encodedvalueabove is abbreviated to fit the page.

15. Copy the entire <add key> element, including the value, into the Notepad file.

16. Open a text processing application like Notepad.

17. Into the Notepad file, paste the text you copied in Step 13 three times.

18. Change the second line’s add key value to mach2_SyncClient.cer.

19. Change the third line’s add key value to mach3_SyncClient.cer.

20. Copy the second and third lines of the Notepad file (the lines you just changed).

21. Return to the Ektron.ASM.EktronServices30.exe.config file.

22. Locate the <add key> element.

23. Place the cursor directly below that line.

24. Paste the text you copied in Step 18.

25. Save the Ektron.ASM.EktronServices30.exe.config file.

Apply Security Certificates to mach2 and mach3
1. On the local server, open two Windows Explorer windows: one showing the mach1’s file

system, and the other showing the mach2’s file system.

2. In the mach1 window, open C:\Program Files\Ektron\EktronWindowsService30.

3. Copy all security certificate files in that folder.

4. In the mach2 window, open the following folder: C:\Program
Files\Ektron\EktronWindowsService30.

5. Paste all security certificate files you copied in Step 3 to that folder.

6. Stop and start the Ektron Windows Service.
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7. In the mach2 window, create a folder underneath the root folder. Name it Ektron Security

Certificates.

Warning! Do not place it under the web root folder, C:\inetpub\wwwroot.

8. Return to the mach1 window, which is still open to the following folder: C:\Program

Files\Ektron\EktronWindowsService30.

9. Copy the following files.

Warning! Copy - do not move - the files from the mach1 folder.

n mach2_SyncClient.pfx

n mach2_SyncClient.pvk

n mach2_SyncClient.cer

n mach2_SyncServer.pfx

n mach2_SyncServer.pvk

n mach2_SyncServer.cer

10. Paste the files into the mach2 folder you created in Step 6. Make sure there are no other

security files in the folder.

Next, you need to register and move the files to the correct folders. The Security Configurator

screen does this.

11. On mach2, open the security configurator screen using this path: Windows Start Button >

All programs > Ektron > CMS400 v7x > Utilities > Security Configurator.

12. The security configurator screen appears.
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13. Click the Apply Remote Server Certificates button (circled above).

14. Click the browse button next to that field.

15. Browse to the folder to which you pasted the security certificates in Step 9.

16. Click the OK button.

17. The utility copies the security certificates you pasted in Step 9 to the correct folder, and

configures them for the remote server.

18. Repeat the above steps for every server in the load balance cluster. Note that the files to

be copied will start with the server name you’re currently setting up.

Setting Up and Running eSync
You set up and run eSync in a load balanced environment the same way you run it normally.

See these sections for details.

n "Using eSync to Initialize a New Site" on page 18-52

n "Setting up eSync Profiles" on page 18-53

n "Optional Steps before Running a Sync" on page 18-63

n "Running a Sync" on page 18-64

Note: If your first load balanced sync fails, youmust run the Search Config Utility on the load balanced server in

order for search to work. See Also: ”AutomaticallyRecreating a Catalog” on page 396

Using eSync in a Multi-site
Environment
If you want to use eSync in a multi-site environment, you must do so before the initial

synchronization of a configuration. That is, you cannot set up a eSync configuration in a

single-site environment and then later change to multi-site. You can set up a new

configuration at any time.

See Also:

n "Limitations on using eSync in a Multi-site Environment" on page 18-84

n "Setting up eSync in a Multi-Site Environment" on page 18-84
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Limitations on using eSync in a Multi-site Environment
n In a multi-site environment, you cannot create a staging site from a production site (as

described in ”"Using eSync to Initialize a New Site" on page 18-52). You must first create

all sites on the staging server, then set up production sites with which they will sync.

n If you want to sync templates between sites in a multi-site configuration, you must sign on

to the site that has the templates that need to be synched. For example, your configuration

consists of a main site and two multi-sites (A & B) on staging and production. If you want

to sync site A’s templates, you must sign on to site A on the staging server, then use its

Workarea screens to sync its templates to site A on the production server.

n When using eSync, each site in a multi-site configuration must be created separately in IIS.

In other words, you cannot set up several sites under one IIS site and successfully use

eSync.

Setting up eSync in a Multi-Site Environment
To set up eSync in a multi-site environment, follow these steps.

Warning! Backup your database before beginning this procedure!

1. Set up all sites on the staging server, following the instructions in the Ektron

CMS400.NET Administrator Manual section “Multi-Site Support”.

2. Install an Ektron CMS400.NET min site on each production server that will host a site. To

do this, run the Ektron CMS400.NET base installation file, version 7.6 or higher. (For more

information, see the Ektron CMS400.NET Setup manual.)

3. Install security certificates between the staging server and all production servers. This

procedure is described in "Managing eSync Security Certificates" on page 18-43.

4. Sign on to the staging server.

5. In the Ektron CMS400.NET Workarea, go to Settings > Configuration > Synchronization.

6. The View All Synchronization Configurations screen appears.

7. Click the Add button ( ).

8. The Create Synchronization Server Relationship screen appears.

Note: If you see the following error, The system cannot find the file specified, youmust set up security

certificates. See Also: "Managing eSyncSecurityCertificates" on page 18-43

Because the staging server is multi-site, the screen’s staging server area has a Site

pulldown field (circled below), which lets you select a site.
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9. Use the following table to complete the screen.

Warning! The first time you synca Ektron CMS400.NET Web site, all of its data is overwritten. Make sure that no

important information resideson the production server before beginning the first sync.

Field Description

Remote

Server

Select a production server by choosing the path to the site’s

physical location on the remote server.

Port

Number

Use this field to indicate to the local service the port on which

the remote service runs. Bydefault, port 8732 appears.

If you want to change the service port, youmust

n change it in this field

n open the C:\Program Files\Ektron\EktronWindowsService30

n \Ektron.ASM.EktronServices30.exe.config file,

n and replace every occurrence of localhost:8732with localhost: fol-

lowed by the new port number.

Choose

Certificate

If you selected a single server above, its name appears here. Proceed to the next

step.

If you selected a domain or IP addressabove, click the dropdown arrow to view all

serverswhose client security certificates reside on this server. Then, select the

server with which you want to set up an eSync relationship.

10. Click the Connect button.

Using eSync in aMulti-site Environment

ReferenceManual

Version 8.0 Rev 1.3
18-85



After you connect to the production server, all eligible databases on it appear. The top one

has a green check mark, indicating it is selected by default.

11. Click the database with which you want to sync. When you do, a green check mark

appears on it, and its background color changes.

12. Click Next.

13. A new screen appears, showing both servers and allowing you to change the direction of

the initial database copy. Make sure you are copying from staging to production.

14. When you are satisfied, click Create. This sets up the server configuration but does not

launch the initial sync.

15. The View All Synchronization Configurations screen appears with the new configuration.

If you are ready to overwrite the production database with the staging one, click Start

Initial Sync.

16. A confirmation screen appears.

17. A screen monitors the sync’s progress.

18. The initial sync creates a default profile, which appears on the View All Synchronization

Configurations screen.

19. Set up and launch sync profiles to sync workarea files and templates on the staging server

with those on the production server. (This is described in "Setting up eSync Profiles" on

page 18-53 and "Running a Sync" on page 18-64.) For synchronization direction, choose

Upload.

Setting up Staging Multi-sites
By default, if you sign on to a staging server then insert library items (images, quicklinks, etc.)

into content, the path to those items includes the production server.

For example, your server setup includes two multi-sites: sales.ektron.com and

support.ektron.com.

Note: Themulti-site namesare defined in the site’s folder properties screen’sProduction Domain field, as

described in ”See "Step 3: AssignMulti-Site Capabilities in Ektron CMS400.NET" on page 19-31.

So, any library links in the sales.ektron.com site’s content look like this:

http://sales.ektron.com/template?id=id number.

However, you may wish to change library links so they refer to the staging server. This would

help you verify that the linked items exist on the staging server.

To change library links so they refer to your staging server, follow these steps.

1. In the Ektron CMS400.NET Workarea, go to Settings > Configuration > Setup.

2. Click the Edit button( ).
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3. Check the This is a Staging Server check box.

4. Save the screen.

5. Go to Content > the staging site folder.

6. Click View > Folder Properties.

7. Click the Edit button( ).

8. Scroll down to the section labeled Multi-Site Domain Configuration:

9. In the Staging Domain field, enter the URL of your staging server

10. Save the screen.

From now on, when a user signs on to the staging server and works with library links, the

links include the staging server instead of the production server.

Using eSync with Web Alerts
The Web Alert feature enables Ektron CMS400.NET to generate email for a list of registered

users whenever new content appears on your site, or existing content is updated. For more

information, see ”Web Alert Feature” on page 75.

In an eSync environment, you need to determine which servers send Web Alerts. For example,

Web Alerts should probably not be generated when content is published on a staging server,

but you would want them when content is published on a production server.

To determine if a server generates Web alerts, use the following property of each Web site’s

web.config file.

<add key="ek_DisableWebAlerts" ..... />

Set the property’s value to true to suppress Web Alerts on a server.

Set the property’s value to false to generate Web Alerts to on a server.

Also, the server clock on the download side of the eSync relationship must be exactly the

same time as or slightly ahead of the clock on the sending server.
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eSync and Integrated Search Folders
In a multi-site environment, Integrated Search folders on the source server are not synched with

the destination server. See Also: ”Using the Integrated Search” on page 435; ”Setting Up

eSync” on page 319

Using eSync with eCommerce
When using eSync with an eCommerce site, you will want to prevent orders from being

processed on your staging server. This is to prevent orders from being processed twice.

For example, a customer on your production site purchases a product. If the staging server and

production server are synced before the credit card is processed, the potential exists for the

customer’s credit card to be charged twice; once from the production server and again from the

staging server.

To prevent orders from being processed on your staging server, edit your staging site’s

web.config file. Next, set the following property to true.

<add key="ek_ecom_OrderProcessingDisabled" value="true" />

Once the property is set to true, you cannot process or edit orders from the Workarea’s View

Order screen on the staging server. Also, if you try to create an order from the staging server’s

Web site, you receive the following message.

“We're sorry, an error occurred while processing your request. Please try again later...”

It is important to note that all other eSync functions still work properly. For example, when

you create catalog entries on a staging server and perform a sync, the entries will be moved to

the production server. This key only affects the processing of orders.

Using eSync with Notifications
When using eSync with Notifications, any new agents are not synched. This means that you

must manually add new agents to each server in your configuration.

Once the agent exists on all servers in your configuration, eSync keeps them updated. For

example, assume a membership user logs into the production server and updates his profile’s

Activities tab by changing the activities a custom agent will perform. eSync will sync those

changes with the staging server.
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See Also: ”Adding an Agent” on page 16-170

eSync Troubleshooting

Symptom Cause Possible Solutions

Synchronization has failed

There wasno endpoint listening at

http://alphatest:8732/

Ektron.Sync.Communication/

SyncCommunicationScheduleService.svc

that could accept themessage.

This is often caused byan incorrect

addressor SOAPaction. See

InnerException, if present, for more

details.

One server in

the

configuration

cannot

resolve the

addressof the

other server.

Thismaybe

due to security

restrictionsor

because the

Ektron

Windows

service is off.

n Modify the hostname of the

other server so that it can be found.

n Restart theWindowsservice

n Reconfigure security

The identity check failed for the outgoing

message. The expected identity is xxx for

the xxx target endpoint.

Local site can't

communicate

with service

1. Load the security con-

figuration utility:

C:\Program

Files\

Ektron\CMS400V7x\utilities\

software\

securityconfigurator\

securityconfigurator.exe.

2. Select the web site that is

failing.

3. ClickOK.

This recopies client certificates to

the site and updatesweb.config to

use them.

No viable CMSsiteswere found on the

remote server specified. Please check the

remote server and try again.

No Ektron

CMS400.NET

site exists on

the remote

server.

Install an Ektron CMS400.NET min

site on the remote server.
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Modifying the Application Setup
Screen
In the setup section of the configuration folder, you can enter or edit information for the Ektron

CMS400.NET Web site including:

n License keys

n Default language

n Ssummary sizes

n Email notification

n Physical library folders on file server

n Builtin user information

n Editor options

n Work page size settings

You must complete this before any user can access your Ektron CMS400.NET Web site.

n "Viewing Application Setup Information" on page 19-2

n "Updating Setup Information" on page 19-3

n "Enabling WebImageFX" on page 19-10

n "Enabling CMS to Create File System Folders" on page 19-10

n "BuiltIn User" on page 19-11

n "BuiltIn User" on page 19-11

Note: Onlymembersof the Administrator User Group can view and edit the Application Setup screen.

Viewing Application Setup
Information
To view Ektron CMS400.NET setup information, follow these steps.

1. Access the Workarea. See Also: "Accessing the Workarea" on page 4-3

2. Click Settings > Configuration > Setup.
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3. The Application Setup screen is displayed. For more information, see "Fields on the

Application Setup Screen: General Tab" on page 19-3.

Updating Setup Information
To update setup information, follow these steps.

1. Access the Application Setup screen, as described in "Viewing Application Setup

Information" on page 19-2.

2. Click the Edit button ( ).

3. The Application Setup screen appears with the General Tab first showing. Update the

fields as needed. The following tables explain the fields.

n "Fields on the Application Setup Screen: General Tab" on page 19-3

n "Fields on the Application Setup Screen: Editor Tab" on page 19-6

n "Fields on the Application Setup Screen: Workarea Tab" on page 19-7

Fields on the Application Setup Screen:General Tab

Updating Setup Information
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Field

(General

Tab)

Description

Version
This number shows the Ektron CMS400.NET version and build numbers. This

number is important to know if you place a call to Ektron Support.

License

Key(s)
Enter the license key sent to you from Ektron via email into this field.

Module

Licenses

Enter the license key for WebImageFX that was sent to you via email. See

"EnablingWebImageFX" on page 19-10 for more information.
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Field

(General

Tab)

Description

Default

Application

Language

Select a default language for Ektron CMS400.NET.

How a User’s Application Language Affects His Use of Ektron

CMS400.NET

This user’s language determines the screensandmessages that appear in

Ektron CMS400.NET.

How the System Default Language Relates to a User’s

Language Setting

In the user profile, you can set each user’s language. You can set anyuser’s

language to system default. Each user whose language is set to system default

uses the language assigned here.

Note: Do not confuse this default application language with the ek_

DefaultContentLanguage variable in web.config. For more information on that

variable, see "The Default Language" on page 14-7.

Maximum

Summary

Size

In characters, limit the size of each summaryby specifying amaximum size. If a

user’s changes to a summary result in exceeding this limit, the user is told to

reduce the summarybefore he can save it.

It cannot exceed 65,000 characters.

System E-mail

Address

Enter a valid email address. This addresswill appear in the From field in the

notification emails.

Server Type:

Staging

Server

Check this box if you want your library links to refer to the staging server

domain, asopposed to the production server domain. Thiswould help you

verify that the linked itemsexist on the staging server. See Also: "Step 3: Assign

Multi-Site Capabilities in Ektron CMS400.NET" on page 19-31

Warning! Important! Checking this boxdisables theWeb Alerts feature on

your server.

Asynchronous

Processor

Location

If your site uses theWeb Alerts feature, enter or update the location of the

asynchronousprocessor Web Services file. The default location i s “[none

specified].” See Also: "Setting Up theMessageQueue and Asynchronous

Processor" on page 20-6

Enable Office

documents to

be published

in other

format

Check the box to allow Ektron CMS400.NET to render Office documents in

PDF format.When a checked, PDF generation is available for individual

folders.

See Also: "PDF Generation" on page 7-454

Enable CMS

to create file

system folders

for library

assets

Check the box if you want to create physical folders on your file system server

that match the Ektron CMS400.NET library folder tree. See Also: "Enabling

CMS to Create File System Folders" on page 19-10
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Field

(General

Tab)

Description

Built - in User

Edit the username and/or password for the built in user. Bydefault, the

username and password combination is builtin/builtin.

Warning! Important! Ektron strongly urges you to change the default pass-

word assigned to the builtin user. An opportunity to do this is presented during

installation.

See Also: "BuiltIn User" on page 19-11

Editor Tab

Fields on the Application Setup Screen:Editor Tab

Field (Editor

tab)
Description

PreserveMS-Word

Styles

When content fromMSWord is cut and pasted into the editor, the editor,

by default, removes someMSWord styles. Checking this boxprevents

the editor from removing them.

Note: Ektron doesnot recommend enabling this feature.

PreserveMS-Word

Classes

Similar to styles, when content fromMS-Word is cut and pasted into the

editor, the editor, by default, removes someMS-Word classes. Checking

this boxprevents the editor from removing them.
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Field (Editor

tab)
Description

Enable Font

Buttons

This option displays the following font-related buttonson the editor

toolbar:

n Font Face

n Font Size

n Font Color

n Font Background Color

See Also: "Enable Font Buttons" on page 19-12;"Font Manager" on

page 19-43

Accessibility/Section

508 Evaluation

If your editor is eWebEditPro+XML: Dialogs that Allow Input of

Accessibility Information

If your editor iseWebEdit400: "Setting up and Customizing Accessibility

Validation" on page 7-683

Fields on the Application Setup Screen:Workarea Tab

Field (Editor

tab)
Description

The following fields change

n whether button text appears in the title bar
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Field (Editor

tab)
Description

n the default Web page after sign-in

n the default Workarea page

The default valuesare automatically applied to all new users, and to all existing userswhen you

upgrade.

Normally, you canmodify these values for anyuser via the Edit User screen. But, you can force

these valueson all users, removing the ability to personalize them.

Landing Page

After Login

If you want one page in your Web site to appear after users sign in, enter

the URL to that page. You can clickSelect Page to browse to the landing

page. The last published version of the page appears. If the page has

never been published, nothing appears.

Bydefault, the page fromwhich the user logged in reappears.

Set Smart

Desktop asStart

Location in the

Workarea

If you want the Smart Desktop to appear as soon asusers enter the

Workarea, click this box.

See Also: "Personalizing the Smart Desktop" on page 4-4

Bydefault, the user sees the Smart Desktop after sign in.

If you leave this checkboxblank, when you enter theWorkarea, you go to

the folder of the content specified at the Landing Page after login field.

Workarea Page

Size

Width

If desired, change the width of the screen in which Ektron CMS400.NET

appears. The width in pixelsmust be between 400 and 2400.

This field accommodatesuserswho have larger monitors and/or prefer a

higher resolution, such as1280 x1024.

The default value for this setting is 790.

Height

If desired, you can change the height of the screen in which Ektron

CMS400.NET appears. The height in pixelsmust be between 300 and

1800.

This field accommodatesuserswho have larger monitors and/or prefer a

higher resolution, such as1280 x1024.

The default value for this setting is 580.
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Field (Editor

tab)
Description

Display button text

in the title bar

Check this box if you want anybutton’s caption text to appear in the screen

title’s bar whenever a user moves themouse over the button. Note the

wordUpdate, describing the button, in the illustration below

If you do not check this box, the screen’s title remains in the title bar when

the user moves themouse over the button, as illustrated below.

Force

Preferences to all

users

To force these settingson all Ektron CMS400.NET users, check this box. If

you do, users can see the values in the user profile screen but not change

them.

If you leave this boxblank, users can personalize these values in their User

Profile.

Enable Verify

email?

Check this box if users should be notified whenever they subscribe to an

email notification list. See Also: "What Happens if Verification email is

Used" on page 20-30

Warning! Warning!When using the Checkout Server Control on an

eCommerce site, theEnable Verify Email settingmust be unchecked.

Otherwise, new userswill receive an error message when they sign-up

using this control. See Also: "Checkout Server Control" on page 17-16

Enable

PreApproval

Group

Use this field to enable Automatic TaskCreation. See Also: "Automatic

Creation of TasksAssociated with Content" on page 11-34

4. Make the necessary changes.

5. Click the Update button ( ).

Updating Setup Information

ReferenceManual

Version 8.0 Rev 1.3
19-9



Enabling WebImageFX
When purchasing Ektron CMS400.NET, you had the option to purchase Ektron WebImageFX

as well. WebImageFX is an imaging application that allows users to edit images online.

If you purchased WebImageFX when you purchased Ektron CMS400.NET, you should have

received an email with a license key for WebImageFX as well.

To enable WebImageFX within Ektron CMS400.NET, from the application setup page, insert

the WebImageFX license key in the Module License field.

Enabling CMS to Create File System
Folders
If this option is enabled, each time a new content/library folder is created in Ektron

CMS400.NET, a corresponding physical folder is created on the file system. This helps

organize library assets on your file server.

The following illustration compares the library folder tree with the file system’s folder

structure.
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Note: If upgrading, the installation doesnot the create sampleWeb site’s folderson the file server. These folders

must be addedmanually. However, all folders created by you are also created on the file server when enabled.

BuiltIn User
The builtin user is a user that is defined in the Ektron CMS400.NET setup screen. Primarily,

he’s an emergency user if you cannot log in to Ektron CMS400.NET as the administrator.

Note: The builtin user can log in to Ektron CMS400.NET whether or not Active Directoryor LDAP is enabled.

Only use the builtin user to correct a bad or expired license key. It is not designed for regular

CMS operations. If you try to edit content while signed on as this user, you see errors.

Warning! Bydefault, the builtin user's username and password combination is builtin/builtin. For security rea-

sons, Ektron recommendschanging them upon installation.

Limitations on Builtin User's Workarea Access

If you log into the CMS400.NET Workarea as the builtin user, you can only access the

following screens on the Settings tab.

n Active Directory

BuiltIn User
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n Asset Server Setup

n Setup

n User

n User Group

You cannot access other areas of the CMS.

Editing the BuiltIn User

To edit the builtin user’s username and password, follow these steps.

1. Access the Edit Application Setup Information screen's General tab, as described in

"Updating Setup Information" on page 19-3.

2. Locate the Built In User field.

3. Change the username and password.

4. Click the Update button ( ).

Note: If you cannot sign in to Ektron CMS400.NET because the builtin user password waschanged and you don’t

know the new password, use the BuiltinAccountReset.exe utility. This resets your Ektron CMS400.NET user \

password to Builtin \ Builtin. This utility is located in C:\Program

Files\Ektron\CMS400versionnumber\Utilities.

Enable Font Buttons

Here is the editor with font related buttons enabled. To enable these buttons, check the Enable

Font Buttons checkbox in the Settings > Configurations > Setup Screen.

Disable Font Buttons

Here is the editor with the font buttons disabled. To disable these buttons, uncheck the Enable

Font Buttons checkbox in the Settings > Configurations > Setup Screen.
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Ektron Windows Service
Ektron CMS400.NET provides a Windows Service to handle background processing functions.

This section explains the service, including

n the CMS functions it performs

n how it propagates updates to the connection string and site path

n where it resides in IIS and the file system

n its activity log

The Ektron Windows Service is explained more fully through these topics.

n "Functions Performed by the Ektron Windows Service" on page 19-13

n "Changing the Update Time" on page 19-14

n "Changing the Name of the data.config File" on page 19-14

n "Changing the http Port" on page 19-14

n "Disabling PDF Generation" on page 19-14

n "Viewing the Ektron Windows Service" on page 19-15

Functions Performed by the Ektron Windows Service
The Ektron Windows Service performs the following processes.

n "XML Indexing" on page 7-389

n "Load Balancing Assets" on page 19-34

n "PDF Generation" on page 7-454

n "Bad Links Report" on page 7-725

n Publication of content scheduled to go live at a future time, and removal of content

scheduled to expire. See "Scheduling Content to Begin and End" on page 7-195.

n When a new metadata definition is created, the Windows service applies it to all content

in the CMS database. However, the metadata definition is only activated for the content

when it is enabled for the content’s folder. See Also: "Working with Metadata" on page 7-

146

In addition, the Ektron Windows Service propagates updates made to the database connection

string or the site path in the web.config file. The service copies the new value to the

EktronWindowsService
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data.config and sitedb.config files (respectively). These are located in C:\Program

Files\Ektron\EktronWindowsservice30. Any CMS components that reference these values can

retrieve the current information from these files.

Warning! Do not edit the data.config and sitedb.config files. Theyare dynamically generated byEktron

CMS400.NET. If these files have incorrect values, edit the web.config file, which is used to generate them.

Changing the Update Time
The update of the data.config and sitedb.config files occurs once a day at a time prescribed in

the C:\Program Files\Ektron\EktronWindowsservice30\Ektron.ASM.EktronServices.exe.config

file’s updateTime value. If desired, you can change this time.

Changing the Name of the data.config File
If your server already has a file named data.config, and you want to change the name of the

one in C:\Program Files\Ektron\EktronWindowsservice30 to avoid confusion, follow these

steps.

1. Open Ektron.ASM.EktronServices.exe.config.

2. Find this line: <connectionStrings configSource="data.config"/>.

3. Replace data.config with the new file name. For example: <connectionStrings

configSource="Ektron_data.config" />

4. Save Ektron.ASM.EktronServices.exe.config.

Changing the http Port
If your Web site is already using port 6060, follow these steps to change the port number used

by the Ektron Windows Web Service.

1. Open Ektron.ASM.EktronServices.exe.config.

2. Find this line: <add key="HttpServicePort" value="6060"/>.

3. Change the value to the port number you will use for the Ektron Windows Service.

Disabling PDF Generation
By default, PDF generation is enabled. If you want to disable it within the Ektron Windows

Services configuration file, follow these steps.

1. On the server to which you installed Ektron CMS400.NET, open C:\Program

Files\Ektron\EktronWindowsservice30.

2. Open Ektron.ASM.EktronServices30.exe.config.

3. Find this line:
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<add name="PdfFileRead" type="-

Ektron.ASM.EktronServices.PdfFileManagerRead.PdfFileManagerReadService, Ektron.ASM.-

EktronServices20" IntervalSeconds="101" Enabled="true" />

4. Set enabled to false.

Viewing the Ektron Windows Service

Viewing in IIS
The Windows Service starts automatically when Ektron CMS400.NET is installed, and again

whenever the server is restarted.

1. To see the status of the service, go to Computer Management > Services and

Applications > Services.

2. Look for Ektron Windows Services. You can see its status in the Status column.

The Activity Log
The service has an Activity Log, which tracks all related events. To see it, go to Computer

Management > System Tools > Event Viewer > Ektron Log.
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To view detail for any event, double click it.

A common source of errors is that the service cannot find Ektron CMS400.NET sites, because

they have not been created yet, as shown in the sample below.

Viewing in the File System
On your file system, the Ektron Windows Service is located in C:\Program

Files\Ektron\EktronWindowsservice30. Within that folder, the

Ektron.ASM.EktronServices.exe.config file runs the Ektron Windows service.
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Using the Search Engine
Optimization (SEO) Control

Ektron CMS400.NET offers a wide array of tools to ensure your Web site is optimized for

search engines, and that your Web pages climb to the top of the ranks. Among these is an SEO

Page Analysis Tool that gives you the key information you need in “real-time” in order to

maximize your returns in organic Web searches.

This SEO tool analyzes the pages of your Web site for W3C compliance, what information

Google has about the page, Alexa rankings, image alt text, keyword density and metadata. The

tool lets you know how (and if) you’ve set these values.

This chapter explains how to use the SEO control.

(continued in Appearance of the SEO Control)

RssAggregator Server Control
An RSS Aggregator or reader takes an RSS feed and displays the information in a readable

format. The RssAggregator server control lets you do the same by processing and displaying an

RSS feed from any Web site. This allows you to create an information Web page for news,

stories, images, lists of music, or for whatever purpose someone creates an RSS feed.

You can create a multi-level information Web page by using multiple RssAggregator server

controls on the same page. For example, you could create a world news Web page by adding

RSS feeds from the NY Times, The BBC, and AFP (Agence France-Presse).

The process of adding an RSS Aggregator to your Web site is simple.

1. Choose a Web form where the RSS Aggregator will reside

2. Drag and drop the RssAggregator server control on that Web form

3. Set the URL property to point at the RSS feed. For example,
http://msdn.example.com/rss.xml

4. Save the Web form

When a visitor to your site views the Web form in a browser, he sees the RSS feed displayed

properly. When he refreshes the Web page, any information that the RSS feed provider has

updated is now reflected. See Also: "Using the RssAggregator Server Control" on page 19-19

By creating a custom XSLT, you can change the way an RSS feed is viewed by your site

visitors.

This subsection contains the following topics:

n "RSSAggregator Server Control Properties" on page 19-18
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n "Using the RssAggregator Server Control" on page 19-19

n "Retrieving the XML Structure of an RssAggregator Control" on page 19-20

RSSAggregator Server Control Properties
The RSSAggregator server control properties are described in this table.

Note: The following table only listsEktron-specific properties. It doesnot describe native .NET properties such as

font, height, width and border style. For documentation of these properties, see VisualStudio help.

Property Value Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer

and can use it to browse to Content, Collections, etc.

See Also: "Using CMSExplorer to Browse Your
Ektron CMS400.NET Site" on page 21-9

String

DisplayXslt

Determineshow the information on the page is

displayed

None-databind only

ecmNavigation - lists the title of everyRSS feed

item

See Also: "Example of ecmNavigation Display"

on page 9-124

ecmTeaser - lists a title and a description of every

RSS feed item

See Also: "Example of ecmTeaser Display" on

page 9-124

Path to Custom Xslt - Enter the path to an Xslt

that determines the display of the page

Warning! : If you specify an external file, it is

strongly recommended that you do not store this

file in your site'sWorkarea folder. If you store this

file in theWorkarea folder, the file will be lost when

you upgrade.

String

Hide

Used to hide an RSSAggregator server control in

design time and run time.

True =HideMetadata server control

False =ShowMetadata server control

boolean
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Property Value Data Type

Language

Set a language for viewing the RssAggregator. This

property shows results in design-time (in Visual

Studio) and at run-time (in a browser).

Integer

LinkTarget

Defines the waya link actswhen a link is clicked.

_blank - This target causes the link to alwaysbe

loaded in a new blankwindow. Thiswindow is not

named.

_self - This target causes the link to always load in

the samewindow the anchor was clicked in. This is

useful for overriding a globally assigned base target.

_parent - This target makes the link load in the

immediate frameset parent of the document. This

defaults to acting like “_self” if the document hasno

parent.

_top - This target makes the link load in the full body

of the window. This defaults to acting like “_self” if

the document is alreadyat the top. It is useful for

breaking out of an arbitrarily deep frame nesting.

ItemLinkTarget

MaxResults
TheMaximum number of items from anRSS feed

that are returned (0=unlimited).
Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround

the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

URL

The RSS feed path for the server control.

For example:

http://msdn.example.com/rss.xml

String

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an

inline portion of an HTML document asa span

element.

Div - The <div> tag is used when you want to apply

attributes to a blockof code.

Custom - Allows you to use a custom tag.

String

Using the RssAggregator Server Control
These steps show how to use the RssAggregator server control.

1. Drag an RssAggregator server control into a template.
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2. Set the URL property with the path of the RSS feed you want to display. This example use

the following RSS feed:
http://ax-

.ph-

obos.apple.com.edgesuite.net/WebObjects/MZStore.woa/wpa/MRSS/topsongs/limit=10/rss.xml

This feed displays the top 10 songs according to the iTunes Music Store.

Note: In addition to the URLproperty, other Ektron propertiesare available to customize this server control. For

more information on these properties, see "RSSAggregator Server ControlProperties" on page 19-18

3. Build the Web form.

4. Browse to the Web page in your browser.

5. The page appears with an RSS list of information.

Retrieving the XML Structure of an RssAggregator
Control
Retrieving the XML structure of XML content allows for greater control over developing

XSLs. The following is an example of how to retrieve the XML structure:

1. Open a new Web form.

2. Drag and drop a RssAggregator server control onto it.

3. Set the URL property.

4. Drag and drop a Textbox on the Web form.

5. Set the TextMode property to MultiLine.
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Note: It is also recommended that you set the width of the text box to at least 400px.

6. On the code behind page, add the following line.
Textbox1.Text = RssAggregator1.XmlDoc.InnerXml

7. Build the project.

8. View the Web form in a browser.

The XML structure of the RssAggregator Menu appears in the textbox.

For an additional example, see the RssAggregator XML page on the CMS400Developer

samples page. It is located at:

In a browser:

http://<site root>/CMS400Developer/Developer/RSS/RssAggregatorXML.aspx

In the source code:

<site root>/CMS400Developer/Developer/RSS/RssAggregatorXML.aspx and

RssAggregatorXML.aspx.vb

Multi-Site Support
Ektron CMS400.NET’s multi-site support feature lets you set up and manage several Web sites

under one CMS. For example:

n www.example.com

n support.example.com

n forums.example.com

All sites share a single database. The multi-site support feature does not support multiple

databases.

Multi-site support is explained through the following topics.

n "Advantages of Multi-Site Configurations" on page 19-21

n "Prerequisites" on page 19-22

n "Using Multi-Site Configurations" on page 19-22

n "Installing the Multi-Site Support Feature" on page 19-22

n ”Using eSync in a Multi-site Environment” on page 18-123

Advantages of Multi-Site Configurations
n The URL can indicate the nature of the site to visitors.

n All sites can share
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- common content, but appear within their own site and templates

- the library of images and files. These files can be stored once, yet authors can insert

them into content from any site.

Prerequisites
n The server must run Windows Server 2003 or 2008

Note: WindowsXP supports only oneWeb site.

n All sites must reside on the same server

Using Multi-Site Configurations
Within the Workarea, sites appear under Ektron CMS400.NET’s folder structure but the icon is

a globe (see illustration below). So, an author can create and edit content in the additional site

the same way he works with content in the root site.

Authors log into a root site then begin editing content in the additional site. Regardless of

which site he is using, an author can use the library to insert hyperlinks, images, files, and

quicklinks.

When a folder has a production domain assigned to it, it is a domain folder. Links to content

in a domain folder are activated via linkit.aspx, which redirects to the appropriate domain name

and uses the appropriate template for the folder or content.

Warning! You cannot create a hyperlinkwithin content, a collection, menu, etc. to a form that resides in another

site.

Installing the Multi-Site Support Feature
There are three major steps to setting up each new site.

n "Step 1: Create New Folders in the File System" on page 19-23
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n "Step 2: Create New Sites in IIS" on page 19-24

n "Step 3: Assign Multi-Site Capabilities in Ektron CMS400.NET" on page 19-31

Step 1: Create New Folders in the File System

Warning! Before creating amulti-site configuration, youmust have installed an Ektron CMS400.NET Web site.

All installed foldersmust remain in that site. The original site cannot have virtual folders.

1. Using Windows Explorer, navigate to the C:\Inetpub\wwwroot folder.

2. Create a new folder for each site.

3. Copy the following CMS files and folders from the original CMS site to your new multi-

site folder.

n all individual files (not subdirectories)

n all .config files in all directories under the site root

n these subdirectories:

- bin

- WorkArea

- widgets

- App_Code

- AssetManagement

4. Within each new site folder, open the web.config file and update the ek_sitePath and

WSPath elements with your CMS site path.
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For example, if your CMS site is in the Web site root, enter slash (/). If it is in a

subdirectory of the Web site, enter the subdirectory name. For example, If your web site

root is C:\inetpub\wwwroot and you have a subdirectory called CMS400Min, enter

CMS400Min as the site path.

Step 2: Create New Sites in IIS
Follow these steps to create each new site in IIS.

1. Go to Start > Programs > Administrative Tools > Internet Services Manager.

2. Right click the Web Sites folder and click New > Web Site.

3. A wizard screen appears. Click Next.

4. Enter a name for the new site.

5. On the IP Address and Port Settings screen, enter the IP address of your new Web site or

the host header. Press Next.

6. On the Web Site Home Directory screen, browse to the new site’s folder. You created it in

"Step 1: Create New Folders in the File System" on page 19-23.

7. On the Web Site Access Permission screen, make sure that Read and Write are checked.

8. You are notified that you have completed the new site.

9. Make the new site an application. To do this, right click the site, and select Properties.

Then, click the Home Directory tab. Under Application Settings area, click the Create

button then click OK.
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10. Set Execute permissions to Scripts only.

Create Virtual Folders in IIS
In IIS, for each new Web site, create one new virtual folder for the following shared folders:

n assets

n privateassets

n uploadedfiles

n uploadedimages

These folders are created when you install Ektron CMS400.NET. If you did a normal

installation, they reside under the site directory. For example, C:\Inetpub\wwwroot\your site

root\uploadedimages.

To create virtual versions of these folders, follow these steps.

n "Creating Virtual Folders in IIS6" on page 19-26
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n "Creating Virtual Folders in IIS7" on page 19-27

Creating Virtual Folders in IIS6

1. In IIS, select the new site folder you created in "Step 2: Create New Sites in IIS" on page

19-24.

2. Right click the mouse and select New > Virtual Directory.

3. Identify the corresponding subfolder in the root folder.

4. Assign Read and Write permissions to the virtual directory.
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5. Follow this procedure for all four folders: assets, privateassets, uploadedfiles,

uploadedimages.

Creating Virtual Folders in IIS7

1. In IIS, select the new site folder you created in "Step 2: Create New Sites in IIS" on page

19-24.

2. Right click the mouse and select Add Virtual Directory.

3. Identify the corresponding subfolder in the root folder.
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4. Follow this procedure for all four folders: assets, privateassets, uploadedfiles,

uploadedimages.

Set File System Permissions on New Folders
To do this, follow these steps:

1. Using Windows Explorer, navigate to the new folder(s) you created in "Step 1: Create

New Folders in the File System" on page 19-23.

2. Right click the folder and click Properties.

3. Click the Security tab.

4. Click the Advanced button.

5. Click the check box next to Allow Inheritable Permissions from the Parent to

Propagate…
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Install the aspnet_isapi.dll File
Follow this procedure to install the aspnet_isapi.dll file for every new site.

1. Open IIS.

2. Navigate to an Ektron CMS400.NET Web site.

3. Right click the site and select Properties.

4. On the Properties screen’s Home Directory tab, click the Configuration button.
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5. The Application Configuration screen appears.
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6. In the Wildcard application maps area, click Insert.

7. The Application Extension Mapping screen appears.

8. Browse to C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\aspnet_isapi.dll.

9. Uncheck the Verify that file exists check box.

10. Click OK.

Step 3: Assign Multi-Site Capabilities in Ektron
CMS400.NET
1. In the Ektron CMS400.NET Workarea, click Content. Each site folder must reside within

the site root folder.

2. Create a new top-level site folder for each site by clicking New > Site.
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3. Assign site folder properties as you did for the root folder.

4. The Multi-site Configuration fields appear on the lower section of the screen (illustrated

below).

5. In the Production Domain field, insert your domain.

6. Save the screen.

Within Ektron CMS400.NET, the new domains are indicated by a globe icon.

Load Balancing Support
Load Balancing has two purposes:

n Provides redundancy for your Web site - if one server fails, a second can still handle

requests

n Balances requests - distributes requests across multiple servers

To enable load balancing, set up several servers that include the same files.
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Warning! The physical path to the Ektron CMS400.NET Web sitemust be the same on all servers being load bal-

anced.

Then, purchase load balancing equipment to evenly distribute content requests among the

servers. Whenever an image or file gets uploaded to your Web site, regardless of the Web

server the user is working on, the asset is replicated on both servers.

The client browser is unaware that more than one server is involved. All URLs point to a

single Web site. The load balance software resolves them.

Ektron provides different strategies for load balancing library images and files and DMS

assets. See

n "Load Balancing Library Images and Files" on page 19-33

n "Load Balancing Assets" on page 19-34

See Also: ”eSync in a Load Balanced Environment” on page 18-114

Load Balancing Library Images and Files
Library load balancing is important when your configuration consists of two or more Web sites

that share a single database. Library files are not saved in the database but in the site root

folders uploadedfiles and uploadedimages.

To support load balancing, the library files on all servers must be identical. To maintain this

state, whenever a user uploads an item to the library, it must be replicated on all other servers.

After following the setup instructions, any image or file added to the library of one server will

be copied to the corresponding folder on the other servers in the configuration.

Setting up Library Load Balancing

Step 1.Update Assetmanagement.config

1. On the first server in the configuration, open the siteroot/AssetManagement.config file.

2. Find the LoadBalanced property.

3. Set the value to 1.

4. Repeat this step for all other servers in the configuration.

Step 2.Update the EktronWindows Service File

1. Open C:\Program Files\Ektron\EktronWindowsService30.

2. Open Ektron.ASM.EktronServices30.exe.config.

3. Find the LoadBalanced property.

4. Set the value to 1.

5. Find the LibraryLoadBalanced property.
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6. Set the value to 1.

7. Find the LoadBalServerCount property.

8. Set to the number of servers in your load balance cluster.

Step 3.Restart the EktronWindows Service

See Also: "Ektron Windows Service" on page 19-13

Load Balancing Assets
Ektron CMS400.NET lets you balance requests to view or work with assets among two or

more servers. To achieve this, each server has its own copy of every asset.
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To accomplish this, Ektron CMS400.NET initially stores every new asset in the database. An

Ektron service constantly checks to see if all database assets also exist on each server’s file

system. To learn about this service, see "Ektron Windows Service" on page 19-13.

If an asset does not exist on any server in the cluster, it is copied from the database to the

server’s file system. Once there, the asset is available for requests to work with it. After an

asset is copied to all servers, Ektron CMS400.NET removes it from the database.

There is no limit to the number of servers or databases that can be load balanced.

Setting up Asset Load Balancing
To set up load balancing for assets, follow these steps on both the staging and production

server.

1. Within the site root folder, open the AssetManagement.config file. Change the value of

the LoadBalanced element to 1.

2. Open the following file using a word processor such as Notepad

C:\Program Files\Ektron\EktronWindowsservice30\Ektron.ASM.EktronServices30.exe.config

3. Find the following tag: <add key="LoadBalanced" value="0" />. Change the value to 1.
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4. Find the following tag <add key="LoadBalServerCount" value="2"/>. Make sure the value

is set to the number of servers in your load balance cluster. This number must be the same

for all servers in the cluster.

5. After updating these files for each server in the load balance cluster, sign on to Ektron

CMS400.NET. This action sets up the load balance software in the database.

Web Services

Introduction
Web Services (WS) are reusable software components that can be consumed by variety of

clients, independent of operating system, programming language, or Web server, using standard

Internet technologies. Because Web Services allow heterogeneous systems to communicate

with each other in a standard way, they have received quick acceptance for data interchange

over the Web.

It’s easy for anyone to integrate your WS into their application. The client application can be a

Web application, a Windows application, a Java application, a Visual Studio.net application,

or a host of others -- it does not matter as long as it supports Web Services.

A Web Service consists of one or more methods that expose functionality. In this sense, a Web

Service is an API that can be accessed using SOAP over HTTP. (SOAP is an XML-based,

lightweight protocol that defines the message format of Web Services.)

For example, you might develop a purchasing application that automatically obtains price

information from several vendors, lets the user select a vendor, submits the order and then

tracks the shipment until it is received. The vendor application, in addition to exposing its

services on the Web, might in turn use XML Web services to check a customer's credit, charge

the customer's account and set up the shipment with a shipping company.

This manual does not explain how Web Services work. To learn more about them, try these

sites.

n http://msdn2.microsoft.com/en-us/library/aa480728.aspx#wsmsplat_topic2

n http://aspalliance.com/jnuckolls/articles/introws/default.aspx

n http://aspnet.4guysfromrolla.com/articles/062602-1.aspx

n http://www.15seconds.com/Issue/010430.htm

CMS400.NET’s Implementation of Web Services
CMS400.NET supports XML Web Services. This means that you can create pages that offer

your content to any Web-enabled device, and you can create pages that consume existing Web
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Services. CMS400.NET’s Web Services feature can return data separated from presentation. In

combination with XML support, this feature lets consumers retrieve your XML data

independent of presentation information and act on it however they see fit.

Benefits of Using Web Services
Web Services make it easy to connect with partners. They can also deliver more personal,

integrated experiences to users via smart devices, including PCs. WSs can save time and

money by reducing development time, and increase revenue by making your own XML Web

services available to others.

WS Components and CMS400.NET Architecture
Web Services require the installation of the .NET Framework on the server.

Ektron’s Web Service runs within the .NET Framework. Through Application API classes in

the Ektron.cms.API, .NET managed code can communicate with .NET Framework code.

Software and Hardware Requirements
n .NET framework, version 2.0, must be installed on the server (for more information, see

http://msdn.microsoft.com/netframework/).

n Ektron CMS400.NET, version 6.0 or higher

CMS400.NET Methods
CMS400.NET implements Web Services that exposes methods for accessing CMS400.NET

functionality. These methods mirror their Ektron.Cms.API equivalent that are avail lab le in the

.NET Assemblies.

The methods determine the kind of content that is made available (for example, a content

block, a collection of content blocks, a summary list) along with the presentation of that

information (for example, an HTML string or an XML data structure representing content

block information).

Ektron’s API documentation contains a list of methods that are exposed with a brief

description of functionality. You can access Ektron’s API documentation through the

following resources.

n API Help inside Visual Studio

- In Visual Studio click Help > Contents

- When the help window appears, expand Ektron CMS400.NET API Documentation

in the frame on the left. If you do not see this entry, use the filter and choose

(unfiltered) or Ektron Documentation.

n HTML online help from www.ektron.com
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- http://www.ektron.com/web-content-management-solutions.aspx?id=4020

- Under the Ektron CMS400.NET SDK header, click CMS400.NET API Reference

manual (HTML)

n PDF from the Desktop

- Click Start > Programs > Ektron > CMS400 > Documentation > API Reference Manual

n PDF From the Workarea

- Click Settings > Help > Developer’s API Reference Manual

n PDF From www.ektron.com

- http://www.ektron.com/web-content-management-solutions.aspx?id=4020

- Under the Ektron CMS400.NET SDK header, click CMS400.NET API Reference

manual (PDF)

These methods are made available through various .asmx files. Below is a list of features, the

associated .asmx files and the location on your server. Each of these files, when viewed in a

browser shows a list of the methods available for that feature.

Feature File & Location Location

Activity
Activity.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI

BusinessRules
BusinessRules.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI

Calendar
Calendar.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Calendar

Calendar
CalendarEvent.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Calendar

Calendar
CalendarEventType.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Calendar

Community - Social

Networking

CommunityGroup.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Community

Community - Social

Networking

Favorites.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Community

Community - Social

Networking

Flag.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Community
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Feature File & Location Location

Community - Social

Networking

Friends.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Community

Community - Social

Networking

MessageBoard.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Community

Community - Social

Networking

Tags.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Community

Content
Asset.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Content

Content
Blog.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Content

Content
Content.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Content

Content
ContentRating.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Content

Content
Form.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Content

Content
ThreadedDiscussion.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Content

Custom Fields
CustomFields.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI

Folders
Folder.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI

Fonts
Font.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI

Library
Library.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI

Metadata
Metadata.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI

Navigation - Menus
FlexMenu.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Navigation

Notification System
Notification.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI
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Feature File & Location Location

Permissions
Permissions.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI

Search
SearchManager.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Search

Site
Site.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI

Site Map
SiteMap.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI

Tasks
Task.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Task

Tasks
TaskCategory.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Task

Tasks
TaskCategoryType.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Task

Taxonomy
Taxonomy.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Taxonomy

Users
ActiveDirectoryUser.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\User

Users
User.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\User

CMS400.NET Web Services Examples
CMS400.NET Web Services Example are available through in the Developer sample site.You

can download the sample site from http://www.ektron.com/cms400-web-
cms.aspx?id=5278.

Once you’ve downloaded the Developer sample site, you can view Web Services examples by

accessing the developer sample site at

http://localhost/CMS400Developer/developer/default.aspx and selecting a feature from the

side bar menu. If a feature has Web service examples associated with it, a folder containing the

letters WS will appear in the list of items (illustrated below).
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In addition to the examples, a link to the .asmx file appears. Clicking this link shows a lists all

of the methods available for a given Web service.

The code examples for these Web Services are located on your server in

[Drive:]\[webroot]\CMS400Developer\Developer\dotNetAssemblies\WebServicesAPI folder.

This folder contains sub folders based on each feature for which there is an example.

Ektron’s Microsoft Office SharePoint
Server Connector
Using this tool, Ektron’s customers can take full advantage of SharePoint’s collaborative

workspace to create documents. These documents can then be delivered to a public facing

Web site, corporate intranet or extranet enabled with all the latest search, navigation, Web 2.0

and social networking functionality provided by Ektron CMS400.NET

Ektron CMS400.NET supports the distribution of SharePoint content to any CMS400.NET

folder. For example, your Marketing Department uses Microsoft SharePoint to create and edit

content. After completing a press release, they use the Publish to Ektron CMS menu option to

copy it from SharePoint to a content folder. Once there, the document can pass through an

approval chain or be published immediately.

See Also:

n "Enabling Ektron's SharePoint Connector" on page 19-42
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n "Distributing SharePoint Content to CMS400.NET" on page 19-42

Enabling Ektron's SharePoint Connector
To enable Ektron's SharePoint Connector in Microsoft SharePoint, simply copy the SharePoint_

To_CMS.exe file from C:\Program Files\Ektron\CMS400v80\Utilities to your SharePoint server

and follow the on screen dialog.

If you successfully log in during Step 1of the Publish To CMS400 process, then get a Please

Login message in Step 2, make sure your web browser is configured to accept cookies from the

Ektron CMS400.NET server. For example, if your Sharepoint server is on

sharepoint.company.com, and Ektron CMS400.NET is on cms.company.com, your web browser

must allow cookies from cms.company.com.

If cookies are being blocked, a stop sign symbol appears at the bottom of Internet Explorer

(shown below).

Distributing SharePoint Content to CMS400.NET
Once the SharePoint Connector is setup on a SharePoint server, navigate to a content item and

click the dropdown arrow next to the content's title. A menu appears with the item Publish to

Ektron CMS. Clicking this item starts a simple wizard that publishes the document into your

CMS400.NET site's folder structure and taxonomy-based information architecture. This

information is collected through a series of screens that guide you through the process.

After SharePoint content is distributed to CMS400.NET the first time, the original content is

forever linked to the destination content. You cannot break the link. However, deleting the

destination content in CMS400.NET allows you to select a new folder when you republish the

content from SharePoint.

Note: If you delete the destination content, you will not be able to accesshistory revisionsof the content in

CMS400.NET.

If you want to later revise the document, you would typically edit it in SharePoint and select

the Publish to Ektron CMS option again. When you do, you are asked to confirm replacing

the document in the destination folder. You are not allowed to select another folder.

Prerequisites
When you click the Publish to Ektron CMS menu item, it will check to see if you can log

into CMS400.NET using Active Directory. If so you will be logged in. If not, you will be
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prompted for your username and password. You must have the following permissions:

n Add

n Delete

n Restore Content.

If you do not have these permissions, the folder doesn't appear on the folder selection screen.

Font Manager
As an administrator, you can add, edit, and delete fonts to and from the Ektron CMS400.NET

application. By adding fonts, you are allowing the content contributors to use them when

creating content. Administrators can also edit the name of a font, and delete a font from the

system.

Minimizing the number of available fonts makes the Web site look more uniform.

Below is the Font Manager screen.

Note: Onlymembersof the Administrator User Group can view, add, or edit fonts.

Adding Fonts
To add a font to the application, follow these steps.

1. From the left frame of the Workarea, click Settings > Configuration > Fonts.

2. Click the Add button ( ).

3. The Add Font screen is displayed.
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4. Enter the font name or family into the text field provided.

5. Click the Save button ( .)

The new font is available to use when adding or editing content if the Application Setup

screen’s Enable Font Buttons field is checked. See Also: ”Modifying the Application Setup

Screen” on page 19-1

Viewing Fonts

When viewing fonts, you can also edit or delete them.

To view a font:

1. Access the font manager in your Workarea as described in "Adding Fonts" on page 19-43.

2. Click the font you want to view.

3. The view font screen is displayed.
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Edit Fonts

When you edit a font, the font or family name is changed. Editing does not change any fonts

in existing content.

To edit a font name, follow these steps.

1. Access the view font screen, as described in "Viewing Fonts" on page 19-44.

2. Click the font that you want to edit.

3. Click the Edit button ( ).

4. The Edit Font screen is displayed.

5. Edit the font name or family in the text field specified.

6. When finished, click the Update button ( ).

Delete Fonts

By deleting a font from the system, you are taking away the content contributors’ use of that

font in their content. To delete a font, follow these steps.

1. Access the view font screen, as described in "Viewing Fonts" on page 19-44.

2. Click the font that you want to delete.

3. Click the Delete button ( ).

4. A confirmation message is displayed.

5. Click OK.

6. The screen is refreshed, and the updated fonts table is displayed.

Note: When you delete a font fromEktron CMS400.NET, you do not delete it from your computer.
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The Web Alert feature enables Ektron CMS400.NET to generate email for a list of registered

users whenever new content appears on your site, or existing content is updated.

For example, anyone may register to be notified when new information about your product is

published. As soon as a page is published on your site, registered users receive an email

announcement with a link to the new/updated page. The recipient clicks the link to

immediately access the page.

As a result, a self-selected group of users can be instantly notified of changes on your Web site

relating to their interests. Once the system is set up, you don’t need to do anything --

everything happens in the background.

Note: Onlymembersof the Administrator User Group and users identified on theManageMembers for Role:

Folder User Admin screen can workwithWeb Alerts.

Sample Web Alert email

This chapter explains the Web Alerts feature through the following topics.

n "How Web Alert Works" on page 20-3
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n "Server Configuration" on page 20-4

n "Enabling the Web Alert Feature" on page 20-5

n "Setting Up the Message Queue and Asynchronous Processor" on page 20-6

n "Creating the email Message" on page 20-13

n "Defining Subscriptions" on page 20-18

n "Assigning Web Alert Information to Folders and Content" on page 20-21

n "How Users Sign up for Subscriptions" on page 20-28

See Also: ”Using eSync with Web Alerts” on page 18-129

How Web Alert Works
The following explains how Web Alert email works.

1. Content is published.

2. Ektron CMS400.NET checks the This is a staging server checkbox on the Settings >

Configuration > Setup screen. If it is unchecked, proceed to the next step. If the box is

checked, no Web alerts will be issued for this server.

3. Ektron CMS400.NET checks to see if any subscriptions are assigned to the folder or

content. (Subscriptions can be assigned at the folder or content level.)

If no subscriptions are assigned, the Web Alerts tab does not appear when editing content.

4. If any subscription is assigned, Ektron CMS400.NET checks to see if an email should be

created for this content. The settings appear underWeb Alerts tab.

For example, some content only triggers an email when it is first published, while other

items always generate an email.

5. If an email should be generated, Ektron CMS400.NET builds the email content by

retrieving information from fields on the Folder Properties screen. These are identified

under the Web Alert Contents section of the Web Alerts tab.

6. Ektron CMS400.NET determines which subscription lists should receive the email. These

are identified on the Available Web Alerts area of the Web Alerts tab. Each list contains

the email address of every subscribed user.

HowWeb Alert Works
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Server Configuration
The following illustration depicts a typical Web server configuration you would use with the

Web Alerts feature.

n Firewall - the Ektron CMS400.NET business tier must have Web access to the

asynchronous server. The business tier maintains the CMS files. This configuration enables

proper communication between Ektron CMS400.NET and the asynchronous processor.

- The asynchronous processor must have port 25 (SMTP) access to a valid mail server to

send emails

- The mail server (omitted from the illustration) must be allowed to send out port 25

(SMTP) traffic and can be on the Async server

n Queuing - Message queuing must be installed on the Async server.

You must create a message queue on the Async machine and record its name. The message

queue is specified in the exe.config file for the service, and in the web.config file for the Web

Service interface.

n CMS - The web.config file includes a key for the location of the asynchronous processor.

This needs to be verified as working.

n Other - IIS must be installed on the asynchronous processor. IIS allows a Web service call

to schedule a file download and send commands.

Ektron recommends that the Async machine only allow HTTP traffic from Ektron

CMS400.NET servers. This provides additional security on the Async processor.
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Verifying Connections

n You can verify the Web service > queue connection by

- leaving the Ektron asynchronous processor service off, submitting content with

notifications, and verifying that a message arrived in the queue

- turning on journaling for the queue. Submit a message in the queue. The Ektron

asynchronous processor service picks it up and places it in the journaled messages.

- turning on logging for the Ektron asynchronous processor service

n To verify the CMS > Web service connection, open the asynchronous processor location

inside a Web browser and test the Web services.

To verify the writing of files, ensure that Ektron CMS400.NET has write access to the [site-

path]subscriptions directory and submit content that will trigger notifications. This action

places a file inside that directory.

n To verify that the Ektron asynchronous processor service can download a file, open a Web

browser on the Async machine and connect to the location of the notification command

files. Attempt to download one.

Enabling the Web Alert Feature
Enabling the Web Alert feature involves the following steps.

Step Description
For more

information, see

1. Set upmes-

sage queue

and asyn-

chronous

processor.

"Setting Up the

MessageQueue

and Asynchronous

Processor" on page

20-6

2. Create

messages.

Define components of the email to be sent to

subscribers.

"Creating the email

Message" on page

20-13

3. Define

subscriptions.

Categories of information on your site. Site

visitors can subscribe to be notified when content

in a category is added or updated.

"Defining

Subscriptions" on

page 20-18
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Step Description
For more

information, see

4. AssignWeb

Alert

information to

folders and

content.

AssignWeb Alert information to folders and

content itemswhich, when published, trigger

emails.

For each folder or content item to which you

assign subscriptions, determine

n activities that trigger emails (for example,

only upon initial publication of content)

n the content of the email

n the subscription list(s) to whom the email is

sent

"AssigningWeb

Alert Information to

Folders and

Content" on page

20-21

5. Create and

publish site

visitor

registration

page.

Create a newWeb form and drop the

membership server control onto it. Then, publish

that form on your Web site.

Note: This task is typically done bya developer.

"Membership

Server Control" on

page 16-24

6. Site visitors

subscribe to

lists of

interest.

Someone signsup to be notified when changes

in a selected subscription (category) are

published on your Web site.

"How UsersSign up

for Subscriptions"

on page 20-28

7. CMSusers

can also

subscribe.

"CMSUser

Subscription Sign

Up" on page 20-32

8. Subscribers

are

automatically

notified when

content is

updated.

Web content is either first published or updated.

If at least one subscription is assigned to the

content or its folder, email is sent according to

pre-defined criteria for the folder.

Setting Up the Message Queue and
Asynchronous Processor
After installing Ektron CMS400.NET version 5.1 or higher, you need to set up the Microsoft

Message Queuing and the Ektron Asynchronous Processor. It is assumed that the following

directories and files are installed on your server:

n C:\Program Files\Ektron\CMS400versionnumber\EktronAsyncProcessor_Service\

n C:\inetpub\wwwroot\your site root\bin\EktronAsyncProcessorWS.dll

WebAlert Feature
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n C:\inetpub\wwwroot\your site root\Workarea\webservices\EktronAsyncProcessorWS.asmx

Note: If you need tomoveWeb services file, use theAsynchronous Processor Location field in the

Configuration >Setup screen to specify the new folder location.

1. On the server that hosts Ektron CMS400.NET, go to Control Panel > Add/Remove

programs > Add/Remove Windows Components.

2. If it is not checked, check Message Queuing Services.

Note: OnWindows2003, it iswithin the Application Server Componentsgroup.

3. IfMessage Queuing Services was checked when you viewed it, go to step 4.

If it was not checked, click Next. A wizard creates the component.

Note: The rest of this procedure employsa wizard that saves you severalmanual steps. If you have a problem

using the wizard, or prefer to installWeb Alertsmanually so you can track the files being installed to your server, see

"ManualSteps for Setting up theMessageQueue and AsynchronousProcessor" on page 20-10.

4. From the Windows Start Menu, click All Programs > Ektron > CMS400 > Utilities >

Web Alerts Setup.

5. The Web Alert Wizard setup screen appears.
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6. Press Next. The wizard begins installing the Web Alerts feature.

7. The following screen appears.
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8. Enter the username and password that will be used to send and receive email.

9. At the Log File Name field, enter the name of the file that will track Web Alert activities.

If you enter nothing, the file is named listener.log.

The file resides in the C:\Program

Files\Ektron\CMS400versionnumber\EktronAsyncProcessor_Service folder. It is also

available from the Workarea. See "Asynchronous Log File Reporting" on page 20-13.

10. If you want a very detailed log file, click Logfile Verbose.

11. Press Next. The following screen appears.
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12. Either insert or browse to the folder that contains your web.config file. This is your site

root folder. Then press Next.

13. If your Asynchronous Processor service is not running, the following message appears.

14. If you see this message, press OK then click Finish.

15. Go to Control Panel > Administrative Tools > Computer Management > Services and

Applications > Services. Start the Ektron Async Processor Service.

Manual Steps for Setting up the Message Queue and
Asynchronous Processor
This section describes manual steps for setting up the Message Queue and Asynchronous

Processor. You can use this procedure if you had a problem using the wizard, or you want to

know which files are being installed to your server.

1. Go to Control Panel > Administrative Tools > Computer Management > Services and

Applications > Message Queuing.

2. Right click the Private Queues folder and select New > Private Queue.
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3. Create a private queue named msmq_web.

4. Right click msmq_web and select Properties.

5. Go to the Security tab. You can give the Everyone group Full Control if you are in a

testing environment. If you are on a production server or want better security, give the

local system account (the account which the EktronAsyncProcessor Service runs as) the

following permissions:

Setting Up theMessageQueue and Asynchronous
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n Delete

n Receive Message

n Peek Message

n Send Message

Give the ASP.NET account (the account that the Web services interface runs as) Send

Message permission.

6. Click OK.

7. Open the following file:
C:\Program Files\Ektron\CMS400v52\EktronAsyncProcessor_

Service\RegEktron.Services.EktronAsyncProcessor.bat

8. Review and update as necessary the paths to the .NET directory and

Ektron.Services.EktronAsyncProcessor.exe file.

Warning! Update the paths to the .NET Directory and the .exe file if necessary.

9. Execute the .bat file.

Or, from a command line or Start Menu > Run, enter:

C:\Windows\Microsoft.NET\Framework\v2.0.50727\installutil “C:\program
Files\Ektron\CMS400v80\EktronAsyncProcessor_

Service\Ektron.Services.EktronAsyncProcessor.exe”

10. Open the following file and enter your SMTP connection settings: C:\Program
Files\Ektron\CMS400v80\EktronAsyncProcessor_

Service\Ektron.Services.EktronAsyncProcessor.exe.config.

11. Go to Control Panel > Administrative Tools > Computer Management > Services and

Applications > Services. Start the Ektron Async Processor Service.
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Asynchronous Log File Reporting

Once the Message Queuing and Asynchronous Process are set up and running, you can access

a log report about the Asynchronous process. This report shows any problems with the

Asynchronous Processor.

In addition to viewing the report, you can email it to any CMS400.NET user. See "Emailing

Reports" on page 7-708.

To access the Asynchronous Process log, follow these steps.

1. From the Workarea’s Smart Desktop, click Reports.

2. Click Contents > Asynchronous Log File Report.

3. Any problems appear on the screen.

Creating the email Message
This section has the following topics.

n "Predefining Message Components" on page 20-14

n "Combining Message Components to Create the Message" on page 20-16

n "Previewing the email Message" on page 20-17
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Predefining Message Components
Before you can create an email message, define the following information.

n default message text

n opt out message

n unsubscribe message

n “from” address

You can define as many as you want of each item. You must, however, define at least one opt-

out message, unsubscribe message, and “from” address to use the Web Alert feature.

These message components are later inserted into an email message that is sent to your

subscribers. See Also: "Creating the email Message" on page 20-13

Creating Default Message Text
You can create one or more default messages to contain the text of the email. A simple editor

lets you apply some XHTML formatting the message.

Including Variables in the Default Message

The default message can include variables that retrieve information about the content and

display it in the message text. The variables are surrounded by at signs (@). For example

The following content was recently updated: @AppContentLink@

In the email, this text might read:

The following content was recently updated: The Effect of Coumadin on Cardiac Patients

You can use the following variables in the body of a Web Alert message.

Variable Displays this information in the email

@appContentTitle@ The title of the content block.

@appCRLF@ Acarriage return. Moves the text down one line.

@appContentLink@
The link to the content blockon theWeb site.

Note: Youmust be logged in to see the changes.

@appContentURL@ TheURL of the content, from the quicklink and domain.
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Variable Displays this information in the email

@appSubscriptionNames@ Comma separated list of subscriptions that a user selected.

@appComment@ The comments for the content block.

@appSubmitterFirstName@ The first name of the user who submitted the content block.

@appSubmitterLastName@ The last name of the user who submitted the content block.

To create default message text, follow these steps.

1. In the Workarea, go to Settings > Configuration > Web Alerts > Messages.

2. Click the Add button ( ).

3. Enter a title that describes the message.

4. At the Type field, select DefaultMessage.

5. In the editor, enter the message text.

6. Click the Save button ( ).

Creating Opt Out Message Text
An Opt-Out message appears as the first line of every email. It directs the reader to the

Unsubscribe message at the bottom. Here is an example:

You have subscribed to receive alerts from the Ektron CMS400.NET email alert system. See

below for removal instructions.

You can add variables to the Opt Out text. See Also: "Including Variables in the Default

Message" on page 20-14

To create Opt-Out message text, follow these steps.

1. Go to Settings > Configuration > Web Alerts > Messages.

2. Click the Add button ( ).

3. Enter a title that describes the Opt-Out message.

4. At the Type field, select OptOut.

5. In the editor, enter the message text.

6. Click the Save button ( ).
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Creating Unsubscribe Message Text
An Unsubscribe message lets the person receiving the email remove himself from the

subscription list.

You can add variables to the Unsubscribe text. See Also: "Including Variables in the Default

Message" on page 20-14

To create Unsubscribe message text, follow these steps.

1. Go to Settings > Configuration > Web Alerts > Messages.

2. Click the Add button ( ).

3. Enter a title that describes the Unsubscribe message.

4. At the Type field, select Unsubscribe.

5. In the editor, enter the message text.

6. Click the Save button ( ).

Creating “From” Addresses

Any email generated by the Web Alert feature must have a “from” address. To create one or

more “from” addresses, follow these steps.

1. Go to Settings > Configuration > Web Alerts > Email From List.

2. Click the Add button ( ).

3. Enter an email address that will be used in the From field of messages generated by the

Web Alert feature.

4. Click the Save button ( ).

Combining Message Components to Create the
Message
You create the content of an email message by configuring the following components. Some

are required. Then, when content is published, Ektron CMS400.NET retrieves the field values

to create the email Web Alert.

Note: If you reached this screen while creating an eCommercemessage, see ”Messages” on page 17-103.

Note: To set or modify this information, youmust have permission to edit the folder.
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Component Comment Required?

1. Subject line
Plain text you enter on theWeb Alerts tab of the Folder

Properties screen
No

2. From

address
See "Creating “From” Addresses" on page 20-16 Yes

3. Opt out

message
See "Creating Opt Out Message Text" on page 20-15 Yes

4. Default

message
See "Creating Default Message Text" on page 20-14 No

5. Content

Summary

The Summaryof the content itemwhose creation or change

generates the email.

Note: The Summary can include variables that retrieve

information about the content item. See "Including Variables

in the Default Message" on page 20-14

No

6. AnyCMS

content item

IdentifyCMS content to include within the email content.

n To identify an existing content item, clickSelect next to

theUse Content checkbox. Then, navigate to the content

item.

Note: If the content item is anOffice document or a

managed file, a link to that item appearswithin the email

message, not the item itself.

n To insert this content item (that is, the one whose cre-

ation or change triggers thisWeb Alert), clickUse Current.

n To create a new content block to insert into thismes-

sage, clickSelect next to theUse Content checkbox.

When the folder navigation window appears, click the Add

Content button ( ). Then, see "Adding HTMLContent"
on page 7-15.

No

7. Unsubscribe

message
See "Creating UnsubscribeMessage Text" on page 20-16 Yes

The elements appear within the email in the sequence shown above.

Previewing the email Message
You can preview the email message at any time by clicking the preview button, which appears

to the right of the Web Alert Contents: label on the Web Alerts tab (see below).
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The button appears on the Web Alerts tab for folders as well as content.

When you click the preview button, a new window displays the body of the email message.

(The components used in an email message are listed in "Combining Message Components to

Create the Message" on page 20-16.)

After previewing the message, you can change any message components and click the button

again to review the updated message. You don’t need to save or check in the content to update

the preview.

Defining Subscriptions
Create a subscription for each type of information site visitors might want to be notified about.

For example, if your site sells electronics, you could set up one subscription for televisions,

another for computers, and a third for stereo equipment. Site visitors can then subscribe to

appropriate areas of interest.

CMS and membership users can also sign up for subscriptions.

See Also: "Server Configuration" on page 20-4

To create one or more subscriptions, follow these steps.
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1. Go to Settings > Configuration > Web Alerts > Subscriptions.

2. Click the Add Subscription button ( ).

3. Enter a name for the subscription. The name should indicate the kind of information that it

will cover.

4. Use the Enabled check box to indicate if the subscription is currently active.

5. Press the Save button ( ).

Effect on Custom User Properties

When you create the first subscription, a new entry is automatically created in the Custom

User Properties screen. By default, its name is Subscriptions, and its type is Category. This

occurs because all custom user properties appear on the Site Visitor Registration screen. In this

way, users visiting that page can select areas of interest about which to be notified when

content is updated.

The default name (Subscriptions) appears on the Site Visitor Registration screen. You may

want to change it to something more helpful, such as Select Areas of Interest. To do this,

select the Subscriptions entry and edit the Label field in the Custom User Properties screen.

The following graphic illustrates the relationship among the Subscriptions, Custom Properties,

and Site Visitor Registration screens.

Defining Subscriptions

ReferenceManual

Version 8.0 Rev 1.3
20-19



If you add more subscriptions later, they have no effect on the Subscriptions entry in the

Custom User Properties screen -- that single entry covers all subscriptions.

Using Subscriptions in a Multi-Language System

When you create a subscription, a version of it is created for every enabled language in your

system. You can edit the subscription name and Enabled values for any language but the ID

number cannot be changed.

WebAlert Feature

20-20
ReferenceManual

Version 8.0 Rev 1.3



To translate any subscription, follow these steps.

1. Go to Settings > Configuration > Subscriptions.

2. From the View Languages dropdown list, select the language into which you want to

translate the subscription.

3. Click the subscription that you want to translate.

4. Click the Edit button ( ).

5. Enter the translation for the subscription name. If desired, you can check or uncheck the

Enabled checkbox. Only enabled subscriptions appear on the Site Visitor Registration

screen.

6. Click the Save button ( ).

Assigning Web Alert Information to
Folders and Content
After creating predefined messages (as explained in "Predefining Message Components" on

page 20-14) and subscriptions (as explained in "Assigning Web Alert Information to Folders

and Content" on page 20-21), you need to identify which folders include content that, when

updated, trigger a Web Alert. For example, new product announcements are placed in the

Marketing folder.

Note: In order to set or modifyWeb Alert information, youmust have permission to edit the folder.

For each folder, you can assign the following kinds of message information.

n whether Web Alert information is inherited from a parent folder or customized

n whether a folder’s Web Alert information is inherited by all content items in the folder

n when email is sent: always, only on initial publication, or never

n the content of the Web Alert email

n the subscriptions assigned to the folder. These determine which recipients receive email

when content in this folder is created or updated.

Customizing Web Alert Information for a Folder

Like other folder-level information in Ektron CMS400.NET, Web Alert information is

inherited from a parent folder. By default, all folders inherit these settings from the root

(Content) folder.
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However, inheritance can be broken and customized at any folder level or even the content

level. Breaking inheritance means that custom settings can be made at any folder level.

Subsequent changes to Web Alert settings at the parent level are ignored.

See Also: "Assigning Web Alert Information to Content" on page 20-25

To view, enter, or modify folder-level Web Alert information, follow these steps.

1. Navigate to the folder whose Web Alert information you want to edit.

2. Click View > Properties.

3. Click the Web Alerts tab.

4. Scroll down to view the Web Alert options.
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5. To change any value, click the Edit Properties button ( ).

6. The following table describes the fields.

Web Alert Fields
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Field

Group
Description

WebAlert

Settings:

Break

Inheritance

To inherit Web Alert settings (described below) from this folder’s parent folder,

leave this box (Break Inheritance) empty.

To assign customWeb Alert settings for this folder, check this boxand use the

fields below to customize the settings.

Web Alert

Options

CheckwhenWebAlert emails are sent as content in this folder is published.

n Notify Always - send emailwhenever any content is published. It doesn’t

matter if the content is being published for the first time or being updated.

n Notify only on Initial Publication - send email the first time content is

published. After that, email is not sent.

n Notify Never - email is never sent for content in this folder.

Web Alert

Subject
Enter the subject line of the email.

Web Alert

email From

Address

Select the addressof the person fromwhom the emailwill be sent. See Also:

"Creating “From” Addresses" on page 20-16

Web Alert

Contents

Checkanyor all of the following components to determine the text of the email.

See Also: "CombiningMessage Components to Create theMessage" on page

20-16

n OptOut Message - see "Creating Opt Out Message Text" on page 20-15

n UseDefault message - see "Creating Default Message Text" on page 20-14

n Use Summary - include the content summary in the email

n UseContent - see "AnyCMScontent item" on page 20-17

n Unsubscribemessage - See "Creating UnsubscribeMessage Text" on

page 20-16

The components appearswithin the email in the order listed above.

Available

Web Alerts

All enabled subscriptions set up in the Subscriptions screen appear. Check those

to be notified when content in this folder is added or updated.

See Also: "AssigningWeb Alert Information to Folders and Content" on page 20-

21

Note: If you uncheckall subscriptions, you disable theWeb Alert feature for this

folder and all of its content. This applies even if unique subscription information

hasbeen assigned to content itemswithin the folder.
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Assigning Web Alert Information to Content

You can customize Web Alert settings for any content item. If you do, you break the

inheritance from its folder. This means that any subsequent changes to the folder settings do

not affect the content’s Web Alert settings. From then on, its settings are independent of the

folder’s settings.

See Also: "Server Configuration" on page 20-4

Exception!

Warning! If all subscriptionsare unchecked for a folder, theWeb Alert feature is disabled for all content in the

folder. This applies even if uniqueWeb Alert information hasbeen assigned to content.

To customize the Web Alert settings for any content item, follow these steps.

1. Navigate to the folder that contains the content.

2. Click the content. The View Content screen appears.

3. Click the Edit button ( ).

4. Click the Web Alerts tab.

Note: TheWeb Alerts tab only appears if requiredmessages, “from” email addresses, and at least one

subscription are assigned to the content’s folder.

5. The Web Alert settings for the content appear.
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The following table describes the settings.
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Field

Group
Description

Web

Alert

Options

CheckwhenWebAlert emails are sent as this content is published.

n Notify Always - send emailwhenever content is published. It doesn’t matter if

the content is being published for the first time or being updated.

n Suspend Next Notification (override) - Check this box if you want to sus-

pend the next email to be sent for this content. Youmight use this feature is you

notice a small error in the content and don’t want to notify all subscribers that the

page wasupdated.

Warning! Important! - This setting only applies until the next time this con-

tent is published.When that happens, this box is automatically unchecked.

n Notify only on Initial Publication - send email the first time content is pub-

lished. After that, email is not sent.

n Send Next Notification (override) - Send an email to all subscribers the

next time this content is published. Use this checkbox to send a one-timemailing to

all subscribers about content that hasalreadybeen published.

Warning! Important! - This setting only applies until the next time this con-

tent is published.When that happens, this box is automatically unchecked.

n Notify Never - email is never sent when content in this folder is published.

Web

Alert

Subject

Same as for a content folder. See "Web Alert Subject" on page 20-24

Web

Alert

email

From

Address

Same as for a content folder. See "Web Alert email FromAddress" on page 20-24

Web

Alert

Contents

Same as for a content folder. See "Web Alert Contents" on page 20-24

Available

Web

Alerts

OnlyWeb Alerts assigned to the folder appear. Checkones that you want to assign

to this content item. For more information, see "AvailableWeb Alerts" on page 20-

24.
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Inheriting Content-Level Web Alert Information from Its
Folder
If you customized Web Alert information for content items and later decide to standardize that

information for all content in a folder, use the Restore Web Alert Inheritance toolbar button (

).

This button copies folder-level Web Alert information to every content item in the folder,

replacing whatever content-level information exists. In this way, all content in a folder will

have the same Web Alert information.

How Content that is Dragged and Dropped is Handled

Web Alert emails are not generated for files that are dragged and dropped into Ektron

CMS400.NET and immediately published. To generate email for these files, you must manually

publish them.

Like HTML content, these files must reside in a folder for which the Web Alert feature is

enabled.

How Users Sign up for Subscriptions
Once subscriptions are set up, you create a page on your Web site to let site visitors subscribe

to areas of interest. An example of that page is below.

Note: The email address collected on the screen is used for themembershipUsername field.
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To place this form on a Web page, your developer inserts a Membership Server Control. See

Also: ”Membership Server Control” on page 16-30

Any user who subscribes via the above screen becomes an Ektron CMS400.NET membership

user, and is automatically added to the All Members user group. For more information, see

”Membership Users and Groups” on page 16-3.

What happens next depends on the Enable Verify email check box in the Application Setup

screen (shown below).

This topic is explained through the following subtopics.

n "What Happens if Verification email is Not Used" on page 20-29

n "What Happens if Verification email is Used" on page 20-30

n "Setting up Other Web Pages for Site Visitor" on page 20-32

n "CMS User Subscription Sign Up" on page 20-32

What Happens if Verification email is Not Used
If the Enable Verify email checkbox is not checked, everyone who signs up automatically

becomes a membership user.
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What Happens if Verification email is Used

Warning! When using the Checkout Server Control on an eCommerce site, the Enable Verify Email setting

must be unchecked. Otherwise, new userswill receive an error message when they sign-up using this control. See

Also: ”Checkout Server Control” on page 17-21

Typically, when managing a self-subscribe list, you want new users to confirm their interest in

being on the list. This prevents people from being subscribed by someone else without their

permission.

If the Enable Verify email checkbox is checked, everyone who signs up is placed on the Users

Not Verified list. (To see this list, go to Workarea > Settings > Community Management >

Memberships > Users Not Verified.)

These people then receive an email. You define the content of this email in Workarea >

Settings > Community Management > Messages. The email should direct the unverified user

to a new Web page that asks him to confirm his interest in signing up for the subscription. (See

"The Verification Message" on page 20-30.) New users are activated when the subscriber

confirms his interest.

To create such a page, your Web developer creates or updates a Web Form using the

Membership Server Control. For this purpose, set the control’s DisplayMode property to

AccountActivate.

Note: Users can also bemanually activated or removed via the View Not Verified Users screen. For more

information, see "The View Not Verified UsersScreen" on page 20-31.

The Verification Message
By default, Ektron CMS400.NET supplies a generic message asking the user to confirm his

password and directing him to the acitvatemyaccount.aspx page on your Web site. If you want

to customize that message, follow these steps.

1. Go to Workarea > Settings > Community Management > Messages.

2. Click the Add button ( ).

3. Assign a title to the message, such as Verification Message.

4. Click to place a check mark in the Default box.

5. Enter the text of the confirmation message you want the subscriber to receive. Be sure to

place the @appQueryLink@ variable in the message to create a link to the confirmation page.

For example:
Welcome to example.com. You have registered to be notified of updates to our site.
Before we can do this, you need to activate your account. To do so, please visit

@appQueryLink@.
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The @appQueryLink@ variable places a link in the message that gets resolved as follows:

http://sitepath/workarea/activateuser.aspx?uid=[username]&acc=[accountID]

For example:

http://ww-

w.example.com/Workarea/activateuser.aspx?uid=john.edit@example.com&acc=ce5w84o936477

If you want the message to include the user’s name and email address, use the following

variables to retrieve that information:

n name - @appEmail@

n email address - @appActivateId@

For example:

Your user name is @appEmail@.

Your account id is @appActivateId@

The View Not Verified Users Screen
All users who have signed up for a subscription but who have not yet verified that

subscription appear on the View Not Verified Users Screen. This screen is available via

Settings > Community Management > Memberships > Users not Verified.

After viewing membership users on the screen, you can manually activate their account. To do

so, selecting one or more users then click the Activate button ( ). Alternatively, you can

delete members by selecting one or more and clicking the Delete button ( ).

Note: The ek_PageSize setting in the web.config file determines themaximum number of users that can appear

on a page before it “breaks.” When a page breaks, additional entriesappear on another screen, and the following

text appearsnear the bottom of the list:

Page 1 of 2[First Page] [Previous Page] [Next Page] [Last Page]

To select all members, click the check box in the header line, next to Username (circled

below).

You can also change the way membership users are sorted, or use the Search button to find

users that match your criteria (for example, users whose username includes example.com.)

These features are explained in ”Sorting Membership Users” on page 16-11 and ”Searching for

Membership Users” on page 16-11.

How Users Sign up for Subscriptions

ReferenceManual

Version 8.0 Rev 1.3
20-31

#
#
#
#
#
#
#
#
#
#
#
#
#
#
#


Setting up Other Web Pages for Site Visitor
You can set up other Web pages that let the subscriber perform the following actions:

n Activate their account

n Reset their password

n Unsubscribe

To create these pages on your web site, place the membership server control on the page. Then

use the control’s DisplayMode property to determine the kind of screen you want to place. For

example, to create a screen that lets the user reset his password, set the Membership server

control’s DisplayMode property to ResetPassword.

For more information, see ”Membership Server Control” on page 16-30.

CMS User Subscription Sign Up
CMS users can also subscribe to any subscription list. This would be particularly useful on an

intranet where, for example, employees are notified when job-related information is updated.

Another example would be for your internet site. The manager of the Marketing Department

could sign up to be notified whenever Marketing content is added or updated.

To do so, users go to Settings > Users > Edit User > Custom tab (see illustration).
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Introduction to Ektron CMS400.NET
Server Controls
Ektron CMS400.NET provides an extensive list of server controls that can be dragged and

dropped onto any ASPX page to coexist with other components. This includes control for

everything from content to user management to breadcrumbs to social network controls, all in

order to provide out-of-the-box markup and functionality.

With Ektron’s server controls there is a great deal of flexibility. In addition to having a set of

properties that can be used to change the controls' output and behavior, developers can access

the Server Control API. See Ektron’s CMS400.NET API Reference Manual for information on

the Server Controls API.

Ektron CMS400.NET’s server controls let you insert many standard methods and properties

within the Visual Studio environment. This means that you can see the effect of your changes

in real time -- you don’t have to modify a page then compile a sample project to see the results.

You can insert server controls using drag and drop or programmatically. You can also use

databinding to retrieve and display data from Ektron CMS400.NET. This chapter explains the

use of the Ektron CMS400 Server Controls through the following topics.

n "Opening the Sample Project" on page 21-3

n "Setting Up a Template" on page 21-4

n "Making the Server Controls Available" on page 21-5

n "Inserting Server Controls Using Drag and Drop" on page 21-6

n "Inserting Server Controls Programmatically" on page 21-10

n Using Drag & Drop and Programmatically Together

n "Data Binding with Server Controls" on page 21-25

n "Caching with Server Controls" on page 21-31

n "Using Ajax Enabled Server Controls and Custom Code" on page 21-36

n "List of Server Controls" on page 21-38

Additional information and examples for Ektron Server Controls are available online after you

install the Developer sample site. Here is the path:

http://localhost/CMS400Developer/Default.aspx

Replace localhost with the webroot where you installed the Developer site.
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Opening the Sample Project
To help get you started, these directions explain how to open the sample site delivered with

Ektron CMS400.NET.

1. Browse to and double click Ektron CMS400.NET‘s solution file,

localhost/siteroot/CMS400Developer.sln.

2. The sample site project opens.

3. To work on a template page, click it from the Solution Explorer.

When you select a page, its properties appear in the Properties area (below Solution Explorer),

and the page appears in the center of the screen. A control’s properties include several standard

.NET properties along with Ektron-specific ones. The Ektron properties are labeled as

illustrated below.
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Setting Up a Template
To create a new template (.aspx) page, follow these steps.

1. Click Project > Add Web Form.

2. On the Add New Item screen, click Web Form and assign a name.

Developer Topics

21-4
ReferenceManual

Version 8.0 Rev 1.3



3. Add controls to determine the page content.

Making the Server Controls Available

Note: Youmust copy the dlls to a local drive before installing them. You cannot copy them from a networkdrive.

1. Display the Visual Studio toolbox (View > Toolbox).

2. Right click the mouse within the Toolbox.

3. Click Add Tab.

4. Type Ektron Server Controls then press enter.

5. Click the Ektron Server Controls Tab.

6. Right click the mouse in the empty area.

7. Click Add/Remove Items. If using Visual Studio, click Choose Items.

8. The Customize Toolbox dialog appears.

9. Select the .NET Framework Components tab.

10. Browse to the directory that stores Ektron CMS400.NET‘s dll files,

localhost/CMS400Developer/bin, and add the Ektron.Cms.Controls.dll file. This file

provides access to Ektron CMS400.NET’s server controls.
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Alternatively, you could use the following location, C:\Program

Files\Ektron\CMS400v8x\bin. The file is identical in both places.

Using the bin folder in your site provides better speed when loading Web pages. However,

if you use the bin folder located in Program Files, you do not have to worry about deleting

the .dll file if you change or delete your site.

11. Click OK.

For easier viewing once the server controls are installed, you can right click on them and select

Sort Items Alphabetically. Note that you can only see the server controls when an aspx

template is selected.

Removing the Server Controls
1. Display the Visual Studio toolbox (View > Toolbox).

2. Right click the mouse within the Toolbox.

3. Click Add/Remove Items. If using Visual Studio, click Choose Items.

4. Click Namespace or Assembly Name to sort the Server Controls by manufacturer.

5. Uncheck all boxes that are Ektron.Cms.Controls.

6. Click OK.

7. Right click the Ektron Server Control tab.

8. Click Delete Tab to remove it.

Updating the Server Controls
To update the server controls you must first remove the existing server controls in Visual

Studio, then add the new server controls.

For information on removing server controls, see "Removing the Server Controls" on page 21-6

For information on adding server controls, see "Making the Server Controls Available" on page

21-5

Inserting Server Controls Using Drag and Drop
Because Visual Studio is a visual environment, you can watch the page layout change as you

add or move a control and adjust its properties. And, whenever you need to identify an Ektron

CMS400.NET object (such as content block or collection), you can use the CMS Explorer to

visually browse to and select it.

Adding a Server Control to a Template
1. Display the Visual Studio toolbox (View > Toolbox).

2. Click the Ektron Server Control tab. The Ektron CMS400.NET’s server controls appear.
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3. Drag a server control and drop it into the desired location on the page.

4. As desired, modify the control’s properties using the Properties area of Visual Studio.
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For a description of server control properties, see "List of Server Controls" on page 21-38.

ServerControlWS.asmx

Best Practice

For improved security, Ektron recommends renaming or removing theWeb services

file when youmove it to your production server. After installation, this file is named

ServerControlWS.asmxand resides in the /siteroot/Workarea/ folder in your Web

root.

ServerControlWS.asmx is the Web service that lets the server controls talk to Ektron

CMS400.NET. The path is coded in the web.config file. This is how it appears:

<!-- Web Service URL for Server Controls design time --> <add key="WSPath"

value="http://localhost/siteroot/Workarea/ServerControlWS.asmx" />

You will need to edit this line if you change the location or name of the

ServerControlWS.asmx file.
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Using CMS Explorer to Browse Your Ektron CMS400.NET
Site
Ektron CMS400.NET provides a window (called the CMS Explorer) that lets you browse

through your Web site to identify CMS objects such as folders, calendars, blogs and content

blocks. For example, if you insert a List Summary Server Control, its FolderID property

identifies the folder whose contents are displayed. If you are not sure of the folder path, click

the gray button.

When you do, a login screen appears (illustrated below).

Note: Auser cannot be logged into the CMSExplorer and the CMS400.NETWorkarea at the same time. If you

log into the CMSExplorer while logged into theWorkarea, you will receive the following error when you try to use

theWorkarea: Error: The current user doesnot have permission to carry out this request [CBR R31]. If you log into

theWorkarea while logged into the CMSExplorer, you will need to re-login to the CMSExplorer when you return to

using it.

Enter your Ektron CMS400.NET username and password. When you do, the CMS Explorer

window appears, providing a visual way to browse your Ektron CMS400.NET Web site.
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Navigate through the folders, select an object, then click the Select button. The selected object

is pasted to the server control property.

Note: Although you see the object in the selected language in VisualStudio, the language is not stored. For

example, if you select a German content blockwhose ID=2, Ektron CMS400.NET only stores content block

ID=2. When a visitor to your site browses to that page, the content blockdoesnot appear in the selected language.

Instead, it is determined bya cookie or the user’s language selection.

Build the Project
After you open the solution file in Visual Studio and add the required files, build the project.

This may take a while the first time you do so. After the project is built, a browser opens and it

is displayed as a Web page.

You can also view a Web page while working on it by right clicking on the Web form and

clicking View in Browser.

Inserting Server Controls
Programmatically
Besides using the drag-and-drop method to insert a server control (explained in "Inserting

Server Controls Using Drag and Drop" on page 21-6), you can insert one programmatically.

You might prefer to insert server controls programmatically for several reasons, such as

n you want the control to be loaded into memory only under certain conditions. In this case,

insert the logic that only displays the control if the condition exists.

n you want to display only certain properties of an object, such as the title of last edited date

of a content block.

Developer Topics

21-10
ReferenceManual

Version 8.0 Rev 1.3



Note that you can drag and drop controls on your page then customize them using code

behind. For more information, see:Using Drag & Drop and Programmatically Together.

The following sections explain how to use the server controls programmatically.

n "Steps to Insert a Server Control Programmatically" on page 21-11

n "Server Control Properties in Code Behind" on page 21-14

n "Customizing Server Controls" on page 21-23

Steps to Insert a Server Control Programmatically
To insert an Ektron server control programmatically, follow these steps.

"Step 1: Declare the Namespace " on page 21-11

"Step 2: Create an Instance of the New Control" on page 21-12

"Step 3: Set the Properties" on page 21-12

"Step 4: Call the Fill Method" on page 21-13

"Step 5: Use .text Property to Display the Control" on page 21-13

Each step is described below. These steps show an example of using the Collection Server

Control.

Step 1: Declare the Namespace
Before inserting the server control, you can declare the namespace at the top of the code

behind Visual Basic file, as shown below.

Note: You do not need to declare a namespace. However if you do not, youmust fully qualify objects that you

create.
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Best Practice

For any customization of the CMS, classesor controls that inherit from Ektron

classes, it is recommend that you create your own namespace within

'Ektron.Cms.Custom'. For example, if your company is 'AcmeExampleTech, Inc.' you

should create all of your custom classeswithin the namespace

'Ektron.Cms.Custom.AcmeExampleTech'.

Step 2: Create an Instance of the New Control
Next, declare a control as an object in the code behind. In this example, we create a collection

named MyColl.

dim MyColl as New Collection

or

dim MyColl as new Ektron.Cms.Controls.Collection

With C#, use this syntax.

Ektron.Cms.Controls.Collection MyColl = new
Ektron.Cms.Controls.Collection();

You can declare any server control as an object by using the server control name in the "List of

Server Controls" on page 21-38. Another example would be: Dim MyMdl as New

MetaDataList.

Step 3: Set the Properties

Note: For descriptionsof the propertiesand how to use them, see "Server ControlProperties in Code Behind" on

page 21-14.

After inserting the control, you can set the properties that you want to display on the page. For

example:

Dim MyColl as New Collection
MyColl.DefaultCollectionID = 4

MyColl.Page = Page

or if you are using code behind to insert the control,

dim MyColl as new Ektron.Cms.Controls.Collection
MyColl.DefaultCollectionID = 4
MyColl.ID = “Collection1”
MyColl.Page = Page

With C#, use this syntax.
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Ektron.Cms.Controls.Collection MyColl = new
Ektron.Cms.Controls.Collection();
MyColl.DefaultCollectionID = 4;
MyColl.ID = “Collection1”;
MyColl.Page = Page;

These lines tell the page to display CollectionID 1 unless otherwise specified.

Warning! When using code behind to add a server control to your Web form, youmust set the Page object for the

server control to Page. For example, Mycoll.Page = Page This line needs to appear between Dim new server

control line and the Fill() line. This line is not added when dragging and dropping a server control on aWeb form.

See Also: "Referencing the Page Property" on page 21-22.

Note: If you do not know an object’s ID number, you can switch to Designmode, drag and drop the object, then

use the CMSExplorer to find the ID number. (See "Using CMSExplorer to Browse Your Ektron CMS400.NET

Site" on page 21-9.) If you do this, remember to delete the dropped object when you are done.

You can also obtain the ID number via theWorkarea.

Dim MyColl as New Collection
MyColl.ID = “Collection1”
MyColl.DefaultCollectionID = 4
MyColl.Page = Page

 MyColl.Random = True

This line sets the Random property to true. See Also: "Random" on page 9-275.

Step 4: Call the Fill Method
Because there is no render event when using objects as components not as controls, use the

Fill method to fill an object’s properties on the page. An example is below.

Dim MyColl as New Collection
MyColl.ID = “Collection1”
MyColl.DefaultCollectionID = 4
MyColl.Page = Page
MyColl.Random = True

 MyColl.Fill()

Step 5: Use .text Property to Display the Control
Finally, use the .text property to determine what appears on the Web page. For example, to

display the first item in a collection, use this syntax.

Note: Before adding this line you need to drag and drop a label on your Web form.

Dim MyColl as New Collection
MyColl.ID = “Collection1”
MyColl.DefaultCollectionID = 4
MyColl.Page = Page
MyColl.Random = True
MyColl.Fill()
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Label1.Text = myColl.EkItems(0).Title

To display all items in a collection, use this syntax.

 Dim myColl As New Ektron.Cms.Controls.Collection
 Dim ekitem As New Ektron.Cms.Common.ContentBase
 MyColl.DefaultCollectionID = 2
 MyColl.ID = “Collection1”
 MyColl.Page = Page
 MyColl.Fill()
 Label1.Text = "<ul>"
 For Each ekitem In myColl.EkItems

 Label1.Text &= "<li><a href=""" & ekitem.QuickLink & """>" & ekitem.Title &

"</a>"
 Next
 Label1.Text &= "</ul>"

This example displays the quick link for every content block in the collection, formatted as a

bulleted list. You can use similar code to display a List Summary or search results. The

following explains the new (red) code above.

n label1.Text = "<ul>" displays the opening tag for the bulleted list

n For Each ekitem In myColl.EkItems creates a loop for all content blocks in the collection

n label1.Text &= "<li><a href=" & ekitem.QuickLink & ">" & ekitem.Title & "</a></li>"

for each content block in the collection, displays its quicklink and title

n Next loops through all content blocks in the collection

n label1.Text &= "</ul>" closes the bulleted list

Server Control Properties in Code Behind
Every server control has properties associated with it that you can only access

programmatically. This subsection explains, what they are, how to access them, and how to use

them.

n "Displaying Properties for a Control" on page 21-14

n "Mutual Server Control Properties in Code Behind" on page 21-15

n "Accessing Additional Properties" on page 21-17

n "Accessing Items in an Array" on page 21-22

n "Referencing the Page Property" on page 21-22

Displaying Properties for a Control
You can use Visual Studio’s intellisense feature to display a control’s properties. The

intellisense box appears as soon as you insert the period (.) after the object, as illustrated

below.
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The intellisense box displays all properties that can be applied. For a description of Ektron’s

standard server control properties, see"List of Server Controls" on page 21-38. To learn about

native VS properties, see its documentation.

The property’s tooltip text indicates its type. In the above example, you can see that the

DefaultCollectionID’s type is integer.

For more information about accessing Ektron CMS400.NET object properties, see

"Customizing the Server Control in the Code Behind" on page 21-24.

Mutual Server Control Properties in Code Behind
There are several read-only properties that can be called in the code behind and used by every

server control. The list below explains these properties.

Note: The propertiesdo not display valueswithin VisualStudio during design time. Instead, theyonly display

valuesat run time, which are dependent on the user’s login status.

Property Value Data Type

IsLoggedIn

Tells if a user is logged in to Ektron CMS400.NET.

True =User is logged in

False =User is not logged in

Boolean

LoggedInUserName Gets the Ektron CMS400.NET user name to display. String

LoggedInUserID Gets the Ektron CMS400.NET ID of the user to display. Integer
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These properties will allow you to personalize any page with your users names and IDs, and

show if they are logged in. Here is an example of using these properties in code behind.

Note: Youmust be logged in to Ektron CMS400.NET for this example to show your name and ID.

1. Drag an Ektron CMS400.NET server control onto a Web form.

2. Drag three Literals onto the Web form.

3. Open the code behind for the Web form.

4. Add the following code to the Page_Load event.

Literal1.Text = ContentBlock1.IsLoggedIn
If ContentBlock1.IsLoggedIn Then
 Literal2.Text = ContentBlock1.loggedInUserName & " is logged in "
 Literal3.Text = ContentBlock1.loggedInUserID & " is the User ID "

End If

5. Build and run the solution.

6. Browse to the login page and log in.

7. Browse to the new Web form you added.

8. The login information is displayed.
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Accessing Additional Properties
In addition to the standard properties, Ektron CMS400.NET provides access to additional

properties for the following objects.

n ListSummary

n Collection

n Search

n ContentBlock

n FormBlock

To access additional properties, use the same syntax you use for standard properties but add

.ekitem or .ekitems after the object. Here is an example.

dim MyCB as New ContentBlock
MyCB.DefaultContentID = 30
MyCB.ID = “ContentBlock1”
MyCB.Page = Page
MyCB.Fill()
label1.text = MyCB.EkItem.dateCreated

or

dim MyCB as new Ektron.Cms.Controls.ContentBlock
MyCB.DefaultContentID = 30
MyCB.ID = “ContentBlock1”
MyCB.Page = Page
MyCB.Fill()
label1.text = MyCB.EkItem.dateCreated

Warning! To accessadditional properties for the Collection, ListSummary, and Search objects, use ekitems, not

ekitem. For example: MyColl.ekitems(0).dateCreated. where (0) is the indexof the array. For more Information

on using ekitems, see "Accessing Items in an Array" on page 21-22.

Inserting Server Controls Programmatically

ReferenceManual

Version 8.0 Rev 1.3
21-17



You can use intellisense to select from a list of additional object properties, as shown below.

The additional properties are listed below.

Note: The following propertiesare read-only. For example, you can get a content block’s ID and pass it through to

another part of the code, however you cannot set a content blocks ID to be shown. mycb.Ekitem.id = 8will not

set a content block’s ID. The correct way to set a content blocks ID isDefaultContentID = 8.

Property Description
For more information,

see

Comment The content block’s comment.

ContentStatus

The status of the content block.

n approved

n checked out

n checked in

n expired

n pending deletion

n pending expiration

n pending start date

n submitted

"Content Statuses" on page

7-133
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Property Description
For more information,

see

ContentType

One of the following

n all types

n archived content

n archived forms

n content

n forms

To learn about archived

content, see "Scheduling

Content to Begin and End"

on page 7-195.

DateCreated

The date when the content blockwas

created, formatted asa .NET date

type.

DateModified

The date when the content blockwas

modified, formatted asa .NET date

type.

DefaultXslt
The default XSLT used to display the

content.

DisplayDateCreated

The date when the content blockwas

created. It is formatted asa string that

representsEktron CMS400’s display

of the date.

DisplayDateModified

The date when the content blockwas

edited. It is formatted asa string that

representsEktron CMS400’s display

of the date.

DisplayEndDate

The content block’s end date. It is

formatted asa string that represents

Ektron CMS400’s display of the date.

"Setting an End Date on

Content" on page 7-197

DisplayGoLiveDate

The content block’s start date. It is

formatted asa string that represents

Ektron CMS400’s display of the date.

"Setting a Start Date" on

page 7-195

DisplayStartDate

The content block’s start date. It is

formatted asa string that represents

Ektron CMS400’s display of the date.

"Setting a Start Date" on

page 7-195

EndDate
The content block’s end date,

formatted asa .NET date type.

"Setting an End Date on

Content" on page 7-197
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Property Description
For more information,

see

EndDateAction

n archive display

n archive expire

n refresh report

"Setting Archive Options" on

page 7-198

FolderID
The ID of the folder that contains each

content block.

GoLiveDate
The content block’s start date

formatted asa .NET date type.

"Setting a Start Date" on

page 7-195

Html

The content that makesup the content

block. If content block is in XML it will

return it as raw XML content.

Hyperlink
Content block title wrapped by <a

href> tags.

Id The content block ‘s ID number.

InheritedFrom
If folder permissionsare inherited, the

folder fromwhich theyare inherited.
"Inheritance" on page 5-44

IsInherited
Whether a content block’s permissions

are inherited.
"Inheritance" on page 5-44

IsPrivate
Whether or not a content block is

private.

"Private Content" on page

7-191

Language The content block’s language.

"Working with Multi-

Language Content" on

page 14-1

LastEditorFname
The first name of the last person to edit

the content block.

LastEditorLname
The last name of the last person to edit

the content block.

PackageDisplayXSLT
If the content block isXML, the name

of itsXSLT.

QuickLink The content block’s quicklink.
"Quicklinks and Forms" on

page 8-22
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Property Description
For more information,

see

StartDate
The content block’s start date

formatted asa .NET date type.

"Setting a Start Date" on

page 7-195”

Status

The status of the content block

n approved

n checked out

n checked in

n expired

n pending deletion

n pending expiration

n pending start date

n submitted

"Content Statuses" on page

7-133”

Teaser The content block summary.
"Adding HTMLContent" on

page 7-15

TemplateLink
Currently empty and not being used

with the ContentBlock server control.

Title The content block title.

UserID Last user who edited the content.

Xslt1
The content block’s first Xslt, as

defined in Ektron CMS400.NET.

Xslt2
The content block’s second Xslt, as

defined in Ektron CMS400.NET.

Xslt3
The content block’s third Xslt, as

defined in Ektron CMS400.NET.

Xslt4

The developer can use this property

programmatically. Ektron

CMS400.NET only usesXslt1, 2 and 3

in the workarea.

Xslt5

The developer can use this property

programmatically. Ektron

CMS400.NET only usesXslt1, 2 and 3

in the workarea.
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Accessing Items in an Array
To access and manipulate content blocks returned by an object, use the common class

Ektron.Cms.Common.ContentBase. EkItems is an array of Ektron.Cms.Common.ContentBase.
EkItem is a single Ektron.Cms.Common.ContentBase.

Search, Collection and ListSummary have EkItems (an array of ContentBase), while

ContentBlock has a single EkItem. Here is an example of how to use this feature.

dim MyC as new Ektron.Cms.Controls.Collection
MyC.DefaultCollectionID = 1
MyC.ID = “Collection1”
MyC.Page = Page
MyC.Fill()
dim item as Ektron.Cms.Common.ContentBase
MyC.Text = "<ul>"
for each item in MyC.EkItems
MyC.Text &= "<li>" & item.Title & "</lI>"
next
MyC.Text &= "</ul>"
Response.Write(MyC.Text())

This example formats every item in the collection in a bulleted list.

Note: For information on using ekitemswith the eCommerce server controls, see ”Using the EkItemsProperty

with eCommerce Server Controls” on page 17-318 and ”Using eCommerce Server ControlEvents” on page 17-

317.

Referencing the Page Property
Server controls require a reference to their parent page (for example, utilizing the

DynamicParameter property on a content block to check for a query string), you must provide

access to the page object if you declared your control in the code behind. To do this, set the

control's Page property to the Web page you're working on. For an example, see the code in red

and italics below.

dim search as new Ektron.Cms.Controls.Search()
MySearch.ID = “Search1”
MySearch.Page = Page
MySearch.Fill()

With C#, use this syntax.

Ektron.Cms.Controls.Search MySearch = new Ektron.Cms.Controls.Search();
MySearch.Page = Page;
MySearch.Fill();
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This relationship is only required when inserting a control in the code behind. When dragging

and dropping, even if you make changes in code behind, the relationship is automatically

generated.

Best Practice

Ektron recommends including the Pageproperty reference when using the server

controls as components in the code behind.

Customizing Server Controls
One of Visual Studio’s strengths is its separation of coding and logic from presentation. Web

page formatting is handled by a page’s HTML, while the logic is handled by the code behind,

which is stored in the corresponding .vb file. For example, if the ASP.NET page is

mypage.aspx, the code behind file is mypage.aspx.vb.

Note: If you do not see the code behind files, click the Show All Files button on the VSSolution Explorer toolbar.

Within the vb file, you can use Visual Basic to insert code to manipulate the events that occur

on the page.

This subsection contains the following topics:

n "Recognizing the Server Control Within the HTML" on page 21-23

n "Recognizing the Server Control Within the Code Behind" on page 21-24

n "Customizing the Server Control in the Code Behind" on page 21-24

n "Troubleshooting Error Creating Control Message" on page 21-25

Recognizing the Server Control Within the HTML
Within a Web page’s HTML, a <cms> tag wraps the Visual Studio object, as shown below.

<cms:Search id="Search1" runat="server" ButtonText="Search" Dis-

play="Vertical"></cms:Search>
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Above is an example of a Search Server Control. Below is an example of a ContentBlock

Server Control.

<cms:ContentBlock id="ctrlMainContentBlock" runat="server" DefaultContentID="1" Dynam-

icParameter="id” OverrideXslt="Default"></cms:ContentBlock>

Recognizing the Server Control Within the Code Behind
Within the Visual Studio code behind file, the Ektron server controls appear (along with the

VS controls) in the Web Form Designer Generated Code section. When you click the plus sign

(+) to display this section, you see something like the following. The content block listed in

HTML above is circled below to help you see their relationship.

The next section of the code behind page loads the page into the browser.

Private Sub Page_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) Han-

dles MyBase.Load

We want our events to occur while the page is loading, so we’ll add custom code following

this line.

Customizing the Server Control in the Code Behind
To customize an Ektron server control in the code behind, insert code similar to the following

after the Page_load command.

Dim MyObj As New Ektron.Cms.Controls.ContentBlock

This code declares a variable named MyObj and assigns to it the value of a content block. The

content block is part of the Ektron.CMS.Controls content base, so it has access to the Ektron

CMS400.NET database.

After defining MyObj as a content block, you can access its properties. For example, to assign

a defaultID of 24, insert the following.

Dim MyObj As New Ektron.Cms.Controls.ContentBlock
MyObj.DefaultContentID = 24
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Now, the content block can be specified dynamically in the URL of the hyperlink that calls it.

If not, content block 24 displays.

This is just an example of programmatically applying property values to content blocks. For a

complete list of properties available to Ektron CMS400.NET objects, see "List of Server

Controls" on page 21-38.

Troubleshooting Error Creating Control Message
If you get an Error Creating Control message while trying to use a server control, you can view

the text of the error message by hovering the mouse over the control. See illustration below.

(continued in Using Drag & Drop and Programmatically Together)

Data Binding with Server Controls
With data binding, you can bind Ektron server controls to a GridView Control, DataList

Control, or Repeater Control. This gives more flexibility when you use data from the Ektron

server controls. Benefits of data binding include ease of data manipulation and the ability to

format data.

Warning! WhenHTML is bound to a column, you need to add HtmlEncode = False to it. Otherwise, the HTML

appears as code. For example, <p>Ektron Inc., an innovator in Web content management soft-

ware, today announced...</p>.

The following are data bindable Ektron Server Controls.

n Collection

n ContentList

n IndexSearch
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n ListSummary

n MetaDataList

n RssAggregator

The following is an example of code behind that uses a GridView to display a Collection:

Note: For the example code below to workproperly, you need to drag and drop aGridView server control on a

Web form.

Dim myCol As New Ektron.Cms.Controls.Collection
MyCol.ID = “Collection1” ‘‘‘Create an ID for the Collection
myCol.DefaultCollectionID = 4
myCol.Page = Page
myCol.Fill()
GridView1.DataSource = myCol
GridView1.DataBind()

This subsection contains the following topics:

n "Steps to Data Binding Using Drag and Drop Server Controls" on page 21-26

Steps to Data Binding Using Drag and Drop Server
Controls
The following example uses a Collection.

1. Create a new Web form.

2. Drag and drop a data bindable Server Control on the Web form. For example, a Collection

server control.

3. In properties, choose a DefaultCollectionID for the Server Control and make sure

DisplayXslt is set to None- DataBind Only.
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4. Drag and drop a GridView on the Web form.

5. In the GridView Tasks, choose the DataSourceID.
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6. In code behind, add the following line of code to the Page add field.gifnit event:
Collection1.Fill()

7. Select the columns to be databound by clicking Add New Column in GridView Tasks.

8. Complete the Add Field window according to the table below.

Field Entry

Choose a field

type:
BoundField

Header text: The title name for each column.
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Field Entry

Data field:

The data to bind to each column. Choose one of the following:

ID - the content block ID

Title - the content block title

Teaser - the content summary

Html - the html content

StartDate - the content’s start date

DateModified - the content’s last modified date

EndDate - the content’s end date

LastEditorFname - the last editor’s first name

LastEditorLname - the last editor’s last name

QuickLink - the content’s quicklink

HyperLink - the content’s hyperlink

DisplayStartDate - the string representation of the start date

FolderID - the folder ID where the content is located

ContentStatus - the content’s status

Language - the content’s default language

DisplayDateModified - string representation of the content’s last

modified date

DisplayEndDate - string representation of the content’s end date

EndDateAction - an action tied to end date. For example, Refresh_

Report

Comment - the content’s comments

9. Click OK.

10. Repeat steps six, seven and eight for each column you want to add.
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11. If you want to add all of the columns automatically, in the GridView Task menu click

Edit Columns. Otherwise, skip to step thirteen.

12. Click the Auto-generate fields checkbox.

13. Click OK.

14. From the Build menu, click Build Page.

15. In design view, right click the form and select View in Browser.
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For more information on GridView, DataList, Repeater and DetailsView, see the help inside

Visual Studio.

Caching with Server Controls
A key factor in building high-performance, scalable Web applications is the storage of items in

memory after the first time they are requested. The items include data objects, pages, and parts

of a page.

Known as caching, this process saves and later reuses page output or application data across

HTTP requests. You can store items on the Web server or other software in the request stream,

such as the proxy server or browser.

Caching saves time and resources because the server does not have to recreate information,

particularly things that demand significant processor time or other resources.

The following illustrates data flow in non-cached and cached environments.
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Ektron CMS400.NET provides two kinds of caching.

n Caching Individual Content - lets you cache part of a Web page; available with some

server controls

n Page Level Caching - lets you cache an entire page; available with all server controls

Each is explained below.

Caching Individual Content
There are two kinds of caching of individual content.

n "Caching While not Logged In" on page 21-33

n "Caching While Logged In" on page 21-33
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Caching While not Logged In
For a description of how Caching While not Logged In works, see "Caching with Server

Controls" on page 21-31.

Caching While Logged In
When a user is logged in, caching prevents any changes from appearing on the site for the

number of seconds defined in the cache interval. This reduces the number of database hits,

which improves your server’s performance.

For example, if you add a new item to a Collection, the change only appears on the site when

the cache interval expires. However, the user can switch to Preview mode to see the updated

Collection immediately. See Also: "Site Preview" on page 3-4

Warning! Caching while logged in doesnot workwith Private content.See Also: "Private Content" on page 7-
191

Setting up Caching of Individual Content
To set up caching of individual content for any Web page, follow these steps.

1. Make sure the Web.config file’s ek_CacheControls property’s value = “1” (one). This is

the default. This setting lets you control caching with server controls.

2. Add a server control that supports caching of individual content to a Web form. See "The

caching of individual content is available for the server controls listed below." on page

21-33.

3. Set the server control ‘s CacheInterval property to the length of time the data should be

cached. For example, to cache data for five minutes, set CacheInterval to 300 (three

hundred).

The default value is 0 seconds. So, you must change the default to enable caching.

Server Controls that Support Caching of Individual Content
The caching of individual content is available for the server controls listed below.
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Control
Caching available while

not logged in

Caching available while

logged in

ActiveTopics X

All blog controls X

Collections X X

CommunityDocuments X

CommunityGroupBrowser X

CommunityGroupList X

CommunityGroupMembers X

CommunitySearch X

ContentBlock X

ContentList X X

DhtmlMenu X X

Directory X

Favorites X

FlexMenu X

FormBlock X

Forum X

Friends X

ListSummary X X

MetadataList X X

Menu X X

Poll X

PostHistory X
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Control
Caching available while

not logged in

Caching available while

logged in

SiteMap X

SmartMenu X X

TagCloud X

UserProfile X

Page Level Caching
Below is an example of a page level cache for non logged-in users. In this example, you use a

Server Control to define whether a user is logged in or not. Then, define if the time is cached,

based on the user’s status.

1. Create a new Web form in your Ektron CMS400.NET project.

2. Add the following text to the Web form:
Refresh the page. The page will cache for 20 seconds when not logged in:
Time is =

3. Next to Time is =, add a literal.

4. Below that, add a ContentBlock Server Control.

5. Set the DefaultContentID. For this example, DefaultContentID = 20.

6. Add the following to the Page_Load event in the code behind.

If Not ContentBlock1.IsLoggedIn Then
Response.Cache.SetExpires(DateTime.Now.AddSeconds(20))
Response.Cache.SetCacheability(HttpCacheability.Public)
Response.Cache.SetValidUntilExpires(True)
Response.Cache.VaryByParams("id") = True
Response.Cache.SetVaryByCustom("cmsCache")
End If
Literal1.Text = Now()

7. Build your Web form.
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8. Browse to your Web form using your browser.

9. Press your browser’s refresh button.

If you are not logged in to CMS400.NET, the time remains for twenty seconds. After twenty

seconds, when you refresh, the new time appears.

Note: You can use the same code in a user control to cache output in a particular region of the page.

Using Ajax Enabled Server Controls
and Custom Code

Best Practice

When using Ajax server controls and custom code, wrap the custom code in a check

for “is not a callback” so it is not executed when a callback from an Ajax server control

occurs.

If you use an Ajax-enabled server control and write custom code, it may generate an exception,

indicating the server control does not work. This issue happens during callback for the Ajax

server control when custom code accesses a property that is filled during page load, but not

filled during callback.

For example, a Poll server control is on a Web form, and you want the title of a content block

to appear in a literal on that form. The EkItem.Title property for the content block is filled

upon page load. When a site user answers the poll question, an exception occurs during the

callback because the EkItem.Title property is not refilled. However, the site user does not see

the exception. It just looks like the Poll server control is not working.

Below is an example of custom code that makes the content block’s title appear in the literal:

Literal1.Text = ContentBlock1.EkItem.Title

To solve this issue, wrap the custom code in a check for “is not a callback”. This prevents the

code execution when callback occurs. For example,

[C#]

If( !IsCallback ) {

Literal1.Text = ContentBlock1.EkItem.Title

}
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[VB]

If ( Not IsCallback )

Literal1.Text = ContentBlock1.EkItem.Title

End If

Displaying Custom XML in Ektron’s
Server Controls
Ektron provides a CustomXml property in several server controls that allows you to add

custom XML to a control’s generated XML before being processed by its XSLT.

This property is available in code behind when using these server controls:

n Cart

n Checkout

n CurrencySelect

n MyAccount

n OrderList

n Product

n ProductList

n ProductSearch

n Recommendation

CustomXml Property Usage Example
Below is a C# example of using the CustomXml property in code behind.

protected void Page_Load(object sender, EventArgs e)
{
product1.CustomXml = "<banner>Save $$$ While Christmas

Shopping!</banner><specials><special><link>ProductDemo.aspx?id=1013</link><text>A great

gift for Dad!</text></special><special><link>ProductDemo.aspx?id=1015</link><text>A

great gift for Mom!</text></special></specials>";
}

Example of CustomXml XSLT Output
Below is an example of the XML sent to the XSLT file.

<root>
<customXml>
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<banner>Save $$$ While Christmas Shopping!</banner>
<specials>

<special>
<link>ProductDemo.aspx?id=1013</link>
<text>A great gift for Dad!</text>

</special>
<special>

<link>ProductDemo.aspx?id=1015</link>
<text>A great gift for Mom!</text>

</special>
</specials>

</customXml>
<otherTags>
 ... (for illustration only, there would be many other tags here)
</otherTags>

</root>

List of Server Controls
To customize your Ektron CMS400.NET application, use these server controls.

Server Control

Names
Description More Information

Analytics Track statistics about visits to your Web site.

AssetControl

The AssetControl server control, when

viewed on aWeb form, displaysa drag and

drop box for users to upload assets to

CMS400.NET or update an existing asset.

"AssetControl Server

Control" on page 7-486

Blog

Ektron providesnine server controls that

relate to displaying a Blog on aWeb site.

Theyare:

n The Blog server control

n The BlogCalendar server control

n The BlogCategories server control

n The BlogEntries server control

n The BlogPost server control

n The BlogRecentPost server control

n The BlogRoll server control

n The BlogRSS server control

n The BlogArchive server control

"Introduction to Blog Server

Controls" on page 7-532

Developer Topics

21-38
ReferenceManual

Version 8.0 Rev 1.3



Server Control

Names
Description More Information

BreadCrumb

Createsa breadcrumb trail of where site

visitors have been and allows them to

navigate back to previouspages.

"BreadCrumb Server

Control" on page 9-285

For information on other

Breadcrumb types, see

"FolderBreadcrumb Server

Control" on page 9-294 and

"SiteMap Server Control" on

page 9-298

BusinessRules
Addsa BusinessRule created in the

CMS400.NET Workarea to aWeb form.

"BusinessRulesServer

Control" on page 12-13

Calendar Displaysan event calendar.
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Server Control

Names
Description More Information

Community

Platform

These controls enable you to build a

community site.

n CommunityDocuments server control

n CommunityGroupBrowser server con-

trol

n CommunityGroupList server control

n CommunityGroupMembers server

control

n CommunityGroupProfile server con-

trol

n Favorites server control

n Friends server control

n Invite server control

n MessageBoard server control

n Messaging server control

n PhotoGallery server control

n SocialBar server control

n UserProfile server control

n CommunitySearch server control

n TagCloud server control

”CommunityDocuments

Server Control” on page 16-

146

”CommunityGroupBrowser

Server Control” on page 16-

129

”CommunityGroupList

Server Control” on page 16-

134

”CommunityGroupMembers

Server Control” on page 16-

141

”CommunityGroupProfile

Server Control” on page 16-

123

”FavoritesServer Control”

on page 16-67

”FriendsServer Control” on

page 16-54

”Invite Server Control” on

page 16-255

”MessageBoard Server

Control” on page 16-97

”Messaging Server Control”

on page 16-259

”PhotoGalleryServer

Control” on page 16-76

”SocialBar Server Control”

on page 16-269

”UserProfile Server Control”

on page 16-49

”CommunitySearch Server

Control” on page 16-301

”TagCloud Server Control”

on page 16-293

Collection Displays links generated by collections.
"Collection Server Control"

on page 9-118

ContentBlock Displaysandmanagesa content block.
"ContentBlockServer

Control" on page 7-201

ContentList
Displaysa list of content blocks created

from a comma delimited list.

"ContentList Server Control"

on page 7-210
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Server Control

Names
Description More Information

ContentRating

Place a rating scale on anypage of your

Web site. The scale letsEktron

CMS400.NET collect feedbackbygiving

site visitors the opportunity to rate a

particular content item.

"ContentRating Server

Control" on page 7-747

ContentReview

Placesa star based rating scale on any

page of your Web site. This control can also

be used to retrieve and display visitor

reviewsand comments.

"ContentReview Server

Control" on page 7-736

DesignTime

Diagnostic

The DesignTimeDiagnostic server control

is used to verify the connection to Ektron’s

server controlsWeb service.

”DesignTimeDiagnostic

Server Control” on page 21-

57

DhtmlMenu
Displaysa drop downmenuwith

submenus.

"DhtmlMenu Server

Control" on page 9-191

Directory

The Directory server control lets you

customize the behavior of the Taxonomy

feature. You place this control on anyWeb

form to display a taxonomy.

"DirectoryServer Control"

on page 9-241

eCommerce

The eCommerce server controls allow you

to set up an onlinemarket place where site

visitors can purchasemerchandise,

servicesor content.

n Cart Server Control

n Checkout Server Control

n CurrencySelect Server Control

n MyAccount Server Control

n OrderList Server Control

n Product Server Control

n ProductList Server Control

n ProductSearch Server Control

n Recommendation Server Control

”Cart Server Control” on

page 17-6

”Checkout Server Control”

on page 17-21

”CurrencySelect Server

Control” on page 17-74

”MyAccount Server Control”

on page 17-276

”OrderList Server Control”

on page 17-265

”Product Server Control” on

page 17-201

”Product List Server

Control” on page 17-215

”ProductSearch Server

Control” on page 17-223

”Recommendation Server

Control” on page 17-247
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Server Control

Names
Description More Information

FlexMenu

The FlexMenu server control displaysa

menu on aWeb form. Although it looksand

acts like a Smart Menu, its architecture is

substantially different. Specifically, a

FlexMenu createsXML. So, you canmodify

its behavior using an XSLT file, and change

its appearance using a cascading style

sheet (.css) file.

"Flexible Menu Server

Control" on page 9-164

FolderBreadcrumb
FolderBreadcrumbsshow you the path

through the sitemap to the current page.

"FolderBreadcrumb Server

Control" on page 9-294

For information on other

Breadcrumb types, see

"BreadCrumb Server

Control" on page 9-285 and

"SiteMap Server Control" on

page 9-298

FormBlock
Displaysa content block that is associated

with a form.

"FormBlockServer Control"

on page 7-281

Forum

Forumsprovide a Discussion Board where

topics can be discussed on your Web site.

There are three server controls associated

with Discussion Boards. Theyare:

n The Forum server control

n The ActiveTopics server control

n The PostHistory server control

"Discussion Board Server

Controls" on page 7-665

ImageControl

Display a CMS400.NET image on aWeb

page. In addition, if a user haspermission

to edit the image, he can right click the

image and a drag and drop boxappears.

This boxallowsa user to overwrite the

existing file.

"ImageControl Server

Control" on page 7-489

IndexSearch

Perform XML index searcheson XML

content. (XML content is created using

Smart Forms.)

"IndexSearch Server

Control" on page 7-394

For information on

searching other content

types, see "Web Search

Server Control" on page 9-

68

Developer Topics

21-42
ReferenceManual

Version 8.0 Rev 1.3



Server Control

Names
Description More Information

LanguageAPI
Allowsdevelopers to force a language for a

Web site.

"LanguageAPI Server

Control" on page 14-44

LanguageSelect Lets user select language of site.
"LanguageSelect Server

Control" on page 14-46

ListSummary Displaysa list of content block summaries.
"ListSummaryServer

Control" on page 9-270

Login

Displays the login or logout button, which

lets the user log in and useEktron
CMS400.NET.

"Login Server Control" on

page 3-6

Map

Displaysamap that flags locationsof

interest to your site visitors. Each location is

a CMScontent item to whichmap

information wasadded.

"Map Server Control" on

page 9-247

Membership
Createsa form for site visitors to add

themselves to your Membership users list.

”Membership Server

Control” on page 16-30

Menu
Calls a definedmenu to be used with an

XSLT to display themenu.

"Menu Server Control" on

page 9-184

MetaData
Addsmetadata contained in content blocks

to aWeb page.

"MetaData Server Control"

on page 7-171

MetaDataList

Createsa list of content blocksbased on

themetadata contained in the content

blocks.

"MetaDataList Server

Control" on page 7-175

Personalization

Personalization server controls allow you to

create aWeb page that site users can

personalize. The following server controls

allow for personalization:

n EktronCatalogPart

n EktronCommunityCatalogPart

n EktronWebPartZone

n PersonalizationManager

”Personalization Server

Controls” on page -696

Poll
Displaysa poll or survey created from an

Ektron CMS400.NET form on aWeb page.

"Poll Server Control" on

page 7-284

RssAggregator
Aggregatesan RSS feed from anRSS

Web site.

"RssAggregator Server

Control" on page 19-17
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ReferenceManual

Version 8.0 Rev 1.3
21-43

#
#
#
#
#
#
#
#
#
#
#
#
#
#


Server Control

Names
Description More Information

Sitemap

The Sitemap server control utilizes the

folder breadcrumb information in the

Workarea to display a sitemap of your site.

"SiteMap Server Control" on

page 9-298

For information on other

Breadcrumb types, see

"BreadCrumb Server

Control" on page 9-285 and

"FolderBreadcrumb Server

Control" on page 9-294

SmartMenu

The Smart Menu server control displaysa

menu on aWeb page. Thismenu style is

themost robust of the three delivered with

Ektron CMS400.NET.

"Smart Menu Server

Control" on page 9-178

WebSearch
TheWeb Search server control lets you

customize the behavior of the search.

"Web Search Server

Control" on page 9-68

DesignTimeDiagnostic Server Control
Warning! This control is for use in design-time only, nothing is rendered at run-time.

The DesignTimeDiagnostic server control is used to verify the connection to Ektron’s server

controls Web service. When added to a Web form, this control provides the following

information:

n Web Service Path - displays the server control Web service path in your web.config file.

n Web Service Exists - calls a method in the Web service that returns True when the Web

service exists. When it does not, it returns False.

n Test Login Control - displays the Login server control to show that the Web service is

connected and working properly. When not connecting properly, an error message is

displayed.

Below is an example of the control on a page connected to the Web service.
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Below is an example of the control on a page not connecting to the Web service. Note that the

path is not the correct path. It should be:
http://192.168.0.82/siteroot/Workarea/ServerControlWS.asmx

DesignTimeDiagnostic Server Control Properties
The DesignTimeDiagnostic server control has no definable ektron properties.

DesignTimeDiagnostic Server Control
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Dreamweaver Extension Support

Ektron CMS400.NET has a custom Adobe® Extension Package, which allows you to not only

create your templates in Dreamweaver® or UltraDevTM, but also to insert the custom functions

through Dreamweaver®.

To do this, all you need is Ektron CMS400.NET, Dreamweaver®/UltraDevTM, and to keep

reading.

Ektron supports Dreamweaver extensions for the following scripting languages:

n ASP.NET - for .NET pages

n ASP - for Active Server Pages

n CFM - for ColdFusion pages

n JSP - Java Server Pages

n PHP - Hypertext Preprocessor

The following sections are contained in this chapter:

n "Requirements" on page 21-46

n "Preparing Dreamweaver for Ektron CMS400.NET Functions" on page 21-47

n "Installing the Extensions" on page 21-48

n "Setup" on page 21-51

n "Editing and Saving Content in Dreamweaver" on page 21-54

n "Using the Ektron CMS400.NET Extensions" on page 21-61

n "Inserting Custom Functions" on page 21-73

Requirements
To use a Dreamweaver extension supplied by Ektron, you need to have Dreamweaver 7.0.1 or

higher installed, as well as Ektron CMS400.NET.
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Preparing Dreamweaver for Ektron
CMS400.NET Functions
To have Ektron CMS400.NET function symbols appear in Dreamweaver, while editing a Web

page, you must edit two PreviewModeCustomTags.edml Dreamweaver files. The steps below

explain how to edit the files.

1. In Windows Explorer, navigate to the Translator > ASP.NET_VB location in the

Dreamweaver install location. For example:
 C:\Program Files\Adobe\Dreamweaver X\Configuration\Translators\ASP.NET_VB\

Note: In the path above,X represents the version of Dreamweaver you are using. For example, Dreamweaver 8

or Dreamweaver MX.

2. Open the PreviewModeCustomTags.edml file using Notepad.

3. Search for the following line of code in the file.
<searchPattern

requiredLocation="openTag"><![CDATA[/runat\s*=\s*"?server"?/i]]></searchPattern>

4. Add the following line after it.
 <searchPattern

requiredLocation="tagName"><![CDATA[/^(?!cms:)/i]]></searchPattern>

Warning! This linemust be inserted after the line above. Order is important.

5. Save and close the file.

6. Navigate to the Translator > ASP.NET_Csharp location in the Dreamweaver install

location. For example:
 C:\Program Files\Adobe\Dreamweaver X\Configuration\Translators\ASP.NET_Csharp\

Note: In the path above,X represents the version of Dreamweaver you are using. For example, Dreamweaver 8

or Dreamweaver MX.

7. Open the PreviewModeCustomTags.edml file using Notepad.

8. Search for the following line of code in the file.
<searchPattern

requiredLocation="openTag"><![CDATA[/runat\s*=\s*"?server"?/i]]></searchPattern>

9. Add the following line after it.
 <searchPattern

requiredLocation="tagName"><![CDATA[/^(?!cms:)/i]]></searchPattern>

Warning! This linemust be inserted after the line above. Order is important.

10. Save the file.
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You are now ready to Install the Ektron CMS400.NET extension. See Also: "Installing the

Extensions" on page 21-48

Installing the Extensions
There are two extensions that can be installed on your server:

n Ektroncms400.mxp - Adds ASP.NET extensions

n C400_ASP_PHP_CF_JSP.mxp - adds ASP, PHP, CF and JSP extensions

You can have both extensions installed at the same time. The extensions do not affect each

other. When you install the second extension, you might receive the following message:

If you see this message or one that say the files are newer, click Yes to All to continue.

Overwriting the files will not affect the extensions.

Before you can insert the Ektron CMS400.NET custom functions through Dreamweaver®, you

must install at least one of the extensions. Listed below are the steps to install an extension.

Note: For additional information about installing an extension, refer to your Dreamweaver®Manual.

To install an extension, follow these steps.

1. Begin by following the path in Dreamweaver:

Commands > Manage Extensions...
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2. The Extension Manager is displayed.

3. From this dialog box, follow the path:

File > Install Extension...

4. The Select Extension to Install window opens.

Installing the Extensions
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5. Locate the Extension Package (.mxp) file that corresponds to Ektron CMS400.NET. By

default, the file gets installed to the following directory:

C:\Program Files\Ektron\CMS400vXX\Utilities

Note: In the folder path, vXX represents the version of Ektron CMS400.NET you have installed.

6. After you select the file, click the Install button.

7. The installation begins with the Extension Manager Disclaimer. Click Accept.

8. The extension begins to install. Once installed, you see a confirmation box.

9. Click OK to continue.

10. The Extension Manager is again displayed, but with the added extension.
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11. If needed, exit Dreamweaver®, then start it back up.

Now you can use the Ektron CMS400.NET Extension Pack.

Refer to "Using the Ektron CMS400.NET Extensions" on page 21-61 for more information on

using Dreamweaver® to create and edit templates for Ektron CMS400.NET.

Setup
Before you can use Dreamweaver®/UltraDevTM to create and edit Ektron CMS400.NET

templates, you should configure the Ektron CMS400.NET Extension. Listed below are the

configurative options for the extension in Dreamweaver:

n Username

n Password

n Domain

n Server File

n Server

n Include

n Check for Include

To change these options, follow these steps.

1. If you use ASP, ColdFusion, JSP or PHP, follow this path:

Commands > Ektron CMS400 - (ASP CF JSP PHP) > Setup...

Setup
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If you use ASP.NET, follow this path:

Commands > Ektron CMS400.NET (Server Controls) > Setup...

2. The Setup dialog box is displayed on the screen.
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3. Use the following table to help you update your setup information. This table refers to

Ektron CMS400.NET (Server Controls) setup. For Ektron CMS400 - (ASP CF JSP PHP),

see "Ektron CMS400 - (ASP CF JSP PHP) Dreamweaver Setup Table." on page 21-53

Ektron CMS400.NET(Server Control) Dreamweaver Setup Table.

Field Description

Username

Valid username of a user of your Ektron CMS400.NET Web site.When using the

extension, the username is used to log in to the database to retrieve information

about content blocksand other Web site information

Password Enter the password for the user.

Domain
Only required if Active Directory hasbeen enabled for your Web site. Enter the

domain corresponding to the username entered.

Server

File

Specify the location and file name for the dreamweaver.aspx file needed for the

extension to properlywork andmake connection with your Ektron CMS400.NET

database.

Include
Each Ektron CMS400.NET template requires an include file to point to the API with

the definitions for the custom functions. Here, specify the include file.

Ektron CMS400 - (ASP CF JSP PHP) Dreamweaver Setup Table.

Field Description

Username

Valid username of a user of your Ektron CMS400.NET Web site.When using the

extension, the username is used to log in to the database to retrieve information

about content blocksand other Web site information

Password Enter the password for the user.

Domain
Only required if Active Directory hasbeen enabled for your Web site. Enter the

domain corresponding to the username entered.

Server

File

Specify the location and file name for the dreamweaver.aspx file needed for the

extension to properlywork andmake connection with your Ektron CMS400.NET

database.

Server

Choose the language of the server.

n ASP - for Active Server Pages

n CFM - for ColdFusion pages

n JSP - Java Server Pages

n PHP - Hypertext Preprocessor

Note: If you want to use a different language, you need to run this setup again and

choose a different language.

Setup
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Field Description

Include

Each template requires an include file to point to the API with the definitions for the

custom functions. Here, specify the include file.

n For ASPuse: <!-- #include file="applicationAPI.asp" -->

n For CFM use: Leave blank

n For JSP use: <%@ include file="applicationAPI.jsp" %>

n For PHPuse: <?php include "applicationAPI.php"; ?>

Check for

Include

If checked the Include statement is added to your page. Checked is the default.

n Checked - include statement added to your page

n Unchecked - include statement is not added to your page

4. Click Update Setup.

5. A message appears.

Note: Amessage other than this is probably due to an incorrect server file, username, or password. Recheck your

settingsand try again.

6. Click OK to continue.

7. The setup dialog box closes. You are ready to create templates using Dreamweaver.

Editing and Saving Content in
Dreamweaver
Making the process of setting up and managing your Web site easier, the Ektron CMS400.NET

Dreamweaver extensions allow you to perform content related tasks directly from Dreamweaver

saving you time and effort.

Through Dreamweaver, you can perform the following tasks:

n Add new content blocks to Ektron CMS400.NET

n Edit existing Ektron CMS400.NET content block
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The following sections explain how to perform these tasks.

Note: The user specified in the setup information for the extension will only be able to perform tasks theyhave

permissions to in Ektron CMS400.NET.

Accessing Manage Content Commands...
To access the CMS Manage commands menu, follow this path:

Commands > Ektron CMS400.NET (Server Controls) > Edit via Dreamweaver...

Or

Commands > Ektron CMS400 - (ASP CF JSP PHP) > Edit via Dreamweaver...

The path you follow depends on which Dreamweaver Extension you installed. If you installed

both extensions, you can use either one.

A list of all CMS Manage Content commands that can be performed is displayed.

The following sections explain how to use the manage content commands.

Edit Content
The edit content command allows you to get a content block from the Ektron CMS400.NET

Web site, and edit it within Dreamweaver.
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To edit a content block within Dreamweaver, perform the following steps:

1. Create a new HTML document in Dreamweaver.

2. In the Ektron CMS400.NET Manage Content menu, click on Edit Content.

The Insert Content tag dialog box is displayed.

3. Choose the Ektron CMS400.NET content block you would like to edit by:

- Typing the ID number of the content

or

- Using the drop down lists to locate the content folder and content block

4. Click Get when you have chosen the content block.

The content block is inserted into Dreamweaver.
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5. Make the necessary changes to the content block using Dreamweaver’s editing

capabilities.

See "Saving Existing Ektron CMS400.NET Content" on page 21-60 for information about

saving the content back to Ektron CMS400.NET.

Save Content
Content that has been created, or edited, in Dreamweaver can be saved to your Ektron

CMS400.NET Web site by using the Save Content command.

The following section explains how to save content created, and edited, to Ektron

CMS400.NET.

Saving New Content
To save a content block that was created in Dreamweaver, perform the following steps:

1. If you haven’t already, create the new content in Dreamweaver.
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2. In the Ektron CMS400.NET Manage Content menu, click on Save Content.

The Save Content dialog box is displayed.
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3. Using the following table, enter the necessary information to complete the form.

Field Description

Title Type a unique title for the content block.

Comment Enter a comment for the content block.

Start

Date

If desired, type in a start date for the content block.

NOTE: Date format MUST match what is set for the ek_dateFormat element, in

theWeb.config file, located in the site’swebroot.

Bydefault, this isdd-mmm-yyyy hh:mm:ss tt (for example, 24-Dec-2005

10:15:00 AM)

End Date

If desired, type in an end date for the content block.

NOTE: Date format MUST match what is set for the ek_dateFormat element, in

theWeb.config file, located in the site’swebroot.

Bydefault, this isdd-mmm-yyyy hh:mm:ss tt (for example, 24-Dec-2005

10:15:00 AM)

Content

Folder
Select the content folder you would like to save the new content block to.

Here is an example of this form filled out.

4. Click Save to save and add the new content block the selected content folder in Ektron

CMS400.NET.
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The content block is added, and a confirmation message is displayed.

Here is the new content block in the Ektron CMS400.NET Workarea.

5. Once the content has been saved to Ektron CMS400.NET, you can close the page in

Dreamweaver.

Saving Existing Ektron CMS400.NET Content
When Ektron CMS400.NET content has been edited in Dreamweaver, you can use the save

content command to save your changes back to Ektron CMS400.NET.

To save existing Ektron CMS400.NET content, perform the following steps.

1. Make changes to an existing Ektron CMS400.NET content block as described in "Edit

Content" on page 21-55.

2. In the Ektron CMS400.NET Manage Content Menu, click on Save Content.

3. The Save Ektron Content dialog box is displayed.

4. Use the following table to complete the form.

Field Description

Title Editing this field will rename the content block in Ektron CMS400.NET.

Comment Enter a comment for the content block.

Start

Date

If desired, type in a start date for the content block.

NOTE: Date format MUST match what is set for the ek_dateFormat element, in

theWeb.config file, located in the site’swebroot.

Bydefault, this isdd-mmm-yyyy hh:mm:ss tt (for example, 24-Dec-2005
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Field Description

10:15:00 AM)

End Date

If desired, type in an end date for the content block.

NOTE: Date format MUST match what is set for the ek_dateFormat element, in

theWeb.config file, located in the site’swebroot.

Bydefault, this isdd-mmm-yyyy hh:mm:ss tt (for example, 24-Dec-2005

10:15:00 AM)

Content

Folder
Disabled.

5. Click Save to save the changes made to the content.

The content is saved, and a confirmation message is displayed.

Note: If you receive amessage other than one confirming your content hasbeen saved, check your settingsand

try again.

Using the Ektron CMS400.NET Extensions
Once the Extension Package has been installed for Dreamweaver, you can create and edit

templates for Ektron CMS400.NET.

The following subsections are contained in this section:

n "Custom Function Symbols" on page 21-61

n "Ektron CMS400.NET Command Menus" on page 21-66

Custom Function Symbols
During the process of inserting functions, symbols are used to represent the custom display

functions. The following table explains each symbol and for which scripting languages the

functions are available.
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Symbol Represents ASP.NET

ASP

- CF

JSP

-

PHP

More Information

Active Topics
"ActiveTopics" on page

21-73

Analytics "Analytics" on page 21-76

Asset Control
"AssetControl" on page

21-78

Blog "Blog" on page 21-81

BlogArchive
"Blog Archive" on page

21-84

Blog Calendar
"Blog Calendar" on page

21-87

Blog

Categories

"Blog Categories" on

page 21-89

Blog Entries
"Blog Entries" on page 21-

91

Blog Posts "Blog Post" on page 21-94

Blog Recent

Posts

"Blog Recent Posts" on

page 21-97

Blog Roll "Blog Roll" on page 21-99
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Symbol Represents ASP.NET

ASP

- CF

JSP

-

PHP

More Information

Blog RSS
"Blog RSS" on page 21-

102

BreadCrumb
"BreadCrumb" on page

21-104

Calendar
"Calendar" on page 21-

109

Collection
"Collection" on page 21-

113

Content Block
"Content Block" on page

21-118

Content List
"Content List" on page 21-

122

Content

Rating

"Content Rating" on page

21-127

Content XSLT

Tag

"Content XSLT Tag..." on

page 21-129

DHTMLMenu
"DHTMLMenu" on page

21-131

Directory -

Taxonomy

"Directory-Taxonomy" on

page 21-137

Discussion

Forum

"Discussion Forum" on

page 21-142

Display by

Meta Value

"DisplayByMeta Value"

on page 21-145
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Symbol Represents ASP.NET

ASP

- CF

JSP

-

PHP

More Information

Dynamic

Content Block

"DynamicContent Block"

on page 21-151

Folder Bread

Crumb

"Folder Bread Crumb" on

page 21-153

FormContent

Block
"Form" on page 21-156

Image Control
"ImageControl" on page

21-159

Language API
"Language API" on page

21-161

Language

Select

"Language Select Box" on

page 21-163

List Summary
"List Summary" on page

21-165

Login/Logout

button
"Login" on page 21-172

Map
"MapControl" on page

21-176

Membership
"Membership Control" on

page 21-182

Metadata

"Metadata for ASP.NET

Pages" on page 21-186

or

"Metadata Function for

ASP, CF, JSP or PHP

Pages " on page 21-190
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Symbol Represents ASP.NET

ASP

- CF

JSP

-

PHP

More Information

Multipurpose

content block.

"Multipurpose Content

Block" on page 21-192

Poll "Poll" on page 21-194

Post History
"PostHistory" on page 21-

196

Random

Content

"RandomContent" on

page 21-199

Random

Summary

"RandomSummary" on

page 21-200

RSS

Aggregator

"RSSAggregator" on

page 21-202

Old Search
"Old Search" on page 21-

205

Search

display

function

"Search Display" on page

21-213

Single

Summary

"Single Summary" on

page 21-215

Site Map
"Site Map" on page 21-

217

Standard

Menu

"StandardMenu" on page

21-224

Smart Menu
"Smart Menu" on page

21-220
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Symbol Represents ASP.NET

ASP

- CF

JSP

-

PHP

More Information

WebSearch
"Web Search" on page

21-227

XML Index

Search

"XML IndexSearch" on

page 21-232

Ektron CMS400.NET Command Menus
The following section explains how to locate Ektron CMS400.NET commands in

Dreamweaver.

There are two Ektron command menus available. One menu is for ASP.NET pages and the

other is used for ASP, ColdFusion, JSP and PHP pages:

n Commands > Ektron CMS400.NET (Server Controls)

n Commands > Ektron CMS400 - (ASP CF JSP PHP)

To locate a command menu in Dreamweaver, perform the following steps:

1. Open Dreamweaver.

2. In the top menu, follow one of these paths:

n If you are using ASP.NET pages, click

Commands > Ektron CMS400.NET (Server Controls)

n If you are using ASP, ColdFusion, JSP or PHP pages, click

Commands > Ektron CMS400 - (ASP CF JSP PHP)

For a list of commands in Ektron CMS400.NET (Server Controls), see "Ektron

CMS400.NET (Server Controls) Functions" on page 21-68.

For a list of commands in Ektron CMS400 - (ASP CF JSP PHP), see "Ektron CMS400 -

(ASP CF JSP PHP) Functions" on page 21-71.

3. The Ektron CMS400.NET commands menu is displayed.

In Ektron CMS400.NET (Server Controls) the functions are broken up into the

following groups:

- Content Controls...

- CMS Module Controls...

- Community Controls...
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In Ektron CMS400 - (ASP CF JSP PHP) the functions are broken up into the following

groups:

- CMS Function...

- XML Function...

Note: For a description of theSetup... andEdit via Dreamweaver... groups, see "Setup" on page 21-51 and

"Editing and Saving Content in Dreamweaver" on page 21-54.

Below are images showing the different views.
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4. Click on the command for the task you would like to perform.

The following tables explain each command. The first table explains the "Ektron

CMS400.NET (Server Controls) Functions" on page 21-68. The second table explains the

"Ektron CMS400 - (ASP CF JSP PHP) Functions" on page 21-71.

Ektron CMS400.NET (Server Controls) Functions

Command Description
More

Information

Content Controls...

Login
Inserts an Ektron CMS400.NET login function into the

template.

"Login" on

page 21-172

Content
Inserts an Ektron CMS400.NET content block function into

the template.

"Content Block"

on page 21-

118

Form
Inserts an Ektron CMS400.NET form content block into the

template.

"Form" on

page 21-156

Poll
Displaysa poll or survey created from an Ektron

CMS400.NET form on aWeb page.

"Poll" on page

21-194

Collection
Inserts an Ektron CMS400.NET collection function into the

template.

"Collection" on

page 21-113
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Command Description
More

Information

List Summary
Inserts an Ektron CMS400.NET list summary function into

the template.

"List Summary"

on page 21-

165

Metadata
Inserts an Ektron CMS400.NET metadata function into the

template.

"Metadata for

ASP.NET

Pages" on

page 21-186

DisplayBy

Meta Value

Inserts an Ektron CMS400.NET display bymeta value

block into the template.

"DisplayBy

Meta Value" on

page 21-145

Content List
Displaysa list of content blocks created from a comma

delimited list.

"Content List"

on page 21-

122

Language

Select

Inserts an Ektron CMS400.NET language select box into

the template.

"Language

Select Box" on

page 21-163

Language API
Inserts an Ektron CMS400.NET Language API into the

template.

"Language

API" on page

21-161

ContentRating

Place a rating scale on anypage of your Web site. The

scale letsEktron CMS400.NET collect feedbackbygiving

site visitors the opportunity to rate a particular content item.

"Content

Rating" on

page 21-127

WebSearch
The Web Search server control lets you customize

the behavior of the search.

"Web Search"

on page 21-

227

Old Search
Inserts an Ektron CMS400.NET search function into the

template.

"Old Search"

on page 21-

205

XML Index

Search

Inserts an Ektron CMS400.NET XML IndexSearch into

the template.

"XML Index

Search" on

page 21-232

Directory-

Taxonomy

Lets you customize the behavior of the Taxonomy

feature. You place this control on any Web form to

display a taxonomy.

"Directory-

Taxonomy" on

page 21-137
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Command Description
More

Information

CMS Module Controls...

Analytics Track statistics about visits to your Web site.
"Analytics" on

page 21-76

Calendar
Inserts an Ektron CMS400.NET event calendar function

into the template.

"Calendar" on

page 21-109

RssAggregator Aggregatesan RSS feed from anRSSWeb site.

"RSS

Aggregator" on

page 21-202

MapControl

Displays a map that flags locations of interest to

your site visitors. Each location is a CMS content

item to which map information was added.

"Map Control"

on page 21-

176

CMS MENU Controls...

Folder Bread

Crumb

FolderBreadcrumbsshow you the path through the

sitemap to the current page.

"Folder Bread

Crumb" on

page 21-153

BreadCrumb
Createsa breadcrumb trail of where site visitors have been

and allows them to navigate back to previouspages.

"BreadCrumb"

on page 21-

104

SmartMenu

Displaysamenu on aWeb page. Thismenu style is the

most robust of the three delivered with Ektron

CMS400.NET.

"Smart Menu"

on page 21-

220

DHTMLMenu
Inserts an Ektron CMS400.NET DHTMLmenu into the

template.

"DHTML

Menu" on page

21-131

Standard

Menu

Inserts an Ektron CMS400.NET standardmenu into the

template.

"Standard

Menu" on page

21-224

Site Map
The Sitemap utilizes the folder breadcrumb information in

theWorkarea to display a sitemap of your site.

"Site Map" on

page 21-217

Community Controls...

Membership
AddsaMembership form to your Web form. This allows

site visitors to self-register themselves to your site.

"Membership

Control" on

page 21-182
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Command Description
More

Information

Discussion

Forum

Forumsprovide a Discussion Board where topics can be

discussed on your Web site.

"Discussion

Forum" on

page 21-142

ActiveTopics
Displays either the most active topics or the most

recent topics.

"ActiveTopics"

on page 21-73

PostHistory Displays a list of posts for a given users

"PostHistory"

on page 21-

196

Blog

The Blog function allows you to quickly add a blog to aWeb

form. It hasall of the itemscommonly found on a blog page

in one server control.

"Blog" on page

21-81

Blog Calendar
Display a calendar on aWeb page and associate it with a

blog.

"Blog

Calendar" on

page 21-87

Blog

Categories
Display the blog categories for a blog on aWeb form.

"Blog

Categories" on

page 21-89

Blog Roll Display the blog roll for a blog on aWeb form.
"Blog Roll" on

page 21-99

Blog RSS Display the icon ( ) for the blog’sRSS feed on theWeb
form.

"Blog RSS" on

page 21-102

Blog Entries Display a list of multiple blog posts on aWeb form.
"Blog Entries"

on page 21-91

Blog Recent

Posts
Display a list of recent blog posts links on aWeb form.

"Blog Recent

Posts" on page

21-97

Blog Post Display an individual blog post on aWeb form.
"Blog Post" on

page 21-94

Blog Archive
Display a list of past months or years that have

posts.

"Blog Archive"

on page 21-84

AssetControl

The AssetControl server control, when viewed on

a Web form, displays a drag and drop box for

users to upload assets to CMS400.NET or update

an existing asset.

"AssetControl"

on page 21-78
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Command Description
More

Information

ImageControl

Display a CMS400.NET image on aWeb page. In addition,

if a user haspermission to edit the image, he can right click

the image and a drag and drop boxappears. This box

allowsa user to overwrite the existing file.

"ImageControl"

on page 21-

159

Ektron CMS400 - (ASP CF JSP PHP) Functions

Command Description More Information

Content Controls...

Login
Inserts an Ektron CMS400.NET login function into

the template.
"Login" on page 21-172

Content
Inserts an Ektron CMS400.NET content block

function into the template.

"Content Block" on page

21-118

Dynamic
Inserts an Ektron CMS400.NET dynamic content

blockplaceholder function into the template.

"DynamicContent Block"

on page 21-151

Collection
Inserts an Ektron CMS400.NET collection function

into the template.

"Collection" on page 21-

113

List

Summary

Inserts an Ektron CMS400.NET list summary

function into the template.

"List Summary" on page

21-165

Metadata
Inserts an Ektron CMS400.NET metadata

function into the template.

"Metadata for ASP.NET

Pages" on page 21-186

Search
Inserts an Ektron CMS400.NET search function

into the template.

"Old Search" on page

21-205

Search

DisplayTag

Inserts an Ektron CMS400.NET search display

function into the template.

"Search Display" on

page 21-213

Single

Summary

Tag

Inserts an Ektron CMS400.NET single summary

function into the template.

"Single Summary" on

page 21-215

Random

Content Tag

Inserts an Ektron CMS400.NET random content

function into the template.

"RandomContent" on

page 21-199

Random

Summary

Tag

Inserts an Ektron CMS400.NET random

summary function into the template.

"RandomSummary" on

page 21-200
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Command Description More Information

Calendar
Inserts an Ektron CMS400.NET event calendar

function into the template.

"Calendar" on page 21-

109

Form
Inserts an Ektron CMS400.NET form content

block into the template.
"Form" on page 21-156

Multipurpose

Tag

Insert a content blockor form content block into

the template.

"Multipurpose Content

Block" on page 21-192

XML Function...

Content

XSLT Tag

Inserts an XML content blockwith your choice of

XSLT in the template.

NOTE: Used to insert an XML content blockwith

an XSLT other than the default applied to it.

"Content XSLT Tag..."

on page 21-129

Inserting Custom Functions

CMS Function
The CMS Function commands let you insert standard Ektron CMS400.NET display functions

into your template.

The following sections explain how to insert each function.

ActiveTopics
For a description of the ActiveTopics function, see See "ActiveTopics Server Control" on page

7-677 .

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Community Controls...

> Forums

To insert the ActiveTopics function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click ActiveTopics.

3. The Insert Ektron CMS400.NET ActiveTopics box appears.

Inserting CustomFunctions

ReferenceManual

Version 8.0 Rev 1.3
21-73



4. Use the following table to assist you with inserting the ActiveTopics function.

Field Description

Control ID A unique name for the function you are inserting.

BoardID

The ID of the Discussion Board.

If you do not know the board ID, you can navigate to it using the Select

folder drop down box.

DisplayMode

Choose between Active or Recent. In Activemode, the server control

displays themost active topics. In Recent mode, the server control displays

the topicswith themost recent posts.

The default isActive.

MaxNumber Themaximum number of topics listed.

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0

(zero). This is the amount of time, in seconds, a control’s data is cached.

For example, if you want to cache the data for fiveminutes, set this

property to 300 (three hundred). See Also: "Caching with Server

Controls" on page 21-31

Hide

Used to hide the function at run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Developer Topics

21-74
ReferenceManual

Version 8.0 Rev 1.3



Field Description

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

An ActiveTopics icon appears to indicate the location of the active topics list.

Shown below is an example of the code that is inserted: ***

Platform Code View

.NET
<cms:ActiveTopics BoardID="106" id="ActiveTopics1"

runat="server"></cms:ActiveTopics>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.
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Platform Code View

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Analytics
This tag appears on the following menu:

n Commands > Ektron CMS400.NET (Server Controls) > CMS Module

Controls...

To insert the Analytics function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Analytics.

3. The Insert Ektron CMS400.NET Analytics box appears.

4. Use the following table to assist you with inserting the Analytics function.

Field Description

Control ID A unique name for the function you are inserting.
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Field Description

Content ID

Specify the ID number of a content item being tracked by this function. If

you do not know the Content ID, you can navigate to it using the Select

Category and Select Content drop down boxes.

DynamicContent

Parameter

Tomake this content analytic control dynamic, select id. When you do, this

server control is attached to the content blockpassed asa URL

parameter.

Hide

Used to hide the function at run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

An Analytic icon appears to indicate that content is being tracked. If you are logged in as

a CMS user and visit the web page, you see the Analytic information. If you are not

logged in, you see nothing.
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Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:AnalyticsTracker id="AnalyticsTracker1"

DefaultContentID="30" runat="server"></cms:AnalyticsTracker>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

AssetControl
For a description of the AssetControl function, see "AssetControl Server Control" on page 7-

486.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Community Controls...

To insert the AssetControl function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click AssetControl.

3. The Insert Ektron CMS400.NET AssetControl box appears.
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4. Use the following table to assist you with inserting the AssetControl function.

Field Description

Control ID A unique name for the function you are inserting.

FolderID

The ID of the folder where assets are added. This property is used when

the UploadTypeproperty is set to Add. See Also: "UploadType" on page

21-79

If you do not know the Folder ID, you can navigate to it using the Select

Folder drop down box.

DefaultAssetID

The ID of the asset you want to update. This property is use when the

UploadTypeproperty is set to Update. See Also: "UploadType" on page

21-79"UploadType" on page 21-79

UploadType

Select whether the control addsnew assets or update existing ones.

Select Add to add assets and use the FolderIDproperty. See Also:

"FolderID" on page 21-79. Select Update to update assets and use the

DefaultAssetID. See Also: "DefaultAssetID" on page 21-79.

The default isNone.

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.
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Field Description

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

An AssetControl icon appears and indicates the AssetControl’s location on the template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:AssetControl id="AssetControl1" DefaultFolderID="0"

runat="server"></cms:AssetControl>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.
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Platform Code View

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Blog
For a description of the Blog function, see See "Blog Server Control" on page 7-533 and

"Introduction to Blog Server Controls" on page 7-532.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Community Controls...

> Blogs

To insert the Blog function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Blog.

3. The Insert Ektron CMS400.NET Blog box appears.

4. Use the following table to assist you with inserting the Blog function.
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Field Description

Control ID A unique name for the function you are inserting.

Blog ID
The ID of the blog in CMS400.NET. If you do not know the Blog ID, you

can choose it from the Select Folder drop down box.

ShowRSS

Displays the icon for the RSS feed ( ) when the box is checked. The
default isChecked.

Checked =DisplayRSS feed

Unchecked =Do not displayRSS feed

ArchiveMode

Select whether the archive appears inmonth format or year format. The

default ismonth.

MaxResults

Set themaximum number of posts to display. If set to 0 (zero), there is no

limit. If set to -1, all posts for the dayare shown. If set to -2, the all post for

themonth are shown, If set to -3, the control uses the # of Post Visible

setting in theWorkarea. The default is -3.

For information on theWorkarea setting # of post visible, see "Blog

Properties" on page 7-497.

DateToStart

The date of the last blog entries you want to appear. For example, if you

want to display blog entries for January 1, 2006 and before, you enter

1/1/2006. Clicking the dropdown boxprovides you with a calendar.

EditorHeight Sets the height of the blog editor in pixels.

EditorWidth Sets the width of the blog editor in pixels.

RecentPosts
The number of post links contained in the Recent Posts list. The default is 5

(five).

PostParameter

Works like the DynamicParameter for content blocks.When id is

selected, this server control passes the blog post ID asa URL parameter.

The default setting is id.

Blank - the list of blog posts is static. The links in the blog posts are inactive.

id - the id of the blog post is passed to the URL asa parameter.

None use default - the list of blog posts is static. The links in the blog

posts are inactive.
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Field Description

ShowHeader

Shows the title and tagline when this box is checked.

The default isChecked.

Checked = show title and tagline

Unchecked =do not show header and tagline

# of seconds -

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0

(zero). This is the amount of time, in seconds, a control’s data is cached.

For example, if you want to cache the data for fiveminutes, set this

property to 300 (three hundred). See Also: "Caching with Server

Controls" on page 21-31.

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

A Blog icon appears and indicates the Blog’s location on the template.
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Shown below is an example of the code that is inserted:

Platform Code View

.NET <cms:Blog id="Blog1" BlogID="41" runat="server"></cms:Blog>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Blog Archive
For a description of the Blog Archive function, see "BlogArchive Server Control" on page 7-

548.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Community Controls...

> Blogs

To insert the Blog Archive function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Blog Archive.

3. The Insert Ektron CMS400.NET Blog Archive box appears.

Developer Topics

21-84
ReferenceManual

Version 8.0 Rev 1.3



4. Use the following table to assist you with inserting the Blog Archive function.

Field Description

Control ID A unique name for the function you are inserting.

Blog ID
The ID of the blog in CMS400.NET. If you do not know the Blog ID, you

can choose it from the Select Folder drop down box.

# of seconds -

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0

(zero). This is the amount of time, in seconds, a control’s data is cached.

For example, if you want to cache the data for fiveminutes, set this

property to 300 (three hundred). See Also: "Caching with Server

Controls" on page 21-31

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"
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Field Description

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

A BlogArchive icon appears and indicates the Blog Archive’s location on the template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:BlogArchive id="Blogarchive1" BlogID="41"

runat="server"></cms:BlogArchive>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.
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Blog Calendar
For a description of the Blog Calendar function, see See "BlogCalendar Server Control" on

page 7-542.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Community Controls...

> Blogs

To insert the Blog Calendar function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Blog Calendar.

3. The Insert Ektron CMS400.NET Blog Calendar box appears.

4. Use the following table to assist you with inserting the Blog Calendar function.

Field Description

Control ID A unique name for the function you are inserting.

Blog ID
The ID of the blog in CMS400.NET. If you do not know the Blog ID, you

can choose it from the Select Folder drop down box.

# of seconds -

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0

(zero). This is the amount of time, in seconds, a control’s data is cached.

For example, if you want to cache the data for fiveminutes, set this

property to 300 (three hundred). See Also: "Caching with Server

Controls" on page 21-31
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Field Description

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

A Blog Calendar icon appears and indicates the Blog Calendar's location on the template.

Shown below is an example of the code that is inserted:
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Platform Code View

.NET
<cms:blogcalendar id="blogcalendar1" BlogID="41"

runat="server"></cms:blogcalendar>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Blog Categories
For a description of the Blog Categories function, see "BlogCategories Server Control" on page

7-545.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Community Controls...

> Blogs

To insert the Blog Categories function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Blog Categories.

3. The Insert Ektron CMS400.NET Blog Categories box appears.

4. Use the following table to assist you with inserting the Blog Categories function.

Inserting CustomFunctions

ReferenceManual

Version 8.0 Rev 1.3
21-89



Field Description

Control ID A unique name for the function you are inserting.

Blog ID
The ID of the blog in CMS400.NET. If you do not know the Blog ID, you

can choose it from the Select Folder drop down box.

# of seconds -

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0

(zero). This is the amount of time, in seconds, a control’s data is cached.

For example, if you want to cache the data for fiveminutes, set this

property to 300 (three hundred). See Also: "Caching with Server

Controls" on page 21-31

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

A Blog Categories icon appears and indicates the Blog Categories’ location on the

template.
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Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:BlogCategories id="BlogCategories1" BlogID="41"

runat="server"></cms:BlogCategories>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Blog Entries
For a description of the Blog Entries function, see "BlogEntries Server Control" on page 7-537.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Community Controls...

> Blogs

To insert the Blog Entries function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Blog Entries.

3. The Insert Ektron CMS400.NET Blog Entries box appears.
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4. Use the following table to assist you with inserting the Blog Entries function.

Field Description

Control ID A unique name for the function you are inserting.

Blog ID
The ID of the blog in CMS400.NET. If you do not know the Blog ID, you

can choose it from the Select Folder drop down box.

DateToStart

The date of the last blog entries you want to appear. For example, if you

want to display blog entries for January 1, 2006 and before, you enter

1/1/2006. Clicking the dropdown boxprovides you with a calendar.

PostParameter

Works like the DynamicParameter for content blocks.When id is

selected, this server control passes the blog post ID asa URL parameter.

If you do not set this parameter to id, you will not be forwarded to the blog

post’s page when you click on any links in the post.

The default setting is id.

Blank - the list of blog posts is static. The links in the blog posts are inactive.

id - the id of the blog post is passed to the URL asa parameter and

None use default - the list of blog posts is static. The links in the blog

posts are inactive.

MaxResults

Set themaximum number of posts to display. If set to 0 (zero), there is no

limit. If set to -1, all posts for the dayare shown. If set to -2, the all post for

themonth are shown, If set to -3, the control uses the # of Post Visible

setting in theWorkarea. The default is -3.

For information on theWorkarea setting # of post visible, see ”# of

Visible Posts” on page 648.

# of seconds -

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0

(zero). This is the amount of time, in seconds, a control’s data is cached.

For example, if you want to cache the data for fiveminutes, set this
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Field Description

property to 300 (three hundred). See Also: "Caching with Server

Controls" on page 21-31

DisplayXslt

Specify an externalXSLT file. See Also: "TheOverrideXslt and DisplayXslt

Properties" on page 7-207.

Warning! If you specify an external file, it is strongly recommended that

you do not store this file in your site'sWorkarea folder. If you store this file

in theWorkarea folder, the file will be lost when you upgrade.

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

A Blog Entries icon appears and indicates the Blog Entries’ location on the template.
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Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:BlogEntries id="BlogEntries1" BlogID="41"

runat="server"></cms:BlogEntries>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Blog Post
For a description of the Blog Post function, see "BlogPost Server Control" on page 7-540.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Community Controls...

> Blogs

To insert the Blog Post function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Blog Post.

3. The Insert Ektron CMS400.NET Blog Post box appears.
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4. Use the following table to assist you with inserting the Blog Post function.

Field Description

Control ID A unique name for the function you are inserting.

DefaultContent ID

The ID of a blog post in CMS400.NET. If you do not know the Blog Post’s

ID, you can navigate to it using the Select Category and Select Content

drop down boxes.

DynamicParameter
Tomake this blog post dynamic, select id. When you do, this server

control uses the blog post passed asa URL parameter.

ShowType

Showsa blogpost’s content and it’s comments or just the blogpost’

comments. The default isContent.

Content - Show a blogpost’s content and its comments.

Description - Show a blogpost’s comments only.

DisplayXslt

Specify an externalXSLT file. See Also: "TheOverrideXslt and

DisplayXslt Properties" on page 7-207

Warning! If you specify an external file, it is strongly recommended that

you do not store this file in your site'sWorkarea folder. If you store this file

in theWorkarea folder, the file will be lost when you upgrade.

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is hidden.
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Field Description

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

# of seconds -

CacheInterval

Sets the amount of time the server control’s data is cached. The default is

0 (zero). This is the amount of time, in seconds, a control’s data is cached.

For example, if you want to cache the data for fiveminutes, set this

property to 300 (three hundred). See Also: ”Caching with Server

Controls” on page 43.

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The

default isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

A Blog Post icon appears and indicates the Blog Post’s location on the template.

Shown below is an example of the code that is inserted:
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Platform Code View

.NET
<cms:BlogPost id="BlogPost1" DefaultContentID="370"

runat="server"></cms:BlogPost>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Blog Recent Posts
For a description of the Blog Recent Posts function, see ”BlogRecentPosts Server Control” on

page 720.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Community Controls...

> Blogs

To insert the Blog Recent Posts function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Blog Recent Posts.

3. The Insert Ektron CMS400.NET Blog Recent Posts box appears.

4. Use the following table to assist you with inserting the Blog Recent Posts function.
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Field Description

Control ID A unique name for the function you are inserting.

Blog ID
The ID of the blog in CMS400.NET. If you do not know the Blog ID, you

can choose it from the Select Folder drop down box.

NumberofPosts Sets the number of post links to display.

# of seconds -

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0

(zero). This is the amount of time, in seconds, a control’s data is cached.

For example, if you want to cache the data for fiveminutes, set this

property to 300 (three hundred). See Also: "Caching with Server

Controls" on page 21-31

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

A Blog Recent Posts icon appears and indicates the Blog Recent Posts’ location on the

template.
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Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:BlogRecentPosts id="BlogRecentPosts1" BlogID="41"

runat="server"></cms:BlogRecentPosts>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Blog Roll
For a description of the Blog Roll function, see "BlogRoll Server Control" on page 7-543.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Community Controls...

> Blogs

To insert the Blog Roll function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Blog Roll.

3. The Insert Ektron CMS400.NET Blog Roll box appears.
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4. Use the following table to assist you with inserting the Blog Roll function.

Field Description

Control ID A unique name for the function you are inserting.

Blog ID
The ID of the blog in CMS400.NET. If you do not know the Blog ID, you

can choose it from the Select Folder drop down box.

# of seconds -

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0

(zero). This is the amount of time, in seconds, a control’s data is cached.

For example, if you want to cache the data for fiveminutes, set this

property to 300 (three hundred). See Also: "Caching with Server

Controls" on page 21-31

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Developer Topics

21-100
ReferenceManual

Version 8.0 Rev 1.3



Field Description

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click Insert.

A Blog Roll icon appears and indicates the Blog Roll’s location on the template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:BlogRoll id="BlogRoll1" BlogID="41"

runat="server"></cms:BlogRoll>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.
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Blog RSS
For a description of the Blog RSS function, see "BlogRSS Server Control" on page 7-547.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Community Controls...

> Blogs

To insert the Blog RSS function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Blog RSS.

3. The Insert Ektron CMS400.NET Blog RSS box appears.

4. Use the following table to assist you with inserting the Blog RSS function.

Field Description

Control ID A unique name for the function you are inserting.

Blog ID
The ID of the blog in CMS400.NET. If you do not know the Blog ID, you

can choose it from the Select Folder drop down box.

# of seconds -

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0

(zero). This is the amount of time, in seconds, a control’s data is cached.

For example, if you want to cache the data for fiveminutes, set this

property to 300 (three hundred). See Also: "Caching with Server

Controls" on page 21-31
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Field Description

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click Insert.

A Blog RSS icon appears and indicates the Blog RSS’s location on the template.

Shown below is an example of the code that is inserted:
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Platform Code View

.NET
<cms:BlogRSS id="BlogRSS1" BlogID="41"

runat="server"></cms:BlogRSS>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

BreadCrumb
For a description of the BreadCrumb function, see "BreadCrumb Server Control" on page 9-285.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > CMS MENU

Controls...

To insert a BreadCrumb Trail:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click BreadCrumb.

3. The BreadCrumb dialog box appears.
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4. Use the following table to assist you with inserting a BreadCrumb Trail.

Field Description

Control ID A unique name for the function you are inserting.

Meta tag to use -

MetadataName

Specify the name of aMetadata Type that you want to associate with

the page. For more information, see "BreadCrumbMetadata Type" on

page 9-292

DisplayTitle

Enter text to describe thisWeb formwhen it appears in the

breadcrumb trail. For example, if theWeb formwhose properties you

are defining is used for all HumanResourcespageson your site, enter

Human Resources.See Also: "BreadCrumb PropertiesApply to

Web Forms, NotWeb Pages" on page 9-287

The default isTitle.

If you define an image in the IconPathproperty below, the image

appears in the trail, followed by this text.

CurrentPageIndicator

If desired, enter one or more symbols or characters that identify the

current page in the breadcrumb trail. See example below.
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Field Description

These characters appear after the image or title that identifies the

current page in the breadcrumb trail.

Content ID

Gets or Sets the ContentID for the BreadCrumb display title. If you do

not know the Content ID, you can navigate to it using the Select

Category and Select Content drop down boxes.

DynamicContent

Parameter

Gets or sets the QueryString parameter to read a content ID

dynamically.

IconPath

If you want the breadcrumb trail to display an image to identify thisWeb

form, enter the path to the image.

Warning! The image locationmust be relative to theWeb root.

For example: \CMS400Developer\Workarea\Images\bc_meta_

icon.gif

IconAlt

If you define an image in the IconPathproperty, enter any “Alt” text

that should appear when a site visitor hovers the cursor over that

image. Here is an example.

LinkTarget

Determines the type of window that appears on thisWeb formwhen a

user clicks an item in the breadcrumb trail. The default is_self.

_Self -opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame
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Field Description

LinkLast Item

Use this property to determine whether the last breadcrumb item

appears asa hyperlink on thisWeb form. If this property box is

checked, and a user clicks the item, the current page reappears.

Checked = last item is a hyperlink

Unchecked = last item is an image and/or text only; the user cannot

click on it

Create Hyperlinks

Unchecking this boxmakes the breadcrumb trail appear asnon-

hyperlinked plain text. The default isChecked.

Checked =breadcrumb trail is hyperlinked

Unchecked =breadcrumb trail is plain text

MaxItems

Enter themaximum number of items in the breadcrumb trail on this

Web form.

The default is5.

If you set a value of 1 or greater and the user navigatesbeyond that

number of pages, only themost recent pagesappear. The older pages

disappear from the trail.

To allowsan unlimited number of breadcrumb trail itemson thisWeb

form, enter zero (0).

Separator

Enter one or more characters to separate the items in a breadcrumb

trail on thisWeb form.

The default character is the greater than sign (>).
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Field Description

DisplayStyle

Indicate how to display the breadcrumb trail: horizontally or vertically.

The default isHorizontal.

This is an example ofHorizontal.

This is an example ofVertical.

Mode

Allows you tomake the breadcrumb trail appear asnon-hyperlinked

plain text. The default isNormal.

Normal =breadcrumb trail is hyperlinked

DisplayOnly =breadcrumb trail is plain text

Hide

Used to hide a BreadCrumb in design time and run time.

Checked =Hide BreadCrumb

Unchecked =Show BreadCrumb

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a block

of code.

SuppressWrapper
Suppresses the output of the span/div tagsaround the control. The

default isUnchecked.
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Field Description

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

Style (Positioning Info

- GridLayout)

Set position information of a control as absolute, when using a

GridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP:

240px"

5. When completed, click Insert.

A graphic defines where the BreadCrumb Trail appears on your template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET

<cms:BreadCrumb id="BreadCrumb1" CurrentPageIndicator="*"

myDisplayTitle="Home Page" LinkLastItem="True"

runat="server"></cms:BreadCrumb>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Calendar
This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) > CMS Function...

or
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n Commands > Ektron CMS400.NET (Server Controls) > CMS Modules

Controls...

To insert an Calendar function:

Note: Inserting a calendar function doesnot add a reference to a calendar style sheet. This stepmust be

performedmanually.

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click on Calendar

3. The Insert Calendar box is displayed.

Warning! When inserting an event calendar using ASP, CF, JSP or PHP, the dialog box that appears only allows

you to set the Calendar ID or choose one from the list.

4. Use the following table to assist you with inserting a calendar.

Field Description

Control ID A unique name for the function you are inserting.
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Field Description

Warning! Used

in ASP.NET only.

Content ID

Type in the Content ID of the calendar that you want to insert. If you do not

know the Content ID, you can navigate to it using the Select Calendar drop

down box.

Select Calendar

The drop-down box is populated with a list of all the calendar titles.When a

title is selected, the content ID textbox is filled with that content block's id

number. If you insert the calendar ID, you do not need to select a calendar.

DynamicContent

Parameter

Warning! Used

in ASP.NET only.

Tomake this calendar dynamic, select calendar_id. When you do, this

server control uses the calendar passed asa URL parameter.

DisplayType

Warning! Used

in ASP.NET only.

Specify the Calendar view type. The default isMonth.

n Month - A 30 day calendar month view.

n Day - Single day view.

n Inline - Display events that occur from the start date of the calendar

through the end date.

n MonthUpWithEvent - Displaysamonth calendar. Events appear to

the right of the calendar when you click on a day.

ShowXML

Warning! Used

in ASP.NET only.

At runtime, output the raw XML data instead of the calendar.With thisXML

data, you can apply your own XSL to create your own custom display

formats.

Default isUnchecked.

Checked =Show raw XML data

Unchecked =Show Calendar

EndDate

Warning! Used

in ASP.NET only.

Specify the end date the calendar displays. Used in conjunction with the

StartDateproperty. For example, you have a calendar that showsonly

classes for the next threemonth semester.

StartDate

Warning! Used

in ASP.NET only.

Specify the start date the calendar displays. Used in conjunction with the

EndDateproperty. For example, you have a calendar that showsonly

classes for the next threemonth semester.

Hide

Warning! Used

in ASP.NET only.

Used to hide a calendar in design time and run time.

Checked =Hide calendar

Unchecked =Show calendar

Note: If Hideand Visibleare both checked, the property is hidden.
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Field Description

Visible

Warning! Used

in ASP.NET only.

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Warning! Used

in ASP.NET only.

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Warning! Used

in ASP.NET only.

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click insert.

A graphic defines where the calendar appears on your template.

Shown below is an example of the code that is inserted.

Platform Code View

.NET
<cms:Calendar id="Calendar1" DefaultCalendarID="1"

runat="server"></cms:Calendar>
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Platform Code View

ASP <% ecmEvtCalendar (1) %>

ColdFusion
<cfmodule Calendar_id="1"

template="#request.ecm.AppPath#ecmEvtCalendar.cfm">

JSP <%= ecmEvtCalendar(1) %>

PHP <?php ecmEvtCalendar (1); ?>

Collection
For a description of the Collection function, see "Collection Server Control" on page 9-118

This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) > CMS Function...

or

n Commands > Ektron CMS400.NET (Server Controls) > Content Controls...

To insert a collection:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click Collection.

3. The Insert Ektron Collection box is displayed.

Warning! When inserting a collection using ASP, CF, JSP or PHP, a different dialog boxappears.

4. Use the following table to assist you with inserting a Collection.
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Field Description

Control ID

Warning! Used

in ASP.NET only.

A unique name for the function you are inserting.

Collection ID

If you know the collection ID, enter it into the textbox. If you do not know the

Collection ID, you can navigate to it using the Select Collection drop down

box.

Select Collection

The drop-down list is filled with a list of all the Collection titles that you have

privileges to.When a title is selected, the Collection ID textbox is filled with

that Collection's id number. If you insert the Collection ID, you do not need

to select a category.

DisplayXslt

Determineshow the information on the page is displayed.

None - databind only

ecmNavigation - lists the title of every content block in the collection

See Also: "Example of ecmNavigation Display" on page 9-124
ecmTeaser - lists the title of every content block in the collection plus the

content summary

See Also: "Example of ecmTeaser Display" on page 9-124

Warning! If you specify an external file, it is strongly recommended that

you do not store this file in your site'sWorkarea folder. If you store this file

in theWorkarea folder, the file will be lost when you upgrade.

Warning! If you enter a valid EkML file at the MarkupLanguageprop-

erty, the Displayxsltproperty value is ignored.

LinkTarget

Warning! Used

in ASP.NET only.

Defines the waya link actswhen a link is clicked.

Choicesare:

_blank - This target causes the link to alwaysbe loaded in a new blank

window. Thiswindow is not named.

_self - This target causes the link to always load in the samewindow the

anchor was clicked in. This is useful for overriding a globally assigned

BASE target.

_parent - This target makes the link load in the immediate frameset

parent of the document. This defaults to acting like “_self” if the document

hasno parent.

_top - This target makes the link load in the full bodyof the window. This

defaults to acting like “_self” if the document is alreadyat the top. It is useful

for breaking out of an arbitrarily deep frame nesting.

DynamicContent

Parameter

Warning! Used

in ASP.NET only.

Checks the QueryString for this value and replaces the collection with a

content blockwhen specified. Leave blank to alwaysdisplay the collection.
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Field Description

Dynamic

Collection

Parameter

Warning! Used

in ASP.NET only.

Tomake this collection dynamic, select coll_id. When you do, the function

uses the collection passed asa URL parameter.

GetHtml

Warning! Used

in ASP.NET only.

Check this box if you want to retrieve and display content (html body) for all

content blocks in the collection. For example, to display content inside a

web server control such asaGridView.

Checked = retrieve and display content (html body) for all content blocks

in the collection

Unchecked =do not retrieve and display content (html body) for all

content blocks in the collection

Random

Warning! Used

in ASP.NET only.

Check this box if you want to randomly display one collection item. The

item changeseach time a site visitor views the page.

Checked = randomly display one collection item

Unchecked =display collection list

# of seconds -

CacheInterval

Warning! Used

in ASP.NET only.

Sets the amount of time the server control’s data is cached. The default is

0 (zero). This is the amount of time, in seconds, a control’s data is cached.

For example, if you want to cache the data for fiveminutes, set this

property to 300 (three hundred).See Also: "Caching with Server
Controls" on page 21-31

Warning! If the EnablePagingproperty is set to True, the CacheIn-

tervalproperty is disabled.

MarkupLanguage

Warning! Used

in ASP.NET only.

Identify the templatemarkup file that controls the display of the collection.

For example, mycollectionmarkup.ekml.

If the *.ekml file is located in the same folder as theWeb form containing

the server control, just enter its name. If the file is in another folder, enter

the path relative to site root. For example,

..\CMS400Developer\workarea\customfiles\

markup\mycollectionmarkup.ekml.

See Also: "Introduction to EKML" on page 21-414 and
"collection.ekml" on page 21-441

Note: If you enter a valid EkML file, the Displayxsltproperty value is

ignored. If the EkML file contains the [$ImageIcon] variable, the

IncludeIconsproperty acts asTrue.
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Field Description

IncludeIcons

Warning! Used

in ASP.NET only.

Choose whether to display iconsnext to the collection list’s links.

Warning! This property onlyworkswhen ecmSummaryor ecmTeaser

are used in the DisplayXsltproperty.When the [$ImageIcon] var-

iable is used in an EkML file and that file is assigned to the Mark-

upLanguageproperty, this property acts asTrue.

EnablePaging

Warning! Used

in ASP.NET only.

This property, in conjunction with the MaxResultsproperty, lets site

visitors view an unlimited number of collection itemswhile controlling the

amount of screen space. To accomplish this, the collection display is limited

to the number set in the MaxResultsproperty.

If you set this property box is checked, and the number of collection items

exceeds the MaxResultsnumber, navigation aids appear below the last

item. The site visitor uses the aids to view additional items. See example

below.

So, for example, if a collection has9 itemsand the MaxResultsproperty is

set to 4, the screen displaysonly the first four items.When the site visitor

clicks [Next], he sees items5, 6, 7 and 8, etc.

Checked =enable paging

Unchecked =disable paging

Warning! If the EnablePagingproperty is set to True, the CacheIn-

tervalproperty is disabled.
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Field Description

MaxResults

Warning! Used

in ASP.NET only.

Enter themaximum number of items to appear in the initial display of this

server control.

To set nomaximum, enter zero (0).

To let site visitors view more than themaximum but limit the amount of

space being occupied, enter themaximum number of results per page

here. Then, check the EnablePagingproperty box.

If you do andmore than the number of MaxResultsare available,

navigation aids appear below the last item to help the site visitor view

additional items. See example below.

Hide

Warning! Used

in ASP.NET only.

Used to hide a collection in design time and run time.

Checked =Hide collection

Unchecked =Show collection

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Warning! Used

in ASP.NET only.

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Warning! Used

in ASP.NET only.

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Warning! Used

in ASP.NET only.

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Warning! Used

in ASP.NET only.

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags
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5. When completed, click insert.

A graphic defines where the collection appears on your template.

Shown below is an example of the code that is inserted.

Platform Code View

.NET
<cms:Collection id=”Collection1” DefaultCollectionID=”6”

DisplayXslt=”ecmTeaser” runat=”server”></cms:Collection>

ASP <% ecmCollection 6,"ecmNavigation" %>

ColdFusion
<cfmodule id="6" displayFunction="ecmNavigation"

template="#request.ecm.AppPath#ecmCollection.cfm">

JSP <%= ecmCollection(6,"ecmTeaser") %>

PHP <?php ecmCollection(6,"ecmNavigation"); ?>

Content Block
This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) > CMS Function...

or

n Commands > Ektron CMS400.NET (Server Controls) > Content Controls...

For a description of the Content Block function, see "ContentBlock Server Control" on page 7-

201.

To insert a content block:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click Content.

3. The Insert Content box is displayed
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Warning! When inserting a Content Blockusing ASP, CF, JSP or PHP, a different dialog boxappears.

4. Use the following table to help you insert a content block.

Field Description

Control ID

Warning! Used in

ASP.NET only.

A unique name for the function you are inserting.

Content ID

Specify the ID number of the content block that you wish to use asa

content blockon theWeb page. If you do not know the Content ID,

you can navigate to it using the Select Category and Select Content

drop down boxes.

Select Category
Choose the folder where the content is located. If you insert the

content ID, you do not need to select a category.

Select Content
Select the content block to use from the list. If you insert the content

ID, you do not need to select content.
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Field Description

DynamicContent

Parameter

Warning! Used in

ASP.NET only.

Determines if content is displayed as static or passed dynamically. By

making content dynamic, when the content displayed on aWeb page

contains a link to another piece of content, you can display the second

piece of content in the sameWeb page space.

None: Displaysa static content block.

id: Content block is passed asa URL parameter.

Warning! If you are using an ASP, CF, JSP or PHPpage, youmust

use the DynamicContent BlockTag to create a dynamic content

block. See "DynamicContent Block" on page 21-151

DisplayXslt

Warning! Used in

ASP.NET only.

Specify an externalXSLT file.See Also: "TheOverrideXslt and
DisplayXslt Properties" on page 7-207

Warning! If you specify an external file, it is strongly recommended

that you do not store this file in your site'sWorkarea folder. If you

store this file in theWorkarea folder, the file will be lost when you

upgrade.

Hide

Warning! Used in

ASP.NET only.

Used to hide a collection in design time and run time.

Checked =Hide collection

Unchecked =Show collection

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Warning! Used in

ASP.NET only.

Used to show or hide the function at run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is hidden.

# of seconds -

CacheInterval

Warning! Used in

ASP.NET only.

Sets the amount of time the server control’s data is cached. The

default is 0 (zero). This is the amount of time, in seconds, a control’s

data is cached. For example, if you want to cache the data for five

minutes, set this property to 300 (three hundred).See Also: See
"Caching with Server Controls" on page 21-31

Style (Positioning Info -

GridLayout)

Warning! Used in

ASP.NET only.

Set position information of a control as absolute, when using a

GridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP:

240px"

Wrap Tag

Warning! Used in

ASP.NET only.

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a

blockof code.
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Field Description

SuppressWrapper

Warning! Used in

ASP.NET only.

Suppresses the output of the span/div tagsaround the control. The

default isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

Note: You see only the list of Ektron CMS400.NET content blocks if you are working online.

5. Click insert.

A graphic indicates the static content block’s location on the template.

Shown below is an example of the code that is inserted.

Platform Code View

.NET
<cms:contentblock id="ContentBlock1" DefaultContentID="12"

runat="server"></cms:contentblock>

ASP <%ecmContentBlock(1) %>

ColdFusion <cfmodule id=”1” template=”#request.ecm.AppPath#ecmContentBlock.cfm”>

JSP <%=ecmContentBlock(12) %>

PHP <?php ecmContentBlock(1); ?>

Content List
For a description of the Content List function, see See "ContentList Server Control" on page 7-

210 .

This tag appears on the following menu(s):
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n Commands > Ektron CMS400.NET (Server Controls) > Content Controls...

To insert the Content List function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Content List.

3. The Insert Ektron CMS400.NET Content List box appears.

4. Use the following table to assist you with inserting the Content List function.

Field Description

Control ID A unique name for the function you are inserting.

ContentIds

A comma delimited list of content blocks IDs.

See Also: "Using the ContentID Property to Display a Content List"

on page 7-218

MetaTag

Specify aMetadata definition whose type isContent Selector.When you

do, the associated list of content itemswill appear where you place the

server control.

Warning! You cannot insert other metadata types.
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Field Description

Thisworkswith the DefaultContentIDproperty.

See Also: "UsingMetadata to Display an Associated Content List" on
page 7-215

For more information about usingmetadata to assign a list of related

content to a content item, see "Related Content Metadata" on page 7-

151.

DefaultContentID

Set content id value. Once set, content IDsare generated from the

MetaTag value for this content. If you do not know the content’s ID, you

can navigate to it using the Select Category and Select Content drop

down boxes.

DynamicParameter
Tomake the content dynamic, select id. When you do, this server control

uses the content passed asa URL parameter.

Random

Check this box if you want to randomly display one content list item. The

item changeseach time a site visitor views the page.

Checked = randomly display one content list item

Unchecked =display the content list

GetHtml

Check this box if you want to retrieve and display content (html body) for

all content blocks in the content list. For example, to display content inside

a web server control such asaGridView.

Checked = retrieve and display content (html body) for all content blocks

in the content list

Unchecked =do not retrieve and display content (html body) for all

content blocks in the content list

Order By

Sort the list by one of the valuesbelow.

n Title - the order of the content’s title.

n Date Modified - the last date the content wasmodified.

n Date Created - the date the content was created.

n Last Author First Name - the last editor’s first name.

n Last Author Last Name - the last editor’s last name.

n OrderOfTheIds - preserves the content ID order based on the list

in the ContentIdsproperty.

Direction Choose whether the list is sorted in Ascending or Descending order.
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Field Description

DisplayXslt

Determineshow information on the page is displayed.

None-databind only

ecmNavigation - lists the title of each content block

See Also: "Example of ecmNavigation Display" on page 9-124

ecmTeaser - lists the title of each content blockplus the content summary

See Also: See "Example of ecmTeaser Display" on page 9-124

ecmUnOrderedList - sorts the list in no particular order. Shows the title

and content summary

Warning! If you specify an external file, it is strongly recommended that

you do not store this file in your site'sWorkarea folder. If you store this file

in theWorkarea folder, the file will be lost when you upgrade.

Warning! If you enter a valid EkML file at the MarkupLanguageprop-

erty, the Displayxsltproperty value is ignored.

LinkTarget

Defines the waya link actswhen a link is clicked.

_blank - This target causes the link to alwaysbe loaded in a new blank

window. Thiswindow is not named.

_self - This target causes the link to always load in the samewindow the

anchor was clicked in. This is useful for overriding a globally assigned

base target.

_parent - This target makes the link load in the immediate frameset

parent of the document. This defaults to acting like "_self" if the document

hasno parent.

_top - This target makes the link load in the full bodyof the window. This

defaults to acting like "_self" if the document is alreadyat the top. It is

useful for breaking out of an arbitrarily deep frame nesting.

# of seconds -

CacheInterval

Sets the amount of time the server control’s data is cached. The default is

0 (zero). This is the amount of time, in seconds, a control’s data is cached.

For example, if you want to cache the data for fiveminutes, set this

property to 300 (three hundred).See Also: "Caching with Server

Controls" on page 21-31
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Field Description

IncludeIcons

Choose whether to display iconsnext to the content list’s links.

Warning! This property onlyworkswhen ecmSummaryor ecmTeaser

are used in the DisplayXsltproperty.When the [$ImageIcon] var-

iable is used in an EkML file and that file is assigned to the Mark-

upLanguageproperty, this property acts asTrue.

MarkupLanguage

Identify the templatemarkup file that controls the display of the content

list. For example, mycontentlistmarkup.ekml.

If the *.ekml file is located in the same folder as theWeb form containing

the server control, just enter its name. If the file is in another folder, enter

the path relative to site root. For example,

..\CMS400Developer\workarea\customfiles\

markup\mycontentlistmarkup.ekml.

See Also: . ”EktronMarkup Language” on page 35 and
”contentlist.ekml” on page 75

Note: If you enter a valid EkML file, the DisplayXsltproperty value is

ignored. If the EkML file contains the [$ImageIcon] variable, the

IncludeIconsproperty acts asTrue.

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page.
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Field Description

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The

default isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

A Content List icon appears and indicates the Content List’s location on the template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET

<cms:ContentList ID="ContentList1" DynamicParameter="id"

DefaultContentID="30" OrderKey="DateCreated"

DisplayXslt="ecmTeaser" runat="server"></cms:ContentList>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.
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Content Rating
For a description of the Content Rating function, see See "ContentRating Server Control" on

page 7-747 .

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Content Controls...

To insert the Content Rating function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click ContentRating.

3. The Insert Ektron CMS400.NET Content Rating box appears.

4. Use the following table to assist you with inserting the Content Rating function.

Field Description

Control ID A unique name for the function you are inserting.

Content ID

Specify the ID number of a content item being tracked by this function. If

you do not know the Content ID, you can navigate to it using the Select

Category and Select Content drop down boxes.

DynamicContent

Parameter

Tomake this content rating control dynamic, select id. When you do, this

server control is attached to the content blockpassed asa URL

parameter.
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Field Description

CompleteGraph

Display

Specify a value to indicate how the ratingsgraph appears if a site visitor

hasalready rated content.

n horizontal - graph appears to the right of the Alrea-

dyRatedMessage

n vertical - graph appears below the AlreadyRatedMessage

n none - graph doesnot appear

GraphBarColor The color of the bars in the graph.

InitialGraphDisplay

Specify a value to indicate how the ratingsgraph appears if a site visitor

hasnot yet rated content.

n horizontal - graph appears to the right of the content rating scale

n vertical - graph appears below the content rating scale

n none - graph doesnot appear

Padding

Enter the number of pixels used to create space between the rating scale

and the graph.

Note: If you do not display the graph, this setting hasno effect.

Hide

Used to hide the function at run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.
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Field Description

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

An Content Rating icon appears and indicates the Content Rating’s location on the

template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:ContentRating id="ContentRating1" DefaultContentID="30"

runat="server"></cms:ContentRating>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Content XSLT Tag...
The insert content XSLT command allows you to insert an XML content block, and specify an

XSLT (other than the default) to be applied to it.

This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) > XML Function...
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To insert a content XSLT tag, perform the following steps:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET XML functions, click on Insert Content XSLT

Tag...

3. The Insert Ektron CMS400.NET Content and Apply an XSLT Tag box is displayed.

4. Use the following table to assist you with this form.

Field Description

Content

ID

Either type in, or select from the drop down lists, the ID number of the XML content to

insert.

Select

XSLT

From the drop down list, select the XSLT you would like to apply to the XML content

block.

Enter

XSLT

If “Enter XSLT” is selected, you can insert the path and file name of the XSLT to apply

to the content.

Warning! If you specify an external file, it is strongly recommended that you do not

store this file in your site'sWorkarea folder. If you store this file in theWorkarea

folder, the file will be lost when you upgrade.

5. Click insert.

A graphic showing you where the XML content block will be placed on the template is

inserted.
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Shown below is the code that will be inserted according to the platform that has been

specified in the setup:

Platform Code View

.NET This function is not available asan Ektron Dreamweaver Extension for .NET.

ASP <% ecmContentBlockEx 30, "", 1 %>

ColdFusion
<cfmodule id="5" xsltpath="" xslttype="1"

template="#request.ecm.AppPath#ecmContentBlockEx.cfm">

JSP <%= ecmContentBlockEx(24, "", 0 ) %>

PHP <?php ecmContentBlockEx (5, ““, 1); ?>

DHTML Menu
For a description of the DHTML Menu function, see See "DhtmlMenu Server Control" on page

9-191 .

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > CMS MENU

Control...

To insert a DHTML Menu:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click DHTML Menu

The DHTML Menu Control box appears.
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3. Use the following table to assist you with inserting a DHTML Menu.

Field Description

Control ID A unique name for the function you are inserting.

DefaultMenuID

The numeric id of themenu that you want to insert. If you do not

know the DefaultMenuID path, you can navigate to it using the

Select Menu drop down box.

Select Menu

Select amenu to be used.When amenu is selected, the

DefaultMenuID textbox is filled with that menu's id number. If you

insert the DefaultMenuID, you do not need to select amenu.

Align

Specifies the horizontal alignment of the root menu text.

The default isCenter.

NotSet - Use the default setting.

Left - Aligns text to the left.

Center - Aligns text to the center.

Right - Aligns text to the right.
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Field Description

Justify - Aligns text justified to bothmargins.

HorizontalDisplay

Displays submenu to the right of the root menu. This only affects

the first submenu of the root menu. All subsequent submenus

appear to the right of each submenu.

The default isUnchecked

Checked =Submenu appears to the right of the root menu

Unchecked=Submenu appears below the root menu

CssClass

Apply a .css class to the root menu. Enter the classname from the

.cssdefined in the Stylesheetproperty.

Since pop_style.css is the default style sheet, you can use its

classeswithout defining it in the Stylesheetproperty.

For example, if you enter lowtext in the property, the root menu

changesas shown below.
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Field Description

MenuHoverOverColor
Sets the background color for the root menu when hovering over

it.

SubMenuBackColor Sets the background color for the submenu.

SubMenuHoverOverColor Sets the background color for the submenuwhen hovering over it.

BackColor
Sets the background color for the root menu. This property

appears in theAppearance category

ForeColor
Sets the color of the font for the root menu. This property appears

in theAppearance category.

Font-Bold Checking this boxallows the font to appear bold.

Font_Italic Checking this boxallows the font to appear italics.

# of seconds -

CacheInterval

Sets the amount of time the server control’s data is cached. The

default is 0 (zero). This is the amount of time, in seconds, a

control’s data is cached. For example, if you want to cache the

data for fiveminutes, set this property to 300 (three hundred).

See Also: "Caching with Server Controls" on page 21-31

FontNames Enter the name of a font to use.

Font-Size The size of the font.

SubMenuItemHeight

Sets the height of each submenu item in pixels. The Default is 20

Example set to 20:

Example set to 30:

SubMenuItemWidth

Sets the width of each submenu item in pixels. The Default is 150

Example set to 150:

Example set to 130:
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Field Description

SubMenuTopOffset

Sets the location of the top of the submenu. This number is in

pixels. The default is 3

Example set to 5:

Example set to 0 (zero):

Example set to -10:

MenuStyle

A specified inline style that defines the root menu.

For example, if you enter the following in the MenuStyleproperty

box:

font: bold 18px Arial;color:royalblue; background-

color:slateblue

StyleSheet

Specify the location and style sheet for the submenu. For example:

\Workarea\csslib\mytest.css.

Leave blank to use the default.

pop_style.css is the default style sheet. It is located in

\webroot\CMS400Developer\Workarea\csslib.

The Stylesheetproperty can be used in conjunction with the

CssClassproperty to define the root menu.

DynamicMenu Parameter

Checks the QueryString for themenu value and replaces the

menu with content when ID is specified. Leave blank to always

display themenu.

None - Use Default

menu_ID - The control uses themenu passed asa URL

parameter.
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Field Description

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a

blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control.

The default isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is

hidden.

Hide

Used to hide the function at run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is

hidden.

Style (Positioning Info -

GridLayout)

Set position information of a control as absolute, when using a

GridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP:

240px"

4. When completed, click insert.

A graphic defines where the DHTML Menu appears on your template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:DhtmlMenu id="DhtmlMenu1" DefaultMenuID="16" ForeColor=""

runat="server"></cms:DhtmlMenu>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.
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Platform Code View

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Directory-Taxonomy
For a description of the Directory-Taxonomy function, see "Directory Server Control" on page

9-241.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Content Controls...

To insert a Directory-Taxonomy:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click Directory-Taxonomy

The Directory-Taxonomy Control box appears.

3. Use the following table to assist you with inserting a Directory-Taxonomy.

Field Description

Control ID A unique name for the function you are inserting.
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Field Description

TaxonomyId

Enter the ID number of the taxonomyor category to appear in this

server control. If you don’t know the number, click the button and

navigate to the taxonomyor category.

When you select one, it appears in the center of the VisualStudio

window.

ItemsControlId
Specify the id of the <span>or <div> tag you will use to format the

display of taxonomy items.

TaxonomyCols
Enter the number of columns in which this taxonomy/categorywill

appear on the page.

TaxonomyDepth

Enter the number of taxonomy levels to retrieve below each

taxonomy/category. Only the top level is displayed in the control. The

rest of the levels are available through XML in code behind. For

example, if the taxonomy isBusinesses > Restaurants > Pizza, and

you set Taxonomy Depth to 2, onlyBusinessand Restaurants are

available in code behind.

To retrieve the all of the categories for a taxonomy recursively, enter -1.

A depth greater than 1 or using -1 is only useful if you create a custom

output using the Taxonomy’sXML.

The default value is 1

Warning! For a live site, Ektron strongly recommends leaving this

value at 1. Increasing this value can slow down your liveWeb server.

However, for testing on a staging server, you can increase the depth.

DynamicParameter
Gets or sets the QueryString parameter to read a content ID

dynamically.

LinkTarget

Defines the waya link actswhen it is clicked. The choicesare:

_blank - loads the link in a new blankwindow. Thiswindow is not

named.

_self - loads the link in the samewindow the anchor was clicked in. This

is useful for overriding a globally assigned base target.

_parent - loads the link in the immediate frameset parent of the

document. This defaults to acting like “_self” if the document hasno

parent.

_top - loads the link in the full bodyof the window. This defaults to acting

like “_self” if the document is alreadyat the top. It is useful for breaking

out of an arbitrarily deep frame nesting.
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Field Description

MaxResults

Enter themaximum number of items to appear in the initial display of this

server control.

To set nomaximum, enter zero (0).

To let site visitors view more than themaximum but limit the amount of

space being occupied, enter themaximum number of results per page

here. Then, check the EnablePagingproperty box.

If you do andmore than the number of MaxResultsare available,

navigation aids appear below the last item to help the site visitor view

additional items. See example below.

EnableAjax

Check this box to enable Ajax searches.When enabled, the

MaxResultsproperty determines themaximum number of results per

page.

Checked =Enable AjaxSearch

Unchecked =OriginalHTMLSearch

EnablePaging

This property, in conjunction with the MaxResultsproperty, lets site

visitors view an unlimited number of taxonomy itemswhile controlling

the amount of screen space. To accomplish this, the taxonomydisplay is

limited to the number set in the MaxResultsproperty.

If you check this property box, and the number of taxonomy items

exceeds the MaxResultsnumber, navigation aids appear below the

last item. The site visitor uses the aids to view additional items. See

example below.

So, for example, if a taxonomyhas9 itemsand the MaxResults

property is set to 3, the screen displaysonly the first three items.When

the site visitor clicks [Next], he sees items4, 5 and 6, etc.

Checked =enablespaging

Unchecked =disables paging

Warning! If the EnablePagingproperty is set to True, the CacheIn-

tervalproperty is disabled.
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Field Description

TaxonomySearch

Check this box if you want a search box (shown below) to appear above

this taxonomydisplay. A site visitor can use the search to find content

within a taxonomy/category that includes termsof interest.

Checked =a search boxappears above the taxonomydisplay

Unchecked = suppress the search box

DisplayXslt

Determineshow the information on the page is displayed. Optionsare

None - databind only

ecmNavigation - lists the title of every content block in the folder

See Also: . "Example of ecmNavigation Display" on page 9-124
ecmTeaser - lists the title of every content block in the folder plus the

content summary

See Also: "Example of ecmTeaser Display" on page 9-124

Path to Custom Xslt - Enter the path to an Xslt that determines the

display of the page

Warning! If you specify an external file, it is strongly recommended

that you do not store this file in your site'sWorkarea folder. If you store

this file in theWorkarea folder, the file will be lost when you upgrade.

Note: If an EkML file is inserted into the MarkupLanguageproperty, this

value is ignored.

NaviDisplayControlId

Specify the id of the <span>or <div> tag to format the display of this

taxonomy’s navigation. Here is an example.

Top : Restaurant : Italian (0)

# of seconds -

CacheInterval

Sets the amount of time the server control’s data is cached. The default

is 0 (zero). This is the amount of time, in seconds, a control’s data is

cached. For example, if you want to cache the data for fiveminutes, set

this property to 300 (three hundred).See Also: "Caching with

Server Controls" on page 21-31

Warning! the EnablePagingproperty is set to True, the CacheIn-

tervalproperty is disabled.
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Field Description

MarkupLanguage

Identify the templatemarkup file that controls the display of the

taxonomy. For example, mytaxonomymarkup.ekml.

If the *.ekml file is located in the same folder as theWeb form containing

the server control, just enter its name. If the file is in another folder, enter

the path relative to site root. For example,

\CMS400Developer\workarea\customfiles\

markup\mytaxonomymarkup.ekml.

See Also: . "EktronMarkup Language" on page 21-414 and
"taxonomy.ekml" on page 21-467

Note: If you enter a valid EkML file, the Displayxsltproperty value is

ignored.

Hide

Used to hide the function at run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using a

GridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a block

of code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The

default isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

4. When completed, click insert.

A graphic defines where the Directory-Taxonomy appears on your template.
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Shown below is an example of the code that is inserted:

Platform Code View

.NET

<cms:Directory id="Directory1" TaxonomyId="2"

DisplayXslt="ecmTeaser" DynamicParameter="id"

runat="server"></cms:Directory>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Discussion Forum
For a description of the Discussion Forum function, see "Discussion Board Server Controls" on

page 7-665.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Community Controls...

> Forums

To insert the Discussion Forum function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Discussion Forum.

3. The Insert Ektron CMS400.NET Discussion Forum box appears.
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4. Use the following table to assist you with inserting the Blog function.

Field Description

Control ID A unique name for the function you are inserting.

Board ID

The ID of the Discussion Board in CMS400.NET. If you do not know

the Board ID, you can choose it from the Select Folder drop down

box.

JavascriptEditorToolbar

Note: Asof version 7.6, the JavaScript editor hasbeen removed

fromCMS400.NET. This property hasbeen deprecated.

Decide which buttonsare available in the JavaScript Editor.

JavascriptEditorWidth

Note: Asof version 7.6, the JavaScript editor hasbeen removed

fromCMS400.NET. This property hasbeen deprecated.

Set the width in pixels for the editor. The default is625.

JavascriptEditorHeight

Note: Asof version 7.6, the JavaScript editor hasbeen removed

fromCMS400.NET. This property hasbeen deprecated.

Set the height in pixels for the editor. The default is 400.

# of seconds -

CacheInterval

Sets the amount of time the server control’s data is cached. The

default is 0 (zero). This is the amount of time, in seconds, a control’s

data is cached. For example, if you want to cache the data for five

minutes, set this property to 300 (three hundred).See Also:
"Caching with Server Controls" on page 21-31

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function
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Field Description

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning Info -

GridLayout)

Set position information of a control as absolute, when using a

GridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP:

240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a

blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The

default isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

A Discussion Forum icon appears and indicates the Discussion Forum’s location on the

template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:Forum id="Forum1" BoardID="106"

runat="server"></cms:Forum>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.
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Platform Code View

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Display By Meta Value
For a description of the Display By Meta Value function, see "MetaDataList Server Control"

on page 7-175.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Content Controls...

To insert Display By Meta Value:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click Display By Meta Value

The Display By Meta Value box appears.

3. Use the following table to assist you with inserting Display By Meta Value.
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Field Description

Control ID A unique name for the function you are inserting.

FolderID
The numeric id of the folder that you want to use. If you do not know the

folder ID, you can navigate to it using the Select folder drop down box.

Select Folder

Select a folder path to be used.When a folder is selected, the folderID

textbox is filled with that folder's id number. If you insert the Folder ID, you

do not need to select a folder.

IncludeIcons

Choose whether to display iconsnext to themetadatalist’s links.

Warning! This property onlyworkswhen ecmSummaryor ecmTeaser

are used in the DisplayXsltproperty.When the [$ImageIcon] var-

iable is used in an EkML file and that file is assigned to the Mark-

upLanguageproperty, this property acts asTrue.

Recursive
Determineswhether the DisplayByMeta Value control uses this folder’s

child folders.

EnablePaging

This property, in conjunction with the MaxResultsproperty, lets site

visitors view an unlimited number of taxonomy itemswhile controlling the

amount of screen space. To accomplish this, the taxonomydisplay is

limited to the number set in the MaxResultsproperty.

If you check this property box, and the number of taxonomy itemsexceeds

the MaxResultsnumber, navigation aids appear below the last item. The

site visitor uses the aids to view additional items. See example below.

So, for example, if a taxonomyhas9 itemsand the MaxResultsproperty
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Field Description

is set to 3, the screen displaysonly the first three items.When the site

visitor clicks [Next], he sees items4, 5 and 6, etc.

Checked =enablespaging

Unchecked =disables paging

Warning! If the EnablePagingproperty is set to True, the CacheIn-

tervalproperty is disabled.

Order By

Specify how you want to order the results that are generated. Also specify

if you want the results in ascending or descending order.

n Title - The title of the content block

n Date Created - The date the content blockwascreated

n Date Modified - The date the content blockwas last modified

n Last Author Last Name - The last author’s last name

n Last Author First Name - The last author’s first name

n ID - The content blocks ID

n Ascending - Alphabetic or numerical order

n Descending - Reverse alphabetic or numerical order
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Field Description

MaxResults

Enter themaximum number of items to appear in the initial display of this

server control.

To set nomaximum, enter zero (0).

To let site visitors view more than themaximum but limit the amount of

space being occupied, enter themaximum number of results per page

here. Then, check the EnablePagingproperty box.

If you do andmore than the number of MaxResultsare available,

navigation aids appear below the last item to help the site visitor view

additional items. See example below.

ExactPhrase

Determineswhether the KeyWordValue needs tomatch the phrase

exactly.

For example, if “site” is the KeyWordValue and the title of a content block is

“Welcome to the site” and the ExactPhrase box is checked, you would not

see the content block in themetadata list. This is because “site” doesnot

equal “Welcome to the site”.

Checked =Match the exact phrase

Unchecked =Doesn’t need tomatch exact phrase

LinkTarget

Defines the waya link actswhen a link is clicked.

Choicesare:

_blank - This target causes the link to alwaysbe loaded in a new blank

window. Thiswindow is not named.

_self - This target causes the link to always load in the samewindow the

anchor was clicked in. This is useful for overriding a globally assigned

BASE target.

_parent - This target makes the link load in the immediate frameset

parent of the document. This defaults to acting like “_self” if the document

hasno parent.

_top - This target makes the link load in the full bodyof the window. This

defaults to acting like “_self” if the document is alreadyat the top. It is useful

for breaking out of an arbitrarily deep frame nesting.
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Field Description

KeyWordName

The KeyWordName is the container where the KeyWordValuesare

located.

Some examplesof a KeyWordNamemight be “Keywordsor Title.”

For information on creating KeyWordNames for Metadata, see the Ektron

CMS400.NET AdministratorsManual > “Managing Content” > “Metadata”

> “ManagingMetadata Definitions” > “Adding aMetadata Definitions”

KeyWordValue
The value that is associated with the KeyWordName.

Some examplesof a KeyWordValuemight be “Home; page; or company”

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0

(zero). This is the amount of time, in seconds, a control’s data is cached.

For example, if you want to cache the data for fiveminutes, set this

property to 300 (three hundred).See Also: "Caching with Server

Controls" on page 21-31

Warning! If the EnablePagingproperty is set to True, the CacheIn-

tervalproperty is disabled.

DisplayXslt

Determineshow the information on the page is displayed.

None-databind only

ecmNavigation - lists the title of every content block in the folder

See Also: "Example of ecmNavigation Display" on page 9-124
ecmTeaser - lists the title of every content block in the folder plus the

content summary

See Also: "Example of ecmTeaser Display" on page 9-124

Warning! If you specify an external file, it is strongly recommended that

you do not store this file in your site'sWorkarea folder. If you store this file

in theWorkarea folder, the file will be lost when you upgrade.

Warning! If you enter a valid EkML file at the MarkupLanguageproperty,

the Displayxsltproperty value is ignored.

MarkupLanguage

Identify the templatemarkup file that controls the display of themetadata

list. For example, mymetadatalistmarkup.ekml.

If the *.ekml file is located in the same folder as theWeb form containing

the server control, just enter its name. If the file is in another folder, enter

the path relative to site root. For example,

..\CMS400Developer\workarea\customfiles\

markup\mymetadatalist.ekml.

See Also: "Introduction to EKML" on page 21-414 and
"metadatalist.ekml" on page 21-465

Note: If you enter a valid EkML file, the DisplayXsltproperty value is

ignored. If the EkML file contains the [$ImageIcon] variable, the

IncludeIconsproperty acts asTrue.
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Field Description

DynamicContent

Parameter

Checks the QueryString for the content block ID value and replaces the

DisplayByMeta Value Controlwith content when an ID is specified. Leave

blank to alwaysdisplay the DisplayByMeta Value Control.

None - Use Default

ID - The control uses the content blockpassed asa URL parameter.

Content Type

Defineswhat type of list summaryappears.

Content - Displaysonly content blocks in the folder.

All Types - Displaysall content in the folder.

Forms - Displaysonly forms in the folder.

Archive_Content - Displaysarchived content from the folder.

Archive_Forms - Displaysarchived forms from the folder.

GetHtml

Check this box if you want to retrieve and display content (html body) for all

content blocks in the collection. For example, display content inside a web

server control such asaGridView.

Checked = retrieve and display content (html body) for all content blocks

in themetadata list

Unchecked =do not retrieve and display content (html body) for all

content blocks in themetadata list

Hide

Used to hide the function in design time and run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page. For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.
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Field Description

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

4. When completed, click insert.

A graphic defines where the Display By Meta Value appears on your template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:metadatalist id="Metadatalist1" FolderId="6"

DisplayXslt="ecmTeaser" runat="server"></cms:metadatalist>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Dynamic Content Block
This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) > CMS Function...

For a description of a dynamic content block, see "Dynamic Content Block" on page 21-254
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To insert a dynamic content block tag:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Content functions, click on Dynamic Tag...

3. The Insert Ektron Dynamic Tag box is displayed

4. Use the following table to assist you with inserting a dynamic content block function.

Field Description

Insert Default

Content

If you want a static content block to be displayed if no ID is passed through the

URL, place a check in this box.

Default

Content ID

Specify the ID number of the content block that you wish to use asa default

content blockon theWeb page.

Select Content
If you are working online, youmayselect the content block to use asa default

content block from the list.

5. When completed, click Insert.

A graphic to define where the dynamic content block has been placed on your template is

inserted.

Developer Topics

21-152
ReferenceManual

Version 8.0 Rev 1.3



Shown below is the code that will be inserted according to the platform that has been

specified in the setup:

Platform Code View

.NET
For ASP.NET pages, use the CMS400.NET (Server Control) Content Block tag

and set the dynamic parameter to id. See "Content Block" on page 21-118

ASP

<% if request.QueryString(“id”)<> “” then

ecmContentBlock(request.QueryString(“id”)) else

ecmContentBlock(1) end if %>

ColdFusion

<cfif isdefined(“url.id”)>

<cfmodule id=”#url.id#”

template=”#request.ecm.AppPath#ecmContentBlock.cfm”>

<cfelse>

<cfmodule id=”1”

template=”#request.ecm.AppPath#ecmContentBlock.cfm”>

</cfif>

JSP
Inserting a DynamicContent Blockusing Ektron’sDreamweaver Extensions is

not supported in JSP.

PHP <?php $id =GetURL_Id(1); ecmContentBlock($id); ?>

Folder Bread Crumb
For a description of the Folder Bread Crumb function, see "FolderBreadcrumb Server Control"

on page 9-294.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > CMS MENU

Controls...

To insert a Folder Bread Crumb Trail:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click Folder BreadCrumb.

3. The Folder Bread Crumb dialog box appears.
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4. Use the following table to assist you with inserting a Folder Bread Crumb.

Field Description

Control ID A unique name for the function you are inserting.

FolderID
The numeric id of the folder that you want to use. If you do not know the

folder ID, you can navigate to it using the Select folder drop down box.

Content ID

Gets or Sets the ContentID. If you do not know the Content ID, you can

navigate to it using the Select Category and Select Content drop down

boxes.

DynamicParameter Gets or sets the QueryString parameter to read a content ID dynamically.

DisplayStyle
Indicate how to display the folder bread crumb: horizontally or vertically.

The default isHorizontal.

Hide

Used to hide a FolderBreadcrumb in design time and run time.

Checked =Hide FolderBreadcrumb

Unchecked =Show FolderBreadcrumb

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.
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Field Description

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The

default isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click Insert.

A graphic defines where the Folder Bread Crumb appears on your template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:FolderBreadcrumb id="FolderBreadcrumb1"

DefaultContentID="65" runat="server"></cms:FolderBreadcrumb>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.
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Platform Code View

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Form
For a description of the Form function, see "FormBlock Server Control" on page 7-281

This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) > CMS Function...

or

n Commands > Ektron CMS400.NET (Server Controls) > Content Controls...

To insert a form:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Content functions, click Form

3. The Insert Form box is displayed.

Developer Topics

21-156
ReferenceManual

Version 8.0 Rev 1.3



Warning! When inserting a form tag using ASP, CF, JSP or PHP, a different dialog boxappears.

4. Use the following table to assist you with inserting a form.

Field Description

Control ID

Warning! Used

in ASP.NET only.

A unique name for the function you are inserting.

Form ID
Type in the form ID that you want to insert. If you do not know the Form ID,

you can navigate to it using the Select Form drop down box.

Select Form

The drop-down box is populated with a list of all the form titles.When a title

is selected, the form ID textbox is filled with that form's id number. If you

insert the Form ID, you do not need to select a form.

DynamicForm

Parameter

Warning! Used

in ASP.NET only.

Tomake this form blockdynamic, select ekfrm. When you do, this control

uses the form blockpassed asa URL parameter.

# of seconds -

CacheInterval

Warning! Used

in ASP.NET only.

Sets the amount of time the server control’s data is cached. The default is 0

(zero). This is the amount of time, in seconds, a control’s data is cached.

For example, if you want to cache the data for fiveminutes, set this

property to 300 (three hundred).See Also: "Caching with Server
Controls" on page 21-31

Add Validation

Warning! Used

in ASP.NET only.

When checked, addsValidation to your main runat=server form.

Checked =add validation

Unchecked =Do not add validation

Include Form

Tags

Warning! Used

in ASP.NET only.

Determines if tagsare generated automatically or manually.See Also:
"Automatic versusManualGeneration of Form Tags" on page 7-284

Checked =automatically generate form tags

Unchecked =generate form tagsmanually
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Field Description

Hide

Warning! Used

in ASP.NET only.

Used to hide a form in design time and run time.

Checked =Hide form

Unchecked =Show form

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Warning! Used

in ASP.NET only.

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Warning! Used

in ASP.NET only.

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Warning! Used

in ASP.NET only.

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click Insert.

A graphic defines where the form appears on your template.

Shown below is an example of the code that is inserted.
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Platform Code View

.NET
<cms:FormBlock id="FormBlock1" DefaultFormID="13"

runat="server"></cms:FormBlock>

ASP <% ecmFormBlock (1) %>

ColdFusion <cfmodule id="1" template="#request.ecm.AppPath#ecmFormBlock.cfm">

JSP <%= ecmFormBlock(1) %>

PHP <?php ecmFormBlock (1); ?>

ImageControl
For a description of the ImageControl function, see "AssetControl Server Control" on page 7-

486.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Community Controls...

To insert the ImageControl function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click ImageControl.

3. The Insert Ektron CMS400.NET ImageControl box appears.

4. Use the following table to assist you with inserting the ImageControl function.
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Field Description

Control ID A unique name for the function you are inserting.

FolderID

The ID of the folder where Imagesare located. This property is used when

the UploadTypeproperty is set to Update.

If you do not know the Folder ID, you can navigate to it using the Select

Folder drop down box.

UploadType

Select whether the control addsnew assets or update existing ones.

Select Add to add assets and use the FolderIDproperty. The default is

None.

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

An ImageControl icon appears and indicates the ImageControl’s location on the template.
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Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:ImageControl id="ImageControl1" DefaultFolderID="14"

UploadType=”Update” runat="server"></cms:AssetControl>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Language API
For a description of the Language API function, see ”LanguageAPI Server Control” on page

 58.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Content Controls...

To insert a Language API:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click Language API

3. The Language API box appears.
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4. Use the following table to assist you with inserting a Language API box.

Field Description

Control ID A unique name for the function you are inserting.

Hide

Used to hide a Language API in design time and run time.

Checked =Hide Language API

Unchecked =Show Language API

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning Info -

GridLayout)

Set position information of a control as absolute, when using a

GridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP:

240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a

blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The

default isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click insert.
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A graphic defines where the Language API appears on your template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:LanguageAPI id="LanguageAPI2"

runat="server"></cms:LanguageAPI>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Language Select Box
For a description of the Language Select Box, see "LanguageSelect Server Control" on page

14-46.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Content Controls...

To insert a Language Select Box:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click Language Select

3. The Language Select box appears.
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4. Use the following table to assist you with inserting a Language Select box.

Field Description

Control ID A unique name for the function you are inserting.

Hide

Used to hide a function in design time and run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hide and Visibleare both checked, the property is hidden.

Style (Positioning Info -

GridLayout)

Set position information of a control as absolute, when using a

GridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP:

240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a

blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The

default isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click insert.
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A graphic defines where the Language Select appears on your template.

Shown below is an example of the code that is inserted.

Platform Code View

.NET
<cms:LanguageSelect id="LanguageSelect1"

runat="server"></cms:LanguageSelect>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

List Summary
For a description of the List Summary function, see "ListSummary Server Control" on page 9-

270.

This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) > CMS Function...

or

n Commands > Ektron CMS400.NET (Server Controls) > Content Controls...

To insert a list summary:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click List Summary.

3. The Insert Ektron List Summary box is displayed.
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Warning! When inserting a list summaryusing ASP, CF, JSP or PHP, a different dialog boxappears.

4. Use the following table to assist you with inserting a metadata control.

Field Description

Control ID A unique name for the function you are inserting.
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Field Description

Warning! Used

in ASP.NET only.

Folder ID
Enter the folder ID. If you do not know the folder path, you can navigate to

it using the Select folder drop down box.

Select Folder

Select the folder the summary information comes from. The folder drop-

down contains folders from your site. If you insert the folder path, you do

not need to select a folder from the dropdown box.

Recursive
If checked, summary information is gathered from the folder selected and

all of its child folders.

IncludeIcons

Warning! Used

in ASP.NET only.

Choose whether to display iconsnext to the list summary list’s links.

Warning! This property onlyworkswhen ecmSummaryor ecmTeaser

are used in the DisplayXsltproperty.When the [$ImageIcon] var-

iable is used in an EkML file and that file is assigned to the Mark-

upLanguageproperty, this property acts asTrue.
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Field Description

EnablePaging

Warning! Used

in ASP.NET only.

This property, in conjunction with the MaxResultsproperty, lets site

visitors view an unlimited number of taxonomy itemswhile controlling the

amount of screen space. To accomplish this, the taxonomydisplay is

limited to the number set in the MaxResultsproperty.

If you check this property box, and the number of taxonomy itemsexceeds

the MaxResultsnumber, navigation aids appear below the last item. The

site visitor uses the aids to view additional items. See example below.

So, for example, if a taxonomyhas9 itemsand the MaxResultsproperty

is set to 3, the screen displaysonly the first three items.When the site

visitor clicks [Next], he sees items4, 5 and 6, etc.

Checked =enablespaging

Unchecked =disables paging

Warning! If the EnablePagingproperty is set to True, the CacheIn-

tervalproperty is disabled.

OrderKey

Specify how the summaries are ordered. Sort by the following criteria.

n Title - The title of the content block

n Date Created - The date the content blockwascreated

n Date Modified - The date the content blockwas last modified

n Last Author Last Name - The last author’s last name

n Last Author First Name - The last author’s first name

n Ascending - Alphabetic or numerical order

n Descending - Reverse alphabetic or numerical order
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Field Description

MaxNumber of

results

Warning! Used

in ASP.NET only.

Enter themaximum number of items to appear in the initial display of this

server control.

To set nomaximum, enter zero (0).

To let site visitors view more than themaximum but limit the amount of

space being occupied, enter themaximum number of results per page

here. Then, check the EnablePagingproperty box.

If you do andmore than the number of MaxResultsare available,

navigation aids appear below the last item to help the site visitor view

additional items. See example below.

DisplayXslt

Warning! Used

in ASP.NET only.

Determineshow the information on the page is displayed. Select:

None - databind only

ecmNavigation - lists the title of every content block in the folder

See Also: See "Example of ecmNavigation Display"
on page 9-124
ecmTeaser - lists the title of every content block in the folder plus the

content summary

See Also: "Example of ecmTeaser Display" on page 9-124
Path to Custom Xslt - Enter the path to an Xslt that determines the

display of the page

Warning! If you specify an external file, it is strongly recommended that

you do not store this file in your site'sWorkarea folder. If you store this file

in theWorkarea folder, the file will be lost when you upgrade.

Note: If an .ekml file is inserted into the MarkupLanguageproperty, this

value is ignored.
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Field Description

LinkTarget

Defines the waya link actswhen a link is clicked.

_blank - This target causes the link to alwaysbe loaded in a new blank

window. Thiswindow is not named.

_self - This target causes the link to always load in the samewindow the

anchor was clicked in. This is useful for overriding a globally assigned base

target.

_parent - This target makes the link load in the immediate frameset

parent of the document. This defaults to acting like "_self" if the document

hasno parent.

_top - This target makes the link load in the full bodyof the window. This

defaults to acting like "_self" if the document is alreadyat the top. It is useful

for breaking out of an arbitrarily deep frame nesting.

DynamicContent

Parameter

Warning! Used

in ASP.NET only.

Checks the QueryString for this value and replaces the list summarywith a

content blockwhen specified. ChooseNone to alwaysdisplay List

Summary.

RandomOutput

Warning! Used

in ASP.NET only.

Displays random content within a list summary.

Checked =display random content from list summary

Unchecked = show a list summary

GetHtml

Warning! Used

in ASP.NET only.

Check this box if you want to retrieve and display content (html body) for all

content blocks in the collection. For example, to display content inside a

web server control such asaGridView.

Checked = retrieve and display content (html body) for all content blocks

in the collection

Unchecked =do not retrieve and display content (html body) for all

content blocks in the collection

Content Type

Warning! Used

in ASP.NET only.

Defineswhat type of list summaryappears.

Content - Displaysonly content blocks in the folder.

All Types - Displaysall content in the folder.

Forms - Displaysonly forms in the folder.

Archive_Content - Displaysarchived content from the folder.

Archive_Forms - Displaysarchived forms from the folder.

# of seconds -

CacheInterval

Warning! Used

in ASP.NET only.

Sets the amount of time the server control’s data is cached. The default is 0

(zero). This is the amount of time, in seconds, a control’s data is cached.

For example, if you want to cache the data for fiveminutes, set this

property to 300 (three hundred).See Also: "Caching with Server
Controls" on page 21-31

Warning! If the EnablePagingproperty is set to True, the CacheIn-

tervalproperty is disabled.
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Field Description

Hide

Warning! Used

in ASP.NET only.

Used to hide a list summary in design time and run time.

Checked =Hide list summary

Unchecked =Show list summary

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Warning! Used

in ASP.NET only.

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Warning! Used

in ASP.NET only.

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Warning! Used

in ASP.NET only.

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

MarkupLanguage

Warning! Used

in ASP.NET only.

Identify the templatemarkup file that controls the display of the list

summary. For example, mylistsummary.ekml.

If the *.ekml file is located in the same folder as theWeb form containing

the server control, just enter its name. If the file is in another folder, enter

the path relative to site root. For example,

..\CMS400Developer\workarea\customfiles\

markup\mylistsummary.ekml.

See Also: ”EktronMarkup Language” on page 35 and
”listsummary.ekml” on page 77

Note: If you enter a valid EkML file, the Displayxsltproperty value is

ignored. If the EkML file contains the [$ImageIcon] variable, the

IncludeIconsproperty acts asTrue.

5. When completed, click insert.

A graphic defines where the list summary appears on your template.
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Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:ListSummary id="ListSummary1" FolderId="14"

DisplayXslt="ecmTeaser" runat="server"></cms:ListSummary>

ASP

<% ecmListSummary "\Human

Resources",1,1,"","DateModified,desc", "DateCreated",0,"",""

%>

ColdFusion

<cfmodule template="#request.ecm.AppPath#ecmListSummary.cfm"

Folder="\Human Resources" MaxNumber="0" Recursive="1"

ShowSummary="1" StyleInfo="" OrderBy="DateModified,desc"

ShowInfo="DateCreated">

JSP
<%= ecmListSummary("\Human Resources",0,1,"",

"Title,asc","DateModified",0,"","") %>

PHP
<?php ecmListSummary("\Human Resources",1,1,"",

"DateModified,desc","DateCreated",0,"",""); ?>

Login
For a description of the Login button, see "Login Server Control" on page 3-6.

This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) > CMS Function...

or

n Commands > Ektron CMS400.NET (Server Controls) > CMS Content

Controls...

To insert a login button:

1. Move the blinking cursor to the area that you want to place it.
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2. From the list of Ektron CMS400.NET functions, click Login.

3. The Insert Ektron CMS400.NET Login box appears.

Warning! When inserting a login function using ASP, CF, JSP or PHP, the dialog box that appears hasno set-

tings.

4. Use the following table to assist you with inserting a Login button.

Field Description

ID

Warning! Used in

ASP.NET only.

A unique name for the function you are inserting.

OnlyAllowMemberLogin

Warning! Used in

ASP.NET only.

This changes the Login button so onlymembership users can log in.

This prevents someone from trying to login asan Ektron

CMS400.NET user and gain access to the Ektron CMS400.NET

Workarea. The default isUnchecked.

Checked =Allow onlymembership users to login.

Unchecked =Allow Ektron CMS400.NET users and
membership users to login.
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Field Description

PromptLogout

Warning! Used in

ASP.NET only.

When set to False, the logout processwill not include the Logout

Prompt window (shown below).

True =Usersmust click the Logout button in the Logout prompt

window before theyare logged out.

False =Users are logged out without having to use the Logout

prompt window.

AutoLogin

Warning! Used in

ASP.NET only.

When this box is checked, users are automatically logged in using

Active Directory authentication. Theydo not need to enter a

username or password. The default isUnchecked.

Checked =Use Active Directory authentication when logging in.

Unchecked =Do not use Active Directory authentication when

logging in.

Warning! For this property to function properly, youmust be using

Active Directory authentication with your CMS400.NET Site.

AutoAddType

Warning! Used in

ASP.NET only.

Set this type to define automatically added users asmembership

users or CMS400.NET content authors.

Author=CMS400.NET content authors

Member=membership users

SuppressHelpButton

Warning! Used in

ASP.NET only.

Hides the Help button that appears below the Login button when this

box is checked. The default isUnchecked.

Checked =Do not display the Help button.

Unchecked =DisplayHelp button.

Hide

Warning! Used in

ASP.NET only.

Used to hide a Login button at run time.

Checked =Hide Login button

Unchecked =Show Login button

Note: If Hide and Visible are both checked, the property is hidden.
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Field Description

Visible

Warning! Used in

ASP.NET only.

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hide and Visible are both checked, the property is hidden.

Style (Positioning Info -

GridLayout)

Warning! Used in

ASP.NET only.

Set position information of a control as absolute, when using a

GridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP:

240px"

Wrap Tag

Warning! Used in

ASP.NET only.

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a

blockof code.

SuppressWrapper

Warning! Used in

ASP.NET only.

Suppresses the output of the span/div tagsaround the control. The

default isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

A login icon indicates where the Login button appears on the template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET <cms:Login id="Login1" runat="server"></cms:Login>

ASP <% ecmlogin %>
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Platform Code View

ColdFusion <cfmodule template="#request.ecm.AppPath#ecmLogin.cfm”>

JSP <%= ecmLogin() %>

PHP <?php ecmlogin() ?>

Map Control
For a description of the Map Control, see See "Map Server Control" on page 9-247 .

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > CMS Module

Controls...

To insert a Map Control button:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Map Control.

3. The Ektron Map Control dialog box appears.

4. Use the following table to assist you with inserting a Map Control.
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Field Description

Control ID A unique name for the function you are inserting.

Folder ID
Enter the folder ID. If you do not know the folder path, you can navigate to

it using the Select folder drop down box.

Recursive

In the FolderIDproperty, you specify a folder whose content is searched

on thismap. To extend the search to all folders below this folder, check this

box.

Latitude
To set a default map center via latitude and longitude (asopposed to an

address), enter the latitude here.

Longitude
To set a default map center via latitude and longitude (asopposed to an

address), enter the longitude here.

MyAddress

To set a default map center, enter its addresshere. If you only enter a zip

code, themap centers on its post office.

The addressappears in the Search field when themap first displays.

If you enter
an address, the latitudeand longitudeproperties are ignored.

MapCategory

Enter the ID number of the taxonomywhose categories appear when a

site visitor clicks thismap’sDisplay on Map button.

When amap first appears, all eligible content appears. If a site visitor clicks

theDisplay on Map button, he can choose one or more categories and

limit themap to itemsassigned to them. For example, the user could view

restaurants only (as shown below).

Asanother example, your map could display all campuses in your state’s

college system. A site visitor could use theDisplay on Map popup

window to limit themap to community colleges.

To learnmore about Taxonomy, see "Taxonomy" on page 9-200.
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Field Description

MinZoomLevel

If you want to set amap zoom level below whichmap locationswill not

appear, enter that value.

The default value is 4. Possible valuesare between 1 (most detailed) and

19.

StartZoomLevel
Enter the zoom level at which themap initially appears.See Also:
"Determining aMap’s Initial Boundaries" on page 9-257

MapStyle
Enter themap’s displaymode: Road, Satellite or Hybrid.

Note: This setting only affectsBingMaps for Enterprisemaps.
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Field Description

PageSize

Enter the number of locations that can appear on one page of the text box

after a search is executed.See Also: "Displaying/SuppressingMap
Elements" on page 9-256

If more than this number of locationsare available, the site visitor sees

[First] [Previous] [Next] [Last] at the bottom of the page. He can use

the navigation aids to view additional locations.

MapProvider
Select the service that provides themap, either Google or BingMaps for

Enterprise.

DistanceUnit
Enter the units of distance on themap. Choicesaremiles and kilometers.

The default value ismiles.

CustomIcon

Use this field if you want the Category popup box to display an icon to the

left of each category, as shown below.

Prerequisite

To use this value, open the webroot/images/application/maps/tree

folder. In that folder, create a new folder whose name is the same as the

Taxonomycategory assigned to theMap server control at the

MapCategoryproperty. In the sample site, this Taxonomy’s name is

MapCategory.

Then, place the icons in that folder by category title namewith a .png

extension. Use an underscore (_) to separate taxonomy levels. For

example, the image for the categoryRestaurant >Americanmust be

named Restaurant_American.png.
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Field Description

DisplayTextResult

If you want the site visitor to see a boxof information about eachmap item

to the right of amap, check this box. To suppress the text box, uncheck this

box.

See Also: "Displaying/SuppressingMap Elements" on page 9-256
Checked =display text results about eachmap item

Unchecked = suppress text box

TypeControl

If thismap usesBingMaps for Enterprisemaps, this property enablesor

disables the zoom/direction/type control (highlighted below). It lets a site

visitor zoom themap in and out, move the center in anydirection, and

change the display style (Road or Aerial).

If thismap usesGoogle Earth maps, this property enablesor disables the

type control (highlighted below). It lets the site visitor change the display

style (Map, Satellite, or Hybrid). Use the ZoomControlproperty to display

or suppressGoogle Earth’s zoom and direction controls.

Checked =display zoom/direction/type controls

Unchecked = suppress zoom/direction/type controls
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Field Description

ZoomControl

Use this property to display or suppress the Googlemap zoom control

(highlighted below).

For BingMaps for Enterprisemaps, the display of the zoom control is

determined by the TypeControlproperty.

Checked =displayGooglemap zoom control

Unchecked = suppressGooglemap zoom control

Hide

Used to hide a Login button at run time.

Checked =Hide Login button

Unchecked =Show Login button

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags
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5. Click insert.

A Map Control icon indicates where the Map Control appears on the template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET <cms:Map id="Map1" FolderId="14" runat="server"></cms:Map>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Membership Control
For a description of the Membership function, see "Membership Server Control" on page 16-24.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Community Controls...

To insert a Membership Control:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click Membership.

3. The Membership dialog box appears.
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4. Use the following table to assist you with inserting a Membership Control.

Field Description

ID A unique name for the function you are inserting.

DisplayMode

The type of membership form displayed. Choose from the

following:

n UserRegistration - Lets a site visitor to register asa

membership user.

n ResetPassword - Lets amembership user to reset his

password.

n UnsubscribeSecured - Lets amembership user unsub-

scribe. Themembership user needs to enter his username

and password to unsubscribe.

n UnsubscribeUnsecured - Lets amembership user

unsubscribe byentering hismembership username only.

n AccountActivate - Let a site visitor activate hismem-

bership account byentering the ID number sent him in the

account verification email.

For more information on the DisplayModeproperty, see

"DisplayMode" on page 16-35.
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Field Description

RedirectedFailedURL

The URLwhere amembership user is sent if the registration

fails. If the page resides in the same folder as the registration

page, you only need to enter the name of the page. For

example, RegFailed.aspx. If the redirect page is located in a

subfolder, you need to add the folder path. For example,

members\RegFailed.aspx.

RedirectedSuccessURL

The URLwhere amembership user is sent if the registration is

successful. If the page resides in the same folder as the

registration page, you only need to enter the name of the page.

For example, RegSuccess.aspx. If the redirect page is located

in a subfolder, you need to add the folder path. For example,

members\RegSuccess.aspx.

RegisterButtonImg
Lets you add an image in place of the text on the register

button.

RegisterButtonText

Text that appears on the Register button. The default is

Register. If you use a register button image, you do not see this

text.

ResetButtonImg Lets you add an image in place of the text on the reset button.

ResetButtonText
Text that appears on the reset button. The default isReset. If

you use a reset button image, you do not see this text.
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Field Description

ShowExtended

Decide if the CustomUser Properties are available when using

this control. The default setting is checked.

Checked = show CustomUser Properties

Unchecked =hide CustomUser Properties

Note: For more information , see See "CustomUser

Properties" on page 15-12.

ShowTerms

When set to True this property shows the Termsand

Conditionsasdefined in theWorkarea. In addition, users are

asked to checka box stating theyhave read and agree to abide

by the termsand conditionsof the forum. Default isFalse.

See Also: "ShowTerms" on page 16-36 and "Terms&
Conditions" on page 7-608

UserExistsMessage

Themessage that appearswhen amembership user already

exists. The default message is: Username(email) already

exists!

UserSuccessMessage

Themessage that appearswhen amembership user

successfully registers. The default message is: You have

registered successfully.

UserUpdateSuccessMessage

Themessage that appearswhen amembership user

successfully updates their information. The default message is:

You have successfully updated your information.

Hide

Used to hide aMembership in design time and run time.

Checked =HideMembership

Unchecked =ShowMembership

Note: If Hideand Visibleare both checked, the property is

hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is

hidden.

Style (Positioning Info -

GridLayout)

Set position information of a control as absolute, when using a

GridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute;

TOP: 240px"
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Field Description

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion

of an HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to

a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control.

The default isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click insert.

A graphic defines where the Membership Control appears on your template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:membership id="Membership1"

runat="server"></cms:membership>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Metadata for ASP.NET Pages
For a description of the Metadata function, see "MetaData Server Control" on page 7-171.
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This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Content Controls...

To insert a metadata function:

1. Move the blinking cursor to the area that you want to place it.

Note: The Ektron CMS400.NET Metadata function should be inserted within the <head> tagsof your template to

workproperly.

2. From the list of Ektron CMS400.NET Functions, click on Metadata.

3. The Insert Ektron Metadata box is displayed.

4. Use the following table to assist you with inserting metadata.

Field Description

Control ID A unique name for the function you are inserting.

Content ID

Enter a valid content ID in the Content ID textbox. If you do not

know the Content ID, you can navigate to it using the Select

Category and Select Content Blockdrop down boxes.

GenerateDublinCore

When enabled, this property automatically creates seven of the

Simple Dublin Coremetadata fields from standard CMS400.NET

system properties. The default isUnchecked.

Checked = Generate Simple Dublin Coremetadata fields

Unchecked =Do not generate Simple Dublin Coremetadata

fields

The seven fields and how theyare associated with the

CMS400.NET properties is explained in "Simple Dublin Core

Metadata" on page 7-154
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Field Description

Select Category
The drop-down list contains a list of content folders. If you insert

the content ID, you do not need to select a category.

Select Content Block

The drop-down box is populated with a list of all the content block

titleswithin that folder.When a title is selected, the content ID

textbox is filled with that content block's id number. If you insert the

content ID, you do not need to select a content block.

DefaultItemList

A comma delimited list of content block IDs to get metadata from.

DefaultContentID must be set to 0 (zero) so you can add IDs to the

list. For example: [2,4,46]

DynamicContent

Parameter

Gets or sets the QueryString parameter to read a content ID

dynamically.

Hide

Used to hide aMembership in design time and run time.

Checked =HideMembership

Unchecked =ShowMembership

Note: If Hideand Visibleare both checked, the property is

hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is

hidden.

Style (Positioning Info -

GridLayout)

Set position information of a control as absolute, when using a

GridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP:

240px"
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Field Description

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a

blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control.

The default isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click insert.

6. The following line appears in the <body> of the HTML code.
 <cms:MetaData id="MetaData2" runat="server"

DefaultContentID="12"></cms:MetaData>

7. Move that line from the <body> tag into the <head> tag.

8. Save the Web form.

9. Open the Web page in the browser.

10. Right click on the Web page and click View Source. Look in the head tag. The meta tags

from the content block are added to the page.

The metadata information added is shown below.
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Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:MetaData id="MetaData2" runat="server"

DefaultContentID="12"></cms:MetaData>

ASP,

ColdFusion,

JSP or PHP

See "Metadata Function for ASP, CF, JSP or PHPPages " on page 21-190

Metadata Function for ASP, CF, JSP or PHP Pages
For a description of the Metadata function, see "MetaData Server Control" on page 7-171.

This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) > CMS Function...

To insert a metadata function:

1. Move the blinking cursor to the area that you want to place it.

Note: The Ektron CMS400.NET Metadata function should be inserted within the <head> tagsof your template to

workproperly.

2. From the list of Ektron CMS400.NET Functions, click on Metadata.

3. The Insert Ektron Metadata box is displayed.

4. Use the following table to assist you with inserting metadata.
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Field Description

Metadata List

When you select a content ID and click the Add toMetadata List button,

The content ID is added to this text box. This allows you to create a list of

content blocks for which themetadata of each content block is added to

the page.

Content ID

Enter a valid content ID in the Content ID textbox. If you do not know the

Content ID, you can navigate to it using the Select Category and Select

Content Blockdrop down boxes.

GenerateDublinCore

When enabled, this property automatically creates seven of the Simple

Dublin Coremetadata fields from standard CMS400.NET system

properties. The default isUnchecked.

Checked = Generate Simple Dublin Coremetadata fields

Unchecked =Do not generate Simple Dublin Coremetadata fields

The seven fields and how theyare associated with the CMS400.NET

properties is explained in "Simple Dublin CoreMetadata" on page 7-

154

Select Category
The drop-down list contains a list of content folders. If you insert the

content ID, you do not need to select a category.

Select Content Block

The drop-down box is populated with a list of all the content block titles

within that folder.When a title is selected, the content ID textbox is filled

with that content block's id number. If you insert the content ID, you do

not need to select a content block.

Metadata types for

exclusion

Select themetadata types that you do not want added to themetadata

function you are inserting. Hold the control keydown for multiple

selections.

5. When completed, click insert.

6. The following line appears in the <body> of the HTML code.
 <cms:MetaData id="MetaData2" runat="server"

DefaultContentID="12"></cms:MetaData>

7. Move that line from the <body> tag into the <head> tag.

8. Save the Web form.

9. Open the Web page in the browser.
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10. Right click on the Web page and click View Source. Look in the head tag. The meta tags

from the content block are added to the page.

The metadata information added is shown below.

Shown below is an example of the code that is inserted:

Platform Code View

.NET For ASP.NET pages, see "Metadata for ASP.NET Pages" on page 21-186

ASP <% ecmMetadata "[1;Title][9][3;Keywords,Title]","" %>

ColdFusion
<cfmodule template="#request.ecm.AppPath#ecmMetadata.cfm"

ItemList="[1;Title][9][3;Keywords,Title]">

JSP <%= ecmMetadata("[12;keywords,Title]","") %>

PHP <?php ecmMetadata("[1;Title][9][3;Keywords,Title]",""); ?>

Multipurpose Content Block
This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) > CMS Function...

To insert a Multipurpose content block function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Content functions, click on Multipurpose Tag...

3. The Insert Ektron CMS400.NET Multipurpose Tag box is displayed.
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4. Use the following table to assist you with inserting a Multipurpose tag.

Field Description

Default

Content

ID

Type in the default content ID, or select a category from the drop down list, then

select a content block from the second dropdown list.

5. When completed, click insert.

A graphic to define where the Multipurpose tag will appear on your template is inserted.

Shown below is the code that will be inserted according to the platform that has been

specified in the setup:

Platform Code View

.NET In ASP.NET, the Content BlockTag functionsasaMultipurpose Content block.

ASP <% ecmMultiPurpose(24) %>

ColdFusion
<cfmodule DefaultID="24"

template="#request.ecm.AppPath#ecmMultipurpose.cfm">

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP <?php ecmMultiPurpose(12); ?>
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Poll
For a description of the Poll function, see "Poll Server Control" on page 7-284.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Content Controls...

To insert a Poll:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Content functions, click Poll.

3. The Insert Poll box is displayed.

4. Use the following table to assist you with inserting a poll.

Field Description

Control ID A unique name for the function you are inserting.

Poll ID
Type in the Poll ID that you want to insert. If you do not know the Poll ID,

you can navigate to it using the Select Poll drop down box.

Select Poll

The drop-down box is populated with a list of all the form titles.When a title

is selected, the Poll ID textbox is filled with that form's id number. If you

insert the Poll ID, you do not need to select a form.

DynamicForm

Parameter

Tomake this form blockdynamic, select ekfrm. When you do, this control

uses the form blockpassed asa URL parameter.
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Field Description

Ajax

Displays the poll or results, using an iFrame, in the area of the page that

contains the pollwithout disturbing its surrounding contents. The default is

checked.

Checked =Polls and results are shown in an iFramewithout any

modification or refresh of the surrounding contents.

Unchecked =The poll and the results replace theWeb page’s content.

# of seconds -

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0

(zero). This is the amount of time, in seconds, a control’s data is cached.

For example, if you want to cache the data for fiveminutes, set this

property to 300 (three hundred).See Also: "Caching with Server

Controls" on page 21-31

Include Form

Tags

Determines if tagsare generated automatically or manually.See Also:
"Automatic versusManualGeneration of Form Tags" on page 7-284

Add Validation

When checked, addsValidation to your main runat=server form.

Checked =add validation

Unchecked =do not add validation

Hide

Used to hide a poll in design time and run time.

Checked =Hide poll

Unchecked =Show poll

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.
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Field Description

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click Insert.

A graphic defines where the form appears on your template.

Shown below is an example of the code that is inserted.

Platform Code View

.NET <cms:Poll id="Poll1" PollID="300" runat="server"></cms:Poll>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

PostHistory
For a description of the PostHistory function, see "PostHistory Server Control" on page 7-679.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Community Controls...

> Forums
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To insert the PostHistory function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click PostHistory.

3. The Insert Ektron CMS400.NET PostHistory box appears.

4. Use the following table to assist you with inserting the ActiveTopics function.

Field Description

Control ID A unique name for the function you are inserting.

BoardID

The ID of the Discussion Board.

If you do not know the board ID, you can navigate to it using the Select

folder drop down box.

UserID The ID of the user for whom to get the post history.

URLPath The URL path to the page the where the Forum server control is located.

MaxNumber Themaximum number of topics listed.

# of seconds -

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0

(zero). This is the amount of time, in seconds, a control’s data is cached.

For example, if you want to cache the data for fiveminutes, set this

property to 300 (three hundred).See Also: "Caching with Server

Controls" on page 21-31

Hide

Used to hide the function at run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is hidden.
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Field Description

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

An PostHistory icon appears to indicate the location of the post history list.

Shown below is an example of the code that is inserted:

Platform Code View

.NET

<cms:PostHistory BoardID="106" id="PostHistory1"

URLPath="forum.aspx" UserID="14"

runat="server"></cms:PostHistory>
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Platform Code View

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Random Content
For a description of the Random Content function, see "Random Content" on page 21-304

This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) > CMS Function...

To insert a Random Content function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Content functions, click on Insert Random Content

Tag...

3. The Insert Random Content Tag box is displayed.

4. Use the following table to assist you with inserting a Random Content tag.

Field Description

Collection

ID

Type in the collection ID, or select it from the drop down list, of the collection where

the random content function will retrieve content from.
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Field Description

XSLT to

apply

XML

Content

only

If desired, youmayspecify an XSLT to apply to the content that gets displayed.

5. When completed, click Insert.

A graphic to define where the Random Content tag will appear on your template is

inserted.

Shown below is the code that will be inserted according to the platform that has been specified

in the setup:

Platform Code View

.NET This function is not available asan Ektron Dreamweaver Extension for .NET

ASP <% ShowRandomContent 3, 0 %>

ColdFusion
<cfmodule id="3" displayFunction="0"

template="#request.ecm.AppPath#ecmShowRandomContent.cfm">

JSP <%= ShowRandomContent(3, 0) %>

PHP <?php ShowRandomContent(3, 0); ?>

Random Summary
For a description of the Random Summary function, see "Random Summary" on page 21-305
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This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) > CMS Function...

To insert a Random Summary function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Content functions, click on Random Summary

Tag...

3. The Insert Ektron CMS400.NET Random Summary Tag box is displayed.

4. Use the following table to assist you with inserting a Random Summary tag.

Field Description

Collection

ID

Type in the collection ID, or select it from the drop down list, of the collection where

the random summary function will retrieve summaries from.

5. When completed, click Insert.

A graphic to define where the Random Summary tag will appear on your template is

inserted.

Shown below is the code that will be inserted according to the platform that has been

specified in the setup:
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Platform Code View

.NET This function is not available asan Ektron Dreamweaver Extension for .NET

ASP <% ShowRandomSummary (2) %>

ColdFusion
<cfmodule id="2"

template="#request.ecm.AppPath#ecmShowRandomSummary.cfm">

JSP <%= ShowRandomSummary(2) %>

PHP <?php ShowRandomSummary (2); ?>

RSS Aggregator
For a description of the RSS Aggregator function, see "RssAggregator Server Control" on page

19-17.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > CMS Module

Control...

To insert an RSS Aggregator:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click RSS Aggregator.

3. The RSS Aggregator dialog box appears.

4. Use the following table to assist you with inserting an RSS Aggregator.

Developer Topics

21-202
ReferenceManual

Version 8.0 Rev 1.3



Field Description

Control ID A unique name for the function you are inserting.

URL
The RSS feed path for the server control. For example:

http://example.com/rss.xml

MaxResults
TheMaximum number of items from anRSS feed that are returned

(0=unlimited).

LinkTarget

Defines the waya link actswhen a link is clicked. The choicesare:

_blank - This target causes the link to alwaysbe loaded in a new blank

window. Thiswindow is not named.

_self - This target causes the link to always load in the samewindow the

anchor was clicked in. This is useful for overriding a globally assigned base

target.

_parent - This target makes the link load in the immediate frameset

parent of the document. This defaults to acting like “_self” if the document

hasno parent.

_top - This target makes the link load in the full bodyof the window. This

defaults to acting like “_self” if the document is alreadyat the top. It is useful

for breaking out of an arbitrarily deep frame nesting.

DisplayType

Determineshow the information on the page is displayed

None-databind only

ecmNavigation - lists the title of everyRSS feed item

See Also: . "Example of ecmNavigation Display" on page 9-124
ecmTeaser - lists a title and a description of everyRSS feed item

See Also: "Example of ecmTeaser Display" on page 9-124

Path to Custom Xslt - Enter the path to an Xslt that determines the

display of the page

Warning! If you specify an external file, it is strongly recommended that

you do not store this file in your site'sWorkarea folder. If you store this file

in theWorkarea folder, the file will be lost when you upgrade.

Hide

Used to hide an RssAggregator in design time and run time.

Checked =Hide RssAggregator

Unchecked =Show RssAggregator

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.
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Field Description

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click insert.

A graphic defines where the RSS Aggregator appears on your template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET

<CMS:RssAggregator id="RssAggregator1"

URL="http://example.com/rss.xml" DisplayXslt="ecmTeaser"

runat="server"></CMS:RssAggregator>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.
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Old Search
This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) > CMS Function...

or

n Commands > Ektron CMS400.NET (Server Controls) > Content Controls...

To insert a Old Search function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Content functions, click on Old Search

3. The Insert Ektron Search box is displayed.
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Warning! When inserting a list summaryusing ASP, CF, JSP or PHP, a slightly different dialog boxappears.

4. Use the following table to assist you with inserting a search.

Field Description

Ajax

Check this box to enable Ajax searches.When enabled, the

MaxResultsproperty determines themaximum number of results

per page, and the ResultTagIdproperty becomesactive.

Checked =Enable AjaxSearch

Unchecked =OriginalHTMLSearch

ButtonImgSrc

(ASP.NET)

Button Image Source

(ASP, CF, JSP or PHP)

If you wish to use an image for the search button, insert the location of

the image in this field. If no image is specified, a standard submit

button is used.

ButtonText
The button text is the text that is displayed on the standard submit

button, or the alt text of a search button image.

Control ID

Warning! Used in

ASP.NET only.

A unique name for the function you are inserting.

DisplayHorizontally
The search can be displayed either vertically or horizontally on your

Web page. Checkoff this box if you want it to appear horizontally.
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Field Description

DisplayType

Warning! Used in

ASP.NET only.

Determineshow the information on the page is displayed

None-databind only

ecmNavigation - lists the title of every content block in the folder

ecmTeaser - lists the title of every content block in the folder plus the

content summary

See Also: "Example of ecmNavigation Display"
on page 9-124
"Example of ecmTeaser Display" on page 9-124

EmptyResultMsg

Warning! Used in

ASP.NET only.

The returnmessage displayed, if the search returnsno hits.

The default is:

Search returned zero results

EnableAdvancedLink

Warning! Used in

ASP.NET only.

Check this box to display the link that makes the advanced properties

available.

Checked =DisplayAdvanced link

Unchecked =Hide Advanced link

EnableArchived

Warning! Used in

ASP.NET only.

Enablesusers to search archived content. The archived content must

be archived asArchived Remain On Site.The default isUnchecked.

Checked =Searching archived content is enabled.

Unchecked =Searching archived content is disabled, unless

Include Archived is checked in the Advanced search.

EnableArchivedBtn

Warning! Used in

ASP.NET only.

Providesa checkbox so users can decide if theywant to perform an

archive search. The default isUnchecked.

Checked =The Include Archive checkbox is enabled in the

advanced search properties. If used with EnableArchived, the

checkbox is checked bydefault.

Unchecked =The Include Archive checkbox is disabled in the

advanced search properties.

EnableContent

Warning! Used in

ASP.NET only.

Enablesusers to search content. The default isUnchecked.

Checked =Searching content is enabled.

Unchecked =Searching content is disabled, unlessContent is

checked in the Advanced search.
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Field Description

EnableContentBtn

Warning! Used in

ASP.NET only.

Providesa checkbox so users can decide if theywant to perform a

content search. The default isUnchecked.

Checked =The Content checkbox is enabled in the advanced

search properties. If used with EnableContent, the checkbox is

checked bydefault.

Unchecked =The Content checkbox is disabled in the advanced

search properties.

EnableContentFieldset

Warning! Used in

ASP.NET only.

Createsa border around the group of content items in an advanced

search. These content items include Content, Formsand DMS

Assets.

The default isUnchecked.

Checked =Show border around content items.

Unchecked =No border around content items.

EnableDMSAssets

Warning! Used in

ASP.NET only.

Enablesusers to search DMSAssets. The default isUnchecked.

Checked =Searching DMSAssets is enabled.

Unchecked =Searching DMSAssets is disabled, unlessDMS

Assets is checked in the Advanced search.

EnableDMSAssetsBtn

Warning! Used in

ASP.NET only.

Providesa checkbox so users can decide if theywant to perform a

DMSAsset search. The default isUnchecked.

Checked =The DMSAsset checkbox is enabled in the advanced

search properties. If used with EnableContent, the checkbox is

checked bydefault.

Unchecked =The DMSAsset checkbox is disabled in the advanced

search properties.

EnableForms

Warning! Used in

ASP.NET only.

Enablesusers to search Forms. The default isUnchecked.

Checked =Searching Forms is enabled.

Unchecked =Searching Forms is disabled, unlessForms is

checked in the Advanced search.

EnableFormsBtn

Warning! Used in

ASP.NET only.

Providesa checkbox so users can decide if theywant to perform a

Formssearch. The default isUnchecked.

Checked =The Formscheckbox is enabled in the advanced search

properties. If used with EnableContent, the checkbox is checked by

default.

Unchecked =The Formscheckbox is disabled in the advanced

search properties.

EnableLibFiles

Warning! Used in

ASP.NET only.

Enablesusers to search LibraryFiles. The default isUnchecked.

Checked =Searching LibraryFiles is enabled.

Unchecked =Searching LibraryFiles is disabled, unlessFiles is

checked in the Advanced search.
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Field Description

EnableLibFilesBtn

Warning! Used in

ASP.NET only.

Providesa checkbox so users can decide if theywant to perform a

LibraryFiles search. The default isUnchecked.

Checked =The Files checkbox is enabled in the advanced search

properties. If used with EnableLibFiles, the checkbox is checked

bydefault.

Unchecked =The Files checkbox is disabled in the advanced

search properties.

EnableLibHyperlinks

Warning! Used in

ASP.NET only.

Enablesusers to search LibraryHyperlinks. The default is

Unchecked.

Checked =Searching LibraryHyperlinks is enabled.

Unchecked =Searching LibraryHyperlinks is disabled, unless

Hyperlinks is checked in the Advanced search.

EnableLibHyperlinksBtn

Warning! Used in

ASP.NET only.

Providesa checkbox so users can decide if theywant to perform a

LibraryHyperlinks search. The default isUnchecked.

Checked =The Hyperlinks checkbox is enabled in the advanced

search properties. If used with EnableLibHyperlinks, the check

box is checked bydefault.

Unchecked =The Hyperlinks checkbox is disabled in the advanced

search properties.

EnableLibImages

Warning! Used in

ASP.NET only.

Enablesusers to search Library Images. The default isUnchecked.

Checked =Searching Library Images is enabled.

Unchecked =Searching Library Images is disabled, unless Images

is checked in the Advanced search.

EnableLibImageBtn

Warning! Used in

ASP.NET only.

Providesa checkbox so users can decide if theywant to perform a

Library Images search. The default isUnchecked.

Checked =The Images checkbox is enabled in the advanced

search properties. If used with EnableLibImages, the checkbox is

checked bydefault.

Unchecked =The Images checkbox is disabled in the advanced

search properties.

Folder
Type in the folder path to be searched. If you do not know the folder

path, you can navigate to it using the Select folder drop down box.

Font Color

Warning! Used in

ASP, CF, JSP and

PHPonly.

The color of the font used in the search function.

Font Face The type of font to use for search function.
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Field Description

Warning! Used in

ASP, CF, JSP and

PHPonly.

Font Size

Warning! Used in

ASP, CF, JSP and

PHPonly.

The size of the font used in the search function.

Hide

Warning! Used in

ASP.NET only.

Used to hide a search in design time and run time.

Checked =Hide search

Unchecked =Show search

Note: If Hideand Visibleare both checked, the property is hidden.

LinkTarget

Warning! Used in

ASP.NET only.

Defines the waya link actswhen a link is clicked. The choicesare:

_blank - This target causes the link to alwaysbe loaded in a new

blankwindow. Thiswindow is not named.

_self - This target causes the link to always load in the samewindow

the anchor was clicked in. This is useful for overriding a globally

assigned base target.

_parent - This target makes the link load in the immediate frameset

parent of the document. This defaults to acting like “_self” if the

document hasno parent.

_top - This target makes the link load in the full bodyof the window.

This defaults to acting like “_self” if the document is alreadyat the top.

It is useful for breaking out of an arbitrarily deep frame nesting.

MaxCharacters

(ASP.NET)

Text BoxMaxChar

(ASP, CF, JSP or PHP)

Specify themaximum amount of characters that is accepted in the

text box.

MaxNumber of results

Warning! Used in

ASP.NET only.

Enter a number to specify howmany results are displayed on the

page (0=unlimited).

When the Ajaxproperty is checked, this property changes from the

maximum amount of results to themaximum results per page. This

takesadvantage of Ajax’s ability to have paging in the searches. If

zero is entered, all results appear on the same page.
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Field Description

Order By

Warning! Used in

ASP.NET only.

Specify how you want to order the search results that are generated

when a search is performed on youWeb site. Also specify if you want

the results in ascending or descending order.

n Title - The title of the content block

n Date Created - The date the content blockwascreated

n Date Modified - The date the content blockwas last modified

n Last Author Last Name - The last author’s last name

n Last Author First Name - The last author’s first name

n Ascending - Alphabetic or numerical order

n Descending - Reverse alphabetic or numerical order

PostResultsAt

(ASP.NET)

Target Page (ASP, CF,

JSP or PHP)

The path of theWeb page where the search resultswill be posted.

The # symbol appears in the text boxbydefault. The # symbol tells

the control to post back to theWeb page that created the search.

Warning! Important: A search controlmust exist on the posting

page.

Recursive
If checked, search information is gathered from the folder selected

and all of its child folders.

RemoveTeaserHtml

Warning! Used in

ASP.NET only.

An optional search result formatting parameter that removesall the

HTML from each content item’s teaser/summarybefore sending it to

the browser.

Checked =Remove HTML

Unchecked =Do not remove HTML

ResultTagId

Warning! Used in

ASP.NET only.

Specify the div tag control ID to display the search results. This

property is only active when the EnableAjaxproperty is checked.

Select Folder
Select a folder path to be searched. If you insert the folder path, you

do not need to select a folder.

ShowExtendedSearch

Allowsa user to search via themetadata type: Searchable Property.

Checked =Show extended search.

Unchecked =Hide extended search.

For more information onMetadata and Searchable Property, see

"Working with Metadata" on page 7-146.

ShowSearchBoxAlways

Warning! Used in

ASP.NET only.

If unchecked, the search boxdoesnot appear on PostBack.
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Field Description

ShowSearchOptions

Warning! Used in

ASP.NET only.

If this box is checked, the following choicesappear along with the

search box. This type of search is also known asa Standard search.

The default setting isChecked.

n All the words

n Anyof the words

n Exact phrase

n Match Partialwords

Checked =Show search options

Unchecked =Hide search options

Style (Positioning Info -

GridLayout)

Warning! Used in

ASP.NET only.

Set position information of a control as absolute, when using a

GridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP:

240px"

TextBoxSize

Specify the size of the text box that is displayed on theWeb page for

users to enter the search keywords. The width is based on the

number of characters.

Visible

Warning! Used in

ASP.NET only.

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Wrap Tag

Warning! Used in

ASP.NET only.

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a

blockof code.

SuppressWrapper

Warning! Used in

ASP.NET only.

Suppresses the output of the span/div tagsaround the control. The

default isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click insert.

A graphic defines where the search appears on your template.
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Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:Search id="Search1" FolderID="41" MaxResults="50"

DisplayXslt="ecmTeaser" runat="server"></cms:Search>

ASP

<% ecmSearch

"\Products",1,"SearchDisplay.asp",10,25,"","Search",

"Verdana","Blue","2",0,"" %>

ColdFusion

<CFMODULE template=”#request.ecm.AppPath#ecmSearch.cfm”

StartingFolder=”\Products” Recursive="1"

TargetPage="SearchDisplay.cfm" TextBoxSize="10"

MaxCharacters="25" ButtonImageSrc="" ButtonText="Search"

FontFace="Verdana" FontColor="Blue" FontSize="2"

Horizontal="0">

JSP

<%=

ecmSearch("\Products",1,"SearchDisplay.jsp",10,25,"","Search",

"Verdana","Blue","2",0,"") %>

PHP

<?php

ecmSearch("\Products",1,"SearchDisplay.php",10,25,"","Search",

"Verdana","Blue","",0,""); ?>

Search Display
The search display custom tag creates the area where search results appear after a search is

executed.

This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) > CMS Function...

To insert a search display function:

1. Move the blinking cursor to the area that you want to place it.
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2. From the list of Ektron CMS400.NET Content functions, click on Insert Search Display

Tag...

3. The Insert Ektron Search Display Tag box is displayed.

4. Use the following table to assist you with inserting a search display function.

Field Description

Maximum

Number of

Documents

Specify themaximum amount of results that will be returned to the user

when a search is performed.

Style Info
Insert an inline style sheet that will be used to format all the hyperlinks that

are returned.

Show Last

Modified Date

Checkoff this box to show the last modified date with the search result. This

allowsusers to distinguish between updated and old content.

5. When completed, click insert.

A graphic to define where the search display tag has been placed on your template is

inserted.
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Shown below is the code that will be inserted according to the platform that has been

specified in the setup:

Platform Code View (with no default content block set)

.NET In ASP.NET, you do not need to add a separate search display.

ASP <% ecmSearchDisplay 0, "", 1 %>

ColdFusion
<cfmodule template="#request.ecm.AppPath#ecmSearchDisplay.cfm"

MaxNumber="0" StyleInfo="" ShowDate="1">

JSP <%= ecmSearchDisplay(0, "", 1)%>

PHP <?php ecmSearchDisplay(0, "", 1)?>

Single Summary
For a description of the Single Summary function, see "Single Summary Function" on page 21-

286

This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) > CMS Function...

To insert a Single summary:

1. Move the blinking cursor to the area that you want to place it.
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2. From the list of Ektron CMS400.NET Content functions, click on Single Summary Tag...

3. The Insert Ektron Single Summary Tag box is displayed.

4. Use the following table to assist you with inserting a single summary tag.

Field Description

Content ID

n Working Offline - Enter a valid content ID into the Content ID textbox.

n Working Online - The top drop-down list will be filled with a list of con-

tent folders that you have privileges to. After choosing a content folder, the

bottom drop-down boxwill be filled with a list of all the content block titles

within that category.When a title is selected, the content ID textboxwill be

filled with that content block's id number.

Show Summary If checked, content summarieswill be displayed.

Style Info
Insert any inline style information, which will be applied to the generated text

hyperlink, here.

Show Info
Select the type of information that will be displayed next to the generated

hyperlinks.

5. When completed, click insert.

A graphic to define where the single summary tag will appear on your template is inserted.
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Shown below is the code that will be inserted according to the platform that has been

specified in the setup:

Platform Code View

ASP <% ecmSingleSummary "1",1,"","DateModified","" %>

ColdFusion

<cfmodule template="#request.ecm.AppPath#ecmSingleSummary.cfm"

ContentID="1" ShowSummary="1" StyleInfo=""

ShowInfo="DateModified">

JSP <%= ecmSingleSummary("1",1,"","DateModified","") %>

PHP <?php ecmSingleSummary("1",1,"","DateModified","") ?>

Site Map
For a description of the Site Map function, see "SiteMap Server Control" on page 9-298.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > CMS Menu Controls...

To insert a Site Map:
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1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click Site Map.

3. The Site Map dialog box appears.

4. Use the following table to assist you with inserting a SiteMap.

Field Description

Control ID A unique name for the function you are inserting.

FolderID
The numeric id of the folder that you want to use. If you do not know the

folder ID, you can navigate to it using the Select folder drop down box.

DisplayStyle
Indicate how to display the site map: horizontally or vertically. The default is

Horizontal.

DisplayXslt

Determineshow the information on the page is displayed.

None - databind only

ecmNavigation - lists the title of every content block in the collection

See Also: "Example of ecmNavigation Display" on page 9-124

ecmTeaser - lists the title of every content block in the collection plus the

content summary : If you specify an external file, it is strongly

recommended that you do not store this file in your site'sWorkarea folder.

If you store this file in theWorkarea folder, the file will be lost when you

upgrade.

See Also: "Example of ecmTeaser Display" on page 9-124

StartLevel
Set to the starting level of the site map. If set to 0 (zero), starts from the

root.

MaxLevel Set themaximum amount of levels to show. Set it to 0 (zero) for unlimited.
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Field Description

FlatTopLevel

When this box is checked, include site nodes from the parent folder but not

their items. Unchecking this box includesall nodesand items.

Checked = include site nodes from the parent folder but not their items

Unchecked = includesall nodesand items

Hide

Used to hide a SiteMap in design time and run time.

Checked =Hide the SiteMap

Unchecked =Show the SiteMap

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

# of seconds -

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0

(zero). This is the amount of time, in seconds, a control’s data is cached.

For example, if you want to cache the data for fiveminutes, set this

property to 300 (three hundred).See Also: "Caching with Server

Controls" on page 21-31.

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click Insert.

A graphic defines where the Site Map appears on your template.
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Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:sitemap id="sitemap1" folderid="32"

runat="server"></cms:sitemap>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Smart Menu
For a description of the Smart Menu function, see "Smart Menu Server Control" on page 9-178.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > CMS Menu Controls...

To insert a Smart Menu:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click Smart Menu

The Smart Menu Control box appears.
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3. Use the following table to assist you with inserting a Smart Menu.

Field Description

Control ID A unique name for the function you are inserting.

DefaultMenuID

The numeric id of themenu that you want to insert. If you do not know

the DefaultMenuID, you can navigate to it using the Select Menu drop

down box.

Select Menu

Select amenu to be used.When amenu is selected, the

DefaultMenuID textbox is filled with that menu's id number. If you

insert the DefaultMenuID, you do not need to select amenu.

DynamicParameter

Checks the QueryString for themenu value and replaces themenu

with content when ID is specified. Leave blank to alwaysdisplay the

menu.

None - Use Default

menu_ID - The control uses themenu passed asa URL parameter.

Stylesheet

Enter the style sheet that will determine the appearance of themenus.

Menu style sheets reside in the site

root/workarea/csslib/smartmenu folder. You canmodify anyof

the standard style sheets or create your own.
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Field Description

LaunchLinksinNew

Window

Check this boxand when a site visitor selects amenu option, it

appears in a new browser window.

If unchecked, the new page replaces the current page in the browser.

Checked =when a site visitor selects amenu option, it appears in a

new browser window

Unchecked = the new page replaces the current page in the

browser

CacheInterval

Sets the amount of time the server control’s data is cached. The

default is 0 (zero). This is the amount of time, in seconds, a control’s

data is cached. For example, if you want to cache the data for five

minutes, set this property to 300 (three hundred).See Also:
"Caching with Server Controls" on page 21-31

Enable508compliance

If you check this box, themenu will complywith Section 508.See
Also: "Section 508 Compliance Featuresof Smart Menus" on

page 9-183

Checked =menuwill complywith Section 508

Unchecked =menu doesnot complywith Section 508

StartCollapsed

If you check this box, all submenusare closed when themenu initially

displays.

Checked =all submenusare closed when themenu initially displays

Unchecked = initially display submenus

AutoCollapseBranches

If you check this box, whenever a new submenu opens, all other

submenus close.

If unchecked, other submenus remain open when a new one opens.

Checked =whenever a new submenu opens, all other submenus

close

Unchecked = submenus remain open when a new one opens

StartWith

RootCollapsed

If you check this box, themenu initially displayswith its root menu

closed.

Note: This property is ignored if the ShowRootFolderproperty is

unchecked.

Checked = themenu initially displayswith its root menu closed

Unchecked = themenu initially displayswith its root menu open

ShowRootFolder

If you check this box, amenu option listing the title of the root folder

appears. If unchecked, the title of the root folder doesnot appear.

Checked =amenu option listing the title of the root folder appears

Unchecked = the title of the root folder doesnot appear
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Field Description

Hide

Used to hide a Smart Menu in design time and run time.

Checked =Hide Smart Menu

Unchecked =Show Smart Menu

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning Info -

GridLayout)

Set position information of a control as absolute, when using a

GridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP:

240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a

blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The

default isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

4. When completed, click insert.

A graphic defines where the Smart Menu appears on your template.

Shown below is an example of the code that is inserted:
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Platform Code View

.NET

<cms:SmartMenu DefaultMenuID="6" id="SmartMenu1"

Enable508Compliance="True" DynamicParameter="menu_id"

Stylesheet="shuttermenu_blue.css"

runat="server"></cms:SmartMenu>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Standard Menu
For a description of the Standard Menu function, see See "Menu Server Control" on page 9-

184.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > CMS Menu Controls...

To insert a Standard Menu:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click Standard Menu

The Standard Menu Control box appears.

3. Use the following table to assist you with inserting a Standard Menu.
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Field Description

Control ID A unique name for the function you are inserting.

DefaultMenuID

The numeric id of themenu that you want to insert. If you do not know the

DefaultMenuID, you can navigate to it using the Select Menu drop down

box.

Select Menu

Select amenu to be used.When amenu is selected, the DefaultMenuID

textbox is filled with that menu's id number. If you insert the

DefaultMenuID, you do not need to select amenu.

MenuType

The type of menu to render.

None - databind only

SampleMenu - A sample display, formatted asa bulletedmenu list

TreeMenu - A sample display, formatted asa folder tree. You can expand

the tree by clicking on the folder icon.

For more information on using the SampleMenu and TreeMenuDisplay,

see See "Using DisplayXslt Samples" on page 9-187 .

DynamicMenu

Parameter

Checks the QueryString for themenu value and replaces themenu with

content when ID is specified. Leave blank to alwaysdisplay themenu.

None - Use Default

menu_ID - The control uses themenu passed asa URL parameter.

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0

(zero). This is the amount of time, in seconds, a control’s data is cached.

For example, if you want to cache the data for fiveminutes, set this

property to 300 0* *(*three hundred).See Also: "Caching with Server

Controls" on page 21-31

Hide

Used to hide amenu in design time and run time.

Checked =Hide function

Unchecked =Show function

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning

Info - GridLayout)

Set position information of a control as absolute, when using aGridLayout

Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"
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Field Description

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML

document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof

code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default

isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

4. When completed, click insert.

A graphic defines where the Standard Menu appears on your template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:Menu id="Menu1" DefaultMenuID="15"

runat="server"></cms:Menu>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.
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Web Search
For a description of the Web Search Function, see See "Web Search Server Control" on page 9-

68.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Content Controls...

To insert an Web Search:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Web Search.

3. The Insert Web Search box is displayed.

4. Use the following table to assist you with inserting an Web Search.

Field Description

Control ID A unique name for the function you are inserting.
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Field Description

FolderID

The numeric id of the folder that you want to search. If you do not

know the folder path, you can navigate to it using the Select folder

drop down box.

Recursive

In the FolderIDproperty, you specify a folder whose content is

searched on thismap. To extend the search to all folders below this

folder, check this box.

Select Folder

Select a folder path to be searched.When a folder is selected, the

folderID textbox is filled with that folder's id number. If you insert the

Folder ID, you do not need to select a folder.

ButtonImgSrc
If you want to display an image on the submit button, enter the server

path to it.

ButtonText
The text used for the button if no image source is identified. If an

image source is identified, this is alternative text for the button.

DisplayXslt

Determineshow the information on the page is displayed

None-databind only

ecmNavigation - lists the title of every content block in the folder

See Also: "Example of ecmNavigation Display" on page 9-124

ecmTeaser - lists the title of every content block in the folder plus the

content summary

Warning! If you specify an external file, it is strongly recommended

that you do not store this file in your site'sWorkarea folder. If you

store this file in theWorkarea folder, the file will be lost when you

upgrade.

See Also: "Example of ecmTeaser Display" on page 9-124

PostResultsAt

Enter theWeb form onwhich the search resultswill post.

To display results on theWeb page fromwhich the search was

initiated, enter a pound sign (#) or leave the field blank.

Warning! AWeb Search server controlmust exist on the posting

page.

ResultTagId

Lets you designate where search results appear. You can place

search criteria in one area of aWeb form and the results in another.

For example, you have the following tag.

<span id=”results”></span>

In this case, enter results for the property value.
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Field Description

Stylesheet

Specify the location of the style sheet for the search results page. Set

the location relative to the site root folder. For example:

csslib\mytest.css.

Leave blank to use the default style sheet,

\webroot\Workarea\csslib\global.css.

MarkupLanguage

Identify the templatemarkup file that controls the display of the

search results. For example, mysearchmarkup.ekml.

If the *.ekml file is located in the same folder as theWeb form

containing the server control, just enter its name. If the file is in

another folder, enter the path relative to site root. For example,

\CMS400Developer\workarea\customfiles\

markup\mysearchmarkup.ekml.

Note: If you enter a valid EkML file, the Displayxsltproperty value

is ignored.

See Also: "EktronMarkup Language" on page 21-414 and

"websearch.ekml" on page 21-474

Text BoxSize
The size of theSearch text box for user input. The width is based on

the number of characters.

ShowSearchBoxAlways

If set to unchecked, the search boxdoesnot appear when the

results are posted to theWeb page.

Checked = search boxalwaysappears

Unchecked = the search boxdoesnot appear when the results are

posted to theWeb page

ShowSearchOptions

If this box is checked, the following optionsappear above the Search

box.

n Site

n Html

n Documents

n Images

n Multimedia

Checked = show search options

Unchecked =hide search options

EnableAdvancedLink

Set to true to display the link to the Advanced Search page (see

image below).
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Field Description

MaxCharacters

Themaximum number of characters theSearch text boxaccepts.

If you enter a value less than 50, it is a good idea to set the

TextBoxSizeproperty to the same number.

Order By

Specify how you want to order the search results that are generated

when a search is performed on youWeb site.

n Title - The title of the content block

n Date Created - The date the content blockwascreated

n Date Modified - The date the content blockwas last modified

n Last Author Last Name - The last author’s last name

n Last Author First Name - The last author’s first name

OrderDirection

Specify if you want the results in ascending or descending order.

n Ascending - Alphabetic or numerical order

n Descending - Reverse alphabetic or numerical order

LinkTarget

Defines the waya link actswhen a link is clicked.

_blank - This target causes the link to alwaysbe loaded in a new

blankwindow. Thiswindow is not named.

_self - This target causes the link to always load in the samewindow

the anchor was clicked in. This is useful for overriding a globally

assigned base target.

_parent - This target makes the link load in the immediate frameset

parent of the document. This defaults to acting like “_self” if the

document hasno parent.

_top - This target makes the link load in the full bodyof the window.

This defaults to acting like “_self” if the document is alreadyat the top.

It is useful for breaking out of an arbitrarily deep frame nesting.

Hide

Used to hide anWeb Search in design time and run time.

Checked =HideWeb Search

Unchecked =ShowWeb Search

Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning Info -

GridLayout)

Set position information of a control as absolute, when using a

GridLayoutWeb page. For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP:

240px"
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Field Description

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a

blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The

default isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click insert.

A graphic defines where the Web Search appears on your template.

Shown below is an example of the code that is inserted.

Platform Code View

.NET
<cms:WebSearch id="WebSearch1" ButtonText="Search!"

FolderId="14" runat="server"></cms:WebSearch>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.
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XML Index Search
For a description of the XML Index Search Function, see "IndexSearch Server Control" on page

7-394.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) > Content Controls...

To insert an XML Index Search:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click XML Index Search.

3. The Insert XML Index Search box is displayed.

4. Use the following table to assist you with inserting an XML Index Search.

Field Description

Control ID A unique name for the function you are inserting.

XMLConfigID

ID of the Smart Formwhose indexed fields appear on the search

screen. If you do not know the XMLConfigID, you can navigate to it

using the Select Smart Form drop down box.
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Field Description

Select XML

Configuration

The drop-down box is populated with a list of all the XML

Configuration titles.When a title is selected, the XMLConfigID

textbox is filled with that XMLConfiguration's id number. If you insert

the XMLConfigID, you do not need to select a XMLConfiguration.

FolderID

The numeric id of the folder that you want to search. If you do not

know the folder path, you can navigate to it using the Select folder

drop down box.

Select Folder

Select a folder path to be searched.When a folder is selected, the

folderID textbox is filled with that folder's id number. If you insert the

Folder ID, you do not need to select a folder.

Search Parm XML
This property preserves settings that a developer would create in

VisualStudio.

Weighted

If this value ischecked, content blocksare ranked by the number of

criteria matches.

For example, if a content blockmatchesall search criteria, it appears

at the top of the results page. A hit marker appears for eachmatch.

If a second content blockonlymatchesone criterion, it also appears

on the results page underneath the first content block. One asterisk

appears above the page’s title to indicate the singlematch.

Checked- display every content block that matchesat least one

search criteria

Unchecked - show only content blocks that match all search criteria

ShowSearchBoxAlways
If set to unchecked, the search boxdoesnot appear on when the

results are posted to theWeb page.

Recursive
Determineswhether the XML IndexSearch Control uses this folder’s

child folders in the search.

LinkTarget

Defines the waya link actswhen a link is clicked.

_blank - This target causes the link to alwaysbe loaded in a new

blankwindow. Thiswindow is not named.

_self - This target causes the link to always load in the samewindow

the anchor was clicked in. This is useful for overriding a globally

assigned base target.

_parent - This target makes the link load in the immediate frameset

parent of the document. This defaults to acting like “_self” if the

document hasno parent.

_top - This target makes the link load in the full bodyof the window.

This defaults to acting like “_self” if the document is alreadyat the top.

It is useful for breaking out of an arbitrarily deep frame nesting.
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Field Description

Order By

Specify how you want to order the search results that are generated

when a search is performed on youWeb site. Also specify if you want

the results in ascending or descending order.

n Title - The title of the content block

n Date Created - The date the content blockwascreated

n Date Modified - The date the content blockwas last modified

n Last Author Last Name - The last author’s last name

n Last Author First Name - The last author’s first name

n Ascending - Alphabetic or numerical order

n Descending - Reverse alphabetic or numerical order

When you choose weighted search results, Ascending and

Descending use howmanycriteria match your search. For example,

if you have weighted results, and you choose Ascending, the results

that match themost criteria appear first.

MaxNumber of results TheMaximum number of content blocks returned (0=unlimited).

DisplayType

Determineshow the information on the page is displayed

None-databind only

ecmNavigation - lists the title of every content block in the folder

See Also: "Example of ecmNavigation Display" on page 9-124

ecmTeaser - lists the title of every content block in the folder plus the

content summary

See Also: "Example of ecmTeaser Display" on page 9-124

DynamicContent

Parameter

Checks the QueryString for the content block ID value and replaces

the search with content when ID is specified. Leave blank to always

display the search. Bymaking content dynamic, when the content

displayed on aWeb page contains a link to another piece of content,

you can display the second piece of content in the sameWeb page

space.

None - Use Default

ID - The control uses the content blockpassed asa URL parameter.

EncodeContentHtml

When checked, Content HTML is encoded when it is returned.

Checked =Content HTML is encoded

Unchecked =Content HTML is not encoded

Hide

Used to hide an IndexSearch in design time and run time.

Checked =Hide IndexSearch

Unchecked =Show IndexSearch

Developer Topics

21-234
ReferenceManual

Version 8.0 Rev 1.3



Field Description

Note: If Hideand Visibleare both checked, the property is

hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: If Hideand Visibleare both checked, the property is

hidden.

Style (Positioning Info -

GridLayout)

Set position information of a control as absolute, when using a

GridLayoutWeb page. For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP:

240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an

HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a

blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The

default isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

Button Text The text that appears on the button.

HitsMarker

This symbol showshowmanysearch criteria each hit matched.

The following example shows the first hit met three of the criteria.

The second groupmet one criterion.

5. When completed, click insert.

A graphic defines where the XML Index Search appears on your template.
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Shown below is an example of the code that is inserted.

Platform Code View

.NET

<cms:IndexSearch id="IndexSearch1" XmlConfigId="10"

FolderId="14" DisplayXslt="ecmTeaser"

runat="server"></cms:IndexSearch>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion
This function is not available asan Ektron Dreamweaver Extension for

ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.
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Other Supported Development
Frameworks

n "Standard ASP.NET Methods" on page 21-238

n "Custom ASP Functions" on page 21-246

n "Custom ColdFusion Functions" on page 21-325

n "Custom PHP Functions" on page 21-345

n "Custom JSP Functions" on page 21-368
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Standard ASP.NET Methods

Use these methods to customize Ektron CMS400.NET. To use them, insert them onto your

template pages to invoke content blocks, list summaries, and other objects stored in your

database. They are the primary building blocks of your Ektron CMS400.NET Content

Management System.

Replacement of Standard Methods
Beginning with Release 4.7, Ektron CMS400.NET utilizes ASP.NET server controls, which

replace most Standard ASP.NET methods. With Ektron CMS400.NET’s new toolbox of pre-

built, reusable, data-bindable ASP.NET controls, Ektron empowers developers working in

Visual Studio to rapidly integrate Ektron CMS components into their templates and sites. For

more Information on Ektron CMS400.NET controls, see "Developer Topics" on page 21-1.

The following examples shows the Login server control added by drag and drop vs. adding a

Login method by the ASP.NET method.

Drag and Drop Login server control

Adding a Login function via an ASP.NET method.

<tr>
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<td>
<%=AppUI.ecmLogin()%>
</td>
</tr>

Best Practice

Ektron recommendsusing CMS400.NET server controlswhen available over

Ektron standard ASP.NET methods. Themethodsare being replaced by the

server controls.

Note: You can still use the standard ASP.NET methods in Ektron CMS400.NET.

Referencing Methods in Visual Basic
Before you can use methods with Visual Basic, you must add a reference to them from Visual

Basic. Follow these steps to do so.

1. Open Visual Basic.

2. Choose or add a project.

3. In Solution Explorer, right click References and choose Add Reference.

4. In the Add Reference dialog box, click Browse.

5. Go to webroot/siteroot/Bin.

6. To load the standard methods click Ektron.Cms.UI.CommonUI.dll. To load the XML

Indexing methods, click Ektron.Cms.Common.dll.

7. Click Open, then OK.
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Adding a New Web Form
To add a new Web form, follow these steps.

1. Open your project in Visual Studio.

2. Right click the project.

3. Click Add > Add Web Form.

4. Click Web Form.

5. In the code behind, add an Imports Ektron.Cms.UI.CommonUI statement.

Requirements for Standard Methods
Ektron CMS400.NET maintains and displays content through the use of Ektron ASPX methods

and ASP.NET assembly objects. To use the methods, include the following code in your

template:

<%@ Page Language="vb" AutoEventWireup="false" %>
<%@ Import Namespace="Ektron.Cms.UI.CommonUI" %>
<% Dim AppUI As New ApplicationAPI %>
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Each line is explained below.

Line Description

<%@ Page Language="vb"

AutoEventWireup="false" %>

Ageneric .net line of code that should alwaysbe

placed in the template

<%@ Import

Namespace="Ektron.Cms.UI.CommonUI"

%>

An import statement that calls the namespace

Ektron.CMS.UI.CommonUI to display

information from the .net assembly file

<% Dim AppUI As New ApplicationAPI

%>

Createsan instance of the ApplicationUI class that

is used byeachmethod

These lines call the Ektron .net assembly object to allow the page to function properly. They

must appear at the top of each template file.

Standard Methods
To customize your Ektron CMS400.NET application, you need to be familiar with these

methods.

Method Description
More

Information

AddContent
Programmatically addsa content blocks to Ektron

CMS400.NET

"Addcontent" on

page 21-242

Collection Displays links generated by collections.

”Collection

Server Control”

on page 153

Content Block Displaysandmanagesa content block.

”ContentBlock

Server Control”

on page 252

Event Calendar Displaysan event calendar

Form
Displaysa content block that is associated with a

form.

”FormBlock

Server Control”

on page 361

IndexSearch Displayson aWeb page a set of search fields. A site ”IndexSearch

StandardMethods
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Method Description
More

Information

visitor uses the page to search for information on

your Web site.

Server Control”

on page 407

List Summary Displaysa list of content block summaries.

”ListSummary

Server Control”

on page 346

Login
Displays the login or logout button, which lets the

user log in and useEktron CMS400.NET.

”Login Server

Control” on page

 8

Metadata
Displays themetadata in the source of theWeb

page displaying the content.

”MetaData

Server Control”

on page 212

Menu Customizes the DHTMLmenus feature

”DhtmlMenu

Server Control”

on page 244

Search

Inserts a text boxwith a search button in the

template.When the user completes the search

screen, it looks through XHTML content on theWeb

site.

”Web Search

Server Control”

on page 85

ShowSiteLanguage
Lets a site visitor select a language in which to view

site.

”LanguageSelect

Server Control”

on page 61

Addcontent
The addcontent method lets you programmatically add a new content block to Ektron

CMS400.NET without logging in. This method can be used for several applications, such as

n A Web form allowing you to collect data from users about the content block

n A loop function that moves information from a database to an Ektron CMS400.NET

database

Warning! Every string that you pass to the functionmust be HTML encoded. Here is the VB.Net syntax for encod-

ing a string.

myTitle = “John’s Book”

myTitle = Server.HtmlEncode(myTitle)
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Explained in the table below are the attributes for the add content block function.

Attribute Description

Username
The username of the user to be authenticated for permissions to see

whether the user is able to add a content block.

Password The password for the username being authenticated.

Domain
If using Active Directory, specify the domain needed to authenticate the

user.

Content_title Specify a title for the content blockbeing added.

Content_

comment
Specify a historical comment for the content being added.

ContentHTML Actual content for the content block.

SummaryHTML Summary information about the content block.

ContentLanguage Language of content.

FolderID ID number of the content folder where the content blockwill be added to.

GoLive

Date and time the content will go live.

Note: Must match date/time format set in theWeb.config keyek_

dateFormat.

EndDate

Date and time the content will expire.

Note: Must match date/time format set in theWeb.config keyek_

dateFormat.

MetaInfo

Specify the information for themetadata which will be used asa reference

point for finding other wordsor information.

An example is:

<metadata><meta id="3">Title</meta></metadata>

Where ID is themetadata definition ID whose value is being set. The value

is set between themeta tagsand themeta tag is repeatable for asmany

metadata definitionsas you want to set for the given content block.

ErrString
If there is a error then errString contains the error, otherwise errString is

empty.

Addcontent
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Add Content Example
The following is an example of the add content function in a template:.

Protected Sub Page_Load(ByVal sender As Object, ByVal e As System.EventArgs)

Handles Me.Load

Dim m_apiObj As Ektron.Cms.UI.CommonUI.ApplicationAPI

Dim newContentId As Integer = 0

Try

m_apiObj = New Ektron.Cms.UI.CommonUI.ApplicationAPI

newContentId = m_apiObj.AddContent( _

"admin", _

"admin", _

"", _

"Content Title", _

"Comment - this content added through API!", _

"This is the <b>body</b> of the content.", _

"This is the <i>summary</i> for the content.", _

"1033", _

"0", _

"06-27-2006 4:09 PM", _

"", _

"<metadata><meta id=""3"">ContentTitle</meta></metadata>", _

"")

Literal1.Text = "Content Added, ID = " + newContentId.ToString

Catch ex As Exception

Literal1.Text = "Error, AddContent Failed: " + ex.Message

Finally

m_apiObj = Nothing

End Try

End Sub

The previous example has the following properties:

n The user “admin” is used to be authenticated.

n The title of the new content block is “Content Title”.

n The comment for the content is “Comment”.

n The body of the content is “This is the body of the content”.

n The summary of the content block is “This is the summary for the content.

n The language ID = 1033, or English.

n The folder ID = 0 is where the content is added.

n The start date is 06-27-2006.

n No end date is specified.

n The metadata definition ID being set is “3” and the value is ContentTitle.
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When this function is executed, the content is added to Ektron CMS400.NET. Displayed here

is the record of the content in the workarea.

AddContent Example
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Custom ASP Functions

Ektron CMS400.NET displays content on your Web site through the use of custom Ektron ASP

functions and ComObjects. Your template you must include the following file to be able to use

the custom functions:

<!-- #include file="applicationAPI.asp" -->

This file (application.asp) calls the file with the custom Ektron functions to allow the

page to function properly. The include statement must appear at the top of every template file

that uses an Ektron CMS400.NET custom ASP function.

Warning! ContentWS.asmx is the web services (WSDL) file that the customASP functionsuse to talk to Ektron

CMS400.NET. TheWSDLpath located in the applicationAPI.asp file must be set to location of theWSDL file.

The default WSDLpath ishttp:/-

/localhost/cms400Developer/WorkArea/WebServices/ContentWS.asmx. If you have changed the loca-

tion of ContentWS.asmx you need to update theWSDLpath. For example, if your site iswww.example.com, the

WSDLpath would be http://www.example.com/WorkArea/WebServices/ContentWS.asmx.

To customize Ektron CMS400.NET, you need to be familiar with these tags.

Function Description
More

Information

Calendar Functions

Calendar
Displaysa calendar with different display types.

For example, a daily view calendar.

Calendar

Function

Event Calendar Displaysamonth view event calendar

"Event

Calendar

Function" on

page 21-305

Collection Functions

Collection Displays links generated by collections

"Collection

Function" on

page 21-293

CollectionXML

CreatesXML for a collection bywrapping tagsaround

all of the collection itemsand their properties. This

allows you to use an XSLT to define how the XML

collection is displayed.

"XML

Collection

Function" on

page 21-300

RandomContent Randomly displays the content of a collection item

"Random

Content" on

page 21-304
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Function Description
More

Information

RandomSummary Randomly displays the summaryof a collection item

"Random

Summary" on

page 21-305

RSSCollection Createsan RSS feed out of the items in a collection.

"RSS

Collection

Function" on

page 21-298

Content Functions

AddContent
Allowsa user to add content to Ektron CMS400.NET

programmatically.

"Add

Content" on

page 21-257

Content Block Displaysandmanagesa content block

"Content

Block

Function" on

page 21-251

Form Displaysa content blockassociated with a form

"Form

Function" on

page 21-307

Multipurpose Displayseither a content blockor a form

"MultiPurpose

Function" on

page 21-310

List Summary Functions

Archive

ListSummary
Displays summaries of archived content blocks

"Archive List

Summary

Function" on

page 21-285

List Summary Displaysa list of content block summaries

"List

Summary

Function" on

page 21-274

List SummaryXML

CreatesXML for a list summarybywrapping tags

around all of the collection itemsand their properties.

This allows you to use an XSLT to define how the XML

collection is displayed.

"XML List

Summary

Function" on

page 21-280
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Function Description
More

Information

RSSList Summary Createsan RSS feed out of the items in a list summary.

"RSS

Summary

Function" on

page 21-289

Single Summary Displays the summary for a content block

"Single

Summary

Function" on

page 21-286

Login Functions

Login Adds the login or logout button

"Login

Function" on

page 21-249

Menu Functions

DropHTMLMenu Used to display a DHTMLmenu

"DHTML

Menus" on

page 21-317

GenerateMenu
Workswith DropHTMLmenu to displayDHTML

menus

"DHTML

Menus" on

page 21-317

XMLMenu
CreatesXML for amenu bywrapping tagsaround all of

themenu itemsproperties.

"XMLMenu"

on page 21-

321

Metadata Functions

Metadata Displays themetadata for the currentWeb page

"Metadata

Function" on

page 21-311

Search Functions

Search Inserts a text boxwith a search button

"Search

Functions

(ASP)" on

page 21-261

Search Display Createsan area to display search results

"Search

Display

Function" on

page 21-270

Developer Topics

21-248
ReferenceManual

Version 8.0 Rev 1.3



Function Description
More

Information

Site Language Functions

ShowSiteLanguage Lets a site visitor select a language in which to view site.

"Show Site

Language

Function" on

page 21-316

Login Function
The login function adds a login button on the template when displayed in a browser. Here it

the format of the login function.

<% ecmLogin %>

This tag is responsible for displaying the following buttons on the Web page.

Button Name Description

Login
When user is not logged into Ektron CMS400.NET, this button

appears. Click this button to let the user log in to the application.

Logout
Once logged in, this button replaces the login button to allow the

user to log out from the Ektron CMS400.NET Web site.

Workarea
When logged in, this button appears under the logout button

allowing the user to access their workarea.

Preview

On

Lets the user to preview the entireWeb site as if all checked-in

content waspublished.

Preview

Off
Turnsoff preview mode.

Login Function
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Login Tag Example
The following example places a login button in a table cell inside an asp template.

<tr>

<td>

<% ecmLogin %>

</td>

</tr>

When inserted properly, a login button appears on the Web page.

Clicking the login button opens a login window in which a user enters the username and

password. Upon successful completion, the user is logged in to the Ektron CMS400.NET Web

site.

Placing Your Login Button
You can add as many login buttons to a template as you like. You might want to include a

login button on each template, or have a special Web page called login.asp, from which users

can log in without the public being able to access the login page.

Developer Topics

21-250
ReferenceManual

Version 8.0 Rev 1.3



Content Block Function
The content block tag displays a content block on an Ektron CMS400.NET Web page. There

are two functions to choose from:

n ecmContentBlock

n ecmContentBlockEX

ecmContentBlock allows you display a content block without having to define an XSLT.

With ecmContentBlockEX, you can display XML content by defining an XSLT or applying

one of the predefined XSLTs located in Ektron CMS400.NET. For more information on

predefined XSLTs, ”Adding a Smart Form Using External XML Files” on page 621.

Here is the format for the ecmContentBlock function.

<%ecmContentBlockEX ID %>

Here is the format for the ecmContentBlockEX function.

<%ecmContentBlockEX

ID,

“XSLT”,

Override %>

Note: Asan alternative, you can use themultipurpose function, which can displayeither a content blockor a

content blockassociated with a form. For more information, see "MultiPurpose Function" on page 21-310.

The table below explains the attributes of the ecmContentBlock function.

Attribute Description Required

ID ID number assigned of the content block that will appear Yes

The table below explains the attributes of the ecmContentBlockEX function.

Attribute Description Required

ID ID number assigned of the content block that will appear Yes
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Attribute Description Required

XSLT

File name and path to a valid XSLT to transform the XML content.

See Also: "The Function’sArguments" on page 21-256

Warning! : If you specify an external file, it is strongly rec-

ommended that you do not store this file in your site'sWorkarea

folder. If you store this file in theWorkarea folder, the file will be lost

when you upgrade.

No

Override

If no XSLT is specified, then enter 1 to use XSLT1, 2 for XSLT2, or 3

for XSLT3.See Also: "The Function’sArguments" on page 21-

256

No

In normal view, these tags retrieve the content block from the database and displays it in the

template.

If a user is logged into Ektron CMS400.NET, the content block tag displays a silver access

point in the upper left of the block to show the edit options when hovering over it. .

Developer Topics

21-252
ReferenceManual

Version 8.0 Rev 1.3



Content Block Examples
Ektron CMS400.NET has two types of content blocks.

Type Displays More information

Static One content blockon theWeb page
"StaticContent Block" on page 21-

253

Dynamic
A content blockwhose ID is passed through

the URL

"DynamicContent Block" on page

21-254

In addition, a content block can contain XHTML or XML content. For more information, see

"XML Content Block" on page 21-255.

Static Content Block
The following illustrates how to insert a static content block on a template.

<tr>

<td>

<% ecmContentBlock(329) %>

</td>

</tr>
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In the example above, the function retrieves the content block with an id of 329 from the

database to the browser.

Dynamic Content Block
The following example shows the content block tag where the id is being passed as a URL

parameter. Use this format with dynamic template.

<tr>

<td>

<% ecmContentBlock(request.QueryString(“id”)) %>

</td>

</tr>

When a user accesses this page, it adds the content block ID number to the tag’s template, and

the content block with the corresponding ID appears on the Web page in the specified

template.
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The id= convention is used by Ektron CMS400.NET to generate quicklinks when content

blocks are created.

The dynamic ecmContentBlock function is almost the same as the static one (see "Static Content

Block" on page 21-253). The only difference is the parameter, which makes the function

dynamic. The parameter uses a query string call (Request.QueryString) to read the URL from

the browser’s address bar. It treats everything after the question mark as a list of key/value

pairs separated by ampersands. So, Request.QueryString passes the key as a parameter and

returns its associated value. For example, in URL

<http://localhost/CMS400Developer/index.asp?id=1&LangType=1036>, the following

QueryString calls return these values.

QueryString Call Return value

Request.QueryString(“id”) 1

Request.QueryString(“LangType”) 1036

XML Content Block
Here is an example of displaying an XML content block. Note that you specify a content

block and an XSLT, which determines how the content block is displayed.
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<tr>

<td>

<% ecmContentBlockEx 13, “”, 1 %>

</td>

</tr>

This example displays the content block ID=13, using XSLT1 as the display XSLT.

The Function’s Arguments
The ecmContentBlockEx takes three arguments. The first argument identifies the content block

to display. The second one is optional and, if used, specifies an external XSLT file.

If the second argument does not exist, the third argument specifies an XSLT identified in the

Edit Smart Form screen. The following table provides additional detail about the second and

third arguments.

To use this display XSLT
Enter this for

argument 2

Enter this for

argument 3

The default XSLT specified in the Edit Smart

Form screen (illustrated below). Note that, in this
example, theXSLT Packaged option is the default

XSLT since it is selected.

““ none

XSLT Packaged: from the Edit Smart

Form screen (that is, the XSLT created in

the Data Designer)

Note: If an XSLT package hasnot been created, and

““ 0
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To use this display XSLT
Enter this for

argument 2

Enter this for

argument 3

zero (0) is the third argument, the default XSLT

specified in the Edit Smart Form screen is used.

XSLT 1 from the Edit Smart Form screen ““ 1

XSLT 2 from the Edit Smart Form screen ““ 2

XSLT 3 from the Edit Smart Form screen ““ 3

An absolute or relative path to an XSLT

An externalXSLT file

not specified in the Edit

Smart Form screen.

For example

<%

ecmContentBlockEx

13,

"samplexslt.xsl"%>

doesnot matter

- if a value exists

in argument 2,

argument 3 is

ignored

Dynamic and Static Combination
Here is an example of how you can use the two different content tags in the same table cell by

using an IF statement

<tr>
<td>
<% if request.QueryString("id")<> "" then
ecmContentBlock(request.QueryString("id"))else
ecmContentBlock(14) end if %>
</td>

<tr>

In this sample code, when a person accesses this page without passing through the content’s

ID number, the content with an ID=14 will be displayed. If you pass a content id through the

URL like index.asp?id=4, the content block ID=4 will be displayed.

Add Content
The add content function allows you to programmatically add a new content block to Ektron

CMS400.NET without the need of logging in.

This function can be for several applications including, but not limited to:
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n Applied to a Web form, allowing you to collect data from users about the content block

n Creating a loop function that moves information from a database to an Ektron

CMS400.NET database

Here is the format for the add content function:

<%
AddContent

Username,Password,Domain,content_
title,content_
comment,
ContentHtml,
SummaryHTML,
ContentLanguage,
FolderID,GoLive,EndDate,MetaInfo

%>

Warning! Every string that you pass to the functionmust be HTML encoded. Here is the VB.Net syntax for encod-

ing a string.

Warning! myTitle = “John’s Book”

Warning! myTitle = Server.HtmlEncode(myTitle)

Explained in the table below are the attributes for the add content block function.

Attribute Description

Username
The username of the user to be authenticated for permissions to see

whether the user is able to add a content block.

Password The password for the username being authenticated.

Domain
If using Active Directory, specify the domain needed to authenticate the

user.

Content_title Specify a title for the content blockbeing added.

Content_

comment
Specify a historical comment for the content being added.
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Attribute Description

ContentHTML Actual content for the content block.

SummaryHTML Summary information about the content block.

ContentLanguage Language of content.

FolderID ID number of the content folder where the content blockwill be added to.

GoLive

Date and time the content will go live.

Note: Must match date/time format set in theWeb.config keyek_

dateFormat.

EndDate

Date and time the content will expire.

Note: Must match date/time format set in theWeb.config keyek_

dateFormat.

MetaInfo

Specify the information for themetadata which will be used asa reference

point for finding other wordsor information.

An example is:

<metadata><meta id="3">Title</meta></metadata>

Where ID is themetadata definition ID whose value is being set. The value

is set between themeta tagsand themeta tag is repeatable for asmany

metadata definitionsas you want to set for the given content block.

Add Content Example
The following is an example of the add content function in a template:.

<tr>
 <td>
 <% AddContent "admin", "admin", "", "Content Title", "Comment",

 "This is the <b>body</b> of the content.", "This is the <i>summary</i>

for the content.", 1033, 31, "06-14-2004 11:55 AM", "",

"<metadata><meta id=""3"">ContentTitle</meta></metadata>","" %>
 </td>

</tr>

The previous example has the following properties:

n The user “admin” is used to be authenticated.

n The title of the new content block is “Content Title”.

n The comment for the content is “Comment”.

n The body of the content is “This is the body of the content”.
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n The summary of the content block is “This is the summary for the content.

n The language ID = 1033, or English.

n The folder ID = 31 is where the content is added.

n The start date is 06-14-2004”.

n No end date is specified.

n The metadata definition ID being set is “3” and the value is ContentTitle.

When this function is executed, the content is added to Ektron CMS400.NET. Displayed here

is the record of the content in the workarea.
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Search Functions (ASP)
The search tag is used to display a text box, with a search button on the template. When seen

on the template of a Web page, users can enter text and click on the search button to search

through all the HTML content on the Web site. To create a search, Ektron has created two

search functions:

n ecmSearch

n ecmSearchNoFormTag

Both functions have the same parameters and perform the same search. The only difference is

ecmSearch automatically inserts form tags, ecmSearchNoFormTag does not.

The following is an example of form tags.

<form name="ecmsearch" method="post" action='search-display.asp'>

</form>

When using ecmSearch, form tags are added automatically. When using ecmSearchNoFormTag

you need to add the tags manually

When using the search function, ecmSearch and ecmSearchNoFormTag can be interchanged.

Shown here is the format for the ecmSearch and ecmSearchNoFormTag:

<% ecmSearch
 or
 ecmSearchNoFormTag

“Starting Folder”,

Recursive,

“Target Page”,

Text Box Size,

Maximum Characters,

“Button Image Source”,

“Button Text”,

‘Font Face’,

“Font Color”,

“Font Size”,

Horizontal,

‘Spare”
%>
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The following table provides information about all the attributes for the search tags.

Attribute Description Required?

Formore

information,

see

Starting

Folder
The folder you wish to search. Yes

"Starting

Folder" on

page 21-264

Recursive Whether to search subfolders. 0=No, 1 =Yes Yes

"Recursive"

on page 21-

264

Target

Page
TheWeb page to output the search results. Yes

"Target Page"

on page 21-

265

Text Box The size of the text box for user input. Yes
"Text Box" on

page 21-265

Maximum

Characters

Themaximum number of characters that the

input text box can accept.
No

"Maximum

Characters"

on page 21-

266

Button

Image

Source

The image location for the search button. Blank

(““) = standard submit button.
No

"Button Image

Source" on

page 21-266

Button

Text

The text used for the button if the standard

submit button is chosen, or alternative text for the

button if an image is chosen.

No

"Button Text"

on page 21-

267

Font Face The font of the search tag text. No

"Font Face"

on page 21-

267

Font Color
The font color of the search tag text. Blank (““) =

Black.
No

Font Size The font size of the search tag text. No
"Font Size" on

page 21-268

Horizontal
Determines if the search optionsare in a row or a

column. 1 = horizontal, 0 = vertical
Yes

"Horizontal"

on page 21-

269

Spare1 Currently not used. Must be ““
"Spare 1" on

page 21-270
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Search Tag Example
The following example places a text field and a search button in a table cell inside an ASP

template.

<tr>
<td>
<% ecmSearch "\",1,"search-
display.asp",25,200,"","Search","Verdana",
"#808080","2",0,"" %>
</td>

</tr>

The previous example has the following properties:

n Searches the root folder, in this case the \content folder.

n Search is recursive.

n The target page is “search-display.asp”.

n The size of the text box is 25.

n The search text box allows up to 200 characters.

n No image is used for a button. Instead, a standard submit button is used.

n The text on the submit button is “Search”.

n The search options appear in Verdana with a color of #808080 and a size of 2pt.

n The search options are arranged vertically.

When added to a template, and visited, the search tag will appear similar to the following:
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Search Tag Attributes
The search tag’s attributes are described below.

Starting Folder
In this attribute, specify the content folder where the search begins. There are two options for

this attribute.

Value Search begins in

“\“

“\folder path” specified folder

Recursive
When you setup the search to be recursive, you are allowing the search to search all the sub-

folders associated with the starting folder you had specified. You have two options for this

attribute:

Developer Topics

21-264
ReferenceManual

Version 8.0 Rev 1.3



Value Search begins in

1 Recursive search (will search sub-folders of the starting folder).

0 Non-Recursive search (will only search starting folder).

Target Page
The page that displays the search results. You may enter any form of a URL for this page.

Note: The target pagemust include the searchdisplay function to display search results.

To use the same page, enter a pound sign (#) into the field.

Text Box
This attribute sets the size of the search text box. It can be any number, depending on the size

of the search text box that you want.

Text Box

Size
Web Page View

10

50
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Maximum Characters
This attribute determines the maximum number of characters that a user can enter for search

text.

Button Image Source
To use an image for the search button, enter the image’s filename and path.

Button Image Source Web Page View

““

“search.jpg”

“http://www.example.com/images/search.jpg”
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Button Text
If no search button image is specified, the text in this field appears on the button. If an image

is being used for the search button, this text is the image’s alt text.

Button Text Web Page View

“ClickMe to Search”

“ClickMe to Search”

Font Face
This font is used for the search options displayed on the Web page.

Font Face Web Page View

Cooper Black
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Font Face Web Page View

Kristen ITC

Font Color
The color of the text in the search tag. You may enter the color name or a hex i decimal value

of the color.

Font Color Web Page View

Red

#14DA14

Font Size
This is the size of the text on the search tag.

Developer Topics

21-268
ReferenceManual

Version 8.0 Rev 1.3



Font Size Web Page View

1

5

Horizontal
This attribute determines whether the search options are displayed vertically or horizontally.

Attribute Web Page View

0

(vertical)

1

(horizontal)
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Spare 1
At the end of the Search tag is a attribute called Spare 1. This attribute has not yet been

assigned an function. As of now, when you enter a search tag, you must pass this attribute ““.

Search Display Function
The search display custom tag creates the area where search results appear after a search is

executed.

Here is the format of the ecmSearchDisplay tag.

<% ecmSearchDisplay
“MaxNumberReturn”,
“StyleInfo”,
ShowDate %>

Below is a description of the tag’s attributes.

Attribute Description Required
Formore

information, see

MaxNumber of

content blocks

Returned

Maximum number of content blocks

returned. (0=Unlimited)
Yes

"MaxNumber of

Content Blocks

Returned" on page

21-271

Style Info

An HTML style string used within the

HTML “hyperlink” generated by the

search output. Can control font, color,

size, etc.

No
"Style Info" on page

21-272

ShowDate
Displays the last modified date of the

content block. 0=No 1=Yes
No

"Show Date" on page

21-273

Search Display Example
Insert the following on the page that displays search results. You may place it on the same

page as the search tag or a separate page.

<tr>
<td>
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<% ecmSearchDisplay 0,"","1" %>
</td>

</tr>

This search display example has the following properties:

n Returns unlimited results when the search is performed.

n Contains no style information.

n Shows the last modified date of the content.

Search Display with Default Content
You can also set up the search display tag to display a default content block if a search is not

performed. Then, if a search is performed, the results replace the content block. The sample

code below does that:

<tr>
<% if (Request.Form("ecmsearchtype") <> "") then %>
<td>
<% ecmSearchDisplay 0,"" %>
</td>
<% else %>
<td>
<% ecmContentBlock(1) %>
</td>
<% end if %>

</tr>

Search Display Attributes
Listed below are the attributes for the SearchDisplay tag.

Max Number of Content Blocks Returned
This attribute determines the number of search results displayed on a page. You may enter any

integer. To display unlimited results, enter 0 (zero).

Search Display Function

ReferenceManual

Version 8.0 Rev 1.3
21-271



Max Returns Web Page View

0

3

Style Info
An HTML style string used within the HTML “hyperlink” generated by the search output. Can

control font, color, size, etc.

Style Info Web Page View

““
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Style Info Web Page View

“font-family:arial; font-weight:bold;

background-color:#cccccc;

border:solid blue 1pt; margin:2px;

width:50%;”

Show Date
This attribute determines if the content block’s last modified date appears next to the title. This

is useful when determining which content block is the most recent. You have two choices.

Attribute Web Page View

0

1
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List Summary Function
The list summary function is used to display the list of content summaries on a Web page.

Shown here is the format of the list summary function:

<% ecmListSummary

"Folder",
Recursive,
ShowSummary,
"StyleInfo",
"OrderBy, Asc/Desc",
"ShowInfo",
MaxNumber,
“ObjType”,
“OptionList” %>

A list and description of the attributes are shown in this table:

Attribute Description Options

Folder This is the folder the summary information will come from. Any folder

Recursive Allow the tag to get summary info from the child folders.

0 =Not

Recursive

1 =Recursive

ShowSummary Do you want the content summary to be displayed?

0 =No

1 =Yes

StyleInfo Inline style information for the generated text hyperlink. Any string

OrderBy,

ASC/DESC

Order the hyperlinks by:

“Title”

“DateModified”

“DateCreated”

“Startdate”

“AuthorFname”

“AuthorLname”

Order the hyperlinks in ascending or descending order. “Title,asc”
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Attribute Description Options

“Title,desc”

ShowInfo Information that will appear to the right of the hyperlink.

“DateModified”

“DateCreated”

“AuthorFname”

“AuthorLname”

MaxNumber Maximum number of summaries returned. 0 =Unlimited

ObjType

Determineswhether the list summary is for the folder or a

single piece of content.

For example:

If the Folderproperty = \books and “Folder” is chosen as

the ObjType, the list summary for the folder with books

appears.

If the folderproperty = 1 and you choose “Content”as

the ObjType, a single summary for content with an ID =1

appears.

See Also: "Single SummaryFunction" on page 21-286

The default ObjType is “Folder”when left blank.

““

“Folder“

“Content”

OptionList Not yet implemented MUST BE ““

List Summary Example
Shown below is an example of the ListSummary function in an ASP Web page.

<TR>
<TD>
<% ecmListSummary "\Marketing\News",0,1,"",
"Title,asc","DateModified",0,"","" %>
</TD>

</TR>

The previous example has the following properties:

n Displays summaries from the \Marketing\News folder.

n Not recursive.

n The summaries will be shown.

n No style was applied to the hyperlinks.

n The results will be displayed in ascending order by title.
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n The date modified of each content block will be displayed.

n Unlimited results will be shown.

Here is how the summaries will appear on the web page.

List Summary Attributes
Listed below are all the different attributes and descriptions about them.

Starting Folder
In this attribute, you will need to specify which content folder you will want to get all the

summaries from. There are two options for this attribute:

Value Description

““
By leaving the value blank, all the summaries from the root content folder will be

displayed.

“\Folder

Path

You can specify a specific folder to display the summaries from by inserting the

folder path
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Recursive
When you setup the search to be recursive, you are allowing the search to search all the

subfolders associated with the starting folder you had specified. You have two options for this

attribute:

Value Description

1 Recursive - summaries in the starting folder’s subfolderswill also be displayed.

0 Non-recursive - only summaries in the starting folder will be displayed.

Show Summary
The show summary attribute displays or suppresses the summary in the summary list. You have

two options for this attribute.

Attribute Web Page View

0

1

Style Info
In this field, you may enter inline style information for the generated text hyperlinks displayed

on the screen.
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Style Info Web Page View

““

"font-family:arial; font-weight:bold;

background-color:#cccccc;

border:solid blue 1pt; margin:2px;

width:100%;"

Order By
This attribute will sort the summary results by different options. There are five different ways to

sort the summaries:

Value Summaries sorted by

Title title

DateModified datemodified

Date Created date created

Startdate The Start Date assigned to the content blockwhen created.

AuthorFname author’s first names

AuthorLname author’s last name
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Ascending/Descending
This attribute is an addition to the previous OrderBy attribute. By default, the list of the

summaries are descending, meaning they will follow the path of A-B-C, or 1-2-3. When set to

ascending, they will order by Z-Y-X or 3-2-1.You will have the option to re arrange these to

display either in ascending or descending order.

To do this, add the following to the OrderBy attribute:

Value Description

asc, 1 Thiswill order the Summaries in an ascending order

desc, 0 Thiswill order the Summaries in a descending order. This is the default setting.

By using the ascending/descending option, you will have the option to set the order of content

blocks from most recent to oldest, or vice versa. As well as ordering the list by the user’s first

names or last names in ascending or descending order.

Show Info
The show info field determines what sort of information is displayed to the right of the

hyperlinked title. There are four different options that you may choose from:

Value Description Web Page View

DateModified
Displays the date the

content was last modified.

***DateCreated

Displays the date when

the content was first

created.

AuthorFname

Displays the first name of

the user who last edited

the content block.
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Value Description Web Page View

AuthorLname

Displays the last name of

the user who last edited

the content block.

Max Number
This attribute determines how many summaries appear on a page. Enter the number of

summaries to be displayed. To display all summaries, enter 0 (zero) and you will display

unlimited results.

XML List Summary Function
The XML List Summary function wraps XML around the properties of a list of content that’s

created as a list summary in the Ektron CMS400.NET Workarea. Once created, you can use the

XML to display the list summary information. The ecmListSummaryXML function allows you

to easily define how the list summary data appears on the Web page.

Shown here is the format of the ecmListSummaryXML function.

<% ecmListSummaryXML

“Folder”,
“Recursive”,
“OrderBy”,
“MaxNumber”,
“ObjType”,
“SummaryType” %>

The ecmListSummaryXml function attributes are explained below.

Attribute Description Options

Folder

This is the folder the summary information

will come from.

See Also: "Starting Folder" on page

21-276

Any folder
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Attribute Description Options

Recursive

Allow the tag to get summary info from the

child folders.

See Also: "Recursive" on page 21-277

0 =Not Recursive

1 =Recursive

OrderBy,

ASC/DESC

Order the hyperlinks by:

See Also: "Order By" on page 21-278

“Title”

“DateModified”

“DateCreated”

“Startdate”

“AuthorFname”

“AuthorLname”

Order the hyperlinks in ascending or

descending order.

“Title,asc”

“Title,desc”

MaxNumber

Maximum number of summaries returned.

See Also: . "MaxNumber" on page 21-
280

0 (Zero) =Unlimited

ObjType

Determineswhether the list summary is for

the folder or a single piece of content.

For example:

If the Folderproperty = \books and

“Folder” is chosen as the ObjType, the list

summary for the folder with booksappears.

If the Folderproperty = 1 and you choose

“Content”as the ObjType, a single

summary for content with an ID =1

appears.

See Also: "Single SummaryFunction"

on page 21-286

The default ObjType is “Folder”when left

blank.

““

“Folder“

“Content”

XML List Summary Function

ReferenceManual

Version 8.0 Rev 1.3
21-281



Attribute Description Options

SummaryType

Used asa filter, this property determines

the type of content that appears in the list

summary. The default is “Content”when

left blank.

“AllTypes” - displaysall of

the content types for the given

folder.

“Content” - displaysa list of

content blocks.

“Forms” - formsappear in

the list summary.

“Archive_Content” -

archived content blocks

appear in the list summary.

“Archive_Forms” - archived

formsappear in the list

summary.

“Assets” - assets, such as

officesdocuments, appear in

the list summary.

“Archive_Assets” -

archived assets appear in the

list summary.

“LibraryItem” - library items

appear in the list summary.

“NonLibraryContent” - all

typesof content appear in the

list summaryexcept for library

items.

When using the XML list summary function, the following tags are created around the

properties of each item in the list summary.

XML Tags Description

<Content></Content>
Declaresa new section of content in the XML

collection.

<ID></ID>

The content block ID.

For example:

<ID>27</ID>

<Title></Title>

The title of the content block.

For example:

<Title>HTML for the World Wide Web with

XHTML and CSS</Title>

<QuickLink></QuickLink>
The quicklink associated with the content block.

For example:
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XML Tags Description

<QuickLink>/CMS400Developer/

collection.aspx?id=27</QuickLink>

<Teaser></Teaser>

The summaryof the content block.

For example:

<Teaser>The easiest HTML book weve seen

that still manages to be

comprehensive.</Teaser>

<StartDate></StartDate>

The content block’s start date formatted asa .NET

date type

For example:

<StartDate>1/1/0001 12:00:00

AM</StartDate>

<DateModified></DateModified>

The last date the content blockwasmodified.

For example:

<DateModified>1/19/2005 4:18:06

PM</DateModified>

<EndDate></EndDate>

The date the content block stops running on theWeb

site

For example:

<EndDate>12/31/9999 12:00:00 AM</EndDate>

<LastEditorFname></LastEditorFname>

The first name of the last person who edited the

content block.

For example:

<LastEditorFname>John</LastEditorFname>

<LastEditorLname></LastEditorLname>

The last name of the last person who edited the

content block.

For example:

<LastEditorLname>Johnson</LastEditorLname>

<DisplayStartDate></DisplayStartDate>
The content block’s start date. It is formatted asa string

that representsEktron CMS400’s display of the date.

<FolderID></FolderID>

The ID of the folder in which the content block is

contained.

For example:

<FolderID>0</FolderID>

<ContentStatus></ContentStatus> The status of the content block.

XML List Summary Function

ReferenceManual

Version 8.0 Rev 1.3
21-283



XML Tags Description

<Language></Language>

The language of the content block.

For example:

<Language>1033</Language>

<DisplayDateModified></DisplayDateModified>

edited. It is formatted asa string that representsEktron

CMS400’s display of the date.

For example:

<DisplayDateModified>1/19/2005 4:18:06

PM</DisplayDateModified>

<DisplayEndDate></DisplayEndDate>

The content block’s end date. It is formatted asa string

that representsEktron CMS400’s display of the date.

For example:

<DisplayEndDate>12/31/9999 12:00:00

AM</DisplayEndDate>

Here is how the raw XML list summary output appears before an XSLT is applied.

<Content>

<ID>24</ID>

<Title>ASP.NET Unleashed</Title>

<QuickLink>/CMS400Developer/collection.aspx?id=24</QuickLink>

<Teaser><p><em>ASP.NET Unleashed, Second Edition</em> is really big, really thorough,

and really <i>good</i>.</p></Teaser>

<StartDate>1/1/0001 12:00:00 AM</StartDate>

<DateModified>1/12/2005 7:53:31 PM</DateModified>

<EndDate>12/31/9999 12:00:00 AM</EndDate>

<LastEditorFname>Application</LastEditorFname>

<LastEditorLname>Administrator</LastEditorLname>

<DisplayStartDate></DisplayStartDate>

<FolderID>0</FolderID>

<ContentStatus></ContentStatus>

<Language>0</Language>

<DisplayDateModified>1/12/2005 7:53:31 PM</DisplayDateModified>

<DisplayEndDate></DisplayEndDate>

</Content>

<Content>

<ID>25</ID>

<Title>Microsoft ASP.NET Programming with Microsoft VisualC#.NET</Title>

<QuickLink>/CMS400Developer/collection.aspx?id=25</QuickLink>

<Teaser><p>Teach yourself how to write high-performanceWeb applicationswith ASP.NET

and VisualC# .NET--one step at a time.</p></Teaser>
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<StartDate>1/1/0001 12:00:00 AM</StartDate>

<DateModified>1/4/2005 7:16:21 PM</DateModified>

<EndDate>12/31/9999 12:00:00 AM</EndDate>

<LastEditorFname>Application</LastEditorFname>

<LastEditorLname>Administrator</LastEditorLname>

<DisplayStartDate></DisplayStartDate>

<FolderID>0</FolderID>

<ContentStatus></ContentStatus>

<Language>0</Language>

<DisplayDateModified>1/4/2005 7:16:21 PM</DisplayDateModified>

<DisplayEndDate></DisplayEndDate>

</Content>

Archive List Summary Function
The Archive list summary function displays on a Web page a list of content summaries for

archived content blocks. For example, you might have a current news page and an archived

news page. Use the List Summary Function to display current news, and this function to

display older news stories.

On the Content Block schedule screen, the user must set an End Date then choose the Archive

and Display option to have the content blocks appear via this function.

Shown here is the format of the Archive List Summary function:

<% ecmListArchiveSummary

“StartingFolder”,
Recursive,
ShowSummary,
"StyleInfo",
"OrderBy, Asc/Desc",
"ShowInfo",
MaxNumber,
"Spare1",
"Spare2" %>

This function has the same parameters as the List Summary Function. See "List Summary

Function" on page 21-274 for details.
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Single Summary Function
The single summary tag is used to display the summary of one content block in the Ektron

CMS400.NET Web site, instead of a list of all the summaries in a content folder. Seen below is

the single summary tag:

<% ecmSingleSummary

"ContentID",
ShowSummary,
"StyleInfo",
"ShowInfo",
"Spare1" %>

You can look at the single summary tag as just a simpler form of the List summary tag. The

format for each of them is almost identical, but the single summary tag does not require as

many attributes to be passed.

A list and description of the attributes are shown in this table:

Attribute Description Required?

Content ID
This is the ID number of the content block the summary

information will come from.
Yes

ShowSummary Do you want the content summary to be displayed? Yes

StyleInfo Inline style information for the generated text hyperlink. No

ShowInfo Information that will appear to the right of the hyperlink. No

Spare1 Not yet implemented MUST BE ““

Single Summary Example
Shown below is an example of the single summary function in an ASP Web page.

<TR>
<TD>
<% ecmSingleSummary "14",1,"","DateModified","" %>
</TD>

</TR>

The previous example had the following properties:

n Displays the summary for the content block with an ID=14
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n The summary will be shown

n No style was applied to the hyperlinks

n The last date the content was modified will be displayed

Here is how the summary will appear on the web page.

Single Summary Attributes
Listed below are all the different attributes and descriptions about them.

Content ID
In this attribute, you will need to specify which content block you will want the summary to

be displayed from.

Show Summary
The show summary attribute will allow or disallow the summary to be displayed in the

summary list. You have two options for this attribute:

Value Web Page View

0

1

Style Info
In this field, you may enter inline style information for the generated text hyperlinks displayed

on the screen.
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Style Info Web Page View

““

font-family:arial; font-weight:bold;

background-color:#cccccc;

border:solid blue 1pt; margin:2px;

width:100%;

Show Info
The show info field determines what sort of information is displayed to the right of the

hyperlinked title. There are five different options that you may choose from:

Value Displays the... Web Page View

ID
ID number for the content

block.

DateModified
date the content was last

modified.

DateCreated
date when the content was

first created.

AuthorFname
first name of the user who last

edited the content block.
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Value Displays the... Web Page View

AuthorLname
last name of the user who last

edited the content block

Spare 1
There is one attribute fields at the end that are currently not used. This is here for future

scalability. When you insert a single summary tag into your template, you must leave this

attributes as ““

RSS Summary Function
The RSS summary function is used to create an XML list of content summaries formatted for

RSS Syndication.

Shown here is the format of the RSS summary function:

<% ecmRssSummary

“Folder”,
Recursive,
"OrderBy, Asc/Desc",
MaxNumber, %>

A list and description of the attributes are shown in this table:

Attribute Description Options

Folder
This is the folder the summary information will come

from.
Any folder

Recursive
Allow the tag to get summary info from the child

folders.

0 =Not

Recursive

1 =Recursive
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Attribute Description Options

OrderBy,

ASC/DESC

Order the hyperlinks by:

“Title”

“DateModified”

“DateCreated”

“Startdate”

“AuthorFname”

“AuthorLname”

Order the hyperlinks in ascending or descending

order.

“Title,asc”

“Title,desc”

MaxNumber Maximum number of summaries returned. 0 =Unlimited

RSS Summary Example
Shown below is an example of the ecmRssSummary function in an ASP Web page.

<TR>
<TD>
<% ecmRssSummary "\CMS400Developer\", 0, "Title,asc", 0 %>
</TD>

</TR>

The previous example has the following properties:

n Displays summaries from the \CMS400Developer\ folder.

n Not recursive.

n The results will be displayed in ascending order by title.

n Unlimited results will be shown.

Here is how an RSS summary appears when viewed without an RSS reader on a web page.

<?xml version=”1.0” ?>
- <rss xmlns:xsd="http://www.w3.org/2001/XMLSchema"

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" version="2.0">
- <channel>
<title>example listsummary</title>
<link>http://localhost/CMS400Developer/developer/ListSummary/RSS.aspx?show=true</link>
<description />
- <item>
<title>eWebEditPro+XML V4.2 supports the vision of create content once, reuse many

times</title>
<link>http://192.168.0.82/CMS400Developer/Developer/ListSummary/pr.aspx?id=290</link>
- <description>
- <![CDATA[ &lt;p&gt;Ektrons XML Authoring Tool Makes it Easier to Create Structured,

Validated Content to Support an Organizations Information and Content Management
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Strategies&lt;/p&gt; ]]>
</description>
<author>Application Administrator</author>
<pubDate>3/7/2006 2:00:46 PM</pubDate>
</item>
- <item>
<title>Ektron Offers a Visual Development Environment for Rapid CMS Integration and

Deployment</title>
<link>http://192.168.0.82/CMS400Developer/Developer/ListSummary/pr.aspx?id=282</link>
- <description>
- <![CDATA[&lt;p&gt;Ektron leverages strong capabilities of Visual Studio to give

developers a truly visual environment for integrating CMS components into Web

templates&lt;/p&gt; ]]>
</description>
<author>Application Administrator</author>
<pubDate>3/7/2006 2:02:19 PM</pubDate>
</item>
- <item>
<title>Ektron Announces Winner of All-Stars Customer Competition</title>
<link>http://192.168.0.82/CMS400Developer/Developer/ListSummary/pr.aspx?id=292</link>
- <description>
- <![CDATA[ &lt;p&gt;&lt;em&gt;-- All-Stars competition identifies the most innovative

and effective implementations of Ektrons Web solutions and tools --

&Lt.;/em&gt;&lt;/p&gt; ]]>
</description>
<author>Application Administrator</author>
<pubDate>3/6/2006 10:51:52 AM</pubDate>
</item>
</channel>
</rss>

RSS Summary Attributes
Listed below are all the different attributes and descriptions about them.

Starting Folder
In this attribute, you will need to specify which content folder you will want to get all the

summaries from. There are two options for this attribute:

Value Description

““
By leaving the value blank, all the summaries from the root

content folder will be displayed.

“\Folder Path
You can specify a specific folder to display the summaries from by

inserting the folder path
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Recursive
When you setup the search to be recursive, you are allowing the search to search all the

subfolders associated with the starting folder you had specified. You have two options for this

attribute:

Value Description

1
Recursive - summaries in the starting folder’s subfolderswill also

be displayed.

0
Non-recursive - only summaries in the starting folder will be

displayed.

Order By
This attribute will sort the summary results by different options. There are five different ways to

sort the summaries:

Value Summaries sorted by

Title title

DateModified datemodified

Date Created date created

Startdate
The Start Date assigned to the

content blockwhen created.

AuthorFname author’s first names

AuthorLname author’s last name

Ascending/Descending
This attribute is an addition to the previous OrderBy attribute. By default, the list of the

summaries are descending, meaning they will follow the path of A-B-C, or 1-2-3. When set to

ascending, they will order by Z-Y-X or 3-2-1.You will have the option to re arrange these to

display either in ascending or descending order.

To do this, add the following to the OrderBy attribute:
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Value Description

asc, 1 Thiswill order the Summaries in an ascending order

desc, 0
Thiswill order the Summaries in a descending order. This is the

default setting.

By using the ascending/descending option, you will have the option to set the order of content

blocks from most recent to oldest, or vice versa. As well as ordering the list by the user’s first

names or last names in ascending or descending order.

Max Number
This attribute determines how many summaries appear on a page. Enter the number of

summaries to be displayed. To display all summaries, enter 0 (zero) and you will display

unlimited results.

Collection Function
The collection function is used to display the list of links that were created as a collection in

the Ektron CMS400.NET Workarea. The ecmCollection function is highly customizable,

allowing you to easily define how the collection data appears on the Web page.

Shown here is the format of the ecmCollection function.

<% ecmCollection
“id”,
“Display Function” %>

The ecmCollection function attributes are explained below.

Attribute Description

id The id of the collection that you would like to be displayed is defined here.

displayFunction

Specify a function that is defined in the API and determineshow the

appearance of the collection data on aWeb page. The display functionmust

also be defined in the ecmCollection function.

See Also: ”Comparison of Collections, Menus, Taxonomy, and the List Summary Features”

on page 1229

Collection Function

ReferenceManual

Version 8.0 Rev 1.3
21-293

#
#
#
#
#
#
#
#
#
#
#
#
#


Collection Examples
The following are examples of the collection function in the Ektron CMS400.NET sample Web

site. One example uses the ecmNavigation display function, and the other uses the ecmTeaser

display function.

The ecmNavigation and ecmTeaser display functions are sample display functions included with

Ektron CMS400.NET.

The ecmNavigation Display Function
The following sample collection function is being used as a navigation menu in the Ektron

CMS400.NET sample Web site.

<% ecmCollection 1, “ecmNavigation” %>

In this example, the collection with an ID=1 is displayed, and the ecmNavigation function

defines the appearance of the collection data on a Web page.

Here is how a collection might appear on a Web page.

Below is the source code for the ecmNavigation display function.

Function ecmNavigation(cInfo)
dim html, info
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html = "<table border=""0"" cellspacing=""0"" cellpadding=""0""
width=""100%"">"
for each info in cInfo
html = html & "<tr><td>&nbsp;&nbsp;<a href="""
html = html & info("ContentLinks")
html = html & """>"
html = html & Cstr(info("ContentTitle"))
html = html & "</a></td></tr><tr><td>&nbsp;</td></tr>"
next
html = html & "</table> "
ecmNavigation = html

end Function

As you can see, the ecmNavigation function is a simple ASP function that creates a table of the

links to the specified collection. It displays the title of the content blocks by using the

info(“ContentTitle”)) building block.

The ecmTeaser Display Function
The following is an example of a collection function being used as a navigation menu in the

Ektron CMS400.NET sample Web site.

<% ecmCollection 2, “ecmTeaser” %>

In this example, the collection with an ID=2 is displayed, and the ecmTeaser function defines

the appearance of the collection data on the Web page. ecmTeaser displays the title and

summary of each content block in the collection.

Here is how the collection might appear on a Web page.

The format of the collection on the Web page depends on the displayFunction that is used.

Below is the source code for the display function ecmTeaser.

Function ecmTeaser(cInfo)
dim html, info
html = "<table border=""0"" cellspacing=""0"" cellpadding=""0""
width=""100%"">"
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for each info in cInfo
html = html & "<tr><td><a href="""
html = html & CStr(info("ContentLinks"))
html = html & """ >"
html = html & Cstr(info("ContentTitle"))
html = html & "</a>&nbsp;("
html = html & info("DateModified")
html = html & ")</td></tr><tr><td>"
html = html & Cstr(info("ContentTeaser"))
html = html & "</td></tr><tr><td>&nbsp;</td></tr>"
next
html = html & "</table>"
ecmTeaser = html

end Function

As you can see, the ecmTeaser function is an ASP function that creates a table of links to the

specified collection. The ecmTeaser function displays the:

n Content title

n Date modified

n Content block summary

Collection Attributes

ID
The collection ID number is assigned to the collection when it is created.
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DisplayFunction
A display function determines which elements of the content blocks in a collection appear on

a Web page. Via ASP scripting, you can create display functions or use any of the three

included functions. You must define the display function in two places.

n In the ecmCollection function as a case

n In the API file as a function
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RSS Collection Function
The RSS collection function is used to create an XML list of links that were created as a

collection in the Ektron CMS400.NET Workarea. The ecmRssCollection function is highly

customizable, allowing you to easily define how the collection data appears on the Web page.

Shown here is the format of the ecmRssCollection function.

<% ecmRssCollection “id” %>

The ecmRssCollection function attributes are explained below.

Attribute Description

id The id of the collection that you would like to be displayed is defined here.

See Also: ”Comparison of Collections, Menus, Taxonomy, and the List Summary Features”

on page 1229

Here is how an RSS Collection appears when viewed without an RSS reader on a web page.

<?xml version=”1.0” ?>

<rss xmlns:xsd=”http://www.w3.org/2001/XMLSchema”

xmlns:xsi=”http://www.w3.org/2001/XMLSchema-instance” version=”2.0”>

<channel>

<title>Books</title>

<link>http://localhost/cms400Developer/WorkArea/WebServices/ContentWS.asmx</link>

<description></description>

<item>

<title>VisualBasic.NET How to Program</title>

<link>http://localhost/cms400Developer/collection.aspx?id=23</link>

<description>VisualBasic .NET How to Program, Second Edition is an awesome resource for

the beginning VB.NET developer who is seriousabout the craft of programming. In 1,500

pages, this book covers an incredible amount of territory, from the evolution of programming

languagesand web development all the way to advanced data structuresand web

services.</description>

<author>Application Administrator</author>

<pubDate>3/3/2005 5:15:30 PM</pubDate>

</item>

<item>

<title>SimplyVisualBasic.NET 2003</title>
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<link>http://localhost/cms400Developer/collection.aspx?id=26</link>

<description>An Application-Driven Tutorial Approach</description>

<author>Application Administrator</author>

<pubDate>1/8/2005 10:50:30 AM</pubDate>

</item>

<item>

<title>Microsoft ASP.NET Programming with Microsoft VisualC#.NET</title>

<link>http://localhost/cms400Developer/collection.aspx?id=25</link>

<description>Teach yourself how to write high-performanceWeb applicationswith ASP.NET

and VisualC# .NET--one step at a time.</description>

<author>Application Administrator</author>

<pubDate>1/4/2005 7:16:21 PM</pubDate>

</item>

<item>

<title>HTML for theWorldWideWebwith XHTML and CSS</title>

<link>http://localhost/cms400Developer/collection.aspx?id=27</link>

<description>The easiest HTML bookwe’ve seen that stillmanages to be comprehensive, and

to stay firmly grounded in the reality of today’s demanding users and complex

browsers.</description>

<author>Application Administrator</author>

<pubDate>1/19/2005 4:18:06 PM</pubDate>

</item>

</channel>

</rss>
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XML Collection Function
The XML collection function wraps XML around the parameters of a list of content that’s

created as a collection in the Ektron CMS400.NET Workarea. Once created you can use the

XML to display the collection information. The ecmCollectionXML function allows you to

easily define how the collection data appears on the Web page.

Shown here is the format of the ecmCollectionXML function.

<% ecmCollectionXML “id”, “GetHtml” %>

The ecmCollectionXML function attributes are explained below.

Attribute Description

id The id of the collection that you would like to be displayed is defined here.

GetHtml

Determineswhether the HTML contained within the content is included in the XML

output.

0 =Do not get HTML

1 =Get HTML

Note: Ektron recommendsusing 0 (zero). HTML content can be large and this

could cause display problemswhen your XML collection is displayed on your Web

page.

See Also: ”Comparison of Collections, Menus, Taxonomy, and the List Summary Features”

on page 1229

When using the XML Collection function, the following tags are created around the properties

of each item in the collection.

XML Tags Description

<Content></Content>
Declaresa new section of content in the XML

collection.

<ID></ID>

The content block ID.

For example:

<ID>27</ID>
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XML Tags Description

<Title></Title>

The title of the content block.

For example:

<Title>HTML for the World

Wide Web with XHTML and CSS</Title>

<QuickLink></QuickLink>

The quicklink associated with the content block.

For example:

<QuickLink>/CMS400Developer/

collection.aspx?id=27</QuickLink>

<Teaser></Teaser>

The summaryof the content block.

For example:

<Teaser>The easiest HTML book weve seen

that still manages to be

comprehensive.</Teaser>

<Html></Html>

All of the HTML content contained in a content block.

See Also: "GetHtml" on page 21-300

For example:

<Html><em>ASP.NET Unleashed, Second

Edition</em> is really big, really

thorough, and really <i>good</i>. The

explanations are simple and clear as

anything weve seen in a .NET book. The

sample code addresses virtually every

facet of ASP.NET development, from little

gems (code for validating credit cards) to

full-fledged web stores. Best of all,

Stephen Walther identifies the mistakes

ASP.NET developers are most likely to make

-- and presents detailed solutions.

</Html>

<StartDate></StartDate>

The content block’s start date formatted asa .NET

date type

For example:

<StartDate>1/1/0001

12:00:00 AM</StartDate>

<DateModified></DateModified>

The last date the content blockwasmodified.

For example:

<DateModified>1/19/2005 4:18:06

PM</DateModified>

<EndDate></EndDate>

The date the content block stops running on theWeb

site

For example:

<EndDate>12/31/9999

12:00:00 AM</EndDate>
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XML Tags Description

<LastEditorFname></LastEditorFname>

The first name of the last person who edited the

content block.

For example:

<LastEditorFname>John</LastEditorFname>

<LastEditorLname></LastEditorLname>

The last name of the last person who edited the

content block.

For example:

<LastEditorLname>Johnson</LastEditorLname>

<Hyperlink></Hyperlink>

The hyperlink shown in the collection for linking to the

content block.

For example:

<Hyperlink><a href="/CMS400Developer

/collection.aspx?id=27">

HTML for the World Wide Web with XHTML and

CSS</a></Hyperlink>

<DisplayStartDate></DisplayStartDate>
The content block’s start date. It is formatted asa string

that representsEktron CMS400’s display of the date.

<FolderID></FolderID>

The ID of the folder in which the content block is

contained.

For example:

<FolderID>0</FolderID>

<ContentStatus></ContentStatus> The status of the content block.

<Language></Language> The language of the content block.

<DisplayDateModified></DisplayDateModified>

edited. It is formatted asa string that representsEktron

CMS400’s display of the date.

For example:

<DisplayDateModified>1/19/2005 4:18:06

PM</DisplayDateModified>

<DisplayEndDate></DisplayEndDate>

The content block’s end date. It is formatted asa string

that representsEktron CMS400’s display of the date.

For example:

<DisplayEndDate>12/31/9999 12:00:00

AM</DisplayEndDate>
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XML Tags Description

<EndDateAction></EndDateAction>

What should happen to the content blockon its end

date.

n archive display

n archive expire

n refresh report

For example:

<EndDateAction>Archive_

Expire</EndDateAction>

<Comment></Comment>

Comments contained in the content block.

For example:

<Comment>move picture below text</Comment>

Here is how the raw XML Collection output appears before an XSLT is applied.

<Content>

<ID>24</ID>

<Title>ASP.NET Unleashed</Title>

<QuickLink>/CMS400Developer/collection.aspx?id=24</QuickLink>

<Teaser><p><em>ASP.NET Unleashed, Second Edition</em> is really big, really thorough,

and really <i>good</i>.</p></Teaser>

<Html></Html>

<StartDate>1/1/0001 12:00:00 AM</StartDate>

<DateModified>1/12/2005 7:53:31 PM</DateModified>

<EndDate>12/31/9999 12:00:00 AM</EndDate>

<LastEditorFname>Application</LastEditorFname>

<LastEditorLname>Administrator</LastEditorLname>

<Hyperlink><a href=”/CMS400Developer/collection.aspx?id=24”>ASP.NET

Unleashed</a></Hyperlink>

<DisplayStartDate></DisplayStartDate>

<FolderID>0</FolderID>

<ContentStatus></ContentStatus>

<Language>0</Language>

<DisplayDateModified>1/12/2005 7:53:31 PM</DisplayDateModified>

<DisplayEndDate></DisplayEndDate>

<EndDateAction>Archive_Expire</EndDateAction>

<Comment></Comment>

</Content>

<Content>

<ID>25</ID>

<Title>Microsoft ASP.NET Programming with Microsoft VisualC#.NET</Title>

<QuickLink>/CMS400Developer/collection.aspx?id=25</QuickLink>

<Teaser><p>Teach yourself how to write high-performanceWeb applicationswith ASP.NET
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and VisualC# .NET--one step at a time.</p></Teaser>

<Html></Html>

<StartDate>1/1/0001 12:00:00 AM</StartDate>

<DateModified>1/4/2005 7:16:21 PM</DateModified>

<EndDate>12/31/9999 12:00:00 AM</EndDate>

<LastEditorFname>Application</LastEditorFname>

<LastEditorLname>Administrator</LastEditorLname>

<Hyperlink><a href=”/CMS400Developer/collection.aspx?id=25”>Microsoft ASP.NET

Programming with Microsoft VisualC#.NET</a></Hyperlink>

<DisplayStartDate></DisplayStartDate>

<FolderID>0</FolderID>

<ContentStatus></ContentStatus>

<Language>0</Language>

<DisplayDateModified>1/4/2005 7:16:21 PM</DisplayDateModified>

<DisplayEndDate></DisplayEndDate>

<EndDateAction>Archive_Expire</EndDateAction>

<Comment></Comment>

</Content>

Random Content
The random content function is used to randomly display the content of a content block that

belongs in a specified collection.

Displayed here is the format for the random content function

<% ShowRandomContent “id”, XSLTId %>

Where the “id” represents the ID number of the collection the content blocks, that will be

displayed, belong to
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And “XSLTId” is the ID number of the display XSLT that will be applied to the content

blocks in the collections.

Random Summary
Similar to the random content function, the random summary function randomly displays a

content block summary that belongs in a specified collection.

Here is the format for the random content function

<% ShowRandomSummary “id” %>

The “id” represents ID number of the collection to which the content blocks belong.

Event Calendar Function
The ecmEvtCalendar function displays a month view event calendar that has been created in

Ektron CMS400.NET. Here is the format for the event calendar custom function.

<% ecmEvtCalendar “id”

%>

Note: You can use ecmCalendar to call a calendar and displaya different view, such asdaily. For more

Information, see Calendar Function

The “id” argument represents the ID number of the event calendar in the Workarea.
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Event Calendar Style Sheet
Before you insert an event Calendar into your Ektron CMS400.NET template, you should make

a reference to the style sheet, \siteroot\Workarea\csslib\calendarStyles.css, in your template.

This style sheet contains styles that define the Calendar.

Event Calendar Sample
Here is an example of an event Calendar in an Ektron CMS400.NET template.

<tr>
<td>
<% ecmEvtCalendar "1" %>
</td>
</tr>

When this code is displayed in a browser, the Calendar with an ID-1 is displayed. Here is the

calendar displayed on a Web Page

If... Calendar Display

Logged

in
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If... Calendar Display

Logged

Out

As you can see, when you are logged into the Web site, you can add and view Calendar

events. When logged out, you can only view calendar events.

(continued in Calendar Function)

Form Function
The ecmFormBlock and ecmFormBlockNoFormTag functions display an HTML form content

block. Both functions have the same parameters and display the form the same way. The only
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The following is an example of form tags.

<form name="myform" action="#" onsubmit="return EkFmValidate(this);" method="post">

</form>

When using ecmFormBlock, form tags are added automatically. When using

ecmFormBlockNoFormTag, form tags need to be added manually.

For more information about HTML forms, see ”Working with HTML Forms” on page 521.

Warning! If you create a template for an existing form content block, youmust manually change its quicklink to

point to the new template. This change doesnot occur automatically. This procedure is described in ”Updating

Default Template for Multiple Quicklinks” on page 1226.

Here are the two formats for the form custom function.

<% ecmFormBlock “id” %>

or

<% ecmFormBlockNoFormTag “id” %>

Note: Asan alternative, you can use themultipurpose function, which can displayeither a content blockor a

content blockassociated with a form. For more information, see "MultiPurpose Function" on page 21-310.

The “id” argument represents the form’s ID number, visible when viewing the form from the

View Form screen.

ecmFormBlock and ecmFormBlockNoFormTag are interchangeable when using this function.

Here is an example of a form content block in an Ektron CMS400.NET template.

<tr>
<td>
<% ecmFormBlock "367" %>
</td>
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</tr>

When this code is read by a browser, the following is displayed.

When a visitor to your site submits a form, the form uses the form information to process the

data.

MultiPurpose Function
The ecmMultiPurpose function displays either a content block or an content block associated

with a form. As a result, you can use one template to display both types of content block.

Here is the format for the Multipurpose function:

<% ecmMultiPurpose “id” %>

To pass in a standard content block, pass the id value in the url parameter, as illustrated below.

http://localhost/cms400sample/index.asp?id=2

To pass in a Form content block, pass the ekfrm value in the url parameter, as illustrated below.

http://localhost/cms400sample/index.asp?ekfrm=2

Note: For more information about passing the id value asa URL parameter, see "DynamicContent Block" on

page 21-254.

If the id value or ekfrm value does not exist, a blank template appears.
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If the url parameter is not passed in or recognized, the function calls ecmContentBlock and

passes the DefaultID value as the id argument. If the DefaultID value is zero (0),

ecmContentBlock is not called.

Metadata Function
The metadata tag is used to display the metadata for one or more content blocks in the Ektron

CMS400.NET Web site. This custom tag lets you generate the list of metadata edited by the

authors and insert it in the source of the Web page. Below is an example of the metadata

custom tag.

<% ecmMetaData “ItemList”,”Spare1” %>

The attributes are described below.

Attribute Description Required?

ItemList

List of the content block ID numbers, and

exclusionsSee Also: ot exist. "Creating
an Item List" on page 21-311 and "Item List" on

page 21-314

No

Spare1
Not yet implementedSee Also: "Spare 1"

on page 21-316
MUST BE ““

Creating an Item List
The Item List for the ecmMetadata tag has the following format.

“[content block id; Exclusion list]...[content block id; Exclusion list]”

Attribute Description Required?

[ (left bracket)
Delineates the beginning of a content block

id/exclusion list pair
Yes

Content Block

ID

The ID of the content blockwhosemetadata you

want to retrieve
Yes

; (semicolon)
Separator: Separates content block id from the

exclusion list

No (Yes if including an

exclusion list)
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Attribute Description Required?

Exclusion List
A comma delimited list of metadata you do not

want to be retrieved for this content block.
No

] (right bracket)
Delineates the end of a content block id/exclusion

list pair
Yes

ecmMetadata Example
For this example, our administrator has defined the following metadata types for Ektron

CMS400.NET.

Name Style Type Editable Required
Remove

Dups

Case

Sensitive

Title n/a HTML Yes Yes No n/a

Keywords Name Meta Yes Yes Yes No

Content-

Type

http-

equiv
Meta No Yes Yes n/a

Our example Web page has two content blocks displayed.

n content block 1, the company’s home page introduction text

n content block 2, a sidebar containing the lead story for the week

The metadata entered by your content editors for these two content blocks are:

Content Block 1:

Title – “Welcome to Our Home Page”

Keywords – “Home; page; company; Welcome”

Content-Type -- “text/html; charset=iso-8859-1“

Content Block 2:

Title – “Announcing our New Product!”

Keywords – “Announce; company; product; widget”

Content-Type -- “text/html; charset=iso-8859-1“

To include both content blocks’ metadata in a Web page, the ecmMetadata call looks like this.

<html>
<head>
<% ecmMetadata “[1][2;Title,Content-Type]”, “” %>
(rest of head)
</head>

Developer Topics

21-312
ReferenceManual

Version 8.0 Rev 1.3



<body>
(rest of web page document)
</body>

</html>

In the above example, the ecmMetadata call is contained in the <head> of the HTML document

(since all HTML metadata is required to exist there). When the Web page is viewed, the Web

page source contains the following information:

<html>
<head>
<Title>Welcome to Our Home Page</Title>
<meta name=”Keywords” content= Home; page; company; Welcome; Announce;
product; widget”>
<meta http-equiv=”Content-Type” content=”text/html; charset=iso-8859-1”>
(rest of head)
</head>
<body>
(rest of web page document)
</body>

</html>

The ecmMetadata constructed three HTML tags based on the administrator defined parameters

and the ecmMetadata call.

The metadata tag was constructed in the page because:

n [1] - Displays all metadata content for the content block ID=1. In this example, the title,

keywords, and content-type were defined, so they were displayed as:
<Title>Welcome to Our Home Page</Title>
<meta name=”Keywords” content= Home; page; company; Welcome;
Announce; product; widget”>
<meta http-equiv=”Content-Type” content=”text/html;

charset=iso-8859-1”>

n [2;title,content-type] - Displays all metadata content for content block ID=2, except for its

title and content-type definitions.
<Title>Welcome to Our Home Page</Title>
<meta name=”Keywords” content= Home; page; company; Welcome;
Announce; product; widget”>
<meta http-equiv=”Content-Type” content=”text/html;
charset=iso-8859-1”>

The next section provides more examples.

More ecmMetadata Examples
Shown below is an example of the metadata function in an ASP Web page.

<TR>
<TD>
<% ecmMetaData "[1][2;title][14;keywords]","" %>
</TD>

</TR>
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The previous example has the following properties:

n All metadata for content block ID=1 is inserted into the page

n All metadata for the content block ID=2 except for its title is inserted into the page

n All metadata for the content block ID=14 except for its keywords is inserted into the page

Using a Dynamic Metadata Tag
You can use a metadata tag in a template to define the metadata for a specific content block.

However, you can also use a dynamic metadata tag combined with a content block tag to show

the metadata for all content blocks on a Web page.

This allows you to create a template and not have to keep updating the tag by adding the new

ID and exclusion list. Shown below is the sample code for this.

<!-- #include virtual="/CMS400.NETsample/CMS400.NETscripts/ektronAPI.asp" -->
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0 Transitional//EN">
<html>
<head>
<% Dim id
if (request.QueryString("id")<> "") then
id = request.QueryString("id")
else
id = 1
end if
ecmMetadata "[" & id & "]", ""
%>
</head>
<body>
<% ecmContentBlock(request.QueryString("id")) %>
</body>
</html>

In this example, if you specify a content block in the URL and the page is displayed, the

metadata takes that ID and displays the proper metadata in the source for the content block.

ecmMetadata Attributes
Below are the attributes and their descriptions.

Item List
In this attribute of the ecmMetadata tag, you need to specify two values.

Value Specifies

ID The content block ID whosemetadata will appear

Exclusion List
Themetadata to be excluded.See Also: "Creating an Item

List" on page 21-311
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Some examples might be:

<% ecmMetaData "[1][2]","" %>

In this example, all metadata from content block ID=1 and 2 is displayed.

<% ecmMetaData "[1;title][2;keywords]","" %>

In this example, all the metadata from content block ID=1 will be displayed except for the

title. Also, all the metadata for content block ID=2 is displayed except its keywords.

<% ecmMetaData "[1][2;title,keywords]","" %>
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In this example, all metadata from content block ID=1 is displayed, and all metadata from

content block ID=2 is displayed except its title and keywords.

Spare 1
One attribute field at the end is currently not used. It is for future scalability. When you insert

a single metadata tag into a template, you must leave this attributes as ““.

Show Site Language Function
This function lets a visitor to your Web site select a language in which to view the site. Here

is what the function looks like when published on a Web page.
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It lists all languages selected on the Settings > Configuration > Language settings screen.

(For more information, see ”Multi-Language Support” on page 1755.)

Below is an example of the Show Site Language custom tag.

<% ecmShowSiteLanguage(FieldName)%>

You can place this function in any location of any page on your site. By default, it appears in

the lower right corner of the home page.

Note: This function onlyworkswith Asp and ASP.Net.

The attribute is described in this table.

Attribute Description

FieldName

An optional argument. You can leave it blankand allow the drop-

down list to be populated by the available languages for your Web

site. For example:

<%=ecmShowSiteLanguage(‘’)%>

Or you can pass in an argument such as:

<%=ecmShowSiteLanguage(‘mysitelanguage’)%>

DHTML Menus
Ektron CMS400.NET’s Menu feature lets users create and maintain a dropdown menu system

for your Web site. The Menu feature lets you display menu options that link to content blocks,

library assets, external hyperlinks and submenus.

To learn more about menus, see ”Working with Menus” on page 1392.

Additional Documentation in Ektron Knowledge Base
This chapter explains how to implement standard menus that ship with Ektron CMS400.NET.

Ektron’s Web site also provides Knowledge Base articles that explain how to extend the

standard menu features.
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Displaying a Menu on a Web Page

GenerateMenu and DropMenu

Warning! Themenu functionsdescribed below are only one example of how to implement menus. The scripts

reside in the Application API file. You can implement your ownmenu system using JavaScript.

Use the GenerateNextGenMenu and DropNextGenMenu custom functions to display a DHTML

menu on a Web page. Place GenerateNextGenMenu once on the page to provide an infrastructure

for DropNextGenMenu. Then, place DropNextGenMenu as needed to implement individual menus.

Follow these steps to display a menu on a Web template.

1. Place the following code directly after the page’s <body> tag.
<%=(ecmDHTML_GenerateNextGenMenu("menu id number"))%>

For example:

<%=(ecmDHTML_GenerateNextGenMenu("1"))%>

To display more than one menu, separate each id number with a comma. For example:

<%=(ecmDHTML_GenerateNextGenMenu("1,2,3"))%>

2. If the user clicks text to display the menu, place the following code within the template

file where the text would appear.

 <%= ecmDHTML_DropNextGenMenu(menu id number,"text user clicks to display menu")%>

For example:

<%= ecmDHTML_DropNextGenMenu(1,"Products")%>

If the user clicks a graphic to invoke the menu, use this syntax:

 <%= ecmDHTML_DropNextGenMenu(menu id number,'<img src=graphic file

name>')%>

For example:

 <%= ecmDHTML_DropNextGenMenu(1,'<img src=mymenugraphic.jpg>')%>

Displaying Menus in a Multi-language System
If your Web site supports multiple languages, and the user selects a language before viewing

the menu, if an edition of the menu is available in that language, it appears. If not, nothing

appears.

For more information, see ”Working with Menus in a Multi-Language System” on page 1423.
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Customizing the Menu’s Appearance
You can customize a menu’s appearance, such as the font style, color, and size. So, you have

the flexibility to coordinate a menu with the design your Web site.

To customize a menu in Ektron CMS400.NET, you can change the ek_menu.js file. See Also:
"ek_Menu.js" on page 21-319

ek_Menu.js
You can change the look and feel of a menu by changing the ek_menu.js file. If you used the

default settings when installing Ektron CMS400.NET, this file is in

webroot/siteroot/Workarea/java/.

Use the following table to help you change menu attributes.

Attribute name Specifies the Default value

fontSize Size of menu text 14

fontWeight

Thicknessof menu text

You can set FontWeight byname (Bold

or Plain) or value. Values range from 0

-1000.

Plain

fontFamily

Font style of menu text

See Also: "FontFamily" on page 21-
320

arial,helvetica,espy,

sans-serif

fontColor

Color of menu text

Note:When changing the color, you can

specify the color name or code.

#000000

fontColorHiLite
Color of text whenmenu item is

highlighted
#ffffff

bgColor Color of border betweenmenu items #555555

menuBorder
Width (in pixels) of border aroundmain

menu
1

menuItemBorder
Width (in pixels) of border around each

menu item
1
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Attribute name Specifies the Default value

menuItemBgColor Background color of menu items #6699ff

menuLiteBgColor

Color of mainmenu border highlight

See Also: "menuLiteBgColor" on
page 21-321

menuBorderBgColor Color of themainmenu border #6699ff

menuHiLiteBgColor
Background color of highlightedmenu

item
#000084

menuContainerBgColor

Background color of the container

Note: The container is like a <div> tag

that displays themenu.When you set the

container color, it appears at the top and

left side of themenu frame only.

childMenuIcon

Path to the submenu icon (the image

used to indicate that a submenu is

available from thismenu item).

To display a different image, either

provide an external path to it or upload

the image to Ektron CMS400.NET then

provide a local path.

./Workarea/images/

application/arrows.gif

childMenuIconHiLite

The path to the icon that appearswhen

you hover themouse over amenu item

that leads to a submenu.

To display a different image, either

provide an external path to it or upload

the image to Ektron CMS400.NET then

provide a local path.

./Workarea/images/

application/arrows2.gif

FontFamily
Use the fontFamily attribute to specify the menu font. It must be supported by the browser.

You can assign to this property several, comma-separated values.
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Note: To displaya font family other than the browser default, specify only the font name and no other comma-

separated values. If you specifymore than one value for the font family, Ektron CMS400.NET uses the default IE

settings.

menuLiteBgColor

Example

XML Menu
The ecmGetMenuXML function wraps XML around the properties of a menu created in the

Ektron CMS400.NET Workarea. Once created you can use the XML to display the menu. The

ecmGetMenuXML function allows you to easily define how the menu data appears on the

Web page.

Shown here is the format of the ecmGetMenuXML function.

<% ecmGetMenuXML (id) %>

The ecmGetMenuXml function attributes are explained below.

Attribute Description

Id The id that associated with themenu.

When using the XML Menu function, the following tags are created around the properties of

each item in the menu.
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XML Tags Description

<Item></Item>

<ItemID></ItemID>
For example:

<ItemID>1</ItemID>

<ItemType></ItemType>
For example:

<ItemType>Submenu</ItemType>

<ItemTitle></ItemTitle>
For example:

<ItemTitle>MenuExample</ItemTitle>

<ItemImage></ItemImage>

<ItemImageOverride></ItemImageOverride>

For example:

<ItemImageOverride>

False</ItemImageOverride>

<Menu></Menu>

<ID></ID>
For example:

<ID>1</ID>

<Title></Title>
For example:

<Title>MenuExample</Title>

<Type></Type>
For example:

<Type>content</Type>

<Link></Link>

<ParentID></ParentID>
For example:

<ParentID>0</ParentID>

<AncestorID></AncestorID>
For example:

<AncestorID>1</AncestorID>

<FolderID></FolderID>
For example:

<FolderID>0</FolderID>

<Description></Description>

<Image></Image>

<ImageOverride></ImageOverride>
For example:

<ImageOverride>False</ImageOverride>
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XML Tags Description

<ItemLink></ItemLink>

For example:

<ItemLink>/CMS400Example/

contentblock.aspx?id=12</ItemLink>

<ItemTarget></ItemTarget>
For example:

<ItemTarget>2</ItemTarget>

<Template></Template>

Here is how the raw XML Menu output appears before an XSLT is applied.

<Item>

<ItemID>1</ItemID>

<ItemType>Submenu</ItemType>

<ItemTitle>MenuExample</ItemTitle>

<ItemImage></ItemImage>

<ItemImageOverride>False</ItemImageOverride>

<Menu>

<ID>1</ID>

<Title>MenuExample</Title>

<Template></Template>

<Type>content</Type>

<Link></Link>

<ParentID>0</ParentID>

<AncestorID>1</AncestorID>

<FolderID>0</FolderID>

<Description></Description>

<ImageOverride>False</ImageOverride>

</Item>

<Item>

<ItemID>2</ItemID>

<ItemType>Submenu</ItemType>

<ItemTitle>Book</ItemTitle>

<ItemImage></ItemImage>

<ItemImageOverride>False</ItemImageOverride>

<Menu>

<ID>2</ID>

<Title>Book</Title>

<Template></Template>

<Type>content</Type>

<ParentID>1</ParentID>

<ImageOverride>False</ImageOverride>

<Item>

<ItemID>23</ItemID>

<ItemType>content</ItemType>

<ItemTitle>VB.NET How to</ItemTitle>

<ItemImage></ItemImage>

<ItemLink>/CMS400Developer/collection.aspx?id=23</ItemLink>

<ItemTarget>2</ItemTarget>

</Item>

</Menu>

</Item>
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</Menu>

</Item>
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Custom ColdFusion Functions

Ektron CMS400.NET maintains and display content through the use of custom Ektron

ColdFusion functions and ComObjects.

When using custom ColdFusion functions, the following paths must be updated in the

application.cfm.

<cfset application.WSDLpath =

"http://localhost/siteroot/WorkArea/WebServices/ContentWS.asmx?WSDL" />

and

<cfset application.AppPath = "/siteroot/WorkArea/platforms/ColdFusion/" />

The application.WSDLpath needs to updated with the location of the WSDL file. For example,

For example, if your site is www.example.com, the WSDL path would be

http://www.example.com/WorkArea/WebServices/ContentWS.asmx.

The application.AppPath needs to updated with the path to the ColdFusion custom Functions.

To customize you Ektron CMS400.NET application, you will need to be familiar with these

tags

Function Description
More

Information

Calendar Functions

Event Calendar Displaysamonth view event calendar

Event

Calendar

Function

Collection Functions

Collection Displays links generated by collections

"Collection

Function" on

page 21-335

CollectionXML

CreatesXML for a collection bywrapping tagsaround all

of the collection itemsand their properties. This allows you

to use an XSLT to define how the XML collection is

displayed.

"XML

Collection

Function" on

page 21-338

RandomContent Randomly displays the content of a collection item

"Random

Content

Function" on

page 21-330
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Function Description
More

Information

Random

Summary
Randomly displays the summaryof a collection item

"Random

Summary

Function" on

page 21-330

RSSCollection Createsan RSS feed out of the items in a collection.

"RSS

Collection

Function" on

page 21-338

Content Functions

Add Content
Allows a user to add content to Ektron

CMS400.NET progammatically.

"Add

Content" on

page 21-

329

Content Block Displaysandmanagesa content block

"Content

Block

Function" on

page 21-328

Form Displaysa content blockassociated with a form

"Form

Function" on

page 21-339

Multipurpose Displayseither a content blockor a form

"MultiPurpose

Function" on

page 21-339

Language Functions

Language Select Lets a site visitor select a language in which to view site.

"Language

Select

Function" on

page 21-343

List Summary Functions

Archive

ListSummary
Displays summaries of archived content blocks

Archive List

Summary

Function

List Summary Displaysa list of content block summaries

"List

Summary

Function" on

page 21-332
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Function Description
More

Information

List Summary

XML

CreatesXML for a list summarybywrapping tagsaround

all of the collection itemsand their properties. This allows

you to use an XSLT to define how the XML collection is

displayed.

"XML List

Summary

Function" on

page 21-332

RSSList

Summary
Createsan RSS feed out of the items in a list summary.

"RSSList

Summary

Function" on

page 21-333

Single Summary Displays the summary for a content block.

"Single

Summary

Function" on

page 21-334

Login Functions

Login Adds the login or logout button

"Login

Function" on

page 21-328

Menu Functions

DropHTMLMenu Used to display a DHTMLmenu

"DHTML

Menus" on

page 21-341

GenerateMenu Workswith DropHTMLmenu to displayDHTMLmenus

"DHTML

Menus" on

page 21-341

XMLMenu
Creates XML for a menu by wrapping tags

around all of the menu items properties.

"XMLMenu

Function" on

page 21-343

Metadata Functions

Metadata Displays themetadata for the currentWeb page

"Metadata

Function" on

page 21-340

Search Functions

Search Inserts a text boxwith a search button

"Search

Function (cf)"

on page 21-

331
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Function Description
More

Information

Search Display Createsan area to display search results

Search

Display

Function

Login Function
This tag is responsible for displaying the following buttons on the Web page.

This function is basically the same as the Login function in ASP. See "Login Function" on

page 21-249 for details. The only difference is the syntax used to implement the function. This

is listed below.

Login Tag Example
<tr>
<td>
<cfmodule template="#request.ecm.AppPath#ecmLogin.cfm">
</td>

</tr>

Content Block Function
The content block and content blockEX tags are used to display a content block on an Ektron

CMS400.NET Web page.

Shown here is the format for the content block function:

<CFMODULE template="#request.ecm.AppPath#ecmContentBlock.cfm"
ID=""

>

Shown here is the format for the content blockEX function:

<CFMODULE template="#request.ecm.AppPath#ecmContentBlockEx.cfm"
ID=""
XSLT=""
Override=""

>
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This functions are basically the same as the ContentBlock and ContenBlockEX function in

ASP. See "Content Block Function" on page 21-251 for details.

The only difference between the Coldfusion function and the ASP one is the syntax for

implementing it. The ColdFusion examples are below.

Static Content Block
 <tr>

<td>
<CFMODULE id="1" template="#request.ecm.AppPath#ecmContentBlock.cfm">

 </td>

 </tr>

Dynamic Content Block
 <tr>
 <td>

<CFMODULE id="#id#"

template="#request.ecm.AppPath#ecmContentBlock.cfm">
 </td>

 </tr>

XML Content Block
 <tr>
 <td>
 <CFMODULE id="13" XSLT= “” override= “1”
 template="#request.ecm.AppPath#ecmContentBlockEx.cfm">

 </td>
 </tr>

Add Content
The add content function allows you to programmatically add a new content block to Ektron

CMS400.NET without the need of logging in.

Here is the format for the add content function:

<CFModule template=”#request.ecm.AppPath#ecmAddContent.cfm”

Username=””,

Password=””,

Domain=””,

content_title=””,

content_comment=””,

ContentHtml=””,

SummaryHTML=””,

ContentLanguage=””,

FolderID=””,

GoLive=””,
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EndDate=””,

MetaInfo=”” >

This function is basically the same as the Add Content function in ASP. See "Add Content" on

page 21-257 for details.

The only difference between the Coldfusion function and the ASP one is the syntax for

implementing it. The ColdFusion example is below.

Add Content Example
The following is an example of the add content function in a template:.

<tr>
<td>
<CFModule template="#request.ecm.AppPath#ecmAddContent.cfm "AddContent UserName="admin",

Password="admin", Domain="", content_title="Content Title", content_comment="Comment",

ContentHTML="This is the <b>body</b> of the content.", SummaryHTML="This is the <i>summary</i>

for the content.", ContentLanguage="1033", FolderID="0", GoLive="", EndDate="", MetaInfo="">
</td>

</tr>

Random Content Function
The random content function is used to randomly display the content of a content block that

belongs to a specified collection. Below is the format for the random content function:

<CFMODULE template="#request.ecm.AppPath#ecmShowRandomContent.cfm"
ID=""
XSLT=""
Override=""

>

This function is basically the same as the Random Content function in ASP. See "Random

Content" on page 21-304 for details.

Random Summary Function
SImilar to the random content function, the random summary function can randomly display a

content block summary that belongs to a specified collection. Here is the format for the random

content function

<CFMODULE template="#request.ecm.AppPath#ecmShowRandomSummary.cfm"
ID=""
>

Developer Topics

21-330
ReferenceManual

Version 8.0 Rev 1.3



This function is basically the same as the Random Summary function in ASP. See "Random

Summary" on page 21-305 for details.

Search Function (cf)
The search tag is used to display a text box, with a search button on the template. When seen

on the template on the Web page, the users will be allowed to enter text and click on the

search button to search through all the content on the Web site.

Shown here is the format for the ecmSearch tag.

<CFMODULE template="#request.ecm.AppPath#ecmSearch.cfm"
StartingFolder=""
Recursive=""
TargetPage=""
TextBoxSize=""
MaxCharacters=""
ButtonImageSrc=""
ButtonText=""
FontFace=""
FontColor=""
FontSize=""
Horizontal=""

>

This function is basically the same as the Search function in ASP. See "Search Functions

(ASP)" on page 21-261 for details.

The only difference between the Coldfusion function and the ASP one is the syntax for

implementing it. The ColdFusion example is below.

Search Tag Example
<tr>
<td>
<CFMODULE template="#request.ecm.AppPath#ecmSearch.cfm"
StartingFolder="\marketing" Recursive="1" TargetPage="search-
display.cfm" TextBoxSize="25" MaxCharacters="200"
ButtonImageSrc="" ButtonText="Search" FontFace="Verdana"
FontColor="##808080" FontSize="2" Horizontal="0">
</td>

</tr>

(continued in Search Display Function)
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List Summary Function
The list summary function is used to display the list of content summaries on a Web page.

Shown here is the format of the list summary function:

<CFMODULE template="#request.ecm.AppPath#ecmListSummary.cfm"
Folder=""
MaxNumber=""
Recursive=""
ShowSummary=""
StyleInfo=""
OrderBy=""
ShowInfo=""
>

This function is basically the same as the List Summary function in ASP. See "List Summary

Function" on page 21-274 for details.

The only difference between the Coldfusion function and the ASP one is the syntax for

implementing it. The ColdFusion example is below.

List Summary Example
<TR>
<TD>
<CFMODULE template="#request.ecm.AppPath#ecmListSummary.cfm"
Folder="\Marketing\News" MaxNumber="0" Recursive="0"
ShowSummary="1" StyleInfo="" OrderBy="Title,asc" ShowInfo="" >
</TD>

</TR>

XML List Summary Function
The XML List Summary function wraps XML around the properties of a list of content, created

as a list summary in the Ektron CMS400.NET Workarea. Once created you can use the XML to

display the list summary information. The ecmListSummaryXML function allows you to easily

define how the list summary data appears on the Web page.

<TR>
<TD>
<CFMODULE template="#request.ecm.AppPath#ecmListSummaryXML.cfm"
Folder="" Recursive="" OrderBy=""
MaxNumber="" ObjType="" SummaryType="" >
</TD>

</TR>
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This function is basically the same as the List Summary XML function in ASP. See "XML List

Summary Function" on page 21-280 for details.

The only difference between the Coldfusion function and the ASP one is the syntax for

implementing it. The ColdFusion example is below.

XML List Summary Example
<TR>
<TD>
<CFMODULE template="#request.ecm.AppPath#ecmListSummaryXML.cfm"
Folder="\books\" Recursive="0" OrderBy="Title,asc"
MaxNumber="0" ObjType="folder" SummaryType="alltypes">
</TD>

</TR>

RSS List Summary Function
The RSS summary function is used to create an XML list of content summaries for RSS

Syndication. Shown here is the format of the RSS list summary function:

<CFMODULE template="#request.ecm.AppPath#ecmListSummary.cfm"
Folder=""
MaxNumber=""
Recursive=""
OrderBy=""
>

This function is basically the same as the RSS Summary function in ASP. See "RSS Summary

Function" on page 21-289 for details.

The only difference between the Coldfusion function and the ASP one is the syntax for

implementing it. The ColdFusion example is below.

List Summary Example
<TR>
<TD>
<CFMODULE template="#request.ecm.AppPath#ecmListSummary.cfm"
Folder="\books" MaxNumber="0" Recursive="0"
OrderBy="Title,asc" >
</TD>

</TR>

(continued in Archive List Summary Function)
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Archive List Summary Function
The Archive list summary function displays on a Web page a list of content summaries for

archived content blocks. For example, you might have a current news page and an archived

news page. Use the List Summary Function to display current news, and this function to

display older news stories.

On the Content Block schedule screen, the user must set an End Date then choose the Archive

and Display option to have the content blocks appear via this function.

This function has the same parameters as the List Summary Function. See "List Summary

Function" on page 21-274 for details.

Single Summary Function
The single summary tag is used to display the summary of one content block in the Ektron

CMS400.NET Web site, instead of a list of all the summaries in a content folder. Seen below is

the single summary tag:

<cfmodule template="#request.ecm.AppPath#ecmSingleSummary.cfm"
ContentID=""
ShowSummary="1"
StyleInfo=""
ShowInfo=""

>

This function is basically the same as the Single Summary function in ASP. See "Single

Summary Function" on page 21-286 for details.

The only difference between the Coldfusion function and the ASP one is the syntax for

implementing it. The ColdFusion example is below.

Single Summary Example
<TR>
<TD>
<cfmodule template="#request.ecm.AppPath#ecmSingleSummary.cfm"
ContentID="14" ShowSummary="1" StyleInfo=""
ShowInfo="DateModified">
</TD>

</TR>
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Collection Function
The collection function is used to display the list of links that were created as a collection in

the Ektron CMS400.NET Workarea. The ecmCollection function is highly customizable,

allowing you to easily define how the collection data will be displayed on the Web page.

Shown here is the format of the ecmCollection function.

<CFMODULE template="#request.ecm.AppPath#ecmCollection.cfm"
id="2"
displayFunction="ecmTeaser"

>

This function is basically the same as the Collection function in ASP. See "Collection

Function" on page 21-293 for details.

The only difference between the Coldfusion function and the ASP one is the syntax for

implementing it. The ColdFusion example is below.

Example Using the ecmNavigation Display Function
The following is an example of a collection function being used as a navigation menu in the

Ektron CMS400.NET sample Web site.

<CFMODULE id="1" displayFunction="ecmNavigation"

template="#request.ecm.AppPath#ecmCollection.cfm">

As stated earlier, the format of the collection on the Web page depends on the displayFunction

that is used. Below is the source code for the display function “ecmNavigation”.

<cfparam name="Attributes.nId" default="">
<cfparam name="Attributes.href" default="">
<cfparam name="Attributes.target" default="">
<cfparam name="Attributes.startStyle" default="">
<cfparam name="Attributes.endStyle" default="">
<cfset LocalError = "">
<cfobject class="CMS400.NETContentBrv2.CMS400.NETContent" Action="Create" name="cmsObj">

<cfset cNavs =

cmsObj.GetEcmCollectionItems(request.ecm.AppConfStr,Attributes.nId,0,request.ecm.cmsPreview,request.ecm.user_

id,request.ecm.site_id,LocalError)>
<cfif cNavs.Count()>
<cfset nString = "">
<cfloop collection=#cNavs# Item=nav>
<cfset nString = nString & "<a href=""">
<cfif len(Attributes.href)>
<cfif FindNoCase("?", Attributes.hrefs)>
<cfset nString = nString & Attributes.href & "&id=" &
nav.Item("ContentID")>
<cfelse>
<cfset nString = nString & Attributes.href & "?id=" &
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nav.Item("ContentID")>
</cfif>
<cfelse>
<cfset nString = nString & nav.Item("ContentLinks")>
</cfif>
<cfset nString = nString & """ ">
<cfif len(Attributes.target)>
<cfset nString = nString & "target=""" & Attributes.target & """ ">
</cfif>
<cfset nString = nString & ">">
<cfif len(Attributes.startStyle)>
<cfset nString = nString & Attributes.startStyle>
</cfif>
<cfset nString = nString & nav.Item("ContentTitle")>
<cfif len(Attributes.endStyle)>
<cfset nString = nString & Attributes.endStyle>
</cfif>
<cfset nString = nString & "</a>">
</CFLOOP>
<cfmodule str="#nString#" nId="#Attributes.nId#"

template="#request.ecm.AppPath#ecmshowCollectionsContent.cfm">
</cfif>
<cfset nNavs = "Nothing">

<cfset cmsObj = "Nothing">

As you can see, the ecmNavigation function is a simple ASP function that creates a table of the

links that belong to the collection specified. The function also displays the title of the content

blocks by using the “info(“ContentTitle”)) building block.

Example Using the ecmTeaser Display Function
The following is an example of a collection function being used as a navigation menu in the

Ektron CMS400.NET sample Web site.

<CFMODULE id="2" displayFunction="ecmTeaser"

template="#request.ecm.AppPath#ecmCollection.cfm">

In this example, the collection with an ID=2 is displayed, and the function “ecmTeaser”

defines how to display the collection data on a Web page. Here is how the collection would

appear on a Web page.
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As stated earlier, the format of the collection on the Web page depends on the displayFunction

that is used. Below is the source code for the display function “ecmTeaser”.

<cfparam name="Attributes.nID" default="">
<cfparam name="Attributes.href" default="">
<cfparam name="Attributes.ShowSummary" default="">
<cfparam name="Attributes.StyleInfo" default="">
<cfparam name="Attributes.target" default="">
<cfset ErrorString = "">
<cfobject class="CMS400.NETContentBrv2.CMS400.NETContent" Action="Create" name="tObj">
<cfset cTeasers = tObj.GetEcmCollectionItems(request.ecm.AppConfStr, Attributes.nId, 0,

request.ecm.cmsPreview, request.ecm.user_id, request.ecm.site_id, ErrorString)>
<cfset tString = "<table border=""0"" cellspacing=""0"" cellpadding=""0""

width=""100%"">">
<cfif cTeasers.Count()>
<cfloop collection=#cTeasers# Item=cT>
<cfset tString = tString & "<tr><td>">
<cfset tString = tString & "<a href=""">
<cfif len(Attributes.href)>
<cfif FindNoCase("?", Attributes.hrefs)>
<cfset tString = tString & Attributes.href & "&id=" &
cT.Item("ContentID")>
<cfelse>
<cfset tStringi = tString & Attributes.href & "?id=" &
cT.Item("ContentID")>
</cfif>
<cfelse>
<cfset tString = tString & cT.Item("ContentLinks")>
</cfif>
<cfset tString = tString & """ ">
<cfif len(Attributes.target)>
<cfset tString = tString & "target=""" & Attributes.target & """ ">
</cfif>
<cfset tString = tString & ">">
<cfset tString = tString & cT.Item("ContentTitle") & "</a>" & "&nbsp;(" &
DateFormat(cT.Item("DateModified"), "mm/dd/yyyy") & " " &
TimeFormat(cT.Item("DateModified"), "h:mm:ss tt") & ")</td></tr><tr><td>" &
cT.Item("ContentTeaser")>
<cfset tString = tString & "</td></tr><tr><td>&nbsp;</td></tr>">
</cfloop>
<cfset tString = tString & "</table>">
<cfmodule str="#tString#" nId="#Attributes.nId#"

template="#request.ecm.AppPath#ecmshowCollectionsContent.cfm">

</cfif>

As you can see, the ecmTeaser function is a simple ASP function that creates a table of the

links that belong to the collection specified.

The ecmTeaser function also displays the:

n Content Title

n Date Modified

n Content Teaser

Collection Variables
See "Collection Attributes" on page 21-296

Collection Function

ReferenceManual

Version 8.0 Rev 1.3
21-337



DisplayFunction
The display function defines how collection data appears on a Web page. Using ColdFusion

scripting, you can create your own display functions, or use the three included functions.

XML Collection Function
The XML collection function wraps XML around the parameters of a list of content that’s

created as a collection in the Ektron CMS400.NET Workarea. Once created you can use the

XML to display the collection information. The ecmCollectionXML function allows you to

easily define how the collection data appears on the Web page.

Shown here is the format of the ecmCollection function.

<CFMODULE template="#request.ecm.AppPath#ecmCollectionXML.cfm"
id=""
getHtml=""

>

This function is basically the same as the XML Collection function in ASP. See "XML

Collection Function" on page 21-300 for details.

The only difference between the Coldfusion function and the ASP one is the syntax for

implementing it. The ColdFusion example is below.

<CFMODULE template="#request.ecm.AppPath#ecmCollectionXML.cfm" id="3" getHtml="0">

RSS Collection Function
The RSS collection function is used to create an XML list of links that were created as a

collection in the Ektron CMS400.NET Workarea and display them in RSS Syndication.

Shown here is the format of the ecmRssCollection function.

<CFMODULE template="#request.ecm.AppPath#ecmRssCollection.cfm"
id="2"

>

This function is basically the same as the RSS Collection function in ASP. See "RSS Collection

Function" on page 21-298 for details.
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The only difference between the Coldfusion function and the ASP one is the syntax for

implementing it.

(continued in Event Calendar Function)

Form Function
The ecmFormBlock function displays an HTML form content block. For more information

about HTML forms, see ”Working with HTML Forms” on page 521.

Warning! If you create a template for an existing form content block, youmust manually change its quicklink to

point to the new template. This change doesnot occur automatically. This procedure is described in “Updating

Default Template for Multiple Quicklinks” on page 1226.”

Here is the format for the form custom function

<CFMODULE template="#request.ecm.AppPath#ecmFormBlock.cfm" ID="" >

This function is basically the same as the Form function in ASP. See "Form Function" on page

21-307 for details.

The only difference between the Coldfusion function and the ASP one is the syntax for

implementing it. The ColdFusion example is below.

Here is an example of a form content block in an Ektron CMS400.NET template.

 <tr>
 <td>

 <CFModule template="#request.ecm.AppPath#ecmFormBlock" form_

id="1">
 </td>

 </tr>

MultiPurpose Function
The ecmMultiPurpose function displays either a content block or an content block associated

with a form. As a result, you can use one template to display both types of content block.

Here is the format for the Multipurpose function

 <CFMODULE template="#request.ecm.AppPath#ecmMultiPurpose.cfm" Defaul-

tID="" >

To pass in a standard content block, pass the id value in the url parameter, as illustrated below.

http://localhost/CMS400Developer/index.asp?id=2
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To pass in a Form content block, pass the ekfrm value in the url parameter, as illustrated below.

http://localhost/CMS400Developer/index.asp?ekfrm=2

Note: For more information about passing the id value asa URL parameter, see "DynamicContent Block" on

page 21-329.

If the id value or ekfrm value does not exist, a blank template appears.

If the url parameter is not passed in or recognized, the function calls ecmContentBlock and

passes the DefaultID value as the id argument. If the DefaultID value is zero (0),

ecmContentBlock is not called.

Metadata Function
The metadata tag is used to display the metadata for one or more content blocks in the Ektron

CMS400.NET Web site. Inserting this custom tag will allow you to generate the list of

metadata that is edited by the authors, and insert it in the source of the Web page. Shown

below is an example of what the metadata custom tag looks like.

<cfmodule template="#request.ecm.AppPath#ecmMetadata.cfm" ItemList="" >

This function is basically the same as the Metadata function in ASP. See "Metadata Function"

on page 21-311 for details.

The only difference between the Coldfusion function and the ASP one is the syntax for

implementing it. The ColdFusion examples are below.

<cfmodule template="#request.ecm.AppPath#ecmMetadata.cfm" ItemList="[1][2]">

<cfmodule template="#request.ecm.AppPath#ecmMetadata.cfm"
ItemList="[1;title][2;keywords]>
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<cfmodule template="#request.ecm.AppPath#ecmMetadata.cfm"
ItemList="[1][2;title,keywords]>

DHTML Menus
Ektron CMS400.NET’s Menu feature lets users create and maintain a dropdown menu system

for your Web site. The Menu feature lets you display menu options that link to content blocks,

library assets, external hyperlinks and submenus.

To learn more about menus, see ”Working with Menus” on page 1392.
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Additional Documentation in Ektron Knowledge Base
This chapter explains how to implement standard menus that ship with Ektron CMS400.NET.

Ektron’s Web site also provides Knowledge Base articles that explain how to extend the

standard menu features.

Displaying a Menu on a Web Page

GenerateMenu and DropMenu

Warning! Themenu functionsdescribed below are only one example of how to implement menus. You can imple-

ment your ownmenu system using JavaScript.

Use the GenerateNextGenMenu and DropNextGenMenu custom functions to display a DHTML

menu on a Web page. Place GenerateNextGenMenu once on the page to provide an infrastructure

for DropNextGenMenu. Then, place DropNextGenMenu as needed to implement individual menus.

Follow these steps to display a menu on a Web template.

1. Place the following code directly after the page’s <body> tag.
<CFMODULE Ids=”menu id number” template="#request.ecm.AppPath#ecmDHTML_

GenerateNextGenMenu.cfm">

For example:

 <CFMODULE Ids="1" template="#request.ecm.AppPath#ecmDHTML_

GenerateNextGenMenu.cfm">

To display more than one menu, separate each id number with a comma. For example:

 <CFMODULE Ids="1,2,3" template="#request.ecm.AppPath#ecmDHTML_

GenerateNextGenMenu.cfm">

2. If the user clicks text to display the menu, place the following code within the template

file where the text would appear.

<CFMODULE MenuId="menu id number" Title="text user clicks to display menu" tem-

plate="#request.ecm.AppPath#ecmDHTML_DropNextGenMenu.cfm">

For example:

<CFMODULE MenuId="1" Title="Products" template="#request.ecm.AppPath#ecmDHTML_

DropNextGenMenu.cfm">

If the user clicks a graphic to invoke the menu, use this syntax:

<CFMODULE MenuId="menu id number" Title= '<img src=graphic file name>' tem-

plate="#request.ecm.AppPath#ecmDHTML_DropNextGenMenu.cfm">

For example:

<CFMODULE MenuId="1" Title= '<img src=mymenugraphic.jpg>'

template="#request.ecm.AppPath#ecmDHTML_DropNextGenMenu.cfm">
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Customizing the Menu’s Appearance
You can customize a menu’s appearance, such as the font style, color, and size. So, you have

the flexibility to coordinate a menu with the design your Web site.

To customize a menu in Ektron CMS400.NET, you can change the ek_Menu.js file.

ek_Menu.js
You can change the look and feel of a menu by changing the ek_menu.js file. If you used the

default settings when installing Ektron CMS400.NET, this file is in

webroot/CMS400Developer/Workarea/java/. For a description of the ek_menu.js file, see "ek_

Menu.js" on page 21-319.

XML Menu Function
The ecmGetMenuXML function wraps XML around the properties of a menu created in the

Ektron CMS400.NET Workarea. Once created you can use the XML to display the menu. The

ecmGetMenuXML function allows you to easily define how the menu data appears on the

Web page.

<CFMODULE id=”” template=”#request.ecm.AppPath#ecmGetMenuXML.cfm”>

This function is basically the same as the XML Menu function in ASP. See "XML Menu" on

page 21-321 for details.

The only difference between the Coldfusion function and the ASP one is the syntax for

implementing it. The Coldfusion example is below.

<CFMODULE id="1" template="#request.ecm.AppPath#ecmGetMenuXML.cfm">

Language Select Function
This function lets a visitor to your Web site select a language in which to view the site. Here

is what the function looks like when published on a Web page.
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Shown here is the format of the ecmLanguageSelect function.

<CFMODULE template="#request.ecm.AppPath#ecmLanguageSelect.cfm">

This function is basically the same as the Show Site Language function in ASP. See "Show Site

Language Function" on page 21-316 for details.

The only difference between the Coldfusion function and the ASP one is the syntax for

implementing it.
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Custom PHP Functions

Ektron CMS400.NET maintains and displays content via custom Ektron PHP functions and

ComObjects. For the custom PHP functions to work properly, do the following:

n Make sure the php_soap.dll file is in the c:\php folder on the server where you installed

PHP.

n Add the following line to the php.ini file.

extension=php_soap.dll

The php.ini file is located in C:\Windows\php.ini.

n In the ApplicationAPI.php file, set the WSDLpath. The applicationAPI.php file is located

by default in:

http:/-

/localhost/siteroot/WorkArea/platforms/PHP/applicationAPI.php

Warning! ContentWS.asmx is the web services (WSDL) file that the customPHP functionsuse to talk to Ektron

CMS400.NET. TheWSDLpath located in the applicationAPI.php file must be set to location of theWSDL file.

The default WSDLpath ishttp://localhost/siteroot/WorkArea/WebServices/ContentWS.asmx. If you

have changed the location of ContentWS.asmx you need to update theWSDLpath. For example, if your site is

www.example.com, theWSDLpath would be http://ww-
w.example.com/WorkArea/WebServices/ContentWS.asmx.

n Add the following line to the top of each template.

<?php include 'applicationAPI.php'; ?>

This file calls the Ektron custom functions file to allow the page to function properly. It must

appear at the top of the template file.

n If you have upgraded your Ektron CMS400.NET from an Ektron CMS300 version, add the

following line between the head tags for each template.

Warning! This only needs to be done if you are upgrading fromCMS300 to CMS400.NET

<meta http-equiv="Content-type" content="text/html; charset=utf-8"
/>

To customize you Ektron CMS400.NET application, you need to be familiar with these

functions.

Function Description
More

Information

Calendar Functions

Event Calendar Displaysamonth view event calendar

Event

Calendar

Function
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Function Description
More

Information

Collection Functions

Collection Displays links generated by collections

"Collection

Function" on

page 21-355

CollectionXML

CreatesXML for a collection bywrapping tagsaround all

of the collection itemsand their properties. This allows

you to use an XSLT to define how the XML collection is

displayed.

"XML

Collection

Function" on

page 21-358

RandomContent Randomly displays the content of a collection item

"Random

Content

Function" on

page 21-359

Random

Summary
Randomly displays the summaryof a collection item

"Random

Summary

Function" on

page 21-359

RSSCollection Createsan RSS feed out of the items in a collection.

"RSS

Collection

Function" on

page 21-358

Content Functions

Add Content
Allows a user to add content to Ektron

CMS400.NET progammatically.

"Add

Content" on

page 21-

350

Content Block Displaysandmanagesa content block

"Content

Block

Function" on

page 21-349

Form Displaysa content blockassociated with a form

"Form

Function" on

page 21-359

Multipurpose Displayseither a content blockor a form

"MultiPurpose

Function" on

page 21-361

List Summary Functions
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Function Description
More

Information

Archive

ListSummary
Displays summaries of archived content blocks

"Archive List

Summary

Function" on

page 21-334

List Summary Displaysa list of content block summaries

"List

Summary

Function" on

page 21-353

List Summary

XML

CreatesXML for a list summarybywrapping tagsaround

all of the collection itemsand their properties. This allows

you to use an XSLT to define how the XML collection is

displayed.

"XML List

Summary

Function" on

page 21-354

RSSList

Summary
Createsan RSS feed out of the items in a list summary.

"RSSList

Summary

Function" on

page 21-355

Single Summary Displays the summary for a content block

"Single

Summary

Function" on

page 21-354

Login Functions

Login Adds the login or logout button

"Login

Function" on

page 21-348

Menu Functions

DropHTMLMenu Used to display a DHTMLmenu

"DHTML

Menus" on

page 21-364

GenerateMenu Workswith DropHTMLmenu to displayDHTMLmenus

"DHTML

Menus" on

page 21-364

XMLMenu
Creates XML for a menu by wrapping tags

around all of the menu items properties.

"XMLMenu

Function" on

page 21-365
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Function Description
More

Information

Metadata Displays themetadata for the currentWeb page

"Metadata

Function" on

page 21-362

Search Functions

Search Inserts a text boxwith a search button

"Search

Function" on

page 21-351

Search Display Createsan area to display search results

"Search

Display

Function" on

page 21-352

Language Functions

Language Select Lets a site visitor select a language in which to view site.

"Language

Select

Function" on

page 21-366

Login Function
This function is responsible for displaying the following buttons on the Web page.

Button Name Description

Login

When user is not logged into Ektron CMS400.NET,

this button appears. Click this button to let the user

log in to the application.

Logout

Once logged in, this button replaces the login button

to allow the user to log out from the Ektron

CMS400.NETWeb site.

Workarea
When logged in, this button appears under the logout

button allowing the user to access their workarea.
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Button Name Description

Preview

On

Lets the user to preview the entire Web site as if all

checked-in content was published.

Preview

Off
Turns off preview mode.

This function is basically the same as the Login function in ASP. See "Login Function" on

page 21-249 for details. The only difference is the syntax used to implement the function. This

is listed below.

Login Function Example
<tr>
<td>
<?php ecmlogin(); ?>
</td>

</tr>

Content Block Function
The ecmContentBlock and ecmContentBlockEX functions are used to display a content block

on an Ektron CMS400.NET Web page.

Shown here is the format for the ecmContentBlock function:

<?php ecmContentBlock (ID) ?>

Here is the format for the ecmContentBlockEX function:

<?php ecmContentBlockEx (ID, “XSLT”, Override) ?>

Note: Asan alternative, you can use themultipurpose function, which can displayeither a content blockor a

content blockassociated with a form. For more information, see "MultiPurpose Function" on page 21-361.

This function is basically the same as the Content Block function in ASP. See "Content Block

Function" on page 21-251 for details.

The only differences between the PHP function and the ASP one are the examples of

implementing it. The PHP examples are below.
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ReferenceManual

Version 8.0 Rev 1.3
21-349



Static Content Block
<tr>
 <td>

 <?php ecmContentBlock(1) ?>
 </td>

</tr>

Dynamic Content Block
<tr>
 <td>

 <?php ecmContentBlock($id) ?>
 </td>

</tr>

XML Content Block
<tr>

 <td>
 <?php ecmContentBlockEx (13, “”, 1) ?>

 </td>
</tr>

Add Content
The add content function allows you to programmatically add a new content block to Ektron

CMS400.NET without the need of logging in.

Here is the format for the add content function:

<? AddContent

(“Username”

“Password”,

“Domain”,

‘content_title”,

“content_comment”,

“ContentHtml”,

“SummaryHTML”,

“ContentLanguage”,

“FolderID”,

“GoLive”,

“EndDate”,

“MetaInfo”); ?>

This function is basically the same as the Add Content function in ASP. See "Add Content" on

page 21-257 for details.
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The only difference between the PHP function and the ASP one is the syntax for implementing

it. The PHP example is below.

Add Content Example
The following is an example of the add content function in a template:.

<tr>

<td>

<? AddContent ("admin", "admin", "", "Content Title", "Comment",

"This is the <b>body</b> of the content.", "This is the <i>summary</i>

for the content.", "1033", "0", "", "", ""); ?>

</td>

</tr>

Search Function
The search function is used to display a text box with a search button on the template. When

seen on the template on the Web page, a user can enter text and click the search button to

search through all the content on the Web site.

Ektron has created two search functions:

n ecmSearch

n ecmSearchNoFormTag

Both functions have the same parameters and perform the same search. The only difference is

ecmSearch automatically inserts form tags, ecmSearchNoFormTag does not.

The following is an example of form tags.

<form name="ecmsearch" method="post" action='search-display.asp'>

</form>

When using ecmSearch, form tags are added automatically. When using ecmSearchNoFormTag

you need to add the tags manually

Here is the format for the search function. You can interchange ecmSearch and

ecmSearchNoFormTag when using this function.

<?php ecmSearch( “StartingFolder”,
Recursive,
"targetpage",
textbox,
MaxCharacters,
"ButtonImgSrc",
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"ButtonText",
"FontFace",
"FontColor",
"FontSize",
Horizontal,
"Spare" );
?>

This function is basically the same as the Search function in ASP. See "Search Functions

(ASP)" on page 21-261 for details.

The only difference between the PHP function and the ASP one is the syntax for implementing

it. The PHP example is below.

Search Function Example
<TR>
 <TD>
 <?php ecmSearch("\\Marketing",1,"search-

 display.php",25,200,"","Search","Verdana","#808080","2",0,""); ?>
 </TD>
</TR>

Search Display Function
The search display custom function created the area where all the search results show after the

search has been executed.

Here is the format of the ecmSearchDisplay function:

<?php ecmSearchDisplay( MaxNumbers,"StyleInfo", ShowDate ); ?>

This function is basically the same as the Search Display function in ASP. See "Search Display

Function" on page 21-270 for details.

The only difference between the PHP function and the ASP one is the syntax for implementing

it. The PHP example is below.

Search Display Function Example
 <tr>

 <td>
 <?php ecmSearchDisplay( 0,"",1); ?>

 </td>
 </tr>
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List Summary Function
The list summary function is used to display the list of content summaries on a Web page.

Here is the format of the list summary function.

<?php ecmListSummary ( "Folder",
Recursive,
ShowSummary,
"StyleInfo",
"OrderBy",
"ShowInfo",
MaxNumber,
"Spare 1",
"Spare2");
?>

This function is basically the same as the List Summary function in ASP. See "List Summary

Function" on page 21-274 for details.

The only difference between the PHP function and the ASP one is the syntax for implementing

it. The PHP example is below.

List Summary Example
<TR>
<TD>
<?PHP ecmListSummary ("\Marketing\News",0,1,"",
"Title,asc","DateModified",0,"",""); ?>
</TD>
</TR>

Archive List Summary Function
The Archive list summary function displays on a Web page a list of content summaries for

archived content blocks. For example, you might have a current news page and an archived

news page. Use the List Summary Function to display current news, and this function to

display older news stories.

On the Content Block schedule screen, the user must set an End Date then choose the Archive

and Display option to have the content blocks appear via this function.

This function has the same parameters as the List Summary Function. See List Summary

Function for details.

(continued in Single Summary Function)
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Single Summary Function
The single summary function is used to display the summary of one content block in the

Ektron CMS400.NET Web site, instead of a list of all the summaries in a content folder. Seen

below is the single summary function:

<?php ecmSingleSummary( “ContentID”,
ShowSummary,
“StyleInfo”,
“ShowInfo”,
“Spare1”);
?>

This function is basically the same as the Single Summary function in ASP. See "Single

Summary Function" on page 21-286 for details.

The only difference between the PHP function and the ASP one is the syntax for implementing

it. The PHP example is below.

Single Summary Example
<TR>
 <TD>

 <?PHP ecmSingleSummary ("14",1,"","DateModified",""); ?>
 </TD>

</TR>

XML List Summary Function
The XML List Summary function wraps XML around the properties of a list of content, created

as a list summary in the Ektron CMS400.NET Workarea. Once created, you can use the XML

to display the list summary information. The ecmListSummaryXML function allows you to

easily define how the list summary data appears on the Web page.

<?php ecmListSummaryXML (“Folder”, Recursive,

“OrderBy”, MaxNumber, “ObjType”, “SummaryType”); ?>

This function is basically the same as the List Summary XML function in ASP. See "XML List

Summary Function" on page 21-280 for details.

The only difference between the PHP function and the ASP one is the syntax for implementing

it. The PHP example is below.

<?php ecmListSummaryXML("\books\\",0,"Title,asc",0,"folder",""); ?>
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RSS List Summary Function
The RSS summary function is used to create an XML list of content summaries for RSS

Syndication. Shown here is the format of the RSS list summary function:

<?php ecmRssSummary (“Folder”, Recursive, “OrderBy”, MaxNumber); ?>

This function is basically the same as the RSS Summary function in ASP. See "RSS Summary

Function" on page 21-289 for details.

The only difference between the PHP function and the ASP one is the syntax for implementing

it. The PHP example is below.

<?php ecmRssSummary("\CMS400Developer\\", 0, "Title,asc", 0); ?>

Collection Function
The collection function is used to display the list of links that were created as a collection in

the Ektron CMS400.NET Workarea. The ecmCollection function is highly customizable,

allowing you to easily define how the collection data will be displayed on the Web page.

Shown here is the format of the ecmCollection function.

<?PHP ecmCollection( “id”,
“displayFunction”;
?>

This function is basically the same as the Collection function in ASP. See "Collection

Function" on page 21-293 for details.

The only difference between the PHP function and the ASP one is the syntax for implementing

it. The PHP example is below.

Collection Examples

Example Using the ecmNavigation Display Function
The following is an example of a collection function being used as a navigation menu in the

Ektron CMS400.NET sample Web site.

<?php ecmCollection(1, "ecmNavigation") ?>
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In this example, the collection with an ID=1 is displayed, and the function “ecmNavigation” is

used to define how the collection data is displayed on the Web page.

Here is how the collection would appear on the Web page.

The format of the collection on the Web page depends on the displayFunction that is used.

Below is the source code for the display function “ecmNavigation”.

Function ecmNavigation($cInfo){
global $html, $info;
$html = "<table border=\"0\" cellspacing=\"0\" cellpadding=\"0\"
width=\"100%\">";
$mycount = $cInfo->count();
for ($iloop=0; $iloop < $mycount; ++$iloop) {
$info = $cInfo->Item($iloop+1);
$html = $html."<tr><td>&nbsp;&nbsp;<a href=\"";
$html = $html.$info->Item("ContentLinks");
$html = $html."\">";
$html = $html.$info->Item("ContentTitle");
$html = $html."</a></td></tr><tr><td>&nbsp;</td></tr>";
}
$html = $html."</table>";
return $html;
}

As you can see, the ecmNavigation function is a simple PHP function that creates a table of the

links that belong to the collection specified.

The ecmNavigation function also displays the title of the content blocks by using the

“info(“ContentTitle”)) building block.
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Example Using the ecmTeaser Display Function
The following is an example of a collection function being used as a navigation menu in the

Ektron CMS400.NET sample Web site.

<?php ecmCollection (2, "MyDisplayFunction"); ?>

In this example, the collection with an ID=2 is displayed, and the function “ecmTeaser” is

used to define how the collection data is displayed on the Web page.

Shown here is how the collection would appear on the Web page.

As stated earlier, the format of the collection on the Web page depends on the displayFunction

that is used.

Shown below is the source code for the display function “ecmTeaser”

Function ecmTeaser($cInfo){
global $html, $info;
$html = "<table border=\"0\" cellspacing=\"0\" cellpadding=\"0\" width=\"100%\">";
$mycount = $cInfo->count();
for ($iloop=0; $iloop < $mycount; ++$iloop) {
$info = $cInfo->Item($iloop+1);
$html = $html."<tr><td><a href=\"";
$html = $html.$info->Item("ContentLinks");
$html = $html."\" >";
$html = $html.$info->Item("ContentTitle");
$html = $html."</a>&nbsp;(";
$html = $html.date("m/d/Y g:i:s A", $info->Item("DateModified"));
$html = $html.")</td></tr><tr><td>";
$html = $html.$info->Item("ContentTeaser");
$html = $html."</td></tr><tr><td>&nbsp;</td></tr>";
}
$html = $html."</table>";
return $html;

}

As you can see, the ecmTeaser function is a simple ASP function that creates a table of the

links that belong to the collection specified.
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The ecmTeaser function also displays the:

n Content Title

n Date Modified

n Content Teaser

Collection Variables
See "Collection Attributes" on page 21-296

DisplayFunction
As explained earlier, the display function is a function that you create that will define how the

collection data will be displayed on the Web page.

By using simple PHP scripting, you can create your own display functions, or use the three

included functions.

XML Collection Function
The XML collection function wraps XML around the parameters of a list of content that’s

created as a collection in the Ektron CMS400.NET Workarea. Once created you can use the

XML to display the collection information. The ecmCollectionXML function allows you to

easily define how the collection data appears on the Web page.

Shown here is the format of the ecmCollection function.

<?php ecmCollectionXML (id, GetHtml); ?>

This function is basically the same as the XML Collection function in ASP. See "XML

Collection Function" on page 21-300 for details.

The only difference between the PHP function and the ASP one is the syntax for implementing

it. The PHP example is below.

<?php ecmCollectionXML (3,0); ?>

RSS Collection Function
The RSS collection function is used to create an XML list of links that were created as a

collection in the Ektron CMS400.NET Workarea and display them in RSS Syndication.
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Shown here is the PHP format of the ecmRssCollection function.

<?php ecmRssCollection (id); ?>

This function is basically the same as the RSS Collection function in ASP. See "RSS

Collection Function" on page 21-298 for details.

The only difference between the PHP function and the ASP one is the syntax for implementing

it.

Random Content Function
The random content function is used to randomly display the content of a content block that

belongs in a specified collection.

Displayed here is the format for the random content function

<?php ShowRandomContent (id); ?>

This function is basically the same as the Random Content function in ASP. See "Random

Content" on page 21-304 for details.

Random Summary Function
SImilar to the random content function, the random summary function is used to randomly

display the summary of a content block that belongs in a specified collection.

Displayed here is the format for the random content function

<?php ShowRandomSummary (id, XsltID); ?>

This function is basically the same as the Random Summary function in ASP. See "Random

Summary" on page 21-305 for details.

(continued in Event Calendar Function)

Form Function
The ecmFormBlock and ecmFormBlockNoFormTag functions display an HTML form content

block. Both functions have the same parameters and display the form the same way. The only
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The following is an example of form tags.

<form name="myform" action="#" onsubmit="return EkFmValidate(this);" method="post">

</form>

When using ecmFormBlock, form tags are added automatically. When using

ecmFormBlockNoFormTag, form tags need to be added manually.

For more information about HTML forms, see ”Working with HTML Forms” on page 521.

Warning! If you create a template for an existing form content block, youmust manually change its quicklink to

point to the new template. This change doesnot occur automatically. This procedure is described in ”Updating

Default Template for Multiple Quicklinks” on page 1226.

Here is the format for the form custom function

<?php ecmFormBlock(id); ?>

<?php ecmFormBlockNoForTag(id); ?>

This function is basically the same as the Form function in ASP. See "Form Function" on page

21-307 for details.

The only difference between the PHP function and the ASP one is the syntax for implementing

it. The PHP example is below.

<tr>
 <td>

 <?php ecmFormBlock(1); ?>
 </td>

</tr>

Note: Asan alternative, you can use themultipurpose function, which can displayeither a content blockor a

content blockassociated with a form. For more information, see "MultiPurpose Function" on page 21-310.

MultiPurpose Function
The ecmMultiPurpose function displays either a content block or a content block associated

with a form. As a result, you can use one template to display both types of content block.

Here is the format for the Multipurpose function

<?php ecmMultiPurpose(ID); ?>

To pass in a standard content block, pass the id value in the url parameter, as illustrated below.

http://localhost/CMS400Developer/index.asp?id=2
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To pass in a Form content block, pass the ekfrm value in the url parameter, as illustrated below.

http://localhost/CMS400Developer/index.asp?ekfrm=2

Note: For more information about passing the id value asa URL parameter, see "DynamicContent Block" on

page 21-254.

If the id value or ekfrm value does not exist, a blank template appears.

If the url parameter is not passed in or recognized, the function calls ecmContentBlock and

passes the DefaultID value as the id argument. If the DefaultID value is zero (0),

ecmContentBlock is not called.

Metadata Function
The metadata function is used to display the metadata for one or more content blocks in the

Ektron CMS400.NET Web site. Inserting this custom function allows you to generate the list

of metadata that is edited by the authors, and insert it in the source of the Web page. Shown

below is an example of what the metadata custom function looks like.:

<?php ecmMetaData ("ItemList","Spare1";) ?>

This function is basically the same as the Metadata function in ASP. See "Metadata Function"

on page 21-311 for details.

The only difference between the PHP function and the ASP one is the syntax for implementing

it. The PHP examples are below.

To include both content blocks’ metadata in the web page, an ecmMetadata call would look

like this.

<html>
<head>
<?php ecmMetadata (“[1][2;Title,Content-Type]”, “”); ?>
(rest of head)
</head>
<body>
(rest of web page document)
</body>

</html>

In the above example the ecmMetadata call is contained in the <head> of the HTML document

(since all HTML metadata is required to exist there). Once the Web page is viewed the Web

page source will contain the following information:

<html>
<head>
<Title>Welcome to Our Home Page</Title>
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<meta name=”Keywords” content= Home; page; company; Welcome; Announce;
product; widget”>
<meta http-equiv=”Content-Type” content=”text/html; charset=iso-8859-1”>
(rest of head)
</head>
<body>
(rest of web page document)
</body>

</html>

<?PHP ecmMetaData ("[1][2]","") ?>

<?PHP ecmMetaData ("[1;title][2;keywords]","") ?>

<?PHP ecmMetaData ("[1][2;title,keywords]","") ?>
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DHTML Menus
Ektron CMS400.NET’s Menu feature lets users create and maintain a dropdown menu system

for your Web site. The Menu feature lets you display menu options that link to content blocks,

library assets, external hyperlinks and submenus.

To learn more about menus, see ”Working with Menus” on page 1392.

Additional Documentation in Ektron Knowledge Base
This chapter explains how to implement standard menus that ship with Ektron CMS400.NET.

Ektron’s Web site also provides Knowledge Base articles that explain how to extend the

standard menu features.

Displaying a Menu on a Web Page

GenerateMenu and DropMenu

Warning! Themenu functionsdescribed below are only one example of how to implement menus. You can imple-

ment your ownmenu system using JavaScript.

Use the GenerateNextGenMenu and DropNextGenMenu custom functions to display a DHTML

menu on a Web page. Place GenerateNextGenMenu once on the page to provide an infrastructure

for DropNextGenMenu. Then, place DropNextGenMenu as needed to implement individual menus.
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Follow these steps to display a menu on a Web template.

1. Place the following code directly after the page’s <body> tag.
<?php ecmDHTML_GenerateNextGenMenu("menu id number"); ?>

For example:

<?php ecmDHTML_GenerateNextGenMenu("1"); ?>

To display more than one menu, separate each id number with a comma. For example:

<?php ecmDHTML_GenerateNextGenMenu("1,2,3"); ?>

2. If the user clicks text to display the menu, place the following code within the template

file where the text would appear.

 <?php ecmDHTML_DropNextGenMenu menu ID number,"text user clicks to display

menu"; ?>"

For example:

<?php ecmDHTML_DropNextGenMenu 1,"MyMenu1"; ?>

If the user clicks a graphic to invoke the menu, use this syntax:

 <?php ecmDHTML_DropNextGenMenu menu ID number, '<img src=graphic file

name>'; ?>

For example:

<?php ecmDHTML_DropNextGenMenu 1,'<img src=mymenugraphic.jpg>'; ?>

Customizing the Menu’s Appearance
You can customize a menu’s appearance, such as the font style, color, and size. So, you have

the flexibility to coordinate a menu with the design your Web site.

To customize a menu in Ektron CMS400.NET, you can change the ek_Menu.js file.

ek_Menu.js
You can change the look and feel of a menu by changing the ek_menu.js file. If you used the

default settings when installing Ektron CMS400.NET, this file is in

webroot/siteroot/Workarea/java/. For a description of the ek_menu.js file, see "ek_Menu.js" on

page 21-319.

XML Menu Function
The ecmGetMenuXML function wraps XML around the properties of a menu created in the

Ektron CMS400.NET Workarea. Once created you can use the XML to display the menu. The

ecmGetMenuXML function allows you to easily define how the menu data appears on the

Web page.

<?php ecmGetMenuXML($Id); ?>
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This function is basically the same as the XML Menu function in ASP. See "XML Menu" on

page 21-321 for details.

The only difference between the PHP function and the ASP one is the syntax for implementing

it. The PHP example is below.

<?php ecmGetMenuXML(1); ?>

Language Select Function
This function lets a visitor to your Web site select a language in which to view the site. Here

is what the function looks like when published on a Web page.

Shown here is the format of the ecmLanguageSelect function.

<?php ecmLanguageSelect(); ?>

This function is basically the same as the Show Site Language function in ASP. See "Show Site

Language Function" on page 21-316 for details.

The only difference between the PHP function and the ASP one is the syntax for implementing

it.
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Custom API

As you have seen, the formatting for the custom functions used in Ektron CMS400.NET for

PHP are defined in the file ApplicationAPI.php. As a developer, you may make changes to this

file to further enhance how the custom functions appear on your Web site.

However, Ektron recommends creating a copy of the file, and renaming it to an arbitrary name,

for example, MyCustomAPI.php, and including that file when creating Ektron CMS400.NET

templates. This ensures that your custom API will not be overwritten if you upgrade to another

version of Ektron CMS400.NET.
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Custom JSP Functions

Ektron CMS400.NET maintains and displays content via custom Ektron JSP functions. For the

custom JSP functions to work properly, do the following:

n In the applicationapi.jsp file, set the WSSoap_address. The applicationapi.jsp file is located

by default in:

http:/-

/localhost/siteroot/WorkArea/platforms/JSP/applicationapi.jsp

Warning! ContentWS.asmx is the web services file that the custom JSP functionsuse to talk to Ektron

CMS400.NET. TheWSSoap_address located in the applicationapi.jsp file must be set to location of theWeb

services file. The default WSSoap_address ishttp://localhost/siteroot/Wor-

kArea/WebServices/ContentWS.asmx. If you have changed the location of ContentWS.asmx you need to

update theWSSoap_address. For example, if your site iswww.example.com, theWSSoap_addresswould be
http://www.example.com/WorkArea/WebServices/ContentWS.asmx.

n Add the following line to the top of each template.

<%@ include file=”applicationapi.jsp” %>

This file calls the Ektron custom functions file to allow the page to function properly. It must

appear at the top of the template file.

n Make sure the contentws.jar file is included in your JSP environment

n Ektron recommends running Axis when using a JSP environment. We have tested on

TomCat and JRUN with Axis v1.2.1. You can download Axis from

http://ws.apache.org/axis/java/.

To customize you Ektron CMS400.NET application, you need to be familiar with these

functions.

Function Description
More

Information

Calendar Functions

Calendar
Displays a calendar with different display types.

For example, a daily view calendar.

Calendar

Function

Event Calendar Displaysamonth view event calendar

Event

Calendar

Function

Collection Functions

Collection Displays links generated by collections

"Collection

Function" on

page 21-371
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Function Description
More

Information

CollectionXML

CreatesXML for a collection bywrapping tagsaround all

of the collection itemsand their properties. This allows you

to use an XSLT to define how the XML collection is

displayed.

"XML

Collection

Function" on

page 21-372

RandomContent Randomly displays the content of a collection item

"Random

Content

Function" on

page 21-372

Random

Summary
Randomly displays the summaryof a collection item

"Random

Summary

Function" on

page 21-373

RSSCollection Createsan RSS feed out of the items in a collection.

"RSS

Collection

Function" on

page 21-373

Content Functions

Add Content
Allows a user to add content to Ektron

CMS400.NET progammatically.

"Add

Content" on

page 21-373

Content Block Displaysandmanagesa content block

"Content

Block

Function" on

page 21-374

Form Displaysa content blockassociated with a form

"Form

Function" on

page 21-375

Language Functions

Language Select Lets a site visitor select a language in which to view site.

"Language

Select

Function" on

page 21-376

Login Functions

Login Adds the login or logout button
"Login

Function" on
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Function Description
More

Information

page 21-377

Menu Functions

DropHTMLMenu Used to display a DHTMLmenu

"DHTML

Menus" on

page 21-378

GenerateMenu Workswith DropHTMLMenu to displayDHTMLmenus.

"DHTML

Menus" on

page 21-378

XMLMenu
Creates XML for a menu by wrapping tags

around all of the menu items properties.

"XMLMenu

Function" on

page 21-379

Metadata Functions

Metadata Displays themetadata for the currentWeb page.

"Metadata

Function" on

page 21-379

Search Functions

Search Inserts a text boxwith a search button.

"Search

Function" on

page 21-382

Search Display Createsan area to display search results.

"Search

Display

Function" on

page 21-383

Summary Functions

List Summary Displaysa list of content block summaries.

"List

Summary

Function" on

page 21-383

List Summary

XML

CreatesXML for a list summarybywrapping tagsaround

all of the collection itemsand their properties. This allows

you to use an XSLT to define how the XML collection is

displayed.

"XML List

Summary

Function" on

page 21-384
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Function Description
More

Information

RSSList

Summary
Createsan RSS feed out of the items in a list summary.

"RSSList

Summary

Function" on

page 21-384

Single Summary Displays the summary for a content block.

"Single

Summary

Function" on

page 21-384

(continued in Calendar Function)

Collection Function
The collection function is used to display the list of links that were created as a collection in

the Ektron CMS400.NET Workarea. The ecmCollection function is highly customizable,

allowing you to easily define how the collection data will be displayed on the Web page.

Shown here is the format of the ecmCollection function.

<%= ecmCollection(int id, String “displayFunction”) %>

This function is basically the same as the Collection function in ASP. See "Collection

Function" on page 21-371 for details.

The only difference between the JSP function and the ASP one is the syntax for implementing

it.

Collection Sample
Here is an example of the Collection function in an Ektron CMS400.NET template.

<tr>

<td>

<%= ecmCollection(24, “ecmTeaser”) %>

</td>

</tr>

Collection Function
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XML Collection Function
The XML collection function wraps XML around the parameters of a list of content that’s

created as a collection in the Ektron CMS400.NET Workarea. Once created you can use the

XML to display the collection information. The ecmCollectionXML function allows you to

easily define how the collection data appears on the Web page. Shown here is the format of the

ecmCollection function.

<%= ecmCollectionXML (int id, boolean GetHtml) %>

This function is basically the same as the XML Collection function in ASP. See "XML

Collection Function" on page 21-300 for details.

The only difference between the JSP function and the ASP one is the syntax for implementing

it. The JSP example is below.

<tr>

<td>

<%= ecmCollectionXML(24, True) %>

</td>

</tr>

Random Content Function
The random content function is used to randomly display the content of a content block that

belongs in a specified collection.

Displayed here is the format for the random content function

<%= ecmShowRandomContent (int collectionID, int xsltId) %>

This function is basically the same as the Random Content function in ASP. See "Random

Content" on page 21-304 for details.
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Random Summary Function
SImilar to the random content function, the random summary function is used to randomly

display the summary of a content block that belongs in a specified collection.

Displayed here is the format for the random content function

<%= ShowRandomSummary (int collectionID) %>

This function is basically the same as the Random Summary function in ASP. See "Random

Summary" on page 21-305 for details.

RSS Collection Function
The RSS collection function is used to create an XML list of links that were created as a

collection in the Ektron CMS400.NET Workarea and display them in RSS Syndication.

Shown here is the JSP format of the ecmRssCollection function.

<%= ecmRssCollection (int id) %>

This function is basically the same as the RSS Collection function in ASP. See "RSS

Collection Function" on page 21-298 for details.

Add Content
The add content function allows you to programmatically add a new content block to Ektron

CMS400.NET without the need of logging in.

Here is the format for the add content function:

<%= ecmAddContent (String UserName, String Password, String Domain, String content_title,

String content_comment, String ContentHtml, String SummaryHTML, String ContentLanguage,

String FolderID, String GoLive, String EndDate, String MetaInfo) %>

This function is basically the same as the Add Content function in ASP. See "Add Content" on

page 21-257 for details.

The only difference between the JSP function and the ASP one is the syntax for implementing

it. The JSP example is below.
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Add Content Example
The following is an example of the add content function in a template:.

<tr>
<td>
<%= ecmAddContent ("admin", "admin", "", "Content Title", "Comment", "This is

the <b>body</b> of the content.", "This is the <i>summary</i> for the

content.", "1033", "0", "", "", "") %>
</td>

</tr>

Content Block Function
The ecmContentBlock and ecmContentBlockEX functions are used to display a content block

on an Ektron CMS400.NET Web page.

Shown here is the format for the ecmContentBlock function:

<%= ecmContentBlock (int id) %>

Here is the format for the ecmContentBlockEX function:

<%= ecmContentBlockEX (int id, String xslt, int OverrideId) %>

These function is basically the same as the Content Block functions in ASP. See "Content

Block Function" on page 21-251 for details.

The only difference between the JSP function and the ASP one is the examples of

implementing it. The JSP examples are below.

Static Content Block
<tr>
 <td>

 <%= ecmContentBlock(1) %>
 </td>

</tr>

Dynamic Content Block
<tr>
 <td>

 <%= ecmContentBlock($id) %>
 </td>

</tr>
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XML Content Block
<tr>

 <td>
 <%= ecmContentBlockEx (13, “”, 1) %>

 </td>

</tr>

Form Function
The ecmFormBlock function displays an HTML form content block. This function has a

parameter that lets you decide whether to have form tags added automatically or manually. The

following is an example of form tags.

<form name="myform" action="#" onsubmit="return EkFmValidate(this);" method="post">

</form>

For more information about HTML forms, see ”Working with HTML Forms” on page 521.

Warning! If you create a template for an existing form content block, youmust manually change its quicklink to

point to the new template. This change doesnot occur automatically. This procedure is described in ”Updating

Default Template for Multiple Quicklinks” on page 1226.

Here is the format for the ecmFormBlock function:

<%= ecmFormBlock (int id, boolean formTagReqd) %>

The ecmFormBlock function attributes are explained below.

Attribute Description

id

The “id” argument represents the form’s ID number, visible when viewing the

form from the View Form screen.

Form Function

ReferenceManual

Version 8.0 Rev 1.3
21-375

#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#


Attribute Description

formTagReqd

Allows form tags to be added automatically.

This is an example of form tags.

<form name="myform" action="#" onsubmit="return

EkFmValidate(this);" method="post">

</form>

true =Add form tagsautomatically

false =Add form tagsmanually

This function is basically the same as the Form function in ASP. See "Form Function" on page

21-307 for details.

The only differences between the JSP function and the ASP one are the formTagReqd

parameter and the syntax for implementing it. The JSP example is below.

<tr>
 <td>

 <%= ecmFormBlock(1, true) %>
 </td>

</tr>

Language Select Function
This function lets a visitor to your Web site select a language in which to view the site. Here

is what the function looks like when published on a Web page.

Shown here is the format of the ecmLanguageSelect function.

<%= ecmLanguageSelect() %>
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This function is basically the same as the Show Site Language function in ASP. See "Show

Site Language Function" on page 21-316 for details.

The only difference between the JSP function and the ASP one is the syntax for implementing

it.

Login Function
This function is responsible for displaying the following buttons on the Web page.

Button Name Description

Login

When user is not logged into Ektron CMS400.NET,

this button appears. Click this button to let the user

log in to the application.

Logout

Once logged in, this button replaces the login button

to allow the user to log out from the Ektron

CMS400.NETWeb site.

Workarea
When logged in, this button appears under the logout

button allowing the user to access their workarea.

Preview

On

Lets the user to preview the entire Web site as if all

checked-in content was published.

Preview

Off
Turns off preview mode.

Shown here is the format of the ecmLogin function.

<%= ecmlogin() %>

This function is basically the same as the Login function in ASP. See "Login Function" on

page 21-249 for details. The only difference is the syntax used to implement the function. This

is listed below.

Login Function Example
<tr>

Login Function
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<td>
<%= ecmlogin() %>
</td>
</tr>

DHTML Menus
Ektron CMS400.NET’s Menu feature lets users create and maintain a dropdown menu system

for your Web site. The Menu feature lets you display menu options that link to content blocks,

library assets, external hyperlinks and submenus.

To learn more about menus, see ”Working with Menus” on page 1392.

Additional Documentation in Ektron Knowledge Base
This chapter explains how to implement standard menus that ship with Ektron CMS400.NET.

Ektron’s Web site also provides Knowledge Base articles that explain how to extend the

standard menu features.

Displaying a Menu on a Web Page

GenerateMenu and DropMenu

Warning! Themenu functionsdescribed below are only one example of how to implement menus. You can imple-

ment your ownmenu system using JavaScript.

Use the GenerateNextGenMenu and DropNextGenMenu custom functions to display a DHTML

menu on a Web page. Place GenerateNextGenMenu once on the page to provide an infrastructure

for DropNextGenMenu. Then, place DropNextGenMenu as needed to implement individual menus.

Follow these steps to display a menu on a Web template.

1. Place the following code directly after the page’s <body> tag.
<%= ecmDHTML_GenerateNextGenMenu("menu id number") %=>

For example:

<%= ecmDHTML_GenerateNextGenMenu("1") %>

To display more than one menu, separate each id number with a comma. For example:

<%= ecmDHTML_GenerateNextGenMenu("1,2,3") %>

2. If the user clicks text to display the menu, place the following code within the template

file where the text would appear.

 <%= ecmDHTML_DropNextGenMenu menu ID number,"text user clicks to display

menu" %>"

For example:

<%= ecmDHTML_DropNextGenMenu 1,"MyMenu1" %>
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If the user clicks a graphic to invoke the menu, use this syntax:

 <%= ecmDHTML_DropNextGenMenu menu ID number, '<img src=graphic file name>'

%>

For example:

<%= ecmDHTML_DropNextGenMenu 1,'<img src=mymenugraphic.jpg>' %>

Customizing the Menu’s Appearance
You can customize a menu’s appearance, such as the font style, color, and size. So, you have

the flexibility to coordinate a menu with the design your Web site.

To customize a menu in Ektron CMS400.NET, you can change the ek_Menu.js file.

ek_Menu.js
You can change the look and feel of a menu by changing the ek_menu.js file. If you used the

default settings when installing Ektron CMS400.NET, this file is in

webroot/siteroot/Workarea/java/. For a description of the ek_menu.js file, see "ek_Menu.js"

on page 21-319.

XML Menu Function
The ecmGetMenuXML function wraps XML around the properties of a menu created in the

Ektron CMS400.NET Workarea. Once created you can use the XML to display the menu. The

ecmGetMenuXML function allows you to easily define how the menu data appears on the

Web page.

<%= ecmGetMenuXML(int id) %>

This function is basically the same as the XML Menu function in ASP. See "XML Menu" on

page 21-321 for details.

The only difference between the JSP function and the ASP one is the syntax for implementing

it. The JSP example is below.

<%= ecmGetMenuXML(1) %>

Metadata Function
The metadata function is used to display the metadata for one or more content blocks in the

Ektron CMS400.NET Web site. Inserting this custom function allows you to generate the list

XMLMenu Function
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of metadata that is edited by the authors, and insert it in the source of the Web page. Shown

below is an example of what the metadata custom function looks like:

<%= ecmMetadata(String itemlist, java.lang.object spare1) %>

This function is basically the same as the Metadata function in ASP. See "Metadata Function"

on page 21-311 for details.

The only difference between the JSP function and the ASP one is the syntax for implementing

it. The JSP examples are below.

To include both content blocks’ metadata in the web page, an ecmMetadata call would look

like this.

<html>
<head>
<%= ecmMetadata (“[1][2;Title,Content-Type]”, “”) %>
(rest of head)
</head>
<body>
(rest of web page document)
</body>

</html>

In the above example the ecmMetadata call is contained in the <head> of the HTML document

(since all HTML metadata is required to exist there). Once the Web page is viewed the Web

page source will contain the following information:

<html>
<head>
<Title>Welcome to Our Home Page</Title>
<meta name=”Keywords” content= Home; page; company; Welcome; Announce;
product; widget”>
<meta http-equiv=”Content-Type” content=”text/html; charset=iso-8859-1”>
(rest of head)
</head>
<body>
(rest of web page document)
</body>

</html>

<%= ecmMetaData ("[1][2]","") %>
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<%= ecmMetaData ("[1;title][2;keywords]","") %>

<%= ecmMetaData ("[1][2;title,keywords]","") %>
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Search Function
The search function is used to display a text box with a search button on the template. When

seen on the template on the Web page, a user can enter text and click the search button to

search through all the content on the Web site.

Ektron has created two search functions:

n ecmSearch

n ecmSearchNoFormTag

Both functions have the same parameters and perform the same search. The only difference is

ecmSearch automatically inserts form tags, ecmSearchNoFormTag does not.

The following is an example of form tags.

<form name="ecmsearch" method="post" action='search-display.asp'>

</form>

When using ecmSearch, form tags are added automatically. When using ecmSearchNoFormTag

you need to add the tags manually

Here is the format for the search function. You can interchange ecmSearch and

ecmSearchNoFormTag when using this function.

<%= ecmSearch(java.lang.String startingFolder, boolean recursive, java.lang.String target, int

textBoxSize, int maxCharacters, java.lang.String buttonImageScr, java.lang.String buttonText,

java.lang.String fontFace, java.lang.String fontColor, java.lang.String fontSize, boolean horizontal,

java.lang.Object spare1) %>

This function is basically the same as the Search function in ASP. See "Search Functions

(ASP)" on page 21-261 for details.

The only difference between the JSP function and the ASP one is the syntax for implementing

it. The JSP example is below.

Search Function Example
<TR>
 <TD>
 <%= ecmSearch("\\",true,"search-

display.jsp",25,200,"","Search","Verdana","#808080","2",false,"") %>
 </TD>
</TR>
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Search Display Function
The search display custom function creates the area where all the search results are shown after

the search has been executed.

Here is the format of the ecmSearchDisplay function:

<%= ecmSearchDisplay(int maxNumber, String styleInfo, boolean ShowDate,

boolean showSummary) %>

This function is basically the same as the Search Display function in ASP. See "Search Display

Function" on page 21-270 for details.

The only difference between the JSP function and the ASP one is the syntax for implementing

it. The JSP example is below.

Search Display Function Example
 <tr>

 <td>
 <%= ecmSearchDisplay(0,"",true,true) %>

 </td>

 </tr>

List Summary Function
The list summary function is used to display a list of content summaries on a Web page. Here

is the format of the list summary function.

<%= ecmListSummary (String folder, boolean recursive, boolean showSummary, String

styleInfo, String OrderBy, String showInfo, int maxNumber, String objType, String

optionList, String summaryType) %>

This function is basically the same as the List Summary function in ASP. See "List Summary

Function" on page 21-274 for details.

The only difference between the JSP function and the ASP one is the syntax for implementing

it. The JSP example is below.

List Summary Example
<TR>
<TD>
<%= ecmListSummary ("\Marketing\News",false,true,"",
"Title,asc","DateModified",0,"","","") %>
</TD>
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</TR>

XML List Summary Function
The XML List Summary function wraps XML around the properties of a list of content, created

as a list summary in the Ektron CMS400.NET Workarea. Once created, you can use the XML

to display the list summary information. The ecmListSummaryXML function allows you to

easily define how the list summary data appears on the Web page.

<%= ecmListSummaryXML (String Folder, int Recursive, String OrderBy, int MaxNumber,

String ObjType, String SummaryType) %>

This function is basically the same as the List Summary XML function in ASP. See "XML List

Summary Function" on page 21-280 for details.

The only difference between the JSP function and the ASP one is the syntax for implementing

it. The JSP example is below.

<%= ecmListSummaryXML("\\CMS400Developer\\",0,"Title,asc",0,"folder",""); ?>

RSS List Summary Function
The RSS summary function is used to create an XML list of content summaries for RSS

Syndication. Shown here is the format of the RSS list summary function:

<%= ecmRssSummary (java.lang.String Folder, boolean Recursive, java.lang.String OrderBy, int

MaxNumber) %>

This function is basically the same as the RSS Summary function in ASP. See "RSS Summary

Function" on page 21-289 for details.

The only difference between the JSP function and the ASP one is the syntax for implementing

it. The JSP example is below.

<%= ecmRssSummary("\\CMS400Developer\\", false, "Title,asc", 0) %>

Single Summary Function
The single summary function is used to display the summary of one content block in the

Ektron CMS400.NET Web site, instead of a list of all the summaries in a content folder. Seen

below is the single summary function:

<%= ecmRssSummary (int contentID, boolean showSummary, java.lang.String showInfo,
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java.lang.String styleInfo, java.lang.String spare1) %>

This function is basically the same as the Single Summary function in ASP. See "Single

Summary Function" on page 21-286 for details.

The only difference between the JSP function and the ASP one is the syntax for implementing

it. The JSP example is below.

Single Summary Example
<TR>
 <TD>

 <%= ecmSingleSummary ("14",true,"","","") %>
 </TD>

</TR>
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Creating Your Own Widgets

What’s a Widget?
Widgets are .NET user controls that allow a site visitor to perform a function on a Web page.

They are small portions of code that developers can write once and then be reused multiple

times by content authors across a site.

For example, a widget can provide a simple calculator or a stock ticker. Or, it can display

significant information from Ektron CMS400.NET, such as a content block or a List Summary.

Widgets at AcmeBooks.com
While this definition adds some clarity to what widgets are, the CIO and the Web team still

have a lot of questions about how to use widgets, and how they are created.

So, let’s get started with using and building widgets.

Using Widgets on a PageBuilder
Page
After widgets are integrated into CMS400.NET, users (like the Marketing team) can add them

to a Dashboard in their profile page or a Community Group’s page. They can also drag-and-

drop these building blocks onto a PageBuilder page (as shown below).

Note: Over 30 standard widgets included in Ektron CMS400.NET. See "StandardWidgets" on page 21-404
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Widgets, DropZones, and Pages
The relationship between a wireframe, dropzones, and widgets is shown below.

Widgets, DropZones, and Pages
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The above illustration of a wireframe depicts how:

n A wireframe can have several dropzones

n Each dropzone can have several columns

n Each column can have several widgets

Ektron CMS400.NET stores each page’s data (a serialized XML string) as a type of content

within the Ektron CMS400.NET Workarea. The string is stored like other content types, such

as HTML content and XML Smart Forms. The following illustration shows a widget’s page

data within the Workarea.

Widget States
Widgets placed on a PageBuilder page have three possible combinations of states.
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Page

mode

Widget

mode
State Illustration

View View
Widget content appears

on page

Edit View

Widget can be

dragged/dropped,

moved, deleted

Edit Edit
User defineswidget

information

In a widget’s user control file, you create an asp:MultiView element that determines available

actions when a widget is in View mode and Edit mode. See sample below:

<%@ Control Language="C#" AutoEventWireup="true" CodeFile="HelloWorld.ascx.cs"

Inherits="widgets_HelloWorld" %>
<%@ Register Assembly="System.Web.Extensions, Version=1.0.61025.0, Culture=neutral,

PublicKeyToken=31bf3856ad364e35"
Namespace="System.Web.UI" TagPrefix="asp" %>
<asp:MultiView ID="ViewSet" runat="server" ActiveViewIndex="0">
<asp:View ID="View" runat="server">
<!-- You Need To Do .............................. -->
<asp:Label ID="HelloTextLabel" runat="server"></asp:Label><br />
<asp:Label ID="CheckBoxLabel" runat="server"></asp:Label>
<!-- End To Do .............................. -->
</asp:View>
<asp:View ID="Edit" runat="server">
<div id="<%=ClientID%>_edit">
<!-- You Need To Do .............................. -->
<asp:TextBox ID="HelloTextBox" runat="server" Style="width: 95%"> </asp:TextBox><br />
<asp:CheckBox ID="MyCheckBox" runat="server" Checked="false" /> <br /><br />
<!-- End To Do .............................. -->
<asp:Button ID="CancelButton" runat="server" Text="Cancel" OnClick="CancelButton_Click"

/> &nbsp;&nbsp;
<asp:Button ID="SaveButton" runat="server" Text="Save" OnClick="SaveButton_Click" />
</div>
</asp:View>
</asp:MultiView>
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Creating a Widget
A widget consists of three file types.

n .ascx - contains a widget’s source code

n .ascx.cs or .vb - contains widget’s codebehind

n .ascx.jpg - image that represents a widget in the widget selection tool

Note: Your widget might use additional files, such as .cssor .js files. Ektron recommendsplacing these files in a

folder within

site root/widgets, and giving the folder the same name as the customwidget.

When creating a widget, you save files to the site root/widgets folder. This folder path is

defined in the site root/web.config file, so if Pete needs to change the folder name or path, he

must update the following web.config ek_widgetPath element:

<add key=”ek_widgetPath” value=”Widgets/" /> .

The “Hello World” Widget
To get a basic understanding of how to create a widget, Pete will create a simple widget,

which will reside in the site root/widgets folder. This widget is based on the Hello World
widget that is installed with the Developer Sample site. It uses the following files:

n HelloWorld.ascx - user control file

n HelloWorld.ascx.cs - user control codebehind file

n HelloWorld.ascx.jpg - image that represents this control on the widget menu

Pete will complete these tasks to create a widget.

n "Copy, Paste and Rename HelloWorld.ascx and HelloWorld.ascx.jpg" on page 21-390

n "Update the Class Names in the New Files" on page 21-395

n "Add Widget in Ektron CMS400.NET Workarea " on page 21-395

Copy, Paste and Rename HelloWorld.ascx and
HelloWorld.ascx.jpg
1. Open your Web site in Visual Studio.

2. In the Visual Studio Solution Explorer, open the widgets folder.
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3. Within that folder, scroll down to and select HelloWorld.ascx.
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4. Right click the mouse and select Copy.

5. Scroll up to the widgets folder.

6. Right click the mouse and select Paste.
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7. Scroll down until you see Copy of HelloWorld.ascx.

8. Right click the mouse and select Rename.
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9. Rename the file new_widget.ascx. Notice that Visual Studio also renames the codebehind

file to new_widget.ascx.cs.

Note: The image file is 48 x48 pixels and 72 dpi

10. Copy, paste, then rename the helloworld.ascx.jpg file to new_widget.ascx.jpg. Ektron

CMS400.NET administrators (like Grace) and content authors (like the Marketing team)

use a widget’s image to select it, as shown below.
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Update the Class Names in the New Files
1. Open new_widget.ascx.

2. On the first line of that file, replace the reference to HelloWorld (circled below) with new_

widget.

3. Open the codebehind file, new_widget.ascx.cs.

4. Again, replace the class HelloWorld with new_widget.

5. Save new_widget.ascx and new_widget.ascx.cs.

6. Check both files for errors by clicking Build > Build Page. Correct any errors before

proceeding.

Add Widget in Ektron CMS400.NET Workarea
1. Open the Ektron CMS400.NET Workarea.

2. Open Settings > Configuration > Personalizations > Widgets.

3. Click the Synchronize button ( ).

4. You see the new user control file, new_widget.ascx, at the bottom of the screen.
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5. Open Settings > Configuration > Template Configuration.

6. Find the template that you created in "Building Pages" on page 6-5, PageLayout.aspx. Or,

any Wireframe template that you are using to create a PageBuilder page.
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7. Click Update.

8. On the Update Template screen, scroll down until you see the new widget.

9. Click the Select All button (circled above).

10. Click Save ( ).
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Note: For directionson creating a PageBuilder page, see "Steps to Creating a “PageBuilder” Page" on page 6-7

11. Go to Content and select a folder that has a PageBuilder page.

12. Edit the PageBuilder page.

13. Open the widget menu.

14. Make sure your new widget appears on the menu.

Now that you have created a new widget and enabled it in the Ektron CMS400.NET

Workarea, you can begin to customize it.

The next sections explain details about the files you copied and renamed above.

n "Understanding the User Control (.ascx) File" on page 21-398

n "Understanding the Codebehind (.ascx.cs) File" on page 21-399

n "Creating the Codebehind (.ascx.cs) File"See "Copy, paste, then rename the

helloworld.ascx.jpg file to new_widget.ascx.jpg. Ektron CMS400.NET administrators (like

Grace) and content authors (like the Marketing team) use a widget’s image to select it, as

shown below." on page 21-394"Copy, paste, then rename the helloworld.ascx.jpg file to

new_widget.ascx.jpg. Ektron CMS400.NET administrators (like Grace) and content authors

(like the Marketing team) use a widget’s image to select it, as shown below." on page 21-

394

Understanding the User Control (.ascx) File
Here is the new_widget.ascx file that Pete uses as the basis of his widget.

<%@ Control Language=”C#” AutoEventWireup=”true” CodeFile=”new_widget.ascx.cs”

Inherits=”widgets_new_widget” %>
<%@ Register Assembly="System.Web.Extensions, Version=1.0.61025.0, Culture=neutral,

PublicKeyToken=31bf3856ad364e35"
Namespace="System.Web.UI" TagPrefix="asp" %>

<asp:MultiView ID="ViewSet" runat="server" ActiveViewIndex="0">

<asp:View ID="View" runat="server">
<!-- You Need To Do .............................. -->
<asp:Label ID="TextLabel" runat="server"></asp:Label><br />
<asp:Label ID="CheckBoxLabel" runat="server"></asp:Label>
<!-- End To Do .............................. -->
</asp:View>

<asp:View ID="Edit" runat="server">
<div id="<%=ClientID%>_edit">
<!-- You Need To Do .............................. -->
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<asp:TextBox ID="TextTextBox" runat="server" Style="width: 95%"> </asp:TextBox><br />
<asp:CheckBox ID="MyCheckBox" runat="server" Checked="false" /> <br />
<!-- End You Need To Do .............................. -->
<asp:Button ID="CancelButton" runat="server" Text="Cancel" OnClick="CancelButton_Click"

/>
<asp:Button ID="SaveButton" runat="server" Text="Save" OnClick="SaveButton_Click" />
</div>
</asp:View>
</asp:MultiView>

Pete notices the following elements of the file.

n The asp:MultiView element declares that the control has two possible modes: View

and Edit.

<asp:MultiView ID="ViewSet" runat="server" ActiveViewIndex="0">

- in view mode, Pierre and the marketing team can see the control but not change it.

- in edit mode, Pete’s developers can change the control’s content and properties.

n Between the multiview tags is information about the control in view mode. It has two

fields: one is a text field, and the other is a check box.
<asp:View ID="View" runat="server">
<asp:Label ID="HelloTextLabel" runat="server"></asp:Label><br />
<asp:Label ID="CheckBoxLabel" runat="server"></asp:Label>
</asp:View>

n Also between the multiview tags is information about the control in edit mode. In edit

mode, a text box, a check box, and a Save button appear. The text box and check box

collect end-user input, and the Save button saves that input to the database.
<asp:View ID="Edit" runat="server">
<div id="<%=ClientID%>_edit">
<!-- You Need To Do .............................. -->
<asp:TextBox ID="HelloTextBox" runat="server" Style="width: 95%"> </asp:TextBox><br />
<asp:CheckBox ID="MyCheckBox" runat="server" Checked="false" /> <br />
<!-- End You Need To Do .............................. -->
<asp:Button ID="CancelButton" runat="server" Text="Cancel" OnClick="CancelButton_Click"

/>
<asp:Button ID="SaveButton" runat="server" Text="Save" OnClick="SaveButton_Click" />

Understanding the Codebehind (.ascx.cs) File
Next, Pete reviews the codebehind file, new_widget.ascx.cs.

n He see a series of using statements at the top of the file, noticing the Ektron ones in

particular:
using Ektron.Cms.Widget;
using Ektron.Cms;Marketing team
using Ektron.Cms.API;
using Ektron.Cms.Common;
using Ektron.Cms.PageBuilder;
using System.Text.RegularExpressions;

n Pete then notes a widget host class, which inherits the system.Web.UI.UserControl and

IWidget classes. *****
public partial class widgets_new_widget : System.Web.UI.UserControl, IWidget
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The following image summarizes the remaining elements of the codebehind file.

n In the next line, he sees the widget’s properties: a string for the text field, and a boolean

for the check box. Here you define the variables and their type. Possible types are string,

integer, long and date.
#region properties
private string _HelloString;
private bool _CheckBoxBool;
[WidgetDataMember(true)]
public bool CheckBoxBool { get { return _CheckBoxBool; } set { _CheckBoxBool = value; }

}
[WidgetDataMember("Hello Wolrd")]
public string HelloString { get { return _HelloString; } set { _HelloString = value; } }
#endregion

n He sees a widget host declaration.
private IWidgetHost _host;

n And the widget’s page_init events.
protected void Page_Init(object sender, EventArgs e)
{
_host = Ektron.Cms.Widget.WidgetHost.GetHost(this);
_host.Title = "Hello World Widget";
_host.Edit += new EditDelegate(EditEvent);
_host.Maximize += new MaximizeDelegate(delegate() { Visible = true; });
_host.Minimize += new MinimizeDelegate(delegate() { Visible = false; });
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_host.Create += new CreateDelegate(delegate() { EditEvent(""); });
PreRender += new EventHandler(delegate(object PreRenderSender, EventArgs Evt) {

SetOutput(); });
ViewSet.SetActiveView(View);
}

Comments on the above code

- The gethost method returns a reference to the container widgethost for this widget.

This is the case in both Personalization and PageBuilder.

- The Title property is the title of this widget. By setting it in page_init for the widget,

we inform the host what text to put in the title bar above the widget. This works in

both PageBuilder and Personalization.

- The events below host.Title are raised by the widgethost. It’s up to the widget to

subscribe to them. In all cases, if we don’t subscribe to them, the icons don’t show up.

This is a method of attaching widget code to button clicks and other events that occur

outside the widget.

- For PreRender: Ektron CMS400.NET renders the contents of this widget on pre-render,

thus ensuring a single render event. Another option is to call SetOutput on the Load

event, but you can only do that if the widget is not in edit mode currently.

- The final line sets the view to display mode.

n He notices the declaration of the widget’s edit events.
void EditEvent(string settings)
{
string sitepath = new CommonApi().SitePath;
ScriptManager.RegisterClientScriptInclude(this, this.GetType(), "widgetjavascript",

sitepath + "widgets/widgets.js");
ScriptManager.RegisterOnSubmitStatement(this.Page, this.GetType(), "gadgetescapehtml",

"GadgetEscapeHTML('" + HelloTextBox.ClientID + "');");
HelloTextBox.Text = HelloString;
MyCheckBox.Checked = CheckBoxBool;
ViewSet.SetActiveView(Edit);
}

Comments on the above code:

Warning! Youmust register JavaScript and cascading style sheet (css) instructions in an external file. See "Work-

ing with JavaScript and Cascading Style Sheets" on page 6-39

- The Edit event is triggered by the widgethost, and since Pete subscribed to it already,

it calls the delegate here.

- sitepath is used to ensure that the correct path for included files is used across

installations.

- By calling the scriptmanager to include the script, Pete ensures it works inside update

panels. Alternatively, he can use Ektron.Cms.Api.Js.RegisterJSInclude
ScriptManager.RegisterOnSubmitStatement(this.Page, this.GetType(),

"gadgetescapehtml", "GadgetEscapeHTML('" + HelloTextBox.ClientID + "');");

- The onsubmitstatement is JavaScript that is run when the widget is submitted. It calls

escape html, which cleans the submitted text to avoid any XSS.
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n Pete notices the editing fields, so users can see the existing data.

HelloTextBox.Text = HelloString;

MyCheckBox.Checked = CheckBoxBool;

ViewSet.SetActiveView(Edit);

n He sees the widget’s save events.
protected void SaveButton_Click(object sender, EventArgs e)
{
HelloString = ReplaceEncodeBrackets(HelloTextBox.Text);
CheckBoxBool = MyCheckBox.Checked;
_host.SaveWidgetDataMembers();
ViewSet.SetActiveView(View);
}

n He notes the widget’s SetOutput events.
protected void SetOutput()
{
HelloTextLabel.Text = HelloString; // client javascript remove brackets, server side

adds back
CheckBoxLabel.Text = CheckBoxBool.ToString();
}

n He notes the widget’s Cancel events.
protected void CancelButton_Click(object sender, EventArgs e)
{
ViewSet.SetActiveView(View);
}

n Finally, he reviews the encoding of the greater and less than signs.
protected string ReplaceEncodeBrackets(string encodetext)
{
encodetext = Regex.Replace(encodetext, "&lt;", "<");
encodetext = Regex.Replace(encodetext, "&gt;", ">");
return encodetext;
}

Removing a Widget from the
Workarea
At some point, the AcmeBooks.com Web team will need to remove a widget from use. To do

this, Grace deletes the widget’s files from the site root/widgets folder. Next, she navigates to

Settings > Configuration > Personalizations > Widgets and clicks Synchronize ( ).

The widget is removed from the list of widgets, as well as from the Dashboard of any users and

community groups.
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Final Assessment from the CIO
Now, the CIO of AcmeBooks.com has a clear understanding of how PageBuilder works, and

how widgets are created and placed on pages.

It’s clear to her that Ektron CMS400.NET’s PageBuilder will greatly enhance the company’s

Web presence, and allow the Marketing team to respond to changing market conditions and

quickly launch and communicate promotions on the AcmeBooks.com Web site.

She is also pleased that PageBuilder will satisfy the company’s Web site developers. No longer

will they have to deal with numerous daily requests for content changes from Marketing. And

Grace is happy because administering PageBuilder and widgets within the CMS is a simple,

straight-forward process.

The future looks bright at AcmeBooks.com thanks to Ektron CMS400.NET and PageBuilder.
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Standard Widgets

Ektron CMS400.NET installs several standard widgets to the <webroot>/<siteroot>/Widgets/

folder. Information about them is below.

Widget Description Files

Atom Feed

Lets user enter path to an AtomPublishing Protocol feed. Also

lets user limit the number of feed results.

AtomFeed.ascx

AtomFeed.ascx.cs

atomfeed.ascx.jpg

and

Files in widgets/Calendar

BaseBall ESPN

Displays latest newsabout the baseball team selected byediting

the widget. Provided byESPN.

BaseBallEspnMlb.ascx

BaseBallEspnMlb.ascx.cs

BaseBallEspnMlb.acx.jpg

Bookmarks

Lets user create a list of URLsbyentering each one’sweb

addressand title.

Bookmarks.ascx

Bookmarks.ascx.cs

bookmarks.ascx.jpg

BrightCove Video

PlaysanyBrightCove video

BrightCoveVideo.ascx

BrightCoveVideo.ascx.cs

BrightCoveVideo.ascx.jpg

and

Files in

widgets/BrightCoveVideo

Calculator

Providesa calculator

Calculator.ascx

Calculator.ascx.cs

Calculator.ascx.jpg

and

Files in widgets/Calculator

Calendar Displaysa calendar. A user can add events to anydayand time.

Calendar.ascx

Calendar.ascx.cs
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Widget Description Files

Calendar.ascx.jpg

and

Files in widgets/Calendar

Clock

Providesa clock that displays time in the current time zone.

Clock.ascx

Clock.ascx.cs

clock.ascx.jpg

Collection

Displaysa collection. The user selects a Collection ID. The user

can also define

n the number entries per page

n if paging is enabled

n if teaser information appears

n if iconsare included

Collection.ascx

Collection.ascx.cs

Collection.ascx.jpg

ContentBlock

Lets user enter a content ID and display that content in the

Widget. Alternatively, user can create new HTML content from

the widget.

ContentBlock.ascx

ContentBlock.ascx.cs

contentblock.ascx.jpg

and

Files in

widgets/ContentBlock

Content List

Displaysa list of content blocks. In contrast to a List Summary,

where content must be in a specified folder, the ContentList

control displays content from anyEktron CMS400.NET folder.

The user can also define

n if teaser information appears

n if iconsare included

n the content’s sort criterion (such as title, last modified date)

n Sort direction

ContentList.ascx

ContentList.ascx.cs

ContentList.ascx.jpg

Content Review

Placesa ContentReview server control on the page. This control

allows site visitors to rate and review the current page.

For more information, see .

ContentReview.ascx

ContentReview.ascx.cs

ContentReview.ascx.jpg

and

Files in

widgets/ContentReview
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Widget Description Files

EmbedHTML

Inserts a browser plugin into your page. The <embed> tag also

lets you determine information about the plugin, such as:

n source of plugin to be played

n width

n height

n allow full screen (boolean)

n allow script access (boolean)

Examplesof sites that provide embed code are YouTube.com,

BrightCove, and hulu.com. See example from hulu.com below.

EmbedHTML.ascx

EmbedHTML.ascx.cs

EmbedHTML.ascx.jpg

ESPN

Displays selected ESPN news feed.

To select a feed, clickEdit button (circled below) and click a feed.

espn.ascx

espn.ascx.cs

espn.ascx.jpg

Flash

Displaysa selected flash file which resides in Ektron

CMS400.NET. You can also set the display’s height and width.

See Also:

Flash.ascx

Flash.ascx.cs

Flash.ascx.jpg

and

Files in widgets/Flash

Flickr

DisplayFlickr’sMost Recent or Most Interesting photos. The user

also can select the number of rowsand columns for the image

display.

See Also:

Flickr.ascx

Flickr.ascx.cs

flickr.ascx.jpg

and

Files in widgets/Flickr
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Widget Description Files

GoogleGadget

Gadgets designed for an IGoogle page. Bydefault, Ektron

supplies 5 Google gadgets.

To insert another Google gadget, follow these steps.

1. Drop aGoogle gadget widget.

2. Click the pencil to enter edit mode.

3. Open a new tab.

4. Go to

http://www.google.com/ig/directory?synd=open&hl=en-

US&gl=US&cat=all.

5. Find the gadget you want to insert.

6. ClickAdd to your Web page.

7. ClickGet the code.

8. Copy the code.

9. Return to the PageBuilder page.

10. Paste the code into the bottom of the Google widget you

dropped in Step 1.

11. ClickSave.

GoogleGadget.ascx

GoogleGadget.ascx.cs

GoogleGadget.ascx.jpg

and

Files in

widgets/GoogleGadget

HelloWorld

Very simple widget. Created byEktron to help developers

understand how to create their ownwidgets.

HelloWorld.ascx

HelloWorld.ascx.cs

HelloWorld.ascx.jpg

iFrame

Lets user enter a path to aWeb page or an item on theWeb

page.

IFrame.ascx

IFrame.ascx.cs

iframe.ascx.jpg
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Widget Description Files

List Summary

Displaysan Ektron List Summary, a list of certain typesof content

in a selected folder. Optionally, the display can include

n number of items to display on the page

n if the number of items in a folder exceeds the number to dis-

play, should you display the rest on additional pages?

n if iconsare included

n the content’s sort criterion (such as title, last modified date)

n sort direction

n an override of the Add Content menu item’s default text. For

example, for a newssite, you could change Add Content to Add

News.

n displays in the widget content identified by the current query

string parameter.

A List Summarywidget displays the following typesof content.

n HTML content

n PageBuilder page

n XMLSmart Form

n Blog

Thiswidget doesnot display the following content types.

n Catalog entries (part of the eCommerce feature)

n Forums

n HTML Forms

n Assets

ListSummary.ascx

ListSummary.ascx.cs

ListSummary.ascx.jpg

and

Files in

widgets/ListSummary

MessageBoard

Allowsuser to leave comments on the page.

For a description of the widget’s properties, see .

MessageBoard.ascx

MessageBoard.ascx.cs

MessageBoard.ascx.jpg

and

Files in

widgets/MessageBoard
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Widget Description Files

Metadata List

Displays content whosemetadata fits a selected folder location

and keywords.

You can also set these display options:

n number of items to display on the page

n if the number of items in the folder exceedsnumber to dis-

play, should remaining itemsappear on additional pages?

n Navigation/Teaser: Determinesdisplay of content

- ecmNavigation - lists title of every content

item

- ecmTeaser - lists title and summary

- ecmUnOrderedList - lists title and summary;

unsorted list

n if iconsare included

n the content’s sort criterion (such as title, last modified date)

n sort direction

MetaDataList.ascx

MetaDataList.ascx.cs

MetaDataList.ascx.jpg

and

Files in

widgets/MetaDataList

News

Lets user select a news feed from a group of major news

providers.

Note: A developer can change the list of news feedsbyediting the

siteroot/widgets/news.ascx.cs file.

IFrame.ascx

IFrame.ascx.cs

iframe.ascx.jpg

Recent blog posts

Displaysa selected number of themost recent blog posts.

RecentBlogs.ascx

RecentBlogs.ascx.cs

RecentBlogs.ascx.jpg

Recent documents

Displaysa selected number of themost recently published

documents.

RecentDocuments.ascx

RecentDocuments.ascx.cs

RecentDocuments.jpg
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Widget Description Files

Recent forum posts

Displaysa selected number of themost recent forum posts.

RecentForumPosts.ascx

RecentForumPosts.ascx.cs

RecentForumPosts.ascx.jpg

RSSFeed

Allowsa user to enter the path of a feed that usesReallySimple

Syndication (RSS).

RSSFeed.ascx

RSSFeed.ascx.cs

rssfeed.ascx.jpg

SalesForce Chart

Allowsusers to enter username, password and information

about a SalesForce chart to display that chart.

SalesForceChart.ascx

SalesForceChart.ascx.cs

SalesForceChart.ascx.jpg

and

Files in

widgets/SalesForceChart

StockTicker

Allowsusers to define a list of stock ticker symbols and display the

price for each symbol.

StockTicker.ascx

StockTicker.ascx.cs

StockTicker.ascx.jpg

StockTicker.css

Text Box

Displaysa single field to capture text. The text is stored in the

database.

TextBox.ascx

TextBox.ascx.cs

TextBox.ascx.jpg

Twitter Feed DisplaysRSS feed from Twitter. You can configure one or more

feeds.

Note: Use the RSS feed URL for the accounts you wish to

display.

TwitterFeed.ascx

TwitterFeed.ascx.cs

TwitterFeed.jpg

and

Files in widgets/TwitterFeed
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Widget Description Files

YouTube

Allowsusers to select from a list of YouTube feeds.When the

page appears, videos in the category appear.

Note: A developer can change the list of youtube feedsbyediting

the siteroot/widgets/youtube.ascx.cs file.

YouTube.ascx

YouTube.ascx.cs

YouTube.ascx.jpg

You Tube Video

Allowsuser to embed code for anyYouTube video.

YouTubeVideo.ascx

YouTubeVideo.ascx.cs

YouTubeVideo.ascx.jpg

Files in

widgets\YouTubeVideo

Weather

Allows the user who is dropping the widget to enter a Zip Code,

then displays itsweather information.

Weather.ascx

Weather.ascx.cs

Weather.ascx.jpg

WebCalendar

Provides full calendar functionality including adding events. See

Also:

WebCalendar.ascx

WebCalendar.ascx.cs

WebCalendar.jpg

Files in

widgets\WebCalendar

Zip Code
Allowsusers to find the information shown below about a location

byentering one of the items.

n Zip Code

n Area Code

n State

n City

ZipCode.ascx

ZipCode.ascx.cs

ZipCode.ascx.jpg
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n This widget supports both .flv and .swf file types.

If you will use .flv files, make sure it is added as a file type.See Also:

n If the Flash file you want to display has already been added to Ektron CMS400.NET, use

the Select File tab to it.

If the file has not been added to Ektron CMS400.NET, first use the Select File tab to select a

folder for the Flash file. Then, use the Upload tab to navigate your computer’s file system, and

upload the file to the selected folder.

n The thumbnail feature only works with .flv file types. If you select a Thumbnail, it appears

within the Flash player when the page loads. See example below.

n The thumbnail is only applied to this instance of the widget - not the Flash file. If you

apply this video to a different widget on this page, you must reapply a thumbnail.

n The thumbnail is an image file that was dropped into Ektron CMS400.NET as an asset. It

cannot be a library image.

n The autostart feature only works with .flv files.
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n If you log in then upload a flash file, and certain requirements are not met for that file, you

see the following image where the widget appears.

The following conditions cause this image to appear.

n The flash file’s folder properties require certain metadata and/or a taxonomy category to be

applied, and they have not.

n The folder has an approval chain, and this content has not been approved.
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Ektron Markup Language

Introduction to EKML
The Ektron Markup Language (EkML) makes it easy for web developers to manage the output

presentation of server controls. EkML uses a simple markup that resembles HTML in syntax.

The EkML is cached and .NET watches for file changes.

The MarkupLanguage property in the Ektron server controls and Ektron Dreamweaver functions

is used to select the template file that contains the Ektron Markup Language. This language is

made up of tags and variables that assign formatting information to a control or function when

displayed on a Web page.

Warning! If themarkup template file is located in the same folder as the form that contains the server control, just

type the file’s name in the server control’sMarkupLanguageproperty. For example,

mycollectionmarkup.ekml. If the file is in another folder, enter the path relative to site root. For example, \CMS4-

00Developer\workarea\customfiles\markup\mycollectionmarkup.ekml.

This chapter contains the following topics.

n "EkML Templates" on page 21-414

n "EkML Example" on page 21-415

n "EkML Tags" on page 21-417

n "EkML Variables" on page 21-418

n "collection.ekml" on page 21-441

n "contentlist.ekml" on page 21-444

n "listsummary.ekml" on page 21-447

n "map.ekml" on page 21-451

n "messageboard.ekml" on page 21-453

n "metadatalist.ekml" on page 21-465

n "taxonomy.ekml" on page 21-467

n "websearch.ekml" on page 21-474

EkML Templates
Ektron, Inc. has provided an .ekml basic template for each control. These templates are located

in [webroot]/Workarea/Templates. At the top of each template is a list of variables that can be
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used with that control.

Warning! Ektron strongly recommends that you save the template under another name and use that template.

This prevents your file from being overwritten when upgradesoccur.

Note: If you install the CMS400Developer site, .ekml template files reside in variousproject folders. These files

exemplify using the .ekmlwith a specific server control.

The following server controls and Dreamweaver functions currently use the Ektron Markup

Language:

n Collection - "collection.ekml" on page 21-441

n ContentList - "contentlist.ekml" on page 21-444

n ListSummary - "listsummary.ekml" on page 21-447

n Map - "map.ekml" on page 21-451

n MessageBoard - "messageboard.ekml" on page 21-453

n MetadataList - "metadatalist.ekml" on page 21-465

n Taxonomy/Directory - "taxonomy.ekml" on page 21-467

n WebSearch - "websearch.ekml" on page 21-474

EkML Example
By customizing the provided EkML templates, you can create a custom layout for the content

you are displaying. For example, if you have a Collection and you want to display it as a

numbered list containing a content’s hyperlink, the date it was last updated and its summary,

you would create the following .ekml file and assign that file to a Collection server control’s

MarkupLanguage property.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink] Updated:<i>[$DateModified]</i><br/>[$Teaser] <hr/>
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

Once the Collection is displayed, it is formatted as follows:
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Because you can use HTML in the Ektron Markup Language, you can format the variables

using common HTML tags.

Let’s breakdown the example collection.ekml code found above.

n The <ekmarkup> tags open and close the markup language. Everything to do with the

EkML needs to be between these tags.

n The specific information you want displayed and any HTML formatting are added between

the <ekoutput> tags.

n <table width=”100%” border=”0”></table> sets up a table. This is HTML formatting.

n The <ekrepeat> tags contain formatting information and variables for items in the

Collection. It repeats this information for each item in the list.

n The [$Index] variable creates a numbered list for each content item in the Collection.

Note, you can add a period (.) or other separator depending on how you want the list to

look.

n The [$HyperLink] variable adds a hyperlink for each content item in the Collection. The

hyperlink use the content’s title as the text for the link. There is no need for anchor tags,

the variable creates them for you. If you want to use anchor tags for formatting you own

links, you can use the [$QuickLink] variable.

Developer Topics

21-416
ReferenceManual

Version 8.0 Rev 1.3



n Updated: is plain text.

n The <i></i> tags are HTML that cause the [$DateModified] variable to appear in italics.

n The [$DateModified] variable displays the date and time each content item in the

Collection was last modified.

n <br/> is HTML. It adds a line break.

n The [$Teaser] variable displays the summary for each content item in the Collection.

n <hr/> is HTML. It adds a horizontal rule line.

EkML Tags
The EkML tags define functions that occur when using the language to display content. The

Ektron Markup Language includes the following tags.
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EkML Tag Description

<ekmarkup>
Use these tags to open and close the Ektron Markup

Language.

<ekoutput>
Define what information is output from the server control

between these tags.

<ekrepeat>

These tags cause what ever formatting information that

appears between them to be applied to each item in the list.

They always appear between the <ekoutput> tags.

<ekbubbleinfo>

Creates a pop-up bubble. This tag is invoked when you use the

[$ShowBubble] or [$ShowBubble(width)] variables. By adding

different variables between the <ekbubbleinfo> tags, you

define what information appears in the bubble.

These tags are placed outside the <ekoutput> tags but within

the <ekmarkup> tags.

<ekcontentinfo>

Places the information defined between the tags in the

specified HTML tag ID. This tag is invoked when you use the

[$ShowContent(‘htmltagid’)] variable.

EkML Variables
The Ektron Markup Language uses variables that appear between the tags in a template file to

define the information that appears in a control’s display. Some variable are used in more than

one template. These are known as common EkML variables.

Another type of variable is a server control specific variable, these variables can only be used

with a specific server control. For example, [$SearchSummary] can only be used in WebSearch.

EkML Variables
Below is a list of EkML variables with a short description, a link to additional information and

whether the variable is common or specific.
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Variable Description

Common or

Control

Specific

[$AddCommentBox]

Displays the Add

Comment text box and button for a

message board.

More

information:"[$AddCommentBox]"

on page 21-455

MessageBoard

[$AddArticle]

Adds a link that allows a logged in

user to add HTML content to

CMS400.NET.

More information: "[$AddArticle]" on

page 21-472

Directory

[$AddAsset]

Adds a link that allows a logged in

user to add assets to

CMS400.NET.

More information:"[$AddAsset]" on

page 21-473

Directory

[$ApproveMessageLink]

Display an Approve link to approve

comments when message board

moderation is active.

More information:

"[$ApproveMessageLink]" on page

21-456

MessageBoard

[$Avatar]

Display the profile image of the

member who entered comments on

a message board.

More information: "[$Avatar]" on

page 21-457

MessageBoard

[$CollectionDescription]

Display the collection’s description.

More information:

"[$CollectionDescription]" on page

21-443

Collection

[$CollectionTitle]

Display the collection’s title.

More information:

"[$CollectionTitle]" on page 21-444

Collection

[$Comment]

The content’s comment information

is displayed.

More information: ”[$Comment]” on

Common

Except: Map,

WebSearch
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Variable Description

Common or

Control

Specific

page 21-47 and Taxonomy

[$ContentByteSize]

Displays the content item’s size in

KB. Works only with taxonomy

search. <ekoutput mode=”article_
search”>

"[$ContentByteSize]" on page 21-

477

Directory

WebSearch

[$ContentId]

Displays the content item’s ID.

More information: ”[$ContentId]” on

page 21-48

Common

Except: Map

[$DateCreated]

Display the date the content was

created.

More information: ”[$DateCreated]”

on page 21-48

Common

Except: Map

and

WebSearch

[$DateModified]

Display the date and time he

content was last modified.

More information: ”[$DateModified]”

on page 21-49

Common

Except: Map

[$DeleteMessageLink]

Displays the Delete link for the

comment on a message board.

More information:

"[$DeleteMessageLink]" on page

21-457

MessageBoard

[$DisplayName]

Display the display name of the

member who left the message on

the board.

More information:

"[$DisplayName]" on page 21-458

MessageBoard

[$EditorFirstName]

Display the last editor’s first name

for a content item.

More information:

”[$EditorFirstName]” on page 21-50

Common

Except: Map

[$EditorLastName]

Display the last editor’s last name

for a content item.

More information:

”[$EditorLastName]” on page 21-51

Common

Except: Map
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Variable Description

Common or

Control

Specific

[$EmailAddress]

Displays the email address of the

member.

More information:

"[$EmailAddress]" on page 21-459

MessageBoard

[$FirstName]

Display the first name of the person

who left the comment on a

message board.

More information: "[$FirstName]" on

page 21-460

MessageBoard

[$FolderDescription]

Displays the folder’s description.

More information:

"[$FolderDescription]" on page 21-

449

ListSummary

[$FolderId]

Display the folder ID of a content

item.

More information: ”[$FolderId]” on

page 21-52

Common

Except: Map

and

WebSearch

[$FolderName]

Displays the folder’s name.

More information: "[$FolderName]"

on page 21-450

ListSummary

[$Html]

Display the HTML contained in the

content item.

More information: ”[$Html]” on page

21-52

Common

Except: Map

and

WebSearch

[$HyperLink]

Adds a hyperlink using the title of

the content block as the text.

More information: ”[$HyperLink]” on

page 21-53

Common

Except: Map

and

WebSearch

[$Image]

Displays the path for the image defined in

a content item’sMetadata.When

wrapped in <img src=””/> tag, the

image is displayed. For example:

<img src=”[$Image]”/>

More information: ”[$Image]” on page

21-54

Common

Except: Map
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Variable Description

Common or

Control

Specific

[$ImageIcon]

Displays an image icon for the

content item. For example, if the

content item is HTML, the ( ) icon
is displayed.

More information: ”[$ImageIcon]”

on page 21-54

Common

Except: Map

[$ImageThumbnail]

Displays the path for the image’s

thumbnail defined in a content item’s

Metadata.Whenwrapped in <img

src=””/> tag, a thumbnail version of the

image is displayed. For example:

<img src=”[$ImageThumbnail]”/>

More information: ”[$ImageThumbnail]”

on page 21-55

Common

Except: Map

[$Index]

Serialize the content items in a

numbered list.

More information: ”[$Index]” on

page 21-56

Common

Except: Map

and

WebSearch

[$ItemCount]

The total number of items in a list.

More information: ”[$ItemCount]” on

page 21-56

Common

Except: Map

[$Language]

Display the language ID for the

content item.

More information: ”[$Language]” on

page 21-57

Common

Except: Map

and

WebSearch

[$LastName]

Display the last name of the person

who left the comment on a

message board.

More information: See

"[$LastName]" on page 21-461]

MessageBoard

[$LinkTarget]

When added to an <a href=””>

tag’s target=”” attribute, this

variable reads the server control’s

LinkTarget property and uses its

setting.

More information: See

"[$LinkTarget]" on page 21-432

Common

Except: Map
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Variable Description

Common or

Control

Specific

[$MessageText]

Displays the text of a message on a

message board.

More information: "[$MessageText]"

on page 21-462

MessageBoard

[$NumberComments]

Displays the number of comments

posted to a message board.

More information:

"[$NumberComments]" on page

21-463

MessageBoard

[$PagingCurrentEndIndex]

The end count number of the items

on the page. For example, if you

are displaying items 11 - 20 on a

page, this variable represents the

number 20. Works only with

taxonomy search. <ekoutput
mode=”article_search”>

More information:

"[$PagingCurrentEndIndex]" on

page 21-478

Directory and

WebSearch

[$PagingCurrentStartIndex]

The numerical record of the first

item on a page. For example, if you

are displaying items 1 through 10

out of 50 total items on a page, this

variable represents the number 1.

Works only with taxonomy search.
<ekoutput mode=”article_search”>

More information:

"[$PagingCurrentStartIndex]" on

page 21-479

Directory and

WebSearch

[$QuickLink]

This property displays the Quicklink

information for the content item.

When wrapped in an <a href=””>

tag, you can create a Hyperlink.

More information:”[$QuickLink]” on

page 21-57

Common

Except: Map

[$SearchDuration]

Displays the amount of time, in

seconds, it has taken to execute

the search. Works only with

taxonomy search. <ekoutput
mode=”article_search”>

Directory and

WebSearch
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Variable Description

Common or

Control

Specific

More

information:"[$SearchDuration]" on

page 21-480

[$SearchSummary]

Creates a summary from

information stored in the indexing

service for each item in the search

results. Works only with taxonomy

search. <ekoutput mode=”article_
search”>

More

information:"[$SearchSummary]"

on page 21-477

Directory and

WebSearch

[$SearchText]

Displays the text for which a user is

searching. This information is same

as what a user entered in the

search text box. Works only with

taxonomy search. <ekoutput
mode=”article_search”>

More information: "[$SearchText]"

on page 21-479

Directory and

WebSearch

[$SERVER_NAME]

Displays the server name. For

example, If this variable is applied

to
http://www.example.com/demo.aspx

, the return is www.example.com.

More information: ”[$SERVER_

NAME]” on page 21-59

Common

Except: Map

and

WebSearch

[$ShortDateModified]

Displays the date the content was

modified. To display the date and

time a content item was updated,

use [$DateModified]

More information:

”[$ShortDateModified]” on page 21-

59

WebSearch
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Variable Description

Common or

Control

Specific

[$ShowAllcategory]

Adds to the Taxonomy search

screen a checkbox that lets the

user decide if he wants to display

categories that have no items.

More information:

”[$ShowAllcategory]” on page 21-

60

Directory

[$ShowBubble(width)]

This is similar to [$ShowBubble]. It

calls the <ekbubbleinfo> tags and

allows you to set the width and

height of the bubble. For example,

[$ShowBubble(300,400)]. The first

number represents the width. The

second number represents the

height.

More information:

”[$ShowBubble(width,height)]” on

page 21-62

Common

Except: Map

and

WebSearch

[$ShowBubble]

Calls the <ekbubbleinfo> tags and

places the information contained

within those tags in a pop-up

bubble.

”[$ShowBubble]” on page 21-61

Common

Except: Map

and

WebSearch

[$ShowContent(‘htmltagid’)]

Calls the <ekcontentinfo> tags an

places the information in those tags

within the specified HTML tag ID.

Replace the htmltagid with the ID of

the tag.

”[$ShowContent(‘htmltagid’)]” on

page 21-63

Common

Except: Map

and

WebSearch

[$Status]

Displays the status of a content

item.

”[$Status]” on page 21-64

Common

Except: Map

and

WebSearch

[$Teaser]

Display the content item’s summary

information.

Note: If the item is an HTML form, this

variable isnot supported with this ekml

file.

”[$Teaser]” on page 21-65

Common

Except: Map

and

WebSearch
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Variable Description

Common or

Control

Specific

[$TemplateQuickLink]

This property displays the

Template Quicklink information

assigned to the taxonomy item in

the Workarea. When wrapped in an

<a href=””> tag, you can create a

Hyperlink.

See Also: "Applying a Template

to a Taxonomy or Category" on

page 9-207

More information :

"[$TemplateQuickLink]" on page

21-473

Directory

[$Title]
Displays the content item’s title.

”[$Title]” on page 21-66

Common

Except: Map

[$UrlEncode(‘str’)]

Encodes the string information.

Replace str with the string you

want to encode. This variable can

be used to encode another EkML

variable and place it in an email.

”[$UrlEncode(‘str’)]” on page 21-69

Common

Except: Map

and

WebSearch

[$UrlParam(‘paramname’)]

Displays the value of a query

string’s given parameter. For

example, if the query string is

?id=27 and the variable is

[$UrlParam(‘id’)], 27 is

displayed.

”[$UrlParam(‘paramname’)]” on

page 21-67

Common

Except: Map

and

WebSearch

[$UserName]

Display the Username of user who

left a comment on a message

board.

"[$UserName]" on page 21-464

MessageBoard
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[$Comment]
The content’s comment information is displayed. Comment information can be added in the

Workarea via the content item’s Comment tab.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink] <br/> [$Comment]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$ContentId]
Displays the content item’s ID.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink] Content ID = [$ContentId]
</td>
</tr>
</ekrepeat>
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</table>
</ekoutput>
</ekmarkup>

[$DateCreated]
Display the date the content was created.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink] - <i>[$DateCreated]</i>
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$DateModified]
Display the date and time the content was last modified. To display the date only, use

[$ShortDateModified].

<ekmarkup>
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<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink] <br/>Date Modified: <b>[$DateModified]</b>
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$EditorFirstName]
Display the last editor’s first name for a content item.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink] Last Editor: [$EditorFirstName]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$EditorLastName]
Display the last editor’s last name for a content item.

<ekmarkup>
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<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink] Last Editor: [$EditorLastName]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$FolderId]
Display the folder ID of a content item.

[$Html]
Display the HTML contained in the content item. In the server control, the control’s GetHTML

property must be set to True; otherwise nothing is displayed. The exception to this is when the

[$Html] appears between the <ekbubbleinfo> tags. In that case, the GetHTML property can be set

to True or False.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$HyperLink]<br/>[$Html]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>
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[$HyperLink]
Adds a hyperlink using the title of the content block as the text. You do not add an <a

href=””> tag when using this variable. That functionality is built into the EkML. Use this

variable when you do not want to create a custom hyperlink. If you want to create a custom

hyperlink, use the [$QuickLink] variable. See Also: "[$QuickLink]" on page 21-433

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$Image]
Displays the path for the image defined in a content item’s Metadata. When wrapped in <img

src=””/> tag, the image is displayed. For example, <img src=”[$Image]”/>.

An example of using this variable is on the developer sample page > List Summary > Flash

news. That sample (flashnews.aspx) refers to flashnews.ekml, which illustrates using this

variable.

[$ImageIcon]
Displays an image icon for the content item. Except for HTML content, these icons are the

same icons used in the Workarea to show the content type. HTML content uses the Internet

Explorer icon ( ). For example, Forms use the Form icon ( ).
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When using this variable with the server control, the IncludeIcons property is automatically set

to True.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink] [$ImageIcon]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$ImageThumbnail]
Displays the path for the image’s thumbnail defined in a content item’s Metadata. When

wrapped in <img src=””/> tag, the image thumbnail is displayed. For example, <img

src=”[$ImageThumbnail]”/>.

An example of using this variable is on the developer sample page > List Summary > Flash

news. That sample (flashnews.aspx) refers to flashnews.ekml, which illustrates using this

variable.

[$Index]
Serialize the content items in a numbered list.

Developer Topics

21-432
ReferenceManual

Version 8.0 Rev 1.3



<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink] [$ImageIcon]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$ItemCount]
The total number of items in a list. In the server control, the EnablePaging property must be set

to True; otherwise nothing is displayed

[$Language]
Display the language ID for the content item.

[$LinkTarget]
When added to an <a href=””> tag’s target=”” attribute, this variable reads the server control’s

LinkTarget property and uses its setting. For example, If you want to create a custom hyperlink

that opens in a new window, you set the server control’s LinkTarget property to _Blank. Then,

in the Ektron Markup Language file, add the [$LinkTarget] variable to the <a href=””> tag’s

Taget=”” attribute. A code example appears below.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
<a href=”[$QuickLink]” target=”[$LinkTarget]”>[$Title]</a>
</td>
</tr>
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</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$QuickLink]
This property displays the Quicklink information for the content item. When wrapped in an <a

href=””> tag, you can create a Hyperlink. Use this property instead of the [$HyperLink] if you

want to customize your hyperlinks. See Also: "[$HyperLink]" on page 21-430

The first image shows the variable displaying the Quicklink information. The second image

shows the Quicklink as a Hyperlink with a custom text.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$QuickLink]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

<ekmarkup>
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<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. <a href="[$QuickLink]">Click Here For Item #[$Index]</a>
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$SERVER_NAME]
Displays the server name for the page on which this variable appears. For example, If this

variable is applied to

http://www.example.com/demo.aspx, the return is www.example.com.

[$ShortDateModified]
Display the date the content was last modified. The variable show the date only. To show the

Date and Time, use the [$DateModified] variable.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink] <br/>Date Modified: <b>[$ShortDateModified]</b>
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>
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[$ShowAllcategory]
If a Directory server control’s EnableSearch property is set to true, this variable adds the

checkbox circled below to the right of the search field.

By default, the Directory server control only shows categories to which at least one content

block is assigned. If you check this box, all categories appear, even those with no content

assigned.

[$ShowBubble]
Calls the <ekbubbleinfo> tags and places the information contained within those tags in a pop-

up bubble. This bubble is typically assigned to the onclick or onmouseover attribute in an <a

href=””> tag. See the example EkML code below.

<ekmarkup>
<ekbubbleinfo>
<table border="0">
<tr>
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<td>[$Html]</td>
</tr>
</table>
</ekbubbleinfo>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index].<a href="#" onmouseover="[$ShowBubble]">[$Title]</a>
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$ShowBubble(width,height)]
This is similar to [$ShowBubble]. It calls the <ekbubbleinfo> tags and places the information

contained within those tags in a pop-up bubble. This variable allows you to set the width and

height of the bubble. For example, [$ShowBubble(300,400). In this example, the first number

represents the width. The second number represents the height.

If you enter a single number, it sets the width. The height of the bubble is then limited to the

length of the content. For example, if you had a video that was formatted at 200 pixels wide

and you wanted to launch it in a bubble, you would add the function as [$ShowBubble(200)].

The minimum width for a bubble is 287. The minimum height is 101.

<ekmarkup>
<ekbubbleinfo>
<table border="0">
<tr>
<td>[$Html]</td>
</tr>
</table>
</ekbubbleinfo>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index].<a href="#" onmouseover="[$ShowBubble(200)]">[$Title]</a>
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>
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[$ShowContent(‘htmltagid’)]
Calls the <ekcontentinfo> tags and places the information contained within those tags in the

specified HTML tag ID. Replace the htmltagid with the ID of the tag. This tag is typically

assigned to the onclick or onmouseover attribute in an <a href=””> tag. See the example EkML

code below.

<ekmarkup>
<ekcontentinfo>
<table border="0">
<tr>
<td>[$Html]</td>
</tr>
</table>
</ekcontentinfo>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index].<a href="#" onmouseover="[$ShowContent(‘contarea’)]">[$Title]</a>
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$Status]
Displays the status of a content item. For example, Approved, Checked in, or Submitted for

Approval. For additional information, see "Content Statuses" on page 7-133.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$Hyperlink]
The content status is <i>[$Status]</i>
</td>
</tr>
</ekrepeat>
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</table>
</ekoutput>
</ekmarkup>

[$Teaser]
Display the content item’s summary information. Summary information is added to content in

the Workarea via the Summary tab. A code example appears below.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink] <br/> [$Teaser]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$Title]
Displays the content item’s title. Use this variable if you want to display the title as normal

text. If you want to display the title as a hyperlink, use [$HyperLink].See Also:
"[$HyperLink]" on page 21-430. If you want to create a custom hyperlink with the title as the

text of the hyperlink, use this property in conjunction with the <a href=””> tag and the

[$QuickLink] variable. See Also: "[$QuickLink]" on page 21-433.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. <a href="[$QuickLink]">[$Title]</a>
</td>
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</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$UrlParam(‘paramname’)]
Displays the value of a query string’s parameter. For example, if you have a collection and

want to display its ID, add the [$UrlParam(‘coll_id’)] where you want the collection’s ID to

appear.

<ekmarkup>
<ekbubbleinfo>
<table border="0">
<tr>
<td>[$Html]</td>
</tr>
</table>
</ekbubbleinfo>
<ekoutput>
<table width="100%" border="0">
<tr>
<td>
<b>This Collection's ID is: [$UrlParam('coll_id')]</b>
<br/><hr/>
</td>
</tr>
<ekrepeat>
<tr>
<td>
[$Index].<a href="#" onclick="[$ShowBubble]">[$Title]</a>[$Teaser]<hr/>
</td>
</tr>
</ekrepeat>
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</table>
</ekoutput>
</ekmarkup>

[$UrlEncode(‘str’)]
Encodes the string information in the variable. This variable can be used to encode another

EkML variable and place it in an email. For example, You want the title of the content block

to appear as the subject of an email. A code example appears below.

<ekcontentinfo>
<table border="0">
<tr>
<td>
<strong>Title:&#160;</strong>
<span style="color:red;">[$Title]</span>
<a href="mailto:?subject=[$UrlEncode('[$Title]')]&body=http://[$SERVER_

NAME]/CMS400Developer/wiki.aspx?id=[$ContentId]">&nbsp;<img

src="WorkArea/images/application/icon_email.gif" align="absmiddle" alt="[$Title]"

border="0"/></a>
<hr />
</td>
</tr>
<tr>
<td>[$Html]</td>
</tr>
</table>
</ekcontentinfo>
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EkML Template Examples

collection.ekml
This file defines which items and information are included when displaying content item

information in a collection using the Collection server control. For an example of using this

file with a Collection server control, see the CMS400 demo example: http://your

site/siteroot/Developer/Collection/TemplateMarkup.aspx.

collection.ekml Variables
Below is a list of variables that are used with the collection.ekml file.

Variable Description More Information

[$CollectionDescription]
Display the collection’s

description.

"[$CollectionDescription]" on

page 21-443

[$CollectionTitle] Display the collection’s title.
"[$CollectionTitle]" on page

21-444

[$Comment]
The content’s comment information is

displayed.
"[$Comment]" on page 21-425

[$ContentId] Displays the content item’s ID. "[$ContentId]" on page 21-426

[$DateCreated] Display the date the content was created.
"[$DateCreated]" on page 21-

427

[$DateModified]
Display the date the content was last

modified.

"[$DateModified]" on page 21-

427

[$EditorFirstName]
Display the last editor’s first name for a

content item.

"[$EditorFirstName]" on page

21-428

[$EditorLastName]
Display the last editor’s last name for a

content item.

"[$EditorLastName]" on page

21-428

[$FolderId] Display the folder ID of a content item. "[$FolderId]" on page 21-429

[$Html]
Display the HTML contained in the content

item.
"[$Html]" on page 21-429
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Variable Description More Information

[$HyperLink]
Adds a hyperlink using the title of the

content block as the text.

"[$HyperLink]" on page 21-

430

[$Image]

Displays the path for the image defined in a content

item’sMetadata.Whenwrapped in <img

src=””/> tag, the image is displayed. For

example: <img src=”[$Image]”/>

"[$Image]" on page 21-430

[$ImageIcon]

Displays an image icon for the content item.

For example, if the content item is HTML,

the ( ) icon is displayed.

"[$ImageIcon]" on page 21-

430

[$ImageThumbnail]

Displays the path for the image’s thumbnail defined

in a content item’sMetadata.Whenwrapped in

<img src=””/> tag, a thumbnail version of the

image is displayed. For example: <img

src=”[$ImageThumbnail]”/>

"[$ImageThumbnail]" on page

21-431

[$Index]
Serialize the content items in a numbered

list.
"[$Index]" on page 21-431

[$ItemCount] The total number of items in a list.
"[$ItemCount]" on page 21-

432

[$Language]
Display the language ID for the content

item.

"[$Language]" on page 21-

432

[$LinkTarget]

When added to an <a href=””> tag’s

target=”” attribute, this variable reads the

server control’s LinkTarget property and

uses its setting.

"[$LinkTarget]" on page 21-

432

[$QuickLink]

This property displays the Quicklink

information for the content item. When

wrapped in an <a href=””> tag, you can

create a Hyperlink.

"[$QuickLink]" on page 21-433

[$SERVER_NAME]

Displays the server name. For example, If

this variable is applied to

http://www.example.com/demo.aspx, the

return is www.example.com.

"[$SERVER_NAME]" on page

21-434

[$ShowBubble(width)]

This is similar to [$ShowBubble]. It calls the

<ekbubbleinfo> tags and allows you to set

the width of the bubble.

"[$ShowBubble(width,height)]"

on page 21-436
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Variable Description More Information

[$ShowBubble]

Calls the <ekbubbleinfo> tags and places

the information contained within those tags

in a pop-up bubble.

"[$ShowBubble]" on page 21-

435

[$ShowContent(‘htmltagid’)]

Calls the <ekcontentinfo> tags an places

the information in those tags within the

specified HTML tag ID. Replace the

'htmltagid' with the ID of the tag.

"[$ShowContent(‘htmltagid’)]"

on page 21-437

[$Status] Displays the status of a content item. "[$Status]" on page 21-437

[$Teaser]

Display the content item’s summary

information.

Note: If the item is an HTML form, this variable is

not supported with this ekml file.

"[$Teaser]" on page 21-438

[$Title] Displays the content item’s title. "[$Title]" on page 21-438

[$UrlEncode(‘str’)]

Encodes the string information. This

variable can be used to encode another

EkML variable and place it in an email.

"[$UrlEncode(‘str’)]" on page

21-440

[$UrlParam(‘paramname’)]

Displays the value of a query string’s

parameter. For example, if the query string

is ?id=27 and the variable is

[$UrlParam(‘id’)], 27 is displayed.

"[$UrlParam(‘paramname’)]"

on page 21-439

[$CollectionDescription]
Display the collection’s description.

<ekmarkup>
<ekoutput>
<h3><b>[$CollectionTitle]</b></h3><p/>[$CollectionDescription]<br/>
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<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$CollectionTitle]
Display the collection’s title.

<ekmarkup>
<ekoutput>
<h3><b>[$CollectionTitle]</b></h3>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

contentlist.ekml
This file defines which items and information are included when displaying content item

information in a content list using the ContentList server control.
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contentlist.ekml Variables
Below is a list of variables that are used with the contentlist.ekml file.

Variable Description More Information

[$Comment]
The content’s comment information is

displayed.
"[$Comment]" on page 21-425

[$ContentId] Displays the content item’s ID. "[$ContentId]" on page 21-426

[$DateCreated] Display the date the content was created.
"[$DateCreated]" on page 21-

427

[$DateModified]
Display the date the content was last

modified.

"[$DateModified]" on page 21-

427

[$EditorFirstName]
Display the last editor’s first name for a

content item.

"[$EditorFirstName]" on page

21-428

[$EditorLastName]
Display the last editor’s last name for a

content item.

"[$EditorLastName]" on page

21-428

[$FolderId] Display the folder ID of a content item. "[$FolderId]" on page 21-429

[$Html]
Display the HTML contained in the content

item.
"[$Html]" on page 21-429

[$HyperLink]
Adds a hyperlink using the title of the

content block as the text.

"[$HyperLink]" on page 21-

430

[$Image]

Displays the path for the image

defined in a content item’s Metadata.

When wrapped in <img src=””/> tag, the

image is displayed. For example:

<img src=”[$Image]”/>

"[$Image]" on page 21-430

[$ImageIcon]

Displays an image icon for the content item.

For example, if the content item is HTML,

the ( ) icon is displayed.

"[$ImageIcon]" on page 21-

430

[$ImageThumbnail]

Displays the path for the image’s thumbnail

defined in a content item’s Metadata. When

wrapped in <img src=””/> tag, a thumbnail

version of the image is displayed. For

"[$ImageThumbnail]" on page

21-431
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Variable Description More Information

example:

<img src=”[$ImageThumbnail]”/>

[$Index]
Serialize the content items in a numbered

list.
"[$Index]" on page 21-431

[$ItemCount] The total number of items in a list.
"[$ItemCount]" on page 21-

432

[$Language]
Display the language ID for the content

item.

"[$Language]" on page 21-

432

[$LinkTarget]

When added to an <a href=””> tag’s

target=”” attribute, this variable reads the

server control’s LinkTarget property and

uses its setting.

"[$LinkTarget]" on page 21-

432

[$QuickLink]

This property displays the Quicklink

information for the content item. When

wrapped in an <a href=””> tag, you can

create a Hyperlink.

"[$QuickLink]" on page 21-433

[$SERVER_NAME]

Displays the server name. For example, If

this variable is applied to

http://www.example.com/demo.aspx, the

return is www.example.com.

"[$SERVER_NAME]" on page

21-434

[$ShowBubble(width)]

This is similar to [$ShowBubble]. It calls the

<ekbubbleinfo> tags and allows you to set

the width of the bubble.

"[$ShowBubble(width,height)]"

on page 21-436

[$ShowBubble]

Calls the <ekbubbleinfo> tags and places

the information contained within those tags

in a pop-up bubble.

"[$ShowBubble]" on page 21-

435

[$ShowContent(‘htmltagid’)]

Calls the <ekcontentinfo> tags an places

the information in those tags within the

specified HTML tag ID. Replace the

'htmltagid' with the ID of the tag.

"[$ShowContent(‘htmltagid’)]"

on page 21-437

[$Status] Displays the status of a content item. "[$Status]" on page 21-437
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Variable Description More Information

[$Teaser]

Display the content item’s summary

information.

Note: If the item is an HTML form, this variable is

not supported with this ekml file.

"[$Teaser]" on page 21-438

[$Title] Displays the content item’s title. "[$Title]" on page 21-438

[$UrlEncode(‘str’)]

Encodes the string information. This

variable can be used to encode another

EkML variable and place it in an email.

"[$UrlEncode(‘str’)]" on page

21-440

[$UrlParam(‘paramname’)]

Displays the value of a QueryString’s

parameter. For example, if the QueryString

is ?id=27 and the variable is

[$UrlParam(‘id’)], 27 is displayed.

"[$UrlParam(‘paramname’)]"

on page 21-439

listsummary.ekml
This file defines which items and information are included when displaying content item

information in a list summary using the ListSummary server control. For an example of using

this file with a ListSummary server control, see the CMS400 demo example: http://<your

site>/CMS400Developer/Developer/ListSummary/TemplateMarkup.aspx.

ListSummary.ekml Variables
Below is a list of variables that are used with the listsummary.ekml file.

Variable Description More Information

[$Comment]

The content’s comment

information

is displayed.

"[$Comment]" on page 21-425

[$ContentId] Displays the content item’s ID. "[$ContentId]" on page 21-426

[$DateCreated]
Display the date the content was

created.

"[$DateCreated]" on page 21-

427

[$DateModified]
Display the date the content was

last modified.

"[$DateModified]" on page 21-

427
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Variable Description More Information

[$EditorFirstName]
Display the last editor’s first name

for a content item.

"[$EditorFirstName]" on page

21-428

[$EditorLastName]
Display the last editor’s last name

for a content item.

"[$EditorLastName]" on page

21-428

[$FolderDescription] Displays the folder’s description.
"[$FolderDescription]" on

page 21-449

[$FolderId]
Display the folder ID of a content

item.
"[$FolderId]" on page 21-429

[$FolderName] Displays the folder’s name.
"[$FolderName]" on page 21-

450

[$Html]
Display the HTML contained in the

content item.
"[$Html]" on page 21-429

[$HyperLink]
Adds a hyperlink using the title of

the content block as the text.

"[$HyperLink]" on page 21-

430

[$Image]

Displays the path for the image defined in

a content item’sMetadata.Whenwrapped

in <img src=””/> tag, the image is

displayed

For example: <img src=”[$Image]”/>

"[$Image]" on page 21-430

[$ImageIcon]

Displays an image icon for the

content item. For example, if the

content item is HTML, the ( ) icon
is displayed.

"[$ImageIcon]" on page 21-

430

[$ImageThumbnail]

Displays the path for the image’s

thumbnail defined in a content item’s

Metadata.Whenwrapped in <img

src=””/> tag, a thumbnail version of the

image is displayed. For example:

<img src=”[$ImageThumbnail]”/>

"[$ImageThumbnail]" on page

21-431

[$Index]
Serialize the content items in a

numbered list.
"[$Index]" on page 21-431

[$ItemCount] The total number of items in a list.
"[$ItemCount]" on page 21-

432

EkML Template Examples

ReferenceManual

Version 8.0 Rev 1.3
21-449



Variable Description More Information

[$Language]
Display the language ID for the

content item.

"[$Language]" on page 21-

432

[$LinkTarget]

When added to an <a href=””>

tag’s target=”” attribute, this

variable reads the server control’s

LinkTarget property and uses its

setting.

"[$LinkTarget]" on page 21-

432

[$QuickLink]

This property displays the Quicklink

information for the content item.

When wrapped in an <a href=””>

tag, you can create a Hyperlink.

"[$QuickLink]" on page 21-433

[$SERVER_NAME]

Displays the server name. For

example, If this variable is applied

to

http://www.example.com/demo.aspx,

the return is www.example.com.

"[$SERVER_NAME]" on page

21-434

[$ShowBubble(width)]

This is similar to [$ShowBubble]. It

calls the <ekbubbleinfo> tags and

allows you to set the width of the

bubble.

"[$ShowBubble(width,height)]"

on page 21-436

[$ShowBubble]

Calls the <ekbubbleinfo> tags and

places the information contained

within those tags in a pop-up

bubble.

"[$ShowBubble]" on page 21-

435

[$ShowContent(‘htmltagid’)]

Calls the <ekcontentinfo> tags an

places the information in those tags

within the specified HTML tag ID.

Replace the 'htmltagid' with the ID of

the tag.

"[$ShowContent(‘htmltagid’)]"

on page 21-437

[$Status]
Displays the status of a content

item.
"[$Status]" on page 21-437

[$Teaser]

Displays the content item’s

summary information.

Note: If the item is an HTML form, this

variable isnot supported with this ekml file.

"[$Teaser]" on page 21-438

[$Title] Displays the content item’s title. "[$Title]" on page 21-438
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Variable Description More Information

[$UrlEncode(‘str’)]

Encodes the string information. This

variable can be used to encode

another EkML variable and place it

in an email.

"[$UrlEncode(‘str’)]" on page

21-440

[$UrlParam(‘paramname’)]

Displays the value of a

QueryString’s parameter. For

example, if the QueryString is

?id=27 and the variable is

[$UrlParam(‘id’)], 27 is displayed.

"[$UrlParam(‘paramname’)]"

on page 21-439

[$FolderDescription]
Displays the folder’s description.

<ekmarkup>
<ekoutput>
<h3><b>[$FolderName]</b></h3><p/>[$FolderDescription]<br/>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$FolderName]
Displays the folder’s name.

EkML Template Examples

ReferenceManual

Version 8.0 Rev 1.3
21-451



<ekmarkup>
<ekoutput>
<h3><b>[$FolderName]</b></h3><p/>[$FolderDescription]<br/>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

map.ekml
The map.ekml file defines which items and information are included when using the Map

server control. Unlike most other .ekml files, the map.emkl has some variables that cannot be

changed or moved around.

The file’s variables appear in three <tr></tr> table rows. These rows are located below the

main table. In the first two table rows, you can modify a tag’s style information only. In the

third, you can change the style information and the order of the variables to create different

layouts for your page. It is recommended you hide the first two table rows if you are not

changing their style information. For example:
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When using the map.ekml file remember these three rules.

1. Do not change any of the IDs.

2. You can change any tag’s style information.

3. You can move the variables in the third table row around to create different layouts. For

example, you can display these sections horizontally or vertically.

Variable Description More Information

__Map
Displays the map section of

the Map server control.

"__Map" on page 21-

452

__
SearchTxtResultPane

Displays the results pane

from the search.

"Search Txt Result

Pane" on page 21-452

__RouteInfoPane
Displays the direction

information pane.

"__RouteInfoPane" on

page 21-453

__Map
Displays the map section of the Map server control.
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Search Txt Result Pane
Displays the results pane from the search.
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__RouteInfoPane
The panel that displays driving directions from the starting address to the arrival address.

messageboard.ekml
This file defines which items and information are included when displaying message

information for a message board using the MessageBoard server control.

messageboard.ekml Variables
Below is a list of variables that are used with the metadatalist.ekml file.

Variable Description More Information

[$AddCommentBox]

Displays the Add Comment text

box and button for a message

board.

"[$AddCommentBox]" on

page 21-455

[$ApproveMessageLink]

Display an Approve link to

approve comments when

message board moderation is

active.

"[$ApproveMessageLink]"

on page 21-456

[$Avatar]

Display the profile image of the

member who entered the

comments on the message board.

"[$Avatar]" on page 21-

457
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Variable Description More Information

[$DateCreated]
Display the date the content was

created.

"[$DateCreated]" on page

21-427

[$DateModified]
Display the date the content was

last modified.

"[$DateModified]" on

page 21-427

[$DeleteMessageLink]

Displays the Delete link for a

comment on the message board.

Only Administrators, the person

who left the message or the

person who owns the board.

"[$DeleteMessageLink]"

on page 21-457

[$DisplayName]
Displays the display name of the

member who left the message.

"[$DisplayName]" on

page 21-458

[$EmailAddress]

Displays the email addressof the

member who left themessage on the

board.

"[$EmailAddress]" on

page 21-459

[$FirstName]

Display the first name of the

person who left the comment on

the message board.

"[$FirstName]" on page

21-460

[$LastName]

Display the last name of the

person who left the comment on

the message board.

"[$LastName]" on page

21-461

[$MessageText]
Displays the message on a

message board.

"[$MessageText]" on

page 21-462

[$NumberComments]
Displays the number of comments

posted to a message board.

"[$NumberComments]"

on page 21-463

[$UserName]

Display the Username of a user

who left a comment on a

message board.

"[$UserName]" on page

21-464

[$AddCommentBox]
Displays the Add Comment text box and button for a message board.
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<ekoutput>
<div class="ContributionForm">
<h4>[$NumberComments] Comments</h4>
<ul>
<ekrepeat>
<li class="ekMessagePost">
<div class="avatar">[$Avatar]</div>
<div class="message">
<div class="metaData">
<span class="username">[$UserName]</span>
<span class="time">[$DateCreated]</span>
</div>
<p class="body">[$MessageText]</p>
<ul class="commands">
<li class="ekDeleteMessage">[$DeleteMessageLink]</li>
<li class="ekApproveMessage">[$ApproveMessageLink]</li>
</ul>
</div>
</li>
</ekrepeat>
</ul>
[$AddCommentBox]
</div>
</ekoutput>

[$ApproveMessageLink]
Displays the Approve link for the message. This link is used to approve the message for

display when the Moderate property is set to true. Only Administrators, the person who left the

message, or the person who owns the board can see this link.
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<ekoutput>
<div class="ContributionForm">
<h4>[$NumberComments] Comments</h4>
<ul>
<ekrepeat>
<li class="ekMessagePost">
<div class="avatar">[$Avatar]</div>
<div class="message">
<div class="metaData">
<span class="username">[$UserName]</span>
<span class="time">[$DateCreated]</span>
</div>
<p class="body">[$MessageText]</p>
<ul class="commands">
<li class="ekDeleteMessage">[$DeleteMessageLink]</li>
<li class="ekApproveMessage">[$ApproveMessageLink]</li>
</ul>
</div>
</li>
</ekrepeat>
</ul>
[$AddCommentBox]
</div>
</ekoutput>

[$Avatar]
Display the profile image of the member who entered the comments on the message board.
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<ekoutput>
<div class="ContributionForm">
<h4>[$NumberComments] Comments</h4>
<ul>
<ekrepeat>
<li class="ekMessagePost">
<div class="avatar">[$Avatar]</div>
<div class="message">
<div class="metaData">
<span class="username">[$UserName]</span>
<span class="time">[$DateCreated]</span>
</div>
<p class="body">[$MessageText]</p>
<ul class="commands">
<li class="ekDeleteMessage">[$DeleteMessageLink]</li>
<li class="ekApproveMessage">[$ApproveMessageLink]</li>
</ul>
</div>
</li>
</ekrepeat>
</ul>
[$AddCommentBox]
</div>
</ekoutput>

[$DeleteMessageLink]
Displays the Delete link for a comment on the message board. Only Administrators, the person

who left the message or the person who owns the board.
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<ekoutput>
<div class="ContributionForm">
<h4>[$NumberComments] Comments</h4>
<ul>
<ekrepeat>
<li class="ekMessagePost">
<div class="avatar">[$Avatar]</div>
<div class="message">
<div class="metaData">
<span class="username">[$UserName]</span>
<span class="time">[$DateCreated]</span>
</div>
<p class="body">[$MessageText]</p>
<ul class="commands">
<li class="ekDeleteMessage">[$DeleteMessageLink]</li>
<li class="ekApproveMessage">[$ApproveMessageLink]</li>
</ul>
</div>
</li>
</ekrepeat>
</ul>
[$AddCommentBox]
</div>
</ekoutput>

[$DisplayName]
Displays the display name of the member who left the message.
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<ekoutput>
<div class="ContributionForm">
<h4>[$NumberComments] Comments</h4>
<ul>
<ekrepeat>
<li class="ekMessagePost">
<div class="avatar">[$Avatar]</div>
<div class="message">
<div class="metaData">
<span class="username">[$DisplayName]</span>
<span class="time">[$DateCreated]</span>
</div>
<p class="body">[$MessageText]</p>
<ul class="commands">
<li class="ekDeleteMessage">[$DeleteMessageLink]</li>
<li class="ekApproveMessage">[$ApproveMessageLink]</li>
</ul>
</div>
</li>
</ekrepeat>
</ul>
[$AddCommentBox]
</div>
</ekoutput>

[$EmailAddress]

Displays the email address of the member who left the message on the board. To create
a hyperlinked email, wrap the [$EmailAddress] variable in a <a> tag with the mailto:
variable. For example:

<a href="Mailto:[$EmailAddress]">[$EmailAddress]</a>
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<ekoutput>
<div class="ContributionForm">
<h4>[$NumberComments] Comments</h4>
<ul>
<ekrepeat>
<li class="ekMessagePost">
<div class="avatar">[$Avatar]</div>
<div class="message">
<div class="metaData">
<span class="username">[$UserName]&#160;&#160;<a

href="Mailto:[$EmailAddress]">[$EmailAddress]</a>
</span>
<span class="time">[$DateCreated]</span>
</div>
<p class="body">[$MessageText]</p>
<ul class="commands">
<li class="ekDeleteMessage">[$DeleteMessageLink]</li>
<li class="ekApproveMessage">[$ApproveMessageLink]</li>
</ul>
</div>
</li>
</ekrepeat>
</ul>
[$AddCommentBox]
</div>
</ekoutput>

[$FirstName]
Displays the first name of the user who left a comment on a message board.
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<ekoutput>
<div class="ContributionForm">
<h4>[$NumberComments] Comments</h4>
<ul>
<ekrepeat>
<li class="ekMessagePost">
<div class="avatar">[$Avatar]</div>
<div class="message">
<div class="metaData">
<span class="username">[$FirstName] [$LastName]</span>
<span class="time">[$DateCreated]</span>
</div>
<p class="body">[$MessageText]</p>
<ul class="commands">
<li class="ekDeleteMessage">[$DeleteMessageLink]</li>
<li class="ekApproveMessage">[$ApproveMessageLink]</li>
</ul>
</div>
</li>
</ekrepeat>
</ul>
[$AddCommentBox]
</div>
</ekoutput>

[$LastName]
Displays the last name of the user who left a comment on a message board.
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<ekoutput>
<div class="ContributionForm">
<h4>[$NumberComments] Comments</h4>
<ul>
<ekrepeat>
<li class="ekMessagePost">
<div class="avatar">[$Avatar]</div>
<div class="message">
<div class="metaData">
<span class="username">[$FirstName] [$LastName]</span>
<span class="time">[$DateCreated]</span>
</div>
<p class="body">[$MessageText]</p>
<ul class="commands">
<li class="ekDeleteMessage">[$DeleteMessageLink]</li>
<li class="ekApproveMessage">[$ApproveMessageLink]</li>
</ul>
</div>
</li>
</ekrepeat>
</ul>
[$AddCommentBox]
</div>
</ekoutput>

[$MessageText]
Displays the text of a message on a message board.
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<ekoutput>
<div class="ContributionForm">
<h4>[$NumberComments] Comments</h4>
<ul>
<ekrepeat>
<li class="ekMessagePost">
<div class="avatar">[$Avatar]</div>
<div class="message">
<div class="metaData">
<span class="username">[$UserName]</span>
<span class="time">[$DateCreated]</span>
</div>
<p class="body">[$MessageText]</p>
<ul class="commands">
<li class="ekDeleteMessage">[$DeleteMessageLink]</li>
<li class="ekApproveMessage">[$ApproveMessageLink]</li>
</ul>
</div>
</li>
</ekrepeat>
</ul>
[$AddCommentBox]
</div>
</ekoutput>

[$NumberComments]
Displays the number of comments posted on the message board.
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<ekoutput>
<div class="ContributionForm">
<h4>[$NumberComments] Comments</h4>
<ul>
<ekrepeat>
<li class="ekMessagePost">
<div class="avatar">[$Avatar]</div>
<div class="message">
<div class="metaData">
<span class="username">[$UserName]</span>
<span class="time">[$DateCreated]</span>
</div>
<p class="body">[$MessageText]</p>
<ul class="commands">
<li class="ekDeleteMessage">[$DeleteMessageLink]</li>
<li class="ekApproveMessage">[$ApproveMessageLink]</li>
</ul>
</div>
</li>
</ekrepeat>
</ul>
[$AddCommentBox]
</div>
</ekoutput>

[$UserName]
Display the Username of a user who left a comment on a message board.

<ekoutput>
<div class="ContributionForm">
<h4>[$NumberComments] Comments</h4>
<ul>
<ekrepeat>
<li class="ekMessagePost">
<div class="avatar">[$Avatar]</div>
<div class="message">
<div class="metaData">
<span class="username">[$UserName]</span>
<span class="time">[$DateCreated]</span>
</div>
<p class="body">[$MessageText]</p>
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<ul class="commands">
<li class="ekDeleteMessage">[$DeleteMessageLink]</li>
<li class="ekApproveMessage">[$ApproveMessageLink]</li>
</ul>
</div>
</li>
</ekrepeat>
</ul>
[$AddCommentBox]
</div>
</ekoutput>

metadatalist.ekml
This file defines which items and information are included when displaying content item

information for a metadata list using the MetadataList server control.

metadatlist.ekml Variables
Below is a list of variables that are used with the metadatalist.ekml file.

Variable Description More Information

[$Comment]
The content’s comment information is

displayed.
"[$Comment]" on page 21-425

[$ContentId] Displays the content item’s ID. "[$ContentId]" on page 21-426

[$DateCreated]
Display the date the

content was created.

"[$DateCreated]" on page 21-

427

[$DateModified]
Display the date the content was last

modified.

"[$DateModified]" on page 21-

427

[$EditorFirstName]
Display the last editor’s first name for a

content item.

"[$EditorFirstName]" on page

21-428

[$EditorLastName]
Display the last editor’s last name for a

content item.

"[$EditorLastName]" on page

21-428

[$FolderId] Display the folder ID of a content item. "[$FolderId]" on page 21-429

[$Html]
Display the HTML contained in the

content item.
"[$Html]" on page 21-429

[$HyperLink]
Adds a hyperlink using the title of the

content block as the text.

"[$HyperLink]" on page 21-

430
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Variable Description More Information

[$Image]

Displays the path for the image defined in a

content item’sMetadata.Whenwrapped in <img

src=””/> tag, the image is displayed.

"[$Image]" on page 21-430

[$ImageIcon]

Displays an image icon for the content

item. For example, if the content item is

HTML, the ( ) icon is displayed.

"[$ImageIcon]" on page 21-

430

[$ImageThumbnail]
Displays the path for the image’s thumbnail

defined in a content item’sMetadata.

"[$ImageThumbnail]" on page

21-431

[$Index]
Serialize the content items in a numbered

list.
"[$Index]" on page 21-431

[$ItemCount] The total number of items in a list.
"[$ItemCount]" on page 21-

432

[$Language]
Display the language ID for the content

item.

"[$Language]" on page 21-

432

[$LinkTarget]

When added to an <a href=””> tag’s

target=”” attribute, this variable reads

the server control’s LinkTarget property

and uses its setting.

"[$LinkTarget]" on page 21-

432

[$QuickLink]

This property displays the Quicklink

information for the content item. When

wrapped in an <a href=””> tag, you can

create a Hyperlink.

"[$QuickLink]" on page 21-433

[$SERVER_NAME]

Displays the server name. For example, If

this variable is applied to

http://www.example.com/demo.aspx, the

return is www.example.com.

"[$SERVER_NAME]" on page

21-434

[$ShowBubble(width)]

This is similar to [$ShowBubble]. It calls

the <ekbubbleinfo> tags and allows you

to set the width of the bubble.

"[$ShowBubble(width,height)]"

on page 21-436

[$ShowBubble]

Calls the <ekbubbleinfo> tags and places

the information contained within those

tags in a pop-up bubble.

"[$ShowBubble]" on page 21-

435

[$ShowContent(‘htmltagid’)]

Calls the <ekcontentinfo> tags an places

the information in those tags within the

specified HTML tag ID. Replace the

'htmltagid' with the ID of the tag.

"[$ShowContent(‘htmltagid’)]"

on page 21-437

Developer Topics

21-468
ReferenceManual

Version 8.0 Rev 1.3



Variable Description More Information

[$Status] Displays the status of a content item. "[$Status]" on page 21-437

[$Teaser]

Display the content item’s summary

information.

Note: If the item is an HTML form, this variable is

not supported with this ekml file.

"[$Teaser]" on page 21-438

[$Title] Displays the content item’s title. "[$Title]" on page 21-438

[$UrlEncode(‘str’)]

Encodes the string information. This

variable can be used to encode another

EkML variable and place it in an email.

"[$UrlEncode(‘str’)]" on page

21-440

[$UrlParam(‘paramname’)]

Displays the value of a QueryString’s

parameter. For example, if the

QueryString is ?id=27 and the variable is

[$UrlParam(‘id’)], 27 is displayed.

"[$UrlParam(‘paramname’)]"

on page 21-439

taxonomy.ekml
This file defines which items and information are included when displaying taxonomy item

information using the Directory server control. Similar to maps.ekml, the taxonomy.ekml works

differently than other .ekml files.

The Directory server control produces multiple areas where content or functionality is defined.

To specify these areas in a template, you would call the <ekoutput> tag with the mode attribute

equaling the area you want to define. For example, in the Directory server control, you can

define information in the breadcrumb area of the server control by using <ekoutput

mode=”breadcrumb”>.

Additional descriptions and commenting in the taxonomy.ekml file will assist you with

learning about EkML with taxonomy. This file is located in <web

root>/CMS400Developer/Workarea/template/taxonomy/taxonomy.ekml.

Taxonomy <ekoutput> modes
The following <ekoutput modes=””> are used with the taxonomy.ekml template.
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EkML Tag Description

<ekoutput

mode=”breadcrumb”>

Defines the display of the breadcrumb portion of the

taxonomy. Within these tags you can define:

n <bctitle> - title for the breadcrumbs

n <bcrootlink> - root link text

n <bcseparator> - separator used to between bread-

crumbs in the breadcrumb trail

n <bchyperlink> - hyperlinks in the breadcrumb trail

n <bcactivelink> - the current active breadcrumb item

<ekoutput

mode=”category”>

Defines how the category information is displayed.

Within these tags you can define:

<ekcolrepeat> takes the category links and spreads

them over the amount of columns that are defined in

the Directory server control's TaxonomyCol property.

This tag must appear within <ekrepeat> tags.

<ekoutput

mode=”categorybacklink”>

Defines information about the link that moves the

category up one level. This can be a text link or an

image link. In this mode, you need to define the

following tags:

n <ekactivebacklink> </ekactivebacklink> -

between these tags, define what appears

when a user is in a sub category. Add the

[$categorybacklink] variable between these

tags and an clickable image appears that

allows a user to navigate one level up.

n <ekdisablebacklink> </ekdisablebacklink> -

between these tags, define what happens

when a user is at the top level category. Add

the [$categorybacklink] variable between

these tags with an <a> tag have users

navigate to another location. For example:
<a href="http://www.example.com" target="_

blank">[$categorybacklink]</a>
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EkML Tag Description

See Also: "[$categorybacklink]" on page 21-473

<ekoutput mode=”article_

search”>
Defines how the search results from the taxonomy

are displayed.

<ekoutput

mode=”article”>
Defines the display of an individual content item in

your taxonomy.

<ekoutput mode=”view”>

This section defines the overall output view of the

Taxonomy. It denotes the locations of the Search

box, Breadcrumb, Category and Articles.

taxonomy.ekml Variables
Below is a list of variables that are used with the taxonomy.ekml file.

Variable Description More Information

[$AddArticle]

Adds a link that allows a logged

in user to add HTML content to

CMS400.NET.

"[$AddArticle]" on page 21-

472

[$AddAsset]
Adds a link that allows a logged in user to

add assets to CMS400.NET.
"[$AddAsset]" on page 21-473

[$categorybacklink]

When place between <ekactivebacklink>

tags, this variable adds a clickable image

that allows a user to navigate up one

category level.

When placed between

<ekdisablebacklink> tags and in the text

area of an <a> tag, this variable adds a

clickable image that allows a user to

navigate to another URL once they reach

the top level category.

categorybacklink

and

"[$categorybacklink]" on page 21-

473

[$CategoryID] The ID of a taxonomy’s category.

[$ContentByteSize]
Displays the content item’s size in KB.

Works only with taxonomy search.
<ekoutput mode=”article_search”>

"[$ContentByteSize]" on page

21-477
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Variable Description More Information

[$ContentId] Displays the content item’s ID. "[$ContentId]" on page 21-426

[$DateCreated] Display the date the content was created.
"[$DateCreated]" on page 21-

427

[$DateModified]
Display the date the content was last

modified.

"[$DateModified]" on page 21-

427

[$EditorFirstName]
Display the last editor’s first name for a

content item.

"[$EditorFirstName]" on page

21-428

[$EditorLastName]
Display the last editor’s last name for a

content item.

"[$EditorLastName]" on page

21-428

[$FolderId] Display the folder ID of a content item. "[$FolderId]" on page 21-429

[$Html]
Display the HTML contained in the content

item.
"[$Html]" on page 21-429

[$HyperLink]
Adds a hyperlink using the title of the

content block as the text.

"[$HyperLink]" on page 21-

430

[$ImageIcon]

Displays an image icon for the content

item type. For example, if the content item

is HTML, the ( ) icon is displayed.

"[$ImageIcon]" on page 21-

430

[$Index]
Serialize the content items in a numbered

list.
"[$Index]" on page 21-431

[$ItemCount] The total number of items in a list.
"[$ItemCount]" on page 21-

432

[$Language]
Display the language ID for the content

item.

"[$Language]" on page 21-

432

[$LinkTarget]

When added to an <a href=””> tag’s

target=”” attribute, this variable reads the

server control’s LinkTarget property and

uses its setting.

"[$LinkTarget]" on page 21-

432
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Variable Description More Information

[$PagingCurrentEndIndex]

The end count number of the items

on the page. For example, if you are

displaying items 11 - 20 on a page, this

variable represents the number 20. Works

only with taxonomy search. <ekoutput
mode=”article_search”>

"[$PagingCurrentEndIndex]"

on page 21-478

[$PagingCurrentStartIndex]

The numerical record of the first item on a

page. For example, if you are displaying

items 1 through 10 out of 50 total items on

a page, this variable represents the

number 1. Works only with taxonomy

search. <ekoutput mode=”article_
search”>

"[$PagingCurrentStartIndex]"

on page 21-479

[$QuickLink]

This property displays the Quicklink

information for the content item. When

wrapped in an <a href=””> tag, you can

create a Hyperlink.

"[$QuickLink]" on page 21-433

[$SearchDuration]

Displays the amount of time, in seconds, it

has taken to execute the search. Works

only with taxonomy search. <ekoutput
mode=”article_search”>

"[$SearchDuration]" on page

21-480

[$SearchSummary]

Creates a summary from information

stored in the indexing service for each item

in the search results. Works only with

taxonomy search. <ekoutput
mode=”article_search”>

"[$SearchSummary]" on page

21-477

[$SearchText]

Displays the text for which a user is

searching. This information is same as

what a user entered in the search text box.

Works only with taxonomy search.
<ekoutput mode=”article_search”>

"[$SearchText]" on page 21-

479

[$SERVER_NAME]

Displays the server name. For example, If

this variable is applied to

http://www.example.com/demo.aspx, the

return is www.example.com.

"[$SERVER_NAME]" on page

21-434

[$ShowAllcategory]

Adds to the Taxonomy search screen a

checkbox that lets the user decide if he

wants to display categories that have no

items.

"[$ShowAllcategory]" on page

21-435
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Variable Description More Information

[$ShowBubble]

Calls the <ekbubbleinfo> tags and places

the information contained within those tags

in a pop-up bubble.

"[$ShowBubble]" on page 21-

435

[$ShowBubble(width)]

This is similar to [$ShowBubble]. It calls the

<ekbubbleinfo> tags and allows you to set

the width of the bubble.

"[$ShowBubble(width,height)]"

on page 21-436

[$ShowBubble(width,height)]

This is similar to [$ShowBubble]. It calls the

<ekbubbleinfo> tags and allows you to set

the width and height of the bubble.

"[$ShowBubble(width,height)]"

on page 21-436

[$ShowContent(‘htmltagid’)]

Calls the <ekcontentinfo> tags an places

the information in those tags within the

specified HTML tag ID. Replace the

'htmltagid' with the ID of the tag.

"[$ShowContent(‘htmltagid’)]"

on page 21-437

[$Status] Displays the status of a content item. "[$Status]" on page 21-437

[$Teaser]

Display the content item’s summary

information.

Note: If the item is an HTML form, this variable is

not supported with this ekml file.

"[$Teaser]" on page 21-438

[$TemplateQuickLink]

This property displays the Template

Quicklink information assigned to the

taxonomy item in the Workarea. When

wrapped in an <a href=””> tag, you can

create a Hyperlink.

See Also: "Applying a Template to a
Taxonomy or Category" on page 9-207

"[$TemplateQuickLink]" on

page 21-473

[$Title] Displays the content item’s title. "[$Title]" on page 21-438

[$UrlEncode(‘str’)]

Encodes the string information. This

variable can be used to encode another

EkML variable and place it in an email.

"[$UrlEncode(‘str’)]" on page

21-440

[$UrlParam(‘paramname’)]

Displays the value of a QueryString’s

parameter. For example, if the QueryString

is ?id=27 and the variable is

[$UrlParam(‘id’)], 27 is displayed.

"[$UrlParam(‘paramname’)]"

on page 21-439
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[$AddArticle]
This variable adds a link that allows a user to add HTML content to CMS400.NET. Clicking

the link opens an editor. When the content is added, it’s automatically added to the taxonomy

category associated with the Directory server control. When you allow users to add content

using this variable, you should set the AddItemFolderID property in the Directory server control

to the folder ID where the content will be stored. This variable should not be added between

the <ekrepeat></ekrepeat> tags. See Also: "AddItemFolderID" on page 9-242

<tr>
<td>
[$AddArticle]
</td>
</tr>

[$AddAsset]
This variable adds a link that allows a user to add assets to CMS400.NET via a drag and drop

box. When the asset is added, it’s automatically added to the taxonomy category associated

with the Directory server control. When you allow users to add assets using this variable, you

should set the AddItemFolderID property in the Directory server control to the folder ID where

the asset will be stored. This variable should not be added between the <ekrepeat></ekrepeat>

tags.See Also: "AddItemFolderID" on page 9-242

<tr>
<td>
[$AddAsset]
</td>
</tr>

[$TemplateQuickLink]
This variable displays the Template Quicklink information assigned to the taxonomy item in the

Workarea. When wrapped in an <a href=””> tag, you can create a Hyperlink.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
<a href="[$TemplateQuickLink]">[Title]</a><br/>[$Teaser]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>
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[$categorybacklink]
When place between <ekactivebacklink> tags, this variable adds a clickable image that allows

a user to navigate up one category level.

When placed between <ekdisablebacklink> tags and in the text area of an <a> tag, this

variable adds a clickable image that allows a user to navigate to another URL once they reach

the top level category. See Also: categorybacklink

<ekoutput mode="categorybacklink">
<ekactivebacklink>
[$categorybacklink]
</ekactivebacklink>
<ekdisablebacklink>
<a href="http://www.example.com" target="_blank">[$categorybacklink]</a>
</ekdisablebacklink>
</ekoutput>

websearch.ekml
This file defines which items and information are included when displaying search results with

the WebSearch server control.

The websearch.ekml template needs two <ekoutput> nodes.

n The first <ekoutput> node formats the results of non-image searches

n The second <ekoutput> node formats results that include images

websearch.ekml Variables
Below is a list of variables that are used with the websearch.ekml file.
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Variable Description More Information

[$ContentByteSize]
Displays the

size of the content item.

"[$ContentByteSize]" on

page 21-477

[$ContentId]

Display the content ID

number assigned to the

content.

"[$ContentId]" on page 21-

426

[$DateModified]

Display the date the

content was last

modified.

"[$DateModified]" on page

21-427

[$EditorFirstName]

Display the last editor’s

first name for a content

item.

"[$EditorFirstName]" on

page 21-428

[$EditorLastName]

Display the last editor’s

last name for a content

item.

"[$EditorLastName]" on

page 21-428

[$Image]

Displays the path for the

image defined in a content

item’sMetadata.When

wrapped in <img src=””/>

tag, the image is displayed.

"[$Image]" on page 21-430

[$ImageIcon]

Used in non-image

searches to display an

image icon for the

content item. For

example, if the content

item is HTML, the ( )
icon is displayed.

"[$ImageIcon]" on page 21-

430

[$ImageThumbnail]

Displays the path for the

image’s thumbnail defined in

a content item’sMetadata.

"[$ImageThumbnail]" on

page 21-431

[$ItemCount]

Displays the total number

of results produced by

the search.

"[$ItemCount]" on page 21-

478

[$LinkTarget]

When added to an <a

href=””> tag’s target=””

attribute, this variable

reads the server control’s

LinkTarget property and

uses its setting.

"[$LinkTarget]" on page 21-

432
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Variable Description More Information

[$PagingCurrentEndIndex]

The end count number of

the items on the page.

For example, if you are

displaying items 11 - 20

on a page, this variable

represents the number

20.

"[$PagingCurrentEndIndex]"

on page 21-478

[$PagingCurrentStartIndex]

The numerical record of

the first item on a page.

For example, if you are

displaying items 1

through 10 out of 50 total

items on a page, this

variable represents the

number 1.

"[$PagingCurrentStartIndex]"

on page 21-479

[$QuickLink]

This property displays

the Quicklink information

for the content item.

When wrapped in an <a

href=””> tag, you can

create a Hyperlink.

"[$QuickLink]" on page 21-

433

[$SearchDuration]

Displays the amount of

time, in seconds, it has

taken to execute the

search.

"[$SearchDuration]" on page

21-480
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Variable Description More Information

[$SearchSummary]

Creates an abstract from

information stored in the

indexing service for each

item in the search results.

Note: The Adobe IFilter,

which is used to generate the

abstract, is only supported in

Tier 1 languages (English,

French, German, and

Japanese). If your Web site

usesother languages, the

abstract maynot be legible. In

such a case, Ektron

recommendssuppressing the

abstract from the search

results.

"[$SearchSummary]" on

page 21-477

[$SearchText]

Displays the text for

which a user is

searching. This

information is same as

what a user entered in

the search text box.

"[$SearchText]" on page 21-

479

[$ShortDateModified]

Displays the date the

content was modified. To

display the date and time

a content item was

modified, use

[$DateModified]

"[$ShortDateModified]" on

page 21-434

[$Title]
Displays the content

item’s title.
"[$Title]" on page 21-438

[$SearchSummary]
Gets the first 300 characters from the body content and creates an abstract.

For content items that do not get indexed, such as images, the SearchSummary uses the image’s

title, summary, and metadata information.
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[$ContentByteSize]
Display the size of the content item in the results list.

[$PagingCurrentEndIndex]
The numerical record of the last item on a page. For example, if you are displaying items 1

through 10 out of 50 total items on a page, this variable represents the number 10.

This variable is typically used in the following context:

Results [$PagingCurrentStartIndex] - [$PagingCurrentEndIndex] of [$ItemCount] for item

[$SearchText] ([$SearchDuration]).
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[$ItemCount]
Displays the total number of results produced by the search.

This variable is typically used in the following context:

Results [$PagingCurrentStartIndex] - [$PagingCurrentEndIndex] of [$ItemCount] for item
[$SearchText] ([$SearchDuration])

.

[$SearchText]
Displays the text for which a user is searching. This information is same as what a user entered

in the search text box.

This variable is typically used in the following context:

Results [$PagingCurrentStartIndex] - [$PagingCurrentEndIndex] of [$ItemCount] for item

[$SearchText] ([$SearchDuration]).
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[$PagingCurrentStartIndex]
The numerical record of the first item on a page. For example, if you are displaying items 1

through 10 out of 50 total items on a page, this variable represents the number 1.

This variable is typically used in the following context:

Results [$PagingCurrentStartIndex] - [$PagingCurrentEndIndex] of [$ItemCount] for item

[$SearchText] ([$SearchDuration]).

[$SearchDuration]
Displays the amount of time, in seconds, it has taken to perform the search.

This variable is typically used in the following context:
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Results [$PagingCurrentStartIndex] - [$PagingCurrentEndIndex] of [$ItemCount] for item

[$SearchText] ([$SearchDuration]).
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Ektron’s Developer SDK

The Developer SDK for Ektron CMS400.NET contains the following components to help you

extend and customize your CMS400.NET site.

n The Developer API which includes:

- Server Control API: An interface for calling the methods and properties of the Ektron

CMS400.NET Server Controls. For additional information on the server controls, see

”Introduction to Ektron CMS400.NET Server Controls” on page 2 and the Developer

API Documentation.

- Web Services API: Exposes a method’s functionality for use with SOAP over HTTP.

For additional information on the Web Services, see ”Web Services” on page 46 and

the Developer API Documentation.

- .NET Assembly API: Similar to the Business API provided in previous version, the

.NET Assembly API provides an interface for calling the methods and properties that

are exposed in Ektron CMS400.NET. See Also: the Developer API Documentation.

- Plug-in Extension API: The Plug-in Extension exposes event hooks in Ektron

CMS400.NET. As a developer, you can utilize these event hooks in Visual Studio C#

or VB.NET to create customized events for your site. See Also: Plug-in Extension
and the Developer API Documentation.

n The Developer API Documentation

The API Documentation contains a detailed description of the functions included in each of

the APIs.

To access the Developer’s API documentation in Visual Studio, click Help >> Contents. Next,

choose Ektron CMS400.NET API Documentation from the list of contents. You can also filter

the documentation so you see only Ektron’s API documentation. Click Ektron API Doc-

umentation in the filter drop down box. You can also access the API documentation online by

clicking here and selecting CMS400.NET API Reference manual (HTML) from the Ektron

CMS400.NET SDK section.

n Plug-in Extension Wizard

The Plug-in Extension exposes event hooks in Ektron CMS400.NET. As a developer, you can

utilize these event hooks in Visual Studio C# or VB.NET to create customized events for your

site. The Plug-in Extension Wizard creates the framework code in Visual Studio to make an

extension. All you need to do is add your custom code to make your events happen. See
Also: Plug-in Extension

n Ektron CMS400.NET Server Controls Toolbox

The Ektron CMS400.NET’s are now install for you when the Developer SDK is installed.

Server controls let you insert, via drag and drop or programmatically, many standard methods

and properties within the Visual Studio environment. This means that you can see the effect of
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your changes in real time -- you don’t have to modify a page then compile a sample project to

see the results. See Also: ”Introduction to Ektron CMS400.NET Server Controls” on page 2

n Ektron Site Setup Wizard

The Ektron Site Setup Wizard allows you to create a site in Visual Studio. This allows you to

easily create additional CMS400.NET sites on your server. The site wizard copies the site file

needed for a working CMS400.NET Min site. In addition, it adds all the necessary permissions,

sets up the database, creates the indexing catalog and creates the asset storage location. See
Also: Using the Ektron Site Setup Wizard

(continued in Installing the Developer SDK)

Installing the Developer SDK
To install the Developer SDK on your Ektron CMS400.NET Server, run the CMS400SDK_

Setup.exe file located in C:\Program Files\Ektron\CMS400v8x\Utilities.

Note: If you installed the CMS400.NET SDKon your server during the initial install, you do not have to install it

again.

If you are installing to a separate client system, copy the CMS400SDK_Setup.exe to that system

and then run it.

Use the steps below to guide you through the install procedure.

1. Run CMS400SDK_Setup.exe.

2. The software is installed and configured.

3. When the SDK setup is complete, click Finish.

(continued in Creating a New Plug-in Extension in Visual Studio)
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Creating a New CMS Extension
Note: In versionsprevious to CMS400.NET version 8.0, developers could use the Plug-in ExtensionWizard to

extend the system.With version 8.0, using CMSExtensions is preferred over the previousPlug-in system.

The following steps explain how to create a new CMS Extension in Visual Studio.

1. In Visual Studio, click File > New > Project...

2. The New Project screen appears.

3. Under Project Type, choose either Visual Basic or Visual C#. (In this example we use

Visual C#.)

4. Under Templates, click Class Library.

5. Fill out the Name, Location and Solution Name text boxes.

6. Click OK.

7. The Class1.cs code page appears in the editor.
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8. Add references to the following assemblies.

Ektron.CMS.Common
Ektron.CMS.ObjectFactory

9. Add the following using statements to the top of the class.

using Ektron.Cms;
using Ektron.Cms.Common;
using Ektron.Cms.Extensibility;
using Ektron.Cms.Extensibility.Content;

10. Update the class to extend Ektron.Cms.Extensibility.ContentStrategy.

namespace Cms.Extensions.Samples
{

public class ContentExtensionsSample : ContentStrategy

{

}

}

Note: The namespace in the code above isCms.Extensions.Samples. This information is

needed for steps12 below.

11. Override the method for the event you wish to catch. In this example, override

OnBeforeAddContent(). The code to modify the Title looks like this.

public override void OnBeforeAddContent(ContentData contentData,

CmsEventArgs eventArgs)
{

contentData.Title += " modified";

}

12. This is what the final code looks like.
using System;
using System.Collections.Generic;
using System.Text;
using Ektron.Cms;
using Ektron.Cms.Common;
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using Ektron.Cms.Extensibility;
using Ektron.Cms.Extensibility.Content;
namespace Cms.Extensions.Samples
{
public class ContentExtensionsSample : ContentStrategy
{
public override void OnBeforeAddContent(ContentData contentData, CmsEventArgs eventArgs)
{
contentData.Title += " modifed";
}
}
}

13. Compile this assembly.

14. Copy the resulting dll into the <webroot>\bin directory

Register the New Extension in the ObjectFactory
After creating the extension in the steps above, register it in the <webroot>/-

ObjectFactory.config file to look like this code.

<objectStrategies>

<add name="Content">

<strategies>

<add name="MyFirstExample"

type="Cms.Extensions.Samples.ContentExtensionsSample,

MySampleExtension"/>

</strategies>

</add>

</objectStrategies>

More information about ObjectFactory
objectStrategies
In order for the CMS to execute the CMS Extension properly, it must be registered in the

objectStrategies section of the ObjectFactory.config file found in the website root.

The node <add name="Content"> tells the CMS that we are defining "Content" extensions.

This is required.

In the <strategies> section, one or more extensions can be added for content.

To add a strategy, two properties must be defined - Name and Type.

1. Name is any unique name which identifies the extension.

2. Type is a fully qualified name of the type you register as the extension. It contains type

name - the NameSpace + type and the assembly name of the type.
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Test the New Extension
The new CMS extension created in the examples above modifies the title of a new content

item by adding the word "modified" to the end of the title.

To test this, create a new content in the workarea of the Website. You will see the new con-

tent title with the word "modifed" appended to the end of it.

More Examples of CMS Extensions
More examples of CMS Extensions are found in the SDK folder of the CMS. The default loca-

tion for this folder is : Program Files\Ektron\CMS400SDK\CMS Extensions. Also,

samples for eCommerce specific extensions are found at Program Files\E-

ktron\CMS400SDK\Commerce\Events.

Plug-in Samples
Ektron provides the following sample code plug-in projects. These projects are located in the

C:\Program Files\Ektron\CMS400SDK\Samples folder. Use the Samples.sln file to launch these

samples in Visual Studio.

n PublishSendAlert

n PublishContentChange

n InstantMessageOnPublish

The PublishSendAlert sample sends an email when new content is published. For example,

you want to be notified if any content is publish on the Web site. See "PublishSendAlert Code

Sample" on page 21-487

The PublishContentChange sample appends content when it is published. For example, you

want to add a signature or copyright information to content when it is published. See

"PublishContentChange Sample" on page 21-488

The InstantMessageOnPublish sample sends an instant message when new content is

published. For example, you want to be notified if any content is publish on the Web site. See

"InstantMessageOnPublish Sample" on page 21-489

The code for each sample appears below.
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PublishSendAlert Code Sample
The following code sample sends an email when new content is publish.

using System;
using System.Collections.Generic;
using System.Text;
using System.Net.Mail;
using System.Net;
using Ektron.Cms.Extensibility;

namespace Ektron.Cms.Extensibility.Samples
{
public class PublishSendAlert : ExtensionEvent
{
public override bool OnAfterPublish()
{
// Declare variables.
bool bReturn = false;
SmtpClient sendClient = null;
MailMessage message = null;
MailAddress from = null;

try
{
// Create connection to mail server and create a new message.
sendClient = new SmtpClient("mail.sample.com", 25);
message = new MailMessage();

// Populate information in the new message.
// TODO: Add from address below
from = new MailAddress("sample_sender@sample.com");

message.From = from;

// TODO: Add all recipients below.
message.To.Add("email@sample.com");
message.To.Add("email2@sample.com");
message.Subject = "Content has been published";
message.Body = "Content published contained the following:\r\n" + Content.Html;

// Send the message.
sendClient.Send(message);

// Set return to success.
bReturn = true;
}
catch (Exception exThrown)
{

// If there was an error, catch it and record the last error message. This is displayed

in the CMS to the end user based upon the method return value and the setup in the

configuration utility. Typically SmtpClient throws an exception if the message could not

be sent.
Content.ErrorMessage = exThrown.Message + exThrown.StackTrace;
bReturn = false;
}
finally
{
// Cleanup
if (message != null)
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{
message.Dispose();
message = null;
}
if (sendClient != null)
{
sendClient = null;
}
}

return bReturn;
}
}
}

PublishContentChange Sample
The following code sample appends HTML content when it is published.

Warning! OnlyHTML content can be appended using the OnBeforePublish event. Assets can not appended and

there is no error message.

using System;
using System.Collections.Generic;
using System.Collections;
using System.Text;
using Ektron.Cms.Extensibility;

namespace Ektron.Cms.Extensibility.Samples
{
public class PublishContentChange : ExtensionEvent
{
private const string S_APPEND = " ****added by PublishContentChange****";

public override bool OnBeforePublish()
{
// Declare variables
bool bReturn = false;
string sLastError = "";
string sTemp = Content.Html;

try
{
//Check content for the last closing paragraph tag. If one exists put additional text

within it. Otherwise just append to end of content.
if (sTemp.Contains("</p>"))
sTemp = sTemp.Insert(Content.Html.LastIndexOf("</p>"), S_APPEND);
else
sTemp += S_APPEND;

// Set content html to our new updated string. This will set it on the CMS side.
Content.Html = sTemp;

// Set return to success.
bReturn = true;
}
catch (Exception exThrown)
{
// If there was an error, catch it and record the last error message. This is displayed

in the CMS to the end user based upon the method return value and the setup in the

configuration utility.
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Content.ErrorMessage = exThrown.Message + exThrown.StackTrace;
bReturn = false;
}

return bReturn;
}

}
}

InstantMessageOnPublish Sample
This sample plug-in sends an instant message (IM) to any designated AIM user. This sample is

made up of various files. To view these files, navigate to the C:\Program

Files\Ektron\CMS400SDK\Samples\InstantMessageOnPublish folder.

Use the following steps when working with this sample.

1. Open the config_info.reg file located in the C:\Program

Files\Ektron\CMS400SDK\Samples\InstantMessageOnPublish folder and edit the

following lines:

- change the SendToUserName

- change the SendFromUserName

- change the SendFromUserPassword

2. Save the file.

3. Double click the config_info.reg to add the information to the registry.

4. In Visual Studio, open the Sample.sln located at: C:\Program
 Files\Ektron\CMS400SDK\Samples

5. Save and build the project.

6. Navigate to the location of your InstantMessageOnPublish plug-in project.

7. From the Bin folder of the plug-in project, copy the newly created DLL to the following

folder on your Ektron CMS400.NET server.
C:\Program Files\Ektron\Plugins\Extensions

Once you have created a plug-in, you can use the Extensibility Configuration Editor to

configure how the plug-in will interact with See Also: "Configuring a Plug-in Extension" on
page 21-490

Manually Creating Plug-in
Framework
If you would like to create a plug-in without using the Plug-in Extension Wizard or you

cannot use the wizard, the following steps explain how to convert a standard DLL to an Ektron
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Plug-in DLL.

1. Create a DLL project skeleton via the VS Class Library wizard.

2. Add a reference to ExtensibilityBase.dll from your current project.

The default install location is: C:\Program Files\Ektron\CMS400SDK

3. Add a using statement for C# or an Imports statement for VB to incorporate the plug-in

namespace.

C#: using Ektron.Cms.Extensibility;

VB: Imports Ektron.Cms.Extensibility

4. Add inheritance to your existing class from ExtensionEvent base class.

C#: public class MyStandardDllClass : ExtensionEvent

VB: Inherits ExtensionEvent

5. Hook the events you want to implement by using intellisense to choose the event. Type:

C#: public override

VB: Public Overrides

6. If the plug-in is to return a status other then True, remove the return line generated by

visual studio and return your own status:

C#: return base.<Overrided_Method_Name>();

VB: Return MyBase.<Overrided_Method_Name>()

Once you have created a plug-in, you can use the Extensibility Configuration Editor to

configure how the plug-in will interact with CMS400.NET. See Also: "Configuring a Plug-in
Extension" on page 21-490

Configuring a Plug-in Extension
Once you have created a Plug-in Extension, the Extensibility Configuration Editor allows you

to:

n prioritize plug-ins and events

n enable or disable them

n assign them to a specific site when using multiple sites with CMS400.NET

n see a description of the plug-in or event

n see who created a plug-in or event

By prioritizing the plug-ins and events you can set the order of execution for events of the

same type that appear in multiple plug-ins. See Also: "Setting the Plug-in Order of

Execution by Event" on page 21-501
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Enabling and disabling plug-ins allows you to temporarily disable a plug-in or event without

disabling the rest of the plug-ins and events. See Also: "Enabling and Disabling Plug-ins and

Events" on page 21-500

If you are using the Multi-site support in CMS400.NET, you can assign a plug-in or event to a

specific site. This allows you to build a Plug-in that might be used in multiple sites, but

contain an event that you only want applied to a single site. See Also: "Applying Plug-ins

and Events to Specific Sites" on page 21-497

The Extensibility Configuration Editor exists on your CMS400.NET server. For the editor to

work with an Extension Plug-in, the plug-in needs to be in the watch folder C:\Program

 Files\Ektron\Plugins\Extensions located on the Ektron CMS400.NET server.

Opening the Extensibility Configuration Editor
To view Plug-in Extensions in the Extensibility Configuration Editor, click Start > Programs

> CMS400 > Utilities > Plug-in Configuration on your CMS400.NET server. You can also

access the editor using the ConfigurationUtility.exe file located in: C:\Program

 Files\Ektron\CMS400SDK.

Viewing Plug-in Extensions in the Extensibility
Configuration Editor
The Extension Plug-ins in the Extensibility Configuration Editor are displayed in a Tree format

that enables you to show or hide each branch of the tree.

You can view the plug-in Extensions by Assembly or by Event Handler. When viewing by

Assembly, you see each Plug-in Extension with all of the events for that extension nested

below it.
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When viewing by Event Handler, you see each event with all of the Plug-in Extensions it

belongs to nested below it.

The Extensibility Configuration Editor’s Toolbar
The plug-in toolbar allows you to Save settings, Refresh, Start and Stop, and Reorder plug-ins

and events.

The table below shows each toolbar button and its description.

Command Button Description See Also

Save
Saves the changesmade in the

editor.

Refresh

Refreshes the editor and displays

anynew plug-ins that are added

to the Extensions folder.

Move Event

Up

Movesan event to a higher priority

whenmultiple events of the same

type are used.

"Setting the

Plug-in Order

of Execution

byEvent" on

page 21-501
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Command Button Description See Also

Move Event

Down

Movesan event to a lower priority

whenmultiple events of the same

type are used.

"Setting the

Plug-in Order

of Execution

byEvent" on

page 21-501

Disable

Selected

Event

Stops the event or plug-in from

running.

"Enabling

and Disabling

Plug-ins and

Events" on

page 21-500

Enable

Selected

Event

Starts the event or plug-in.

"Enabling

and Disabling

Plug-ins and

Events" on

page 21-500

Help Launcheshelp information.

Close Editor Exits the editor.

Setting Plug-in Extension and Event Properties
When using the Assembly view, you can set properties at the Assemblies level, the Plug-in

Extension level or at the event level. When using the Event Handler view, you can set

properties at the Event Handler level, the Event level or the Plug-in Extension level. The table

below explains the different levels.

Level Where the Level Appears in the Editor

Assembly View
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Level Where the Level Appears in the Editor

Assemblies - All plug-ins and events below this

level use the properties applied to this level.

Plug-in Extension - The plug-in you choose and

all the events associated with that plug-in use the

same properties.

Event - Properties are assigned to each individual

event.

Event Handler View

Configuring a Plug-in Extension

ReferenceManual

Version 8.0 Rev 1.3
21-497



Level Where the Level Appears in the Editor

Event Handler - All events and plug-ins

below this level use the properties applied

to this level.

Event - The event you choose and all the

plug-ins associated with that event use the

same properties.

Plug-in Extension - Properties are

assigned to each plug-in.
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Property List
The following table lists the properties contained in the Extensibility Configuration Editor.

Property Description See Also

Sites

ThisPlug-in

Applies to:

Choose the sites to which this plug-in or event applies. You

need only choose a site if you are usingMulti-site support.

"Applying

Plug-ins and

Events to

SpecificSites"

on page 21-

497

and

”Multi-Site

Support” on

page 2774

Recovery

If there is an

unhandled

error or false is

returned from

a plug-in, I

would like to:

Choose what happenswhen there is an unhandled error.

"Determining

What

Happens

After an Error

Occurs" on

page 21-499

Name
The name of the plug-in or event is displayed. This property

is set in the plug-in’s code.

"Setting the

Information

Properties in

the Plug-in

Code" on

page 21-499

Author
The author of the plug-in or event. This property is set in the

plug-in’s code.

"Setting the

Information

Properties in

the Plug-in

Code" on

page 21-499

Organization
The organization or company that created the plug-in or

event. This property is set in the Plug-in’s code.

"Setting the

Information

Properties in

the Plug-in

Code" on

page 21-499
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Property Description See Also

Status
Decide whether plug-ins and events are enabled or

disable.

"Enabling and

Disabling

Plug-ins and

Events" on

page 21-500

Order

Decide the order of execution for events of the same type

that appear in multiple plug-ins. For example, if the

OnBeforeContentAdd event appears in

EktronExtDLL5.EventExt1 and EktronExtDLL2.EventExt1,

you can choose which plug-in’s event is executed first.

"Setting the

Plug-in Order

of Execution

byEvent" on

page 21-501

Applying Plug-ins and Events to Specific Sites
If you are using the Multi-site Support feature in CMS400.NET, you may find it necessary to

apply a plug-in or event to one site and not another. To accomplish this, use the Sites property.

It allows you to assign events and plug-ins to all the sites on a server or to select sites on the

server. For example, you are appending HTML content by applying a company’s copyright

information to a site and you are supporting multiple sites with CMS400.NET.

To apply a plug-in or event to a specific site, follow these steps.

1. Open the Ektron Extensibility Configuration Editor by clicking Start > Programs >

CMS400 > Utilities > Plug-in Configuration.

2. Click the plug-in or event in the menu tree.

3. Under the Sites property, select either All Sites on This Computer or Choose radio

buttons. The first time you select the Choose radio button, the Site Chooser screen appears.
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Note: If the Site Chooser screen doesnot appear when you click theChoose radio button, click theChoose

hyperlinknext to the radio button.

4. Highlight the sites in the Available Sites column to which the plug-in or event will be

assigned.

5. Click the > button to move the selected sites to the Chosen Sites column. Click >> to

move all of the sites. To remove a selection from the Chosen Sites column, highlight it

and click the < button. To remove all selections, click the << button.

6. Click OK.

7. The chosen sites appear in the text box.

8. Click Apply.

9. Click the Save ( ) button.

Determining What Happens After an Error Occurs
The Recovery property allows you to decide how to handle errors that arise when utilizing

plug-ins and events. For this property there are two choices:

n Halt Current CMS Operation - in the event of an unhandled error, this selection stops

the current operation completely. For example, if you publish a piece of content and the

OnBeforePublish event has an unhandled error, the content is not published and the error

message associated with the action is displayed.
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n Continue Current CMS Operation - when this option is selected, the choices below are

available.

- Continue On to the Next Event - in the event of an unhandled error, the process moves

to the next event. For example, if you had three plug-ins that contained the

OnBeforePublish event and it failed in the first instance, the process would then move

on to the next OnBeforePublish event.

- Cancel Impending Events - in the event of an unhandled error, the process cancels all

impending occurrences of the event. For example, if you had three plug-ins that

contained the OnBeforePublish event and it failed in the first instance, all subsequent

OnBeforePublish events are canceled.

To apply the Recovery property to a Plug-in or Event, follow these steps.

1. Open the Ektron Extensibility Configuration Editor by clicking Start > Programs >

CMS400 > Utilities > Plug-in Configuration.

2. Click the plug-in or event in the menu tree.

3. Under the Recovery property, select the Halt Current CMS Operation or Continue

Current CMS Operation radio button.

4. If you select Continue Current CMS Operation, select Continue On to the Next Event or

Cancel Impending Events radio button. Otherwise, continue to the next step.

5. Click Apply.

6. Click the Save ( ) button.

Setting the Information Properties in the Plug-in Code
You can add Author, Organization and Description information to your plug-in code. This

helps you identify who wrote the plug-in and what it does. This information can be assigned at

the assembly level (the plug-in) or the method level (the event). The method level attributes

override the attributes assigned at the assembly level.

You assign assembly level attributes in the AssemblyInfo.cs or AssemblyInfo.vb depending on

the language you are using. Method level attributes are assigned in the plug-in code above the

method. The example below is at the method level using C#:

[ExtensionAuthor("John Smith")]

[ExtensionDescription("Appends text to the html")]

public override bool OnBeforePublish()

The following table shows more syntax examples for C# and VB.
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Example

Type
Language Example

Method

Level
C#

[ExtensionAuthor("John Smith")]

[ExtensionDescription("Appends text to the

html")]

public override bool OnBeforePublish()

Assembly

Level
C#

[assembly: AssemblyDescription("Assembly Level

Description")]

[assembly:

Ektron.Cms.Extensibility.ExtensionAuthor("John

Smith")]

[assembly: AssemblyCompany("Ektron Company

Extension")]

Method

Level
VB

<ExtensionAuthor(“John Smith”)> _

<ExtensionDescription(“Before Content Add Description”)> _

PublicOverridesFunction OnBeforeContentAdd() AsBoolean

Note: The continue character “_” must be used at the end of

each description line.

Assembly

Level
VB

<Assembly: AssemblyDescription(“Assembly Level

Description”)>

<Assembly:

Ektron.Cms.Extensibility.ExtensionAuthor(“John

Smith”)>

<Assembly: AssemblyCompany(“Ektron Company

Extension”)>

Enabling and Disabling Plug-ins and Events

Plug-ins and events are enabled and disable using the Enable Events ( ) and Disable Events

( ) buttons. You can enable or disable single events by clicking on the event and then
clicking the Enable or Disable button.

If you want to enable or disable all the events in a plug-in, click on the plug-in while in the

Assemblies view. Next, click the Enable or Disable button. To enable or disable all of the

events of the same type, click on the event while in the Event Handler view. Next, click the

Enable or Disable button.

When events are enabled, their puzzle icon is green. If they are disabled, their puzzle icon is

red. Plug-ins and events are enabled by default.
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Setting the Plug-in Order of Execution by Event
Setting the plug-in execution order allows you to control when events of the same type are

executed. For example, if you have three OnBeforePublish events in three separate plug-ins,

you can decide which OnBeforePublish event happens first, second and third.

The order of events can only be set in Event Handler view. This way you see the plug-ins

sorted by event. To change the plug-in execution order, click a plug-in and use the Event Up (

) or Event Down ( ) button to reorder plug-ins.

In the before and after example below, the EktronExtensionDll2.EventExtension1 has been

move to order position 1 (one) for the OnBeforeFolderAdd event.

Before:

After:
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Connecting to the Web Service API
From a Plug-in
You can connect to the Web Service API from a plug-in by using a Web service proxy.

Calling a Web service proxy accessor creates a connection to a particular Web service. For

example, using the GetContentProxy() creates a connection to the Web Service API

Content.asmx.

When using the Web service proxy, the Web service connects to the site that produced the

event. For example, if you have three sites and site two uses a plug-in with the

OnBeforePublish event that calls a Web service, the Web service connects back to site two

only.

Because the Plug-in Architecture and CMS400.NET run on the same server, no authentication

is needed when making a Web Service API call. Once a connection is made, you can call any

Web service method that is available. For information on Web service methods, click Help >

Contents > Ektron CMS400.NET API Documentation > Ektron Namespace > Web Services

API.

Below is a list of available Web service proxies.

Note: In theWeb Service Connection column, the ... refers to/<site

webroot>/Workarea/webservices/WebServiceAPI

Proxy Accessor Returns Web Service Connection

GetActiveDirectoryUserProxy() ActiveDirectoryUserProxy …/User/ActiveDirectoryUser.asxm
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Proxy Accessor Returns Web Service Connection

GetAssetProxy() AssetProxy .../Content/Assest.asmx

GetBlogProxy() BlogProxy .../Content/Blog.asmx

GetBusinessRulesProxy() BusinessRulesProxy …/BusinessRules.asmx

GetCalendarEventTypeProxy() CalendarEventTypeProxy .../Calendar/CalendarEventType.asmx

GetCalendarProxy() CalendarProxy …/Calendar/Calendar.asmx

GetContentProxy() ContentProxy .../Content/Content.asmx

GetCustomFieldsProxy() CustomFieldsProxy .../CustomFields.asmx

GetFolderProxy() FolderProxy .../Folder.asmx

GetFontProxy() FontProxy .../Font.asmx

GetFormProxy() FormProxy .../Content/Form.asmx

GetLibraryProxy() LibraryProxy .../Library.asmx

GetMetadataProxy() MetadataProxy .../Metadata.asmx

GetPermissionsProxy () PermissionsProxy .../Permissions.asmx

GetSearchManagerProxy() SearchManagerProxy .../Search/SearchManager.asmx

GetSiteMapProxy() SiteMapProxy .../SiteMap.asmx

GetSiteProxy() SiteProxy .../Site.asmx

GetTaskProxy() TaskProxy .../Task.asmx

GetTaskCategoryProxy() TaskCategoryProxy .../Task/TaskCategory.asmx

GetTaskCategoryTypeProxy() TaskCategoryTypeProxy .../Task/TaskCategoryType.asmx

GetThreadedDiscussionProxy() ThreadedDiscussionProxy .../Content/ThreadedDiscussion.asmx

GetUserProxy() UserProxy .../User/User.asmx
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Debugging a Plug-in
When a Plug-in Extension is not working, it is necessary to debug it. The sections explain

how to debug a C# plug-in or a VB plug-in.

n "Debugging a C# Plug-in Extension" on page 21-505

n "Debugging a VB Plug-in Extension" on page 21-510

Note: You should only debug a plug-in on a non-productionmachine. Real-time plug-in updatesare disabled

when debugging takesplace. For example, deleting or replacing a plug-in that’s in the watch directory is not

supported while in debugmode.

Debugging a C# Plug-in Extension

Steps

1. Navigate toStart >Control Panel >Administrative Tools >Services and stop the

Ektron ExtensibilityServer.

2. Run Regedit by clickingStart >Run and typing regedit in the Open text box. Next, clickOK.
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Steps

3. Change the entryHKEY_LOCAL_

MACHINE\SOFTWARE\Ektron\CMS400\Extensions\Debug to 1. Use either Hexadecimal

or Decimal.

4. In Visual Studio, right click on the project in the Solution Explorer and

select properties. Next, click the Build tab change the Output path of the

plug-in so it builds in the service directory. This is the directory that has

the ExtensionService.exe in it. The default install location is C:\Program

 Files\Ektron\Plugins\Service\.

5. Copy the built plug-in to the watch folder via the Post-build step on the

Build Events settings page. The default install location is C:\Program
Files\Ektron\Plugins\Extensions.
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Steps

6. On the Debug tab, change Configuration to “Debug” and build the plug-in.

7. Start the Ektron Extensibility server.

8. In Visual Studio, click Debug > Attach to Process or Ctrl+Shift+R. Next,

click the ExtensionService.exe process, then click the Attach button.

Warning! Important: If you do not see the ExtensionService.exe, make sure thatShow proc-

essesfrom all users

andShow processes in all sessions are checked.
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Steps

9. Set the breakpoint(s) in the plug-in where debugging is to take place.

10. Execute the action within the CMS to trigger the event. For the example

breakpoint below, publish a piece of content. The breakpoint is hit as

shown below.
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Debugging a VB Plug-in Extension

Steps

1. Navigate toStart >Control Panel >Administrative Tools >Services and stop the

Ektron ExtensibilityServer.

2. Run Regedit by clickingStart >Run and typing regedit in the Open text box. Next, clickOK.

3. Change the entryHKEY_LOCAL_

MACHINE\SOFTWARE\Ektron\CMS400\Extensions\Debug to 1. Use either Hexadecimal

or Decimal.

4. In Visual Studio, right click on the project in the Solution Explorer and

select Properties. Next, click the Compile tab change the Build Output
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Steps

path of the plug-in so it builds in the service directory. This is the directory

that has the ExtensionService.exe in it. The default install location is

C:\Program Files\Ektron\Plugins\Service\.

5. Copy the built plug-in to the watch folder via the Post-Build event. On the

Compile tab, click the Build Events... button. Next, click the Edit Post-

build... button. Enter the following information and click OK.
copy $(TargetFileName) "C:\Program

Files\Ektron\Plugins\Extensions\$(TargetFileName)

Developer Topics

21-512
ReferenceManual

Version 8.0 Rev 1.3



Steps

6. On the Debug tab, change Configuration to “Debug” and build the plug-

in.

7. Start the Ektron Extensibility Server.
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Steps

8. In Visual Studio, click Debug > Attach to Process or Ctrl+Shift+R. Next,

click the ExtensionService.exe process, then click the Attach button.

Warning! Important: If you do not see the ExtensionService.exe, make sure thatShow proc-

essesfrom all users

andShow processes in all sessions are checked.

9. Set the breakpoint(s) in the plug-in where debugging is to take place.
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Steps

10. Execute the action within the CMS to trigger the event. For the example

breakpoint below, publish a piece of content. The breakpoint is hit as

shown below.
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Using the Search Engine
Optimization (SEO) Control

Ektron CMS400.NET offers a wide array of tools to ensure your Web site is optimized for

search engines, and that your Web pages climb to the top of the ranks. Among these is an SEO

Page Analysis Tool that gives you the key information you need in “real-time” in order to

maximize your returns in organic Web searches.

This SEO tool analyzes the pages of your Web site for W3C compliance, what information

Google has about the page, Alexa rankings, image alt text, keyword density and metadata. The

tool lets you know how (and if) you’ve set these values.

This chapter explains how to use the SEO control.

Appearance of the SEO Control
The Search Engine Optimization (SEO) Control appears as an image on any template or master

page on which you drop it, as circled below.
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When a logged-in user clicks the image, he sees a detailed report of how search engines

evaluate the page. For example, the report runs the page through a W3C validation site, or

displays how search engines evaluate the page's text.

Installing the SEO Control
You can only install the SEO control onto pages within an Ektron CMS400.NET Web site.

This is because the CMS contains files required by the control.

1. Open C:\Program Files\Ektron\CMS400v80\CommonFiles\StarterApps\.

Note: If you don't see an SEO folder within StarterApps, your version doesn't support the SEOcontrol.

2. From the StarterApps folder, copy the SEO folder to the root folder of the Web site in

which you want to use the control.

3. Open Visual Studio.

4. Open your Web site.

5. Open a master page or template on which you want to place the SEO control.

6. Open Solution Explorer, and your web site within it.

7. Open the SEO folder.
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8. Drag the SEO control (seo_w3c.ascx) on to an area of the page.

9. Save the page.

Viewing a Web Page's SEO Report
Only logged in CMS or Membership users can see the SEO control.The following summarizes

the information on the SEO Report.

Tab Description

SEO
Compares viewed page against a basicSEOchecklist, such

as if keywordsare included, language and charset values, etc.

Google
Information that search engineshave about your page, including pages that link to it,

indexed pageson the site and what the page looks like on amobile device.

W3C

ValidatesWeb page for markup and CSS compliance, and also checks for broken

links and the ability of the page to be displayed onmobile devices. Byhaving correct

markup that conforms to HTML or XHTML standards, search engineswill detect

wordsand phrases correctly, a keyelement in SEO.

Correct markup also ensures that search engine spiders can easily understand the

content and navigation on the page. Proper code willmake it easier for spiders to

parse asexpected and digest the content for organic search engines.

Alexa
Alexa is a leader in providing insight on the overall ranking of your web site on the

Internet. Alexa overview, traffic, related and linked-to sites.

Images
To ensure SEOand compliance, all imageson your pages should contain alt tags.

This enables searching of the images (since engines cannot read the contents of an
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Tab Description

image). In addition, alt tagsmust be used for 508 compliance. This tab identifies all

imagesand their alt tags.

Text

A keyword density analysis report displays text graphically in much the sameway that

organic search engines see your page.Web pages that are content rich typically yield

higher search engine rankings than pages that aremainly imagesor multimedia

based. This report displayswords, two-word phrasesand three-word phrases in a

cloud format, revealing wordsand phrases that show upmost often on the page. This

information helps you to optimize your content and reach your target audience.

Meta The page'smetadata

Misc Additional search information
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Learning About Visual Studio

This section provides background information about Microsoft’s Visual Studio. For more

information, use the help feature installed with Visual Studio and Microsoft’s developer Center

(http://msdn.microsoft.com/vstudio/).

Grid Layout vs. Flow Layout

Note: The following definitionsare fromVisualStudio Help:

Grid Layout - Absolute positioning attributes are inserted into elements that are added, and

updated in elements that are moved. Elements can be dragged across the Design view surface.

The positioning grid and Snap to Grid are available.

Flow Layout - Elements are added without absolute positioning attributes. Web browsers

arrange elements in the order that they occur on the page, from top to bottom. You cannot drag

elements across the Design view surface or use the positioning grid.

Grid layout is the default, which means that all controls drawn to the Web form in the designer

window will have absolute positioning. Here is an example.

<body MS_POSITIONING="GridLayout">
 <form id="Form1" method="post" runat="server">
 <asp:Button id="Button1" style="Z-INDEX: 101; LEFT: 160px; POSITION: absolute; TOP:

80px" runat="server" Text="Button"></asp:Button>
 <asp:Button id="Button2" style="Z-INDEX: 102; LEFT: 480px; POSITION: absolute; TOP:

88px" runat="server" Text="Button"></asp:Button>
 <asp:GridView id="GridView1" style="Z-INDEX: 103; LEFT: 208px; POSITION: absolute;

TOP: 152px" runat="server"></asp:GridView>
 </form>

</body>

In Grid layout, you can position your controls like a WYSIWYG editor with no knowledge of

HTML. However, because absolute positioning is not rendered consistently by all browsers, the

page layout can be flexible based on the size of other controls on the page, and the Web

browser window.

When other controls are dynamically populated, such as a GridView, controls that appear

beneath it in the Web form would be obscured if they were positioned absolutely at design

time. In addition, when utilizing globalization of pages with different languages, the size of

text areas can vary and cause obstructions.
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approval chain, editing 5-34
approval process 5-37
archiving see archiving 7-198
assigning permissions 5-51
automatic notification of activity 1-86
awaiting approval 4-4
border
hiding and showing 7-6

checked in, definition 7-135
checked out, definition 7-137
comparing, see comparing

content

7-120, 7-

122
copying 7-113
creating 7-15
declining 5-36
deleting 7-130
difference
view, button, floating toolbar 7-5
viewing 7-120, 7-122

editing 7-105
end date, setting 7-197
history
accessing fromWeb page 7-109, 7-

118
accessing viaWorkarea 7-110, 7-

117
moving 7-113
one content block 7-114
several blocksat once 7-115

multi-language seemulti-language

content

14-

1
pending start date 7-139

previous version, viewing 7-117
private 7-191
properties 7-13
publish see publish 5-36
purging historical versions 5-21
rating feature 7-729
limiting visitors to one rating 7-730

reports 7-702
checked in content 7-712
checked out content 7-713
content pending start date 7-716
content to expire 7-719
expired content 7-718
new content 7-714
refresh reminder 7-717
submitted content 7-715

restoring previous version 7-117
review feature
inserting server control 7-730

scheduling 7-195
see also content block [content
aaa] 7-142, 7-143, 7-143, 7-

144, 7-145
start date, setting 7-195
statuses 7-133
approved 7-133

submitted, definition 7-138
summary see sum-

mary

7-142, 7-143, 7-143,

7-144, 7-145
template, assigning 7-190
to expire report 7-719
translating 7-112
types 2-3
viewing 7-9
Workarea search 9-87

content block
ASP 21-251
dynamic 21-254
dynamic and static 21-257
examples 21-253
static 21-253

ASP.Net 7-201
examples
dynamic content 7-203
static content 7-202

ColdFusion 21-328
examples
dynamic content 21-329
static content 21-329

format 21-328, 21-328, 21-330,

21-330, 21-339
definition 2-2, 2-3, 7-3
editing
overview 2-5, 2-5

finding 7-105
lifecycle 2-5
PHP 21-349
examples
dynamic content 21-350
static content 21-350

format 21-349, 21-349
see also content [content block
aaa] 7-142, 7-143, 7-143, 7-

144, 7-145
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control panel
discussion boards 7-658

copy content 7-113
countries, eCommerce 17-47
country tax table, eCommerce 17-103
coupons, eCommerce 17-225
creating
document, document man-

agement feature

7-

437
creating custom appli-

cationAPI.php

21-

367
credit card types, eCommerce 17-77
cross sell items, eCommerce 17-188
currencies, eCommerce 17-53
currency, default, eCommerce 17-55
customASP functions
collection 21-293, 21-298, 21-300
examples 21-294
ecmNavigation 21-294
ecmTeaser 21-295

variables 21-296
display function 21-297
id 21-296

content block 21-251
dynamic 21-254
dynamic and static 21-257
examples 21-253
static 21-253

list summary 21-274, 21-285, 21-289,

21-334, 21-353
example 21-275, 21-290
variables 21-276, 21-291
maxnumber 21-280, 21-293
order by 21-278, 21-292
recursive 21-277, 21-292
show info 21-279
show summary 21-277
starting folder 21-276, 21-291
style info 21-277

login 21-249
example 21-250
placing 21-250

metadata 21-311
creating item list 21-311
dynamic 21-314
example 21-312
format 21-311
variables 21-314
item list 21-314
spare 21-316

search 21-261
examples 21-263
variables 21-264
button image source 21-266
button text 21-267
font color 21-268
font face 21-267
font size 21-268
horizontal 21-269
maximum characters 21-266
spare1 21-270
starting folder 21-264
target page 21-265
text box 21-265

search display 21-270
example 21-270
variables 21-271
max returns 21-271
show date 21-273
style info 21-272

with default content 21-271
single summary 21-286
example 21-286
variables 21-287
content id 21-287
show info 21-288
show summary 21-287
spare 21-289
style info 21-287

customASP.Net func-

tions

21-238, 21-

239
collection 9-118
examples
ecmNavigation 9-124
ecmTeaser 9-124

content block 7-201
examples
dynamic content 7-203
static content 7-202

list summary 9-270
login 3-6
placing 3-6

membership 16-24
search 9-68

customColdFusion functions 21-325
collection 21-335, 21-338
examples
ecmNavigation 21-335
ecmTeaser 21-336

format 21-335, 21-338, 21-344
variables 21-337
display function 21-338

content block 21-328
examples
dynamic content 21-329
static content 21-329

format 21-328, 21-328, 21-

330, 21-330, 21-339
list summary 21-332, 21-333
example 21-332, 21-333, 21-333
format 21-332, 21-333

login 21-328
example 21-328

metadata 21-340
format 21-340

search 21-331
example 21-331
format 21-331

single summary 21-334
example 21-334
format 21-334

customPHP functions 21-345
collection 21-355
examples 21-355
ecmNavigation 21-355
ecmTeaser 21-357

format 21-355
variables 21-358
display function 21-358

content block 21-349
examples
dynamic content 21-350
static content 21-350

format 21-349, 21-349
creating customAPI 21-367
include file 21-345
list summary 21-353
example 21-353
format 21-353

login 21-348
example 21-349

metadata 21-362
format 21-362

search 21-351
example 21-352, 21-352
format 21-351

search display 21-352
format 21-352

single summary 21-354
example 21-354, 21-385
format 21-354

custom user properties
adding 15-14
changing order 15-24
deleting 15-24
editing 15-23
input field types 15-18
overview 15-12
validation 15-18
with non-English languages 15-26

custom validation, data

designer

7-240, 7-

371

D

data design package
editing 7-383

data designer
calculated field 7-332
calendar field 7-341
checkbox field 7-322
choices field 7-327
custom validation 7-240, 7-371
deleting a field from screen 7-299
field types 7-297
File LinkField 7-346
group box field 7-308
image only field 7-344
invalid documents, saving 7-694
plain text field 7-323
validation
defining 7-691
defining calculation 7-689
defining custom 7-691
defining error message 7-691
defining schema fragment 7-688
treeImg attribute 7-688

walkthrough of screen design 7-302
decline
content
from approval report 7-711
from publishing 5-36

one content item 5-35
several content blocks 5-36



default application language, setup

information

19-

5
delete
button, floating toolbar 7-5

deleting
content 7-130

Detect All field, eWebDiff 7-125
difference
content
view, toolbar button 7-5

discussion boards
category
creating 7-607
editing 7-607

changing page size 7-606
control panel 7-658, 7-659
deleting a privatemessage 7-660
viewing user profile 7-661

creating 7-601
deleting 7-606
editing 7-606
elements
hierarchy 7-597

forums
creating 7-609
deleting 7-611
editing 7-611
inserting server control 7-645
locking 7-611
moderating from control panel 7-

662
outputting asRSS 7-656
ranking users 7-612

implementing 7-600
locking 7-603
overview 7-596
permissions
assigning 7-636
editing users and user groups 7-

641
for membership users 7-639
granting to users and user

groups

7-

640
initialization of 7-637
list of 7-638
revoking for users and user

groups

7-

641
post reporting
setting up 7-635

posts
adding a reply 7-623
approving 7-624
attaching imagesand files 7-626
deleting 7-625
editing 7-625
replacing words 7-628
replying to 7-623
searching 7-627

privatemessage 7-658
deleting 7-660

restricting IP address 7-634
searching 7-627
sort order 7-607

subscriptions
deleting 7-657
reviewing 7-657
submitting 7-656

taxonomy, assigning 7-603
termsand conditions 7-608
topics
adding to forum 7-616
approving 7-622
deleting 7-622
editing title 7-621
locking 7-619
overview 7-616
priority, announcement 7-618
priority, normal 7-619
priority, setting 7-618
priority, sticky 7-619
sorting 7-647
viewing 7-620

user profile, contents 7-654
user profile, suppression byadmin-

istrators

7-

655
user profile, suppression byusers 7-

655
viewing 7-605
Web site
adding video to a post 7-652
approving 7-646, 7-649
deleting a topic 7-647
deleting post 7-650
editing post 7-649
posting a reply 7-648
quoting a post 7-648
reporting a post 7-650
suppressing user infor-

mation

7-646, 7-

653
using on 7-646

display button text in title bar 19-9
distribute option 16-261
DMSDocument Option 7-417
DoNot Force All Approvers 5-42
document
creating, document management

feature

7-

437
importing into DMS 7-415

document management feature
adding documents to collections 7-

440
adding documents tomenus 7-440
approving file 7-440
asset management configuration 7-

441
browser requirements 7-410
creatingmanaged file 7-437
document types 7-409
file types 7-409, 7-443
importing document 7-415
introduction 7-408
managed files 7-435
Office document, editing 7-427
overview 7-408
PDF generation
enabling/disabling 7-456
local 7-455

permissions 7-444
reports 7-440
reports of document by status 7-440
security 7-410
software requirements 7-410
workflow 7-439

Document Management System
Firefox plugin 7-411

drag and drop
DMSdocuments 7-419

Dreamweaver
configuring for CMS100 21-51
extension
using 21-61

requirements 21-46
support 21-46

Dublin Coremetadata 7-154
dynamic and static content block
ASP 21-257

dynamic content block
ASP 21-254

E

eCommerce
analytics 17-188
bundles 17-116
catalog entries
archiving 17-138
attributes 17-144
buyable 17-138
comment 17-136
content 17-136
creating/updating 17-130
deleting 17-131
dimensions 17-139
inventory adjustments 17-139
in stock 17-139
on order 17-139
pricing 17-140
reorder level 17-139

items
entering 17-149

media 17-146
overview 17-128
pricing
list price 17-141
non-default currency 17-141
salesprice 17-141
tier 17-142
tier, for non-default currency 17-

143
properties 17-137
SKU code 17-138
summary 17-137
tangible item 17-139
tax class 17-138
template 17-136
thumbnail size 17-148
thumbnails 17-146

catalog folders
assigning product type 17-127
deleting 17-128
overview 17-126

complexproduct 17-117
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countries 17-47
country tax table
deleting 17-105
editing 17-104
overview 17-103

coupons
creating 17-225
discount 17-227
eligible catalog entries 17-231
minimum order amount 17-230
overview 17-225
start/end dates 17-230

credit card types
creating 17-78
deleting 17-80
editing 17-80
introduction 17-77
where used 17-78

cross sell items 17-188
currencies 17-53
deleting 17-59
editing 17-58
enabled 17-54
installed 17-54

currency
default 17-55

customer information
address 17-212
overview 17-211
shopping cart 17-213

exchange rate
effect on item’s price 17-57
updating 17-57

kits 17-113
messages
creating 17-83
editing 17-83
how created 17-82
overview 17-81
variables 17-83

orders
cancelling 17-202
capturing 17-200
marking fraud 17-203
overview 17-197
statuses 17-198
tracking number 17-202
view screen 17-199

packages
creating 17-88
deleting 17-89
editing 17-89
how used 17-88
introduction 17-87

payment gateway
creating 17-72
default 17-72
deleting 17-73
editing 17-73
introduction 17-61

postal tax table
creating 17-100
deleting 17-101
editing 17-101
overview 17-99

product types
classes 17-106
creating 17-108
deleting 17-126
editing 17-125
effect on catalog entries 17-107
overview 17-106

regional tax table
deleting 17-103
editing 17-102
overview 17-101

regions 17-50
shippingmethods 17-90
adding 17-92
changing sequence 17-93
deleting 17-93
editing 17-93

shipping providers
default 17-91
defining 17-90

shopping cart, deleting 17-213
shopping cart, viewing 17-213
tax class
creating 17-98
deleting 17-99
editing 17-99
screens 17-97

taxes
how calculated 17-95
overview 17-95

upsell items 17-188
warehouse 17-85
creating 17-85
default, changing 17-86
deleting 17-87
editing 17-87

edit button, floating toolbar 7-5
editing
content block, overview 2-5, 2-5

editors
introduction 7-20

email
automatic
content 1-87
notification of content activity 1-86

disabling notification for a user 15-6
instant 1-91
conditions 1-92
modifying 1-93

system address 19-5
emailing workflow reports 7-708
end date, setting for content 7-197
eSync
bidirectional 18-61
CMScontent and folder 18-71
enabling 18-73
prerequisites 18-72
using 18-73

CMS folder 18-76
collisions 18-68
configurations, sample 18-37
conflict resolution 18-62
content 18-74
ID numbering 18-42
initializing a new site 18-52

introduction 18-1, 18-4, 18-35
items to synchronize 18-62
load balanced system 18-76
manually running 18-64
multisite environment 18-83
port number, changing 18-85
profile
setting up 18-53

security certificates
installing 18-45
introduction 18-43
regenerating 18-50
replacing 18-50
testing 18-50

software requirements 18-35
troubleshooting 18-89
Windows files 18-62

eWebDiff window 7-125
eWebEdit400
alignment toolbar buttons 7-28
anchor tag toolbar button 7-25
bold toolbar button 7-27
bookmarks 7-53
bullet toolbar button 7-28
cells
background color 7-95
background color, deleting 7-96
background image, deleting 7-97
background image, inserting 7-96
border size 7-92
deleting 7-95
merging 7-102
padding and spacing 7-103
splitting 7-101
text alignment 7-100
width 7-94

copy
information from other appli-

cations

7-

30
toolbar button 7-24

cut toolbar button 7-24
email links 7-59
finding text 7-31
font
background color toolbar button 7-

28
color toolbar button 7-28
relative size toolbar button 7-27
size, absolute, toolbar button 7-27
style toolbar button 7-27

form elements toolbar 7-30
horizontal line toolbar button 7-26
HTML
viewing 7-60

hyperlink toolbar button 7-26
hyperlinks 7-55
creating 7-56
editing 7-58
enteringmanually 7-56
preventing 7-59
removing 7-59
to a bookmark in another web

page

7-

58
images
deleting 7-52



inserting 7-37
indent toolbar button 7-28
insert symbol toolbar button 7-26
italic toolbar option 7-27
library toolbar button 7-26
number toolbar button 7-28
paragraph style toolbar button 7-26
paste fromWord toolbar button 7-25
paste plain text toolbar button 7-25
paste toolbar button 7-24
print toolbar button 7-25
redo toolbar button 7-25
remove hyperlink toolbar button 7-26
replace toolbar button 7-25
replacing text 7-31
search 7-31
considering case of search term 7-

34
direction 7-34
whole wordmatch 7-35

select all toolbar button 7-24
spell check toolbar button 7-25
spelling 7-36
strikethrough toolbar button 7-27
style class toolbar button 7-26
subscript toolbar button 7-27
superscript toolbar button 7-27
table
add row above toolbar button 7-29
add row below toolbar button 7-29
adding columns 7-70
adding rows 7-70
alignment 7-75
background color 7-77, 7-79
background color,deleting 7-79
background image 7-81
background image,deleting 7-82
border color 7-83
border size 7-85
cell properties toolbar button 7-30
columns, specifying 7-69
creating 7-63
delete cell toolbar button 7-29
delete column toolbar button 7-29
delete row toolbar button 7-29
deleting 7-68, 7-70
insert column left toolbar button 7-

29
insert column right toolbar button 7-

29
insert toolbar button 7-29
inserting within a table 7-69
merge cell horizontally toolbar but-

ton

7-

29
merge cell vertically toolbar button 7-

29
properties toolbar button 7-30
rows,specifying 7-69
section 508 7-87
abbreviation 7-91
categories 7-91
table caption 7-90
table summary 7-90

show/hide border toolbar button 7-

30
span rowsand columns 7-97
split cell toolbar button 7-30
width,setting bypercentage 7-72
width,setting bypixels 7-74
word wrap 7-102

text, searching 7-31
text,aligning in columns 7-69
toolbar buttons 7-23
translate toolbar button 7-26
underscore toolbar button 7-27
undo toolbar option 7-25
wiki toolbar button 7-26

exchange rate
eCommerce 17-57

extension, Dreamweaver, using 21-61

F

file extensions
library folder property 8-7

File LinkField, data designer 7-346
file types
determining which onesare

allowed

7-

443
file upload path
library folder property 8-7

files
copying to library 8-11
library
inserting into content 8-18
overwriting 8-16
viewing 8-13

library, editing title 8-15
finding
content block 7-105

FireFoxplugin for DMS
installing 7-411

flagging
content 16-198
report 16-200

definitions 16-195
assigning to folder 16-197

introduction 16-193
folder
assigning smart forms 7-377
assigning to amenu 9-158
assigningWeb Alerts 20-21
content
applying
style sheet 5-14, 7-556
template 5-14, 7-556

creating on server to match CMS

folders

19-

10
deleting 5-20
managing 5-1
properties 5-13
toolbar 5-16, 7-557

permissions
setting 5-47

folders
information available when viewing 5-

4
view history, restore 7-128
viewing 5-3

folders, traverse 5-46
font buttons, enabling 19-7
fonts
adding 19-43
deleting 19-45
editing 19-45
managing 19-43
viewing 19-44

Force All Approvers 5-42
forms
adding to content 8-23
HTML
assigning task 7-260
creating 7-222
creating content block 7-228
database 7-274
deleting 7-274
editing
content block 7-273
introduction 7-272
summary 7-273

field validation options 7-237
implementing onWeb page 7-253
inserting fields
calendar field 7-248
checkbox 7-233
choices 7-245
text 7-234

introduction 7-220
mailto 7-274
permissions 7-221
processing overview 7-221
reports, exporting 7-267
reports, viewing 7-262
sending data asXML 7-254
structure of data 7-222
toolbar options 7-229
validation 7-232
viewing 7-268
XML email structure 7-255

viewing 8-23
forum
signature, defining 15-7

full screen, work page, customizing for

user

15-

7

H

height, screen, adjusting 19-8
height, work page, customizing for

user

15-

7
history
button, view, floating toolbar 7-5
content
accessing fromWeb page 7-109, 7-

118
accessing viaWorkarea 7-110, 7-

117
window 7-118

HTML
saving Office document as 7-432

http port, changing in EktronWeb

Services file

19-
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hyperlinks
adding asmenu option 9-143
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definition 8-2
library
adding 8-21
adding to content 8-21
editing 8-21
viewing 8-21

I

Ignore All field, eWebDiff 7-125
Ignore Case field, eWebDiff 7-125
Ignore Format Attributes field,

eWebDiff

7-

126
image extensions
library folder property 8-7

image only field
data designer 7-344

image upload path
library folder property 8-7

images
library
adding to content 8-22
editing titles 8-22
overwriting 8-22
uploading 8-21
viewing 8-22

login, changing 3-11
include file
ASP 21-246

indexing catalog
full scan 9-17
incremental scan 9-18

indexing service
restart 9-15

indexing, XML see XML indexing 7-389
inheritance
breaking 5-45
restoring 5-45

IP address, restricting for a forum 7-634

K

kits, eCommerce 17-113

L

landing page after login, customizing

for user

15-

8
language export feature, seemulti-

language content

14-

13
language, foreign seemulti-lan-

guage content

14-

1
LDAPauthentication
Active DirectorySetup screen 15-

105
adding organizational unit 15-98
adding user information from LDAP

server to CMS400

15-

99
deleting users 15-105
disabling 15-109
editing user information in CMS

400

15-

104
enabling 15-95
overview 15-94
using with CMS400.NET 15-95

view users screen 15-106
library
accessing 8-3
asset, adding asmenu item 9-143
copying files to 8-11
definition 8-1
files
deleting 8-18
editing 8-15
inserting into content 8-18
overwriting 8-16
viewing 8-13

folder properties 8-6
folders
creating 8-4

forms
adding to content 8-23
viewing 8-23

hyperlinks
adding 8-21
adding to content 8-21
editing 8-21
viewing 8-21

images
adding to content 8-22
editing titles 8-22
overwriting 8-22
uploading 8-21
viewing 8-22

items
actions that can be performed 8-5

permissions 8-4
quicklinks
adding to content 8-23
viewing 8-23

search results
include images 8-11, 9-97
text only 8-11, 9-97

searching 8-8
license key
modifying 19-4

lifecycle, content block 2-5
links, bad, report 7-725
list summary
ASP 21-274, 21-285, 21-289, 21-

334, 21-353
example 21-275, 21-290
variables 21-276, 21-291
maxnumber 21-280, 21-293
order by 21-278, 21-292
recursive 21-277, 21-292
show info 21-279
show summary 21-277
starting folder 21-276, 21-291
style info 21-277

ASP.Net 9-270
ColdFusion 21-332, 21-333
example 21-332, 21-333, 21-333
format 21-332, 21-333

PHP 21-353
example 21-353
format 21-353

ListSummary, compared with col-

lection andmenu

9-

2

load balancing 8-24
assets 19-34
setting up 19-35

introduction 19-32
library imagesand files 19-33

lock
discussion boards 7-603
discussion forum 7-611

locked user account, unlocking 3-10
locking out a user 3-10
log in 3-2
log out 3-4
button, floating toolbar 7-5

login
ASP 21-249
example 21-250
placing 21-250

ASP.Net 3-6
placing 3-6

attempts, disabling 3-10
ColdFusion 21-328
example 21-328

images, changing 3-11
locking out a user 3-10
PHP 21-348
example 21-349

preventing all users from 3-11
preventing CMSusers from 3-11
restricting number of attempts 3-9

M

Macromedia Extension Package 21-46
managed files 7-435
creating 7-437
editing 7-437
importing one 7-437

mapped network folder
adding Office documents 7-422
drag and drop assets 7-425
editing Office document 7-428
language restrictions 7-423
removing 7-426
setting up 7-423
viewing files 7-426

maximum summary size, setting 19-5
membership
ASP.Net 16-24

membershipmodule
accessing 16-5

membership user

groups

16-15, 16-16, 16-19,

16-23
adding 16-16
adding users 16-17
deleting 16-18
deleting users 16-18
name, editing 16-17
viewing users 16-17

membership users
activating 20-31
adding 16-6
deleting 16-15
editing 16-11
permissions, assigning 16-19
unverified, confirmationmessage 20-



30
unverified, viewing 20-31
viewing 16-9

menus
accessing 9-131
add new content block via navi-

gation link

9-

145
adding new
via content folder 9-133
viaMenusmodule 9-137

appearance
to content contributor 9-129
to site visitor 9-129

assigning folders to 9-158
assigning users permission to edit via

the Roles screen

15-

34
compared with collection and List

Summary

9-

2
creating
in any language 9-157

definition 9-129
deleting 9-153
editing 9-146
via content folder 9-146
viamenusmodule 9-147
via navigation link 9-147

items
adding
content blockas 9-142
external hyperlink as 9-143
library asset as 9-143
submenu 9-144
to submenu 9-144
via content folder 9-138
viamodules folder 9-140
via navigation link onWeb page 9-

141
definition 9-130
deleting
via content folder 9-154
viamenusmodule 9-155

editing
via content folder 9-148
viamenusmodule 9-149
via navigation link 9-150

rearranging 9-153
multi-language issues 9-155
permissions 9-132
structure 9-130
submenu, definition 9-130
template link field 9-137
translating 9-155
URL link field 9-136
viewing
via content folder 9-151
viamenusmodule 9-151
via navigation link 9-152

messages
eCommerce 17-81

metadata
adding to content 7-167
ASP 21-311
creating item list 21-311
dynamic 21-314
example 21-312

format 21-311
variables 21-314
item list 21-314
spare 21-316

assigning to a folder 7-165
ColdFusion 21-340
format 21-340

definition fields 7-158
definitions
adding 7-156
converting style 7-162
deleting 7-165
editing 7-164

Dublin Core 7-154
inheritance from parent folder 7-167
making publicly viewable 7-160
meta tag additional fields 7-159
PHP 21-362
format 21-362

property definitions, viewing 7-164
related content
compared with MetadataList

server control

7-

152
creating and deploying 7-152
overview 7-151

response field style 7-161
Microsoft Office
documents
importing 7-415

Microsoft Office document
checking out, saving and replacing 7-

430
deleting 7-429
saving 7-432
saving in html format 7-432

Microsoft Office documents
adding via DMSDocument Option 7-

417
edit in mapped network folder 7-428
editing in Office 7-427
imported
how named 7-416

Microsoft Office Documents
adding via drag and drop 7-419
adding via mapped network folder 7-

422
adding via Multiple DMSDoc-

uments option

7-

418
MIME types, seemultimedia assets 7-449
move content 7-113
multi-languagemenus 9-155
multi-language content
approval chains 14-23
creating new content 14-8
creatingWeb pages in several lan-

guages

14-

27
default language 14-7
determining available languages 14-5
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